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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Adapter Platform. IT managers who seek to understand the role of the 
Adapter Platform and the Global Manager in the context of an EMC Smarts solution may 
also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide.


Audience
This document is intended for administrators who are responsible for deploying, 
installing, and configuring the Adapter Platform.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI (CUI)


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


These documents are updated periodically. Electronic versions of the updated manuals 
are available on the EMC Online Support website (registration required) at: 
https://support.emc.com

11
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EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.
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Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.

13
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and 


menus
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, 


keywords, clauses, environment variables, functions, and utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, 


file systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs, 
processes, services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and 


menus
• What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables


Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


Courier bold Used for specific user input, such as commands


Courier italic Used in procedures for:
• Variables on the command line
• User input variables 


< > Angle brackets enclose parameter or variable values supplied by the user 


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Service Assurance Adapter Platform


This chapter contains the following information:


◆ Overview.................................................................................................................  18
◆ Service Assurance Adapter Platform architecture.....................................................  20
◆ Overview of configuration for Adapter Platform........................................................  22
◆ Configuring Adapter Platform Server........................................................................  22
◆ Starting and stopping the Adapter Platform Server ..................................................  42
◆ The sm_edit utility ..................................................................................................  43

Service Assurance Adapter Platform 17







Service Assurance Adapter Platform

Overview
The EMC® Smarts® Service Assurance Manager Adapter Platform (Adapter Platform) 
imports and normalizes topology and event information from sources other than 
EMC Smarts products, such as SNMP traps, system log files, or events generated from the 
sm_ems command line interface. After it normalizes to the ICIM data model, the 
information is transferred to the EMC Smarts Service Assurance Manager (Global 
Manager). 


The Adapter Platform works with third-party applications in a variety of ways to import 
topology and event information and prepare it for use by the Global Manager. The Adapter 
Platform allows for several methods of receiving events, including:


◆ SNMP trap integration


◆ Log file integration


◆ Integration by using a custom adapter


◆ Command line interface


The Adapter Platform works with any combination of these methods.


Regardless of how the Adapter Platform receives the event information, it does the 
following:


◆ Provides uniform representation of event information regardless of the source of the 
event. This is called event normalization.


◆ Consolidates recurring events, rather than considering each new event separately. 
This reduces the number of events sent to the Global Manager. It is called 
deduplication.


◆ Allows for an incoming message to clear a previous event.


◆ Provides a mechanism to set an event expiration. This mechanism automatically 
clears events that have not changed for a period of time.


◆ Optionally associates events to a topology element, thus placing events in their 
topological context.


After the event information is processed, it is sent to the Global Manager.


Table 1 on page 19 describes the configuration files that are relevant to the Adapter 
Platform Server. The sm_edit utility ensures that modified files are saved to the 
appropriate location in the BASEDIR/smarts/local directory. 
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You should edit only local copies of the Adapter Platform configuration files, which are 
located in BASEDIR/smarts/local/conf/icoi. If local copies of the configuration files 
already exist and you attempt to edit non-local files, the sm_edit utility will locate and edit 
the local (not the non-local) versions of files. “The sm_edit utility” on page 43 provides 
information about the sm_edit utility. EMC Smarts System Administration Guide provides 
detailed instructions about how to properly modify an EMC Smarts file.


Table 1  Adapter Platform configuration files


Directory under 
BASEDIR Filename


User 
editable Description


smarts/conf/icoi bootstrap.conf No Contains vital information required 
to start the Adapter Platform 
Server.


smarts/conf/icoi dxa-sysip.conf No Used by the Adapter Platform to 
import information from 
cooperating EMC Smarts IP 
Availability Managers.


smarts/conf/icoi icoi-config.dtd No Definition file for XML 
configuration.


smarts/conf/icoi icoi-default.xml Yes Contains the default notification 
lists, user profiles, and users for 
the Service Assurance Adapter 
Platform when the server is first 
started, or started without an 
existing repository file.


smarts/conf/icoi icoi-config-sample.xm
l


Yes Sample XML file of notification 
lists, user profiles, and users. It can 
be used as a template for creating 
XML files of these entities.


smarts/conf/icoi nlconfig-sample.xml Yes Sample XML file for notification list 
configuration. It can be used as a 
template for creating additional 
files.


smarts/conf/icoi profileconfig-sample.x
ml


Yes Sample XML file for user profile 
configuration. It can be used as a 
template for creating additional 
files.


smarts/conf/icoi userconfig-sample.xm
l


Yes Sample XML file for user 
configuration. It can be used as a 
template for creating additional 
files.
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Service Assurance Adapter Platform architecture
The Adapter Platform consists of four basic components as shown in Figure 1 on page 21:


◆ Service Assurance Adapter Platform Server


The Adapter Platform Server prepares event information for use by the Global 
Manager. It normalizes the event information and places it in a context understood by 
the Global Manager.


◆ EMC Smarts Syslog Adapter


The Syslog Adapter parses a system log file and generates notifications based on the 
contents of the file. Either the complete contents of the file are read or the file can be 
tailed, which means that only newly added information is read.


◆ EMC Smarts SNMP Trap Adapter (Receiver)


The SNMP Trap Adapter parses SNMP traps received and generates notifications 
based on the contents of the traps. The SNMP Trap Adapter can be configured to 
handle many different types of traps.


If you plan to receive SNMPv3 traps, additional steps are required. “Configuring the 
SNMP Trap Adapter to receive SNMPv3 traps” on page 49 provides more information.


◆ Command line interface sm_ems)


The command line interface creates or modifies notifications that are sent to the 
Global Manager. This interface may be used in conjunction with third-party 
applications to send events to the Global Manager.


The Syslog Adapter and the SNMP Trap Adapter configurations must be customized to 
specify the relevant file contents or the SNMP traps to use and how the information maps 
to objects in the Global Manager repository.
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Topology Importer
In addition to the basic Adapter Platform components, you can enable an Adapter 
Platform feature, the Topology Importer, which provides a consistent method of identifying 
the systems associated with Adapter Platform events.


The Adapter Platform creates notifications from different sources and tries to associate 
these notifications to the topology element where the notification occurred. Making this 
association can be difficult because there are many different methods of identifying 
topology elements. 


The Topology Importer collects IP addresses and hostnames from an EMC Smarts IP 
Availability Manager so the Adapter Platform can accurately place events in their 
topological context.


The Adapter Platform updates this list as the information changes in the IP Availability 
Managers. Figure 1 on page 21 shows the Service Assurance Adapter Platform 
architecture.


Figure 1  Service Assurance Adapter Platform architecture
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Overview of configuration for Adapter Platform
Configuring the Adapter Platform to import and normalize event and topology information 
requires that you complete one or more of the following procedures. Not all of these 
configuration procedures are relevant in all Adapter Platform deployments. 


Depending on which components you are implementing, you can omit some of these 
steps:


◆ Configure the Adapter Platform Server


◆ Configure the SNMP Trap Adapter


◆ Configure the Syslog Adapter


◆ Configure the Adapter Platform Server and adapters to start and stop automatically.


The following configuration sections describe each of these procedures.


Configuring Adapter Platform Server
Configuring the Adapter Platform Server involves:


◆ “Configuring notification lists” on page 22


◆ “Configuring user profiles” on page 24


◆ “Configuring users” on page 30


◆ “Configuring system defaults” on page 31


◆ “System defaults cannot be deleted.” on page 32


◆ “Configuring domain types” on page 35


Configuring notification lists


Topics in this section include:


◆ “Creating a notification list” on page 22


◆ “Modifying a notification list” on page 23


◆ “Disabling a notification list” on page 24


◆ “Configuring custom notification lists” on page 24


Creating a notification list
To create a notification list by using the Notification List Creation Wizard:


1. From the Global Manager Administration Console, select Edit > New Notification List.


The Notification List Creation Wizard appears.


2. Type a unique name for the Notification List. 
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3. Select to create a new notification list or copy an existing notification list:


• If a new notification list is being created, all of the filter properties are empty.


• If you copy a notification list, the notification list properties contain the same 
values as the copied list.


4. Click Next. 


5. Create an expression filter or type the name of an ASL Filter prefaced by the name of 
the BASEDIR/smarts/local/rules directory in which it is located, and click Next. 


6. Edit the column headings that are displayed in the notification log. The left column 
lists the attributes included in a notification. The right column lists the column names 
as they are currently displayed. You can edit the values in the right column by 
double-clicking a field.


7. Perform one of the following:


• Click Next to view the confirmation panel.


• Click Finish to create the notification list. 


The new notification list is displayed in the Global Manager Administration Console.


Modifying a notification list
To edit the filters and the column headings for a notification list:


1. Select a notification list in the tree.


The Configure Notification List panel appears.


2. Click Edit Filter to modify the filter.


The Edit Filter dialog box appears. The EMC Smarts Service Assurance Manager 
Configuration Guide provides additional information.


3. Click OK when finished editing the filters. 


4. Edit the display headings as needed. Double-click the display heading in the right 
column to edit the text. The new display heading is visible when users reattach to the 
Global Manager. 


5. Click Apply.


To provide a value for a UserDefined attribute, you must configure a hook script to 
populate the field. EMC Smarts Service Assurance Manager Configuration Guide provides 
information about hook scripts.
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Disabling a notification list
You can disable a notification list if you do not want it active, but do not want to delete it. 
When a user attaches to a Global Manager and their notification is disabled, their console 
will not receive any notifications. The console will receive notifications when the 
notification list is enabled.


To disable a notification list:


1. Select the list from the tree in the Global Manager Administration Console.


2. Clear the Enabled checkbox.


3. Click Apply.


The name of the disabled notification list appears dimmed. 


Configuring custom notification lists
You do not need to create a notification list in the Adapter Platform Server for the Global 
Manager to use. By default, it connects to the Adapter Platform Server’s Default 
notification list. However, if you want to use a custom notification list, you can create it 
through the Global Manager Administration Console, or you can create it through the use 
of the nlconfig-sample.xml file and import it with the sm_config command. This allows you 
to send a subset of notifications from the Adapter Platform Server to the Global Manager. 
Then you need to modify the local copy of the dxa-oi.conf on the Global Manager and 
change the following line:


sub    Default/n
to
sub     <notification_list>/n


Configuring user profiles


Topics in this section include:


◆ “Creating a user profile” on page 24


◆ “Deleting a user profile” on page 27


◆ “Modifying a user profile” on page 27


Creating a user profile
When using the User Profile Creation Wizard, you are prompted to specify the users, 
notification list, tools, saved consoles, and console operations associated with the user 
profile. 


You can create users and notification lists from within the User Profile Creation Wizard.


As you proceed through the wizard, you may notice that certain elements, such as users or 
tools, appear dimmed. This indicates that these elements are not enabled. You can 
associate disabled elements with a user profile. However, such elements are not available 
to the user profile. For example, if a tool is not enabled, it will not be available to a user 
until it is enabled. You can enable or disable elements by selecting them in the tree, and 
selecting or clearing the Enable box in the Configure User Profile panel.
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In addition, you can click Finish at any point and the wizard will create the user profile. If 
you are creating a new user profile, any options after the point where you selected Finish 
will be blank. If you copied an existing user profile, the new profile will include the options 
of the copied profile.


Users may have to detach and reattach for changes to their user profile to take effect.


To create a user profile:


1. From the Global Manager Administration Console, click the Launch User Profile Wizard 
toolbar button.


The User Profile Creation Wizard appears.


2. Type the name of the user profile and select whether to create a new profile or to copy 
an existing profile, and click Next. If you want to copy an existing profile, the remaining 
configuration options will be identical to the user profile that was copied.


The name of a user profile cannot be the same as the name of a user. For example, you 
cannot create a user profile Operator and a user Operator. A suggested naming 
convention is to name the user profile with a –profile extension. For example, you 
could have a user profile called Operator–profile.


3. Select a notification list from list box and click Next. Optionally, you can select New 
Notification List from the menu to create a new notification list. 


4. Select the user or users associated with this user profile. You can select multiple users 
by holding the Ctrl key when selecting users. Click Add to associate the user or users 
with the user profile. 


If the user does not exist, you can create a user by doing the following:


a. Type the username in the Create and add new user field.


b. Click Add.


c. Click Next.


A user can belong to only one user profile. If the user you select is already a member 
of another user profile, the user is associated with the new user profile.


5. Select any appropriate server tools from the list of Available server tools and click Add 
to associate them with the user profile. You can select multiple tools by holding the 
Ctrl key while selecting. When finished, click Next.


Click the Allow user to launch client or server tools only for a single selected object 
option to allow users to only launch client or server tools for a single selected object.
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6. Select one or more appropriate client tools from the list of Available client tools, and 
click Add to associate them with the user profile. You can select multiple tools by 
holding the Ctrl key while selecting. When finished, click Next.


Click the Allow user to launch client or server tools only for a single selected object 
option to allow users to only launch client or server tools for a single selected object.


7. Select the saved consoles that are opened when users attach to the Global Manager, 
and click Next. If a saved console is not selected, the default NotificationLog console 
will appear when the user attaches to the Global Manager.


If the appropriate console is not listed, type the name of the console in the Add new 
console field, and click Add. You can specify the name of a saved console whether or 
not the saved console exists.


8. Select the console operations for users associated with this user profile. You can 
select Other for specific console operations or select one of the default sets of console 
operations:


• Read Only


• Operator


• Administrator


The default sets of console operations cannot be modified.


You can assign a modified version of one of the default sets of console operations by 
first selecting the set that provides most of the console operations to assign. Then, 
select Other. When you click Next, the console operations that correspond to the set 
you chose are selected but you can enable or disable individual console operations.


9. Click Next. The final screen of the User Profile Wizard shows all newly created 
elements, including the new user profile. By default, the user profile is enabled. You 
can disable it by clearing the box next to the profile name. 


10. Click Finish to display a dialog box confirming that the user profile elements were 
created.
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Deleting a user profile
To delete a user profile:


1. Select the user profile.


2. Select Edit > Delete.


You can disable a user profile without removing it. “Disabling a user profile” on page 28 
describes how to disable a user profile.


You must not delete the default-profile user profile. When users attach to a Global 
Manager and their username is not assigned to a user profile, the default-profile user 
profile is applied. If the default-profile does not exist, an error message appears and the 
Global Console will not open.


Modifying a user profile
To modify a user profile:


1. Select the user profile.


2. Modify the properties of the user profile in the right panel:


a. Change the notification list.


b. Add or remove users.


c. Add or remove server tools.


d. Add or remove client tools.


e. Add or remove saved consoles.


f. Add or remove console operations.


3. Click Apply.


Changes to a user profile may not be available to console users until they restart the 
Global Console. 

Configuring Adapter Platform Server 27







Service Assurance Adapter Platform

Disabling a user profile 


You can disable a user profile without having to delete it. When users of a disabled profile 
attach to the Global Manager, they are assigned the default-profile. If the default-profile is 
deleted, users associated with a disabled user profile cannot attach to the Global 
Manager.


To disable a user profile:


1. Select the user profile.


2. Clear the Enabled checkbox.


3. Click Apply.


Changing the notification list for a user profile


A notification list determines what notifications a user sees in the Global Console. 
Changing the notification list associated with a user profile affects all the users of this 
profile.


To change the notification list for a user profile, select a new notification list from the 
Notification List menu.


Adding or removing a user


A user can be associated with only one user profile. If you add a user to a user profile, the 
user is automatically removed from its previous user profile.


To add a user to a profile:


1. Select the user profile from the tree. 


2. From the Configure User Profile panel, click Modify List in the Users section.


This displays the Modify Users dialog box.


3. Add or remove users from the user profile. 


4. Click OK. 


5. Click Apply. “Creating a user profile” on page 24 describes how to create a user 
account.


To remove a user, select the user profile in the tree. From the Configure User Profile panel, 
select the user from the Users list and click Remove Selected. Click Apply at the bottom of 
the Configure User Profile panel.


When you remove a user from a user profile, the user is automatically associated with the 
default-profile until you assign the user to a different user profile. 
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Adding or removing a tool


Client and server tools are configured separately, however the process for adding or 
removing a client or server tool from a user profile is the same. 


To add a tool to a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Server Tools or Client 
Tools section. 


The Modify Server Tools or Modify Client Tools dialog box appears.


3. Add or remove tools from the user profile. 


4. Click OK.


5. Click Apply. 


To remove a tool:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, select a tool and click Remove Selected.


3. Click Apply at the bottom of the Configure User Profile panel.


Adding or removing a saved console


A saved console provides users with a preconfigured view of the network, helping users 
focus on aspects of the managed system they are to monitor.


To add a saved console to a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Saved Consoles section. 


The Modify Saved Consoles dialog box appears.


3. Add or remove saved consoles from the user profile. 


4. Click OK. 


5. Click Apply.


To remove a saved console:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, select a saved console and click Remove 
Selected. 


3. Click Apply at the bottom of the Configure User Profile panel.
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Adding or removing console operations


Console operations are the functions and commands a user can invoke through the Global 
Console. By adding or removing console operations, an administrator can determine the 
level of access a user has to console operations. 


To add or remove console operations for a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Console Operations 
section. 


The Console Operations dialog box appears.


3. Select or clear console operations for the user profile. 


In addition, you can select one of the three default groups of console operations and 
apply it to the user profile. 


4. Click OK to close the dialog box. 


5. Click Apply at the bottom of the Configure User Profile panel.


Configuring users


Topics in this section include:


◆ “Creating a user account” on page 30


◆ “Deleting a user account” on page 31


Creating a user account
You can create new users in one of the following ways:


◆ Through the User Profile Wizard when you create a user profile as described in 
“Creating a user profile” on page 24.


◆ Through the User Wizard as described below.


◆ Through the sm_config utility as described in “The sm_edit utility” on page 43.


To create a new user with the User Wizard:


1. Select the Launch User Wizard toolbar button.


The User Creation Wizard appears. 


2. Type the name of the new user. The username must be unique. Click Next. 


3. Select a user profile for this user from the list box.


4. Do one of the following:


• Click Next to display a confirmation screen.


• Click Finish to create the user.


5. Add the username and password in the serverConnect.conf file used by the Global 
Manager.
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Deleting a user account
To delete a user:


1. Select the user in the tree.


2. Select Edit > Delete.


Do not disable or remove the Admin user account. If the Admin user account is removed or 
disabled, but other users still have the same privileges, none of the applications can be 
shut down.


Configuring system defaults


To configure system defaults:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the Adapter Platform (INCHARGE-OI).


3. Expand ICS Configuration. 


4. Click System Defaults.


The Configure System Defaults interface appears, as illustrated in Figure 2 on page 31.


Figure 2  Global Manager Administration Console — Configure System Defaults


5. Type or select your system defaults configuration options.


6. Click Apply.
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Table 2 on page 32 describes the system default parameters.


System defaults cannot be deleted.


Configuring domains


Topics in this section include:


◆ “Creating a domain” on page 32


◆ “Modifying domains” on page 34


◆ “Deleting domains” on page 35


Creating a domain
To create a domain:


1. From the Global Manager Administration Console, select Edit > New Domain.


The Domain Creation Wizard appears.


2. Type the name of the domain server in the Domain Name field.


3. Type the description of the domain in the Domain Description field, and click Next.


To create a domain by using the Copy Existing option, select an existing domain server 
from the Copy Existing list, type a Domain Name, and click Finish.


4. Select the domain type. Available options include:


• Use Default Type


This option is available only when copying an existing domain.


Table 2  System default parameters


Parameter Description


Auto acknowledgement 
interval


Defines interval, in seconds, after which an inactive and unowned 
notification is acknowledged. Notifications that are acknowledged 
by the Global Manager are owned by the user SYSTEM. 
Default: 300 seconds


Inactive auto archive 
interval


Defines interval, in seconds, after which an inactive and 
acknowledged notification is archived. Default is 14400 seconds (4 
hours). If this value is set to zero, archiving is disabled and 
notifications will not be deleted, causing Global Manager to use 
more memory.


Audit trail size limit Defines the number of audit log entries for each notification that 
are saved and visible in the Global Console before the log contents 
are archived. When this limit is reached, half of the entries are 
written to the notification archive. 
Default: 100 entries
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• Create New Type


If this option is selected, type the name of the domain type in the Type Name field.


To copy an existing domain type, select an existing domain type from the Copy 
Existing list.


• Select Existing Type


If this option is selected, select a domain type from the Select Type list.


5. Click Next.


6. Edit the domain settings, and click Next.


Table 3 on page 33 defines the available domain settings.


The instance that is created when the domain creation process is complete appears.


By default, the domain is enabled. If the domain is part of a domain group, it is only 
enabled if the domain group it belongs to is enabled. To disable the domain, clear its 
checkbox.


7. Click Finish.


Table 3  Domain settings


Option Definition


DXA file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Notice: If the hook script is enabled, type the path for the hook 
script in the field.


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65
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Modifying domains
To modify a domain:


1. Open the Global Manager Administration Console.


2. From the Manager List, select the Adapter Manager (INCHARGE-OI).


3. Expand ICS Configuration.


4. Expand IC Domain Configuration.


5. Expand Domains.


6. Click the appropriate domain.


The Configure Domain interface appears, as illustrated in Figure 3 on page 34.


Figure 3  Global Manager Administration Console — Configure Domain interface


7. Type the appropriate configurations.


Table 4 on page 34 describes the available domain parameters.


8. Click Apply.


9. Click Reconfigure.


Configuration changes are not applied until Reconfigure is clicked. Clicking 
Reconfigure starts the data synchronization process. Click Reconfigure only after all 
updates to domains, domain tags, domain groups, and domain types have been 
made.


Table 4  Domain parameters


Parameter Description


Enable Enables the domain.


Domain description Provides a description of the domain.


Domain type Defines the domain type.


Show type details Displays the domain type information.
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Deleting domains
To delete domains:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the Adapter Platform (INCHARGE-OI).


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain.


6. Click the appropriate domain.


7. Select Edit > Delete.


The selected domain is deleted.


Domains that refer to other domains cannot be deleted.


Configuring domain types


Topics in this section include:


◆ “Creating domain types” on page 35


◆ “Modifying domain types” on page 36


◆ “Deleting domain types” on page 38


Creating domain types
To create a domain type by using the Domain Groups Creation Wizard:


1. From the Global Manager Administration Console, select Edit > New Domain Type.


The Domain Groups Creation Wizard appears.


2. Select a type to be copied from the Copy Existing list.


3. Type a name in the Type Name field.


4. Type a description in the Type Description field.


5. Click Next.


6. Edit the domain type settings, and click Next.
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Table 5 on page 36 defines the available domain type settings.


7. Select the servers from the Available Domains list.


8. Click Add to move the server to the Selected Domains list. 


This defines the servers associated with the new domain type.


Domains cannot be removed from a domain type — they can only be reassigned to 
another domain type. By adding domains, you are only reassigning the domains to a 
different domain type. Newly added domains appear in green text. You can only delete 
domains displayed in green text. After clicking Apply, the domains cannot be deleted.


9. Click Next.


Objects that will be created after the domain type creation process is complete.


10. Click Finish. The configuration objects are created in the server.


Modifying domain types
To modify a domain type:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the Adapter Platform (INCHARGE-OI).


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Types.


6. Click the appropriate INCHARGE Domain Type.


Table 5  Domain type settings


Option Definition


DXA file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Notice: If the hook script is enabled, type the path for the hook 
script in the field.


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65
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The Configure Domain Type interface appears, as illustrated in Figure 4 on page 37.


Figure 4  Global Manager Administration Console — Configure Domain Type interface


7. Type the appropriate configurations. 


Table 6 on page 37 defines the available domain type configuration parameters.


8. Click Apply.


9. Click Reconfigure.


Table 6  Domain type configuration parameters


Parameters Definition


Type description Defines the domain type.


DXA configuration file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Notice: If the hook script is enabled, type the path for the hook script in 
the field.


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65


Domains Defines the domains associated with the domain type.


Notice: Click Modify List to add domains, select a domain from the list 
and click Remove Selected to remove domains, and click Restore to 
restore previously configured domains. Domains cannot be removed 
from a domain type, they can only be reassigned to another domain 
type.
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Configuration changes are not applied until Reconfigure is clicked. Clicking 
Reconfigure starts the data synchronization process. Click Reconfigure only after all 
updates to domains, domain tags, domain groups, and domain types have been 
made.


Deleting domain types
To delete domain tags:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the Adapter Platform (INCHARGE-OI).


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Types.


6. Click the appropriate domain type.


7. Select Edit > Delete.


The selected domain type is deleted.


Domain types that refer to other domains cannot be deleted.


Configuring security for the Adapter Platform


It is important to secure access to the Adapter Platform Server. Service Assurance 
components authenticate users and determine their privileges through three files: 
serverConnect.conf, clientConnect.conf, and brokerConnect.conf. These files ensure that 
only authorized users access Service Assurance Server applications. Use sm_edit to 
modify these files, which are located in BASEDIR/smarts/conf.


The Adapter Platform functions as a server application. The following are possible clients 
of the Adapter Platform Server:


◆ Broker


◆ Command line utilities (dmctl)


◆ Global Manager


◆ sm_ems


◆ SNMP Trap Adapter (Receiver)


◆ Syslog Adapter


EMC Smarts System Administration Guide provides a complete list of server and client 
programs and a more detailed explanation of the Service Assurance security mechanism.


Figure 5 on page 39 provides an overview of the security files required in a typical 
deployment of the Adapter Platform. A circle in the figure indicates that the component 
represented by the adjacent box is a client application. An arrowhead indicates that the 
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component represented by the adjacent box is a server application. For example, the 
Adapter Platform is a client of the broker and the Adapter Platform has five clients—the 
broker, the Global Manager, the SNMP Trap Adapter, the Syslog Adapter, and sm_ems. 
Although not depicted in the figure, the SNMP Trap Adapter, the Syslog Adapter, and 
sm_ems are also clients of the Broker because everything is a client of the Broker.


In general, the Global Manager and the Adapter Platform are deployed on different hosts. 
If the Adapter Platform resides on the same host as another Service Assurance server 
application, such as the Adapter Platform, then they can share the same 
serverConnect.conf file. Likewise, if clients of the Adapter Platform reside on the same 
host as other Service Assurance client applications, they too can share the same 
clientConnect.conf file. 


Figure 5  Security configuration of the Adapter Platform


The following sections provide examples of authentication records for the client programs, 
SNMP Trap Adapter (Receiver), Syslog Adapter, and sm_ems command line interface and 
corresponding records for the server program, Adapter Platform Server. 


The EMC Smarts System Administration Guide provides examples of authentication 
records for the broker and the Global Manager.


EMC Smarts SNMP Trap Adapter security
The SNMP Trap Adapter is a client of the Adapter Platform Server. As such it will use 
information in the clientConnect.conf file to provide authentication information to the 
Adapter Platform Server. The Adapter Platform Server will compare this information to 
entries in the serverConnect.conf file to validate the connection. Thus, both these files 
must be configured.


The clientConnect.conf file must be configured on the host where the SNMP Trap Adapter 
runs. In the clientConnect.conf file you should create an entry for the system user ID 
running the SNMP Trap Adapter with a corresponding EMC Smarts username and 
password. For example:


trap-uid1 : INCHARGE-OI : admin : changeme


where:


SNMP Trap Receiver Syslog Adapter sm_ems


Global Manager


Client Application


Server Application


Adapter Platform Server


Service Assurance
Broker
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◆ trap-uid1 is the system user ID running the SNMP Trap Adapter


◆ INCHARGE-OI is the Adapter Platform Server name


◆ admin is the EMC Smarts login username


◆ changeme is the EMC Smarts login password


The serverConnect.conf must be configured on the same host as the Adapter Platform. In 
the serverConnect.conf, an entry must exist that corresponds to the EMC Smarts 
username and password specified in the clientConnect.conf file for the system user ID 
running the SNMP Trap Adapter. The EMC Smarts user must be given All privileges. For 
example:


INCHARGE-OI : admin : changeme : ALL


where:


◆ INCHARGE-OI is the Adapter Platform Server name (you could use an * to indicate all 
Service Assurance servers)


◆ admin is the EMC Smarts login username


◆ changeme is the EMC Smarts login password


◆ ALL is the privileges granted this user


The SNMP Trap Adapter does not have to run on the same host as the Adapter Platform. 
EMC Smarts System Administration Guide provides more information about security 
configuration.


EMC Smarts Syslog Adapter security
The Syslog Adapter is a client of the Adapter Platform Server. As such it will use 
information in the clientConnect.conf file to provide authentication information to the 
Adapter Platform Server. The Adapter Platform Server will compare this information to 
entries in the serverConnect.conf file to validate the connection. Thus, both these files 
must be configured.


The clientConnect.conf file must be configured on the host where the Syslog Adapter runs. 
In the clientConnect.conf file you should create an entry for the system user ID running the 
Syslog Adapter with a corresponding EMC Smarts username and password. For example:


syslog-uid1 : INCHARGE-OI : admin : changeme


where:


◆ syslog-uid1 is the system user ID running the Syslog Adapter


◆ INCHARGE-OI is the Adapter Platform Server name


◆ admin is the EMC Smarts login username


◆ changeme is the EMC Smarts login password


The system user ID that starts the Syslog Adapter will need administrative privileges. 
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The serverConnect.conf must be configured on the same host as the Adapter Platform. In 
the serverConnect.conf, an entry must exist that corresponds to the EMC Smarts 
username and password specified in the clientConnect.conf file for the system user ID 
running the Syslog Adapter. 


The EMC Smarts user must be given All privileges. For example:


INCHARGE-OI : admin : changeme : ALL


where:


◆ INCHARGE-OI is the Adapter Platform Server name (you could use an * to indicate all 
Service Assurance servers)


◆ admin is the EMC Smarts login username


◆ changeme is the EMC Smarts login password


◆ ALL is the privileges granted this user


The Syslog Adapter runs on the same host as the Adapter Platform. The EMC Smarts 
System Administration Guide provides more information about security configuration. 


sm_ems command line interface security
The sm_ems command line interface may or may not run on a host different from the 
Adapter Platform Server. The clientConnect.conf file must be configured on the host 
running the command line interface. You should create a unique username and password 
that matches a user in serverConnect.conf and give that user All privileges. Typically, when 
using the command line interface from a third-party application, the username and 
password should not be prompted. However, if you want to run sm_ems manually, then 
prompting could be used. The EMC Smarts System Administration Guide provides more 
information about security configuration. 
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Starting and stopping the Adapter Platform Server
If you installed the Adapter Platform Server as a service, it automatically starts when the 
system starts up. The following instructions describe how to use the sm_service utility to 
manually start and stop the Adapter Platform Server.


To use the sm_service utility to install a service or start a service, you must have 
administrative privileges on the local host.


Issue one of the following from the command line:


BASEDIR/smarts/bin/sm_service start ic-icoi-server


or


BASEDIR/smarts/bin/sm_service stop ic-icoi-server


The EMC Smarts System Administration Guide provides more information about the 
sm_service utility or about how to modify sm_service options.


On Windows, if the Adapter Platform was installed as a service, you can also start and stop 
the service by using the Control Panel Administrative Tools.


Default sm_service parameters for Adapter Platform Server


When the Adapter Platform Server is installed as a service during the installation process, 
the Adapter Platform Server is set up with default parameters. The default parameters and 
their values are:


▼ /InCharge/SAM/smarts/bin/sm_service install
--startmode=runonce --name=ic-icoi-server
--description=”SMARTS SAM Adapter Platform Server”
/C:/InCharge/SAM/smarts/bin/sm_server
--name=INCHARGE-OI
--config=icoi
--port=0
--ignore-restore-errors
--output ▲ 


▼ ▲ indicates the command must be typed as one line. Type the command from the 
BASEDIR/smarts/bin directory for the Service Assurance Manager product.
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The sm_edit utility
As part of the EMC Smarts deployment and configuration process, you need to modify 
certain files. User modifiable files include configuration files, rule set files, templates, and 
files (such as seed files and security configuration files) that contain encrypted 
passwords. Original versions of these files are installed into appropriate subdirectories 
under the BASEDIR/smarts/ directory. Examples follow:


Examples ◆ The original versions of the Global Manager configuration files on UNIX are installed to 
/opt/InCharge/SAM/smarts/conf/ics


◆ The original versions of the Console configuration files on Windows are installed on 
C:\InCharge\SAM\smarts\conf\console


Original versions of files should not be altered. If a file requires modification, it must be 
stored as a local copy of the file in BASEDIR/smarts/local or one of its subdirectories. For 
example:


Examples ◆ A modified dxa-sam.conf file on UNIX should be saved to 
/opt/InCharge/SAM/smarts/local/conf/ics


◆ A modified properties.conf file on Windows should be saved to 
C:\InCharge\SAM\smarts\local\conf\console


EMC Smarts software is designed to first search for user modifiable files in 
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not 
found in the local area, the software then searches appropriate nonlocal directories.


To facilitate proper file editing, EMC Corporation provides the sm_edit utility with every 
product. When used to modify an original version of a file, this utility automatically creates 
a local copy of the file and places it in the appropriate location under 
BASEDIR/smarts/local. This ensures that the original version of the file remains 
unchanged. You can invoke sm_edit from the command line. Optionally, you can configure 
Windows so that sm_edit is automatically invoked when user-modifiable files are 
double-clicked in Windows Explorer.


To invoke the sm_edit utility from the command line, specify the path and the name of the 
file to edit under BASEDIR/smarts. If multiple products are running on the same host, 
invoke sm_edit from the bin directory of the product with the files to edit. 


Example To edit the configuration file for the Global Manager, invoke the sm_edit utility as follows: 


# /opt/InCharge/SAM/smarts/bin>sm_edit conf/ics/dxa-sam.conf
In this example, the sm_edit utility automatically creates a local copy of the dxa-sam.conf 
file in the /opt/InCharge/SAM/smarts/local/conf/ics directory and opens the file in a text 
editor. If a local version of the file already exists, the sm_edit utility opens the local 
version in a text editor. In addition, sm_edit creates any necessary subdirectories.


The EMC Smarts System Administration Guide provides additional information about the 
sm_edit utility.
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CHAPTER 2
EMC Smarts SNMP Trap Adapter


This chapter contains the following information:


◆ Overview.................................................................................................................  46
◆ Configuring the SNMP Trap Adapter to receive SNMPv3 traps ..................................  49
◆ Configuring trapd.conf (trap exploder and trap receiver) ..........................................  53
◆ Configuring the SNMP Trap Adapter to forward notifications ....................................  58
◆ Starting and stopping the SNMP Trap Adapter .........................................................  79
◆ Default sm_service parameters for the SNMP Trap Adapter......................................  79

EMC Smarts SNMP Trap Adapter 45







EMC Smarts SNMP Trap Adapter

Overview
The Simple Network Management Protocol (SNMP) Trap Adapter (Receiver) collects and 
parses SNMP traps and generates notifications to the Global Manager based on the 
contents of the traps. The Trap Adapter can receive SNMP v1, v2c, or v3 traps. However, it 
forwards only v1 or v2c traps. If SNMPv3 traps are received, they are converted to one of 
the other formats before being sent to a Domain Manager or to another trap receiver.


Two deployment scenarios are possible. The EMC Smarts Service Assurance Manager 
Deployment Guide provides more information.


Scenario 1: Single trap receiver associated with Adapter Platform


In Scenario 1, a single trap receiver listens for all traps from the network. 


Do not use this scenario in a production environment! This scenario may be employed for 
test or debug purposes when forwarding small numbers of traps to the Adapter Platform 
and possibly one other manager such as IP Availability Manager. 


In this scenario, you must edit the following files:


◆ The InCharge/SAM/smarts/conf/icoi/trapd.conf file to indicate the port and 
hostnames to forward the traps to. “Configuring trapd.conf (trap exploder and trap 
receiver)” on page 53 provides more information. 


◆ If you plan to receive SNMPv3 traps from the network, you must edit a seed file as 
explained in “Editing seed files” on page 50 load SNMPv3 agent credentials.


This trap receiver (ic-trapd-receiver) is the one that starts automatically if you install 
the SNMP Trap Adapter as a service. “Default sm_service parameters for the SNMP 
Trap Adapter” on page 79 provides more information.


◆ The InCharge/SAM/smarts/conf/icoi/trap-mgr.conf file to convert traps to 
notifications and send them on to the Adapter Platform. “Configuring the SNMP Trap 
Adapter to forward notifications” on page 58 provides more information.


◆ The ics-default.xml file to allow communication (forwarding of notifications) between 
the Adapter Platform and the Global Manager.


Scenario 2: Trap exploder forwards traps to a second trap receiver


In Scenario 2, there are two trap receivers. The first trap receiver, referred to as the trap 
exploder, receives all traps from the network and selectively forwards only those traps that 
meet certain configuration requirements. This scenario is the recommended deployment 
scenario. It may be employed when a large volume of traps comes from the network and 
you need to send traps to multiple Domain Managers as well as to a second trap receiver 
associated with Adapter Platform.
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To set up the trap exploder, configure the following files:


◆ Edit BASEDIR/smarts/conf/trapd/trapd.conf and specify the port to forward traps to 
as well as the hostname of the Domain Managers and Adapter Platform. (BASEDIR 
may be either InCharge/IP/ or InCharge/SAM/. The same trapd.conf file is shipped 
with both products.) “Configuring trapd.conf (trap exploder and trap receiver)” on 
page 53 provides more information.


◆ If you plan to receive SNMPv3 traps from the network, you must edit a seed file as 
explained in “Editing seed files” on page 50 in order to load SNMPv3 agent 
credentials. 


◆ Copy this seed file to the BASEDIR/smarts/conf/trapd path in the product (IP or SAM) 
where the trap exploder is running. For example, to start the trap exploder from the 
Service Assurance Manager:


▼Incharge/SAM/smarts/bin>sm_trapd --port=162 --rules=default 
--name=TRAP_EXPLODER --seed=seedfile▲


--rules=default uses the rules set located at 
BASEDIR/smarts/rules/trapd/trapParse.asl for parsing traps.


With SAM 9.2, the behaviour of sm_trapd option, --rules=default is changed so that it will 
no longer log received traps by default.


To enable logging of received traps, follow the procedure:


1. Goto BASEDIR/smarts/rules/trapd and type the following command to edit the 
trapParse.asl file:


./sm_edit <BASEDIR>/smarts/rules/trapd/trapParse.asl


2. Type the following command to change the setting of debug from FALSE to TRUE on 
line 25 in the trapParse.asl file:


debug = TRUE; /* Set to TRUE to enable printing of trap data */


3. Save the modified file and then restart sm_trapd.


To start the trap exploder as a service you must carry out a manual step in which you need 
to ensure the name is unique. 


For example:


▼ ▲ indicates the command must be typed as one line. Type the command from the 
BASEDIR/smarts/bin directory for the Service Assurance Manager product.


▼ /InCharge/SAM/smarts/bin/sm_service install --force --unmanaged
--startmode=runonce 
--description="EMC Smarts SNMP Trap Exploder Server"
--name=trap_exp


/InCharge/SAM/smarts/bin/sm_trapd                                                 
    --name=TRAP_EXPLODER 
    --config=trapd 
    --port=162
    --sport=9180
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    --seed=seedfile
    --rules=default 
    --output ▲


To configure the second trap receiver (associated with Adapter Platform), edit both files 
listed below:


◆ InCharge/SAM/smarts/conf/icoi/trapd.conf, as described in “Configuring trapd.conf 
(trap exploder and trap receiver)” on page 53.


◆ InCharge/SAM/smarts/conf/icoi/trap-mgr.conf file, as described in “Configuring the 
SNMP Trap Adapter to forward notifications” on page 58.


◆ Start the trap receiver associated with the Adapter Platform as a service (if not already 
installed as a service). “Default sm_service parameters for the SNMP Trap Adapter” on 
page 79 provides more information.
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Configuring the SNMP Trap Adapter to receive SNMPv3 traps
You may want to receive SNMPv3 traps from some of your network devices. The SNMP Trap 
Adapter supports the following SNMPv3 features:


◆ The ability to receive SNMPv3 traps, convert them to SNMPv2c, and forward them in 
SNMPv2c format to other elements of the EMC Smarts system such as IP Domain 
Managers or Adapter Platform.


◆ The use of the SNMPv3 User Security Model (USM) for authentication and privacy, as 
described in RFC-3414.


◆ The ability to load USM user credentials by using text files (similar in format to existing 
IP domain manager seed files).


◆ The use of authentication protocols MD5 and SHA-1 (RFC-3414).


◆ The use of privacy protocols DES (RFC-3414) and AES-128 (RFC 3826).


If the SNMPv3 network devices are configured to support authentication and encryption, 
you have to load the agent credentials by using a seed file to enable the SNMP Trap 
Adapter to receive the SNMPv3 traps.


Configuring the seed file to load SNMPv3 credentials


A seed file is used to load the SNMPv3 User Security Model (USM) data into the Local 
Credentials Database (LCD). The SNMP Trap Adapter recognizes SNMPv3 device entries by 
the engineID/userName pair for a given device listed in the seed file. 


A sample seed file is shipped with the Service Assurance Manager software in the 
InCharge/SAM/smarts/conf/icoi path. The format (syntax) of the seed file used for the 
SNMP Trap Adapter is the same as it is for an IP domain manager; however, there may be 
slight variations in field values when used for IP discovery. The EMC Smarts IP Manager 
User Guide provides specific seed file values required for the discovery process. 


“Editing seed files” on page 50 provides more details about editing seed file entries for 
use by the SNMP Trap Adapter.


If you plan to use the seed file for both IP discovery and for the SNMP Trap Adapter 
Scenario 1 (single trap receiver only), then ensure the seed file resides in two places: 


◆ InCharge/IP/smarts/conf


◆ InCharge/SAM/smarts/conf/icoi


If you plan to use the seed file for the SNMP Trap Adapter Scenario 2 (trap exploder), then 
ensure the seed file is in the following path (not in the InCharge/SAM/smarts/conf/icoi 
path mentioned above):


◆ BASEDIR/smarts/conf/trapd (where BASEDIR may be either InCharge/SAM/ or 
InCharge/IP/)


Be sure to use the sm_edit utility to edit the seed file so that passwords will be encrypted. 


Verify that the secret phrase used to re-encrypt the seed file matches for all products 
receiving traps from the SNMP Trap Adapter. The EMC Smarts System Administration 
Guide provides more information about configuring the secret phrase used to encrypt 
seed files.
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Although the SNMP Trap Adapter can parse plain text passwords from unencrypted seed 
files, EMC strongly recommends that all seed files be encrypted by using the sm_edit 
utility. The EMC Smarts System Administration Guide provides more information.


Editing seed files
The format of the seed file is identical to a standard IP Domain Manager seed file, but the 
semantics are slightly different. In IP, the sections are keyed by the hostname or IP 
address (the first line in each block). SNMPv3/USM uses the engineID of the SNMP agent 
in the network device to uniquely identify the agent which sent the trap. The hostname (or 
IP address) is ignored completely. For each engineID, there will be one or more users. The 
engineID/userName pair constitutes the unique key for the SNMP Trap Adapter seed file.


To receive SNMPv3 traps, you must uncomment and edit specific lines. For example, you 
must type a valid hostname or IP address, set the SNMPVERSION field to V3, and edit the 
seed file fields beginning with the comment: # The following are for SNMPv3 entries. 
Recommended practice is to place each SNMPv3 field/value pair on its own line. “Sample 
SNMPv3 seed file entries” on page 51 provides more information.


The first line in the seed file must appear as follows if you intend to encrypt both the 
AUTHPROTOCOL and PRIVPROTOCOL passwords:


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


When you edit the seed file by using the sm_edit utility, this line controls which field 
values in the seed file should be encrypted (for example, the AUTHPASS and PRIVPASS 
password fields).


The sm_edit utility may be invoked in a non-interactive mode by using the noedit option, 
for example:


sm_edit --noedit conf/trapd/seedfile


This will cause sm_edit to read the seed file, encrypt the fields specified by the first line, 
and write them back in an encrypted mode. 


While sm_trapd can parse plain text passwords from unencrypted seed files, EMC strongly 
recommends that all seed files be encrypted by using the sm_edit utility. Failure to encrypt 
the seed files (and destroy any plaintext intermediates) will expose plaintext passwords to 
anybody who can read the file.
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Sample SNMPv3 seed file entries


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


128.221.19.8 
SNMPVERSION=V3 
USER=shaAESUser 
AUTHPROTOCOL=SHA 
AUTHPASS=123ABC456#$%123abc456#$%
PRIVPROTOCOL=AES 
PRIVPASS=456123abc456#$%456123ABC456#$%
ENGINEID=0000000902000003E333C440


qa-gwipv6 
SNMPVERSION=V3 
USER=MD5DesUser 
AUTHPROTOCOL=MD5 
AUTHPASS=789ABC456#$%789abc456#$%
PRIVPROTOCOL=DES
PRIVPASS=789123abc456#$%789123ABC456#$%
ENGINEID=000000090200000F134B93C


Table 7 on page 51 lists and describes seed file fields for SNMPv3.


To simplify debugging of your network device configurations, EMC Corporation 
recommends that you first establish that SNMPv3 traps sent from the network device in 
noAuthNoPriv mode are processed correctly. When you are sure that it works, use 
authNoPriv and finally authPriv, after verifying correct operation at each step.


Table 7  SNMPv3-related seed file field descriptions


Field Description


AUTHPROTOC
OL


Specifies the authentication protocol in use by the network device sending the SNMPv3 traps. Valid 
entries include MD5, NONE, or SHA. For the SNMP trap processor, if no value is specified, it defaults 
to NONE.


Notice: The default value used in the discovery process by the IP Manager may differ. The EMC 
Smarts IP Manager Release Notes provide more information.


AUTHPASS Authentication password. This may be 64 characters long. EMC Corporation recommends the use of 
complex passwords (for example, a long string of uppercase or lowercase alpha characters, 
numbers, and special characters)


ENGINEID An engineID is a unique string identifying an SNMP engine. It does not uniquely identify a DEVICE, 
because technically, a device can host multiple SNMP agents. So, the engine ID is assigned to each 
agent, not device. 
If you have EMC Smarts IP Availability Manager running, you can use the sm_tpmgr -s <server name> 
--dump-agents command to find the engineIDs for those agents generating SNMPv3 traps in your 
network.


PRIVPASS Privacy (encryption) password. This may be 64 characters long. EMC Corporation recommends the 
use of complex passwords (for example, a long string of uppercase or lowercase alpha characters, 
numbers, and special characters).


PRIVPROTOC
OL


Privacy (encryption) protocol in use by the router sending the SNMPv3 traps. Valid entries include 
DES, NONE, or AES. If no entry, defaults to NONE.
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Encryption (Privacy) options supported in SNMPv3 seed file
The following seed file options are used to encrypt SNMPv3 traps coming from the network 
to the SNMP trap exploder (SNMP Trap Adapter):


◆ PRIVPASS 


◆ PRIVPROTOCOL


The EMC Smarts IP Manager User Guide and the EMC Smarts System Administration Guide 
provide additional information.


To enable the SNMPV3 Privacy Protocol and Privacy Password fields located in the Add 
Agent dialog box:


1. From the Add Agent dialog box, click Advanced Options.


The Advanced Options pane appears.


2. Select V3 from the SNMP Version field.


The SNMP V3 Specifications pane appears.


3. Select a privacy protocol from the Privacy Protocol field.


4. Type a password in the Privacy Password field.


5. Click OK.


Load the seed file into the Local Credentials Database (LCD)
Provide agent credentials to the SNMP Trap Adapter by loading one or more seed files 
using the importSeedFile.asl script. This script writes the content of the seed file to the 
LCD.


The sample startup script given above will cause the SNMP Trap Adapter to read in a 
pre-existing seed file when the program begins execution. This is most useful in a test 
environment, or in a fairly small and static installation. In a large network, it is expected 
that new devices will be added, and user credentials changed, on a regular basis. To 
accommodate this, the SNMP Trap Adapter can read seed files while it is running.


To read a new seed file, invoke the ASL script, importSeedFile.asl, and give a single 
command line option specifying the name of the seed file:


1. Go to BASEDIR/smarts/bin for the Service Assurance Manager product.


2. Type the following command:


▼sm_adapter -s TRAP-INCHARGE-OI -D seed=seedfile 
trapd/importSeedFile.asl ▲


▼ ▲ indicates the command must be typed as one line.


The seed file will be parsed, and the new USM credential data will be merged into the 
existing LCD. 
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Managing seed file updates
The seed file entries used by the SNMP Trap Adapter are keyed by engineID and userName 
pair. Any entry which has the same engineID and userName pair as existing data in the 
LCD will result in the new data overwriting the old.


In some cases, it may be convenient to split the USM credential data into several seed 
files (for example, one seed file corresponding to each of several IP domain managers). 
You may run importSeedFile.asl after for each seed file; and they will be read in turn. All of 
the data from all of the seed files is merged into a single LCD. If there are duplicate 
engineID and userName pairs between files, the last one read is the one which will be 
kept.


There is currently no way to delete a user from the LCD. In many instances, having obsolete 
user data in the LCD will cause no operational harm, and old entries can simply be 
ignored. If you want, you may import a seed file containing the obsolete engineID and 
userName pair with a non-matching password to effectively disable that entry. 


Configuring trapd.conf (trap exploder and trap receiver)
To configure the trap receiver to listen for traps, edit the trapd.conf file. There are multiple 
trapd.conf files shipped with the EMC Smarts product s. Table 8 on page 54 lists and 
describes the parameters in the trapd.conf file.


To determine which trapd.conf file to edit depends upon your deployment scenario:


◆ For Scenario 1 (single trap receiver), edit InCharge/SAM/smarts/conf/icoi/trapd.conf. 
For example, to forward traps to the IP Availability Manager, remove the # to 
uncomment the FORWARD line:


# Traps required by InCharge IP Availability Manager (AM)
#
# Generic: coldStart, warmStart, LinkUp, LinkDown
# FORWARD: *.*.*.* .* <0-3> * host:port
For example:
FORWARD: *.*.*.* .* <0-3> * AM_HOST-NAME:AM-PORT


where AM_HOST-NAME is the host on which IP Availability Manager is running and 
AM-PORT is the port on which the IP Availability Manager is listening for traps.


◆ For Scenario 2 (one trap exploder and one trap receiver), edit:


BASEDIR/smarts/conf/trapd/trapd.conf 


For example, to forward traps to both Adapter Platform and to the IP Availability 
Manager, remove the # to uncomment the FORWARD line. Add the hostnames and port 
numbers for the trap receiver associated with the Adapter Platform and any Domain 
Managers that should receive the traps:


FORWARD: *.*.*.* .* * * TRAP-ADAPTER_HOST-NAME:TRAP-ADAPTER-PORT
FORWARD: *.*.*.* .* <0-3> * AM_HOST-NAME:AM-PORT


where TRAP-ADAPTER_HOST-NAME is the host on which the trap receiver associated 
with Adapter Platform is running and TRAP-ADAPTER-PORT is the port (usually 162) on 
which the trap receiver is listening for traps.
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If the trapd.conf FORWARD entry has no community string, the community string in the 
incoming trap is preserved. 


If you want to forward traps with a different community string (for example, public), you 
must explicitly set the outgoing community string to public by editing the FORWARD entry. 
For example:


FORWARD: *.*.*.* .* <0-3> * host:port:public


Parameters in trapd.conf file


The trapd.conf file is located under:


◆ For Trap Adapter: <BASEDIR>/smarts/conf/trapd directory


◆ For Trap Exploder: <BASEDIR>/smarts/conf/icoi directory


You need to use sm_edit to edit the parameters in the trapd.conf file. Table 8 on page 54 
lists and describes the parameters in the trapd.conf file.


Table 8  Parameters in trapd.conf file (page 1 of 3)


Configuration file 
parameter Description Valid values


Applicable for 
Adapter or 
Exploder


PORT The UDP port number the trap adapter listens to. 
If NetView or OpenView is running on this system, during 
installation, the value is set to 9000, otherwise it is set to 162


0-65535 Adapter 


WINDOW This is the de-duplication window, in seconds. The maximum 
amount of time between receiving similar traps, before the 
second trap is considered unique. 
To disable de-duplication feature make all traps unique. That 
is, do not specify a value for this parameter or use zero. If a 
value is not specified for this parameter, or it is set to zero, 
de-duplication is disabled.


Non-negative 
integer 


Adapter


THREADS The number of trap processing threads to spawn. The 
determines how many traps can be processed concurrently. 
The maximum value is 25. If not set, the default value is 1.


0 - 25 Adapter and 
Exploder


ASCII This controls the formatting of non-printable characters. If the 
value for ASCII is set to FALSE or if “--ascii” is not specified on 
the commandline for starting sm_trapd, sm_trapd converts 
the entire value of that OID into a printable UTF-8 coding 
string, such as a varbind. For example, .1.3.6.1.4.1.333.1 -> 
"abcd012" is converted into .1.3.6.1.4.1.333.1 -> "61 62 63 
64 C3 96 30 31 32".
If the value for this parameter is set to TRUE or if “--ascii” is 
specified on the commandline for starting sm_trapd, 
sm_trapd replaces all the non-printable characters with an 
“X” followed by the HEX string of these characters using UTF 
coding. The remaining printable characters of the original 
value (octet-string) remain unchanged, such as the varbind. 
For example, .1.3.6.1.4.1.333.1 -> "abcd012" 
is then converted into .1.3.6.1.4.1.333.1 -> 
"abcdXC3X96012."


TRUE | FALSE Adapter and 
Exploder
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SOURCE This switch enables the trap processor to obtain the source 
address of the IP packet, and makes it available to the 
customer configurable .conf file and .asl scripts. If not set, 
value is FALSE.


TRUE | FALSE Adapter and 
Exploder


TAG Enables tagging of varbind values. When enabled, it streams 
the value's type before each value. For example, INTEGER-32 
3.


TRUE | FALSE Adapter and 
Exploder


QUEUE_LIMIT_MEGS This parameter helps limit the size of internal trap queue to 
the stated size. The limit is not exact - the queue may grow 
slightly larger than that. When the limit is reached, some traps 
will be discarded. The default value is set to 200 MB. On 
reaching this limit, the sm_trapd queue starts discarding 
traps. 
When the queue starts discarding traps, a 
trapdDiscardingTraps alert is generated, as defined in the 
trap_mgr.conf file. If and when a device is identified as the 
source of a trap storm, information about it is logged in the 
sm_trapd log file. The alert is cleared once the incoming trap 
rate to the sm_trapd reduces to a rate below which these traps 
can be processed by the queue.


Non-negative 
integer 


Adapter and 
Exploder


QUEUE_LIMIT_SECONDS Limit the time that a trap can remain in the internal trap 
queue. This limit is even less exact than the size limit above. 
In general, it is advisable to specify both. When traps start to 
remain in the queue exceeding the time limit set, some traps 
will be discarded. The default value is set to 480 seconds. 
When the queue starts discarding traps, a 
trapdDiscardingTraps alert is generated, as defined in the 
trap_mgr.conf file. If and when a particular device is identified 
as the source of a trap storm, information about it is logged in 
the sm_trapd log file. The alert is cleared once the incoming 
trap rate to the sm_trapd reduces to a rate below which these 
traps can be processed by the queue.


Non-negative 
integer 


Adapter and 
Exploder


ENABLE_FWD This parameter enables trap forwarding. Traps are only 
forwarded if a forwarding criteria is specified. See the 
FORWARD parameter for more information.


TRUE | FALSE Exploder


MATCH Determines whether traps are tested against all forwarding 
criteria or up to the first criterion that matches. If forwarding 
criteria is not specified, this parameter is ignored. Forwarding 
criteria is specified in this file using the FORWARD parameter. 
If not set, value is first.


all | first Exploder


TIMESTAMP_RCV When receiving a trap, whether to forward the time from the 
trap to ASL as the received time of the trap. The original 
behavior of the trap processor received timestamps of this 
format and this option allows that behavior. If set to FALSE 
this defaults to sending the timestamp from the trap itself 
which is in normal SNMP time format of hundredths of a 
second since device boot.


TRUE | FALSE Adapter and 
Exploder


Table 8  Parameters in trapd.conf file (page 2 of 3)


Configuration file 
parameter Description Valid values


Applicable for 
Adapter or 
Exploder
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FORWARD Specifies matching criteria for traps and the forwarding 
destinations for matched traps. Valid syntax is as follows: 


FORWARD<specific type> <<dest_opt> | 
<dest_entry>> \ [<<dest_opt> | <dest_entry>>...]


Where:
a. <dest_entry> is: <host>:<port> | 


<host>:<port>:<community>


<host> is one of the following:
<host name>[:<ipVersion>]
<fully qualified domain name>[:<ipVersion>]
<IPv4 address>[:<ipVersion>]"["<IPv6 address>"]"
<ipVersion> is: v4 | v6 | v4v6 | v6v4 or similar values with 
mixed case or uppercase letters.
<port> is an integer
<community> is a community string


b. <dest_opt> is "-nosmtrapaddr" | 
"-usesmtrapaddr"


dest_opt -nosmtrapaddr disables the addition of MIB 
variables representing the trap address type and trap 
address. dest_opt -usesmtrapaddr enables the addition 
of these MIBs. This is the default behavior. 
-nosmtrapaddr and -usesmtrapaddr apply to destination 
entries that occur after the option, until the end of the 
line or until a new option overrides the active option. 


Examples are provided below:
FORWARD: 192.168.250.<32-120> .* 6 * asterix:5000 
jupiter 
[3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002


Here, all specific traps received from network devices in the 
range from 192.168.230.32 to 192.168.230.120 will be sent 
to asterix port 5000, jupiter port 162 and 
3ffe:80c0:22c:109:214:4fff:fe39:a73d port 2002.


FORWARD: * .* * * snake:9099:public1


All traps received from all network devices will be sent to host 
snake port 9099.


Table 8  Parameters in trapd.conf file (page 3 of 3)


Configuration file 
parameter Description Valid values


Applicable for 
Adapter or 
Exploder
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Globbing can be used to specify values of the following fields: <address>, <OID>, <generic 
type>, <specific type>. Table 9 on page 57 lists and describes the fields:.


Some more examples:


◆ All traps from all IPv4 addresses are forwarded to IPv6 host gifted.yahoo.com on port 
2002:


FORWARD: *.*.*.* .* * * gifted.yahoo.com:v6:2002


◆ All traps from all IPv6 addresses are forwarded to IPv6 host gifted.yahoo.com on port 
2002:


FORWARD: *:*:* .* * * gifted.yahoo.com:v6:2002


◆ All traps from all IPv6 addresses are forwarded to IPv6 host with address 
3ffe:80c0:22c:109:214:4fff:fe39:a73d on port 2002:


Table 9  Field description


Field name Description


<address> Source IP address or host name of the SNMP agent sending the 
trap. Globbing can be used to specify ranges of IP addresses. 
Examples of valid values:
192.168.114.5 
3ffe:80c0:22c:109:214:4fff:fe39:a73d
*.*.*.* 
*:*:* 
192.168.*.*
3ffe:80c0:22c:*
*.*.*.168
*:*:a73d
192.168.<120-123>.*
3ffe:80c0:22c:109:214:4fff:<0-ffff>:*


 <OID>  Enterprise OID of incoming trap. Globbing can be used to specify 
ranges of OIDs. Examples of valid values:
.1.3.6.4.1.9 
.1.3.* 
.* 
.1.3.6.4.1.<1-18>.*


 <generic type> Generic type of incoming trap. Globbing can be used to specify 
ranges of trap numbers. Examples of valid values: 0, 3, <0-5>


 <specific type> Specific type of incoming trap, if valid. For standard (generic) traps 
this field is ignored. Globbing can be used to specify ranges of 
trap numbers. Examples of valid values:
733, <130-156>, *


<host <[:port] | 
[:port:community]>>


Destination to forward matched traps to. Multiple destinations can 
be specified. Host is specified as an IP address or a host name. 
Port and Community are optional; IPv6 addresses need to be 
enclosed in square brackets [] if omitted, port 162 is used and the 
community string of the incoming trap is preserved. Globbing 
cannot be used in this field. Examples of valid values: cobra, 
snake.planet.net:6789, 192.76.70.21, 
[3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002, 
192.168.70.190:6789

Configuring trapd.conf (trap exploder and trap receiver) 57







EMC Smarts SNMP Trap Adapter

FORWARD: *:*:* .* * * [3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002


◆ All traps from all IPv4 addresses are forwarded to IPv6 host gifted.yahoo.com on port 
2002, smarts OIDs smTrapAddress and smTrapAddressType are not added when 
forwarding.


FORWARD: *.*.*.* .* * * -nosmtrapaddr gifted.yahoo.com:v6:2002
◆ All traps from all IPv6 addresses are forwarded to IPv6 host gifted.yahoo.com on port 


2002, smarts OIDs smTrapAddress and smTrapAddressType are not added when 
forwarding.


FORWARD: *:*:* .* * * -nosmtrapaddr gifted.yahoo.com:v6:2002


◆ All traps from all IPv6 addresses are forwarded to IPv6 host with address 
3ffe:80c0:22c:109:214:4fff:fe39:a73d on port 2002, smarts OIDs smTrapAddress 
and smTrapAddressType are not added when forwarding.


FORWARD: *:*:* .* * * -nosmtrapaddr 
[3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002


◆ All traps from all IPv4 addresses are forwarded to IPv4 host amtest.smarts.com (on the 
default SMTP port) and IPv6 host gifted.yahoo.com (on port 2002). MIB variables 
smTrapAddress and smTrapAddressType are added when forwarding to 
amtest.smarts.com (default behavior). The same OIDs are not added when forwarding 
to gifted.yahoo.com, due to the -nosmtrapaddr option that precedes this destination 
entry.


FORWARD: *.*.*.* .* * * ipam.smarts.com:v4:2002 -nosmtrapaddr 
gifted.yahoo.com:v6:2002


Configuring the SNMP Trap Adapter to forward notifications
Table 10 on page 59 describes the files that you use to configure the SNMP Trap Adapter 
to forward notifications on to the Global Manager. 


You can define up to 25 trap processing threads in your local trapd.conf file, which 
includes a definition and default value for THREADS.  Running a multi-threaded trap 
adapter may eliminate the need to send these traps to a forwarder. 


To configure the SNMP Trap Adapter, complete the following steps:


1. Define the traps that you want to forward to the Global Manager in your local copy of 
trap_mgr.conf file.


2. Set up the proper security between the Adapter Platform and the SNMP Trap Adapter. 
“EMC Smarts SNMP Trap Adapter security” on page 39 provides more information.


3. Verify the port setting for the SNMP Trap Adapter. “Verifying the SNMP Trap Adapter 
port setting” on page 72 provides more information.


4. Configure the SNMP Trap Adapter to start and stop automatically.
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5. Start the SNMP Trap Adapter. “Starting and stopping the SNMP Trap Adapter” on 
page 79 provides more information.


Overview of trap_mgr.conf 


The trap receiver uses the trap_mgr.conf configuration file to translate incoming traps into 
notifications that are sent to the Global Manager. You need to use sm_edit to edit 
trap_mgr.conf (found at BASEDIR/smarts/conf/icoi) to define the traps that you want to 
send to the Global Manager. For situations requiring more advanced trap processing, an 
ASL script can be called for specific traps.


The trap_mgr.conf file contains several sections: 


◆ The beginning of the file includes comments regarding the syntax of the file.


◆ The first line of code sets the BATCH_NOTIFY_INTERVAL. “SNMP trap batching” on 
page 72 provides more information about this interval.


◆ A default section, which lists default values for the fields. If, for a given trap, no value 
is set for a field, the value from the default section is used. This section begins with 
BEGIN_DEFAULTS and ends with END_DEFAULTS.


◆ Trap definition sections, which define mappings of information for specific traps or 
groups of traps. There can be one or more trap definition sections. Each section 
begins with BEGIN_TRAP and specifies the trap mapping by OID, generic trap number, 
and specific trap number. Each trap definition ends with END_TRAP. 


“Default trap parameter section” on page 61 provides more information. “EMC Smarts 
MIB for SNMP Traps” on page 105 includes the EMC Smarts MIB implemented by EMC 
Corporation for SNMP traps.


SNMP trap example
Figure 6 on page 60 shows an example of a simple trap and how values in the trap might 
populate fields in a Service Assurance notification. In this example, the SNMP trap 
consists of five values:


◆ Enterprise OID


◆ Generic Trap Number


◆ Specific Trap Number


◆ System Name


The system name sent by the trap translates into the instance name. 


◆ Varbind 1


Varbind 1 translates into a text message for the notification.


Table 10  SNMP Trap Adapter configuration and script files


Directory under 
BASEDIR/


Filename User 
editable


Description


smarts/conf/icoi trap_mgr.conf Yes Used to map incoming SNMP traps to 
notifications, and to configure 
notification batch parameters.
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Other fields in the notification get populated from values placed in the configuration file. 
For example, the ClassName is Host not because the information was sent with the trap, 
but because an association was made in the configuration file.


Figure 6  Translation of SNMP trap to standard notification


The following is an example of a portion of the configuration file used by the SNMP Trap 
Adapter. This example corresponds to Figure 6 on page 60. When the trap matches a trap 
definition (Enterprise OID, generic trap number, and specific trap number), the Adapter 
Platform populates attributes in a notification based on entries in the trap definition. In 
the example, the standard notification attribute ClassName is populated with the value 
Host:


BEGIN_TRAP  .1.3.6.1.4.1.2.1  0  0
ClassName:Host
InstanceName:$SYS$
EventName:Cold Start
Severity: 5
EventType:MOMENTARY
EventText:Agent $SYS$ restarted, reason=$V1$
END_TRAP


.1.3.6.1.4.1.2.1 0 0 HostNYC8 Operator requested reboot


SNMP Trap (simplified)


.1.3.6.1.4.1.2.1


0


0


HostNYC8


Operator requested 
reboot


Enterprise OID


Generic Trap Number


Specific Trap Number


System Name


Varbind 1


Incoming SNMP Trap 


Cold Start


HostNYC8 InstanceName


EventName


Host ClassName


EventTypeMOMENTARY


EventText


Agent HostNYC 
restarted, 


reason=Operator 
requested reboot


Severity5


Standard Notification Fields 


For this example, no translation into any standard 
notification fields. These fields are used as keys 
to the configuration file.
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Default trap parameter section
The format of the default section is as follows:


BEGIN_DEFAULTS
ClassName:SNMPTrap
InstanceName:$SYS$
EventName:$E$ $N$ $S$
Severity: 2
EventText:Varbinds: $V*$
Expiration:7200
State: NOTIFY
InMaintenance:FALSE
ClearOnAcknowledge:TRUE
EventType:MOMENTARY
SysNameOrAddr:$A$
UnknownAgent:IGNORE
LogFile: NONE


END_DEFAULTS


You should neither delete nor move the BEGIN_DEFAULTS section of this file. This section 
defines what parameters will be sent for each trap if not specified in subsequent trap 
definition sections of the file. Also, the Map and Aggregate fields are not supported in the 
Default Trap Parameter section.


The default section demonstrates that you can use variables in descriptions. Of particular 
note is the use of the varbind variable with an asterisk for the EventText parameter. In this 
case, EventText stores the value of all of the varbinds associated with a trap. By defining 
LogFile, the SNMP Trap Adapter logs all of the traps unless a trap’s LogFile is defined as 
NONE.


Trap definition sections
The configuration file contains multiple trap definitions. Each definition specifies what set 
of traps are processed by the trap definition and what notification values are set for those 
traps. Incoming SNMP traps are matched against trap definitions in a configuration file. 


The beginning of each trap definition starts with BEGIN_TRAP. Each incoming trap is 
identified by three fields following BEGIN_TRAP. These fields are: Enterprise OID, generic 
trap number, and specific trap number. The format of the first line is:


BEGIN_TRAP <enterprise> <generic_trap> <specific_trap>


Each of the fields need to be separated by either a space or a tab. The first field contains 
the Enterprise OID. The first six numeric values in this field are expected to conform to 
either the standard Enterprise (vendor) prefix of 1.3.6.1.4.1 or the standard MIB-II 
(generic) prefix of 1.3.6.1.2.1. However, the SNMP Trap Adapter does not restrict you to 
these numeric values. The first field can be any valid OID number or the string ’any’ (or *).


You can specify a range or use wildcards in the range. For example, you can specify a range 
as .1.3.6.1.4.1.<4-10> where the last numeric value can be within the range of 4 through 
10. In the example 1.3.6.1.4.1.*, the “*” character matches any number for the last OID 
numeric value.


Additionally, you can list multiple OIDs at the beginning of each trap definition. Specifying 
multiple OIDs allows the same trap definition to be used for multiple traps. The following 
example demonstrates listing multiple OIDS, specifying a numeric value range, and using 
a wildcard: 
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BEGIN_TRAP .1.3.6.1.4.1.1.2.<23-40> 6 1 .1.3.6.1.4.1.6.* 6 1 


Trap definitions are read from left to right. For example, suppose a configuration file 
includes multiple trap definitions such as:


BEGIN TRAP .1.2.3.4.5.6.*   *  2
BEGIN TRAP .1.2.3.4.5.6.*   1  *


Your system receives a trap with the definition:


BEGIN TRAP .1.2.3.4.5.6.*   1  2


The trap matches both trap definitions included in the configuration file. However, 
because traps definitions are read from left to right, the second trap definition is used for 
the trap.


SNMP trap parameters


The trap definition follows the BEGIN_TRAP line. The trap definition is the set of values for 
specified notification attributes that are placed in the Service Assurance notification. You 
can define these values in any order. The syntax of a line from the trap definition is:


<notification_attribute>:  <value>


Table 11 on page 62 shows the complete list of parameters to use in a trap definition and 
in the BEGIN_TRAP line. Each trap definition ends with END_TRAP. 


If no parameter values are set within a trap definition BEGIN_TRAP section, the values set 
in the BEGIN_DEFAULT section are used.


Table 11  Trap definition parameters (page 1 of 4)


Configuration file 
parameter


Corresponding standard notification attribute or 
description Valid values


ASL For advanced SNMP trap integration, this defines 
the ASL rule set file used to perform additional 
processing, which may include additional 
variable substitution. The ASL rule set must be 
located in 
BASEDIR/smarts/local/rules/icoi_trapd. (A 
sample rule set is available in my_trap-rules.asl.) 
The ASL processing overwrites any values set in 
the trap definition section.


Filename
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Aggregate For advanced SNMP trap integration, this defines 
the mapping of a trap definition to an aggregate 
notification. One or more component 
notifications comprise an aggregate notification.
“Using the Trap Adapter Aggregate parameter” 
on page 69 provides details and examples.


Notice: The Aggregate field is not supported in 
the Default Section of the file.


Special
• EventName:<string>


This is the name of the aggregate 
notification and is required.


• ElementName:<object-handle>
An object-handle identifies the 
InstanceName and the CreationClassName 
of an element.
This is the name of the topology element 
where the aggregate is defined. This field 
is optional. If this field is not defined, the 
ElementClassName and ElementName of 
the trap definition are used, if available. 
Otherwise, the ClassName and 
InstanceName of the trap definition are 
used.
If you define this field and specify an 
object-handle that does not exist in the 
topology, then the aggregate is not 
created.


• EventText:<string>
This is the description of the aggregate 
notification (event). This field is optional.


Category Category Any string


ClassName ClassName and DisplayClassName Any string


ClearOnAcknowledge ClearOnAcknowledge TRUE or FALSE


Discard Discard the event information captured by the 
trap:
• YES discards event information.
• NO saves event information.
• IF_MANAGED allows a discard of the event 


information if the device is managed by 
another connected server, thus avoiding 
possible duplicate event information from 
both servers.


YES, NO, or IF_MANAGED


Notice: IF_MANAGED requires that the ICOI 
server subscribes to all underlying IP servers 
for consideration to determine if the device 
that originated the trap is managed.


ElementClassName ElementClassName Valid Class Name in EMC Smarts topology.


ElementName ElementName Valid Instance Name in EMC Smarts topology. 
If you set the UnknownAgent to CREATE, then 
the instance does not have to previously 
exist.


Notice: If the UnknownAgent parameter is 
configured to CREATE, the ElementClassName 
and ElementName parameters must be 
defined in the trap_mgr.conf file.


EventName EventName (describing the notification) and the 
EventDisplayName


Any string


EventText EventText Any string


Table 11  Trap definition parameters (page 2 of 4)


Configuration file 
parameter


Corresponding standard notification attribute or 
description Valid values
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EventType EventType:
• MOMENTARY sends notifications of events 


with no duration, such as a coldStart trap. 
Clears after the Expiration interval.


• DURABLE sends notifications of events with 
an active and inactive state, such as linkDown 
and linkUP traps.


MOMENTARY or DURABLE


Expiration Defines the expiration time in seconds for the 
notification. Zero indicates that the notification 
will not expire. 7200 is the default value. 
If you use zero, you should use some method to 
eventually clear the notification. For example, 
you can configure the SNMP Trap Adapter to 
send clear state notifications or set the 
ClearOnAcknowlege parameter to TRUE.


Integer 


ForceOccurredOn Overwrite the ElementClass or ElementName to 
modify the OccurredOn object. 


Notice: If ElementClass and ElementName are 
undefined, the trap defaults to the Agent name if 
it is defined.


TRUE or FALSE


InMaintenance InMaintenance TRUE or FALSE


InstanceName InstanceName (of the object associated with the 
notification) and InstanceDisplayName.


Any string


LogFile The name of the file used by the SNMP Trap 
Adapter to log information for this trap. If this 
parameter is NONE or undefined, no information 
is logged. If this parameter is undefined, the 
default value is used.


Notice: Log files contain any error messages with 
line numbers of the trap_mgr.conf to help you 
find and correct the error. 


Filename


Map Map is a special field that enables you to map 
varbinds to one or more printable strings. “Using 
the Map parameter” on page 67 and “Using the 
Map parameter with tags” on page 68 provide 
more information and examples of how to map 
varbind values.


Notice: The Map field is not supported in the 
Default Section of the file.


Special


Severity Severity Any integer from 1 to 5


State Describes the state of the notification. NOTIFY or CLEAR


SysNameOrAddr A valid value describes either the system name 
or address of the entity that sent the trap. Values 
for this parameter override values in 
ElementClassName and ElementName.


Any string


Table 11  Trap definition parameters (page 3 of 4)


Configuration file 
parameter


Corresponding standard notification attribute or 
description Valid values
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In Figure 6 on page 60 and the corresponding trap definition, certain values in the SNMP 
trap were used as attribute values in the notification. This is accomplished through the 
use of variable substitution. SNMP variable bindings (varbinds) are placeholders for 
information common to standard SNMP traps and can be assigned to Service Assurance 
notification attributes within the trap definitions in the trap_mgr.conf file. The following 
two lines are taken from the trap definition based on Figure 6 on page 60 that use variable 
substitution:


InstanceName:$SYS$
EventText:Agent $SYS$ restarted, reason=$V1$


The attribute InstanceName is populated with the value of a variable $SYS$. The contents 
of this variable come from the incoming trap. In this example, $SYS$ is the name of the 
system where the trap originated, and $V1$ represents the value of the first varbind. 
Table 12 on page 65 describes the variables available for basic SNMP trap integration. 
When specifying a variable, it must be enclosed within dollar signs ($).


TrapSource Define the name of your trap processor so that it 
more closely identifies the function or form of 
your traps. The default name isTrap Processor. 


Any string


UnknownAgent Describes whether Adapter Platform should 
ignore traps related to unknown topology 
elements or create elements for the traps.


CREATE or IGNORE


Notice: If the UnknownAgent parameter is 
configured to CREATE, the ElementClassName 
and ElementName parameters must be 
defined in the trap_mgr.conf file.


UpdateUD Update the user-defined trap and data with a 
CLEAR.


TRUE or FALSE


UserDefined1-10 UserDefined1-10 Any string


Table 11  Trap definition parameters (page 4 of 4)


Configuration file 
parameter


Corresponding standard notification attribute or 
description Valid values


Table 12  SNMP Trap Adapter variables (page 1 of 2)


Variable Description


$A$ Address of the agent sending the trap.


$C$ Community string of the SNMP trap.


Notice: To use this variable, you must start the trap adapter with the --community option.


$E$ Enterprise OID of the SNMP trap.


$N$ Generic trap number of the SNMP trap.


$S$ Specific trap number of the SNMP trap.


$SRC$ Source, or originator, of the IP address for the trap. A V1 trap may return the source IP address of the 
relay agent for the trap.


Notice: To use this variable, you must specify the --source parameter.
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Example of set and clear notification
The following example illustrates how to configure the notification and clear an event. One 
trap creates a state of NOTIFY, while the other creates a state of CLEAR:


BEGIN_TRAP  .1.3.6.1.4.1.10.1.9.5.1  6  1
ClassName:Port
InstanceName:$SYS$ PORT $V1$
EventName:lerAlarmOn
Severity: 3
EventText:This is a longer text message
EventType:DURABLE
Category: Performance
State: NOTIFY
END_TRAP


BEGIN_TRAP  .1.3.6.1.4.1.10.1.9.5.1  6  2
ClassName:Port
InstanceName:$SYS$ PORT $V1$
EventName:lerAlarmOn
State: CLEAR
END_TRAP


Notifications are uniquely identified by using the three attributes: ClassName, 
InstanceName, and EventName. In the example, the second trap definition will clear an 
event created with the first trap definition when the values of the three key fields are 
identical. 


$SYS$ System where the SNMP trap originated.


$T$ Timestamp of the SNMP trap.


$V<n>[-<tag>]$ 
or


$OID<n>[-<tag>]$
or


$V<*>$
or


$OID<*>$


Value of the <n>th varbind. The varbind may contain one of the following data types: integer, 
bit-string, octet-string, IP address, counter, gauge, unsigned integer, time ticks, counter 64, obj id, 
opaque, or null.
Optionally, you can use a text string to tag the value of the <n>th varbind for multiple mappings.
You can also use an asterisk <*> to specify all varbinds.


Table 12  SNMP Trap Adapter variables (page 2 of 2)


Variable Description
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Using the Map parameter
The format of the Map parameter is:


Map: {
V<n>
 <value_a>= <string>
 <value_b>= <string>
}
{
V<n>
 <value_c>= <string>
 <value_d>= <string>
}


You cannot specify a variable within the definition of a Map parameter.


The format of the Map parameter requires a space after the equal sign (=). For example, 
<value_a>= <string>.


The following example shows how the Map parameter could be used to substitute text for 
two different varbind values:


BEGIN_TRAP .1.3.6.1.4.1.10 6 0
ClassName: Host
InstanceName: $SYS$
EventName: Coldstart
Severity: 5
EventText: Reason - $V1$
Expiration: 30
State: NOTIFY
UserDefined1: Community String: $C$
ClearOnAcknowledge:TRUE
Map: {


V1
 1= UP
 2= DOWN
}


EventType: DURABLE
UnknownAgent: CREATE
ElementClass: Router
ElementInstance:$SYS$
LogFile: Coldstart.log


END_TRAP


In the example, the Map parameter describes how the enumeration values of the first 
varbind translate into printable strings. These printable strings are substituted as values 
in EventText. If a SNMP trap had a value of one for its first varbind, the phrase “Reason - 
UP” would be placed in EventText.


If a map is not defined for a specific varbind, the SNMP Trap Adapter uses the varbind’s 
integer value. In the example, the integer “1” would be used instead of the text “UP,” so 
the phrase “Reason -1” would be placed in EventText.


For a trap to clear, the InstanceName and ElementInstance parameters must be set to the 
same type.
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Using the Map parameter with tags
Each incoming trap is identified by three fields: Enterprise OID, generic trap number, and 
specific trap number. Some SNMP agents send traps with the same combination of OID, 
generic, and specific trap numbers but for different reasons. When this occurs, the only 
way to differentiate the meaning of the trap is to examine the varbinds. You can use the 
$V<n>-[<tag>]$ variable to map varbind values to different text strings.


The format of the Map parameter when using tags is as follows:


Map: {
V<n-tag1>
 <value_a>= <string1>
 <value_b>= <string2>
 default= <string3>
}
{
V<n-tag2>
 <value_a>= <string4>
 <value_b>= <string5>
 default=
}
}
V<n-tag3>
 <value_a>= <string6>
 <value_b>= <string7>
 default=


The following example defines two $V<n>-[<tag>]$ variables, one for substitution of 
ClassName and another for substitution of EventName:


BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 
ClassName: $V2-class$
EventName: $V2-event$


.


.


.


The mapping defines when to map the appropriate tags to the varbinds.


.


.


.
Map: {


V2-class
.1.3.6.1.4.1.546.1.1.7.9.30.0= Memory
.1.3.6.1.4.1.546.1.1.7.9.2.0= Processor
default=Host
}
{
V2-event
.1.3.6.1.4.1.546.1.1.7.9.30.0= NotEnoughMem
.1.3.6.1.4.1.546.1.1.7.9.2.0= HighUtilization
default= TrapReceived
}


If the incoming trap has a Varbind 2 value of .1.3.6.1.4.1.546.1.1.7.9.30.0, then Memory 
is used for the ClassName and NotEnoughMem is used for the EventName. If the incoming 
trap has a Varbind 2 value of .1.3.6.1.4.1.546.1.1.7.9.2.0, then Processor is used for the 
ClassName and HighUtilization is used for the EventName. The default, Host, is used for 
the ClassName and the default, TrapReceived, is used for the EventName for incoming 
traps with any other Varbind 2 values. If a default is not specified, the original value for the 
Varbind 2 is returned.
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Using the Trap Adapter Aggregate parameter
An aggregate notification is a notification that is composed of one or more component 
events. When one of the component events occurs, the aggregate notification is notified. 
Creating an aggregate notification provides several benefits:


◆ Aggregation compresses multiple component events into a single aggregate 
notification.


◆ Aggregation helps you organize related traps into meaningful categories.
◆ Aggregation provides a method by which the details of the component events can be 


displayed to an operator. The component events of an aggregate notification are 
displayed in the Aggregate tab of the Notification Properties window of the Global 
Console.


You use the aggregate in your trap definition to create an aggregate notification as well as 
the aggregate’s component events. You are required to define an EventName for each 
aggregate or component event. Because all notifications are uniquely identified by 
EventName and the ClassName, and the InstanceName it OccurredOn, values must also 
be derived for the two latter attributes. EMC Corporation recommends that you explicitly 
define the ElementName:<object-handle> within the Aggregate portion of the trap 
definition. If you do not explicitly define the ElementName within the Aggregate portion, 
then the ElementClassName and ElementName of the trap definition are used, if 
available. Alternatively, if ElementName and ElementClassName are not defined, then the 
ClassName and InstanceName are used to define the aggregate. 


The following example illustrates how to configure two different trap definitions to 
generate the same aggregate notification. The first trap definition processes an incoming 
trap that indicates a system is experiencing low memory. The second trap definition 
processes an incoming trap that indicates that a system’s processor is experiencing high 
utilization. As both traps indicate system degradation, if either trap is received, a 
notification is generated to indicate that the system is degraded: 


BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 1
ClassName: Memory
InstanceName: MEM-$SYS$
EventName: Low
Aggregate: {


  EventName:Degraded
  ElementName:$SYS$


}
Severity: 1
Expiratiton: 30
State: NOTIFY
ClearOnAcknowledge:TRUE


END_TRAP
BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 2  


ClassName: Processor
InstanceName: PRO-$SYS$
EventName: HighUtilization
Aggregate: {


  EventName:Degraded
  ElementName:$SYS$


}
Severity: 1
Expiratiton: 30
State: NOTIFY
ClearOnAcknowledge:TRUE


END_TRAP
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Using the example, if a trap with OID .1.3.6.1.4.1.546.1.1 6 1 is received from 
Router::CoreRouter1, the component event Memory::MEM-CoreRouter1 Low is generated. 
Similarly, if a trap with OID .1.3.6.1.4.1.546.1.1 6 2 is also received from the same router, 
then the component event Processor::PRO-CoreRouter1 HighUtilization is generated. 
Because the same aggregate is defined for both of these traps, this will also generate the 
aggregate notification, Router::CoreRouter1 Degraded. 


Although all events are propagated to the Service Assurance Global Manager, only the 
aggregate notification (Router::CoreRouter1 Degraded) will appear in the Global Console. 
This is because the default NotificationList used by the Global Manager is configured to 
filter out the component (raw trap) events. If desired, the Global Console operator can 
display the component events from the Notification Properties window by clicking the 
Aggregate tab.


Advanced SNMP trap integration


For more sophisticated SNMP trap processing, you can define an ASL script in a trap 
definition that is invoked during the processing of the trap. To define an ASL script, you 
add the keyword ASL, followed by the ASL script name, to the trap definition. For example:


BEGIN_TRAP  .1.3.6.1.4.1.9.10.1  0  0
ClassName:   System
ASL:         my-trap-rules.asl
InstanceName:$SYS$
EventName:   ColdStart
Type:        MOMENTARY


END_TRAP


Notification attribute values are initially determined by the trap definitions. If an attribute 
value has not been defined by a trap definition, then the value for the attribute will come 
from the default section. The notification attribute values are exported from within the ASL 
script. The ASL script can override default attribute values. After the ASL script completes, 
the notification is created with those sets of values.


The ASL script relies on two special types of variables: input/output and input-only. 
Input/output variables correspond to attributes of the notification and the parameters in 
the configuration file. The input-only variables correspond to the variables used in the 
configuration file (for example, $SYS$, $V4$, and $N$).


A DISCARD_TRAP variable is included with the input/output variables. The variable 
controls whether a given trap message is discarded or processed. The default value for 
this variable is “NO,” which means the trap must be processed. To override the default 
and discard the trap, create a rule in the functional loop of the hook script in 
my_trap_rules.asl to process the trap, and within this rule set the DISCARD_TRAP to “YES.”


To run the ASL script, you must place it in the BASEDIR/smarts/local/rules/icoi-trapd 
folder. Further, ensure that you include the hook script in the trap definition in the 
trap_mgr.conf file for the hook script to be invoked for a particular OID.
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Example of ASL script to set EventText
In the following example, ASL script extracts the substring “Agent Restarted for Reason:” 
from the contents of a trap’s first varbind, and places the remaining string into the 
notification attribute EventText. In the script, a list of all of the input and output variables 
as well as the input-only variables precedes the start of the processing (START). 


Only the variables used by the script need to be declared:


/*
 * The first variable binding is a string of the form:
 * "Agent Restarted for Reason: <text to extract>"
 */


// Input/Output variables.


CLASSNAME = "";
INSTANCENAME = "";
EVENTNAME = "";
AGGREGATE = "";
SEVERITY = "";
EVENTTEXT = "";
CATEGORY = "";
COMMUNITY = "";
DISCARD = "";
FORCEOCCURREDON = "";
UPDATEUD = "";
EXPIRATION = "";
STATE = "";
INMAINTENANCE = "";
CLEARONACKNOWLEDGE = "";
TRAPSOURCE = "";
EVENTTYPE = "";
MAP = "";
ASL = "";
ELEMENTCLASSNAME ="";
ELEMENTNAME ="";
SYSNAMEORADDR ="";
UNKNOWNAGENT ="";
LOGFILE ="";
USERDEFINED1 = "";
USERDEFINED2 = "";
USERDEFINED3 = "";
USERDEFINED4 = "";
USERDEFINED5 = "";
USERDEFINED6 = "";
USERDEFINED7 = "";
USERDEFINED8 = "";
USERDEFINED9 = "";
USERDEFINED10 = "";
DISCARD_TRAP = "YES";


// Input Variables


TIMESTAMP = "0";
IPADDRESS = "";
ENTERPRISE = "";
GENERIC = "9999";
SPECIFIC = "9999";
V1 = "";
V2 = "";
V3 = "";
V4 = "";
V5 = "";
V6 = "";
V7 = "";
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V8 = "";
V9 = "";
V10 = "";
V11 = "";
V12 = "";
V13 = "";
V14 = "";
V15 = "";
V16 = "";
V17 = "";
V18 = "";
V19 = "";
V20 = "";


START {
PARSE_EVENT_TEXT


}


PARSE_EVENT_TEXT {
input = V1;
..  "Reason:"  EVENTTEXT: rep(word)  eol


}


The processing of the trap’s first varbind occurs in the rule PARSE_EVENT_TEXT. The input 
to the rule is the contents of the first varbind. The line after the input reads all text up to 
and including “Reason:”. The rest of the string is assigned to the variable EVENTTEXT. Any 
change to the value of the input/output variables automatically gets placed in the 
corresponding attribute in the translated Service Assurance notification. EMC Smarts ASL 
Reference Guide provides more information about ASL.


Verifying the SNMP Trap Adapter port setting


The default value for the SNMP Trap Adapter (trap receiver) port is 9000. The EMC Smarts 
System Administration Guide provides more information about how to change this default 
value, and about how to modify runtime parameters for an application.


SNMP trap batching


By default, the SNMP Trap Adapter immediately converts traps it receives (that match a 
trap definition) into new Service Assurance notifications or into updates to existing 
Service Assurance notifications and forwards them on to the Global Manager. SNMP trap 
batching refers to a process where the Adapter Platform Server waits for a specified period 
of time before forwarding re-notifications (updated notifications) to the Global Manager.


In case of high frequency of traps, you can use batching to improve performance of clients 
processing the converted Service Assurance notifications. You configure batching by 
editing your local copy of trap_mgr.conf file so that traps renotifying an event are held for a 
specified period of time. After that time is exceeded, only the most recent trap of those 
bearing the same notification name is sent to the Global Manager.


To set the batch parameter, use sm_edit to open 
BASEDIR/smarts/local/conf/icoi/trap_mgr.conf, and type the period of time in seconds 
you want the trap receiver to wait before forwarding re-notifications to the Global 
Manager. The following text shows the section where you set the batch parameter. By 
default, the batch setting is 10 seconds. To disable batching, specify zero (0):
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# This interval (in seconds) will be used to batch updates to # 
notifications. In case, where a high frequency of
# notifications occur, batching will improve performance.
# Setting this interval to 0 will disable batching.


 BATCH_NOTIFY_INTERVAL = 10


Using keywords in trap_mgr.conf


Table 13 on page 73 lists and describes keywords that you can set in your local 
trap_mgr.conf.


Table 13  Keywords in trap_mgr.conf (page 1 of 4)


Keyword Description Option or format


BATCH_NOTIFY_INTERVAL Allows you to set an interval (in seconds) to 
batch updates to notifications. In case, where a 
high frequency of notifications occurs, batching 
improves performance. To disable batching, set 
this interval to 0.
For example:


BATCH_NOTIFY_INTERVAL = 10


Any integer


CACHE_HOSTS
Notice: Use this CACHE_HOSTS keyword only if 
the “RESOLVE_IP” keyword is TRUE.  


Allows you to determine whether the system 
hosts will be cached and used to resolve IP 
addresses instead of calling the system 
functions, which may be slow in some cases.


Notice: This is ONLY useful if DNS name 
resolution is disabled in the EMC Smarts 
environment. This is sometimes done to improve 
performance, but it requires an extensive hosts 
table. By altering the “HOSTS_PATH” keyword, 
you can use a special file to load the hosts cache 
instead of using the same hosts file used by the 
system that the trap processor is running on.


For example:
CACHE_HOSTS = FALSE


TRUE or FALSE


DEBUG Allows you to generate status messages, which 
you can use to debug the trap 
processor—without updating the 
trap_mgr_parse.asl. When DEBUG is set to TRUE 
in your local trap_mgr.conf, verbose status 
messages are generated, and your trap processor 
runs slower while the log grows faster. 
For example:


DEBUG = FALSE


TRUE or FALSE
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HOSTS_PATH
Notice: Use this HOSTS_PATH keyword only if 
“CACHE_HOSTS” is TRUE.


Allows you to define the full path to the system 
hosts file.  (You can use a unique file for the 
cache by specifying its path here.)
For example:


HOSTS_PATH = /etc/hosts


Path name


IMPORT Allows you to access external information or 
processes for processing traps—without editing 
ASL scripts. You can use the IMPORT keyword in 
your local trap_mgr.conf to load tables, or any 
other pre-processor driver scripts. To load import 
drivers and lookup tables, you can replicate the 
IMPORT keyword as many times as necessary. 
For example: 


IMPORT TRUE TRUE driver1 import_rules.asl 
local/conf/someinput.txt |


The format is as follows:
IMPORT <wait> <auto-reload> 
<driver-name> <rules-file> 
[<input-file>] ... [<field-separator>]


where:
• <wait> is TRUE or FALSE. Set the Trap 


Processor to wait for the driver to 
exit.


• <auto-reload> is TRUE or FALSE. Set 
the Trap Processor to start this driver 
using a --reloadConfig call.


• <driver-name> is simple string used 
to name the driver.


• <rules-file> is the name of the rules 
file located in rules/icoi-rules.


• <input-file> is optional. Set the path 
to an input file from $SM_SITEMOD.


• <field-separator> is optional. Set the 
field separator character.


LOGGING Allows you to generate status messages, which 
you can use to capture information about the 
trap processor. When LOGGING is set to OFF, for 
example, in your local trap_mgr.conf, error 
messages are generated and sent to the log file. 
For example: 


LOGGING = OFF


ALL, DISCARD, STATUS, and OFF:
• ALL logs all messages about traps 


received and discarded, as well as 
server status.


• DISCARD logs messages about 
discarded traps and server status.


• STATUS logs messages about 
changes to the server status.


• OFF logs error messages.


Table 13  Keywords in trap_mgr.conf (page 2 of 4)


Keyword Description Option or format
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LOOKUP Allows you to substitute one value for another in 
the trap processor—without editing ASL scripts. 
You can use the LOOKUP keyword in your local 
trap_mgr.conf to substitute values. 
For example: 


LOOKUP MyTable local/lookups/filename
In this example, filename contains:


abcd1234:Alexandria
stuvwxyz:Hopkinton


If the trap definition in your trap_mgr.conf 
includes:


UserDefined1: $MyTable($SYS$)$
Then, if SYS contains abcd1234, then 
UserDefined1 returns the value Alexandria. If 
SYS contains stuvwxyz, then UserDefined1 
returns the value Hopkinton.


Other examples include:
$TABLE1($V4$)$; $TABLE2($SYS$[4])$ 
$TABLE2(coldStart[1])$


Available formats include:
• <table>(<key>) accesses a lookup 


table to return a single element if the 
table has only one value, or a list if 
the table has more than one value.


• <table>(<key>[<index>]) accesses a 
lookup table to return an element 
from the table.


where:
• <table>  is the name of the table 


defined in the IMPORT keyword.
• <key> is the key into this table, which 


is any string or variable.
• <index>  is an optional index value, 


which starts from 1 if the table 
contains more than one value.


RESOLVE_IP Allows you to resolve IP addresses into their 
names.
You can use this option to determine whether 
unrecognized IP addresses will be resolved 
before being assigned to the $SYS$ variable.  For 
objects already known to the system, this option 
has no effect.


Notice: Name resolution can be very slow. A 
system receiving thousands of traps and calling a 
name server for every request can seriously 
impact the number of traps that can be 
processed. Threading can help somewhat, but 
name resolution is not recommended in large 
installations unless the server is configured to 
use only host file resolution and the 
“CACHE_HOSTS” keyword is defined.  
Alternatively, a caching DNS server can be run on 
the trap host to help somewhat, but performance 
will still be impacted. 


For example:
RESOLVE_IP = FALSE


TRUE or FALSE


Table 13  Keywords in trap_mgr.conf (page 3 of 4)


Keyword Description Option or format
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sm_trapd options


Table 14 on page 76 lists and describes available options for sm_trapd.


USE_CURRENT_TIME Allows you to set the timestamp for 
notifications—using either the time contained in 
the trap, or the time the trap was received.
If this keyword is set to FALSE, then the 
timestamp from the trap is used unless it is 
invalid. If this option is set to TRUE, the 
timestamp from the trap is discarded, and the 
current time is used when creating notifications.


Notice: When using threads, traps can appear to 
come in out of order if this keyword is enabled.  
CLEAR traps are reordered, but other traps 
appear to occur at the time they were processed.


For example:
USE_CURRENT_TIME = FALSE


TRUE or FALSE


Table 13  Keywords in trap_mgr.conf (page 4 of 4)


Keyword Description Option or format


Table 14  Options for sm_trapd (page 1 of 3)


Option Description


--ascii If “--ascii” is not specified on the commandline for starting sm_trapd, sm_trapd converts the 
entire value of that OID into a printable UTF-8 coding string, such as a varbind. For example, 
.1.3.6.1.4.1.333.1 -> "abcd012" is converted into .1.3.6.1.4.1.333.1 -> "61 62 63 64 C3 96 30 
31 32".
If “--ascii” is specified on the commandline for starting sm_trapd, sm_trapd converts only the 
non-printable characters into a HEX string using the UTF coding for these characters. The 
remaining printable characters of the original value (octet-string) remain unchanged, such as 
the varbind. For example, .1.3.6.1.4.1.333.1 -> "abcd012" is then converted into 
.1.3.6.1.4.1.333.1 -> "abcdXC3X96012."


--broker Alternate broker location as host:port. For example: --broker AM_HOST-NAME:AM-PORT. Also 
-b <location>.


--community Stream the trap community string to the parser. Writes the community string to the 
sm_trapd.log file.


Notice: This option is required in the sm_trapd command line when using a community string 
in a hookscript or the $C$ variable.


--config=<cfg> Name of trap configuration directory where the trapd.conf is located. The trapd.conf file is 
loaded from one of the following directories:
• BASEDIR/smarts/local/conf/<cfg> or
• BASEDIR/smarts/conf/<cfg> 
The file in the local directory takes precedence if the configuration is present in both places. 


Notice: Default is --config=trapd.


--limitQueueMegs=
<num>


Size limit of internal trap queue. When the limit is reached, discard incoming traps from the 
most active sources.


--model=<model> Name of the model library that you want to load. For example: -model=sm_actions. Also -m 
<model>.
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--name=<name> Registered server name you want to start. Also -name <name>.


--output Data transfer.


--port=<port> Alternate port number for receiving traps. Also -p <port>.


Notice: Default value is --port=162.


--reloadConfig Reload, rather than restart, the trap configuration file for an already-running SNMP trap 
adapter. 
For example: -s <adaptername> --reloadConfig.


--rules=<name> Name of the rules set for parsing traps. For example: --rules=icoi-trapd/trap_mgr_parse.asl.


--rules=default Name of the default rules set for parsing traps.


Notice: Default is --rules=BASEDIR/smarts/rules/trapd/trapParse.asl.


--seed=<file> Get SNMPv3/USM credentials from the seed file. 
For example: --seed=seedfile.
The seed file has a path that is relative to the conf directory.


--server=<name> Name of the server. For example: --server=INCHARGE-OI. Also -s <name>.


--source Forward the source address of the trap to the trap processor and make this address available 
to configuration files and ASL scripts.


--sport=<port> Alternate registration port. Use with --name. For example: --sport=9180. Also -P <port>.


--tag Tag each varbind value with its type.


--window=<num> Window size for duplication. Also -w <num>.


Trace options


 --traceSNMP Trace incoming SNMP messages.


 --traceRules Trace rule compilation.


 --traceServer Trace interactions with the back-end server.


 --traceParse Trace rule matching.


Standard options


--accept=<host-list> Accept connections only from hosts on <host-list>, which is a comma-separated list of 
hostnames and IP addresses. The any option for <host-list> allows any host to connect.


Notice: Default is --accept=any.


--daemon Run process as a daemon.


--errlevel=<level> Minimum error printing level. 


Notice: Default is --errlevel=Warning.


--help Print help and exit.


Table 14  Options for sm_trapd (page 2 of 3)


Option Description
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--loglevel=<level> Minimum system logging level. 


Notice: Default is --loglevel=Error.


--logname=<name> Use <name> to identify sender in the system log.


Notice: Default is the name of a program.


--output[=<file>  Redirect server output (stdout and stderr). The filename is <file>, or the --logname value if <file> 
is omitted. Log files are in $SM_LOGFILES or $SM_WRITEABLE/logs.


 --tracelevel=<level> Minimum stack trace level. Options for <level> include: One of None, Emergency, Alert, Critical, 
Error, Warning, Notice, Informational, or Debug. Fatal is a synonym for Critical. For example: 
--tracelevel=Informational.


Notice: Default is --tracelevel=Fatal.


--version Print program version and exit.


 
--useif=<ip-address>


Use this IP address as the source or destination interface address.


-- Stop scanning for options.


--trailingNulls This option allows for printing trailing NULL bytes in an octet string of varbind value as 00 or 
\X00. By default trailing null octets are ignored. 
For example:
Device data: 41 00 00 00 00
sm_adapter data: 41
If sm_adapter is started with option --trailingNulls, then the adapter will print the octet string 
as it is, that is, the way it is coming from the trap device, including the trailing null octets.
For example:
sm_adapter started with --trailingNulls option:
Device data: 41 00 00 00 00
sm_adapter data: 41 00 00 00 00


Table 14  Options for sm_trapd (page 3 of 3)


Option Description
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Starting and stopping the SNMP Trap Adapter
If you installed the SNMP Trap Adapter as a service, it automatically starts when the 
system starts up. The following instructions describe how to use the sm_service utility to 
manually start and stop the SNMP Trap Adapter.


To use the sm_service utility to install a service or start a service, you must have 
administrative privileges on the local host.


Issue one of the following from the command line:


BASEDIR/smarts/bin/sm_service start ic-trapd-receiver
or


BASEDIR/smarts/bin/sm_service stop ic-trapd-receiver


The EMC Smarts System Administration Guide provides more information about the 
sm_service utility and about how to modify sm_service options.


On Windows, if the SNMP Trap Adapter was installed as a service, you can also start and 
stop the service by using the Control Panel Administrative Tools.


Default sm_service parameters for the SNMP Trap Adapter


When the SNMP Trap Adapter is installed as a service during the installation process, the 
SNMP Trap Adapter is set up with default parameters. The default parameters and their 
values are:


▼ /InCharge/SAM/smarts/bin/sm_service install --force --unmanaged
--startmode=runonce 
--description="SMARTS SNMP Trap Adapter" ic-trapd-receiver


/InCharge/SAM/smarts/bin/sm_trapd                                                 
    --name=TRAP-INCHARGE-OI                                                
    --server=INCHARGE-OI                                                   
    --config=icoi                                                          
    --port=162 
    --model=sm_actions 
    --seed=seedfile
    --rules=icoi-trapd/trap_mgr_parse.asl 
    --output ▲ 


▼ ▲ indicates the command must be typed as one line. Type the command from the 
BASEDIR/smarts/bin directory for the Service Assurance Manager product.
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Overview
The Syslog Adapter tails and parses the contents of any system log file and generates 
notifications to the Global Manager based on the file contents. 


You start the adapter by invoking the sm_service command. For example:


InCharge/SAM/smarts/bin>sm_service start ic-syslog-adapter


First the syslog_mgr.asl file parses each syslog message and populates the input 
variables. Then the my_hook_syslog.asl gets executed. This script first populates the 
notification attribute output variables by using the default values. It then uses the 
MODIFY_ATTRIBUTES rule to set additional attributes defined and potentially modify 
(overriding) any default attribute values. This is how the Service Assurance notification 
gets created by the Syslog Adapter.


Before you configure the Syslog Adapter, identify the location of the SYSFILE you want the 
adapter to tail and parse and ensure that sm_service install command line for the 
ic-syslog-adapter identifies this location. You must also ensure that the file format of the 
Syslog exactly matches the format described in the following sections.


Configuring the Syslog Adapter
Table 15 on page 82 describes the files that you need to use when configuring the Syslog 
Adapter. If you edit any of these files, you must use the sm_edit utility. The utility will save 
the local copies to the appropriate EMC Smarts subdirectories under the 
BASEDIR/smarts/local directory. “The sm_edit utility” on page 43 provides more 
information.


The Syslog Adapter creates events by parsing the contents of syslog files. You can use it to 
parse the contents of any text file with entries of the format:


month day time hostName applicationName [process_id]:text_message
If the format of your syslog file is different from the above format, you can edit 
my_hook_syslog.asl and syslog_mgr.asl to parse the entries accordingly.


The Syslog Adapter can parse the contents of a file and it can tail a file. When the Syslog 
Adapter tails a file, it skips the existing content and uses only content added to the file 
while the adapter is running.


The process_id parameter is optional when parsing the contents of syslog files.


The Adapter Platform includes a basic template for processing a syslog file. This file is 
BASEDIR/smarts/rules/icoi-syslog/my_hook_syslog.asl. 


Table 15  Syslog Adapter configuration and script files


Directory under 
BASEDIR/ Filename


User 
editable Description


smarts/rules/icoi-syslo
g/


my_hook_syslog.a
sl


Yes Basic template for processing a 
syslog file.


smarts/rules/icoi-syslo
g/


syslog_mgr.asl Yes Rule set for parsing each syslog 
message.
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After ensuring that the Adapter Platform Server and the Global Manager are up and 
running, complete the following procedures to configure the Syslog Adapter:


1. Check the location of the Syslog file to be sure it is appropriately placed for your 
operating system. 


2. Change the parameters in the local copy of my_hook_syslog.asl to match your needs.


3. Start the Syslog Adapter.


Syslog file location


The sm_service install command line for the Syslog Adapter, ic-syslog-adapter, is stored in 
the sm_service database. By default, the SYSFILE parameter in this script specifies the 
location as /var/log/syslog. Edit the command line to change the location of the Syslog 
file if necessary.


Editing the my_hook_syslog.asl


You can use the Adapter Scripting Language (ASL) to modify the functionality of the local 
copy of my_hook_syslog.asl or to create a new file. The basic components of a custom 
processing file for the Syslog Adapter are explained below:


debug = FALSE;
ASLNAME = " ".getRuleFileName ().": ";


DISCARD = "TRUE";


CLEAR_SYSLOG = "FALSE";


BATCH_NOTIFY_INTERVAL = 10;


// Output variables : This section has all default settings.


CLASSNAME = "Syslog";
INSTANCENAME = "";
EVENTNAME = "";
SEVERITY = "2";
EVENTTEXT = "";
CATEGORY = "";
EXPIRATION = "7200";
STATE = "";
INMAINTENANCE = "FALSE";
CLEARONACKNOWLEDGE = "TRUE";
EVENTTYPE = "";
USERDEFINED1 = "";
USERDEFINED2 = "";
USERDEFINED3 = "";
USERDEFINED4 = "";
USERDEFINED5 = "";
USERDEFINED6 = "";
USERDEFINED7 = "";
USERDEFINED8 = "";
USERDEFINED9 = "";
USERDEFINED10 = "";


ELEMENTCLASSNAME = "";
ELEMENTNAME = "";
SYSNAMEORADDR = "";
UNKNOWNAGENT = "IGNORE";
LOGFILE = "NONE"; 
// Aggregate Section : 
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AGG_EVENTNAME = "";
AGG_ELEMENTNAME = "";
AGG_EVENTTEXT = "";


The values of the output variables populate the attributes of the standard notification 
created when the syslog message is imported. The variable names correspond directly to 
the standard notification’s attribute names.


The Syslog Adapter populates these variables when the syslog entry is parsed:


// Input Variables


SYSLOGTIME = "";
HOST = "";
APPLICATION_NAME = "";
PROCESS_ID = "";
MESSAGE = "";


The START rule takes the text parsed from the syslog entry as input, prints a message, calls 
three other rules, prints another message, and exits after the processing is complete:


START {
  input=MESSAGE;
do {
if (debug) {print(time().ASLNAME."SYSLOGTIME =".SYSLOGTIME);}
if (debug) {print(time().ASLNAME."HOST =".HOST);}
if (debug) 


{print(time().ASLNAME."APPLICATION_NAME=".APPLICATION_NAME);}
if (debug) {print(time().ASLNAME."PROCESS_ID =".PROCESS_ID);}
if (debug) {print(time().ASLNAME."MESSAGE =".MESSAGE);}
}
    PARSE_MESSAGE
    MODIFY_ATTRIBUTES
    CUSTOM_RULE?
} do {
    if (debug) { print(time().ASLNAME."Done with my_hook_syslog.asl 


");}
    return;
}


The CUSTOM rule is an example of a rule which performs more customizations. In this 
case, it saves a prefix and a message description:


CUSTOM_RULE {
    unusedPrefix:rep(notany(":")) ":" /* consume chars up to : */
    msgDescription:rep(word) eol
} do {
    if (debug) { print(time().ASLNAME."Executing CUSTOM_RULE");}
}


This PARSE_MESSAGE rule saves only the first 30 characters:


PARSE_MESSAGE {
} do {
    // Use a slice of 30 characters as part of EVENTNAME
    slice = substring(MESSAGE, 0, 30);
}


The MODIFY_ATTRIBUTES rule assigns values to the notification created from the syslog 
entry. The value of InstanceName is composed of HOST, APPLICATION_NAME, and 
PROCESS_ID. These are values parsed from the syslog entry:


/*
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 * MODIFY_ATTRIBUTES Rule:
 * All your customizations are done here. You can use all
 * the Syslog input variables wherever you want them assigned
 * to ICS_Notification attributes.
 * ------------------------------------------------------------ */


MODIFY_ATTRIBUTES {
} do {


  DISCARD = "TRUE";
  CLEAR_SYSLOG = "FALSE";
  BATCH_NOTIFY_INTERVAL = 10;
  CLASSNAME = "Syslog" ? LOG;
  INSTANCENAME = HOST."_".APPLICATION_NAME."_".PROCESS_ID ? LOG;
  EVENTNAME = slice ? LOG;
   SEVERITY = "2" ? LOG;
   EVENTTEXT = MESSAGE ? LOG;
   CATEGORY = "" ? LOG;
   EXPIRATION = "7200" ? LOG;
   STATE = "NOTIFY" ? LOG;
   INMAINTENANCE = "FALSE" ? LOG;
   CLEARONACKNOWLEDGE = "TRUE" ? LOG;
   EVENTTYPE = "DURABLE" ? LOG;
   USERDEFINED1 = "" ? LOG;
   USERDEFINED2 = "" ? LOG;
   USERDEFINED3 = "" ? LOG;
USERDEFINED4 = "" ? LOG;
USERDEFINED5 = "" ? LOG;
USERDEFINED6 = "" ? LOG;
USERDEFINED7 = "" ? LOG;
USERDEFINED8 = "" ? LOG;
USERDEFINED9 = "" ? LOG;
USERDEFINED10 = "" ? LOG;


ELEMENTCLASSNAME = "Host";
ELEMENTNAME = HOST;
SYSNAMEORADDR = HOST;
UNKNOWNAGENT = "CREATE";
LOGFILE = "NONE";


AGG_EVENTNAME = "AggEvent-".INSTANCENAME;
AGG_ELEMENTNAME = HOST;
AGG_EVENTTEXT = "This is an Aggregate Test"


}


You can optionally add logic that compares the input variables and sets the output 
variables based on them.


Whenever you modify the hook script file, you must restart the adapter for the changes to 
take effect.
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Syslog Adapter parameters


Table 16 on page 86 shows the complete list of parameters that can be defined for a 
notification forwarded to the Global Manager by the Syslog Adapter.


If no parameter values are set within the MODIFY_ATTRIBUTES rule, then the values set in 
the Output variables section are used. 


Table 16  Syslog Adapter parameters (page 1 of 2)


Parameter
Corresponding standard notification attribute or 
description Valid values


AGG_EVENTNAME This is the event name of the aggregate 
notification and is required if you are creating an 
aggregate.


<string>


AGG_ELEMENTNAME This is the name of the topology element where 
the aggregate event occurs. This field is optional. 
If this field is not defined, the ElementClassName 
and ElementName of the trap definition are used, 
if available. Otherwise, the ClassName and 
InstanceName are used.
If you define this field and specify an 
object-handle that does not exist in the topology, 
then the aggregate is not created.


<object-handle>


AGG_EVENTTEXT This is the description of the aggregate 
notification (event). This field is optional.


<string>


CATEGORY Category Any string


CLASSNAME ClassName and DisplayClassName Any string


CLEARONACKNOWLED
GE


ClearOnAcknowledge TRUE or FALSE


CLEAR_SYSLOG Controls whether a given syslog message clears 
an already existing notification or results in a 
notify. 
The default is FALSE, all syslog messages result 
in notifications.
All syslog messages result in notifications unless 
the syslog messages are processed by 
subsequent MODIFY_ATTRIBUTES rules, which 
override the default. 


TRUE or FALSE


DISCARD Controls whether a given syslog message is 
discarded or processed. 
The default is TRUE, all syslog messages are 
discarded.
To override the default and process a syslog 
message, create a rule to process this syslog 
message. Within this rule, DISCARD should be set 
to FALSE.


TRUE or FALSE


ELEMENTCLASSNAME ElementClassName Valid Class 
Name in 
EMC Smarts 
topology
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ELEMENTINSTANCENA
ME


ElementName Valid Instance 
Name in 
EMC Smarts 
topology


EVENTNAME EventName (describing the notification) and the 
EventDisplayName


Any string


EVENTTEXT EventText Any string


EVENTTYPE EventType MOMENTARY or 
DURABLE


EXPIRATION Defines the expiration time in seconds for the 
notification. Zero indicates that the notification 
will not expire. 7200 is the default value.
If you use zero, you should use some method to 
eventually clear the notification. For example, you 
can configure the Syslog Adapter to send clear 
state notifications or set the ClearOnAcknowlege 
parameter to TRUE.


Integer 


INMAINTENANCE InMaintenance TRUE or FALSE


INSTANCENAME InstanceName (of the object associated with the 
notification) and InstanceDisplayName


Any string


LOGFILE The name of the file used by the SNMP Trap 
Receiver to log information for this trap. If this 
parameter is ’NONE’ or not defined, no 
information is logged.


Filename


SEVERITY Severity Any integer 
from 1 to 5


STATE Describes the state of the notification. 
This option is deprecated; its function is replaced 
by CLEAR_SYSLOG.


NOTIFY or 
CLEAR


SYSNAMEORADDR A valid value describes either the system name or 
address of the entity that sent the trap. Values for 
this parameter override values in ElementClass 
and ElementInstance.


Any string


UNKNOWNAGENT Describes whether Adapter Platform should 
ignore traps related to unknown topology 
elements or create elements for the traps.


CREATE or 
IGNORE


USERDEFINED1-10 UserDefined1-10 Any string


Table 16  Syslog Adapter parameters (page 2 of 2)


Parameter
Corresponding standard notification attribute or 
description Valid values
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Using the Syslog Aggregate parameters 
You configure aggregates in the Aggregate Section of the local copy of my_hook_syslog.asl 
rule set, located in BASEDIR/smarts/local/rules/icoi-syslog directory. “Using the Trap 
Adapter Aggregate parameter” on page 69 provides general information about 
Aggregates.


The following example illustrates how to use the aggregate parameter with the Syslog 
Adapter:


/*
 * my_hook_syslog.asl - Hook adapter for 
 * any syslog related customizations.
 *
 * Copyright (C) 1997, System Management ARTS (SMARTS)
 * All Rights Reserved
 */


debug = FALSE;
ASLNAME = " ".getRuleFileName().": ";


DISCARD = "TRUE";


CLEAR_SYSLOG = "FALSE";


/*
 * This interval (in seconds) will be used to batch updates to
 * notifications. In case, where a high frequency of
 * notifications occur, batching will improve performance. 
 * Setting this interval to 0, will disable batching.
 */


BATCH_NOTIFY_INTERVAL = 10;


CLASSNAME = "Syslog";
INSTANCENAME = "";
EVENTNAME = "";
SEVERITY = "2";
EVENTTEXT = "";
CATEGORY = "";
EXPIRATION = "300";
STATE = "";
INMAINTENANCE = "FALSE";
CLEARONACKNOWLEDGE = "TRUE";
EVENTTYPE = "";
USERDEFINED1 = "";
USERDEFINED2 = "";
USERDEFINED3 = "";
USERDEFINED4 = "";
USERDEFINED5 = "";
USERDEFINED6 = "";
USERDEFINED7 = "";
USERDEFINED8 = "";
USERDEFINED9 = "";
USERDEFINED10 = "";


ELEMENTCLASSNAME = "";
ELEMENTNAME = "";
SYSNAMEORADDR = "";
UNKNOWNAGENT = "IGNORE";
LOGFILE = "NONE";


/* Need to Declare these, if you want Aggregates
 * --------------------------------------------- */
AGG_EVENTNAME = "";
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AGG_ELEMENTNAME = ""; 
AGG_EVENTTEXT = ""; 


/*
 * Input Variables: Following are the variable declarations,
 * which hold the Syslog parsed values.
 * -------------------------------------------------------- */
SYSLOGTIME = "";
HOST = "";
APPLICATION_NAME = "";
PROCESS_ID = "";
MESSAGE = "";


if (debug) {  print(time().ASLNAME."Activated"); }


/*
 * Start Rule
 * ---------- */


START {
    input=MESSAGE;
    MODIFY_ATTRIBUTES
    CREATE_AGGREGATE
} do {
    if (debug) { print(time().ASLNAME."Done with my_hook_syslog.asl 


");}
    return;
}


CREATE_AGGREGATE {
} do {
        // If you see strings "CPU" and "HighUtilization" in 
        // the syslog 
        // message, then generate and aggregate.
        // --------------------------------------------------
        if (glob("*CPU*",MESSAGE) &&
        glob("*HighUtilization*",MESSAGE)) {


                AGG_EVENTNAME = "Degraded";
                AGG_ELEMENTNAME = HOST;
                AGG_EVENTTEXT = "Host [".HOST."] is Degraded";
        }
}


MODIFY_ATTRIBUTES {
} do {
    CLASSNAME = "Processor" ? LOG;
    INSTANCENAME = "PRO-".HOST ? LOG;
    EVENTNAME = substring(MESSAGE, 0, 30) ? LOG;
    SEVERITY = "2" ? LOG;
    EVENTTEXT = MESSAGE ? LOG;
    CATEGORY = "" ? LOG;
    EXPIRATION = "7200" ? LOG; //PR:6617
    STATE = "NOTIFY" ? LOG;
    INMAINTENANCE = "FALSE" ? LOG;
    CLEARONACKNOWLEDGE = "TRUE" ? LOG;
    EVENTTYPE = "DURABLE" ? LOG;


    ELEMENTCLASSNAME = "Processor";
    ELEMENTNAME = "PRO-".HOST ? LOG;
    UNKNOWNAGENT = "CREATE";
    LOGFILE = "Processor.log";
}
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DEFAULT {
     msg:{.. eol}
} do {
    print(time().ASLNAME."Reached Default rule: ".msg);
    this->clearVariables();                
}


/*
 * These variables describe the formatting of this file.  If 
 * you don't like the template defaults, feel free to change    
 * them here (not in your .emacs file).
 *
 * Local Variables:
 * mode: C++
 * End:
 */


Syslog batching


By default, except if the DISCARD parameter is set to TRUE, the Syslog Adapter does the 
following: 


◆ Converts the syslog messages it receives into new Service Assurance notifications or 
updates the existing Service Assurance notifications.


◆ Forwards them on to the Global Manager. 


Syslog batching refers to a process where the Adapter Platform Server waits for a specified 
period of time before forwarding re-notifications (updated notifications) to the Global 
Manager.


In case of high frequency of syslog messages, you can use batching to improve 
performance of clients processing the converted Service Assurance notifications. You 
configure batching by editing the my_hook_syslog.asl file so that re-notification messages 
are held for a specified period of time. Then, once that time is exceeded, only the most 
recent message of those bearing the same notification name is sent to the Global 
Manager.


To set the batch parameter, use sm_edit to open my_hook_syslog.asl, and type the period 
of time (in seconds) you want the Syslog Adapter to wait before forwarding re-notifications 
to the Global Manager. By default, the batch setting is 10 seconds. To disable batching, 
specify zero (0): 


BATCH_NOTIFY_INTERVAL = 10


“Using the Syslog Aggregate parameters” on page 88 provides an example of a script that 
contains the batch parameter.
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Starting and stopping the Syslog Adapter
If you installed the Syslog Adapter as a service, it automatically starts when the system 
starts up. The following instructions describe how to use the sm_service utility to 
manually start and stop the Syslog Adapter.


To use the sm_service utility to install a service or start a service, you must have 
administrative privileges on the local host.


Issue one of the following from the command line:


BASEDIR/smarts/bin/sm_service start ic-syslog-adapter


or


BASEDIR/smarts/bin/sm_service stop ic-syslog-adapter


The EMC Smarts System Administration Guide provides more information about the 
sm_service utility and about how to modify sm_service options.


On Windows, if the Syslog Adapter was installed as a service, you can also start and stop 
the service by using the Control Panel Administrative Tools.


Default sm_service parameters for the Syslog Adapter


When the Syslog Adapter is installed as a service during the installation process, the 
Syslog Adapter is set up with default parameters. 


The default parameters and their values are:


▼ /InCharge/SAM/smarts/bin/sm_service install 
--startmode=runonce 
--description="SMARTS Syslog Adapter" ic-syslog-adapter


/InCharge/SAM/smarts/bin/sm_adapter                                                 
    --name=SYSLOG-INCHARGE-OI                                              
    --rserver=INCHARGE-OI                                                  
    --tail=/var/log/syslog                                                 
    --model=sm_system                                                      
    --model=sm_actions                                                     
    --output                                                               
    icoi-syslog/syslog_mgr.asl ▲                                                             


▼▲ indicates the command must be typed as one line. Type the command must from the 
BASEDIR/smarts/bin directory for the Service Assurance Manager product.
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CHAPTER 4
Command Line Interface


The command line interface (sm_ems) is useful for converting information from third-party 
applications into events. This interface can create and clear events and create basic 
topology elements. The command line interface also can update event attributes passed 
by the Adapter Platform Server, and associate events to topology elements. You can use 
the ASL scripting language in conjunction with the command line interface for more 
advanced processing.


This chapter contains the following information:


◆ Using the command line interface ...........................................................................  94
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Using the command line interface
Configuration of the command line interface consists of two parts:


1. You need to set up the proper security between the Adapter Platform and the 
command line interface. By default, the sm_ems command line interface does not 
prompt for authentication credentials.


If you are working in a secure environment, you need to create an entry in the 
clientConnect.conf file (using the sm_edit utility) that provides the necessary 
username and password for the sm_ems interface. The username in this entry must 
match a user in the corresponding serverConnect.conf file. You must edit the 
clientConnect.conf file on the host where sm_ems is running.


2. You must modify your third-party application to call sm_ems.


Command line interface usage
The third-party application must be modified to call the sm_ems command. The 
documentation for third-party applications provides more information about configuring 
the application to call the command line interface.


The basic format to call the command line interface is: 


sm_ems --server=<server_name> [options ...] <command>


Table 17 on page 94 describes the options.


Table 17  Command line interface options (page 1 of 2)


Option Description


--server=<name> The name of the Adapter Platform Server. This parameter is 
required.


--broker=<location> The name of the broker, if you override the broker set by the 
SM_BROKER environment variable.


--system=<nameOrAddr> Specifies the name or IP address of the existing system (Unitary 
Computer System) you want to associate with this event. 
The event will automatically be associated with this system in the 
Adapter Platform topology. 
The system name is converted to its canonical name using 
hostname lookups. For example, Host1 or 10.1.2.345 might be 
converted to Host1.example.com.
If the system does not exist in the topology, it may be created 
automatically if the --create-system option is specified.


--create-system Determines that the unitary computer system should 
automatically be created if it does not exist in the topology. The 
Class defaults to Node, however you can optionally use 
--element-class to specify the class name. This option is 
deprecated, but retained for backwards compatibility. 
The --create-element option can be used instead of this option to 
create any infrastructure element.


--element-class=<ClassN
ame>


Determines the ClassName of the entity being created in the 
EMC Smarts topology, if the element does not already exist. 
Issue this option with --create-element and also --element-name. 
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Command line interface commands
There are 10 different commands to use with sm_ems. Along with the command, you need 
to pass arguments. Table 18 on page 96 describes these commands. Where possible in 
the table, the arguments passed with the command are expressed as attributes from the 
standard notification. Notification attributes are described in “Adapter Platform and 
Notifications” on page 99.


--element-name=<Instanc
eName>


Determines the InstanceName to be used with the 
--element-class option. Options provided with --element-class 
and --element-name will be used to create the object. 


Notice: Do not use the --system option if you are also issuing the 
--element-class and --element-name options.


--create-element Determines that the element-class and element-name you 
specify should automatically be created if it does not exist in the 
EMC Smarts topology.
Use this option to create any infrastructure element, including 
business elements, application-related elements, and unitary 
computer systems. 


--aggregate-element-clas
s=<ClassName>


Determines the ClassName for the Aggregate Notification, if one 
is being created.


--aggregate-element-nam
e=<InstanceName>


Determines the InstanceName for the Aggregate Notification, if 
an aggregate notification is being created (using the 
--aggregate-event option). Also creates an OccurredOn 
relationship between the Instance and the Aggregate Event.


--aggregate-event=<Aggre
gateEventName>


Determines the EventName of an Aggregate Notification. This is a 
required option if you are creating an Aggregate. 


--audit=<msg> Optional text to include in the description field of the audit log 
entry created for this action. 


Notice: This option is ignored for the add-audit-log command.


--traceServer Enables tracing of server communications.


Table 17  Command line interface options (page 2 of 2)


Option Description
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With the exception of summarize, all of the sm_ems commands use ClassName, 
InstanceName, and EventName. These three fields are always required because they 
uniquely identify a standard notification. 


Table 18  sm_ems commands (page 1 of 2)


Command Description


acknowledge <ClassName> 
<InstanceName> <EventName>


Changes the notification’s attribute, Acknowledged to TRUE. 
Attribute values modified using this command argument do 
not get propagated to Global Manager through the Adapter 
Platform.


add-audit-log <ClassName> 
<InstanceName> <EventName> 
<message>


Adds an entry to the Adapter Platform’s audit log. The entry 
contains information about the notification as well as a text 
message (<message>).


assign <ClassName> 
<InstanceName> <EventName> 
<Owner>


Changes the notification’s ownership. Attribute values 
modified using this command argument do not get 
propagated to Global Manager through the Adapter Platform.


clear <ClassName> 
<InstanceName> <EventName> 
<SourceDomainName>


Clears an occurrence of a notification. In order for this 
command to work, SourceDomainName must match the 
notification’s attribute.


notify <ClassName> 
<InstanceName> <EventName> 
<SourceDomainName> 
<EventType> <Clear-Mode> 
[<attribute>=<value> ...]


Creates a notification. 
If you use the notify command to create a notification that 
already exists, the Count attribute is increased by 1 and any 
attribute which is not explicitly assigned a new value will 
retain its previous value.
You must use values for each argument through 
<Clear-Mode>. Clear-Mode indicates how the notification gets 
cleared. Valid values for Clear-Mode are:
• source — The source sends a clear.
• <number> — The number of seconds before the event 


expires.
• none — The notification should not expire and the source 


will not send a clear.
At the end of this command, you have the option of defining 
other attributes for the command. Optional attributes are: 
Category, Certainty, ClassDisplayName, 
ClearOnAcknowledge, EventDisplayName, EventText, Impact, 
InMaintenance, InstanceDisplayName, Severity, 
TroubleTicketID, and UserDefined1 through UserDefined10.
In this case, the attribute name must match the standard 
notification attribute. If you do not explicitly assign values for 
other attributes, the default attribute values are used. 
“Adapter Platform and Notifications” on page 99 provides a 
list of default values.


print <ClassName> 
<InstanceName> <EventName>


Prints all of the notification’s attributes to stdout.


release <ClassName> 
<InstanceName> <EventName>


Clears the notification ownership. Attribute values modified 
using this command argument do not get propagated to 
Global Manager through the Adapter Platform.
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An example of the sm_ems Notify command
The following sm_ems command creates a notification on the Adapter Platform Server 
ICOI:


▼sm_ems --server=ICOI notify Router RouterNY25 Down 
 3rdParty DURABLE 3600 Category=3rdParty-Down Severity=2 ▲


▼ ▲ indicates the command must be typed as one line.


The notification is for a Router named RouterNY25 and it is Down, which is in this case a 
durable event. The notification expires in 3600 seconds. The Category attribute of the 
standard notification contains the name of the event as seen in the third-party 
application.


An example of the sm_ems Create Element option with Notify command
The following sm_ems command uses the --create-element option along with the notify 
command to:


◆ Create a Host, WebHost (Host::WebHost) if it does not exist in the EMC Smarts 
topology.


◆ Generate a notification, ApplicationService::WebServer Stopped. Specifies that the 
event was sent by a third party, is a momentary type of event, will be cleared by its 
source, and has a severity level of 2. Also, implies that the event OccurredOn 
Host::WebHost:


▼sm_ems --server=ICOI --element-class=Host 
--element-name=WebHost --create-element notify ApplicationService 


WebServer Stopped 3rdParty momentary 
source severity=2 ▲


▼ ▲ indicates the command must be typed as one line.


summarize 
[<Notification_List>] 


Prints a summary for a given notification list. If a notification 
list is not specified, the notification list named Default is 
used.


unacknowledge <ClassName> 
<InstanceName> <EventName>


Changes the notification’s attribute, Acknowledged to FALSE. 
Attribute values modified using this command argument do 
not get propagated to Global Manager through the Adapter 
Platform.


update <ClassName> 
<InstanceName> <EventName> 
<attribute>=<value> ...


Modifies one or more of a notification’s attributes.


Table 18  sm_ems commands (page 2 of 2)


Command Description
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An example of the sm_ems Aggregate option with Notify command
The following sm_ems command uses Aggregate option along with the notify command to 
generate two notifications:


◆ Generate an Aggregate notification, CPU::WebHost-CPU High-Utilization. Specifies 
that the event was sent by a third party, is a momentary type of event, and has a 
severity level of 1.


◆ Generate a component Notification, Host::WebHost Unresponsive, which is 
associated with the previously generated Aggregate Notification: 


▼sm_ems --server=ICOI --aggregate-element-class=Host 
--aggregate-element-name=WebHost 
--aggregate-event-name=unResponsive notify CPU WebHost-CPU 
High-Utilization 3rdParty momentary source severity=1 ▲


▼ ▲ indicates the command must be typed as one line.
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Adapter Platform and Notifications


The purpose of the Service Assurance Adapter Platform is to normalize events and place 
them into a topological context so that they can be imported into a Global Manager. This 
means that the Adapter Platform Server takes incoming events from a variety of other 
sources and translates the information into standard notifications. The standard 
notification is based on the ICIM_Notification class and consists of many attributes. When 
the Adapter Platform is used as a platform for ASM Adapters, the ASM Adapters set the 
properties of the notification attributes. Depending on the configuration of the adapter, 
the attributes created for each notification may or may not be populated with data.


Also, when the Global Manager collects the notification information from the Adapter 
Platform Server, not all of the attributes of the notification get passed by default. Table 19 
on page 99 lists the attributes of the notifications for Service Assurance and also 
identifies those that get passed to the Global Manager. 


For attributes that contain a time value, time is counted in seconds from Midnight, January 
1st, 1970 GMT (the Epoch).


Table 19  Notification attributes (page 1 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description


Acknowledged Boolean TRUE or FALSE No TRUE if the notification has 
been acknowledged, FALSE if 
not.


Active Boolean TRUE or FALSE
(Default: TRUE)


No TRUE if the notification is 
active, FALSE if not.


AuditTrail Special No Audit trail for the 
notification. AuditTrail is a 
table that includes:
• ActionType
• SerialNumber
• Text
• Timestamp
• User
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Category String Yes Type of notification. Possible 
values include:
• Availability
• Discovery
• Error
• Operational
• Performance
• PowerSupply
• Resource
• Temperature
• IMPACT 
These categories correspond 
to the Exceptions of the 
same name described in the 
EMC Smarts IP Manager User 
Guide and the EMC Smarts 
Business Impact Manager 
User Guide.


Certainty Float 0 to 100
(Default: 100)


Yes Confidence level that this 
notification is the correct 
diagnosis.


ClassDisplayName String Yes Class name of the managed 
element (where the event 
occurred) that is displayed to 
the user.


ClassName String Yes Class name of the managed 
element where the event 
occurred. This attribute 
along with InstanceName 
and EventName uniquely 
identifies this notification. 
ClassName may differ from 
the ElementClassName.


ClearOnAcknowled
ge


Boolean TRUE or FALSE
(Default: FALSE)


Yes TRUE if the notification 
should be cleared when it is 
acknowledged. Use this in 
cases when notifications 
never expire or that have 
sources that will not 
generate a clear.


ElementClassNam
e


String Yes Class Name of the object that 
the event occurred on.


ElementName String Yes Element Name of the object 
that the event occurred on.


EventDisplayName String Yes Name of the notification that 
is displayed to the user.


Table 19  Notification attributes (page 2 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description
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EventName String Yes Name of the event. This 
attribute along with 
ClassName and 
InstanceName uniquely 
identifies this notification.


EventState String No Indicates the state of the 
notification. Possible values 
include:
• ACTIVE
• SUSPENDED
• WAS_ACTIVE
• INACTIVE
• UNINITIALIZED


EventText String Yes A description of the 
notification.


EventType Special MOMENTARY or 
DURABLE
(Default: 
DURABLE)


Yes Indicates the nature of the 
event. A MOMENTARY event 
has no duration (such as an 
authentication failure). A 
DURABLE event has a period 
during which the event is 
active and after which the 
event is no longer active 
(such as a link failure). 


FirstNotifiedAt Integer (Default: 0) No First notification time. (This 
value is reset after an event 
is archived.)
Events diagnosed by an 
underlying domain include 
timestamps that accurately 
reflect when the event 
occurred. The Global 
Manager uses this value 
from the event for the 
FirstNotifiedAt/LastNotifiedA
t times when it creates the 
notification.


Impact Integer (Default: 0) No A number that quantifies the 
impact of this notification on 
the infrastructure or 
business processes. Larger 
numeric values indicate a 
larger impact.


InMaintenance Boolean TRUE or FALSE
(Default: FALSE)


No TRUE indicates that the 
device associated with the 
notification is in 
maintenance mode, FALSE if 
not.


Table 19  Notification attributes (page 3 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description
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InstanceDisplayNa
me


String Yes Name of the instance that is 
displayed to the user.


Notice: If tagging is 
implemented in the Global 
Manager, the 
InstanceDisplayName may 
include a tag suffix.


InstanceName String Yes Name of the instance where 
the event occurred. This 
attribute along with 
ClassName and EventName 
uniquely identifies this 
notification.


IsRoot Boolean TRUE or FALSE No TRUE if the notification is a 
root cause, FALSE if not.
It is often useful to filter on 
IsRoot to find those 
notifications which require 
immediate attention.


IsProblem String Yes Yes indicates if (and only if) 
at least one of the source 
event types is “PROBLEM” 
and other source event types 
are either “PROBLEM” or 
“UNKNOWN”.
No indicates that one or 
more of the source event 
types is “EVENT” or 
“AGGREGATE”.
Because filtering on IsRoot 
can result in transient 
behavior when events are 
received from multiple 
underlying sources, it is 
recommended to filter on 
IsProblem instead.


LastChangedAt Integer (Default: 0) No Time since the Epoch when 
the status of the notification 
last changed. This is 
calculated by the Global 
Manager.


LastClearedAt Integer (Default: 0) No Time since the Epoch when 
the notification was last 
cleared. This is calculated by 
the Global Manager.


LastNotifiedAt Integer (Default: 0) No Time since the Epoch when 
the notification was last 
notified. 


Name String No Internal identifier for the 
notification.


Table 19  Notification attributes (page 4 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description
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Occurrence Count Integer No Number of times the 
notification has occurred.


Owner String No Name of the user 
responsible for handling this 
notification.


Severity Integer 1 to 5
(Default: 5)


Yes An enumerated value that 
describes the severity of the 
notification from the 
notifier's point of view. Valid 
values are the integers 1 
through 5:
1. Critical indicates action is 


needed NOW and the 
scope is broad, for 
example, an outage to a 
critical resource.


2. Major indicates action is 
needed NOW.


3. Minor indicates action is 
needed, but the situation 
is not serious at this time.


4. Unknown indicates that 
the element is 
unreachable, 
disconnected, or in an 
otherwise unknown state.


5. Normal is used when an 
event is purely 
informational.


Notice: Only the numbers, 
not the text descriptions, are 
passed by the Global 
Manager.


SourceDomainNa
me


String No The name of the domain that 
notified current occurrences 
of this event. If there is more 
than one domain, the 
attribute lists each separated 
by a comma.
An intermediary Manager 
that relays an event is not 
listed as a source. For 
example, “Trap Processor” 
(SNMP Trap Adapter) is listed 
as the source of a 
notification and not the 
intermediary SAM Adapter 
Platform Server.


Table 19  Notification attributes (page 5 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description
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SourceEventType String UNKNOWN Yes Indicates the type of event 
from an underlying source or 
sources. Value can be: 
PROBLEM, EVENT, 
AGGREGATE, or UNKNOWN. 
(Not to be confused with 
Event Type.)


TroubleTicketID String No Trouble-ticket number 
associated with this 
notification.


UserDefined1-10 String No User defined field 1-10.


Table 19  Notification attributes (page 6 of 6)


Notification 
attribute Type Value range


(default value)
Passed 
by default


Description
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APPENDIX B
EMC Smarts MIB for SNMP Traps


The EMC Smarts MIB implemented by EMC Corporation for SNMP Traps is as follows:


-- SMARTS-MIB.my: EMC Smarts corporate MIB
--
-- Copyright 1999-2006 by EMC Corporation ("EMC").
-- All rights reserved.
--
-- UNPUBLISHED CONFIDENTIAL AND PROPRIETARY PROPERTY OF EMC.  The
-- copyright notice above does not evidence any actual or intended
-- publication of this software.  Disclosure and dissemination are
-- pursuant to separate agreements.  Unauthorized use, distribution
-- or dissemination are strictly prohibited.
--
-- RCS $Id: SMARTS-MIB.my,v 1.1.38.2 2006/02/06 23:41:15 eo1 Exp $
--
SMARTS-MIB DEFINITIONS ::= BEGIN


IMPORTS
        enterprises, Counter32, OBJECT-TYPE,
        MODULE-IDENTITY, OBJECT-IDENTITY, NOTIFICATION-TYPE
                FROM SNMPv2-SMI;


smartsMIB MODULE-IDENTITY
        LAST-UPDATED "200602070000Z"
        ORGANIZATION "EMC Corporation"
        CONTACT-INFO
                "       Support
                Postal: EMC Corporation
                        Corporate Headquarters
                        176 South Street
                        Hopkinton, MA 01748-9103
                        US
                Phone:
                  United States: (800) 782-4362 (SVC-4EMC)
                  Canada:        (800) 543-4782 (543-4SVC)
                  Worldwide:     (508) 497-7901


Web: http://powerlink.emc.com"
                DESCRIPTION
                        "The MIB module for EMC Smarts entities defined 


by
                        EMC Corporation."
        ::= { enterprises 733 }


-- top level groups in the SMARTS-MIB


-- The smNotificationTrap Group.


smNotificationTrap OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "This group is acutally the prefix one uses when creating
          enterprise-specific trap OID's for an SNMPv2 trap.  It is
          used in the SMARTS MIBS when defining traps."
        ::= { smartsMIB 0 }


-- The smNotificationData Group.
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smNotificationData OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "The members of this group are the OIDs for VarBinds
          containing notification data."
        ::= { smartsMIB 2 }


-- Group for generic notification data.


smGenericNotify OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "The members of this group are the OIDs for VarBinds
          containing generic notification data."
        ::= { smNotificationData 1 }


smNotifTimestamp OBJECT-TYPE
        SYNTAX Counter32
        MAX-ACCESS accessible-for-notify
        STATUS  current
        DESCRIPTION
         "The timestamp of the notification."
        ::= { smGenericNotify 1 }


smNotifServer OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The name of the server that is sending the notification."
        ::= { smGenericNotify 2 }


smNotifClass OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The class of the object associated with the notification."
        ::= { smGenericNotify 3 }


smNotifInstance OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
        "The instance name of the object associated with the 


notification."
        ::= { smGenericNotify 4 }


smNotifEventName OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
        "The name of the event causing the notification."
        ::= { smGenericNotify 5 }


smNotifInstanceID OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The unique InCharge inventory identification 
          for the object associated with the notification."
        ::= { smGenericNotify 6 }
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smNotifDescription OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "A complete description of the event."
        ::= { smGenericNotify 7 }


smNotifCertainty OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The certainty of the event.  Floating-point number in the
          range 0-100, stored as a string."
        ::= { smGenericNotify 8 }


smNotifSeverity OBJECT-TYPE
        SYNTAX INTEGER {
                notApplicable (1),
                informational (2),
                warning (3),
                minor (4),
                major (5),
                severe (6)
        }
        MAX-ACCESS accessible-for-notify
        STATUS  current
        DESCRIPTION
         "The severity of the event.  Integer number in the range 1-6."
        ::= { smGenericNotify 9 }


-- The SMARTS enterprise Traps
--
-- These are the enterprise-specific trap codes currently in-use in
-- SMARTS software.  The final sub-OID of each object is the code sent
-- in the "specific-trap" field of an SNMPv1 Trap-PDU.
--
-- The definition of these objects mimics the SNMPv2 convention for
-- sending traps:  Take the enterprise OID, append 0, then append the
-- trap code.


-- TRAP NUMBER USE: Trap code 0 is reserved (by SNMP).
--                  Trap codes 1-3 are used by the SMARTS-OV-NV-MIB.


-- TRAPS 4-7: The "smTrap*" series of traps define "base" trap
--            numbers, ones with a generic purpose.  These traps are
--            also used by the generic Trap Adapter.


          smTrapNotification NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
               }
            STATUS current
            DESCRIPTION
             "A trap describing an InCharge root cause notification.
              The text in smNotifDescription indicates the nature of
              the problem."
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          ::= { smNotificationTrap 4 }


          smTrapCertaintyChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                }
             STATUS current
             DESCRIPTION
              "A trap indicating a certainty change of an InCharge
               notification. The text in smNotifDescription indicates
               the nature of the problem."
           ::= { smNotificationTrap 5 }


           smTrapSeverityChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                }
             STATUS current
             DESCRIPTION
              "A trap indicating a severity change of an InCharge
               notification. The text in smNotifDescription indicates
               the nature of the notification."
           ::= { smNotificationTrap 6 }


           smTrapNotificationClear NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
              STATUS current
              DESCRIPTION
               "A trap indicating the clear of an InCharge 


notification."
           ::= { smNotificationTrap 7 }


           smTrapNotificationChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
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              STATUS current
              DESCRIPTION
               "A trap indicating the change of an InCharge 


notification."
           ::= { smNotificationTrap 98 }


           smTrapNotificationDelete NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
              STATUS current
              DESCRIPTION
               "A trap indicating the delete of an InCharge 


notification."
           ::= { smNotificationTrap 99 }


-- TRAP NUMBER USE: Trap codes 8-99 are reserved for future "base trap 
number"


--                  use.
--
--                  Trap codes 100-133 are used by 


SMARTS-PERFORMANCE-MIB.
--                  Trap codes 134-199 are reserved for future use by
--                  SMARTS-PERFORMANCE-MIB. 


END
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Business Impact Manager. IT managers who seek to understand the 
role of the Business Impact Manager and Global Manager in the context of an EMC Smarts 
solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


These documents are updated periodically. Electronic versions of the updated manuals 
are available on the EMC Online Support website (registration required) at: 
https://support.emc.com


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide
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◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Introduction 


This chapter introduces EMC Smarts Business Impact Manager and provides an 
architectural and functional overview of the product. It contains the following sections:


◆ About Business Impact Manager .............................................................................  18
◆ Architectural and functional overview......................................................................  19
◆ Business Impact Manager features..........................................................................  21
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Introduction

About Business Impact Manager
Business enterprises, such as those operated by financial institutions, manufacturers, 
retailers, and network service providers, consist of the following broad categories of 
elements as shown in Figure 1 on page 18:


◆ Network infrastructure elements


Devices (such as hosts, routers, and switches) and connections that make up a 
network.


◆ Application elements


Software programs (such as accounting packages, order management programs, and 
inventory control packages) that are layered over and hosted by the network 
infrastructure elements.


◆ Business elements


Business service offerings and business processes and the subscribers (such as 
service subscribers, customers, organizations, business units, lines of business, and 
departments) who use those service offerings and processes.


Figure 1  Business enterprise hierarchy of elements


The degradation or failure of important network infrastructure elements can slow or stop 
vital applications and services, and dramatically reduce user productivity in needed 
business areas. For example, a host (an infrastructure element) that exhibits degraded 
performance will slow one or more applications that are running on it. The slow 
applications will, in turn, disrupt business services and processes on which subscribers 
depend.


EMC® Smarts® Business Impact Manager (Business Impact Manager) calculates the 
impact of network infrastructure and application root-cause problem events on business 
elements, and creates business impact notifications. The business impact notifications 
enable business enterprises to immediately identify disruptions and failures, and to 
prioritize the resolution of the infrastructure and application problems in accordance with 
their business impact.


Business 
elements


Application 
elements


Network 
infrastructure


elements
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Architectural and functional overview
Business Impact Manager operates in conjunction with, and extends the capabilities of, 
EMC Smarts Service Assurance Manager (Global Manager) to calculate the impact of 
infrastructure and application problems on business elements. 


Figure 2  Business Impact Manager architecture


To improve Global Manager performance, Business Impact Manager runs as its own server 
process instead of running as part of the Global Manager server process. Business Impact 
Manager and Global Manager may run on the same host machine or on different host 
machines.


Business Impact Manager imports its business service topology, hierarchical group 
topology, and weights from user-configured datafiles loaded into the Global Manager. It 
may also import business service topology and hierarchical group topology created using 
the Topology Builder and the Group Builder and event filters from a user-configured event 
filter datafile.


Applications


Hosts


Network


Network & system topology
& events


Application topology
& events


Service & group
topology


Business Impact 
Manager


import datafiles


Global Console


Business Services 
maps


Weights


Event filters


Service & group
topology, weights, 


event filters,
& notifications


Business impact
notifications &


calculated
impact values


Global Manager Business Impact
Manager


Domain Manager Domain Manager


Application topology
& polled data


Network and system topology,
polled data, & traps


Topology Builder


Service topology


Group Builder


Group topology

Architectural and functional overview 19







Introduction

Business service topology includes business service offering elements, business process 
elements, and business subscriber elements—subscribers who use the business service 
offerings and processes.


Business Impact Manager subscribes to all infrastructure and application notifications 
from the Global Manager, calculates the impact of the infrastructure and application 
root-cause problem notifications on the business elements, and propagates the impacts 
to the affected business elements. The propagated impacts are discrete notifications that 
are connected through a causal event chain to the root-cause problems in the network 
infrastructure layer or the application layer of the business enterprise.


Each infrastructure root-cause problem notification, each application root-cause problem 
notification, and each business impact notification includes a business impact value, 
which is specified in the user-configured weight datafile. The business impact value for a 
notification is displayed in the Notification Log Console of the Global Manager. 
Concurrently, the propagated impact notification (Impacted) generated for a business 
element is displayed in Business Services maps in the Map Console of the Global 
Manager. The Impacted business element shows a Severity icon that is colored according 
to the severity level of the notification. Double-clicking the element in the Business 
Services map shows the details of the notification.
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Business Impact Manager features
Business Impact Manager provides:


◆ Business Services maps through which users view impacted business elements.


Chapter 3, “Viewing Business Analysis Results and Topology,” describes this feature.


◆ Text import datafiles in which users define business elements in text format, define 
hierarchical group elements in text format, and define weight elements in text format.


Chapter 4, “Setting Up and Using Business Impact Manager,” describes this feature.


◆ A Group Builder, also known as a Group Definitions window, through which users can 
create and modify hierarchical group elements.


The EMC Smarts Service Assurance Manager Configuration Guide describes this 
feature.


◆ XML import datafiles in which users define the following elements in XML format:


• Business elements


• Hierarchical group elements 


• Weight elements 


• Event filter elements


Event filter elements represent events for which Business Impact Manager does not 
generate business impact notifications.


Chapter 4, “Setting Up and Using Business Impact Manager,” describes this feature.


◆ InMaintenance attribute processing, in which Business Impact Manager sets the 
InMaintenance attribute to TRUE for any business impact notification created solely 
from causal infrastructure or application notifications associated with devices in 
maintenance mode.


Chapter 4, “Setting Up and Using Business Impact Manager,” describes this feature.
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CHAPTER 2
Business Elements and Notifications 


This chapter describes the EMC Smarts ICIM business classes managed by Business 
Impact Manager and the business impact notifications created by Business Impact 
Manager. It consists of the following topics:


◆ Business Impact Manager elements ........................................................................  24
◆ Business Impact Manager notifications ...................................................................  26
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Business Impact Manager elements
Business Impact Manager uses instances of certain EMC Smarts ICIM classes to create a 
data model representation of the managed business topology within its repository. ICIM is 
based on the Common Information Model developed by the Distributed Management Task 
Force. The data model, shown in Figure 3 on page 24, represents the managed business 
elements and the relationships between them.


Figure 3  Business data model


As shown in the figure, BusinessProcess is a subclass of ServiceOffering, and Customer, 
Organization, BusinessUnit, LOB, and Department are subclasses of ServiceSubscriber.


ServiceOffering


A ServiceOffering represents a business service delivered to a set of subscribers 
(consumers). The ServiceOffering is related to its subscribers through the 
Subscribers/Subscriptions relationship set. A ServiceOffering is also related to the 
infrastructure and application elements that implement the offering through the 
ConsistsOf/MemberOf relationship set.


ServiceOfferings are usually web hosting or device name services.


BusinessProcess


A BusinessProcess represents functions and operations that support the internal business 
activities or other processes of a business enterprise or both. In the manufacturing sector, 
BusinessProcess elements can include, for example, Order Processing, Production 
Planning, Purchasing and Receiving, Inventory Management, Production Control, and 
Accounts Payable and Receivable.


In addition to the relationship sets (Subscribers/Subscriptions and 
ConsistsOf/MemberOf) inherited from ServiceOffering, a BusinessProcess can also 
participate in the Serves/ServedBy relationship set with other BusinessProcess elements. 
Serves/ServedBy models the dependencies between business processes.
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ServiceSubscriber


A ServiceSubscriber represents a subscriber (consumer) of one or more ServiceOfferings. 
The ServiceSubscriber relationship to a ServiceOffering is Subscriptions.


Through class inheritance, Customer, Organization, BusinessUnit, LOB, and Department 
elements also have a Subscriptions relationship to a ServiceOffering. Like 
ServiceSubscriber, all of these classes consume business services provided by one or 
more ServiceOfferings.


Customer


A Customer represents one or more business enterprises or individuals that maintain a 
business relationship with an Organization or one of its BusinessUnit elements.


Organization


An Organization represents a hierarchically structured business enterprise consisting of 
one or more business units that engage in one or more lines of business. Its primary 
function is to manage the performance of its composite business units. Organization 
elements can include, for example, manufacturers, retailers, financial institutions, and 
service providers. 


BusinessUnit


Within an Organization, a BusinessUnit represents a semi-autonomous division that 
engages in one or more lines of business. Typically, BusinessUnit elements focus on 
specific product markets (in the computer industry, for example, hardware or software 
products) or geographical areas (for example, the Eastern United States, Europe, or Asia).


LOB 


Within a BusinessUnit, a line of business (LOB) represents a division that focuses on 
specific product markets. In the insurance industry, LOB elements include, for example, 
general homeowner policies, fire coverage, and flood insurance. LOB elements can be 
further categorized as commercial lines (for businesses) and personal lines (for 
individuals).


Department


Within a BusinessUnit or LOB, a Department represents a group that engages in business 
functions that support the BusinessUnit or LOB. Two very common, yet vital Department 
elements can include, for example, Human Resources and Accounting.
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Business Impact Manager notifications
Business Impact Manager evaluates events that affect business elements by:


◆ Calculating business impact values and generating business impact notifications.


◆ Automatically propagating business impact notifications.


Calculated business impact values


An administrator uses the weights.conf or weights-conf.xml import datafile to assign 
weights to business elements and to the infrastructure and application elements that 
support the business elements. Business Impact Manager uses the assigned weights to 
calculate a numeric impact value for each root-cause problem notification received by the 
Global Manager from an underlying Domain Manager. Business Impact Manager 
calculates the impact value for a problem notification as soon as Business Impact 
Manager imports the notification from the Global Manager.


To calculate a numeric impact value for a root-cause problem notification, Business 
Impact Manager performs the following operations:


◆ Determines the infrastructure or application element denoted in the problem 
notification.


◆ Determines the infrastructure or application element denoted in each impact 
notification associated with the problem notification by tracing the Causes 
relationship from the problem notification to each of its impact notifications:


problem notification -> Causes -> impact notification
impact notification -> CausedBy -> problem notification


The underlying Domain Manager that diagnoses the problem and its impacts creates 
the Causes/CausedBy relationships between the problem notification and its impact 
notifications.


◆ Determines the business elements associated with the infrastructure or application 
element denoted in the problem notification.


◆ Determines the business elements associated with each infrastructure or application 
element denoted in the impact notifications associated with the problem notification.


◆ Reads the weights assigned to the impacted business, infrastructure, and application 
elements and adds the weights together to calculate the impact value for the problem 
notification.


After calculating the business impact value of a root-cause problem notification, Business 
Impact Manager assigns that value to the Impact attribute of the notification. When 
viewing the problem notification in the Notification Log Console of the Global Manager, 
the business impact value appears in the Impact column.


Business impact values quantify the business impact of the root-cause problems; the 
larger the impact value, the larger the business impact (degree of impairment). 
Administrators can use business impact values to sort problem notifications by the impact 
that they have on service delivery.
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Automatically propagated business impact notifications


Concurrently with calculating a business impact value for a problem notification, Business 
Impact Manager uses a built-in, automated mechanism to automatically propagate the 
impact as discrete notifications from the problem element through an event causality 
chain to the affected business elements. When viewing a business impact notification in 
the Notification Log Console of the Global Manager, the “Impacted” event name appears 
in the Event column.


Impacts are propagated as follows:


◆ To a service offering whenever an event occurs on a member of the service offering.


◆ To the business process that is served by an impacted business process.


◆ To one service subscriber from another whenever an event occurs on a service offering 
or business process associated with the service subscriber. In addition, impacts are 
propagated to service subscribers from the other service subscribers that are part of 
it. For example, impacts are propagated to an Organization from an impacted 
Department that is part of the Organization.


When viewing an impacted business element in a Business Services map in the Map 
Console, the color of the severity bar associated with the element corresponds to the 
severity level of the notification. Double-clicking the element displays the details of the 
notification.
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Automatically propagated impact notification scenario
An example of the automatic propagation of impact notifications is shown in Figure 4 on 
page 28. In this example, the Trade Settlement BusinessProcess depends on a Trade 
Settlement Application.


Figure 4  Automatically propagated impact notification scenario


When viewing the Business Services map, remember that it shows dependent 
relationships through arrowed lines: The arrowed lines point from a business element to 
the element that the business element depends on. Impact notifications propagate in the 
direction opposite to that of the arrowed lines: The impact notifications propagate to a 
business element from the element that the business element depends on.


To aid in understanding, read the relationships in Figure 4 on page 28 from top to bottom 
and left to right. For example, TradeAccntgFinCntr (Trade Accounting Financial Center) is 
served by Trade Netting, and Trade Netting is served by Trade Settlement.


When the Trade Settlement Application is Degraded (severity level 2, Major notification), 
the degradation causes Business Impact Manager to generate an impact notification for 
the Trade Settlement BusinessProcess.


Thus, Trade Settlement Application Degraded causes Trade Settlement Impacted. From 
Trade Settlement BusinessProcess, the impact notification propagates to any dependant 
business processes—that is, any business processes that Trade Settlement serves. These 
are the Trade Reconciliation and TradeAccntgFinCntr BusinessProcesses.
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The Trade Reconciliation Impacted and TradeAccntgFinCntr Impacted notifications then 
propagate further to any business processes served by these processes: to the Trade 
Netting BusinessProcess from TradeAccntgFinCntr Impacted and, once again, to 
TradeAccntgFinCntr from Trade Reconciliation Impacted.


As a result, Business Impact Manager generates an impact notification for Trade 
Settlement, Trade Reconciliation, TradeAccntgFinCntr, and Trade Netting.
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CHAPTER 3
Viewing Business Analysis Results and Topology


This chapter describes how to use the Global Console to view business impact 
notifications, business topology elements, and Business Services maps, and to manually 
create business impact notifications. It consists of the following sections:


◆ Before you start.......................................................................................................  32
◆ Attaching the Global Console to the Global Manager ...............................................  32
◆ Business impact notifications .................................................................................  33
◆ Business topology ..................................................................................................  37
◆ Business Services maps..........................................................................................  37
◆ Business Process tools............................................................................................  44
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Before you start
The console operations described in this chapter are controlled by certain console 
operation options such as Notification Properties and Expand Map Node. The EMC Smarts 
Service Assurance Manager Configuration Guide provides instructions on changing the 
console operations.


Also, accessing the consoles described in this chapter requires attaching the Global 
Console to the Global Manager (for example, INCHARGE-SA) in your deployment. The EMC 
Smarts Service Assurance Manager Operator Guide provides information about starting 
the Global Console, logging in, and attaching to a Manager.


Console access is controlled by the user profile associated with your EMC Smarts user 
account. You do not need a user account with administrative privileges to access the 
consoles described in this chapter.


Attaching the Global Console to the Global Manager
To attach the Global Console to the Global Manager in your deployment:


1. Start the Global Console.


• On a Windows system, select Start > Programs > InCharge > EMC Smarts Global 
Console.


The Attach Manager dialog box opens as shown in Figure 5 on page 32.


Figure 5  Attach Manager dialog box


2. In the dialog box:


a. Ensure that the EMC Smarts Broker for your deployment appears in the Broker text 
box.


b. Click the Manager list box or the Browse button to display a list of active (running) 
Domain Manager, and from that list select the Global Manager application (for 
example, INCHARGE-SA) in your deployment as the Domain Manager to which you 
want to connect.


c. Type your login username and password. (The default administration login is 
username admin and password changeme.)


d. Click OK.


localhost:426
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The Notification Log Console view of the Global Console opens as shown in Figure 6 on 
page 33.


In the figure, the Notification Log Console is attached to a Global Manager application 
named INCHARGE-SA.


Figure 6  Notification Log Console—example


The Notification Log Console is one of many console views composing the Global Console. 
One other console view of particular interest to the discussions that follow is the Map 
Console, which graphically represents topology in a map format.


The EMC Smarts Service Assurance Manager Operator Guide provides detailed 
information on using the Global Console.


Business impact notifications
Business Impact Manager passes the results of its impact analysis in the form of 
notifications to the Global Manager. The Global Manager, in turn, combines these 
notifications with the notifications received from underlying Domain Managers such as IP 
Availability Manager and then passes the notifications to the Global Console, where they 
are presented in a tabular form in the Notification Log Console.


Each notification consists of a set of attributes that describe properties of the notification, 
such as Class, Name, Event, Source, and Impact. The value in the Name attribute is the 
display name of the notification; “Understanding names and display names” on page 54 
describes the naming formats used to create business element names. For a root-cause 
problem notification impacting (affecting) business elements or the infrastructure or 
application elements that support those business elements, Business Impact Manager 
sets the notification’s Impact attribute to the sum of the weights of the impacted 
elements; the larger the numeric value, the larger the impact.


The severity of a notification is reflected by its color, where red indicates the highest 
severity level.
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Viewing business impact notifications


You can view the notifications through the Global Console in two basic ways:


◆ As tabular entries in a Notification Log Console view


Included with the Notification Log Console view (or any other view where you can see 
notifications) is a Notification Properties dialog box for viewing detailed information 
about an individual notification.


◆ As color-coded severity bar icons in a Map Console view


In a map, a color-coded severity bar icon appears underneath nodes (graphical 
representations of topology elements) that are affected by abnormal conditions 
denoted in notifications.


Opening a business Notification Properties dialog box


To obtain detailed information about an individual business impact notification, you can 
use any of the following common methods to open the Notification Properties dialog box:


◆ Double-click a business impact notification in the Notification Log Console.


◆ Select a business impact notification in the Notification Log Console and then click 
Show Notification Properties.


◆ Right-click a selected business impact notification and then select Properties in the 
pop-up menu.


◆ Double-click a business map icon (in the Map Console) affected by active events.
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Figure 7 on page 35 is an example of a Notification Properties dialog box showing detailed 
information for a ServiceOffering Impacted notification diagnosed by Business Impact 
Manager.


Figure 7  Notification Properties dialog box showing a ServiceOffering Impacted notification


In Figure 7 on page 35, the setting No for attributes IsProblem and IsRoot indicates that 
the ServiceOffering Impacted notification is not a root cause.


Table 1 on page 35 shows the three possible value combinations for these two attributes 
and what the combinations mean. 


Table 1  Possible value combinations for IsProblem and IsRoot attributes


IsProblem value IsRoot value Meaning


Yes Yes Indicates that this notification is a root-cause 
problem diagnosed by an underlying Domain 
Manager using event-correlation analysis.


No Yes Indicates that this notification is an event 
computed by an underlying Domain Manager when 
a certain polled metric equals or exceeds a 
threshold. The event is a root cause unto itself.


No No Indicates that this notification is an impact event 
generated by a listening Business Impact Manager 
or by an underlying Domain Manager, or is an 
informational event originating from the managed 
network and forwarded by the underlying Domain 
Manager to the Global Manager.
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Except for notifications created for BusinessProcess elements using the tools described in 
“Business Process tools” on page 44, no root-cause problems are defined for business 
elements.


By default, the IsProblem and IsRoot attributes columns do not appear in the Notification 
Log Console. To add the IsProblem attribute column:


1. Right-click an attribute in column heading (for example, Class) in the Notification Log 
Console. 


2. Select Insert Column in the pop-up menu. 


3. Then select IsProblem in the submenu. The IsProblem column is inserted to the left of 
the selected column. 


4. Repeat this procedure to add the IsRoot attribute column.


Viewing the cause of a business impact notification


You view the cause of a business impact notification by clicking the Caused By tab in the 
Notification Properties dialog box. The Caused By tab lists the problem that caused the 
notification.


For example, Figure 8 on page 36 identifies the problem that caused the ServiceOffering 
Impacted notification shown in Figure 7 on page 35.


Figure 8  Caused By tab showing the problem that caused the ServiceOffering Impacted notification

36 EMC Smarts Business Impact Manager User Guide







Viewing Business Analysis Results and Topology

When the problem causing a business impact notification is cleared, the business impact 
notification is also cleared. A cleared business impact notification has its Active attribute 
set to No and its IsRoot attribute set to Yes. The Caused By tab does not appear in the 
Notification Properties dialog box in case of a cleared business impact notification.


Business topology
The Global Manager loads instances of the following topology element types from the 
import datafiles of the Business Impact Manager. The topology includes offering types, 
subscriber types, and hierarchical groups:


◆ Offering types:


• ServiceOffering


• BusinessProcess


◆ Subscriber types:


• ServiceSubscriber


• Customer


• Organization


• BusinessUnit


• LOB


• Department


◆ Hierarchical groups:


• HierarchicalGroup


“Business Impact Manager elements” on page 24 and “Text import datafile 
service.data.template” on page 56 describe the offering type and subscriber type 
topology elements. “Text import datafile topology-group.data.template” on page 62 and 
the EMC Smarts Service Assurance Manager Configuration Guide describe the hierarchical 
group topology elements.


Business Services maps
The Global Console presents the business topology information in a variety of dynamically 
updated formats that show the status of the business and group elements and their 
relationships. One of those formats is the Business Services map, which is a graphical 
representation of the business topology.


Viewing Business Services maps is an easy and quick way to learn more about the source 
and cause of business impact notifications. You can view Business Services maps using 
the Map Console view.


The Business Services map shows business, group, infrastructure, and application 
elements. The infrastructure and application elements support the ServiceOffering and 
BusinessProcess business elements and include devices, software services, and groups 
of devices or software services (HierarchicalGroups).
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The relationships between the business, group, infrastructure, and application elements 
are defined in the Business Impact Manager import datafiles. The infrastructure and 
application elements are discovered by the underlying Domain Managers.


Opening a Business Services map


You can use any of the following common methods to open a Business Services map:


◆ Open the Map Console by selecting the Show Map menu option from any opened 
console attached to the Global Manager. For example, in the Notification Log Console, 
click a business impact notification and then select Event > Show Map, or right-click 
the notification and then select Show Map in the pop-up menu. In the Topology 
Browser Console, right-click a business element and then select Show Map in the 
pop-up menu.


◆ Open the Map Console from the Global Console by selecting File > New > Map Console. 
In the topology tree of the Map Console, click an element to display a map for the 
element, or right-click an element and then select Business Services from the pop-up 
menu. If the Business Services option is not available (dimmed) in the pop-up menu, 
a Business Services map is not available for the element.


◆ In an opened topology map, right-click a map icon and then select Business Services 
from the pop-up menu.


If an infrastructure or application element has a relationship to ServiceOffering or 
BusinessProcess elements, the Business Services map is available for that infrastructure 
or application element in the Topology tab of the Map Console. Likewise, for groups with 
relationships to ServiceOffering or BusinessProcess elements, the Business Services map 
is available for the group in the Groups tab of the Map Console.


Business Services map pop-up menus


Two types of pop-up menus are available in a Business Services map:


◆ Right-click a selected node in the map


Opens a pop-up menu that enables you to select any of the map types available to the 
selected node (for example, Business Services, Physical Connectivity), to display 
notification properties (if any) for the selected node, and so on. For a node marked 
with a plus sign (+), the Expand Node menu option allows you to expand the node to 
see all nodes that are physically or logically connected to the node. 


◆ Right-click an open space in the map


Opens a pop-up menu that enables you to display a circular layout of the map, to 
manually position nodes in the map, and so on. The Reset map menu option enables 
you to reset changes made to the map or to return to the saved map display.
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In the topology tree of a Map Console, a pop-up menu is also available when you 
right-click an object. This menu enables you to select any of the map types available to the 
selected object, to display notification properties (if any) for the selected object, and so 
on.


The EMC Smarts Service Assurance Manager Operator Guide provides detailed 
descriptions of map menus and pop-up menus available for the Map Console.


Business Services map graphical representations


In a map display, a node is a graphical representation of a topology element, and an edge 
is a graphical representation of a relationship or connection between elements.


Table 2 on page 39 identifies and describes the default nodes and edges that may appear 
in a Business Services map. In the Map Console, you can also select Map > Map Legend to 
see a similar list. 


Table 2  Default icons and edges for the Business Services map (page 1 of 2)


Icon / visual indicator Description


Icon represents a ServiceOffering (business element).


Icon represents a BusinessProcess (business element).


Icon represents a ServiceSubscriber (business 
element).


Icon represents a Customer (business element).


Icon represents an Organization (business element).


Icon represents a BusinessUnit (business element).
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Your system administrator may replace the default map nodes with other map nodes that 
are preferred by your organization. In that case, use Map > Map Legend to see the 
definitions of your map nodes.


You can customize the font and point size of the map icon text. The default map icon font 
is Helvetica. The default map icon font size is 12 point. The font and font size properties 
are modified in the webconsole.properties and dashboard.properties files. “Adjusting 
Java properties” in the EMC Smarts Service Assurance Manager Operator Guide provides 
detailed information.


Icon represents a line of business (LOB) (business 
element).


Icon represents a Department (business element).


Icon represents a HierarchicalGroup.


Icon represents a DatabaseServer.


Icon represents a SoftwareService.


Solid line with arrow represents dependency.


Dotted line with arrow represents dependency, 
composition, and membership.


Table 2  Default icons and edges for the Business Services map (page 2 of 2)


Icon / visual indicator Description
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Business Services map example


In the Business Services map examples presented in this section, an Organization named 
Acme uses an order management process flow. The flow includes five distinct business 
processes:


◆ Demand Planning develops product and market forecasts to ensure that Acme can 
meet customer demands. This process does not rely on a specialized application.


◆ Order Management uses an SAP application to support all order management 
functions, including scheduling and generating parts lists.


◆ Fulfillment relies on FedEx fulfillment services to deliver orders to customers.


◆ Accounting provides customer billing, accounts receivable, and accounts payable 
functions for Acme. These functions are supported by (1) an SQL database that stores 
financial data and (2) the Oracle Financials application for bookkeeping.


◆ Customer Relationship Management (CRM) attempts to ensure customer satisfaction 
after order delivery by providing product support, refund processing, and warranties. 
CRM uses the Siebel applications for this purpose.


The Business Services map, shown in Figure 9 on page 41 shows how the order 
management process flow is mapped in Business Impact Manager. Acme appears in the 
topology tree under Organization. When Acme is selected in the topology tree, the 
Business Services map appears. In the figure, the Business Services map was expanded 
to show all elements.


Figure 9  A fully expanded Business Services map


The Business Services map shows that the Organization named Acme relies on five 
BusinessProcesses through the dependencies. Four of the BusinessProcesses consist of 
at least one SoftwareService; two BusinessProcesses also consist of a DatabaseServer.
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When viewing a Business Services map, you might find it useful to manually rearrange the 
icons so that the logic of the Organization’s business processes is more evident. For 
example, after manually rearranging the icons, the linear relationship of the 
BusinessProcesses is obvious in Figure 10 on page 42:


◆ The BusinessProcesses include DemandPlanning, OrderManagement, Fulfillment, 
Accounting, and CRM. Remember that the arrowed lines indicate dependencies—not 
data flow. Therefore, OrderManagement depends on, or is served by, 
DemandPlanning. Fulfillment is served by OrderManagement, and so on.


◆ SoftwareServices include SAP, FedExFulfillment, OracleFinancials, and Siebel. Dashed 
arrowed lines indicate dependency and composition: for example, the 
OrderManagement BusinessProcess consists of the SAP application, and the 
Fulfillment BusinessProcess consists of the FedExFulfillment application.


◆ The DatabaseServers are SQLFinancialRepository and SQLServerRepository. Once 
again, dashed arrowed lines indicate dependency and composition, so the 
Accounting BusinessProcess consists of the SQLFinancialRepository data server, and 
the CRM BusinessProcess consists of the SQLServerRepository data server.


Figure 10  A manually arranged Business Services map showing an organization’s business 
processes
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When an event occurs, Business Impact Manager calculates the business impact of the 
event and propagates impact notifications to the affected business elements. Figure 11 
on page 43 shows how impacts are automatically propagated in the example. A Degraded 
event occurs at the Siebel SoftwareService, which indicates Major status (severity 2). An 
impact notification results at the CRM BusinessProcess, which also indicates Major status 
(severity 2). No other BusinessProcesses are served by CRM, so there is no further 
propagation of the impact.


Figure 11  Notification propagation in a Business Services map for an organization
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Business Process tools
Through the Global Console, you can access a set of server tools to create, modify, or clear 
BusinessProcess notifications. The tools are called Business Process tools.


EMC Smarts Service Assurance Manager Configuration Guide provides details on the 
server tools.


BusinessProcess elements are typically affected by performance degradation or failures in 
infrastructure or application elements, and are displayed as impact notifications. 
However, business leaders, for example, directors and managers, as well as other 
authorized personnel, can use the Business Process tools to create root-cause problem 
notifications for BusinessProcess elements when they notice disruptions in processes.


For example, a financial officer of a business unit can create a root-cause notification if the 
officer sees that the Accounts Receivable process is impacted by external activities such 
as construction in the building that prevents access to the Accounts Receivable office. The 
problem with the process can then be resolved in a timely manner.


Notify Business Process Event tool


This tool enables you to create a notification on a BusinessProcess element. In the dialog 
box, shown in Figure 12 on page 44, you must provide an event name (other than 
“Impacted”) for Event Name and a severity level (1, 2, 3, 4, or 5) for Severity. Event Text is 
optional.


Figure 12  Notify Business Process Event dialog box


The Notify Business Process Event tool is accessed from the Topology Browser Console or 
from a Business Services map in a Map Console by right-clicking an instance of a 
BusinessProcess element and selecting Notify Business Process Event from the Server 
Tools menu.


The attribute values automatically assigned to a manually created BusinessProcess 
notification are listed in Table 3 on page 44. 


Table 3  Attribute values for manually created business process notifications (page 1 of 2)


Attribute Value


Category BusinessNotification


Certainty 100


ClearOnAcknowledge FALSE


EventType DURABLE
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Update Business Process Event tool


This tool enables you to change the Event Text and Severity values of a BusinessProcess 
notification created using the Notify Business Process Event tool. In the dialog box, shown 
in Figure 13 on page 45, you have the option to update the values for Event Text and 
Severity. If the values are not updated, the current values remain.


Figure 13  Update Business Process Event dialog box


The Update Business Process Event tool is accessed from the Notification Log Console by 
right-clicking a BusinessProcess notification and selecting Update Business Process Event 
from the Server Tools menu.


Clear Business Process Event tool


This tool enables you to clear a BusinessProcess notification created using the Notify 
Business Process Event tool. In the dialog box, shown in Figure 14 on page 45, you can 
update the Event Text.


Figure 14  Clear Business Process Event dialog box


The Clear Business Process Event tool is accessed from the Notification Log Console by 
right-clicking an active BusinessProcess notification and selecting Clear Business Process 
Event from the Server Tools menu. 


Expiration 0


InMaintenance FALSE


SourceDomainName INCHARGE-SA (Global Manager name)


Table 3  Attribute values for manually created business process notifications (page 2 of 2)


Attribute Value
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Business Process tools notification scenario


Figure 15 on page 46 illustrates an impact notification created with the Business Process 
tools. In the figure, the BusinessProcess Customer Relationship Management (CRM) 
depends on an application, Customer Service, for its operations. When Customer Service 
is degraded or down, CRM is degraded or down.


Figure 15  Business Process tools notification scenario


When viewing the Business Services map, remember that it shows dependent 
relationships through arrowed lines: The arrowed lines point from a business element to 
the element that the business element depends on. Impact notifications propagate in the 
direction opposite to that of the arrowed lines: The impact notifications propagate to a 
business element from the element that the business element depends on.


To aid in understanding, read the relationships in Figure 15 on page 46 from top to bottom 
and left to right. For example, CRM consists of Customer Service, and Accounting is served 
by CRM.


For example, if the customer service representatives decide to go on strike at Ace 
Industries, their manager can use the Business Process tools to create an 
UnusualSituation root event on CRM with a severity level 1, critical. Business Impact 
Manager will also create an impact notification on the affected BusinessProcess CRM, also 
with severity level 1, critical.


In addition, the CRM notification propagates through the ServedBy relationship to the 
business process of Accounting. As a result, Business Impact Manager generates an 
impact notification for Accounting. 


Thus, the CRM UnusualSituation notification causes CRM and Accounting Impacted 
notifications.


ServedBy


ConsistsOf


CRMAccounting
FulfillmentOrder


Management
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Service


E-Commerce
Orders
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CHAPTER 4
Setting Up and Using Business Impact Manager


This chapter describes the Global Manager datafiles relevant to Business Impact Manager, 
describes their content, and provides instructions for configuring and importing them into 
Business Impact Manager. It consists of the following sections:


◆ Configuration overview ...........................................................................................  48
◆ Understanding names and display names...............................................................  54
◆ Defining business service and hierarchical group topology......................................  55
◆ Defining business weights ......................................................................................  63
◆ Defining business event filters ................................................................................  67
◆ Specifying text or XML datafiles...............................................................................  68
◆ Reloading service and group elements ....................................................................  72
◆ Reloading weight and event filter elements .............................................................  73
◆ Using a utility to convert text service and group definitions to XML ..........................  73
◆ Merging pre-9.1 business-related rules files with rules files of 9.1 and later 


installations............................................................................................................  74
◆ Adding the Global Manager as a topology source ....................................................  76
◆ Specifying a different Global Manager source..........................................................  78
◆ Enabling maintenance tracking ...............................................................................  80
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Configuration overview
The Maintenance and Business Impact Manager (MBIM) is a separate service and server, 
and must be started so that the Business Impact Manager works correctly.


Figure 16  Data imported when the Global Manager is added as a topology source


As part of the MBIM configuration, the Service Assurance Manager server must be added 
as the topology source for the MBIM server. Figure 16 on page 48 identifies the data 
imported by the Maintenance and Business Impact Manager server when the Global 
Manager is added as a topology source to the Maintenance and Business Impact Manager 
server.


Adding BIM Domain as INCHARGE-SAM-MBIM-SUITE Domain Type


To add the BIM Domain in the available Domains:


1. In EMC Smarts Global Console, select Configure > Global Manager Administration 
Console.


2. In the Global Manager Administration Console, expand INCHARGE-SA (SAM Server) > 
ICS Configuration > IC Domain Configuration > Domains. 


3. Right-click Domains > New Domain. The Domain Creation Wizard appears.


Service & group
topology


Business Impact 
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import datafiles


Global Console


Weights


Event filters


Business Impact
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Topology Builder
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Group Builder


Group topology


Global Manager


Domain Manager 
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Figure 17  Global Administration Console for creating a new domain


4. In the Domain Creation Wizard, type INCHARGE-MBIM as Domain Name.


5. Click Next.


6. Select Select Existing Type.


7. Select INCHARGE-SAM-MBIM-SUITE from the Select Type list box.
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Figure 18  Domain Creation Wizard for Select Existing Type


8. Click Launch Server Reconfiguration to reconfigure SAM.


Adding Service Assurance Manager as topology source to MBIM server


To add the Service Assurance Manager as a topology source to MBIM:


1. In the Domain Manager Administration Console, select INCHARGE-MBIM from the 
Manager list box, and select Topology > Add Source to launch the Add Source dialog 
box.


2. In the dialog box, as shown in Figure 19 on page 50, select SA from the Element Type 
list box, type the name of the Service Assurance Manager server (for example, 
INCHARGE-SA) in the Element Name field, and then click OK to add the Service 
Assurance Manager server as a topology source.


Figure 19  Add Source dialog box for the Service Assurance Manager server


INCHARGE-SA


SA
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The Service Assurance Manager server contains the complete set of Business Impact 
Manager topology object data and contains Business Impact Manager maps, too. The 
MBIM server only imports the minimum required Business Impact Manager data to 
perform business impact analysis. The MBIM server does not contain a complete set of 
Business Impact Manager object data.


Import datafiles


Two sets of user-configurable import datafiles, identified in Figure 20 on page 51 and 
Figure 21 on page 52, are available with the Global Manager. “Defining business service 
and hierarchical group topology” on page 55, “Defining business weights” on page 63, 
and “Defining business event filters” on page 67 describe how to define entries in the 
import datafiles.


“Specifying text or XML datafiles” on page 68 describes how to specify which text-format 
or XML-format import datafiles are loaded by the Global Manager, for subsequent import 
by Business Impact Manager. 


Regardless of the selection (TEXT or XML), the Global Manager will load and the Business 
Impact Manager will import the event filter import datafile.


Figure 20  Text import datafiles for Business Impact Manager


File definitions:
service.data.template


ics-default.xml


weights.conf


topology-group.data.template


Text import datafile containing business service 
topology definitions in text format


XML file containing default configuration settings 
for the Global Manager


Text import datafile containing weight definitions 
in text format


Text import datafile containing hierarchical group 
topology definitions in text format


BASEDIR


conf


smarts


ics


service.data.template


topology-group.data.template


weights.conf


ics-default.xml


names listed in businessconfig section of
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Figure 21  XML import datafiles for Business Impact Manager


Topology Builder


In addition to defining business service topology in text or XML import datafiles, users can 
also use the Topology Builder to create or modify business service topology. The Topology 
Builder is described in Chapter 5, “Creating Business Elements with the Topology 
Builder.”


Note that elements or relationships created by the Topology Builder can be removed only 
by the Topology Builder. Similarly, the Topology Builder Console cannot remove any 
elements or relationships created or established using the import datafiles.


The Topology Builder can also delete service information created using other means, such 
as an ASL script or using the create operation with the dmctl utility.


File definitions:
service-group-data-sample.xml XML import datafile containing sample business 


service and hierarchical group topology 
definitions in XML format


service-group-data.xml XML import datafile containing no topology; to be 
used to enter business service and hierarchical 
group topology definitions in XML format


BASEDIR


conf


smarts


ics


service-group-data-sample.xml bim-config.dtdweights-conf.xml


event-filter-conf.xml


formats defined in


service-group-data.xml


weights-conf.xml


bim-conf.dtd


event-filter-conf.xml


XML import datafile containing weight definitions 
in XML format


Data type definition file containing XML formats 
for business services, hierarchical groups, 
weights, and event filters


XML import datafile containing event filter 
definitions in XML format
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Group Builder


In addition to defining hierarchical group topology in text or XML import datafiles, users 
can also use the Group Builder (also known as a Group Definitions window) to create or 
modify hierarchical group topology. The EMC Smarts Service Assurance Manager 
Configuration Guide describes the Group Builder.


Automatic conversion of text service and group definitions to XML


Users can use a Service Assurance topology export utility to convert text-format service 
and group definitions to XML-format definitions and write the definitions to an XML 
service-group import datafile. “Using a utility to convert text service and group definitions 
to XML” on page 73 provides the procedure for performing the conversion.


File migration from an old installation to a new installation


When migrating from an old Service Assurance Manager installation to a new Service 
Assurance Manager installation, users must manually merge any modified 
business-related rules files with the same files in the new installation. “Merging pre-9.1 
business-related rules files with rules files of 9.1 and later installations” on page 74 
identifies the files to be merged and provides the procedure for merging the files.


InMaintenance attribute processing


For a business impact notification created solely from causal infrastructure or application 
notifications associated with devices in maintenance mode, Business Impact Manager will 
set the InMaintenance attribute of the business impact notification to TRUE.


Put another way, Business Impact Manager will set the InMaintenance attribute of a 
business impact notification to TRUE when the InMaintenance attribute of each of the 
underlying causal infrastructure or application notifications is set to TRUE. If the 
InMaintenance attribute of at least one underlying causal notification is FALSE, Business 
Impact Manager will set the InMaintenance attribute of the business impact notification to 
FALSE.


An administrator can configure a notification list and associate it with a user profile to 
determine whether users of the user profile will see, in their Notification Log Console, 
those business impact notifications having InMaintenance=TRUE. The EMC Smarts 
Service Assurance Manager Configuration Guide provides instructions for creating and 
modifying notification lists.


Global Manager sourcing


Adding the Global Manager as a topology source to Business Impact Manager enables 
Business Impact Manager to import business service and hierarchical group topology, 
weights, and event filters from the Global Manager. “Adding the Global Manager as a 
topology source” on page 76 provides instructions for completing this task.
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Understanding names and display names
Each element in the Global Manager’s repository must have a unique name. When you 
create a topology element, the Global Manager assigns a predetermined prefix to each 
element’s name to prevent naming conflicts with other topology elements. Table 4 on 
page 54 lists the prefixes for the business elements managed by Business Impact 
Manager. 


In addition to a Name, each element is also given a DisplayName, which is easier to read 
and understand. The DisplayName does not include the element prefix.


When you create topology elements using topology import datafiles or the Topology 
Builder, specify the DisplayName. The Global Manager automatically creates the Name by 
adding the prefix to the DisplayName.


When topology elements are created by other means, for example, through a custom 
adapter, the Name of the element must include the prefix while the DisplayName should 
not. Elements created using these methods must observe the naming conventions used 
by EMC Smarts software.


Table 4  Prefixes for business element names


Prefix Business element


SRVO- ServiceOffering


BP- BusinessProcess


SRVS- ServiceSubscriber


ORG- Organization


BU- BusinessUnit


LOB- Line of business (LOB)


DEP- Department


CUS- Customer


HGRP HierarchicalGroup
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Defining business service and hierarchical group topology
For Business Impact Manager to import business service and hierarchical group topology 
from its source Global Manager, you define business service and hierarchal group 
topology in the two text import datafiles or the single XML import datafile identified in 
Figure 22 on page 55. The datafiles are located in the Service Assurance installation area 
from which the source Global Manager is invoked.


Figure 22  Business service and hierarchal group import datafiles for Business Impact Manager


Whether you choose to use the two text import datafiles or the single XML import datafile 
to define service and group elements, the Global Manager will load the elements in the 
same way: At startup, the Global Manager loads the service and group elements and store 
them in its repository. “Specifying text or XML datafiles” on page 68 describes how to 
specify the import of text-format or XML-format import datafiles. 


This section focuses on defining service and group elements in the service.data.template 
and topology-group.data.template files, respectively. Defining service and group elements 
in the service-group-data.xml file is identical to defining service and group elements in the 
two text files except that the definitions are in XML format. The format of the 
service-group-data.xml file (and the service-group-data-sample.xml file) is defined in the 
BASEDIR/smarts/conf/ics/bim-config.dtd file.
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service.data.template
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Text import datafiles (default) XML import datafiles
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Text import datafile service.data.template


All lines in the original service.data.template file are commented-out (preceded with a 
pound sign), meaning that by default the Global Manager does not load any business 
service definitions from the service.data.template file.


The discussions that follow assume that the name of the service import datafile is 
service.data.template. Of course, when editing the service.data.template file to create a 
service import datafile, as explained in “Procedure for creating a service import datafile” 
on page 61, you can save the file as a new name.


Input format
The input format of the service.data.template file is based on Offering Types and 
Subscriber Types, where:


◆ Offering Types represent any of the following ICIM classes:


• ServiceOffering


• BusinessProcess


◆ Subscriber Types represent any of the following ICIM classes:


• ServiceSubscriber


• Customer


• Organization


• BusinessUnit


• LOB


• Department


These ICIM classes compose the business data model, which is described in “Business 
Impact Manager elements” on page 24.


Relationship keywords
The following portion of the service.data.template file shows the relationship keywords (in 
bold) that can be stated between Offering Types and Subscriber Types, between 
Subscriber Types and Subscriber Types, and between Offering Types and underlying 
infrastructure elements and applications. The serves and servedby relationships are valid 
for the BusinessProcess Offering Type but not for the ServiceOffering Offering Type:


# <Offering Type> <service> subscribers <Subscriber Type>::<subscriber1> ...
# <Offering Type> <service> subscribers file:<//foo/bar/service.subscribers>
# <Offering Type> <service> members <class1>::<instance1> ...
# <Offering Type> <service> members file:<//foo/bar/service.members>
#
# <Subscriber Type> <subscriber> subscriptions <Offering Type>::<service1> ...
# <Subscriber Type> <subscriber> composedof <Subscriber Type>::<subscriber1> ...
# <Subscriber Type> <subscriber> partof <Subscriber Type>::<subscriber1> ...
#
# BusinessProcess <bProcess> serves <bProcess1> ...
# BusinessProcess <bProcess> servedby <bProcess1> ...


Relationships enable Business Impact Manager to associate business elements with each 
other, and with underlying infrastructure elements and applications. Relationships also 
identify dependencies of elements on other elements, and identify groupings. Examples:
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◆ subscriptions
(corresponds to the ICIM-defined relationship named Subscriptions):


Associates a Subscriber Type to one or more Offering Types that are being provided to 
the Subscriber Type.


◆ subscribers
(corresponds to the ICIM-defined relationship named Subscribers):


Associates an Offering Type to one or more Subscriber Types who subscribe to the 
Offering Type.


◆ members
(corresponds to the ICIM-defined relationship named ConsistsOf):


Associates an Offering Type to one or more underlying infrastructure, application, or 
hierarchical group elements that are directly relied upon by the Offering Type. The list 
of underlying elements might be a list of network elements (hosts, routers, and so on), 
a list of applications, or a HierarchicalGroup.


◆ servedby
(corresponds to the ICIM-defined relationship named ServedBy):


Associates a BusinessProcess to one or more other BusinessProcesses that serve the 
BusinessProcess.


Syntax
The syntax for defining business services in the service.data.template file is as follows:


<class> <instance> <relationship keyword> <related_instance>


◆ <class> is the name of any Offering Type or Subscriber Type; that is, any business class.


◆ <instance> (<service>, <subscriber>, <bProcess>) is the DisplayName name of the 
instance to be created.


“Understanding names and display names” on page 54 describes the DisplayName 
and Name naming conventions.


◆ <relationship keyword> is the name of the relationship keyword and can be one of the 
following:


• subscriptions/subscribers


• members


• servedby/serves


• composedof/partof


◆ <related_instance> is the name (<class_name>::<instance> or just <instance>) of a 
related instance Offering Type, Subscriber Type, member, or application. One or more 
<related_instance> fields may appear in a business service definition. If the members 
relationship is specified, <related_instance> is a name in <class_name>::<instance> 
format. In such a case, the instance must already exist in the topology.


In all cases, except when the members relationship is specified, the class name 
(<class_name>) in a <related_instance> name is optional. When the class name is not 
specified, Business Impact Manager makes the following assumptions, when:
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◆ <relationship keyword> is subscriptions, the default class for <related_instance> is 
ServiceOffering.


◆ <relationship keyword> is subscribers, the default class for <related_instance> is 
ServiceSubscriber.


◆ <relationship keyword> is servedby or serves, the default class for <related_instance> is 
BusinessProcess.


◆ <relationship keyword> is composedof or partof, the default class for 
<related_instance> is ServiceSubscriber.


Business service definition examples
In the following examples, relationship keywords are indicated in bold type.


Here is a ServiceSubscriber example:


ServiceSubscriber subscriber1 subscriptions service1 service2 
BusinessProcess::bProcess1


This business service definition results in the creation of the ServiceSubscriber element 
subscriber1 and the ServiceOffering elements service1 and service2. The bProcess1 
element will also be created as an instance of the class, BusinessProcess. The 
ServiceOffering class is not specified because the subscriptions keyword implies that 
these elements are instantiated from the ServiceOffering class.


The ServiceOffering example that follows uses similar logic:


ServiceOffering service1 subscribers subscriber1 subscriber2 Customer::customer1


This business service definition results in the creation of the ServiceOffering element 
service1 and the ServiceSubscriber elements subscriber1 and subscriber2. The 
customer1 element will also be created as an instance of the class, Customer. The 
ServiceSubscriber class is not specified because the subscribers keyword implies that 
these elements are instantiated from the ServiceSubscriber class.


When the relationship keyword is serves or servedby, the value of <class> is 
BusinessProcess, and the implied class for <related_instance> is also BusinessProcess:


BusinessProcess bProcess1 serves bProcess2 BusinessProcess::bProcess3
BusinessProcess bProcess1 servedby bProcess4


Here are some more Subscriber Type examples:


Organization organization1 subscriptions service1 BusinessProcess::bProcess1


BusinessUnit business_unit1 subscriptions service1 BusinessProcess::bProcess1


LOB lob subscriptions ServiceOffering::service1 BusinessProcess::bProcess1


Department department subscriptions service1 BusinessProcess::bProcess1


Customer customer subscriptions service1 service2 BusinessProcess::bProcess1


Additionally, Subscriber Type elements can be a part of or composed of other Subscriber 
Type elements. The syntax is:


Organization organization1 composedof BusinessUnit::business_unit1
Department::department1


LOB lob1 partof business_unit1 BusinessUnit::business_unit2
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As business_unit1 does not have a class specified for it, it will automatically be created as 
an instance of ServiceSubscriber.


After a BusinessProcess instance is specified in the service.data.template file, it can be 
specified as a member of a ServiceOffering or HierarchicalGroup that is also defined in the 
service.data.template file:


ServiceOffering service1 members BusinessProcess::bProcess1 Host::H1


HierarchicalGroup group1 members BusinessProcess::bProcess1 Router::R1


A BusinessProcess may consist of SoftwareService elements or other logical elements that 
already exist in the topology:


BusinessProcess bProcess1 members SoftwareService::A1 SoftwareService::A2


For a complete example, the Organization, BusinessProcess, DatabaseServer, and 
SoftwareService elements and their relationships shown in the Business Services map in 
Figure 9 on page 41 through Figure 11 on page 43 are defined as follows:


BusinessProcess CRM servedby BusinessProcess::Accounting


BusinessProcess Accounting servedby BusinessProcess::Fulfillment


BusinessProcess Fulfillment servedby BusinessProcess::OrderManagement


BusinessProcess OrderManagement servedby BusinessProcess::DemandPlanning


Organization Acme subscriptions BusinessProcess::OrderManagement


BusinessProcess OrderManagement members SoftwareService::SAP


BusinessProcess Fulfillment members SoftwareService::FedExFulfillment


BusinessProcess Accounting members SoftwareService::OracleFinancials 
DatabaseServer::SQLFinancialRepository


BusinessProcess CRM members SoftwareService::Siebel 
DatabaseServer::SQLServerRepository


When dealing with large numbers of members in a ServiceOffering, it may become more 
practical to use HierarchicalGroups to represent a group of network elements. Groups may 
be defined in the service.data.template file along with the ServiceOfferings. The EMC 
Smarts Service Assurance Manager Configuration Guide contains additional information 
on defining and importing HierarchicalGroups.
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Optional input files
Listing related (<related_instance>) subscribers, members, or applications is not practical 
because there are too many of them, elements can be listed in separate input files that are 
referenced in the service.data.template file. For example:


BusinessProcess bProcess1 serves bProcess2 bProcess3 bProcess4


is the same as:


BusinessProcess bProcess1 serves file://C:/mydir/myfile


where C:/mydir/myfile consists of three lines:


bProcess2
bProcess3
bProcess4


Input files must be specified in the service.data.template file.


Each element in an input file must use the <class_name>::<instance> syntax with one entry 
per line. Similar to the service.data.template file, Business Impact Manager assumes that 
elements in the input file for an Offering Type having a subscribers relationship keyword 
are ServiceSubscriber elements.


When members are specified, the elements must already exist in the topology so that the 
relevant relationship keyword can be established with the requested element. Otherwise, 
such items will be ignored.


Rules and considerations for creating business service definitions
When defining business service definitions in the service.data.template file, keep the 
following rules and considerations in mind:


◆ Each business element to be included must start with the class name (for example, 
ServiceOffering, ServiceSubscriber).


◆ You can combine ServiceOffering data with group data (HierarchicalGroups) in the 
service.data.template file.


◆ When defining members or subscribers in a separate input file, <file_name> is a file 
that will contain one member or subscriber name per line, as an alternative to listing 
members in the service.data.template file. For members, the <class_name>::<instance> 
syntax is required.


◆ Each relationship must be defined on a separate line.


◆ The same business element can appear in multiple lines (so you do not have to list all 
of the related elements on a single line).


◆ Because a service is created as a ServiceOffering of a subscriber, it does not need to 
be defined separately if it does not have any other subscribers or any members of its 
own. Similarly, when a subscriber appears in a line where an offering is listed, it is 
automatically created. You do not have to define it individually.


◆ The system name of an element does not need to be a fully qualified domain name. 
The truncated system name will be searched for and matched.
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Procedure for creating a service import datafile
You use the service.data.template file as the basis for creating a service import datafile.


To create a service import datafile:


1. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command to open the 
service.data.template file:


sm_edit conf/ics/service.data.template


Press Enter.


2. Add your business service definitions to the file.


3. Save and close the file. The modified version of the service.data.template file is saved 
to the BASEDIR/smarts/local/conf/ics directory in the installation area.


If you saved the service import datafile as a new name, the file is saved as the new name 
in the BASEDIR/smarts/local/conf/ics directory. Perform the procedure in “Specifying text 
or XML datafiles” on page 68 to make the Global Manager aware of the new service import 
datafile. Then, perform the procedure in “Reloading service and group elements” on 
page 72 to force the Global Manager to load the elements defined in the new service 
import datafile.


If you saved the service import datafile as is, the file is saved as service.data.template in 
the BASEDIR/smarts/local/conf/ics directory. If the Global Manager was running before 
you created the file, perform the procedure in “Reloading service and group elements” on 
page 72 to force the Global Manager to load the elements defined in the service import 
datafile.


Thereafter, every time that you modify the service import datafile, perform the procedure 
in “Reloading service and group elements” on page 72 to force the Global Manager to 
reload the elements defined in the service import datafile.
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Text import datafile topology-group.data.template


All lines in the original topology-group.data.template file are commented-out (preceded 
with a pound sign), meaning that by default the Global Manager does not load any 
hierarchical group definitions from the topology-group.data.template file.


The discussions that follow assume that the name of the group import datafile is 
topology-group.data.template. Of course, when editing the topology-group.data.template 
file to create a group import datafile, as explained in “Procedure for creating a group 
import datafile” on page 62, you can save the file as a new name.


Input format and relationship keywords
The following portion of the topology-group.data.template file shows the input format of 
the topology-group.data.template file and the relationship keywords (in bold) that can be 
stated between HierarchicalGroups and children or member groups:


# HierarchicalGroup <group> children <group1> <group2> ...
# HierarchicalGroup <group> members  <class1::instance1> <class2::instance2> ...
# HierarchicalGroup <group> members  file:<//foo/bar/group.members>


The members relationship keyword corresponds to ConsistsOf in the 
ConsistsOf/MemberOf ICIM-defined relationship set, and the children relationship 
keyword corresponds to ChildGroups in the ChildGroups/ParentGroup ICIM-defined 
relationship set.


The EMC Smarts Service Assurance Manager Configuration Guide provides information 
about defining and importing HierarchicalGroups.


Hierarchical group definition examples
In the following examples, relationship keywords are indicated in bold type:


HierarchicalGroup "Groups of SO1" children "Group1 of SO1" "Group2 of SO1"


HierarchicalGroup "Groups of SO1" members file:/foo/bar/g1_so1.members


HierarchicalGroup "Routers of SO1" children Critical


HierarchicalGroup "Routers of SO1" members Router::lab-gw.smarts.com 
Router::ny-sma-1


HierarchicalGroup "Routers of SO1" members file:/foo/bar/routers_so2.members


HierarchicalGroup Critical members Router::moto-gw


HierarchicalGroup G1 children G2


HierarchicalGroup G1 members VLAN::VLAN-1 Cable::IF-172.16.0.0 
IPNetwork::LINK-IF-172.16.0.0


Procedure for creating a group import datafile
You use the topology-group.data.template file as the basis for creating a group import 
datafile.


To create a group import datafile, follow the instructions in “Procedure for creating a 
service import datafile” on page 61; substitute service.data.template with 
topology-group.data.template in the procedure and add your hierarchical group 
definitions to the group import datafile.
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Defining business weights
For Business Impact Manager to import weights from its source Global Manager, you 
define weight elements in the text or XML import datafile identified in Figure 23 on 
page 63. The datafiles are located in the Service Assurance installation area from which 
the source Global Manager is invoked.


Figure 23  Weights import datafiles for Business Impact Manager


Whether you choose to use the text or the XML import datafile to define weight elements, 
the Global Manager will load the elements in the same way: At startup, the Global 
Manager loads the weight elements but does not store them in its repository. “Specifying 
text or XML datafiles” on page 68 describes how to specify the import of text-format or 
XML-format import datafiles.


This section focuses on defining weight elements in the weights.conf file. Defining weight 
elements in the weights-conf.xml file is identical to defining weight elements in the text 
file except that the definitions are in XML format. The format of the weights-conf.xml file is 
defined in the BASEDIR/smarts/conf/ics/bim-config.dtd file.


Text import datafile weights.conf


All but the following lines in the original weights.conf file are commented-out (preceded 
with a pound sign), meaning that by default the Global Manager loads the following 
weight definitions from the weights.conf file:


◆ ClassWeight ICIM_ManagedElement 1


◆ ClassWeight UnitaryComputerSystem 1


◆ ClassWeight ICIM_Service 1


◆ ClassWeight ServiceOffering 1


◆ ClassWeight ServiceSubscriber 1


BASEDIR


conf


smarts


ics


weights.conf


formats defined in


bim-config.dtdweights-conf.xml


Text import datafile (default) XML import datafile
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Impact value calculations


Business Impact Manager calculates a numeric impact value for a root-cause problem 
notification by summing the weights of all of the elements affected by the problem. The 
numeric impact value appears in the Impact column for the problem notification in the 
Notification Log Console.


A weight is a numeric value that you assign to an element (for example, a ServiceOffering, 
a BusinessProcess, or an infrastructure or application element supporting a 
ServiceOffering or BusinessProcess) based on its importance to your business. By 
summing all of the assigned values, Business Impact Manager determines which problem 
notifications have a greater business impact than other problem notifications. Assigning 
weights allows you to apply your own criteria to “weigh” problems based on information 
that is most important to you at any given time; it enables you to prioritize support efforts 
based on business impacts.


Only root-cause problem notifications can have a non-zero Impact value. A notification 
can both cause and be caused by other notifications, as shown in Figure 24 on page 64.


Figure 24  Impact value calculation and impact propagation


Notification N2 is caused by N1, and causes notification N3. However, even if a 
notification causes other notifications, if it is not the root-cause problem notification, its 
Impact value is zero. Only notification N1 has an Impact value greater than zero.


In the figure, note that even if the element denoted in notification N1 has a weight 
assigned to it, Business Impact Manager does not include that weight in the calculated 
impact value for N1. Business Impact Manager includes in its calculation only the weights 
of the elements affected by the problem element.
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Mechanisms for assigning weights


Business Impact Manager uses the weights.conf file to assign weights to ICIM classes and 
instances (elements, objects). By default, Business Impact Manager assigns a weight of 
“1” for each managed infrastructure or business element in the ICIM_ManagedElement 
class. Therefore, if left at this default level, all impacted infrastructure, ServiceOffering, 
BusinessProcess, and ServiceSubscriber elements carry equal “weight” when determining 
an event’s impact.


Strategies for assigning weights


Weight values are assigned to ICIM classes and instances in the weights.conf file.


Weights can be assigned to any class or instance by specifying one of the following 
keywords:


◆ ClassWeight


◆ InstanceNameWeight


◆ InstanceWeight


The syntax in the file is as follows:


ClassWeight <class_name> <value>
InstanceNameWeight <class_name> <DisplayName> <value>
InstanceNameWeight <class_name> <full_instance_name> <value>
InstanceWeight <class_name> <instance_name> <value>


For the keyword InstanceNameWeight, business classes are specified by their 
DisplayName, without a prefix. For all other classes, you must specify the 
<full_instance_name>, or the complete name of the element, including the prefix of the 
element. For <instance_name>, you can specify the DisplayName or you can specify a 
wildcard pattern. The symbols for wildcards are listed and described in the weights.conf 
file.


When you assign weight values to elements, categorize the elements according to their 
importance within your environment. Then, assign greater values to the elements that are 
more important to your business.


For example:


ClassWeight ICIM_ManagedElement 1
InstanceNameWeight BusinessProcess Inventory 4000
InstanceNameWeight Application APP-Inventory Service 4000
InstanceWeight  Router *[Gg][Ww]* 1000


Similarly, you can assign varying weights to service subscribers:


ClassWeight   Organization    1000
ClassWeight   BusinessUnit    1200
ClassWeight   LOB             1400
ClassWeight   Department      1600
ClassWeight   Customer        1800


In Business Impact Manager’s calculations, the weight assigned to an instance takes 
precedence over the weight assigned to a class, and the weight assigned to a subclass 
takes precedence over the weight assigned to the parent class.
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Procedure for creating a weights import datafile


You use the weights.conf file as the basis for creating a weights import datafile.


To create a weights import datafile:


1. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command to open the 
weights.conf file:


sm_edit conf/ics/weights.conf


Press Enter.


2. Add your weight definitions to the file.


3. Save and close the file. The modified version of the weights.conf file is saved to the 
BASEDIR/smarts/local/conf/ics directory in the installation area.


If the Global Manager was running before you created your weights import datafile, 
perform the procedure in “Reloading weight and event filter elements” on page 73 to force 
the Global Manager to load the weight elements defined in the 
BASEDIR/smarts/local/conf/ics/weights.conf file.


Thereafter, every time that you modify the weights import datafile, perform the procedure 
in “Reloading weight and event filter elements” on page 73 to force the Global Manager to 
reload the weight elements defined in the BASEDIR/smarts/local/conf/ics/weights.conf 
file.
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Defining business event filters
For Business Impact Manager to import event filters from its source Global Manager, you 
define event filter elements in the XML import datafile identified in Figure 25 on page 67. 
The datafile is located in the Service Assurance installation area from which the source 
Global Manager is invoked.


Figure 25  Event filter import datafile for Business Impact Manager


At startup, the Global Manager loads the event filter elements but does not store them in 
its repository.


XML import datafile event-filter-conf.xml


All lines in the original event-filter-conf.xml file are commented-out, meaning that by 
default the Global Manager does not load any event filter definitions from the 
event-filter-conf.xml file.


You use the event-filter-conf.xml file to create a table of events for which Business Impact 
Manager will not generate business impact notifications. An event filter definition is 
designated as a ClassName::EventName pair.


The format of the event-filter-conf.xml file is defined in the 
BASEDIR/smarts/conf/ics/bim-config.dtd file.


BASEDIR


conf


smarts


ics


event-filter-conf.xml


formats defined in


bim-config.dtd
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Procedure for creating an event filter import datafile


You use the event-filter-conf.xml file as the basis for creating an event filter import 
datafile.


To create an event filter import datafile:


1. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command to open the 
event-filter-conf.xml file:


sm_edit conf/ics/event-filter-conf.xml


Press Enter.


2. Add your event filter definitions to the file.


3. Save and close the file. The modified version of the event-filter-conf.xml file is saved 
to the BASEDIR/smarts/local/conf/ics directory in the installation area.


If the Global Manager was running before you created your event filter import datafile, 
perform the procedure in “Reloading weight and event filter elements” on page 73 to force 
the Global Manager to load the event filter elements defined in the 
BASEDIR/smarts/local/conf/ics/event-filter-conf.xml file.


Thereafter, every time that you modify the event filter import datafile, perform the 
procedure in “Reloading weight and event filter elements” on page 73 to force the Global 
Manager to reload the event filter elements defined in the 
BASEDIR/smarts/local/conf/ics/event-filter-conf.xml file.


Specifying text or XML datafiles
You use the Business Templates configuration window of the Global Manager 
Administration Console attached to the source Global Manager to specify whether the 
source Global Manager loads, and the Business Impact Manager imports:


◆ The text-format service and group import datafiles (service.data.template and 
topology-group.data.template by default) or the XML-format service-group import 
datafile (service-group-data.xml for example).


◆ The text-format weights import datafile (weights.conf by default) or the XML-format 
weights import datafile (weights-conf.xml).


Open the Global Manager Administration Console


The EMC Smarts Service Assurance Manager Operator Guide provides information about 
starting the Global Console, logging in, and attaching to a Manager. You need a user 
account with administrative privileges to access the Global Manager Administration 
Console. The default administrative account is username admin and password changeme.


“Attaching the Global Console to the Global Manager” on page 32 provides additional 
information.


The EMC Smarts System Administration Guide provides information about changing the 
password for the default administrative account (recommended) and configuring access 
privileges. The EMC Smarts Service Assurance Manager Configuration Guide provides 
information on configuring permissions to perform specific console operations.
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To open the Global Manager Administration Console:


1. Attach the Global Console to the Global Manager in your deployment.


A Notification Log Console opens.


2. In the console, select Configure > Global Manager Administration Console to open the 
Global Manager Administration Console.


Open the Business Templates configuration window


To open the Business Templates configuration window:


1. In the left panel of the Global Manager Administration Console, expand the 
configuration tree to display Business Templates.


2. Click Business Templates to display its configuration window as shown in Figure 26 on 
page 69.


Figure 26  Business Templates configuration window—example


In the Business Templates configuration window, the upper list box determines the 
topology format (TEXT|XML) of the service/group import datafiles, and the lower list box 
determines the format (TEXT|XML) of the weights import datafile, that is, determines 
whether the weights.conf file or the weights-conf.xml file is to be loaded by the Global 
Manager. The text box identifies which service/group import datafiles are currently 
selected for loading by the Global Manager.


With the exception of using the lower list box to determine the weights import datafile, all 
functions available through the Business Templates configuration window pertain to 
selecting which service/group import datafiles are to be loaded by the Global Manager.
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Configure a service/group import datafile list


To configure a service/group import datafile list:


1. In the Business Templates configuration window, select TEXT in the upper list box if 
you want to configure a text service/group import datafile list, or select XML if you 
want to configure an XML service/group datafile list.


2. In the Business Templates configuration window, click Modify List to launch the Edit 
Business Template Files dialog box as shown in Figure 27 on page 70.


Figure 27  Edit Business Template Files dialog box—example


If TEXT is selected in the upper list box of the Business Templates configuration window, 
all files with names matching *.template in the BASEDIR/smarts/local/conf/ics or 
BASEDIR/smarts/conf/ics directory will appear in the Available Template Files list of the 
dialog box, except for any already selected matching text files, which will appear in the 
Selected Template Files list. You can select one or more text service/group import datafiles 
for loading by the Global Manager.


The asterisk (*) is a wildcard character that matches an arbitrary string of characters, 
including an empty string.


If XML is selected in the upper list box of the Business Templates configuration window, all 
files with names matching *service-group-data*.xml in the 
BASEDIR/smarts/local/conf/ics or BASEDIR/smarts/conf/ics directory will appear in the 
Available Template Files list of the dialog box, except for any already selected matching 
XML file, which will appear in the Selected Template Files list. You can select only one XML 
service-group import datafile for loading by the Global Manager.


Be aware that even after the format in the Business Templates configuration window is 
changed to the opposite value, whatever service/group import datafiles are currently 
selected for loading will appear in the Selected Template Files list. For example, if you set 
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the upper list box in Figure 26 on page 69 to XML and click Modify List, the 
service.data.template and topology-group.data.template files will still appear in the 
Selected Template Files list as shown in Figure 28 on page 71.


Figure 28  Edit Business Template Files dialog box—example 2


Of course, all files with names matching *service-group-data*.xml in the 
BASEDIR/smarts/local/conf/ics or BASEDIR/smarts/conf/ics directory will appear in the 
Available Template Files list.


You remove an unwanted, currently selected file from the Business Templates 
configuration by selecting it in the Selected Template Files list and clicking Remove. Or, as 
an alternative, you can remove the file by selecting it in the Business Templates 
configuration window, Figure 26 on page 69, and clicking Remove Selected.


At anytime, you can click Refresh in the Business Templates configuration window to 
populate the window with its original settings.


To modify the list of selected service/group import datafiles:


1. In the Edit Business Template Files dialog box, select a file in the Available Template 
Files list box or in the Selected Template Files list box.


2. Click Add to move an available file to the Selected Template Files list, or click Remove 
to move a selected file to the Available Template Files list.


3. In the Edit Business Template Files dialog box, type the name of a service/group 
import datafile in the New Template File text box.


For TEXT format, you can type the name of any text service/group import datafile 
except a name matching *.xml. For XML format, you can type the name of any XML 
service-group import datafile matching *.xml. The datafile must reside in the 
BASEDIR/smarts/local/conf/ics directory.


4. Click Add to move the new file to the Selected Template Files list.
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5. Click OK to close the dialog box.


6. In the Business Templates configuration window, click Apply to save your changes.


Upon clicking Apply, the underlying software loads a single configuration object named 
ICS_BusinessTemplatesConfiguration::ICS-Business Templates and stores it in the Global 
Manager's repository. The attributes of this object hold most of the settings of the 
Business Templates configuration, including the names of the selected service/group 
import datafiles and the format (TEXT|XML) of the datafiles. An attribute of the 
BIM_Manager::BIM-Manager object holds the format (TEXT|XML) of the selected weights 
import datafile.


To load the topology elements defined in the service/group import datafiles, perform the 
procedure given in “Reloading service and group elements” on page 72. To load the 
weight elements defined in the weights import datafile, perform the procedure given in 
“Reloading weight and event filter elements” on page 73. 


Each time an import datafile is reloaded, the new definition set replaces the current one. 
Any eliminated definition from an import datafile will remove that definition from the 
Global Manager’s memory.


The Global Manager automatically loads the topology elements defined in the 
service/group datafiles whenever it performs a topology synchronization with an 
underlying Domain Manager.


Reloading service and group elements
When you modify the content of a text service import datafile, a text group import datafile, 
or an XML service-group import datafile that has already been loaded by the source Global 
Manager, you must issue a dmctl command to force the Global Manager to reload the 
elements defined in the service and group import datafiles. The dmctl command invokes a 
driver that loads the elements defined in these datafiles.


To reload business service and hierarchical group elements:


1. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command on one line:


dmctl -s <Global Manager name> 
invoke GA_DaemonDriver::ICS-Group-Driver start


Press Enter.


For example:


dmctl -s INCHARGE-SA invoke 
GA_DaemonDriver::ICS-Group-Driver start


2. If prompted for a username and password, specify your user account; for example, to 
specify the default administrative account, enter username admin and password 
changeme.


Each time a service/group import datafile is reloaded, the new definition set replaces the 
current one. Any eliminated definition from a service/group import datafile will remove 
that definition from the Global Manager’s repository.
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Reimporting affects the elements or relationships previously created by a service/group 
data import; it does not affect the elements or relationships created using the Topology 
Builder Console.


Reloading weight and event filter elements
When you modify the content of a weights or event filter import datafile that has already 
been loaded by the source Global Manager, you must issue an sm_adapter command to 
force the Global Manager to reload the elements defined in the weights and event filter 
import datafiles. The sm_adapter command invokes the drivers that load the elements 
defined in these datafiles.


To reload business weight and event filter elements:


1. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command:


sm_adapter -s <Global Manager name> ics/ICS_RemoteConfig.asl


Press Enter.


For example:


sm_adapter -s INCHARGE-SA ics/ICS_RemoteConfig.asl


2. If prompted for a username and password, specify your user account; for example, to 
specify the default administrative account, type username admin and password 
changeme.


Each time a weights or event filter import datafile is reloaded, the new definition set 
replaces the current one. Any eliminated definition from a weights or event filter import 
datafile will remove that definition from the Global Manager’s memory.


Using a utility to convert text service and group definitions to XML
You can use a Service Assurance topology export utility to convert text-format service and 
group definitions to XML-format definitions and write the definitions to an XML 
service-group import datafile. The final location of this XML service-group import datafile 
must be the BASEDIR/smarts/local/conf/ics directory in the installation area.


To automatically convert text service and group definitions to XML:


1. Consult “Specifying text or XML datafiles” on page 68 and select the text service and 
group import datafiles that you want to convert to XML.


2. Consult “Reloading service and group elements” on page 72 and load the topology 
elements defined in the import datafiles selected in step 1 .


3. In the installation area from which the source Global Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command on one line:


dmctl -s <Global Manager name> invoke 
ICS_ConfigurationManager::ICS-ConfigurationManager 
exportConfigFor BIM_Topology > 
<BASEDIR/smarts/local/conf/ics/name of XML datafile into which 
to write the service-group definitions>


Press Enter.
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For example:


dmctl -s <INCHARGE-SA> invoke 
ICS_ConfigurationManager::ICS-ConfigurationManager 
exportConfigFor BIM_Topology > 
/opt/InCharge/SAM/smarts/local/conf/ics/service-group-data.xml


4. If prompted for a username and password, specify your user account; for example, to 
specify the default administrative account, type username admin and password 
changeme.


If you want to convert text-format weight definitions to XML-format definitions and save 
the definitions to the BASEDIR/smarts/local/conf/ics/weights-conf.xml import datafile, 
you can do so manually by following the classweightconfig format defined in the 
bim-config.dtd.


Merging pre-9.1 business-related rules files with rules files of 9.1 
and later installations


When migrating from a Service Assurance Manager pre-9.1 installation to a Service 
Assurance Manager 9.1 and later installations, you must manually merge any modified 
business-related rules files with the same files in the 9.1 and later installations. Figure 29 
on page 75 identifies the files to be merged.
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Figure 29  File merging when migrating from a pre-9.1 installation to 9.1 and later installations


In the figure, the top two files are relevant to Business Impact Manager operation, and the 
bottom three files are relevant to Global Manager operation.


If you have not modified any of these files in the pre-9.1 installation from which you are 
migrating, you do not need to merge the older versions of the files in the pre-9.1 
installation with the newer versions of the files in the 9.1 and later installations. 


To merge a pre-9.1 business-related rules file with the rules files of 9.1 and later 
installations:


1. Use an editor application with a file-comparison capability to open both the pre-9.1 
file and the file from the 9.1 and later installations.


2. Perform a comparison of the pre-9.1 file with the file from the 9.1 and later 
installations to identify your modifications.


3. Add your modifications to the file from the 9.1 and later installations. You can copy 
text from the pre-9.1 file and copy it into the file from the 9.1 and later installations.


4. Close the pre-9.1 file without saving the file. 


5. Save and close the modified file from the 9.1 and later installations to the /local 
subdirectory identified in Figure 29 on page 75.


Merge modifications to


BASEDIR/smarts/local/rules/���/ICS_BusinessImpact.asl


Merge modifications to


BASEDIR/smarts/local/rules/���/ics-impact.asl


Merge modifications to


Merge modifications to


BASEDIR/smarts/local/rules/ics/ICS_ParseConf.asl


Remove two ASL rules, IMPACT_DRIVER and BUSINESS_IMPACT_DRIVER, 
and remove the two single-line ASL statements that call these two rules.


BASEDIR/smarts/local/rules/ics/ICS_Weights.asl BASEDIR/smarts/local/rules/ics/ICS_Weights.asl


Merge modifications to


BASEDIR/smarts/local/rules/ics/ics-group.asl


BASEDIR/smarts/local/rules/���/ics-impact.asl


BASEDIR/smarts/local/rules/���/ICS_BusinessImpact.asl


��	
�������	�����������	��	�����


BASEDIR/smarts/local/rules/ics/ICS_ParseConf.asl


BASEDIR/smarts/local/rules/ics/ics-group.asl


��	
�������	�����������	�������������	
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Adding the Global Manager as a topology source
You use the Domain Manager Administration Console attached to Business Impact 
Manager to add the Global Manager as a topology source to Business Impact Manager.


When you add the Global Manager as a topology source, Business Impact Manager 
imports business service topology, hierarchical group topology, weights, and event filters 
from the Global Manager.


Open the Domain Manager Administration Console


The EMC Smarts Service Assurance Manager Operator Guide provides information about 
starting the Global Console, logging in, and attaching to a Manager. You need a user 
account with administrative privileges to access the Domain Manager Administration 
Console. The default administrative account is username admin and password changeme.


“Attaching the Global Console to the Global Manager” on page 32 provides additional 
information.


The EMC Smarts System Administration Guide provides information about changing the 
password for the default administrative account (recommended) and configuring access 
privileges. The EMC Smarts Service Assurance Manager Configuration Guide provides 
information on configuring permissions to perform specific console operations.


To open the Domain Manager Administration Console:


1. Attach the Global Console to the Business Impact Manager in your deployment.


A Topology Browser Console opens.


2. In the console, select Configure > Domain Manager Administration Console to open the 
Domain Manager Administration Console.
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Add the Global Manager as a topology source


To add the Global Manager as a topology source to Business Impact Manager:


1. In the Domain Manager Administration Console, select Business Impact Manager 
(BIM) from the Manager list box, and select Topology > Add Source to launch the Add 
Source dialog box.


2. In the dialog box, as shown in Figure 30 on page 77, select SA from the Element Type 
list box, type the name of the Global Manager application (for example, INCHARGE-SA) 
in the Element Name field, and then click OK to add the Global Manager as a topology 
source.


Figure 30  Add Source dialog box for the Global Manager—example


In response, Business Impact Manager:


• Adds the specified Global Manager as a topology source.


• Creates in its repository an InChargeDomain object (for example, INCHARGE-SA) for 
the Global Manager instance added as a topology source.


• Establishes a connection to the Global Manager source.


A Discovery Progress window opens, displays progress messages. When you see "Last 
discovery completed" near the end of the progress report in the Discovery Status 
section, the setup of the Global Manager as a source to Business Impact Manager is 
complete.


At that point, Business Impact Manager:


• Probes the Global Manager source for business service topology, group topology, 
weights, and event filters.


• Imports and loads this data to its repository.


• Subscribes to infrastructure and application notifications from the Global 
Manager.


3. Click Close to close the Discovery Progress window.


INCHARGE-SA


SA
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After completing its initial import from the Global Manager, Business Impact Manager will 
import business service topology, group topology, weights, and event filters from the 
Global Manager whenever any of this data changes in the Global Manager.


Upon adding a Global Manager source, the Topology > Add Source menu option on the 
Domain Manager Administration Console is unavailable (dimmed) to prevent users from 
adding more than one Global Manager source to Business Impact Manager.


Specifying a different Global Manager source
You can specify a different Global Manager source for Business Impact Manager by 
performing the following two steps:


1. Remove the current Global Manager source by stopping the Business Impact Manager 
and then restarting it with a startup command line that contains the --norestore 
option.


2. Add a new Global Manager source by completing the procedure in “Adding the Global 
Manager as a topology source” on page 76.


Including the --norestore option in the startup command line will start Business Impact 
Manager without restoring any saved objects from its repository file. (Business Impact 
Manager repository files are located in the BASEDIR/smarts/local/repos/icf directory.) 
This mode of startup is necessary to delete from the repository the topology elements 
associated with the Global Manager source that is targeted for source removal.


Because the Business Impact Manager startup command created during the Service 
Assurance Manager installation does not contain the --norestore option, you will need to 
either temporarily modify the Business Impact Manager startup command (substitute 
--ignore-restore-errors with --norestore) or create a new service startup command or a new 
native startup command that contains the --norestore option.


Example procedure for specifying a different Global Manager source


What follows is an example procedure of specifying a different Global Manager source; 
that is, an example procedure for removing the current Global Manager source and adding 
a new Global Manager source. A native startup command containing the --norestore 
option is included in the procedure.


To specify a different Global Manager source:


1. In the installation area from which Business Impact Manager is invoked, go to the 
BASEDIR/smarts/bin directory and type the following command to stop Business 
Impact Manager:


sm_service stop --force ic-mbim-server


Press Enter.
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On a Windows system, you can also stop Business Impact Manager by selecting Start 
> Programs > Administrative Tools > Services to launch the Services window, 
right-clicking EMC Smarts BIM Server in the Services window, and then selecting Stop 
from the pop-up menu.


2. Type the following native command from BASEDIR/smarts/bin to start Business 
Impact Manager:


On a Windows system:


start sm_server --name=INCHARGE-MBIM --config=bim 
--subscribe=default --norestore --output


On a Windows system, including "start" at the beginning of the command line 
launches another command line window in which the EMC Smarts process starts and 
runs until the process is terminated. Launching a separate window leaves the original 
command line window free to receive more commands.


On a UNIX system:


sm_server --name=INCHARGE-MBIM --config=bim --subscribe=default 
--norestore --output --daemon


On a UNIX system, including the --daemon option in the command line starts the 
EMC Smarts process running in the background, leaving the original UNIX shell free to 
receive more commands. The --daemon option is not a valid option for a Windows 
system.


3. Consult “Adding the Global Manager as a topology source” on page 76 and add the 
new Global Manager source.
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Enabling maintenance tracking
You can track the maintenance of specific managed elements by enabling the 
maintenance tracking option. To enable maintenance tracking:


1. Log in to the console.


2. In the Topology Browser Console, select Service Assurance Manager (SAM) from the 
Manager list box.


3. Right-click the SAM manager.


A submenu appears.


4. Select Enable Maintenance.


Disabling maintenance tracking


To disable maintenance tracking:


1. Log in to the console.


2. In the Topology Browser Console, select Service Assurance Manager (SAM) from the 
Manager list box. 


3. Right-click the SAM manager.


A submenu appears.


4. Click Disable Maintenance.
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CHAPTER 5
Creating Business Elements with the Topology 
Builder


This chapter describes how to use the Topology Builder to manually create and add 
business elements and relationships to the business-related topology stored in the Global 
Manager’s repository. It consists of the following sections:


◆ Topology Builder overview.......................................................................................  82
◆ Business elements..................................................................................................  82
◆ Relationships..........................................................................................................  83
◆ Accessing the Topology Builder Console ..................................................................  84
◆ Opening the Topology Builder Console ....................................................................  84
◆ Understanding the layout of the Topology Builder Console ......................................  85
◆ Modifying topology .................................................................................................  86
◆ Adding business elements to your topology ............................................................  86
◆ Adding relationships to your topology .....................................................................  90
◆ Deleting business elements and relationships ........................................................  93
◆ Synchronizing topology...........................................................................................  93
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Topology Builder overview
The Topology Builder is a tool used to create and add business elements to the 
business-related topology loaded into the Global Manager’s repository from the Business 
Impact Manager’s import datafiles. Typically, you use the import datafiles to create most 
of the business elements, and use the Topology Builder to create smaller collections of 
business elements.


You use the Topology Builder to create business elements, to create relationships (links) 
between business elements, and to create relationships between business elements and 
infrastructure, application, or hierarchical group elements. The analysis performed by a 
Manager such as Business Impact Manager depends on the relationships between 
topology elements.


Business elements
You use the Topology Builder to create and add instances of the ICIM business classes and 
their subclasses identified in Table 5 on page 82 to the Global Manager’s topology. These 
classes and subclasses compose the business data model shown in Figure 3 on page 24. 


Table 5  Business classes added to the Global Manager topology using the Topology Builder


Business class Subclasses Description


ServiceOffering Represents a business service delivered to a set of 
subscribers (consumers).


BusinessProcess Represents the functions and operations that support the 
internal business activities or other processes of a 
business enterprise.


ServiceSubscriber Represents a subscriber (consumer) of one or more 
ServiceOfferings.


Customer Represents one or more business enterprises or individuals 
that maintain a business relationship with an Organization 
or one of its BusinessUnit elements.


Organization Represents a hierarchically structured business enterprise 
consisting of one or more business units that engage in one 
or more lines of business (LOBs).


BusinessUnit Within an Organization, represents a semi-autonomous 
division that engages in one or more LOBs.


LOB Within a BusinessUnit, represents a division that focuses 
on specific product markets.


Department Within a BusinessUnit or LOB, represents a group that 
engages in business functions that support the 
BusinessUnit or LOB.
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Relationships
ICIM-defined relationships enable Business Impact Manager to associate business 
elements with each other, and with underlying infrastructure, application, or hierarchical 
group elements. The relationships also identify the dependencies of elements on other 
elements, and identify groupings.


In most cases, a relationship has an inverse relationship. For example, the relationship 
PartOf is the inverse relationship of ComposedOf. A relationship pair, such as 
ComposedOf/PartOf, is referred to as a relationship set.


You use the Topology Builder to create the following relationships between elements 
(nodes) in Business Services map displays:


◆ Subscriptions/Subscribers relationship set
(corresponds to subscriptions/subscribers relationship keywords in import datafiles):


The Subscriptions relationship associates a ServiceSubscriber or ServiceSubscriber 
subclass to one or more ServiceOfferings or BusinessProcesses that are being 
provided to the ServiceSubscriber or ServiceSubscriber subclass.


The Subscribers relationship associates a ServiceOffering or BusinessProcess to one 
or more ServiceSubscribers or ServiceSubscriber subclasses who subscribe to the 
ServiceOffering or BusinessProcess.


◆ ConsistsOf/MemberOf relationship set
(corresponds to members relationship keyword in import datafiles):


The ConsistsOf relationship associates a ServiceOffering or BusinessProcess to one or 
more underlying infrastructure, application, or hierarchical group elements that are 
directly relied upon by the ServiceOffering or BusinessProcess. The list of underlying 
elements might be a list of network elements (hosts, routers, and so on), a list of 
applications, or a HierarchicalGroup.


The MemberOf relationship associates an underlying infrastructure, application, or 
hierarchical group element to one or more ServiceOfferings or BusinessProcesses that 
directly rely upon the infrastructure, application, or hierarchical group element.


The ConsistsOf/MemberOf relationship set can also associate a ServiceOffering to 
another ServiceOffering, or to a BusinessProcess, and can associate a 
BusinessProcess to another BusinessProcess, or to a ServiceOffering.


◆ ServedBy/Serves relationship set
(corresponds to servedby/serves relationship keywords in import datafiles):


The ServedBy relationship set associates a BusinessProcess to one or more other 
BusinessProcesses that serve the BusinessProcess.


The Serves relationship associates a BusinessProcess to one or more other 
BusinessProcesses that are served by the BusinessProcess.


◆ ComposedOf/PartOf relationship set
(corresponds to composedof/partof relationship keywords in import datafiles):


The ComposedOf relationship associates a ServiceSubscriber or ServiceSubscriber 
subclass to one or more other ServiceSubscribers or ServiceSubscriber subclasses 
that it contains.
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The PartOf relationship associates a ServiceSubscriber or ServiceSubscriber subclass 
to one or more other ServiceSubscribers or ServiceSubscriber subclasses in which it is 
contained.


Because the arrowed lines in a Business Services map point from a business element to 
the element that it depends on, only the Subscriptions, ConsistsOf, ServedBy, and 
ComposedOf relationships appear in a Business Services map. Their inverse relationships 
are implied but not shown.


Accessing the Topology Builder Console
Accessing the Topology Builder Console and the Business Services map requires attaching 
the Global Console to the Global Manager (for example, INCHARGE-SA) in your 
deployment. The EMC Smarts Service Assurance Manager Operator Guide provides 
information about starting the Global Console, logging in, and attaching to a Manager.


“Attaching the Global Console to the Global Manager” on page 32 provides additional 
information.


You need a user account with administrative privileges to access the Domain Manager 
Administration Console. The default administrative account is username admin and 
password changeme.


The EMC Smarts System Administration Guide provides information about changing the 
password for the default administrative account (recommended) and configuring access 
privileges. The EMC Smarts Service Assurance Manager Configuration Guide provides 
information on configuring permissions to perform specific console operations.


Opening the Topology Builder Console
To open the Topology Builder Console:


1. Attach the Global Console to the Global Manager in your deployment.


A Notification Log Console opens.


2. In the console, select Configure > Topology Builder to open the Topology Builder 
Console.

84 EMC Smarts Business Impact Manager User Guide







Creating Business Elements with the Topology Builder

Understanding the layout of the Topology Builder Console
Figure 31 on page 85 shows an example Topology Builder Console display. In the display, 
the Topology Builder Console is attached to a named INCHARGE-SA.


Figure 31  Topology Builder Console—example


Topology tree and topology graphical display


The Topology Builder Console is divided into two panels: a topology tree panel (left panel) 
and a topology graphical display panel (right panel). The topology tree panel contains a 
Topology tab and a Groups tab.


The topology tree of the Topology tab shows the business-related topology of the attached 
Global Manager. The topology tree of the Groups tab shows the hierarchical group 
business-related topology of the attached Global Manager. Clicking the plus sign next to a 
topology element class shows the topology elements associated with the class. Clicking a 
topology element launches a graphical topology representation—a Business Services 
map—in the right panel of the console.


To display a list of nodes (graphical representations of elements) and edges (graphical 
representations of relationships and connections) that may appear in a graphical topology 
representation, select Map > Map Legend in the Topology Builder Console.
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Toolbar buttons


Table 6 on page 86 describes the toolbar buttons used to create business elements and 
relationships. 


An unavailable (dimmed) toolbar button indicates that the associated function is not 
available, or that you do not have sufficient permission to perform the action.


Modifying topology
You use the Topology Builder to add new business elements and relationships to your 
topology and to delete business elements and relationships created with the Topology 
Builder. Your topology modifications are automatically saved as you make them, and are 
stored in the Global Manager’s repository.


You cannot use Topology Builder to add or modify elements and relationships that are 
discovered by the underlying Domain Manager topology sources or defined in the 
Business Impact Manager import datafiles. For example, you cannot create a new element 
for the Host class.


Clicking the Synchronize Topology toolbar button exports your topology changes to the 
listening Business Impact Manager. Invoke Synchronize Topology after you have 
completed your changes.


Adding business elements to your topology
You can create and add business elements to your topology using one of several methods:


◆ “Add elements using the “Create Node” toolbar button” on page 87


◆ “Add elements using the Create Instance menu option” on page 88


◆ “Add elements using the “Create Instance” pop-up menu option” on page 88


◆ “Add elements using the “Create” pop-up menu” on page 89


◆ “Add elements using the “Add to map” pop-up menu” on page 89


Table 6  Toolbar buttons for editing business-related topology


Button Description


Create Node creates a new business element in a Business 
Services map and adds the element to the existing topology.


Remove deletes the selected business element or relationship 
from a Business Services map. You can only remove elements and 
relationships that were created with the Topology Builder Console.


Link Node creates a relationship between two selected elements in 
a Business Services map.


Synchronize Topology forces the attached Global Manager to 
export topology updates to all listening Managers, including 
Business Impact Manager.
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The new elements will be visible as element names in the topology tree and as nodes in a 
graphical topology representation—a Business Services map. If the ICIM class of a new 
element is not already listed in the topology tree, the class will automatically be added to 
the topology tree.


When creating new elements, follow the naming conventions in “Understanding names 
and display names” on page 54 to name them. You use the DisplayName format when 
naming a new element.


After creating and adding the new elements to your topology, follow the procedure in 
“Adding relationships to your topology” on page 90 to create relationships for them.


Add elements using the “Create Node” toolbar button


This method is available only when a Business Services map is displayed in the Topology 
Browser Console. This method adds a new business element to both the Business 
Services map and the topology tree.


To add a business element using the Create Node toolbar button:


1. Click an element in the topology tree to open a Business Services map in which you 
want to add the new element. The clicked element becomes the focal element (object) 
of the map display and is surrounded by a box.


2. Click the Create Node toolbar button to display the Create Map Node dialog box. 


3. In the dialog box, select an element class (BusinessProcess, BusinessUnit, Customer, 
Department, LOB, Organization, ServiceOffering, or ServiceSubscriber) from the Select 
class list box.


4. Type the name of the new element.


5. Click Apply to add the new element to the topology, and continue to create additional 
elements. Or, click OK to add the new element and close the Create Map Node dialog 
box.
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Add elements using the Create Instance menu option


This method is available whether or not a Business Services map is displayed in the 
Topology Browser Console. This method adds a new business element to the topology 
tree.


To add a business element using the Create Instance menu option:


1. In the menu bar, select Edit > Create Instance to launch the Create instance in domain 
dialog box. 


2. In the dialog box, select an element class (BusinessProcess, BusinessUnit, Customer, 
Department, LOB, Organization, ServiceOffering, or ServiceSubscriber) from the Select 
class list box.


3. Type the name of the new element.


4. Click Apply to add the new element to the topology, and continue to create additional 
elements. Or, click OK to add the new element and close the Create instance in 
domain dialog box.


Add elements using the “Create Instance” pop-up menu option


This method is identical to the method described in the previous section, “Add elements 
using the Create Instance menu option” on page 88.


To initiate this method:


In the topology tree, right-click the name of the Global Manager (for example, 
INCHARGE-SA) and select Create Instance from the pop-up menu. The Create instance in 
domain dialog box appears.
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Add elements using the “Create” pop-up menu


This method is available whether or not a Business Services map is displayed in the 
Topology Browser Console. This method adds a new business element to the topology 
tree.


To add a business element using the Create pop-up menu option:


1. In the topology tree, right-click the element class (BusinessProcess, BusinessUnit, 
Customer, Department, LOB, Organization, ServiceOffering, or ServiceSubscriber) for 
which you want to add an element and select Create from the pop-up menu. The 
Create Instance dialog box appears. 


2. In the dialog box, type the name of the new element.


3. Click Apply to add the new element to the topology, and continue to create additional 
elements. Or, click OK to add the new element and close the Create Instance dialog 
box.


Add elements using the “Add to map” pop-up menu


This method is available only when a Business Services map is displayed in the Topology 
Browser Console. This method adds any element in the topology tree—including a 
non-business element—to the currently displayed Business Services map.


To add any element in the topology tree to the currently displayed Business Services map:


1. Click an element in the topology tree to open a Business Services map in which you 
want to add an instance of an existing element.


2. In the topology tree, right-click the element (any business or non-business element) 
that you want to add and select Add to map from the pop-up menu. The element 
appears as a node in the Business Services map.
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Adding relationships to your topology
After you add new business elements to your topology, you need to add ICIM-defined 
relationships to link them to related topology elements. You add relationships between 
the new business elements, and between the new business elements and existing 
business, infrastructure, application, or hierarchical group elements. The analysis 
performed by a Manager such as Business Impact Manager depends on the relationships 
between topology elements.


When an underlying infrastructure or application element has a problem, the problem may 
propagate to a manually added business element through a manually added relationship, 
or may propagate to an existing business element through a manually added relationship. 
The additional symptoms resulting from these propagations help Business Impact 
Manager better calculate the impact of underlying problems on business elements.


To establish a relationship between two elements:


1. Click an element in the topology tree to open a Business Services map in which you 
want to add the relationship.


2. Press Ctrl and select the source element and then the related element between which 
you want to create the relationship. The source element refers to the first element 
selected, and the related element refers to the second element selected.


3. Click the Link Node toolbar button. What happens at this point depends on the source 
element and the related element:


• For a source ServiceSubscriber or ServiceSubscriber subclass element and a 
related ServiceOffering or BusinessProcess element, the Topology Browser 
automatically adds a Subscriptions relationship from the source element to the 
related element. For example: 


• (Inverse of previous bulleted item) For a source ServiceOffering or BusinessProcess 
subclass element and a related ServiceSubscriber or ServiceSubscriber subclass 
element, the Topology Browser automatically adds a Subscriptions relationship 
from the related element to the source element. For example: 
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• For a source ServiceOffering or BusinessProcess element and a related 
infrastructure, application, or hierarchical group element, the Topology Browser 
automatically adds a ConsistsOf relationship from the source element to the 
related element. For example: 


• (Inverse of previous bulleted item) For a source infrastructure, application, or 
hierarchical group element and a related ServiceOffering or BusinessProcess 
element, the Topology Browser automatically adds a ConsistsOf relationship from 
the related element to the source element. For example: 


• For a source (“From”) ServiceOffering element and a related (“To”) 
BusinessProcess element, a Link Selected Map Nodes dialog box similar to this 
one appears: 


• (Inverse of previous bulleted item) For a source (“From”) BusinessProcess element 
and a related (“To”) ServiceOffering element, a Link Selected Map Nodes dialog 
box similar to this one appears: 
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• For a source (“From”) BusinessProcess element and a related (“To”) 
BusinessProcess element, a Link Selected Map Nodes dialog box similar to this 
one appears: 


• For a source (“From”) ServiceSubscriber or ServiceSubscriber subclass element 
and a related (“To”) ServiceSubscriber or ServiceSubscriber subclass element, a 
Link Selected Map Nodes dialog box similar to this one appears: 


4. If a Link Selected Map Nodes dialog box appears, select a relationship from the list. 
(Typically, you create only one relationship—or more precisely, only one relationship 
set—between a source element and a related element.) Click OK to add the 
relationship and to close the Link Selected Map Nodes dialog box.


Because the arrowed lines in a Business Services map point from a business element to 
the element that it depends on, the Topology Browser creates only Subscriptions, 
ConsistsOf, ServedBy, or ComposedOf relationships.


If you select Subscribers, MemberOf, Serves, or PartOf in a Link Selected Map Nodes 
dialog box, the Topology Browser will create a Subscriptions, ConsistsOf, ServedBy, or 
ComposedOf relationship from the related (“To”) element to the source (“From”) element.
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Deleting business elements and relationships
You use the Remove toolbar button to delete one or more selected business elements or 
relationships from the Global Manager’s topology. You can delete elements and 
relationships created with the Topology Builder, but you cannot delete elements and 
relationships that are discovered by the underlying Domain Manager topology sources or 
defined in the Business Impact Manager import datafiles.


To remove a new business element or relationship:


1. Click an element in the topology tree to open a Business Services map in which you 
want to delete the new element or relationship.


2. In the map, select the element or relationship that you want to remove. (To select 
multiple elements or relationships, press Ctrl while making your selections.)


3. Click the Remove toolbar button to remove the element or relationship from the 
topology.


Synchronizing topology
After you have completed your changes, click the Synchronize Topology toolbar button to 
export your topology changes to the listening Business Impact Manager, at which time the 
updates become available to Business Impact Manager for analysis. The updates do not 
affect analysis locally (at the attached Global Manager, itself) or remotely (at the listening 
Business Impact Manager) until the topology is synchronized.


If you do not invoke Synchronize Topology and you exit the Topology Builder, the attached 
Global Manager does not export the updates to Business Impact Manager.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
This document provides instructions for the configuration of EMC Smarts Service 
Assurance Manager, specifically the Global Manager. Topics include creating user profiles, 
specifying sources of topology and events, and managing topology and notifications.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Global Manager. IT managers who seek to understand the role of the 
Global Manager in the context of an EMC Smarts solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide Guide.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide
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◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Overview


This chapter provides a brief overview of EMC Smarts Service Assurance Manager and 
illustrates its architecture. 


The successful deployment of the Service Assurance Manager requires knowledge of your 
operations environment and the management tools already in place. You can integrate 
Service Assurance with third-party tools and existing installations of EMC Smarts 
applications.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides the hardware and software requirements, as well as the procedures for installing 
the Service Assurance Manager.


This chapter contains the following information:


◆ Service Assurance Manager components ................................................................  20
◆ Information flow between components ...................................................................  23
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Service Assurance Manager components
EMC® Smarts® Service Assurance Manager includes the following components.


Global Manager


Global Manager (Service Assurance Manager) is the software component at the heart of 
Service Assurance. The Global Manager consolidates topology and event information from 
multiple underlying domains and provides a central point for monitoring and managing 
distributed analysis domains.


Global Console


The Global Console is the primary tool for operators and administrators. The console 
enables operators to monitor the state of the managed environment and quickly respond 
to notifications. The Global Console also allows users to launch map and topology views. 
As the primary tool for users, the Global Console is typically installed on many hosts. The 
Global Manager Administration Console enables administrators to create and manage:


◆ User profiles


◆ Notification lists


◆ Tools


◆ Escalation policies


Business Dashboard


Business Dashboard displays views normally available from the Global Console as 
viewlets within your organization’s web page or a third-party web portal. Viewlets™ can 
display a variety of information including:


◆ Notification log


◆ Status table


◆ Maps


◆ Summary


◆ Notification properties


◆ Containment


Adapter Platform


Adapter Platform is a software component that:


◆ Imports SNMP traps, topology, and even information from third-party applications or 
products


◆ Normalizes the imported data to the ICIM Common Information Model (ICIM)


◆ Provides this data to the Global Manager
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EMC Smarts Adapter for UIM/O


The EMC Smarts Adapter for Unified Infrastructure Manager/Operations (referred to as the 
EMC Smarts Adapter for UIM/O) provides integration between the EMC Smarts Adapter for 
Unified Infrastructure Manager/Operations (herein referred to as UIM/O) and the Service 
Assurance Manager. The adapter retrieves alerts from UIM/O, creates notifications from 
the alerts, and sends the notifications to the Global Manager.


The EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide provides deployment information, configuration instructions, and client tool 
examples.


Business Impact Manager


Business Impact Manager extends the capabilities of the Global Manager to:


◆ Calculate the business impact of events


◆ Propagate the impacts to affected business elements (ServiceOfferings, 
BusinessProcesses, and ServiceSubscribers)


The propagated impacts are discrete notifications that are connected through an event 
causality chain to the root-cause problems.


EMC Smarts Notification Module


The EMC Smarts Notification Module (NOTIF) augments EMC Smarts solutions with event 
management features that are configured through a graphical user interface (the NOTIF 
Editor). NOTIF enables the user to easily optimize the flow of events and notifications sent 
through any EMC Smarts system. NOTIF can be installed on a SAM server and/or an 
Adapter Platform server. The internal event and notification processing features of the 
standard SAM Adapter Platform are replaced by NOTIF.


The EMC Smarts Notification Module User Guide includes information on NOTIF 
functionality and architecture.


Companion UI


EMC Smarts Companion UI supplements existing functionality in SAM, and EMC Smarts 
Network Configuration Manager (NCM).


The Companion UI is a VMware®-based appliance, that is, a virtual machine. The EMC 
Smarts SolutionPack Installation and Configuration Guide provides detailed information 
about installing and configuring the Companion UI.


Watch4net


Watch4net provides cross-domain performance monitoring of infrastructure and data 
center components, in real-time, from a single customizable Watch4net dashboard. The 
EMC Smarts Console SolutionPack provides consolidated access to various console 
components of SAM and CUI from Watch4net.


If you are deploying SAM, Watch4net, and Companion UI and you want single sign-on 
capability, consult the EMC Smarts SolutionPack Installation and Configuration Guide for 
instructions.
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EMC Smarts Notification Module Cisco Syslog Processing Adapter


The EMC Smarts Notification Module Cisco Syslog Processing Adapter (referred to as the 
NOTIF Cisco Syslog Adapter) replaces the log file processing features of the standard 
Syslog Adapter. The NOTIF Cisco Syslog Adapter processes log file information into useful 
notifications, with or without the use of ASL scripts. 


The EMC Smarts Notification Module Cisco Syslog Processing Adapter Installation and 
User Guide provides additional information on this adapter.
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Information flow between components
The following scenarios describe the architectural flow of topology and notifications 
between the different Service Assurance Manager components.


Scenario 1


The components described in Figure 1 on page 24 include:


◆ Service Assurance Manager:


• Broker


• Global Manager


• Global Console


• Report Manager


◆ Underlying Domains:


• SAM Adapters


• EMC Smarts IP Availability Manager


• EMC Smarts IP Performance Manager
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Figure 1  Information flow between Global Manager, Managers, adapters, and 
Global Console


Scenario 2


The second scenario, shown in Figure 2 on page 25, adds Adapter Platform and the 
Business Dashboard:


◆ Adapter Platform functions as an underlying domain by processing events and 
topology from disparate sources and sending this information to the Global Manager. 


◆ Business Dashboard provides access to the Global Console by using standard web 
technologies such as HTML and Java.
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Figure 2  Information flow between Global Manager, Adapter Platform, and Business Dashboard


The Adapter Platform processes events and topology from third-party sources and 
provides this information to the Global Manager. Adapter Platform can receive events and 
topology from the following sources:


◆ SNMP traps — To process SNMP traps, you must configure the EMC Smarts SNMP Trap 
Adapter. The SNMP Trap Adapter can operate as a trap exploder, forwarding traps to 
multiple locations, or it can convert traps to notifications and forward the notifications 
to Adapter Platform. The NOTIF Editor may be used to graphically configure trap to 
notification management.


◆ System log files — To produce notifications from a system log file, you must configure 
the EMC Smarts Syslog Adapter. You must specify the appropriate system log file to 
process and make sure that the format of the log file matches the format described in 
the Syslog Adapter’s ASL rule set. The Notification Module Cisco Syslog Processing 
Adapter may be used to manage Cisco type log messages into notifications.
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◆ Third-party sources with sm_ems — To process events from a third-party source, you 
must configure the event source to invoke the sm_ems utility. You must invoke 
sm_ems so that it can notify or clear events, update the values of attributes, or create 
topology elements.


The EMC Smarts Service Assurance Manager Adapter Platform User Guide describes how 
to configure Adapter Platform, the SNMP Trap Adapter, the Syslog Adapter, and the 
sm_ems utility.


Business Dashboard
The Business Dashboard displays information about the managed environment through a 
web browser.
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CHAPTER 2
Configuration Overview


After you install the Global Manager, one of the first configuration tasks is to specify the 
sources of topology and events and enable the Global Manager to begin working.


While there is much you can do to tailor Global Manager to your particular environment, 
the set of default configuration parameters provides a base from which to start. You can 
continue to configure the Global Manager while it is running.


This chapter contains the following information:


◆ Types of configuration tasks....................................................................................  28
◆ How to configure the Global Manager......................................................................  30
◆ Starting and Configuring EMC Smarts NOTIF ............................................................  34
◆ Starting services .....................................................................................................  36
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Types of configuration tasks
This section organizes configuration options into groups of related tasks:


◆ Creating user profiles


◆ Specifying underlying domains and system-wide parameters


◆ Managing notifications and topologies


◆ Automating responses to notifications


Each of these groups includes several options:


◆ Creating user profiles


◆ Configuring system parameters


◆ Managing topology and notifications


◆ Automating responses to notifications


Creating user profiles


A user profile defines the environment for one or more users, that is, anyone who requires 
access to the Global Manager through the Global Console. You can create user profiles 
based on role (administrator/operator), job function (network management/helpdesk), or 
a combination of these. With a user profile, you specify the following:


◆ Notification lists determine which notifications the Global Manager shows to a 
particular user. You define one or more filters in a notification list to determine which 
notifications are available through that notification list. Chapter 6, “Managing 
Notifications with the Global Manager,” provides additional information about 
notifications.


◆ Console operations determine a user’s access privileges to various functions and 
commands provided by the Global Console. Such functions range from adding a view, 
to acknowledging a notification, and saving a console. You can select the console 
operations associated with each user profile. “Console operations” on page 59 lists 
the console operations and describes how to add or remove operations to a user 
profile.


◆ Tools provide a means by which users can respond to a notification. Such a response 
might include pinging a device to see if it is reachable or opening a trouble ticket. By 
defining the tools associated with a user profile, you determine what actions a user 
can invoke in response to a notification. Chapter 8, “Tool Configuration for the Global 
Manager,” describes how to create and configure tools.


◆ Saved consoles provide users with a defined view of the network. This defined view 
can equal multiple displays of information. “Creating a saved console” on page 50 
describes how to create a saved console and make it available to users over the 
network.
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Configuring system parameters


System configuration tasks define the operation of the Global Manager:


◆ Specifying sources of topology and events and defining a smoothing interval and a 
minimum certainty for notifications received from each underlying domain.


◆ Setting parameters related to the archival of notifications.


◆ Defining the interaction between the Global Manager and Global Consoles.


◆ Defining the interaction between the Global Manager and underlying domains.


“Defining system defaults” on page 69 describes the system parameters.


Managing topology and notifications


Managing the topology and notifications maintained by the Global Manager requires an 
understanding of how the Global Manager synchronizes topology information and 
processes notifications. 


You may need to perform one or more of the following tasks:


◆ Uniquely identify elements managed by two or more underlying domains (tagging). 
“How the Global Manager applies tags” on page 102 describes how to configure 
overlapping elements.


◆ Organize managed elements into groups. Chapter 7, “Managing Topology with the 
Global Manager,” describes how to group topology elements.


◆ Customize the display of maps with new icons or map backgrounds. “Custom icons for 
map nodes” on page 136 describes how to add new icons or load map backgrounds.


The EMC Smarts Notification Module User Guide provides detailed information on how to 
manage notifications through the use of the NOTIF Editor.


Automating responses to notifications


Escalation policies provide a way to automatically respond to notifications. Chapter 9, 
“Escalation Configuration for the Global Manager,” describes how to create escalation 
policies using the Global Manager Administration Console. 
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How to configure the Global Manager
You configure the Global Manager using the following methods:


◆ Global Manager Administration Console


◆ sm_config utility


Privilege requirements


To access the Global Manager Administration Console, you must have the following 
privileges:


◆ You must have All privileges, as determined by the serverConnect.conf file used by the 
Global Manager.


◆ You must have access to the Configure Global Manager Administration Console 
console operation.


To invoke the sm_config utility requires All privileges in the Global Manager’s 
serverConnect.conf file as well as the necessary system privileges to edit installed files. 
Typically, administrator privileges are required to edit configuration files.


Global Manager Administration Console


The Global Manager Administration Console is a graphical interface for performing 
configuration tasks related to user profiles, escalation policies and custom map icons. The 
following wizards are provided to simplify configuration tasks:


◆ Notification List Wizard


◆ Automatic Tool Wizard


◆ Client Tool Wizard


◆ Server Tool Wizard


◆ User Profile Wizard


◆ User Wizard


◆ New Domain Wizard


◆ New Domain Group Wizard


◆ New Domain Type Wizard


◆ New Domain Tag Wizard


You can also create new users and notification lists through the User Profile Wizard.
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Launching the Global Manager Administration Console
To open the Global Manager Administration Console:


From the Global Console, select Configure > Global Manager Administration Console.


The Global Administration Console is divided into two panes with a navigation tree in the 
left panel and a configuration panel in the right panel. Selecting an element in the tree 
displays content in the configuration panel. At the top level of the tree is the Global 
Manager you are configuring. Listed under the Global Manager are five elements 
configured through the console; Escalation Policies, Notification Lists, Tools, User profiles, 
and Users. Listed under each element are any instances of these elements. For example, 
the users default and maint are listed under the Users element.


To modify the icons displayed in the map consoles, from the Global Manager 
Administration Console, select Configure > Edit Map Icons.


The configuration of the Global Manager is stored in its repository file. Chapter 11, 
“Importing and Exporting Configurations,” describes how to configure a Global Manager 
using the sm_config utility.


Modifying configuration files


As part of the EMC Smarts deployment and configuration process, you need to modify 
certain files. User-modifiable files include configuration files, rule set files, templates, and 
files (such as seed files and security configuration files) that contain encrypted 
passwords. Original versions of these files are installed into appropriate subdirectories 
under the BASEDIR/smarts/ directory.


Examples:


◆ The original versions of the Global Manager configuration files on UNIX are installed to 
/opt/InCharge/SAM/smarts/conf/ics


◆ The original versions of the Console configuration files on Windows are installed on 
C:\InCharge\SAM\smarts\conf\console


Original versions of files should not be altered. If a file requires modification, it must be 
stored as a local copy of the file in BASEDIR/smarts/local or one of its subdirectories. 


Examples:


◆ A modified dxa-sam.conf file on UNIX should be saved to 
/opt/InCharge/SAM/smarts/local/conf/ics


◆ A modified properties.conf file on Windows should be saved to 
C:\InCharge\SAM\smarts\local\conf\console


EMC Smarts software is designed to first search for user-modifiable files in 
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not 
found in the local area, EMC Smarts software then searches appropriate nonlocal 
directories.


To facilitate proper file editing, EMC Corporation provides the sm_edit utility with every 
EMC Smarts product. When used to modify an original version of a file, this utility 
automatically creates a local copy of the file and places it in the appropriate location 
under BASEDIR/smarts/local. This ensures that the original version of the file remains 
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unchanged. You can invoke sm_edit from the command line. Optionally, you can configure 
Windows so that sm_edit is automatically invoked when user-modifiable files are 
double-clicked in Windows Explorer.


To invoke the sm_edit utility from the command line, specify the path and the name of the 
file to edit under BASEDIR/smarts. If multiple EMC Smarts products are running on the 
same host, invoke sm_edit from the bin directory of the product with the files to edit. 


Example:


To edit the configuration file for the Global Manager, invoke the sm_edit utility as follows: 


# /opt/InCharge/SAM/smarts/bin>sm_edit conf/ics/dxa-sam.conf


In this example, the sm_edit utility automatically creates a local copy of the dxa-sam.conf 
file in the /opt/InCharge/SAM/smarts/local/conf/ics directory and opens the file in a text 
editor. If a local version of the file already exists, the sm_edit utility opens the local 
version in a text editor. In addition, sm_edit creates any necessary subdirectories.


The EMC Smarts System Administration Guide provides additional information about the 
sm_edit utility.


A number of configuration files exist for the Global Manager. The 
BASEDIR/smarts/local/conf/ics directory contains configuration files related to the Global 
Manager.


Table 1 on page 32 lists the configuration files for the Global Manager.


Table 1  Global Manager configuration files


Directory Files Description


conf serverConnect.conf
clientConnect.conf
brokerConnect.conf
sm_cloneDir.conf


Security files for configuring access to 
Service Assurance Manager. The EMC Smarts 
System Administration Guide describes the 
syntax and configuration of these files.


conf/ics service.data.template
topology-group.data.template


Sample datafiles for importing services and 
groups into the Global Manager.


actionconfig-sample.xml
ics-config-sample.xml 
nlconfig-sample.xml
policyconfig-sample.xml
profileconfig-sample.xml
userconfig-sample.xml
mapgif-sample.xml


The XML files that define sample 
configurations for notification lists, user 
profiles, users, and custom map icons for 
the Global Manager.


weights.conf The configuration file for EMC Smarts 
Business Impact Manager. The EMC Smarts 
Business Impact Manager User Guide 
describes how to configure this file.


local/conf runcmd_env.sh Used to set environment variables for 
EMC Smarts software.
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Configure Secure Broker
To configure Secure Broker, edit serverConnect.conf and clientConnect.conf files in the 
BASEDIR/smarts/local/conf/ics directory.


◆ Edit the serverConnect.conf file as follows:


1. In the serverConnect.conf file, comment out the following line:


<BROKER>:<DEFAULT>:<DEFAULT>:All


2. Modify the BrokerNonsecure setting as follows:


<BROKER>:BrokerNonsecure:Nonsecure:Ping


3. Add the following line after the BrokerNonsecure line


<BROKER>:SecureBroker:Secure:All


◆ Edit the clientConnect.conf file as follows:


1. In the clientConnect.conf file, comment out the following line:


*:<BROKER>:BrokerNonsecure:NonSecure


2. Add a secure value as follows:
*:<BROKER>:<PROMPT>:<PROMPT>


where Secure value can be encrypted.


Table 2 on page 33 lists additional files used by the Global Manager. The files listed in 
Table 2 on page 33 should not be modified by the user.


If your deployment involves adapters that integrate with any third-party products, there 
might be additional configuration and XML definition files. For more information regarding 
adapter configurations, refer to the guide for that adapter. 


Table 2  Nonmodifiable Service Assurance configuration files


Directory Files Description


conf/ics ics-config.dtd 
ics-default.xml
console_operations.xml
consoleoper-ext.xml
consoleoper_config.dtd


The XML and data type definition (DTD) files that 
define default notification lists, user profiles, 
users, and console operations for the Global 
Manager. These XML files provide the default 
configuration for the Global Manager.


conf/maps instance_maptype-sample
.xml
map-config.dtd
map_gif.xml


The XML and DTD files that define custom map 
icons.


conf/xml-if icim_xml.dtd
sample.xml


A sample XML file and the DTD file to define the 
XML standard used to import ICIM objects into 
EMC Smarts software. The EMC Smarts XML 
Adapter User Guide describes how to import 
topology using XML.
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 Starting and Configuring EMC Smarts NOTIF
After you install and configure the Global Manager, you must also configure NOTIF if you 
want to optimize the flow of events and notifications sent through your EMC Smarts 
system. To start and configure NOTIF:


1. Set an environment variable in the BASEDIR directory path to ensure that Java can be 
successfully started for NOTIF. In BASEDIR/smarts/local/conf/runenv_cmd.sh, add the 
following line:


export SM_JAVA_ENABLED=YES


2. Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of 
the default trap_mgr_parse.asl script in order for NOTIF to process SNMP traps.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi
--port=9013 --model=sm_actions --output
--rules=icoi-trapd/Notif-trap_mgr_parse.asl --daemon


The --daemon option only works on UNIX systems, not Microsoft Windows systems. 
Any customizations made to the original trap_mgr_parse.asl file in the 
BASEDIR/smarts/rules/icoi-trapd directory must be incorporated into the 
Notif-trap_mgr_parse.asl file in the BASEDIR/smarts/rules/icoi-trapd directory.


3. Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the 
default SysLog_mgr.asl script in order for NOTIF to process Cisco system log files.


For example:


sm_adapter.exe --name=SYSLOG-OI --server=INCHARGE-OI 
--tail=/var/log/syslog --model=sm_system --model=sm_actions 
--output icoi-syslog/Notif-SysLog_mgr.asl


One or more adapters can feed a single NOTIF server.


4. Start the NOTIF Editor by selecting Start > Programs > InCharge > Smarts NOTIF Editor. 


You can also start the editor by double-clicking the NotifGui.bat file (for Windows 
systems) or the NotifGui.sh file (for UNIX systems) in the BASEDIR/smarts/notif/editor 
directory.


5. Use the NOTIF Editor to connect to the running SAM or Adapter Platform server. Select 
Remote > Edit a server's settings in the NOTIF Editor.
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6. The Connect to a Server dialog box displays the list of available Adapter Platform and 
SAM server connections. Choose a server from the list of available server connections 
in the Connect to a Server dialog box and click OK.


If no available server connections are displayed, do the following to populate the list 
of server connections:


a. Click the More button in the Connect to a Server dialog box. This launches the 
Manage Connections dialog box where you can add server connections. 


b. Click the Add button in the Manage Connections dialog box. 


The Input dialog box displays. 


c. Enter a connection reference name (for example, “Remote Smarts NOTIF OI 
server”) in the Input dialog box and click OK. 


d. Fill in the new connection record in the right pane of the Manage Connections 
dialog box.


e. Click OK to save the connection setup.


The Remote Server Settings dialog box displays, showing the server's current settings.


7. Select the Activate Smarts NOTIF checkbox, and then click OK. 


You can also change other server settings in the Remote Server Settings dialog box if 
necessary.


8. Restart your SAM/Adapter Platform server.


Server setting changes made in the Smarts NOTIF Editor Remote Server Settings 
dialog box are persistent. When you change server settings in the Remote Server 
Settings dialog box and click OK, the changes are saved to the Notif_Settings.import 
file that is generated and saved to the BASEDIR/smarts/local/conf/<icoi or ics> 
directory in the Adapter Platform or SAM server where Smarts NOTIF is running.


Server setting changes made in the Smarts NOTIF Editor are preserved even if the 
repository is deleted. For example, if the repository is erased because you used the 
--norestore option for server startup, the server uses the last saved settings from the 
Smarts NOTIF Editor saved in BASEDIR/smarts/local/conf/<icoi or 
ics>/Notif_Settings.import. The EMC Smarts Notification Module User Guide includes 
information on how to use the Smarts NOTIF Editor.
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Starting services
During installation, Smarts products may be installed as services. When installed as 
services, default values are specified for the parameters that are associated with the 
services.


The parameters for the Global Manager service:


sm_service install --force  --unmanaged  --startmode=runonce \
'--name=ic-sam-server' \
'--description=EMC Smarts Service Assurance Manager Server' \
'/data/username/SAM_811_clean/SAM/smarts/bin/sm_server' \
'-n' \
'INCHARGE-SA' \
'--config=ics' \
'--port=0' \
'--ignore-restore-errors' \
'--output'


The parameters for the Adapter Platform service:


sm_service install --force 
--name=ic-sam-server 
"--description=EMC Smarts Service Assurance Manager Server"
--startmode=runonce
E:\data\SAM\9.2\SAM\smarts\bin\sm_server.exe  "-n"


"INCHARGE-SA" 
"--config=ics" 
"--port=0" 
"--ignore-restore-errors" 
"--output"


The parameters for the SNMP Trap adapter service:


/opt/InCharge/SAM/smarts/bin/sm_service 
install --force --unmanaged --startmode=runonce
--name=ic-trapd-receiver
--description="EMC Smarts SNMP Trap Adapter"
/opt/InCharge/SAM/smarts/bin/sm_trapd 


--name=TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--model=sm_actions
--rules=icoi-trapd/Notif-trap_mgr_parse.asl
--seed=seedfile
--output


C:\InCharge\SAM\smarts\bin>sm_service
install --force --name=ic-trapd-receiver
--description="EMC Smarts SNMP Trap Adapter"
C:\InCharge\SAM\smarts\bin\sm_trapd.exe 


--name=TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--model=sm_actions
--rules=icoi-trapd/Notif-trap_mgr_parse.asl
--seed=seedfile
--output


The parameter for the Syslog adapter service:


/opt/InCharge/SAM/smarts/bin/sm_service
install --force  --unmanaged  --startmode=runonce
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--name=ic-syslog-adapter
--description="EMC Smarts Syslog Adapter"
/opt/InCharge/SAM/smarts/bin/sm_adapter


--name=SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output
icoi-syslog/Notif-SysLog_mgr.asl


C:\InCharge\SAM\smarts\bin>sm_service
install --force --name=ic-syslog-adapter
--description="EMC Smarts Syslog Adapter"
C:\InCharge\SAM\smarts\bin\sm_adapter.exe


--name=SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output
icoi-syslog/Notif-SysLog_mgr.asl


When Smarts products are installed as services, they start automatically upon system 
restart. The following sections describe additional methods to start Smarts services.


Starting services on Windows


To start an EMC Smarts service from the Windows desktop:


1. Select Settings > Control Panel > Administrative Tools.


2. Select Services.


3. Right-click the EMC Smarts service to select.


4. Select Start from the menu.
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Configuring a security message
A security disclaimer message can be configured to display when users attempt to start 
the Global Console, Business Dashboard console, or the Web Console.


By default, the disclaimer dialog box is not enabled.


Configuring the security message for the Global Console


The file, security.warning, used to configure the disclaimer message is located in the 
<BASEDIR>\smarts\local\conf directory. The file, security.warning, is a simple ascii text file 
containing the security warning message text. This text appears in the security warning 
dialog box.


The file used to configure the disclaimer message must be labeled security.warning. If the 
file does not exist or is labeled a different name, the security warning message will not 
appear when the console starts.


To configure the disclaimer message for the Global Console:


1. Verify that the security.warning file is located in the <BASEDIR>\smarts\local\conf 
directory.


The security.warning file must be manually created if it already does not exist in the 
<BASEDIR>\smarts\local\conf directory.


2. Modify the text in the security.warning file, if necessary.


Configuring security message for Business Dashboard viewlet and Web Console


For the security message to appear on either the Business Dashboard viewlet or the Web 
Console, the com.smarts.securityMessage parameter must be configured.


The value of the com.smarts.securityMessage parameter is the filename of the ascii file 
containing the security message. For example, if the security message file was created and 
saved as trespass.notice, the property would be specified as:


com.smarts.securityMessage=trespass.notice


If the parameter is not specified in the properties file, or if the files exists but has zero 
length, the warning message will not appear when the web console or dashboard starts. If 
the parameter is specified but the specified file cannot be found, a default security 
message appears.


The Adjusting Java Properties section of the EMC Smarts Service Assurance Manager 
Operator Guide provides additional information.
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User profiles
User profiles provide a means by which an administrator can create and control the access 
and display of users who attach to the Global Manager through the Global Console, 
including the EMC Smarts web console and the Business Dashboard. For example, an 
administrator can create one user profile for operators who monitor the network 
infrastructure and a second user profile for operators who monitor application 
performance. All user accounts for a Global Manager are associated with a user profile.


A user profile includes the following properties:


◆ A notification list determines what notifications the Global Manager sends to the 
users.


◆ One or more users defined for the Global Manager. You must also ensure that these 
users have access to the Global Manager through the serverConnect.conf security file. 
The EMC Smarts System Administration Guide describes the configuration of security 
files.


◆ Server or client tools that enable users to invoke programs in response to 
notifications. Server and client tools, which are optional, are separately assigned to 
user profiles.


◆ One or more saved consoles that open when the user attaches to the Global Manager.


◆ Console operations, which are user actions on the console and determine a user’s 
access privileges to various functions and commands provided by the Global Console.


You can create user profiles with the Global Manager Administration Console or by using 
the sm_config utility. Chapter 11, “Importing and Exporting Configurations,” describes the 
sm_config utility.


Creating a user profile


When using the User Profile Wizard, you are prompted to specify the users, notification 
list, tools, saved consoles, and console operations associated with the user profile. 


You can create users and notification lists from within the User Profile Wizard.


As you proceed through the wizard, you may notice that certain elements, such as users or 
tools appear grayed out. This indicates that these elements are not enabled. You can 
associate disabled elements with a user profile, however such elements are not available 
to the user profile. For example, if a tool is not enabled, it will not be available to a user 
until it is enabled. You can enable or disable elements by selecting them in the tree and 
selecting or clearing the Enable box in the Configure User Profile panel.
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In addition, you can click Finish at any point and the wizard will create the user profile. If 
you are creating a new user profile, any options set after the point where you selected 
Finish will be blank. If you copied an existing user profile, the new profile will include the 
options of the copied profile.


Users may have to detach and reattach for changes to their user profile to take effect.


To create a user profile using the User Profile Wizard:


1. From the Global Manager Administration Console, click the Launch User Profile Wizard 
toolbar button.


The User Profile Creation Wizard appears.


2. Type the name of the user profile and choose whether to create a new profile or to 
copy an existing profile, and click Next. If you choose to copy an existing profile, the 
remaining configuration options will be identical to the user profile that was copied.


The name of a user profile cannot be the same as the name of a user. For example, you 
cannot create a user profile Operator and a user Operator. A suggested naming 
convention is to name the user profile with a –profile extension. For example, you 
could have a user profile called Operator–profile.


3. Select a notification list from the list box and click Next. Optionally, you could choose 
New Notification List from the menu to create a new notification list. “Notification list 
parameters” on page 53 describes how to create notification lists.


4. Assign users to this user profile. You can select multiple users by holding the Ctrl key 
when selecting users. Click the Add button to associate the user or users with the user 
profile. 


If the user does not exist, you can create a user by doing the following:


a. Type the username in the Create and add new user field.


b. Click Add.


c. Click Next.


A user can belong to only one user profile. If the user you select is already a member 
of another user profile, the user is associated with the new user profile.


5. Select the appropriate server tools from the list of Available server tools and click the 
Add button to associate them with the user profile. You can select multiple tools by 
holding the Ctrl key while selecting. When finished, click Next.


Click the Allow user to launch client or server tools only for a single selected object 
option to allow users to only launch client or server tools for a single selected object.
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6. Select the appropriate client tools from the list of Available client tools and click the 
Add button to associate them with the user profile. You can select multiple tools by 
holding the Ctrl key while selecting. When finished, click Next.


Click the Allow user to launch client or server tools only for a single selected object 
option to allow users to only launch client or server tools for a single selected object.


7. Select the saved consoles that are opened when users attach to the Global Manager, 
and click Next. If a saved console is not selected, the default NotificationLog console 
will appear when the user attaches to the Global Manager.


If the appropriate console is not listed, type the name of the console in the Add new 
console field and click the Add button. You can specify the name of a saved console 
whether or not the saved console exists.


8. Select the console operations for users associated with this user profile. You can 
select Other to choose specific console operations or choose one of the default sets of 
console operations:


• Read Only


• Operator


• Administrator


The default sets of console operations cannot be modified.


You can assign a modified version of one of the default sets of console operations by 
first selecting the set that provides most of the console operations to assign. Then, 
select Other. When you click Next, the console operations that correspond to the set 
you chose are selected but you can enable or disable individual console operations.


9. Click Next.


The final screen of the User Profile Wizard shows all newly created elements, including 
the new user profile. By default, the user profile is enabled. You can disable it by 
clearing the box next to the profile name. 


If you chose to copy an existing profile in step 2, and if the existing profile is disabled, 
then the user profile is disabled by default.


10. Click Finish to display a dialog box confirming that the user profile elements were 
created.
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Deleting a user profile


To delete a user profile:


1. Select the user profile.


2. Select Edit > Delete.


You can disable a user profile without removing it. “Disabling a user profile” on page 44 
describes how to disable a user profile.


You must not delete the default-profile user profile. When users attach to a Global 
Manager and their username is not assigned to a user profile, the default-profile user 
profile is applied. If the default-profile does not exist, an error message appears and the 
Global Console will not open.


Modifying a user profile


To modify a user profile:


1. Select the user profile.


2. Modify the properties of the user profile in the right panel:


a. Change the notification list.


b. Add or remove users.


c. Add or remove server tools.


d. Add or remove client tools.


e. Add or remove saved consoles.


f. Add or remove console operations.


3. Click Apply.


Changes to a user profile may not be available to console users until they restart the 
Global Console. 


Disabling a user profile 
You can disable a user profile without having to delete it. When users of a disabled profile 
attach to the Global Manager, they are assigned the default-profile. If the default-profile is 
deleted, users associated with a disabled user profile cannot attach to the Global 
Manager.


To disable a user profile:


1. Select the user profile.


2. Clear the Enabled checkbox.


3. Click Apply.
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Changing the notification list for a user profile
A notification list determines what notifications a user sees in the Global Console. 
Changing the notification list associated with a user profile affects all the users of this 
profile.


The Default notification list filters out notifications where the value of the Owner attribute 
is maint. When the user maint takes ownership of a notification, that notification is 
removed from the display of users assigned the Default notification list. 


There is a difference between taking ownership of a notification and acknowledging a 
notification. If a notification is:


◆ Owned and acknowledged and then recurs, the ownership and acknowledgement 
values are cleared in the new notification.


◆ Owned but not acknowledged and the notification recurs, the ownership is 
maintained and the recurring notification is also filtered from the operator’s display.


“Notification lists” on page 52 describes the properties of the default notification lists.


To change the notification list for a user profile, select a new notification list from the 
Notification List menu. “Notification list parameters” on page 53 describes how to use the 
Notification List Wizard to create a notification list.


Adding or removing a user
A user can be associated with only one user profile. If you add a user to a user profile, the 
user is automatically removed from its previous user profile.


To add a user to a profile:


1. Select the user profile from the tree. 


2. From the Configure User Profile panel, click Modify List in the Users section.


The Modify Users dialog box appears.


3. Add or remove users from the user profile. 


4. Click OK. 


5. Click Apply at the bottom of the Configure User Profile panel. “User accounts” on 
page 48 describes how to create a user account.


To remove a user, select the user profile in the tree. From the Configure User Profile panel, 
select the user from the Users list and click Remove Selected. Click Apply at the bottom of 
the Configure User Profile panel.


When you remove a user from a user profile, the user is automatically associated with the 
default-profile until you assign the user to a different user profile. “Creating a saved 
console” on page 50 describes the default user profiles. 
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Adding or removing a tool
Client and server tools are configured separately, however the process for adding or 
removing a client or server tool from a user profile is the same. 


To add a tool to a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Server Tools or Client 
Tools section. 


The Modify Server Tools or Modify Client Tools dialog box appears.


3. Add or remove tools from the user profile. 


4. Click OK. 


5. Click Apply at the bottom of the Configure User Profile panel.


To remove a tool:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, select a tool and click Remove Selected.


3. Click Apply at the bottom of the Configure User Profile panel.


Chapter 8, “Tool Configuration for the Global Manager,” describes how to configure tools.


Adding or removing a saved console
A saved console provides users with a preconfigured view of the network, helping users 
focus on aspects of the managed system they are to monitor.


To add a saved console to a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Saved Consoles section. 


The Modify Saved Consoles dialog box appears.


3. Add or remove saved consoles from the user profile. 


4. Click OK. 


5. Click Apply.


To remove a saved console:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, select a saved console and click Remove 
Selected. 


3. Click Apply at the bottom of the Configure User Profile panel.


“Creating a saved console” on page 50 describes how to create a saved console.
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Adding or removing console operations
Console operations are the functions and commands a user can invoke through the Global 
Console. By adding or removing console operations, an administrator can determine the 
level of access a user has to console operations.“Console operations” on page 59 lists the 
various console operations.


To add or remove console operations for a user profile:


1. Select the user profile in the tree. 


2. From the Configure User Profile panel, click Modify List in the Console Operations 
section. 


The Console Operations dialog box appears.


3. Select or clear console operations for the user profile. 


In addition, you can select one of the three default groups of console operations and 
apply it to the user profile. 


4. Click OK to close the dialog box. 


5. Click Apply at the bottom of the Configure User Profile panel.


About the predefined user profiles


Service Assurance includes four editable user profiles: admin-profile, oper-profile, 
default-profile, and maint-profile. The default-profile, admin-profile, and oper-profile user 
profiles include the default notification list and the Notification Log console.


default-profile
The default-profile user profile provides read-only operations and no tools. This profile 
ensures that any user that is not associated with a user profile or whose user profile is 
disabled, can attach to the Global Manager. The user must still authenticate with the 
Global Manager. 


maint-profile
The maint-profile also serves a special purpose, which is to take ownership of 
notifications that are not relevant to operators. For example, if notifications are generated 
for interfaces that should not be managed, or for components that are known to be faulty 
but are not scheduled to be fixed, an administrator can log in as the user maint and take 
ownership of these notifications.


admin-profile
The admin-profile includes all console operations access groups, server tools, and client 
tools, assuming the user has been given “All” privileges on the server side using the 
serverConnect.conf configuration file.
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oper-profile
The oper-profile includes:


◆ All client and server tools


◆ Details about notifications


◆ Maps


◆ Notification management, such as acknowledge


◆ Taking ownership of a notification


◆ Groups configurations


◆ Restricted access to configuration and management of user console and views


User accounts
A user account provides a unique identifier for each person who attaches to the Global 
Manager with the Global Console. The username provides a method for tracking who 
performs the following operations on notifications:


◆ When users acknowledge or unacknowledge a notification, their username is added to 
the notification’s Owner attribute and recorded in the notification’s audit trail.


◆ When users take ownership, their username is added to the notification’s Owner 
attribute and this information is recorded in the notification’s audit trail.


◆ When users invoke a tool on a notification, the user’s name is recorded to the 
notification’s audit trail.


When a user attaches to a Global Manager, the console automatically tries to associate 
the user with a user profile. If the user is not assigned to a profile, the default-profile is 
used.


Users must authenticate with a matching username and password in the 
serverConnect.conf file used by the Global Manager. The EMC Smarts System 
Administration Guide describes the syntax and configuration of the security files.
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Creating a user account


You can create new users in one of the following ways:


◆ Through the User Profile Wizard when you create a user profile as described in “User 
profiles” on page 41.


◆ Through the User Wizard as described below.


◆ Through the sm_config utility as described in Chapter 11, “Importing and Exporting 
Configurations”.


To create a new user with the User Wizard:


1. Select the Launch User Wizard toolbar button.


The User Creation Wizard appears. 


2. Type the name of the new user. 


The username must be unique. 


3. Click Next. 


4. Select a user profile for this user from the list box. 


5. Do one of the following:


• Click Next to display a confirmation screen.


• Click Finish to create the user.


6. Add the username and password in the serverConnect.conf file used by the Global 
Manager.


Deleting a user account


To delete a user:


1. Select the user in the tree.


2. Select Edit > Delete.


Do not disable or remove the Admin user account. If the Admin user account is removed or 
disabled, but other users still have the same privileges, none of the applications can be 
shut down.
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Creating a saved console
You can create a console layout for the Global Console, save it to the Global Manager, and 
associate it with a user profile so that it automatically opens for users associated with that 
profile. In addition, you can save the console to the Global Manager so that users can 
open it from the Global Console by selecting File > Open Remote.


There are two methods to set up access to a saved console:


◆ Specify the console name when you set up a new user profile, the saved console 
opens automatically when the user attaches to the Global Console. 


◆ Save a console to a directory that users can access. Console users can use the Open 
Remote As command to open consoles in this directory. 


The EMC Smarts Service Assurance Manager Operator Guide describes how to set up and 
save a console.


Saving a remote console for user access
You can save a console to one of the following locations on the host where the Global 
Manager is running:


◆ Use BASEDIR/smarts/local/consoles for all users. 


◆ Use BASEDIR/smarts/local/consoles/<user> for a specific user.


◆ Use BASEDIR/smarts/local/consoles/<user_profile> for all users assigned a specific 
user profile.


The BASEDIR/smarts/local/consoles/<user_profile> directory must be manually created by 
the administrator.


When a console is saved by selecting File > Save As > Save Remote As, the console is saved 
to the BASEDIR/smarts/local/consoles/<USER> directory, where <USER> is the EMC Smarts 
username. Users cannot see or open the consoles saved in another user’s directory unless 
it is manually copied into:


◆ Their own console directory.


◆ The BASEDIR/smarts/local/consoles directory.


◆ The BASEDIR/smarts/local/consoles/<user_profile> directory that corresponds to the 
user profile associated with their username.
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Providing a saved console in a user profile
To provide a saved console in a user profile:


1. Configure the console layout and select File > Save As > Save Remote As.


The console is saved to a directory that corresponds to your username under 
BASEDIR/smarts/local/consoles. For example, if you are logged in as the user 
“admin”, the console is saved to the BASEDIR/smarts/local/consoles/admin 
directory.


When you select Save Remote As, you are prompted to select the Domain Managers to 
which the saved console should automatically reattach in the event of a disconnect. 
The list includes those Domain Managers to which you are currently attached. By 
choosing to automatically reattach to a Domain Manager, you can omit the attach and 
detach console operations from the user profile.


2. To make the console available to all Global Console users, move the saved console 
from its current directory to the BASEDIR/smarts/local/consoles directory. 


When a saved console is located in this directory, a user can also open the console 
using File > Open Remote.


3. Add the console to the user profiles as described in “Adding or removing a saved 
console” on page 46.


4. To make the console available to users of a particular user profile, move the saved 
console from its current directory to the 
BASEDIR/smarts/local/consoles/<user_profile> directory.


The BASEDIR/smarts/local/consoles/<user_profile> directory must be manually 
created by the administrator.
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Notification lists
A notification list determines what notifications a client of the Global Manager receives. A 
notification list includes a filter that the Global Manager uses to process notifications 
before sending the notifications to the client. In addition to a filter, you can also use a 
notification list to change the name of column headings in the Notification Log of the 
Global Console.


Changes to a notification list are not available to console users until they reattach to the 
Global Manager.   


Clients that use notification lists include:


◆ Global Consoles — The notification list is a property of the user profile. “Creating a 
user profile” on page 41 describes how to create user profiles.


◆ Notification adapters — The notification list used by a notification adapter is specified 
in the NLSubscription section of the adapter’s configuration file. The EMC Smarts 
Service Assurance Manager Notification Adapters User Guide provides additional 
details on notification adapters.


◆ Adapter Platform — A Global Manager uses a notification list to receive notifications 
from the Adapter Platform. The notification list used by Global Manager is specified in 
the dxa-oi.conf file.


Changes to the notification list are made using the Global Console and not by directly 
editing the dxa-oi.conf file.


Because a notification list controls what notifications a client receives, it affects more than 
the display of notifications in a Notification Log. A notification list also affects the display 
of maps in the Global Console. For example, if a notification list filters out all notifications 
for a router, the status of that router will appear normal, regardless of its actual condition.


The filters specified as part of a notification list should not be confused with the filtering 
capabilities of the Global Console. The Global Manager performs the filtering defined in a 
notification list. The notifications that are filtered out by a notification list are not sent to a 
client. Filters in the Global Console can be used to further refine the filter of a notification 
list. The EMC Smarts Service Assurance Manager Operator Guide describes filtering 
performed by the Global Console. 


You can create or modify a notification list using the Global Manager Administration 
Console or the sm_config utility. This section describes using the Global Manager 
Administration Console. Chapter 11, “Importing and Exporting Configurations,” describes 
how to use the sm_config utility.
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Notification list parameters


A notification list includes the properties described in Table 3 on page 53.


You can use expression filters and ASL filters in combination, as well as specify multiple 
expressions in an expression filter. However, each filter definition sheets can contain only 
expression filters or an ASL filter. 


You cannot have expression filters and ASL filters on the same sheet:


◆ When an expression filter and an ASL filter are used in combination (they are on two 
separate sheets), a notification must match either the expression filter or the ASL 
filter to be sent to the client.


◆ When multiple expression filters are specified on the same sheet, the notification 
must match each expression filter to be sent to the client.


◆ When multiple expression filters are specified on multiple sheets, the notification 
must match each expression filter on sheet 1 or each expression filter on sheet 2, and 
so on.


By default, there are two notification lists:


◆ Default — Specifies an expression filter.


◆ Maintenance — Does not specify a filter, it matches all notifications.


“About Default notification lists” on page 56 describes the default notification lists.


Table 3  Notification list parameters


Field Description


Name Name of the notification list, must be unique among notification lists. 


Filter
and
ASL Filter


Type of filter used to filter notifications. You can specify two types of 
filters: an expression filter or an ASL filter:
• An expression filter matches a wildcard expression against the 


value of a notification attribute. You create an expression filter 
using the filter builder. “Building expression filters” on page 180 
describes expression filters.


• An ASL filter is specified by checking the ASL Filter checkbox and 
typing the name of the ASL file. The ASL filter file must be located 
in the BASEDIR/smarts/local/rules/ics directory. You must also 
specify the ics directory with the name of the filter, for example, 
ics/myASLfilter.asl.


If no filter is specified, the notification list matches all notifications.


Column Heading Used to modify the column headings that are displayed in the 
Notification Log. “Attributes for matching notification properties” on 
page 215 lists notification attributes.
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Creating a notification list


To create a notification list using the Global Manager Administration Console:


1. Select the Launch Notification List Wizard toolbar button.


The Notification List Creation Wizard appears.


2. Type a unique name for the Notification List. 


3. Choose to create a new notification list or copy an existing notification list:


• If a new notification list is being created, all of the filter properties are empty.


• If you copy a notification list, the notification list properties contain the same 
values as the copied list.


4. Click Next. 


5. Create an expression filter or type the name of an ASL Filter prefaced by the name of 
the BASEDIR/smarts/local/rules directory in which it is located, and click Next. 


The ASL filter must exist in the specified location, as the Global Manager loads the 
filter when you exit the wizard. The filter builder, used to create expression filters, is 
also used to configure tool and escalation policies. Chapter 10, “Working with 
Filters,” provides additional information.


6. Edit the column headings that are displayed in the notification log. The left column 
lists the attributes included in a notification. The right column lists the columns 
names as they are currently displayed. You can edit the values in the right column by 
double-clicking a field.


7. Do one of the following:


• Click Next to view the confirmation panel.


• Click Finish to create the notification list. 


The new notification list is displayed in the Global Manager Administration Console.
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Modifying a notification list


To edit the filters and the column headings for a notification list:


1. Select a notification list in the tree.


The Configure Notification List panel appears.


2. Click Edit Filter to modify the filter.


The Edit Filter dialog box appears. Chapter 10, “Working with Filters,” provides 
additional information.


3. Click OK when you have finished editing the filters.


4. Edit the display headings as needed. Double-click the display heading in the right 
column to edit the text. The new display heading is visible when users reattach to the 
Global Manager. 


5. Click Apply.


To provide a value for a UserDefined attribute, you must configure a hook script to 
populate the field. “User-defined notification attributes” on page 115 provides 
information about hook scripts.


Disabling a notification list


You can disable a notification list if you do not want it active but do not want to delete it. 
When users attach to a Global Manager and their notification is disabled, their console 
will not receive any notifications. The console will receive notifications when the 
notification list is enabled.


To disable a notification list:


1. Select the list from the tree in the Global Manager Administration Console.


2. Clear the Enabled checkbox.


3. Click Apply.


The name of the disabled notification list appears dimmed. 


The Default notification list is used by the default-profile, admin-profile, and oper-profile 
user profiles and if this default notification list is disabled then user attached to this 
profile will not be able to receive any notification. Whenever changes are made to enable 
or disable of notification list through an admin profile, SAM server re-initializes all 
notifications to console. The resent notifications are based on changes made by the 
admin. So if the admin disables Default Notification List, when server re-initializes the 
connection, it will not find the default notification list or any other notification list 
attached to admin-profile. This will cause the console to not receive any notifications.
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About Default notification lists


Two notification lists, Default and Maintenance, are included with the Global Manager and 
defined in the ics-default.xml file. The Default notification list is used by the 
default-profile, admin-profile, and oper-profile user profiles. If a user profile is disabled, 
users of that profile are assigned the Default user profile, which includes the notification 
list.


The Default notification list uses an expression filter that specifies the following 
conditions:


◆ Matches any notification in which the value of the Owner attribute is not maint.


◆ Matches any notification in which the value of Owner attribute is not SYSTEM.


A notification must match both conditions before it is sent to a client. The Maintenance 
notification list does not specify a filter. Because of this, it matches all notifications.


“About the predefined user profiles” on page 47 describes the purpose of the default 
notification lists and how they are incorporated into the default user profiles.


Processing notifications


The Service Assurance Manager processes notifications sent from:


◆ The Adapter Platform Manager (OI) to the INCHARGE-SA (SAM) server 


◆ An Aggregate SAM server to a Presentation SAM server 


If your SAM Server is communicating with an older version SAM, or OI, you must configure 
the usePre8.0 parameter included in the dxa-oi.conf file to true. Configuring the usePre8.0 
parameter to true, instructs the SAM server to communicate with pre 8.0 SAM Servers and 
OIs. 


To configure the SAM Server to communicate with older versions of SAM and OI:


1. Using a text editor, open the dxa-oi.conf file.


2. Locate the following lines of text:


# Underlying OI is pre8.0, so we must use a different transport....
usePre8.0 TRUE


3. Uncomment (delete the pound sign) the line, for example:


Underlying OI is pre8.0, so we must use a different transport....
usePre8.0 TRUE


4. Save and close the file.


If your Service Assurance Manager environment requires even faster notification 
processing, you can configure your Service Assurance Manager to provide multiple 
threads to process the notifications. Processing notifications using multiple threads adds 
an additional layer of complexity to your configuration, could possibly use additional 
system resources, and is only recommended for specific use if your system is failing to 
keep up with the notifications.
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To configure your Service Assurance Manager to process notifications using multiple 
threads:


1. Using a text editor, open the dxa-oi.conf file.


2. Locate the following lines of text:


# Subscribe to a Notification List
# NLName/n
sub     Default/n


3. Uncomment (delete the pound sign) the line.


4. Add the number of threads, for example:


Subscribe to a Notification List
NLName/n
sub     Default/n4


In this example, the SAM Server creates four threads to process the notifications from 
the adapter platform. 


5. Save and close the file.


Notification polling and Property Change


The SAM Console polls the SAM server to request batched notification updates at a default 
polling interval of 10 seconds. Therefore, operations that update notifications are shown 
with an average delay of a few seconds.


In SAM 8.0 and above, an option has been added to the SAM Console to choose between 
Notification polling (HyperNotification) and PropertyChange (subscription based 
notification updates from server) notification updates. 


Notification Polling
Notification polling provides better performance over a simple Notification transfer. To 
enable Notification polling, set the new Console property 
com.smarts.disableHyperNotification to FALSE by typing the following in the command 
line prompt:


sm_gui -Dcom.smarts.disableHyperNotification=False


By default, this property is set to FALSE making Notification polling the default form of 
receiving notification updates. 


Notifications are fetched in bulk at regular intervals. This interval can be changed by 
setting the environment variable, SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP in the 
runcmd_env.sh file. The default value for SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP 
parameter is 10. Setting the value to 5 will reduce the interval for fetching notifications 
and any mismatch in notification timestamp in a hierarchical environment.
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For example, to set an interval of 5 seconds, add the following line in the runcmd_env.sh 
file: 


SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP=5


If the interval is set to less than 5 seconds, the performance of the SAM server is 
impacted. Hence, an interval of less than 5 seconds is not recommended.


Polling Change
To enable PropertyChange notification updates, set the Console property 
com.smarts.disableHyperNotification to TRUE by typing the following in the command line 
prompt:


sm_gui -Dcom.smarts.disableHyperNotification=True


Setting this parameter to True, also helps avoid creation of multiple entries for a single 
session connected using dmctl. 


The -Dcom.smarts.disableHyperNotification parameter was introduced in the SAM 8.1 HF 
3 release. The hyper notification feature allows the console to poll the SAM server to 
request batches of notification updates. The feature requires dedicated separate 
connections between the server and console. While hyper notification increases the 
number of connections between the server and console for SAM 8.x versus SAM 7.x, it at 
the same time improves the console performance and notification processing.


It is recommended that hyper notification is not disabled as it would put additional load 
on the server and console, resulting in degradation of SAM performance. Exercise caution 
while using the -Dcom.smarts.disableHyperNotification parameter.


Configuring the Maintenance and Business Impact Manager


To configure the MBIM- Maintenance and Business Impact Manager:


1. Start the MBIM domain manager server.


2. Configure an MBIM domain.


“Configuring domains” on page 88 provides detailed information for configuring 
domains and reconfiguring SAM.


Connecting SAM to the MBIM domain provides automatic MBIM notifications. When 
MBIM is disconnected, a notification appears in the console and the maintenance 
adapter is automatically disabled.


3. From the Domain Manager Administration Console, attach to the MBIM domain.


4. Select the MBIM object (the root of the display).


5. Click Topology > Add Source.


6. Type the instance of SAM to use as a source of topology for the MBIM domain.

58 EMC Smarts Service Assurance Manager Configuration Guide







User Configuration for the Global Manager

Schedule Maintenance option


To inform fellow operators that a specific managed element is entering its scheduled 
maintenance period, the In Maintenance option for a specific notification is used.


Enabling maintenance tracking
To enable maintenance tracking:


1. Log in to the console. 


2. In the Topology Browser Console, right-click on the name of the Service Assurance 
Manager server at the top of the topology tree which is the topology source for MBIM.


3. Click Enable Maintenance.


Disabling maintenance tracking
To disable maintenance tracking:


1. Log in to the console. 


2. In the Topology Browser Console, right-click on the name of the Service Assurance 
Manager server at the top of the topology tree which is the topology source for MBIM.


3. Click Disable Maintenance.


Console operations
Console operations are user actions on the console and determine a user’s access 
privileges to various functions and commands provided by the Global Console. Examples 
of console operations include taking ownership or acknowledging a notification, adding a 
view to the console, or viewing the details of a notification. An administrator can assign 
one or more of these tasks to a user profile.


Interaction with EMC Smarts username/password privileges


An administrator needs All privileges, conferred by the Global Manager’s 
serverConnect.conf file and console operations access privileges to perform the following 
administrative tasks:


◆ Display the Configure menu in the Global Console


• Open the Global Manager Administration Console


• Open the Domain Manager Administration Console


• Open the Group Definition Console


• Open the Topology Builder Console


• Edit Map Icons


◆ Save View as Dashboard viewlet


◆ Edit attributes in underlying domains


◆ Select Correlate Now or Recompute Codebook in underlying domains


◆ Manage or unmanage elements in underlying domains
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With console operations, an administrator can assign one or more of these tasks to a user 
profile. 


Some features require a separate license, such as Business Services Maps. An 
administrator can assign any feature to a user, but the feature may not be enabled.


Default user profiles


The user profiles included with Service Assurance support the following console 
operations:


◆ The admin-profile includes all console operations groups, giving users assigned to 
this profile administrative access.


◆ The maint-profile includes the Detail Information, Map, Views, and Event Management 
console operations groups, giving users operator access.


◆ The default-profile includes the Detail Information, Map, and Views console 
operations groups, giving users read-only access.


◆ The oper-profile includes the Detail Information, Map, Views, and Event Management 
console operations groups, giving users operator access.


Console operations and groups


Table 4 on page 60 lists the console operations and their assigned group. To facilitate the 
configuration of user profiles, the following sets of groups are provided:


◆ Read Only includes the Detail Information, Map, and Views groups


◆ Operator includes the groups in Read Only and Event Management


◆ Administrator includes all groups


When one of these sets is selected, the associated groups and operations are 
automatically selected. 


The administrator can then customize the selected groups or operations as described in 
“Creating a user profile” on page 41.


Table 4  Console operations and groups (page 1 of 4)


Group/Console operation Description


Detail Information


Browse Opens a Topology Browser view from the Global 
Manager and displays the element as the root.


Browse Detail Opens a Topology Browser view from the 
underlying Domain Manager and displays the 
element as the root.


Expand Map Node Expands a map node to display connected nodes.


Show Containment Displays an element’s components.


Map
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Physical Connectivity Opens a map displaying physical connectivity.


IP Connectivity Opens a map displaying IP connectivity.


VLAN Connectivity Opens a map displaying VLAN connectivity.


Membership Opens a map showing group elements (IP or 
VLAN).


Business Services Opens a map displaying business elements.


Application Opens a map displaying application elements.


Network Protocol Manager 
Connectivity


Opens a map that depicts topology and 
connectivity for:
• BGP Connectivity
• OSPF Connectivity
• OSPF Network Connectivity
• EIGRP Connectivity
• EIGRP Network Connectivity
• ISIS Connectivity
• ISIS Network Connectivity


MPLS Connectivity Opens a map that depicts MPLS topology.


Multicast Connectivity Opens a map that depicts Multicast topology.


Multicast A Multicast map depicts multicast topology.


Storage Network Connectivity Opens a map that depicts storage network 
topology.


Views


Notification Log Provides the ability to access a Notification Log 
view.


Topology Browser Provides the ability to access a Topology Browser 
view.


Summary Provides the ability to access a Summary view.


Status Table Provides the ability to access a Status Table view.


Map Open a Map Console.


View Configuration


Notification View Filter Create a filter for a Notification Log.


Summary Filter Create a filter for Summary Views.


Edit Summary Parameters Edit a Summary View configuration.


Add Summary Add a Summary to a Summary View.


Delete Summary Remove a Summary from a Summary View.


Status Table Configuration Edit Status Table configuration.


Console


Table 4  Console operations and groups (page 2 of 4)


Group/Console operation Description
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Save Save the console to wherever it was originally 
loaded from, local or remote.
If a console has not been previously saved, the 
system will prompt the user for information on 
where to save the console.


Save Remote As Save a console to the Global Manager.


Open Local Open a console from the local system.


Open Remote Open a Console from the Global Manager.


InCharge Manager Attach Attach to a Domain Manager.


InCharge Manager Detach Detach from a Domain Manager.


Views Management


Add View Provides the ability to add a view to a console, 
and also open a new console (for example, 
Notification Log Console).


Notice: You can only add views or open a console 
for views for which you have permission to access. 


Delete View Remove a view from the console.


Copy View Copy a view in the console.


Copy View as New Console Copy a view in the console and open as a new 
console.


Set View Context Listening Set listening context for active view.


Event Management


Take Ownership Take ownership of a notification.


Release Ownership Release ownership of a notification.


Schedule Maintenance Schedule maintenance on a managed element.


Acknowledge Acknowledge a notification.


Unacknowledge Unacknowledge a notification.


Notification Properties Open a notification properties dialog or add 
notification properties view to console.


Administration


Configure Group Open a Groups Definition Console.


Configure Global Manager 
Administration Console


Open a Global Manager Administration Console.


Configure Domain Manager 
Administration Console


Open a Domain Manager Administration Console.


Configure Map Icons Specify custom icons for map nodes using the 
Global Manager Administration Console.


Launch Topology Builder Open the Topology Builder Console.


Table 4  Console operations and groups (page 3 of 4)


Group/Console operation Description
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Console operations allowed for all users
There are additional console operations that are always available and cannot be removed 
from the console. Table 5 on page 63 lists of the more useful of these console operations.


There are other operations that cannot be removed from the console that are not included 
in this table.


Save View as Viewlet Save a view as a viewlet for the InCharge Business 
Dashboard.


Table 4  Console operations and groups (page 4 of 4)


Group/Console operation Description


Table 5  Console operations allowed for all users


Console view/console operation Description


Notification Log View/Console


Sort Columns Sort notifications by selected column.


Select Columns Select columns to display in the log.


Save log contents to file Save the log to a file on the local system.


Freeze Display Freeze the log to prevent display of new notifications.


Summary View/Console


Layout Set the number of summaries per row.


Move Summary Left Move a summary one summary to the left.


Move Summary Right Move a summary one summary to the right.


Topology Browser View/Console


Select Control the set of classes or instances displayed in the 
tree.


Refresh tree Refresh the tree view.


Make Root Make the selected instance the root of the tree.


Map View/Console


Save map Save a map to the Global Manager.


Edit map filter Edit classes displayed in a map.


Set background Load a background image for a map.
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System Configuration for the Global Manager


This chapter contains the following information:


◆ Defining Domain Manager parameters ....................................................................  66
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Defining Domain Manager parameters
A Domain Manager refers to an underlying analysis application, such as IP Availability 
Manager, Storage Insight for Availability, Adapter Platform, or other Global Manager that 
serves as a source of event and topology data. You specify these domains and the 
parameters that control the import of event and topology data in the domainconfig section 
of the ics-default.xml file.


The domainconfig section is divided into one or more domaintype subsections, each of 
which defines the configuration for one or more underlying domains. The following 
example shows the syntax of a domainconfig section when the underlying domain is IP 
Availability Manager:


<domainconfig>
        <domaintype
            name="AM-Suite"
            description="Type for AM-Suite"
            dxaConfFile="dxa-conn.conf"
            MinimumCertainty="0.01"
            SmoothingInterval="65">
            <hook enable="False">ics/dxa-sample-hook.asl</hook>
            <domainname>INCHARGE-AM-1</domainname>
            <domainname>INCHARGE-AM-2</domainname>
        </domaintype>


Table 6 on page 66 describes the domainconfig parameters.


Table 6  Parameters defining the domainconfig section (page 1 of 2)


Parameter Description


name Defines the domain name.


description Defines the description of the domaintype.


dxaConfFile Defines the data exchange file that corresponds to the 
underlying domain. A data exchange file ensures that Global 
Manager receives the correct event and topology data. Table 7 
on page 67 specifies the correct data exchange file for each 
product.


MinimumCertainty Defines the minimum value that the Certainty attribute must 
have before an event is sent to the Global Manager from the 
underlying domain. Events with a Certainty value below the 
threshold are discarded. This value must be a number between 
0.0 and 0.99.
The default value is 0.01 for IP Availability Manager and IP 
Performance Manager. Otherwise the default is 0.24.


Notice: The MinimumCertainity parameter does not apply to 
underlying Adapter Platform servers or other Global Managers.
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Data exchange files or underlying domains


Table 7 on page 67 lists the data exchange files that should be used for each product.


SmoothingInterval Defines the time, in seconds, an event must be active before it 
is sent to the Global Manager. 
The default value is 65 seconds. 


Notice: The SmoothingInterval parameter does not apply to 
underlying Adapter Platform servers or other Global Managers.


hook [Optional] Defines the name of an ASL script that modifies a 
notification. Typically, this is used to add information to one of 
the user-defined fields of a notification. Hook scripts must be 
located in the BASEDIR/smarts/local/rules directory. You must 
prefix the name of the script with the directory in which it is 
located, typically this is the ics directory.


For example, the ics/dxa-sample-hook.asl hook script is located 
in the BASEDIR/smarts/local/rules/ics directory.


Notice: The default ASL hook scripts are placeholders for a 
script you must provide. A hook script is not required unless you 
need to perform additional processing on the notifications 
coming from the underlying domain. “User-defined notification 
attributes” on page 115 describes possible uses for hook 
scripts.


domainname Defines the name of the underlying domain. You can specify 
multiple domains with the same configuration by adding name 
parameters to the domaintype section. However, the value of 
each name parameter within a domaintype section must be 
unique.


Table 6  Parameters defining the domainconfig section (page 2 of 2)


Parameter Description


Table 7  Data exchange file for each product (page 1 of 3)


Product Component Data exchange file


Service Assurance Manager Global Manager dxa-sam.conf


Adapter Platform dxa-oi.conf


Adapter for BMC Patrol dxa-bmc.conf


 SDI Adapter dxa-sdi.conf


MBIM server dxa-sam-from-mbim.conf


IP Manager 7.0 IP Availability Manager dxa-conn.conf


IP Performance Manager and IP Server 
Performance Manager


dxa-perf.con


IP Availability Manager and IP Performance 
Manager


dxa-conn-perf.conf


IP Discovery Manager dxa-dm.conf
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IP Manager 6.x IP Availability Manager dxa6X-conn.conf


IP Performance Manager and IP Server 
Performance Manager


dxa6X-perf.conf


IP Availability Manager and IP Performance 
Manager


dxa6X-conn-perf.conf


IP Discovery Manager dxa6X-dm.conf


IP Manager 4.x IP Availability Manager dxa4X-conn.conf


IP Performance Manager dxa4X-perf.conf


IP Availability Manager and IP Performance 
Manager


dxa4X-conn-perf.conf


Network Protocol Manager Network Protocol Manager for BGP dxa-bgp.conf


Network Protocol Manager for OSPF dxa-ospf.conf


Network Protocol Manager for EIGRP dxa-eigrp.conf


Network Protocol Manager for IS-IS dxa-isis.conf


Storage Insight Manager Storage Insight for Availability dxa-storage-analysis.conf
dxa-storage-topology.conf


VoIP Availability Manager VoIP Availability Manager dxa-sam-from-voip.conf


Application Insight Application Connectivity Monitor dxa-sam-from-acm.conf


Application Insight dxa-sam-from-ai.conf


MPLS Manager MPLS Manager dxa-mpls-vpn-ics-analysis.con
f


dxa-mpls-vpn-ics-monitoring.c
onf


dxa-mpls-vpn-ics-topology.co
nf


dxa-mpls-vpn-ics.conf


ATM/Frame Relay Availability 
Manager


ATM/Frame Relay Availability Manager dxa-sam-from-atmfr.conf


XD Manager for ATM/FR-to-IP AM dxa-sam-from-xdatmfrip.conf


Multicast Manager Multicast Manager dxa-mcast.conf


Optical Transport Manager Optical Transport Manager for SONET dxa-sam-from-sonet.conf


Optical Transport Manager for WDM dxa-sam-from-wdm.conf


XD Manager OTM to IP dxa-xd-otm-ip.conf


Application Connectivity Monitor 1.0 Application Connectivity Monitor dxa-app-poller.conf


Application Services Manager 1.0 Application Services Manager dxa-asm10.conf


Application Services Manager 1.1 Application Services Manager dxa-asm.conf


Table 7  Data exchange file for each product (page 2 of 3)


Product Component Data exchange file
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Defining system defaults
System defaults are system-wide settings that affect the Global Manager and its clients. 


To configure system defaults:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Click System Defaults.


The Configure System Defaults interface appears, as illustrated in Figure 3 on page 69.


Figure 3  Global Manager Administration Console—Configure System Defaults


CiscoWorks Device Fault Manager CiscoWorks Device Fault Manager dxa-dfm.conf


CiscoWorks Voice Health Monitor CiscoWorks Voice Health Monitor dxa-vhm.conf


Security Infrastructure Manager Security Infrastructure Manager dxa-sim.conf


Table 7  Data exchange file for each product (page 3 of 3)


Product Component Data exchange file
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Table 8 on page 70 describes the System Defaults parameters.


Table 8  System Defaults parameters (page 1 of 3)


Parameter Description


Auto Acknowledgement Interval Defines interval, in seconds, after which an inactive and 
unowned notification is acknowledged. Notifications that 
are acknowledged by the Global Manager are owned by 
the user SYSTEM. 
Default: 300 seconds


Inactive Auto Archive Interval Defines interval, in seconds, after which an inactive and 
acknowledged notification is archived. If this value is set 
to zero, archiving is disabled and notifications will not be 
deleted, causing Global Manager to use more memory.
Default: 14400 seconds (4 hours)


Audit Trail Size Limit Defines the number of audit log entries for each 
notification that are saved and visible in the Global 
Console before the log contents are archived. When this 
limit is reached, half of the entries are written to the 
notification archive. 
Default: 100 entries


SMTP Server Defines the name of the SMTP mail server through which 
mail messages sent by the Global Console’s Mail tool are 
sent. This mail server must be reachable from the host 
where the Global Manager is running. This value can be 
overridden in the Global Console.
Default: “localhost”


Fetch Local Notification 
Properties


Defines how the properties of a particular notification are 
retrieved when requested by a client application. If set to 
“true”, properties are retrieved from the Global Manager. 
If set to “false”, properties are retrieved from the Global 
Manager and from the underlying domain.


Notice: The values configured for this parameter affect 
the performance of the Service Assurance Manager.


Client applications include the Global Console, the dmctl 
utility, and adapters.
Default: False


RMI Time Out Defines the maximum amount of time, in seconds, the 
Global Manager is allotted to retrieve Notification 
Properties, Find System, or get System Containment 
information from an underlying domain. If a negative 
value is specified, no time-out value is set. 
Default: 60 seconds


Number Of Worker Threads Defines the number of worker threads used by the 
escalation mechanism in executing tools associated with 
escalation levels in escalation paths. Increase the 
number of threads if the escalation mechanism falls 
behind in executing tools for escalation levels. Valid 
values are 1 - 10.
Default: 2
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Broadcast Event State on Restart Defines whether notifications that result from internal 
Global Manager events are propagated to clients that 
subscribe to them. Internal Global Manager events 
include system disconnects and system reconfigurations. 
If set to True, notifications resulting from internal Global 
Manager events are propagated. If set to False, the 
events are not propagated.
When configuring this parameter, the value must be 
identical for all Service Assurance Manager servers 
within your Service Assurance Manager deployment. For 
changes to this parameter configuration to take effect, 
the Service Assurance Manager servers must be 
restarted. 


Notice: For optimum benefit, configure this parameter as 
early in your Service Assurance Manager deployment as 
possible, before all source domains are added to the 
Service Assurance Manager server. The quickest way to 
apply this parameter configuration is to restart the 
Service Assurance Manager server. However, if you are 
configuring this parameter in a production environment, 
apply the parameter configuration to the Service 
Assurance Manager server by making a minimal change 
to the configuration of each of the underlying source 
domain types, and clicking the Reconfigure button. One 
example of a minimal configuration change is to modify 
the value for the Smoothing Interval parameter. A 
minimal configuration change is required for each 
domain type. This results in the Service Assurance 
Manager server disconnecting from each underlying 
domain, rereading all the settings including the new 
modification, and then reconnecting to the underlying 
domains.


Default: True


Hierarchical Acknowledge Defines whether acknowledging or unacknowledging a 
notification in the server sends the acknowledge (or 
unacknowledged) information to the underlying servers. 
If set to True, the notification in the underlying servers 
are also acknowledged or unacknowledged. If set to 
False, the notification in the underlying servers are not 
changed.
Default: True


Companion UI Hostname Defines the location of the related Companion UI vApp. 
The accepted values are the Domain Name System (DNS) 
host or the IP address of the vApp (for example, 
companionUI or companionUI.mycompany.com).


Table 8  System Defaults parameters (page 2 of 3)


Parameter Description
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5. Type or select your system defaults configuration options.


6. Click Apply.


System defaults cannot be deleted. EMC Corporation cannot guarantee that any repository 
modification made since the last time the repository was saved will be implemented 
during a Windows Service restart. To guarantee that repository modifications are 
implemented during a Windows Service restart, you must shut down the service 
completely and then restart the service. 


Use DNS Lookup in This Domain Defines whether the system performs Domain Name 
System (DNS) searches when searching for computer 
systems. If set to True, the system queries the DNS in this 
domain.


Notice: When performing a DNS search, perform the 
search from the Adapter Platform (OI).


Default: True


Use DNS Lookup in Underlying 
Domains


Defines whether the system uses Domain Name when 
searching for computer systems. If set to True, the system 
queries the DNS in underlying domains.
Default: True


Use DNS Domains in DNS Lookup Defines whether DNS domains are used when the system 
performs a DNS search. If set to false, only original 
domain names are used during the DNS search.
Default: False


DNS Domain Names Defines the list of domain names the system uses when 
performing a DNS search.


Notice: When entering multiple domain names, separate 
each domain name with a comma.


Underlying Domains Order Defines the order in which the underlying domains are 
searched.


Notice: When entering multiple domain names, separate 
each domain name with a comma.


Fully Qualified Domain Name 
Suffixes


Defines which domain names returned as a result of 
performing a DNS search are considered to be fully 
qualified. Domain names matching suffixes entered in 
this parameter are considered fully qualified.


Table 8  System Defaults parameters (page 3 of 3)


Parameter Description
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About acknowledging notifications


When a notification is acknowledged, an entry is appended to the notification’s Audit Log. 
In addition, the values of two notification attributes are set: Owner and Acknowledged. 
The value of the Owner attribute is set to the username of whomever acknowledged the 
event. The value of the Acknowledged attribute is set to TRUE.


If a notification is unacknowledged, another entry is appended to the notification’s audit 
log. The value of the Owner attribute is set to the EMC Smarts username of whomever 
unacknowledged the notification and the value of the Acknowledged attribute is set to 
FALSE.


Auto acknowledgement is a facility designed for notifications that clear before an operator 
is able to acknowledge them. Usually a notification will clear shortly after it appears. 
Instead of requiring operators to manually acknowledge such notifications, the Global 
Manager automatically acknowledges unowned notifications after they remain inactive 
(clear) for the time specified by the AutoAcknowledgementInterval. Notifications 
acknowledged by the Global Manager have their Owner attribute set to SYSTEM.


After a notification is acknowledged, it is eligible for archiving. The Global Manager will not 
archive an active or unacknowledged notification.


Archiving notifications


Old notifications are periodically removed from the Global Manager’s repository and 
archived to a file. The notification archive includes the values of the notification’s 
attributes at the time it is archived, including the contents of the audit log. This archive is 
intended to provide a record of information before it is deleted.


The EMC Smarts Report Manager User Guide describes how to generate historical reports 
based on notification data. Report Manager does not use the notification archive for 
reporting, but maintains the notification information in a relational database.


Archived notifications are written to the file <global_manager>.archive, where 
<global_manager> is the name of the Global Manager. By default, this is INCHARGE-SA so 
the resulting notification archive is named INCHARGE-SA.archive. This file is written to the 
BASEDIR/smarts/local/logs directory.


Over a period of time, a busy Global Manager can generate a sizeable archive file. It may 
be necessary to periodically rotate the notification archive file.
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Configuring business templates
Business templates are used to load business entities. Two types of business entities are 
topology-group/service data files and Business Impact Manager weights files.


Both topology-group/service data files and Business Impact Manager weights data can be 
loaded using text or XML files. 


To configure business templates:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration.


4. Click Business Templates.


The Configure Business Templates interface appears, as illustrated in Figure 4 on 
page 74.


Figure 4  Global Manager Administration Console—Configure Business Templates
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5. Select the format for the type of data file being configured.


TEXT is the default format file type for both topology-group/service data files and the 
Business Impact Manager weights files.


6. Click Modify List to add business template files.


Click Remove Selected to delete a selected business template file from the list.


7. Click Apply.


Business templates cannot be deleted.


Configuring Global Manager Administration Console preferences
The following preferences are configured using the Global Manager Administration 
Console Preferences dialog box:


◆ DXA configuration file cannot be found at the server location


◆ Hook script cannot be found at the server location


◆ Business template file cannot be found at the server location


◆ Prompt for confirmation when closing the console with a server which requires 
reconfiguration


◆ Prompt for confirmation when exiting the application with a server which requires 
reconfiguration


◆ Remind to reconfigure after changing Domain configuration


◆ Remind to reconfigure after changing Domain Group configuration


◆ Remind to reconfigure after changing Domain Type configuration


◆ Remind to reconfigure after changing Domain Tag configuration
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To configure Global Manager Administration Console Preferences:


1. From the Global Manager Administration Console, select View > Global Administration 
Console Preferences.


The Global Administration Console Preferences dialog box appears, as illustrated in 
Figure 5 on page 76.


Figure 5  Global Administration Console Preferences dialog box


2. Select or click your desired configuration options.


3. Click Apply.


Click Restore Defaults to restore the default configuration settings.
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Configuring IPv6 Availability Manager connections
The SM_IP_VERSIONS environment variable allows you to define the Internet Protocol (IP) 
version used when SAM is running in an IPv6 network. 


To configure this variable:


1. Using a text editor, edit the runcmd_env.sh file. The runcmd_env.sh file is located in 
the BASEDIR/smarts/local/conf/ directory.


2. Add the following line:


SM_IP_VERSIONS=<value>


The available values for the variable are:


• V4 — IPv4 connections only. This is the default value.


• V6 — IPv6 connections only.


• V4V6 — IPv4 connections preferred over IPv6 connections.


• V6V4 — IPv6 connections preferred over IPv4 connections.


3. Save and close the file.


4. Edit the com.smarts.ip_versions Java property. The value for this property must match 
the value entered for the SM_IP_VERSIONS environment variable.


The EMC Smarts System Administration Guide provides detailed environment variable 
information.


Examples of specifying the IP version


Code examples that specify the IP version when connection, include:


frame:v4
frame:v6
frame:v4v6
frame:v6v4
frame:v6:3026    ## 3026 is the port
[1:1::1111]:3026 ## 3026 is the port


The IP version in the following example is redundant but allowed:


[1:1::1111]:v6:3026 ## 3026 is the port
[1:1::1111]:v4v6:3026 ## 3026 is the port
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Audit logging
Entries written to the audit log include specific user interactions with EMC Smarts analysis 
servers.


Audit logging is enabled on the Service Assurance Manager and analysis servers when a 
modification is made to the servers from the Global Console.


Actions that a user may perform in the Global Manager Administration Console that are 
captured in the audit logs include:


◆ Escalation Policies


• Add an escalation policy


• Delete an escalation policy


• Modify an escalation policy


• Disable an escalation policy


• Enable an escalation policy


◆ Notification Lists


• Add a new notification list


• Delete a notification list


• Modify a notification list


– Modify filters


– Modify display headings


• Disable a notification list


• Enable a notification list


◆ Tools


• Add a new tool


• Delete a tool


• Modify a tool


• Allow different user profiles access to the tool


• Disable a tool


• Enable a tool


◆ User Profiles


• Add a user profile


• Delete a user profile
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• Modify a user profile


– Modify notification list


– Modify users associated with profile


– Modify tools the user profile can access


– Modify default console


– Modify console operations the user profile can access


• Disable a user profile


• Enable a user profile


This section includes the following topics:


◆ “Configuring the Audit Log Adapter” on page 79


◆ “Starting the Audit Log Adapter” on page 80


◆ “Starting a new log file” on page 80


◆ “Filtering the Audit Log” on page 81


Configuring the Audit Log Adapter


To generate audit log output on a server you must add the SM_AUDIT_CLIENT_ACTIONS 
environment variable to the runcmd_env.sh file. The runcmd_env.sh file is located in the 
BASEDIR/smarts/local/conf directory.


To add the SM_AUDIT_CLIENT_ACTIONS environment variable to the runcmd_env.sh file:


1. Invoke the sm_edit utility from the BASEDIR/smarts/bin directory:


sm_edit conf/runcmd_env.sh


If multiple EMC Smarts products are running on the same host, you should ensure you 
invoke the sm_edit utility from the bin directory of the product whose files you want to 
edit. The EMC Smarts Service Assurance Manager Configuration Guide contains 
additional sm_edit utility information.


2. Add the following environment variables and corresponding values using the following 
syntax:


SM_AUDIT_CLIENT_ACTIONS=TRUE
SM_AUDIT_ALL_CONNECTIONS=1


Set the SM_AUDIT_CLIENT_ACTIONS environment variable to true to have all console 
actions entered into the audit logs. Set the SM_AUDIT_ALL_CONNECTIONS 
environment variable to 1 to have all operations including command line actions 
entered into the audit logs.
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3. Save and close the runcmd_env.sh file.


4. Restart any EMC Smarts program currently running for the new environment variables 
to take effect.


Starting the Audit Log Adapter


To start the Audit Log Adapter, type the following command:


▼BASEDIR/smarts/bin/sm_server -n <adapter_name>
--config=audit-parse --output▲


Where:


◆ <adapter_name> is the name of the Audit Log Adapter. It is recommended that you 
name the Audit log Adapter relative to the server for which it is performing audit 
parsing, for example, INCHARGE-SAM-AUDIT.


▼ ▲ Indicates that this command must be typed as one line. Separate each option with a 
space when typing the command.


To name the Audit Log Adapter a name other than <adapter_name>:


1. Copy the Sam/Smarts/conf/audit-parse/adapter-name.conf file to the 
sam/smarts/local/conf/audit-parse directory.


2. Rename the adapter-name.conf file with the same name as the Audit Log Adapter.


For example, if the Audit Log Adapter name is Audit-log, the adapter-name.conf file 
should be renamed Audit-log.conf.


Starting a new log file


The roll_sam_auditlog command is invoked through the dmctl utility, which requires that 
you attach to a Domain Manager or adapter with administrative privileges. The syntax of 
the command is:


serverName exec roll_sam_auditlog


For example, on Windows to start a new log file for a Domain Manager named InCharge, 
type the following command and press Enter:


C:\InCharge\SAM\smarts\bin\dmctl -s InCharge exec roll_sam_auditlog


On UNIX systems, the equivalent command is:


opt/InCharge/SAM/smarts/bin/dmctl -s InCharge exec roll_sam_auditlog


When roll_sam_auditlog is invoked, the Domain Manager or adapter writes an 
informational message to the end of the current log file, repeats the steps it executed at 
startup, and creates a new log file and a backup log file. All subsequent logging 
information is recorded to the new file.
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Filtering the Audit Log


By default, the SAM audit log performs an audit and logs SAM functions in the .audit file 
without filtering. When logging of client actions is enabled, the audit log provides 
information about client actions that changed the state of the server, such as put, insert, 
remove or delete requests. The audit ignores requests for information that do not change 
the state of the server, for example, get requests. 


Many operations do not change the state of a server, and hence do not need to be logged 
or audited. The conf/ics/sam-audit-filter.import file contains a list of operations that are 
known to not change the state of the server. If a new operation is added that does not 
change the state of the server or if you do not want a particular operation logged, then the 
operation may be added to the file to suppress logging that operation when it is invoked. 
Each operation to be suppressed is listed on a separate line as a string containing the 
class name, two colons, and the operation name.


In order to exclude redundant functions from the .audit file, a filtering criteria is available. 
To exclude functions from the audit log, add them to the conf/ics/sam-audit-filter.import 
file. After the file is updated, restart SAM.
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SAM performance throughput report
SAM performance throughput report provides users with information on notifications 
processed, notified, cleared and changed within a specified time interval. The report 
explains the possible slowdown in SAM performance and provides a better view into the 
health of SAM. The report, referred to as the <SAM-SERVER-NAME>.perf file, is available 
under the <BASEDIR>/smarts/local/logs directory. 


This report provides information on notification processing attributes such as:


◆ Average notification processing time


◆ Average impact refresh calculation time


◆ Number of topology synchronizations that have occurred during the default 
monitoring duration


◆ Average time for processing hook files


◆ Number of connected events


◆ Number of disconnect events


◆ Number of suspended events


◆ Number of cleared events


◆ Number of timer alarms


◆ Number of events with heart beats


◆ Number of rejected events


◆ Number of accepted events


◆ Number of notified events


◆ Average time taken to push an event to the NOTIF processing queue


The monitoring period for the report is controlled by the PERF_ARCHIVE_INTERVAL 
environment variable. The default time interval for this variable is set to 3600 seconds 
(that is, one hour). At an interval of every one hour, the above mentioned performance 
statistics are written to the <SAM-SERVER-NAME>.perf file. 


Each record in the file is in the following format:


<DATA-TIME> - <DOMAIN-MANAGER-NAME> : Performance metrics


Provided below is an example of the SAM performance throughput report:


December 19, 2011 4:23:19 PM GMT+05:30 - EMC-IT : 
Avg_NotificationProcess_Time = 0      Avg_ImpactRefresh_Time = 0      
No_Toposync = 0 Property_Control = 0Attrib_Change = 0        Connect 
= 0     Suspend = 0     Clear = 0       Avg_HookFileProcess_Time = 0    
Avg_NotifProcess_Time = 0       Timer_Alarm = 60    Disconnect = 0   
Heart_Beat = 0  Reject = 0      Accept = 0      Notify = 0      
Total_Count = 60


You can modify the default time interval set for the PERF_ARCHIVE_INTERVAL environment 
variable in the ics-event-processing.asl and the ics-nl-processing.asl files. These files are 
located under the <BASEDIR>/local/rules/ics folder or the <BASEDIR>/rules/ics folder. The 
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modification must be carried out in both the ics-event-processing.asl and the 
ics-nl-processing.asl files. Use the sm_edit utility to modify the values to these files. For 
example:


BASEDIR/smarts/bin>sm_edit ../rules/ics/ics-event-processing.asl


You must reconfigure the domain for the changes to take effect. 


Performance threshold event in SAM
As part of performance monitoring, few threshold values have been defined in the 
DEFINE_PERF_THRESHOLD_VALUES rule, available in the ics-event-processing.asl and 
ics-nl-processing.asl files. You can find these ASL files in the <BASEDIR>/local/rules/ics 
folder or the <BASEDIR>/rules/ics folder. For example, the default number of threads for 
disconnected events in an hour is one. If case more than one disconnected event is found, 
SAM generates a performance monitoring severity 2 notification in SAM with relevant 
details. This notification will get auto-cleared after an hour as defined in the 
PERF_ARCHIVE_INTERVAL environment variable. 


Table 9 on page 83 lists the SAM performance monitoring threshold setting parameters. 
This feature is not enabled by default. You can enable this feature by setting the value for 
the PERF_THRESHOLD_EVENT flag to TRUE in both the ics-event-processing.asl and 
ics-nl-processing.asl files.


You can modify the default values for the performance monitoring threshold parameters 
by modifying the values for the parameters both in the ics-event-processing.asl and the 
ics-nl-processing.asl files. Use a text editor or the sm_edit utility to modify the values. For 
example:


BASEDIR/smarts/bin>sm_edit ../rules/ics/ics-event-processing.asl


You must reconfigure the domain for the changes to take effect. 


Table 9 SAM performance monitoring threshold setting parameters


Parameter Default Values


Number of Topology 
Synchronization


The maximum is one topology synchronization operation 
every 10 minutes for a given domain manager.


Number of disconnect Events The maximum is one disconnected event in an hour for a 
given domain manager. 


Average Impact Refresh 
Calculation Time


The average time taken must not be more than 5 seconds.


Average Notification Processing 
Time


The average time taken must not be more than one second.


Average Hook file processing 
Time


The average time taken must not be more than two seconds.


Average Time taken to push an 
Event to NOTIF processing 
queue


The average time taken must not be more than two seconds.
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Notification lifecycle auditing
Notification lifecycle auditing feature helps you identify any kind of delay in the event or 
notification processing lifecycle. If this feature is enabled the audit log includes additional 
information such as the time spent by a notification in a hook script, in addition to notify, 
refresh impact, NOTIF processing, change and clear events. 


Auditing entries are displayed for the following stages of event or notification processing:


◆ Notification creation and updating of notification attributes


◆ Topology element linking


◆ Hook script invocation


◆ Impact and CausedBy relationship update


◆ NOTIF processing


The feature is disabled by default and can be manually enabled when required for that 
specific domain by setting the variable detailedEventAudit to TRUE.


To enable notification lifecycle auditing, type the following command:


#dmctl -s <SAM-Server> put InChargeDomain::InChargeDomain_<omain 
Name>::detailedEventAudit TRUE


For example,


#dmctl -s <SAM-Server> put 
InChargeDomain::InChargeDomain_INCHARGE-AM::detailedEventAudit TRUE


The feature can be disabled for each domain by setting the parameter detailedEventAudit 
to FALSE using the same command:


#dmctl -s <SAM-Server> put 
InChargeDomain::InChargeDomain_INCHARGE-AM::detailedEventAudit 
FALSE


The values of the EventAudit and NotificationAudit flags in the DXA configuration files 
associated with the underlying domain are internally changed based on the value set for 
detailedEventAudit.


EMC recommends that you use the variable detailedEventAudit to enable or disable 
notification lifecycle auditing. Modifying values in the DXA configuration files can cause a 
conflict and there is a chance that the value of detailedEventAudit will get overwritten 
when the event driver restarts.


The audit trail has a size limit and is by default set to 100 entries. Defining system defaults 
section in the EMC Smarts Service Assurance Manager Configuration Guide describes the 
procedure to modify the default audit trial size limit.
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Configuring weights.conf for OTM


This is an Optical Transport Manager (OTM) product-specific configuration in SAM, and 
hence not required to be carried out by other product users.


The SAM weights.conf file must be configured in the SAM installation area. After you 
install SAM, the following new, weights files are installed in SAM installation area:


◆ <BASEDIR>smarts/conf/ics/weights.conf


◆ <BASEDIR>smarts/conf/ics/weights-otm.conf


The weights-otm.conf contains the names of the classes which need to be appended to 
weights.conf for Impact count calculation.


1. Use sm_edit to open the <BASEDIR>smarts/conf/ics/weights.conf and the 
<BASEDIR>smarts/conf/ics/weights-otm.conf.


2. Copy the following configuration items from 
<BASEDIR>/smarts/conf/ics/weights-otm.conf: 


• ClassWeight OpticalNetworkElement 0


• NotificationClassWeight HighOrder_Circuit 1


• NotificationClassWeight LowOrder_Circuit 1


• NotificationClassWeight ClientCircuit 1


• NotificationClassCheck TopologicalLink


• NotificationClassCheck DropSideTopologicalLink


• NotificationClassCheck BBFiberLink


• NotificationClassCheck BBTopologicalLink


• NotificationClassCheck BBDropSideTopologicalLink


• NotificationClassCheck Equipment


• NotificationClassCheck Card


• NotificationClassCheck EquipmentProtectionGroup


• NotificationClassCheck FiberLink


• NotificationClassCheck FiberBundle


• NotificationClassCheck OpticalNetworkElement


• NotificationClassCheck HighOrder_Trail


• NotificationClassCheck LowOrder_Trail


• NotificationClassCheck Transponder


• NotificationClassCheck Amplifier
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• NotificationClassCheck PTP


• NotificationClassCheck Conduit


3. Paste the configuration items to <BASEDIR>/conf/ics/weights.conf.


4. Save and close conf/ics/weights.conf.


5. Close conf/ics/weights-otm.conf without saving.


EMC Smarts Optical Transport Management Installation Guide provides detailed 
instructions on installing OTM.


Hierarchical SAM configuration
In a typical SAM configuration, when the server is started it does not contain the dynamic 
library to load all custom classes, for example, UIM_O_AdapterManager. In a custom 
hierarchical SAM configuration, this could result in generating ASL errors. 


The following configuration must be made in the hierarchical SAM area to avoid the 
generation of ASL errors:


1. Copy dyn_uii.ldm and dyn_uii.mdl files from the Service Assurance Manager 
BASEDIR/smarts/model/ics files to the BASEDIR/smarts/local/model/top-sam folder. 
Here, top-sam is the custom created folder for the top-level SAM.


2. Restart the server.
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Configuring domains
This section provides detailed information on configuring domains and includes the 
following topics:


◆ “Creating a domain” on page 88


◆ “Modifying domains” on page 91


◆ “Deleting domains” on page 92


Table 10 on page 88 defines the domains available.


The domains will be available in the Console only if SAM is started without an RPS file. For 
domains with existing RPS files, the domains will not be available. The INCHARGE-AM 
domain is enabled by default. All other domains are disabled. 


You can use sm_config utility to import domain configurations. However, EMC Corporation 
recommends that you create and modify domains using the Domain Creation Wizard and 
the Global Manager Administration Console. “Creating a domain” on page 88 and 
“Modifying domains” on page 91 provide detailed information.


Creating a domain


To create a domain:


1. From the Global Manager Administration Console, click Edit > New Domain.


The Domain Creation Wizard appears.


2. Type the name of the domain server in the Domain Name field.


Table 10  Available domains


Domain Description


INCHARGE-AM-PM Availability and Performance Manager


INCHARGE-AM Availability Manager


INCHARGE-DISCMGR Discovery Manager


INCHARGE-MPLS-ANALYSIS Analysis Server for MPLS 2.0


INCHARGE-MPLS-MONITORING Monitoring Server for MPLS 2.0


INCHARGE-MPLS-TOPOLOGY Topology Server for MPLS 2.0


INCHARGE-OI Adapter Platform 


INCHARGE-PM Performance Manager


INCHARGE-MBIM MBIM Manager


NCM Network Connectivity Monitor
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3. Type the description of the domain in the Domain Description field, and click Next.


To create a domain using the Copy Existing option, select an existing domain server 
from the Copy Existing list, type a Domain Name, and click Finish.


4. Click the domain type. Available options include:


• Use Default Type


This option is available only when copying an existing domain.


• Create New Type


If this option is selected, type the name of the domain type in the Type Name field.


To copy an existing domain type, select an existing domain type from the Copy 
Existing list.


• Select Existing Type


If this option is selected, select a domain type from the Select Type list.


5. Click Next.


6. Type the tag string in the Tag String field. 


If a tag string is not specified, go to step 12.


7. Click Next.


8. Click the appropriate option. Available options include:


• Use Default Tag


This option only appears when a copied domain is selected or when the selected 
domain has an assigned tag.


• Create New Tag


Type a name in the Tag Type Name field. To copy an existing tag, select a tag from the 
Copy Existing list. 
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• Select Existing Tag


Select a tag from the Select Tag list.


9. Click Next.


10. Type description in the Tag Description field.


11. Type a matching tag pattern in the Matching Pattern field.


12. Click Next.


13. Select the groups this domain belongs to from the Available Groups list.


14. Click the group’s role. Available options include:


• Topology Server


• Monitoring Server


• Analysis Server


This step is only required if configured groups exist.


15. Click Add to move the group to the Selected Groups list.


16. Click Next.


The instance that will be created when the domain creation process is complete is 
displayed.


By default, the domain is enabled. If the domain is part of a domain group, it is only 
enabled if the domain group it belongs to is enabled. To disable the domain, clear its 
checkbox.


17. Click Finish.


Domain naming conventions
To allow the console to easily suppress names of component domain servers, domain 
names must comply with the following naming convention:


Group Name-Role[-Sub-Role]


Where:


◆ Group Name — Identifies the function of the group (for example, MPLS) as well as the 
region or other further designation if multiple groups with the same function are being 
deployed. For example, MPLS-NA might designate the MPLS server group monitoring 
North America.
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◆ Role — Must be one of MONITORING, TOPOLOGY, or ANALYSIS. This is the key field the 
graphical user interface uses to identify component servers.


◆ Sub-Role — Distinguishes multiple servers within the same role. For example, 
MPLS-Monitoring-Snmp and MPLS-Monitoring-Ping. 


Modifying domains


To modify a domain:


1. Open the Global Manager Administration Console.


2. From the Manager List, select the SAM Manager.


3. Expand ICS Configuration.


4. Expand IC Domain Configuration.


5. Expand Domains.


6. Click the appropriate domain.


The Configure Domain interface appears, as illustrated in Figure 6 on page 91.


Figure 6  Global Manager Administration Console—Configure Domain interface


7. Type the appropriate configurations.


Table 11 on page 91 describes the available Domain parameters.


Table 11  Domain parameters


Parameter Description


Enable Enables the domain.


Domain Description Provides a description of the domain.


Domain Type Defines the domain type.
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8. Click the Apply.


9. Click Reconfigure.


Configuration changes are not applied until the Reconfigure button has been clicked. 
Clicking the Reconfigure button starts the data synchronization process. Click the 
Reconfigure button only after all updates to domains, domain tags, domain groups, 
and domain types have been made.


Deleting domains


To delete domains:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain.


6. Click the appropriate domain.


7. Select Edit > Delete.


The selected domain is deleted.


Domains that refer to other domains cannot be deleted.


Show Type Details Displays the domain type information.


Tag Type Defines the tag type.


Tag String Defines the tag string.


Domain Groups Defines the domain groups in which the domain is 
included.
The table includes the following columns:
• T — Topology
• M — Monitoring
• A — Analysis


Notice: Click Add New to display the Add Domain Group 
dialog box. Select a Domain Group and click Delete 
Selected to remove a domain group.


Table 11  Domain parameters (continued)


Parameter Description
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Configuring domain groups
A typical domain group comprises three servers—a topology server, an analysis server, 
and a monitoring server. 


For more complex deployments, contact Custom Engineering.


The Configure Domain Group interface consists of a description of the domain group and 
three sections listing the topology servers, monitoring servers, and analysis servers. A 
typical MPLS deployment includes one of each type of server. The pane included on the 
left of the interface displays the default configuration of the Service Assurance Manager 
(SAM) server.


Most domain objects included in the default configuration are disabled (except 
INCHARGE-AM). The MPLS Group is disabled by default.


This section includes the following topics:


◆ “Creating domain groups” on page 93


◆ “Modifying domain groups” on page 94


◆ “Deleting domain groups” on page 96


Creating domain groups


Use the Domain Groups Creation Wizard to create a new domain group. Using the wizard, 
you can:


◆ Copy an existing domain group and type a name for the new group. The wizard 
automatically creates the domains in the group.


◆ Manually create the component domains from within the wizard.


Creating a domain group using the Copy Existing option
To create a domain group using the Copy Existing option:


1. From the Global Manager Administration Console, click Edit > New Domain Group. 


The Domain Group Creation Wizard appears.


2. Select a group to be copied from the Copy Existing list.


3. Type a name in the Group Name field.


4. Type a description in the Group Description field.


5. Click Next. 
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6. Click Default Configuration.


To customize the configuration, click Customized Configuration. This option is for 
advanced users only.


7. Click Finish.


The configuration objects are created in the server.


Manually creating a domain group
To manually create a domain group:


1. From the Global Manager Administration Console, click Edit > New Domain Group.


The Domain Groups Creation Wizard appears.


2. Type a name in the Group Name field.


3. Type a description in the Group Description field.


4. Click Next.


5. Click Default Configuration.


To customize the configuration, click Customized Configuration and complete the 
Select Topology Server options. If the Default Server option is selected, the wizard 
creates a default server for this group. The default server does not include any domain 
tagging information. The default server’s domain type is copied from the 
corresponding domains of the copied domain group.


6. Click Next.


The instance that will be created once the domain group creation process is complete 
appears in the wizard.


By default, the domain group is enabled. If a domain is part of the domain group, it is 
also enabled. To disable the domain group, clear its checkbox.


7. Click Finish.


Modifying domain groups


To modify a domain group:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Groups.
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6. Click INCHARGE-MPS. The Configure Domain Group interface appears, as illustrated in 
Figure 7 on page 95.


Figure 7  Global Manager Administration Console—Configure Domain Group interface


7. Type the appropriate configurations.


Table 12 on page 95 describes the available Domain Group parameters.


Table 12  Domain Group parameters


Parameter Description


Enable Enables the domain group.
Enabling a domain group enables all the domains within it.  
Disabling the group disables domains included in the group 
as long as the domains are not members of any other 
enabled group.  Disabling or enabling a domain, however, 
has no effect on groups of which that domain is a member. 


Group Description Provides a description of the domain group.


Topology Servers Defines the topology servers.


Monitoring Servers Defines the monitoring servers.


Analysis Servers Defines the analysis servers.
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Click the Modify List button to display the Modify List of Topology Services dialog box. 
To remove a server from a list, select the server in the list and click the Removed 
Selected button.


8. Click the Apply.


9. Click Reconfigure.


Configuration changes are not applied until the Reconfigure button has been clicked. 
Clicking the Reconfigure button starts the data synchronization process. Click the 
Reconfigure button only after all updates to domains, domain tags, domain groups, 
and domain types have been made.


Deleting domain groups


To delete domain groups:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Groups.


6. Click the appropriate domain group.


7. Select Edit > Delete.


The selected domain group is deleted.


Domain groups that refer to other domains cannot be deleted.
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Configuring domain types
A domain type is a configuration object that captures all the settings relevant to a 
particular type of domain with which the Service Assurance Manager server connects. One 
domain type exists for each class of server communicating with the Service Assurance 


Manager; for example, AM, NPM, MPLS, and SIA.


Properties of a domain type include:


◆ DXA file


◆ Hook scripts


◆ Minimum certainty


◆ Smoothing intervals


The domain type does not instantiate a domain object.


Table 13 on page 97 defines the default domain types.


Additional domain types previously configured in the ics.conf file are available as 
separately loadable XML files located in the conf/ics directory.


The following topics are included in this section:


◆ “Creating domain types” on page 98


◆ “Modifying domain types” on page 99


◆ “Deleting domain types” on page 101


Table 13  Default domain types


Domain type Description


INCHARGE-AM-PM-SUITE Availability and Performance Manager


INCHARGE-AM-SUITE Availability Manager


INCHARGE-DISCMGR-SUITE Discovery Manager


INCHARGE-MPLS-ANALYSIS-SUITE Analysis Server for MPLS 2.0


INCHARGE-MPLS-MONITORING-SUITE Monitoring Server for MPLS 2.0


INCHARGE-MPLS-TOPOLOGY-SUITE Topology Server for MPLS 2.0


INCHARGE-OI-SUITE Open Integration Server


INCHARGE-PM-SUITE Performance Manager


INCHARGE-SAM-MBIM-SUITE Maintenance and Business Impact Manager


NCM-SUITE NCM OEM
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Creating domain types


To create a domain type using the Domain Groups Creation Wizard:


1. From the Global Manager Administration Console, click Edit > New Domain Type.


The Domain Groups Creation Wizard appears.


2. Select a type to be copied from the Copy Existing list.


3. Type a name in the Type Name field.


4. Type a description in the Type Description field.


5. Click Next.


6. Edit the domain type settings, and click Next.


Table 14 on page 98 defines the available domain type settings.


7. Select the servers from the Available Domains list.


8. Click Add to move the server to the Selected Domains list. 


This defines the servers associated with the new domain type.


Domains cannot be removed from a domain type—they can only be reassigned to another 
domain type. By adding domains, you are only reassigning the domains to a different 
domain type. Newly added domains display in green text. You can only delete domains 
displayed in green text. After clicking Apply, the domains cannot be deleted.


9. Click Next.


10. Click Finish. The configuration objects are created in the server.


Table 14  Domain type settings


Option Definition


DXA File Defines the DXA configuration file.


Hook Script: Enable Enables the hook script.


Notice: If the hook script is enabled, type the path for the hook 
script in the field.


Minimum Certainty Defines the minimum certainty.
Default value: 0.01


Smoothing Interval Defines the smoothing interval.
Default value: 65
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Modifying domain types


To modify a domain type:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Types.


6. Click the appropriate INCHARGE Domain Type. The Configure Domain Type interface 
appears, as illustrated in Figure 8 on page 99.


Figure 8  Global Manager Administration Console—Configure Domain Type interface


7. Type the appropriate configurations. 
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Table 15 on page 100 defines the available domain type configuration parameters.


8. Click Apply.


9. Click Reconfigure.


Configuration changes are not applied until the Reconfigure button has been clicked. 
Clicking the Reconfigure button starts the data synchronization process. Click the 
Reconfigure button only after all updates to domains, domain tags, domain groups, 
and domain types have been made.


Table 15  Domain type configuration parameters


Parameters Definition


Type Description Defines the domain type.


DXA Configuration File Defines the DXA configuration file.


Hook Script: Enable Enables the hook script.


Notice: If the hook script is enabled, type the path for the hook 
script in the field.


Minimum Certainty Defines the minimum certainty.
Default value: 0.01


Smoothing Interval Defines the smoothing interval.
Default value: 65


Domains Defines the domains associated with the domain type.


Notice: Click Modify List to add domains, select a domain from the 
list and click Remove Selected to remove domains, and click 
Restore to restore previously configured domains. Domains cannot 
be removed from a domain type, they can only be reassigned to 
another domain type.
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Deleting domain types


To delete domain tags:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Types.


6. Click the appropriate domain type.


7. Select Edit > Delete.


The selected domain type is deleted.


Domain types that refer to other domains cannot be deleted.


Managing overlapping elements from separate underlying 
domains


A Global Manager collects topology information from multiple underlying domains. In 
some cases, two or more of these domains can manage elements with the same name. 
Two such examples are IP networks, which are named using the network address, and 
partitions which are assigned names by the underlying domain.


For example, a service provider might use a private IP network address, such as 10.0.0.0, 
to provide IP addresses to different customers. When the same range of IP addresses are 
assigned to multiple customers, different topology elements may have the same IP 
address, and thus the same name.


Partitions are created and named by IP Availability Manager. All IP Availability Managers 
use the same convention to name partitions. If the topologies of two domain managers 
each include partitions, it is possible that one or more of the partitions have the same 
name, as defined by the Name attribute. The EMC Smarts IP Manager User Guide provides 
more information about partitions. 


By default, the Global Manager treats elements with the same name from different 
underlying domains as a single instance, consolidating the relationships and attributes of 
the two elements to a single topological instance. The values for the attributes are taken 
from the underlying domain that performs the most recent topology synchronization.


You can, however, configure the Global Manager to manage elements of the same name 
from different domains as distinct elements. By specifying a tag for one or both of the 
underlying domains, the Global Manager will create two separate topology elements, each 
containing the attributes and relationships of the respective objects in the underlying 
domains. The tag that you specify is appended to the name of the objects in the tagged 
domain and displayed in the Global Console.
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To tag managed elements, you need to complete two tasks:


◆ Specify a tag.


◆ Specify a matching pattern that will match the IP addresses and partitions to be 
tagged.


How the Global Manager applies tags


The Global Manager can apply tags to both topology elements and notifications. The 
Global Manager finds matching elements by comparing the matching pattern against the 
Name and DisplayName attributes of both topology elements and notifications from the 
relevant underlying domain. If they match the filter, both are applied to the tag. 
Additionally, a notification on a matching instance will cause the Name, DisplayName, 
InstanceDisplayName, and InstanceName of the notification to be tagged.


As a result, you should construct a matching pattern to match the values of attributes you 
want tagged. For topology elements, this can include the Name and DisplayName 
attributes. For notifications, this can include the DisplayName, InstanceDisplayName, and 
InstanceName attributes.


For example, the pattern IP*-172.16.*|172.16.* could match the following:


◆ Elements of the IPNetwork class, which are prefixed with “IPNET-”. For 
IPNET-172.16.0.0, the following would result:


• DisplayName of 172.16.0.0 [tag-3]


• Name of IPNET-172.16.0.0_tag-3.


◆ Elements of the system classes, such as Host, that are named using the system’s IP 
address. For host 172.16.1.107, the following would result:


• DisplayName of 172.16.1.107 [tag-3]


• Name of 172.16.1.107_tag-3.


◆ Notifications generated for these elements would also be tagged. For a Host Down 
notification, the following would result:


• DisplayName of Host Down 100%: 172.16.1.107 [tag-3]


• InstanceDisplayName of 172.16.1.107 [tag-3]


• InstanceName of 172.16.1.107_tag-3.


If the system is named by its hostname, this matching pattern would not apply.
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Configuring domain tagging
Domain tags allow the Service Assurance Manager to tag a subset of the topology of a 
given domain. Domain tags distinguish a topology subset from topology from an 
underlying domain which may have instance names that overlap but represent unique 
instances in the network topology.


A domain tag consists of a unique identifier and a wildcard expression that identifies 
matching instances.


The following topics are included in this section:


◆ “Creating domain tags” on page 103


◆ “Modifying domain tags” on page 104


◆ “Deleting domain tags” on page 105


Creating domain tags


To create a domain tag:


1. From the Global Manager Administration Console, click Edit > New Domain Tag. 


The Domain Tag Creation Wizard appears.


2. Type a name in the Tag Type Name field.


3. Type a description in the Tag Description field.


To copy an existing tag, select a tag from the Copy Existing list.


4. Click Next.


5. Type a matching pattern for the domain tag in the Matching Pattern text box.


6. Click Next.


7. From the Available Domains list, select domains for which the domain tag applies.


For each domain selected, type a tag string in the Tag String field. If a domain has a 
tag string already associated with it, you can replace the domain tag associated with 
the tag string with this new one.


8. Click the Add button to move the selected domains to the Selected Domains list.


9. Click Next.


Instances that will be created when the create domain tag process is completed 
appear in this screen.


10. Click Finish.
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Modifying domain tags


To modify domain tags:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Tags.


6. Click the appropriate domain tag.


The Configure Domain Tag interface appears, as illustrated by Figure 9 on page 104.


Figure 9  Global Manager Administration Console—Configure Domain Tag interface


7. Type the appropriate configurations.

104 EMC Smarts Service Assurance Manager Configuration Guide







Configuring Domains

Table 16 on page 105 describes the available Domain Tag parameters.


8. Click Apply.


9. Click Reconfigure.


Configuration changes are not applied until the Reconfigure button has been clicked. 
Clicking the Reconfigure button starts the data synchronization process. Click the 
Reconfigure button only after all updates to domains, domain tags, domain groups, 
and domain types have been made.


Deleting domain tags


To delete domain tags:


1. Open the Global Manager Administration Console.


2. From the Manager list, select the SAM Manager.


3. Expand ICS Configuration. 


4. Expand IC Domain Configuration.


5. Expand Domain Tags.


6. Click the appropriate domain tag.


7. Select Edit > Delete.


The selected domain tag is deleted.


Domain tags that refer to other domains cannot be deleted.


Table 16  Domain Tag parameters


Parameter Description


Tag Description Provides a description of the domain tag.


Matching Pattern Defines the domain tag matching pattern.


Notice: Wildcard expressions are valid.


Domains Defines the domains with which the domain tag is 
associated.


Notice: Click Add New to display the Add New Domain 
dialog box. Select a domain and click Edit Selected to 
display the Edit Domain dialog box. Select a domain and 
click Delete Selected to delete the selected domain.
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Reconfiguring the server
Any modifications to domains, domain groups, domain tags, and domain types are not 
implemented until the server has been reconfigured. You should reconfigure the server 
only after all modifications have been applied—not after each individual modification. 
When you click the Launch Server Reconfiguration toolbar button, the reconfigure process 
begins. 


Click View > Message Log to display the Manager Message Log window. Configuration 
errors are displayed in this window.


The Service Assurance Manager server applies all reconfigurations during the restart 
process.


To reconfigure the server:


From the Global Manager Administration Console, click the Launch Server Reconfiguration 
toolbar button.


Click the Launch Server Reconfiguration toolbar button only after all modifications have 
been applied.
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Managing Notifications with the Global Manager


This chapter contains the following information:


◆ Overview of notifications.......................................................................................  108
◆ Understanding and managing notifications ...........................................................  109
◆ Acknowledging and archiving notifications............................................................  113
◆ Notification types and incrementing OccurrenceCount...........................................  114
◆ User-defined notification attributes.......................................................................  115
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Overview of notifications
The Global Manager stores the topology and event information that it receives from the 
underlying domains in its repository. The topology and event information are stored as 
objects, that is as instances of the classes defined in the ICIM model. The notifications 
that Global Manager sends to clients are themselves objects in the Global Manager’s 
repository.


Notification objects, similar to other objects in the Global Manager’s repository, have 
attributes that describe their properties. For notifications, these attributes include the 
time the event occurred, the type of event, the name of the object where the event 
occurred, and much more information. “Attributes for matching notification properties” on 
page 215 provides a complete list of notification attributes.


Notification attributes are used throughout Service Assurance for a variety of purposes:


◆ Notification attributes correspond to the columns in the Notification Log of the Global 
Console. 


Attribute names are not exactly the same as the column headings of the Notification 
Log.


◆ You can specify a matching pattern against the values of notification attributes for 
filtering a notification list. 


◆ Twenty notification attributes are user-defined. You can write an ASL script that 
populates these attributes with additional information.


This chapter discusses how you can manage notifications using the Global Manager. In 
addition to the standard notification processing provided by the Global Console, you can 
also manage notifications creation in a more extensive manner from any event source 
using the NOTIF Editor. This editor allows for real-time reconfiguration of event and 
notification processing without server restarts. The EMC Smarts Notification Module User 
Guide provides detailed information on configuring events and notifications using the 
NOTIF Editor.
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Understanding and managing notifications
This section describes the states of a notification. It also describes the attributes of a 
notification and how a change in the notification’s state affects the values of these 
attributes. Finally, this section describes the acknowledgement and archiving of 
notifications.


The following notification attributes are related to a notification’s state:


◆ Event State


◆ First Notify Time


◆ Last Notify Time


◆ Last Change Time


◆ Last Clear Time


◆ Count


The connotation for the Last Notify Time attribute differs between the one displayed in the 
SAM notification console and the IP event console. In the IP event console, Last Notify 
Time indicates the current timestamp of the console, compared to the actual notification 
time displayed in SAM. Hence, the Last Notify Time from the IP event console must not be 
used for correlation of the Last Notify Time between SAM and IP. 
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States of a notification


A notification’s state is defined by the Event State attribute, which has five possible 
values. Table 17 on page 110 describes each possible value of the Event State attribute 
and shows its relationship to the Active notification attribute.


The WAS_ACTIVE and SUSPENDED event states
The WAS_ACTIVE event state is used to identify those notifications that are active under 
two conditions:


◆ A Global Manager disconnects from the underlying domain that is the event source. In 
this case, all active notifications from the disconnected domain are marked 
WAS_ACTIVE.


◆ A Global Manager is started from a saved repository file. In this case, all active 
notifications are marked WAS_ACTIVE.


Notifications marked as WAS_ACTIVE remain in the WAS_ACTIVE state until the Global 
Manager can verify their status.


Table 17  Description of Event State notification attribute


Event State value Description Active value


ACTIVE Event that caused the notification is occurring. The 
notification is in the “notify” state.


TRUE


WAS_ACTIVE Global Manager is disconnected from the underlying 
domain that was the source for the notification. 


Notice: The WAS_ACTIVE attribute is not applicable 
when the Broadcast Event State on Restart Flag is 
configured to FALSE.


“The WAS_ACTIVE and SUSPENDED event states” on 
page 110 describes the suspended state. “Defining 
system defaults” on page 69 provides detailed 
information on the Broadcast Event State on Restart 
Flag system default.


TRUE


SUSPENDED Global Manager is no longer receiving information 
about an active notification.


Notice: The SUSPENDED attribute is not applicable 
when the Broadcast Event State on Restart Flag 
system default is configured to FALSE.


“The WAS_ACTIVE and SUSPENDED event states” on 
page 110 describes the suspended state. “Defining 
system defaults” on page 69 provides detailed 
information on the Broadcast Event State on Restart 
Flag system default.


TRUE


INACTIVE Event that causes the notification is no longer 
occurring. The notification is in the clear state.


FALSE


UNINITIALIZED State of the notification object when it is first created 
and before any state is assigned to it.


FALSE
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If the Global Manager is not able to reconnect to the underlying domains that generated 
these notifications in 1800 seconds (30 minutes), the value of the Severity attribute is set 
to 4 (“Severity”  on page 217 provides additional information), changing the color of the 
notification in a Notification Log to blue. The value of 1800 seconds is referred to as the 
detachTime.


When the connection between the Global Manager and the underlying domains is 
reestablished, the Global Manager does the following:


◆ Notifications that are still active in the underlying domain have their Event State 
changed to ACTIVE and their Severity value updated accordingly. The Last Change 
attribute is assigned the current time and the Last Notify attribute value remains 
unchanged.


◆ Notifications that have cleared in the underlying domain remain in the WAS_ACTIVE 
state until the attachTime has elapsed. The default value of attachTime is 6000 
seconds (100 minutes). However, the actual value that is used to calculate when to 
clear the notifications is determined as follows:


• When the uptime for the underlying domain is greater than the attachTime, then 
the value is 240 seconds plus the smoothing interval. The smoothing interval is 
specified in the corresponding Domain Type. This typically occurs when the server 
was restarted.


• When the uptime for the underlying servers is less than the attachTime, the value 
is attachTime minus uptime plus the smoothing interval plus 20 minutes. For 
temporary disconnects, this value is typically used to determine the state of 
WAS_ACTIVE notifications. This typically occurs when the server was restarted and 
there was a disconnect.


The SUSPENDED state indicates that the Global Manager is no longer able to retrieve 
information about an active notification. When an underlying Domain Manager is not able 
to get to the source of a notification, it suspends the notification. The Domain Manager 
sends this message to the Global Manager, which in turn suspends the notification. A 
Domain Manager may not be able to get to the source of a notification because an SNMP 
agent is not responding or because it received unexpected error values in an SNMP 
request. 


Notifications suspended by the Global Manager have the value of the Severity attribute 
set to 4, changing the color of the notification in a Notification Log to blue.


A notification’s life cycle


Each notification has a unique name. A notification’s name consists of the class name and 
instance name where the event occurred, and the event name. The notification naming 
convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, 
which occurred in instance R1 of the Router class. 


The Notification Log Console will not list more than one notification with this name. If the 
event clears and occurs again before it is archived, the Count field is increased 
accordingly.


The following notification attributes are related to a notification’s state:
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◆ First Notify — Is the first time a notification occurs.


◆ Last Notify — Is the last time a notification occurs.


◆ Last Clear — Is the last time a notification cleared.


◆ Last Change — Is the last time a notification changed.


◆ Count — Is the number of occurrences of an event starting from First Notify until Last 
Notify.


Table 18 on page 112 illustrates the states of the notification 
NOTIFICATION-Router_R1_Down. For the First Notify and Last Notify attributes, the 
timestamp value is provided by the underlying domain that diagnosed the event. Values 
for Last Change, Count, and Last Clear (not shown) are provided by the Global Manager.


In this example:


At 1:00, an Availability Manager generated a Down event. 


At 2:00, the Global Manager connected to the Availability Manager and the Global 
Manager created the notification NOTIFICATION-Router_R1_Down for the Down event. The 
Global Manager retains the original timestamp of the event and stores it in the 
notification—First Notify and Last Notify are assigned the values of 1:00.


At 2:15, the notification is cleared.


At 2:25, the Availability Manager generated the same Down event again, the Availability 
Manager was already connected to the Global Manager, and the Global Manager 
reactivates the notification. The First Notify remains 1:00 and the Last Notify reads 2:25.


At 2:35, the notification is cleared.


At 3:00, the operator acknowledged the notification.


Notice at 3:05, the notification is archived and the archive action records the most recent 
values for First Notify, Last Notify, and Last Change. A notification cannot be archived until 
it has been acknowledged. Acknowledgement does not change a notification’s state 
unless the notification attribute ClearOnAcknowledge is set to True for a specific 
notification.


Table 18  States of NOTIFICATION-Router_R1_Down


Time User/system 
actions


Notification 
state


Time of first 
notify


Time of last 
notify


Time of last 
change


Count


2:00 Notify 1:00 1:00 2:00 1


2:15 Clear 1:00 1:00 2:15 1


2:25 Notify 1:00 2:25 2:25 2


2:35 Clear 1:00 2:25 2:35 2


3:00 Acknowledge 1:00 2:25 3:00 2


3:05 Archived 1:00 2:25 3:00 2


3:55 Notify 3:55 3:55 3:55 1
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At 3:55, the Availability Manager generated a Down event again and the Global Manager 
created the notification again. After a notification is archived, the Global Manager treats a 
recurrence of that notification as though it were a first occurrence. The value of notification 
attributes start all over again: new First Notify time, Count starts at 1, and so on.


Acknowledging and archiving notifications
Regardless of its state, a notification can be marked as Acknowledged. An operator can 
acknowledge a notification through the Global Console. When an operator acknowledges 
a notification, the operator becomes the owner of the notification. Acknowledging a 
notification does not change its state. If an inactive acknowledged notification is 
re-notified, the value of the Acknowledged attribute is set to FALSE and the value of the 
Owner attribute is cleared.


By default, the Global Manager automatically acknowledges cleared (inactive) and 
unowned notifications after 5 minutes. When Global Manager acknowledges a cleared 
notification, the owner is set to SYSTEM. You can configure this interval through the 
AutoAcknowledgementInterval. 


Using a notification list, you can filter acknowledged notifications so that they do not 
appear in an operator’s display.


After a notification has been acknowledged and is cleared (inactive), it is eligible to be 
archived. An archived notification is removed from the Global Manager’s repository and 
written to an archive file. The notification archive file is named <global_manager>.archive 
and located in the BASEDIR/smarts/local/logs directory.


When a notification is archived, the Global Manager treats a recurrence of that notification 
as though it were the first occurrence. The value of notification attributes start over again: 
new First Notify time, Count starts at 1, and so on.


The Global Manager archives only notifications that are both inactive and acknowledged. 
You can configure the acknowledgement and archival of notifications through the 
AutoAcknowledgementInterval and InactiveAutoArchiveInterval settings.


Configuration of acknowledgment and archiving of notifications


The following parameters, defined using the Global Administration Console, control how 
and when the Global Manager acknowledges or archives notifications. “Defining Domain 
Manager parameters” on page 66 describes these parameters.


Any changes made to the parameters of the ics-default.xml file require that you click the 
Reconfigure button to make those changes take effect. “Reconfiguring the server” on 
page 106 provides detailed information.
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AutoAcknowledgementInterval
AutoAcknowledgementInterval controls when a cleared (inactive) notification is 
automatically marked as acknowledged by the Global Manager. The interval is calculated 
from the time when a notification clears. If a notification recurs, or is unacknowledged, the 
notification is rescheduled for automatic acknowledgement. The default value is 300 
seconds (5 minutes). When this interval is set to 0, the Global Manager will not 
automatically acknowledge cleared notifications. 


InactiveAutoArchiveInterval
InactiveAutoArchiveInterval controls when a cleared (inactive) and acknowledged 
notification is archived by the Global Manager. The interval is calculated from either the 
time the notification is cleared or the time a notification is acknowledged (whichever is 
later). If a notification recurs, or is unacknowledged, the notification is rescheduled for 
archival. The default value is 14400 seconds (4 hours). When this interval is set to 0, the 
Global Manager will not automatically archive cleared and acknowledged notifications.


Retain local objects with an associated notification instance
If attributes such as, elementname and elementclassname are found empty for 
notifications in the Notification Log Console, it is likely that corresponding local objects 
were deleted during topology synchronization with underlying domain managers but 
notifications were not cleared.


To avoid local objects that have an associated notification instance from being deleted, 
set the following property in the local/conf/runcmd_env.sh file:


SM_KEEP_LOCAL_OBJECTS=true


By default, it is set to FALSE.


Notification types and incrementing OccurrenceCount
The ICIM defines two types of notifications: momentary and durable. A momentary 
notification has no duration, it describes an event that happened at a specific time. An 
authentication failure is an example of a momentary event. A durable notification 
describes an event that is active over a period of time. While the event is active, the 
problem it causes is still in effect. An example of a durable event is a link failure. You can 
determine a notification’s type by checking the value of the EventType notification 
attribute.


A notification’s type determines how the value of the OccurrenceCount attribute is 
increased by a Global Manager. In addition, the source of the notification and the 
conditions under which a notification is sent, also determine how a notification’s count is 
increased.


For example, consider the scenario where notification N_1 is active in a Global Manager 
and there are two different sources (S1 and S2) for the notification:


◆ For durable notifications, the OccurrenceCount represents how many times the 
notification has become active (notified) during the notification’s life cycle. The count 
is incremented when the notification reoccurs after it was cleared and renotified.


Using the example above, when S1 notifies, the Global Manager increments the 
OccurrenceCount to 1. If S2 then notifies, the OccurrenceCount remains 1.
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◆ For momentary notifications, the OccurrenceCount represents how many times the 
Global Manager has received a notify message regarding the notification. The current 
state of the notification has no effect.


Using the example above, when S1 notifies, the Global Manager increments the 
OccurrenceCount to 1. If S2 then notifies, the OccurrenceCount increments to 2.


The Global Manager would increment the OccurrenceCount on a re-notify by 1, 
regardless of whether the notification was active. In fact, if notification N_1 occurred 
50 times in the underlying domain, the Global Manager would increase the value of 
the OccurrenceCount by 50.


If the Event Type is durable or the value for the SM_OCCURANCECOUNT flag is set to FALSE 
in the runcmd_env.sh file while the event type is momentary, the server always ignores 
any re-occurrences of an active notification that has occurred during the disconnected 
period. If the Event Type is momentary and the value for the SM_OCCURANCECOUNT flag is 
set to TRUE in the runcmd_env.sh file, the server will update the re-occurrences of an 
active notification that has occurred during the disconnected period.


User-defined notification attributes
Notification objects created by the Global Manager include twenty user-definable 
attributes. By default, these attributes have no value.


To populate the attributes with values, you may create an ASL program and specify it in the 
HookScript field of a DomainType subsection. “Defining Domain Manager parameters” on 
page 66 describes the HookScript field.


A sample ASL program, dxa-sample-hook.asl, is included in the 
BASEDIR/smarts/rules/ics directory. This ASL program receives a handle to the 
notification object. You need to provide any additional functionality. Your ASL script 
should query the Global Manager, Adapter Platform, or underlying domain for additional 
information.


For example, you can populate one of the columns with the number of affected customers 
(instances of the ServiceSubscriber class) by counting the number of impacted 
subscribers.


“Notification list parameters” on page 53 describes the method to give the column names 
in the Global Console more meaningful names. 
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User-defined notification attributes from Adapter Platform or Global Manager


When a Global Manager receives notifications from Adapter Platform or another Global 
Manager, these notifications include 20 user-definable notification attributes. The values 
for these user-defined notification attributes should be populated in the underlying 
Adapter Platform or Global Manager.


The user-defined attributes, and their values, are automatically passed to a Global 
Manager when the default data exchange file is specified in the corresponding Domain 
Type, for example:


◆ dxa-oi.conf for notifications received from Adapter Platform


◆ dxa-sam.conf for notifications received from Global Manager


“Defining Domain Manager parameters” on page 66 describes how to configure a Global 
Manager to receive events and topology from underlying domains.
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CHAPTER 7
Managing Topology with the Global Manager


This chapter contains the following information:


◆ Topology synchronization......................................................................................  118
◆ Topology Timeout..................................................................................................  123
◆ Ensuring a consistent representation of topology ..................................................  123
◆ Organizing topology with groups ...........................................................................  126
◆ Purging of HierarchicalGroupManager instance .....................................................  135
◆ Custom icons for map nodes .................................................................................  136


The EMC Smarts Business Impact Manager User Guide describes how to augment the 
topology with business and service-related elements.
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Topology synchronization
A Global Manager imports topology information from the underlying domains specified for 
all enabled domains. To maintain an up-to-date representation topology, the Global 
Manager synchronizes its topology with an underlying domain when any one of the 
following occurs:


◆ The underlying domain is reconnected after a connection loss or a restart.


◆ The Global Manager is started.


◆ The underlying domain performs a full or incremental discovery, rediscovers an object, 
or a manual discovery is initiated.


◆ A change is made to the configuration of the underlying domains. When the Global 
Manager is reconfigured, it automatically synchronizes its topology with the updated 
underlying domains.


Topology synchronization consists of the following two parts:


◆ Import of raw topology data from remote domains – This involves retrieving of raw 
data from the domain and creating topology elements and relationships. If topology 
and relationships already exist, no action is taken.


◆ Post processing – This involves reconciliation of the SAM topology. SAM maintains an 
internal data structure to keep track of topology elements imported from underlying 
domains which allows SAM to identify and purge topology objects and relationships 
which no longer exists in the underlying domains.


Starting topology synchronization


To manually start topology synchronization, invoke the following dmctl command from the 
BASEDIR/smarts/bin directory:


▼dmctl -s SAMServername invoke GA_Driver::<domain-name>_Topo-Driver 
start▲


▼ ▲ The command must be typed as one line.
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Limitation of topology synchronization


The following are the limitations of SAM topology synchronization:


◆ Redundant syncs


◆ Costly operation


Redundant syncs 


Topology synchronization is triggered whenever there is a change in topology of an 
underlying domain. But SAM may import only a subset of the topology from the underlying 
domain based on dxa configuration. As a result, topology synchronization may be 
triggered even though the imported topology has not changed in the underlying domain. 
Such topology synchronizations are not useful as no change is propagated to SAM and can 
be avoided by disabling autosync mode. Instead topology synchronizations can be 
triggered manually at regular intervals. One of the easiest ways to identify redundant 
syncs is to find out number of instances added or deleted during topology 
synchronizations. If it is zero, then it is likely that redundant syncs are triggered between 
SAM and underlying domain.


Costly Operation


Topology synchronization is a costly operation on SAM server and it is recommended to 
configure topology synchronization judiciously. Performance of SAM topology 
synchronization is dependent on the factors mentioned in Table 19 on page 119.


Table 19  Performance factors of SAM topology synchronization


Performance factor Dependency of SAM topology synchronization


Size of topology Time taken to import topology is directly proportional to size of 
topology.


Frequency of sync More frequent syncs increase load on SAM server.


Resources(CPU/memory) Concurrent topology synchronization works better on a multi 
core machine.


Network latency Topology import slows down due to network latency.
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Memory growth due to Topology Synchronization


When reconciliation of SAM topology and import of topology from other underlying 
domains are in progress at the same time, a growth in memory is observed. 


During topology synchronisation in SAM, a separate thread is created for synchronization 
of each domain. Whenever topology changes in the underlying domains, topology 
synchronization is triggered by SAM to keep local SAM topology in synchronization with 
the topology in the underlying domains. The underlying domain updates the 
lastProbeFinishedAt attribute of ICF_TopologyManager whenever there is a change in 
topology. SAM subscribes to the attribute and when the attribute is updated after a 
topology change (like discovery in AM), SAM triggers topology synchronization with 
underlying domain. Each time topology synchronization is triggered, classes mentioned in 
dxa configuration are imported from underlying domains and SAM topology is reconciled. 
In other words, topology synchronization is always full and not incremental in nature.


Topology Synchronization can be run in the following three modes:


◆ Concurrent Synchronization – This is the default mode.


◆ Serial Synchronization – This can be enabled by setting 
SM_ENABLE_SERIAL_SYNCS=TRUE in runcmd_env.sh


◆ Fixed Interval – This disables topology synchronization and invokes drivers at regular 
interval. 


Enable or disable topology autosync


There are two methods by which you can disable auto synching of the topology:


◆ “Enable or disable topology autosync using the Console” on page 120


◆ “Enable or disable topology autosync using the configuration file” on page 121


Enable or disable topology autosync using the Console
To enable or disable topology autosync using the Global Manager Administration Console:


1. Open the Global Manager Administration Console.


2. From the Manager List, select the SAM Manager.


3. Expand ICS Configuration.


4. Expand IC Domain Configuration.


5. Expand Domains.


6. Click the appropriate domain.
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7. The Configure Domain interface appears, as illustrated in Figure 10 on page 121.


Figure 10  Global Manager Administration Console - Disable autosync


8. Select or clear the Automatic Topo-Sync Enabled check box based on whether you 
want to enable or disable autosync of the topology.


Automatic synchronization of topology is enabled by default.


9. Click Apply > Reconfigure.


Enable or disable topology autosync using the configuration file


Autosync of topology is enabled by default.


To disable topology autosync using the configuration file:


1. Add the following command at the end of the dxa file used for the domain:


topoUpdate ICF_TopologyManager::ICF-TopologyManager::fakeAttr
The sm_edit utility that is available in the bin directory, can be used to edit the 
dxa file.


2. Reconfigure or restart the server.
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Enable topology synchronizations at regular intervals


To enable topology synchronizations at regular intervals add the following command to a 
cron script:


dmctl -b <broker-name> -s <server-name> invoke 
GA_DaemonDriver::<Underlying-Domain-Name>_Topo-Driver start


Get a list of topology drivers


To get a list of topology drivers, execute the following command:


dmctl -b <broker-name> -s <server-name> getInstances 
GA_DaemonDriver


The advantages and disadvantages of running topology synchronization in each mode are 


mentioned in Table 20 on page 122.


If there are overlapping topologies between two or more underlying domains and top level 
SAM is configured such that it is synchronizing with underlying domains concurrently, 
then it is recommended to either run the server in serial mode or start topology drivers at 
regular intervals. The rule of thumb is to use the serial mode if there is more than 50% 
overlapping topology when synchronizations are triggered concurrently. When topology 
synchronization is set to operate in serial mode(non-default option), both import and post 
processing operations are considered as one atomic operation, and multiple topology 
synchronizations with underlying domains are executed serially. 


Only one topology synchronization thread is executed at any point. This reduces the load 
on the server. The downside is a delay in completion of topology synchronization 
operation if multiple synchronizations are triggered at the same time.


Table 20  Advantages and disadvantages of each mode


Mode Advantages Disadvantages


Concurrent 
Synchronization


• Topology is updated with 
little or no delay.


• Post processing is refined 
which improves the 
performance of server.


• Heavy load on server as 
topology synchronizations are 
triggered at higher frequency.


• Memory growth might happen if 
overlapping topologies are 
synchronized at the same time.


Serial 
Synchronization


• Server Load is less on server 
as only one sync will be 
active at any point.


• No issues related to 
memory growth.


• Topology may get updated with 
delay. Time delay is 
unpredictable as depends on 
how many domains are 
synchronizing at the same time.


• Post processing gets invoked at 
the end of topology 
synchronization which might 
degrade the performance in 
large topology.


Fixed Interval • Topology synchronization 
can be scheduled based on 
server load pattern.


• Time delay in topology 
update is predictable.


• Topology is updated with delay.
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Topology Timeout
The timeout (default timeoutTopoValue) parameter defines the default timeout to be 
applied to the front end and back end to which this driver is connected. If multiple drivers 
are connected, the maximum value across all of them defines the default. The timeout is 
always in seconds. A value of 0, requests no timeout. The value cannot be negative. If 
multiple drivers connect to the same front end or back end, a value of 0 requesting no 
timeout can be replaced by a non-zero value. If you want to force there to be no timeout, 
set the timeout to some very large value. For instance, you may leave the timeout value at 
the default value of 600 seconds. When the topodriver calls the remote server, it waits for 
600 seconds to receive a response from the server. During topology synchronization if for 
some reason the underlying source domain stops responding to SAM, after a wait of 600 
seconds, SAM will time-out and resume topology synchronization after the next topology 
discovery cycle.


The TimeOutTopo <n> parameter is present in the dxa configuration file of the 
corresponding domain (for example, dxa-sam.conf for SAM domains). The timeout value 
can be modified in the corresponding underlying domain dxa configuration file. 


Ensuring a consistent representation of topology
A Global Manager imports topology information. Because the topology information comes 
from disparate sources, it is important that the Global Manager present a correct and 
consistent representation of the topology. This is especially true when two or more 
domains manage the same devices.


Newer versions of EMC Smarts applications include an expanded and updated list of 
certified devices. This may mean that a device classified as Uncertified or Node by an 
older version of the EMC Smarts software is classified as a Router or Switch by a newer 
version of the software. For best results, upgrade existing EMC Smarts applications to the 
most recent version. If that is not possible, use the same version of the software for all the 
underlying applications.


Two issues can arise when the Global Manager receives inconsistent topology 
information:


◆ The Global Manager imports information about two or more devices with the same 
name but the devices are classified differently in their respective underlying domains.


◆ The Global Manager imports the same device from two or more underlying domains 
but the device is named differently in each underlying domain.


The Global Manager does not import instances of the Unsupported and Undiscovered 
classes. However, the topology of a Global Manager may include instances, such as Hosts, 
with a value of Undiscovered for their Certification attribute.
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Same device classified differently in separate underlying domains


The Global Manager can receive conflicting topology information when two underlying 
domains discover the same device but classify it differently. The scenarios where this may 
occur are as follows:


◆ A device has the same name, but is an instance of different classes in two or more 
underlying domains. In addition, the device is classified as Host, Uncertified, or Node 
in one or more of the underlying domains. When this occurs, the Global Manager 
replaces an instance of a less specific class, Host, Uncertified or Node, with an 
instance of a more specific class. Incoming event information for the device is 
consolidated to the instance in the Global Manager’s topology. 


For example, device1.mydomain.com is classified as Uncertified in one underlying 
domain and classified as a Router in a second underlying domain. The Global Manager 
classifies the device as a Router in its topology. All incoming notifications related to 
device1.mydomain.com are associated with the Router instance in the Global 
Manager’s topology. 


◆ A device has the same name, but is an instance of different classes in two or more 
underlying domains. In this case, the device is not classified as Host, Uncertified, or 
Node in any underlying domain. The Global Manager classifies the device according to 
the first topology information it receives from an underlying domain. Relationship 
information for the device is updated during consecutive topology synchronizations. 
Incoming event information for the device is consolidated to the instance in the 
Global Manager’s topology.


For example, device2.mydomain.com is classified as a Probe in one underlying 
domain and a Router in a second underlying domain. If the first underlying domain 
synchronizes first with the Global Manager, the Global Manager classifies the device 
as a Probe in its topology. However, any relationship information for the router from 
the second underlying domain is preserved by the Global Manager and added to the 
Probe instance. All incoming notifications related to device2.mydomain.com are 
associated with the Probe instance in the Global Manager’s topology.


If there is only one domain, the Global Manager will change the classification of an object 
when the domain changes it. For example, if IP Availability Manager discovers a device as 
a Probe, the Global Manager will create a Probe. If IP Availability Manager rediscovers the 
same device as a Switch, then Global Manager will delete the Probe and re-create the 
instance as a Switch.
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Same device named differently in separate underlying domains


The Global Manager creates its topology based on the names of the devices it imports 
from the underlying domains. When the Global Manager imports the same device from 
two or more underlying domains with the same name, it creates a single corresponding 
device in its own topology. The Global Manager associates any incoming events from the 
underlying domains that are related to this device with the single device in its own 
topology.


When the Global Manager imports the same device from two or more underlying domains 
and each domain gives the device a different name, the Global Manager creates unique 
elements in its topology for each device.


For example:


◆ One underlying domain discovers a device and gives it the name device3. 


◆ Another underlying domain discovers the same device but gives it the name 
device3.mydomain.com. 


When the Global Manager receives topology information from these underlying domains, 
it creates two instances in its topology — one named device3 and one named 
device3.smarts.com.


Same device with different DisplayName
When two or more underlying domains manage the same instance and the value of 
DisplayName is different in each underlying domain, the value of DisplayName in the 
Global Manager changes each time it synchronizes with the other underlying domain. The 
same issue applies to notification display names when an alarm is generated on the 
instance by one of the underlying domains. 


To fix the display name to a single value, specify the keyword update in the underlying 
domains from which the value of DisplayName should be taken in the 
smarts/conf/ics/ics-default.xml file, as shown in the following example:


<domainconfig>
        <domaintype
            name="MPLS"
            description="Type for MPLS"
            dxaConfFile="dxa-mpls-vpn-conn.conf"
            MinimumCertainty="0.24"


 update=”True”
            SmoothingInterval="65">
            <hook enable="False">ics/dxa-sample-hook.asl</hook>
            <domainname>INCHARGE-MPLS</domainname>
</domaintype>
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Organizing topology with groups
Grouping provides a method by which you can organize topology elements. With Service 
Assurance Manager, you can create groups and organize topology elements to more 
efficiently manage large numbers of elements. 


Before you start, it might be useful to devise a strategy to organize topology elements into 
groups. Common strategies include organizing by the following:


◆ Business units


◆ Geographical regions


◆ Resources


General properties of groups


A group is a user-defined collection of instances from the Global Manager’s topology. A 
group consists of members or child groups. A member is a topological element such as a 
switch. A child group (or subgroup) is another group, which may be a collection of 
members or additional subgroups. A group that contains child groups is referred to as the 
parent group.


Parent and child groups are organized into a tree structure. At the root of each tree is a 
top-level group. Each top-level group is a distinct organization of groups and 
members—its configuration or removal does not effect other top-level groups.


In the Map Console, top-level groups are displayed directly beneath the icon for the Global 
Manager:


◆ A member is also a member of the groups above it within the same group hierarchy.


◆ Within a single group hierarchy, an element cannot be a member of more than one 
group. An element can belong to two or more groups that descend from different 
top-level groups.


◆ You cannot create a circular group where a group is specified as a subgroup of itself or 
one of its subgroups.


Before we explain how to create groups, you may find it helpful to understand how groups 
are displayed in the Map Console. 


How groups are displayed in the Map Console
The Map Console only displays the members of a group when that group does not contain 
any child groups. If a group contains one or more child groups as well as members, only 
the child groups are displayed.


When you create groups to display them in the console maps, create a catch-all group 
within a parent group. The catch-all group should contain all the members that do not 
belong to any of the other subgroups. This technique prevents a parent group from 
containing both members and child groups.
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Types of groups
The Global Manager supports two types of groups: selective groups and hierarchical 
groups:


◆ A selective group is a group whose members are determined by a matching pattern 
that you specify through the Global Console. 


◆ A hierarchical group is specified in a data file which is then imported by the Global 
Manager.


In addition to the methods by which they are created, there exist several other differences 
between selective and hierarchical groups.


Properties of selective groups


Selective groups contain three properties that distinguish them from hierarchical groups: 
matching criteria, priority, and target classes. These properties help to determine what 
elements become members of a selective group.


Matching criteria
Matching criteria are attributes defined in the ICIM model that you use to determine what 
elements are eligible to become a member of a group. When you create a selective group, 
you specify a matching pattern that is compared against the attributes of the element. If 
the pattern matches the value of the specified attribute, the element becomes a member 
of the group. A matching pattern comprises one or more characters and wildcards. If you 
do not specify a matching pattern, all managed elements that pass the target class filter 
match the group. Priority will determine if any elements become members. 


Table 21 on page 127 lists attributes against which you can apply a matching pattern. The 
group’s target class determines which attributes are available to match against. For 
example, if the target class is IPNetwork, attributes that describe a managed system, such 
as Certification, are not listed.


Table 21  Attributes for matching criteria (page 1 of 2)


Attribute Description


Certification Level of certification assigned to this device during discovery. 
Values include: UNCERTIFIED, GENERIC, TEMPLATE, CERTIFIED, 
or VALIDATED.


CreationClassName Name of the class of which the managed element is an 
instance. This is used as the ClassDisplayName attribute in 
notifications affecting this element.


Description A brief description of the element.


DisplayClassName Same as creation class name.


DisplayName Name of the managed element. For systems, DisplayName and 
Name are usually the same.

Organizing topology with groups 127







Managing Topology with the Global Manager

“Wildcard Patterns” on page 219 describes wildcards for matching patterns.


Priority
Priority distinguishes between groups at the same level of the hierarchy with the same 
parent. Each such group is automatically assigned a different priority. When a topology 
element matches the pattern of two different groups, it becomes a member of the group 
with the higher priority. Because of this, you should assign a higher priority to a group with 
a stricter matching pattern. If a group has a high priority and it matches all the topology 
elements, it will contain all the available members.


Target classes
A target class acts like a filter, allowing only those elements that are instances of the target 
class, or one of its subclasses, to become members of the group. Managed elements must 
pass the target class filter before they are compared against the matching criteria.


When you create a child group, the child group should have the same target class as its 
parent. The exception to this rule is when the new target class is a subclass of the parent 
group’s target class. For example, the ICIM_ManagedSystemElement class is near the top 
of the ICIM hierarchy. All of the other target classes are a subclass of 
ICIM_ManagedSystemElement. If ICIM_ManagedSystemElement is the target class of a 
parent group, you can select a different target class for a child group.


Similarly, VLAN, NetworkConnection, and IPNetwork are subclasses of ICIM_LogicalLink. If 
ICIM_LogicalLink is the target class of the parent, you can choose one of these three 
classes as the target class for a child group. 


IsManaged Determines if the system is managed by the underlying 
domain. 
Value is TRUE or FALSE.


Notice: Unmanaged elements do not appear in the Global 
Manager topology.


Location A brief textual description of the system’s physical location.


Model Vendor’s name for the system.


Name Name of the managed element. For systems, Name and 
DisplayName are usually the same.


PrimaryOwnerContact Information on how to contact the system’s owner.


PrimaryOwnerName Name of the system’s owner.


ServiceName Name of external system used to import attributes and events.


SystemName Name of the system that contains this managed element.


Type Classifies the type of system. Possible values include: Bridge, 
Host, Hub, Node, Other, Probe, Router, RSFC, RSM, Switch, and 
TerminalServer.


Vendor Name of the system’s manufacturer.


Table 21  Attributes for matching criteria (page 2 of 2)


Attribute Description
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Table 22 on page 129 lists the target classes you can assign to a selective group when you 
create it. Classes are listed in the order that they appear in the ICIM class hierarchy. The 
description indicates when a class is a subclass of another target class.


Creating selective groups


You create and edit selective groups by using the Global Console. Creating or editing 
groups through the console requires administrator privileges from the Global Manager. 
Operators with monitoring privileges can view groups in the Topology Browser and Map 
Console, but are not able to create or edit groups.


You should be aware of the following points when creating selective groups:


◆ Top-level selective groups cannot contain members, only child groups. As such, you 
need to create both a top-level group and one or more child groups to assign topology 
elements to a group.


◆ By default, each top-level group contains all the topology elements that match its 
target class and matching criteria.


◆ Each group is identified by a unique name. The name is displayed in group maps and 
in the Topology Browser. It is the value of the DisplayName attribute for the group 
instance.


◆ Hierarchical groups are visible in the Group Definition window, but they cannot be 
edited.


Table 22  Target classes for selective groups


Target class Description


ICIM_ManagedElement Base class for the ICIM system element hierarchy. This is the 
broadest target class.


UnitaryComputerSystem Represents a single computer system. This is the superclass 
for the Bridge, Host, Hub, Probe, MSFC, Router, RSFC, RSM, 
Switch, TerminalServer, and Node classes.


ApplicationService Represents service provided by software. Examples include 
email, web server, and database applications. 


LogicalLink Represents a link between two endpoints. Examples 
include database transactions, IP networks, and cables.


VLAN Virtual LAN typical in switched networks. VLAN is a subclass 
of LogicalLink.


NetworkConnection A connection between two routers, typically a virtual circuit. 
NetworkConnection is a subclass of LogicalLink.


IPNetwork Subnet of an IP network. IPNetwork is a subclass of 
LogicalLink.


ServiceSubscriber Customer who receives services provided through a service 
offering.


ServiceOffering A service provided to customers.
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Layout of the Group Definition window
You create and edit groups through the Group Definition window. You open this window by 
selecting Groups from the Configure menu of the Global Console.


The Group Definition window is divided into two panels. The left panel displays the Global 
Manager, groups, and the group members. When you choose a selective group in the left 
panel, the Properties, Priorities, and Matching Criteria tabs display in the right panel of the 
Group Definition window. 


When you select a top-level group, only the Properties tab is displayed. Top-level selective 
groups do not have priority or matching criteria.


Priority and matching criteria determine which topology elements are members of each 
group. If you have worked with configuration groups (Polling Groups and Threshold 
Groups) for EMC Smarts applications, the priority and matching criteria for topology 
groups function similarly.


“Properties of selective groups” on page 127 describe priority and matching criteria.


The toolbar of the Group Definition window contains four buttons:


◆ Delete removes the specified group from the topology of the Global Manager. If the 
deleted group contains child groups, the child groups are also deleted.


The Delete command does not remove hierarchical groups.


◆ Regroup tells the Global Manager to rebuild the selective groups from the selected 
group down to the bottom of the group hierarchy. If you select the Global Manager 
icon and invoke Regroup, the Global Manager rebuilds all of the selective groups. 
This, however, is not usually necessary. It is more efficient to regroup a section of the 
group hierarchy when there are large number of topology elements in each group.


You need to invoke Regroup after you make changes to the priority or matching criteria 
of a group. The Global Manager automatically regroups the topology when it 
synchronizes its topology with the underlying domains.


The Regroup command does not affect hierarchical groups.


◆ Create Top Level Group displays the New Group dialog box where you specify the 
name, description, and target class for the group. This command is only available 
when the Global Manager is selected.


◆ Create New Group displays the New Group dialog box where you specify the name, 
description, and target class for a child group. This command is available when a 
group is selected in the group tree hierarchy in the left panel of the Group Definition 
window.


You can also find these commands under the Group menu. In addition, the Group menu 
also contains the Save Groups command. When you invoke Save Groups, the Global 
Manager saves its in-memory database to the repository file.
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Method for creating selective groups
To create a selective group: 


1. Select Groups from the Configure menu of the Global Console. The Group Definition 
window appears.


This requires administrator privileges. The Configure menu is not displayed for users 
with monitoring privileges.


2. To create a top-level group, select the Global Manager icon and click the Create Top 
Level Group toolbar button.


To create a child group, select the parent group and click the Create New Group toolbar 
button. The New Group dialog box appears.


3. Specify a name, description, and target class for the group. After you finish specifying 
values for these three fields, click OK.


The new group displays in the Group Definition window. You can also see the group as 
an instance of the SelectiveGroup class in the Topology Browser Console or as a group 
in the Groups tab of the Map Console.


4. Change the priority of the new group. If there are other groups at the same level of the 
group hierarchy, they are listed under the Priorities tab. By default, a new group is 
assigned the lowest priority.


To change a group’s priority, select the group whose priority you want to change. 
Under the Priorities tab, click the up arrow to give the group a higher priority or click 
the down arrow to give the group a lower priority. 


5. Click the Matching Criteria tab and specify a matching pattern for the group. By 
default, a new group does not contain matching criteria, meaning it matches all 
possible elements.


For example, if you want to create a group that includes systems from a certain 
geographical area, then you might match against the value of the Type and Location 
attributes. 


For example:


• Specify a pattern that matches the type of systems you want to group. 


To create a group of routers you would add Type as a matching criteria attribute and 
specify a matching pattern of Router. 


• Specify a pattern that matches against the geographical locale specified in the 
system’s Location attribute. 


To match against routers in New York, you could add Location as a matching criteria 
attribute and specify a pattern of “*NY*|*New York*”. This pattern would match 
against “NY” and “New York” anywhere in the Location attribute. Table 21 on 
page 127 lists the classes whose values you can match against.
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6. Select the parent for the newly created group, or the Global Manager, and click the 
Regroup toolbar button.


To create a catch-all group, create a group with no matching criteria and assign it the 
lowest priority.


Editing the properties of a selective group
You can edit the description, target class, priority, and matching criteria of a selective 
group. Similar to creating a group, you must attach to Global Manager with administrative 
privileges and select Groups from the Configure menu.


You can edit all the properties of a group before applying the changes. However, if you 
select another group before clicking Apply, your changes are not applied. In this case, the 
console displays a dialog box asking if you want to abandon the changes that have not 
been applied. 


To edit the properties of a selective group:


1. Select the group whose properties you want to edit. 


The properties of the group appear in the right panel of the Group Definition window.


The description and target class of the group appear under the Properties tab.


2. Do one of the following:


• To change the target class, select a class from the pop-up menu.


• To change the description, edit the text in the Description text box.


3. Select the Priority tab to change the priority of the group. 


4. Select the Matching Criteria tab to change the matching pattern of the group.


5. Click Apply. If you change the target class, priority, or matching criteria, you also need 
to click Regroup.
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Creating hierarchical groups


This section describes how to create hierarchical groups, including the syntax of the group 
datafile and how to load the group information into the Global Manager.


To create hierarchical groups:


1. Create one or more hierarchical group datafiles that specify the groups and their 
members. You can also add new groups and their members to existing hierarchical 
group datafiles, including the two example group datafiles 
(topology-group.data.template and service.data.template) that are provided with the 
system. To use one of the example group datafiles, make a copy of the example file 
and rename it appropriately. These data files must be located in the 
BASEDIR/smarts/local/conf/ics directory. “Syntax of hierarchical group datafiles” on 
page 133 describes the syntax of the group data files.


2. If necessary, edit the Business Templates options in the Global Manager 
Administration Console to add or delete the names of hierarchical group datafiles.


3. If hierarchical group files are added or deleted, reconfigure the Global Manager. 
“Reconfiguring the server” on page 106 describes how to reconfigure the Global 
Manager.


4. Import the group definitions by regrouping the group datafiles. “Regrouping 
hierarchical group data” on page 135 describes how to regroup the datafiles.


The Global Manager processes the group and service topology data specified in the 
BusinessSection. If the Global Manager does not encounter any errors, it does the 
following: 


◆ Adds any new group and service information to its topology


◆ Deletes any group and service information that is in the current topology but which 
has been deleted in the new hierarchical group datafiles being imported


Both reconfiguring and regrouping update the service topology used by Business Impact 
Manager. 


After the hierarchical group data is loaded into the Global Manager, you can view 
hierarchical groups through the Global Console.


Syntax of hierarchical group datafiles
The syntax for group datafiles provide a means for specifying groups, children 
(subgroups), and members. The following example illustrates the syntax of a hierarchical 
group datafile:


HierarchicalGroup NewYork children NY-Routers "NY Customers"
HierarchicalGroup NewYork children Queens Nassau HierarchicalGroup 


NewYork children Bronx 
HierarchicalGroup NewYork members Router::nyc1


HierarchicalGroup NY-Routers members Router::nyc1
HierarchicalGroup "NY Customers" members 


file:/opt/dev/incharge-sa/smarts/local/conf/ics/ny-customers.member
s
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This example illustrates the following syntactic rules of hierarchical group datafiles:


◆ Each line that specifies a hierarchical group must start with the keyword 
HierarchicalGroup.


◆ Elements of a hierarchical group must be separated by one or more spaces.


◆ The name of the group follows the keyword HierarchicalGroup. The name of the group 
must be unique for all existing groups. If the same group name is used in multiple 
lines, each line is referring to the same instance. In the example above, all four lines 
starting with “HierarchicalGroup NewYork” are defining either children or members of 
the NewYork group.


◆ If the name of a group contains a space, it must be enclosed in double quotes.


◆ The keyword children indicates that this line specifies subgroups of the named group. 
For example, NY-Routers and “NY Customers” are child groups, or subgroups, of the 
group named NewYork.


◆ The keyword members indicates that this line specifies members of the named group. 
For example, the router nyc1 is a member of the group named NY-Routers. You must 
specify the class name and the instance name of the topology element, separating 
them with a double colon (::).


◆ You cannot specify child groups and members in the same line. You can, however, use 
multiple lines to specify members or children for the same group.


◆ You can specify a list of members in a member file. For example, the file 
ny-customers.members lists members of the “NY Customers” group. However, you 
must specify the full path to the file, by using the correct syntax for the host operating 
system.


The following example shows the syntax of a file that lists the members of a group. 
Because the hierarchical group datafile specifies the name of the group, you only need to 
specify the <class>::<instance> pairs, one per line, for each member, for example:


Router::nycbrd1
Router::nycbrd3
Switch::nycs2


Reconfiguring the Global Manager
“Reconfiguring the server” on page 106 provides additional information on reconfiguring 
the Global Manager.
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Regrouping hierarchical group data
To regroup the hierarchical group and service topology datafiles, invoke the following 
command from the BASEDIR/smarts/bin directory:


▼dmctl -s <global_manager> invoke GA_DaemonDriver::
   ICS-Group-Driver start ▲


▼▲ The command must be typed as one line.


Depending on your security configuration, you might be prompted for your EMC Smarts 
username and password.


When the Global Manager regroups the topology information in the datafiles, it first 
checks for errors. If the Global Manager encounters an error, it writes output to the 
terminal or its log file and does not process the datafiles.


Purging of HierarchicalGroupManager instance
The HierarchicalGroupManager instance maintains relationships with HierarchicalGroups 
and SelectiveGroups. SelectiveGroups are created using SAM console and 
HierarchicalGroups are created from configuration files. Once HierarchicalGroupManager 
instance is purged, the group instances are not visible since the relationship information 
is lost even though group instances are present in the repository.


To recreate SelectiveGroups, run the following command:


./sm_adapter -s INCHARGE-linux ics/ics-restore-selectivegroup.asl


In case of HierarchicalGroup instances, perform the following steps to recreate them:


1. In the Global Manager Administration Console, expand INCHARGE-SA > ICS 
Configuration and click Business Templates.


2. Click Modify List on the Configure “Business Templates” screen.


3. On the Edit Business Template dialog-box, select a template from Selected Template 
Files and remove it.


4. From Available Template Files, add the template you just removed.


5. Click OK on the Edit Business Template dialog-box.


6. Click Apply on the Configure “Business Templates” screen.


7. Start the group driver by running the following command:


    dmctl -s INCHARGE-SA invoke GA_DaemonDriver::ICS-Group-Driver start
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Custom icons for map nodes
An administrator with appropriate privileges can add or remove a custom icon to a class of 
elements or to individual elements. A custom icon can be used to customize maps for your 
organization and to meet the needs of your operators.


The Global Console includes a default set of icons for all ICIM elements. Icons can be 
associated with classes or instances. 


If an icon is not associated specifically with a class, the icon for the parent class is used; 
this is the derived icon. In addition, the icon for a given class could be associated multiple 
levels up in the class hierarchy. 


The set of icons shipped with the console does not include one icon for each class. The 
derived icon (from the parent class) is used for those classes that do not have a specific 
icon assigned to them.


You can use two methods to assign icons to class or instances:


◆ Use the Edit Map Icons operation in either the Global Manager Administration Console 
or the Map Console.


◆ Use the sm_config utility to specify the name of the map icon specification file. 
Appendix C, “XML Reference,” describes how to assign map icons using sm_config.


Map icon text defaults to Helvetica 12 point. You can customize the map icon text. 
“Adjusting Java properties” in the EMC Smarts Service Assurance Manager Operator Guide 
provides detailed information.


Assigning icons to classes or instances


Before assigning images to map nodes, you must create the images and save them to the 
proper directory on the host where the Global Manager is running. Note that the icons 
included in the console are not loaded over the network.


The requirements for custom images are:


◆ Images must be in GIF format.


◆ Images must be 56 pixels square.


After you obtain the custom images, copy them to the 
BASEDIR/smarts/local/images/icons directory. Images located in this directory are 
automatically displayed in the icon configuration dialog box. The filename of the image, 
minus any file extension, is used to identify the image.


If an image file located on the Global Manager has the same name as an icon included 
with the console, the image located on the Global Manager takes precedence. 
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Assigning an icon to a class


To assign an icon to a class:


1. Select Configure > Edit Map Icons operation in the Global Manager Administration 
Console. 


The Select Icons for: <Global Manager> dialog box appears.


2. Select the class in the Classes list box.


The Classes list box displays the classes of managed elements. By default, all classes 
are assigned an icon. However, it might be an icon associated with a parent class. 
Certain classes are assigned the same icon as their parent class. For example, the 
Redundancy Group icon is used for the System Redundancy Group, Network 
Connection Redundancy Group, and Network Adapter Redundancy Group. You can 
determine what icon is used for the System Redundancy Group by selecting this class 
in the Classes list and seeing what is displayed as the derived icon. The name of the 
class to which the derived icon is assigned is also displayed.


3. Click Use the specific icon. 


4. Scroll through the list at the bottom of the dialog box to choose an icon.


5. Click Apply.


6. When you are finished, click OK.


Assigning an icon to an instance


You can assign an icon to an instance without changing the class icon. 


To assign an icon to an instance:


1. Select Configure > Edit Map Icons operation in the Global Manager Administration 
Console. 


The Select Icons for: <Global Manager> dialog box appears.


2. Select the appropriate class in the Classes list box.


3. Select Select Instances. 


The Instances list box displays the instances of the selected class in the topology. 


4. Select the instance in the Instances list box. 


5. Click Use the specific icon.


6. Scroll through the list at the bottom of the dialog box to choose an icon.


7. Click Apply.


8. When you are finished, click OK.
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Reassigning the derived icon to a class


To reassign the derived icon to a class:


1. Select Configure > Edit Map Icons operation in the Global Manager Administration 
Console. 


The Select Icons for: <Global Manager> dialog box appears.


2. Select the class in the Classes list.


3. Click Use the derived icon. 


4. Click Apply.


5. When you are finished, click OK.


Reassigning the derived icon to an instance


To reassign the derived icon to an instance:


1. Select Configure > Edit Map Icons operation in the Global Manager Administration 
Console. 


The Select Icons for: <Global Manager> dialog box appears.


2. Select the class in the Classes list.


3. Click the Select Instances checkbox and then select the instance.


4. Click Use the derived icon. 


5. Click Apply.


6. When you are finished, click OK.
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Types of program tools 
A tool is a script that is typically invoked in response to a notification. Such a response 
might be to ping an affected device or to open a trouble ticket. Tools can also be invoked 
on topology elements. Service Assurance supports three types of tools:


◆ Server tools


◆ Client tools


◆ Automated tools


Server and client tools are associated with a user profile and invoked by an operator using 
the Global Console. Two tool submenus, Server Tools and Client Tools, appear in a pop-up 
menu when an operator right-clicks a notification or a device. Access to server and client 
tools can be controlled by associating or not associating tools to user profiles:


◆ The Server Tools menu in the Global Console displays a list of available server tools. 
Server tools are invoked by the Global Manager and available to any console user. For 
the tools to be available for a user, the user’s profile must include the tools. “Security 
considerations for tools” on page 142 provides additional information.


◆ Client Tools are invoked on the host where the Global Console is running, which 
requires that the tool scripts are installed on the host where the console is running. 
The Client Tools menu displays a list of available client tools, provided the user’s 
profile includes the tool.


Client tools can also be invoked from the web console. The EMC Smarts Service 
Assurance Manager Dashboard Configuration Guide describes how to configure client 
tools for the web console and the Business Dashboard.


◆ An automated tool is a type of server tool that is invoked by an escalation policy or an 
adapter. Automated tools are not visible to users of the Global Console. 


Additional Service Assurance tools


In addition, Service Assurance provides the following tools that are described in separate 
documents. They include:


◆ Business Process Tools. The EMC Smarts Business Impact Manager User Guide 
provides additional information.


◆ Report Manager tools. The EMC Smarts Report Manager User Guide provides 
additional information.


◆ Remedy tools. The EMC Smarts Adapter for Remedy ARS User Guide provides 
additional information.


◆ Concord eHealth tools. The EMC Smarts Adapter for Concord eHealth User Guide 
provides additional information.
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How tools are invoked
This section describes how to invoke tools and where the output of server and client tools 
appears. 


Invoking server and client tools


Server and client tools are invoked through the Global Console. Such tools are always 
invoked on a particular target object by the console operator. The target object can be a 
notification or a topology element such as a router. When an operator right-clicks the 
target, the pop-up menu lists the available tools. The EMC Smarts Service Assurance 
Manager Operator Guide describes how to invoke tools from the Global Console.


Viewing the output of a server or client tool
Server and client tools, depending on their purpose, might produce output. For example, 
the output of a ping tool indicates whether the ping completed successfully.


For client and server tools, you can configure whether a tool displays any output. When a 
server tool is configured to display output, the output is echoed to stdout and collected by 
the Global Manager. The Global Manager sends the output back to the console where the 
tool was invoked. 


The output of server and client tools is displayed in the Tool Output window. The Tool 
Output window opens when the tool is invoked. Output is written to the window while the 
tool is running. If a tool produces an error, the error message is also displayed in the Tool 
Output window. If an error occurs for a server tool that is not configured to display output, 
the Tool Output window displays the return code of the tool.


If the SAM server is started by attaching the server to a broker address that is different 
from the one specified during SAM installation, then the SM_BROKER variable for the 
non-default broker must be specified in the local/conf/runcmd_env.sh file. If the 
SM_BROKER variable for the non-default broker is not specified, the server tool will not 
work as expected.


The Tool Output dialog box includes a Stop button. Client tools, such as shell scripts that 
do not respond to a SIGTERM signal will not stop when an operator clicks Stop. Create a 
client tool script that responds to a SIGTERM signal or manually stop the process from the 
command line or from the Task Manager.
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Invoking automated tools


An automated tool is run when it is triggered based on the settings of an escalation policy. 
An escalation policy is configured to invoke automatic tools to run on notifications that 
meet the escalation criteria for specified periods of time. Chapter 9, “Escalation 
Configuration for the Global Manager,” includes additional information on configuring the 
Global Manager.


Alternatively, an automated tool runs with the automatic action adapter on the same host 
as the Global Manager. Start this adapter by invoking the sm_adapter command and 
supplying a list of arguments. After starting the automatic action adapter, no further 
intervention is required. The adapter uses a notification list to listen for particular 
notifications. When it receives a matching notification, it automatically responds by 
invoking the specified tools through the Global Manager. 


Once started, the automatic action adapter runs in the background and responds to 
notifications that match its notification list. For example, the automatic action adapter, 
configured with a trouble-ticket system tool, could respond to a notification by opening a 
trouble ticket. “Modifying a tool” on page 154 includes additional information about 
creating an automated tool.


Information recorded to a notification’s audit log


When a server or automated tool is invoked on a notification, information about the tool is 
recorded to the notification’s audit log. This information includes:


◆ Date and time when the tool was invoked.


◆ Name of user that invoked the tool.


◆ Whether the tool completed successfully.


◆ Name of the tool. 


Security considerations for tools
If a tool invokes an EMC Smarts utility, such as dmctl, or otherwise initiates a connection 
to the Global Manager, you must configure security to enable that connection. An 
essential piece of information is knowing the username under which the tool is invoked, 
for example: 


◆ Client tools are invoked under the username of the operator who started the Global 
Console.


◆ Server tools are invoked under the username that the Global Manager is running 
under. Remember, server tools are invoked on the same host as the Global Manager.


◆ Automated tools are invoked under the username that started the sm_adapter 
command or by the name of the Global Manager.


If a client tool needs to connect to the Global Manager and perform an action that requires 
administrative privileges, you have two choices:


◆ Provide the operator with administrative privileges.


◆ Create a server tool that performs the action.
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As the server tools run under the username that invoked the Global Manager process, this 
user must have an authentication record in the clientConnect.conf and serverConnect.conf 
files on the host where the tool is to be executed. You must configure the authentication 
records for this account so that prompting is not required. Prompting should not be used 
for automated tools.


Sample tool scripts
EMC Smarts provides a number of sample tool scripts that, with minor modifications, work 
on most systems. The main purpose of these scripts, however, is to provide examples that 
you can examine when developing your own tools. 


The ping and Telnet tools are sample scripts. You need to customize them to meet the 
needs of your environment. For example, the sample scripts do not take firewalls into 
account.


Table 23 on page 143 lists the sample server and automated tools, the display name for 
the tool as seen by users in the Global Console, and provides a brief description. Server 
and automated tools are located in the BASEDIR/smarts/actions/server directory.


To modify one of the sample tool scripts, open it with the sm_edit utility to create a local 
copy of the script.


Table 23  Sample server tool scripts (page 1 of 2)


Server tool script Display name for tool Description


ics-closetkt Sample - Close 
Trouble Ticket


This tool inserts a static value into the field of a 
notification. The context and Status Criteria 
specify that this tool is only active for 
notifications with the text OPEN in the 
TroubleTicketID field.


ics-opentkt Sample - Open 
Trouble Ticket


This tool inserts a static value into the field of a 
notification. The context and Status Criteria 
specify that this tool is only active for 
notifications without the text OPEN in the 
TroubleTicketID field.


ics-ping-interface Sample - 
Ping-Interface


This tool pings an IP interface. The Context 
Criteria specify that this tool is active for 
notifications with a value of “Interface” for the 
ClassName attribute.


ics-ping-IP  Sample - Ping-IP This tool pings an IP interface. The Context 
Criteria specify that this tool is active for 
notifications with a value of “IP” for the 
ClassName attribute.
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ics-ping-all Sample - Ping-all This tool pings all the IP interfaces associated 
with a device. The Context Criteria specify that 
this tool is active when the target is a 
UnitaryComputerSystem. As such, valid targets 
include both notifications and instances.
When invoked, this tool retrieves all of the IP 
addresses associated with the target instance 
from one or more underlying domains. Two 
variables that control the behavior of the tool:
• PING_ALL_DOMAINS controls whether the tool 


retrieves IP addresses from each underlying 
domain that manages the instance. When set 
to 0, the default, the tool retrieves IP 
addresses from a single domain. When set to 
1, the tool retrieves IP addresses from all 
domains.


• PING_ONCE controls whether the tool pings 
each retrieved IP address or whether it stops 
after the first successful ping. When set to 0, 
the tool stops after the first successful ping. 
When set to 1, the default, the tool pings all 
available IP addresses.


ics-ping-device Sample - Ping-device This tool pings the IP address of the SNMP agent 
for the affected element. The Context Criteria 
specify that this tool is active when the target is a 
UnitaryComputerSystem. As such, valid targets 
include both notifications and instances.
When invoked, this tool retrieves the IP address 
of the SNMP agent associated with the target 
instance from one or more underlying domains.
The tools script includes one variable that 
controls the behavior of the tool:
• PING_ALL_DOMAINS controls whether the tool 


retrieves IP addresses from each underlying 
domain that manages the instance. When set 
to 0, the default, the tool retrieves IP 
addresses from a single domain. When set to 
1, the tool retrieves IP addresses from all 
domains.


ics-telnet Sample - Telnet This tool opens a Telnet session with the affected 
device. The .sh version of this script pings an IP 
address of the affected device before attempting 
to connect. If the ping fails, the script pings 
another IP address on the device, and so on until 
a ping succeeds or all the pings fail. When a ping 
succeeds, the script connects to the IP address 
where the ping succeeded.
If this tool is invoked from a console that is 
running over X Windows, the script opens a 
separate window on the user’s display to invoke 
the Telnet session.


Table 23  Sample server tool scripts (page 2 of 2)


Server tool script Display name for tool Description
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Table 24 on page 145 lists the sample client tools and provides a brief description of 
each. Client tools are located in the BASEDIR/smarts/actions/client directory.


Remember that tool scripts are system-specific. On Windows systems, a tool is typically 
invoked by the Windows command interpreter (cmd.exe). You can also write a tool script in 
a language such as Perl, which runs on different platforms with little or no modification.


Creating tools
This section provides the information necessary to create and configure a tool script.


Follow these steps to develop and use a tool script:


1. Determine the action to be performed by the tool and write the script.


2. Save the script to the proper location.


3. Test the tool script to ensure that it executes properly.


4. Assign the proper read and execute permissions to the tool script.


5. Configure the tool to invoke the script. In addition, client and server tools must be 
associated with the appropriate user profile. For automated tools, you must create an 
adapter or escalation policy to invoke the tool.


You can configure tools by using one of the following tools:


◆ Global Manager Administration Console, as described in this section.


◆ The sm_config utility, “Importing and Exporting Configurations” on page 189 provides 
additional information.


Table 24  Sample client tools scripts


Client tool Description


SmGetEnv This tool parses the environment variables passed by the Global 
Manager to the tool script. It also prints all environment 
variables to the Tool Output window. A version of this tool script 
is also provided in Perl.


SmLaunchPerlScript This tool launches the SmGetEnv.pl tool script to illustrate how 
you can launch Perl scripts from a tool. 
You must edit this script to specify the location where Service 
Assurance is installed.


browser This tool opens a web browser. You must edit this script to 
specify the location where your browser is installed.


ciscoworks This tool opens a web browser that loads the administration 
page for CiscoWorks. You must edit this script to specify the 
location of your browser and the host where CiscoWorks is 
running.


pinger This tool pings the name of the specified element.


Reporting This action accesses reports available through the Service 
Assurance Report Manager. It opens a web browser with the URL 
set to the location of the Crystal Enterprise EportFolio 
application. You must edit this script to specify both the web 
browser and the URL.
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How data is passed to a tool script


When a tool is invoked, the attributes of the tool target are automatically passed to the 
tool script. The attributes are passed to the tool script as environment variables in the 
form:


SM_OBJ_<NAME>=<value>


The <NAME> parameter identifies the attribute and the <value> parameter contains the 
attribute’s value. For example, the ClassName attribute would be passed in the 
environment variable:


SM_OBJ_CLASSNAME=Router


Your tool script must parse these environment variables and extract the information 
required by the program invoked by the tool script. For example, if you want a tool that 
telnets to a device, you need to extract the environment variable that contains the name or 
IP address of the device, as shown in the example code (in Windows CMD script):


rem if SM_OBJ_Name isn't set in environment report an error
if not defined SM_OBJ_Name (
   echo Invalid SM_OBJ_NAME
   exit 0 
)


rem Use the value of SM_OBJ_Name to connect to the device
start /wait cmd /c "telnet %SM_OBJ_Name% "


The tool target can either be a notification or an instance. For both types of targets, a tool 
script receives the attributes listed in Table 25 on page 146 as environment variables.


Table 26 on page 146 lists the attributes that are passed to the tool script when the target 
is an instance.


Table 25  Attributes passed to all tool scripts


Environment variable Description


SM_REMOTE_USER Specifies the EMC Smarts username of the 
person that invoked the tool.


SM_SERVER_NAME Specifies the name of the Global Manager that 
executes the tool script.


Table 26  Attributes for element targets


Element target attributes Description


SM_OBJ_CLASS_NAME Class name of the system. For example, Router.


SM_OBJ_INSTANCE_NAME Name of the system.


SM_OBJ_DOMAIN_NAME Name of the Global Manager.
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Table 27 on page 147 lists the attributes that are passed to the tool script when the target 
is a notification.


Table 27  Attributes for notification targets (page 1 of 2)


Notification target attributes Description


SM_OBJ_Acknowledged Specifies whether the notification is 
acknowledged. TRUE if the notification has been 
acknowledged, FALSE if not.


SM_OBJ_Active Specifies whether the notification is active. TRUE 
if the notification is active, FALSE if not.


SM_OBJ_Category Type of notification sent by the Global Manager. 
Possible values include:
• BackplaneUtilization
• Error
• Performance
• PowerSupply
• Resource
• SystemConnectivity
• Temperature
• VLANConnectivity


SM_OBJ_Certainty Confidence that this notification is the correct 
diagnosis. Value ranges from 0 to 100.


SM_OBJ_ClassDisplayName Name of the ClassName that is displayed to the 
user.


SM_OBJ_ClassName Name of the class where the event occurred. 
Might not be the same as 
SM_OBJ_ClassDisplayName.


SM_OBJ_ElementClassName Class name of the managed element most closely 
related to this event.


SM_OBJ_ElementName Name of the managed element most closely 
related to this event.


SM_OBJ_EventDisplayName Name of the EventName that is displayed to the 
user.


SM_OBJ_EventName Name of the event. Might not be the same as 
SM_OBJ_EventDisplayName.


SM_OBJ_EventText A description of the notification.


SM_OBJ_EventType MOMENTARY when the notification has no 
duration. DURABLE if the notification has a period 
for which it is active, such as a link failure.


SM_EventState State of the event. Possible values include:
• ACTIVE
• WAS_ACTIVE
• SUSPENDED
• INACTIVE
The UNITIALIZED state is not relevant here.


SM_OBJ_FirstNotifiedAt Time, in seconds, when the notification first 
became active.
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SM_OBJ_Impact Numeric value that indicates the effect of this 
event on related elements.


SM_OBJ_InMaintenance TRUE if the device is in maintenance mode, FALSE 
if not.


SM_OBJ_InstanceDisplayName Name of the InstanceName that is displayed to 
the user.


SM_OBJ_InstanceName Name of the instance where the event occurred. 
Might not be the same as 
SM_OBJ_InstanceDisplayName.


SM_OBJ_IsProblem TRUE if (and only if) at least one of the types is 
“PROBLEM”, and none of the types are anything 
other
than “PROBLEM” or “UNKNOWN”.


SM_OBJ_IsRoot TRUE if the notification is a root cause, FALSE if 
not.


SM_OBJ_LastChangedAt Time, in seconds, when the status of the 
notification last changed.


SM_OBJ_LastClearedAt Time, in seconds, when the notification was last 
cleared.


SM_OBJ_LastNotifiedAt Time, in seconds, when the notification was last 
notified.


SM_OBJ_Name InternalEventHandle for the notification.


SM_OBJ_OccurrenceCount Number of times the notification has occurred.


SM_OBJ_Owner Name of the person responsible for this 
notification. Value is SYSTEM when 
acknowledged by the Global Manager.


SM_OBJ_Severity Level of severity for this notification.
1 = CRITICAL
2 = MAJOR
3 = MINOR
4 = UNKNOWN
5 = NORMAL


SM_OBJ_SourceDomainName Name of the underlying domain that sent this 
notification. If more than one domain is listed, 
the names are separated by commas.


SM_OBJ_SourceEventType Indicates the type of event from an underlying 
source or sources. Value can be: PROBLEM, 
EVENT, AGGREGATE, or UNKNOWN. The default 
value is UNKNOWN.


SM_OBJ_TroubleTicketID Trouble-ticket number associated with this 
notification.


SM_OBJ_UserDefined1-20 Twenty user-defined fields.You can populate 
these fields with data with an ASL hook script.


Table 27  Attributes for notification targets (page 2 of 2)


Notification target attributes Description
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Table 28 on page 149 lists additional attributes that are passed to the tool script when the 
tool is invoked through an escalation policy. 


In addition to the attributes listed above, a server tool script receives the DISPLAY 
environment variable. The value of this variable is used to determine the location of the 
user’s X Window System display. “Running tools over X Windows” on page 156 includes 
detailed information for invoking server tools through an X Windows System.


Where to save tool scripts


After you write a script, you need to save it to the proper location and ensure that it is 
executable. A server tool, which includes automated tools, must be located in the 
BASEDIR/smarts/local/actions/server directory on the host where the Global Manager is 
running. The Global Manager must be able to execute the script.


A client script must be located on the host where the Global Console is installed. The 
proper location is the BASEDIR/smarts/local/actions/client directory. The console user 
must be able to execute the script. Server and client tools are configured in the Global 
Manager Administration Console. 


Configuring with the Global Manager Administration Console


New tools, or modifications to existing tools, are not available to console users until they 
restart the Global Console.


To configure a tool by using the Global Manager Administration Console:


1. Select the type of tool you need to configure from the Edit menu or click the 
appropriate toolbar button. This displays one of the following wizards:


• Automated Tool Creation Wizard


• Client Tool Creation Wizard


• Server Tool Creation Wizard


2. Type a name for the tool. This name is displayed in the Global Manager Administration 
Console, and, for server and client tools, in the Global Console.


3. Do one of the following:


• Click Create New.


• Click Copy Existing. 


When you copy an existing tool, the configuration parameters for the tool are the 
same as the copied tool. 


4. Click Next. 


Table 28  Attributes for escalation targets


Element target attributes Description


SM_POBJ_POLICY Name of the policy that executed the 
tool.


SM_POBJ_PATH Name of the path that executed the tool.


SM_POBJ_LEVEL   Name of the level that executed the tool.
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5. Define the following tool parameters:


• Program to run


• Time-out Interval


• Trace


• Display (client and server tools only)


• User Profiles (client and server tools only)


“Tool parameters” on page 150 describes these parameters.


6. Click Next. 


7. Use the Filter Builder to specify the Context Criteria for a server or client tool and click 
Next. 


“Using the Filter Builder” on page 182, includes detailed information on the Filter 
Builder. “Context and Status Criteria for client and server tools” on page 151 includes 
additional information on Context and Status Criteria. 


8. Use the Filter Builder to specify the Status Criteria for a server or client and click Next 
to advance to the confirmation screen. 


9. Click Finish to create the tool. You will receive an error message or a success message 
based on the result.


Tool parameters
Table 29 on page 150 describes the configuration parameters for tools. Only a subset of 
these parameters are available for automated tools.


Table 29  Server tool configuration parameters


Parameter Description


Name Name of the tool that is displayed in the console. 


Program Specifies the name of the program that is invoked when the tool runs. 
Type the program name or select a program from the pop-up menu:
• For client tools, this is a list of tools in the 


BASEDIR/smarts/actions/client and 
BASEDIR/smarts/local/actions/client directories on the host where 
the Global Manager Administration Console is running.


• For server or automatic tools, this is a list of tools in the 
BASEDIR/smarts/actions/server and 
BASEDIR/smarts/local/actions/server directories. This parameter 
cannot contain path separators. This is a list box of existing server or 
client scripts.


The name cannot contain path separators.


Timeout Interval Specifies the number of seconds to wait for a tool script to complete. If 
the tool script does not complete within the specified time, the tool 
process is terminated. The default is 30 seconds.


Trace Specifies whether trace output, used for debugging, should appear in the 
tool output window when a tool is run. 
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Configuration of server tools prompts
Server tools include the capability of prompting for input when a user invokes the tool. 
The input provided by the user is passed to the server tool when it runs.


Administrators, using the Server Tool Wizard in the Global Manager Administration 
Console, can specify the parameters that are displayed to the user in the prompt. Each 
parameter includes three fields:


◆ Name, which is required, is the internal name of the parameter


◆ Text, which is the description displayed to the user


◆ Width, which specifies the visible size of the input field in characters


Parameters are passed from the Global Console to the script, by way of the Global 
Manager, as environment variables in the form SM_POBJ_<name>, where <name> is the 
internal name of the parameter.


Context and Status Criteria for client and server tools


Context Criteria and Status Criteria determine whether a tool is applicable to the selected 
target. If an operator selects an instance, then the target is an instance. If an operator 
selects a notification, the target can be either the notification or the instance where the 
notification occurred, as identified by the ElementClass and ElementInstance attributes.


Context Criteria determine whether a tool is displayed in the menu when a target is 
selected. The console checks the Context Criteria when the notification is received and 
does not re-check until the notification is archived and re-notified. Hence, you must apply 
context checking to attributes whose values do not change:


◆ Category


◆ ClassDisplayName


◆ ClassName


◆ ElementClassName


◆ ElementName


Display Output Specifies whether a tool script should display output to the console. If 
this parameter is set to true, the console opens the Tool Output window 
immediately after invoking the tool. If false, the Tool Output window 
opens only if the tool returns an error. If this parameter is omitted, it 
defaults to true. This parameter is not applicable to automated tools.


User Profiles Specifies the user profiles that include this tool. This parameter is not 
applicable to automated tools. 


Context Determines whether a tool displays in the console’s pop-up menu when 
the user right-clicks on a tool target. A tool always displays when this 
parameter is omitted. This parameter is not applicable to automated 
tools.


Status Determines whether a tool is enabled or disabled in the console’s 
pop-up menu. A tool is always enabled when this parameter is omitted. 
This parameter is not applicable to automated tools.


Table 29  Server tool configuration parameters (continued)


Parameter Description
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◆ EventDisplayName


◆ EventName


◆ EventType


◆ InstanceDisplayName


◆ InstanceName


Although you can apply context checking to other attributes, the results are based on the 
initial value of the attribute.


Status Criteria determines whether a tool is active. The name of a disabled tool is dimmed 
in the menu and cannot be invoked. You should apply Status Criteria to attributes whose 
value might change, including:


◆ Acknowledged


◆ Active


◆ Certainty


◆ ClearOnAcknowledge


◆ EventState


◆ EventText


◆ Impact


◆ InMaintenance


◆ IsProblem


◆ IsRoot


◆ OccurrenceCount


◆ Owner


◆ Priority


◆ Severity


◆ SourceDomainName


◆ SourceEventType


◆ TroubleTicketID
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The tool target determines what attributes are passed to the tool to be matched against 
the Context Criteria. For example:


◆ When the target is an element, you can match against the attributes specified in 
Table 26 on page 146. 


◆ When the target is a notification, the matching criteria determine which attributes are 
passed to the Context Criteria. 


Results differ depending on the matching criteria:


◆ If the matching criteria specify a notification attribute, then the attributes of a 
notification, from Table 27 on page 147, are passed. 


◆ If the matching criteria specify an element, then the attributes of an element are 
passed.


Creating Context and Status Criteria
Chapter 10, “Working with Filters,” provides information on specifying Context and Status 
Criteria by using the Filter Builder. You can use an expression filter or an ASL filter to 
specify context and Status Criteria. Unlike the filters you can create for notification lists, 
you can use either an expression filter or an ASL filter, but not both.


The following example illustrates creating Context Criteria using Filter Builder:


1. Select a class from the Context object list box. The filter expression is matched against 
one or more attributes of the selected class.


For example, select the UnitaryComputerSystem class.


2. Add an attribute to the filter sheet to specify a wildcard expression against an 
attribute of UnitaryComputerSystem. This enables you to narrow the range of 
notifications for which the tool is displayed.


If you do not add an attribute, the Context Criteria matches all instances of 
UnitaryComputerSystem or its subclasses.


3. Click Next. The filter sheet for Status Criteria appears.


4. Select a class from the Status object list box. The filter expression is matched against 
one or more attributes of the selected class.


For example, to match Routers, select the Router class.


5. Add an attribute to the filter sheet to specify a wildcard expression against an 
attribute of the Router class.


If do not add an attribute, the Status Criteria matches all instances of the Router class.


6. For example, select the Vendor attribute and type a value of CISCO. The Status and 
Context Criteria for this tool specify that it displays in the Server Tools menu for any 
system element or any notification for which the failing element is a system. If that 
system is a router with a value of CISCO for its Vendor attribute, the tool is active and 
can be invoked.


7. Do the following:


• Click Next to view the confirmation screen.


• Click Finish to create the tool configuration.
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Modifying a tool


To modify an existing server, client, or automated tool:


1. Select the tool in the tree of the Global Manager Administration Console. 


The Configure Tool panel appears. 


2. Modify the appropriate parameters.


3. Click Apply to synchronize the changes in the Global Manager. 


Disabling a tool 
You can disable server, client, and automated tools. This allows you to prevent the tool 
from being used. Disabled tools are not displayed in the Global Console and do not 
execute when launched through an escalation policy or through sm_adapter. 


To disable a tool:


1. Select the appropriate client, server, or automated tool in the Global Manager 
Administration Console. 


2. On the configuration panel, clear the Enable checkbox. 


The name of disabled tool displays in gray in the navigation tree. 


3. Click Apply.


Changing the order in which tools are displayed
You can determine the order in which tools are displayed in the Server Tools and Client 
Tools menus of the Global Console. 


To change the display order:


1. In the Global Manager Administration Console, select Automatic, Client, or Server 
under Tools in the tree. 


The Prioritize Tools panel appears. 


2. Use the up and down arrows to move a tool up or down in the menu list.


3. Click Apply. The changes become effective immediately.
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Running automated tools with sm_adapter
The configuration options for an automated tool are specified as arguments to the 
sm_adapter program when you invoke it at the command line. Table 30 on page 155 lists 
the arguments you should specify when invoking an automated tool. 


The following example shows the arguments for the automatic action adapter that invokes 
the “Open Trouble Ticket” script when a notification becomes active (is notified) and 
invokes the “Close Trouble Ticket” tool when the notification becomes inactive (clears):


▼ BASEDIR/smarts/bin/sm_adapter--server=INCHARGE-SA \
 --subscribe=TicketingNL/n  \


-DNotifyAction="Open Trouble Ticket"  \
-DClearAction="Close Trouble Ticket"  \
-DLogActions=TRUE  \
--output  \
../rules/ics/auto-action.asl ▲


▼▲ The command must be typed as one line.


Table 30  Arguments to sm_adapter for automated action


Argument Default value Description


--server= INCHARGE-SA The name of the Global Manager from which the 
adapter receives its notification list and 
notifications.


--subscribe= N/A Name of the notification list received from the 
Global Manager. 


-DNotifyAction= N/A Name of the tool as specified in the Global 
Manager Administration Console. This is the tool 
to invoke when a notification is active. This 
argument is optional.


-DClearAction= N/A Name of the tool as specified in the Global 
Manager Administration Console. This is the tool 
to invoke when the notification clears. This 
argument is optional.   


-DLogActions= FALSE Specifies whether the adapter should log each 
action to stdout. This argument is optional.


--output N/A Redirects the output from the adapter to a log file 
in BASEDIR/smarts/local/logs. The 
--DLogActions argument must be true to enable 
output.


rules/ics/auto-action.asl N/A Script required to perform the automated action.
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Running tools over X Windows
If necessary, you can configure a server tool to invoke an X Windows application. The 
console user that invokes such an action must run an X server in order to display the X 
window. When the Global Console attaches to the Global Manager, it passes the user’s 
display information to the Global Manager. 


The Global Console determines a user’s display by using the following rules:


◆ If the environment variable SM_DISPLAY is set, its value is passed to the Global 
Manager.


◆ If the environment variable DISPLAY is set, its value is passed to the Global Manager.


◆ The value is set to <host>:0.0 where <host> is the name of the user’s system.


Because X Windows applications are typically long running, take special care when writing 
the tool script to avoid unwanted interactions with the tool timeout. You should write the 
tool script so that the X Window application runs in the background. This allows the tool 
script to exit and the Global Manager to stop the timeout. If the tool’s script runs in the 
foreground, the Global Manager terminates the process when the timeout expires.


The sm_xcmd utility is provided by EMC Smarts for executing an X Windows application in 
the background. The utility performs a basic connectivity test of the user's X Windows 
display. The ics-telnet.sh server tool is an example of a tool script that uses sm_xcmd to 
run an application over X Windows.


Adding domain configurations
Domains are configured using the graphical interface accessed from the Global Manager 
Administration Console. The domain configuration information is saved to repository files. 
The repository files include information for the following predefined domains:


◆ INCHARGE-AM


◆ INCHARGE-PM


◆ INCHARGE-AM-PM


◆ INCHARGE-AM2


◆ INCHARGE-OI


◆ NCM


◆ INCHARGE-DISCMGR


◆ INCHARGE-MPLS-ANALYSIS


◆ INCHARGE-MPLS-MONITORING


◆ INCHARGE-MPLS-TOPOLOGY


Only the INCHARGE-AM domain is enabled. You must enable other domains or create new 
ones as necessary.
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If your domain configurations are not predefined in the Service Assurance Manager server, 
you can use the following tools to add new configurations to the Service Assurance 
Manager server:


◆ Import XML Domain Configurations


◆ Import XML Configurations


Chapter 5, “Configuring Domains,”provides additional information on the ics-default.xml 
file.


Importing XML Domain Configurations


To add new configurations using the XML domain configuration tool:


1. Open the Topology Browser Console.


2. Right-click the instance of the local InChargeDomain representing the Service 
Assurance Manager server.


3. Select Server Tools > Import XML Domain Configuration.


The Import XML Domain Configuration dialog box appears, as illustrated in Figure 11 
on page 157.


Figure 11  Import XML Domain Configuration dialog box


4. Type a domain type descriptor in the Domain Type Descriptor field.


Table 31 on page 157 defines domain type descriptors for all available domain 
configuration files.


Table 31  Available domain type descriptors (page 1 of 2)


Domain type 
descriptor Filename Description


acm ics-acm-default.xml Application Connectivity Manager post 
1.0


acm-1.0 ics-acm-1.0-default.xml Application Connectivity Manager 1.0


ai ics-ai-default.xml Application Insight


app-poller ics-app-poller-default.xml Application Poller


asm ics-asm-default.xml Application Services Manager


atm ics-atm-default.xml ATM-Frame Relay Manager


bmc cs-bmc-default.xml --
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5. Click the Apply these values to all selected objects option to have the domain values 
applied to selected objects.


6. Click OK.


The domain configuration is imported in a disabled state. To begin synchronization with 
Service Assurance Manager, enable the domain and click the Launch Server 
Reconfiguration toolbar button located on the Global Manager Administration Console 
toolbar menu.


If the SAM server is started on a non-default broker, importing an XML Domain 
configuration throws an error. This issue can be avoided by updating the value of the 
non-default broker under SM_BROKER_DEFAULT in the runcmd_env.sh file.


ciena ics-ciena-default.xml Ciena TMF14 Adapter


ctm ics-ctm-default.xml Cisco TMF814 Adapter


dfm ics-dfm-default.xml Device Fault Manager


mcast ics-mcast-default.xml Multicast Manager


mpls ics-mpls-default.xml MPLS Manager


mpls1.3 ics-mpls1.3-default.xml MPLS Manager 1.3 and earlier


npm ics-npm-default.xml Network Protocol Manager


oi ics-oi-default.xml Open Integration Server


sam ics-sam-default.xml Hierarchical SAM


sdi ics-sdi-default.xml SQL Data Interface


sia ics-sia-default.xml Storage Insight


sia-group ics-sia-group-default.xml Storage Insight using the new domain 
group mechanism


sim ics-sim-default.xml Security Infrastructure Manager


sonet ics-sonet-default.xml --


vhm ics-vhm-default.xml Voice Health Manager


voip ics-voip-default.xml Voice over IP Manager


wdm ics-wdm-default.xml --


xdatmfrip ics-xdatmfrip-default.xml Cross Domain ATM-FR to IP


xdotmip ics-xdotmip-default.xml Cross Domain OTM to IP


Table 31  Available domain type descriptors (page 2 of 2)


Domain type 
descriptor Filename Description
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Importing XML configurations


To add new configurations using the generic configuration tool:


1. Open the Topology Browser Console.


2. Right-click the instance of the local InChargeDomain representing the Service 
Assurance Manager server.


3. Select Server Tools > Import XML Configuration. The Import XML Configuration dialog 
box appears, as illustrated in Figure 12 on page 159.


Figure 12  Import XML Configuration dialog box


4. Type the name of the XML file you want to load in the Configuration File to Load field.


The XML being added must reside in the SITEMOD/conf/ics directory.


5. Click OK.
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Escalation Configuration for the Global Manager
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Overview of escalation
Escalation provides a method for automatically responding to a notification:


◆ As soon as the notification is received by the Global Manager.


◆ When the notification satisfies certain conditions. 


Automatic escalation can enhance your problem resolution process by:


◆ Dispatching maintenance staff with a description of hardware failures and the specific 
parts they will need.


◆ Restoring service by restarting applications, initiating failover processes, or rerouting 
services around failed components.


◆ Notifying customers of service outages and providing status updates.


◆ Alerting successive layers of management of unresolved problems to ensure that they 
receive the proper level of attention.


Escalation helps prevent important notifications from being overlooked or ignored and 
can immediately start the process of remedying the situation that caused the notification.


For example, you can create an escalation policy that is activated when a specific router 
goes down. When this notification occurs, the Global Manager matches it to the 
appropriate escalation policy and path. The path then begins invoking tools such as 
opening a trouble ticket and paging technicians.


A notification continues to escalate while it matches the filter criteria of the path. As time 
progresses, the notification may escalate to different levels in the path based on the 
duration, and the path may invoke additional tools to respond to the notification. If the 
status of the notification changes in such a way so that it no longer matches the path’s 
filter criteria, the notification no longer escalates to the next path level.


For example, if a Router Down notification matches against the path filter for 15 minutes, 
the notification is escalated to the next level. At this level, the escalation path could 
invoke a tool that sends email to a manager. But, if a technician acknowledges the 
notification after 10 minutes, and this acknowledgement causes the notification to no 
longer match the path filter criteria, the notification does not escalate to the next level.


Escalation policy structure


An escalation policy is a set of related escalation paths. An escalation policy includes a 
policy filter and one or more escalation paths, as shown in Figure 13 on page 163. 
Notifications that match the policy filter are passed to the escalation paths. If a 
notification does not match the policy filter, it is ignored. If a policy filter is not defined, all 
notifications are passed to the escalation paths.


An Escalation Path also includes a filter and up to six escalation levels. A notification must 
match both the policy filter and the path filter to begin at the first escalation level, Level 0.


Each escalation level includes one or more automated tools to invoke and a time duration, 
after which a notification advances to the next level. An escalation level cannot have a 
duration of less than 1 minute. You can, if necessary, create an escalation level that does 
not invoke a tool.
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Figure 13  Escalation policy structure


When a notification matches both the policy and path filters, it starts at escalation level 0. 
When a notification reaches level 0, the tools associated with level 0 are invoked 
immediately. The notification remains at Level 0 for the specified duration, shown as T0 in 
Figure 13 on page 163, before escalating to Level 1. At this point, all Level 1 tools are 
invoked and, after the duration of T1, the notification escalates to Level 2. This process 
repeats through each level defined for the path. If the notification changes during 
escalation and no longer matches the path and policy filters, it leaves the escalation path 
without invoking any additional tools. 


Viewing an escalation policy


You create, configure, and monitor escalation policies with the Global Manager 
Administration Console. Expanding Escalation Policies in the administration tree lists 
escalation policies. Selecting a policy in the administration tree displays the Escalation 
Policy view, as shown in Figure 14 on page 164. 


Policy names in the administration tree are black when any escalation path in the policy is 
enabled. When all paths in a policy are disabled, the policy name is dimmed.


The Configure Escalation Policy view allows you to create, modify, and delete escalation 
policies, paths, and levels. In addition, you can monitor the status of an escalation policy 
by right-clicking on an escalation path and selecting Show Notifications from the menu.


Escalation paths are displayed as horizontal bars. The name on the left of the escalation 
path is the pathname. Within each bar are shaded blocks, each of which represents an 
escalation level within the path. The duration and automated tools are listed within each 
escalation level of the path.


An enabled escalation path is displayed with each level a different color. A disabled path 
is dimmed. All the escalation paths shown in Figure 14 on page 164 are enabled.
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Figure 14  Escalation policy view 


When you hold the cursor over an escalation level, a tooltip window displays:


◆ Level: Indicates the level (0–5) within the path.


◆ Time to level: Indicates the amount of time it takes a notification to reach this level 
within the path.


◆ Duration: Indicates the amount of time a notification spends at this level before 
advancing to the next level. However, Duration does not include the time it takes to 
invoke any tools. When a level is reached, actions are executed first. When all actions 
have finished executing, the notification is scheduled to enter the next level. The 
notification will enter the next level after the amount of time set by Duration.


◆ Tools: Lists the automated tools that are invoked at this level.


At the bottom of the Configure Escalation Policy window are three buttons:


◆ Add Path — Adds a new escalation path to the displayed policy. This is equivalent to 
selecting Escalation > Path > New.


◆ Apply — Saves any changes made to the escalation configuration to the Global 
Manager. If you have unsaved changes, you are prompted to save before leaving the 
view.
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◆ Refresh — Retrieves the configuration of current escalation policy from the Global 
Manager. This is important if another administrator might be modifying the policy that 
you are currently viewing. The Global Manager prevents two administrators from 
overwriting each other’s changes without first viewing the changes. For example, if 
you make changes to an escalation policy and apply them while another administrator 
is also making changes, the other administrator will not be able to apply the changes. 
The Global Administration Manager Console prompts the other administrator to 
refresh their policy view.


Refresh can also be used to cancel changes that have not been applied. 


How notifications are scheduled for escalation
When the Global Manager receives or creates a notification, it compares the notification 
against the filter for each policy and path. If the notification matches a policy and path 
filter, the Global Manager schedules the notification for escalation. When a level is 
reached, actions are executed first. When all actions have finished executing, the 
notification is scheduled to enter the next level. The notification will enter the next level 
after the amount of time set by the duration of the level.


The Last Notify time, or the LastNotifiedAt notification attribute, also determines whether 
a notification enters into an escalation policy. The Last Notify Time must be later than the 
time at which the path was enabled in order for the notification to escalate. 


If a Global Manager is stopped and restarted, the Global Manager restores the state of 
escalated notifications. Notifications which are scheduled to escalate to a new level 
before the Global Manager stops are rescheduled based on the current time when the 
Global Manager is restarted. 


The rescheduled escalation time accounts for the time that the Global Manager was not 
running. A rescheduled notification, however, will never escalate more than one level as a 
result of the time the Global Manager was not running.


Effect of Global Manager restart on escalation


The following examples illustrate the effect of a Global Manager restart on escalating 
notifications.


Example 1
1. A notification enters escalation level 0 at 1 P.M. The duration of the level is 1 hour.


2. At 1:10 P.M. the Global Manager is shut down.


3. At 1:25 P.M. the Global Manager is restarted.


The notification was scheduled to escalate to level 1 at 2 P.M. When the Global Manager 
restarts, this notification is rescheduled to escalate at 2 P.M.
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Example 2
1. A notification enters escalation level 1 at 2 P.M. The duration of level 1 is 10 minutes 


and the duration of level 2 is 10 minutes.


2. The Global Manager is shut down at 2:05 P.M. and restarted 20 minutes later at 2:25 
P.M.


Prior to the Global Manager shutting down at 2:05 P.M., the notification would have 
escalated to level 2 at 2:10 P.M. and was scheduled to escalate to level 3 at 2:20 P.M. (the 
duration of level 2 is 10 minutes). 


Since the notification was in level 1 when the Global Manager was shutdown, it needs to 
be rescheduled for the next level (level 2) when the Global Manager is restarted. 
Therefore, when the Global Manager is restarted, it reschedules the notification to 
escalate to level 2 immediately at 2:25 P.M. Upon entering level 2 and performing actions, 
the notification is scheduled for level 3 at 2:35 P.M. 


Developing escalation policies
The first step in creating an escalation policy is to formalize your response plans to the 
notifications you are likely to encounter. You may need to assign responsibilities and 
determine how quickly your organization is required to respond to various types of system 
and network failures. These plans form the template for your escalation paths and levels. 


You may also need to create automated tools to initiate your response to incoming 
notifications. Chapter 8, “Tool Configuration for the Global Manager,” describes how to 
create and configure automated tools.


The process of creating an escalation policy at the Global Manager Administration Console 
consists of the following steps: 


1. Create an escalation policy by copying an existing policy or creating a new policy.


2. Add one or more escalation paths to the policy. Again, you can copy an existing path 
or create a new path.


3. Add escalation levels, up to six, to each path.


Creating an escalation policy


To create an escalation policy, complete the following steps by using the Global Manager 
Administration Console:


1. Select Escalation > Policy > New. The Create a New Escalation Policy dialog box 
appears.


2. Type the name for the escalation policy.


Create the policy by copying an existing policy or by creating a new policy. When you 
create a new policy, the parameters of the policy, such as filters and paths, must be 
created. When you copy a policy, all the properties of the existing policy are copied to 
the new policy. However, the name of the newly created escalation policy always 
appears dimmed in the administration tree even if the original policy name appears 
bright.
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3. Click Edit Filter to create or modify the filter that is matched against notifications to 
determine whether they qualify for the policy. The Filtering New Policy text dialog box 
appears.


You can specify an expression filter, an ASL filter, or both. When you combine filters, 
by adding filter sheets, a notification must match at least one of the filter sheets to 
pass the filter. Chapter 10, “Working with Filters,” includes additional information 
about the Filtering New Policy dialog box.


4. When you finish creating filters, click OK to close the Filtering New Policy dialog box.


5. Click OK to close the Create a new Escalation policy dialog box. The name of the 
escalation policy appears in the administration tree and at the top of the Configure 
Escalation Policy window.


When using ASL filter under Edit Filter, the escalation policy is created only if the relative 
path to the ASL file is provided as ics/<asl file name>. By default, Global Manager searches 
for the ASL file under local/rules and the policy is not created even though the ASL file 
exists under BAEDIR/rules/ics. Also, the escalation policy is not created if the absolute 
path to the ASL file is specified, which is BAEDIR/rules/ics/<asl file name>.


Creating an escalation path


You can create an unlimited number of paths within a policy, but it is usually easier to 
organize and manage smaller groups of paths in more policies.


To create an escalation path:


1. Select the escalation policy in the administration tree.


The Configure Escalation Policy panel appears.


2. Create an escalation path by adding a new path or copying an existing path.


• To create a new blank path, select Escalation > Path > New or click Add Path at the 
bottom of the Escalation Policy View panel.


The Create a new Escalation Path dialog box appears.


• To copy a path, select the path you wish to copy and select Escalation > Path > Copy. 


The Copy Escalation Path dialog box appears.


You can only copy a path from the current policy.


3. Type the name of the escalation path. If you are copying the path, modify it to suit your 
needs. “Modifying escalation policies and paths” on page 169 provides additional 
information.


4. Click Edit Filter to create or modify the path filter.


The Filtering New Path dialog box appears.
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The filter determines what notifications follow this path of the policy. Similar to the 
policy filter, you can specify an expression filter, an ASL filter, or both. Chapter 10, 
“Working with Filters,” includes information on setting up a filter.


For most escalation paths, you should add a filter that matches active notifications to 
ensure that you only escalate active notifications.


5. When you finish creating filters, click OK to close the Filtering New Path dialog box.


6. Click OK to close the Create a new Escalation Path dialog box.


Your path is displayed in the Configure Escalation Policy panel of the Global Manager 
Administration Console.


7. Repeat this procedure for each escalation path.


The next step is to add one or more levels to each escalation path.


Adding escalation levels


An escalation path requires at least one level. You can add up to six levels to each path.


To add escalation levels:


1. Right-click the path and select Level > Insert or select the path and choose Escalation > 
Level > Insert. The Insert Level dialog box appears.


If the escalation path already contains a level, you can control where the new level is 
inserted:


• To insert a new level at the end of the path, select the box at the end of the path to 
insert the level.


• To insert a level before an existing level, select the level that you want to insert the 
new level in front of to insert the level.


2. Specify the duration of the level by typing a number and selecting the time unit from 
the list box.


3. Select automated tools from the Available Tools list and move them to the Invoked 
Tools list. Tools are invoked immediately after a notification reaches this level. 
Chapter 8, “Tool Configuration for the Global Manager,” includes information on 
creating tools.


4. Click OK to close the Insert Level dialog box. 


The new level appears in the escalation path.


5. Repeat these steps for each level in the escalation path.


6. When the path is complete, click Apply to save the changes to the Global Manager.


7. Repeat this procedure for each escalation path in the escalation policy. 


After you finish an escalation policy, you can enable one or more of its paths.
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Modifying escalation policies and paths
The types of modifications you can make to an escalation path are determined by whether 
the escalation path is enabled or disabled. For example, when:


◆ A path is enabled, you can edit the duration and tools for any escalation level in the 
path. You cannot add or remove escalation levels from the path or change the policy 
or path filters. However, you can change the script when asl script is used as a filter.


◆ A path is disabled, you can edit the escalation path filter and change the duration or 
invoked tools at any escalation level. In addition, you can add or remove escalation 
levels. 


◆ All paths in a policy are disabled, you can edit the escalation policy filter.


Enabling and disabling escalation paths


Escalation policies cannot be enabled or disabled. Instead, you can enable or disable the 
escalation paths within a policy. When all of the escalation paths within a policy are 
disabled, the policy is effectively disabled.


Disabling an escalation path cancels the escalation of all notifications currently scheduled 
within the path. New notifications are not added to a disabled path. To avoid losing any 
notifications currently scheduled on the path, but to prevent new notifications from being 
scheduled, you can retire the path instead of disabling it. “Retiring an escalation path” on 
page 173 includes more information on retiring a path.


Disable an escalation path
To disable an escalation path:


1. Select the escalation policy in the administration tree of the Global Manager 
Administration Console. The Configure Escalation Policy panel appears.


2. Right-click the path and select Path > Disable. You are prompted to confirm this choice.


3. Click Yes to disable the path. The path is dimmed to indicate it is disabled.


4. Click Apply.


When all of the paths for an escalation policy are disabled, the name of the policy in the 
administration tree is dimmed to indicate that the policy has no active paths.


Enable an escalation path
When a path is enabled, the path begins to process any notifications with a Last Notify 
time that is later than when the path was enabled.


To enable an escalation path:


1. Select the policy in the administration tree. 


The Configure Escalation Policy panel appears in the Global Manager Administration 
Console.


2. Right-click the path and select Path > Enable from the menu. 


The path is enabled.


3. Click Apply to save the change to the Global Manager.
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Modifying an enabled escalation path


When you change the tools or duration of a level in an enabled path, the following is true:


◆ Notifications escalated beyond this level are unaffected.


◆ Notifications not yet escalated to this level are subject to the new duration or tools.


◆ Notifications currently at the modified level are rescheduled according to the new 
duration or use the new tools.


The following example illustrates what happens when the duration of a level is increased:


1. A notification enters Level 1 of an escalation path at 1 P.M. The duration of the level is 
20 minutes and the notification is scheduled to escalate to Level 2 
at 1:20 P.M.


2. At 1:10 P.M., the duration of this level is increased to 30 minutes. As a result, the 
notification is rescheduled to escalate to Level 2 at 1:30 P.M.


The following example illustrates what happens when the duration of a level is decreased:


1. A notification enters Level 1 of an escalation path at 1 P.M. The duration of the level is 
30 minutes and the notification is scheduled to escalate to Level 2 
at 1:30 P.M.


2. The notification is scheduled to enter Level 2 at 1:30 P.M. The duration of Level 2 is 5 
minutes and the notification is scheduled to enter Level 3 at 1:35 P.M.


3. At 1:20 P.M., the duration of Level 1 is decreased to 10 minutes. As a result, the 
notification escalates to Level 2 immediately. At Level 2, the notification is scheduled 
to escalate to level 3 at 1:25 P.M. because the duration of Level 2 is 5 minutes. 


A change in duration will not cause a notification to escalate more than one level.


Changing the tools or duration of a level
To change the tools or duration of a level in an enabled escalation path:


1. Select the escalation policy name in the administration tree. The policy appears in the 
Configure Escalation Policy panel of the Global Manager Administration Console.


2. Right-click the level you want to modify and select Level > Edit Properties. The Edit 
Level dialog box appears.


3. Change the Duration or Invoked Tools:


• Type a new value for Duration and select the units from the list box.


• Change the Invoked Tools list: 


– Select a tool in the Invoked Tools list and click  (right arrow) to remove it. 


– Select a tool in the Available Tools list and click  (the left arrow) to move the 
tool to the Invoked Tools list. 


If a tool is not available, you can create the tool by clicking Tool Wizard. Chapter 8, 
“Tool Configuration for the Global Manager,” includes information on creating 
automated tools.
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4. Click OK to close the Edit Level dialog box. The changes to the level appear in the path.


5. Click Apply to send the change to the Global Manager.


Modifying disabled escalation paths or policies


When an escalation path is disabled, you can modify the path filter and add or remove 
levels. If you disable all of the paths in an escalation policy, you can edit the escalation 
policy filter.


Disabling a path cancels the escalation of any notifications along the path. If you want to 
modify a path or policy but do not want to cancel any scheduled notifications, you can 
retire the path or paths instead. This prevents new notifications from joining the path but 
allows scheduled notifications to continue to escalate. “Retiring an escalation path” on 
page 173 includes information on retiring a path.


Modifying an escalation policy filter
To modify the filter of an escalation policy, you must first disable all of the paths within the 
policy:


1. Select the escalation policy in the administration tree of the Global Manager 
Administration Console. The policy appears in the Escalation Policy Configuration 
panel.


2. Select Escalation > Policy > Edit Properties. The Edit selected Policy dialog box 
appears.


3. Click Edit Filter. The Filtering Policy test dialog box appears.


4. Change the filters as needed. 


Chapter 10, “Working with Filters,” contains information on changing a filter.


5. When you finish editing the filters, click OK to close the Filtering Policy test dialog box. 


6. Click OK to close the Edit selected Policy dialog box.


7. Click Apply to send the changes to the Global Manager. You can now enable the paths 
in the policy.


Modifying an escalation path filter
To change a path filter, you must first disable the path:


1. Select the escalation policy in the administration tree of the Global Manager 
Administration Console. The policy appears in the Escalation Policy Configuration 
panel.


2. Right-click the path and select Path > Edit Properties. The Edit selected Path dialog box 
appears.


3. Click Edit Filter. The Filtering Path test dialog box appears.
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4. Change the filters as needed. 


Chapter 10, “Working with Filters,” contains information on changing a filter.


5. When you finish editing the filters, click OK to close the Filtering Path test dialog box.


6. Click OK to close the Edit selected Path dialog box.


7. Click Apply to send the changes to the Global Manager. You can now enable the path.


Inserting escalation levels in a path
To insert escalation levels in a path:


1. For a disabled path, select the level (or Path End box) that will follow the new level. 
The selected level or box changes color to indicate that is selected. 


2. Right-click to display the Path menu.


3. Select Level > Insert. 


The Insert Level dialog box appears.


4. Type the Duration and select the units from the list box.


5. Select any quantity or combination of tools from the Available Tools list. 


If a tool is not available, create the tool by clicking Tool Wizard. Chapter 8, “Tool 
Configuration for the Global Manager,” includes information on creating automated 
tool.


6. Click  ( left arrow) to move the selected tools to the Invoked Tools list.


7. Click OK to close the Insert Level dialog box. The level appears in the path.


8. Repeat steps 1 through 6 to add additional levels up to a total of six levels.


Remember that new levels are always inserted in front of the selected level. 


9. When your path is complete, click Apply to send the changes to the Global Manager. 


You can now enable the path. “Enable an escalation path” on page 169 provides 
detailed information on enabling paths.
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Removing escalation levels from a path
To remove escalation levels from a path:


1. For a disabled path, select the level to remove. The selected level changes color to 
indicate that it is selected. 


2. Right-click to display the Path menu. 


3. Select Level > Remove. The level disappears from the path.


4. Repeat step 1 through 3 to remove additional levels. 


A valid path must have at least one level. 


5. When your path is complete, click Apply to send the changes to the Global Manager. 


You can now enable the path. “Enable an escalation path” on page 169 provides 
detailed information on enabling paths.


Modifying tools or duration at an escalation level
This procedure is identical to the one performed when the path is enabled. “Changing the 
tools or duration of a level” on page 170 includes information on modifying tools or 
duration at an escalation level.


Retiring an escalation path


To avoid losing escalations, consider retiring the path. Retiring an escalation path allows 
all notifications with a Last Notify time earlier than the retirement time to enter or continue 
escalation through the path. The path will not escalate any notifications with later Last 
Notify times. 


To retire an escalation path:


1. Select the escalation policy in the administration tree of the Global Manager 
Administration Console. The policy appears in the Escalation Policy Configuration 
panel.


2. Select the appropriate path by clicking a level in the path. The level changes color 
indicating it is selected.


3. From the Escalation menu, select Path > Retire. The Confirm Disable dialog box 
appears. 


4. Click Yes to retire the path. All levels in the path change color (to one shade of blue) 
indicating the path is retired.


5. Click Apply to send the change to the Global Manager.


6. After checking the retired path to determine whether any notifications are being 
escalated, disable or remove the path. 
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Modifying escalation paths by using the Retire option


You may need to modify a path to add escalation levels or edit the filter. These changes 
require that the path is disabled. Disabling the path immediately terminates the 
escalation of any scheduled notifications. 


The Retire option enables you to avoid this issue and provides a smooth transition to a 
new path. When a path is retired, notifications that are currently being escalated through 
the path continue to follow the escalation path. In addition, existing notifications that now 
meet the filtering criteria for the retired path will enter the path (from level 0). However, 
new notifications that meet the filtering criteria for the retired path are not added to the 
path. 


To retire an existing path and replace it with a modified path: 


1. Copy the enabled path you want to change.


The copied path will be disabled.


2. Modify the path you copied.


3. Enable the new path, but do not apply the changes.


4. Retire the existing path. “Retiring an escalation path” on page 173 includes 
information for retiring an escalation path.


5. Click Apply to simultaneously enable the new path and retire the original path. 
Notifications on the retired path continue to escalate while any new notifications are 
handled by the new path.


6. Remove the retired path when all notifications escalate through the entire path.


The new path only processes notifications that are notified after the enable time of the 
path. The existing path, because it is retired, processes any notifications with a notify time 
less than the time that the path was retired. 
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Removing or deleting escalation paths and policies
Enabled paths and policies can be removed or deleted. This terminates all scheduled 
escalations for the removed path or for all paths in a deleted policy.


Removing an escalation path
A path can be removed when it is enabled, disabled, or retired.


To remove an escalation path:


1. Select the policy name in the administration tree. The policy appears in the Escalation 
Policy Configuration panel.


2. Select the path.


3. From the Escalation menu, select Path > Remove. The path is removed from the 
Escalation Policy Configuration panel.


4. Click Apply to send the change to the Global Manager.


Deleting an escalation policy
A policy can be removed with enabled, disabled, or retired paths. When an escalation 
policy is deleted, all escalation paths within the policy are deleted. All currently scheduled 
escalations will be unscheduled, and the policy will be removed from the system and no 
longer process any notifications.


To delete an escalation policy:


1. Select the policy name in the administration tree. The policy appears in the Escalation 
Policy Configuration panel.


2. From the Escalation menu, select Policy > Delete. The Confirm Delete dialog box 
appears.


3. Click Yes to confirm the policy deletion. The policy name is removed from the 
administration tree in the Administration Console.
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Testing and troubleshooting escalation policies
As escalation policies usually handle important notifications, test your escalation paths to 
ensure they function appropriately. 


EMC Smarts software allows you to quickly test and verify escalation paths through the 
use of sm_ems, the Audit log, and the automated tools you intend to invoke.


After configuring and enabling escalation policy and paths, use sm_ems with the notify 
command option to issue a sample of the specific notification that you hope to escalate. 
The EMC Smarts Service Assurance Manager Adapter Platform User Guide describes the 
sm_ems utility.


Once your sample notification appears in Notification Log Console, double-click the 
notification and select the Audit Log tab. Check the log for escalation-related entries in 
Table 32 on page 176. Escalation-related Audit Log entries always have the userid of 
SYSTEM.


Finally, ensure your automated tools are invoked and function as intended.


Table 32  Escalation-related entries in the Audit Log 


Type Audit Log description Description 


Action 
Completed


<tool name> The named automated tool was invoked and 
completed. 


Action Failed <tool name> The named automated tool was invoked, but 
failed. 


Action Invoked <tool name> The named automated tool was invoked. 


ESCALATION MATCHED:<policy name/path name> Notification has characteristics that match the 
filter criteria for the specified escalation policy 
and path.


ESCALATION REACHED:<policy name>/<path name>, 
<level number>


Notification has reached the indicated 
escalation level in the specified path. 


ESCALATION SCHEDULED:<policy name>/<path 
name> for <level number> at <date> 
<time>


Notification is scheduled to reach the next 
escalation level at the specified date and time. 


ESCALATION TERMINATED ESCALATION: Unmatched 
<policy name>/<path name>


A change in the notification means it no longer 
matches the filter criteria for the escalation 
policy and path and is removed from the policy. 


ESCALATION TERMINATED ESCALATION: Disabled 
<policy name>/<path name>


The escalation policy or path was disabled and 
notifications are no longer escalated within the 
policy or path.


ESCALATION TERMINATED ESCALATION: Notification 
Archived, <policy name>/<path name>


The notification was archived after it entered the 
escalation policy and was removed from the 
policy.


ESCALATION RESCHEDULED: <policy name>/<path 
name> from <level> due at <datestamp> 
<timestamp>


An action within a level was rescheduled to a 
new date or time.


ESCALATION END OF PATH:
<policy name>/<path name>, <level 
number>


Notification has gone through all escalation 
levels and reached the end of the named 
escalation path. 
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Viewing notifications being escalated


Once an escalation path is enabled, you can monitor any notifications that escalate 
through the path. You can select an escalation level within a path and view the 
notifications which are currently escalated to the level. You can then select any of the 
notifications to see the notification properties.


To view notifications being escalated:


1. Select the policy name in the administration tree. The policy appears in the Escalation 
Policy Configuration panel.


2. Select the appropriate path by clicking a level in the path. The level changes color.


3. From the Escalation menu, select Level > Show Notifications. The Escalated 
Notifications dialog box displays any escalated notifications currently at the level. 


4. Double-click an escalated notification to display its notification properties.


Notification data displayed is static. Changes are not automatically updated in the 
view. Click Refresh to update the view. 


5. Click Close to close the Escalated Notifications dialog box.

Testing and troubleshooting escalation policies 177







Escalation Configuration for the Global Manager

178 EMC Smarts Service Assurance Manager Configuration Guide







CHAPTER 10
Working with Filters 


This chapter contains the following information:


◆ Overview...............................................................................................................  180
◆ Building expression filters.....................................................................................  180
◆ ASL filters .............................................................................................................  186

Working with Filters 179







Working with Filters

Overview
A filter screens incoming notifications by comparing a set of defined criteria against the 
attributes of a notification or ICIM class. Values that match the criteria pass through the 
filter. Filters are used to configure:


◆ Notification lists — “Notification lists” on page 52 provides additional information.


◆ Context and Status Criteria of client and server tools — “Context and Status Criteria for 
client and server tools” on page 151 provides additional information.


◆ Escalation paths and policies — “Developing escalation policies” on page 166 
provides additional information.


You can define two types of filters: an expression filter or an ASL filter. You create an 
expression filter using the Filter Builder, which is described in the next section. An ASL 
filter, specified in the ASL Filter checkbox of the Filter Builder, is defined in a separate ASL 
file. “ASL filters” on page 186 provides more information about creating ASL filters.


Building expression filters
An expression filter uses matching criteria to filter against the value of an attribute of the 
specified class. Matching criteria comprises a series of characters, and optionally, 
wildcards:


◆ “Attributes for matching notification properties” on page 215 includes a complete list 
of notification attributes.


◆ “Wildcard Patterns” on page 219 provides a description of wildcards.


Table 33 on page 180 describes the parameters of an expression filter.


Table 33  Expression filter fields


Parameter Description


Attribute Name of the attribute. The expression filter matches against the value of 
this attribute.


matches Matching pattern that is compared against the value of an attribute:
• For Boolean attributes, a menu lists the values.
• For attributes whose values are known, the Helper button lists 


potential values, taken from the notifications in the Global Manager. 
You can use wildcards within the value field. 


AND 
(green plus sign)


Add more attributes to the filter sheet to match against, creating a more 
narrow filter. A notification must match all of the attributes on a sheet to 
pass the filter.


OR
(Sheet Tab)


Add more filter sheets to filter. A notification must match at least one of 
the filter sheets to pass the filter. You can add sheets by clicking Add 
Sheet or selecting Edit > Add Sheet.
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Layout of the Filter Builder


The Filter Builder interface differs for notification filters, context and status criteria, and 
escalation policies.


Filter Builder for notification lists
The Filter Builder for notification lists opens with a blank “Sheet:1” tab. The sheet 
contains a Use ASL Script checkbox and a green plus sign, which is used to add 
notification attributes to the sheet. For notification lists, you can specify an ASL filter, an 
expression filter, or both. If you use a sheet to specify an ASL filter, you cannot specify an 
expression filter on that same sheet.


Menus for each filter criterion enable you to select a notification attribute and one of the 
following conditions, if applicable:


◆ A match condition such as a specific value or expression. You can also specify 
wildcard characters in a match condition. Values are case-sensitive.


Values entered into the notification list filter from the Global Console are not 
case-sensitive.


◆ The is child of condition (the IsA filter option) for notification attributes that have a 
class name for their value. “IsA Filter option for notification lists and logs” on 
page 182 provides more information on this option.


To treat a wildcard character as a text character, insert a backslash (\) before the wildcard 
character. For example, to filter on all event names that include a bracket, specify “*\]*”. 
(Do not include the quotation marks in the expression.)


Filter Builder for Context and Status Criteria
The Filter Builder for specifying Context Criteria and Status Criteria opens with a blank 
“Sheet:1” tab. At the top, the sheet contains a Use ASL Script checkbox and a list box that 
lists Context objects or Status objects. For expression filters, you select a class from the 
object menu and then click the plus sign to add attributes that your expression matches 
against. When using the Filter Builder for Context and Status Criteria, you can use either an 
expression filter or an ASL filter, but not both. In addition, you cannot add more sheets.


Filter Builder for escalation policies
The Filter Builder is used to specify policy filters and path filters. In both cases, you are 
matching against notification attributes. The Filter Builder dialog box provides an Edit 
menu from which you can use to add, copy, or delete sheets from your filter. Select the Use 
ASL Script checkbox to specify an ASL filter or click the plus sign (+) to create an 
expression filter.


At the top of the dialog box, the Edit menu enables you to add, copy, or delete a Sheet tab. 
On the left, the plus sign (+) button enables you to add one filter criterion at a time. Menus 
for each filter criterion enable you to select a notification attribute and a match condition 
such as a specific value or expression. The IsA Filter option is available when supported 
on the server. You can also specify wildcard characters in a match condition. Values are 
case-sensitive.
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IsA Filter option for notification lists and logs


The IsA Filter option is available for filtering the notification log and summary views on 
clients whether or not the Global Manager supports it, because the filtering is performed 
by the client. The option is only available for Notification List and Escalation filtering on 
the server if the server supports it; this is because the filtering is on the server.


The IsA filter option, displayed as is child of, only appears for notification attributes that 
have a class name for their value, including:


◆ Class


◆ ClassName


◆ ElementClass


To create an IsA filter for one of these notification attributes:


1. Select the class and the is child of option from the pull-down menus.


2. Click OK to apply your filter and exit the dialog box.


The Notification Log Console then displays only those notifications for instances of the 
specified class and its subclasses.


Only a single class name, without any wildcard characters of any kind, may be specified 
for an IsA filter.


For example, if IsA filter is used and based on the RedundancyGroup class, the notification 
log would display only all notifications related to instances of the following:


◆ WebServerRedundancyGroup


◆ DatabaseRedundancyGroup


◆ OracleRAC


◆ ApplicationServerRedundancyGroup


◆ WebSphereCluster


Using the Filter Builder


An expression filter comprises one or more sheets. Each sheet specifies an ASL filter or is 
composed of one or more attribute/value pairs. Each pair includes the attribute name and 
an expression to match against that attribute’s value. To match a given sheet, a 
notification or topological element must match every attribute/value pair specified in the 
sheet.


You can specify multiple sheets. A notification or topological element passes the filter if it 
matches at least one sheet.
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Using the Value Helper
When defining the expression for a filter, you can use the Helper button to open a dialog 
box that enables you to add values to an expression. The type of help provided depends 
on the value type of the attribute for which you are defining an expression. For example, 
the Value Expression Helper for the Certainty notification attribute allows you to specify a 
range. An expression for a string field can include wildcard patterns as well as characters. 
For example, the Element Class helper displays a list of known Element Classes. You can 
select multiple names and the helper dialog box automatically creates an OR expression 
with the selected values.


You can also use wildcards in the Value field. Type one or more characters in the Value 
field and specify a wildcard. After you type the Value field, the Value Helper is disabled. 
“Wildcard Patterns” on page 219 provides additional information on wildcards.


Figure 15 on page 183 illustrates the Value Helper dialog box with two Element Class 
elements selected.


Figure 15  Filter Value Helper dialog box


After clicking OK, the dialog box is closed and the expression is listed to the right of the 
attribute in the filter builder where you can manually edit it.
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Filter examples
Figure 16 on page 184 illustrates different expression filters. The filter in the first example 
matches all notifications with a severity of 1 or 2.


Figure 16  Filter notifications with severity of 1or 2


The filter in Figure 17 on page 184 matches all notifications with a value of Router or 
Switch in the Element Class attribute.


Figure 17  Filter notifications of element class router


The filter inFigure 18 on page 185 uses an implicit “or” condition by adding a second 
sheet. When you specify multiple sets of criteria as shown in the example, a notification 
passes the filter if it matches all of the conditions in one sheet. In this example, a 
notification passes the filter if it has a severity of one or two OR an impact between 5 and 
100.
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Figure 18  Filter notifications with severity of 1-2 or an impact of 5 or more


The filter example in Figure 19 on page 185 matches all notifications that have an owner 
assigned to them unless that owner is SYSTEM or maint.


Figure 19  Filter showing notifications owned by all users other than “SYSTEM” or “maint”


The filter example in Figure 19 on page 172 matches all notifications for routers with a 
value of 1 in the severity field.
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Figure 20  Filter showing routers with severity 1


ASL filters
If an expression filter does not provide enough flexibility to define filtering criteria, you can 
use an ASL filter. An ASL filter is an ASL program that processes each notification or other 
type of object.


The EMC Smarts ASL Reference Guide provides detailed information on ASL expressions.


An example ASL filter script, nl-sample-filter.asl, is included in the 
BASEDIR/smarts/rules/ics directory. 


Using ASL filter to load Notif remotely
To reload Notif remotely using ASL, invoke the clearConfigCache method on 
singletonNotifProcessorInterface instance of notifProcessorInterface(class) on the 
appropriate SAM server.


Here is an example of the command:


$./dmctl -b localhost:8822 -s INCHARGE-OI invoke 
notifProcessorInterface::singletonNotifProcessorInterface 
clearConfigCache


where localhost:8822 is the port on which the Broker is running and INCHARGE-OI is the 
name of the server.


This command, when successfully executed, will reload the Notif processor with all the 
.ncf files available in all the SITEMOD locations, and display TRUE as output on the CLI.
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Notification lists and escalation policies
The following example illustrates the format of an ASL filter used to filter Notification List 
and Escalation Policies. It filters for notifications with an EventName attribute “Failure.” 


The name of the notification object is assigned to the variable notification. If the value of 
EventName is Failure, the value of Result is set to TRUE and the notification passes the 
filter, as illustrated in the following code sample:


START do {
      notification = object(NotificationName);
      if (notification->EventName == "Failure")
      {
         Result = TRUE;
      }
      else
      {
         Result = FALSE;
      }
}


To apply the ASL filter, access the filter builder. Select the Use ASL Script checkbox and 
type the name of the ASL script.


Context and Status Criteria for client and server tools
The following example illustrates the format of an ASL filter used to filter context and 
status criteria for client and server tools. It filters for notifications with an EventName 
attribute Failure. 


The name of the object is assigned to the variable ObjectName. If the value of ObjectName 
is Failure, the value of Result is set to TRUE and the notification passes the filter, as 
illustrated in the following code sample:


START do {
timeNow = object(ObjectName)->nowString
if (glob("*1<0-1>:*:* AM*|*<1-5>:*:* PM*|*12:*:* PM*", timeNow)) 
{


Result = "TRUE";
} 
else 
{


Result = "FALSE";
}


}


To apply the ASL filter:


1. Open the filter builder. 


2. Click Use ASL Script. 


3. Type the name of the ASL script.
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Saving ASL filters
The ASL filter files must be located in the appropriate directory under the 
BASEDIR/smarts/local/rules directory. The files are located in different subdirectories for 
different products. 


For example, when saving files:


◆ Global Manager ASL files should be saved in the BASEDIR/smarts/local/rules/ics 
directory.


◆ When changed, the Global Manager’s nl-sample-filter.asl file must be saved as 
BASEDIR/smarts/local/rules/ics/nl-sample-filter.asl. 


◆ Adapter Platform ASL files should be saved in the BASEDIR/smarts/local/rules/icoi 
directory.


When you save a file, specify the path to a specific BASEDIR/smarts/local/rules directory.
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Importing and Exporting Configurations

Overview
This chapter describes how to use sm_config to import and export repository objects such 
as notification lists, users, user profiles, tools, and escalation policies. It also describes 
how to use sm_config for configuring map icons.


The sm_config utility imports configurations, written in XML, for the Global Manager and 
the Adapter Platform. The sm_config utility is used for the following purposes:


◆ As an alternative to creating notification lists, users and user profiles in the Global 
Manager Administration Console. 


◆ To batch process multiple configurations. 


◆ To duplicate configurations between Global Managers.


◆ To import tools for third-party applications.


A strong understanding of XML is necessary if you intend to create and manage repository 
objects using XML. Appendix C, “XML Reference,” provides a guide for creating 
notification lists, user profiles, users, tools and escalation policies according to the 
ics-config.dtd XML specification. 


About the default XML files
Default configuration settings for the Global Manager are shipped in 
BASEDIR/smarts/conf/ics in a file called ics-default.xml. This file requires the Document 
Type Definition (DTD), which must be in the same directory. The name of the DTD is 
ics-config.dtd. 


The ics-default.xml file is only used when the Global Manager is started without a 
repository (*.rps) file. It creates the default repository objects if none are defined in the 
repository. For example, the ics-default.xml file creates the default notification lists if 
there are no notification lists found in the repository.   


The ics-default.xml file also reads:


◆ The console_operations.xml file


The console_operations.xml file resides in the BASEDIR/smarts/conf/ics directory. 
This file requires a DTD, consoleoper-config.dtd. The console_operations.xml file and 
the consoleoper-config.dtd must be stored in the same directory.


◆ The map_gif.xml file


The map_gif.xml file resides in the BASEDIR/smarts/conf/maps directory. This file 
also requires a DTD, map-config.dtd. The map_gif.xml file and the map-config.dtd 
must be stored in the same directory.
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If you start the Global Manager without a repository, the ics-default.xml file is read to 
instantiate the Global Manager with default configurations. These default configurations 
include objects which are added to the Global Manager. Objects included in each of the 
default XML files are:


◆ ics-default.xml


• Business Templates:


– Topology-group.data.template


– service.data.template


• Domains:


– INCHARGE-AM


– INCHARGE-PM


– INCHARGE-AM-PM


– INCHARGE-AM2


– INCHARGE-OI


– NCM


– INCHARGE-DISCMGR


– INCHARGE-MPLS-ANALYSIS


– INCHARGE-MPLS-MONITORING


– INCHARGE-MPLS-TOPOLOGY


• Notification Lists: 


– Default


– Maintenance


• Server Tools: 


– Clear Business Process Event


– Disable BypassPropogateNotifications


– Disable Maintenance Tracking


– Enable BypassPropogateNotifications


– Enable Maintenance Tracking


– Import XML Configuration


– Import XML Domain Configuration


– Notify Business Process Event


– Sample - Close Trouble Ticket


– Sample - Open Trouble Ticket


– Sample - Ping-all


– Sample - Ping-device

About the default XML files 191







Importing and Exporting Configurations

– Sample - Ping-Interface


– Sample - Ping-IP


– Sample - Telnet


– Show Storage Impacts


– Update Business Process Event


• Client Tools:  


– Report Manager


– Launch Web Browser


– Dump Properties


– Ping


• User Profiles:  


– admin-profile


– default-profile


– maint-profile


– oper-profile


• Users:


– admin


– default


– maint


– oper


◆ console_operations.xml


The console_operations.xml file contains configuration information related to console 
operations. This file cannot be modified.


◆ map_gif.xml


The map_gif.xml file sets the default image file that is used as a map icon for ICIM 
classes. This file cannot be modified.
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Running sm_config
Using the sm_config command you can import objects into and export objects from the 
repository. In addition, the command allows you to enable, disable, and delete objects. 


The options for importing, exporting, and enabling configurations are specified as 
commands to sm_config when you invoke it at the command line. Table 34 on page 193 
lists the arguments you should specify when invoking sm_config, which is run from 
BASEDIR/smarts/bin. 


The information included in Table 34 on page 193 can be retrieved by entering the --help 
argument when invoking sm_config from the command line.


Table 34  Arguments to sm_config for managing configurations (page 1 of 3)


Command option / argument Description


Commands


import  
[command-options] 
<input-xmlfile> 


Imports the specified XML file into the Global Manager.


export  
--server=
[<output-xmlfile>] 


Exports the current object configurations to XML. If no 
output XML filename is specified, the XML is exported 
as standard output.


delete  
--classname=<class> 
--instancename=<instance> 
[--type=<action_type>] 


Removes the specified instance from the Global 
Manager repository.


enable  
--classname=<class> 
--instancename=<instance>
[--type=<action_type>]


Enables the specified instance in the Global Manager 
repository. 


disable 
--classname=<class> 
--instancename=<instance> 
[--type=<action_type>]


Disables, but does not delete, the specified instance in 
the Global Manager repository.


--help Displays the sm_config command option / argument 
help.


Command options 


--force  To be used with the import command. Imports 
repository objects even if existing objects were 
modified since the XML was last exported. This 
overwrites existing repository objects that may have 
been changed. 
Also -f can be used.
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--replace  To be used with the import command. Deletes all the 
XML-configured repository objects that currently exist 
in the Global Manager (specifically notification lists, 
user profiles, users, tools, escalation policies, and 
actions). New repository objects, as specified in the 
XML file, are created in their place. 
Also -r can be used. 


--classname=<class> To be used with the delete, enable, or disable 
command. Specifies the class name of the object you 
want to modify. 
Also -c <class> can be used. 


--instancename=<instance> To be used with the delete, enable, or disable 
command. Specifies the instance name of the object 
you want to modify. 
Also -i <instance> can be used. 


--type=<action_type>  To be used with the delete, enable, or disable 
command when you are modifying an action or tool. 
Specifies the action type. The possible values are 
server, client, or auto. 
Also -t <action_type>. 


Notice: This option is required if --classname=Action 
can be used. 


Arguments


<input-xmlfile>  Name of the Input XML file. 
Input XML files for Service Assurance Manager must be 
located in BASEDIR/smarts/local/conf/ics.   


Notice: Only the filename (including the file extension) 
must be specified, not the path to the file. 


<output-xmlfile> Name of the file that is generated when exporting 
configurations. 
Output XML files for Service Assurance Manager are 
created in BASEDIR/smarts/local/conf/ics.   
Output XML files for the Adapter Platform are created 
in BASEDIR/smarts/local/conf/icoi. 
If an output XML File is not specified, the XML is written 
to standard output. 


<class>  Supported Values: 
• Action 


(To be used for client, server, and automatic tools.)
• AutoActionPolicy 


(To be used for Escalation Policies.)
• NotificationList
• UserProfile
• User


Notice: There is no map icon support for <class>. You 
cannot import an individual instance of a map icon. 


Table 34  Arguments to sm_config for managing configurations (page 2 of 3)


Command option / argument Description
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Importing configurations 
Adding new objects and modifying existing objects requires the following steps:


1. Define the objects in an XML file.


2. Import the XML file.


Defining objects in XML


You have several options for creating XML files for import with sm_config, including:


◆ Export the current configurations to a file and modify the XML as needed. “Exporting 
configurations” on page 198 provides additional information on exporting 
configurations.


◆ Copy and modify an existing object from one of the XML sample files located in 
BASEDIR/smarts/conf/ics.


◆ Write the XML for the new object. 


When making any modifications to the XML, be sure to adhere to the standards of the 
following DTDs:


◆ ics-config.dtd located in BASEDIR/smarts/conf/ics


◆ map_config.dtd located in BASEDIR/smarts/conf/maps. 


“XML Reference” on page 223 provides additional information on Service Assurance XML 
standards.


<instance> Instance value is the logical name of the repository 
object. 


<action_type> Used with the --type command option to specify the 
type of action to delete, enable, or disable. Possible 
values are:
• client
• server
• auto


Standard options


--broker=<broker_location> Alternate location of the broker as <host>:<port>. This 
value can be verified in the SM_BROKER environment 
variable. 


Notice: This argument is optional. 


Also -b <broker_location> can be used.


--server=<server_name> Name of Global Manager or Adapter Platform. 


Notice: This argument is required. 


Also -s <server_name> can be used.


Table 34  Arguments to sm_config for managing configurations (page 3 of 3)


Command option / argument Description
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Sample XML configuration files
Sample XML documents are provided for use as templates and can be edited to suit your 
needs. The following sample files are located in BASEDIR/smarts/conf/ics:


◆ Tools:  actionconfig-sample.xml


◆ Notification lists:  nlconfig-sample.xml


◆ Escalation policy:  policyconfig-sample.xml


◆ User profile:  profileconfig-sample.xml


◆ User:  userconfig-sample.xml


◆ Multiple types of repository objects:  ics-config-sample.xml 


◆ Map icons: mapgif-sample.xml


Working with XML sample files
The simplest way to create new repository objects in XML is to use a template. Sample 
XML files located in BASEDIR/smarts/conf/ics are provided for this purpose. Use sm_edit 
to open and save a copy of this file in your BASEDIR/smarts/local directory. For example, 
to create a new notification list, open the nlconfig-sample.xml file using sm_edit:


BASEDIR/smarts/bin>sm_edit ../conf/ics/nlconfig-sample.xml


Modify the current notification list example to create a new one that suits your needs. 


For example, change the name="Default" attribute to name="NotificationList_1". Remove 
everything up to the ColumnHeading declaration and then change one of the column 
headings to display the "Certainty" percentage of the event. 


The revised portion of the sample files looks like:


<ics_config>
  


<nlconfig name="NotificationList_1" enable="True" timestamp="0">
<filterconfig type="Expression">


    <criterion attribute="Owner">~maint</criterion>
<criterion attribute="Owner">~SYSTEM</criterion>


    </filterconfig>


<columnheading 
column="InstanceDisplayName">"Name"


</columnheading>
<columnheading 


column="EventDisplayName">"Event"
</columnheading>
<columnheading 


column="Certainty">"Certainty"
</columnheading>


</nlconfig>


</ics_config>


You can subscribe to multiple notification lists by adding multiple nlconfig elements to the 
nlconfig XML file. For example, you can add:


<nlconfig name="NotificationList_2" enable="True" timestamp="0">
<filterconfig type="Expression">


    <criterion attribute="Owner">~maint</criterion>
<criterion attribute="Owner">~SYSTEM</criterion>
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    </filterconfig>


<columnheading 
column="InstanceDisplayName">"Name"


</columnheading>
<columnheading 


column="EventDisplayName">"Event"
</columnheading>
<columnheading 


column="Certainty">"Certainty"
</columnheading>


</nlconfig>


When creating new users, the serverConnect.conf file and the clientConnect.conf file must 
be modified to authenticate them with usernames and passwords. The EMC Smarts 
System Administration Guide provides additional information on modifying these files.


Importing XML files to the Global Manager


When you have prepared an XML file with the appropriate additions or changes, you can 
import it into the Global Manager. By default, the sm_config import command will add 
new objects but will not allow modification to objects that exist in the repository. For 
example, to import a file called NewUsers.xml located in BASEDIR/smarts/local/conf/ics, 
use the following procedure:


1. Change directory to BASEDIR/smarts/bin.


2. Run the command: 


sm_config -s INCHARGE-SA import NewUsers.xml 


3. Verify that the new configurations were imported by viewing them in the Global 
Manager Administration Console.


Importing options
There are two options for the sm_config import command: 


◆ --force:  Use this option to override the default and allow modification of existing 
XML-configurable objects with those in your XML import file.  


◆ --replace: Use this option when you want to remove all the XML-configurable objects 
that exist in the repository and replace them with the objects in your XML import file. 
This option is typically used when copying configurations from one Global Manager to 
another Global Manager in order to duplicate the repository objects.


As an example, use the following command to import configuration objects from a file 
called ics-conf.xml into a Global Manager called INCHARGE-SA and overwrite any existing 
configurations:


sm_config -s INCHARGE-SA import --force ics-conf.xml
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Exporting configurations
Exporting the repository objects to XML enables you to view the current configurations of 
your Global Manager. Exporting configuration-related objects from one Global Manager in 
XML and then importing them to a second Global Manager allows you to duplicate 
configurations between Global Managers. 


Before exporting, you need to know the name of the appropriate Manager and the location 
(host and port) of the broker. Exporting produces an XML representation of the current 
configurations for your notification lists, users, user profiles, tools, escalation policies, 
and map icons. By default, the XML file is created in the BASEDIR/smarts/local/conf/ics 
directory.


To export the repository object configurations, use the following command syntax:


▼sm_config -s <Global_Manager_Name> 
--broker=<host:port> export <file_name>.xml ▲ 


The command must be typed as one line.


For example, to create an XML file called Current_Configuration.xml containing the 
repository objects in the INCHARGE-SA Global Manager on the host and port MyHost:426, 
the following command is used:


▼ sm_config -s INCHARGE-SA 
--broker=MyHost:426 export Current_Configuration.xml ▲


The command must be typed as one line.


“Importing XML files to the Global Manager” on page 197 provides detailed information 
on importing the XML file.
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Modifying individual repository objects
Using sm_config you can also enable, disable, and delete individual repository objects. To 
modify these configurations, you need to know:


◆ Class name


◆ Instance name


◆ Action type (if the class name is Action)


Enabling or disabling repository objects


Disabling an object deactivates it and prevents it from being used. To disable or enable an 
object from the repository, use the following command syntax:


▼sm_config [options...] disable --classname=<class> 
--instancename=<instance> ▲


The command must be typed as one line.


To enable the object, replace the disable command with the enable command. For 
example, to enable a user profile called UserProfile1 in a Global Manager named 
INCHARGE-SA, use the following command:


▼ sm_config -s INCHARGE-SA enable --classname=ICS_UserProfile 
--instancename=ICS-Profile1 ▲


The command must be typed as one line.


Deleting repository objects


Deleting a repository object completely removes it from the Global Manager. If you are not 
completely sure you want to remove it, consider disabling the object instead. “Enabling or 
disabling repository objects” on page 199 provides additional information.


Map objects cannot be deleted.


To delete an object from the repository, use the following command syntax:


▼ sm_config [options...] delete --classname=<class> 
--instancename=<instance> ▲


The command must be typed as one line.
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For example, to delete a server action named Telnet from a Global Manager named 
INCHARGE-SA, use the following command:


▼ sm_config -s INCHARGE-SA delete --classname=ICS_Action 
--instancename=Telnet --type=server ▲


The command must be typed as one line.


Importing tools implemented by EMC Smarts adapters
If you are deploying an EMC Smarts adapter that integrates with a third-party application, 
you may need to import an XML definition file for the tools implemented by that adapter. 


The XML definition files for these adapters are imported into the Global Manager using 
sm_config. “Importing XML files to the Global Manager” on page 197 provides detailed 
information on importing XML files. Refer to the user guide for that adapter for more 
information regarding the specific tool.


For example, to import the tools definition for the Concord eHealth tool from a file called 
configureEHealthTools.xml into a Global Manager called INCHARGE-SA, type the following 
command:


sm_config -s INCHARGE-SA import configureEHealthTools.xml
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System default parameters
System defaults are system-wide settings that affect the Global Manager and its clients. 
Table 36 on page 205 describes the System Defaults parameters.


Table 35  System Defaults parameters (page 1 of 3)


Parameter Description


Auto Acknowledgement Interval Defines interval, in seconds, after which an inactive and unowned 
notification is acknowledged. Notifications that are acknowledged by the 
Global Manager are owned by the user SYSTEM. 
Default: 300 seconds


Inactive Auto Archive Interval Defines interval, in seconds, after which an inactive and acknowledged 
notification is archived. If this value is set to zero, archiving is disabled and 
notifications will not be deleted, causing Global Manager to use more 
memory.
Default: 14400 seconds (4 hours)


Audit Trail Size Limit Defines the number of audit log entries for each notification that are saved 
and visible in the Global Console before the log contents are archived. When 
this limit is reached, half of the entries are written to the notification archive. 
Default: 100 entries


SMTP Server Defines the name of the SMTP mail server through which mail messages sent 
by the Global Console’s Mail tool are sent. This mail server must be 
reachable from the host where the Global Manager is running. This value can 
be overridden in the Global Console.
Default: “localhost”


Fetch Local Notification Properties Defines how the properties of a particular notification are retrieved when 
requested by a client application. Client applications include the Global 
Console, the dmctl utility, and adapters.
If set to “true”, properties are retrieved from the Global Manager. If set to 
“false”, properties are retrieved from the Global Manager and from the 
underlying domain.
Default: False


RMI Time Out Defines the maximum amount of time, in seconds, the Global Manager is 
allotted to retrieve Notification Properties, Find System, or get System 
Containment information from an underlying domain. If a negative value is 
specified, no time-out value is set. 
Default: 60 seconds


Number Of Worker Threads Defines the number of worker threads used by the escalation mechanism in 
executing tools associated with escalation levels in escalation paths. 
Increase the number of threads if the escalation mechanism falls behind in 
executing tools for escalation levels. Valid values are 1 - 10.
Default: 2

202 EMC Smarts Service Assurance Manager Configuration Guide







SAM Configuration Parameters

Broadcast Event State on Restart Defines whether notifications that result from internal Global Manager 
events are propagated to clients that subscribe to them. Internal Global 
Manager events include system disconnects and system reconfigurations. If 
set to True, notifications resulting from internal Global Manager events are 
propagated. If set to False, the events are not propagated.
Example:
In the case of the value being TRUE in a hierarchical SAM configuration, 
notifications at presentation level SAM will go to ‘Suspended’ state if there is 
a disconnect between aggregation level SAM and a source domain. This will 
happen because aggregation SAM will broadcast the notification state 
change from Active to WAS_ACTIVE. In the case of the value being False, the 
notifications in the aggregation SAM will change to WAS_ACTIVE, but no 
change will be sent to presentation level SAM. When aggregation SAM 
reconnects to the source domain events it will send clears for notifications 
that are no longer active. 
When configuring this parameter, the value must be identical for all Service 
Assurance Manager servers within your Service Assurance Manager 
deployment. For changes to this parameter configuration to take effect, the 
Service Assurance Manager servers must be restarted. 


Notice: For optimum benefit, configure this parameter as early in your 
Service Assurance Manager deployment as possible, before all source 
domains are added to the Service Assurance Manager server. The quickest 
way to apply this parameter configuration is to restart the Service Assurance 
Manager server. However, if you are configuring this parameter in a 
production environment, apply the parameter configuration to the Service 
Assurance Manager server by making a minimal change to the configuration 
of each of the underlying source domain types, and clicking the Reconfigure 
button. One example of a minimal configuration change is to modify the 
value for the Smoothing Interval parameter. A minimal configuration change 
is required for each domain type. This results in the Service Assurance 
Manager server disconnecting from each underlying domain, rereading all 
the settings including the new modification, and then reconnecting to the 
underlying domains.


Default: True


Hierarchical Acknowledge Defines whether acknowledging or unacknowledging a notification in the 
server sends the acknowledge (or unacknowledged) information to the 
underlying servers. If set to True, the notification in the underlying servers 
are also acknowledged or unacknowledged. If set to False, the notification in 
the underlying servers are not changed.
Default: True


Companion UI Hostname Defines the location of the related Companion UI vApp. The accepted values 
are the Domain Name System (DNS) host or the IP address of the vApp (for 
example, companionUI or companionUI.mycompany.com).


Use DNS Lookup in This Domain Defines whether the system performs Domain Name System (DNS) searches 
when searching for computer systems. If set to True, the system queries the 
DNS in this domain.


Notice: When performing a DNS search, perform the search from the Adapter 
Platform (OI).


Default: True


Table 35  System Defaults parameters (page 2 of 3)


Parameter Description
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Use DNS Lookup in Underlying 
Domains


Defines whether the system performs Domain Name when searching for 
computer systems. If set to True, the system queries the DNS in underlying 
domains.
Default: True


Use DNS Domains in DNS Lookup Defines whether DNS domains are used when the system performs a DNS 
search. If set to false, only original domain names are used during the DNS 
search.
Default: False


DNS Domain Names Defines the list of domain names the system uses when performing a DNS 
search.


Notice: When entering multiple domain names, separate each domain name 
with a comma.


Underlying Domains Order Defines the order in which the underlying domains are searched.


Notice: When entering multiple domain names, separate each domain name 
with a comma.


Fully Qualified Domain Name Suffixes Defines which domain names returned as a result of performing a DNS 
search are considered to be fully qualified. Domain names matching suffixes 
entered in this parameter are considered fully qualified.


Table 35  System Defaults parameters (page 3 of 3)


Parameter Description
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ics-event-processing parameters
Table 36 on page 205 describes the ics-event-processing parameters.


Table 36  ics-event-processing parameters


Parameter Description


default debug This parameter helps track the event flow. If set to true, it 
prints all the messages under debug flag. 
Default: FALSE


default timeoutTopoValue       This prevents topology synchronization operations from 
waiting indefinitely. Depending on the value you specify 
for this parameter in the configuration file, if the child 
(underlying domain) has gone down, then the parent 
(domain) waits for the time interval specified here before 
starting off topology synchronization operations. The 
default value of 600 seconds can be increased on the 
basis of size and complexity of the topology. 
Default: 600 seconds


default broadcastEventState This variable allows you to customize and bypass internal 
event storms. It displays information about 
domain-related events, such as system disconnects and 
system reconfigurations. This parameter is set using the 
Global Console.
Default: TRUE
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ics-nl-processing parameters
Table 37 on page 206 describes the ics-nl-processing parameters.


Table 37  ics-nl-processing parameters


Parameter Description


default debug If set to true, it prints all the messages under debug flag. 
Default: FALSE


default broadcastEventState This variable allows you to customize and bypass internal 
event storms.
Default: True


default timeoutTopoValue This prevents topology synchronization operations 
waiting indefinitely.
Default: 600 seconds
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Console parameters
Table 38 on page 207 describes the Console parameters.


Table 38  Console parameters (page 1 of 3)


Parameter Description


com.smarts.connectionTimeout This property indicates the maximum amount of 
time that the console will wait for the Domain 
Manager pulse check (the upTime attribute) to 
respond. If there is no response within the 
specified time, the console disconnects from the 
Domain Manager. 
Default: 300 seconds (5 minutes) 


com.smarts.highLatency This will be set to true in high latency environment.
Default: FALSE


com.smarts.securityMessage Defines the name of the ASCII file containing the 
security warning message. 
Default: String


com.smarts.server.logMessages If set to true, causes the server to write messages to the 
server log file.
Default:TRUE


com.smarts.mapNodeText.font Allows the user to define the map icon font..
Default: Helvetica


com.smarts.mapNodeText.fontSize Allows the user to define the map icon font size.
Default: 12 point


com.smarts.java.log If specified, the Java log contents are saved to the 
specified file. 
Default: No file specified


com.smarts.map.showAllBusiness If set to true, it shows all nodes and edges in a Business 
Services map, including those that are not part of 
paths that originate from or terminate at the map 
central node. If set to false, it shows the nodes and edges 
in a Business Services map that either originate from or 
terminate at the map central node.
Default: TRUE


com.smarts.map.showNormalBanner If set to True, it shows map nodes with the status of 
Normal with a green color bar underneath the icon. If 
false, shows map nodes with the status of Normal 
without a green color bar underneath the icon. 
Default: FALSE


com.smarts.mapBackgroundColor Enables you to specify a single background color 
for all maps. This parameter overrides the default 
color for all map types. Note that if the setting you 
enter is invalid, the background color for all maps 
will be white.
Default: 600 seconds
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com.smarts.showDomainConsistsOf Defines whether the InChargeDomainConsistsOf 
relationship displays in the topology view. If 
configured to false, the 
InChargeDomainConsistsOf relationship does not 
display in the topology view reducing the 
possibility of the console not responding. If 
configured to true, all the information for the 
ConsistsOf relationship displays in the topology 
view.
Default: FALSE


com.smarts.fasttopologybrowse Defines whether the topology browser 
performance is enhanced for displaying related 
instance information. Options include:
• Off — Default value
• On — Speed up enhancement is activated with 


instance information sorted
• Nosort — Speed up enhancement is activated with 


instance information not sorted
Default: OFF


com.smarts.clientTool.setEnv Defines the method of passing parameters to client 
scripts. If configured to true, the console directly loads 
parameters passed to the client script into the 
environment. 
Configuring this property to true, enables parameters 
with values that cause Windows parsing of the command 
to fail to be passed to the client script.
If configured to false (or when a value is not specified), 
the console passes parameters to the client scripts as 
command line arguments and requires the client script to 
parse the parameters to load them into the environment.
Default: FALSE


com.smarts.getMap.timeout Defines the time, in seconds, that the Get Map function 
tries to retrieve map data before the function times out. 
Once the Get Map function times out, the Get map timed 
out message appears.
Default: 120


com.smarts.timestampFormat Overrides the default formatting of timestamps in 
the console, for example, the First Notify, Last 
Notify, and Last Change fields in the notification 
view.


com.smarts.user.timezone Causes the console to format all times and timestamps 
according to the specified time zone. Examples of 
acceptable values are: PST for U.S. Pacific Standard Time 
and GMT for Greenwich Mean Time.
The default is the time zone where the console is 
running. Class TimeZone at the Java website includes 
additional information.


com.smarts.writeable Defines the location of console logs.


Table 38  Console parameters (page 2 of 3)


Parameter Description
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smarts.remote.broker Defines the default broker for domain attach dialog 
boxes.
Default: host:port


com.smarts.securityEnabled If set to true, security is enabled. This is the default value 
when the sm_gui.exe is executed. If set to false, security 
is disabled.


com.smarts.log.level Defines the level of messages written to the console java 
log. Options include:
• FATAL
• SEVERE
• SERIOUS
• DEFAULT (default option)
• WARNING
• INFO
• CONFIG
• DEBUG
• TRACE


smarts.allowBGjpegs If set to true, it allows map background files to be saved 
in jpeg (.jpg) format.If set to false, map background files 
will not be saved in jpeg format.


com.smarts.viewer.map.disableMaps If set to true, it disables the display of maps. If set to 
false, it does not diable maps. 
Default: TRUE


com.smarts.viewer.hideToolbarText If set to true, it hides the display text for the toolbar 
buttons. If set to false, shows the text for the toolbar 
buttons.
Default: TRUE


com.smarts.maxTopoInstances It determines the number of topology instances that will 
be displayed on the browser.
Default: 10000


smarts.maps.maxGroupMembers A positive integer. This is the maximum number of 
members of a leaf group that will display for a 
Group Membership map without a prompt dialog 
box. The dialog box prompts the operator when 
there is a large number of members to display.
Default: 100


com.smarts.maxFilterInstances Enables you to change the maximum number of 
instances that will automatically display in the 
Topological Filter tab.
Default: 50


Table 38  Console parameters (page 3 of 3)


Parameter Description
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trap.d conf parameters
The EMC Smarts Service Assurance Manager Adapter Platform User Guide provides details 
on the trap.d conf parameters.


Environment variables
Table 39 on page 210 describes the environment variables.


Table 39  Environment variables


Parameter Description


SM_NOTIF_DISPLAY_PACKET If set to true, it displays packet information regarding 
notification.
Default: FALSE


SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP Sets the polling interval to fetch notifications.
Default: 10


SM_ENABLE_SERIAL_SYNCS If set to true, enables serial mode for topology 
synchronization.
Default: FALSE


SM_DELAY_BETWEEN_TOPO_SYNCS Sets the minimum delay between two successive 
synchronization to a domain.
Default: 120 seconds


SM_JDK_HOME The SM_JDK_HOME environment variable is used to 
indicate the location of the JDK, if present. If you 
provide the location of the JDK while running the 
appropriate setup script, then the SM_JDK_HOME 
variable will be defined in the runcmd script.


SM_JAVA The SM_JAVA environment variable specifies a Java 
Runtime Environment (JRE) other than that in 
BASEDIR/smarts/jre. The contents are the paths to the 
libraries of the JRE. On UNIX, the value of SM_JAVA is 
added to the LD_LIBRARY_PATH (Solaris and Linux). On 
Windows, the value of SM_JAVA is added to the PATH.
This variable is optional. If not set, runcmd will assume 
standard paths relative to the value of SM_JAVAHOME.


SM_JAVAHOME The SM_JAVAHOME environment variable is used in 
conjunction with SM_JAVA to specify a non-standard 
JRE. It specifies the location of the JRE, and defines the 
value
of the JVM's ""java.home"" system property.
• If SM_JAVAHOME is left unset and SM_JDK_HOME 


was specified, then SM_JAVAHOME will effectively 
be set to SM_JDK_HOME/jre.


• If left is not set and SM_JDK_HOME is also unset, 
and if the BASEDIR/jre directory exists, then 
SM_JAVAHOME will effectively be set to 
BASEDIR/jre.


SM_JAVA_ENABLED Set this environment variable to Yes in the BASEDIR 
directory path to ensure that Java can be successfully 
started for NOTIF.

210 EMC Smarts Service Assurance Manager Configuration Guide







APPENDIX A
ICIM Classes Used with Matching Criteria


This appendix contains the following information:


◆ Classes and attributes for matching managed systems..........................................  212
◆ Attributes for matching notification properties ......................................................  215

ICIM Classes Used with Matching Criteria 211







ICIM Classes Used with Matching Criteria

Classes and attributes for matching managed systems
To configure the Global Manager, you may need to specify a matching pattern or matching 
criteria. The matching pattern or criteria are compared to the name or value of system and 
notification attributes. Tasks where you might specify a matching pattern include:


◆ Creating notification lists


◆ Specifying tagging patterns


◆ Determining the status or criteria of tools


◆ Creating selective groups with the Global Console


Matching criteria are strings that are matched against the value of the specified attribute. 
The criteria can contain any combination of text, integers, and wildcards.


Table 40 on page 212 lists the attributes of the system class hierarchy. The ICIM_System 
class is at the top of the hierarchy. As you move down the table, the classes become 
increasingly more specialized until you reach classes that represent specific systems such 
as routers and switches. 


Classes lower in the hierarchy inherit the attributes of classes higher in the hierarchy.


Table 40  System classes and their attributes (page 1 of 3)


System class Attributes Type Description


ICIM_System CreationClassName String Name of the class from which the element 
was instantiated.


DisplayClassName String Name of the system’s class that is displayed 
in the console.


DisplayName String Name of the system that is displayed in the 
console.


Description String Description of the system.


IsManaged Boolean Determines if the system is managed by the 
underlying domain. 


Notice: Unmanaged elements do not appear 
in the Global Manager topology.


Name String Name of the system.


PrimaryOwnerContact String Contact information for the primary owner of 
this system.


PrimaryOwnerName String Name of the primary owner of this system.


SystemName String Name of the system of which this component 
is a part of or this service is hosted by. 


ICIM_ComputerSystem ICIM_ComputerSystem does not add 
attributes to the system class hierarchy. A 
computer system is a collection of managed 
system elements such as file systems, 
processors, and memory.
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UnitaryComputerSystem Certification String Level of certification assigned to this device 
during discovery. Possible values are:
• CERTIFIED
• VALIDATED
• TEMPLATE
• GENERIC
• UNCERTIFIED
• UNDISCOVERED
• UNSUPPORTED


Location String Description of the physical location of this 
system.


Model String Vendor name for the system.


Type String Type of the computer system. Possible values 
are:
• BRIDGE
• FIREWALL
• HOST
• HUB
• LOADBALANCER
• MSFC
• NODE
• PROBE
• ROUTER
• RSFC
• RSM
• SWITCH
• TERMINALSERVER
• UNCERTIFIED


Vendor String Name of the system’s manufacturer.


Bridge Type String Unitary computer system that bridges 
packets between separate segments. Value is 
BRIDGE.


Firewall Type String Unitary computer system that controls the 
flow of traffic between networks. Value is 
FIREWALL.


Host Type String Unitary computer system that represents a 
workstation or server. Value is HOST.


Hub Type String Unitary computer system that connects 
multiple segments. Value is HUB.


LoadBalancer Type String Unitary computer system that distributes 
client traffic across multiple web servers. 
Value is LOADBALANCER.


MSFC Type String Unitary computer system that represents a 
Multi Layer Switch Feature Card. An MSFC is a 
card installed into a switch to perform routing 
between VLANs. Value is MSFC.


Node Type String Unitary computer system that has not yet 
been certified by discovery.


Table 40  System classes and their attributes (page 2 of 3)


System class Attributes Type Description
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Probe Type String Unitary computer system that monitors 
networks or systems. Value is PROBE.


Router Type String Unitary computer system that routes packets 
between computer networks. Value is 
ROUTER.


RSFC Type String Unitary computer system that represents a 
Router Switch Feature Card. An RSFC runs 
Cisco IOS router software and directly 
interfaces with Catalyst switches to provide 
inter-VLAN routing. Value is RSFC.


RSM Type String Unitary computer system that represents a 
Router Switch Module. Often installed in 
switches to route packets between VLANs. 
Value is RSM.


Switch Type String Unitary computer system that switches 
packets between separate segments. Value is 
SWITCH.


TerminalServer Type String Unitary computer system that represents a 
terminal server or similar access device. 
Value is TERMINALSERVER.


Uncertified Type String [Deprecated, replaced by Node] Unitary 
computer system that represents a system 
that has not yet been certified by discovery. 
Value is HOST.


Table 40  System classes and their attributes (page 3 of 3)


System class Attributes Type Description
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Attributes for matching notification properties
Table 41 on page 215 lists the notification attributes that are contained in notifications 
generated by the Global Manager. When you create a matching pattern, use the name of 
the attribute, not the column heading from the Notification Log.


Table 41  Notification attributes (page 1 of 3)


Attribute
Default column 
name Value type Description


Acknowledged Acknowledged Boolean Indicates if a notification has been 
acknowledged. Possible values include:
• TRUE if the notification has been 


acknowledged.
• FALSE if not.


Active Active Boolean Indicates if a notification is active. Possible 
values include:
• TRUE if the notification is active.
• FALSE if not.


AuditTrail n/a String Audit trail includes five fields separated by 
spaces. The fields include:
• Serial number — A unique number that 


identifies the audit trail entry.
• Timestamp — Identifies when this audit trail 


entry was written.
• User — The InCharge username associated 


with this audit trial entry.
• Action type — Identifies the reason for the 


audit trail entry.
• Text — A brief description of the audit trail 


entry.


Category Category String Type of notification sent by the Global Manager. 
Possible values include:
• Availability
• Discovery
• Error
• IMPACT
• Operational
• Performance
• PowerSupply
• Resource
• Temperature


Certainty Certainty Float Confidence that this notification is the correct 
diagnosis. Value ranges from 0 to 100.


ClassDisplayName Class String Name of the class that appears to the user.


ClassName ClassName String Class name of the instance where this event 
occurred. This attribute, with InstanceName and 
EventName uniquely identifies this notification.


ClearOnAcknowledge n/a Boolean Indicates that this event should be cleared when 
it is acknowledged. Default is FALSE.


ElementClassName Element Class String Class name of the managed element most 
closely related to this event.
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ElementName Element Name String Name of the managed element most closely 
related to this event.


EventDisplayName Event String Name of the notification that appears to the 
user.


EventName EventName String Name of this notification. This attribute, with 
ClassName and InstanceName, uniquely identify 
this notification.


EventState Event State String Describes the state of the event. Value can be 
one of:
• ACTIVE
• WAS_ACTIVE
• SUSPENDED
• INACTIVE
• UNITIALIZED


EventText Event Text String A description of the notification.


EventType Event Type String MOMENTARY when the notification has no 
duration. DURABLE if the notification has a 
period for which it is active, such as a link 
failure.


FirstNotifiedAt First Notify Integer Time, in seconds, when the notification first 
became active.
Events diagnosed by an underlying domain 
include timestamps that accurately reflect when 
the event occurred. The Global Manager uses 
this value from the event for the 
FirstNotifiedAt/LastNotifiedAt times when it 
creates the notification.


Impact Impact Integer Numeric value that indicates the effect of this 
event on related elements.


InMaintenance In Maintenance Boolean Indicates if the device is in maintenance mode. 
Possible values include:
• TRUE if the device is in maintenance mode.
• FALSE if not.


InstanceDisplayName Name String Name of the instance that is displayed to the 
user.


InstanceName InstanceName String Name of the object where this notification 
occurred. This attribute, with ClassName and 
EventName, uniquely identify this notification.


IsProblem IsProblem Boolean IsProblem is defined as TRUE if (and only if) at 
least one of the types is “PROBLEM”, and none 
of the types are anything other
than “PROBLEM” or “UNKNOWN”.


Notice: Since filtering on IsRoot can result in 
transient behavior, it is recommended to filter 
on IsProblem instead.


Table 41  Notification attributes (page 2 of 3)


Attribute
Default column 
name Value type Description
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IsRoot IsRoot Boolean Indicates if the notification is an authentic 
problem. Possible values include:
• TRUE if the notification is an authentic 


problem (root cause). 
• FALSE if not.
If a given notification has no CausedBy 
relationship, it is declared to be a root event, 
and IsRoot for that notification is set to TRUE.
It is often useful to filter on IsRoot to find those 
notifications which require immediate attention.


LastChangedAt Last Change Integer Time, in seconds, when the status of the 
notification last changed.


LastClearedAt Last Clear Integer Time, in seconds, when the notification was last 
cleared.


LastNotifiedAt Last Notify Integer Time, in seconds, when the notification was last 
notified.


OccurrenceCount Count Integer Number of times the notification has occurred.


Owner Owner String Name of the person responsible for this 
notification. Value is SYSTEM when 
acknowledged by the Global Manager.


Severity Severity Integer Level of severity for this notification.
1 = CRITICAL
2 = MAJOR
3 = MINOR
4 = UNKNOWN
5 = NORMAL


Notice: Only the numbers, not the text 
descriptions, are passed by the Global Manager.


SourceDomainName Source String Name of the underlying domain that sent this 
notification. If more than one domain is listed, 
the names are separated by commas.


SourceEventType SourceEventType String Indicates the type of event from an underlying 
source or sources. Value can be one of:
• PROBLEM
• EVENT
• AGGREGATE
• UNKNOWN.
The default value is UNKNOWN. (Not to be 
confused with Event Type.)


TroubleTicketID Ticket ID String Trouble-ticket number associated with this 
notification.


UserDefined1-20 User Defined 1-20 String Twenty notification attributes can be defined by 
the user. You can set a value with a hook script 
specified in DomainType section of 
ics-default.xml file.


Table 41  Notification attributes (page 3 of 3)


Attribute
Default column 
name Value type Description
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For attributes that contain a time value, time is counted from Midnight, January 1st, 1970 
(GMT). In the Global Console, these values are converted to a date and time.
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Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character 
strings. You can use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a 
time. Basic wildcard patterns are defined in Table 42 on page 220. Characters that are not 
part of match constructs match themselves. The pattern and the incoming string must 
match completely. For example, the pattern abcd does not match the input abcde or abc. 


A compound wildcard pattern consists of one or more basic wildcard patterns separated 
by ampersand (&) or tilde (~) characters. A compound wildcard pattern is matched by 
attempting to match each of its component basic wildcard patterns against the entire 
input string. Compound wildcard patterns are listed in Table 43 on page 221.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) 
character, the compound is interpreted as if an asterisk (*) appeared at the beginning of 
the pattern. For example, the pattern ~*[0-9]* matches any string not containing any 
digits. A trailing instance of an ampersand character (&) can only match the empty string. 
A trailing instance of a tilde character (~) can be read as “except for the empty string.”


Spaces are interpreted as characters and are subject to matching even if they are adjacent 
to operators like “&”.


Table 42  Basic wildcard patterns (page 1 of 2)


Character Description


? Matches any single character. 
For example, server?.example.com matches server3.example.com and 
serverB.example.com, but not server10.example.com.


* Matches an arbitrary string of characters. The string can be empty. 
For example, server*.example.com matches server-ny.example.com and 
server.example.com (an empty match).


[set] Matches any single character that appears within [set]; or, if the first 
character of [set] is (^), any single character that is not in the set. A hyphen 
(-) within [set] indicates a range, so that [a-d] is equivalent to [abcd]. The 
character before the hyphen (-) must precede the character after it or the 
range will be empty. The character (^) in any position except the first, or a 
hyphen (-) at the first or last position, has no special meaning. 
For example, server[789-].example.com matches server7.example.com 
through server9.example.com, but not server6.example.com. It also 
matches server-.example.com.
For example, server[^12].example.com does not match 
server1.example.com or server2.example.com, but will match 
server8.example.com.
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Special characters for compound wildcard patterns are summarized in Table 43 on 
page 221.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, 
which represent nonnegative integer values. The matching characters are a 
non-empty string of digits whose value, as a nonnegative integer, is greater 
than or equal to n1 and less than or equal to n2. If either end of the range is 
omitted, no limitation is placed on the accepted number.
For example, 98.49.<1-100>.10 matches a range of IPv4 addresses from 
98.49.1.10 through 98.49.100.10. 
Example of an omitted high end of the range: <50-> matches any string of 
digits with a value greater than or equal to 50. 
Example of an omitted low end of the range: <-150> matches any value 
between zero and 150.
For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, 
with * matching no characters. Similarly, it matches strings like 9x, with * 
matching the trailing x. However, it does not match 11, because <1-10> 
always extracts the longest possible string of digits (11) and then matches 
only if the number it represents is in range.


| Matches alternatives. For example,”ab|bc|cd” without spaces matches 
exactly the three following strings:  “ab”, “bc”, and “cd”. A | as the first or 
last character of a pattern accepts an empty string as a match.
Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) 
has no special meaning within a set ([set]) or range (<n1-n2>) construct.


Table 42  Basic wildcard patterns (page 2 of 2)


Character Description


Table 43  Compound wildcard patterns


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard 
pattern is preceded by & (or is the first basic wildcard pattern in the compound 
wildcard pattern), it must successfully match. 
Example: *NY*&*Router* matches all strings which contain NY and also contain 
Router. 
Example: <1-100>&*[02468] matches even numbers between 1 and 100 
inclusive. The <1-100> component only passes numbers in the correct range and 
the *[02468] component only passes numbers that end in an even digit. 
Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also 
contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a 
component basic wildcard pattern is preceded by ~, it must not match. 
Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 
except 10.20.30.50.
Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, 
except a Cisco router, with an address on network 10.20.30, except not 
10.20.30.10 through 10.20.30.20.
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Sample XML files
This chapter describes the XML needed to create and modify repository objects such as 
notification lists, users, user profiles, tools, escalation policies, console operations, and 
map icons. The XML files are imported into the repository using the sm_config utility. 
Chapter 11, “Importing and Exporting Configurations,” provides additional information. 
You must have a strong understanding of XML if you intend to create and manage 
repository objects using XML.


Sample XML documents are provided to use as a template and can be edited to suit your 
needs. The following sample files are located in the BASEDIR/smarts/conf/ics directory:


◆ Tools: actionconfig-sample.xml


◆ Notification Lists: nlconfig-sample.xml


◆ Escalation Policy: policyconfig-sample.xml


◆ User Profile: profileconfig-sample.xml


◆ User: userconfig-sample.xml


◆ Multiple types of repository objects: ics-config-sample.xml 


◆ Map Icons: mapgif-sample.xml


The instance_maptype-sample.xml file is reserved for future use.


A useful way of viewing valid, complex XML is to export the configurations you make in the 
Global Manager Administration Console. “Exporting configurations” on page 198 
describes how to export the configuration of a Global Manager.


Structure of an XML document
The basic building blocks of an XML document are elements, attributes, and values. Tag is 
a general term that can be used for elements and attributes. A relevant sample of the 
Global Manager configuration XML DTD is provided with each of the structural 
descriptions.


Element


An element is a tag that is a container for subelements and attributes. For example, the 
nlconfig element contains defining information for the notification list you are adding or 
editing in the repository. If an element comprises any subelements, these are defined in 
parentheses after the element declaration in the DTD. For example, the notification list 
element, nlconfig, comprises a filter, column heading, and user profile as seen in this 
sample of the DTD:


<!ELEMENT  nlconfig  (filterconfig | columnheading | userprofile)*>
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Attribute declaration (attribute list)


Attribute declarations, as defined in the ATTList tag of the DTD, provide a detailed 
definition for an element. Many elements use name declarations to identify the element 
as well as enable declarations that instruct the Global Manager to create and enable the 
object in repository.


An attribute is a source of additional information about an element, used to define the 
element:


◆ The value of an attribute must match one of the values listed. Values must appear in 
parentheses and be separated by OR (|) symbols. 


◆ Attribute may be required (#REQUIRED), optional (#IMPLIED), or have a default value 
in quotes. 


◆ All attribute values must be quoted. 


The following is an example of an attribute declaration in the DTD for the notification 
(nlconfig) element:


<!ATTLIST nlconfig 
name CDATA #REQUIRED
enable (TRUE | FALSE | true | false | True | False) "true"
timestamp CDATA "0">


This indicates that the notification list element has three attributes: 


◆ Name — A character string that is required.


◆ Enable — Determines whether the repository object is enabled when it is imported. 
This attribute can take one of the values in parentheses. The default value is true.


◆ Timestamp — Character string that identifies the date and time the object was last 
modified. The 0 indicates that, by default, there is no timestamp.


Value


The value setting of the attribute declaration is paired with the declaration in name=value 
groupings. The values define the properties of the element you are adding, modifying, or 
deleting in the repository. In the following example, the notification list element is made 
up of a notification list element tag (“nlconfig”), attributes (name and enable), values 
(Hosts_and_Routers and false), and a close tag for the element (/>):


<nlconfig name="Hosts_and_Routers" enable="false"> </nlconfig>


An attribute value is either required or implied. If the value is an attribute that you must 
define such as the name of the object, this is indicated by the phrase #REQUIRED after the 
attribute in the DTD. If the value is implied, then a default value is indicated in quotes. For 
example, TRUE is the default value for the enable attribute of the actionconfig element:


<!ATTLIST actionconfig
name CDATA #REQUIRED
enable (TRUE | FALSE | true | false | True | False) "TRUE"
type ( server | client | auto ) #REQUIRED >
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Value indicators
Table 44 on page 226 lists the terms and symbols used to build the XML expressions with 
proper syntax structure.


Configuration elements
This section describes the elements of the ics-config.dtd. For each element, an 
explanation of the attributes and values is provided as defined by the DTD. An XML 
example for most elements is provided. Additional requirements and guidelines for the 
XML representations are defined in the Semantics section of each element.


ics_config 


This is the root element of any Service Assurance configuration XML document. In any XML 
document that you create for import into the Global Manager, this root element must be 
the opening and closing tag of the document. There are no attributes for the ics_config 
element. All configuration elements are contained within the ics_config element tags. 


ics_config DTD description
Within the DTD, ics_config is defined as the root element. The nlconfig, actionconfig, 
userprofileconfig, userconfig, and policyconfig elements are listed as subelements in 
parentheses:


<!ELEMENT ics_config (nlconfig | actionconfig | userprofileconfig | 
userconfig | policyconfig | consoleoperationconfig | map_gifconfig 
)*>


ics_config XML example


For example, to define a new user profile, it must be nested within the root ics_config 
element:


<ics_config> 
<userprofileconfig name="default" enable="True" timestamp="0">


<nl>Default</nl>
<user>user-default</user>
<console>NotificationLog</console>


</userprofileconfig>
</ics_config> 


Table 44  XML value indicators


Value indicator Description


CDATA Character data (CDATA) type attributes may contain only 
character data.


#PCDATA Parsed character data is text that will be examined by the 
parser for entities and proper syntax.


<element>* The asterisk (*) indicates that the content is optional (may 
occur zero or more times).


<element>? The question mark (?) after an element makes it optional, but 
only one may appear.
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Notification list (nlconfig)


This declares the notification list object and indicates that the subelements that can be 
nested are filters, column headings, and user profiles. 


nlconfig DTD description
The nlconfig element defines the notification list repository object. In the ics-config.dtd, 
the element is defined as:


<!ELEMENT nlconfig (filterconfig | columnheading | userprofile)>


 <!ATTLIST nlconfig 
name     CDATA #REQUIRED 
enable   (TRUE | FALSE | true | false | True | False)"TRUE" 
timestamp    CDATA "0" >


Table 45 on page 227 identifies the attribute declarations and possible values for the 
nlconfig element. 


nlconfig XML example


For example, a notification list named "NL1" that is enabled without a specific timestamp 
would be defined as:


<nlconfig name="NL1" enable="True" timestamp="0"> </nlconfig>


To enable multiple notification lists, add multiple nlconfig elements to the Service 
Assurance configuration XML document.


Table 45  Attribute-list declarations for the nlconfig element


XML attribute Description
Possible 
value


Value required/
default value


name A unique name for the 
notification list.


CDATA Required.


enable Indicates whether the 
notification list should be 
enabled when imported into 
the Global Manager or 
whether it was enabled at the 
time of export.


TRUE
True
true
FALSE
False
false


Not Required.
Default is “True” 
so the 
notification list is 
enabled when 
imported.


timestamp When exporting, the value is 
the last time the object was 
modified by any user through 
the Administration Console or 
through sm_config. 
When importing, the 
timestamp defined in the XML 
file is compared with the 
timestamp of the object in the 
repository. Modifications to an 
existing object will fail when 
the import timestamp is later 
than the existing repository 
timestamp (unless the force 
option is used).


CDATA Not Required.
Default is “0”.
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Filter (filterconfig)


The filterconfig element defines filter criteria that determines which notifications or 
topology elements may pass through it. The filterconfig element is a subelement to the 
following elements:


◆ nlconfig


◆ policyconfig


◆ pathconfig


◆ status_criteria (for actions)


◆ context_criteria (for actions)


filterconfig DTD description
  In the ics-config.dtd, the element is defined as:


<!ELEMENT  filterconfig (isa?, (criterion* | filename))>


This declares the filter object and indicates that the subelements that can be nested are 
isa, criterion, and filenames. 


<!ATTLIST filterconfig
type(ASL | EXPRESSION | asl | expression | Expression)  #REQUIRED 
enable (TRUE | FALSE | true | false | True | False) "TRUE">


Table 46 on page 228 identifies the attribute declarations for the filterconfig element.    


filterconfig XML example


For example, to indicate that an ASL filter called nl_notify.asl is to be utilized for a 
notification list called NL1, use the following syntax:


<nlconfig name="NL1" enable="True" timestamp="0"> 
<filterconfig type="ASL"> 


<filename>nl_notify.asl</filename>
</filterconfig>


</nlconfig>


Table 46  Attribute-list declarations for the filterconfig element


XML attribute Description Possible value


Value 
required/
default 
value


type One of two types of notification 
filters. Chapter 10, “Working 
with Filters,” describes 
expression and ASL filters.


EXPRESSION
Expression
expression
ASL 
asl 


Required.


enable Indicates whether the filter 
should be enabled when 
imported into the Global 
Manager or whether it was 
enabled at the time of export.


TRUE
True
true
FALSE
False
false


Not 
required
Default is 
"True" so 
the filter is 
enabled 
when 
imported.
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In another example, the ics-default.xml file defines a filter for the default notification list 
that allows all notifications not owned by maint or system. The XML representation of this 
is:


 <filterconfig type="EXPRESSION" enable="TRUE"> 
<criterion attribute="Owner">~maint</criterion> 
<criterion attribute="Owner">~SYSTEM</criterion> 


</filterconfig>


filterconfig semantics


You can have multiple criteria defined in a filter; these criteria are grouped by AND. If you 
have multiple filterconfig definitions, these are grouped by OR. 


filename  
This subelement is used when you are using an ASL filter.  The filename refers to the ASL 
file to be used as the filter for the notification list.  In the ics-config.dtd, the element is 
defined as: 


<!ELEMENT filename (#PCDATA)>


filename XML example


For example, to define an ASL filter using a file called nl_notify.asl, use the following 
syntax:


<filterconfig type="ASL" enable="TRUE"> 
<filename>nl_notify.asl</filename> 


</filterconfig> 


isa  
This isa element is used to define a filter for a particular ICIM class.  There are no attributes 
associated with the isa element.  In the ics-config.dtd, the element is defined as: 


<!ELEMENT isa  (#PCDATA)>


Any ICIM class name is a valid #PCDATA value for this element.


isa XML example


For example, to define an expression filter that allows all instances of the 
UnitaryComputerSystem class to pass through, use the following syntax:


<filterconfig type="Expression" enable="TRUE"> 
<isa>UnitaryComputerSystem</isa> 


</filterconfig> 


criterion  
The criterion element is used to populate an expression filter with the notification 
attributes against which the notifications or topology elements  are matched.  


The criterion element utilizes wildcards to build expressions. “Wildcard Patterns” on 
page 219 describes wildcards.
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criterion DTD description


In the ics-config.dtd, the element is defined as: 


<!ELEMENT criterion (#PCDATA)>
<!ATTLIST criterion


attribute CDATA #REQUIRED>


Table 47 on page 230 identifies the attribute declarations for the criterion element.    


criterion XML example


For example, to define an expression filter that will only pass on notifications that do not 
have an open trouble ticket ID (~*OPEN*), use the following syntax:


<filterconfig type="Expression" enable="TRUE"> 
<criterion attribute="TroubleTicketID">~*OPEN*</criterion> 


</filterconfig>


Column heading (columnheading)


The columnheading element defines the names of the columns in the notification log in 
the Global Console. 


columnheading DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT columnheading (#PCDATA)>


<!ATTLIST columnheading
column CDATA   #REQUIRED
column (String | Boolean | Time | Integer | Float | Percentage )      
"String">


Table 47  Attribute-list declarations for the criterion element


XML attribute Description Possible value


Value 
required/
default 
value


attribute Name of the notification 
attribute. Must be one of the 
attributes listed in “Attributes for 
matching notification 
properties” on page 215.


#PCDATA Required
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Table 48 on page 231 identifies the attribute declarations for the columnheading element.    


columnheading XML example


For example, this sample represents a notification list called NL1 with three columns. The 
ClassDisplayName attribute will be displayed in the NL1 Class Name column. The 
InstanceDisplayName attribute will be displayed in the NL1 Display Name column. Finally, 
the EventDisplayName attribute will be displayed in the NL1 Event Name column:


<nlconfig name="NL1" enable="True" timestamp="0"> 
<columnheading column="ClassDisplayName">NL1 Class Name


</columnheading> 
<columnheading column="InstanceDisplayName">NL1 Instance Name


</columnheading> 
<columnheading column="EventDisplayName">NL1 Event Name


</columnheading> 
</nlconfig>


Column heading values
The column headings for a notification list correspond to notification attributes. Table 49 
on page 231 describes the notification attributes, data types, and default display names 
of the column headings.


Table 48  Attribute-list declarations for the columnheading element


XML attribute Description Possible value
Value required/
default value


column The name of the notification 
attribute.


CDATA
(string?)


Required.


column The text you want to display as 
the column heading in the 
Global Console for users of this 
notification list.


String
Boolean
Time
Integer
Float
Percentage


Not required
Default is "String" so 
the column heading 
text must be defined.


Table 49  Column heading attributes and default display names


Notification attributes Data type Default column name


Name STRING InternalEventHandle


ClassName STRING ClassName


InstanceName STRING InstanceName


EventName STRING EventName


ClassDisplayName STRING Class


InstanceDisplayName STRING Name


EventDisplayName STRING Event


ElementClassName STRING Element Class


ElementName STRING Element Name


SourceDomainName STRING Source
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Tool/Action (actionconfig)


The actionconfig element identifies the tool repository object. Chapter 8, “Tool 
Configuration for the Global Manager,” describes tool configuration.


actionconfig DTD description
 In the ics-config.dtd, the element is defined as:


<!ELEMENT  actionconfig (program_name | timeout? | trace | display | 
status_criteria? | context_criteria | userprofile )*> 


<!ATTLIST actionconfig
 name  CDATA  #REQUIRED 
 enable (TRUE | FALSE | true | false | True | False)"TRUE" 
 type (SERVER | CLIENT | AUTO | server | client | auto | Server |


Client | Auto) #REQUIRED
 timestamp CDATA "0">


Active BOOLEAN Active


OccurrenceCount INTEGER Count


FirstNotifiedAt TIME First Notify


LastNotifiedAt TIME Last Notify


LastClearedAt TIME Last Clear


LastChangedAt TIME Last Change


IsRoot BOOLEAN IsRoot


Acknowledged BOOLEAN Acknowledged


Owner STRING Owner


EventType STRING Event Type


EventState STRING Event State


Category STRING Category


EventText STRING Event Text


Severity INTEGER Severity


Impact INTEGER Impact


Certainty PERCENTAGE Certainty


InMaintenance BOOLEAN In Maintenance


TroubleTicketID STRING Ticket ID


UserDefinedN STRING User Defined N


Table 49  Column heading attributes and default display names (continued)


Notification attributes Data type Default column name
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The userprofile subelement is used by the Global Console to reference the user profile in 
the display. This is not used for configuration. “User profile (userprofileconfig)” on 
page 239 describes how to configure user profiles using XML.


This declares the tool object and indicates that the allowable subelements to be nested 
are:


◆ Program Name (“program_name DTD description” on page 234 provides additional 
information)


◆ Timeout (“timeout DTD description (for actionconfig)” on page 235 provides 
additional information)


◆ Trace (“trace DTD description” on page 236 provides additional information)


◆ Display (“display DTD description” on page 235 provides additional information)


◆ Status Criteria (“status_criteria DTD description” on page 236 provides additional 
information)


◆ Context Criteria (“context_criteria DTD description” on page 237 provides additional 
information)


Table 50 on page 233 identifies the attribute declarations for the actionconfig element.   


Table 50  Attribute-list declarations for the actionconfig element (page 1 of 2)


XML 
attribute Description Possible value


Value required/
default value


name A unique name for the tool. CDATA
(string?)


Required.


enable Indicates whether the tool should 
be enabled when imported into 
the Global Manager or whether it 
was enabled at the time of export.


TRUE
True
true
FALSE
False
false


Not required
Default is True so 
the tool is enabled 
when imported.


type Indicates the classification of the 
tool:
• Server — Tools executed on the 


same host as the Global 
Manager. These are displayed 
in the Tools menu on the Global 
Console.


• Client — Tools executed locally 
by the console.  These are 
displayed in the Tools menu on 
the Global Console.


• Auto — Tools executed 
automatically through 
escalation policies or the 
automatic action adapter 
(sm_adapter). These are not 
visible in the tools menu on the 
Global Console.


SERVER
Server
server 
CLIENT 
Client
client
AUTO 
Auto
auto 


Required.
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actionconfig XML example


For example, a server tool named Action1 that is enabled, running a server type program 
called server-action.sh without a specific timestamp would be defined as:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<program_name>server-action.sh</program_name>    


</actionconfig>


Program name (program_name)


This is the name of the program that the Global Manager (for server and automatic tools) 
or the host running the Global Console (for client tools) executes when the tool is invoked. 
This subelement is implicitly required when defining an action in XML.


program_name DTD description
There are no attributes associated with the program_name element.  In the ics-config.dtd, 
the element is defined as:


<!ELEMENT program_name (#PCDATA)>


program_name XML example


For example, if the server tool called Action1 is designed to execute a program called 
server-action.sh, use the following syntax:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<program_name>server-action.sh</program_name>    


</actionconfig>


Timeout (actionconfig)


This specifies the maximum number of seconds to wait for the tool script to complete. If 
the tool script does not complete within the specified timeout interval, the Global 
Manager terminates the tool.


timestamp When exporting, the value is the 
last time the object was modified 
by any user through the Global 
Manager Administration Console 
or through sm_config. 
When importing, the timestamp 
defined in the XML file is 
compared with the timestamp of 
the object in the repository.  
Modifications to an existing object 
will fail when the import 
timestamp is later than the 
existing repository timestamp 
(unless the force option is used).


CDATA Not required
Default is "0".


Table 50  Attribute-list declarations for the actionconfig element (page 2 of 2)


XML 
attribute Description Possible value


Value required/
default value
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timeout DTD description (for actionconfig)
There are no attributes associated with the timeout element.  In the ics-config.dtd, the 
element is defined as:


<!ELEMENT timeout (#PCDATA)>


timeout XML example (for actionconfig)


For example, if the server tool called Action1 is designed to execute a program called 
server-action.sh with a timeout value of 60 seconds, then the syntax to define that would 
look like this:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<timeout>60</timeout>
<program_name>server-action.sh</program_name>   


</actionconfig>


Display (display)


This specifies whether the tool should display output to the console.  If this parameter is 
set to true, the console will open the Tool Output window immediately after running the 
tool.  If false, the console only opens the Tool Output window if there is an error.  The 
default is true.  


display DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT display EMPTY>
<!ATTLIST display


    display_value (FALSE | TRUE | true | false | True | False)"TRUE">


Table 51 on page 235 identifies the attribute declarations for the display element.    


display XML example


For example, if the server tool called "Action1" is designed to execute a program called 
"server-action.sh" with a timeout value of 60 seconds, and you want to see the display 
output, then the syntax to define that would look like this:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<timeout>60</timeout>
<program_name>server-action.sh</program_name>   
<display display_value="True" />


</actionconfig>


Table 51  Attribute-list declarations for the display element


XML attribute Description Possible value
Value required/
default value


display_value Indicates whether or not to open 
the Tool Output window when 
running the tool. If false, the Tool 
Output window will only open if an 
error occurs when the tool runs. 


TRUE
True
true
FALSE
False
false


Not required.
Default is "TRUE".
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Trace (trace)


Trace indicates that additional debugging information will be included in the display 
output of the tool.  This element is only valid if the display element is also declared. 


trace DTD description
There are no attributes associated with the trace element.  In the ics-config.dtd, the 
element is defined as:


<!ELEMENT trace EMPTY>
<!ATTLIST trace
    trace_value (FALSE | TRUE | true | false | True | False)"FALSE">


The EMPTY declaration indicates that the element has no sub-elements or character data 
associated with it. 


trace XML example


For example, to turn on the trace utility when defining an action, use the following syntax:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<timeout>60</timeout>
<program_name>server-action.sh</program_name>   
<display display_value="True" /diplay>
<trace trace_value="True"/> 


</actionconfig>


Status criteria (status_criteria)


This element determines whether a client or server tool is accessible from the popup 
menu in the Global Console. The tool is always accessible when the status_criteria 
element is omitted. This parameter is not available for automated tools. 


status_criteria DTD description
There are no attributes associated with the status_criteria element. But, there is a 
filterconfig subelement that determines which notifications utilize the tool. In the 
ics-config.dtd, the element is defined as:


<!ELEMENT status_criteria (filterconfig?)>
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status_criteria XML example


For example, there is a server tool called Action1 designed to execute a program called 
server-action.sh with a timeout value of 60 seconds, with a display output.  To set the 
status criteria to ensure that the tool only appears in the popup menu if there is an open 
trouble ticket for that notification, use the following syntax:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<timeout>60</timeout>
<program_name>server-action.sh</program_name>   
<display display_value="True" /diplay>
<status_criteria>


<filterconfig type="Expression">
<criterion attribute="TroubleTicketID">~*OPEN*</criterion>


 </filterconfig>
</status_criteria>


</actionconfig>


Context criteria (context_criteria)


This determines whether the tool appears on the tool menu in the Global Console when 
the user right-clicks on a notification. The tool automatically appears in the tool menu 
when this parameter is omitted. This parameter is not available for automated tools. 


context_criteria DTD description
There are no attributes associated with the context_criteria element. But, there is a 
filterconfig subelement that determines which notifications utilize the tool. In the 
ics-config.dtd, the element is defined as:


<!ELEMENT context_criteria (filterconfig?)>


For example, there is a server tool called Action1 that executes a program called 
server-action.sh with a timeout value of 60 seconds, with a display output.  To make sure 
that the tool is enabled in the popup menu for  Router notifications, the syntax is:


<actionconfig name="Action1" type="Server" enable="True" 
timestamp="0">
<timeout>60</timeout>
<program_name>server-action.sh</program_name>   
<display display_value="True" /diplay>
<context_criteria>


<filterconfig type="Expression">
<isa>ICIM_Notification</isa>
<criterion attribute="ClassName">Router</criterion>


</filterconfig>
</context_criteria>


</actionconfig>
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User (userconfig)


A user is an individual member of a user profile.  If no user profile is specified, then the 
users are assigned to the Default user profile.  


The userconfig element contains a subelement called userprofile. This subelement is used 
by the Global Console to reference the user profile in the display. This is not used for 
configuration. “User profile (userprofileconfig)” on page 239 describes the 
userprofileconfig element which is used to configure user profiles.


userconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  userconfig (userprofile)*>
<!ATTLIST userconfig


name CDATA    #REQUIRED 
    enable(TRUE | FALSE | true | false | True | False)"TRUE"


timestamp CDATA "0">


Table 52 on page 238 identifies the attribute declarations and possible values for the 
userconfig element.    


Table 52  Attribute-list declarations for the userconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the user. CDATA Required.


enable Indicates whether the user should 
be enabled when imported into 
the Global Manager or whether it 
was enabled at the time of export.


TRUE
True
true
FALSE
False
false


Not required.
Default is "True" so 
the notification list is 
enabled when 
imported.


timestamp When exporting, the value is the 
last time the object was modified 
by any user through the 
Administration Console or through 
sm_config.  
When importing, the timestamp 
defined in the XML file is 
compared with the timestamp of 
the object in the repository. 
Modifications to an existing object 
will fail when the import 
timestamp is later than the 
existing repository timestamp 
(unless the force option is used).


CDATA Not required.
Default is "0".
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userconfig XML example


For example, if two users called User1 and User2 are designed to be enabled with no 
specific timestamp, then the syntax to define that would look like this:


<userconfig name="User1" enable="True" timestamp="0"> </userconfig>
<userconfig name="User2" enable="True" timestamp="0"> </userconfig>


If you are creating new users, be sure they are authenticated with a username and 
password in the serverConnect.conf and clientConnect.conf files. 


User profile (userprofileconfig)


A user profile defines what a set of users can see and do when they log in to the Global 
Console. The user profile determines what notification lists, consoles, and actions a set of 
users can access. 


userprofileconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  userprofileconfig (nl | console | user | action | 
consoleoperation)*> <!ATTLIST userprofileconfig


    name CDATA #REQUIRED 
    enable(TRUE | FALSE | true | false | True | False)"TRUE"
    timestamp   CDATA          "0">


This declaration states that the userprofileconfig element has four required subelements:  
nl, console, user, and action. 

Configuration elements 239







XML Reference

Table 53 on page 240 identifies the attribute declarations and possible values for the 
userprofileconfig element.    


userprofileconfig XML example


For example, in the ics-default.xml file, the "maint-profile" user profile is defined.  It has 
the following attributes:  


◆ One notification list (Maintenance).


◆ One console (NotificationLog).


◆ One user associated with it (maint).


The maint-profile user profile also has several actions and console operations defined:


<userprofileconfig name="maint-profile" enable="True" timestamp="0"> 
<nl>Maintenance</nl> 
<console>NotificationLog</console>
<user>maint</user>
<action type="server">Sample - Telnet</action>
<action type="server">Sample - Ping-Interface</action>
<action type="server">Sample - Ping-IP</action>
.
.
.
<consoleoperation>Browse</consoleoperation>
<consoleoperation>BrowseDetail</consoleoperation>
<consoleoperation>ExpandMapNode</consoleoperation>
<consoleoperation>ShowContainment</consoleoperation>
.
.


</userprofileconfig>


Table 53  Attribute-list declarations for the userprofileconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the user profile. CDATA
(string?)


Required.


enable Indicates whether the user profile 
should be enabled when imported 
into the Global Manager or 
whether it was enabled at the time 
of export.


TRUE
True
true
FALSE
False
false


Not required.
Default is "True" so 
the notification list is 
enabled when 
imported.


timestamp When exporting, the value is the 
last time the object was modified 
by any user through the 
Administration Console or through 
sm_config.  
When importing, the timestamp 
defined in the XML file is 
compared with the timestamp of 
the object in the repository.  
Modifications to an existing object 
will fail when the import 
timestamp is later than the 
existing repository timestamp 
(unless the force option is used).


CDATA Not required.
Default is "0".
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Notification list (nl)


The nl is the name of notification list defined by the nlconfig element. “Notification list 
(nlconfig)” on page 227 provides additional information.   


nl DTD description
There are no attributes associated with the timeout element.  In the ics-config.dtd, the 
element is defined as:


<!ELEMENT nl (#PCDATA)>


nl XML example


For example, in this user profile called UserProfile1 there is a notification list called NL1:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 
<nl>NL1</nl> 
<console>Console1</console> 
<console>Console2</console> 
<user>User1</user> 
<user>User2</user> 
<user>User3</user> 
<action type="server">Action1</action> 
<action type="client">Action1</action> 


</userprofileconfig>


nl semantics


When defining a user profile, you are required to provide a notification list.  The nl 
subelement is required and only one is allowed.


Console (console)


The console element is the name of an InCharge console file (by default, the file extension 
is *.iccon and does not need to be typed in the declaration). The console files are located 
in BASEDIR/smarts/consoles or BASEDIR/smarts/local/consoles.


console DTD description
There are no attributes associated with the console element.  In the ics-config.dtd, the 
element is defined as:


<!ELEMENT console (#PCDATA)>


console XML example


For example, in this user profile called UserProfile1 there are two consoles called Console1 
and Console2:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 
<nl>NL1</nl> 
<console>Console1</console> 
<console>Console2</console> 
<user>User1</user> 
<user>User2</user> 
<user>User3</user> 
<action type="server">Action1</action> 
<action type="client">Action1</action> 


</userprofileconfig>
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console semantics


The console subelement is required and multiple consoles are allowed.


User (user)


The user element is the name of user defined by the userconfig element. “User 
(userconfig)” on page 238 provides additional information. 


user DTD description
There are no attributes associated with the user element.  In the ics-config.dtd, the 
element is defined as:


<!ELEMENT user (#PCDATA)>


user XML example


For example, in this user profile called UserProfile1 there are three users called User1, 
User2, and User3:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 
<nl>NL1</nl> 
<console>Console1</console> 
<console>Console2</console> 
<user>User1</user> 
<user>User2</user> 
<user>User3</user> 
<action type="server">Action1</action> 
<action type="client">Action1</action> 


</userprofileconfig>


user semantics


This subelement is not required but if user(s) are not defined no user will access the 
profile.


Tool/Action (action)


The action subelement refers to the name of a tool defined by the actionconfig element. 
“Tool/Action (actionconfig)” on page 232 provides additional information. In addition to 
the name of the tool, you are required to define the type of tool (server, client, or 
automatic).


action DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT action (#PCDATA)>
<!ATTLIST action
    type (SERVER | CLIENT | AUTO | server | client | auto | 


       Server | Client | Auto) #REQUIRED>
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Table 54 on page 243 identifies the attribute declarations for the actionconfig element.   


action XML example


For example, in this user profile called UserProfile there are two tools defined.  The first is 
a server tool  called Action1 and the second is a client tool called Action1:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 
<nl>NL1</nl> 
<console>Console1</console> 
<console>Console2</console> 
<user>User1</user> 
<user>User2</user> 
<user>User3</user> 
<action type="server">Action1</action> 
<action type="client">Action1</action> 


</userprofileconfig>


action semantics


If actions(s) are not defined, the user will have no tools available in the tools menu of the 
Global Console. Multiple actions may be listed. 


Console operation (consoleoperation)


The consoleoperation element is the list of console operations associated with a user 
profile.


consoleoperation DTD description
There are no attributes associated with the consoleoperation element. In the 
consoleoper-config.dtd, the element is defined as:


<!ELEMENT consoleoperation (#PCDATA)>


Table 54  Attribute-list declarations for the actionconfig element


XML attribute Description Possible value
Value required/
default value


type Indicates the classification of the 
tool:
• Server: tools executed on the 


same host as the Global 
Manager. These are displayed 
in the Tools menu on the Global 
Console.


• Client:  tools executed locally 
by the console.  These are 
displayed in the Tools menu on 
the Global Console.


• Auto: tools executed 
automatically through 
escalation policies or the 
automatic action adapter 
(sm_adapter). These are not 
visible in the tools menu on the 
Global Console.


SERVER
Server
server 
CLIENT 
Client
client
AUTO 
Auto
auto 


Required

Configuration elements 243







XML Reference

consoleoperation XML example


The following example shows the console operations associated with the training-profile 
user profile:


<userprofileconfig name="training-profile" enable="True">
  <nl>Maintenance</nl>
   <console>NotificationLog</console>
   <user>User1</user>


  <consoleoperation>Browse</consoleoperation>
  <consoleoperation>BrowseDetail</consoleoperation>
  <consoleoperation>ExpandMapNode</consoleoperation>
  <consoleoperation>ShowContainment</consoleoperation>


</userprofileconfig>


Escalation policy (policyconfig)


An Escalation Policy is composed of a policy filter and one or more escalation paths.  If a 
policy filter is not defined, all notifications will be passed on to the paths for escalation.


policyconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  policyconfig  (filterconfig | pathconfig)*> <!ATTLIST 
policyconfig
name CDATA #REQUIRED 


    timestamp   CDATA          "0"


Table 55 on page 244 identifies the attribute declarations and possible values for the 
policyconfig element.    


Table 55  Attribute-list declarations for the policyconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the escalation 
policy.


CDATA Required.


timestamp When exporting, the value is the 
last time the object was modified 
by any user through the 
Administration Console or through 
sm_config.  
When importing, the timestamp 
defined in the XML file is 
compared with the timestamp of 
the object in the repository.  
Modifications to an existing object 
will fail when the import 
timestamp is later than the 
existing repository timestamp 
(unless the force option is used).


CDATA Not required.
Default is "0".
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policyconfig XML example


This XML sample describes a policy called Policy-Host  The expression filter indicates that 
all notifications pertaining to the ICIM class of Host will be entered into the policy.


There is one escalation path defined called path1. An expression filter at the path level 
determines that only notifications with a Trouble Ticket ID are escalated. 


The escalation actions open a trouble ticket for the notification after 60 minutes, then 
follows up with an email after another 30 minutes:


<policyconfig name="Policy-Host" timestamp="0">


<filterconfig type="EXPRESSION">
<isa>ICIM_Notification</isa>
<criterion attribute="ClassName">Host</criterion>


</filterconfig>


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 
<retireTime>0</retireTime> <enableTime>0</enableTime> 
<filterconfig type="EXPRESSION"> 


<isa>ICIM_Notification</isa> 
<criterion attribute="TroubleTicketID"> </criterion> 


</filterconfig> <escalationlevel interval="1800" level="0"> 
</escalationlevel> <escalationlevel interval="900" level="1"> 
<action type="auto">Open Trouble Ticket</action> 
</escalationlevel> <escalationlevel interval="900" level="2"> 
<action type="auto">Email Manager</action> </escalationlevel> 


</pathconfig> 


</policyconfig>


Filter (filterconfig)


The filterconfig element within the policyconfig element is the filter on the entire policy.  
This filter determines which notifications enter into the policy.  


The filterconfig element within the pathconfig element is a filter on the escalation path.  
Notifications that enter the policy are filtered again to determine the path on which they 
will escalate.


“Filter (filterconfig)” on page 228 provides filter element details.
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Escalation path (pathconfig)


You may have multiple escalation paths within an escalation policy.


pathconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  pathconfig  (filterconfig | retireTime | enableTime | 
escalationlevel)*> <!ATTLIST pathconfig
name  CDATA #REQUIRED 


    enable (TRUE | FALSE | true | false | True | False)"False" 
    retire    (TRUE | FALSE | true | false | True | False)"False" >


Table 56 on page 246 identifies the attribute declarations and possible values for the 
pathconfig element.   


pathconfig XML example


For example, this XML sample defines an escalation path called “Path1:”


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 
<retireTime>0</retireTime> 
<enableTime>0</enableTime> 
<filterconfig type="EXPRESSION"> 


<isa>ICIM_Notification</isa> 
<criterion attribute="TroubleTicketID"> </criterion> 


</filterconfig> <escalationlevel interval="1800"
level="0"> 
</pathconfig>


Table 56  Attribute-list declarations for the pathconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the escalation 
path.


CDATA Required.


enable Indicates whether the escalation 
path should be enabled when 
imported into the Global Manager 
or whether it was enabled at the 
time of export.


TRUE
True
true
FALSE
False
false


Not Required.
Default is “False”.


retire Indicates whether the escalation 
path should be retired when 
imported into the Global Manager 
or whether it was retired at the 
time of export


TRUE
True
true
FALSE
False
false


Not Required.
Default is “False”.
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Retire time (retireTime)


This is the time interval, in seconds, for which an escalation path is retired. 


retireTime DTD description
There are no attributes associated with the user element. In the ics-config.dtd, the 
element is defined as:


<!ELEMENT retireTime (#PCDATA)>


retireTime XML example


For example, this XML sample defines an escalation path called Path1 with a retireTime of 
5 minutes (300 seconds): 


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 
<retireTime>300</retireTime> 
<enableTime>0</enableTime> 
<filterconfig type="EXPRESSION"> 


<isa>ICIM_Notification</isa> 
<criterion attribute="TroubleTicketID"> </criterion> 


</filterconfig> 
<escalationlevel interval="1800" level="0"> 


Enable time (enableTime)


This is the duration for an escalation path that is retired. 


enableTime DTD description
There are no attributes associated with the user element. In the ics-config.dtd, the 
element is defined as:


<!ELEMENT enableTime (#PCDATA)>


enabletime XML example


For example, this XML sample defines an escalation path called “Path1” with an enable 
interval of 15 minutes (900 seconds): 


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 
<retireTime>0</retireTime> 
<enableTime>900</enableTime> 
<filterconfig type="EXPRESSION"> 


<isa>ICIM_Notification</isa> 
<criterion attribute="TroubleTicketID"> </criterion> 


</filterconfig> 
<escalationlevel interval="1800" level="0"> 
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Escalation level (escalationlevel)


Each Escalation Level includes a set of automatic tools to invoke and a time duration 
before a notification advances to the next level. As time progresses, a notification 
escalates to different levels in the path based on the level duration, and invokes tools to 
handle the notification. 


escalationlevel DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  escalationlevel (action)*>
<!ATTLIST escalationlevel


level      CDATA    #REQUIRED  
    interval   CDATA    #REQUIRED >


Table 57 on page 248 identifies the attribute declarations and possible values for the 
escalationlevel element.    


escalationlevel XML example


For example, this sample defines two escalation levels:


◆ Level 0 will open a trouble ticket after a duration of 15 minutes (900 seconds)


◆ Level 1 will email a manager after a second duration of 15 minutes (900 seconds)


</escalationlevel> <escalationlevel interval="900" level="0"> 
<action type="auto">Open Trouble Ticket</action> 


</escalationlevel> <escalationlevel interval="900" level="1"> 
<action type="auto">Email Manager</action> 


</escalationlevel>  


escalationlevel semantics


You can specify that no tools are invoked at a level, but the duration cannot be less than 1 
minute. 


Table 57  Attribute-list declarations for the escalationlevel element


XML attribute Description Possible value
Value required/
default value


level Level indicates the order of the 
level. Levels must be consecutive 
numbers beginning with “0”.


CDATA
(0-5)


Required.


interval The duration of time the 
notification spends in a level 
before going on to next level. This 
includes the time it takes to invoke 
the action at this level.


CDATA
(in seconds)


Required.
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Map icon configuration


Custom map icons can also be configured using the XML interface. The specification for 
map icons has its own DTD, map-config.dtd, which is located in the 
BASEDIR/smarts/conf/maps directory.


The map-config.dtd defines the mapgifconfig element.


mapgifconfig element


The mapgifconfig element is the root element of the map-config.dtd. It defines the 
subelements that specify the configuration for a map icon. 


mapgifconfig DTD description
In the map-config.dtd, the element is defined as:


<!ELEMENT  map_gifconfig  (map | repos | image)*>


The map element is not currently used.


repos element


The repos element specifies a map configuration:


<!ELEMENT repos (#PCDATA)>
<!ATTLIST repos
  class  CDATA   #REQUIRED
  class (String | Boolean | Time | Integer | Float | Percentage )  


"String"
>


Table 58 on page 249 identifies the attribute declarations for the map element. 


repos XML example


The following example specifies a map icon for the DatabaseServer ICIM class:


<map_gifconfig>
    <repos class="DatabaseServer">*</repos>
    <image>DatabaseServer</image>
</map_gifconfig>


Table 58  Attribute-list declarations for the map element


XML attribute Description Possible value
Value required/
default value


class The name of the ICIM class that the 
icon will represent.


CDATA
(string)


Required.


class The instance name of the ICIM 
class. If instance name is 
specified, the image/gif will be 
applied for that particular instance, 
otherwise "*" indicates that the 
image/gif is applied to all 
instances of that class.


String
Boolean
Time
Integer
Float
Percentage


Not required.
Default is "String" 
so the column 
heading text must 
be defined.
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image element


The image element specifies the name of the icon file, it has no attributes. The icon file 
must be of GIF format. It is not necessary to specify a filename extension such as .gif. The 
icon file must be located in the BASEDIR/smarts/local/conf/icons directory.


image XML example


The following example specifies the DatabaseServer image for the specified class:


<map_gifconfig>
    <repos class="DatabaseServer">*</repos>
    <image>DatabaseServer</image>
</map_gifconfig>


Global Manager configuration DTDs 
The following DTDs identify the XML elements, attributes, and values for Global Manager 
configuration.


ics-config.dtd


The ics-config.dtd is located in the BASEDIR/smarts/conf/ics directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT ics_config (nlconfig | actionconfig | userprofileconfig | 
userconfig | policyconfig | consoleoperationconfig | 
consoleoperationgroupconfig | map_gifconfig)*>


<!ELEMENT  nlconfig  (filterconfig | columnheading | userprofile)*>
<!ATTLIST nlconfig


name CDATA #REQUIRED 
    enable(TRUE | FALSE | true | false | True | False)"TRUE" 
    timestamp   CDATA          "0"
>


<!ELEMENT columnheading (#PCDATA)>
<!ATTLIST columnheading


column CDATA   #REQUIRED
column (String | Boolean | Time | Integer | Float | Percentage )      
"String"


>
<!ELEMENT userprofile (#PCDATA)>


<!ELEMENT  userprofileconfig (nl | console | user | action | 
consoleoperation)*>


<!ATTLIST userprofileconfig
name CDATA #REQUIRED 


    enable(TRUE | FALSE | true | false | True | False)"TRUE"
    timestamp   CDATA          "0"
>


<!ELEMENT nl (#PCDATA)>
<!ELEMENT user (#PCDATA)>
<!ELEMENT action (#PCDATA)>
<!ATTLIST action
    type (SERVER | CLIENT | AUTO | server | client | auto | Server | 


Client | Auto) #REQUIRED
>
<!ELEMENT console (#PCDATA)>
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<!ELEMENT  userconfig (userprofile)*>
<!ATTLIST userconfig


name CDATA #REQUIRED 
    enable(TRUE | FALSE | true | false | True | False)"TRUE"
    timestamp   CDATA          "0"
>


<!ELEMENT  actionconfig (program_name | timeout? | trace | display | 
status_criteria? | context_criteria | user_prompts? | userprofile)*>


<!ATTLIST actionconfig
name CDATA  #REQUIRED 


    enable(TRUE | FALSE | true | false | True | False)"TRUE" 
    type(SERVER | CLIENT | AUTO | server | client | auto | Server | 


Client | Auto)#REQUIRED
    timestamp   CDATA          "0"
>


<!ELEMENT trace EMPTY>
<!ATTLIST trace
    trace_value (FALSE | TRUE | true | false | True | False)"FALSE"
>
<!ELEMENT display EMPTY>
<!ATTLIST display
    display_value (FALSE | TRUE | true | false | True | False)"TRUE"
>
<!ELEMENT program_name (#PCDATA)>
<!ELEMENT timeout (#PCDATA)>


<!-- Note: user prompts are only allowed on server-side actions -->
<!ELEMENT user_prompts (one_prompt*)>


<!ELEMENT one_prompt (#PCDATA)>
<!ATTLIST one_prompt name CDATA #REQUIRED>


<!ELEMENT status_criteria (filterconfig?)>
<!ELEMENT context_criteria (filterconfig?)>


<!ELEMENT  filterconfig (isa?, (criterion* | filename))>
<!ATTLIST filterconfig


type (ASL | EXPRESSION | asl | expression | Expression)  #REQUIRED  
    enable(TRUE | FALSE | true | false | True | False)     "TRUE"
>


<!ELEMENT isa  (#PCDATA)>
<!ELEMENT filename (#PCDATA)>
<!ELEMENT criterion (#PCDATA)>
<!ATTLIST criterion


attributeCDATA   #REQUIRED
>


<!ELEMENT  policyconfig  (filterconfig | pathconfig)*>
<!ATTLIST policyconfig


name CDATA #REQUIRED 
    timestamp   CDATA          "0"
>


<!ELEMENT  pathconfig  (filterconfig | retireTime | enableTime | 
escalationlevel)*>


<!ATTLIST pathconfig
name CDATA #REQUIRED 


    enable(TRUE | FALSE | true | false | True | False)"False" 
    retire    (TRUE | FALSE | true | false | True | False)"False" 
>


<!ELEMENT retireTime (#PCDATA)>
<!ELEMENT enableTime (#PCDATA)>
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<!ELEMENT  escalationlevel (action)*>
<!ATTLIST escalationlevel


level      CDATA    #REQUIRED  
    interval   CDATA    #REQUIRED 
>
<!ENTITY % consoleoper-config SYSTEM "consoleoper-config.dtd">
&consoleoper-config;
<!ENTITY % map-config SYSTEM "../maps/map-config.dtd">
%map-config;


consoleoper-config.dtd


The consoleoper-config.dtd is located in the BASEDIR/smarts/conf/ics directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT consoleoperation (#PCDATA)>


<!ELEMENT consoleoperationconfig (#PCDATA)>
<!ATTLIST consoleoperationconfig 
    name CDATA #REQUIRED
    enable (TRUE | FALSE | true | false | True | False) "TRUE"
    timestamp CDATA "0"
>


<!ELEMENT consoleoperationgroupconfig (consoleoperation)*>
<!ATTLIST consoleoperationgroupconfig
    name CDATA #REQUIRED
    displayname CDATA ""
    template (TRUE | FALSE | true | false | True | False) "FALSE"
    enable (TRUE | FALSE | true | false | True | False) "TRUE"    
   timestamp CDATA "0" >


map-config.dtd


The map-config.dtd is located in the BASEDIR/smarts/conf/maps directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT  map_gifconfig  (map | repos | image)*>


<!ELEMENT map (#PCDATA)>
<!ATTLIST map


class CDATA   #REQUIRED
class (String | Boolean | Time | Integer | Float | Percentage )  
"String"


>


<!ELEMENT repos (#PCDATA)>
<!ATTLIST repos


class CDATA   #REQUIRED
class (String | Boolean | Time | Integer | Float | Percentage )  
"String"


>


<!ELEMENT image (#PCDATA)>
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC representative if a product does not function properly or does not 
function as described in this document.


This document was accurate at publication time. New versions of this document might be 
released on the EMC online support website. Check the EMC online support website to 
ensure that you are using the latest version of this document.


Purpose
The EMC Smarts Business Dashboard is a web-based interface that enables customers, 
operators, and administrators to access information about the status of their managed 
infrastructure from any standard browser, from any location. This document describes 
how to configure the EMC Smarts Business Dashboard. Configuration tasks include 
configuring Tomcat Servlet Engine, saving views in the Global Console as viewlets, writing 
HTML, and configuring the interaction and operation of dashboard viewlets.


Audience
This document is intended for system or network administrators and IT managers 
responsible for the configuration and management of the EMC Smarts Business 
Dashboard. Administrators responsible for deploying web portals that incorporate 
dashboard viewlets or the web console will also find this document useful.


EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.
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EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion User Interface (CUI)


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• XML Adapter


• EMC Smarts Adapter for UIM/O


Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory.


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide

10 EMC Smarts Service Assurance Manager Dashboard Configuration Guide







Preface

These documents are updated periodically. Electronic versions of the updated manuals 
are available on the EMC online support website:
https://support.emc.com


EMC Smarts Service Assurance Manager documentation
The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.
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Conventions used in this document
EMC uses the following conventions for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Pathname conventions


Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, 


buttons, fields, and menus
• Names of resources, attributes, pools, Boolean expressions, buttons, 


DQL statements, keywords, clauses, environment variables, functions, 
and utilities


• URLs, pathnames, filenames, directory names, computer names, links, 
groups, service keys, file systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, 
options, programs, processes, services, applications, utilities, kernels, 
notifications, system calls, and man pages


Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, 


buttons, fields, and menus
• What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables


Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown 


outside of running text


Courier bold Used for specific user input, such as commands


Courier italic Used in procedures for:
• Variables on the command line
• User input variables 


< > Angle brackets enclose parameter or variable values supplied by the user 


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Graphical conventions


If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager


Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, licensing, and service, go to the EMC online support 
website (registration required) at:


https://support.emc.com


Technical support — For technical support, click Create Service Requests or Contact 
Customer Service on EMC Online Support at https://support.emc.com. To open a service 
request through EMC Online Support, you must have a valid support agreement. Contact 
your EMC Sales Representative for details about obtaining a valid support agreement or to 
answer any questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@EMC.com
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This chapter contains the following information:


◆ Overview.................................................................................................................  16
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◆ Software requirements............................................................................................  18
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Overview

Overview
The EMC® Smarts® Business Dashboard displays the results of EMC Smarts analysis in a 
flexible, web-based user interface. The EMC Smarts Business Dashboard provides the 
views from the Global Console as individual components called dashboard viewlets. A 
dashboard viewlet is implemented as a Java applet. 


You can configure the display and contents of dashboard viewlets to customize the 
presentation of EMC Smarts analysis, enabling you to deliver role-based views of the 
managed topology across all layers of your IT environment, including:


◆ Business managers can view status summaries for systems and business processes


◆ Operations staff can view real-time operational status of monitored elements and 
services


◆ Users can drill down to see the health and status of related infrastructure, 
applications, and business services


Installing the EMC Smarts Business Dashboard provides all of the components necessary 
to create, configure, and display dashboard viewlets. Chapter 3, “Examples of Dashboard 
viewlets,” includes a set of ready-to-use viewlets.


In addition, an installation of the EMC Smarts Business Dashboard includes the web 
console, which displays the Global Console within a web browser. The web console 
provides the same functions and features as the Global Console.


Architecture of Service Assurance Manager with the dashboard
While the Global Console is the primary user interface for EMC Smarts software, the EMC 
Smarts Business Dashboard provides another means of viewing and responding to the 
analysis provided by EMC Smarts Service Assurance Manager. The EMC Smarts Business 
Dashboard provides additional features:


◆ Dashboard viewlets can be displayed in any supported web browser from any 
location. The web clients do not require an installation of EMC Smarts software.


◆ Dashboard viewlets can be embedded into a web Portal, combining EMC Smarts’ 
analysis with information from other sources.


Figure 1 on page 17 illustrates how the EMC Smarts Business Dashboard integrates with 
EMC Smarts Service Assurance Manager.
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Figure 1  Architecture of Service Assurance with Business Dashboard


The following components, illustrated in Figure 1 on page 17, are related to the EMC 
Smarts Business Dashboard:


◆ Global Manager consolidates topology and event information it receives from data 
sources such as EMC Smarts Managers. The Global Manager provides this data to 
clients such as the Global Console or dashboard viewlets.


◆ EMC Smarts Business Dashboard is a collection of dashboard viewlets that are 
displayed in a web page. A viewlet can also be embedded within a web portal page or 
loaded from a dynamically generated URL.


◆ Tomcat Servlet Engine serves the JAR files that compose dashboard viewlets and the 
map layout servlet. The servlet engine is installed as a service with the EMC Smarts 
Business Dashboard. If you are already running a web server, you can use it to serve 
the necessary files to display dashboard viewlets.
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Software requirements
EMC Smarts Business Dashboard includes the necessary files and software for serving the 
files to display dashboard viewlets and the web console.


Client requirements


Users who display dashboard viewlets in a web browser, or want to use the web console, 
require the following software:


◆ One of the following web browsers:


• Internet Explorer 7.0 and 6.0 with Service Pack 1


• Firefox 1.5.x


• Browser that supports Java JRE 1.6.15 or later


Only browsers running on Linux, Solaris, and Windows operating systems are 
supported.


Use Firefox instead of Microsoft IE if you need to use an IPv6 literal address to access 
the Web Console or Business Dashboard. Microsoft Internet Explorer (IE) web browser 
running on Windows 2008 does not support IPv6 literal addresses in URLs.


◆ Java 2 Platform Standard Edition 5.0 which includes the 1.6.x web browser Plug-in


When using Internet explorer with JRE 1.6, exiting the Web Console or Business Dashboard 
by choosing File > Exit does not clear the display on the browser window. The browser 
window displays whatever was displayed in the window at the time you exited the 
application. This does not impact the functionality. Instead of exiting the browser, you can 
either:


◆ Close the Web browser


◆ Type a new URL in the Web browser


Server requirements


An installation of the EMC Smarts Business Dashboard includes the Tomcat Servlet 
Engine, which is necessary to serve the JAR files and map layout servlet. The servlet 
engine is installed as the EMC Smarts Servlet Engine service on the system where you 
install the EMC Smarts Business Dashboard.


If you wish to serve dashboard viewlets from a different web server, you must install the 
EMC Smarts Business Dashboard to obtain the necessary files. “Deploying viewlets” on 
page 24 provides a description of these files.
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Overview
The configuration tasks for EMC Smarts Business Dashboard depend on how you intend to 
deploy it. A simple deployment could use the sample viewlets as an EMC Smarts Business 
Dashboard to display information from a Global Manager. A more complicated 
deployment could involve creating new HTML pages to display Dashboard viewlets, 
configuring the display of viewlets, creating an on-demand URL addressable viewlet, or 
integrating a viewlet with a portal. 


The configuration steps necessary to provide these deployments are described in this 
chapter and involve one or more of the following tasks:


◆ Configuring the Tomcat Servlet Engine or an alternative web server


◆ Configuring user accounts on the Global Manager


◆ Creating saved viewlets with the Global Console


◆ Writing HTML to display viewlets


◆ Creating a URL-addressable viewlet


Serving Dashboard viewlets
The Servlet Tomcat Engine is installed into the BASEDIR/smarts/tomcat directory on the 
host where the EMC Smarts Business Dashboard is installed. If you intend to use Tomcat 
to serve Dashboard viewlets, you should install the EMC Smarts Business Dashboard onto 
the system from which you want to serve the relevant files. This can be a different host 
from where the Global Manager, or any other Service Assurance component is installed.


The Servlet Tomcat Engine, its directory structure, and the Tomcat configuration files are 
not developed by EMC Smarts. As such, the files under this directory, including the files 
related to the EMC Smarts Business Dashboard, are not intended to be edited using the 
sm_edit utility. Instead, open and edit any files under the BASEDIR/smarts/tomcat 
directory with a text editor.


Table 1 on page 20 lists relevant subdirectories under BASEDIR/smarts/tomcat related to 
the configuration and running of EMC Smarts Business Dashboard.


Table 1  Tomcat Servlet Engine directories


Directory Description


/conf Contains Tomcat configuration files, including 
server.xml


/webapps Contains directories and files served by Tomcat:
• /templates includes JAR files, viewlets, 


configuration files, and HTML files related to the 
samples described in Chapter 3, “Examples of 
Dashboard viewlets.”


• /webconsole includes the files for the web console.
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About the EMC Smarts Servlet Engine service


The Servlet Tomcat Engine is installed as a service named the EMC Smarts Servlet Engine. 
As a service, it starts automatically with the system and runs continuously until it is 
manually stopped. The EMC Smarts Servlet Engine serves the HTML, JAR, and map layout 
servlet for both Dashboard viewlets and the web console.


Default service parameters
The EMC Smarts Servlet Engine service is installed with the following options:


▼C:/InCharge/SAM/smarts/bin/sm_service install --force 
--startmode=runonce --description=”EMC SMARTS Servlet Engine” 


--name=”ic-business-dashboard” 
/C:/InCharge/SAM/smarts/bin/sm_tomcat --output start ▲


▼▲ indicates the command must be typed as one line.


The program used to invoke the Tomcat Servlet Engine is the sm_tomcat program. The 
sm_tomcat program is used by EMC Smarts to set the proper environment for software 
running from an EMC Smarts installation.


Starting and stopping the EMC Smarts Servlet Engine
The sm_service utility is used to start and stop services. Invoke the following commands 
from the BASEDIR/smarts/bin directory on the host where the service is running:


To stop the EMC Smarts Servlet Engine service:


./sm_service stop ic-business-dashboard


To start the EMC Smarts Servlet Engine service:


./sm_service start ic-business-dashboard


The EMC Smarts System Administration Guide provides additional information about 
services.


Verify that Tomcat is running
After the EMC Smarts Servlet Engine service is installed and started, you can verify 
whether Tomcat is running by opening the following URL in a web browser: 
http://<tomcat_host>:<port>, where <tomcat_host> is the system where the EMC Smarts 
Business Dashboard is installed and <port> is the TCP port the Tomcat Servlet Engine is 
listening on.


You can also access the Tomcat Servlet Engine documentation from the following URL: 
http://<tomcat_host>:<port>/tomcat-docs.
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Changing the port number of Tomcat
For most installations, Tomcat should not require any additional configuration. In some 
cases, however, it may be necessary to change the port number on which the Tomcat 
Servlet Engine is running.


The configuration of Tomcat is determined by the server.xml file located in the 
BASEDIR/smarts/tomcat/conf directory. By default, Tomcat is configured to use TCP port 
8080. If this port is already in use on the system where the EMC Smarts Business 
Dashboard is installed, you can configure Tomcat to use another port.


To change the port number, find the following lines in server.xml:


<Connector port="8080" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />


Change the port number to a suitable number. If Tomcat is currently running, you will need 
to restart it.


You may also need to change the shutdown server port number. Port number 8005 is the 
default port for the shutdown server. To change the shutdown server port number, find the 
following line in the server.xml:


<Server port="8005" shutdown="SHUTDOWN">


Change the port number to a suitable number.


For more information regarding Tomcat Servlet Engine, see http://tomcat.apache.org


Increasing the heap space 
You can increase the heap space for the Java Plug-in and for Java Web Start.


Increasing the Java Plug-in heap space


If the web console or viewlets run out of memory, adjust the maximum amount of heap 
space that the Java Plug-in uses for dynamic memory allocation. By specifying -Xmx256m 
as a runtime parameter, for example, you can increase the heap space allocation to 256 
MB. The number can be set larger or smaller than 256 MB, depending on the resources 
available on the client machine running the web browser.


To increase the heap space for the Java Plug-in:


1. Launch the Java Control Panel. The Sun website provides instructions 
(http://java.sun.com).


2. In the Java Control Panel, click the Java tab.


3. In the Java Runtime Environment Settings section, click the View button.


The Java Runtime Environment Settings dialog box appears.


4. In the Runtime Parameters field, type the maximum heap-space runtime parameter 
(-Xmx) and a value for the parameter. 
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For example: -Xmx330m. Figure 2 on page 23 illustrates the Java Runtime Environment 
Settings dialog box.


Figure 2  Java Runtime Environment Settings


The heap-space runtime parameter specifies heap size in megabytes, for example, 
-Xmx330m increases the heap space to 330 megabytes.


5. Click OK.


6. Click the Java Control Panel Apply button.


7. Terminate and restart any web browser running on the host machine. 


For the Java Web Start, the heap space defaults to 350 megabytes. 


Increasing Java Web Start heap space


To increase the heap space for the Java Web Start:


1. Using a text editor, open the 
BASEDIR/smarts/tomcat/webapps/webconsole/globalConsoleApp.jnlp file.


2. Locate the following line:


<j2se version="1.6.0+" max-heap-size="350M"/>


3. Change the max-heap-size variable value.


4. Save and close the file.
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Deploying viewlets


Directories under BASEDIR/smarts/tomcat/webapps contain the web applications served 
by the Tomcat Servlet Engine. For example, the sample Dashboard viewlets included with 
EMC Smarts Business Dashboard are installed to the 
BASEDIR/smarts/tomcat/webapps/templates directory. Each directory under /webapps 
must contain the JAR, HTML, and configuration files necessary for the web application to 
run.


You can choose one of the following methods to deploy Dashboard viewlets:


◆ Modify the template files under BASEDIR/smarts/tomcat/webapps/templates. You 
can also add your own new viewlet files to this directory.


◆ Create your own viewlets directory under /webapps. You must ensure that the new 
directory contains the files and directories listed in Table 2 on page 24, which can be 
copied from the templates directory. After you create the new directory and add the 
necessary files, you need to restart the EMC Smarts Servlet Engine service.


Table 2  Files used for viewlets


File or directory Description


HTML files HTML files that specify the layout of viewlets, including the JAR 
files and configuration parameters.


jcommon-0.7.0.jar
jfreechart-0.9.3.jar
masterpiece.jar
tsgdtj50.jar
tsgetj50.jar
tsglt50.jar
tsgltc50.jar
tsgmtj50.jar


JAR files necessary for displaying EMC Smarts Business 
Dashboard viewlets. All JAR files are required.


dashboard.properties [Optional] Properties file to specify parameters that apply to all 
viewlets. This file must be specified in the HTML using the 
com.smarts.propertiesFile parameter. “Specifying additional 
viewlet properties” on page 36 provides additional information 
about HTML parameters.


viewlet.properties [Optional] Property file to specify parameters for a specific 
viewlet. This file must be specified in the HTML using the 
com.smarts.viewletProperties parameter. “Specifying additional 
viewlet properties” on page 36 provides additional information 
about HTML parameters.


WEB-INF Directory indicates that Tomcat should serve the files contained 
in this directory upon request. This directory is required by 
Tomcat.
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Deploying viewlets with a third-party web server
If you deploy viewlets using a different web server, the JAR files listed in Table 2 on 
page 24 are required. The properties files are optional, but recommended as they simplify 
configuration of viewlets. Copy the necessary files listed in Table 2 on page 24 to the host 
where the web server is running.


If you intend to display Map viewlets, the web server must be capable of executing 
servlets. 


In addition, the files in Table 3 on page 25 must be installed on the server.


Figure 3 on page 26 illustrates the flow of information when using a web server other than 
the EMC Smarts Servlet Engine to serve viewlets.


Table 3  Additional files needed for third-party web server


Operating system Files needed


Windows mfc42.dll
tsj6ag50.dll
tsj6bl50.dll
tsj6cd50.dll
tsj6cl50.dll
tsj6dg50.dll
tsj6hl50.dll
tsj6ja50.dll


tsj6jx50.dll
tsj6mg50.dll
tsj6nl50.dll
tsj6ol50.dll
tsj6sl50.dll
tsj6tl50.dll
tsj6ut50.dll
tsjj6ag50.dll


tsjj6cl50.dll
tsjj6dg50.dll
tsjj6hl50.dll
tsjj6mg50.dll
tsjj6ol50.dll
tsjj6sl50.dll
tsjj6tl50.dll
tsjj6ut50.dll
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Figure 3  Architecture when using a third-party web server


To deploy the Dashboard viewlets with another web server (for example, a future version 
of Tomcat 6.x or 7.x), perform the following steps:


Version numbers and directory paths in these steps are for example only.


1. Install Tomcat 6.x or 7.x. 


2. Set JAVA_HOME. For example, JAVA_HOME=C:\Program Files\JAVA\jdk1.6.0_15. Add 
the line to the catalina.bat file in the following location:


• C:\tomcat-6.x\bin for Tomcat 6.x.


• C:\tomcat-7.x\bin for Tomcat 7.x.


3. Copy BASEDIR\smarts\tomcat\webapps\tss, \webapps\webconsole, and 
\webapps\templates to the new directory. For example, to the following location:


• C:\tomcat-6.x\webapps for Tomcat 6.x.


• C:\tomcat-7.x\webapps for Tomcat 7.x.


4. Create a "lib" folder under the following location:


• C:\tomcat-6.x\webapps\tss\WEB-INF for Tomcat 6.x.


• C:\tomcat-7.x\webapps\tss\WEB-INF for Tomcat 7.x.


and copy the JAR files from BASEDIR\smarts\tomcat\webapps\webconsole to this new 
folder. You need only copy the JAR files that begins with “tsg.”
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5. Ensure that BASEDIR\smarts\lib is in the system path (used in the PATH environment 
variable for Windows) when Tomcat is started. This directory includes libraries that the 
servlet needs. 


This only works if the web server is on the same host as the Dashboard or Global 
Console. If they are not, you must copy libraries from the BASEDIR\smarts\lib of the 
Dashboard or Global Console to the machine where the server is installed. Table 3 on 
page 25 lists these files.


6. Start the Tomcat engine using your standard web server startup command:


..\tomcat-6.x\bin\startup.bat


or


..\tomcat-7.x\bin\startup.bat


7. Close and reopen all Internet Explorer windows.


Configuring the web console, Business Dashboard, Dashboard viewlets, and Global Console to use 
a proxy server


You can configure the Business Dashboard and Dashboard viewlets to use a proxy server 
to communicate with EMC Smarts applications (for example, Availability Manager and 
Global Manager) that reside behind a firewall. Using a proxy server, the number of firewall 
ports that need to be opened is reduced to one.


Before you configure these EMC Smarts Java clients, ensure that the web server that will 
act as the proxy satisfies the requirement. “Requirement for the proxy server” on page 29 
describes these requirements.


To configure the EMC Smarts Java clients to use a proxy server, perform the following 
steps:


1. Your firewall administrator needs to open Port 80 on the firewall to enable 
communications between the client and a web server.


Through a series of requests, the client communicates with a web server and that web 
server acts as the proxy to the EMC Smarts applications.


2. Use a text editor (not sm_edit) to edit the Proxy properties described in Table 4 on 
page 28 in the appropriate properties file (where BASEDIR is 
C:\InCharge\SAM\smarts\):


• If you are using the web console (or Java Web Start), modify the 
webconsole.properties file in the 
BASEDIR/smarts/tomcat/webapps/webconsole directory.


• If you are using the Business Dashboard and viewlets, modify the 
dashboard.properties file in the
BASEDIR/smarts/tomcat/webapps/templates directory. 
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3. Use the sm_edit utility to modify the properties.conf file.


• If you are using the Global Console, modify the 
BASEDIR/smarts/conf/console/properties.conf file on the machine where the 
Global Console is running. 


The parameters com.smarts.proxyAuthString and com.smarts.proxyAdditionalHeaders are 
optional.


For com.smarts.proxyAuthString, the value depends upon the type of authentication 
scheme the web-server supports. For example, if it supports Basic Access Authentication 
Scheme, and if the Username is “User” and Password is “Password,” the value would be:


"Proxy-Authorization: basic VXNlcjpQYXNzd29yZAo=\r\n"


Then string “VXNlcjpQYXNzd29yZAo=” would be the base64 encoding of, 
“User:Password”.


For com.smarts.proxyAdditionalHeaders, the value could be any valid HTTP request like 
this, for example:


"GET http://www.example.com HTTP/1.1 \r\nHost: example.domain.com 
\r\n" 


4. Modify the proxy connection settings in Internet Explorer. (This step is not applicable 
for the Global Console.)


• Open Internet Explorer and select Tools > Internet Options. 


• In the Internet Options dialog box, select Connections.


• In the Connection tab, click the LAN Settings button.


• In the Local Area Network (LAN) Settings dialog box, in the Proxy server section, 
select the checkbox for Use a proxy server for your LAN, and specify an IP address 
for the proxy server and port number. Click OK to save your changes. 


• Click OK in the Internet Properties dialog box.


If you are using Java Web Start, it has a similar dialog box in which you can specify the 
address for the proxy server and the port number.


Table 4  Parameters for properties file


Parameter Value


com.smarts.proxyHost "<Host name where the web server is running>"


com.smarts.proxyPort <Port number of the web server>


com.smarts.proxyAuthString "<Authentication string if authentication is 
required>"


com.smarts.proxyAdditionalHeaders  "<Additional HTTP Requests if any >"
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Requirement for the proxy server
The connection time-out mechanism implemented in EMC Smarts Service Assurance 
Manager makes use of a standard TCP feature known as “urgent data” or “out of band 
data.” 


The HTTP proxy used with this code must pass the “out of band data” as is. 


The RFCs that define the correct operation of HTTP proxies require that the proxies provide 
a transparent network connection. However, they do not explicitly mention support of out 
of band data.


Because of the large number of HTTP proxy implementations in use, EMC Corporation is 
not in a position to indicate which, if any, fail to correctly pass out of band data. 


Please check if the proxy server you are considering passes out of band data. Contact 
EMC Smarts Global Services if the proxy server does not pass TCP urgent data. 


Encrypted connections
Encrypted connections between Dashboard viewlets and the Global Manager are 
configured using two environment variables:


◆ SM_OUTGOING_PROTOCOL — Controls the connections that an EMC Smarts program 
acting as a client is allowed to initiate.


◆ SM_INCOMING_PROTOCOL — Controls the connections that an EMC Smarts program 
acting as a server is allowed to accept.


The variables are set in the runcmd_env.sh file, which is located in the 
BASEDIR/smarts/local/conf directory. The variables may be set to “0” (unencrypted 
connection), “1” (encrypted connection), or “1,0” (both encrypted and unencrypted 
connections).


The default setting is to use both encrypted and unencrypted connections which means 
that the Dashboard viewlets and the Global Manager automatically negotiate the 
connection to the highest level of encryption possible. 


Encryption can be controlled by setting similar variables in the HTML code that displays 
the Dashboard viewlet. “Specifying viewlet parameters in HTML” on page 37 and “Using a 
properties file to specify viewlet parameters” on page 37 provide additional information.


For these two methods, the following variables are used:


◆ com.smarts.incoming_protocol — Controls the connections that an EMC Smarts 
program acting as a server is allowed to accept.


◆ com.smarts.outgoing_protocol — Controls the connections that an EMC Smarts 
program acting as a client is allowed to initiate.


The EMC Smarts System Administration Guide provides detailed information about 
encrypted connections.
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Using SSL (https://)
If your deployment requires the use of Secure Socket Layer (SSL), you need to perform the 
following steps before you launch the Dashboard with the https protocol:


The ssl-howto.html document in the BASEDIR/smarts/tomcat/webapps directory on your 
system provides detailed information. Or, access the document from the website: 
http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html.


1. Prepare a "self-signed" certificate.


If you do not purchase a Certificate from a Certificate Authority, you can generate a 
Certificate.


For example:


java1.5_HOME> /bin/keytool.exe -genkey -alias tomcat -keyalg  RSA - 
keystore testKeystore
Enter keystore password:  changeit
What is your first and last name?
  [Unknown]: User Name
What is the name of your organizational unit?
  [Unknown]: Engineering
What is the name of your organization?
  [Unknown]: Emc Smarts
What is the name of your City or Locality?
  [Unknown]:  White Plains
What is the name of your State or Province?
  [Unknown]: NY
What is the two-letter country code for this unit?
  [Unknown]: US
Is CN=User Name, OU=Engineering, O=Emc Smarts, L=White Plains, ST=NY, 
C=US correct?
  [no]:  yes
Enter key password for <tomcat>
        (RETURN if same as keystore password):<Return>


At this point you have a Certificate in a keystore file called testKeystore. Move the file 
into the Tomcat home directory (for Business Dashboard 9.2 on Windows, for 
example, it is: C:\InCharge\SAM\smarts\tomcat\).


2. Configure Tomcat:


a. In the Tomcat home directory, back up the conf/server.xml file. Then, edit the file.


b. Find the SSL connector element which is commented out (<!-- commented out text 
-->):


<-- Define an SSL HTTP/1.1 Connector on port 8443 
-->
<!--
<Connector port="8443" 
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" debug="0" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />
-->
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c. Uncomment the lines and edit them to include the keystore file that you created. 
The preceding will look like this:


<!-- Define an SSL HTTP/1.1 Connector on port 8443 
-->
    
<Connector port="8443" 
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
keystoreFile="C:\InCharge\SAM\smarts\tomcat\testKeystore" 
keystorePass="changeit"
acceptCount="100" debug="0" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS" />


d. Then comment out the non-SSL connector used for http, to look like this:


<!-- Define a non-SSL HTTP/1.1 Connector on the
port specified during installation  -->
<!--
<Connector port="8080" 
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443"
acceptCount="100"
debug="0" connectionTimeout="20000" 
disableUploadTimeout="true" />
--> 


e. If the com.smarts.layoutServlet property is defined, ensure that the 
dashboard.properties and webconsole.properties point to the correct URL so that 
the maps lay out properly:


com.smarts.layoutServlet="https://localhost:8443/tss/
LayoutServer"


3. Start the Tomcat engine using the following command:


./sm_service start ic-business-dashboard


4. In the URL that will launch the web application, replace: 


http://localhost:8080/ 


with: 


https://localhost:8443/ 


5. Launch the Dashboard by typing the following URL in the browser's Address field:


https://localhost:8443/templates


The system displays a Security Alert window that provides information about the 
Certificate being used. On accepting it, a Directory Listing for templates is displayed, as in 
the case of the non-SSL Dashboard.
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About user profiles and user accounts
Users who attach to a Global Manager, whether through the Global Console, the web 
console, or a web browser, must have a user account. Each user account, in turn, is 
associated with a user profile. A user profile defines the console operations a user can 
perform, the tools the user can invoke, and the notifications displayed to the user. The 
EMC Smarts Service Assurance Manager Configuration Guide provides detailed 
information about user profiles.


If a user attaches to a Global Manager using both the Global Console and a web browser, 
the same user profile can apply for both connections.


When you save a viewlet, you can save it to a user’s directory or a user profile directory. In 
both cases, the directory is located in the BASEDIR/smarts/local/consoles directory on 
the host where the Global Manager is running. Dashboard viewlets saved to a user’s 
directory are only accessible to that user. The name of a user’s directory is the same as the 
username. Dashboard viewlets saved to a user profile directory are accessible by any user 
associated with that user profile. The name of the user profile directory is the same as the 
user profile name.


You must create the user profiles and user accounts before you can save a viewlet to a 
user’s directory or a user profile.


About Dashboard viewlets
A Dashboard viewlet is a view from the Global Console that you can use as an applet. As 
such, you can use viewlets in the following ways:


◆ Create an HTML page that includes one or more viewlets to provide a customized 
display of EMC Smarts analysis. Because this view is displayed in a web browser, it is 
accessible from any host with a web browser.


◆ Provide an application that dynamically generates a URL in response to a notification 
that displays one or more viewlets in a web browser.


◆ Embed a viewlet within a web portal application to combine the information from the 
Global Manager within an existing information view.


The configuration tasks that must be completed to provide any of the above Dashboard 
viewlets are similar. After you create a viewlet for a web page, for example, you could also 
embed that same viewlet within a portal. This enables you to re-use viewlets, assigning 
them as necessary according the user’s role or informational requirements.


You can also use the Dashboard viewlets located in the 
BASEDIR/smarts/tomcat/webapps/templates directory. The HTML code for each viewlet 
has been converted to HTML that displays properly in both Netscape and Internet Explorer. 
Chapter 3, “Examples of Dashboard viewlets,” provides additional information about the 
sample viewlets. The HTML converter used to create browser-specific HTML is installed as 
part of Java 2 Platform Standard Edition 6.0.
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Global Console views that function as viewlets


The following views from the Global Console can also be displayed as viewlets:


◆ Notification Log


◆ Status Table


◆ Summary View


◆ Containment


◆ Notification Properties


You can display these console elements as viewlets by specifying their parameter name 
and any configuration parameters in the HTML code. “HTML syntax for viewlets” on 
page 35 provides additional information regarding the HTML syntax for viewlets.


Saving views as viewlets


You can configure the views listed below using the Global Console and save them as 
viewlets:


◆ Notification Log


◆ Status Tables


◆ Summary Views


Unless noted otherwise, the configuration options provided through the Global Console 
are retained in the viewlet file.


To save a view as a viewlet:


1. Configure the view using the Global Console. 


The EMC Smarts Service Assurance Manager Operator Guide provides additional 
information.


2. Select View > Save View As Viewlet to open the Save View As Viewlet dialog box. You 
need to provide the following information to save the viewlet:


• Global Manager where the Dashboard viewlet is to be saved


• Location where the Dashboard viewlet is to be saved


• Dashboard viewlet name


3. Select the Global Manager where the viewlet is to be saved. You can save the viewlet 
to any attached Global Manager.


4. Select the location on the Global Manager where the viewlet is to be saved:


• Save for User saves the viewlet into a user’s directory on the selected Global 
Manager under BASEDIR/smarts/local/consoles. The list box lists users for the 
selected Global Manager. If the user directory under 
BASEDIR/smarts/local/consoles does not exist, it is created. A viewlet saved to a 
user’s directory is only accessible to that user.
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• Save for User Profile saves the viewlet into a user profile directory on the selected 
Global Manager under BASEDIR/smarts/local/consoles. The list box lists available 
user profiles. If the user profile directory does not exist, it is created.


Any user associated with this user profile can load the viewlet, provided the 
viewlet is specified by name in the web page loaded by the user.


If a viewlet in the user’s directory has the same name as a viewlet in the user profile 
directory, the viewlet in the user’s directory takes precedence.


5. Specify a name for the viewlet. The file naming convention for saved viewlets is as 
follows:


<user_specifed_name><viewlet_type>.icsvm


where <viewlet_type> is one of the following:


• NLviewlet for a Notification Log viewlet


• STviewlet for a Status Table viewlet


• SVviewlet for a Summary View viewlet


For example, if you saved a Notification Log as a viewlet with the name CoreRouters, 
the resulting file would be named CoreRoutersNLviewlet.icsvm.


6. Click OK.


Displaying maps


Map viewlets are not the same as the maps displayed in a Global Console. Map viewlets 
do not display a topology tree from which an element can be selected. Use one of the 
following methods to display elements in a Map viewlet:


◆ Select Show Map from a menu in another viewlet


◆ Enable context sharing for the Map viewlet. “Context sharing for viewlets” on page 39 
provides additional information.


◆ Save a map, as described below, and display the map by specifying its focus.


Saving maps
The purpose of saving a map is to customize the default map that is displayed for a 
specific element. A saved map is associated with the element that is the focus of the map. 
When the focus element is selected to display in a map, the saved map is displayed for 
users with access to the saved map.


A saved map can include the following information:


◆ Adjusted scope (for example, expanded nodes)


◆ Node positions


◆ Layout type (circular, hierarchical, or manual)


◆ Filtered classes


◆ User-defined backgrounds
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To save a map, in the Map Console, select Map > Save Map. Click OK to acknowledge the 
pop-up message which displays the location of the saved map. The map is saved to the 
user’s directory under BASEDIR/smarts/local/consoles/ on the host where the Global 
Manager is running. The file extension for a saved map is “.icsvm”.


To make a saved map available to other users, you must copy the map file to the shared 
location BASEDIR/smarts/local/consoles.


The EMC Smarts Service Assurance Manager Operator Guide provides additional 
information about saved maps.


Displaying a saved map
To display a saved map, you must specify the topological instance that was the focus 
when the map was saved. Unlike a saved viewlet, it is not necessary to specify the name of 
the saved map. “Properties for map viewlets” on page 45 describes Map viewlets. 


HTML syntax for viewlets
This section describes the HTML parameters for loading and configuring Dashboard 
viewlets. Because the viewlets are Java applets, you must use the HTML tags for displaying 
applets. The tags vary with the version of HTML. 


When you create an HTML page that displays several viewlets, using HTML frames 
provides control over the layout of the viewlets. In addition, if you want to load two 
viewlets of the same type, two Notification Logs for example, each viewlet must be 
specified in a separate HTML page. Then apply Frame tags to display both Notification Log 
viewlets on the same page.


You can examine and copy the HTML of the samples in the 
BASEDIR/smarts/tomcat/webapps/templates directory. Chapter 3, “Examples of 
Dashboard viewlets,” describes the viewlets and their associated HTML files.


The HTML code in this section uses elements from the HTML 4.0 Specification.


HTML to display viewlets


Table 5 on page 36 lists the HTML tags and attributes necessary to display a Dashboard 
viewlet in a web page. Subsequent sections describe attributes that enable you to further 
configure the viewlet.


An attribute’s name and its value must be enclosed by double quotes. When an attribute 
includes a set of values, the set of values is enclosed by double quotes, as shown in the 
following example:


<APPLET TYPE="applet"
CODE="com.smarts.webapps.SmWebNotificationsApp.class"
WIDTH=”100%” HEIGHT=”100%”


ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\
jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\
tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


</APPLET>
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Specifying additional viewlet properties


You can specify additional properties in the HTML code that displays a viewlet, or in a 
properties file. These properties include parameters for the following features:


◆ Opening a saved view


◆ Enabling context sharing


◆ Setting the focus of a view 


◆ Specifying connection properties


“Additional viewlet properties” on page 38 describes each of these properties.


Table 5  HTML elements required to display a Dashboard viewlet


HTML element and 
parameters Description


<APPLET> ...
... </APPLET>


Element used to embed a Dashboard viewlet within a web page.


code Parameter that specifies the type of viewlet:
• com.smarts.webapps.SmWebNotificationsApp (Notification Log)
• com.smarts.webapps.SmWebGridApp 


(Status Table)
• com.smarts.webapps.SmWebMapApp


(Maps)
• com.smarts.webapps.SmWebSummaryApp


(Summary View)
• com.smarts.webapps.SmWebNotificationPropertiesApp


(Notification Properties)
• com.smarts.webapps.SmWebContainmentApp (Containment)


archive Parameter that lists the JAR files necessary to display the viewlet. All 
of the JAR files are necessary for each viewlet:
• jcommon-0.7.0.jar
• jfreechart-0.9.3.jar
• masterpiece.jar
• tsgdtj50.jar
• tsgetj50.jar
• tsglt50.jar
• tsgltc50.jar
• tsgmtj50.jar
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Specifying viewlet parameters in HTML
Parameters included in the HTML code that displays a viewlet are nested inside the 
<APPLET> tags and have the following syntax:


<param name=”name” value=”value”>


In the following example, the com.smarts.context.collectionEntity parameter is set to true 
to enable context listening for a Notification Log viewlet.


<APPLET TYPE="applet"
CODE="com.smarts.webapps.SmWebNotificationsApp.class"
WIDTH=”100%” HEIGHT=”100%”


ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\
jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\
tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


<PARAM NAME="com.smarts.context.collectionEntity"\
VALUE="true">


</APPLET>


Using a properties file to specify viewlet parameters
You can use a properties file to specify parameters for a Dashboard viewlet. One or more 
viewlets can reference the properties file. This simplifies configuration because you can 
change the parameters within the properties file instead of editing each HTML file.


Two parameters may be used to specify a properties file:


◆ com.smarts.propertiesFile specifies properties common to all viewlets. Such 
properties might include the location of the EMC Smarts Broker and the name of the 
Global Manager.


◆ com.smarts.viewletProperties specifies properties for a single viewlet. Such 
properties might enable context sharing or set the focus of a map viewlet.


The parameters to specify a properties file for the viewlet are nested inside the <APPLET> 
tags and have the following syntax:


<param name=”name” value=”value”>


"value" indicates the name of the file containing the properties. You can use any name for 
a properties file.


In the following example, the HTML for a Notification Log viewlet references a properties 
file named dashboard.properties:


<APPLET TYPE="applet"
CODE="com.smarts.webapps.SmWebNotificationsApp.class"
WIDTH=”100%” HEIGHT=”100%”


ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\
jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\
tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


<PARAM NAME="com.smarts.propertiesFile" \
VALUE ="dashboard.properties">


</APPLET>
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“Additional viewlet properties” on page 38 and “Encrypted connections” on page 29 
describes the dashboard properties file. The properties are assigned using the following 
syntax:


parameter_name=”value”


Quotes around the value are optional unless you need to have leading or trailing spaces 
as part of the value. 


The following properties file example sets the location of the EMC Smarts Broker and the 
name of the Global Manager:


smarts.remote.broker=host1.smarts.com:426
com.smarts.autoAttachDM=INCHARGE-SA


As a result, when a user opens the web page that displays the viewlet, the Attach dialog 
box includes the information about the Broker and Global Manager. The user simply 
provides a username and password to connect.


Additional viewlet properties


The following sections describe Dashboard viewlet properties that can be specified either 
in the HTML displaying the viewlet or in a properties file. Similar properties are grouped 
together.


Displaying analysis servers and monitoring servers
Table 6 on page 38 describes the parameter used to display both analysis servers and 
monitoring servers in the Broker dialog box.


Table 6  Parameter for displaying analysis and monitoring servers


Parameter Description


com.smarts.attachComponentServers When set to true, both analysis servers and monitoring 
servers are displayed in the Broker dialog box. 


Also, when this parameter is set to true, the functionality 
that checks for case-insensitive strings of text in domain 
names is deactivated.


Notice: This parameter can also be entered when using 
the sm_gui utility. For example, from <BASEDIR> enter: 


./sm_gui -Dcom.smarts.attachComponentServers=true 
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Displaying a saved viewlet
Table 7 on page 39 describes the parameter used to specify the name of a saved viewlet.


Tooltips are displayed only for Business Dashboard viewlets that are currently in focus. If 
you position the cursor over an item in a viewlet that is not in focus, no tooltip appears. To 
display tooltips in a viewlet other than the focused viewlet, click the second viewlet to 
cause it to gain focus.


Context sharing for viewlets
Context sharing is when the focus of one viewlet determines the content that is displayed 
in one or more viewlets on the same HTML page. A simple example illustrates how this 
might work. When instance context sharing is enabled for a Notification Log viewlet, a user 
can select a failed node in a Map viewlet and the Notification Log displays the 
notifications related to the selected map node. The EMC Smarts Service Assurance 
Manager Operator Guide provides additional information about context sharing.


Table 8 on page 39 lists the parameters related to context sharing for viewlets and 
indicates which viewlets the parameters apply to. Setting the value to “true” enables 
context sharing.


Table 7  Parameter for displaying a saved viewlet


Parameter Description


com.smarts.savedView Name of the saved view that is displayed as a viewlet. Note that it 
is not necessary to include the file extension, “.icsvm”, of the 
viewlet file.
“Saving views as viewlets” on page 33 provides additional 
information about saving a viewlet.


Table 8  Parameters for context sharing with viewlets


Parameter Description


com.smarts.context.notification When true, causes the viewlet to listen for 
notification context changes. You can set this 
parameter for the following viewlets:
• Map


com.smarts.context.instance When true, causes the viewlet to listen for 
instance context changes. You can set this 
parameter for the following viewlets:
• Map
• Notification Log
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Notification Properties viewlets always listen for notification context and Containment 
viewlets always listen for notification and instance context.


Automatic attach for viewlets 
Automatic attach (autoAttach) enables you to configure a viewlet so that a user does not 
need to provide a username or password to view information provided by the Global 
Manager. 


To make the connection to a Global Manager transparent, you must do the following:


◆ Edit two parameters in the dashboard.properties file (or in the viewlet HTML files).


◆ Configure the Dashboard credentials identifier (ID). This ID specifies the location of 
the EMC Smarts Broker, the name of the Global Manager, a username, and a 
password.


The EMC Office of Product Security deems the use of this feature (Automatic attach by 
storing credentials on disk) as an unsecure mode of operation. Storing credentials on disk 
amounts to no user authentication. As such, EMC Corporation discourages the use of this 
feature.


com.smarts.context.summary When true, causes a Notification Log viewlet to 
display the notifications graphed in the Summary 
viewlet.
• Notification Log


com.smarts.context.collectionEntity When true, causes the viewlet to display 
information related to the collection entity class. 
Collection entity classes include the following 
classes and their subclasses:
• ServiceOffering
• ServiceSubscriber
• HierarchicalGroup
• SelectiveGroup
• ApplicationGroup
You can set this parameter for the following 
viewlets:
• Notification Log
• Map
• Summary


com.smarts.launch.globalMg Name of the Global Manager for context when the 
viewlet is attached to more than one Global 
Manager.


Table 8  Parameters for context sharing with viewlets (continued)


Parameter Description
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Configure Dashboard viewlets to automatically attach to the Global 
Manager


The configuration of a Dashboard viewlet to automatically attach to a server involves 
defining two properties in the dashboard.properties file. Alternatively, the parameters can 
be defined in the HTML files used to launch the viewlets. If the properties are defined in 
the HTML files, they must be defined identically in all the viewlet HTML files. 


Table 9 on page 41 describes the parameters used to configure Dashboard viewlets to 
automatically attach to the Global Manager.


Example of modified dashboard.properties file


An example of a modified dashboard.properties file that uses the parameters described in 
Table 9 on page 41 is:


# This is a Java Properties file, for the GUI running as an Applet.


# Leading and trailing blanks are stripped from parameter values.
# If you have a property which you want to have leading or trailing 
blanks, enclose that parameter in double quotes, 
# e.g.: some.parameter="  I am a value with leading and trailing 
blanks  "


com.smarts.viewer.hideToolbarText=true
com.smarts.OemCustomization=NONE
com.smarts.securityEnabled=true
com.smarts.viewlet.authhttp=http://<tomcat_host>:8080/SMViewletAuth
/ViewletAuth.do?MASK=0
com.smarts.attach.alias=GUI_ID


In this example, the parameter, com.smarts.viewlet.authhttp, refers to the URL of the 
servlet that will retrieve the credentials (username, password, broker, and Global 
Manager) from Tomcat.


The parameter, com.smarts.attach.alias, is set to the Dashboard credentials identifier 
named, GUI_ID. To configure GUI_ID, use the Dashboard credentials administrator’s tool.


Table 9  Parameters for automatic attach with viewlets


Parameter Description


com.smarts.viewlet.authhttp The value of com.smarts.viewlet.authhttp specifies the URL of the 
servlet that will perform the lookup and retrieval of the stored 
userid and password credentials.
The syntax of this parameter is 
http://<tomcat_host>:8080/SMViewletAuth/Viewle
tAuth.do?MASK=0


If web server is configured to run over https, then the syntax to be 
used is: 
https://<tomcat_host>:8443/SMViewletAuth/Viewl
etAuth.do?MASK=0, where port 8443 is the secure port (the 
port may differ depending on how the web server is configured). 
“Using SSL (https://)” on page 30 provides additional 
information.


com.smarts.attach.alias The value of com.smarts.attach.alias is a unique identifier that 
labels the credentials to be used by the auto attach mechanism. 
This unique identifier will have to be defined in a small server 
database using the administrator Dashboard credentials tool 
provided in the distribution.
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Configuring the Dashboard credentials identifier


The administrator must define the credentials ID using the Dashboard credentials tool. To 
configure the Dashboard credentials identifier:


1. Start a web browser specifying the following URL:


http://<tomcat_host>:8080/SMViewletAuth


The Dashboard viewlet authenticator login screen appears. 


2. Type a username and password that will be used in the future to access the Dashboard 
credential tool (for example, admin, 12345). 


3. Click Submit. 


A message indicating a successful login appears.


This step assigns values to two parameters that control access to the tool: 
configuration.admin.user and configuration.admin.password. Use this username and 
password whenever you need to access this tool to edit Dashboard credential IDs.


4. Select Edit Configuration. The following text appears:


# Automatically generated configuration file
# admin credential: DO NOT EDIT 2 fields below
configuration.admin.user=admin
configuration.admin.password=12345
#[connection_alias1]
#    com.smarts.userid=admin
#    com.smarts.password=changeit
#    smarts.remote.broker=10.239.3.92:426
#    com.smarts.autoAttachDM=INCHARGE-SAM
#    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11
## end of entry connection_alias1


Table 10 on page 42 explains the parameters used in this screen.


Table 10  Parameters for automatic attach with viewlets


Parameter Description


connection_alias1 Replace this string of text with the credentials ID (for 
example, GUI_ID). You must replace this at both the 
beginning and end of the list.


com.smarts.userid Username. This name must match a record in the 
serverConnect.conf file used by the Global Manager. In 
addition, this user must have an account with the Global 
Manager.


com.smarts.password Password.
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5. Copy the text beginning with the line, #[connection_alias1], and paste it at the end of 
the file. Uncomment and edit the parameters in these lines in order to create the 
credentials ID for the autoAttach feature. For example:


[GUI_ID]
    com.smarts.userid=oper
    com.smarts.password=oper
    smarts.remote.broker=qa-fancy:426
    com.smarts.autoAttachDM=INCHARGE-SA
    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11;127.0.0.1
# end of entry GUI_ID


Observe the data entry syntax shown above. You must uncomment the lines (remove the # 
character) needed to support each credentials ID. The ID must appear in braces on the first 
line followed by each parameter on subsequent lines. The userid and password must be 
associated with a valid user profile. And the last line requires that one of the comment (#) 
characters be removed leaving a single # character preceding the "end of entry <ID>" string 
of text.


6. Click Save. 


The Show Configuration screen appears and the username and password are 
scrambled, for example:


# start of entry GUI_ID 
[GUI_ID]
# The following fields CAN NOT be modified manually
    com.smarts.userid=5f2c442449242f41
    com.smarts.password=5f2c642e4d392041
# end of fields CAN NOT be modified manually


    smarts.remote.broker=qa-fancy:426
    com.smarts.autoAttachDM=INCHARGE-SA
    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11;127.0.0.1
# end of entry GUI_ID 


7. Click Edit to return to the Edit Configuration screen.


smarts.remote.broker Location of the Broker in <host>:<port> format. For example, 
smarts-broker:426.


com.smarts.autoAttachDM Name of the Global Manager, for example INCHARGE-SA.


com.smarts.clientips Your IP for running the Dashboard applet should be 
inserted to the "com.smarts.clientips" list of the alias you 
are using for the Dashboard. For localhost, it might be 
127.0.0.1. "com.smarts.clientips" controls which host can 
run the Dashboard without the need of knowing the 
connection credentials.


Table 10  Parameters for automatic attach with viewlets


Parameter Description
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8. Click Logout to exit.


By default, the configuration file with all the obfuscated credentials is stored in the 
directory where tomcat was started. The default filename is viewletauth.conf. The 
administrator can change this behavior and specify a different location. This can be 
done by specifying the following property:


<init-param>
        <param-name>com.smarts.viewletauth.conf</param-name>


<param-value>file_path</param-value>
      </init-param>


This property should be added to the web.xml file located in folder:


<install_path>\SMViewletAuth\WEB-INF


where <install_path> refers to the path used to install the ViewAuth.war file. By default 
this location is <tomcat_installation>\webapps.


9. Start the viewlet. If properly configured, the viewlet should bypass the login dialog box 
and attach directly to the Global Manager (INCHARGE-SA). (Note, this assumes that the 
Global Manager is already running.) When values for one or more of the parameters in 
Table 10 on page 42 are not provided, the viewlet displays the login dialog box 
requesting credentials.


Recovering an administration account user ID and password


To recover an administration account user ID and password:


1. Using a text editor, open the viewletauth.conf file.


The viewletauth.conf file is located in your Service Assurance Manager installation 
where tomcat is running.


Once the viewletauth.conf file is opened, locate the following lines located near the 
beginning of the file:


# Automatically generated configuration file
# admin credential: DO NOT EDIT 2 fields below
configuration.admin.user=5f24442449242f292d5e572150283341
configuration.admin.password=5f2041214a2a2432315f5641264e4545


2. Execute the following command replacing the encoded string value with the encrypted 
(encoded) configuration.admin.user text string value:


java -cp TOMCAT_INSTALL/webapps/SMViewletAuth/WEB-INF/classes 
com.smarts.viewletauth.util.SMObfuscatorFactory -s encoded_string


Where TOMCAT_INSTALL is the path to your web applications. For example, 
InCharge/SAM/smarts/tomcat (for UNIX) and InCharge\SAM\smarts\tomcat (for 
Windows).
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3. Execute the following command replacing the encoded string value with the encrypted 
(encoded) configuration.admin.password text string value:


java -cp TOMCAT_INSTALL/webapps/SMViewletAuth/WEB-INF/classes 
com.smarts.viewletauth.util.SMObfuscatorFactory -s encoded_string


Where TOMCAT_INSTALL is the path to your web applications. For example, 
InCharge/SAM/smarts/tomcat (for UNIX) and InCharge\SAM\smarts\tomcat (for 
Windows).


Properties for map viewlets
Table 11 on page 45 describes the parameters which enable you to specify an element as 
the focus of a map viewlet and to determine what type of map is displayed. The map type 
must be relevant to the specified element.


When launching a map viewlet, you must specify the class of the element and instance 
name of the element for the map, otherwise the map will be empty. (The map viewlet does 
not include the topology browser so you cannot select an instance.) However, when the 
map is used in conjunction with other viewlets, such as the Notification Log viewlet, you 
can context share to display elements in the map. When you specify the instance in the 
URL without a map type, the console chooses a default map type for that instance.


Table 11  Parameters for map viewlets


Parameter Description


com.smarts.launch.class Name of the ICIM class of which the element 
is an instance.


com.smarts.launch.instance Display name of the elements.


com.smarts.launch.mapType Type of map that is displayed. Can include:
• Physical for Physical Connectivity
• IP for IP Connectivity
• VLAN for VLAN Connectivity
• Membership for Membership
• Business for Business Services Maps
• Application for Applications Maps


com.smarts.map.passive When true, prevents console operations 
such as Show Map from displaying in the 
Map viewlet. Instead, actions such as Show 
Map display in a new Map viewlet.


com.smarts.launch.mapHops Optional parameter that specifies how many 
hops the map should display. If a value is 
not specified, one hop is displayed. (Part of 
Launching in Context.)


com.smarts.fitInWindow Value is boolean. When true, this optional 
parameter forces the Map to fit inside the 
window no matter how large the map.


com.smarts.map.showAllBusiness Value is boolean. When true, this optional 
parameter allows all business topology to be 
seen in the map and not just the topology 
that has a direct path to the central map 
node.
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You can also use the com.smarts.launch.class and com.smarts.launch.instance 
parameters for Notification Properties and Containment viewlets.


Configuring map viewlet for dashboard


To configure map viewlets for the dashboard:


1. Open the viewlet.properties.file(com.smarts.ViewletProperties) file located under the 
<BASEDIR>/smarts/tomcat/webapps/templates.


2. Add the following lines:


com.smarts.launch.class=<class name>
com.smarts.launch.instance=<instance name>
com.smarts.launch.globalMgr=<SAM Server>
com.smarts.launch.mapType=<Type>


3. Save the file.


Enabling client tools
Client tools are programs that can be invoked by an operator using the Global Console, 
web console, or Business Dashboard. Access to client tools can be controlled by 
associating or not associating tools to user profiles. Available client tools are displayed in 
a pop-up menu when an operator right-clicks on a notification or a device. The EMC 
Smarts Service Assurance Manager Configuration Guide provides additional information 
about creating client tools.


Client tools that require the user to input values are not supported in either the web 
console or Business Dashboard.


In order for client tools to be invoked, the tool scripts must be placed in a directory 
accessible from the client machine (where the web browser is running). In an environment 
where Dashboard users share a network drive, the client tools can be placed in a directory 
on the network drive, thus avoiding the need to copy the tools onto each client machine. 

46 EMC Smarts Service Assurance Manager Dashboard Configuration Guide







Configuring the EMC Smarts Business Dashboard

To enable access to the client tools from the Business Dashboard, add the parameters 
described in Table 12 on page 47 to the appropriate properties file, for example, 
dashboard.properties.


Example


This example illustrates how to configure a tool named myClientTool.cmd where 
com.smarts.webconsole.sitemod=Z:/toolsdir. The two parameters would be set as 
follows:


com.smarts.clientToolsInApplet=true
com.smarts.webconsole.sitemod=Z:/toolsdir


The client tool must be placed in the /actions/client folder under Z:/toolsdir, for example:


Z:/toolsdir/actions/client/myClientTool.cmd


The parameter, com.smarts.webconsole.sitemod does not directly specify where the tool 
file is stored. Instead, it specifies where the /actions/client directory containing the tool 
file is stored. 


If com.smarts.webconsole.sitemod is not specified, the /client/actions folder with the 
tool must be placed under the web browser’s default directory. (For Internet Explorer, this 
may be Documents and Settings\Desktop. For Firefox, it is the Firefox installation base 
directory.) 


Table 12  Parameter to enable client tools


Parameter Description


com.smarts.clientToolsInApplet=tr
ue


When set to true, client tools are enabled in the web console 
or Business Dashboard.
If this parameter is specified, and the 
com.smarts.webconsole.sitemod parameter (see below) is 
not specified, the Dashboard client tool function gets the 
client tools from the /actions/client directory in the web 
browser’s default directory. (For IE, this may be Documents 
and Settings\Desktop. For Firefox, the Firefox installation 
base directory.) You must put a copy of the tool in this 
/actions/client path.


com.smarts.webconsole.sitemod When this parameter is configured in the 
dashboard.properties file, the Business Dashboard searches 
for client tools in the directory path(s) specified. For 
example, 
com.smarts.webconsole.sitemod=F:/webconsoleSitemod;C:
webconsoleSitemod/locl. 
If this parameter is specified, then 
com.smarts.clientToolsInApplet=true must also be specified 
to enable client tools in the web console or Business 
Dashboard.
If this parameter is not specified, but 
com.smarts.clientToolsInApplet=true is specified, then 
client tools will be accessed from a default directory (see 
above).
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Enabling the com.smarts.user.display property to pass client IP addresses to server 
scripts


To pass the client IP address instead of hostname to server scripts:


1. For web console, Java Web Start or dashboard, add the following line to the 
webconsole or dashboard properties file:


com.smarts.user.display={IP}:0.0


2. To apply this option only to the Java Web Start, add the following property to the 
globalConsoleApp.jnlp file:


<property name="com.smarts.user.display" value="{IP}:0.0"/>.


3. For the command line console (sm_gui), add the following command line option:


-D com.smarts.user.display={IP}:0.0


Verifying the configuration
If the correct masterpiece file was used and the com.smarts.user.display property was 
configured correctly, an entry similar to the following appears in the Java Console or the 
EMC Smarts console’s Java Message log:


Property com.smarts.user.display set to: 128.222.218.149:0.0 (was: {IP}:0.0)


The IP address varies depending upon your specific environment.


If the entry is not added to the logs, the configuration is not accurate.


URL-addressable viewlets
A URL-addressable viewlet is a viewlet that is displayed when a web client loads a 
particular URL. This enables you to dynamically generate a URL to display Map, 
Notification Properties, and Containment viewlets from within the context of another 
application. “Additional viewlet properties” on page 38 describes the viewlet parameters 
to configure a URL-addressable viewlet.


To specify viewlet parameters directly in a URL, use the following syntax:


http://URL?class=viewlet&parameter_name=value[&...]


The [&...] indicates you can add as many parameters and values as needed. Each 
parameter and value must be separated with an ampersand.
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Table 13 on page 49 lists values used with the class parameter typically used with 
URL-addressable viewlets and Table 14 on page 49 describes the separators used.


The following URL is an example of a URL-addressable viewlet that loads a Map viewlet 
with a specific element class and instance as the focus. It does not specify a map type. 
The example uses an HTML page included with the viewlet samples. “Example of 
URL-addressable viewlet” on page 61 provides additional information. 


▼ http://<tomcat_host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebMapApp& 
com.smarts.propertiesFile=dashboard.properties& 
com.smarts.launch.class=Router& 
com.smarts.launch.instance=lab-gw.example.com ▲


The URL has been formatted to make it readable. The symbols ▼ and ▲ indicate the URL 
should appear on one line.


The following URL, which is similar to the preceding, is an example of a URL-addressable 
viewlet that loads a Map viewlet with a specific element class and instance as the focus, 
and specifies a map type:


▼ http://<tomcat host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebMapApp& 
com.smarts.launch.mapType=IP& 
com.smarts.launch.class=Host& 
com.smarts.launch.instance=qa-fancy ▲


When necessary, use the dmctl utility to list the notifications in the Global Manager and 
select the one that you want to use for the viewlet:


./dmctl -s INCHARGE-SA getInstances ICS_Notification


Table 13  Class parameter values for URL-addressable viewlets


Parameter Dashboard viewlets


class Determines the Dashboard viewlet that is displayed:
• com.smarts.webapps.SmWebMapApp


(Maps)
• com.smarts.webapps.SmWebNotificationPropertiesApp


(Notification Properties)
• com.smarts.webapps.SmWebContainmentApp


(Containment)


Table 14  Separators used in URL-addressable viewlets


Separator Description


? Separates the filename of the HTML page specifying the JAR 
files from the parameter/value pairs.


& Separates parameter/value pairs in the URL.
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About the web console
The web console provides the same functionality as the Global Console, including the 
Topology Browser view that is not available as a viewlet. “Client requirements” on page 18 
defines the client systems requirements. 


Users can open the EMC Smarts web console after you complete the following tasks:


◆ Start the EMC Smarts Business Dashboard service


◆ Create user profiles and user accounts


The web console is installed to the BASEDIR/smarts/tomcat/webapps/webconsole 
directory. 


Attaching with the web console


Two versions of the web console are available. With both versions, the JAR files are loaded 
over the network during the initial connection but then saved to the user’s local system. 
Subsequent connections use the cached files to optimize the use of network resources.


The first version functions as a typical Java applet. The HTML and JAR files are located on 
the host where the EMC Smarts Business Dashboard is installed. When a user opens the 
web console, the JAR files are loaded over the network to the user’s web browser.


A second version of the web console uses Java Web Start. Java Web Start integrates the 
web console with the user’s desktop. This enables users to start the web console directly 
from their desktop without using a web browser. 


When opening the web console or a Dashboard viewlet, the JRE on the user’s system 
displays a security warning. Users must select Yes or Always to allow the applet to run.


Using the web console
To display the web console, open the following URL:


http://<tomcat_host>:8080/webconsole/InChargeApplet.html


When attached, the web console displays inside the web browser window. If the user 
opens additional consoles using the File > Open menu options, each new console is 
displayed in its own window. When the user exits the web browser, all web console 
windows are closed, as is the connection to the Global Manager.
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Using Java Web Start
You can also use Java Web Start for caching the applet locally for improved performance; 
the necessary applet files are not reloaded each time the applet is launched. To do so, 
point your browser at the following URL:


http://<tomcat_host>:8080/webconsole/globalConsoleCached.html


When you launch the cached applet, you are prompted to optionally add a Java Web Start 
icon on your desktop and a link in your Start menu.


If Java Web Start is not installed, you are prompted to use an automatic installer or 
directed to a Sun Microsystems web page, depending upon your operating system or 
browser.
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CHAPTER 3
Examples of Dashboard viewlets


This chapter describes the Dashboard viewlet and HTML code samples included with the 
EMC Smarts Business Dashboard and contains the following information: 


◆ About the sample viewlets ......................................................................................  54


The sample viewlets and their web pages are installed to the 
BASEDIR/smarts/tomcat/webapps/templates directory. Online information regarding the 
sample viewlets is available from 
http://<tomcat_host>:<port>/templates/DashboardIndex.html
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About the sample viewlets
Each viewlet type is specified in an HTML page, with slight variations specified in separate 
HTML pages. Each sample combines several viewlets, which are displayed in a single 
HTML page through the use of HTML frames. 


To ensure that the HTML pages that specify a viewlet display properly on all supported 
platforms and web browsers, EMC Corporation has processed the HTML pages using Java 
Plug-in HTML Converter. The Java Plug-in Converter converts an HTML page that specifies 
Java applet to a form that can be processed by a web browser using the Java Plug-in.


Because the converted HTML files are not easily read, both the original HTML file and the 
converted files are included. For example, the original file for the Notification Log viewlets 
is named NotificationsAppOrig.html. The converted files, which are used to display the 
viewlet, have names such as NotificationsApp1.html.


To view the samples in a web browser, the EMC Smarts Servlet Engine must be installed 
and running. You can open the following URL in your web browser, appending the filename 
specified for each sample. For example, if the EMC Smarts Servlet Engine is running on 
host1, you can view sample 1, by opening the following URL:


http://<tomcat_host>:<port>/templates/sample1.html


In addition, you also can find all the sample viewlets in 
BASEDIR\smarts\tomcat\webapps\templates\


Index to the sample Dashboard viewlets
The best way to view the samples is to open the following HTML page in your web browser:


BASEDIR\smarts\tomcat\webapps\templates\DashboardIndex.html 


This page provides an index listing of all the sample viewlets and a ReadMe.html with 
hyperlinks to each. 
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Sample 1


You can view the first sample by opening sample1.html in your web browser. This sample 
includes the viewlets described in Table 15 on page 55. The layout of this sample includes 
a Notification Log in the top frame row and a Summary and Status Table in the bottom 
frame row.


Table 15  Viewlets of Sample1.html


Frame page Viewlet pages Viewlet Additional parameters


sample1.html NotificationsApp1.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.collectionEntity has a a 
value of true. This indicates that the 
Notification Log viewlet will display 
notifications related to elements selected in 
the Status Table. “Context sharing for 
viewlets” on page 39 provides additional 
information about context sharing.


SummaryApp1.html Summary View • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information about properties files.


StatusTableAppAll.html Status Table • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information on properties files. 

About the sample viewlets 55







Examples of Dashboard viewlets

Sample 2


You can view the second sample by opening sample2.html in your web browser. This 
sample includes the viewlets described in Table 16 on page 56. The layout of this sample 
includes a Status Table and Map in the top frame row and a Notification Log in the bottom 
frame row.


Table 16  Viewlets of Sample2.html


Frame page Viewlet pages Viewlet Additional parameters


sample2.html StatusTableAppAll.html Status Table • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


MapApp2a.html Map • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.collectionEntity has a a 
value of true. This indicates that the Map 
viewlet will display the elements selected in 
the Status Table. “Context sharing for 
viewlets” on page 39 provides additional 
information.


NotificationsApp2a.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.collectionEntity has a a 
value of true. This indicates that the 
Notification Log viewlet will display 
notifications for elements selected in the 
Status Table. “Context sharing for 
viewlets” on page 39 provides additional 
information.


• com.smarts.context.instance has a a value of 
true. This indicates that the Notification Log 
viewlet will display notifications for elements 
selected from the Map. “Context sharing 
for viewlets” on page 39 provides 
additional information.
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Sample 3


You can view the third sample by opening sample3.html in your web browser. This sample 
includes the viewlets described in Table 17 on page 57. The layout of this sample includes 
a Map in the top frame row and a Notifications Log and Containment viewlet in the bottom 
frame row.


Table 17  Viewlets of Sample3.html


Frame page Viewlet pages Viewlet Additional parameters


sample3.html MapApp3a.html Map • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.notification has a a 
value of true. This indicates that the Map 
viewlet will display the elements related to 
notifications selected in the Notification Log. 
“Context sharing for viewlets” on 
page 39 provides additional information.


NotificationsAppAll.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


ContainmentAppAll.html Containment • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.
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Sample 4


You can view the fourth sample by opening sample4.html in your web browser. This 
sample includes the viewlets described in Table 18 on page 58. The layout of this sample 
includes a Notifications Log in the top frame row, a Summary and Notification Properties 
viewlets in the middle frame row, and a map in the bottom frame row.


Table 18  Viewlets in sample4.html


Frame page Viewlet pages Viewlet Additional parameters


sample4.html NotifcationsApp4.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file.“Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.summary has a a value 
of true. This indicates that the Notification 
Log viewlet will display the notifications 
graphed by the selected Summary. “Context 
sharing for viewlets” on page 39 provides 
additional information.


SummaryAppAll.html Summary • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


NotificationPropertiesAppAll.
html


Notification 
Properties


• com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


MapApp4a.html Map • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.notification has a a 
value of true. This indicates that the Map 
viewlet will display the elements related to 
notifications selected in the Notification Log. 
“Context sharing for viewlets” on 
page 39 provides additional information.
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Sample 5


You can view the fifth sample by opening sample5.html in your web browser. This sample 
includes the viewlets described in Table 19 on page 59. The layout of this sample includes 
a Notification Log in the top frame row, a Summary and a map in the middle frame row, 
and a second Notification Log in the bottom frame row.


Table 19  Viewlets in Sample5.html


Frame page Viewlet pages Viewlet Additional parameters


sample5.html NotificationsAppAll.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


SummaryAppAll.html Summary • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


MapApp5a.html Map • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.notification has a a 
value of true. This indicates that the Map 
viewlet will display the elements related to 
notifications selected in the Notification Log. 
“Context sharing for viewlets” on 
page 39 provides additional information.


NotificationsApp5.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.summary has a a value 
of true. This indicates that the Notification 
Log viewlet will display the notifications 
graphed by the selected Summary. “Context 
sharing for viewlets” on page 39 provides 
additional information.
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Sample 6


You can view the sixth sample by opening sample6.html in your web browser. This sample 
includes the viewlets described in Table 20 on page 60. The layout of this sample includes 
a Status Table and Summary in the first row, a Notification Log in the second row, and a 
second Summary in the bottom row.


One notable difference between this sample and the previous samples is that 
sample6.html uses HTML TABLE tags in conjunction with IFRAME tags to position viewlets. 
An advantage of IFRAME tags is that the viewlets within the tags remain at their specified 
size. As the web browser window is resized, the viewlets within the table do not resize. 
When the browser window is made smaller than the specified size of a viewlet, scroll bars 
are displayed within the IFRAME.


Table 20  Viewlets of Sample6.html


IFrame page Viewlet pages Viewlet Additional parameters


sample6.html StatusTableAppAll.html Status Table • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


SummaryApp6.html Summary • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.collectionEntity has a a 
value of true. This indicates that the 
Summary viewlet will display a summary 
based on selections in the Status Table. 
“Context sharing for viewlets” on 
page 39 provides additional information.


NotificationsApp6.html Notification Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.


• com.smarts.context.collectionEntity has a a 
value of true. This indicates that the 
Notification Log viewlet will display 
notifications for elements selected in the 
Status Table. “Context sharing for 
viewlets” on page 39 provides additional 
information.


SummaryAppAll.html Summary Log • com.smarts.propertiesFile includes the 
parameters specified in the 
dashboard.properties file. “Using a 
properties file to specify viewlet 
parameters” on page 37 provides 
additional information.
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Example of URL-addressable viewlet


A URL-addressable viewlet is a viewlet that is displayed when a web client loads a 
particular URL. This enables you to dynamically generate a URL that displays the Map, 
Notification Properties, or Containment viewlets.


The base URL for displaying a viewlet is: 
http://<tomcat_host>:<port>/templates/context.html


This sample uses context.html as the base URL to load the JAR files necessary to display 
one of these three viewlets. At a minimum you must specify the type of viewlet to display. 


Opening this page without specifying a viewlet displays a blank page.


“Additional viewlet properties” on page 38 describes parameters and separators you can 
add to the base URL. “URL-addressable viewlets” on page 48 provides additional 
information on the syntax of URL-addressable viewlets.


The following URL is an example of a URL-addressable viewlet that loads a map viewlet 
with a specific element class and instance as the focus. It does not specify a map type:


▼http://<tomcat_host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebMapApp& 
com.smarts.propertiesFile=dashboard.properties& 
com.smarts.launch.class=Router& 
com.smarts.launch.instance=lab-gw.example.com ▲


As with all examples in the section, this URL has been formatted to make it readable. The 
symbols ▼ and ▲ indicate the URL should appear on one line.


The following URL, which is similar to the preceding, provides an example of a 
URL-addressable viewlet that loads a Map viewlet with a specific element class and 
instance as the focus, and specifies a map type:


▼http://<tomcat host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebMapApp& 
com.smarts.launch.mapType=IP& 
com.smarts.launch.class=Host& 
com.smarts.launch.instance=qa-fancy ▲ 


The following URL provides an example of a URL-addressable viewlet that loads a 
Notification Properties viewlet. In the example, the class (optional) is ICS_Notification, 
and the instance is the name of the notification.


▼http://<tomcat host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebNotificationPropertiesApp& 
com.smarts.launch.class=ICS_Notification& 
com.smarts.launch.instance=NOTIFICATION-Router_qa-mplspe4.example.com_


Unresponsive ▲
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The following URL provides an example of a URL-addressable viewlet that loads a 
Containment viewlet. The parameters for the Containment viewlet are the same as for a 
map: the class of the element and the instance name of the element.


▼http://<tomcat host>:8080/templates/context.html? 
class=com.smarts.webapps.SmWebContainmentApp& 
com.smarts.launch.class=Router& 
com.smarts.launch.instance=qa-mplspe4.example.com ▲
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CHAPTER 4
Troubleshooting


This chapter includes information for troubleshooting the EMC Smarts Business 
Dashboard and contains the following information: 


◆ Troubleshooting overview .......................................................................................  64
◆ Debugging the web console ....................................................................................  65
◆ Sun Java Console (Plug-in message log) ..................................................................  68
◆ Log file location ......................................................................................................  69
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Troubleshooting overview


The information contained in this chapter should be checked against your installation 
before problems arise. Contact EMC Smarts support if it becomes necessary to clarify or 
resolve any questions or issues.


When troubleshooting reasons why the web console stops responding, the following files 
and parameters are reviewed:


◆ Required files


When troubleshooting issues, EMC always asks for the following files:


• rps files


• Service Assurance Manager server log files


• tomcat log files


• sm_monitor log files


• Console log files


• ics.conf files


The console log files include the EMC Smarts Java Message log file, the Sun Java 
Plug-in Console log file, and the EMC Smarts server messages received log file. By 
reviewing the console log files, EMC can clearly determine if the console stopped 
responding because the system ran out of memory, or if the issue was the result of 
some other error. Using the server log file, EMC can review what occurred at the time 
the console stopped responding; for example, was the server busy or was there some 
other exception.


From prior experience, a web console or global console stops responding as a result of 
the machine running out of memory. 


◆ Debugging parameters


To have debugging information entered in the log files, you must have the console 
debugging parameters set by default, before you use the console and the console 
stops responding. You need to verify that the debugging information is being entered 
into the log files before there is a problem. Having the debugging parameters set 
ensures that no critical information is lost.


◆ Primary Java log file


The primary Java log file is the key tool used in diagnosing issues. This file gets 
overwritten at each startup time and is the file that saves the contents of the Console 
Java Log. Enable this file by typing the following command: 


-Dcom.smarts.java.log=<filename>


This file must be saved before the console is restarted.
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◆ Asynchronous message log file


This log file is controlled by versioning. This file can get very large if the server is 
processing numerous notifications. Enable the asynchronous message log file by 
typing the following command:


Dcom.smarts.server.logMessages=true


Debugging the web console
Table 21 on page 65 defines the parameters used to capture information when a web 
console stops responding. 


The parameters are configured in the Java Plug-in Control Panel.


Table 21  Web console debugging parameters


Parameter Description


-Xmx350m -Dsun.net.inetaddr.ttl=0 This parameter gets around the broker failover 
cache problem.


-Dcom.smarts.server.logMessages=true This parameter logs all the asynchronous 
messages that the server sends to the console, 
primarily, notification adds/changes/deletes.


-Dcom.smarts.java.log=<name>-webconsole.log This parameter saves the EMC Smarts Java 
Message Log content. This content is lost when 
the console stops responding. This log file must 
be copied and saved before restarting the web 
console. Content included in this log file could 
provide information on why the console 
stopped responding. 


Notice: Restarting the web console overwrites 
this file.


-Dcom.smarts.log.level=TRACE This parameter results in maximum information 
being entered in the Java Message Log.


Heap size EMC has tested a heap size of 350 M
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Configuring the log file directories


You can set up the log file directories for the com.smarts.server.logMessages and 
com.smarts.java.log files when the EMC Smarts graphical user interface (GUI) is running 
as a web console in Internet Explorer.


The parameters can be enabled if they are set in the Java Control Panel in the Windows 
workstations. To display the Java Control Panel, click Settings > Control Panel > Java. 


The Java Control Panel appears as illustrated in Figure 4 on page 66.


Figure 4  Java Control Panel


Internet Explorer defaults the console’s com.smarts.writeable parameter to the Windows 
desktop location where log files are written. You can verify this in the Sun Java Console 
window (not the EMC Smarts Java Log file).


To verify that the com.smarts.writeable parameter is configured correctly:


From Internet Explorer, click Tools > Sun Java Console. 


The Java Console appears. An example of the type of information available from the Sun 
Java Console is:


Java Plug-in 1.6.0_15
Using JRE version 1.6.0_15 Java HotSpot(TM) Client VM
User home directory = C:\Documents and Settings\bm1.SMARTS 


----------------------------------------------------
c: clear console window
f: finalize objects on finalization queue
g: garbage collect
h: display this help message
l: dump classloader list
m: print memory usage
o: trigger logging
p: reload proxy configuration
q: hide console
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r: reload policy configuration
s: dump system and deployment properties
t: dump thread list
v: dump thread stack
x: clear classloader cache
0-5: set trace level to <n>
---------------------------------------------------- 
Properties: com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable 


not found.
Defaulting com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable 


paths to: C:\Documents and Settings\bm1.SMARTS\Desktop 
The Properties line defines the location of the com.smarts.writable path. In this example, 
the path has been defaulted to the desktop and the user ID has been defined by default as 
the user ID for the specific Windows workstation (in the example, the user ID is: 
bm1.SMARTS).


Configuring the log files


To retrieve the log files when running the web console: 


1. Verify that the log files have been configured. 


“Configuring the log file directories” on page 66 provides additional information. 


2. Create a new folder labeled “logs” on the workstation's desktop.


Use Windows Explorer or a command prompt to go to the directory specified in the 
Java Console message and create the new folder. For example, the path for the folder 
could be C:\Documents and Settings\bm1.SMARTS\Desktop\logs. 


3. Click Settings > Control Panel > Java. 


The Java Control Panel appears.


4. Click Advanced and add a new Java Runtime Parameter. (For Java 1.5 or later, click the 
Java tab and then click the View button to display the Java Runtime Settings window.) 
An example of the settings is:


-Dcom.smarts.server.logMessages=true 
-Dcom.smarts.java.log=ZZZZ 
-Dcom.smarts.log.level=TRACE


5. Edit the -Dcom.smarts.java.log=ZZZZ to the name of your java log file. 


This log file does not get appended with versions. It needs to be saved before 
restarting the console. If the file is not saved before starting the console, the contents 
of the file are overwritten. 


After configuring the java log file location, when you run Internet Explorer, the log of server 
message log file and the java log file are written into the desktop's logs directory. The java 
log file lists trace level messages. 


Because the parameter was updated in the client’s Java Plug-in, you do not need to restart 
the tomcat application.
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You need to configure the log files location before a console stops responding so that 
information about the console not responding can be retrieved. EMC suggests verifying 
that the two debugging files (webconsole.log and server_Mesg_<userid>.log) get written to 
the logs directory. 


Sun Java Console (Plug-in message log)
When the EMC Smarts GUI is run as a web console, important debugging information is 
written to the Sun Java Plug-in Console. When the EMC Smarts GUI stops responding but 
Internet Explorer continues to run (for example, if the web browser window goes blank), it 
is helpful to capture the contents of the Sun Java Plug-in console.


To enable the Sun Java Plug-in Console


To enable the Sun Java Plug-in Console:


1. From Settings, click Control Panel.


The Control Panel appears.


2. Double-click Java. 


The Java Control Panel appears.


3. Click Advanced.


4. Expand the Java console option.


5. Click the Show Console option.


By default, the Sun Java Plug-in Console displays as a window (typically in the 
upper-left corner of the screen) in Internet Explorer. You can also display the Sun Java 
Console by clicking the Internet Explorer’s Tools menu and selecting the Sun Java 
Console. 


Capturing the Sun Java Plug-in Console content


To capture the Sun Java Plug-in Console content:


1. From the Java Console, click Copy.


The content displayed in the Sun Java Console is copied to the clipboard. 


2. Open a new file in a text editor and paste the clipboard contents into the new file. 


3. Save the file and send the file to EMC along with other debugging information.  


If you are reporting web console problems that did not cause the web console to stop 
responding, you should also copy, save, and send this log file.
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Log file location
Table 22 on page 69 defines the log file locations.


Table 22  Log file location


The Is located in the


rps file <BASEDIR>/smarts/local/repos/icf directory.


Notice: Run dmctl -s NA-SAM-PRES and invoke the 
ICF_PersistenceManager::ICF-PersistenceManager. Save this 
information before sending the rps file to ensure all notifications 
are saved to the rps. 


SAM server log <BASEDIR>/smarts/local/logs directory.


sm_monitor 
logs


<BASEDIR>/smarts/local/logs/SM_Monitor directory.


Tomcat logs <BASEDIR>/smarts/jakarta-tomcat-5.0.16/logs directory from 
where tomcat started.


ics.conf file <BASEDIR>/smarts/local/conf/ics directory. 


Console logs C:\Documents and Settings\<username>.SMARTS\Desktop\logs 
directory.
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Overview
Use this article to help you find solutions to issues you may have with SAM, the EMC M&R
platform, and the SolutionPack for Smarts.


Log files
Log files help you diagnose issues that you may have with SAM, the EMC M&R platform,
and the SolutionPack for EMC Smarts.


SAM log files
The SAM log file names may differ depending on the domain name. You can find these
log files in SAM/smarts/local/logs.


brstart_en_US_UTF-8.log


Created by the Smarts broker.


emc-alerts-es.log


Created by the elasticsearch service. The Notifications cache uses elasticsearch to
store and index its notifications to be served by the Alerts EDAA.


INCHARGE-SA-PRES.audit


The SAM audit log.


INCHARGE-SA-PRES_en_US_UTF-8.log


The SAM server log. In this case, the log's name represents the INCHARGE-SA-PRES
domain.


rabbit@<HOSTNAME>.log


Created by the RabbitMQ service. The Notification cache uses the RabbitMQ service
to transfer notifications from SAM to the Notification cache. This log file name
depends on the host name of the SAM installation.


setup_elasticsearch.log


Created the first time you run the elasticsearch service. This service must be primed
the first time it is run, and this log records the setup results.


setup_rabbitmq.log


Created the first time that you run the RabbitMQ service. This service must be primed
the first time it is run, and this log records the setup results.


sm_serviced_en_US_UTF-8.log


Created by the sm_serviced daemon process that is responsible for running the
registered Smarts services.


Tomcat log files
These log files are generated by Tomcat and any web applications running within Tomcat.
You can find these log files in SAM/smarts/local/logs/tomcat.


alerts-edaa.log


Created by the Alerts EDAA web application. This web application exposes
notifications in the Notification cache.
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alerts-ingestion.log


Created by the alerts-ingestion web application. This web application populates
notifications in to the Notification cache that come from SAM via RabbitMQ.


catalina.<date>.log


The Tomcat engine writes log messages pertaining to Tomcat.


catalina.out


Logs the code output running under Tomcat. This output is also written to
System.out or System.err.


localhost.<date>.log


Logs information about the virtual host within Tomcat. Always check this log if you
cannot find an error in catalina.out or if something is seriously wrong.


localhost_access_log.<date>.txt


Logs the calls being made to the Tomcat server.


smarts-edaa.log


Created by the smarts-edaa web application. This web application exposes the
topology from one or more domain managers in a RESTful feed.


Status checks on services
You can verify that the services are running and performing their required tasks.


Perform status checks on services by following these procedures:


l Checking elasticsearch on page 3


l Checking the notifications exchange on page 4


l Checking the RabbitMQ configuration on page 4


l Checking Alerts EDAA on page 5


l Checking Smarts EDAA on page 5


Checking elasticsearch
The elasticsearch service, a component of the Notifications cache, is only accessible from
the local machine. Verify this service is running and serving requests.


Procedure


1. Verify elasticsearch is running by typing $ smarts/bin/sm_service show.


The expected result is: RUNNING smarts-elasticsearch


2. Verify elasticsearch is serving requests from a browser on the same machine on
Windows or using a tool like curl on Linux.


Browser example:


http://localhost:9200/_status


A page specific to the browser appears.


Linux examples:


curl -XGET http://localhost:9200/_status
curl http://localhost:9200/smarts/alert/_count
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A JSON page appears indicating success and showing Smarts as one of the indices.
For example:


"_shards":{"total":10,"successful":5,"failed":0}
.
.
.
"indices":{"smarts":...


3. If the Smarts index does not exist, the setup script has failed. Check the
setup_elasticsearch.log file. Note that after you first start elasticsearch, it
may take a few minutes before the setup script begins running.


Checking the notifications exchange
The RabbitMQ service exchanges notifications from SAM to the Notification cache. This
service is running by default and is a password-protected web-based management
interface running on port 15672.


Procedure


1. Verify RabbitMQ is running: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


The main page shows various statistics and status information for RabbitMQ.


Checking the RabbitMQ configuration
Follow these steps to check if the RabbitMQ service was properly configured.


When you start the sm_rabbitmq script, it verifies the RabbitMQ configuration and
creates the required exchanges, queues, users, and priming message in qnameq if they
do not exist. If this script fails, check the local/logs/setup_rabbitmq.log file.


Procedure


1. Log in to the RabbitMQ interface: http://<HOSTNAME>:15672/
2. Type the credentials for the RabbitMQ interface. The default values are admin for the


user and changeme for the password.


3. Verify these exchanges are under the Exchanges tab:


l emc.smarts.notifications (of type topic)


l emc.smarts.notifications.ingestion (of type x-consistent-hash)


4. Verify these queues are under the Queues tab:


l emc.smarts.notifications.q1, the main queue for holding notifications
for ingestion


l emc.smarts.notifications.qnameq
If a high number of messages appear under emc.smarts.notifications.q1,
ingestion is either backlogged or has stopped.


One message should appear under emc.smarts.notifications.qnameq.


5. Verify these users are defined under the Admin tab, and have access to the
emc.smarts.notifications vhost:
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l admin (with the administrator tag)


l ingestion


l publisher


Checking Tomcat
Verify Tomcat is running and serving requests.


Procedure


1. Verify Tomcat is running by typing $ bin/sm_service show.


The expected result is: RUNNING smarts-tomcat


2. Verify Tomcat is serving requests from a browser: http://<HOSTNAME>:8080/


A welcome page for Tomcat Version 8.x appears.


Checking Alerts EDAA
Verify the Alerts EDAA, a component of the Notification cache, is running and connected
to elasticsearch.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 5.


2. Verify alerts_edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa?
alt=json&pretty=true


3. Make sure there is an entry for alerts on the page.


4. Check that the cache is connected to the elasticsearch service and has the expected
notifications.


For example:


http://itops-qa-192.lss.emc.com:8080/alerts-edaa/msa/alerts/
instances?alt=json&pretty=true


Checking Smarts EDAA
Verify the Smarts EDAA is running, connected to the broker and is able to retrieve
information from your presentation SAM.


Procedure


1. Verify Tomcat is running, as described in Checking Tomcat on page 5.


2. Verify smarts-edaa is running.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa?
alt=json&pretty=true


3. Make sure there are entries for the dmbroker and the presentation SAM.


4. Verify smarts-edaa is connected to the broker.


For example:
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http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
dmbroker/types/DomainManager/instances?alt=json&pretty=true


5. Make sure there are entries for the various domains registered with the broker.


6. Verify smarts-edaa can retrieve information from your presentation SAM.


For example:


http://itops-qa-192.lss.emc.com:8080/smarts-edaa/msa/
INCHARGE-SA-PRES/instances/SM_System::SM-System?
alt=json&pretty=true


7. Make sure you can see the properties of SM_System::SM-System.


Unable to access Smarts EDAA
If your system cannot access Smarts EDAA, follow these steps.


Procedure


1. Verify the SAM server is not using a broker from a pre-9.4 Smarts installation.


2. Verify the SAM broker is configured for Smarts EDAA access:
<SAM_base_directory>/SAM/smarts/bin> dmctl -s localhost:426/
dmbroker getI EDAAService


The expected result is: SMARTS-EDAA
3. If you made configuration changes to the broker or SAM using the runcmd_env.sh


file, do the following in this order:


a. Shutdown SAM.


b. Shutdown Tomcat.


c. Shutdown the broker.


d. Restart the broker.


e. Restart Tomcat.


f. Restart SAM.


Notification cache is empty
Follow these steps when notifications are not appearing in the Notification cache.


Before you begin


Review this before you start the troubleshooting steps.


l If alerts show up in the Alerts EDAA but not in EMC M&R, the issue is in EMC M&R.


l If you see a backup of messages in RabbitMQ, the SAM publisher is working but the
ingestion service or elasticsearch service may be failing.


l If no messages are passing through into RabbitMQ, the problem is on the SAM
publisher side.


Procedure


1. Verify all services are running, as described in Status checks on services on page 3.


2. Check that SAM has started to publish to RabbitMQ and started with --
bootstrap=bootstrap-amqp.conf.
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3. Verify SAM is exposed via the EDAA and started with --edaa=sam-
presentation/2.0.


4. Under the Connections tab in the RabbitMQ web-based management interface, do the
following:


a. Verify that there are two connections: one from RabbitMQ / Java and the other from
rabbitmq-c.


b. If RabbitMQ / Java is not present, check if Tomcat is running and view the
<SAM_base_directory>/SAM/smarts/local/logs/tomcat/alert-
ingestion.


c. If rabbitmq-c is not present and if SAM is running, check the presentation SAM log
to see if it is publishing to RabbitMQ.


5. From the host running the presentation SAM server, check if you can access the
elasticsearch database and verify the count from a browser on Windows or using a
tool like curl on Linux.


Browser example:


http://localhost:9200/smarts/alert/_count


Linux example:


curl http://localhost:9200/smarts/alert/_count


A result similar to this appears:


{"count":50002,"_shards":{"total":5,"successful":5,"failed":0}}
6. If the count is zero, check if there are any notifications in SAM.


7. From a browser, check if you can access Tomcat in the SAM server host.


For example:


http://hostname:8080
8. Verify elasticsearch is running by checking <SAM_base_directory>/SAM/
smarts/local/logs/tomcat/alert-ingestion.log
If the service was running and is now shut down or unable to process notifications, a
message similar to this may appear in the alerts-ingestion.log file:


{date} {time},{pid} INFO  'ALERTS-IN' EventConsumerService 
EventConsumerPool-1 watchdog attemps to reconnect   
 {date} {time},{pid} INFO  'ALERTS-IN' plugins EventConsumerPool-1 
[La Lunatica] loaded [], sites [] {date} {time}
 {date} {time},{pid} ERROR 'ALERTS-IN' 
ElasticsearchNodeConfigurationService EventConsumerPool-1  
 ElasticSearchNodeConfigurationService::verifyIndexing: 
ElasticSearch :   
 
SERVICE_UNAVAILABLE :org.elasticsearch.client.transport.NoNodeAvail
ableException: No node available
 {date} {time},{pid} INFO  'ALERTS-IN' transport elasticsearch[Ent]
[generic][T#8] [Ent] failed to get node info for [#transport#-1]
[inet  
 [localhost/127.0.0.1:9300]], disconnecting...  
 org.elasticsearch.transport.NodeDisconnectedException: []
[inet[localhost/127.0.0.1:9300]][cluster/nodes/info] disconnected
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Stale alerts and messages appear in Notification cache
If the Notification cache contains stale alerts and messages, you can synchronize SAM
and the Notifications cache. This happens when you restart SAM with a different RPS file.


You have two options to synchronize SAM and the Notification cache:


l Stopping the SAM publisher to clear the Notification cache on page 8. This is the
recommended option because it has low impact on the system.


l Stopping SAM to clear the Notification cache on page 8.


Stopping the SAM publisher to clear the Notification cache
This method of clearing the Notification cache has less impact on the system because
you are only stopping the SAM publisher.


Procedure


1. Stop the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke
SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher stop


2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart the publisher: $ bin/dmctl -s INCHARGE-SA-PRES invoke


SM_AMQPNotificationPublisher::SM-AMQPNotificationPublisher start


Stopping SAM to clear the Notification cache
This method of clearing the Notification cache has a substantial impact on the system.


Procedure


1. Stop SAM: $ bin/sm_service stop ic-sam-pres
2. Clear the Notifications cache by typing these commands:


a. $ bin/sm_service stop smarts-elasticsearch


b. $ rm -rf local/repos/emc-alerts-es


c. $ bin/sm_service start smarts-elasticsearch
3. Restart SAM: $ bin/sm_service start ic-sam-pres


Troubleshooting notification list errors
Notifications are not visible in the EMC M&R user interface. "MSAException" and "Map is
showing HTTP Error" messages display.


Check the /etc/hosts file in the Presentation SAM server. If the /etc/hosts file
does not list the Fully Qualified Domain Name of the EMC M&R host, these errors will
display.


Add the entry in the /etc/hosts file and restart all SAM services.


Article


8 Service Assurance Suite 9.4.2  Article







Troubleshooting an empty notification list
After creating a new Notification List in Service Assurance Manager, the notifications are
not visible in the EMC M&R User Interface.


When you create a new Notification List in Service Assurance Manager, you must issue
this command to have notifications populate the correct reports in EMC M&R. This
command ensures notifications are re-cached so they display in the correct Notification
List.


Issue this command from the Presentation Service Assurance Manager <install_directory>
\SAM\smarts\bin folder: dmctl> invoke ICS_NLManager::ICS-NLManager
renotifyAllEvents


Troubleshooting Notification view popouts
The popout option that was formerly available under the gear tool for the Notification
report is not available.


Select View in Full Page under the Display option in the EMC M&R user interface. This
opens the Notification report in a new window.


RabbitMQ does not start
Follow these steps to determine why the RabbitMQ service does not start.


Procedure


1. Verify RabbitMQ is NOT already running by typing sm_service show.


2. Verify the Erlang process is NOT running by typing ps -ef | grep erl.


3. If the Erlang process is running, kill it before restarting RabbitMQ.


The Erlang process may be running from a prior installation, or was started outside the
sm_service mechanism.


4. Verify the qpidd process is NOT running by typing ps -ef | grep qpidd.


5. If the qpidd process is running, kill it before restarting the RabbitMQ service.


The qpidd process runs on some Linux distributions and can conflict with RabbitMQ
by using the same port.


6. Check that no other RabbitMQ installation exists by typing ps -ef | grep rabbit.


Tomcat does not start
Follow these steps to determine why Tomcat does not start.


Procedure


1. Verify that Tomcat is NOT already running by typing sm_service show.


Tomcat may be running from a prior install, or was started outside of the
sm_service mechanism. Also, another instance of Tomcat or another web server
may be running on the system that prevents this Tomcat instance from binding to port
8080, causing it to shut down.
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2. Verify the underlying application is not already running Tomcat by typing ps -ef |
grep java.


If you see that the /opt/InCharge/SAM/smarts/tomcat/bin/
bootstrap.jar process is running, then Tomcat is likely running as well.


3. Review the messages in SAM/smarts/local/logs/tomcat/catalina.out
and SAM/smarts/local/logs/tomcat/catalina.<date>.log.


Tomcat starts but then stops
Procedure


1. Follow the steps in Tomcat does not start on page 9


2. Check if another process is running on port 8080.


This can cause Tomcat to start for a few minutes and then return to a NOT RUNNING
state.


Changing the password of the EDAA account
The Smarts EDAA logs into domains using the EDAA account _edaa. This account has the
same access privileges as the admin account as well as the ability to perform actions on
behalf of other users. To secure this account, change its default password, which is
changeme.


Procedure


1. In the install directory of each domain server accessed by Smarts EDAA, type
sm_edit conf/serverConnect.conf
By default, only presentation SAM is exposed.


2. In the serverConnect.conf file, change the encrypted default password for the
_edaa account.


For example, you can change this password:


*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB524
9ACD10C773E1:Impersonate


to the new password:


*:_edaa:<new_password>:Impersonate


When you save the serverConnect.conf file, sm_edit encrypts the new
password.


3. In the install directory of the SAM server hosting the Smarts EDAA, type sm_edit
conf/edaaClientConnect.conf


4. In the edaaClientConnect file, change the encrypted default password for the
_edaa account.
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For example, you can change this password:


*:*:_edaa:<E-1.0>94C355DA7E0EB7AADE32F80F201F70C5CCA88288443EE23CB5
249ACD10C773E1


to the new password:


*:*:_edaa:<new_password>


When you save the edaaClientConnect file, sm_edit encrypts the new
password.


5. Stop the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
stop smarts-tomcat.


6. Restart the Smarts Tomcat hosting the Smarts EDAA by typing bin/sm_service
start smarts-tomcat.


7. Verify that the Smarts EDAA can access each domain.


How do I change the RabbitMQ passwords
There are three default accounts in the RabbitMQ installation: an admin account, an
account used by the SAM publisher to deliver messages into RabbitMQ, and an account
used by the ingestion process to pull messages from RabbitMQ. You can change the
password for each one of these accounts.


Follow these procedures to change the passwords of the RabbitMQ accounts:


l Changing the RabbitMQ admin password on page 11


l Changing the RabbitMQ publisher password on page 12


l Changing the RabbitMQ ingestion password on page 13


Changing the RabbitMQ admin password
The RabbitMQ admin account is used for configuring RabbitMQ and accessing
RabbitMQ's web-based management interface. It is not used by any other component of
the system except for the initial RabbitMQ setup process.


Procedure


1. Make sure the smarts-rabbitmq service was started.


2. To access the RabbitMQ web-based management interface, connect with a browser to
port 15672 on the host where RabbitMQ is installed.


For example:


http://my-pres-sam-host.example.com:15672/
3. Log in as admin using the default password of changeme.


4. If this is the first time RabbitMQ was started, make sure the first-time setup has
completed before continuing, as explained Checking the RabbitMQ configuration on
page 4. The setup process uses the default admin/changeme login credentials to
make changes to RabbitMQ.


5. Click the Admin tab and select admin from the list of RabbitMQ login users.


6. Click Update this user.
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7. Type the new password in both password fields. Do not change the Tags field.


8. Click Update User.


A message appears indicating the login failed. This is because you changed the
password for the user that is currently logged on, making the password invalid.


9. Click Log Out.


A new login form appears.


10. Type admin and the new password to confirm the password was successfully
changed.


Changing the RabbitMQ publisher password
The publisher is a component in the presentation SAM domain that sends notifications
into RabbitMQ. The RabbitMQ login for this process is publisher with the default
password of changeme. To change this password, you must update both RabbitMQ and
the SAM configuration with a new matching password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select publisher from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in the SAM configuration:


a. Log in to the host where the presentation SAM is installed.


b. Type sm_edit conf/clientConnect.conf.


c. In the clientConnect.conf file, look for a line beginning with AMQP/*
It is similar to this:


*:AMQP/
*:publisher:<E-1.0>94FF41842043EDA1DE6E67FB08015B3D456752865F8B5
D7DC63F259270B36092


d. In the AMQP/*" line, replace the password field with the same password that you
entered for the RabbitMQ publisher account.


In this example, the password was set to california:


*:AMQP/*:publisher:california


e. Save clientConnect.conf and exit sm_edit.


7. Restart the publisher by connecting to your presentation SAM using dmctl.


For example:


a. $ dmctl -s INCHARGE-SA-PRES


b. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher stop
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Note


If the stop command hangs, verify that you entered the same password for the


RabbitMQ publisher and SAM.


c. dmctl> invoke SM_AMQPNotificationPublisher::SM-
AMQPNotificationPublisher start


8. In the RabbitMQ interface, click the Connections tab and verify the publisher is
connected.


Changing the RabbitMQ ingestion password
Alert-ingestion is a component running in Tomcat that pulls notifications from RabbitMQ
and inserts them in to the Notification cache. The RabbitMQ login for this service is
ingestion with the default password of changeme. To change this password, you
must update both RabbitMQ and the alerts-ingestion configuration with a new matching
password.


Procedure


1. Log in to the RabbitMQ web-based management interface as admin.


2. Click the Admin tab and select ingestion from the list of RabbitMQ login users.


3. Click Update this user.


4. Enter the new password in both password fields.


5. Click Update User.


6. To change the password in alerts-ingestion:


a. Stop the Smarts Tomcat service by typing sm_service stop smarts-tomcat.


b. Using a text editor, open the file smarts/tomcat/webapps/alerts-
ingestion/WEB-INF/classes/rabbitmq-config.xml.


c. Find the password line that looks like this:


<property name="password" value="changeme" />


d. Replace changeme with the new password.


In this example, the password was changed to california:


<property name="password" value="california" />


e. Restart the Smarts Tomcat service by typing sm_service start smarts-
tomcat.


7. In the RabbitMQ interface, click the Connections tab and verify alerts-ingestion is
connected. It may take a few minutes for Tomcat to start and for alerts-ingestion to
connect.
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UI cannot display alerts or Smarts topology when CAS is enabled
Follow these steps when the Central Authentication Service is enabled and the UI is
unable to display information about alerts and objects in the Smarts topology.


Procedure


1. Verify the status of the Alerts EDAA, as described in Checking Alerts EDAA on page 5.


2. Verify the status of the Smarts EDAA, as described in Checking Smarts EDAA on page
5.


3. If Tomcat is running but queries to the EDAA result in the browser hanging, type this
command on the SAM server:


cd /opt/InCharge/SAM/smarts/bin
./runcmd_env.sh


4. In the runcmd_env.sh output:


a. If SM_CAS_SERVER exists, verify this entry includes the protocol, fully-qualified
domain name of the EMC M&R host, and the port number. Make sure there is
nothing after the port number (not even a "/").


b. If the https protocol is used, make sure the port is correct for https.


c. Verify SM_TOMCAT_SERVER has an URL for Tomcat that is part of the SAM
installation.


d. Make sure localhost and 127.0.0.1 are NOT in SM_CAS_SERVER or
SM_TOMCAT_SERVER entries. These environment variables must contain URLs
that reach services from outside the host machine.


Wrong CAS host name in runcmd_env.sh
The UI informs you when you entered an incorrect Central Authentication Service host
name in the runcmd_env.sh script.


This error message appears throughout the UI when you specify an incorrect host name
for CAS in runcmd_env.sh:


java.util.concurrent.ExecutionException:com.emc.asd.mashupengine.utils
.JSONException:A JSONObject text must begin with '{' at 1 [character 
2 line 1] 


Procedure


l Specify the correct CAS host name in the runcmd_env.sh script.


Services remain registered and running after an uninstall
If you did not stop all services before performing an uninstall, the services are still
running and using ports. If you do not want to reboot your system, you must manually
stop these services to allow other services to use these ports.


An uninstall only removes those services that were configured during the installation of
the software being uninstalled. If there are services configured by a second installation
on the same host or by manually invoking sm_service install, those services are
not removed.
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Follow these procedures to stop services:


l Stopping services on Linux on page 15


l Stopping services on Windows on page 16


Stopping services on Linux
Follow this procedure if you did not stop all services before performing an uninstall. This
procedure shows you examples of how to find the process IDs of the services that you
need to stop on Linux systems.


Procedure


1. Find the process ID for elasticsearch, a Java process running
org.elasticsearch.bootstrap.ElasticSearch
For example:


root      7223 10165  0 Jun05 ?        00:11:36 /opt/InCharge/SAM/
smarts/jre/bin/java -cp /opt/InCharge/SAM/smarts/toolbox/
elasticsearch/lib/elasticsearch-0.90.7.jar:/opt/InCharge/SAM/
smarts/toolbox/elasticsearch/lib/*:/opt/InCharge/SAM/smarts/
toolbox/elasticsearch/lib/sigar/* -Xms1g -Xmx1g -Xss256k -
Djava.awt.headless=true -XX:+UseParNewGC -XX:+UseConcMarkSweepGC -
XX:CMSInitiatingOccupancyFraction=75 -XX:
+UseCMSInitiatingOccupancyOnly -XX:+HeapDumpOnOutOfMemoryError -
Delasticsearch -Des.pidfile=/opt/InCharge/SAM/smarts/local/logs/
elasticsearch.pid -Des.foreground=yes -Des.path.home=/opt/
InCharge/SAM/smarts/toolbox/elasticsearch -Des.path.data=/opt/
InCharge/SAM/smarts/local/repos -Des.path.logs=/opt/InCharge/SAM/
smarts/local/logs -Des.path.conf=/opt/InCharge/SAM/smarts/conf/
elasticsearch org.elasticsearch.bootstrap.ElasticSearch


2. Find the process ID for Tomcat, a Java process running
org.apache.catalina.startup.Bootstrap
For example:


root     12495 10165  0 Jun05 ?        00:31:17 /opt/InCharge/SAM/
smarts/jre/bin/java -Xrs -Xms1g -Xmx3g -XX:PermSize=512m -XX:
+HeapDumpOnOutOfMemoryError -classpath /opt/InCharge/SAM/smarts/
tomcat/bin/bootstrap.jar:/opt/InCharge/SAM/smarts/tomcat/bin/
tomcat-juli.jar:/opt/InCharge/SAM/smarts/local/l10n/spool:/opt/
InCharge/SAM/smarts/local/l10n:/opt/InCharge/SAM/smarts/l10n -
Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager -
Djava.util.logging.config.file=/opt/InCharge/SAM/smarts/tomcat/
conf/logging.properties -Djava.endorsed.dirs=/opt/InCharge/SAM/
smarts/tomcat/endorsed -Dsmarts.remote.broker=localhost:426 -
Dcatalina.logdir=/opt/InCharge/SAM/smarts/local/logs/tomcat -
Dcatalina.base=/opt/InCharge/SAM/smarts/tomcat -
Dcatalina.home=/opt/InCharge/SAM/smarts/tomcat -
Djava.io.tmpdir=/opt/InCharge/SAM/smarts/tomcat/temp -
Djava.awt.headless=true -Dcom.smarts.disable_ci_jni=true -
Djava.security.egd=file:/dev/./urandom -
Dcom.emc.msa.dmt.clientconnect=/opt/InCharge/SAM/smarts/conf/
edaaClientConnect.conf -Dsmarts.cas.server=https://itops-
dev-121.lss.emc.com:58443 -Dcom.smarts.incoming_protocol=1,0 -
Dcom.smarts.outgoing_protocol=1,0 -Dcom.smarts.fips_mode=FALSE -
Dsmarts.tomcat.server=https://itops-dev-120.lss.emc.com:8443 
org.apache.catalina.startup.Bootstrap --ignoreme start


3. Find the process ID for RabbitMQ, an Erlang beam process running with -s rabbit
For example:


root      7221 10165  0 Jun05 ?        00:24:03 /opt/InCharge/SAM/
smarts/toolbox/OTP/erts-5.9.3.1/bin/beam.smp -W w -K true -A30 -P 
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1048576 -- -root /opt/InCharge/SAM/smarts/toolbox/OTP -progname 
erl -- -home /root -- -pa /opt/InCharge/SAM/smarts/toolbox/
rabbitmq/ebin -noshell -noinput -s rabbit boot -sname rabbit@itops-
dev-120 -boot start_sasl -config /opt/InCharge/SAM/smarts/conf/rmq/
rabbitmq.config -kernel inet_default_connect_options 
[{nodelay,true}] -sasl errlog_type error -sasl sasl_error_logger 
false -rabbit error_logger {file,"/opt/InCharge/SAM/smarts/local/
logs/rabbit@itops-dev-120.log"} -rabbit sasl_error_logger 
{file,"/opt/InCharge/SAM/smarts/local/logs/rabbit@itops-dev-120-
sasl.log"} -rabbit enabled_plugins_file "/opt/InCharge/SAM/smarts/
conf/rmq/enabled_plugins" -rabbit plugins_dir "/opt/InCharge/SAM/
smarts/toolbox/rabbitmq/plugins" -rabbit plugins_expand_dir "/opt/
InCharge/SAM/smarts/local/repos/rmq/rabbit@itops-dev-120-plugins-
expand" -os_mon start_cpu_sup false -os_mon start_disksup false -
os_mon start_memsup false -mnesia dir "/opt/InCharge/SAM/smarts/
local/repos/rmq/rabbit@itops-dev-120" --ignoreme


4. Use the process IDs to kill these three processes: $ kill -9 7223 12495 7221


Stopping services on Windows
Follow this procedure if you did not stop all services before performing an uninstall.


Procedure


1. Access the Services Management Console to see which services are still registered
and running.


2. Stop the services from the Services Management Console.


3. Delete the SAM directory from \InCharge\SAM.


4. Manually remove the services using the command prompt tool name sc. For example:


a. sc delete ic-broker


b. sc delete smarts-tomcat


c. sc delete ic-sam-server-pres


Retrieving the current elasticsearch PID
You can monitor the resource consumption of elasticsearch using the Linux top -p
<pid> command. This procedure explains where to retrieve the current process ID of
elasticsearch.


Procedure


l To determine the current process ID of elasticsearch, view <SMARTSHOME>/local/
logs/elasticsearch.pid.


Multi-sort option not working after clicking on Notification
column title


When you click the column title in Notification view and then try to set the multi-sort
option for the same column, multi-sort does not work.


From Operations > Network > Notifications, select a notification and click a column title.
This sorts the data in the column (also called "UI sort.") If you try to enable multi-sort for
the same column, it will not work. The sort order remains the same as when you clicked
on the column heading.


In addition, you cannot restore the default sort order.
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Procedure


1. To clear the UI sort, refresh the Notification view.


l Multi-sort is based on Backend sorting


l UI sorting (when you click on the column title) overrides the multi-sort feature. You
must clear this before multi-sort will work again.


Ports that must be open between SAM and EMC M&R
Ensure that the firewall between the server hosting SAM and the servers hosting EMC
M&R (Watch4net) are open. EMC M&R collects data from the Smarts domain managers.
Configure the firewall settings to allow access across ports.


Ports in use with HTTP (no SSL encryption)


l Tomcat server in Service Assurance Manager (SAM): 8080


l Tomcat server in EMC M&R (Watch4net): 58080


l Smarts Broker: 426 (also used for SSL encryption)


l Smarts License Server: 1744 (also used for SSL encryption)


l Elasticsearch: 9200


l RabbitMQ: 15672


Ports in use with HTTPS enabled (SSL encryption)


l Tomcat server in SAM: 8443


l Tomcat server in EMC M&R (Watch4net): 58443


l Smarts Broker: 426


l Smarts License Server: 1744
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
The EMC Smarts Service Assurance Manager Deployment Guide describes how to deploy 
the EMC Smarts Service Assurance Manager and related components of the EMC Smarts 
Service Assurance Manager.


This guide is intended as a comprehensive resource for deployment tasks. In many cases, 
you will be referred to other EMC Smarts documents for specific procedures and 
configuration tasks, such as:


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers — 
This document that accompanied your software product contains detailed hardware 
requirements, platform requirements, and installation procedures.


◆ EMC Smarts Service Assurance Manager Configuration Guide — This document 
contains information about the Global Manager Administration Console.


◆ EMC Smarts System Administration Guide — This document contains detailed 
administration procedures for the EMC Smarts deployment.
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Audience
This guide is intended for the following audiences: 


◆ Network and system administrators who aid in designing and maintaining 
EMC Smarts deployments


◆ Integrators and network consultants who aid in designing EMC Smarts deployments 
and then install, validate, and tune the deployments 


◆ Systems engineers who design EMC Smarts deployments


◆ EMC Smarts Professional Services personnel who design, install, validate, and tune 
EMC Smarts deployments


◆ EMC Smarts Global Services personnel who respond to inquiries, problems, and 
issues that arise during EMC Smarts deployments


EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.

12 EMC Smarts Service Assurance Manager Deployment Guide







Preface

EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI (CUI)


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter


Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 
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EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help
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◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and 


menus
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, 


keywords, clauses, environment variables, functions, and utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, 


file systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs, 
processes, services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and 


menus
• What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables


Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


Courier bold Used for specific user input, such as commands


Courier italic Used in procedures for:
• Variables on the command line
• User input variables 


< > Angle brackets enclose parameter or variable values supplied by the user 


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Overview of the Service Assurance Deployment 
Process


This chapter provides an overview of the deployment process for the Service Assurance 
portions of the EMC Smarts architecture and contains the following information:


◆ EMC Smarts architecture .........................................................................................  20
◆ Deployment process ...............................................................................................  22
◆ Before you begin checklist ......................................................................................  25
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EMC Smarts architecture
The EMC® Smarts® is a fundamental part of all EMC Smarts deployments. As shown in 
Figure 1 on page 22, it consists of the following components and relationships:


◆ The Global Manager (Service Assurance Manager) is a manager of managers that 
provides end-to-end views of the status of your managed IT environment. The Global 
Manager consolidates and abstracts topology, analysis, and events from various 
sources, including EMC Smarts Domain Managers such as EMC Smarts IP Availability 
Manager and EMC Smarts IP Performance Manager. In addition, the Global Manager 
serves as an integration point for the EMC Smarts products.


◆ The EMC Smarts Business Impact Manager allows you to create and relate 
business-level objects, such as departments, services, and customers, to 
applications and network infrastructure. The Business Impact Manager can then 
determine the business impact of infrastructure failures on business services and 
their users. The Business Impact Manager is installed as part of the Global Manager. 
The Business Impact Manager has undergone an architectural change, that is, the 
analysis has been separated into separate processes.


◆ The EMC Smarts Global Console is a user interface that provides information about 
EMC Smarts analysis: root-cause failures, notifications, topology, and even business 
views. The Global Console also provides configuration and administration controls. 
This functionality can also be provided to a web browser by using a Java applet as the 
EMC Smarts Web Console. Both the Web Console and Global Console connect directly 
to the Global Manager.


The Global Console, Web Console and Business Dashboard are installed from a 
separate CD.


◆ The Business Dashboard is a flexible, business-oriented alternative to the Web 
Console. With the Business Dashboard, a collection of EMC Smarts analysis data can 
be displayed with important data from other sources on an organization’s web page. 
Each component of EMC Smarts data is referred to as a Dashboard viewlet, which 
connects directly to the Global Manager. 
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◆ EMC Smarts Service Assurance Adapters (SAM Adapters), EMC Smarts Service 
Assurance Manager Adapter Platform (Adapter Platform) and EMC Smarts Adapter for 
Unified Infrastructure Manager/Operations (EMC Smarts Adapter for UIM/O) provide 
EMC Smarts software with additional sources of data when monitoring a network. The 
Adapter Platform normalizes and consolidates data from adapters before it is passed 
to the Service Assurance Manager. This guide covers deployment of the Adapter 
Platform and specifically describes two adapters that send data to the Adapter 
Platform: the EMC Smarts SNMP Trap Adapter and the EMC Smarts Syslog Adapter. 
The EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide provides deployment information, configuration instructions, and client tool 
examples on the EMC Smarts Adapter for UIM/O.


◆ EMC Smarts Companion UI (Companion UI) supplements existing functionality in SAM, 
EMC Smarts Network Configuration Manager (NCM) and Watch4net Automated 
Performance Grapher (APG). The Companion UI is a VMware®-based appliance, that 
is, a virtual machine. In a solution, one Companion UI is deployed for one 
presentation SAM server. The EMC Smarts SolutionPack Installation and 
Configuration Guide provides detailed information about installing and configuring 
the Companion UI.


Products such as the IP Manager and the Network Protocol Manager include Domain 
Managers that discover or monitor objects for a particular domain.


The Domain Managers use Codebook Correlation Technology™ to perform root-cause 
analysis for the related domain. These domains forward topology and events to the Global 
Manager, which in turn provides this information in a consolidated and abstracted manner 
to the Global Console.
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Design and deployment of the underlying Domain Managers is not covered in this guide. 
Individual product deployment guides provide information on deploying underlying 
Domain Managers.


Figure 1  EMC Smarts Service Assurance Manager deployment architecture


Deployment process
EMC Smarts software is deployed in phases. In the first phase, the domains that feed the 
EMC Smarts Service Assurance Manager are deployed. If there are many types of 
underlying EMC Smarts domain, each type can be deployed in a separate phase. The 
sequence of these initial phases is determined by the priorities of the organization and 
the complexity of each domain.


An EMC Smarts Service Assurance Manager is typically deployed in the initial phases with 
these underlying EMC Smarts domains, but only in a simple, standard configuration. This 
deployment is intended to only validate the operation of the EMC Smarts domains and is 
described in the deployment guide for that domain.
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After the initial phases, the production design of the EMC Smarts Service Assurance 
Manager configuration is deployed. This deployment phase is covered in this guide and 
includes the design, installation, and configuration of EMC Smarts Service Assurance 
Manager. The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM 
Managers and the EMC Smarts Service Assurance Manager Configuration Guide provide 
specific installation and configuration details.


As shown in Figure 2 on page 23, each phase in the deployment process can be further 
divided into four distinct stages:


◆ Stage 1: Designing the deployment


◆ Stage 2: Installing and configuring the components


◆ Stage 3: Validating the deployment


◆ Stage 4: Tuning and maintaining the deployment to improve performance


Figure 2  Stages in an EMC Smarts deployment phase


During each stage of deployment, it is vitally important that you document all aspects of 
the deployment that could be required to recreate, troubleshoot, and reconfigure the 
installation. “Document the deployment” on page 28 provides information on creating a 
document for this information.


Stage 1: Designing the deployment 


Designing an EMC Smarts deployment consists of gathering necessary information and 
then using the information to develop a plan for the deployment.


Gathering the information is a process that involves both the designer and the network 
and application administrators. The administrators must provide details of their 
organization’s network and application infrastructure. Chapter 2, “Gathering Basic 
Information,” describes this process.


This information is then applied to develop a deployment design that will properly support 
the infrastructure. The design should also account for projected growth of the network and 
applications. 


While the deployment is being designed, all plans, decisions, and supporting information 
must be documented. Typically, this documentation takes the form of a solution 
architecture diagram and a deployment build guide. In their preliminary stages, this 
diagram and guide may be used in the response to an organization’s request for proposal 
(RFP) or request for quote (RFQ). 
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After a deployment is contracted, the information in the solution architecture diagram and 
deployment build guide can be refined and verified.


Design is covered in the following chapters:


◆ Chapter 3, “Designing the Service Assurance Deployment,”


◆ Chapter 4, “Designing for Topology Operations,” 


◆ Chapter 5, “Planning for Notifications,” 


◆ Chapter 6, “Designing for EMC Smarts Users,” 


◆ Chapter 7, “Deploying Business Impact Processing,” (optional)


Normally, this design process is performed by EMC Smarts Professional Services or an 
EMC Smarts partner with extensive input from the organization’s IT staff.


Stage 2: Installing and configuring the components


After the design is complete, the next stage is installing and configuring EMC Smarts 
components. This stage is usually broken down into deployment phases where related 
components are installed and configured together. Each installed and configured phase is 
validated individually as described in the next stage of the deployment process. This 
phased approach eases troubleshooting.


Many organizations have specific procedural requirements that must be met before and 
during installation of new software products in their production environments. These 
requirements might include lab installations with performance validations and 
pre-production deployments. Lab configurations usually require the use of a testbed that 
is configured and equipped similarly to the production environment. Before deployment 
in the production environment, acceptance tests may be performed. After the production 
deployment, the lab or testbed may be used to test upgrades and, if required, patches.


Though this guide cannot cover organization-specific requirements, it does provide 
guidelines that may aid you in responding to these conditions.


Chapter 8, “Deploying Service Assurance,” provides information on installing and 
configuring the software. The deployment information, including software locations and 
all configuration choices, should be recorded in the deployment build guide. Normally, 
this stage is performed by the purchaser of the deployment and either EMC Smarts 
Professional Services or an EMC Smarts partner.


Stage 3: Validating the deployment


Validating the deployment ensures that all installed components are operational and can 
communicate with each other as required and that the appropriate components can 
properly discover and poll the network. 


Logical segments of EMC Smarts software are usually installed and validated to ease 
troubleshooting. After all individual segments are installed and validated, the complete 
deployment must be validated from end to end. Included in this overall validation could 
be acceptance tests that demonstrate the functionality of the installation. Criteria for 
acceptance tests should be defined during the design stage. The execution of these 
acceptance tests and the results are usually included in an installation or build report.
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Chapter 9, “Validating Your Deployment (Acceptance Testing),” provides information on 
validating components. Normally, this stage is performed by the purchaser of the 
deployment and either EMC Smarts Professional Services or an EMC Smarts partner.


Stage 4: Monitoring and tuning the deployment


After EMC Smarts software is deployed and validated, you must ensure that it is operating 
at an optimal level. Tuning is the process of adjusting the configuration to improve 
performance; it should be performed after all components are installed and validated. 


Chapter 10, “Monitoring the Performance of Your Deployment,” describes the process of 
monitoring a deployment for tuning. Normally, this stage is initially performed by either 
EMC Smarts Professional Services or a partner and the knowledge is transferred to the 
purchasing organization’s staff. As the network and application infrastructure grows, the 
organization’s staff will take on the task of tuning the deployment to handle this growth. If 
the infrastructure growth is extensive, the original design may no longer be sufficient and 
redesigning the deployment may be required. 


Throughout the life of the deployment, administrators should repeat this stage to 
maintain the deployment.


Before you begin checklist
Before you begin an EMC Smarts deployment, you must meet the requirements described 
in Table 1 on page 25. Each chapter in this guide includes a checklist. Appendix A, 
“Design and Deployment Checklists,” contains all available checklists.


Table 1  Before you begin checklist 


Complete Requirement Description


❑ Possess an 
understanding of the 
architecture and 
capabilities.


At a minimum, you must understand the concepts and 
architecture described in the following documents: 
• EMC Smarts Service Assurance Manager Introduction
• EMC Smarts Service Assurance Manager 


Configuration Guide
• EMC Smarts Service Assurance Manager Adapter 


Platform User Guide
• EMC Smarts System Administration Guide
• EMC Smarts Installation Guide for SAM, IP, ESM, 


MPLS, VoIP, and NPM Managers that accompanied 
your product


• EMC Smarts user guides related to the underlying 
domains in your deployment


To improve your understanding, attend training courses 
offered by EMC Education Services and Development. 
Typically, deployment requires the knowledge 
equivalent to what is provided in the training courses 
on:
• Global Manager
• EMC Smarts Service Assurance Manager Adapter 


Platform
• Any underlying EMC Smarts domain that will be part 


of your deployment.
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❑ Obtain contact 
information for the 
deployment team.


The contact list should include titles, responsibilities, 
and contact methods for all team members.


❑ Get non-disclosure 
requirements and 
negotiate an 
agreement.


Be aware of the requirements of the non-disclosure 
agreements that are in place for the deployment.


❑ Develop schedules 
and set milestones for 
early deliverable. 


Scheduling a software deployment varies based on the 
size and scope of the deployment and the organization’s 
requirements. Typical milestones might include:
• Initial project meeting to define the deployment 


scope
• Purchase of EMC Smarts software
• Project development begins 
• Installation in test environment complete
• Testing complete
• Installation in production environment complete
• EMC Smarts goes live
Additional information on scheduling is beyond the 
scope of this guide.


Table 1  Before you begin checklist  (continued)


Complete Requirement Description
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CHAPTER 2
Gathering Basic Information


This chapter describes the first step in designing a Service Assurance deployment, that is, 
gathering the organizational and network-related information that is required to develop a 
successful design. This chapter also describes how to document the information that you 
gather and your resulting design in a solution architecture diagram and a deployment 
build guide. This chapter contains the following information:


◆ Document the deployment ......................................................................................  28
◆ Gather information required to size Service Assurance ............................................  29
◆ Determine requirements for installing software .......................................................  30
◆ Gather network security information .......................................................................  31
◆ Other network features affecting EMC Smarts..........................................................  32
◆ Basic Service Assurance information checklist ........................................................  33
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Document the deployment
The most useful way to document the managed environment and the design of your 
deployment is to create a solution architecture diagram and record implementation 
details in a deployment build guide.


The solution architecture diagram


Based on the complexity of the deployment, a solution architecture diagram may actually 
be a set of diagrams documenting various levels of the architecture. 


The diagram relates the information that you gather on the environment to both physical 
and logical choices for your architecture in an easily understood manner. This diagram 
illustrates your design choices and will be an important part of the review and approval 
process for your design.


The solution architecture diagram should always include:


◆ Necessary information about the managed network and application environment


◆ A logical representation of the EMC Smarts components that will be installed


◆ Locations for each component including the name and IP address of the host and the 
geographical location of the host


◆ Connections between components and the ports that are used for communications


◆ Connections, including port numbers, between EMC Smarts components and external 
sources such as networks and third-party software products


This diagram cannot be completed until the design is complete and deployed, so 
recommendations for adding information to the diagram appear throughout this guide.
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The deployment build guide


To record the specifics of the managed environment and the deployment design and 
implementation, create a document called a deployment build guide. As with the solution 
architecture diagram, this chapter describes information that you should add to the 
deployment build guide. The deployment build guide should include the complete design 
and all installation specifications, validation results, and tuning activities. 


Start the deployment build guide by recording all the information that you gather on the 
network, some of which may come from your planning of IP Availability Manager or IP 
Performance Manager installations. As you continue the deployment process, this guide 
will include recommendations for adding other information to the deployment build 
guide.


Gather information required to size Service Assurance
To determine the size and configuration of Service Assurance, including the number of 
Global Managers and the equipment required to support them, gather the following 
information:


◆ The number of devices and applications to manage


◆ The number of Service Assurance clients


◆ The number of underlying managed domains


Determine how many devices and applications will be managed


One of the most important factors in determining the size of a Service Assurance 
deployment is quantity of devices and applications that must be managed. Estimate all 
managed devices in a network once. Include the following types of devices:


◆ All routers, including virtual routers


◆ All switches


◆ Hosts that will be managed, including virtual machines


◆ Any other devices that will be managed


All managed applications should also be counted: if an application consists of component 
processes, count each process.


EMC Corporation has determined that even in well-managed large networks, 
administrators can underestimate the quantities of devices and applications that they 
intend to manage. 


If possible, validate the estimated quantities for some portion of the network. If the 
estimate does not match, try to obtain an improved estimate for another part of the 
network and then validate again. If improving the estimates is not possible, determine the 
percentage error and use it to adjust all the other estimates.


As a final step in estimating the quantities of managed devices and applications, account 
for growth of the organization’s network and for planned application deployments. 
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Your Service Assurance deployment design should account for network growth over the 
expected life of the design. The network growth rate will relate to the vertical market 
environment and the organization’s plans, so the organization must provide you with 
growth estimates.


Information on the future deployment of business applications may be more difficult to 
obtain. For example, an organization’s budgetary plans may provide useful information, 
but may not be available to you. Interviews with IT staff may be your best source of 
information.


Estimate quantities and types of Service Assurance clients


The number of Service Assurance clients will affect Global Manager configuration and 
equipment choices. The clients can include any of the following:


◆ Users of the Global Console, Web Console, and Business Impact Manager. 


◆ EMC Smarts Adapters that connect to the Global Manager directly, including the 
Service Assurance Manager Notification Adapters: SNMP Trap Notifier Adapter, Script 
Notifier Adapter, and Log File Notifier Adapter.


Estimate the number of underlying EMC Smarts domains


Estimating the number of underlying domains requires that you size these domains 
following EMC Smarts Professional Services recommendations or by following the process 
described in the underlying domain’s deployment guide, such as the EMC Smarts IP 
Manager Deployment Guide.


Determine requirements for installing software
Most organizations define some criteria for installing new software on their network. At a 
minimum, this might include software testing requirements. In addition, plan on using a 
staging area before deploying. By staging the deployment, you can maintain a clean 
software distribution that does not include unwanted files, changes, and logs.


Define requirements for integrating existing software with EMC Smarts


Integrating third-party software products with EMC Smarts software requires the use of 
EMC Smarts adapters. Most integrations do one of the following:


◆ Exchange information. Determine the exact type of information (topology or events) 
that must be exchanged with any third-party software products.


◆ Allow access to the third-party software from the Global Console. Some EMC Smarts 
adapters provide this capability as the Server Tools functionality. For example, both 
the EMC Smarts Adapter for InfoVista and EMC Smarts Adapter for Concord eHealth 
allow users at the Global Console to access reports from these products.


EMC Corporation has developed many adapters for use with EMC Smarts software that 
may already support the integration requirements of your deployment. Itemize the 
integration requirements so that the suitability of existing EMC Smarts adapters can be 
assessed by EMC Smarts Professional Services. This guide specifically covers the 
integration capabilities provided by the EMC Smarts SNMP Trap Adapter (Receiver). This 
guide also addresses the basic information for other adapters.
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Gather network security information
Determine the level of security for the network that EMC Smarts software will monitor so 
that the software can be configured to a corresponding level of security. For example, the 
security needs of a network in a financial, defense, or health care vertical market may be 
greater than in the manufacturing vertical market. Enumerate security preferences, such 
as the use of passwords, encrypted password storage, and encrypted communications to 
guide you when configuring security capabilities.


Firewalls between parts of the EMC Smarts deployment 


Appropriate Service Assurance components must be able to receive traps and 
communicate with other EMC Smarts components. Certain TCP and UDP ports will need to 
be opened in the firewalls to facilitate these communications. “Considering security and 
firewalls” on page 51 provides additional information.
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Other network features affecting EMC Smarts
Other network features may affect the EMC Smarts deployment design. Consider the 
following questions when gathering information on the network:


◆ Does the organization require failover capabilities in network software?


◆ Is there an “out-of-band” network just for management information? For example, are 
certain Ethernet ports just for management information? This is typical with some 
deployments in the financial and military or defense vertical markets. 


◆ What are the issues related to network latency, bandwidth, and speed available for 
network management traffic?
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Basic Service Assurance information checklist
Use the checklist shown in Table 2 on page 33 to aid in gathering information for your 
Service Assurance design. Each chapter in this guide includes a checklist. “Design and 
Deployment Checklists” on page 107 contains all available checklists.


Table 2  Service Assurance information checklist 


Complete Task Description Related documentation


❑ Determine the number of 
managed devices and 
applications in the 
environment.


Document all quantities in the 
deployment build guide.


“Determine how many 
devices and applications will 
be managed” on page 29


❑ Estimate potential growth in 
quantity of managed 
devices.


The deployment must support 
potential network growth. Estimate 
the growth over a specific time 
period. Document the calculations in 
the deployment build guide.


“Determine how many 
devices and applications will 
be managed” on page 29


❑ Get the organization’s 
testing/acceptance 
requirements.


Your design may be required to meet 
test and acceptance requirements. 
Obtain any specifications that cover 
integration testing, user acceptance 
testing, and operational acceptance 
testing. You may be required to write 
an installation or deployment report 
that follows an organization’s 
particular standards.


“Determine requirements for 
installing software” on 
page 30


❑ Describe the organization’s 
requirements for installing 
new software.


Document these requirements and 
how the design meets them in the 
deployment build guide.


“Determine requirements for 
installing software” on 
page 30


❑ List the products that 
currently monitor the 
network and will be 
integrated with the 
EMC Smarts deployment.


Document the products (including 
version) in the deployment build 
guide.


“Define requirements for 
integrating existing software 
with EMC Smarts” on 
page 30


❑ Describe the network 
security.


Describe security features that will 
affect the deployment. 
Document the security features in the 
deployment build guide.


“Gather network security 
information” on page 31


❑ List any other network 
requirements or features 
that may affect the 
EMC Smarts deployment.


Document the features in the 
deployment build guide.


“Other network features 
affecting EMC Smarts” on 
page 32
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CHAPTER 3
Designing the Service Assurance Deployment


This chapter provides guidelines for producing an initial design of the Service Assurance 
deployment by using the information you have gathered on the organization’s application 
and network environment. This chapter contains the following information:


◆ Determine the Service Assurance configuration.......................................................  36
◆ Web Console and Business Dashboard requirements ..............................................  45
◆ Essential EMC Smarts applications .........................................................................  48
◆ Locating the Global Managers in the network ..........................................................  50
◆ Considering security and firewalls ...........................................................................  51
◆ Considering failover (high availability) configurations..............................................  51
◆ Designing acceptance tests.....................................................................................  52
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Determine the Service Assurance configuration
A single Global Manager can support most Service Assurance deployments, but there are 
cases where multiple Global Managers are required. Use Table 3 on page 36 to determine 
the Service Assurance configuration required to support your managed environment. The 
first three columns in Table 3 on page 36 identify the quantities that will determine the 
Service Assurance configuration:


◆ The Managed devices and applications column details the total quantity that will be 
managed in the Service Assurance deployment. This number should include 
estimates for growth.


◆ The Underlying domains column details the total number of domains that will feed 
topology and events to the Service Assurance deployment.


◆ The Concurrently connected clients column details the total number of Service 
Assurance clients that will be connected concurrently, including Global Consoles, Web 
Consoles, Dashboard viewlets, and any adapters that connect to the Global Manager 
directly.


Table 3  Determining the required Service Assurance configuration


Using the quantities for the managed 
environment Use this Service Assurance configuration


Managed 
devices and 
applications


Underlying 
domains


Concurrently
connected 
clients


Global Manager 
configuration


Global Manager platform 
equipment tier


Aggregation
layer (if used)


Presentation
layer (if used)


0 to 2,000 
(small 
deployment)


10 100 Standard Small


>100 Basic Hierarchical Small Medium


✞ 10 100 Standard Medium


>100 Basic hierarchical Medium Medium


2,001 to 
6,000 
(medium 
deployment)


 10  100 Standard Small


>100 Basic hierarchical Small Medium


✞10  100 Standard Medium


>100 Basic hierarchical Medium Medium


6,001 to 
12,000
(large 
deployment)


10 100 Basic hierarchical Medium Medium


>100 Hierarchical presentation Large All medium


✞10  100 Hierarchical aggregation All medium Large


>100 Hierarchical Mesh All large All Large
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The columns in the Use this Service Assurance configuration section define 
recommendations to support the deployment:


◆ The Global Manager configuration column details the recommendation for the number 
of Global Managers, either a single one (Standard) or multiple (any of the hierarchical 
configurations). If a hierarchical configuration is recommended, the specific structure 
is also defined. The Global Manager configurations are explained in the following 
sections.


◆ The Global Manager platform equipment tier columns define the hardware that is 
required to support the Global Managers. For hierarchical configurations, two layers of 
Global Managers are defined: an aggregation layer and a presentation layer. Domain 
Managers connect to a Global Manager at the aggregation layer while Service 
Assurance clients connect to a Global Manager at the presentation layer. The table 
indicates the equipment required to support each layer. “Hardware for Service 
Assurance platform equipment tiers” on page 43 provides definitions for the 
equipment tiers.


Table 3 on page 36 defines Service Assurance configurations for coherent deployments. It 
is possible to create separate deployments in a managed environment that do not feed 
events and topology to a single, central Global Manager. If this is the case, each of these 
deployments must be treated separately with distinct Global Manager configurations 
based on unique quantities for first three columns in Table 3 on page 36.


12,001 to 
20,000 
(extra large 
deployment)


 10 100 Basic hierarchical Large Large


>100 Hierarchical presentation Extra large All large


✞10 100 Hierarchical aggregation All large Extra large


>100 Hierarchical mesh All extra large All extra large


Above 20,000 devices EMC Smarts deployments in this range are currently in 
production. Consult with EMC Smarts Professional Services for 
aid in this design.


Table 3  Determining the required Service Assurance configuration (continued)


Using the quantities for the managed 
environment Use this Service Assurance configuration


Managed 
devices and 
applications


Underlying 
domains


Concurrently
connected 
clients


Global Manager 
configuration


Global Manager platform 
equipment tier


Aggregation
layer (if used)


Presentation
layer (if used)
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Standard Global Manager configuration


A single Global Manager, as shown in Figure 3 on page 38, should be able to handle many 
typical deployments. This is called the Standard Configuration. In this configuration, there 
are no links that introduce high latency between the main EMC Smarts components.


Figure 3  Standard Service Assurance configuration
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Basic hierarchical Global Manager configuration


Deployments with either large numbers of clients or large numbers of domains can usually 
be supported using the basic hierarchical configuration shown in Figure 4 on page 39. 
This hierarchical configuration separates the topology synchronization processing 
(aggregation) from the client processing (presentation) to improve performance.


Figure 4  Basic hierarchical Service Assurance configuration
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Hierarchical aggregation Global Manager configuration


The hierarchical aggregation configuration shown in Figure 5 on page 40 uses multiple 
Global Managers at the aggregation layer to address these configurations: 


◆ More than 10 underlying domains: It is recommended that each Global Manager at the 
aggregation layer supports a maximum of 10 EMC Smarts domains. The example in 
Figure 5 on page 40, therefore, would support 20 domains.


◆ Geographically separate groups of domains: Using a standard Global Manager 
configuration would force some domains to connect to a Global Manager over a 
high-latency link. Additional Global Managers at the aggregation layer would be 
located in the same geographical area as the domains.


To ensure that acknowledgements and ownership of notifications are properly 
propagated, Service Assurance clients should connect only to the Global Manager at the 
presentation layer.


Figure 5  Hierarchical aggregation Service Assurance configuration
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Hierarchical presentation Global Manager configuration


The hierarchical presentation configuration shown in Figure 6 on page 41 uses multiple 
Global Managers at the presentation layer to address these configurations: 


◆ More than 100 Service Assurance clients that connect concurrently: This includes 
Global Consoles, Web Consoles, Dashboard viewlets, and any adapters that connect 
to the Global Manager directly. It is recommended that each Global Manager at the 
presentation layer supports up to 100 concurrently connected clients. The example in 
Figure 6 on page 41, therefore, would support 200 clients.


◆ Geographically separate groups of clients: In these cases, using a standard Global 
Manager configuration would force a group of clients to connect to a Global Manager 
over a high-latency link. Additional Global Managers at the presentation layer would 
be located in the same geographical area as the groups of clients.


To ensure that acknowledgements and ownership of notifications are properly 
propagated, some customization may be required.


Figure 6  Hierarchical presentation Service Assurance configuration

Determine the Service Assurance configuration 41







Designing the Service Assurance Deployment

Hierarchical mesh Global Manager configuration


The hierarchical mesh configuration shown in Figure 7 on page 42 is used to support the 
largest, most complex deployments that require multiple Presentation Global Managers 
and multiple Aggregation Global Managers.


As with the other hierarchical configurations, it is recommended that each additional 
Aggregation Global Manager should support up to 10 underlying domains and each 
additional Presentation Global Manager should support up to 100 simultaneously 
connected clients. 


Deploying the hierarchical mesh configuration requires the aid of EMC Smarts 
Professional Services.


Figure 7  Hierarchical Mesh Service Assurance configuration
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Hardware for Service Assurance platform equipment tiers


Typical hardware for the equipment tiers and operating systems is listed in Table 4 on 
page 43.


Table 4  Typical hardware for the equipment tiers


It is recommended that you work with Sun Microsystems, Inc. to determine models that 
meet or exceed these requirements in addressing your business needs.


Xeon processors vary a lot across models. The Xeon 3GHz 5160 is rated at about 16 at 
SpecInt for speed while the 2.93GHz Xeon X5670 is rated at about 37 for speed. If you 
require a specific speed processor, EMC recommends using the SpecInt (SPEC Integer) 
benchmark published by SPEC both for assessing the CPU speed and throughput ratings. 
SPEC is an organization of computer industry vendors dedicated to developing 
standardized benchmarks and publishing reviewed results. 


Operating system


Platform equipment tier


Small 
(1–2 low end 


CPUs, 
2 GB RAM) 


Medium 
(2 CPUs, 


4 GB RAM)


Large 
(2 CPUs, 


4 GB RAM)


Extra large
(4 CPUs, 


4–8 GB RAM)


Red Hat Enterprise 
Linux


Any vendor,
1-2 Xeon 2.8 GHz


Any vendor,
2 Xeon 2.8
GHz


Any vendor,
2 Xeon 2.8 GHz


Any vendor,
4 Xeon 3.0 GHz


Solaris UltraSPARC-T1 
(T2000)


Ultra-
SPARC-T2 
(T5220)


SPARC64 VII 
(M4000)


SPARC64 VII 
(M4000)
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CPUs may have multiple cores and cores may have multiple hardware threads. Cores and 
threads may share CPU resources with other cores and threads. This makes assessment of 
CPU capacity difficult. EMC recommends using the benchmark published by SPEC for 
assessing expected relative CPU performance. CPU2006 is the current version of the CPU 
component benchmark suite from SPEC. 


The results are broken out by reported metric for:


◆ CPU Speed: You can access this benchmark from:


http://www.spec.org/cpu2006/results/cint2006.html


◆ CPU Throughput: You can access this benchmark from:


http://www.spec.org/cpu2006/results/rint2006.html


While cint runs one copy of the benchmark, rint runs as many copies as there are threads 
in the machine.


CPU speed and the number of CPUs available affect performance. You can get a sense of 
the expected performance by comparing the CPU speed directly to the speed ratings of the 
CPUs on which the benchmark is based. The current strategy for assessing the number of 
effective CPUs in a machine is to divide the throughput rating by the speed rating. In 
general, our software benefits more from faster CPU speed, than the comparable addition 
of more CPUs. Thus, it is preferred to have 1 CPU rated at 20, than 2 rated at 10. 


If you are installing more than one product, then your system must meet the products total 
memory and data disk space requirements.


Table 5 on page 44 lists disk space requirements for installing the Service Assurance 
Manager Server.


Table 5  Required disk space for the Service Assurance Manager Server


Table 6 on page 44 lists disk space requirements for installing the Service Assurance 
Manager console.


Platform Disk space


Solaris 10 730 MB


Red Hat Enterprise Linux AS 5 475 MB


Windows Server 2008 R2 2.7 GB


Table 6  Required disk space for the Service Assurance Manager 
console


Platform Disk space


Solaris 10 485 MB


Red Hat Enterprise Linux AS 5 365 MB


Windows Server 2008 R2, Windows
Vista, and Windows XP


1.6 GB

44 EMC Smarts Service Assurance Manager Deployment Guide







Designing the Service Assurance Deployment

Table 7 on page 45 lists minimum requirements for CPUs, memory, and data disk space 
that is used by the software for writable files such as logs, repository files, and output 
files.


CPU means the number of physical CPU cores and not the number of CPUs displayed when 
hyperthreading is activated. 
For the XML Adapter, disk space depends on the size of the output that you want to export. 
Each output file can range from 0 to 200 MB. If, for example, the XML Adapter 
communicates with 5 Service Assurance Global Managers and each output file is 200 MB, 
then 1 gigabyte (GB) is required.


If you are installing multiple products, then your system must meet the products’ total 
memory and data disk space requirements. Table 5 on page 44 defines required disk 
space and Table 7 on page 45 lists CPU, memory, and data disk space requirements.


Web Console and Business Dashboard requirements
The EMC Smarts Global Console can also be deployed as either: 


◆ EMC Smarts Web Console


or


◆ EMC Smarts Business Dashboard


Tomcat Servlet Engine version 6.0.30 or above is installed as part of the Web 
Console/Business Dashboard. The Tomcat Servlet Engine serves the files used by the Web 
applications.


Users who display Business Dashboard viewlets in a Web browser, or want to use the Web 
Console, require the following software:One of the following Web browsers:


Table 7  CPU, memory, data disk space requirements


EMC Smarts product CPUs
Memory 
(RAM) Data disk space 


Service Assurance Manager 2 512 MB 100 MB each


Global Console 1 256 MB Not applicable


Global Console, Web Console, and 
Business Dashboard


1 256 MB 150 MB


EMC Smarts Service Assurance Manager 
Adapter Platform


1 512 MB 100 MB each


Syslog Adapter 1 256 MB 50 MB each


SNMP Trap Adapter 1 256 MB 50 MB each


EMC Smarts Adapter for UIM/O 1 256 MB 50 MB


XML Adapter 1 256 MB See the following Note.
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• Internet Explorer 6.0 with Service Pack 1, 7.0, 8.0, 9.0


• Firefox 2, 3.5, 3.6, 4.0, and 5.0


• Google Chrome 12.0


• Safari 3.0


• Browser that supports Java JRE 1.6.x


Only browsers running on Linux, Solaris, and Microsoft Windows operating systems are 
supported.


◆ For Windows, the browser must be JavaScript enabled. 


Also, a list of specific versions of browsers that are supported on different platforms 
can be found in the Oracle website.


◆ Java 2 Platform Standard Edition 6.0, which includes the 1.6.x Web browser plug-in 
must be installed on the client workstation.


If you are running any version prior to 1.6, when you try to start up and run the 
Dashboard or web console, the applets inside the sample views that are shipped with 
the software do not display properly.


If your client workstation does not have this version of JRE, you must obtain it and 
install it:


For all platforms, download it from the Sun Microsystems website. 


If the JRE is not installed on your client workstation, you will be prompted to install it 
when you launch the Web Console or Business Dashboard.


In SAM 9.2, Red Hat Enterprise Linux AS 5, Windows Server 2008 R2, and Solaris 10, uses 
JRE version 1.6.0.26.


Java Web Start requirements for Web Console


Java Web Start is optional and can be invoked when the Web Console is executed.


Java Web Start must be installed and configured on the client machine:


◆ For UNIX, contact your system administrator to install and configure Java Web Start or 
follow the instructions provided in the Sun Microsystems website. 


◆ For Windows, on the client machine, depending upon the type of browser, after you 
launch the Web Console, use an automatic installer or follow the instructions provided 
in the Sun Microsystems website. 


To launch the Java Web Start version of the Web Console and use the automatic 
installer, point your browser to the following URL:


http://<Tomcat_host>:8080/webconsole/globalConsoleCached.html


where <Tomcat_host> refers to the name of the machine where the Tomcat Servlet 
Engine is installed and 8080 refers to the default port for Tomcat. 
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The EMC Smarts Service Assurance Manager Dashboard Configuration Guide provides 
information about using the Web Console.


When launching the Web Console from the browser (using the globalConsoleCached.html 
and JRE 1.6.13), an exception may be raised stating that the JAR resource in the JNLP file is 
not signed by the same certificate.
Launch the Web Console from http://<servername>:8080/webconsole/ to download the 
correct (JRE 1.6_25) version.


Web browser requirements for the Smarts Adapter for UIM/O


The following web browsers are required for the Smarts Adapter for UIM/O:


◆ Internet Explorer 6.0 with Service Pack 1, 7.0, and 8.0


◆ Firefox 3.5, 3.6, 4.0, and 5.0


Only browsers running on Windows operating systems are supported. For Windows, the 
browser must be JavaScript enabled. The EMC Smarts Adapter for Unified Infrastructure 
Manager/Operations Configuration Guide describes a recommended configuration task 
for both browsers and Firefox addons.


In addition, Java Standard Edition 6.0, which includes the 1.6.x Web browser plug-in, must 
be installed on the client workstation. If your client workstation does not have the JRE 1.6, 
you must obtain it and install it. For all platforms, download it from the Oracle website, 
http://www.oracle.com.


The Deployment Guide may not be updated for patch or service pack releases. For the 
most up-to-date information about a release, refer to the Release Notes.


Deploying Global Managers and Domain Managers


Deploy the Global Manager separately from the Domain Managers. After deployments 
become large, run the Service Assurance Adapter Platform separately from the Global 
Manager. Avoid running any other applications on these platforms to ensure that you do 
not adversely affect the performance of the EMC Smarts applications.


Adding information to the solution architecture diagram and build guide


Include the Global Managers and related applications on the architecture solution 
diagram. Draw boxes to show the platforms and include the names, locations, and, when 
applicable, port numbers for all the EMC Smarts components.


For the deployment build guide, document equipment choices and create a table that 
documents EMC Smarts components on each host.
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Essential EMC Smarts applications
Every EMC Smarts installation must include an EMC Smarts Broker and a license server. 
Both are critical components, without either, the installation will not work. Usually, you 
install these two components together, in a single location. All of the EMC Smarts 
applications must be able to communicate with both applications.


Locating EMC Smarts Brokers


The Broker manages a registry of EMC Smarts server applications. When an EMC Smarts 
application needs to connect with another application, it gets the necessary information 
from the Broker. Periodically, the Broker pings the applications in its registry to determine 
whether they are still active. 


Server applications, such as the Global Manager, IP Availability Manager, and Adapter 
Platform, are maintained in the Broker’s registry. Applications such as the Global Console 
connect to the Broker to determine the location of registered applications.


With most installations, the Broker is typically installed on the same machine as the 
license server. All EMC Smarts applications must be able to access the Broker. By default, 
the Broker uses port 426.


It is recommended that you use a DNS alias to a machine for the Broker so that it is easier 
to redirect other EMC Smarts applications if it becomes necessary to move.


Add the following information for the Broker to the deployment build guide:


◆ Name of host where the Broker will reside


◆ Port number to be used by the Broker (the default is 426.)


◆ Information for the DNS broker alias


Installations use more than one Broker for failover configurations. Multiple Brokers require 
special consideration to synchronize lists of registered servers. If you determine that your 
installation needs more than one Broker, consult with the EMC Smarts Professional 
Services organization.
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Locating license servers


The license servers authenticate EMC Smarts applications. Without proper licensing, the 
applications will not work correctly. Licenses control access to applications and features 
as well as limit the number of systems discovered.


It is recommended that the license server runs on the same host as the Broker—all 
applications need to be able to access the license server. However, an existing FLEXnet 
License Server may be used if it meets the EMC Smarts specifications. If there is more than 
one Broker for the installation, there may be good reason to use more than one license 
server.


In certain cases, you may use multiple license servers in your network for the same 
reasons that you split a topology or choose different locations for the Domain Managers: 
geographical requirements, corporate organizational requirements, or the network’s 
security design. Multiple license servers would require the corresponding number of 
licenses. 


When multiple license servers are used, each domain will use blocks of licenses from a 
specific license server. Therefore, the license blocks must be divided among multiple 
licenses and the appropriate license must be deployed to each license server. Then, the 
Domain Managers that rely on a specific license server will have the appropriate licenses 
to support the systems that they must manage.


Collect the following information for each license server and add it to the deployment 
build guide:


◆ The host ID of the computer where the FLEXnet license server is running


◆ The expected installation path to BASEDIR/smarts/bin on your broker (or to the 
EMC Smarts installation from which you want to run the license server)


◆ The operating system of the computer


◆ The port number used


The EMC Smarts System Administration Guide provides additional information.
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Locating the Global Managers in the network
In choosing locations for the platforms that support the Global Managers, there may be 
restrictions on locations that are not related to network and application efficiency. 
Locating the Global Managers may be based on the following considerations:


◆ Geographical requirements: An organization may require that all EMC Smarts 
Managers be based in a single Network Operations Center (NOC). Other organizations 
might have the Global Manager in the NOC and underlying Domain Managers located 
in regional data centers.


◆ Corporate organizational requirements: For example, organizations that have a 
distributed business management might require that components be located to 
match the organization’s structure.


Communication between applications is influenced by network speed and latency. Avoid 
configurations that require a Global Manager to receive information from other 
applications across WAN links with high latency. Instead, consider placing Global 
Managers on both ends of high-latency WAN links. The hierarchical Global Manager 
configurations can be used to eliminate high-latency link issues for these situations:


◆ Domain Managers that connect to a Global Manager over a high-latency link: Use the 
basic hierarchical, hierarchical aggregation, or hierarchical mesh configuration to 
place a Global Manager on the same side of the high-latency link as the Domain 
Managers.


◆ A group of clients that connect to a Global Manager over a high-latency link: Use the 
basic hierarchical, hierarchical presentation, or hierarchical mesh configuration to 
place a Global Manager on the same side of the high-latency link as the group of 
clients.


After you determine the configuration and locations of the Global Managers, add system 
names and Global Manager names to your solution architecture diagram. Define IP 
addresses and dedicated port numbers when needed. Establish a host naming 
convention and a Global Manager naming convention before you settle on any names. 
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Considering security and firewalls
Based on the security information you obtained earlier, you must plan design solutions so 
that the applications can function properly in the network’s security environment:


◆ Configure security policies (rules) to enable a one-way connection from the FLEXnet 
license server and the Broker to the various applications.


For communication between Managers across firewalls, plan on opening a hole in the 
firewall for the EMC Smarts communications. Certain UDP and TCP ports must be 
opened for proper communications:


• Broker: Port 426


• License Manager: Port 1744


• Manager: one port each, which can be configured


• Adapters, including SNMP Trap Adapter and Syslog Adapter. The EMC Smarts 
Service Assurance Manager Adapter Platform User Guide provides details.


◆ Consider proxy servers when communicating with EMC Smarts applications that reside 
behind firewalls. Using a proxy server reduces the number of firewall ports that need 
to be opened to one firewall port. “Configuring the Java clients to use a proxy server” 
on page 86 provides additional information on the procedure to configure the Java 
clients to use a proxy server.


◆ If access lists are used, plan on deploying the IP addresses of hosts that include 
Managers to the access list of devices that will be managed. EMC Smarts applications 
must have full access to browse the MIBs of the devices. The EMC Smarts IP Manager 
User Guide lists the specific MIBs. Depending on the network size and complexity, 
this may require scheduling to obtain support from the organization’s network 
personnel.


◆ You must have a listing of SNMP versions and related security parameter values that 
are used by specific devices in the organization’s network. Due to security concerns, it 
may not be appropriate to include them in the deployment build guide.


Security levels and EMC Smarts applications
In addition, consider the level of security to configure EMC Smarts applications. The 
security mechanisms support various levels of user authentication, and also 
authentication and encrypted communication between applications. Ensure that you 
understand the capabilities described in the EMC Smarts System Administration Guide 
and then choose a level of security that is appropriate for the deployment.


Considering failover (high availability) configurations
EMC Smarts offers a failover product that works in conjunction with the Global Manager. 
You can find information about configuring a failover solution in the EMC Smarts Failover 
System User Guide. For additional help, consult with EMC Smarts Professional Services.
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Designing acceptance tests
Acceptance tests may be required for different portions of EMC Smarts functionality. Be 
aware of the requirements and develop acceptance criteria with the aid of the network 
administrators and other organization personnel. Include all necessary acceptance tests 
in the deployment build guide for the deployment. At a minimum, you must develop 
completion criteria that the organization’s project managers approve. Document these 
completion criteria in the deployment build guide and use them in validation.
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Initial design checklist
Document your initial overall design of the deployment. 


Each chapter in this guide includes a checklist. “Design and Deployment Checklists” on 
page 107 contains all the available checklists.


Table 8  Initial design checklist


Complete Task Description
Related 
documentation


❑ Determine the 
configuration of the 
Service Assurance 
deployment.


Determine Service Assurance configuration, 
including the number of Global Managers and 
how they are organized in the deployment.


“Determine the 
Service Assurance 
configuration” on 
page 36


❑ Determine the hardware 
required to support the 
Service Assurance 
deployment.


For each Global Manager in the Service 
Assurance configuration, determine the type of 
equipment required to support it.


“Hardware for 
Service Assurance 
platform equipment 
tiers” on page 43


❑ Determine the location 
of the EMC Smarts 
Broker.


Choose a location for the Broker that will 
support the deployment.


“Locating 
EMC Smarts Brokers” 
on page 48


❑ Determine the location 
of the License Server.


Choose a location for the License Server that 
will support the deployment.


“Locating license 
servers” on page 49


❑ Determine the location 
of the EMC Smarts 
Global Managers.


Choose locations for the one or more Global 
Managers that will support the deployment.


“Locating the Global 
Managers in the 
network” on page 50


❑ Determine if the Service 
Assurance Manager 
must be configured with 
failover.


Determine if a high-availability configuration is 
required.


“Considering failover 
(high availability) 
configurations” on 
page 51


❑ Determine if acceptance 
tests are required.


Acceptance tests may be required for different 
portions of functionality. Be aware of the 
requirements and develop acceptance criteria.


“Designing 
acceptance tests” on 
page 52
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CHAPTER 4
Designing for Topology Operations


This chapter describes considerations for importing and organizing topology. The EMC 
Smarts Service Assurance Manager Configuration Guide provides additional details about 
the methods for importing and organizing topology. 


This chapter contains the following information:


◆ Designing topology synchronization........................................................................  56
◆ Designing topology groupings.................................................................................  58
◆ Designing topology operations checklist .................................................................  58


The EMC Smarts Business Impact Manager User Guide and the EMC Smarts Adapter for 
Alcatel-Lucent 5620 SAM EMS Installation Guide provide information on business and 
application topology.
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Designing topology synchronization
A Global Manager imports topology from configured underlying EMC Smarts domains. The 
topology sources are specified in the Global Manager’s ics-default.xml file located in the 
BASEDIR/smarts/conf/ics directory. A Global Manager synchronizes its topology 
whenever any of the following occurs:


◆ The Global Manager is started.


◆ A reconfiguration to an underlying server is required.


◆ The analysis domain is reconnected after a connection loss or a restart.


◆ The analysis domain performs a full or incremental discovery, or rediscovers an object; 
or a manual discovery is initiated.


Understanding topology synchronization


The Global Manager maintains an abstracted representation of the topology discovered by 
the Domain Managers and the topology from the Adapter Platform. When the Domain 
Manager completes a discovery, the Global Manager resynchronizes the topology from the 
Domain Managers. 


In all cases, the Global Manager does a full topology synchronization, even when only one 
device is added to an underlying domain. This means that topology synchronization is 
most efficient when it occurs less frequently, but with larger sets of changed devices. The 
Global Manager resynchronizes topology after a single device discovery, a pending 
discovery, or a full rediscovery. 


Another important aspect of topology synchronization is synchronization between the 
Global Manager and the Adapter Platform. The Adapter Platform is typically configured to 
contain some of the topology from the IP Availability Manager. With this topology, the 
Adapter Platform matches events to devices managed in the IP Availability Manager. So, 
the Adapter Platform often contains all of the IP Availability Manager topology and also 
some topology created based on events received as traps, or from other sources. 


When the Global Manager synchronizes topology with the Adapter Platform, the topology 
inherited from the IP Availability Manager, as well as the topology created due to events 
from traps or other sources, is synchronized. This means that a Global Manager may 
synchronize topology twice when a change is made to a device in IP Availability Manager: 
once with the IP Availability Manager and then once with the Adapter Platform.


The Adapter Platform does not contain all of the topology from the IP Availability Manager. 
So, the synchronization it performs with the Global Manager for the topology from IP 
Availability Manager is less performance-intensive than the synchronization between the 
Global Manager and the IP Availability Manager.


Topology synchronizations in the Global Manager may be done concurrently. If there are a 
number of underlying domains that need to synchronize topology at the same time, the 
Global Manager may synchronize these at the same time. In most cases, this gives optimal 
performance. However, if there are many concurrent topology synchronizations, the 
performance of the Global Manager may be adversely affected. Also, topology 
synchronizations overall may take longer due to the contention caused by many 
concurrent threads updating the Global Manager repository. 
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Planning for topology synchronization


If there is a large number of underlying domains and the topology of each changes 
frequently, it is likely that the Global Manager will often be required to perform multiple 
concurrent topology synchronizations. 


To optimize Global Manager performance, it is best to reduce the number of small 
discoveries, and instead have a smaller number of larger discoveries. Also, if full 
rediscoveries are scheduled, Global Manager performance can be improved by staggering 
the times of full rediscoveries of the underlying domains.


Finally, if you expect a constantly changing network with a large number of discoveries, 
you may want to reconsider your Global Manager configuration. If you are not already 
planning on implementing a hierarchical aggregation Global Manager configuration or 
hierarchical mesh Global Manager configuration, consider using one of these 
configurations. “Determine the Service Assurance configuration” on page 36 provides 
additional information.
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Designing topology groupings
Topology grouping is a visual tool that does not affect Global Manager performance. 
Groups help organize topology elements. The groups can represent resources, 
geographical areas, business areas, or entities of other organizations. 


Think about groups in terms of the business needs: Is your topology divided by region? 
Does the topology correspond to business units? Is the topology allocated by customer or 
function?


Groups are organized into parent and child groups. A group can contain both members 
and child groups. When planning group organization, you should try to restrict each group 
to hold only members or only child groups. The Map Console will not show the members of 
a group if the group also contains child groups.


There are two ways to create groups. The first method uses matching patterns entered 
through a Global Console. This method creates selective groups. The second method 
relies on a file to determine group hierarchy and membership. This method creates 
hierarchical groups.


For selective groups, you must define three properties to organize your groups: matching 
criteria, priority, and target classes. You define hierarchical groups and their members by 
using files. One file contains groups and child groups, which can also include members or 
links to files that contain members.


The EMC Smarts Service Assurance Manager Configuration Guide provides additional 
information about topology groupings.


Designing topology operations checklist
Table 9 on page 58 contains the designing topology operations checklist. Each chapter in 
this guide includes a checklist. “Design and Deployment Checklists” on page 107 contain 
all available checklists.


Table 9  Designing topology operations checklist 


Complete Task Description
Related 
documentation


❑ Review topology 
synchronization 
issues.


Ensure that you understand how topology 
synchronization affects Global Manager performance.


“Understanding 
topology 
synchronization” on 
page 56


❑ Plan topology 
synchronizations.


To optimize Global Manager performance, it is best to 
reduce the number of topology synchronizations where 
possible. 


“Planning for 
topology 
synchronization” on 
page 57


❑ Plan topology 
groups.


Topology grouping is a visual tool that doe not affect 
Global Manager performance. Groups help organize 
topology elements.


“Designing topology 
groupings” on 
page 58
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CHAPTER 5
Planning for Notifications


This chapter covers the basics of notification handling for the Global Manager, the Adapter 
Platform, and clients of the Global Manager. The design and deployment of notification 
handling is an iterative process. Start with a basic configuration and make adjustments 
based on results. The chapter contains the following information:


◆ Overview of notification processing.........................................................................  60
◆ Designing trap processing .......................................................................................  62
◆ Trap processing performance ..................................................................................  65
◆ Planning for notifications checklist..........................................................................  66
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Overview of notification processing
In a typical configuration of the Global Manager, there are two types of information 
sources: the Adapter Platform, which handles information from third-party applications, 
and the underlying EMC Smarts Domain Managers. After the Global Manager processes 
the information, it forwards the results to end users through clients such as the Global 
Console or an adapter that sends information to third-party applications.


Figure 8 on page 60 is an example of a basic Global Manager configuration. The lines 
show how information enters through either an IP Availability Manager (or other 
underlying Domain Managers) or an Adapter Platform, is passed to a Global Manager, and 
finally is passed to an end user or application. Note that the figure does not show the 
connection that transports topological information between the IP Availability Manager 
and the Adapter Platform.


Figure 8  Flow of event information in a basic Global Manager configuration


The Adapter Platform imports topology and event information from third-party 
applications and prepares it for use by the Global Manager; data from third-party 
applications should not be sent directly to the Global Manager. The Adapter Platform 
creates notifications from the incoming information and can even associate these 
notifications to topology information supplied by another EMC Smarts application. This 
connection is not shown in Figure 8 on page 60.
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Efficient notification processing presents the most important information to the operator 
who uses a Global Console. One of the goals of deployment design is to plan to optimize 
the flow of notifications sent through the system. This improves the performance of the 
deployment and the performance of the operators who use EMC Smarts products. 


Notifications from the Adapter Platform


Ensure that only the notifications that are useful to Global Console operators reach the 
Global Manager. When EMC Smarts software is first deployed, a strategy to reduce and 
control the flow of notifications from the Adapter Platform to the Global Manager 
temporarily is used. This is to prevent any notifications from the Adapter Platform from 
being forwarded to the Global Manager by using notification list filtering. Use the Global 
Console to connect directly to the Adapter Platform and observe the notifications there; 
evaluate the notifications. Then, modify the notification list to forward useful notifications 
to the Global Manager.


Configuring notifications for clients


Notification lists are the mechanism that clients use to subscribe to and receive 
notifications from a Global Manager. Smaller notification lists produce better performance 
in both the client and the Global Manager. 


Notification lists are associated with user profiles—one list per profile. When designing 
notification lists for consoles, attempt to design them not to typically include more than 
500 active notifications.


It is more efficient to prevent a notification from being sent to an EMC Smarts client by 
using a notification list than to use a filter to remove the notification from the Notification 
Log view at a client’s console. These filters do not curtail the output of notification lists 
and do not provide any performance benefit to the Global Manager.


“Designing notification lists” on page 71 provides information about configuring clients to 
receive notifications.

Overview of notification processing 61







Planning for Notifications

Designing trap processing
Any EMC Smarts deployment should include a plan to handle trap processing. This section 
covers one method.


Recommended trap processing design


Figure 9 on page 63 presents the recommended design for trap processing. This 
configuration relies on two instances of the SNMP Trap Adapter to handle trap processing 
and performs well under the stress of high volumes of traps.


Instance 1 of the adapter is configured as a trap exploder that receives and forwards traps. 
In this configuration, the trap exploder does not process traps into notifications or use any 
ASL scripts for sophisticated trap processing. The trap exploder’s sole function is to filter 
and forward traps as follows:


◆ IP Availability Manager-required traps are forwarded to IP Availability Managers.


◆ Traps required for other EMC Smarts domains are forwarded to the proper domain. 


◆ Other useful traps are forwarded to Instance 2 of the SNMP Trap Adapter for 
processing into notifications. These traps provide meaningful or actionable 
information to the administrators of the network.


◆ Traps may be received in SNMP v1, v2c, or v3 formats; however, they are forwarded on 
to the Adapter Platform or to other Domain Managers as SNMP v1 or v2c only.


◆ Other traps that administrators do not consider useful can be forwarded to an unused 
port to reduce overhead at the SNMP Trap Adapter. Normally, the adapter logs an error 
message for each trap that is not forwarded. This practice eliminates the processing 
associated with error message logging. Another benefit is that forwarding these traps 
to a location permits you to set up a tool to collect the traps. 


Instance 2 of the SNMP Trap Adapter performs the typical processing of traps into 
notifications and may invoke ASL scripts for advanced processing. This instance does not 
forward any traps.


The two SNMP Trap Adapter instances are invoked using different configurations. The 
following is the typical configuration when the instances are on a single host:


◆ The trap exploder, Instance 1 of the SNMP Trap Adapter, uses 
BASEDIR/smarts/local/conf/trapd/trapd.conf. This trapd.conf file includes trap 
forwarding statements and indicates the port to use when listening for traps.


◆ Instance 2 of the SNMP Trap Adapter processes traps into notifications and uses 
BASEDIR/SAM/smarts/local/conf/icoi/trapd.conf and 
BASEDIR/SAM/smarts/local/conf/icoi/trap_mgr.conf. This instance of the trapd.conf 
file does not include trap forwarding statements. (If the Trap Adapter was installed as 
a service, these traps will be forwarded to the Adapter Platform by default). The 
trap_mgr.conf file includes definitions for all traps that will be forwarded as 
notifications.


The trapd.conf files installed with IP Availability Manager and IP Performance Manager can 
be configured to permit the IP Availability Manager and the IP Performance Manager to 
forward traps by using their built-in trap receivers. This capability should not be used 
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except for testing deployments or when migrating traps from multiple locations to one 
destination. The EMC Smarts Service Assurance Manager Adapter Platform User Guide 
provides a complete description of the SNMP Trap Adapter.


Figure 9  Recommended trap processing design


Batching to improve performance
In a deployment where a high frequency of traps is expected, plan on using the batching 
capability of the SNMP Trap Adapter to improve performance of clients that process the 
notifications. The BATCH_NOTIFY_INTERVAL in the trap_mgr.conf configuration file 
determines the length of the interval. It may be necessary to fine tune this value under the 
typical trap load, so plan on monitoring the client performance and adjusting this value.
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Listening for traps
The SNMP Trap Adapter configured as the trap exploder should listen for traps on the 
standard port that network devices use when forwarding traps. Typically, this is port 162.


If another application is listening for traps at this port, the application should be moved 
and the trap exploder can forward needed traps to the application’s new location. The 
SNMP Trap Adapter is usually a better choice for forwarding traps than other third-party 
software applications because the adapter can be limited to the forwarding function.


The second instance of the SNMP Trap Adapter can listen on any port, but the trap 
exploder must be configured to forward the appropriate traps to this port.


Trap forwarding


When defining trap forwarding, traps required by underlying EMC Smarts domains are 
already defined in the trapd.conf file. The only change that you must configure is to specify 
the specific destination hosts and ports where the domains listen for traps. This change is 
only necessary in the BASEDIR/smarts/local/conf/trapd/trapd.conf file for the trap 
exploder instance of the SNMP Trap Adapter (Receiver).


Always try to minimize the volume of traps that are forwarded from the trap exploder to the 
second instance of the SNMP Trap Adapter. If network administrators do not use the traps, 
discard them by sending them to a nonexistent address. Judicious forwarding of traps can 
reduce or eliminate stressful trap processing loads. Deployment administrators should be 
aware of how traps are discarded so that they can choose to discard other useless traps as 
their experience with the network grows.


Each trap that is transformed into a notification will require an entry in the trap_mgr.conf 
file. If an entry does not exist, the trap should not be forwarded to the second instance of 
the SNMP Trap Adapter.


Traps and notifications
When configuring the SNMP Trap Adapter to process traps, you must decide which traps 
should become notifications and how the notifications should appear at the Global 
Console. This is defined in the trap_mgr.conf configuration file which is described in the 
EMC Smarts Service Assurance Manager Adapter Platform User Guide.


Advanced trap processing by using ASL scripts
The EMC Smarts Service Assurance Manager Adapter Platform User Guide provides 
specific information on advanced SNMP Trap integration. Typically, the ASL scripts (hook 
scripts) will extract event text or other important information from network sources to 
populate the user defined fields in the notification.


Include as much of the ASL processing definition as possible in the deployment build 
guide. When the ASL scripts are complete, the code should be documented in the 
deployment build guide.
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Trap processing performance
The following processing issues impact performance directly:


◆ Filtering traps in trap_mgr.conf


◆ Using trap manager hook scripts


◆ Adding new topology for received traps


◆ Looking up host names


◆ Batching traps


Consider them as you design and configure trap processing in your environment.


Filtering traps in trap_mgr.conf


The number of traps that are processed and specified in trap_mgr.conf is a factor in 
performance. The smaller the number of received traps processed as events, the higher 
the overall rate of processing.


With trap receiver you can import subsets of traps into the Adapter Platform. Large 
numbers of traps may be sent by network devices, but typically only a small subset are 
important to network operators. For example, link up and down traps are sent frequently 
by devices but are not typically important to display to the network operator since the IP 
Availability Manager already supplies authentic, root-cause problems related to these 
traps. 


Using trap manager hook scripts


With the trap manager, you can customize trap processing by using an ASL hook script. 
Typically, this additional processing causes performance to be slightly slower than if no 
ASL hook scripts are used.


Adding new topology for received traps


The trap manager allows the Adapter Platform to create a topology element if a trap is 
received for an element that is not already in the topology. The performance declines 
whenever a large percentage of the traps processed result in topology creation and 
increases whenever all traps relate to existing topological elements.


Looking up host names 


The trap processing logic may require a reverse host name lookup to find the logical name 
of the element sending a trap based on the IP address. The speed of this host name 
lookup in a particular customer’s environment may have a significant impact on trap 
processing rates. For example, if a customer uses a DNS host lookup and a large number 
of traps are received for devices not listed in DNS, DNS time-outs may significantly impact 
trap processing performance.
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Batching traps


Configuring the trap manager to batch traps for the same notification results in improved 
performance due to the reduced number of notifications and updates that need to be 
processed.


The trap manager has an option to batch traps whenever multiple traps for the same 
notification are received within a configurable number of seconds. For example, if 50 
identical traps are received from a single device in 2 seconds, the result is 50 updates to 
the same notification. All clients receiving these notifications would receive 50 updates to 
the notification. Setting a two-second batch interval, however, means that there is only 
one update to the notification, even though 50 traps were sent.


Configuring trapd.conf file to manage flooding of traps


In order to avoid the trap receiver and trap exploder from crashing due to flooding of traps, 
the default values for the QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS parameters in 
the trapd.conf file are set to 200 MB and 480 seconds, respectively. On reaching the limits 
set using these parameters, the sm_trapd queue starts discarding traps. An alert, 
trapdDiscardingTraps, which is defined in the trap_mgr.conf file is triggered when the 
queue starts discarding traps. If and when a device is identified as the source of a trap 
storm, information about it is logged in the sm_trapd log file.


The EMC Smarts Service Assurance Manager Adapter Platform User Guide provides details 
on the parameters in the trapd.conf file. 


Planning for notifications checklist
Before discovering the network, the requirements mentioned in Table 10 on page 66 must 
be completed. Each chapter in this guide includes a checklist. “Design and Deployment 
Checklists” on page 107 contains all available checklists.


Table 10  Planning for notifications checklist


Complete Task Description
Related 
documentation


❑ Determine which 
notifications are important 
for EMC Smarts operators.


Ensure that only the notifications that are useful 
to Global Console operators reach the Global 
Manager.


“Overview of 
notification 
processing” on 
page 60


❑ Configure notification lists. Notification lists are the mechanism that clients 
use to subscribe to and receive notifications 
from a Global Manager. 


“Configuring 
notifications for 
clients” on 
page 61


❑ Design trap processing. Any EMC Smarts deployment should include a 
plan to handle trap processing.


“Recommended 
trap processing 
design” on 
page 62
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CHAPTER 6
Designing for EMC Smarts Users


This chapter describes how best to use EMC Smarts clients to satisfy the needs of 
operators, including providing appropriate access rights to monitoring and administration 
functions. This chapter contains the following information:


◆ Determining the Global Manager users....................................................................  68
◆ Choose a console for types of users ........................................................................  68
◆ Designing user profiles ...........................................................................................  71
◆ EMC Smarts user design checklist ...........................................................................  73
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Determining the Global Manager users
When designing your deployment, you must determine who will use the Global Consoles 
and for what purposes. Initially, it is not necessary to define individual users — consider, 
instead, broad functional categories of users with similar needs and characteristics. 


Name these categories of users, and list their requirements in the deployment build 
guide. Using specific position names as categories can make the process easier. For 
example, you might create one or more of these categories: application engineer, 
application administrator, application support specialist, network engineer, network 
administrator, network support specialist, NOC manager, NOC operator, LAN 
administrator, and IT management. After you choose categories, determine the typical 
EMC Smarts-related duties that are performed by the individuals in these categories. You 
may find that as you list the duties, you have to expand or combine certain categories. 
After the categories are completely defined, list them and their specific needs in the 
deployment build guide.


For example, Table 11 on page 68 defines two typical user categories.


Choose a console for types of users
EMC Smarts consoles have different capabilities. For each type of user and their 
equipment, determine which console is most appropriate:


◆ Global Console can provide all functions and all views to operators. Administrators 
can restrict console operations so that operators have only the specific functionality 
that they require.


◆ Web Console can also provide all functions and all views that are available from the 
Global Console, except for the Topology Browser Console. As with the Global Console, 
most console operations can be restricted.


Table 11  Examples of EMC Smarts user categories


User category Description of needs or duties


Network engineer Administers and maintains local and wide area networks and 
related hardware. Monitors daily activity, enforces licensing 
agreements, and provides front line support, including both 
software and hardware support.
• Needs monitoring access to all EMC Smarts domains.
• Needs to see all important traps, notifications, and 


network outages.


Local area network 
administrator supporting a 
customer of a Service 
Provider


Directs the daily operational availability of the hardware and 
software systems required to support facility operations. 
Directs and oversees scheduled testing and review of 
hardware and software to ensure that potential problems are 
identified as soon as possible. Analyzes, evaluates, and 
builds cost effective LAN solutions that leverage resources 
and technology to meet business requirements. Designs, 
creates, and distributes user documentation relating to 
installation of software:
• Needs monitoring access to the EMC Smarts domain that 


supports the customer, but not access to any other 
domains.


• Needs to see all important traps, notifications, and 
network outages for the customer’s EMC Smarts domain.
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◆ Business Dashboard provides access to the results of EMC Smarts analysis through 
one or more Dashboard viewlets implemented as Java applets. A Dashboard viewlet is 
a Java application that shows a particular aspect of Service Assurance information 
such as notifications, containment, or maps. Dashboard viewlets provide operational 
functions, but no administrative functions. 


A Global Console, a Web Console, and a Business Dashboard (on a single browser using 
one Java Virtual Machine) showing similar content, all use the same resources. This is 
regardless of the number of viewlets displayed by the Business Dashboard.


Deployment considerations for client consoles


Each of the available Client Consoles has different deployment considerations.


Typically, the Global Console is deployed by installing EMC Smarts software on the user’s 
system, but the Global Console can also be accessed by using the X Windows server 
software on the user’s system when the Global Console runs on a remote UNIX server. If 
using X Windows, the client that displays the application over X does not require Java.


The Web Console can be deployed in two ways: 


◆ As a typical Java applet where the HTML and JAR files are located on the host where 
the Business Dashboard is installed. When a user opens the Web Console, the JAR 
files are loaded over the network to the user’s Web browser.


◆ By using Java Web Start, which integrates the Web Console with the user’s desktop. 
This enables users to start the Web Console directly from their desktop without using 
a Web browser. 


With both methods, the JAR files are loaded over the network during the initial connection 
but then saved to the user’s local system. Subsequent connections use the cached files to 
optimize the use of network resources. 


An installation of the Business Dashboard includes the Tomcat Servlet Engine, which is 
necessary to serve the JAR files and map layout servlet. The servlet engine is installed as 
the EMC Smarts Servlet Engine service on the system where you install the Business 
Dashboard. If you wish to serve Dashboard viewlets from a different Web server, you must 
install the Business Dashboard to obtain the necessary files.


Users and security


When defining the functional categories for users, consider the EMC Smarts security 
implementation. For each user category, determine the following:


◆ List the specific EMC Smarts managers that must be accessed by the users in the 
category. If necessary, divide a category. For example, in a category of network 
administrators, some users require access to managers in Asia, other users require 
access to managers in Europe, and still other users require access to all managers. In 
this case, the network administrators category could be divided into three categories 
to match these user needs while maintaining tighter security.


◆ Determine what functionality must be accessed by users in this category. EMC Smarts 
software is designed so that users can be classified into levels that define access:


• All - A level where users can access all Global Console functionality available for 
one or more EMC Smarts Managers, if their user profile permits it.
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• Monitor - A level where users can access only Global Console monitoring 
functionality, not administrative functionality, at one or more EMC Smarts 
Managers, if their user profile permits it.


• Ping - A level normally reserved for EMC Smarts processes, where processes will 
ping hosts where other EMC Smarts processes are installed to determine if the 
hosts are running.


• None - A level that specifically excludes access to the Global Console.


These types of security access are defined in the serverConnect.conf file located in the 
BASEDIR/smarts/local/conf directory on the servers where EMC Smarts software is 
installed.


Password configurations
Determine how you will configure EMC Smarts passwords. You can do any or all of the 
following:


◆ Allow the host operating system to validate users. This method provides the highest 
level of security and is easy to manage because it relies on the security 
implementation that is already in place. There are two variations: Any valid user can 
access one of the EMC Smarts levels (All, Monitor, Ping), or specific users can access 
a specific EMC Smarts security level. Defining specific access requires more 
maintenance because you must list the user names in the configuration files 
(serverConnect.conf and clientConnect.conf). The EMC Smarts System Administration 
Guide defines methods to configure and to secure access for these files.


◆ Specify unique passwords for individual users. Consider this method only when there 
are very few users because it requires a high level of maintenance. 


This is less secure than permitting the host to validate users. Plan on using the 
EMC Smarts password encryption mechanism. The EMC Smarts System 
Administration Guide provides information on using this encryption mechanism.


◆ Specify a common user name with a common password. This method is the least 
secure, but very easy to maintain. The EMC Smarts System Administration Guide 
provides information on using this.


You can combine these methods, for example, you could restrict administration (All) 
capabilities to specific users validated by the operating system. In addition, you could 
provide Monitor level abilities to a general EMC Smarts user named, Monitor.
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Designing user profiles
The functional grouping of users and their requirements form the basis of EMC Smarts 
user profiles. These profiles combine access to notification lists, console operations, 
custom console layouts, and specific tools. 


Create a profile for each category of user that you must support. Groups of users with 
similar needs can then be assigned the same user profile.


If needed, you can further customize a generic user profile by copying it and then 
modifying it for more specific needs. For example, an administration user profile could be 
customized for less experienced administrators by restricting access to some 
administrative console operations and tools. Other possible user profiles could include 
regional or customer-specific consoles.


Designing notification lists


A notification list determines the events that are forwarded to a user. Essentially, the list 
filters the notifications that are sent from the Global Manager and can be assigned to one 
or more users. The lists can be organized by:


◆ Business units


◆ Geographical regions


◆ Groups of resources


For example, a notification list can be defined to allow only notifications from the 
subnetworks devoted to a specific ISP customer to reach the Global Console of the 
customer’s network administrator. “Configuring notifications for clients” on page 61 
provides additional information.
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Restricting console operations


Most operations that can be performed at the Global Console can be individually enabled 
or disabled in the user profiles. When used with the security levels, restricting console 
operations can fine tune user access to functionality and further protect the deployment. 


For example, consider two users who have the Monitor security level that allows access to 
Global Console monitoring functionality, but not administrative functionality, for an 
EMC Smarts Manager. You can further restrict one of the viewers to see only the Summary 
view and the IP Network Map while restricting the other user to the Notification Log and 
the Topology Browser.


Designing consoles


Specific console layouts can be saved and then automatically provided to match user 
needs at the Global Console, Web Console, and Business Dashboard. Layouts including 
the Notification Log view, Map view, Summary view, Status Table view, Notification 
Properties view, and Containment view can be used to create a custom console layout for 
Global Console and Web Console users. These same views can be provided to Business 
Dashboard users as Dashboard viewlets. Another view, the Topology Browser view, can be 
used only in layouts for Global Console and Web Console users.


Filtering the Notification Log view at the Global Console or Web Console does not affect 
Global Manager performance, but it can be used to create a simpler, more useful 
Notification Log view for groups of users. Properly configured filters can be used to 
customize notification consoles for groups of users. In addition, specific views can be 
automatically provided to match user needs.


Topology Browser views (not Map views) are more resource intensive than others. 
Carefully consider the information that operators require before including the Topology 
Browser view in a console layout.


All console layouts are created by using the Global Console and then deployed by copying 
them to appropriate directories on the Global Manager.


Planning for tools and tool deployment


Many types of client and server tools can be designed and developed for users. Typically, 
creating tools will require different levels of programming skills based on their complexity. 
Plan to have individuals with the appropriate skills available to create the tools. In 
addition, determine which tools should be available to which users through their user 
profiles.
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EMC Smarts user design checklist
Each chapter in this guide includes a checklist. “Design and Deployment Checklists” on 
page 107 contains all available checklists.


Table 12  Client and user design checklist


Complete Task Description
Related 
documentation


❑ Define functional 
groups for users.


List the broad functional groups that users will belong to 
and then define the needs and duties of each group. Add 
this information to the deployment build guide.


“Determining the 
Global Manager 
users” on page 68


❑ Choose 
appropriate 
EMC Smarts 
clients for users.


EMC Smarts consoles have different capabilities. For 
each type of user and their equipment, you must 
determine which console is most appropriate. Document 
your choices in the deployment build guide.


“Choose a console 
for types of users” on 
page 68


❑ Define how you 
will implement 
security for user 
groups.


When defining the functional categories for users, 
consider EMC Smarts’s security implementation. 
Document the implementation in the deployment build 
guide.


“Users and security” 
on page 69


❑ Define the 
notification lists 
in EMC Smarts 
user profiles.


The Notification List determines which notifications are 
sent from the Global Manager to the EMC Smarts client. 
Carefully define the Notification Lists, as they can affect 
Global Manager performance. Document the notification 
list provided for each user profile in the deployment 
build guide.


“Designing 
notification lists” on 
page 71


❑ Design console 
operations 
access.


Most operations that can be performed at the 
EMC Smarts clients can be individually enabled or 
disabled in the user profiles. Document the access 
provided for each user profile in the deployment build 
guide.


“Designing consoles” 
on page 72


❑ Design console 
layouts.


Specific console layouts can be saved and automatically 
provided to match user needs at the Global Console, 
Web Console, and Business Dashboard. Document the 
console layout used in each user profile in the 
deployment build guide.


“Designing consoles” 
on page 72


❑ Design client and 
server tools.


Define the necessary tools that users must access and 
the levels of programming skills required to create the 
tools. Document this information and tools provided by 
each user profile in the deployment build guide.


“Planning for tools 
and tool 
deployment” on 
page 72
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CHAPTER 7
Deploying Business Impact Processing


The EMC Smarts Business Impact Manager calculates the impact of infrastructure and 
application events on business services. This chapter describes the choices that must be 
made when designing business impact processing, and contains the following 
information:


◆ Designing business impact processing....................................................................  76
◆ Importing information .............................................................................................  77
◆ Business Impact Manager design checklist .............................................................  79


The EMC Smarts Business Impact Manager User Guide provides complete configuration 
details.
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Designing business impact processing
Business Impact Manager uses information from a Global Manager in conjunction with 
user-defined criteria to calculate the business impacts of infrastructure and application 
events.


To design business impact processing, you must consider at least these things: 


◆ Business processes to model


◆ Topology of the business processes and the underlying infrastructure


◆ Impact (weight) caused by issues in the topology


Business processes


When designing a Business Impact Manager implementation, consider the company’s 
business processes. Try to answer the following questions:


◆ Which business processes exist?


◆ Which business processes depend on applications or network devices?


A business process represents functions and operations that support the internal 
business activities of an enterprise. In the manufacturing sector, for example, business 
processes include order processing, production planning, accounting, fulfillment and so 
on. Each of these may depend on different applications in order to operate as well as on 
network devices to pass information among and between applications and processes. 


In a hypothetical situation, an order comes into a company and is processed. The 
processing involves entering the order into a Customer Relationship Management (CRM) 
application and simultaneously sending it to accounting for approval and fulfillment for 
shipping. Underlying accounting is a financials application and underlying fulfillment is a 
logistics application. Fulfillment begins preparing the order for shipping but cannot 
release the order until it receives approval from accounting. After accounting approves the 
order, it notifies both fulfillment and ordering through a financials application that 
updates both the logistics and CRM applications. If a network device that supports the 
financials application exhibits problems, the fulfillment and CRM applications will not 
receive necessary updates, which has an impact on the business.


Try to map these dependencies in preparation for creating business topologies and 
weighing the impacts of problems on these processes. In the hypothetical situation, 
updating the logistics application, after accounting approves the order, may be a higher 
priority than updating the CRM application. 


Business topology


After you have established the business processes, create a business topology to model 
them. The Business Impact Manager has special elements to describe business 
processes, including ServiceOffering, BusinessProcess, ServiceSubscriber, Customer, and 
others. The Business Impact Manager provides flexibility in classifying elements, but be 
consistent in your choices.
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The names of these business elements or entities must be unique. The Global Manager 
assigns prefixes to the names of business elements to identify elements, but their display 
names do not include this prefix. When importing topology, remember to specify these 
names. When using a custom adapter to import topology, the element names must 
include the prefix.


The relationship between elements in the business topology is defined as part of an 
element’s definition. The next step in designing the business topology is to define 
relationships between business elements and other elements. As you do this, consider 
the following:


◆ How do infrastructure and other events affect business elements?


◆ What are the critical elements upon which the business elements rely?


In the case of an internet service provider (ISP), ServiceOffering represents the 
connections between a customer and the ISP. ServiceSubscriber represents a customer. 
You can make other choices. In this example, a ServiceOffering is a specific contract to 
provide a connection to a ServiceSubscriber. The business topology gets linked to 
infrastructure elements through more definitions. The critical elements associated with a 
ServiceOffering are the customer routers. While the ISP edge routers are important, a 
ServiceOffering does not necessarily have to be associated with a particular router. When 
events affect customer routers, the ServiceOffering is directly affected. These routers are 
associated as members of the ServiceOffering. 


As the ISP does not manage the customer routers, the ISP has only ICMP access to those 
routers. The ISP could choose to represent those routers as hosts.


Weights: Impacts of issues in the topology


Weight values are optionally set to indicate the magnitude of a problem but are not 
necessary to a Business Impact Manager installation. When a root-cause event occurs, the 
Business Impact Manager sums the weight of the affected elements for a total impact, 
which is displayed with the root-cause: the greater the impact number, the greater the 
problem. You can assign weights by class, instance name, and instance. Wildcards can be 
used when you assign weights by instance.


There is no particular method to use to assign weights. Weights measure the relative 
importance of aspects such as revenue, contractual requirements, reputation, cost and so 
on.


One strategy to follow when assigning weights is to develop weights from parent classes, 
through subclasses, down to particular instances. If there is any overlap, the instance 
weight is used before the class weight, which is used before the parent class weight.


Importing information
There are two methods of importing Business Impact Manager information: import files 
and manually through a Global Console:

Importing information 77







Deploying Business Impact Processing

◆ For small Business Impact Manager configurations, such as demonstrations and test 
installations, manual configuration using the Topology Builder Console is a 
reasonable choice. Objects created through this console are stored only in the 
topology. You cannot modify elements not created with the Topology Builder or that 
are discovered by the underlying Domain Manager. Before you can use this console, 
you must set correct user privileges and permissions.


◆ For larger deployments, creating import files can ease the process. Import files provide 
an additional benefit in that they act as backup to the business topology. 


Do not use both methods to modify business topology. Elements added through one 
method are not modifiable by the other.


The structure of import files


When creating import files, consider the structure of the files. Especially when defining 
relationships, multiple files may be used to define one-to- many relationships. Business 
elements can be comprised of members and subscribers. Separate files may exist for 
these files or may exist for all of the different business elements. 


The import files define business elements and service data, related infrastructure, and 
lists of related elements. The lists of related elements can be very useful when 
constructing relationships among large groups of elements, subscribers, or applications. 


The EMC Smarts Business Impact Manager User Guide provides additional information.
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Business Impact Manager design checklist
Each chapter in this guide includes a checklist. “Design and Deployment Checklists” on 
page 107 contains all available checklists.


Table 13  Business Impact Manager design checklist


Complete Task Description
Related 
documentation


❑ Define relevant 
business 
processes. 


Determine the business processes to model. 
Record your choices in the deployment build 
guide.


“Designing business 
impact processing” 
on page 76


❑ Create a business 
topology.


Create business elements to model the business 
processes. Define the expectations of the model 
and the events it should analyze. Document your 
topology in the deployment build guide.


“Business topology” 
on page 76


❑ Assign weights to 
the elements of 
the topology.


This step is optional but allows you to assign a 
value to measure the impact of events that occur 
in the topology. The weights of impacted 
elements are summed in the root-cause event. 
Record your choices in the deployment build 
guide.


“Weights: Impacts of 
issues in the 
topology” on 
page 77


❑ Choose a method 
for importing 
information.


If the topology is small, use the Topology Builder 
Console. For larger topologies, use one or more 
topology files. Record your choice in the 
deployment build guide.


“Importing 
information” on 
page 77
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CHAPTER 8
Deploying Service Assurance 


This chapter describes important design considerations when installing EMC Smarts 
software. This chapter should be considered as a supplement, not a replacement, for the 
installation guides included with the EMC Smarts Service Assurance Manager software 
and for the EMC Smarts System Administration Guide. This chapter contains the following 
information:


◆ General installation/deployment guidelines............................................................  82
◆ Configuring the Java clients to use a proxy server ....................................................  86


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides detailed installation procedures and the EMC Smarts System Administration 
Guide provides detailed configuration procedures.
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General installation/deployment guidelines
Many organizations have strict rules for deploying enterprise-level software which may 
include deployment of staging areas whenever possible. A staging area is a copy of the 
installation.


Never install a deployment during a normal production shift; instead, choose a period of 
low utilization for installation. If a test environment is not available, create a staging area 
(an environment that mirrors production) and make and test all changes in the staging 
area. 


If possible, install the deployment in stages to reduce the size and complexity of each step 
in the overall process. Doing so makes debugging easier. “Validating Your Deployment 
(Acceptance Testing)” on page 89 provides information on verifying each stage of the 
deployment.


EMC Smarts licensing


EMC Smarts licensing comes in two different forms: temporary and permanent. Temporary 
licensing is file-based, where each application uses a special license file. Permanent 
licensing uses a licensing server.


Information to collect for permanent licensing
For permanent licensing, EMC Smarts products rely on FLEXnet licensing software and a 
license file provided by EMC Smarts. 


The FLEXnet software is installed with the EMC Smarts software, but a license file from 
EMC Corporation is also required. The license file must be installed by using the 
install_license script. The EMC Smarts System Administration Guide provides additional 
information on using this script. To generate the license, EMC Corporation needs the 
following information for the computer where the FLEXnet license server is running:


◆ The host ID


◆ The operating system


◆ The installation path to BASEDIR/smarts/bin on your Broker (or to the EMC Smarts 
installation from which you want to run the license server).


Send this information to the licensing@emc.com e-mail address to ensure that an 
appropriate license is available for the deployment. 


Locating the license server
It is best to install the license server on the same host as the Broker. Both the license 
server and the Broker need to be able to communicate with various EMC Smarts 
applications. 


Multiple license servers
When multiple license servers are used, each Domain Manager will use blocks of volume 
licenses from a specific license server. Therefore, the license blocks must be divided 
among multiple licenses; the appropriate license must be deployed to each license server. 

82 EMC Smarts Service Assurance Manager Deployment Guide







Deploying Service Assurance

Then, Availability Managers that rely on a specific license server will have the appropriate 
volume licenses to support the systems they manage. If multiple license servers are used, 
ensure that EMC Corporation is aware of the configuration details.


EMC Smarts Service Assurance installation and configuration


As you install EMC Smarts applications, configure each application before installing the 
next application. The following installation order is recommended:


1. Broker (normally installed and configured when the first EMC Smarts components are 
installed)


2. A Global Console to use to verify the installation of other applications


3. Underlying domains (IP Availability Manager, IP Performance Manager, Network 
Protocol Manager and so on) with associated adapters


4. Global Manager which includes Business Impact Manager, if licensed


5. Adapter Platform


6. EMC Smarts Adapters (that use Adapter Platform as a server)


7. Global Consoles for end users


To ease troubleshooting of the initial deployment, install limited segments of the 
deployment first. Always configure and validate a segment before installing the next 
segment.


By default, all EMC Smarts applications are installed as services and are started 
immediately after installation. During deployment, you should set the services to start 
manually until your installation, configuration, and validation are complete.


Setting environment variables
Setting inappropriate values for environment variables is a common cause of 
post-installation problems. The EMC Smarts System Administration Guide provides 
detailed descriptions of the EMC Smarts environment variables, including methods for 
setting them.


Configure security


Usernames and passwords
For initial validation, use the default administration user name and password (admin and 
changeme). Once you have validated your installation, change the default administration 
user name and password.


Security configuration files and a Secure Broker
A Secure Broker is a broker that requires authentication for EMC Smarts applications to 
use it. By default, the Broker is not secure. Universal access is provided to all EMC Smarts 
applications. By changing the password associated with the Broker, you configure a 
Secure Broker. EMC Smarts applications need to use the username and password to 
register with the Broker and also to connect to the Broker to determine the location of 
server applications.
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Use and guard your EMC Smarts secret phrase
EMC Smarts components are installed using a default secret phrase. This phrase is used 
to encrypt passwords used in authentication and to encrypt communications between 
EMC Smarts components. 


It is recommended that you take advantage of the added level of security provided 
through the secret phrase and its related security mechanisms. To do this, you must 
change the secret phrase using sm_rebond and make it consistent at all your EMC Smarts 
installation sites. Due to the sensitive and vital nature of this secret phrase, store and 
guard the phrase as you would do with the root passwords of the most sensitive servers in 
your network.


Under certain circumstances, the loss of the secret phrase can force extensive 
reconfigurations and require reinstallations of all EMC Smarts components.


Propagating the secret phrase
The recommended method to change the secret phrase for an EMC Smarts deployment is 
to run the sm_rebond utility in each installation area. Under certain circumstances, you 
can use one machine to create and encrypt the different configuration files as well as the 
imk.dat file.


It is best to do the propagation before the other applications are started. If you want to 
propagate the files and the server has started but there are no SNMP V3 passwords in use, 
replace the connection configuration files. If you are using SNMP V3 passwords, you will 
need to replace the connection configuration files, delete the existing repository files 
(*.rps), and restart the server.


An alternative to propagating all of the files is to propagate imk.dat, then run it for each 
file requiring security on each installation:


sm_edit --noedit <filename>


Deploy Business Impact Manager


Deploying the Business Impact Manager consists of the following tasks:


◆ Modify weights by changing weights.conf and applying the change using the ASL 
script, ICS_RemoteConfig.asl. Unless the weights are modified, each element will 
have the same value.


◆ Import business data by using the Topology Builder Console.
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Deploy user configurations


Deploying the user configurations consists of these tasks: 


◆ Configure access to the software by adding user names and passwords to the security 
files (clientConnect.conf and serverConnect.conf). The EMC Smarts System 
Administration Guide provides additional information. These files define the security 
level for each user, including user capabilities, servers that can be accessed, and 
passwords.


◆ Configure users:


• Deploy and configure tools. Server tools must be copied to the server where the 
Service Assurance Manager is installed and client tools must be copied to all 
systems where Global Consoles are installed.


• Create console configurations and then save them on the server where the Global 
Manager is installed. Create each console configuration by opening the Global 
Console and then arranging the layout and customizing preferences. Save the 
customized console. 


• Define customized Notification Lists.


• Create user profiles that associate individual users with access to specific tools, 
consoles, and a Notification List.


The EMC Smarts Service Assurance Manager Configuration Guide provides 
configuration information.
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Configuring the Java clients to use a proxy server
You can configure the Web Console, Business Dashboard, Dashboard viewlets, and Global 
Console to use a proxy server to communicate with EMC Smarts applications (for example, 
Availability Manager and Global Manager) that reside behind a firewall. Using a proxy 
server reduces the number of firewall ports that need to be opened to one firewall port.


For example, Figure 10 on page 86 illustrates a typical deployment where a web server 
acts as the proxy server.


Figure 10  Example of a deployment with a proxy server


Before you configure these Java clients, ensure that the web server that will act as the 
proxy satisfies the requirement. “Requirement for proxy server” on page 88 provides 
additional information.


To configure the Java clients to use a proxy server, perform the following steps:


1. Your firewall administrator needs to open Port 80 on the firewall to enable 
communications between the client and a web server.


Through a series of requests, the client communicates with a web server and that web 
server acts as the proxy to the EMC Smarts applications.


2. Use the sm_edit utility to add the Proxy properties described in Table 14 on page 87 to 
the appropriate properties file:


Public Network


Business Dashboard or Web Console or Global Console


Host 1
AM/PM Manager


Host 2
Service Assurance 


Manager 


Host 3
Broker on Port 426


Web Server on Port 80 (Proxy Host)


Firewall accepting connections on Port 80


Local Area Network (Private network protected by the firewall)
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• If you are using the Web Console (or Java Web Start), modify the 
webconsole.properties file in the BASEDIR/smarts/tomcat/webapps/webconsole 
directory.


• If you are using the Business Dashboard and viewlets, modify the 
dashboard.properties file in the BASEDIR/smarts/tomcat/webapps/templates 
directory. 


• If you are using the Global Console, modify the 
BASEDIR/smarts/conf/console/properties.conf file on the machine where the 
Global Console is running. 


The parameters, com.smarts.proxyAuthString and com.smarts.proxyAdditionalHeaders, 
are optional. 


For com.smarts.proxyAuthString, the value would depend upon the type of authentication 
scheme the web server supports. For example, if it supports Basic Access Authentication 
Scheme, and if the Username is “User” and Password is “Password”, the value would be:


"Proxy-Authorization: basic VXNlcjpQYXNzd29yZAo=\r\n"
Then, string “VXNlcjpQYXNzd29yZAo=” would be the base64 encoding of, 
“User:Password”.


For com.smarts.proxyAdditionalHeaders, the value could be any valid HTTP request like 
this, for example:


▼"GET http://www.example.com HTTP/1.1 \r\nHost: example.domain.com 
\r\n"▲ 


3. Modify the proxy connection settings in Internet Explorer. (This step is not applicable 
for the Global Console.)


• Open Internet Explorer and select Internet Options dialog from the Tools menu.


• In the Internet Options dialog, select the Connections tab.


• In the Connections tab, click the LAN Settings button.


• In the Local Area Network (LAN) Settings dialog, in the Proxy server section, select 
the checkbox for “Use a proxy server for your LAN”, and specify an IP address for 
the proxy server and port number. Click OK to save your changes. 


• Click OK in the Internet Properties dialog.


If you are using Java Web Start, it has a similar dialog in which you can specify the 
address for the proxy server and the port number.


Table 14  Parameters for Properties files


Parameter Value


com.smarts.proxyHost= "<Host name where the web server is running>"


com.smarts.proxyPort= <Port number of the web server>


com.smarts.proxyAuthString= “<Authentication string if authentication is 
required>"


com.smarts.proxyAdditionalHeaders = "<Additional HTTP Requests if any >"
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Requirement for proxy server
The connection time-out mechanism implemented in the EMC Smarts Service Assurance 
Manager makes use of a standard TCP feature known as urgent data or out-of-band data. 


The HTTP proxy used with this code must pass the out-of-band data as is. 


The RFCs that define the correct operation of HTTP proxies require that the proxies provide 
a transparent network connection. However, they do not explicitly mention support of 
out-of-band data.


Because of the large number of HTTP proxy implementations in use, EMC Corporation is 
not in a position to indicate which, if any, fail to correctly pass out-of-band data. 


Please check if the proxy server you are considering passes out-of-band data. Contact EMC 
Global Services if the proxy server does not pass TCP urgent data. 


If the proxy server fails to pass out-of-band data, connections will time out within about 
three minutes. The Global Manager or Domain Manager log will contain a message of the 
following form:


CI-E-EFLOWKEEPALIVESEND-Flow closing due to missed keepalive
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CHAPTER 9
Validating Your Deployment (Acceptance Testing)


This chapter describes how to ensure that your deployment operates as intended and 
contains the following information:


◆ Validation techniques .............................................................................................  90
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Validation techniques
When validating, begin by dividing the deployment into manageable, logical segments. 
Ensure that each of the segments function properly and then perform end-to-end testing. 
Check data flow and then check the accuracy of the data itself. Validate as much as 
possible before discovering the topology so that you reduce complexity. 


Initial validation


To start validation, ensure that the Broker has access to all the EMC Smarts Managers and 
that the EMC Smarts Manager processes are registered and running. Use brcontrol to list 
the processes registered with the Broker and their status. The EMC Smarts System 
Administration Guide provides additional information.


Validating topology operations


After the topology of the network is discovered, it must be provided to the Global Manager 
from underlying domains or third-party software and then from the Global Manager to the 
Global Consoles. You must validate the topology before and after each exchange. 


If the deployment includes an IP Availability Manager, ensure that you verify the topology 
at the Domain Manager. The EMC Smarts IP Manager Deployment Guide provides 
additional information.


Validating trap processing
Use sm_snmp to generate traps to the SNMP Trap Adapter (Receiver) functioning as the 
trap exploder. 


Ensure that you send traps that cause notifications from the underlying analysis servers as 
well as from the SAM Adapter configuration. Create a trap for each trap processing 
statement in the trap_mgr.conf file. If ASL scripting is included in the trap processing, 
ensure that the scripts function as intended.


Validating users and capabilities


To validate users and their capabilities, test each user profile. Create a temporary user for 
each of your user profiles. Log onto the Global Console as each user in turn and review the 
associated console capabilities including access to console operations, access to tools, 
configuration of the notification list, and layout of the console. Ensure that the capabilities 
match your expectations for each user profile.
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CHAPTER 10
Monitoring the Performance of Your Deployment


This chapter describes methods for identifying performance problems in a Service 
Assurance deployment and the steps that you can take to correct these problems. This 
chapter contains the following information:


◆ Assessing performance ...........................................................................................  92
◆ Improving performance .........................................................................................  104


Regardless of the size of your deployment, always monitor its performance. If tuning is 
required, remember that tuning your deployment is an ongoing process that should be 
performed regularly.
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Assessing performance
For the Global Manager, assess performance by checking the resources required by 
EMC Smarts processes against the operating system limits and by reviewing EMC Smarts 
performance metrics. The following methods helps you access performance:


◆ Monitoring Global Manager memory usage


◆ Monitoring Global Manager queues


◆ Monitoring EMC Smarts software with heartbeat notifications


◆ Monitoring topology synchronization performance


◆ Monitoring clients and threads


◆ Monitoring tool execution 


◆ Monitoring escalation 


Monitor Global Manager memory usage


Monitor memory usage by the Global Manager to ensure that it does not exceed the 
operating system’s memory limit and as a way to detect possible performance issues.


Although monitoring memory usage should be part of a routine, these symptoms require 
immediate investigation:


◆ Fast memory growth after the Global Manager has reached a steady state, such as 
hundreds of megabytes of memory growth in a few hours. The steady state is typically 
reached sometime after startup: Be conservative and allow a few hours after startup 
before assuming that the Global Manager is in the steady state.


◆ Consistent memory growth over time, never reaching a plateau. This is relevant only if 
the overall growth of the Global Manager process is also hundreds of megabytes of 
memory, after reaching steady state. 


Establish and monitor a baseline for process memory size
Under normal conditions with the Global Manager process memory size well within the 
operating system limit, monitor memory size to establish a baseline that can be used to 
detect performance issues early. 


For UNIX systems, this can be automated by creating a script that periodically executes ps 
-l -p proclist and writes the output to a file. For Windows, similar functionality can be 
created using a batch file run by the Task Scheduler. 


Investigating the values from the file helps to understand the memory growth pattern over 
time. Once the pattern is understood, it can be used to establish a baseline value for the 
memory usage of a running Global Manager. 


The baseline value is then used to establish a memory usage threshold. Using a 
monitoring script, an alert can be generated if the memory used by the Global Manager 
ever exceeds the threshold. 


Once the alert is received, investigate the queue growth before attempting to remedy the 
condition.
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Monitoring Global Manager queues


Global Manager queue growth is often a cause of the Global Manager memory growth. 
Memory growth and queue growth are expected occasionally, due to large bursts of 
information processed. However, consistent growth of queues may indicate a problem.


The dump queues command
To monitor queues, EMC Smarts software provides a dump queues command that uses 
this syntax:


▼dmctl -s <server_name> exec dmdebug --queues 
-output=<file_name>▲


where:


◆ <server_name> is the name of the Global Manager. 


◆ <file_name> is the name of the file where the output is written, such as 
queues-010105-0100.out (where 010105 is January 1, 2005, and 0100 is 1 AM). The 
file is written to the smarts/local/logs directory.


Figure 11  Global Manager queues information example


Analyzing queue size
The queues output lists many queues. Monitor these queues closely:


◆ SM_PropertyPoller: This queue contains client requests for property subscriptions and 
data to be sent to clients as responses to property subscriptions. For example, in the 
Global Manager, notifications are sent to clients through property subscriptions. So, 
the property poller queue contains notifications to be sent to clients.


◆ SubscriberFE: This queue represents a connection the Global Manager server makes 
to another server, where the Global Manager server subscribes to information in 
another server. For example, there is a SubscriberFE queue for each underlying 
Domain Manager. For each queue, the first line provides name of the queue and the 
number of workers. 


Subscriber Front Ends like this one never have any workers, since they are not used as 
normal server queues. 


SubscriberFE                                          [0 worker(s)]
Current size 0, max  369; processed entries  21843
Size          0-0.00            0-0.00            0-0.00            0-0.00
Flow      21839+0.06 21803+0.05        21446+0.05        17895+0.06
Late     0.0000+0.00       0.0000+0.00       0.0000+0.00       0.0000+0.00


Average over
3 minutes


Average over
30 minutes


Average over
300 minutes


Average over
3000 minutes
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The second line provides the current size, and an exact maximum size. Also included is 
the total number of entries “processed.” To be exact, this is the total number of entries 
that were pulled from the queue.

94 EMC Smarts Service Assurance Manager Deployment Guide







Monitoring the Performance of Your Deployment

The next three rows provide averages. Each column reports values averaged over a 
different time interval: The last 3 minutes, 30 minutes, 300 minutes, and 3000 minutes. 
Each row reports a different value: 


◆ Size is the queue size, that is, the average of what “Current size” reports for this 
moment.


◆ Flow is the number of queue entries processed, that is, the average of what “Current 
processed entries” reports.


◆ Late is the delay between when an entry in a timer queue was scheduled to run and 
when it actually ran. The Late row is always all 0's for a server queue. 


Each of the averages listed in the Size, Flow, and Late rows have two fields separated by a 
sign (+ or -):


◆ The first field is the average value of the variable over the appropriate period. The 
queue in Figure 11 on page 93 has processed many entries -- almost 22,000 -- and 
once, even held 369 entries; but that was apparently an isolated peak some time in 
the past, since its average Size over all the reported intervals is 0: Most of the time, 
the queue is empty. On the other hand, the Flow value over the last 3 minutes is very 
close to the value for processed entries (21,843). If we look at this value averaged 
over longer and longer periods, we see that the longer the period, the smaller the 
value. This is what we would expect if the rate at which elements are flowing through 
this queue is roughly constant. Always keep in mind that Size grows and shrinks, 
while Flow can only grow. 


◆ The second field is the average rate of change in the first value, per second. In the 
example above, the Size is shrinking slowly: -0.0 indicates fewer than 0.01 entries per 
second. On the other hand, the Flow is increasing at a steady rate: between 0.05 and 
0.06 entries per second (3.0 and 3.6 entries per minute) are flowing through this 
queue. Again, because Flow can only increase, the second field is always non- 
negative. Note that the rates are virtually the same across all time periods, which is 
consistent with the analysis in the previous paragraph that entries are flowing through 
at a slow, steady rate.
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Guidelines for monitoring queues
Follow these guidelines:


◆ The queues output lists many queues. Queues that should be monitored more closely 
are SubscriberFE and SM_PropertyPoller.


◆ Current size information is the most important to monitor. For most queues, this value 
is often 0. Some queues, such as ICS_ActionScheduler, almost always have non-zero 
values for current size. If the current size is not zero and grows over several successive 
dump queues commands, it should be further analyzed.


Establish and monitor a baseline for queue size
Under normal conditions, monitor queue size to establish a baseline that can be used to 
detect performance issues early. 


To set up automatic monitoring of queues, a script may be written to parse the output of 
the dump queues. The script could specifically parse the current size for each queue. For 
example, if the current size exceeds a specified threshold, then alert someone to 
investigate this further. Some queues would need to be exempt from the threshold, such 
as ICS_ActionScheduler. 


A possible threshold for queues would be 10,000. However, this setting would depend on 
your specific needs. It would also be possible to set the threshold lower. If you set a lower 
threshold, you should do more monitoring to determine whether or not there is a 
consistent queue growth.


If queue growth happens consistently over time, further investigation is recommended.


Monitoring with heartbeat notifications


To monitor the throughput of notifications by a Global Manager, you can implement a 
mechanism to create heartbeat notifications. These notifications are generated in Domain 
Managers or Adapter Platforms on a periodic basis. The notifications are propagated from 
the lower level domains to the Global Manager or through multiple levels of Global 
Manager. 


A custom adapter listens for these notifications at the Global Manager. The custom 
adapter monitors the rate of receipt of the notifications from each of the underlying 
domains. 


If a notification is not received within a predetermined period after it is generated, 
appropriate personnel are alerted automatically for further investigation. This 
investigation would entail determining if there is a consistent delay from either of the 
following:


◆ One particular EMC Smarts domain: If the delay is from one domain, analyze the 
domain. Consult the appropriate deployment guide for the domain. 


◆ All EMC Smarts domains: If the delay is from all domains, analyze the Global Manager. 
Analyze the Global Manager memory usage, queues, and topology synchronizations 
as described in this chapter.


The heartbeat notifications must be filtered so that they are not displayed in the Global 
Consoles. This would add an unnecessary burden to the Global Console users. Configure 
the notifications lists to eliminate the heartbeat notifications.
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EMC Smarts Global Services or Professional Services can aid in deploying heartbeat 
notifications for monitoring.


Monitoring topology synchronization


Topology synchronization information is written to the Global Manager log file. This 
information indicates when the Global Manager starts and ends a topology 
synchronization with an underlying domain. Topology synchronization is one of the more 
resource intensive aspects of processing in the Global Manager. Therefore, it is important 
when analyzing Global Manager performance to determine the following information 
about topology synchronizations:


◆ How many topology synchronizations occur over a period? 


◆ How frequently are individual domains synchronizing topology?


◆ How long did each topology synchronization take?


The log file contains a significant amount of information. To extract only the topology 
synchronization information, use grep. The gnu version of grep provides an option to 
return lines above and below the matching line, which is very helpful in this case. 


For example, using /opt/gnu/bin/grep -C1 “Topology Synch” will return an output similar 
to the sample in the Figure 12 on page 97. Note that the “-C1” option returns one line 
above and one line below the matched line.


Figure 12  Global Manager Topology Synchronization Information Example


Figure 12 on page 97 shows two topology synchronizations from IC-AM1, an IP Availability 
Manager, during the log file monitoring period:


◆ Started on July 6 at 13:57 and then ended at 14:01. 


◆ started on July 6 at 14:42 and then ended at 14:42. 


Another topology synchronization was in progress from IC-AM2 which ended at 14:13. The 
start time is not included in the log file.


A slow topology synchronization may not be an issue. Since topology synchronization 
occurs in the background, its duration does not necessarily impact general processing of 
the Global Manager. If there is a long latency in the connection from Global Manager to the 


[06-Jul-2004 13:57:27+522ms EST]
ICS-W-ics-event-processing.asl: 'IC-AM1' - Topology Synchronization has
    started
--
[06-Jul-2004 14:01:46+737ms EST]
ICS-W-ics-topology-sync.asl: IC-AM1' - Topology Synchronization has
    ended
--
[06-Jul-2004 14:13:46+172ms EST]
ICS-W-ics-topology-sync.asl: 'IC-AM2' - Topology Synchronization has
    ended
--
[06-Jul-2004 14:42:10+151ms EST]
ICS-W-ics-event-processing.asl: 'IC-AM1' - Topology Synchronization has
    started
--
[06-Jul-2004 14:42:57+528ms EST]
ICS-W-ics-topology-sync.asl: 'IC-AM1' - Topology Synchronization has 
    Ended
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underlying domain that it is synchronizing with, the topology synchronization may take 
longer and yet not affect Global Manager. Also, topology synchronization will take longer 
for larger topologies than smaller topologies. 


However, it may be a symptom that the Global Manager is overloaded and is trying to 
process more than it can handle. If the Global Manager is overloaded, you may see long 
topology synchronization times, slow performance when viewing information in the 
console, and possibly even delays in processing notifications. 


Since topology synchronization is one of the Global Manager processing tasks, improving 
control of topology synchronization may be a way to improve performance.


For example, it is possible to make small topology changes on an underlying domain at a 
high frequency or larger topology changes at a low frequency on an underlying domain. 
Global Manager performance will be better if a low frequency of larger topology changes 
are made. The frequency of topology changes can be controlled partially in underlying 
domains by adjusting the periodic and full discovery intervals. Also, an EMC Smarts 
administrator can initiate discoveries. The frequency of these on-demand discoveries may 
affect Global Manager performance; minimize them when possible. 


Another topology synchronization consideration is the number of underlying domains 
communicating with Global Manager and the concurrency of the topology synchronization 
of these. If there are a large number of domains, there is an increased likelihood of 
concurrent topology synchronizations of underlying domains. Since topology 
synchronization is one of the more intensive processes done by Global Manager, having 
multiple topology synchronizations concurrently may cause console performance and 
notification throughput to slow down.
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Periodic dump threads and dump clients


EMC Smarts provides a number of different monitoring utilities, including:


◆ Listing thread information from a running EMC Smarts server


◆ Listing attached clients for a running EMC Smarts server


Listing thread information
These can be executed using the command:


▼dmctl -s <server_name> exec dmdebug dumpThreads 
-output=<file_name>▲


The output of threads is shown in Figure 13 on page 99.


Figure 13  Global Manager threads information example


Figure 13 on page 99 lists running threads in the server. This gives an idea of the type of 
processing done in the server. This is often used in conjunction with a pstack output. This 
information is not typically monitored, but often used in investigating issues.


t@1     dmboot                                        RUNNING
t@5     Tracked Variable Manager                      RUNNING  Tracki
ables every 0.483248091497799 sec OOR 5.80298835530771E-09
t@6     SM_LicenseManager #1                          RUNNING
t@7     DX_MonitorControlObserver #1                  RUNNING
t@8     DX_Correlator #1                              RUNNING
t@9     DX_CorrelationTimer #1                        RUNNING
t@10    DX_CorrelatorEngine #1                        RUNNING
t@11    DX_MonitorControl #1                          RUNNING
t@12    DX_Dispatcher #1                              RUNNING
t@13    DX_ModelObserver #1                           RUNNING
t@14    DX_ModelManagerProcessor #1                   RUNNING
t@18    ICS_ActionScheduler::ICS-ActionScheduler #1   RUNNING
t@19    ICS Auto Action Timer #1                      RUNNING
t@20    SubscriberFE-EventTimer #1                    RUNNING
t@21    ICS-Impact-Driver                             RUNNING
t@22    SubscriberFE-EventTimer #1                    RUNNING
t@23    SM_PropertyPoller #1                          RUNNING
t@24    HistoryOnlyAccessor polling #1                RUNNING
t@25    monitored_property propagate retry            RUNNING
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Listing client information
This command displays a list of all clients attached to an EMC Smarts server, including 
adapters.


▼dmctl -s <server_name> exec dmdebug dumpClients 
-output=<file_name>▲


Figure 14 on page 100 shows an example of dump clients output.


Figure 14  Global Manager client information example


The example in Figure 14 on page 100 shows one console client, “IC Console”, and one 
ASL client, “ASL”. The output gives the time the connection was initiated, the privileges 
associated with the connection, and the host the client runs on.


Remote Clients [21-Oct-2004 10:05:05 GMT] -
  Id     User        Privs Host                   PID     Since                     Description
--------------------------------------------------
  5      AdministratorPING+READNETVISTAM42-SAM   unknown  18-Oct-2004 11:08:21 GMT  IC Console
   Input:
    Socket 101, mode Read; 0/2048 bytes, lasterr 0, no timeout
    Desktop1:2180 -> 192.6.17.52:3073
    00000000 00000006 526F7574 65720000 000B5243 4C4F4E35 30303938 30000000
   Output:
    Socket 101, mode Write; 0/2048 bytes, lasterr 0, no timeout
    Desktop1:2180 -> 192.6.17.52:3073
    02000000 0D000000 06526F75 7465726B 436F6E6E 65637469 6F6E4F62 6A656374
  10     root        ALL   server1                1061    18-Oct-2004 11:08:21 GMT  ASL
  Input:
   Socket 151, mode Read; 0/2048 bytes, lasterr 0, no timeout
   Server1:2180 -> server2:63325
   00000048 00000014 4943535F 4E6F7469 66696361 74696F6E 4C697374 0000000E
  Output:
   Socket 151, mode Write; 0/2048 bytes, lasterr 0, no timeout
   Server1:2180 -> server2:63325
   28284950 20416464 72657373 2050726F 626C656D 293A202E 312E332E 362E312E
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Monitoring tools


Tools are programs that can be invoked automatically by the Global Manager or through 
the Global Console by an operator. The tools should be monitored using the following 
EMC Smarts utility to ensure that they do not adversely affect performance:


▼dmctl -s <server_name> invoke ICS_ActionManager::ICS-ActionManager 
dumpStatistics <string> filename▲


Figure 15 on page 101 illustrates the output of the Dumpstatistics option for tools.


Figure 15  Output of the Dumpstatistics option for tools


The tools monitored by the utility include all synchronous tools (server and automatic). 
Asynchronous tools (client tools), which are client tools invoked by users from the Global 
Console, are not monitored using this utility. 


Monitoring escalation


EMC Smarts software provides a utility that can monitor escalation, including statistics for 
each escalation level in every escalation path configured in the Global Manager. The 
syntax is as follows:


Synchronous Action Statistics [28-Dec-2004 03:46:22 PM Eastern Standard Time] 
Summary : 
 number_of_sync_actions_executed    :           7 
 max_execution_time                 :          30.6950 secs 
 avg_execution_time                 :           9.3593 secs 


 number_of_successfull_sync_actions :           5 
 number_of_timeout_sync_actions     :           2 
 number_of_failed_sync_actions      :           0 


Details : 
 Action ID : ICS-ServerProgramAction-Sample - Close Trouble Ticket 
  No of times invoked         :           1 
  Maximum Execution time      :           1.3720 secs 
  Average Execution time      :           1.3720 secs 
  No of Successful Execution  :           1 
  No of Timeouts              :           0 
  No of Failures              :           0 


 Action ID : ICS-AutoProgramAction-Set UserDefined1 
  No of times invoked         :           1 
  Maximum Execution time      :           0.5410 secs 
  Average Execution time      :           0.5410 secs 
  No of Successful Execution  :           1 
  No of Timeouts              :           0 
  No of Failures              :           0 


 Action ID : ICS-ServerProgramAction-Sample - Open Trouble Ticket 
  No of times invoked         :           1 
  Maximum Execution time      :           1.8720 secs 
  Average Execution time      :           1.8720 secs 
  No of Successful Execution  :           1 
  No of Timeouts              :           0 
  No of Failures              :           0 


 Action ID : ICS-AutoProgramAction-Esc-Paging 
  No of times invoked         :           4 
  Maximum Execution time      :          30.6950 secs 
  Average Execution time      :          15.4325 secs 
  No of Successful Execution  :           2 
  No of Timeouts              :           2 
  No of Failures              :           0 
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▼dmctl -s <server_name> invoke 
ICS_AutoActionManager::ICS-AutoActionManager dumpStatistics 
<string>fileName▲


Figure 16  Output of the Dumpstatistics option for escalation


[20-May-2003 05:49:05 PM EDT]
Escalation Statistics (All times are in seconds)
OVERALL:
number_of_executed_jobs  :          122
total_execution_time     :      10.0430
max_execution_time       :       0.3024
avg_execution_time       :       0.0823
total_queue_delay        :       5.0068
max_queue_delay          :       0.2419
avg_queue_delay          :       0.0410


LEVEL Policy1-Path1-0:
number_of_executed_jobs  :            4
total_execution_time     :       0.8123
max_execution_time       :       0.2856
avg_execution_time       :       0.2031


LEVEL Policy1-Path1-1:
number_of_executed_jobs  :            0
total_execution_time     :       0.0000
max_execution_time       :       0.0000
avg_execution_time       :       0.0000


LEVEL Policy1-Path1-2:
number_of_executed_jobs  :            0
total_execution_time     :       0.0000
max_execution_time       :       0.0000
avg_execution_time       :       0.0000


LEVEL Policy2-Path2-0:
number_of_executed_jobs  :          118
total_execution_time     :       9.2307
max_execution_time       :       0.3024
avg_execution_time       :       0.0782
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Figure 16 on page 102 shows the sample output for the Dumpstatistics option for 
escalation. The following values are included as a total for all escalation paths and for 
each level in each path:


◆ Number of executed jobs. A job is a scheduled notification that matched a policy-path 
and that repeats for each level in that path. The number of executed jobs is indicated 
for all levels in all paths (overall) and for each level.


◆ Total, maximum, and average execution times. Execution time indicates how long the 
tool actions defined for a job took in seconds. If the maximum execution time at a 
level far exceeds the average, it may indicate an issue for a particular tool.


◆ Total, maximum, and average queue delays for all the escalation paths is also 
displayed. These delays are not related to execution time. Delay is difference between 
when a job was scheduled to execute and when the job was actually executed. A 
positive value for the delay indicates that the system is not keeping up with 
scheduled escalation. Delay may be caused by the overall load on the server, number 
of notifications, policies, paths, or levels. When a burst of notifications make it into a 
path, all jobs are scheduled to execute at the same time in a future time, so delay may 
increase due to these bursts.


“Increase worker threads for escalation” on page 105 provides information on improving 
escalation performance.
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Improving performance
If the performance metrics indicate a performance degradation, do the following to 
improve performance:


◆ Refine notification lists for users


◆ Reassess the topology synchronization configuration


◆ Refine sets of trap, syslog notifications sent to SAM 


◆ Increase worker threads used for escalation


◆ Redesign your deployment to deploy additional Global Managers in a hierarchical 
Service Assurance configuration 


Refine notification lists for users


A Notification List determines the events that are forwarded to a user. Essentially, the list 
filters the notifications that are sent from the Global Manager and can be assigned to one 
or more users.


In large Service Assurance deployments, significant numbers of notifications are active at 
any given time. Displaying all of these notifications to all users may adversely affect the 
performance of the system. Instead, create notification lists that are focused on providing 
groups of users with only the notifications that are specifically useful to them. This 
approach will improve performance and may also simplify users’ tasks by allowing them to 
focusing their efforts on appropriate notifications.


Reassess configuration of topology synchronization 


“Designing for Topology Operations” on page 55 describes the frequency of topology 
changes that can be controlled partially in underlying domains by adjusting the periodic 
and full discovery intervals. If the pace of change in your network and application 
infrastructure can be supported with longer discovery intervals, increasing the interval 
may also improve Global Manager performance.


Because discovery can also initiated manually, another method to improve performance 
may be to reduce the frequency of manual discoveries. Reassess access to unplanned 
discovery and remove it from the user profiles of administrators who do not require it. For 
administrators who retain access to manual discovery, educate them on the effect of 
initiating an unscheduled discovery. 


Refine set of trap and syslog notifications sent to Global Manager


The notifications that result from analysis by EMC Smarts Managers typically contribute 
very little to the notification load on Global Manager. During analysis, EMC Smarts 
Managers reduce the load by analyzing numerous traps and polling results to produce a 
notification for each root cause rather than the symptoms. 


Do not forward traps to the Global Manager when they are already sent to a Domain 
Manager for analysis. Use the first match in trap forwarding configuration file, if possible. 
If you have not implemented batching at the EMC Smarts SNMP Trap Adapter, do so.


“Designing trap processing” on page 62 provides additional information.
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Increase worker threads for escalation


If the performance metrics indicate a performance degradation in Escalation, add worker 
threads to improve performance. Increasing threads to 10 worker threads is acceptable, 
but keep in mind that more threads may require additional or more capable CPUs. Be 
conservative when increasing threads, since this action may reduce the overall resources 
that are available and affect performance. Increase the value in the ics-default.xml file. 
The EMC Smarts Service Assurance Manager Configuration Guide provides information on 
reconfiguring the Global Manager.


Once increased, the number of worker threads cannot be reduced unless the server is 
restarted.
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Upgrade server hardware


Improve the capabilities of the equipment where the EMC Smarts process is installed by 
using a faster CPU or reinstall EMC Smarts software on a more capable equipment. Before 
resorting to this hardware upgrade, consider the previous options.


Redesign the Service Assurance deployment


If, after attempting the other methods to improve performance, there are still issues, then 
determine if your actual deployment has exceeded the original deployment design. 


If this is the case, you may have to deploy additional Global Managers in a hierarchical 
Service Assurance configuration. To start redesigning a deployment, return to “Designing 
the Service Assurance Deployment” on page 35.
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Design and Deployment Checklists


This appendix gather the checklists that are included throughout this guide into a single, 
easily accessible location. The checklists included in this chapter are:


◆ Before you begin checklist ....................................................................................  108
◆ Basic information checklist ...................................................................................  109
◆ EMC Smarts design checklist.................................................................................  110
◆ Designing topology operations checklist ...............................................................  110
◆ Planning for notifications checklist........................................................................  111
◆ EMC Smarts client and user design checklist .........................................................  112
◆ Business Impact Manager design checklist ...........................................................  113

Design and Deployment Checklists 107







Design and Deployment Checklists

Before you begin checklist
Table 15  Before you begin checklist 


Complete Requirement Description


❑ Possess an 
understanding of the 
EMC Smarts 
architecture and 
capabilities.


At a minimum, you must understand the concepts and EMC Smarts 
architecture described in the following documents: 
• EMC Smarts Service Assurance Manager Introduction
• EMC Smarts Service Assurance Manager Configuration Guide
• EMC Smarts Service Assurance Manager Adapter Platform User Guide
• EMC Smarts System Administration Guide
• EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM 


Managers that accompanied your software product
• EMC Smarts user guides related to the underlying EMC Smarts domains in 


your deployment


To improve your understanding, attend EMC Smarts training courses offered 
by EMC® Education Services and Development. Typically, deployment 
requires the knowledge equivalent to what is provided in the training courses 
on:
• EMC Smarts Global Manager
• EMC Smarts Service Assurance Manager Adapter Platform
• Any underlying EMC Smarts domain that will be part of your deployment.


❑ Obtain contact 
information for the 
deployment team.


The contact list should include titles, responsibilities, and contact methods 
for all team members.


❑ Get nondisclosure 
requirements and 
negotiate an 
agreement.


Be aware of the requirements of the non-disclosure agreements that are in 
place for the EMC Smarts deployment.


❑ Develop schedules 
and set milestones for 
early deliverable. 


Scheduling a software deployment varies based on the size and scope of the 
deployment and the organization’s requirements. Typical milestones might 
include:
• Initial project meeting to define the deployment scope
• Purchase of EMC Smarts software
• Project development begins 
• Installation in test environment complete
• Testing complete
• Installation in production environment complete
• EMC Smarts goes live
Additional information on scheduling is beyond the scope of this guide.
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Basic information checklist
Table 16  Basic Service Assurance information checklist


Complete Task Description
Related 
documentation


o Determine the number of 
managed devices and 
applications in the 
environment.


Document all quantities in the deployment build 
guide.


“Determine how 
many devices and 
applications will be 
managed” on 
page 29


o Estimate potential 
growth in quantity of 
managed devices.


The EMC Smarts deployment must support potential 
network growth. Estimate the growth over a specific 
time period. Document the calculations in the 
deployment build guide.


“Determine how 
many devices and 
applications will be 
managed” on 
page 29


o Get the organization’s 
testing/acceptance 
requirements.


Your design may be required to meet test and 
acceptance requirements. Obtain any specifications 
that cover integration testing, user acceptance 
testing, and operational acceptance testing. You may 
be required to write an installation or deployment 
report that follows an organization’s particular 
standards.


“Determine 
requirements for 
installing software” 
on page 30


o Describe the 
organization’s 
requirements for 
installing new software.


Document these requirements and how the design 
meets them in the deployment build guide.


“Determine 
requirements for 
installing software” 
on page 30


o List the products that 
currently monitor the 
network.


Document the products (including version) in 
deployment build guide.


“Define 
requirements for 
integrating existing 
software with 
EMC Smarts” on 
page 30


o Describe the network 
security.


Describe security features that will affect the 
deployment. 
Document the security features in the deployment 
build guide.


“Gather network 
security 
information” on 
page 31


o List any other network 
requirements or features 
that may affect the 
deployment.


Document the features in the deployment build 
guide.


“Other network 
features affecting 
EMC Smarts” on 
page 32
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EMC Smarts design checklist


Designing topology operations checklist


Table 17  Initial design checklist 


Complete Task Description
Related 
documentation


o Determine the 
configuration of the 
Service Assurance 
Deployment.


Determine Service Assurance configuration, 
including the numbers of Global Managers and how 
they are organized in the EMC Smarts deployment.


“Determine the 
Service Assurance 
configuration” on 
page 36


o Determine the hardware 
required to support the 
Service Assurance 
Deployment.


For each Global Manager in the Service Assurance 
configuration, determine the type of equipment 
required to support it.


“Hardware for 
Service Assurance 
platform equipment 
tiers” on page 43


o Determine the location of 
the EMC Smarts Broker


Choose a location for the EMC Smarts Broker that 
will support the EMC Smarts deployment.


“Locating 
EMC Smarts 
Brokers” on 
page 48


o Determine the location of 
the License Server


Choose a location for the EMC Smarts License 
Server that will support the EMC Smarts 
deployment.


“Locating license 
servers” on 
page 49


o Determine the location of 
the EMC Smarts Global 
Manager(s)


Choose locations for the one or more EMC Smarts 
Global Manager(s) that will support the EMC Smarts 
deployment.


“Locating the 
Global Managers in 
the network” on 
page 50


o Determine if Service 
Assurance Manager must 
be configured with 
failover.


Determine if a high availability configuration is 
required.


“Considering 
failover (high 
availability) 
configurations” on 
page 51


o Determine if acceptance 
tests are required.


Acceptance tests may be required for different 
portions of EMC Smarts functionality. Be aware of 
the requirements and develop acceptance criteria.


“Designing 
acceptance tests” 
on page 52


Table 18  Designing topology operations checklist 


Complete Task Description
Related 
documentation


o Review topology 
synchronization issues.


Ensure that you understand how topology 
synchronization affects Global Manager 
performance.


“Understanding 
topology 
synchronization” 
on page 56


o Plan topology 
synchronizations.


To optimize Global Manager performance, it is best 
to reduce the number of topology synchronizations 
where possible. 


“Planning for 
topology 
synchronization” 
on page 57


o Plan topology groups. Topology grouping is a visual tool that does not 
affect Global Manager performance. Groups help 
organize topology elements.


“Designing 
topology 
groupings” on 
page 58
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Planning for notifications checklist


Table 19  Planning for notifications checklist 


Complete Task Description
Related 
documentation


o Determine which 
notifications are 
important for 
EMC Smarts 
operators.


Ensure only the notifications that are useful to Global 
Console operators reach the Global Manager.


“Overview of 
notification 
processing” on 
page 60


o Configure 
Notification Lists.


Notification lists are the mechanism that clients use to 
subscribe to and receive notifications from a Global 
Manager. 


“Configuring 
notifications for 
clients” on 
page 61


o Design Trap 
Processing.


Any EMC Smarts deployment should include a plan to 
handle trap processing.


“Recommended 
trap processing 
design” on 
page 62
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EMC Smarts client and user design checklist
Table 20  EMC Smarts client and user design checklist  


Complete Task Description
Related 
documentation


o Define functional 
groups for users.


List the broad functional groups that users will belong to 
and then define the needs and duties of each group. Add 
this information to the deployment build guide.


“Determining the 
Global Manager 
users” on page 68


o Choose 
appropriate 
EMC Smarts 
clients for users.


EMC Smarts consoles have different capabilities. For each 
type of user and their equipment, you must determine 
which console is most appropriate. Document your choices 
in the deployment build guide.


“Choose a console 
for types of users” 
on page 68


o Define how you 
will implement 
security for user 
groups.


When defining the functional categories for users, consider 
EMC Smarts’s security implementation. Document the 
implementation in the deployment build guide.


“Users and 
security” on 
page 69


o Define the 
notification lists in 
EMC Smarts user 
profiles.


The Notification List determines which notifications are 
sent from the Global Manager to the EMC Smarts client. 
Carefully define the notification lists as they can affect 
Global Manager performance. Document the notification 
list provided for each user profile in the deployment build 
guide.


“Designing 
notification lists” 
on page 71


o Design console 
operations access.


Most operations that can be performed at the EMC Smarts 
clients can be individually enabled or disabled in the user 
profiles. Document the access provided for each user 
profile in the deployment build guide.


“Designing 
consoles” on 
page 72


o Design console 
layouts.


Specific console layouts can be saved and then 
automatically provided to match user needs at the Global 
Console, Web Console, and Business Dashboard. 
Document the console layout used in each user profile in 
the deployment build guide.


“Designing 
consoles” on 
page 72


o Design client and 
server tools.


Define the necessary tools that users must access and the 
levels of programming skills required to create the tools. 
Document this information and tools provided by each 
user profile in the deployment build guide.


“Planning for tools 
and tool 
deployment” on 
page 72


o Define functional 
groups for users.


List the broad functional groups that users will belong to 
and then define the needs and duties of each group. Add 
this information to the deployment build guide.


“Determining the 
Global Manager 
users” on page 68
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Business Impact Manager design checklist
Table 21  Business Impact Manager design checklist


Complete Task Description
Related 
documentation


o Define relevant 
business 
processes.


Determine the business processes to model. “Designing 
business impact 
processing” on 
page 76


o Create a business 
topology.


Create business elements to model the business 
processes. Define the expectations of the model and the 
events it should analyze.


“Business 
topology” on 
page 76


o Assign weights to 
the elements of 
the topology.


This step is optional but allows you to assign a value to 
measure the impact of events that occur in the topology. 
The weights of impacted elements are summed in the 
root-cause event.


“Weights: Impacts 
of issues in the 
topology” on 
page 77


o Choose a method 
for importing 
information.


If the topology is small, use the Topology Builder Console. 
For larger topologies, use one or more topology files.


“Importing 
information” on 
page 77
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APPENDIX B
Service Assurance Manager Benchmarks


This appendix contains Service Assurance Manager (SAM) benchmarking statistics and 
includes the following information:


◆ Service Assurance Manager benchmarking deployment ........................................  116
◆ Number of syslog messages a given Smarts syslog parser can successfully handle per 


second..................................................................................................................  123
◆ Number of escalation policies that can successfully be processed using multiple 


threads .................................................................................................................  124
◆ Service Assurance Manager 8.0 performance benchmarking .................................  126
◆ Time to log in to the SAM 8.0 server ......................................................................  127
◆ Default Global Console heap size allocation ..........................................................  128
◆ SAM 8.1 latency performance benchmark testing ..................................................  129
◆ Amount of memory SAM 8.1 requires to process notifications ...............................  131
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Service Assurance Manager benchmarking deployment
The following software and hardware configuration was used in conducting the SAM 9.1 
benchmarking:


◆ Software


• Service Assurance Manager 9.1


• Availability Manager-Performance Manager 9.1


◆ Hardware


Table 22 on page 116 defines the hardware used:


The following three setups were used to deploy the Service Assurance Manager 
components and domain manager.


◆ Figure 17 on page 117 shows Service Assurance Manager deployment with one trap 
adapter and no trap exploder


◆ Figure 18 on page 118 shows Service Assurance Manager deployment with one trap 
adapter and one trap exploder


◆ Figure 19 on page 119shows Service Assurance Manager deployment with two trap 
adapters and one trap exploder


Table 22  Service Assurance Manager benchmarking hardware


Hardware Operating system CPU quantity CPU Model Memory


PowerEdge 
R310 - Dell


Red Hat Enterprise Linux 
Server release 5.8


4 Intel(R) Xeon(R) CPU           
X3450  @ 2.67GHz


16 GB
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Figure 17  Service Assurance Manager deployment with one trap adapter and no trap exploder
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Figure 18  Service Assurance Manager deployment with one trap adapter and one trap exploder
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Figure 19  Service Assurance Manager deployment with two trap adapters and one trap exploder
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Number of traps Service Assurance Manager can successfully process


This benchmark defines how many traps per second the Service Assurance Manager can 
successfully process. The following points were considered when setting up the 
benchmark environment:


◆ The benchmark is based on receiving a mix of new notifications from multiple traps


◆ The trap adapter will be tested with, and without ASL scripts in use


◆ The trap adapter is flooded using a trap generator with traps ranging from 2000 to 
10000 TPM to reach it’s optimum limit


◆ SAM servers, Trap Exploder, Trap Adapter are running on the same machine.


The following configurations were tested:


◆ One trap adapter, no trap exploder, ASL script disabled


◆ One trap adapter, with trap exploder, ASL script disabled


◆ One trap adapter, with trap exploder, ASL script enabled


◆ One trap adapter, with trap exploder, ASL script enabled, with Queue limits settings


◆ Two trap adapters, with trap exploder, ASL script enabled


One trap adapter, no trap exploder, ASL script disabled
The procedure for benchmarking one trap adapter with ASL script disabled included:


◆ Generating consistent inflow of traps each minute directly to Trap Adapter.


◆ Without Queue Limits set


◆ Match=ALL


Table 23 on page 120 defines the results for a one trap adapter, no trap exploder, ASL 
script disabled, with 10 threads configuration. 


Legend
T/s – Traps per second


One trap adapter, with trap exploder, ASL script disabled
The procedure for benchmarking one trap adapter with a ASL script disabled included:


◆ Generating consistent inflow of traps each minute directly to Trap Exploder.


◆ Trap Exploder forwards traps to Trap Adapter.


◆ Without Queue Limits set


◆ Match=ALL 


Table 23  One trap adapter, no trap exploder, ASL script disabled


Trap 
exploder


Trap 
adapter Threads ASL script


Trap rate NA 100 T/s 10 NA
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Table 24 on page 121 defines the results for a one trap adapter, with trap exploder, ASL 
script disabled, with 10 threads configuration.


Legend
T/s – Traps per second


One trap adapter, with trap exploder, ASL script enabled
The procedure for benchmarking one trap adapter with a ASL script enabled included:


◆ Generating consistent inflow of traps each minute directly to Trap Exploder.


◆ Trap Exploder forwards traps to Trap Adapter.


◆ Without Queue Limits set


◆ Match=ALL 


Table 25 on page 121 defines the results for a one trap adapter, no trap exploder, ASL 
script disabled, with 10 threads configuration.


Legend
T/s – Traps per second


One trap adapter, with trap exploder, ASL script enabled, with Queue Limit settings
The procedure for benchmarking one trap adapter with a ASL script enabled included:


◆ Generating consistent inflow of traps each minute directly to Trap Exploder.


◆ Trap Exploder forwards traps to Trap Adapter.


◆ With Queue Limits set to 200 MB


◆ Match=ALL 


Table 26 on page 121 defines the results for a one trap adapter, no trap exploder, ASL 
script disabled, with 10 threads configuration.


Legend
T/s – Traps per second


Table 24  One trap adapter, with trap exploder, ASL script disabled


Trap 
exploder


Trap 
adapter Threads ASL script


Trap rate 133.33T/s 100 T/s 10 NA


Table 25  One trap adapter, with trap exploder, ASL script enabled


Trap 
exploder


Trap 
adapter Threads ASL script


Trap rate 133.33 T/s 33.33 T/s 10 Yes


Table 26  One trap adapter, with trap exploder, ASL script enabled


Trap 
exploder


Trap 
adapter Threads ASL script


Trap rate 133.33 T/s 50 T/s 10 Yes
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Two trap adapters, with trap exploder, ASL script enabled
The procedure for benchmarking one trap adapter with a ASL script enabled included:


◆ Generating consistent inflow of traps each minute directly to Trap Exploder and Trap 
Adapter.


◆ Trap Generator forwards traps to Trap Exploder.


◆ Trap Exploder forwards traps to first Trap Adapter.


◆ Another instance of Trap Generator forwards traps directly to second Trap Adapter.


◆ Without Queue Limits set


◆ Match=ALL 


Table 27 on page 122 defines the results for a two trap adapters, with trap exploder, ASL 
script enabled, with 10 threads configuration.


Legend
T/s – Traps per second


Table 27  Two trap adapters, with trap exploder, ASL script enabled


Trap 
exploder


Trap 
adapter 1


Trap 
adapter 2 Threads ASL script


Trap rate 133.33 T/s 33.33 T/s 33.33 T/s 10 Yes
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Number of syslog messages a given Smarts syslog parser can successfully 
handle per second


The following configurations were benchmarked:


◆ Syslog adapter using the --file option


◆ Syslog adapter using the -- tail option


Syslog adapter using --file option
When a file containing all syslog entries was processed, both the SAM aggregate server 
and the SAM presentation server approximately 55 notifications per second in a SAM 8.0 
environment.


Table 28 on page 123 defines the results for a syslog adapter using the --file option 
configuration.


Legend
S/s – Syslogs per second
N/s – Notifications per second


Syslog adapter using --tail option
When a file was appended with 33,333 syslog entries a second, both the SAM aggregate 
server and the SAM presentation server processed 58.65 notifications per second in a 
SAM 8.0 environment.


Table 29 on page 123 defines the results for a syslog adapter using the --tail option 
configuration.


Legend
S/s – Syslogs per second
N/s – Notifications per second


Table 28  SAM 8.0 Syslog adapter using the --file option benchmarking results


Syslog 
Adapter


Adapter 
Platform (OI)


SAM 8.0
aggregate 
server


SAM 8.0 
presentation 
server


Syslog Rate 57.18 S/s 57.18 S/s 56.88 N/s 55.59 N/s


Table 29  SAM 8.0 Syslog adapter using the --tail option benchmarking results


Syslog 
Adapter


Adapter 
Platform (OI)


SAM 8.0
aggregate 
server


SAM 8.0 
presentation 
server


Syslog Rate 58.69 S/s 58.69 N/s 58.65 N/s 58.65 N/s
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Number of escalation policies that can successfully be processed using 
multiple threads


When 50,000 traps were sent to the trap adapters, the rate to compute the escalation of 
notifications at the Service Assurance Manager presentation server was measured for 5, 
10, 20, and 50 escalation policies. For each escalation policy:


◆ The following path and levels were used: 1 path and 1 level, 5 paths and 3 levels, and 
10 paths and 6 levels


◆ Each notification matches exactly one policy per path


Each escalation, path, and level action consisted of running a unique shell script that 
created an empty file in the local file system.


Table 30 on page 124 defines the escalation policy benchmarking results for SAM 8.0.


Legend
• * Queue name is ICS Auto Action Time. If no value, the queue file was not created.
• N/s – Notifications per second.
• NG – No queue growth.
• Elapsed Time in Seconds is the time to execute all escalations.


Table 30  Escalation policy benchmark results


Configurat
ion
policy/
path/
level


Adapter 
Platfor
m (OI)
N/s


SAM-
Aggregat
e N/s


SAM-
Presenta
tion N/s


Elapsed 
time 
in 
seconds


Queue 
growt
h


Memory 
start in 
KB


Memor
y end in 
KB


Delay 
in 
compl
etion 
in 
secon
ds


Notificatio
n average 
escalation 
time in 
seconds


Time to 
load 
XML 
file


5/1/1 37.48 35.41 13.94 3587 2 264448 419432 0 0.1987 3.6


10/1/1 41.91 40.23 13.14 3805 6 283944 438064 0 0.2016 3.6


20/1/1 42.37 40.52 12.42 4025 5 283376 433032 0 0.2108 3.8


50/1/1 40.00 37.94 12.53 3990 2 268864 422168 0 0.207 4.3


5/5/3 38.70 37.06 5.48 9131 896 274960 516096 2 min. 121.0753 5.3


10/5/3 32.98 30.40 5.87 8642 1022 230984 472424 2 min. 121.2158 6.8


20/5/3 37.97 36.34 5.21 9721 836 283760 514104 2 min. 121.1235 19.7


50/5/3 35.46 32.81 5.47 9269 885 238376 478216 2 min. 
1 sec.


121.0869 69.3


5/10/6 32.24 28.97 2.93 17359 1857 219896 588280 5 min. 
2 sec.


325.505 15.2


10/10/6 37.12 32.94 2.38 21350 1686 269768 625400 5 min. 
1 sec.


311.5431 47.6


20/10/6 37.12 35.04 2.60 19567 1013 283224 628792 5 min. 
13 sec.


305.2938 253


50/10/6 33.94 31.87 2.56 19808 1082 288608 402664 5 min. 
2 sec.


305.0976 1146.8
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• min. – minutes.
• sec. – seconds.
• Delay in Completion in Seconds is the excess time to complete the execution of the escalations 


This is measured as the difference between the time the last notification was received by the 
Service Assurance Manager server and the time the last escalation was completed.


• Time to load XML file defines the time it took to load the escalation policies configuration file into 
the Service Assurance Manager server. This file is in XML format and is loaded into the server 
using the sm_config command.
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Service Assurance Manager 8.0 performance benchmarking
Service Assurance Manager 8.0 performance benchmarking focused on the following 
functionality:


◆ Displaying containment views


◆ Displaying maps


◆ Processing notifications


◆ Performing topology synchronization 


Environment
The Service Assurance Manager 8.0 performance benchmarking environment consisted of 
multiple:


◆ Hierarchical Service Assurance Manager servers


◆ Underlying domains (at a minimum four underlying domains, including IP and NPM)


◆ Trap adapters


Table 31 on page 126 defines the hardware configuration used for the performance 
benchmarking.


Scenario
The performance benchmarking scenario included 100 concurrent clients responsible for 
the same number of notifications, performing different operations, such as taking 
ownership of an event, releasing ownership of an event, getting properties of an event, 
getting a map, and getting containment views.


Table 31  Performance benchmarking hardware configuration


Type Model Platform
Memory 
size


Server System Sun SPARC Enterprise T5220 sun4v/1.1GH
z


16256 MB
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Results
During a typical scenario with 100 concurrent users logged in and with the SAM server 
receiving 20 event notifications a minute and the console displaying 1,200 event 
notifications when logged in, a containment view displays in approximately 5 seconds.


Time to log in to the SAM 8.0 server
This section describes the performance benchmark for logging in to the SAM 8.0 server.


Environment
Table 32 on page 127 defines the hardware configuration used in benchmarking the time 
to log in to the SAM 8.0 server.


The environment for this benchmark did not include any network latency.


Scenario
This benchmark included the following scenarios:


◆ 40,000 total notifications with 21 concurrent clients logging in to the SAM server at 
the same time.


◆ 40,000 total notifications with 20 concurrent clients logged in and performing 
operations and 1 client logging in to the SAM server. 


◆ 20,000 total notifications with 21 concurrent clients logging in at the same time.


◆ 20,000 total notifications with 20 concurrent clients logged in and performing 
operations and 1 client logging in to the SAM server. 


◆ 40,000 total notifications with 1 client logging into the SAM server.


Table 32  Time to log in to the SAM 8.0 server benchmarking hardware configuration


Type Model Platform
Memory 
size


Server Sun Fire V240 sun4v / 1.5 GHz 4 GB


Console Windows 2003 SP2 / 3 GHz 1 GB
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Results
Table 33 on page 128 defines the benchmarks for logging into the SAM 8.0 server. 


Default Global Console heap size allocation
This section describes the default heap size allocation for the SAM 8.0 Global Console.


Environment
Table 34 on page 128 defines the hardware configuration used to determine the default 
Global Console heap size allocation.


Recommendations
The SAM 8.0 default heap size allocation for the Global Console is 350 MB. A heap size of 
350 MB is sufficient for deployments having 50,000 notifications. 


The default heap size allocation for previous versions of SAM was 256 MB.


For the Web Console, the default heap size is 64 MB. A heap size of 64 MB is sufficient for 
SAM deployments with 15,000 notifications. For deployments with more than 50,000 
notifications the heap size should be increased to 350 MB. The EMC Smarts Service 
Assurance Manager Dashboard Configuration Guide provides detailed heap size 
considerations for the Web Console and Business Dashboard applets. 


Table 33  Logging into the SAM 8.0 server benchmark


Scenario Benchmark


40,000 total notifications with 21 concurrent clients 
logging in to the SAM server at the same time.


1 minute and 51 seconds


40,000 total notifications with 20 concurrent clients 
logged in and performing operations and 1 client 
logging in to the SAM server. 


1 minute and 44 seconds


20,000 total notifications with 21 concurrent clients 
logging in at the same time.


51 seconds


20,000 total notifications with 20 concurrent clients 
logged in and performing operations and 1 client 
logging in to the SAM server. 


46 seconds


40,000 total notifications with 1 client logging into the 
SAM server.


1 minute and 46 seconds


Table 34  Default Global Console heap size allocation benchmarking hardware configuration


Type Model Platform Processor
Memory 
size


Server Windows 2003 SP2 2.66 GHz 2 GB
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SAM 8.1 latency performance benchmark testing
SAM 8.1 latency performance benchmark testing consisted of introducing latency in a 
wide area network environment and testing the:


◆ Notification processing time between the presentation SAM server and the underlying 
aggregate SAM domain managers


◆ Topology synchronization time between the SAM server and the underlying servers 


Environment
Router connections governing communication between two hosts were adapted to cause 
network latency delays of less than 1 millisecond (ms), 100 milliseconds, and 300 
milliseconds. Transactions between domain managers were then monitored at each 
latency level over the router connection.


The specific environment specifications include:


◆ Host specifications include:


• 4 GB of RAM


• 2 CPUs


• 60 GB of storage


◆ Static notification set:


All notifications used in the notification synchronization were included in the 
aggregate SAM repository. Additional notifications were not added during the test.


◆ Topology synchronization repository specifications include:


• 1,200 systems


– Instances — 17,862 (17,859 added 0 deleted)


– Relationships — 35,306 (79,398 connections)


• 2,600 systems


– Instances — 21,841 (21,838 added 0 deleted)


– Relationships — 43,528 (99,066 connections)


• 3,600 systems


– Instances — 26,951 (26,948 added 0 deleted)


– Relationships — 53,204 (121,016 connections)
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Scenarios


Scenario 1 Table 35 on page 130 defines the time required to process notifications between two SAM 
domain managers, an underlying aggregate SAM server and a top-level presentation SAM 
server.


The format for the time measurement is minutes:seconds.


Scenario 2 Table 36 on page 130 defines the time required to complete initial topology 
synchronization between an IP domain manager (for example, AM and AMPM) and a SAM 
domain manager.


The format for the time measurement is minutes:seconds:milliseconds.


Results
Latency did have an effect on processing time. However, the number of objects being 
monitored and the complexity of the repository structure did greatly influence the 
processing time.


Table 35  Latency results for SAM-to-SAM notification processing


Latency 1 ms 100 ms 300 ms


~14500 notifications 1:45  2:37 3:32


~32500 notifications 3:10 4:07 5:00


~35100 notifications 3:46 4:20 5:53


Table 36  Latency results to complete an initial topology synchronization between an IP domain 
manager and a SAM domain manager


Latency 1 ms 100 ms 300 ms


~1200 systems 2:35:735 2:39:962 2:51:916


~2600 systems 4:20:484 4:21:969 4:55:593


~3600 systems 4:41:862 4:53:813 5:40:516
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Amount of memory SAM 8.1 requires to process notifications
This benchmark determines the amount of memory SAM 8.1 requires to process 
notifications.


Environment
The benchmark environment consisted of:


◆ SAM server version 8.1 running on:


• LinuxAS5 physical machine


• Red Hat Enterprise Linux Server release 5, Kernel 2.6.18-8.el5 on an x86_64, with 
4 GB of memory


• 4 Intel® Xeon™ CPU 3.60GHz  


◆ Console version 8.1 running on: 


• Windows 2003 Standard Edition SP2, with 1 GB of memory


• Intel® Xeon™ CPU 3.00GHz, 2.99GHz  


◆ IP servers version 7.0.3 started on:


• Sun T5220 Solaris 10, with 16 GB of memory, 40 1167 MHz SUNW,UltraSPARC-T2 
Virtual CPUs  
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Test scenarios
Test scenarios included the following four cases:


◆ Case 1 — Configured an AM/PM server with approximately 2000 devices as an 
underlying Service Assurance Manager domain. Generated 40,000 notifications as 
rapidly as possible. Measured the memory of the SAM server from initialization until 
all notifications were processed.


◆ Case 2 — Repeated Case-1 with 30 simulated consoles attached.


◆ Case 3 — Configured 2 AM/PM servers with approximately 2000 devices, configured 2 
AM servers with approximately 1000 devices as underlying Service Assurance 
Manager domains. Generated 90,000 notifications as rapidly as possible. Measured 
the memory of the SAM server from initialization until all notifications were 
processed.


◆ Case 4 — Repeated Case 3 with 30 simulated consoles attached.
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Results on a Linux AS5 platform
Table 37 on page 133 defines the results on a Linux AS5 platform.


Table 37  SAM 8.1 Memory benchmarking results 


Initialization: 477580 KB


Topology synchronization (27,000 instances, 
30,000 relationships) from Case 1 and Case 2:


202240 KB


Topology synchronization (50,000 instances, 
59,000 relationships) from Case 3 and Case 4:


315704 KB


43,000 notifications from Case 1: 159084 KB 
3.69 KB per notification.


43,000 notifications with 30 consoles from 
Case 2:


414136 KB
Amount of overhead per console 
for 43,000 notifications equals 
8501.73 KB, or 197.7 bytes per 
notification.


96,000 notifications from Case 3: 343044 KB
3.57 KB per notification.


96,000 notifications with 30 Consoles from 
Case 4:


598388 KB
Amount of overhead per console 
for 96,000 notifications equals 
8511.47KB, or 88.66 bytes per 
notification.
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Overview
Service Assurance Suite combines some of the best features of Service Assurance
Manager and EMC M&R to provide a common interface for viewing Notifications and
reports on historical events. You must install and configure EMC Service Assurance
Manager (SAM), EMC M&R, and the SolutionPack for EMC Smarts before you can view
notifications or reports from the EMC M&R Report Library.


When EMC M&R platform and the SolutionPack for EMC Smarts are deployed with Service
Assurance Manager, these features may be accessed from the EMC M&R interface:


l Notifications


l Reports showing geographical representation of Smarts network devices, physical
inventory of device groups, and a physical inventory of the IP network


l IP Configuration Manager settings such as polling and thresholds


l Discovery and topology settings for underlying domain managers


In addition, the EMC Smarts Failover System now supports failover of the services used to
communicate between Service Assurance Manager and EMC M&R platform. The EMC
Smarts Failover System User Guide provides more information.


When upgrading to a newer version of the SolutionPack for EMC Smarts, ensure you
upgrade and configure the Presentation Service Assurance Manager before upgrading the
EMC M&R core software. Services must be installed and running before you install or
upgrade the SolutionPack for EMC Smarts.


Additional information is described in these documents:


l Service Assurance Suite Installation and Configuration Guide for EMC M&R


l SolutionPack for EMC Smarts Summary Sheet


l How to Maintain IP Manager Settings


l Troubleshooting the Deployment of SAM, EMC M&R, and the SolutionPack for EMC Smarts


Resource allocation for SAM and EMC M&R
Ensure you dedicate resources (4CPU, 16GB) to SAM and also to the EMC M&R servers.


Typically, EMC M&R deployment is divided among different virtual machines (Backend,
Frontend, Collector, and so forth). Ensure that sufficient memory and CPU are available in
the virtual machine. Otherwise the system will fail.


Port configuration between SAM and the SolutionPack for EMC Smarts
When you install the SolutionPack for EMC Smarts, you must configure the ports between
EMC M&R and the server hosting the Smarts EDAA (EMC Data Access API) to ensure
communication across the firewalls.


The default port for the Smarts EDAA is 8080 (8443 in SSL mode). However, this port can
be configured manually. If EMC M&R (with SolutionPack for EMC Smarts) and SAM are
installed on different hosts, you must open the access to the EDAA port. Additionally, the
Smarts Collector used by the SolutionPack connects to the Smarts Domain Manager
servers via the ports they are started on. You must open a range of ports, including the
Broker, in order for data to pass between the Smarts domains and EMC M&R.
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Workflow for setting up SAM
Configure the Presentation Service Assurance Manager (SAM-PRES) server to
communicate with the SolutionPack for EMC Smarts installed on the EMC M&R platform.


During SAM installation you have a choice between two SAM services:


l EMC Smarts Service Assurance Manager Server (Notification Cache Publishing)


n Start the Presentation SAM server with the EMC Smarts Service Assurance
Manager Server (Notification Cache Publishing) service if you plan to integrate
EMC M&R with this installation. When the SAM server is started with this service,
SAM communicates with both EMC M&R and Smarts analysis domains.


l EMC Smarts Service Assurance Manager Server


n Start Aggregation-level SAM servers with the EMC Smarts Service Assurance
Manager Server service in environments with hierarchical SAM configurations.


One Presentation SAM server may be configured to work with one SolutionPack for EMC
Smarts. By default, the SolutionPack for EMC Smarts connects to the Smarts Broker.
When installing or updating the SAM software, you must enable Notification Cache
Publishing so that notifications will flow into EMC M&R. Notification Cache Publishing
enables SAM to publish its notifications to the Notification Cache. The Notification Cache
is a separate collection of components, including RabbitMQ, ElasticSearch, and two
webapps running under Tomcat (Ingestion and the Alert EDAA). Services for all of these
components must be installed and running before notifications display in the EMC M&R
User Interface.


Note


Both Smarts Web Console and the SAM Tomcat Server use the same default port (8080).
If installing both on the same machine, change the port for one of them. Change the
Smarts EDAA Tomcat port when it conflicts with the Web Console Tomcat port on page
6


1. Ensure the Presentation SAM server has been upgraded to the latest version of the
Service Assurance Suite. Select these options:


l Under Core Services, select EMC Smarts Broker if you plan to run the Broker from
the Presentation SAM server. If you run the Broker from another server, make note
of the Fully Qualified Domain Name (FQDN) of the server.


l Under Service Assurance Manager Services, select EMC Smarts Service
Assurance Manager Server (notification cache publishing)


l Under EMC Data Access API, select all of the entries:


n EMC Smarts Data Web Applications (Tomcat)


n EMC Smarts Data Web Applications (Tomcat)


n EMC Smarts Notification Exchange (Rabbit MQ)


n EMC Smarts Notification Cache (ElasticSearch)


l Enter the port for the Broker service.


2. Configure your SAM license using smarts.lic or the license server.


3. Add the parameter, SM_CAS_SERVER, to the runcmd_env.sh file in the
Presentation SAM server. SM_CAS_SERVER is the URL that identifies the EMC M&R
Tomcat server host, and it has to specify the protocol and port used to log into EMC
M&R. Example: SM_CAS_SERVER=http://
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smartslin03.svtdomain.us.dg.com:58080. You must use the
SM_CAS_SERVER entry to connect to the EMC M&R server.


Note


The entries in the Reports configuration screen of the SolutionPack for EMC Smarts
must match the values in SM_CAS_SERVER. In the example above:


l Set EMC M&R tomcat hostname or IP address to
www.smartslin03.svtdomain.us.dg.com


l Ensure EMC M&R tomcat port number matches the port specified in


SM_CAS_SERVER (58080 in the example)


l If using a secure protocol (https) in the SM_CAS_SERVER URL, ensure the HTTPS
enabled is checked


l Ensure the Frontend server in the Physical Overview uses the same naming
convention (You must use the FQDN across all field entries.)


l Use the FQDN, not the IP address, for hostnames; otherwise CAS (Central
Authentication Service) will not work properly.


4. Set the SM_TOMCAT_SERVER parameter in the runcmd_env.sh file of the
Presentation SAM server to specify the Fully Qualified Domain Name (FQDN) of the
SAM Tomcat server. Example: SM_TOMCAT_SERVER=http://<hostname.com>:
8080. This SM_TOMCAT_SERVER entry must match the name and port values in the
Smarts EDAA host name or IP address and Smarts EDAA port number fields of the
Reports configuration block in the SolutionPack for EMC Smarts.


5. Start the services. (Start the Broker service before starting the Tomcat service in your
Presentation SAM installation.)


6. Issue the sm_service show command to ensure these services associated with
the Presentation SAM installation are running:


Service name Description of feature


ic-broker Broker connected to Presentation SAM server


ic-sam-server-pres SAM server with Notification Cache


smarts-tomcat Smarts EDAA (controlled by Tomcat server)


smarts-rabbitmq Rabbit MQ


smarts-elasticsearch Elastic Search


7. When connecting to domain managers running pre-9.4 versions of Service Assurance
Suite software, add two parameters that control security settings to the
runcmd_env.sh file in the Presentation SAM server:


l SM_TLS_PROTOCOLS=+TLSv1.1
l SM_ALLOW_LEGACY_CRYPTO=TRUE


Note


When upgrading from older versions of SAM to version 9.3 or higher, you must manually
register and start the SAM Notification Cache service (INCHARGE-SA-PRES). Command
syntax for registering the SAM Notification Cache service on page 5
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Command syntax for registering the SAM Notification Cache service
After an upgrade of older SAM software to version 9.3 or higher, you must register the
SAM Notification Cache service and start it manually if you intend to use the SolutionPack
for EMC Smarts to view notifications from the EMC M&R User Interface.


Register the SAM Notification Cache service


sm_service install --force  --unmanaged  --startmode=runonce '--
name=ic-sam-server-pres' '--description=EMC Smarts Service Assurance 
Manager Server (notification cache publishing)' '/opt/InCharge/SAM/
smarts/bin/sm_server' '-n' 'INCHARGE-SA-PRES' '--config=ics' '--
port=0' '--edaa=sam-presentation/2.0' '--bootstrap=bootstrap-
amqp.conf' '--ignore-restore-errors' '--output'


sm_service show --cmdline ic-sam-server-pres


Start the SAM Notification Cache service
From the SAM/smarts/bin folder, issue the command, sm_service start ic-
sam-server-pres
Check on status of running services


sm_service show
RUNNING ic-broker
RUNNING ic-sam-server-pres
NOT RUNNING ic-mbim-server
RUNNING smarts-tomcat
RUNNING smarts-rabbitmq
RUNNING smarts-elasticsearch
NOT RUNNING ic-sam-server


Smarts ElasticSearch service syntax for manual startup


smarts-elasticsearch
/opt/InCharge/SAM/smarts/bin/sm_service install --force 
--unmanaged --startmode=runonce 
--name=smarts-elasticsearch 
--description=”EMC Smarts Notification Cache (ElasticSearch)” 
/opt/InCharge/SAM/smarts/bin/sm_elasticsearch 
--ignoreme


EMC Smarts Notification Exchange (Rabbit MQ) service syntax for manual startup


/opt/InCharge/SAM/smarts/bin/sm_service install --force 
--unmanaged --startmode=runonce
--name=smarts-rabbitmq
--description=”EMC Smarts Notification Exchange (Rabbit MQ)” 
/opt/InCharge/SAM/smarts/bin/sm_rabbitmq
--ignoreme


EMC Smarts Data Web Applications (Tomcat) service syntax for manual startup


/opt/InCharge/SAM/smarts/bin/sm_service install --force --unmanaged --
startmode=runonce 
--name=smarts-tomcat' 
--description=”EMC Smarts Data Web Applications (Tomcat)”
/opt/InCharge/SAM/smarts/bin/sm_tomcat 
--ignoreme
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Server tool limitations in the EMC M&R User Interface
Only server tools available from the Presentation SAM server may be invoked from the
EMC M&R User Interface.


In a hierarchical SAM deployment, server tools that need to be executed at the Aggregate
Sam (SAM-AGG) layer will fail if they rely on communication with an underlying Smarts
domain manager. When the server tool executes a script, it will still work at the Aggregate
SAM level (for example, the LSP Ping server tool in MPLS or the Remedy Adapter).


If your server tool is not working as expected, you may need to edit the ASL scripts to
invoke the SAM-AGG layer to work around this problem.


Change the Smarts EDAA Tomcat port when it conflicts with the Web Console Tomcat
port


Change the ports for Smarts EDAA when the ports are already being used by the EMC
Smarts Web Console which is installed on the same server. You also have to change the
port setting for the SM_TOMCAT_SERVER environment variable.


The default ports when configuring Tomcat are 8080, 8005 and 8009.
If the Web Console is running Tomcat on these ports as described for a default
installation, setting up a service like EDAA on same server causes a port conflict because
the default ports for this Tomcat version are also 8080, 8005 and 8009.


When the Web Console and EDAA are running on same server, they require two versions
of Tomcat to run: One is installed with the Console for the Dashboard service and the
other for the SAM server services that require it such as EDAA.


To change the ports for Smarts EDAA, follow this procedure.


Procedure


1. Determine which ports are not being used on the server. For a list, run the command:


l For Linux: netstat -anpt
l For Windows: netstat -anb -p TCP


2. On the server where EDAA is installed, go to the Tomcat directory of the SAM
installation (for example: ./SAM/smarts/tomcat/conf).


3. Save a copy of the server.xml file as server.xml.orig.


4. Edit the server.xml file. Change the ports 8080, 8005 and 8009 to ports that are
not being used (in this example, 8015, 8181 and 8019):


<Server port="8015" shutdown="SHUTDOWN">
  <!-- Security listener. Documentation at /docs/config/
listeners.html
 <Listener 
className="org.apache.catalina.security.SecurityListener" />
 -->
 <!--APR library loader. Documentation at /docs/apr.html -->
 <Listener 
className="org.apache.catalina.core.AprLifecycleListener" 
SSLEngine="on" />
       .  
       .
       .
<Service name="Catalina">
 <!--The connectors can use a shared executor, you can define one 
or more named thread pools-->
 <!--
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 <Executor name="tomcatThreadPool" namePrefix="catalina-exec-"
    maxThreads="150" minSpareThreads="4"/>
 -->
 
 <Connector port="8181" protocol="HTTP/1.1"
      connectionTimeout="20000"
      redirectPort="8443" />
 
 <!-- Define an AJP 1.3 Connector on port 8009 -->
 <Connector port="8019" protocol="AJP/1.3" redirectPort="8443" />


5. Set the SM_TOMCAT_SERVER environment variable to the replacement port for 8080
(line with: protocol="HTTP/1.1") in the runcmd_env.sh file:


a. Use sm_edit from the <BASEDIR>/smarts/bin directory to open the file. For
example: sm_edit conf/runcmd_env.sh


b. Change the SM_TOMCAT_SERVER environment variable from
SM_TOMCAT_SERVER=http://<public_hostname>:<public_port> to
8181 for this example:


SM_TOMCAT_SERVER=http://<public_hostname>:8181


c. Save the file.


6. Restart the Tomcat service.


For Linux: Type these commands from the <BASEDIR>/smarts/bin directory:


sm_service stop smarts-tomcat
sm_service show
sm_service start smarts-tomcat


For Windows:


a. Use the Service control panel to stop the service named "EMC Smarts Data Web
Applications (Tomcat)".


b. Use the Service control panel to start the service named "EMC Smarts Data Web
Applications (Tomcat)" .


Workflow for setting up EMC M&R
1. Install or upgrade to the latest version of EMC M&R. The Service Assurance Suite


Installation and Configuration Guide for EMC M&R provides more information.


2. Start the services. For example, /opt/APG/bin/manage-modules.sh service
start all


3. New installations of EMC M&R provide a 30-day trial license for all SolutionPacks.
Ensure you obtain and install permanent licenses for SolutionPacks you plan to use
longer than 30 days.


4. Install the SolutionPack for EMC Smarts.
The article, SolutionPack for EMC Smarts Summary Sheet, provides more information.


l On the Reports page of the SolutionPack installation wizard, you must enter the
Fully Qualified Domain Name (FQDN) of the EMC M&R Tomcat server. This address
must match the entry in the SM_CAS_SERVER parameter setting in the
runcmd_env.sh file in the Presentation SAM server.
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Note


Use the FQDN, not an IP address, when configuring the SolutionPack for EMC
Smarts.


l Enter the FQDN for the server hosting the Smarts EDAA.


l Accept the default values for the other fields unless your deployment has a non-
default SAM setup. For example,


n SAM Presentation server is not named INCHARGE-SA-PRES
n SAM server is using SSL


n The admin-profile in SAM has changed


l On the Reports page of the SolutionPack installation wizard, enter the Smarts
Configuration Manager domain name if you plan to manage settings for your IP
domains from the EMC M&R interface.


Note


Ensure you restart the Presentation SAM services after you configure the
SolutionPack for EMC Smarts. This forces the CAS webapp to run with the latest
configuration.


After installation of the SolutionPack for EMC Smarts, configure IP settings in the
Configuration Manager and push them to the remote IP domain managers. Access the
IP settings from Administration > Modules > Smarts. Additional information is
provided in this article:


l How to Maintain IP Manager Settings


5. Create user accounts for operators in EMC M&R. The Administrator must also create
new Roles for these users and map them to existing profiles in Service Assurance
Manager (SAM).


6. Set the default navigation style to Use tree navigation. This setting is recommended
for the SolutionPacks for the 9.4.2 release.


7. Hide the ViPR SRM-related report nodes in the navigation tree if you do not plan to
install ViPR SRM. (The Smarts-related nodes are under Network in the tree.)


8. You can customize the tools available in the Notification views depending on the
value of the User Status.


9. You can customize the client tools available from the Notification reports if you want
to add scripts to show notification name or severity.


10. Run manual Topology import from Administration > Centralized Management >
Scheduled Tasks > Topology. Click sm-collector/import-smarts-topology and click
Run.
By default the task runs every day at midnight.


User management for SolutionPack for EMC Smarts
In order to manage notifications from the SolutionPack for EMC Smarts, the Administrator
must set up users and roles in EMC M&R that correspond to the profiles set up in Service
Assurance Manager (SAM).


In the SAM Global Manager Administration Console, the Administrator configures profiles
that define which Notifications, Actions, and Tools are available to each group of users
(for example, OPER profile and so forth).
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The Administrator providing access to SolutionPack for EMC Smarts views has to create
users and roles in EMC M&R that reflect the characteristics of the SAM profiles that are in
use.


If Administrators need to restrict Notifications, Actions, or Tools available to a user in
EMC M&R, they need to define the restrictions first in the corresponding SAM profile.


Note


The Administrator should not duplicate EMC M&R users in SAM unless a user needs
access to both the SolutionPack for EMC Smarts views and classic SAM Consoles. Users
working only in EMC M&R need only the user login and role definition created in EMC
M&R.


Set role restrictions for non-administrator users of SolutionPack for Smarts
If you want additional user roles, such as oper (operator), or profiles configured in your
Presentation SAM server, you must set role restrictions after installing the SolutionPack
for Smarts.


The default role is assigned to administrator. Add additional roles as needed.


Procedure


1. From Administration > Roles, click New Role.


2. Click Modules & Restrictions Access and expand the Smarts module.


3. Add an existing smarts profile (such as oper-profile or default-profile) and
click Save.


4. From Administration > Users, create a new user and assign a role to the new user.


You can assign one or more roles to a new user.


Note


Notification actions (like Acknowledge/Unacknowledge, Take/Release Ownership,
and so on) in the Notifications view are available for a user who is assigned multiple
roles that have the same sam-profiles. Notification actions are not available for a user
who is assigned multiple roles that have different sam-profiles.


SAM user profile mapping and EMC M&R role-based access


After you set up the user profiles and assign them to roles in EMC M&R, the administrator
must associate those profiles and roles with users who need to access both Service
Assurance Manager (SAM) Consoles and the EMC M&R User Interface.


Administrator profile behavior
The EMC M&R administrator role is mapped to the EMC Smarts Admin profile when the
SolutionPack for EMC Smarts is installed.


Note


If you try to assign a SAM profile to the EMC M&R Admin user, that SAM profile will be
overwritten with the EMC M&R profile.


User profile behavior
The administrator can assign a SAM profile to an EMC M&R non-administrator user from
Administration > Modules & Restrictions Access > Smarts.
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l Ensure you assign an existing SAM Profile to the user, (for example, oper-profile,
default-profile, and so forth).


l You can assign more than one Role with a SAM Profile to a user.


Set default navigation style
The navigation style controls the look and feel of the left navigation column in the
reporting interface.


An administrator sets the global default navigation style. Users can override the global


default style for a user account on Settings  > User Preferences.


Procedure


1. Navigate to Administration  > Portal.


2. Click the Default Display tab.


3. In Navigation Style, make a selection.


Option Description


Use icon navigation The navigation column contains icons that expand into
reporting categories


Use tree navigation The navigation column is a hierarchical tree of report names


4. Click Save.


Hide unused entries in the navigation tree
You can hide default entries in the navigation tree if you have not installed the products
that populate them with data.


Before you begin


The default EMC M&R platform displays nodes such as Operations, Explore, Dashboards,
and Planning in the navigation tree. Other product suites that also use EMC M&R as their
platform display entries under these nodes by default. However, no data populates these
entries unless you are using those products. The SolutionPack for EMC Smarts populates
data in the Network block under Operations, Explore, and Dashboards.


Procedure


1. To hide entries in the navigation tree, click Edit Mode from the EMC M&R User
Interface.


2. Find the storage-related blocks in the list and select, Always Hide.


Do not hide the Network block under the Operations, Explore, or Dashboards nodes.
The Network block contains all of the SolutionPack for EMC Smarts views and reports.
The Planning node is not used by the SolutionPack for EMC Smarts.


Viewing notifications from the EMC M&R User Interface
Launch Object Details from the Notifications view.


Before you begin


You can view notifications coming from the Presentation SAM server in the EMC M&R User
Interface.
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Procedure


1. To view Notifications where an element name is collected, launch the Object Details
report with map, details, containment, and so forth.


2. To view Notifications with an element name that is not collected by the SolutionPack
for EMC Smarts, launch only the Details view.


The SolutionPack for EMC Smarts does not collect every class and instance that exists
in the Smarts domains. It selects "top level" classes like Routers, Switch and some of
their underlying components.


Troubleshooting an empty notification list
After creating a new Notification List in Service Assurance Manager, the notifications are
not visible in the EMC M&R User Interface.


When you create a new Notification List in Service Assurance Manager, you must issue
this command to have notifications populate the correct reports in EMC M&R. This
command ensures notifications are re-cached so they display in the correct Notification
List.


Issue this command from the Presentation Service Assurance Manager <install_directory>
\SAM\smarts\bin folder: dmctl> invoke ICS_NLManager::ICS-NLManager
renotifyAllEvents


Troubleshooting notification list errors
Notifications are not visible in the EMC M&R user interface. "MSAException" and "Map is
showing HTTP Error" messages display.


Check the /etc/hosts file in the Presentation SAM server. If the /etc/hosts file
does not list the Fully Qualified Domain Name of the EMC M&R host, these errors will
display.


Add the entry in the /etc/hosts file and restart all SAM services.


Troubleshooting Notification view popouts
The popout option that was formerly available under the gear tool for the Notification
report is not available.


Select View in Full Page under the Display option in the EMC M&R user interface. This
opens the Notification report in a new window.


Customizing the tools that are available in the Notification view
Depending on your business needs, you can customize which tools are available for the
user in the Notification view. When you create the EMC M&R user, the value that you
select for the User Status field determines which tools will appear for the view.


By default, for a non-administrator user (Normal user), all tools except Associate User and
Clear Customizations are enabled. All tools are enabled for the admin user (Global
Administrator).


Procedure


1. Go to the <installdirectory>/APG/Web-Servers/Tomcat/Default/
webapps/dojoviews/WEB-INF/classes/resources/view/AlertView
directory.


2. Edit the userStatus section in the SmartsAlertTools.xml file.
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Change the values to true or false. Do not edit other sections of the file.


<userStatus>
<status name ="Global Administrator" isAdministrator="true"
   <filter>true</filter>
   <clearFilter>true</clearFilter>
   <associateUser>true</associateUser>
   <clearCustomization>true</clearCustomization>
   <multiSort>true</multiSort>
   <manageColumns>true</manageColumns>
   <manageColor>true</manageColor>
</status>
<status name ="Normal User" isAdministrator="false"
   <filter>true</filter>
   <clearFilter>true</clearFilter>
   <associateUser>false</associateUser>
   <clearCustomization>false</clearCustomization>
   <multiSort>true</multiSort>
   <manageColumns>true</manageColumns>
   <manageColor>true</manageColor>
</status>
</userStatus>


The Audible Alert tool is not listed because it cannot be enabled or disabled.


3. Save the file.


4. Restart the Tomcat services.


5. Verify by logging in as the user, select Operations > Network > Notifications, and select
the gear icon near the Notification view.


Creating client tools
Client tools are programs the operator invokes by right-clicking on a notification.


The default client tool, Launch EMC M&R, launches the EMC M&R home page. You can
create others by editing the SmartsTools.json file.


Procedure


1. To create client tools, log in to Centralized Management and expand Logical Overview
> Miscellaneous > Custom.


2. Click Webapps-Resources::Default and expand the list of Configuration files.


3. Select the checkbox for /conf/SmartsTools.json and click the pencil icon to
edit the file.


Use this file to add or modify options that appear in the Notifications Client Tools
right-click menu. You can edit the tool to launch any URI and pass in any notification
property as a parameter by surrounding it with brackets.


You must encode & characters as %26.


Column headers which are available in Notifications can be passed as arguments to
the URI. The various notification properties that can be used are Acknowledged,
Active, Category, Certainty, ClassName, ClassDisplayName, ClearOnAcknowledge,
ElementClassName, ElementName, EventText, EventName, EventState,EventType,
EventDisplayName, FirstNotifiedAt, Impact, InstanceName, IsProblem, IsRoot,
InMaintenance, LastClearedAt, LastNotifiedAt, LastChangedAt, Name, NotificationID,
OccurrenceCount, Owner, Severity, SourceDomainName, SourceEventType,
TroubleTicketID, UserDefined 1 to 20.
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Example client tool:


{
         "name": "Example 1",
         "url": " http://www.emc.com/?class={ClassName}
%26source={SourceDomainName}"
        },
       


In this example, "name":"Example 1" is the name which appears on the sub-
menu for the right click action on the notification. This causes the text, "Example 1" to
display. When you right-click on a Notification, you will see Client Tools > Example 1.


In this example, "url": " http: //www.emc.com/?class={ClassName}
%26source={SourceDomainName}" provides the URL to which a notification
attribute can be appended as a parameter. In this example, ClassName and
SourceDomainName are used. When invoked, this tool would launch, http://
www.emc.com/?class=Host&source=INCHARGE-AM-PM.


Additional files that may be used when creating client tools include conf/
common.properties and mib-browser/mib-browser.xml.


Invoking Perl scripts with client tools in Notification views
Configure client tools to execute Perl scripts when you right-click a notification. This is not
part of the default installation and must be configured manually.


Before you begin


This feature is available when the Presentation SAM is upgraded to version 9.4.2
onwards and EMC M&R is upgraded to 6.7u1 onwards. The SolutionPack for EMC Smarts
must also be upgraded to get support for this feature.


Procedure


1. Create a folder, clientTools, in <installdirectory>/APG/Web-Servers/
Tomcat/Default/webapps/dojoviews/WEB-INF.


2. Copy a valid Perl script file, <file_name>.pl, to this location.


3. Edit dojoviews.xml and add privileged="true" as an attribute for the Context
tag. For example, <Context reloadable="false" privileged="true">
dojoviews.xml is in <install directory>/APG/Web-Servers/Tomcat/
Default/conf/Catalina/localhost


4. Save the file.


5. Modify web.xml to uncomment the servlet, cgi, and its servlet mapping.


web.xml is in <install directory>/APG/Web-Servers/Tomcat/
Default/webapps/dojoviews/WEB-INF


6. Restart the tomcat services


7. Test the script by invoking the URL. For example, from this location, <install
directory>/APG/Web-Servers/Tomcat/Default/webapps/dojoviews/
WEB-INF, enter this URL: http://<M&R_Host>:<Port>/dojoviews/client-
tool/<file_name>.pl


8. Modify SmartsTools.json to add the new tool as a Notification attribute.
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SmartsTools.json is in EMC M&R Centralized Management at Logical Overview >


Miscellaneous > Custom > WebApps-Resources.


Perl script example for use with client tool in Notification view
This example script prints the notification name and severity and displays it in a web
browser.


Example 1  alertExample.pl


#!/usr/bin/perl -w
use CGI qw(:standard);
use strict;
my $query = new CGI;
my $notification = $query->param('notification');
my $severity = $query->param('severity');
print $query->header("text/html");
print "Notification $notification has severity value $severity\n";


Editing client tools in SmartsTools.json
You must edit SmartsTools.json to add the Perl script as an attribute on the
Notification table. This allows you to right-click the notification and select the client tool
that invokes a Perl script.


To add the script to the client tool available from the Notification view, copy the script to
a file with a .pl extension, for example, alertExample.pl.


You must add the script to the Notification Client tool by modifying
SmartsTools.json in this Centralized Management path: Logical Overview >


Miscellaneous > Custom.


Procedure


1. Click Webapps-Resources::Default and expand the list of Configuration files.


2. Select the checkbox for /conf/SmartsTools.json and click the pencil icon to
edit the file.


3. Add these lines to the .json file and save the changes.


{
"name": "Alert Attribute",
"url": "/dojoviews/client-tool/alertExample.pl?notification=
{Name}
&severity=
{Severity}
"
}


4. Test the client tool changes by invoking the alertExample.pl script from a Notification.


Select a notification in the Operation > Network > Notificationreport. Right-click the
notification and select Alert Attribute to invoke the example Perl script.


Results


This will display the notification name and severity value.
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Enrich device location data in Smarts geographical maps
The Smarts geographical map (geomap) shows the location of Smarts-enabled devices in
the network. Before viewing Smarts geomaps, perform data enrichment of the device
locations to provide more details in the map.


Before you begin


Ensure device discovery has finished and devices display in the user interface before
enriching the location data. Look in the Explore > Network tree to view the discovered
devices. The Location attribute of the device object in Smarts IP Manager populates the
Device Location dropdown after discovery.


The APG-Centralized-Management-Guide, found in the /APG/Doc folder in your EMC M&R
installation, provides additional information.


Procedure


1. Register the Collector Manager module with the hostname of the EMC M&R
installation.


a. From Centralized Management > Data Enrichment, click Register for New Module.


b. Click <hostname> in the first column.


c. Click Collecting in the second column.


d. Click Collector Manager :: emc-smarts :: DataEnrichment in the third column.


Do not select any other modules from the list. They are not required for geomaps.


2. Select Collector Manager :: emc-smarts :: DataEnrichment and click geo-map-
enrichment.


The DataEnrichment property is used to enrich the values in Device Location to match
meaningful values in the smlocale column.


a. Find the columns for Device Location and smlocale.


By default the first row displays @MATCHALL for Device Location and @NULL for
smlocale.


b. Replace the default values with meaningful names, for example, *white, in Device
Location can map to White Plains, New York for the smlocale value.


Enter a valid smlocale name which will be identifiable on the geomap.


The Device Location dropdown menu displays accurate data only after device
discovery has finished. For example, typing ‘W’ displays all locations having
names with ‘W’. Typing * displays all locations.


c. Save the changes.


d. Click Update in the Save Data Enrichment window.


All values in the dropdown windows must be enriched to get all locations in the
geomap.


To add a new row for enrichment, right-click the icon appearing in front of the row.
This gives options to Insert Before, Insert After, or Delete a row.


3. Restart the Database and Backend.


a. Go to Centralized Management > Scheduled Tasks.
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b. Click Select All.


c. Uncheck the Update Online option.


d. Click Run now to restart the Database and Backend.


4. Restart the EMC M&R services.


This restarts the Collector Manager.


After some time, the Smarts Geography geomap will be uploaded to Dashboard >
Network > EMC Smarts Geography. Click the icons on the map to view devices present
at that location.


Alternate method of data enrichment using file import
Use the Import/Export function in the UI to import CSV or XLS files with Device Location
and smlocale mapping as an alternative method of enriching Smarts geomap data.


The XLS or CSV files must have two columns of values in the same order as the columns
mentioned in data enrichment. Here is an example:


Table 1 Sample data enrichment import file column layout


Device Location column data smlocale column data


white* White Plains, NY


10;PUGET SOUND;United States;REDMOND, WA;11 Redmond, Washington


*Westchester Ave* White Plains, NY


LOCATION Bangalore, India


EMC E-Labs Building 119 Bangalore, India


*Hopkinton* Hopkinton, MA


DevLab, row 2-rack 2, 44 S Broadway, 7th floor Bangalore, India


10.3.2 Delhi, India


Chicago, IL Chicago, IL


Although the value, <city>, is enough for smlocale to render points in the map, enter <city,
state> or <city,country> to avoid duplicates or conflicts. Ensure the location name is valid
because it will display in the maps report.


Map reports
A map report is basically a standard table report where each child node displays as a
point in a geographical map. You can edit the location and the name of the location as
well as the size, color, and shape of marker displayed on the map.


In Report Type on the Report Configuration tab, you select the map report from the
miscellaneous section.


You can edit the following attributes on a map report:


l Location locates an element on the map.


l Name provides a name to a location, such as device name, region, and sitename.


l Size sets the size of the marker. The size of the marker is based on a given metric
value, such as the number of devices at the site.
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l Color sets the color of the marker. The color relies on the threshold definition where
green represents no thresholds, yellow represents a major threshold, and red
represents a critical threshold.


l Marker sets the shape of the marker, such as circle, square, triangle, inverted
triangle, pentagon, and sector.


Switch between OpenStreetMap and Google Maps
OpenStreetMap is used as the default platform mapping software. Use this procedure to
configure EMC M&R to use other mapping software, such as Google Maps.


Procedure


1. To switch from OpenStreetMaps (osm) to Google Maps (google), navigate to APG/
Web-Applications/APGFrontend/APG/conf/common.properties.


a. Add these lines to common.properties:


#=========================================================
Setting for Google Maps (client-side)
#========================================================= 
apg.maps.geocode=false
apg.maps.provider=google
apg.maps.geocoder=google


b. Restart all managed module services including tomcat.


2. To switch back to OpenStreetMaps from Google Maps


a. Comment the lines of code you added to common.properties file to disable
them.


b. Restart all managed module services including tomcat.


SSL setup for SAM and EMC M&R
Adjust the port and protocol settings when enabling SSL encryption in SAM and EMC
M&R.


The procedures for SSL setup assume use of the Java Keytool. You may, optionally, use a
different encryption tool.


This keytool generates keystore files in the location where the commands are issued. For
these SSL procedures, the following assumptions are made:


1. When configuring EMC M&R (Watch4net) with CLI commands, issue the commands
from the bin folder of the installation path. For example, /opt/APG/bin or from c:
\Program Files\APG\bin.


2. When configuring Service Assurance Manager (SAM) with CLI commands, issue the
commands from the base directory path. For example, /opt/InCharge/SAM/
smarts or from c:\Program Files\InCharge\SAM\smarts.


3. Both EMC M&R and SAM installations include versions of Java. Check to ensure the
correct versions of Java are in use in both the EMC M&R server and in the SAM server.
Java is usually installed into the ...usr/bin path. (The versions may differ
between EMC M&R and SAM.)


Workflow


1. Edit the Reports configuration settings in the SolutionPack for EMC Smarts to adjust
port and protocol settings.
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2. Generate the SSL certificate for the EMC M&R (Watch4net) server where the Tomcat
server is running. The Java documentation provides details.


3. Generate the SSL certificate for the Service Assurance Manager (SAM) server where
the Tomcat server is running. The Java documentation provides details.


4. Ensure the configuration settings have been adjusted for SSL. For example, check the
SM_CAS_SERVER and SM_TOMCAT_SERVER settings in the runcmd_env.sh file in
SAM and edit the settings to add the secure port numbers and change the protocol
from http to https. (When you change runcmd_env.sh, you must stop and restart
the SAM service. For example, sm_service stop|start ic-sam-server-
pres)


5. Enable the https protocol in the server.xml files in both the SAM and EMC M&R
deployments. Add the Http11Protocol and Http11NioProtocol sections if
missing from the server.xml file.


6. Export the EMC M&R certificate and import to the SAM server.


7. Export the SAM certificate and import to the EMC M&R server.


8. Stop and start the SAM Tomcat server.


9. Restart the EMC M&R Tomcat server.


Linux SSL Setup


Enable SSL port and protocol settings in SolutionPack for EMC Smarts
When enabling SSL, you must edit the Reports configuration of the SolutionPack for EMC
Smarts and ensure use of secure port and protocol settings.


Before you begin


This procedure assumes the SolutionPack for EMC Smarts is already installed and
running. If not, the SolutionPack for EMC Smarts Summary Sheet article provides
installation instructions.


Edit the Reports configuration page to enable SSL for the SolutionPack for EMC Smarts.
Access this page from Centralized Management. Expand SolutionPacks > Infrastructure
and click EMC Smarts.


Procedure


1. Click the Pencil icon by the Reports SolutionPackBlock.


The Reports reconfiguration page appears.


2. Expand Tomcat Configuration and choose Add a new Tomcat configuration in the
dropdown box.


3. Click the checkbox for HTTPS Enabled for EMC M&R and Smarts.


4. Enter the Fully Qualified Domain Name or IP address of the EMC M&R Tomcat server.


This name must match the host name portion of the entry in SM_CAS_SERVER in the
Presentation SAM runcmd_env.sh file. Ensure consistent use of either IP address or
FQDN in all of the field entries. Do not mix the entry formats.


5. Enter the secure port for the EMC M&R Tomcat server. (Default SSL port is 58443).


6. Expand the Smarts and Alerts EDAA Configuration and choose Add a new Smarts and
Alerts EDAA Configuration in the dropdown box.
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Check the entry in the Smarts EDAA hostname or IP address field. This entry must
match the host name portion of the entry in SM_TOMCAT_SERVER in the Presentation
SAM runcmd_env.sh file.


7. Enter the secure port for the Smarts EDAA server. (Default SSL port is 8443).


8. Adjust other entries if needed and then click Reconfigure.


After you finish


Continue with the SSL certificate generation, import, and export steps. The changes will
not take effect until the Tomcat servers are restarted in both SAM and EMC M&R.


Linux: Generate the keystore file for EMC M&R
Create the keystore file for the EMC M&R host. This file stores the Tomcat server's private
key and self-signed certificate.


Before you begin


Stop the EMC M&R Tomcat service. For example, opt/APG/bin/manage-modules.sh
service stop tomcat
Procedure


1. Generate the keystore. For example, run this command for the EMC M&R host if it has
a Fully Qualified Domain Name (FQDN):


/opt/APG/Java/Sun-JRE/8.0u51/bin/keytool -genkey -alias tomcat 
-keyalg RSA -keystore /opt/APG/.keystore


a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type yes when asked for confirmation.


If you are using an IP address naming convention for the configuration, run this
command and specify the IP address of the EMC M&R host for <ip:x.x.x.x>.


/opt/APG/Java/Sun-JRE/8.0u51/bin/keytool -genkey -alias tomcat 
-keyalg RSA -ext SAN=<ip:x.x.x.x> -keystore /opt/APG/Web-Servers/
Tomcat/Default/conf/.keystore


Results


This creates a keystore file inside /opt/APG folder with name .keystore. This is a
hidden file in Linux.


Linux: Editing the EMC M&R server.xml file
Edit the server.xml file to tell Tomcat server which secure port to use.


Update the https connector configuration in server.xml in this path, /opt/APG/
Web-Servers/Tomcat/Default/conf.


Procedure


1. Uncomment the https connector configuration in server.xml.
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2. Add the path to the keystore file. For example,


 <Connector port="58443" protocol="HTTP/1.1" SSLEnabled="true"
               maxThreads="150" scheme="https" secure="true"
               compression="2048" compressableMimeType="text/"
               clientAuth="false" sslProtocol="TLS" 
URIEncoding="UTF-8"
        keystoreFile="/opt/APG/.keystore" keystorePass="changeit"
               SSLDisableCompression="true" />


Configuring SAM environment variables to support SSL
Edit the environment variables in the SAM runcmd_env.sh file to support SSL.


Before you begin


Both SM_CAS_SERVER and SM_TOMCAT_SERVER must be configured to support SSL. The
SM_CAS_SERVER environment variable is set to the URL for EMC M&R. The
SM_TOMCAT_SERVER environment variable is set to the URL for the SAM Tomcat server.


Procedure


1. Enter the secure port and protocol used to log into EMC M&R in the SM_CAS_SERVER
variable. For example, SM_CAS_SERVER=https://<cas-serverhost>:58443


2. Enter the secure port and protocol used to log into SAM Tomcat server in the
SM_TOMCAT_SERVER variable. For example, SM_TOMCAT_SERVER=https://
<smarts-tomcat-server-host>:8443


After you finish


Stop and restart the SAM service to make the changes take effect. For example:


sm_service stop ic-sam-server-pres


sm_service start ic-sam-server-pres


Linux: Generating the SAM Tomcat server keystore file and certificate
Create the Tomcat server keystore file and certificate.


Before you begin


Generate the keystore file in the home directory where you issue the command.


Procedure


1. Issue the command to generate the keystore file. For example, run this command for
the SAM host if it has a Fully Qualified Domain Name (FQDN):


/opt/InCharge/SAM/smarts/jre/bin/keytool -genkey -alias tomcat -
keyalg RSA


To specify a different location or filename, add the -keystore parameter followed
by the complete pathname to the keystore file. For example,


$JAVA_HOME/bin/keytool -genkey -alias tomcat -keyalg RSA 
-keystore /opt/InCharge/SAM/smarts/.keystore


a. Enter changeit for the keystore password.
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b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type yes when asked for confirmation.


If you are using an IP address naming convention for the configuration, run this
command and specify the IP address of the SAM host for <ip:y.y.y.y>.


/opt/InCharge/SAM/smarts/jre/bin/keytool -genkey -alias tomcat -
keyalg RSA -ext SAN=<ip:y.y.y.y> -keystore /opt/InCharge/SAM/
smarts/.keystore


Results


This creates a keystore file inside /opt/InCharge/SAM/smarts folder with
name .keystore.


Linux: Editing the SAM server.xml file
Edit the server.xml file to tell the SAM Tomcat server which secure port and protocol to
use.


Update the https connector configuration in server.xml in this path, /opt/
InCharge/SAM/smarts/tomcat/conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file and the password. For example,


 <Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
             maxThreads="150" scheme="https" secure="true"
              keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
              clientAuth="false" sslProtocol="TLS" />


3. Configure the Connector protocols in server.xml as follows. (Copy in this code if it is
missing.)


 <Connector protocol="org.apache.coyote.http11.Http11Protocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


<Connector protocol="org.apache.coyote.http11.Http11NioProtocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="/opt/InCharge/SAM/smarts/.keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />
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Linux: Creating the trust relationship between SAM and EMC M&R
You must export and import certificates to get the SAM Tomcat server and EMC M&R
Tomcat server to trust each other.


Before you begin


First, export a certificate on the SAM server. Then import it into the EMC M&R Tomcat
server. Then export a certificate from the EMC M&R server and import it into the SAM
Tomcat server.


Procedure


1. Export a certificate from the SAM Tomcat server. For example,


$JAVA_HOME/bin/keytool -export -keystore /opt/InCharge/SAM/
smarts/.keystore -alias tomcat -rfc > SAMtomcat.cert


a. Copy SAMtomcat.cert to the host where EMC M&R Tomcat server is installed.


b. On the EMC M&R host, import the SAMtomcat.cert. For example,


$JAVA_HOME/bin/keytool -import -file SAMtomcat.cert -alias 
SAMtomcat -keystore /opt/APG/.keystore


c. Back up the original EMC M&R cacerts file.


cp /opt/APG/Java/Sun-JRE/8.0u51/lib/security/cacerts /opt/APG/
Java/Sun-JRE/8.0u51/lib/security/cacerts-SAVE    # Backup old 
cacerts file


d. Copy .keystore and rename it to cacerts.


cp /opt/APG/.keystore /opt/APG/Java/Sun-JRE/8.0u51/lib/security/
cacerts


2. Restart Tomcat server on the EMC M&R host.


/opt/APG/bin/manage-modules.sh service restart tomcat


3. Export a certificate from the EMC M&R host. For example,


•    $JAVA_HOME/bin/keytool -export -keystore /opt/APG/.keystore -
alias tomcat -rfc > W4Ntomcat.cert


4. Copy W4ntomcat.cert to the SAM server host.


5. On the SAM server host, run this command to import a certificate copied from the EMC
M&R server host.


$JAVA_HOME/bin/keytool -import -file W4Ntomcat.cert -alias 
W4Ntomcat -keystore /opt/InCharge/SAM/smarts/.keystore
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6. Copy the keystore file.


cp /opt/InCharge/SAM/smarts/jre/lib/security/cacerts /opt/
InCharge/SAM/smarts/jre/lib/security/cacerts-SAVE    # Backup old 
cacerts file


cp /opt/InCharge/SAM/smarts/.keystore /opt/InCharge/SAM/
smarts/jre/lib/security/cacerts


7. Confirm the certificates copied properly (review entries).


For SAM


/opt/InCharge/SAM/smarts/jre/bin/keytool -list -keystore /opt/
InCharge/SAM/smarts/.keystore


For EMC M&R


/opt/APG/bin/keytool -list -keystore /opt/APG/.keystore


8. Stop and start the Tomcat service on the SAM server:


a. /opt/InCharge/SAM/smarts/bin/sm_service stop smarts-tomcat
b. /opt/InCharge/SAM/smarts/bin/sm_service start smarts-


tomcat
9. Restart the EMC M&R services.


/opt/APG/bin/manage-modules.sh service restart all


Windows SSL Setup


Enable SSL port and protocol settings in SolutionPack for EMC Smarts
When enabling SSL, you must edit the Reports configuration of the SolutionPack for EMC
Smarts and ensure use of secure port and protocol settings.


Before you begin


This procedure assumes the SolutionPack for EMC Smarts is already installed and
running. If not, the SolutionPack for EMC Smarts Summary Sheet article provides
installation instructions.


Edit the Reports configuration page to enable SSL for the SolutionPack for EMC Smarts.
Access this page from Centralized Management. Expand SolutionPacks > Infrastructure
and click EMC Smarts.


Procedure


1. Click the Pencil icon by the Reports SolutionPackBlock.


The Reports reconfiguration page appears.


2. Expand Tomcat Configuration and choose Add a new Tomcat configuration in the
dropdown box.


3. Click the checkbox for HTTPS Enabled for EMC M&R and Smarts.
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4. Enter the Fully Qualified Domain Name or IP address of the EMC M&R Tomcat server.


This name must match the host name portion of the entry in SM_CAS_SERVER in the
Presentation SAM runcmd_env.sh file. Ensure consistent use of either IP address or
FQDN in all of the field entries. Do not mix the entry formats.


5. Enter the secure port for the EMC M&R Tomcat server. (Default SSL port is 58443).


6. Expand the Smarts and Alerts EDAA Configuration and choose Add a new Smarts and
Alerts EDAA Configuration in the dropdown box.


Check the entry in the Smarts EDAA hostname or IP address field. This entry must
match the host name portion of the entry in SM_TOMCAT_SERVER in the Presentation
SAM runcmd_env.sh file.


7. Enter the secure port for the Smarts EDAA server. (Default SSL port is 8443).


8. Adjust other entries if needed and then click Reconfigure.


After you finish


Continue with the SSL certificate generation, import, and export steps. The changes will
not take effect until the Tomcat servers are restarted in both SAM and EMC M&R.


Windows: Generate the keystore file for EMC M&R
Create the keystore file for the EMC M&R host. This file stores the tomcat server's private
key and self-signed certificate.


Before you begin


Stop the EMC M&R Tomcat service. For example, c:\Program Files\APG\bin\manage-
modules.cmd service stop tomcat
Procedure


1. Generate the keystore. For example, run this command for the EMC M&R host if it has
a Fully Qualified Domain Name (FQDN):


C:\Program Files\Java\Sun-JRE\8.0u51\keytool.exe -genkey -alias 
tomcat -keyalg RSA -keystore C:\Program Files\APG\.keystore


a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type yes when asked for confirmation.


If you are using an IP address naming convention for the configuration, run this
command and specify the IP address of the EMC M&R host for <ip:x.x.x.x>.


C:\Program Files\Java\ jdk1.7.0_07\keytool.exe -genkey -alias 
tomcat -keyalg RSA -ext SAN=<ip:x.x.x.x> -keystore C:\Program Files
\APG\Web-Servers\Tomcat\Default\conf\.keystore


Results


This creates a keystore file inside C:\Program Files\APG folder with
name .keystore.
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Windows: Editing the EMC M&R server.xml file
Edit the server.xml file to tell Tomcat server which secure port to use.


Update the https connector configuration in server.xml in this path, c:\Program
Files\APG\Web-Servers\tomcat\Default\conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file. For example,


 <Connector port="58443" protocol="HTTP/1.1" SSLEnabled="true"
               maxThreads="150" scheme="https" secure="true"
               compression="2048" compressableMimeType="text/"
               clientAuth="false" sslProtocol="TLS" 
URIEncoding="UTF-8"
        keystoreFile="C:\Program Files\APG\.keystore" 
keystorePass="changeit"
               SSLDisableCompression="true" />


Configuring SAM environment variables to support SSL
Edit the environment variables in the SAM runcmd_env.sh file to support SSL.


Before you begin


Both SM_CAS_SERVER and SM_TOMCAT_SERVER must be configured to support SSL. The
SM_CAS_SERVER environment variable is set to the URL for EMC M&R. The
SM_TOMCAT_SERVER environment variable is set to the URL for the SAM Tomcat server.


Procedure


1. Enter the secure port and protocol used to log into EMC M&R in the SM_CAS_SERVER
variable. For example, SM_CAS_SERVER=https://<cas-serverhost>:58443


2. Enter the secure port and protocol used to log into SAM Tomcat server in the
SM_TOMCAT_SERVER variable. For example, SM_TOMCAT_SERVER=https://
<smarts-tomcat-server-host>:8443


After you finish


Stop and restart the SAM service to make the changes take effect. For example:


sm_service stop ic-sam-server-pres


sm_service start ic-sam-server-pres


Windows: Generating the SAM Tomcat server keystore file and certificate
Create the Tomcat server keystore file and certificate.


Before you begin


Generate the keystore file in the home directory where you issue the command.


Procedure


1. Issue the command to generate the keystore file. For example,


$JAVA_HOME\bin\keytool -genkey -alias tomcat -keyalg RSA
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To specify a different location or filename, add the -keystore parameter followed
by the complete pathname to the keystore file. For example,


C:\Program Files\Java\jdk1.7.0_07\bin\keytool.exe" -genkey -alias 
tomcat -keyalg RSA -keystore C:\InCharge\SAM\smarts\.keystore


a. Enter changeit for the keystore password.


b. When asked for your first and last name, enter the fully qualified name of the
machine, for example, itops-dev-204.lss.emc.com.


c. Answer the other questions and type yes when asked for confirmation.


If you are using an IP address naming convention for the configuration, run this
command and specify the IP address of the SAM host for <ip:y.y.y.y>.


$JAVA_HOME\bin\keytool -genkey -alias tomcat -keyalg RSA -ext 
SAN=<ip:y.y.y.y> -keystore C:\InCharge\SAM\smarts\.keystore


Results


This creates a keystore file inside C:\InCharge\SAM\smarts\keystore folder with
name .keystore.


Windows: Editing the SAM server.xml file
Edit the server.xml file to tell the SAM Tomcat server which secure port and protocol to
use.


Update the https connector configuration in server.xml in this path, c:\InCharge
\SAM\smarts\tomcat\conf.


Procedure


1. Uncomment the https connector configuration in server.xml.


2. Add the path to the keystore file and the password. For example,


 <Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
             maxThreads="150" scheme="https" secure="true"
              keystoreFile="C:\InCharge\SAM\smarts\keystore" 
keystorePass="changeit"
              clientAuth="false" sslProtocol="TLS" />


3. Configure the Connector protocols in server.xml as follows. (Copy in this code if it is
missing.)


 <Connector protocol="org.apache.coyote.http11.Http11Protocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile="C:\InCharge\SAM\smarts\keystore" 
keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


<Connector protocol="org.apache.coyote.http11.Http11NioProtocol"
          port="8443"
          maxThreads="150" scheme="https" secure="true"
          keystoreFile=”C:\InCharge\SAM\smarts\keystore" 
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keystorePass="changeit"
          clientAuth="false" sslProtocol="TLS" />


Windows: Creating the trust relationship between SAM and EMC M&R
You must export and import certificates to get the SAM Tomcat server and EMC M&R
Tomcat server to trust each other.


Before you begin


First, export a certificate on the SAM server. Then import it into the EMC M&R Tomcat
server. Then export a certificate from the EMC M&R server and import it into the SAM
Tomcat server.


Procedure


1. Export a certificate from the SAM Tomcat server. For example,


"c:\Program Files\Java\<JDK_version>\bin\keytool.exe" -export –
keystore C:\InCharge\SAM\smarts\keystore -alias tomcat -rfc >  C:
\InCharge\SAM\smarts\SAMtomcat.cert


a. Copy SAMtomcat.cert to the host where EMC M&R Tomcat server is installed.


b. Import the SAMtomcat.cert into the EMC M&R host. (Copy the files manually
using Windows Explorer and CTRL+C and CTRL+V commands.) For example,


c:\Program Files\APG>"C:\Program Files\Java\<JDK_version>\bin
\keytool.exe" –import -file "c:\Program Files\APG\ 
SAMtomcat.cert" -alias SAMtomcat -keystore "C:\Program Files\APG
\.keystore


c. Back up the original cacerts file before this next step.


c:\Program Files\APG>"C:\Program Files\Java\<JDK_version>\bin
\keytool.exe" –import -file "c:\Program Files\APG\ 
SAMtomcat.cert" -alias SAMtomcat -keystore "C:\Program Files\APG
\.keystore


Rename file C:\Program Files\APG\Java\Sun-JRE\8.0u51\lib
\security\cacerts to C:\Program Files\APG\Java\Sun-JRE
\8.0u51\lib\security\cacerts-SAVE    # Backup old cacerts file


d. Copy .keystore located at c:\Program Files\APG\.keystore to this
location, C:\Program Files\APG\Java\Sun-JRE\8.0u51\lib
\security, and rename it to cacerts


2. Restart Tomcat server on the EMC M&R host.


/opt/APG/bin/manage-modules.sh service restart tomcat


3. Export a certificate from the EMC M&R host. For example,


c:\Program Files\APG>"C:\Program Files\Java\<JDK_version>\bin
\keytool.exe" –export  -keystore "C:\Program Files\APG\.keystore" -
alias tomcat -rfc > "C:\Program Files\APG\W4Ntomcat.cert"
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a. Copy W4ntomcat.cert to the SAM server host.


b. On the SAM server host, run these commands to import a certificate copied from
the EMC M&R server host. (Copy the files manually using Windows Explorere and
CTRL+C and CTRL+V commands.)


"C:\Program Files\Java\<JDK_version>\bin\keytool.exe" -import –
file C:\InCharge\SAM\smarts\ W4Ntomcat.cert -alias W4Ntomcat –
keystore C:\InCharge\SAM\smarts\keystore


c. Back up the original cacerts file before this next step. Rename the cacerts file
located at C:\InCharge\SAM\smarts\jre\lib\security\cacerts to
C:\InCharge\SAM\smarts\jre\lib\security\cacerts-SAVE #
Backup old cacerts file


d. Copy the keystore file from C:\InCharge\SAM\smarts\keystore and
rename it to cacerts at this location C:\InCharge\SAM\smarts\jre\lib
\security\cacerts


4. Stop and start the Tomcat service on the SAM server:


a. c:\Program Files\InCharge\SAM\smarts\bin\sm_service stop
smarts-tomcat


b. c:\Program Files\InCharge\SAM\smarts\bin\sm_service start
smarts-tomcat


5. Restart the EMC M&R services.


c:\Program Files\APG\bin\manage-modules.sh service restart all
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Overview
Learn how to install and configure the SolutionPack for EMC Smarts. This SolutionPack,
available with the EMC M&R 6.7u1 platform and later 6.7uX platforms, notifies your
operators of real-time network events and displays the root-cause and impact of the
event. Historical event data is available as well.


The SolutionPack for EMC Smarts collects performance and availability metrics from your
Smarts domain managers and displays them in Dashboard reports.


When the SolutionPack for EMC Smarts is configured to work with Service Assurance
Manager, the network operator can view and manage notifications from the EMC M&R
Operations interface.


When the SolutionPack for EMC Smarts is configured to work with the IP Configuration
Manager, the administrator can maintain IP polling and threshold settings from the EMC
M&R Administration interface. The article, How to Maintain IP Manager Settings, provides
more information.


Technical specifications


SolutionPack version
2.2.1


Compatible EMC M&R version
6.7u1 and later


Data collection method
Smarts collector


Main reports
Reports display in Report Library > EMC Smarts.


Events


Lists events from networks monitored by EMC Smarts domain managers.


Domain Manager Health


Provides health-related metrics for networks monitored by EMC Smarts domain
managers.


ESM Performance


Provides performance metrics for the EMC Smarts Server Manager.


IP (AM-PM)


Provides availability and performance metrics for IP networks monitored by EMC
Smarts domain managers.


ACM Performance


Provides performance metrics for the EMC Smarts Application Connectivity Manager.


Additional reports display in these tabs:
l Dashboards > Network
l Explore > Network
l Operations > Network


By default, the SolutionPack for EMC Smarts uses the Smarts discovery associated with a
Presentation Service Assurance Manager (SAM). When you configure the SolutionPack to
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link to the Presentation SAM server and to its Broker, the SolutionPack connects to the
domain managers through the host:port/DM_name settings. Notifications from SAM
display in the Notification List in the EMC M&R User Interface. Device details from
underlying Smarts domain managers connected to that Broker display in other EMC M&R
reports.


Alternatively, you may connect the SolutionPack for EMC Smarts directly to the underlying
Smarts domain managers.


Here are examples of the statistics collected by the SolutionPack for EMC Smarts:


l IP Availability Manager (AM)/Performance Manager (PM) (statistics on network
devices and links)


l Server Performance Manager (SPM)/EMC Server Manager (ESM) (statistics on UNIX
and Windows servers, physical and virtual servers and applications)


l Application Connectivity Monitor (ACM) (statistics on transaction response time and
availability


l Service Assurance Manager (SAM) (historical view of SAM notifications)


l SAM (real-time view of SAM notifications)


Where to find the latest SolutionPack software
Install the latest core software update for your product suite. SolutionPacks distributed
with core software have a 30-day free evaluation period. If you plan to use the software
longer than 30 days, you must install a SolutionPack license before the trial period ends.


This 30-day free evaluation only applies to new installations and is not available for
upgraded installations. If you upgrade the core software and want to try a new
SolutionPack, you must request a license for that SolutionPack by completing a Support
Request (SR) form, which is available on the EMC Online Support website at http://
support.emc.com.


Installation steps


Installing the SolutionPack for EMC Smarts


Before you begin


l Determine whether you need a SolutionPack license file by checking the feature
names and expiration dates listed in Centralized Management > License
Management. If the license is not listed, obtain one by completing a Support Request
(SR) form, which you can find on the EMC support website http://support.emc.com.


l Ensure the core modules, such as the Module-Manager, are up-to-date on all servers
since not all module dependencies are validated during the SolutionPack
installation. See the Service Assurance Suite Installation and Configuration Guide for
EMC M&R for more information.


l If you are upgrading older software components to the latest release, review these
recommendations. When upgrading from EMC M&R pre-6.4u1 and Smarts domain
managers pre-9.3, follow this upgrade order:


1. Upgrade Smarts Service Assurance Manager (SAM) to 9.4.2 or higher and
configure SAM with Notification Cache Publishing enabled. This starts the services
for Smarts EDAA, Elastic Search and Rabbit MQ. Ensure you also upgrade SAM
Console and Smarts domains such as Adapter Platform (OI), MBIM, Trap Receiver/
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Exploder, and so forth to the latest build. The EMC Smarts Installation Guide for
SAM, IP, ESM, MPLS, VoIP, and NPM Managers provides more information.


2. Upgrade EMC M&R to 6.7u1 or higher and install the SolutionPack for EMC Smarts
2.2 or higher. The Service Assurance Suite Installation Guide for EMC M&R provides
information.


3. Upgrade Smarts IP domains to 9.4.2 or higher.


4. Upgrade the remaining Smarts analysis domains that are configured to
communicate with the SolutionPack for EMC Smarts.


5. If Network Configuration Manager (NCM) is part of the deployment, there is no
specific upgrade order for NCM. The NCM 9.4.2 software is backwards compatible
with the SolutionPack for NCM and other Smarts domains.


l When upgrading from EMC M&R 6.4u1 and Smarts domain managers 9.3 and higher,
follow this upgrade order. (This assumes you have already installed SAM with
Notification Cache Publishing enabled and that Smarts EDAA, Elastic Search and
Rabbit MQ services have already been configured.)


1. Upgrade the Presentation Service Assurance Manager to 9.4.2 first. Then upgrade
EMC M&R to 6.7u1. Both deployments need to be upgraded to their latest
versions in order for the latest set of features to work.


2. Upgrade Smarts IP domains to 9.4.2 or higher.


3. Upgrade the remaining Smarts analysis domains that are configured to
communicate with the SolutionPack for EMC Smarts.


4. If Network Configuration Manager (NCM) is part of the deployment, there is no
specific upgrade order for NCM. The NCM 9.4.2 software is backwards compatible
with the SolutionPack for NCM and other Smarts domains.


l Ensure you have installed and configured the Presentation Service Assurance
Manager (SAM) server with Notification Cache Publishing enabled.


l Ensure you have enabled security settings to allow interoperability with EMC M&R by
setting these flags in the runcmd_env.sh file:


Table 1 Security settings for the SAM runcmd_env.sh file


Flag Value


SM_ALLOW_LEGACY_CRYPTO= TRUE


SM_TLS_PROTOCOLS= +TLSv1.1


l Ensure these services associated with the Presentation SAM installation are running:


Table 2 SAM services when Notification Cache Publishing is enabled


Service name Description of feature


ic-broker Broker connected to Presentation SAM server


ic-sam-server-pres Presentation SAM with Notification Cache Publishing


smarts-tomcat Smarts EDAA and Notification Cache (hosted by Tomcat server)


smarts-rabbitmq Notification Exchange (Rabbit MQ)


smarts-elasticsearch Storage/Search engine used by the Notification Cache
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l Obtain the login credentials and the Fully Qualified Domain Names (FQDN) for the
servers where Smarts Broker, Smarts EDAA, and Presentation SAM servers are
running.


l Review the article, How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts,
for additional configuration procedures.


Follow these steps to install the SolutionPack for EMC Smarts.


Procedure


1. Log in to Administration > Centralized Management.


2. Select SOLUTIONPACK CENTER.


3. Select SolutionPack for EMC Smarts in the Browse and Install SolutionPacks window.


4. Read the summary information and click Install.


5. Accept the default instance name or type a new name.


One SolutionPack for EMC Smarts instance may be configured for each Presentation
SAM server.


6. Select which server each component will be installed on.


The recommended servers are:


l Data Collection--Collector


l Database--Primary Backend


l Events--Primary Backend


l Reports--Front End


7. Click Next and complete the field entries for the Data collection, Database, Events,
and Reports screens.


Click the question mark icon to access field-level help. (Actual screens and version
numbers will vary from the examples shown in this article.)


l Data collection setup when installing SolutionPack for EMC Smarts on page 6


l Event datastore when installing SolutionPack for EMC Smarts on page 6


l Report setup when installing SolutionPack for EMC Smarts on page 7


8. Click Install after you complete the last screen.


The installation process begins.


9. Select the maximize arrow next to each component to view the installation process.


When the installation successfully completes, green checkmarks appear.


10. After installation is complete, select Centralized Management > SolutionPack to verify
the installed SolutionPack.


11. Restart the Presentation SAM services.


This step is important because the SAM server may have an existing entry in the
runcmd_env.sh file that points to a previous CAS configuration. Restarting the
Presentation SAM services forces the CAS webapp to run with the latest configuration.


After you finish


Perform these post-installation tasks:
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l For Windows environments only, configure the Domain Manager Health collection
package. (No additional configuration is required for EMC Smarts domain managers
running on Linux platforms.)


l If you chose MySQL as the Database Type in the Events list box, follow these steps: 
Enabling event reporting for MySQL database in Smarts SolutionPack on page 9.


l If you chose Datastore as the Database Type in the Events list box, follow these
steps, Enabling event reporting for Datastore database in Smarts SolutionPack on
page 9, and create the Datastore database schema.


l Set up non-administrator roles and assign users to these roles.


l Set the default navigation style to Use tree navigation. This setting is recommended
for the SolutionPacks for the 9.4.2 release.


l If using the IP Configuration Manager, set the polling and thresholds values. The
article, How to Manage IP Settings, provides more information.


Data collection setup when installing SolutionPack for EMC Smarts


Accept the default settings or configure custom data collection settings.


l In the Collection list box, you can accept the default Smarts Discovery option to
connect the SolutionPack to the Smarts Broker, Service Assurance Manager, and the
underlying Smarts domains. You can filter domains for data collection by selecting,
Do you want to configure advanced settings.


l If you choose Smarts collector instead of Smarts Discovery, you can
collect topology data from individual Smarts domain managers by configuring their
credentials.


Figure 1  Data Collection example


Event datastore when installing SolutionPack for EMC Smarts
You can choose the database that will hold active and inactive (archived) event data
coming from the underlying Smarts domain managers. The MySQL database can hold
both active and inactive (archived) event data. If you choose Datastore as the
Database Type, MySQL will still hold active event data, but Datastore will hold the
inactive (archived) event data.


New installations of the SolutionPack for Smarts should choose the Datastore option
as the Database Type. Do not enable the option, Do you want to configure advanced
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settings, because this is used when migrating archived event data and that is not
applicable to new installations.


Note


Deployments that used MySQL as the Events database in earlier versions of Watch4net


may want to use the default MySQL entry when updating SolutionPackBlocks. After


migration or update processes have successfully completed, you can change the entry to
use Datastore as the database for inactive (archived) events.
If you are updating the SolutionPackBlocks and you choose Datastore as the Database
Type, do not enable the option, Do you want to configure advanced settings. First, ensure
you have successfully installed the SolutionPack for EMC Smarts and performed the post-
installation steps. Then return to the Events setup screen to migrate the event data using
the Do you want to configure advanced settings option.


The event data migration procedures are in the article, How to migrate archived events after
updating the EMC Smarts SolutionPack.


Figure 2  Events setup example


Report setup when installing SolutionPack for EMC Smarts


In the Report list box, you must specify
l EMC M&R Tomcat Hostname—Enter in the Fully Qualified Domain Name (FQDN) of


your EMC M&R Frontend server. For example, if your EMC M&R Frontend server is at
http://www.example.com:58080/APG, type, www.example.com here.
n Ensure you added the parameter, SM_CAS_SERVER, to the runcmd_env.sh file


in the Presentation SAM server. The hostname portion of the URL entry for
SM_CAS_SERVER has to match the hostname in the EMC M&R Tomcat Hostname
field. Use only the Fully Qualified Domain Name (FQDN). Do not use the IP
address.


l Smarts EDAA hostname or IP address—Enter the Fully Qualified Domain Name (FQDN)
of your EMC Smarts EDAA Hostname. For example, if your EMC Smarts EDAA
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Hostname is at http://www.example.com:8080/, type www.example.com
here.


l Presentation SAM configuration—Type the name of the Presentation SAM Server that
was started with the Notification Cache Publishing option. (This is the domain name,
such as INCHARGE-SA-PRES. Do not enter the service name, such as ic-sam-
server-pres.)


l Use Smarts Configuration Manager—Select this checkbox if you plan to use EMC
M&R and the SolutionPack for EMC Smarts to manage IP Settings such as polling and
thresholds. Specify the name of the Configuration Manager in the Configuration
Manager field if it does not use the default name. If you are enabling this feature after
you have already installed the SolutionPack for EMC Smarts, click Reconfigure to
apply the new settings.


If you enabled the security configuration checkbox (HTTPS enabled for
Watch4net and Smarts), you must adjust the port settings to reflect your security
configuration.


Figure 3  Report setup example


Post-installation steps


Database types for storing event data
Complete the post-installation configuration steps for the type of database (MySQL or
Datastore) that holds the archived event data.


Depending upon which Database Type you choose, you must enable event reporting in
order for your reports to point to the correct database. If you switch from one database to
another after you install the SolutionPack, you must adjust the configuration so the
reports will continue to display archived event data properly.


l If you choose MySQL as the Database type, follow instructions in this topic: Enabling
event reporting for MySQL database in Smarts SolutionPack on page 9
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l If you choose Datastore as the Database type, follow instructions in these topics: 
Enabling event reporting for Datastore database in Smarts SolutionPack on page
9and Configure the Datastore database schema on page 10


Enabling event reporting for MySQL database in Smarts SolutionPack
If you chose the MySQL database to store archived events in, you must enable event
reporting.


Run these commands once after a new installation. Do not run these commands after an
upgrade or reconfiguration.


Procedure


1. For Linux, execute these commands from the APG/bin directory:


#./manage-resources.sh update dba/FLOW-RPE2-ARCH 
'{"disabled":false}'
#./manage-resources.sh update dba/FLOW-RPE2-LIVE 
'{"disabled":false}'


2. For Windows, execute these commands from the APG\bin folder:


manage-resources.cmd update dba/FLOW-RPE2-ARCH
{"disabled":false}
manage-resources.cmd update dba/FLOW-RPE2-LIVE
{"disabled":false}


3. Restart the Tomcat service in order to make the changes effective


Enabling event reporting for Datastore database in Smarts SolutionPack
If you chose the Datastore database to store archived events in, you must enable event
reporting.


Run these commands once after a new installation. Do not run these commands after an
upgrade or reconfiguration.


Procedure


1. For Linux, execute these commands from the APG/bin directory:


#./bin/manage-resources.sh update dba/FLOW-RPE2-ARCH 
'{"disabled":false,"datasource":
{"driverClassName":"com.watch4net.x100.jdbc.Driver","validationQuer
yTimeout":null,"username":"admin","password":"
{65901E8A34371DBC8627A4FC9B5DCD30FB83529BB380BB6670FB3D0F1E33B9CD11
4922FC7713361287955791DD0C6EBA}","url":"jdbc:x100://localhost:
48443/Databases/APG-Datastore/Default"}}'
./bin/manage-resources.sh update dba/FLOW-RPE2-LIVE 
'{"disabled":false}'


2. For Windows, execute these commands from the APG\bin folder:


manage-resources.cmd update dba/FLOW-RPE2-ARCH 
{"disabled":false,"datasource":
{"driverClassName":'com.watch4net.x100.jdbc.Driver',"validationQuer
yTimeout":null,"username":'admin',"password":'
{65901E8A34371DBC8627A4FC9B5DCD30FB83529BB380BB6670FB3D0F1E33B9CD11
4922FC7713361287955791DD0C6EBA}
',"url":'jdbc:x100://localhost:48443/Databases/APG-Datastore/
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Default'}}
manage-resources.cmd update dba/FLOW-RPE2-LIVE
{"disabled":false}


3. Restart the Tomcat service in order to make the changes effective


Configure the Datastore database schema
You must configure the Datastore database schema before you can load event data.


Before you begin


If you selected Datastore as the Database Type when installing the EMC Smarts
SolutionPack, you must load a database schema to enable the Event Processing
Manager.


Inactive (archived) events are written to the Datastore database. Active events are written
to the MySQL database.


Procedure


1. Log in to the host running EMC M&R.


2. Connect to the Datastore with this command, /<INSTALL_DIR>/APG/bin/
datastore-client


3. From the prompt, copy and paste in the contents of /<INSTALL_DIR>/APG/
Event-Processing/APG-Datastore-Writer/emc-smarts/ddl/ds-
event-x100.sql
This creates the schema.


4. Start the Event Processing Manager service.


a. If starting from Centralized Management, navigate to Physical Overview and select
the Backend server hosting the Datastore database. Select Event-Processor-
Manager::emc-smarts and click Start to start the service.


Replace the instance name with one from your deployment if different from emc-
smarts.


b. If using CLI commands, navigate to the installation bin folder (for
example, /opt/APG/bin) and issue ./manage-modules.sh service
start event-processing-manager emc-smarts (for Linux) or manage-
modules.cmd service start event-processing-manager emc-
smarts (for Windows).


Replace the instance name with one from your deployment if different from emc-
smarts.


5. Verify the schema loaded properly by issuing this command from the datastore-client
command prompt: sql> select count(* ) from events_archive;
In the resulting output, you will see something similar to 1 row. For example, query:
0.01 sec; total: 0.01 sec


Configure icStats helper for EMC Smarts health collection
Additional configuration is required to enable Smarts Health data collection for EMC
Smarts domains running on Windows. Metrics for the processor, memory, and other
domain information cannot be collected until icStats helper is set up.


EMC Smarts health collection is now part of the emc-smarts-collect package, installed as
part of the SolutionPack for EMC Smarts.
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Configure the icStats helper for EMC Smarts domains running on Windows platforms. (No
additional configuration is required for EMC Smarts domains running on Linux platforms.)


Procedure


1. Obtain plist.exe from http://technet.microsoft.com/en-us/sysinternals/
bb896682.aspx


2. Install plist.exe in the PATH statement for each Windows host.


Set role restrictions for non-administrator users of SolutionPack for Smarts
If you want additional user roles, such as oper (operator), or profiles configured in your
Presentation SAM server, you must set role restrictions after installing the SolutionPack
for Smarts.


The default role is assigned to administrator. Add additional roles as needed.


Procedure


1. From Administration > Roles, click New Role.


2. Click Modules & Restrictions Access and expand the Smarts module.


3. Add an existing smarts profile (such as oper-profile or default-profile) and
click Save.


4. From Administration > Users, create a new user and assign a role to the new user.


You can assign one or more roles to a new user.


Note


Notification actions (like Acknowledge/Unacknowledge, Take/Release Ownership,
and so on) in the Notifications view are available for a user who is assigned multiple
roles that have the same sam-profiles. Notification actions are not available for a user
who is assigned multiple roles that have different sam-profiles.


Confirming report creation
After you install a SolutionPack, you can view its reports.


To view the reports:


Procedure


1. Go to User Interface > Report Library.


2. Click the SolutionPack to view its reports.


Results


It may take up to an hour to display all relevant information in these reports.


Set default navigation style
The navigation style controls the look and feel of the left navigation column in the
reporting interface.


An administrator sets the global default navigation style. Users can override the global


default style for a user account on Settings  > User Preferences.
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Procedure


1. Navigate to Administration  > Portal.


2. Click the Default Display tab.


3. In Navigation Style, make a selection.


Option Description


Use icon navigation The navigation column contains icons that expand into
reporting categories


Use tree navigation The navigation column is a hierarchical tree of report names


4. Click Save.


Hide unused entries in the navigation tree
You can hide default entries in the navigation tree if you have not installed the products
that populate them with data.


Before you begin


The default EMC M&R platform displays nodes such as Operations, Explore, Dashboards,
and Planning in the navigation tree. Other product suites that also use EMC M&R as their
platform display entries under these nodes by default. However, no data populates these
entries unless you are using those products. The SolutionPack for EMC Smarts populates
data in the Network block under Operations, Explore, and Dashboards.


Procedure


1. To hide entries in the navigation tree, click Edit Mode from the EMC M&R User
Interface.


2. Find the storage-related blocks in the list and select, Always Hide.


Do not hide the Network block under the Operations, Explore, or Dashboards nodes.
The Network block contains all of the SolutionPack for EMC Smarts views and reports.
The Planning node is not used by the SolutionPack for EMC Smarts.


Troubleshooting


Report display problems


l What to do if data does not appear in any reports on page 12


l What to do if data does not appear in some reports on page 13


l Viewing collector errors in the Collector-Manager log files on page 14


What to do if data does not appear in any reports


Procedure


1. After the completion of at least three collection cycles, verify if data is populating into
the reports. If there is still no data in the reports, continue to the next step.


2. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to the next step.
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3. To view the log files for errors, go to Centralized Management and click Logical
Overview > Collecting > Collector-Manager::<instance name> > Log Files.


Running a scheduled task to import data into reports
After you push a new configuration into a collector, a scheduled task runs and populates
the reports with new data. You can manually run the scheduled task to import the data
more quickly.


Before you begin


Allow at least three polling cycles to pass before manually running the scheduled task.


Procedure


1. Click Administration.


2. Click Centralized Management.


3. Expand Scheduled Tasks.


4. Click Database.


5. Select the import-properties-Default task.


6. Click Run Now.


7. Confirm success in running the task in the Last Result and Last Result Time columns.


What to do if data does not appear in some reports


Procedure


1. Run the scheduled task to import data into reports. If there is still no data in the
reports, continue to step 2.


2. Search for the metric in the database.


3. To view the log files for errors, go to Centralized Management and click Logical
Overview > Collecting > Collector-Manager::<instance name> > Log Files.


4. To view the log files for errors, go to Centralized Management and click Events > Event-
Processing_Manager::Instance name > Logs.


To debug the errors, enable the Event-Spy for the Event Processing Manager.


Searching for metrics in the database
You can verify that a metric is being collected and used for reporting when you search
and find the metric in the database.


Procedure


1. Click Administration .


2. Under Modules, click Management of Database Metrics.


3. On the Metric Selection page, create the filter, type the number of results, and select
the properties to display for the metric.


For example, to list up to 100 results of the Capacity metric with the properties of
device and IP, type name=='Capacity' in the Filter field, 100 in the Maximum results
field, and select device and IP for the Properties to show.


4. Click Query.


A list of the metric results appears. If nothing displays, the metric is not being
collected.
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Generating and downloading diagnostic files
Diagnostic files are a collection of system configuration files and log files that can help in
researching problems.


Procedure


1. Go to Administration > Centralized Management > Logs and Diagnostics > Diagnostic
Files.


2. Click Generate diagnostic files.


This action generates a zip file of XML, CSV, properties, script, and java files that
define your current configuration and implementations. Some log files are also
included.


When generation is completed, a Download button appears.


3. Click Download to access the .zip file.


Viewing collector errors in the Collector-Manager log files
Review the Collector-Manager log files to troubleshoot problems with data collection.


Procedure


1. Click Administration.


2. Click Centralized Management > Logical Overview.


3. Expand Collecting.


4. Click the Collector-Manager for your collector instance.


Collector-Manager::<Collector-Manager instance> - <host_ID>


5. Expand Log Files and click the View File icon to review the error messages.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC representative if a product does not function properly or does not 
function as described in this document.


This document was accurate at publication time. New versions of this document might be 
released on the EMC online support website. Check the EMC online support website to 
ensure that you are using the latest version of this document.


Purpose
The Service Assurance Manager (Service Assurance) solution automatically correlates 
topology and event data from multiple EMC Smarts managed domains to diagnose 
root-cause problems and (with Business Impact Manager) the impact that those problems 
have on business-critical processes and services. EMC Smarts managed domains can 
include IP networks, systems, routing protocols, ATM/Frame Relay, applications, and 
business entities. Service Assurance Manager enables operations personnel to effectively 
prioritize their time and resources to maintain and sustain the business-critical processes 
and services.


EMC Smarts Service Assurance Manager Introduction provides high-level architectural and 
functional overviews of the EMC Smarts Service Assurance Manager solution. It also 
provides several examples of implementation scenarios.


Audience
This document is intended for operations staff, managers, and administrators who are 
interested in automated Service Assurance solutions.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• XML Adapter


• EMC Smarts Adapter for UIM/O
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory.


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


These documents are updated periodically. Electronic versions of the updated manuals 
are available on the EMC online support website:
https://support.emc.com


EMC Smarts Service Assurance Manager documentation
The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide
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◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.
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Conventions used in this document
EMC uses the following conventions for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Pathname conventions


Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions


If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and menus
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords, 


clauses, environment variables, functions, and utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file 


systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs, processes, 
services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, buttons, fields, and menus
• What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables


Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


Courier bold Used for specific user input, such as commands


Courier italic Used in procedures for:
• Variables on the command line
• User input variables 


< > Angle brackets enclose parameter or variable values supplied by the user 


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Manager


Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information. For documentation, release notes, software updates, or information 
about EMC products, licensing, and service, go to the EMC online support website 
(registration required) at:


https://support.emc.com


Technical support — FFor technical support, click Create Service Requests or Contact 
Customer Service on EMC Online Support at https://support.emc.com. To open a service 
request through EMC Online Support, you must have a valid support agreement. Contact 
your EMC Sales Representative for details about obtaining a valid support agreement or to 
answer any questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@EMC.com
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CHAPTER 1
Architectural Overview


This chapter provides an architectural overview of EMC Smarts Service Assurance Manager 
(Service Assurance), the Service Assurance Manager adapters, and the Service Assurance 
modules (EMC Smarts Business Impact Manager, Global Console, and Business 
Dashboard) that can be implemented to extend the capabilities of Service Assurance.


EMC Smarts Service Assurance Manager is a solution for managing the technology 
infrastructure that supports business services. As the cornerstone of network operations 
management, it provides integrated, unified, and individualized views of the systems, 
network infrastructure, applications, and business entities that comprise the managed 
domain.


Service Assurance Manager imports topology and event information from the underlying 
managed domains (distributed management applications), consolidates the information, 
and interprets problems in the context of their impact on business services. Service 
Assurance provides operations personnel with meaningful information with which 
automated corrective actions can be associated.


The Service Assurance modules provide the capabilities to calculate the business impact 
of infrastructure problems, to produce a wide variety of operational and management 
reports, and to display customer-specific information to a given enterprise or service 
provider customer through a secure channel.


This chapter contains the following information:


◆ Service Assurance Manager architecture .................................................................  14
◆ Service Assurance modules.....................................................................................  17
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Architectural Overview

Service Assurance Manager architecture
Figure 1 on page 14 illustrates the EMC® Smarts® Service Assurance Manager 
architecture. 


Figure 1  EMC Smarts Service Assurance Manager architecture


EMC Smarts Service Assurance Manager abstracts topology information and 
cross-correlates and consolidates event information from distributed EMC Smarts 
applications and third-party applications. 


EMC Smarts applications are responsible for discovering and monitoring infrastructure 
elements, and correlating event information within their respective managed domains.


Service Assurance Manager, other EMC Smarts applications, or third-party applications 
communicate by way of a shared Information Bus that employs the EMC Smarts Common 
Information Model™ (ICIM). After Service Assurance abstracts high-level views of the 
distributed topologies from the underlying applications, it correlates, consolidates, and 
integrates event information collected from the applications, and enriches the event 
information with the severity of the events.


Event information (for example, root-cause problems and their impacts and severities) are 
displayed in the Notification Log Console, Topology Browser Console, Map Console, or 
Summary View Console. From these consoles, operations personnel can invoke diagnostic 
or corrective tools, store the information for management and operations reports, and 
send the information to third-party applications.

14 EMC Smarts Service Assurance Manager Introduction







Architectural Overview

Service Assurance Manager


The Service Assurance Manager, also referred to as the Global Manager, is the Service 
Assurance component that serves as the central point for monitoring and managing your 
entire technology infrastructure by obtaining data from multiple distributed domains. The 
Global Manager communicates with the underlying distributed EMC Smarts applications 
and abstracts and consolidates:


◆ Network, system, application, and business resources


◆ Results of domain-specific root-cause analysis


◆ Results of domain-specific impact analysis


The Global Manager scales to large topologies because it maintains a high-level, abstract 
representation of the topology. The detailed topology information — and therefore the 
bulk of the data — is kept in other EMC Smarts applications. When needed, the Global 
Manager retrieves detailed information from the underlying domains.


The Global Manager can attach to multiple, distributed EMC Smarts applications as well 
as other Global Managers. It can also be integrated with third-party applications from 
which it can receive topology and event information, and to which it can send event 
information or initiate corrective actions.


The Global Manager, in conjunction with Report Manager, sorts and stores event-related 
information in an ODBC-compliant database from which users can produce a variety of 
management, operations, and business impact reports.


Global Console


EMC Smarts Service Assurance Manager includes a user interface that provides different 
views into EMC Smarts-managed domains.


The Global Console displays topology and notifications as well as summary, containment, 
and status information. EMC Smarts operators use the Global Console to monitor 
EMC Smarts domains, acquire detailed information (on demand) about topology and 
events, respond to problems, and take corrective action. EMC Smarts administrators with 
appropriate privileges and access control can use the Global Console to discover topology, 
and administer underlying domains, as well as administer EMC Smarts users, user 
profiles, program tools, and escalation policies.


The Global Console runs as a standalone Java program.


Companion User Interface


EMC Smarts Service Assurance Manager Companion User Interface (SAM Companion UI) 
supplements existing functionality in SAM, EMC Smarts Network Configuration Manager 
(NCM) and Watch4net Automated Performance Grapher (APG).


The SAM Companion UI is a VMware®-based appliance, that is, a virtual machine. The 
EMC Smarts SolutionPack Installation and Configuration Guide provides detailed 
information about installing and configuring the SAM Companion UI.
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Integration with third-party applications


Because EMC Smarts Service Assurance Manager is an open solution, it is possible to 
integrate Service Assurance with third-party applications and other EMC Smarts 
applications by way of Service Assurance Manager (SAM) adapters, as shown in Figure 2 
on page 16.


The EMC Smarts Service Assurance Manager Adapter Platform, which normalizes data in 
accordance with the ICIM, enables the import or export of topology and event information. 
The topology information is stored in the repository of the Global Manager. As event data 
is forwarded to Service Assurance through the adapters, the system correlates the 
third-party event data with the corresponding elements in the Global Manager’s 
repository.


SAM adapters also enable EMC Smarts Service Assurance Manager to forward event 
information to third-party applications, such as trouble ticketing systems.


Figure 2  Integration with third-party applications


EMC Smarts Adapter for UIM/O


The EMC Smarts Adapter for Unified Infrastructure Manager/Operations (referred to as the 
EMC Smarts Adapter for UIM/O) provides integration between the EMC Smarts Adapter for 
Unified Infrastructure Manager/Operations (here in referred to as UIM/O) and the Service 
Assurance Manager. The adapter retrieves alerts from UIM/O, creates notifications from 
the alerts, and sends the notifications to the Global Manager.


The EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide provides deployment information, configuration instructions, and client tool 
examples.
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Service Assurance Failover System


To maintain critical availability, EMC Smarts Service Assurance Manager can be 
implemented with a failover system. The EMC Smarts Service Assurance Manager Failover 
System ensures that the managed environment continues to be monitored when the 
primary Global Manager becomes unavailable because of a hardware failure or system 
malfunction. Redundancy is provided by a secondary Global Manager that serves as a 
backup to the primary Global Manager. The Failover System, which is configured to match 
the primary system, monitors the primary Global Manager. The Failover System 
periodically copies the repository file to the secondary Global Manager, thus preserving 
important topology and configuration information.


If a failure occurs, the secondary Global Manager automatically starts. The secondary 
Global Manager registers with the EMC Smarts Broker using the name of the primary 
Global Manager. Clients of the primary Global Manager (such as the Global Console and 
adapters) that become disconnected can reconnect to the secondary Global Manager.


When the primary Global Manager is again available to monitor the managed 
environment, a reset script copies the backup repository to the primary Global Manager, 
shuts down the secondary Global Manager, and restarts the primary Global Manager.


Service Assurance modules
Several modules can be implemented with EMC Smarts Service Assurance Manager to 
extend Service Assurance’s capabilities. These include:


◆ EMC Smarts Business Impact Manager


◆ EMC Smarts Web Console


◆ EMC Smarts Business Dashboard


EMC Smarts Business Impact Manager


EMC Smarts Business Impact Manager (Business Impact Manager) extends the 
capabilities of Service Assurance to analyze events by calculating the business impact of 
events and propagating the impacts to affected business entities as discrete notifications 
that are linked to topology within the managed domain. The impacts are displayed in the 
Business Services Maps.


To accomplish its functions, Business Impact Manager includes facilities to import 
business entities, which consist of subscribers and service offerings. Subscriber 
information may include customers as well as organizations, business units, lines of 
business, and department entities. Service offerings include business processes. For 
example, a subscriber can be a customer that subscribes to an IT service offering that 
provides Internet access.


The imported business information can be also assigned to user-specified groups. 


Additionally, Business Impact Manager provides facilities to assign weights to business 
entities and other elements in your topology. The weights capability allows you to 
prioritize critical topology and to use the prioritized information when calculating the 
business impact of events.
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EMC Smarts Web Console


The contents of the Global Console can also be displayed as a Java applet within a web 
browser. The Web Console capability allows you to connect to a Domain Manager from any 
system with a web browser and does not require a Global Console installation on the 
system.


EMC Smarts Business Dashboard


The EMC Smarts Business Dashboard (Business Dashboard) is a flexible, 
business-oriented alternative to the Web Console. The Business Dashboard displays a 
collection of EMC Smarts analysis data alongside important data from other sources. 
Components of the collection of EMC Smarts data are referred to as EMC Smarts 
ViewletsTM. The collection of viewlets can be loaded into your organization’s web page and 
can commingle with important trouble-ticketing information or your company’s intranet 
news. EMC Smarts viewlets can also be embedded within a third-party Web Portal 
product. 


Figure 3 on page 18 illustrates the architecture of a Web Console and an EMC Smarts 
Business Dashboard when loaded by a remote user. 


Figure 3  Web Console and EMC Smarts Business Dashboard architecture
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CHAPTER 2
Functional Overview


This chapter provides a functional overview of EMC Smarts Service Assurance Manager 
and the Service Assurance modules (EMC Smarts Business Impact Manager, Report 
Manager, Web Console, and Business Dashboard) that can be implemented to extend the 
functionality of Service Assurance Manager. This chapter contains the following 
information:


◆ Service Assurance Manager features and functions .................................................  20
◆ Automatic topology and event consolidation...........................................................  20
◆ Automatic topology abstraction ..............................................................................  21
◆ Global Console........................................................................................................  21
◆ Service Assurance functions....................................................................................  25
◆ Service Assurance module functions .......................................................................  29
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Service Assurance Manager features and functions
Service Assurance Manager provides the automated functions and features that are 
required by today’s enterprise and service provider network operations centers. Its 
automation, intelligent analyses, and adaptability can significantly reduce both the 
resources needed for pinpointing and resolving infrastructure problems, and the costs of 
monitoring and managing distributed networks.


Automatic topology and event consolidation
One of the primary tasks of EMC Smarts Service Assurance Manager is topology and event 
consolidation. Service Assurance Manager imports infrastructure elements (such as hosts 
and routers) and applications from each underlying managed domain. As it imports the 
elements, it consolidates elements that are reported by different sources. Service 
Assurance Manager also imports the relationships between the elements from the 
underlying managed domains. Using these relationships and overlapping devices, Service 
Assurance Manager accurately pieces together a complete topology of the managed 
environment.


When Service Assurance Manager imports events from the underlying managed domain, 
they are automatically associated with the elements to which they apply. Notifications 
received from multiple sources are consolidated into single events. Similarly, impacts 
reported by different sources for the same problem are deduplicated and associated with 
the consolidated event in Service Assurance Manager.


Further, to provide business context, EMC Smarts Service Assurance Manager provides a 
facility that imports customer and service information from provisioning systems and 
other sources. Using this data, Service Assurance Manager can automatically calculate the 
customer and service impact for the consolidated events.
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Automatic topology abstraction
In order to scale to large numbers of underlying systems, EMC Smarts Service Assurance 
Manager performs topology abstraction. Figure 4 on page 21 illustrates the difference 
between a detailed representation and an abstracted representation of network 
connectivity.


Figure 4  Difference between detailed and abstracted representation


Abstraction produces a coarse level of topology detail. A system, for example, is viewed as 
a single entity rather than as a collection of its components, and connectivity is between 
systems as opposed to between components in the system.


Although Service Assurance maintains a coarse level of topology detail, it stores sufficient 
information for its varied Notification Log, Topology Browser, and Map views. When 
needed, detailed information can be automatically retrieved from the underlying 
applications by Service Assurance.


Global Console
The Global Console provides a focal point through which operations personnel can 
monitor and manage distributed systems and EMC Smarts administrators can configure 
and administer Domain Managers. EMC Smarts administrators control the views, program 
tools, and access to console operations for EMC Smarts users. The following describes the 
full functionality of each console. Certain functions require a license and thus may not be 
included in your EMC Smarts deployment. Also, an EMC Smarts user’s access to some 
console operations may be restricted based on the user’s connection privileges and user 
profile.


For any given event, operations personnel with appropriate access control can take 
ownership of the event, acknowledge the event, add comments to the audit log of the 
event, or invoke tools for corrective actions.


The Global Console provides the following console views:


◆ Notification Log Console


◆ Topology Browser Console
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◆ Map Console


◆ Summary View Console


◆ Status Table Console


◆ Domain Manager Administration Console


◆ Global Manager Administration Console


Notification Log Console


The Notification Log Console provides a view of a set of notifications, which is defined by 
the user profile associated with the user. The notification information can include, for 
example, the type of event, the element that is affected, and the severity of the event. 
Operations personnel can potentially open multiple Notification Log Consoles, each 
customized to display different events, or show multiple lists in a single console, as 
needed.


Operations personnel can also potentially access the details of the event through the use 
of the Notification Properties dialog box. The Notification Properties dialog box provides 
detailed information about a selected notification. The properties include, for example, 
attributes and values related to this event, elements that are impacted by this event, an 
audit log of changes in this event’s history, or (if this event is a root-cause problem) other 
events used in the analysis. 


The viewable attributes of the displayed events in the Notification Log view (for example, 
event severity, active event, or first notify) can be customized to meet the needs or 
preferences of operations personnel. The order in which the attributes are displayed can 
also be modified. Operations personnel can sort on any number of attributes (whether the 
attribute column is visible or not) by specifying up to five sorting columns.


The notifications listed in the Notification Log view are color-coded in accordance with the 
severity of the events. An icon is also used as another indicator of an event’s severity.


Topology Browser Console


The Topology Browser Console enables operations personnel to display the managed 
topology in a tree format and traverse the topology. The console displays Domain 
Managers as well as Global Managers. For the selected managed domain, the console 
displays the classes of elements, instances of each class, and their relationships. 
Specified elements, indicated by a plus sign on Windows systems, can be expanded into 
instances, properties, or relationships.


When an element in the topology tree is selected, the console displays a corresponding 
property sheet with tabs for Attributes, Events, and Groups. The tabs, where applicable, 
include the following information:


◆ Attributes — Provides general information about the selected element


◆ Events — For a selected Global Manager, displays the active events that Service 
Assurance may notify for the element


◆ Groups — Provides the current group membership of the element
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In addition, the Topology Browser Console provides the Browse Detail menu option. When 
an element in the topology tree is selected, Browse Detail displays a list of all underlying 
managed domains that contain that element in their topology. Users can select an 
underlying managed domain and display it in another Topology Browser view. For 
hierarchical Service Assurance deployments, users can select Browse Detail as many 
times as necessary to navigate to the desired domain. Note that Browse Detail is also 
available for selected notifications in the Notification Log Console and for selected map 
icons and edges in the Map Console.


Map Console


The Map Console displays, by way of icons and edges, the managed elements in a given 
environment and the relationships between them. Different types of maps are made 
available based upon the elements in your managed topology. For example, with EMC 
Smarts IP Availability Manager, the console displays infrastructure elements in network 
and connectivity maps. With the addition of Business Impact Manager, the console can 
also display business services maps that show how the infrastructure elements are 
associated with business services, as well as the customers that subscribe to those 
services.


Operations personnel can select elements in the maps and then display detailed 
information about the elements, such as the ports or interfaces contained in a system.


If the status of a given element displayed in the Map Console indicates a problem, 
operations personnel can view the audit logs of events by way of the Notification 
Properties dialog box. They can also select and use tools such as on-demand pings and 
Telnet sessions.


The maps can be customized to meet your needs or preferences. For example, custom 
backgrounds and element icons can be incorporated into the maps. 


Summary View Console


The Summary View Console provides overviews or summaries of notifications. The console 
can contain several summaries that are attached to either the same managed domain or 
to different domains. 


Summaries offer concise, graphical representations of sets of notifications associated 
with groups of elements. The summary can be depicted as a three-dimensional graph or 
pie chart. The summary counts indicate the percentages of elements in the group with 
active events.


The summaries organized by severity are color-coded in accordance with the severity of 
the events. Otherwise, for other criteria, the colors do not indicate event status.


Status Table Console


A Business Impact Manager user can view a Status Table to quickly determine the overall 
status of customers and the services being delivered to those customers. In such a Status 
Table, customers would be represented as the primary set of instances, and the services 
being delivered to them would be represented as the secondary set of instances.
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To describe it in more general terms, a Status Table Console offers another way to present 
a concise status of a set of instances. The information appears as a matrix, with a primary 
set of instances along the y-axis and a secondary (related) set of instances along the 
x-axis. The status of the related instances appears, when relevant, at the intersection 
points in the matrix to reflect the overall status for each primary instance.


The Status Table functionality is very useful for the Business Impact Manager user. The 
Status Table requires a Web Console or EMC Smarts Business Dashboard license.


Domain Manager Administration Console


The Domain Manager Administration Console enables EMC Smarts administrators to 
configure and administer the underlying Domain Managers, and to perform tasks such as:


◆ Discover topology


◆ Manage and unmanage elements in the managed topology


◆ Access the Polling and Thresholds Console to fine-tune parameters of the polling and 
thresholds settings in the underlying domain


The EMC Smarts Storage Insight for Availability Discovery Guide provides information 
about the Domain Manager Administration Console. Information about polling and 
thresholds for specific EMC Smarts applications is provided in their respective user 
guides.


Global Manager Administration Console


The Global Manager Administration Console enables EMC Smarts administrators to 
configure Global Managers, including Security Infrastructure Managers (SIMs), and the 
SAM Adapter Platform. 


For a selected Global Manager, EMC Smarts administrators create and maintain 
configuration entities such as notification lists, tools, users, user profiles, access control 
to console operations, and escalation policies.


The EMC Smarts Service Assurance Manager Configuration Guide contains information 
about the Global Manager Administration Console.
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Service Assurance functions
The following section describes many of the functions that are integral to the EMC Smarts 
Service Assurance Manager.


Notification severity


The EMC Smarts Service Assurance Manager classifies notifications according to their 
calculated severity.


The notifications listed in the Notification Log Console and the Map Console are 
color-coded in accordance with the severity of the events. Icons are also used in the 
notification log and the maps to identify severity.


The color codes are explained in Table 1 on page 25.


Notification List


A Notification List determines the events that are forwarded to a given client. Essentially, 
the list filters the notifications that are sent from the Global Manager to a client. 
Additionally, the list, which is configured by the EMC Smarts administrator, can be 
assigned to one or more user profiles. The personnel assigned to a specified list only see 
the set of events defined by the list.


The lists could be used to organize, for example:


◆ Business units


◆ Geographical regions


◆ Groups of resources


During day-to-day operations, operations personnel use the Global Console to monitor 
and manage their areas of responsibility. In doing so, personnel see only the subset of 
notifications defined for them in the Notification List.


EMC Smarts adapters can also connect to a Notification List, and receive the notifications 
that match the conditions specified in the list.


Table 1  Notification severity levels


Level Icon Color Description


1 Red Critical — Identifies a specific failure that requires 
resolution.


2 Orange Major — Identifies a serious condition that requires 
immediate attention.


3 Yellow Minor — Identifies an abnormal condition that is not 
serious but requires some action.


4 Blue Unknown — Identifies an unknown, unreachable, 
disconnected, or suspended condition.


5 Green Normal — The element is in its normal state.
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The EMC Smarts Service Assurance Manager Configuration Guide contains information 
about Notification Lists.


Tools


Tools are programs that are executed by EMC Smarts Service Assurance Manager. There 
are two types of tools:


◆ Server and client tools can be invoked by operations personnel in the Global Console 
or can be automated using escalation policies. Tools invoked by operators may 
produce output that can be sent back to the console for display.


◆ Automatic tools are executed by administrator-specified escalation policies or by 
adapters. Output is not sent back to the console for display.


Server and client tools are executed in the context of a particular target object. The target 
object may be a notification, or it may be an infrastructure element such as a router. When 
invoked from the Global Console, the specification of the target object is implicit. 


Automatic tools are executed for notifications that meet the escalation criteria for 
specified periods of time. 


The EMC Smarts Service Assurance Manager Configuration Guide contains additional 
information about the Service Assurance tools.


Notification escalation


Escalation is a process that defines a sequence of corrective actions for notifications. 
Examples of corrective actions include alerting responsible parties and executing 
automatic tools. EMC Smarts administrators use the Escalation view in the Global 
Manager Administration Console to configure escalation policies.


Escalation policies enable EMC Smarts administrators to automate responses to events. 
For example, an administrator can configure an escalation policy to page a shift supervisor 
if no one takes ownership of a problem for more than 15 minutes. If the problem remains 
unowned for 30 minutes, the policy will page the operations manager. The administrator 
can define multiple policies to handle different types of events.


Audit log


An audit log is associated with each of the notifications that the EMC Smarts Service 
Assurance Manager receives from the underlying EMC Smarts applications. The audit log 
includes the following information:


◆ Event


◆ Time of the update


◆ Name of the operations person or system that made the update


◆ Type of audit entry


◆ Description of the entry (for example, Notify, Clear, or Suspend)
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Service Assurance begins to create an audit log when it receives a notification, and relates 
the event to an infrastructure element. Thereafter, Service Assurance adds actions for the 
event, any program tools used for the event, and changes in the status of the event. 
Actions may include system actions such as archiving and user actions such as 
acknowledgement and ownership. Comments can be added directly to the audit log.


An audit log for each notification can be viewed in an audit log dialog box using the Global 
Console, exported to spreadsheet applications, or printed as part of a report. All the audit 
log entries for individual notifications are stored in one log file on the Global Manager.


Containment


The Containment dialog box provides detailed information about a managed element. 
Containment information varies depending upon the type of element and the type of 
analysis being performed by the underlying domain. As examples, for a network 
connection, the containment information includes details about connection points; for a 
device managed by IP Performance Manager, containment information includes details 
about the device’s memory.


The Containment dialog box is available for selected notifications in the Notification Log 
Console, for selected instances in the Topology Browser Console, and for selected nodes 
in the Map Console. When an element is managed by multiple Domain Managers, the 
Containment dialog box includes all the containment information for each domain.


Security


Security is a critical concern in the world of large-scale distributed networks. Therefore, 
the EMC Smarts Service Assurance Manager provides several means by which EMC Smarts 
administrators can set up security and control access to the system. This includes:


◆ User rights and privileges, including client authentication


◆ Encryption of passwords in files


◆ Encryption of communication channels


◆ Support for FIPS 140-2


An EMC Smarts administrator can place access restrictions on certain console operations 
by applying user profiles. Each user should be associated with a profile that defines the 
appropriate level of access control (rights and privileges) for their position and job 
responsibilities.


Client/server connections are controlled on both the client and server sides of the system. 
The system is secured using authentication records and by assigning connection 
privileges on the server side. When a client initiates a connection to a server, the client 
must supply appropriate authentication to the server before the connection (as defined by 
the connection privileges) is permitted.


For added protection, authentication and other passwords are encrypted in the files that 
store them.


Communication channels (that is, TCP connections made through Remote API) between 
EMC Smarts servers, brokers, and adapters can also be encrypted. Instead of passing 
information as clear text, these components’ communications can be encrypted using 
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either a site secret, the Diffie Helman-Advanced Encryption Standard (DH-AES), or both. 
For new installations, encryption by DH-AES is enabled by default between EMC Smarts 
processes that support encryption.


The Federal Information Processing Standard (FIPS) Publication 140-2 is a U.S. 
government computer security standard governing cryptographic modules. FIPS 140 is 
required for any software purchased by the U.S government and U.S military. This release 
specifically addresses U.S Government accounts which require FIPS 140 compliance.


A configuration parameter, SM_FIPS140, has been introduced for FIPS 140 in the 
runcmd_env.sh file. The SAM administrator can enable or disable this parameter as 
required. The default value of this parameter is FALSE.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides additional information on FIPS 140-2.


The EMC Smarts System Administration Guide contains additional information about 
securing access to EMC Smarts applications. The EMC Smarts Service Assurance Manager 
Configuration Guide includes additional information about restricting access to certain 
Global Console operations.
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Service Assurance module functions
The Service Assurance modules provide additional capabilities to calculate the business 
impact of infrastructure problems, to produce a wide variety of operational and 
management reports, and to display customer-specific information to a given enterprise or 
service-provider customer through EMC Smarts Business Dashboard.


EMC Smarts Business Impact Manager functions


The degradation or failure of important infrastructure elements can slow or stop vital 
business processes and business services, or dramatically reduce user productivity in 
needed business areas. EMC Smarts Business Impact Manager ensures maximum 
availability of services.


EMC Smarts Business Impact Manager (Business Impact Manager) extends the 
capabilities of Service Assurance to calculate the business impact of events, and to 
propagate the impacts to affected business entities as discrete notifications that are 
linked to elements in the infrastructure.


Users can create business entities, such as organizations, business units, lines of 
business, and departments, and relate them to corresponding infrastructure elements. 
Users can also create business processes.


In Business Impact Manager, users can assign different weights to any elements in the 
business or infrastructure topology. Business Impact Manager calculates the impact of 
root-cause problems by summing up the weights of the impacted elements. 


The calculated impact enables operations management to prioritize notifications in 
accordance with business needs, and to effectively use their time and resources to resolve 
problems that degrade or threaten vital processes and services.


Business process tools are also provided for users to create, update, and delete events 
associated with their business processes. For example, a user might create an event that 
represents a telephone call from a supplier who is out of stock of a popular retail product, 
and then associate the event with the user’s Order Fulfillment Business Process.


The EMC Smarts Business Impact Manager User Guide includes detailed information 
regarding Business Impact Manager.


EMC Smarts Business Dashboard functions


The EMC Smarts Business Dashboard (Business Dashboard) displays views normally 
available from the Global Console as a collection of EMC Smarts viewlets within your 
organization’s web page or a third-party web portal. EMC Smarts viewlets can display a 
variety of information including a Notification Log, Status Table, Map, Summary, 
Notification Properties, or Containment view. Viewlets can also be customized to suit your 
needs. For example, a map viewlet can be set up to show a specific topology instance as 
the focus of the map display.


Furthermore, the viewlets can function as sources for broadcasting context information to 
other, listener viewlets. For example, a Status Table viewlet and a Notification Log viewlet 
can be displayed such that selections in the Status Table result in the Notification Log 
showing notifications related to those Status Table selections.
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CHAPTER 3
Implementation Scenarios


This chapter highlights important features of EMC Smarts solutions, and describes how 
EMC Smarts Service Assurance Manager can be implemented for a competitive advantage 
in two business areas:


◆ Enterprise service provider


◆ Network service provider


This chapter contains the following information:


◆ Challenges of network management........................................................................  32
◆ EMC Smarts solutions .............................................................................................  32
◆ Enterprise provider..................................................................................................  34
◆ Network service provider.........................................................................................  36
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Challenges of network management
Regardless of the business area, network management organizations everywhere are 
faced with the following challenges: 


◆ Improve service


◆ Reduce operational costs


◆ Integrate new tools with existing management and support systems


◆ Deliver a high return on investment


EMC Smarts solutions
The features and functions of the EMC Smarts solutions, which include EMC Smarts IP 
Availability Manager, EMC Smarts IP Performance Manager, EMC Smarts Application 
Services Manager, EMC Smarts ATM/Frame Relay Manager, and EMC Smarts Service 
Assurance Manager, address important challenges that network management 
organizations face on a day-to-day basis.


Fast and accurate fault isolation


EMC Smarts uses comprehensive topology models to quickly and accurately analyze and 
isolate failures in networks of any size and complexity.


EMC Smarts analysis improves service by greatly reducing manual problem isolation, 
which accounts for up to 80 percent of total downtime. The analysis also lowers 
operational costs by reducing the human effort involved in isolating problems, as well as 
the effort involved in chasing down all the symptomatic events and false alerts.


Automated corrective actions


Once a fault has been accurately isolated, Service Assurance Manager can be configured 
to initiate automated responses to correct soft faults or to reroute services around failures. 
Because EMC Smarts can separate root-cause problems from symptomatic events and 
false alarms, actions are only invoked when or where needed. With the EMC Smarts 
topology models, corrective actions can be invoked against both the failed component or 
any impacted services.


Service Assurance Manager’s automated actions avoid service downtime and provide 
virtually immediate service restoration. They can also improve service by fixing problems 
before users become impacted.


Business focus


EMC Smarts Business Impact Manager can import business information directly from 
existing data sources such as provisioning systems. During its analysis, it places 
infrastructure problems in their proper business context and analyzes their impact on 
services, business processes, and customers. This enables managers to focus their efforts 
on the problems with the highest business impact.
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Integration


EMC Smarts solutions are designed to integrate with management tools and other 
operational support systems. EMC Smarts leverages management data from third-party 
sources while providing console access to third-party management applications. 
EMC Smarts software’sability to distill countless events into a concise set of defined 
problems and exceptions makes it a natural integration point for problem management 
(ticketing) systems.


Service Assurance’s integration with other management applications lowers operational 
costs by providing users with a single, consistent, intuitive interface for viewing all 
management data. At the same time, Service Assurance improves operational control by 
presenting a concise display of network problems in their full topology context, complete 
with their impacts and histories.


Rapid deployment and low maintenance


EMC Smarts solutions are designed for rapid deployment and low maintenance. Unlike 
other management solutions, EMC Smarts software’s comprehensive set of problem and 
impact models automatically adapt to the configuration of the network infrastructure — 
providing immediate results. This same adaptability enables EMC Smarts solutions to 
automatically keep pace with future changes in the infrastructure without the need for 
expensive ongoing code maintenance.


EMC Smarts has the ability to automatically adapt to changes due to use of ICIM models 
that represent the various elements of the infrastructure, how they relate to one another, 
and how they can affect one another. EMC Smarts solutions then apply these models to 
the discovered elements in a given network to provide problem and impact analysis 
specific to that network. Furthermore, customers who need additional functionality can 
leverage these models to build solutions that also adapt automatically to change.


This enables EMC Smarts solutions to provide better return on investment than other 
management solutions. Benefits include:


◆ Automatic adaptation reduces the head-count needed to maintain the management 
solution


◆ Analysis that automatically adapts to changes in the environment and provides more 
accurate results, which reduces service downtime


◆ More accurate analysis frees up expensive engineering resources to work on more 
strategic initiatives
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Enterprise provider
A diversified financial services firm deployed an EMC Smarts Service Assurance Manager 
solution to help them manage their complex infrastructure as an integrated system rather 
than as sets of unrelated silos.


The primary concern of the financial enterprise was that more than 100 mission-critical 
applications were used by their business units, such as applications to monitor their 
exposure to interest and currency fluctuations. Basically, the enterprise had too many 
mission-critical applications for the network teams to track. At the same time, their 
network changed and evolved so quickly that the application teams could not stay abreast 
of the changes.


As a result, when network failures occurred, or when network maintenance was required, 
they had no way of knowing which applications were affected. Attempts to do this with 
traditional tools—where one specified network dependencies for each application—failed 
because of the need to manually maintain the correlation logic every time the network 
topology changed. If they missed a change, the correlation would fail.


By deploying an EMC Smarts solution, the enterprise was able to solve their problem by 
separating the network, applications, and business analysis into separate domains, thus 
breaking the problem into manageable pieces, as well as automating the most 
complicated part of their problem: defining the network dependencies of the distributed 
applications. Their EMC Smarts solution consisted of the following:


◆ EMC Smarts IP Availability Manager and IP Performance Manager — To monitor failures 
in the network infrastructure and identify the affected systems, automatically 
calculating the affect of any network path redundancies


◆ EMC Smarts Application Services Manager — To perform root-cause and impact 
analysis of distributed applications based on events and topology information 
imported from the IP Availability Manager, IP Performance Manager, and the SAM 
adapters


◆ EMC Smarts Business Impact Manager — To correlate failures in the technology 
infrastructure to the businesses they impact (for example, processing on NASDAQ 
trades)


◆ EMC Smarts Service Assurance Manager — To bring it together into a single system, 
where users can customize views of the data they need, and use the appropriate tools 
to quickly restore service


◆ EMC Smarts Business Dashboard — To provide web-based, personalized views for 
business unit managers (for example, in the foreign exchange unit) showing a map 
representation and a summary view of the status of their systems.


Figure 5 on page 35 illustrates their EMC Smarts implementation.
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Figure 5  Enterprise solution
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By connecting the analysis from the network, application, and business domains, EMC 
Smarts Service Assurance Manager provided the enterprise with an end-to-end view of 
causes and impacts — automatically correlating network failures with their impacts on 
applications and critical business processes. 


By knowing the business impact of each problem, the operations staff effectively 
prioritized their support efforts on the most critical problems; that is, they aligned their 
efforts with the overall business objectives of the enterprise.


At the same time, because EMC Smarts IP Availability Manager and EMC Smarts IP 
Performance Manager automatically adapt to changes in the network topology, operations 
did not need to devote teams of people to modify the analysis every time the network 
topology changes. This dramatically reduced the cost to maintain their management 
systems. In fact, because all of the logic is based on the infrastructure topology, they only 
needed to manually maintain the business and application elements. EMC Smarts 
software automatically adapted everything else: root-cause and impact analysis, 
personalized views, and so forth.


In addition to solving the problem of application and business impact, the EMC Smarts 
Service Assurance Manager also streamlined operational processes.


By identifying the root causes, the support staff eliminated most of the time-consuming 
fault isolation process and immediately proceeded to problem resolution. By identifying 
which events are impacts of other problems, the support staff avoided wasting time trying 
to chase down and fix symptoms of other problems. Finally, by relating the root causes 
with the impacts, operations staff streamlined communications. For example, when 
estimating the time to resolve a root-cause problem, that information was automatically 
propagated to all affected systems, applications, and business processes.


Because they identified the actual root-cause failures (for example, a card on a switch), 
they were able to automate the dispatch of service technicians from their maintenance 
provider. More importantly, because they positively identified the failed element, they 
avoided the delays caused by technicians who arrived on site with the wrong parts.


By integrating the EMC Smarts solution with their existing system and application 
management tools (by way of SAM adapters), the enterprise was able to leverage their 
previous investments in management tools and accelerate the deployment of the overall 
solution.


Network service provider
A large network service provider had been using traditional management tools to manage 
a broad array of services. After several years of deployment and custom work, the systems 
were starting to improve network operations. However, the maintenance costs were 
spiraling out of control and it was becoming more difficult to keep up with changes in the 
managed environment. Worse, the operational improvements were not translating into 
higher customer satisfaction because of communications failures between operations and 
the call center. The provider needed to find an alternative that could deliver real 
improvements to customer satisfaction while reducing operational costs. The answer to 
this challenge was an EMC Smarts solution composed of:


◆ EMC Smarts ATM/Frame Relay Manager


◆ EMC Smarts IP Availability Manager 
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◆ EMC Smarts IP Performance Manager


◆ EMC Smarts Application Services Manager


◆ EMC Smarts Service Assurance Manager Adapter Platform


◆ EMC Smarts Business Impact Manager


◆ EMC Smarts Service Assurance Manager


◆ EMC Smarts Business Dashboard


With the autodiscovery feature of EMC Smarts autodiscovery, built-in analysis, and 
policy-based management, operations was able to immediately identify and isolate 
root-cause failures in their networks. Because EMC Smarts applications automatically 
detect and adapt to changes in topology, the service provider no longer needed to 
dedicate teams of consultants to maintain them. Also, because EMC Smarts intelligently 
manages networks with overlapping IP addresses (for example, private IPs), the provider 
could discontinue the expensive process of dedicating a separate management system to 
each customer. These features helped the provider to dramatically reduce the cost of 
managing their environment.


By integrating the EMC Smarts solution with existing management tools (for example, 
system and application agents from Concord), the service provider was able to use its 
existing investments to cut deployment time.


The unique capability of EMC Smarts to integrate not just events, but events in the context 
of a comprehensive topology, allowed the service provider to more effectively integrate 
operations with its other OSS applications. By integrating with their provisioning system, 
the provider was able to automatically build their business topology, and relate customers 
to services and services to elements in their network topology. This integration provided 
automated business impact analysis for prioritization, and allowed users to view 
technology failures in their complete technical and business context.


Leveraging this business topology, EMC Smarts was able to automatically identify which 
events customers would care about so that the call center could focus on customer 
impacts rather than sifting through masses of arcane infrastructure events. Similarly, by 
using the customer data to integrate with the CRM application, EMC Smarts was able to 
identify the account managers associated with each customer impact, and notify them of 
problems in real time. Furthermore, the operations staff used this information to 
coordinate maintenance work with the account managers of potentially affected 
customers.


Because problem causes and impacts were linked, the provider was also able to 
streamline communications between operations and the call center. For example, when 
operations identified a problem and dispatched an engineer to resolve it, they could 
estimate a repair time and the system automatically relayed that estimate for all customer 
impacts to the call center and customer web applications so that everyone immediately 
knew when the service would be restored. Finally, when customer relations faced a crisis 
and the customer assurance staff elevated the priorities of specific customer impacts, 
EMC Smarts automatically applied the priority changes to the root-cause failures and 
notified engineering management so that operations could shift their activities 
accordingly.
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With the Business Dashboard, the provider's customers were able to get real-time views of 
their data. Because these views use the same topology, the views changed automatically 
whenever the topology changed. This, too, reduced the cost of servicing customers.


In conclusion, by effectively integrating the EMC Smarts solution with its existing 
applications (for example, provisioning, CRM, and call center), the service provider was 
able to show a more professional face to its customer. In the past, customer calls to the 
call center typically resulted in an operator taking messages, calling around operations to 
see what was happening, and then calling the customer back — a time- consuming 
process that often left the customer wondering what the provider was doing. Now, when 
the customer calls, the call center is not only aware of the problem, but is also able to give 
the customer up-to-the-minute information about the status of the problem and its 
resolution.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
The purpose of this guide is to provide information about how EMC Smarts Service 
Assurance Manager Notification Adapters manage the flow of data between your Global 
Manager (or Domain Manager) and other applications or locations on the network.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Global Manager. IT managers who seek to understand the role of the 
Global Manager in the context of an EMC Smarts solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide Guide.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide
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◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example

EMC Smarts Service Assurance Manager Notification Adapters User Guide 13







Preface

Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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Introduction

Overview
Use an EMC® Smarts® Notification Adapter (notifier) to pass information contained in 
EMC Smarts Service Assurance Manager notifications to other applications or to users. For 
example, you can use a notifier to:


◆ Convert notifications into email messages or SNMP traps


◆ Write the notification text to a log file


◆ Execute a script upon receiving a notification


Table 1 on page 16 describes the purpose of each notifier.


EMC Corporation recommends using the notification adapters with the EMC Smarts 
Service Assurance Manager (Global Manager). The notification adapters may also be used 
with Domain Managers.


The following are additional examples of typical notifier usage:


◆ Write notifications to a log.


◆ Execute a program, such as a paging service or email, upon receipt of a notification.


◆ Extend and get additional information about a notification:


• Get the impact when you receive a notification.


• Get the system location of a failing device.


◆ Open a trouble ticket using a third-party package.


Table 1  Notification adapters and descriptions


Adapter Description


Email Notifier Adapter Sends notifications from a Global Manager to specific 
addresses in an email system


Log File Notifier Adapter Logs notifications from a Global Manager to a file


SNMP Trap Notifier Adapter Converts notifications into SNMP traps and sends the traps 
to specified locations


Script Notifier Adapter Calls a custom script when a notification is received
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Implementing adapters
This section describes the high-level tasks necessary to configure and start notification 
adapters. Before you begin, ensure that the EMC Smarts Service Assurance Manager is 
properly installed and functional. The notification adapters are installed automatically as 
part of SAM. The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM 
Managers contains additional information. This document assumes the adapters are 
installed:


1. If the notification adapter is already running, stop it. “Starting and stopping 
notification adapters” on page 23 contains instructional information.


2. Verify the parameters in your adapter’s configuration file. If necessary, use the 
sm_edit utility to modify them. For example, you might need to define a destination or 
modify the default value of the serverName parameter to match the name of your 
Global Manager or Domain Manager.


“Configuration files” on page 20 and the respective adapter chapter contains detailed 
instructions.


3. Verify the SubscribesTo section in your adapter’s configuration file. The default 
subscription is for a Global Manager. If the adapter needs to subscribe to a Domain 
Manager, then you need to modify the file. “Specifying subscriptions in the 
configuration file” on page 21 contains additional information.


4. Check that the appropriate authentication is set in the security configuration files. 
“Securing access” on page 22 contains additional information.


5. Start the notification adapter. “Starting and stopping notification adapters” on 
page 23 contains additional information.
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CHAPTER 2
Running the Notification Adapters


This chapter contains the common configuration and administration tasks for the 
EMC Smarts Service Assurance Manager Notification Adapters and contains the following 
information:


◆ Configuration files...................................................................................................  20
◆ Securing access ......................................................................................................  22
◆ Starting and stopping notification adapters ............................................................  23
◆ Logging notification adapter history ........................................................................  28


Any differences between the notifiers are noted and discussed in detail in subsequent 
chapters.
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Configuration files
When a notifier starts, it reads a configuration file (*.conf). Original versions of the adapter 
configuration files are installed to the BASEDIR/smarts/conf/notifier directory. Retain the 
original (unedited) version of each configuration file. If you intend to modify a 
configuration file, use the sm_edit utility provided with your EMC Smarts software. This 
will ensure that you modify a copy of the file and this copy is placed in the proper local 
subdirectory. “Editing notification adapter files” on page 20 contains additional 
information on modifying files and using sm_edit. Table 2 on page 20 lists the name of 
each notifier’s configuration file.


The configuration files for each of these notifiers share some common parameters and 
subscription information. The configuration files are text files.


Whenever you modify a configuration file, you must stop and restart the notifier for the 
changes to take effect.


Editing notification adapter files


As part of the EMC Smarts deployment and configuration process, you need to modify 
certain files. User modifiable files include configuration files, rule set files, templates, and 
files (such as seed files, and security configuration files) that contain encrypted 
passwords. Original versions of these files are installed into appropriate subdirectories 
under the BASEDIR/smarts/ directory.


Original versions of files should not be altered. If a file requires modification, it must be 
stored as a local copy of the file in BASEDIR/smarts/local or one of its subdirectories. 


Example 1: Modify serverConnect.conf


In UNIX:


◆ The original version of the server connect (serverConnect.conf) security configuration 
file on UNIX is installed to:


/opt/InCharge/SAM/smarts/conf


◆ A modified serverConnect.conf security configuration file on UNIX should be saved to: 


/opt/InCharge/SAM/smarts/local/conf


Table 2  Notification adapter configuration files


Adapter Configuration filename


Email Notifier Adapter mail-notify.conf 


Log File Notifier Adapter file-notify.conf


SNMP Trap Notifier Adapter trap-notify.conf


Script Notifier Adapter script-notify.conf
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In Windows:


◆ The original version of the server connect (serverConnect.conf) security configuration 
file on Windows is installed to: 


C:\InCharge\SAM\smarts\conf


◆ A modified serverConnect.conf security configuration file on Windows should be 
saved to: 


C:\InCharge\SAM\smarts\local\conf


EMC Smarts software is designed to first search for user modifiable files in 
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not 
found in the local area, EMC Smarts software then searches appropriate non-local 
directories.


To facilitate proper file editing, EMC Corporation provides the sm_edit utility with every 
EMC Smarts products. When used to modify an original version of a file, this utility 
automatically creates a local copy of the file and places it in the appropriate location 
under BASEDIR/smarts/local. This ensures that the original version of the file remains 
unchanged. You can invoke sm_edit from the command line. Optionally, you can configure 
Windows so that sm_edit is automatically invoked when user-modifiable files are 
double-clicked in Windows Explorer.


To invoke the sm_edit utility from the command line, specify the path and the name of the 
file to edit under BASEDIR/smarts. If multiple EMC Smarts products are running on the 
same host, invoke sm_edit from the bin directory of the product with the files to edit. 


Example 2: Edit a configuration file


To edit the configuration file for connecting to a server (serverConnect.conf), invoke the 
sm_edit utility as follows: 


/opt/InCharge/SAM/smarts/bin>sm_edit conf/serverConnect.conf


In this example, the sm_edit utility automatically creates a local copy of the 
serverConnect.conf file in the /opt/InCharge/SAM/smarts/local/conf directory and opens 
the file in a text editor. If a local version of the file already exists, the sm_edit utility opens 
the local version in a text editor. In addition, sm_edit creates any necessary 
subdirectories.


The EMC Smarts System Administration Guide provides additional information about the 
sm_edit utility.


Specifying subscriptions in the configuration file


The notifiers can subscribe to either an EMC Smarts Service Assurance Manager (Global 
Manager) or to a Domain Manager. 


To indicate which notifications (or event information) the adapter will process, you specify 
this in the Subscriptions section of the notifier’s configuration file. EMC Corporation 
recommends that you subscribe to the Global Manager. 


By default, the notifiers subscribe to a Global Manager. To subscribe to a Domain 
Manager, you must uncomment the code in the Subscriptions section and comment out 
the code for the Global Manager (insert a # character at the beginning of the lines that are 
not needed).
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EMC Smarts Service Assurance Manager
You use a notification list to subscribe an adapter to a Global Manager. For example, to 
subscribe the Log File Notifier Adapter to the default notification list, use the following:


SubscribesTo = 
{


GA_NLSubscription::file-Default-NLSubscriptions
{


NLName = "Default"
}


}


EMC Smarts Domain Manager
Use the choice subscription to subscribe an adapter to a Domain Manager (for example, 
Availability Manager). For example, to subscribe the SNMP Trap Notifier Adapter to all 
problems reported in a Domain Manager, use the following:


SubscribesTo =
{


GA_ChoiceSubscription::trap tibrv-All-Problems-Subscriptions
{


className = ".*"
instanceName = ".*"
eventName = ".*"
problems = TRUE
aggregates = FALSE
symptoms = FALSE


}
}


Securing access
Before you start your notification adapter, check that the appropriate authentication is set 
in the security configuration files. Depending on your adapter, you will need to modify 
default values or add authentication records to one or both of these files:


◆ The clientConnect.conf file since the notification adapter acts as a client when it 
connects to an EMC Smarts Manager.


◆ The serverConnect.conf file if the notification adapter acts as a server and is registered 
with the EMC Smarts Broker. (Table 4 on page 24 lists the 
--name parameters used to register the notification adapter with the Broker.) A 
notification adapter acting as a server will need to authenticate incoming connections 
from users or other applications.


These security configuration files are located in the BASEDIR/smarts/conf directory of the 
EMC Smarts Service Assurance Manager. 


The EMC Smarts System Administration Guide contains information about security and 
configuring the clientConnect.conf and serverConnect.conf files.
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Starting and stopping notification adapters
This section describes how to use:


◆ The sm_notify command to start notification adapters. This method is useful if you 
intend to run the adapter once for a short period of time. For example, if you need to 
run a Log File Notifier Adapter to log notifications for testing purposes, use the 
sm_notify command. “Using sm_notify to start notification adapters” on page 23 
contains additional information.


◆ Platform commands to stop notification adapters that were started with sm_notify. 
“Stopping a notification adapter” on page 25 contains additional information.


◆ The sm_service utility to install notification adapters as services. This method is 
recommended if you intend to run the adapter for a long period of time and want it to 
start automatically when the system starts. For example, if a notification adapter is 
part of your deployment, manually install the adapter as a service. “Installing a 
notification adapter as a service” on page 25 contains additional information.


◆ The sm_service utility to start and stop services. “Starting and stopping a service” on 
page 27 contains additional information.


The installation process installs notification adapters but does not configure them to run 
as services. However, you can use the sm_service utility to install the notification adapters 
as services at any time. 


Using sm_notify to start notification adapters


You start these notifiers manually. To start the notifiers, use the following syntax:


▼BASEDIR/smarts/bin/sm_notify --output[=<file>]
[<param> ...] <notifier> ▲


where <param> is one or more of the parameters listed in Table 4 on page 24 and <notifier> 
is one of the following: mail, file, trap, script, or tibrv.


▼ ▲ indicates the command must be typed as one line.


Table 3 on page 23 defines the Notification adapters names.


Table 3  Notification adapters and names


Adapter Adapter name


Email Notifier Adapter mail


Log File Notifier Adapter file


SNMP Trap Notifier Adapter trap


Script Notifier Adapter script
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Use additional parameters with the sm_notify command to override information about the 
Global Manager or the Broker, change logging information, or run the notifier as a daemon 
(UNIX only). Table 4 on page 24 lists some of the parameters that can be set for sm_notify.


For additional information about the sm_notify command, type:


BASEDIR/smarts/bin/sm_notify --help


Table 4  sm_notify parameters and descriptions


Parameter Description


--server=<name> Sets the EMC Smarts Manager connection. 
If this is not specified, the notifier uses the value in the 
configuration file.


--broker=<location> Overrides the use of the variable SM_BROKER (Environment 
variable in UNIX and System variable in Windows). 
The format of <location> is <host>:<port>


--name=<notifier_name> Specifies a name for the notifier. The name is used to 
register the notifier with the Broker. 
This parameter is required if you intend to use the roll_log 
command in Windows. Otherwise, this parameter is rarely 
used unless directed by EMC Global Services. Notification 
adapters are not required to be registered with the Broker.
“Starting a new log file” on page 28 contains additional 
information.


--daemon Runs the process as a daemon (UNIX only).


--output[=<file>] Redirects the output (stdout and stderr) to 
BASEDIR/smarts/local/logs/<file>.log by default. The 
filename is <file>, or the 
--logname value if <file> is omitted.
If you run multiple instances of the same notifier on the 
same machine, you must specify an output location for each 
of the log files. The notifiers cannot write to the same log file.


--conf[=<conf_file>] Specifies the configuration file to use for the notifier. 
If this is not specified, the notifier uses the default 
configuration file, <notifier>-notify.conf in 
BASEDIR/smarts/conf/notifier. 
This parameter is useful if you need to use the sm_notify 
command to start more than one notifier (such as two Email 
Notifier Adapters) on a single host. Since each notifier 
references a unique configuration file, the notifiers can be 
configured to behave differently by, for example, subscribing 
to different notifications or sending the notifications to 
different locations.“Starting the customized notification 
adapter” on page 67 contains additional information.


--confdir[=<dir>] Specifies the location (directory) of the notifier’s 
configuration file.
If this is not specified, the notifier uses the default directory, 
BASEDIR/smarts/conf/notifier.
This parameter can also be used to start multiple copies of a 
notifier on the same host or it can be used to start many 
notifiers from a centrally located set of configuration files.


<notifier> Notification adapter. Acceptable values are: mail, file, trap, 
script, or tibrv.
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Running multiple copies of a notification adapter
If you want to start more than one copy of the same notifier, for example, to use two Log 
File Notifier Adapters with a different Global Manager or to have two Email Notifier 
Adapters subscribe to different notifications from the same Global Manager, you should 
use the --conf or --confdir parameters. 


Stopping a notification adapter


To stop a notifier, terminate the process in UNIX or use the Task Manager in Windows. 
(“Starting and stopping a service” on page 27 contains additional information if the 
notification adapter was manually installed as a service.)


UNIX


To terminate the process in UNIX, locate the process ID and then terminate the process:


% ps -elf | grep sm_notify
janedoe  14563 3830  0 14:38:14 pts/35   0:01 sm_notify mail
% kill 14563


Windows


To terminate the process in Windows:


1. Press Ctrl+Alt+Delete and click Task Manager. 


2. In the Processes tab, select the process. 


3. Click End Process.


Installing a notification adapter as a service


To use the sm_service utility to install a service or start a service, you must have 
administrative privileges on the local host.


The syntax for the sm_service install command for a notification adapter is:


▼BASEDIR/smarts/bin/sm_service install --force 
--name=<service_name> --startmode=<mode>
--description="<DESC>"
BASEDIR/smarts/bin/sm_notify --output[=<file>] [<param> ...] 


<notifier> ▲


▼ ▲ indicates the command must be typed as one line.


The parameters for the sm_service install command are described in Table 5 on page 26. 
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The sm_service install command uses the same sm_notify parameters as previously 
described in Table 4 on page 24. The exception is the --daemon parameter which is not 
applicable for the sm_service utility.


Examples of the sm_service install command
To manually install the program for an Email Notifier Adapter as a service, issue:


UNIX


▼# /opt/InCharge/SAM/smarts/bin/sm_service install --force 
--name=ic-email_notifier-adapter


--startmode=manual
--description="SMARTS E-Mail Notifier Adapter"
/opt/InCharge/SAM/smarts/bin/sm_notify 
--output=mail-output 
--server=INCHARGE-SA
mail ▲


Table 5  sm_service install parameters and descriptions


Parameter Description


--force Overwrites an existing service with the same name. This 
parameter is used to update or modify the parameters of an 
existing service. 


--name=<service_name> Display name of the service.


--startmode=<mode> Service start policy. The value for <mode> is one of the following:
• Runonce (start automatically when sm_serviced starts)
• Automatic (starts automatically when sm_serviced does not 


detect that it is running)
• Manual (requires an explicit start request)
• Disable (cannot be started)
The default is runonce.


--description="<DESC>" Short description of the service. Enclose the description with 
double quotation marks.
On UNIX platforms, the description information is printed with 
the name of the service when the sm_service show action is 
invoked.
On Windows platforms, the description appears in the first 
column of the Services Control Panel window (the “Descriptive 
Name”).
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Windows


▼C:\InCharge\SAM\smarts\bin\sm_service install --force 
--name=ic-email_notifier-adapter
--startmode=manual 
--description="SMARTS E-Mail Notifier Adapter"
C:\InCharge\SAM\smarts\bin\sm_notify 
--output=mail-output 
--server=INCHARGE-SA
mail ▲


▼ ▲ indicates the command must be typed as one line.


The EMC Smarts System Administration Guide contains additional information about 
using the sm_service utility.


Starting and stopping a service


To start or stop a service manually, use the sm_service utility. 


To start a service, issue the command:


sm_service start <service_name> [<service_name> ...]


To stop a service, specify stop instead of start.


For example, to start an Email Notifier Adapter that has been manually installed as a 
service, issue:


UNIX


▼# /opt/InCharge/SAM/smarts/bin>./sm_service start 
ic-email_notifier-adapter ▲


Windows


▼C:\InCharge\SAM\smarts\bin>sm_service start 
ic-email_notifier-adapter ▲
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Logging notification adapter history
When the --output option is specified for the sm_notify command, each notifier stores its 
working history in a log file. Every time a notifier starts, when errors occur, or when the 
connection with a Global Manager is lost, the notifier writes information to the log file. 


Each notifier writes its log file to BASEDIR/smarts/local/logs. When the notification 
notifiers run on the same machine, specify a unique name for the log file of each notifier.


All log files have a .log file type. The default name of a log file is based on the program’s 
name. For a notification adapter, the default name of the log file is sm_notify.log. To 
change the default name, specify a filename with the --output option for the sm_notify 
command. For example, for an Email Notifier Adapter, specify --output=MailAdapter and 
the name of the log will be MailAdapter.log.


EMC Smarts software can maintain up to 1,000 different copies of backup log files. The 
number of saved log files is determined by the value of the SM_BACKUP_FILE_LIMIT 
environment variable. When an adapter starts up, it renames a file that matches its log 
filename and adds a .bak to the name (for example, MailAdapter.log to 
MailAdapter.log.bak). If a file with this name already exists, it is renamed 
MailAdapter.log.bak.NNN, and a new MailAdapter.log.bak is created. By default, 
EMC Smarts programs save two log files, which do not include the active log file.


Starting a new log file


You can request that an adapter create a new log file, often referred to as rolling over a log 
file. Typically, this is done when a log file becomes quite large. Log files grow indefinitely, 
though slowly under normal conditions.


Most notification adapter log files are small and rolling over a log file is not necessary. 
However, if you need to start a new log file, use the following methods:


◆ For UNIX systems only, use the kill command.


◆ For UNIX and  Windows systems, use the roll_log command.


You can repeat the log file roll-over process as many times as you like. If you need to retain 
log files beyond the limit specified by the SM_BACKUP_FILE_LIMIT environment variable, 
you should copy or at least rename the .log.bak files as soon as they are created. The EMC 
Smarts System Administration Guide contains additional information about managing and 
rolling over log files.


The kill command method for UNIX systems
On UNIX systems only, it is possible to request that a notifier “roll over” its log files. You do 
this by sending a SIGUSR1 signal to the process ID writing the log file. Use the kill 
command of your shell:


% kill -USR1 <pid>


Upon receipt of the USR1 signal, a notifier first writes an informational message to the end 
of the current log file, repeats the steps it executed at startup, and creates a new log file 
and a backup log file as previously described.
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The roll_log command method
The roll_log command is invoked through the dmctl utility, which requires that you attach 
to the adapter with administrative privileges. 


Use the roll_log command to register the notification adapter with the Broker using the 
--name option. “Using sm_notify to start notification adapters” on page 23 contains 
additional information.


The syntax of the command is:


roll_log [<file-name>]


The <file-name> option enables you to specify a new name for current and subsequent 
log files. If you omit this option, the current naming convention is retained. If you specify a 
name, the new log file uses that name. Any new log files created with roll_log will also use 
this name if a different name is not specified. The new name specified by <file-name> is 
handled in exactly the same manner as the --output option to the sm_notify command. 


For example, on Windows to start a new log file for an Email Notifier Adapter named 
MailAdapter, issue:


▼C:\InCharge\SAM\smarts\bin\dmctl -s MailAdapter exec roll_log ▲


On UNIX systems, the equivalent command is:


▼% /opt/InCharge/SAM/smarts/bin/dmctl -s MailAdapter exec roll_log ▲


▼ ▲ indicates the command must be typed as one line.


When roll_log is invoked, the adapter writes an informational message to the end of the 
current log file, repeats the steps it executed at startup, and creates a new log file and a 
backup log file as previously described. 
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Email Notifier Adapter overview
The Email Notifier Adapter sends email, based on notifications, to a designated list of 
users using an SMTP server. 


All notifications received by the Email Notifier Adapter are sent as email to one or more 
users, as shown in Figure 1 on page 32. The Email Notifier Adapter sends the same 
information to all of the recipients.


Figure 1  Email Notifier Adapter


The Email Notifier Adapter sends information about event notifications. By default, it does 
not send information when an event is cleared.


Each email sent has the form:


Subject: 


NOTIFY <Affected_Instance_Name> <Event_Name>


Body:


InCharge Server <serverName>:
NOTIFY <Class_Name> <Affected_Instance_Name> <Event_Name> 


(<Certainty %>)
<Event_Description>


Mail User 1


Mail User 2


Mail User 3


Mail User 4


Notifications E-Mail Notifier Adapter E-Mail Message
(same content)


Global Manager
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Configuring the Email Notifier Adapter
The file, mail-notify.conf, configures the notifier. The original version of the file is located 
in BASEDIR/smarts/conf/notifier. You should retain the original (unedited) version of the 
configuration file. A local copy should be made if you intend to make any modifications. If 
you intend to modify a configuration file, you should use the sm_edit utility provided with 
your EMC Smarts software. This will ensure that you modify a copy of the file and that the 
copy is placed in the proper local subdirectory. “Editing notification adapter files” on 
page 20 contains additional information on modifying files and using sm_edit.


If you modify the configuration file while the notifier is running, you will need to restart the 
notifier so that it rereads its configuration file.


Email Notifier Adapter parameters


Before you start this notifier, you must set values for the following parameters:


◆ MailServer


◆ SenderID


◆ Recipients


The other parameters may remain unchanged. You can also change the subscriptions for 
this notifier. “Specifying subscriptions in the configuration file” on page 21 contains 
additional information. Table 6 on page 33 describes each Email Notifier Adapter 
parameter.


Table 6  Email Notifier Adapter parameters and descriptions (page 1 of 2)


Parameter Description


serverName Default name of the EMC Manager to connect to. 
The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier sends a 
notification. 
This parameter is used only if the notifier is subscribed to a Domain 
Manager. 
If the notifier is subscribed to a Global Manager, this parameter is 
not applicable and the value is 0 seconds.
The default is 0 seconds. 


minimumCertainty Threshold above which notifications are sent. Any notification with 
a certainty below the threshold is discarded. This value must be a 
number between 0.0 and 1.0. Service Assurance uses the value 
from the NotificationList definition.
The default is a certainty of 0.01. 


initialEventDelay Time interval the notifier should wait after it connects to the EMC 
Manager before accepting events. 
The default is 0 seconds.
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Appendix A, “Customizing a Notification Adapter,” contains additional information about 
customizing a notification adapter.


MailServer Name of the mail server. For example:
MailServer = "localhost"


SenderId Email address associated with the notifier. Users can reply to this 
address. This address must be recognized by the mail server. For 
example:
SenderID = "daemon@localhost"


Recipients Comma-separated list of the recipients of the emails. The recipients 
in the list must be recognized by the mail server. For example:
Recipients = "root@localhost,recipient@your_company.com"


Table 6  Email Notifier Adapter parameters and descriptions (page 2 of 2)


Parameter Description
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This chapter contains the following information:


◆ Log File Notifier Adapter overview ...........................................................................  36
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Log File Notifier Adapter overview
The Log File Notifier Adapter writes notifications (that it subscribes to) to a file. This 
notification file can include event notifications (including cleared events). The output is a 
single line with the following fields:


Current_Time 
Event_Type 
Class_Name 
Affected_Instance_Name 
Event_Name 
Certainty 
Event_Description


The notifier saves the notification file to the BASEDIR/smarts/local/logs directory. By 
default, the name of the file is:


<InCharge_Manager>-alarms.log


Figure 2 on page 36 illustrates how the Log File Notifier Adapter receives notifications and 
adds them to a notification file.


Figure 2  Log File Notifier Adapter


Configuring the Log File Notifier Adapter
The configuration file, file-notify.conf, configures the notifier. The original version of the 
file is located in BASEDIR/smarts/conf/notifier. You should retain the original (unedited) 
version of the configuration file. If you intend to modify a configuration file, you should 
use the sm_edit utility provided with your EMC Smarts software. This ensures that you 
modify a copy of the file and the copy is placed in the proper local subdirectory.


Do not change any of the parameters in the configuration file before starting this notifier. If 
you decide to change a parameter, use the sm_edit utility to edit the configuration file. 
“Editing notification adapter files” on page 20 contains additional information on 
modifying files and using sm_edit. 


If you edit the configuration file while the notifier is running, restart the notifier so that it 
rereads its configuration file.


Notifications


Text Output from


Notification
Log File Notifier Adapter


INCHARGE-SA-alarms.log


Global Manager
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Log File Notifier Adapter parameters


Table 7 on page 37 describes each parameter for the Log File Notifier Adapter. “Specifying 
subscriptions in the configuration file” on page 21 contains additional information on 
optionally changing the subscriptions for this notifier to receive different types of 
notifications. 


Appendix A, “Customizing a Notification Adapter,” contains additional information.


Table 7  Log File Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the EMC Manager to connect to. 
The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier 
sends a notification. 
This parameter is used only if the notifier is subscribed to a 
Domain Manager. 
If the notifier is subscribed to a Global Manager, this 
parameter is not applicable and the value is 0 seconds.
The default is 0 seconds.


minimumCertainty Threshold above which notifications are sent. Any notification 
with a certainty below the threshold is discarded. This value 
must be a number between 0.0 and 1.0. Service Assurance 
uses the value from the NotificationList definition.
The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the 
EMC Manager before accepting events. 
The default is 0 seconds.


fileName Full name of the notification file. The name cannot contain 
path separators. 
If you do not assign a value, the name of the notification file is 
<InCharge_Manager>-alarms.log.

Configuring the Log File Notifier Adapter 37







Log File Notifier Adapter

38 EMC Smarts Service Assurance Manager Notification Adapters User Guide







CHAPTER 5
SNMP Trap Notifier Adapter
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SNMP Trap Notifier Adapter overview
The SNMP Trap Notifier Adapter converts notifications into SNMP traps. This notifier sends 
the traps to specific trap receivers on the network as shown in Figure 3 on page 40.


Figure 3  SNMP Trap Notifier Adapter


The SNMP Trap Notifier Adapter supports SNMP V1, SNMP V3, and V2C traps.


All traps sent by the SNMP Trap Notifier Adapter include the same information:


◆ Agent Address = IP address for host running the notifier


◆ Enterprise OID = enterprises.733 (Full OID is .1.3.6.1.4.1.733)


◆ Generic Trap Number = 6


◆ Varbind sequence always the same for all of the traps


Table 8 on page 40 shows the types of traps the SNMP Trap Notifier Adapter sends. 


Table 9 on page 40 shows the varbinds of the SNMP Traps the SNMP Trap Notifier Adapter 
sends.


SNMP Trap Receiver


SNMP Trap Receiver


Notifications
SNMP Trap Notifier Adapter SNMP TrapsGlobal Manager


Table 8  Trap types


Trap name Trap number


smTrapNotification 4


smTrapNotificationClear 7


smTrapNotificationChange 98


smTrapNotificationDelete 99


Table 9  Varbinds of the SNMP Traps (page 1 of 2)


Varbind name Varbind number Description


smNotifTimestamp enterprises.733.2.1.1.0 Timestamp of the notification. 
(unsigned 32-bit integer)


smNotifServer enterprises.733.2.1.2.0 Name of the Global Manager sending 
notifications to the SNMP Trap Notifier 
Adapter. (string)


smNotifClass enterprises.733.2.1.3.0 Class name associated with an event. 
(string)


smNotifInstance enterprises.733.2.1.4.0 Instance display name associated with 
an event. (string)
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Appendix D, “EMC Smarts MIB for SNMP Traps,” contains additional information on the 
EMC Smarts MIB implemented by EMC Corporation for SNMP Traps.


Configuring the SNMP Trap Notifier Adapter
The file, trap-notify.conf, configures this notifier. The original version of the file is located 
in BASEDIR/smarts/conf/notifier. You should retain the original (unedited) version of the 
configuration file. To modify the configuration file, use the sm_edit utility provided with 
your EMC Smarts software. This will ensure that you modify a copy of the file and that the 
copy is placed in the proper local subdirectory. “Editing notification adapter files” on 
page 20 contains additional information on modifying files and using sm_edit.


If you edit the configuration file while the notifier is running, restart the notifier so that it 
rereads its configuration file. 


SNMP Trap Notifier Adapter parameters


Before this notifier will work, you must set values for the destinations. The other 
parameters may remain unchanged. Table 10 on page 42 describes the parameters for the 
SNMP Trap Notifier Adapter. “Specifying subscriptions in the configuration file” on 
page 21 contains additional information on changing the subscriptions for this notifier. 


smEventName enterprises.733.2.1.5.0 Event name. (string)


smNotifInstanceID enterprises.733.2.1.6.0 Combination of class name and the 
instance name (as stored in the 
repository). Has the form <class 
name>::<instance name>. (string)


smNotifDescription enterprises.733.2.1.7.0 Description of the event. (string)


smNotifCertainty enterprises.733.2.1.8.0 Printed value of a floating point 
number that is the certainty of an 
event. (string)


smNotifSeverity enterprises.733.2.1.9.0 Severity of the event. (integer)


Table 9  Varbinds of the SNMP Traps (page 2 of 2)


Varbind name Varbind number Description
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Table 10  SNMP Trap Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the EMC Manager to connect to. 
The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier sends 
a notification. 
This parameter is used only if the notifier is subscribed to a 
Domain Manager. 
If the notifier is subscribed to a Global Manager, this parameter 
is not applicable and the value is 0 seconds.
The default is 0 seconds. 


minimumCertainty Threshold above which notifications are sent. Any notification 
with a certainty below the threshold is discarded. This value 
must be a number between 0.0 and 1.0. Service Assurance uses 
the value from the NotificationList definition.
The default is a certainty of 0.01. 


initialEventDelay Time interval the notifier should wait after it connects to the 
EMC Manager before accepting events. 
The default is 0 seconds.


Destinations Table of destinations for the SNMP traps. 
Each row consists of three different values: hostname or IP 
address, port number, and SNMP version. The values are 
separated by commas. Surround each row with curly braces. 
Each row is also separated from the next by a comma. Also, 
surround the complete set of rows with curly braces.
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The format for the destinations parameter is:


Destinations = { {"host_or_IP", port_number, "SNMP_Version"}
             }


You need to surround each single destination with a pair of curly braces and the entire set 
of destinations with another pair of curly braces. Even for a single destination, you must 
use both pairs of braces. For multiple destinations, separate each destination with a 
comma.


Surround the hostname or IP address with quotation marks.


Valid values for SNMP_Version are V1 and V2C. You must use uppercase letters and 
quotation marks.


An example of destinations:


Destinations = { {"localhost", 162, "V1"},
               {"other-host", 30162, "V2C"}
             }


If there are any mistakes in the configuration file, the notifier will generate error messages 
on startup and abort.


Appendix A, “Customizing a Notification Adapter,” contains additional information on 
customizing a notification adapter.
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This chapter contains the following information:
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Script Notifier Adapter overview
The Script Notifier Adapter allows you to automatically take an action when a notification 
is received. Upon receiving a notification, the Script Notifier Adapter invokes a custom 
script supplied by you that performs user-defined actions. For example, you can create a 
Script Notifier Adapter to send a page, using a paging service. Another Script Notifier 
Adapter might invoke an audible alarm when mission critical notifications are received.


Figure 4 on page 46 illustrates how the Script Notifier Adapter receives notifications and 
invokes a script.


Figure 4  Script Notifier Adapter


Configuring the Script Notifier Adapter
The configuration file, script-notify.conf, configures this notifier. The original version of the 
file is located in BASEDIR/smarts/conf/notifier. Retain the original (unedited) version of 
the configuration file. To modify a configuration file, use the sm_edit utility provided with 
your EMC Smarts software. This will ensure that you modify a copy of the file and the copy 
is placed in the proper local subdirectory. “Editing notification adapter files” on page 20 
contains additional information on modifying files and using sm_edit.


If you edit the configuration file while the notifier is running, restart the notifier so that it 
rereads its configuration file. 


For the Script Notifier Adapter to function, create a script to perform the desired action. 
Whenever the notifier receives a notification, it will call the script you created. Save your 
custom script in BASEDIR/smarts/local/actions. The Script Notifier Adapter arguments for 
your script are located in BASEDIR/smarts/local/rules/notifier/script/script-custom.asl.


You also need to change the scriptName parameter in the script-notify.conf file. To do this, 
delete the # character at the beginning of the line and replace the string “myScript” with 
the name of the custom script you want to run.


The script files must have appropriate read/execute permissions, and must return an exit 
status of 0 for success and non-zero for failure.


Notifications Arguments
Script Notifier Adapter ScriptGlobal Manager
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Script Notifier Adapter parameters


Table 11 on page 47 describes each parameter for the Script Notifier Adapter. “Specifying 
subscriptions in the configuration file” on page 21 contains additional information on 
changing the subscriptions for this notifier to receive different types of notifications. 
Appendix A, “Customizing a Notification Adapter,” contains additional information on 
customizing a notification adapter.  


Script Notifier Adapter compared with sm_adapter automated 
tools


EMC Smarts Service Assurance Manager also provides the sm_adapter command line 
option, which can automate a server tool (script). The following summarizes functional 
differences between an automated tool action and a Script Notifier Adapter action:


◆ Automated Service Assurance actions execute on the Global Manager by the user 
running the Global Manager (with all the security implications, and the overhead for 
the Global Manager process); Script Notifier Adapter actions run on any sm_notify 
adapter host (with all the connectivity implications), by any user. The EMC Smarts 
System Administration Guide contains additional information on security 
implications. 


◆ Parameters to automate Service Assurance actions are passed as environment 
variables, preconfigured (hard-coded) by EMC Corporation; parameters to Script 
Notifier Adapter actions are passed from the script-custom.asl, and are user 
configurable.


Table 11  Script Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the EMC Manager to connect to. 
The default is INCHARGE-SA.


scriptName Base name of the script to execute. The name cannot contain 
path separators. The custom script resides in 
BASEDIR/smarts/local/actions.


eventSmoothingInterval Time that an event must remain active before the notifier sends 
a notification. 
This parameter is used only if the notifier is subscribed to a 
Domain Manager. 
If the notifier is subscribed to a Global Manager, this parameter 
is not applicable and the value is 0 seconds.
The default is 0 seconds. 


minimumCertainty Threshold above which notifications are sent. Any notification 
with a certainty below the threshold is discarded. This value 
must be a number between 0.0 and 1.0. Service Assurance uses 
the value from the NotificationList definition.
The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the 
EMC Manager before accepting events. 
The default is 0 seconds.
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◆ Automated Service Assurance actions can return an output to the caller; Script Notifier 
Adapter actions can only return a status.


◆ Script Notifier Adapter actions are synchronous; by default, automated Service 
Assurance actions are synchronous as well, but you can use asynchronous actions if 
you make minor modifications to the auto-action.asl file.


◆ Script Notifier Adapter actions can be used with any EMC Smarts application, not just 
Service Assurance; meaning you can subscribe and trigger a Script Notifier Adapter 
action upon receipt of a notification from any EMC Smarts application.


The EMC Smarts Service Assurance Manager Configuration Guide contains additional 
information about automated tools.
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Notification Adapter Framework


This chapter contains the following information:


◆ ASL scripts overview ...............................................................................................  50
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ASL scripts overview
The notification adapter framework is comprised of five ASL scripts (rulesets) that control 
the operation of a notification adapter. Each notification adapter uses its own version of 
each ASL script. Each ASL script performs a specific function. The original versions of the 
ASL scripts are located in BASEDIR/smarts/rules/notifier/<adapter_name>, where 
<adapter_name> is the name of the notification adapter (for example, mail, file, trap, 
script, or tibrv). 


Typically, it is unnecessary to edit the ASL scripts. This is reserved for more advanced 
adapter customizations. However, if you want to customize an adapter, retain the original 
(unedited) version of the ASL scripts. To modify an ASL script, use the sm_edit utility 
provided with your EMC Smarts software. This will ensure that you modify a copy of the file 
and the copy is placed in the proper local subdirectory. “Editing notification adapter files” 
on page 20 contains additional information on modifying files and using sm_edit. 


If you edit the file while the notifier is running, restart the notifier so that it rereads its 
framework script file:


◆ Init <adapter_name>-init.asl


◆ Sync <adapter_name>-sync.asl


◆ Filter <adapter_name>-filter.asl


◆ Notify <adapter_name>-notify.asl


◆ Custom <adapter_name>-custom.asl


For example, the Log File Notifier Adapter's scripts are: file-init.asl, file-sync.asl, 
file-notify.asl, file-filter.asl, and file-custom.asl. 


Table 12 on page 50 contains descriptions for the ASL scripts associated with each of the 
notification adapters and indicates whether an ASL script is intended to be modified 
during the customization process. 


Table 12  Notification adapters scripts (page 1 of 2)


ASL script filename To be 
modified


Description


Init
<adapter_name>-init.asl 


No Invoked when the adapter starts and shuts 
down. Adapter-specific initialization and 
preshutdown tasks are included in this script.


Sync 
<adapter_name>-sync.asl 


No Invoked whenever the adapter connects or 
disconnects from a Domain Manager. This 
script is used for synchronization with the 
Domain Manager. 
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Appendix A, “Customizing a Notification Adapter,” contains additional information on 
customizing an adapter.


Filter 
<adapter_name>-filter.asl 


Yes This ASL script is the first to run during normal 
event processing. Its purpose is twofold:  
•  It can filter out events, terminating further 


processing. 
•  It may initiate customizations that will occur 


before main processing. 
Within this script, add the “sentByCustom = 
TRUE” flag in order to execute customizations. 


Notify 
<adapter_name>-notify.asl 


No This ASL script is responsible for processing 
notifications and contains most of the 
processing directions. It performs the defined 
actions such as sending traps or emails.


Custom 
<adapter_name>-custom.asl 


Yes This is the last ASL script invoked during 
normal event processing. Any customizations 
to be made belong in this ASL script. 


Table 12  Notification adapters scripts (page 2 of 2)


ASL script filename To be 
modified


Description
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CHAPTER 8
Attributes 


This chapter contains the following information:


◆ Overview of current event object attributes .............................................................  54
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Overview of current event object attributes
Notification adapters receive events from Domain Managers or notifications from Global 
Managers. The information from the event or notification is available in the Notification 
Adapter in a current event object. The attributes of this object describe the properties of 
the notification or event such as the time the event occurred, the name of the object where 
the event occurred, the type of event, and additional information.


The filter, notify, and custom scripts, described in Chapter 7, “Notification Adapter 
Framework,” utilize the current event object to access the attributes of an event or 
notification. In these scripts, the variable currentEvent represents the current event 
object. For example, the following code may be used to access the instance display name 
from a notification:


x = currentEvent->icInstanceDisplayName;


Current event object attributes for events from Domain Managers


Table 13 on page 54 describes the attributes contained in current event objects in the 
Notification Adapter generated by a Domain Manager. When customizing the notification 
adapters, use these attributes to retrieve the specific information you require regarding 
each event. 


All attributes for timestamps represent units of time in seconds. The attribute’s value is 
the number of seconds since January 31, 1970 (Greenwich Mean Time, GMT). 


Table 13  Current event object attributes for events from Domain Managers  (page 1 of 3)


Notification attribute Type Description


icCertainty Float Confidence that this notification is the correct 
diagnosis.  Value ranges from 0 to 100.


icClass String The class of the object triggering the event.


icClassDisplayName String The display class name of the object that 
triggered the event.


icDisplayName String The display name of the object triggering the 
event.


icDisplayType String Display string of the notification type that 
abstracts the difference between the 
notifications from the Global Manager and the 
events from the Domain Manager (for example, 
NOTIFY, CLEAR, and TIMER_ALARM). 


Notice: The icType field contains the detailed 
type information.


icEventDescription String The event description.


icEventDisplayName String The event name, which has the same value as 
icEvent.
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icEvent String The event name. 


Notice: The attribute icEventName is also 
available for backward compatibility and has 
the same value as icEvent.


icEventType String The event type. The valid types are:
• PROBLEM 
• SYMPTOM
• EVENT
• AGGREGATION


icId String A unique identification for this event. 
As previously received notifications are cleared 
(CLEAR), or changed (CERTAINTY_CHANGE), 
these new messages have the same ID as the 
original event (NOTIFY). 
Customizations to the ASL scripts that need to 
match such messages should use this attribute.


icInstance String The instance name of the object triggering the 
event.


icInstanceDisplayName String Name of the instance that is displayed to the 
user. 


icIsRoot Boolean TRUE if the notification is a root cause, FALSE if 
not. 


icServerName String The name of the Domain Manager that notified 
the event. 


icSystemDescription String Description of the system specified in the 
icSystemName field.


icSystemName String The display name of the computer system most 
closely associated with the event. In cases 
where there is no relevant system, the 
attribute’s value will be an empty string.


Table 13  Current event object attributes for events from Domain Managers  (page 2 of 3)


Notification attribute Type Description
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Current event object attributes for notifications from Global Managers


Table 14 on page 56 describes the attributes contained in current event objects in the 
Notification Adapter generated by the Service Assurance Global Manager. When 
customizing the notification adapters, combine these attributes to include the specific 
information you require regarding each notification. 


All attributes for timestamps represent units of time in seconds. The attribute’s value is 
the number of seconds since January 31, 1970 (Greenwich Mean Time, GMT).


icSystemType String Type of the system specified in icSystemName 
field.
The attribute’s value may be an empty string, 
the DisplayClassName of the system’s class, or 
one of the following: 
• HOST
• ROUTER
• SWITCH
• HUB
• SERVER
• BRIDGE
• REPEATER
• PROBE
• OTHER
• TERMINALSERVER


icTimestamp Integer The time when the Domain Manager notifies a 
client about an event, clears an event, or 
changes the certainty of an event.


icType String Notification Type. The valid types are: 
• NOTIFY
• CERTAINTY_CHANGE
• CLEAR


Table 13  Current event object attributes for events from Domain Managers  (page 3 of 3)


Notification attribute Type Description


Table 14  Current event object attributes for events from the Global Manager (page 1 of 4)


Notification attribute Type Description


icAcknowledged Boolean TRUE if the notification is acknowledged, FALSE 
if not.


icActive Boolean TRUE if the event is active, FALSE if not.


icCategory String Type of notification sent by the Global Manager. 
For example:
• Availability
• Discovery
• Error
• Operational
• Performance
• PowerSupply
• Resource
• Temperature
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icCertainty Float Confidence that this notification is the correct 
diagnosis.  Value ranges from 0 to 100.


icClass String Class of the object triggering the event.


icClassDisplayName String The display class name of the object triggering 
the event.


icDisplayName String Display name for the instance that triggered this 
event. This value is the same as 
icInstanceDisplayName.


icDisplayType String Display string of the notification type that 
abstracts the difference between the 
notifications from the Global Manager and the 
events from the Domain Manager (for example, 
NOTIFY, CLEAR, and TIMER_ALARM). 


Notice: The icType field contains the detailed 
type information.


icElementClassName String Class name of the managed element most 
closely related to this event. The attribute’s 
value may be an empty string.


icElementName String Name of the managed element most closely 
related to this event. The attribute’s value may 
be an empty string.


icEvent String Event name such as DOWN or NOT RESPONDING. 


icEventDescription String Description of the event.


icEventDisplayName String The event name. This has the same value as 
icEvent.


icEventType String The event type. The valid event types are: 
• MOMENTARY 
• DURABLE


icFirstNotifiedAt Integer Timestamp of the first notification. 


icId String A unique identification for this notification. 
As previously-received notifications are cleared 
(NL_CLEAR), these new messages have the 
same ID as the original notification (NL_NOTIFY). 
Customizations to the ASL scripts that need to 
match such messages should use this attribute.


icImpact Integer Numeric value that indicates the effect of this 
event on related elements.


icInMaintenance Boolean TRUE if the device is in maintenance mode, 
FALSE if not.


icInstance String Instance name of the object that triggered the 
event.


icInstanceDisplayName String Display name for the instance triggering this 
event. This value is the same as icDisplayName.


Table 14  Current event object attributes for events from the Global Manager (page 2 of 4)


Notification attribute Type Description
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icIsRoot Boolean TRUE if the notification is a root cause; FALSE if 
not.


icIsProblem Boolean Yes indicates if (and only if) at least one of the 
source event types is “PROBLEM”, and other 
source event types are either “PROBLEM” or 
“UNKNOWN.”
No indicates that one or more of the source 
event types is “EVENT” or “AGGREGATE.”
Since filtering on IsRoot can result in transient 
behavior when events are received from 
multiple underlying sources, it is recommended 
to filter on IsProblem instead.


icLastChangedAt Integer Timestamp, in seconds, when the notification 
was last changed. 


icLastClearedAt Integer Timestamp, in seconds, when the notification 
was last cleared.


icLastNotifiedAt Integer Timestamp when the Global Manager was last 
notified of the occurrence of this notification.


icNLObjectName String The object name of the notification list that 
generated this notification.


icNotificationName String Name of the notification object. It can be used to 
retrieve additional information about the 
notification not sent to the adapter by default.


icOccurrenceCount Integer Number of times the notification occurred.


icOwner String Name of the person responsible for this 
notification. Value is SYSTEM when 
acknowledged by the Global Manager.


icServerName String Name of the EMC Manager to whom the adapter 
listens. 


icSeverity Integer Level of severity for the notification: 
1 = CRITICAL 
2 = MAJOR
3 = MINOR 
4 = UNKNOWN 
5 = NORMAL


Notice: Only the numbers, not the text 
descriptions are contained in this attribute. 


icSourceDomainName String A comma-separated list of sources for this 
notification.
These are names of the underlying notifying 
sources. There may be more than one in case 
underlying sources have an overlapping 
topology. 


Table 14  Current event object attributes for events from the Global Manager (page 3 of 4)


Notification attribute Type Description
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icSourceEventType String Indicates the type of event from an underlying 
source or sources. Value can be: PROBLEM, 
EVENT, AGGREGATE, or UNKNOWN. The default 
value is UNKNOWN. (Not to be confused with 
Event Type.)


icSystemDescription String Description of the system specified in the 
icSystemName field.


icSystemName String The display name of the computer system most 
closely associated with the event. In cases 
where there is no relevant system, the 
attribute’s value will be an empty string.


icSystemType String Type of the system specified in icSystemName 
field.
The attribute’s value may be an empty string, 
the DisplayClassName of the system’s class, or 
one of the system’s class such as HOST, 
ROUTER, or SWITCH.


icTimestamp Integer The time when the Global Manager notifies a 
client that a change occurred for the notification.
For the Global Manager, note that the following 
attributes are typically used instead of 
icTimestamp: icFirstNotifiedAt, 
icLastChangedAt, icLastClearedAt, and 
icLastNotifiedAt.


icTroubleTicketId String Trouble ticket ID.


icType String Notification Type. The valid types are:  
• NL_NOTIFY 
• NL_CHANGE 
• NL_CLEAR 
• NL_DELETE 
• TIMER_ALARM


Notice: Now the notification adapters do not 
send notifications for NL_CHANGE or NL_DELETE 
event types. You cannot use an adapter to 
inform another application about notification 
changes or deletions.


icUserDefined1-10 String Ten user-defined fields. Reserved for custom 
configuration.


Table 14  Current event object attributes for events from the Global Manager (page 4 of 4)


Notification attribute Type Description
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APPENDIX A
Customizing a Notification Adapter


This appendix describes how to customize a notification adapter and contains the 
following information:


◆ Customization overview ..........................................................................................  62


The tasks are essentially the same for all the notification adapters. Specific adapter 
parameters are described in previous chapters.


It also provides an example procedure for customizing the Email Notifier Adapter to 
display specific Service Assurance notification information. 
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Customization overview
To customize a notification adapter:


1. Stop the notification adapter if it is running


2. Modify the Filter script.


3. Modify the Custom script.


4. Modify the configuration file.


5. Start the notification adapter.


Modifying local copies of files


Original versions of the ASL and configuration files for adapters should not be changed:


◆ The original versions of the ASL scripts are located in 
BASEDIR/smarts/rules/notifier/<adapter_name>, where <adapter_name> is the name 
of the notification adapter (for example, mail, file, trap, script, or tibrv).


◆ The original versions of the adapter configuration files are installed to the 
BASEDIR/smarts/conf/notifier directory.


Use the sm_edit utility to edit the configuration and rules files to ensure that the original 
versions are retained and that modified files are saved to the proper local directory. 
“Editing notification adapter files” on page 20 provides additional information on using 
sm_edit.


Stopping the notification adapter


If you are currently running a notification adapter, stop it before making any 
customizations. “Stopping a notification adapter” on page 25 and “Starting and stopping 
notification adapters” on page 23 contains detailed instructions.


Modifying the filter script


The filter script, <adapter_name>-filter.asl, filters network events from being processed any 
further as notifications and also contains some instructions for processing notifications 
that will utilize the notification adapter. Add a variable, sentByCustom, which invokes the 
script running the customization actions you want from the custom script, 
<adapter_name>-custom.asl. 
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To modify the filter script:


1. Using sm_edit, open the filter script. 


2. Add the following line for the sentByCustom variable to the end of the script (as shown 
in bold type):


...
START() {
/* 
 * Filter cleared events.
 */
OMIT_CLEAR_EVENTS()


do { 
if (currentEvent->icType == "CLEAR"
 || currentEvent->icType == "NL_CLEAR" )
{ currentEvent->filterMe = TRUE;


currentEvent->sentByCustom = TRUE;
}
}


}


3. Save the modified script. The sm_edit utility automatically saves the script to the 
appropriate local directory, located in BASEDIR/smarts/local/rules/notifier. 


Email Notifier Adapter example: Modifying the mail-filter.asl script
To customize an Email Notifier Adapter, add the sentByCustom variable to the 
mail-filter.asl script. In addition, you need to modify the filter script to send emails when a 
notification is cleared:


1. Using sm_edit, open the mail-filter.asl script. Open the file using the following 
command: 


▼ BASEDIR/smarts/bin>sm_edit rules/notifier/mail/
mail-filter.asl ▲


▼ ▲ indicates that the command must be typed on one line.


2. Add the following line for the sentByCustom variable to the end of the script (as shown 
below in bold type).


By default, when a network problem is resolved and a CLEAR notification is received, 
an email is not sent to the administrators involved in the repair. Within the 
mail-filter.asl script, you can use the filterMe variable to indicate whether or not you 
want an email to be delivered when a notification is cleared (when the problem is 
resolved). 


To have emails sent on CLEAR notifications, change the filterMe = TRUE Boolean value 
to FALSE (as shown in bold type):


...
START() {
/* 
 * Filter cleared events.
 */
OMIT_CLEAR_EVENTS() filter { 
    (currentEvent->icType == "CLEAR" || currentEvent->icType 
     == "NL_CLEAR")
} do {
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    currentEvent->filterMe = FALSE;
currentEvent->sentByCustom = TRUE;
}


}


3. Save the modified script. The sm_edit utility automatically saves the script to the 
BASEDIR/smarts/local/rules/notifier/mail directory. 


Modifying the custom script


The custom script, <adapter_name>-custom.asl, contains the details of the script. 
Modifying the custom script allows you to specify which combination of notification 
attributes will be included in the adapter’s output (for example, an email, information sent 
to a file or custom script, and SNMP traps messages).


“Attributes” on page 53 contains a list of attributes and their descriptions.


To modify the custom script:


1. Using sm_edit, open the custom script. 


2. Add or comment out the attributes.


3. Save the modified script. The sm_edit utility automatically saves the script to the 
appropriate local directory, located in BASEDIR/smarts/local/rules/notifier. 


Email Notifier Adapter example: Modifying the mail-custom.asl script
For an Email Notifier Adapter, the mail-custom.asl script contains the details of the script. 
Modifying the mail-custom.asl script allows you to specify which combination of 
notification attributes will be included in the email. 


To modify the mail-custom.asl script:


1. Using sm_edit, open the mail-custom.asl script. For example: 


▼ BASEDIR/smarts/bin>sm_edit rules/notifier/mail/mail-custom.asl ▲


▼ ▲ indicates that the command must be typed on one line.


“Example: mail-custom.asl file” on page 73 contains an original version of the 
mail-custom.asl script.


2. Add the notification attributes for the subject and body of the email message you want 
generated for the notification.


For example, if you want to add the timestamp attribute to the subject and the event 
type attribute to the body of the email message, edit mail-custom.asl as follows (the 
bold attributes indicate the modifications):


START() {
    local subject = "";
    local body = "";
} filter {
    /*
     * Only send here if sentByCustom is TRUE.
     */
    (currentEvent->sentByCustom)
} do {
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subject = currentEvent->icTimestamp." ". 
currentEvent->icDisplayType." ".
currentEvent->icInstanceDisplayName." ".
currentEvent->icEventDisplayName;
    body = ("  InCharge Server " . serverName . ":\n " .
            currentEvent->icDisplayType . " " .
            currentEvent->icClassDisplayName . " " . 
            currentEvent->icInstanceDisplayName . " ".
currentEvent->icEventType . " ".
currentEvent->icEventDisplayName .
" (" . string(currentEvent->icCertainty) . "%):\n " .
            currentEvent->icEventDescription . "\n");
    mailer->sendmail(sender, recipients, subject, body) ? LOG,STOP;
}


3. Save the modified script. The sm_edit utility automatically saves the script to the 
BASEDIR/smarts/local/rules/notifier/mail directory.  


Modifying the configuration file


When you start and run a notification adapter, it reads a configuration file, 
<adapter_name>-notify.conf. Use the following procedure to modify the configuration file 
to run your customizations.


If you are developing multiple customized notification adapters with different 
subscriptions, you need a configuration file for each adapter. For each notification list (in 
Service Assurance) or event subscriptions (in Availability Manager) you subscribe to, 
create an individual configuration file:


Whenever you modify a configuration file, stop and restart the notifier for the changes to 
take effect.


1. Using the sm_edit utility, open the configuration file:


▼BASEDIR/smarts/bin>./sm_edit 
conf/notifier/<adapter_name>-notify.conf▲


▼ ▲ indicates that the command must be typed on one line.


If you are developing multiple customized notification adapters, rename the 
configuration file. The sm_edit utility automatically saves this file to the 
BASEDIR/smarts/local/conf/notifier directory.


2. Add the following lines to specify the ASL scripts that contain your customizations. 
The lines should be added to the end of the file below the initialEventDelay parameter:


filterRuleSet = "notifier/mail/mail-filter.asl"
customRuleSet ="notifier/mail/mail-custom.asl" 


3. Modify the SubscribesTo parameter if necessary.
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By default, the notifiers subscribe to a Global Manager. To subscribe to a Domain 
Manager, you must uncomment the code in the Subscriptions section and comment 
out the code for the Global Manager (insert a # character at the beginning of the lines 
that are not needed). “Specifying subscriptions in the configuration file” on page 21 
contains additional information.


4. Modify other adapter parameters as desired. 


For information about parameters and their acceptable values, see the chapter for the 
individual notification adapter.


5. Save the modified configuration file. The sm_edit utility automatically saves the file to 
the BASEDIR/smarts/local/conf/notifier directory. 


Email Notifier Adapter example: Modifying the mail-notify.conf file
For an Email Notifier Adapter, the configuration file is mail-notify.conf:


Whenever you modify a configuration file, you need to stop and restart the notifier for the 
changes to take effect.


1. Using the sm_edit utility, open the configuration file:


BASEDIR/smarts/bin>./sm_edit conf/notifier/mail-notify.conf


2. If you are developing multiple customized notification adapters, rename the 
configuration file, giving the file a relevant name (for example, if you are going to 
customize the Email Notifier Adapter to send emails for all problems related to 
Routers, you could name the file mail-notify-Router.conf). The sm_edit utility 
automatically saves this file to the BASEDIR/smarts/local/conf/notifier directory.


3. Modify the file to change the name of the Domain Manager or Global Manager:


serverName = <YOUR_INCHARGE_MANAGER>


4. Define the hostname of the appropriate mail server:


MailServer = "localhost"


5. Define the recipients for the notification email. Multiple email addresses should be 
separated by a comma:


Recipients = "root@localhost,recipient@your_company.com"


6. Define the email address of the sender. This address will display in the From field of 
the email message:


SenderId = "daemon@localhost"


If there is a comment character (#) beside any of the parameters you just defined 
(such as MailServer, Recipients, serverName, or SenderID), remove the comment 
character to activate the parameter.
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7. Add the following lines to specify the ASL scripts that contain your customizations. 
The lines should be added to the end of the file below the initialEventDelay parameter:


filterRuleSet = "notifier/mail/mail-filter.asl"
customRuleSet ="notifier/mail/mail-custom.asl" 


8. Modify the SubscribesTo parameter to define the specific notifications for which you 
want email alerts sent.


For a Global Manager, you indicate which notifications generate 
emails by defining a notification list in the Subscriptions section:


SubscribesTo = 
         {
              #
              # NL subscription.
              #
              GA_NLSubscription::mail-Default-Subscriptions
              {
                       NLName = "Default"
              }
         }


9. Save the modified configuration file. The sm_edit utility automatically saves the file to 
the BASEDIR/smarts/local/conf/notifier directory. 


Appendix B, “Example Files,” contains complete samples of the configuration file.


Starting the customized notification adapter


After creating configuration files and ASL scripts for each of the notification adapters you 
want to run, start each adapter. “Using sm_notify to start notification adapters” on 
page 23 and “Starting and stopping notification adapters” on page 23 contain detailed 
instructions.


Email Notifier Adapter example: Start the adapter with the sm_notify command
The Email Notifier Adapter is started manually using the sm_notify command or the 
sm_service start command. For a customized Email Notifier Adapter, you must also 
specify the location and name of the configuration file that contains the customization 
information. 


The syntax to start a customized Email Notifier Adapter using the sm_notify command is:


▼BASEDIR/smarts/bin/sm_notify --output --confdir=<DIRECTORY> 
--conf=<CONF_FILE_NAME> mail▲


▼ ▲ indicates the command must be typed as one line.


The parameters --conf and --confdir are used with the sm_notify command to override the 
default configuration files for each adapter. Table 4 on page 24 describes these 
parameters. 
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If you have renamed your configuration files, but have kept them in default 
BASEDIR/smarts/local/conf/notifier directory, use the --conf startup parameter. If your 
configuration files retain the default names, but are in a new location, use the --confdir 
startup parameter. 


# BASEDIR/smarts/bin/sm_notify --output 
--confdir=BASEDIR/smarts/Custom/mail/conf 
--conf=mail-notify-Router.conf mail


▼ ▲ indicates the command must be typed as one line.


Email Notifier Adapter example: Start the adapter as a service
To start a customized adapter as a service, use the sm_service start command. “Starting 
and stopping a service” on page 27 contains additional information.


# BASEDIR/smarts/bin>./sm_service start mail


The sm_notify parameters --conf and --confdir are specified with the sm_service install 
command.


Running multiple copies of a notification adapter


You may have developed more than one customized notification adapter (for example, 
more than one Email Notifier Adapter especially if you want to send emails based on 
different notification subscriptions). Since you created separate configuration files for 
each adapter, you must specify the location and filename of the configuration file at 
startup. 


The adapters should be started individually by specifying the appropriate configuration 
file for that adapter. To do this, use the --confdir or --conf parameters.
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Overview
This appendix provides examples of the files used in the customization procedure 
described in Appendix A, “Customizing a Notification Adapter”:


◆ A sample configuration file (mail-notify.conf) for the Email Notifier Adapter for 
EMC Smarts IP Availability Manager.


◆ A sample configuration file (mail-notify.conf) for the Email Notifier Adapter for a Global 
Manager.


◆ An original version of an ASL file (mail-custom.asl) for the Email Notifier Adapter for 
both EMC Smarts IP Availability Manager and EMC Smarts Service Assurance Manager 
(Global Manager). Chapter 7, “Notification Adapter Framework,” contains a 
description of ASL files.


Example: mail-notify.conf file for an EMC Smarts IP Availability 
Manager


The following is a sample configuration file (mail-notify.conf) for the Email Notifier Adapter 
for EMC Smarts IP Availability Manager:


# mail-notify.conf - Configuration for the mail notification # adapter
#
# Copyright (C) 1999-2011 EMC Corporation
# All Rights Reserved
#
# $Id: mail-notify.conf,v 1.4 2000/08/22 13:16:51 boaz Exp $
#


GNA_Notifier::mail-Notifier
{
    #
    # Name of the InCharge Server from which to receive 
    # notifications.
    #
    serverName = "INCHARGE-AM"


    ConfiguredBy = MailConfiguration::Mail-Configuration
    {
         #
         # Name of mail server host.
         #
         MailServer = "localhost"


         #
         # Sender identity.  
         # Must be a valid email address, recognized by the 
         # mail server.
         #


 SenderId = "daemon@localhost"


 #
         # Comma-separated list of users to whom notifications 
         # should be sent to.
         #
         Recipients = "root@localhost"
    }
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    ReadsInputFrom = GA_SubscriberFE::mail-Subscriber-
    FrontEnd
    {
         #
         # How long, in seconds, an event must remain active 
         # before the adapter sends a notification.
         #
         eventSmoothingInterval = 0


         #
         # Notification threshold; discard notifications with 
         # a certainty below this value, which should be 
         # between 0.0 and 
         # 1.0.
         #
         minimumCertainty = 0.01


         #
         # Subscriptions.
         #
         SubscribesTo = 
         {
              #
              # Choice subscription.
              #
              GA_ChoiceSubscription::mail-All-Subscriptions
              {
                       className = ".*"
                    instanceName = ".*"
                       eventName = ".*"
                        problems = TRUE
                      aggregates = FALSE
                        symptoms = FALSE
              }


#              #
#              # Profile subscription.
#              #
#              GA_ProfileSubscription::file-Default-Profile-


Subscriptions
#              {
#                   profileName = "default"
#              }
         }
    }


    #
    # How long, in seconds, to ignore notifications from the 
    # server after it connects.  Use this parameter to avoid 
    # receiving the initial flood of notifications when the 
    # server (re)connects.
    #
    initialEventDelay = 0
   
    filterRuleSet = "$Basedir/smarts/Custom/mail/rules/mail-
    filter.asl"
    
    customRuleSet = "$Basedir/smarts/Custom/mail/rules/mail-
    custom.asl"


}
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Example: mail-notify.conf file for a Global Manager
The following is a sample configuration file (mail-notify.conf) for the Email Notifier Adapter 
for EMC Smarts Service Assurance Manager:


# mail-notify.conf - Configuration for the mail notification 
# adapter
#
# Copyright (C) 1999-2011 EMC Corporation
# All Rights Reserved
#
# $Id: mail-notify.conf,v 1.4.8.1 2001/06/13 14:42:01 boaz 
# Exp $
#


GNA_Notifier::mail-Notifier
{
    #
    # Name of the InCharge Server from which to receive 
    # notifications.
    #
    serverName = "INCHARGE-SA"


    ConfiguredBy = MailConfiguration::Mail-Configuration
    {
         #
         # Name of mail server host.
         #
         MailServer = "localhost"


         #
         # Sender identity.  
         # Must be a valid email address, 


 # recognized by the mail server.
         #
         SenderId = "daemon@localhost"


         #
         # Comma-separated list of users to whom notifications 
         # should be sent to.
         #
         Recipients = "root@localhost"
    }


ReadsInputFrom = GA_SubscriberFE::mail-Subscriber-FrontEnd
    {
         #
         # How long, in seconds, an event must remain active 
         # before the adapter sends a notification.
         #
         eventSmoothingInterval = 0


         #
         # Notification threshold; discard notifications with 
         # a certainty below this value, which should be 
         # between 0.0 and 1.0.
         #
         minimumCertainty = 0.01


         #
         # Subscriptions.
         #
         SubscribesTo = 
         {
              #
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              # NL subscription.
              #
              GA_NLSubscription::mail-Default-Subscriptions
              {
                       NLName = "Default"
              }


         }
    }


    #
    # How long, in seconds, to ignore notifications from the 
    # server after it connects.  Use this parameter to avoid 
    # receiving the initial flood of notifications when the 
    # server (re)connects.
    #
    initialEventDelay = 0


    filterRuleSet = "notifier/mail/mail-filter.asl"
    
    customRuleSet = "notifier/mail/mail-custom.asl"


}


Example: mail-custom.asl file
The following is an original version of the mail-custom.asl file for the Email Notifier 
Adapter for both EMC Smarts IP Availability Manager and EMC Smarts Service Assurance 
Manager:


/* mail-custom.asl - Custom script for the mail notification adapter.
 *
 * Copyright (C) 1999-2011, EMC Corporation
 * All Rights Reserved
 *
 * RCS $Id:mail-custom.asl,v 1.6 2002/01/30 23:27:26 boaz Exp $
 */
/** No word delimiter needed.*/
delim = "";


/*
 * Required variables.*/


default debug = FALSE;
default test = FALSE;


default NotifierName = "<error>";
notifier = self->object("GNA_Notifier", NotifierName) ? LOG,STOP;


currentEvent = notifier->CurrentEvent ? LOG,STOP;


mailer = self->object("ACT_Mail", "ACT-Mail") ? LOG,STOP;
mailer->test = test;
mailer->trace = debug;


serverName = notifier->serverName;


/** User-provided parameters.*/


sender = notifier->ConfiguredBy->SenderId;
recipients = notifier->ConfiguredBy->Recipients;


/*
 * Rules.
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 */


START() {
    local subject = "";
    local body = "";
} filter {
    /*
     * Only send here if sentByCustom is TRUE.
     */
    (currentEvent->sentByCustom)
} do {


    /*
     * This is how the adapter constructs the default message.  
     * Edit to suit your tastes.
     */
    subject = currentEvent->icDisplayType." ".
              currentEvent->icInstanceDisplayName." ".
              currentEvent->icEventDisplayName;
    body = ("  InCharge Server " . serverName . ":\n " .
            currentEvent->icDisplayType . " " .
            currentEvent->icClassDisplayName . " " . 
            currentEvent->icInstanceDisplayName . " ".
            currentEvent->icEventDisplayName .
            " (" . string(currentEvent->icCertainty) . "%):\n " .
            currentEvent->icEventDescription . "\n");
    mailer->sendmail(sender, recipients, subject, body) ? LOG,STOP;
}


/*
 * Local Variables:
 * mode: C++
 * End:
 */

74 EMC Smarts Service Assurance Manager Notification Adapters User Guide







APPENDIX C
Troubleshooting Adapters


This appendix contains the following information:


◆ Overview.................................................................................................................  76
◆ Notification adapter issues .....................................................................................  77

Troubleshooting Adapters 75







Troubleshooting Adapters

Overview
This appendix contains resolutions to common issues experienced by adapter users 
involving notification adapters.


Each section begins by addressing general issues. For example, the first issue describes 
what to check if this type of adapter fails to start. Subsequent sections address issues 
specific to a particular adapter. For each issue there may be more than one suggested 
action to follow.


Table 15 on page 76 includes the complete list of common issues and their solutions 
covered in this appendix, organized by adapter. 


Table 15  Issues covered in this appendix


Issues Solution 


Email Notifier Adapter


Does not start. “Notification adapter fails to start” on page 77


Does not connect to InChange Manager. “Notification adapter starts, but fails to 
connect to the EMC Manager” on page 78


No email is received. “Email not received” on page 79


Only some email is received. “Email received, but not for all events” on 
page 79


Log File Notifier Adapter


Does not start. “Notification adapter fails to start” on page 77


Does not connect to EMC Manager. “Notification adapter starts, but fails to 
connect to the EMC Manager” on page 78


Notification file is not created or updated. “Notification file not created” on page 80


Notification file does not include all events. “Information in the notification file does not 
include all events” on page 80


SNMP Trap Notifier Adapter


Does not start. “Notification adapter fails to start” on page 77


Does not connect to EMC Manager. “Notification adapter starts, but fails to 
connect to the EMC Manager” on page 78


Destinations do not receive any traps. “No traps delivered to destination” on page 81


Destinations receive only some traps. “Not all traps delivered to destination” on 
page 81


Script Notifier Adapter


Does not start. “Notification adapter fails to start” on page 77


Does not connect to EMC Manager. “Notification adapter starts, but fails to 
connect to the EMC Manager” on page 78


Script is not invoked. “Script is not invoked for Script Notifier 
Adapter” on page 81
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Notification adapter issues
The issues covered here apply to the:


◆ Email Notifier Adapters


◆ Log File Notifier Adapters


◆ SNMP Trap Notifier Adapters


◆ Script Notifier Adapters


Notification adapter fails to start


Applies to the Email Notifier Adapter, the Log File Notifier Adapter, the SNMP Trap Notifier 
Adapter, and the Script Notifier Adapter.


When a notification adapter appears not to start, check the status of its process or service. 


For an adapter started with the sm_notify command
For Windows, check the Task Manager for the sm_notify process.


For an adapter started as a service
For Windows, to check the status of a service, use the Service control panel:


1. Click Start. 


2. Select Settings > Control Panel > Administrative Tools > Services.
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Notification adapter starts, but fails to connect to the EMC Manager


Applies to the Email Notifier Adapter, the Log File Notifier Adapter, the SNMP Trap Notifier 
Adapter, and the Script Notifier Adapter.


When an adapter cannot connect to an EMC Manager, it is usually for one of the following 
reasons:


◆ EMC Manager is not running.


◆ Name of the EMC Manager is not the same as the name specified in the adapter’s 
configuration file.


◆ EMC Manager cannot be reached from the host running the adapter.


Check the status of the EMC Manager
Use the brcontrol command to check the status of the EMC Manager. The syntax is:


BASEDIR/smarts/bin/brcontrol


By default, this command returns a list of EMC Managers registered with the broker and 
their current state. The list indicates whether an EMC Manager’s state is RUNNING or 
DEAD.


If the EMC Manager is not running or included in the list, restart the EMC Manager. 


Check the name of the EMC Manager in the configuration file
The configuration file of each adapter contains the name of the EMC Manager to which it 
connects. This value in the configuration file can be overridden by using the --server 
option with the sm_notify command. 


In cases where an adapter cannot connect, check that the --server option, if used, points 
to a valid EMC Manager. If that is not the issue, check that the appropriate EMC Manager is 
specified in the adapter’s configuration file. Table 16 on page 78 lists the configuration 
file and parameter to check for each adapter.


Check communication to the EMC Manager’s host
If the adapter and the EMC Manager run on different hosts, the adapter’s host might not 
be able to communicate with the EMC Manager’s host. From the adapter’s host, run the 
following command:


dmctl --server=<InCharge_Manager> ping


Table 16  Adapters and EMC Manager parameters


Adapter Location and name (relative 
to BASEDIR/smarts/conf) EMC Manager parameter


Email Notifier Adapter /notifier/mail-notify.conf serverName


Log File Notifier Adapter /notifier/file-notify.conf serverName


SNMP Trap Notifier Adapter /notifier/trap-notify.conf serverName


Script Notifier Adapter /notifier/script-notify.conf serverName
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The results of this command show whether the EMC Manager is alive or unavailable.


Email not received


Applies to the Email Notifier Adapter.


When the Email Notifier Adapter starts and connects to the Domain Manager and the 
intended recipient receives no email, the issue is usually an incorrect configuration. The 
configuration file for the Email Notifier Adapter is mail-notify.conf. This file resides in the 
BASEDIR/smarts/notifier directory. 


There are three parameters that specify where the Email Notifier Adapter delivers 
information. Table 17 on page 79lists these parameters.


Check the parameters in the configuration file and verify them with your email 
administrator. All three must have a valid value for the Email Notifier Adapter to work. For 
the changes to the configuration file to take effect, the adapter must be restarted.


Email received, but not for all events


Applies to the Email Notifier Adapter.


If the Email Notifier Adapter does not seem to be sending messages for all of the correct 
events, it could be that the subscription profile is incorrect or that you expect the adapter 
to be sending messages when notifications clear.


Modify the subscription profile
When the Email Notifier Adapter sends email, but does not send them for all expected 
events, the issue usually is improper subscriptions. “Specifying subscriptions in the 
configuration file” on page 21 contains instructions on modifying the subscription profile 
for this adapter.


Table 17  Parameters needed to receive email


Parameter Description


MailServer Name for the mail server. For example:
MailServer = "localhost"


SenderId Email address associated with the adapter. Users can reply to this 
address. This address must be recognized by the mail server. For 
example:
SenderId = "daemon@localhost"


Recipients A comma-separated list of the recipients of the emails. The 
recipients in the list must be recognized by the mail server. For 
example:
Recipients = "root@localhost,recipient@your_company.com"
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Change the Email Notifier Adapter to send notifications of cleared events
By default, the Email Notifier Adapter does not send messages when a notification clears. 
It only sends messages for new notifications or when the certainty of the notification 
changes. 


To enable the Email Notifier Adapter to send CLEAR notifications, change the following in 
the file, BASEDIR/rules/notifier/mail/mail-filter.asl:


START () {
     OMIT_CLEAR_EVENTS
}


to 


START () {
//   OMIT_CLEAR_EVENTS
}


After making changes to the file, restart the adapter for the changes to take effect.


Notification file not created


Applies to the Log File Notifier Adapter.


When the Log File Notifier Adapter starts and connects to the EMC Manager, but it does 
not appear to create the notification file, check to ensure the filename is the one you 
expect. The Log File Notifier Adapter’s configuration file, file-notify.conf, contains the 
name of the notification file. The file-notify.conf file resides in the 
BASEDIR/smarts/conf/notifier directory. The parameter, fileName, defines the name of 
the notification file that the adapter creates for its output. The adapter always creates the 
notification file in the BASEDIR/smarts/local/logs directory. If you do not specify a value, 
the adapter creates a default file named <InCharge_Manager>-alarms.log.


Do not confuse this adapter’s output file with its log file. The log file also appears in the 
BASEDIR/smarts/local/logs directory. You determine the log file’s name when the adapter 
starts using the --output command option. The default name of the log file is 
sm_notify.log.


Never use the same name for both the notification file and the Log File Notifier Adapter’s 
log file.


Information in the notification file does not include all events


Applies to the Log File Notifier Adapter.


When the Log File Notifier Adapter sends information to the notification file, but does not 
send it for all of the correct events, the issue usually is improper subscriptions. 
“Specifying subscriptions in the configuration file” on page 21 contains instructions on 
modifying the subscription profile for this adapter.
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No traps delivered to destination


Applies to the SNMP Trap Notifier Adapter.


When the SNMP Trap Notifier Adapter starts and connects to the EMC Manager and does 
not send the SNMP Traps, the issue is usually the format of the parameter Destinations. 


The parameter, Destinations, is a table that contains the SNMP trap destinations. Each row 
in the table is surrounded by curly braces and consists of three different values: hostname 
or IP address, port number, and SNMP version. The values are separated by commas. 
There are two valid values for SNMP version: V1 and V2C. These values and the values for 
host name or IP address must be surrounded by quotation marks. The port number is an 
integer value with no quotation marks.


Each row in the table is separated from the next by a comma. Place a comma after the curly 
brace that marks the end of each row in the table except for the last. An outer set of curly 
braces defines the entire table. 


For example, the Destinations parameter could appear as follows:


Destinations = {
                 {"localhost", 162, "V1"},
                 {"other-host", 30162, "V2C"},
                 {"195.67.23.103",21539, "V2C"}
               }


The SNMP Trap Notifier Adapter supports SNMP V1, SNMP V3, and V2C traps.


Not all traps delivered to destination


Applies to the SNMP Trap Notifier Adapter.


When the SNMP Trap Notifier Adapter sends traps, but does not send them for the correct 
events, the issue is usually improper subscriptions. “Specifying subscriptions in the 
configuration file” on page 21 contains instructions on modifying the subscription profile 
for this adapter.


Script is not invoked for Script Notifier Adapter


Applies to the Script Notifier Adapter.


1. Ensure your script is located in BASEDIR/smarts/local/actions, and that it is readable 
and executable. 


2. Check the configuration file to see that you have altered the file to include the correct 
name for the script you want to invoke.
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EMC Smarts MIB implemented by EMC Corporation for SNMP 
Traps


-- SMARTS-MIB.my:  EMC Smarts corporate MIB
--
-- Copyright 1999-2011 by EMC Corporation ("EMC").
-- All rights reserved.
--
-- UNPUBLISHED CONFIDENTIAL AND PROPRIETARY PROPERTY OF EMC.  The
-- copyright notice above does not evidence any actual or intended
-- publication of this software.  Disclosure and dissemination are
-- pursuant to separate agreements.  Unauthorized use, distribution
-- or dissemination are strictly prohibited.
--
-- RCS $Id: SMARTS-MIB.my,v 1.1.38.2 2006/02/06 23:41:15 eo1 Exp $
--
SMARTS-MIB DEFINITIONS ::= BEGIN


IMPORTS
        enterprises, Counter32, OBJECT-TYPE,
        MODULE-IDENTITY, OBJECT-IDENTITY, NOTIFICATION-TYPE
                FROM SNMPv2-SMI;


smartsMIB MODULE-IDENTITY
        LAST-UPDATED "200602070000Z"
        ORGANIZATION "EMC Corporation"
        CONTACT-INFO
                "       Support
                Postal: EMC Corporation
                        Corporate Headquarters
                        176 South Street
                        Hopkinton, MA 01748-9103
                        US
                Phone:
                  United States: (800) 782-4362 (SVC-4EMC)
                  Canada:        (800) 543-4782 (543-4SVC)
                  Worldwide:     (508) 497-7901


Web: http://powerlink.emc.com"
                DESCRIPTION
                        "The MIB module for EMC Smarts entities defined 


by
                        EMC Corporation."
        ::= { enterprises 733 }


-- top level groups in the SMARTS-MIB


-- The smNotificationTrap Group.


smNotificationTrap OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "This group is acutally the prefix one uses when creating
          enterprise-specific trap OID's for an SNMPv2 trap.  It is
          used in the SMARTS MIBS when defining traps."
        ::= { smartsMIB 0 }


-- The smNotificationData Group.


smNotificationData OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "The members of this group are the OIDs for VarBinds
          containing notification data."
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        ::= { smartsMIB 2 }


-- Group for generic notification data.


smGenericNotify OBJECT-IDENTITY
        STATUS  current
        DESCRIPTION
         "The members of this group are the OIDs for VarBinds
          containing generic notification data."
        ::= { smNotificationData 1 }


smNotifTimestamp OBJECT-TYPE
        SYNTAX Counter32
        MAX-ACCESS accessible-for-notify
        STATUS  current
        DESCRIPTION
         "The timestamp of the notification."
        ::= { smGenericNotify 1 }


smNotifServer OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The name of the server that is sending the notification."
        ::= { smGenericNotify 2 }


smNotifClass OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The class of the object associated with the notification."
        ::= { smGenericNotify 3 }


smNotifInstance OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
        "The instance name of the object associated with the 


notification."
        ::= { smGenericNotify 4 }


smNotifEventName OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
        "The name of the event causing the notification."
        ::= { smGenericNotify 5 }


smNotifInstanceID OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The unique InCharge inventory identification 
          for the object associated with the notification."
        ::= { smGenericNotify 6 }


smNotifDescription OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
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        DESCRIPTION
         "A complete description of the event."
        ::= { smGenericNotify 7 }


smNotifCertainty OBJECT-TYPE
        SYNTAX OCTET STRING
        MAX-ACCESS accessible-for-notify
        STATUS current
        DESCRIPTION
         "The certainty of the event.  Floating-point number in the
          range 0-100, stored as a string."
        ::= { smGenericNotify 8 }


smNotifSeverity OBJECT-TYPE
        SYNTAX INTEGER {
                notApplicable (1),
                informational (2),
                warning (3),
                minor (4),
                major (5),
                severe (6)
        }
        MAX-ACCESS accessible-for-notify
        STATUS  current
        DESCRIPTION
         "The severity of the event.  Integer number in the range 1-6."
        ::= { smGenericNotify 9 }


-- The SMARTS enterprise Traps
--
-- These are the enterprise-specific trap codes currently in-use in
-- SMARTS software.  The final sub-OID of each object is the code sent
-- in the "specific-trap" field of an SNMPv1 Trap-PDU.
--
-- The definition of these objects mimics the SNMPv2 convention for
-- sending traps:  Take the enterprise OID, append 0, then append the
-- trap code.


-- TRAP NUMBER USE: Trap code 0 is reserved (by SNMP).
--                  Trap codes 1-3 are used by the SMARTS-OV-NV-MIB.


-- TRAPS 4-7: The "smTrap*" series of traps define "base" trap
--            numbers, ones with a generic purpose.  These traps are
--            also used by the generic Trap Adapter.


          smTrapNotification NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
               }
            STATUS current
            DESCRIPTION
             "A trap describing an InCharge root cause notification.
              The text in smNotifDescription indicates the nature of
              the problem."
          ::= { smNotificationTrap 4 }


          smTrapCertaintyChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
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                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                }
             STATUS current
             DESCRIPTION
              "A trap indicating a certainty change of an InCharge
               notification. The text in smNotifDescription indicates
               the nature of the problem."
           ::= { smNotificationTrap 5 }


           smTrapSeverityChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                }
             STATUS current
             DESCRIPTION
              "A trap indicating a severity change of an InCharge
               notification. The text in smNotifDescription indicates
               the nature of the notification."
           ::= { smNotificationTrap 6 }


           smTrapNotificationClear NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
              STATUS current
              DESCRIPTION
               "A trap indicating the clear of an InCharge 


notification."
           ::= { smNotificationTrap 7 }


           smTrapNotificationChange NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
              STATUS current
              DESCRIPTION
               "A trap indicating the change of an InCharge 


notification."
           ::= { smNotificationTrap 98 }
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           smTrapNotificationDelete NOTIFICATION-TYPE
            OBJECTS {   smNotifTimestamp,
                        smNotifServer,
                        smNotifClass,
                        smNotifInstance,
                        smNotifEventName,
                        smNotifInstanceID,
                        smNotifDescription,
                        smNotifCertainty,
                        smNotifSeverity
                 }
              STATUS current
              DESCRIPTION
               "A trap indicating the delete of an InCharge 


notification."
           ::= { smNotificationTrap 99 }


-- TRAP NUMBER USE: Trap codes 8-99 are reserved for future "base trap 
number"


--                  use.
--
--                  Trap codes 100-133 are used by 


SMARTS-PERFORMANCE-MIB.
--                  Trap codes 134-199 are reserved for future use by
--                  SMARTS-PERFORMANCE-MIB. 


END
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About MODEL

Overview
This document is a reference guide for the EMC® Smarts® Managed Object Definition 
Language (MODEL). It serves as a comprehensive reference for the syntax and use of 
MODEL declarations.


The EMC Smarts Managed Object Definition Language (MODEL) is a descriptive language 
used to develop correlation models for EMC Smarts Foundation applications. MODEL 
provides constructs for defining classes of managed objects and describing their 
properties. Properties include attributes, operations, relationships, basic events, 
problems, and symptoms.


The main purpose of MODEL is to provide a means of describing the potential components 
of a managed domain in a reusable object-oriented framework. Developing your 
management application with EMC Smarts provides two advantages.


◆ MODEL is an object-oriented language in which you declare a static class from which 
many objects (or instances) can be instantiated at runtime. 


◆ EMC Smarts applications separate the generic correlation model from topology. 
Because the model you develop is not tied to a particular topology, it can be used to 
model different domains that consist of similar types of managed objects.


MODEL is based on CORBA IDL (The Common Object Request Broker: Architecture and 
Specification, Object Management Group and Xopen, 1992). MODEL uses CORBA IDL 
notation where possible, introducing new syntax to address semantic concepts not 
provided by CORBA IDL. The new syntax supports event-driven information including 
problems, symptoms, and their propagation.


EMC Smarts installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed.


◆ For Windows, this location is C:\InCharge\<productsuite>.


◆ For UNIX, this location is /opt/InCharge/<productsuite>.


InCharge names the directory where the software is installed. The <productsuite> 
represents the EMC Smarts product suite to which the product belongs. This location is 
referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than:


◆ Windows: C:\InCharge


◆ UNIX: /opt/InCharge


However, you cannot change the <productsuite> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com
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Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Modeling event-driven information
Events are observable conditions that occur in objects of the managed domain. Event 
information is essential to the root-cause analysis that is performed by the Domain 
Manager.


MODEL recognizes the importance of event modeling and supports the following concepts 
as they relate to the occurrence and effect of events in a managed system.


1. Events occur in objects and are modeled as object properties. Events can also be 
imported from an external source.


2. Events may be symptoms or problems and sometimes both. A symptom is a basic 
event that is directly observable on a class instance. A problem, defined on a class, 
causes symptoms that may be directly observable on the same class or on related 
classes. When the problem is fixed, the symptoms that it causes no longer occur.


3. Events can propagate from one object to another through a relationship. Propagation 
of events is important to understand because the symptoms of a problem cannot 
always be observed in the object where the problem occurs. Instead, the symptoms of 
such a problem must be detected in related objects to properly diagnose the problem.


Detecting events


An EMC Smarts application is event-driven. When an event is detected, the Domain 
Manager sends a notification to its client(s) indicating that the event has occurred. When 
the Domain Manager determines that the notified event is no longer occurring, it clears 
the notification to indicate that the conditions that caused the event are no longer 
present.


In MODEL, events are declared as Boolean expressions constructed with the values of 
attributes or other events. When the Domain Manager monitors an event, it determines 
which attributes are required to evaluate the event expression. The Domain Manager 
builds a data structure that links these attributes to the event expression and monitors 
those attributes. When the value of a monitored attribute changes, the Domain Manager 
re-evaluates the event expression to determine if its truth value has changed.


Determining which events are monitored


A Domain Manager does not automatically monitor for every event declared in the 
correlation model. Instead, the Domain Manager only monitors for events that have been 
subscribed to by EMC Smarts clients, which include adapters.


When an EMC Smarts client requests to be notified of an event (by subscribing to the 
event), the Domain Manager monitors only those attributes and events necessary to 
determine when the event occurs. Attributes that do not affect the evaluation of a 
subscribed-to event are not monitored. When the value of an attribute that is not 
monitored changes, the Domain Manager does not re-evaluate any event expressions. The 
values of all attributes, monitored or not, are accessible to EMC Smarts clients.

Modeling event-driven information 13
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Introduction by Example

Overview
This chapter uses an example model to introduce the basic MODEL declarations that you 
will use to develop correlation models. The detailed syntax of MODEL declarations is 
described in later chapters.


Class properties
A Domain Manager’s Repository maintains a runtime database of managed objects 
instantiated from MODEL classes. The Repository also maintains an index of all instances 
of a class. Each class has properties that define it within the Repository. These properties 
are as follows.


◆ Inheritance defines the hierarchy of classes. Object classes are related in a 
subclass/superclass hierarchy. All of the properties defined for a superclass are 
inherited by its subclasses. For example, in Figure 1 on page 16 the 
UnitaryComputerSystem class has an attribute XYZ and an event Down. Each of the 
subclasses (Router and Host) inherits the attribute XYZ and the Down event.


Figure 1  Inheritance of properties by subclasses


A subclass may refine existing properties or add new properties and operations to 
introduce unique behavior or states. “Inheritance” on page 57 provides further 
information.


◆ A class can be declared as abstract or concrete. Concrete classes can be directly 
instantiated and must define implementations for all their properties. Abstract 
classes cannot be instantiated and may have properties for which they do not define 
implementations. “Interface header declaration” on page 57 provides further 
information.


UnitaryComputerSystem


Attribute XYZ
Event Down


Host


Attribute XYZ
Event Down


Superclass


Subclasses
Router


Attribute XYZ
Event Down
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Declaring a class in MODEL


A class defines the state and behavior for all its instances. In MODEL, a class is defined by 
an interface declaration. MODEL constructs are specified within an interface declaration.


An interface declaration defines a managed object class in the Repository. Each interface 
must inherit from another interface. There are two base classes from which you can 
inherit: MR_ManagedObject and MR_MetaObject. MR_ManagedObject serves as the base 
class for all managed objects. When you develop a correlation model, the classes that 
represent types of managed objects should inherit from MR_ManagedObject. 
MR_MetaObject serves as the base class for objects that do not correspond to managed 
elements. Objects derived from MR_MetaObject may be used for configuration and control 
purposes. As such, MR_MetaObject is used less often.


Interface declarations


An interface is composed of an interface header declaration followed by a sequence of 
declarations enclosed in curly braces. Properties of the interface are specified between 
the curly braces.


Examples of interface declarations
The following code fragment declares five interfaces. The first two interfaces, Department 
and Person, are subclasses of MR_ManagedObject. Employee is a subclass of Person and 
has two subclasses, Director and Manager. 


Each subclass inherits all of the properties of its superclass. Because Person is declared 
as abstract, instances of this class cannot be instantiated. Employee is a subclass of 
Person but is not declared as abstract. Instances of Employee can be created to populate 
the topology, as shown in Figure 2 on page 17.


Figure 2  Sample hierarchy


MR_ManagedObject


Department Person


Employee


ManagerDirector
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The quoted strings that appear in each declaration are descriptions. Most MODEL 
declarations have an optional description field. The descriptions are stored in the 
Repository and can be displayed by EMC Smarts clients. You can use more than one line 
for a description, but each line must begin and end with quotation marks. When a 
description spans more than one line, add an extra space before the quotation marks at 
the end of each line. This ensures that the description is readable when the client 
concatenates the lines that compose the description.


interface Department : MR_ManagedObject
"The departments forming the company"
{
}


abstract interface Person : MR_ManagedObject
"A generic description of a person"
{
}


interface Employee : Person
"A person who works for the company"
{
}


interface Manager : Employee
"An employee who has managerial responsibilities"
{
}


interface Director : Employee
"An employee who has directorial responsibilities"
{
}


18 EMC Smarts Foundation MODEL Reference Guide







Introduction by Example

Modeling an object’s properties
The state of an object is defined by the values of its state properties. Attributes of an 
object and relationships between an object and one or more other objects are examples of 
an object’s state properties.


Attribute declarations


The attribute declaration is one of the basic declarations that comprise an interface 
declaration. An attribute declaration specifies a property that is present in all instances of 
the interface.


The value of an attribute can be stored in the Repository, computed on demand, 
propagated from other objects through a relationship, or instrumented. An instrumented 
attribute is an attribute whose value is obtained, by using an accessor.


A stored attribute declaration includes the attribute’s type, and optionally, a description, 
access type, access flag, and initial value. MODEL supports most built-in C++ data types. 
“Supported types” on page 51 provides a list of the supported attribute types. At runtime 
the attributes obtain values. These values describe the state of the instance.


Examples of attribute declarations
The following code fragment declares attributes for the interfaces from the previous 
example. Each declaration specifies the attribute’s data type and access type, if it is not 
stored. Note that an expression in a computed attribute must be defined in-line, as shown 
by the attribute Wages in the class Employee. Intrinsically, computed attributes are read 
only, and therefore, the readonly keyword is optional. Their value cannot be set through a 
EMC Smarts client.


Note: In a MODEL file, “//” is used to comment a line. “/* and “*/” are used comment a 
block of lines.


interface Department : MR_ManagedObject
"The departments forming the company"
{


// Attributes
attribute short DeptNumber 
"Department Number"
= 0;
attribute float DeptBudget 
"Budget for wages"
= 0;


}


abstract interface Person : MR_ManagedObject
"A generic description of a person"
{


// Attributes
attribute string LastName 
"Person’s last name";


attribute string FirstName 
"Person’s first name";


}
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interface Employee : Person
"The people that work for the company"
{


// Attributes
attribute float LowWage_Thr 
"The minimum salary expected for an employee"
= 5.15;


attribute float HoursWorked_Thr
"The maximum number of hours an employee should be "
"allowed to work per week"
= 60;


attribute string EmployeeID 
"Employee identification number"
= "0000";


attribute float HoursWorked 
"Number of hours an employee works per week"
= 40;


attribute float HourlyRate 
"The employee's hourly wage"
= 13;


readonly computed attribute float Wages 
"The employee’s weekly salary"
= HoursWorked * HourlyRate;


}


Relationship declarations


A relationship maps instances of one class to instances of the same or another class. For 
each relationship, an inverse relationship may also exist that maps from the related class 
back to the originating class. The term relation refers to the pair of relationships between 
two objects.


The cardinality of a relationship can be to-one or to-many. The cardinality of a relationship 
from class C1 to class C2 is to-one when an object of class C1 can be mapped by the 
relationship to, at most, one object of class C2. The cardinality of a relationship from class 
C1 to class C2 is to-many when an object of class C1 can be mapped by the relationship to 
zero or more objects of class C2.


The reciprocal relationship between two objects may have a different cardinality than the 
original relationship. Because of this, the relation between classes C1 and C2 is 
one-to-one when the pair of relationships that define the relation are to-one relationships. 
The cardinality of the relation between two classes is one-to-many when one of the 
relationships is to-one and the other relationship is to-many. The cardinality of the relation 
is many-to-many when both relationships are to-many.


A relationship declaration includes the cardinality of the relationship, the name of the 
relationship, the name of the related class, the name of the inverse relationship, and an 
optional description. Cardinality is determined by the keyword relationship, which 
declares a to-one relationship, or relationshipset, which declares a to-many relationship.
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Examples of relationship declarations
The Department class declares two relationships: ManagedBy and Contains. ManagedBy 
is a relationship between a Department and a Manager. Contains is a relationship 
between a Department and the employees who work in the department. Because a 
department potentially has many employees, Contains is declared as a relationshipset.


In the Employee class, the relationship WorksIn declares the inverse of the Contains 
relationship in the Department class. It declares that an employee can work in one 
department.


The Manager class contains the Manages relationshipset, which is the inverse of the 
ManagedBy relationship.


interface Department : MR_ManagedObject
"The departments forming the company"
{


// Relationships
relationship ManagedBy, Manager, Manages
"The manager who manages this department";


relationshipset Contains, Employee, WorksIn
"The employees this department contains";


}


interface Employee : Person
"The people that work for the company"
{


relationship WorksIn, Department, Contains
"The department the employee works in";


}


interface Manager : Employee
"An employee who has managerial responsibilities"
{


relationshipset Manages, Department, ManagedBy
"The department this manager manages. "
"A manager manages one department";


}


Propagate attribute declarations


Relationships define connections between classes of managed objects. 


The value of a propagated attribute can be obtained from a single object through a 
relationship or it can be retrieved from multiple objects through a relationshipset. When 
the value of the propagated attribute is obtained through a relationshipset, you must 
specify an aggregate operator. The aggregate operator tells the Domain Manager how to 
combine the set of values formed by the value it receives from each instance participating 
in the relationshipset.


A propagate attribute declaration includes the relationship name the attribute is retrieved 
over, the related class, and the name of the attribute that propagates.

Modeling an object’s properties 21







Introduction by Example

Examples of propagated attributes
The Department interface declares two propagated attributes. The first, 
AverageDeptWage, computes the average salary of the employees who work in the 
department. This requires retrieving the value of the Wages attribute from each instance of 
the Employee class through the Contains relationshipset. Because Contains is a 
relationshipset, an aggregate operator, avg (for average), must be specified.


The second propagated attribute, ManagerSalary, retrieves the salary of the manager who 
manages this department. This is accomplished through the ManagedBy relationship. 
Manager is a subclass of Employee and inherits the Salary attribute. 


interface Department : MR_ManagedObject
"The departments forming the company"
{


// Propagated attributes
propagate attribute float avg AverageDeptWage 
"The average salary of employees in this department "
= Employee, Contains, Wages;


propagate attribute float ManagerSalary 
"The salary of the manager of this department"
= Manager, ManagedBy, Wages;


}
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Modeling event-driven behavior
Events define the behavior for instances of a class. An event is an observable condition 
that occurs within an object. MODEL provides the following declarations for specifying 
event-driven behavior.


◆ Event declaration 


◆ Problem declaration


◆ Propagate symptom declaration


◆ Aggregate declaration


◆ Propagate aggregate declaration


◆ Export declaration


Note: An object created with the event declaration is referred to as a basic event. 
Repository objects created with event, problem, aggregate, symptom, propagate 
symptom, and propagate aggregate declarations are all referred to generically as events.


Event declarations


An event declaration declares a basic event that is observable in instances of the class for 
which it is defined. It is important to note that an event declaration specifies an 
observable event. As such, the Domain Manager does not perform correlation to 
determine when such an event occurs. Instead, events specified by an event declaration 
are used by the Domain Manager to diagnose problems. By monitoring observable events, 
the Domain Manager is able to pinpoint problems (specified by problem declarations), 
which cause the observable events.


An event declaration specifies the name of the basic event, an event expression, and an 
optional description. Event expressions are written as Boolean expressions defined over 
attributes or other events. When an event expression evaluates to true, it means that the 
basic event is occurring. When the event expression evaluates to false it either means that 
the basic event has cleared or that the event is not active.


Examples of an event declaration
The Employee class declares three basic events: UnderPaidEmployee, OverWorked, and 
UnderAchieved. UnderPaidEmployee occurs when the value of the attribute HourlyRate is 
less than the attribute LowWage_Thr. Similarly, OverWorked occurs when the attribute 
HoursWorked is greater than the attribute HoursWorked_Thr. UnderAchieved is defined 
using two previously declared basic events. When either UnderPaidEmployee or 
OverWorked occurs, the basic event UnderAchieved occurs.


interface Employee : Person
"The people that work for the company"
{


// Events
event UnderPaidEmployee
"This employee is making less than the minimum wage"
= HourlyRate < LowWage_Thr;
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event OverWorked
"This employee is working too many hours during the "
"week"
= HoursWorked > HoursWorked_Thr;


event UnderAchieved
"The employee is not performing as expected"
= UnderPaidEmployee || OverWorked;


}


Problem declarations


A problem declaration declares an event that is detected by observing its symptoms. 
Symptoms are observable events that uniquely identify the problem. Note that the 
symptoms described here are not necessarily declared by a symptom declaration. The 
symptoms of a problem can be declared by event, symptom, and other problem 
declarations.


Like an event declaration, a problem declared by a problem declaration must be 
subscribed to by an EMC Smarts client to make the Domain Manager monitor for it.


A problem declaration specifies the name of the problem, the list of symptoms that the 
problem causes, and an optional description.


As noted earlier, the Domain Manager only monitors problems that an EMC Smarts client 
has subscribed to. If a problem is not subscribed to, the Domain Manager does not 
monitor the attributes and events that the problem depends on.


Example of a problem declaration
The PoorPerformance problem causes the UnderAchieved event, making UnderAchieved a 
symptom of PoorPerformance. When the Domain Manager detects the UnderAchieved 
event, it concludes that PoorPerformance is the problem and sends a notification for the 
PoorPerformance problem. 


“Examples of an event declaration” on page 23 describes the attributes and events the 
Domain Manager would have to monitor to determine when UnderAchieved occurs.


interface Employee : Person
"A person who work for the company"
{


// Problems
problem PoorPerformance
"The employee is not able to complete his or "
"her activities. Therefore, the employee is "
"forced to work extra hours"
=> UnderAchieved;


}
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Propagate symptom declarations


It is not unusual for a problem declared in one class to cause events in a related class. 
MODEL supports this notion through the propagate symptom declaration.


The propagate symptom declaration specifies a set of events that are not observable in 
the object where they occur but whose effects propagate to related objects. It is important 
to note that although the name of the declaration is propagate symptom, it is more 
accurate to think of it as a propagated event. This is because a propagate symptom 
declaration can be used to propagate events from event, problem, and other propagate 
symptom declarations.


A propagate symptom declaration specifies the name of the propagated symptom, the 
name of the related class, the name of the relationship along which the event propagates, 
and the name of the symptom. The symptom refers to the event, problem, or propagate 
symptom declaration that specifies the event in the related class.


Example of a propagate symptom declaration
The Department class declares two propagated symptoms: UnderPaidEmployee and 
UnderAchieved. Both these events occur in instances of the Employee class. However, 
neither of these events is observable in instances of the Department class. Instead, they 
are detected through their symptoms that propagate from instances of the Employee class 
through the Contains relationship.


Unlike a propagate attribute declaration, a propagate symptom declaration does not use 
an aggregate operator. A propagate symptom declaration causes all instances of the target 
problem/symptom/event to be in the problem signature for the problem that causes the 
propagated symptom.


interface Department : MR_ManagedObject
"The departments forming the company"
{


propagate symptom UnderPaidEmployee
"The employees in this department that are underpaid"
= Employee, Contains;


propagate symptom UnderAchieved
"The employees in this department that are not "
"performing as expected"
= Employee, Contains;


}


Note: If the name of the basic event that propagates from the related class is not 
specified, it means that the basic event has the same name as the propagated symptom.
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Aggregate declarations


An aggregate declaration specifies a set of events that are grouped into a single event by 
disjunction. Therefore, when any one event in the set occurs, the aggregate event occurs.


Like event and problem declarations, an event specified by an aggregate declaration must 
be subscribed to for the Domain Manager to monitor it. When an EMC Smarts client 
subscribes to an aggregate event, the Domain Manager only monitors those attributes and 
events necessary to determine when the aggregate occurs.


An aggregate declaration specifies the name of the aggregated event, an optional 
description, and a list of one or more events that comprise the aggregate. Events specified 
by event, problem, and aggregate declarations can be used in an aggregate declaration.


Example of an aggregate declaration
The LegalException aggregate is a single event declared with the UnderPaidEmployee and 
OverWorked events. When either the UnderPaidEmployee or the OverWorked events 
occur, the LegalException aggregate also occurs. Both events that compose the aggregate 
are also declared in the Employee class.


interface Employee : Person
"The people that work for the company"
{


// Aggregate
aggregate LegalException
"The employee is experiencing an illegal condition in "
"his/her working environment"
= UnderPaidEmployee,
  OverWorked;


}


Propagate aggregate declarations


A propagate aggregate declaration specifies an event whose set of symptoms are events 
declared in related classes. When one of the symptoms in the set occurs, it propagates to 
the instance where the propagate aggregate is declared.


The syntax of the propagate aggregate declaration is similar to that of the propagate 
symptom declaration. A propagate aggregate declaration specifies the name of the 
propagated aggregate, an optional description, and the names of the related class, the 
relationship along which the symptoms propagate, and the symptom in the related class.


Example of a propagate aggregate declaration
The LegalException propagate aggregate declared in the Department class propagates 
from instances of the Employee class through the Contains relationship. LegalException is 
also the name of the event in the event declaration in the Employee class, so it is not 
necessary to provide its name. When LegalException occurs in any instance of Employee, 
the LegalException becomes active in the Employee’s Department.
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interface Department : MR_ManagedObject
"The departments forming the company"
{


propagate aggregate LegalException
"This department contains employees that work "
"under illegal conditions. The employment contract "
"for these employees must be reviewed"
= Employee, Contains;


Export declaration


Exported events are those events that are made visible to EMC Smarts clients. When you 
declare an event as exported, it is accessible to EMC Smarts clients, so they can subscribe 
to the event and receive notifications when the event occurs.


If an event is not exported, it remains private and is not accessible outside of the Domain 
Manager’s Repository. 


A single export declaration can declare all of the public events for a class. Table 7 on 
page 96 specifies the types of events that can be exported. 


The export declaration specifies, by name, the events that are to be exported.


Example of an export declaration
The Department class exports a single event, the aggregate Legal Exception, while the 
Employee class exports one problem and three events. To make your MODEL code easier 
to read, use separate declarations to export events and problems.


interface Department : MR_ManagedObject
"The departments forming the company"
{


// Exported Aggregates
export


LegalException;
{


interface Employee : Person
“The people that work for the company"
{


// Exported problems
export


PoorPerformance;   


// Exported events
export 


UnderPaidEmployee,
OverWorked,
UnderAchieved;


}
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Refining an object’s properties


Refinement provides a method for modifying a class property in a subclass. Attribute, 
relationship, event, problem, propagate symptom, aggregate, and propagate aggregate 
declarations may be refined. The refinement must be declared in a subclass.


A refined property has the same name as the property it modifies and is indicated by the 
keyword refine. A property’s description can always be changed through a refinement.


◆ For a stored attribute declaration, a refinement can change the attribute’s initial value 
and its access type.


◆ For a relationship or relationshipset declaration, a refinement can change the class 
that participates in the relationship. The interface where the relationship is originally 
declared must be a superclass of the interface where the relationship is refined. 
In addition, the cardinality of the refined relationship must remain the same as that of 
the original relationship.


◆ For an event declaration, a refinement can change all the properties of the event.


◆ For a problem declaration, a refinement can change all the properties of the problem.


◆ For an aggregate declaration, a refinement can change all the properties of the 
aggregate.


◆ For propagate aggregate and propagate symptom declarations, a refinement can 
change all the properties of the declarations.
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The complete example
The following is the complete model from which the examples in this chapter were taken. 


#include <repos/managed_object.mdl>


#pragma include_h <repos/managed_object.h>
#pragma include_c "department.h"        


interface Department : MR_ManagedObject
"The departments forming the company"
{


// Export Aggregates
export
   LegalException;


// Aggregates
propagate aggregate LegalException
"This department contains employees that work under "
"illegal conditions. The employment contract for "
"these employees must be reviewed"
= Employee, Contains;


// Relationships
relationship ManagedBy, Manager, Manages
"The manager who manages this department";


relationshipset Contains, Employee, WorksIn
"The employees this department contains";


// Attributes
attribute short DeptNumber 
"Department Number"
= 0;


attribute float DeptBudget 
"Budget for wages"
= 0;


// Propagated attributes
propagate attribute float avg AverageDeptWage 
"The average salary of employees in this department"
= Employee, Contains, Wages;


propagate attribute float ManagerSalary 
"The salary of the manager of this department"
= Manager, ManagedBy, Wages;


propagate symptom UnderPaidEmployee
"The employees in this department that are underpaid"
= Employee, Contains;


propagate symptom UnderAchieved
"The employees in this department that are not "
" performing as expected"
= Employee, Contains;


}
abstract interface Person : MR_ManagedObject
"A generic description of a person"
{


// Attributes
attribute string LastName 
"Person's last name";
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attribute string FirstName 
"Person's first name";


}


interface Employee : Person
"A person who works for the company"
{


// Exported problems
export
   PoorPerformance;   


// Exported events
export 
   UnderPaidEmployee,
   OverWorked,
   UnderAchieved;


// Problems
problem PoorPerformance
"The employee is not able to complete his or her "
"activities. Therefore, the employee is forced "
"to work extra hours "
=> UnderAchieved;


// Events
event UnderPaidEmployee
"This employee is making less than the minimum wage"
= HourlyRate < LowWage_Thr;
event OverWorked
"This employee is working too many hours during the "
"week"
= HoursWorked > HoursWorked_Thr;


event UnderAchieved
"The employee is not performing as expected"
= UnderPaidEmployee ||
  OverWorked;
// Aggregates
aggregate LegalException
"The employee is experiencing an illegal condition "
"in his/her working environment"
= UnderPaidEmployee,
  OverWorked;


// Relationships
relationship WorksIn, Department, Contains
"The department the employee works in";


// Attributes
attribute float LowWage_Thr 
"The minimum wage for an employee"
= 5.15;


attribute float HoursWorked_Thr
"The maximum number of hours an employee should be "
"allowed to work per week"
= 60;


attribute string EmployeeID 
"Employee identification number"
= "0000";
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attribute float HoursWorked 
"Number of hours an employee works per week"
= 40;


attribute float HourlyRate 
"An employee's hourly wage"
= 13;


readonly computed attribute float Wages 
"The employee's weekly salary"
= HoursWorked * HourlyRate;


propagate attribute float ManagerSalary 
"The weekly salary of the employee's manager"


        = Department, WorksIn;


}
interface Manager : Employee
"An employee who has managerial responsibilities"
{


// Exported problems
export 
   StingyManager;


// Problems
problem StingyManager
"This manager does not compensate employees properly, "
"or his/her managerial skills are not provding the "
"direction his employees require to perform better"
=> MyEmployeesUnderAchieved;


// Events
refine event OverWorked
"This employee is working too many hours during a "
"week period"
= HoursWorked > 1.5 * HoursWorked_Thr;


// Symptoms
propagate symptom MyEmployeesUnderAchieved
"The employees that are paid less than the minimun "
"wage"
= Department, Manages, UnderAchieved;


// Relationships
relationshipset Manages, Department, ManagedBy
"The department this manager manages. "
"A manager manages one department";


relationship ReportsTo, Director, Supervises
"The director this manager reports to";


}
interface Director : Employee
"An employee who has directorial responsibilities"
{


// Relationships
relationshipset Supervises, Manager, ReportsTo
"The manager this director supervises";


}
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Overview
After you successfully compile a correlation model, the next step is to load the MODEL 
library into a Domain Manager and test it. The purpose of testing is to ensure that:


◆ The proper events are triggered when the values of attributes change


◆ The problems and aggregations occur when expected


◆ The events are propagating along relationships as expected


If your model includes complex expressions in event or attribute declarations, you should 
test these expressions to ensure that they return the expected results.


You can use several different tools to load and test a MODEL library. This chapter briefly 
describes these tools and explains various procedures for testing your correlation model.


Tools for working with MODEL libraries
You can perform the procedures for loading and testing a correlation model with any of the 
tools described below. You can choose the tool you prefer to use and follow the 
procedures for that tool. These tools include the dmctl utility, and adapters.


◆ The dmctl utility is a command-line tool for connecting to a Domain Manager.


◆ Adapters can also be used to load and test MODEL libraries. The methods for doing 
this are not discussed in this book. The EMC Smarts ASL Reference Guide provides 
further information.


Using the dmctl command-line interface


The dmctl utility provides a command line interface to a running Domain Manager. You can 
use it to perform tasks such as adding or deleting objects, setting the value of attributes, 
and inserting objects in or removing objects from relationships.


The dmctl utility can operate in two modes: you can establish a continuous connection 
with a Domain Manager, or you can open and close a connection for each command. 
When you perform multiple operations, a continuous connection is easier because you do 
not have to specify the name of the Domain Manager for each operation.


To establish a continuous connection with a running Domain Manager, specify the name 
of the Domain Manager with the --server option, where <domain> is the name of the 
Domain Manager:


dmctl --server=<domain>


To use dmctl in such a way that it opens and closes the command for the operation, 
specify the name of the Domain Manager and the command. The following command 
shuts down the specified Domain Manager.


dmctl --server=<domain> shutdown


The dmctl utility can be used to create instances, insert instances into relationships, 
supply values to attributes, and generate events for the example model described in “The 
complete example” on page 29.
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More information regarding dmctl is available in two places:


◆ The HTML documentation for EMC Smarts commands, which is installed into the 
BASEDIR/smarts/doc/html/usage directory. The help file for dmctl is dmctl.html.


◆ Information is also available by specifying the --help option:


dmctl --help
You can retrieve the complete list of dmctl commands by specifying the 
--commands option:


dmctl --commands


Loading a MODEL library
You can load a MODEL library into a Domain Manager when you start it or after it is already 
running. For security purposes, the Domain Manager looks in a specific directory for 
MODEL libraries. You can specify additional locations with an environment variable.


Location of MODEL libraries


Because the Domain Manager may run with root or administrator privileges, the Domain 
Manager (and other EMC Smarts commands) is limited to loading libraries from specific 
directories. When invoked, EMC Smarts programs append the SM_LIBPATH environment 
variable and the BASEDIR/smarts/lib path to the system library variable described in 
Table 1 on page 35. 


You can specify additional directories by setting the SM_LIBPATH environment variable. By 
default, the SM_LIBPATH environment variable is not set.


Setting SM_LIBPATH on Windows
On Windows systems, you can specify additional directories for the current user session 
from the command prompt.


C:> SET SM_LIBPATH=<path>;<path>;<path>


Setting SM_LIBPATH on UNIX and Red Hat Linux
On UNIX and Red Hat Linux systems, the method for setting an environment variable 
differs according to the shell. The instructions below assume sh or ksh.


% SM_LIBPATH=<path>:<path>:<path>
% export SM_LIBPATH


Where <path> is a directory where MODEL libraries are located. More than one path may be 
specified by separating the paths with a colon (:).


Table 1  Library variables for supported operating systems


Operating system Library variable


Red Hat Linux LD_LIBRARY_PATH 


Windows 
(also used to locate main programs)


PATH
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Starting a Domain Manager


The Domain Manager Toolkit includes a runtime license for a Domain Manager. This 
enables you to test your model and any adapters you have developed. Follow the 
procedures in the EMC Smarts System Administration Guide to obtain a permanent 
license.


There are two commands available to start a Manager: dmstart and sm_server.   The 
sm_server command has more options, including the specification of a configuration 
directory, and therefore is the command normally used in production. The dmstart 
command is generally used early in the development cycle before configuration files have 
been created. 


Note: The dmstart and sm_server commands assume that the Broker is already running.


You can use the -help option for a complete list of command line options. Change to the 
BASEDIR/smarts/bin directory and enter:


dmstart --help


or


sm_server --help


One of the required command line parameters of sm_server is the domain manager 
configuration directory ("--config=<directory>"). The EMC Smarts software includes a 
directory called BASEDIR/smarts/examples, which contains several different 
subdirectories. Each subdirectory is for a separate example. Some of these examples 
include a conf subdirectory, such as BASEDIR/smarts/examples/apollo13/conf. The 
BASEDIR/smarts/examples/apollo13/conf directory contains a sample bootstrap.conf 
and sample .import file. These files show how to instantiate key objects and set 
parameters on them that may be useful for your application.


The installed versions of these files have their contents commented out. You may activate 
these by running the sm_edit utility to bring up these files in an editor so that you can 
uncomment selected lines. Alternatively, you can create a new configuration directory 
named after your application by copying BASEDIR/smarts/conf/SDK to 
BASEDIR/smarts/conf/<new-app-name>, and then running sm_edit to edit the files in this 
new directory.


Methods for loading MODEL libraries


There are several methods for loading a MODEL library into a Domain Manager.


◆ You can load a MODEL library when you start the Domain Manager.


◆ You can use the dmctl utility to load a MODEL library into a running Domain Manager.


Regardless of what method you use, you only specify the base name of the library when 
you load it into a Domain Manager. For example, the name of the MODEL library might be 
libexample.so. When you load the library, simply use example to specify the library.
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Loading a MODEL library at Domain Manager startup
To load a MODEL library when you start the Domain Manager, specify the MODEL library 
with the --model option to the dmstart command.


BASEDIR/smarts/bin/dmstart --name=<domain> --model=<model>


where <domain> is the name of the Domain Manager, and <model> is the name of the 
MODEL library.


Loading a MODEL library with dmctl
To load a MODEL library to a running Domain Manager, use the dmctl command-line 
interface and the loadModel command.


BASEDIR/smarts/bin/dmctl --server=<domain> loadModel <model>


This command must be run on a single line. The <domain> parameter is the name of the 
Domain Manager and <model> is the name of the MODEL library.
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Working with a MODEL library and a Domain Manager
Once your model is compiled and loaded into a Domain Manager, you are ready to start 
testing. This section describes different methods for viewing your model, listing its 
contents, creating instances, and notifying events.


Methods for listing models loaded into a Domain Manager


You can use the dmctl utility to list the models loaded into a Domain Manager.


Use the getModels option to retrieve the list.


BASEDIR/smarts/bin/dmctl --server=<domain> getModels


Listing classes in the MODEL library


You can use the dmctl utility to list the classes declared in the model. If more than one 
model is loaded into the Domain Manager, only the concrete classes from the loaded 
models are retrieved.


The getClasses command can be used to list the classes.


BASEDIR/smarts/bin/dmctl --server=<domain> getClasses


Note: The list of classes retrieved by dmctl will also include classes used to configure and 
control the operation of the Domain Manager. Removing these classes or modifying the 
properties of their instances is not recommended.


Creating instances of a class


You can use the dmctl utility to create instances of classes declared in your model. By 
creating instances, you build a topology of managed elements.


The create command is used to create an instance. You must specify the class name and 
an instance name.


In this example, dmctl is already connected to a Domain Manager. This enables you to 
type commands without having to first attach to the Domain Manager.


% dmctl> create <class_name>::<instance_name>


Modifying the properties of an instance


You can use the dmctl utility to modify the properties of instances. This includes changing 
the values of attributes and inserting instances into relations.


Note: When you insert an instance into a relation, the instance that is on the other end of 
the relation must already exist.
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Changing an attribute value with the dmctl utility
You can change the value of an attribute by using the put command:


dmctl> put <class>::<instance>::<attribute> <value>


Note: The value of attributes declared as read-only, which includes computed attributes, 
cannot be changed by an EMC Smarts client.


Insert an instance into a relation with the dmctl utility
To insert an instance into a relation with dmctl, use the insert command. You may find it 
helpful to retrieve the class properties to verify the relations in which the instance can 
participate.


To retrieve the properties of a class:


% dmctl> getProperties <class_name>


To insert an instance into a relation, you must specify an instance for each end of the 
relation. For the instance to be inserted, specify the class name, instance, and relation. For 
the other end of the relation, specify the class name and instance.


% dmctl> insert <class>::<instance>::<relation> \
<class>::<instance>


Notifying events


Notifying events provides a method for simulating the occurrence of events in a managed 
system. The Domain Manager treats a notified event as though it were a real event.


You simulate events with the notify command. Events specified by problem or aggregate 
declarations cannot be notified. Instead, you notify the symptoms, specified by event 
declarations, that the problem would cause if it were to occur. If the problem affects other 
objects, as specified by an aggregate declaration, then the Domain Manager notifies the 
appropriate aggregate events as well.


To notify an event, by using dmctl, specify the class name, instance, and event.


% dcmtl> notify <class>::<instance>::<event>
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Overview
The remaining chapters of this document provide a reference for the syntax and usage of 
MODEL declarations. This chapter describes the basic lexical elements of MODEL 
including keywords, identifiers, and data types. Because MODEL files are compiled to C++, 
the lexical elements follow many of the conventions for keywords, identifiers, and data 
types established by C++.


Keywords
Table 2 on page 42 lists the MODEL keywords, and Table 3 on page 50 lists the C++ 
keywords and other words that are reserved and should not be used as identifiers. 
Identifiers with a double underscore ( _ _ ) or those that begin with an underscore and an 
uppercase letter are also reserved for use by C++ implementations and standard libraries. 
You should avoid C++ keywords because the code generated by the MODEL compiler is 
compiled by a C++ compiler. 


Note: Not all of the keywords in the following lists are currently used by MODEL. Unused 
keywords are reserved for future use. 


Table 2  MODEL keywords  (page 1 of 8)


Keyword Description Refer to


_time Represents the current time as an 
int in UNIX epoch format. Used in 
expressions.


abstract Defines an interface for which 
instances cannot be instantiated.


“Interface header declaration” 
on page 57.


aggregate A type of declaration that groups 
one or more basic events, 
problems, aggregates or 
propagated aggregates declared for 
the same class into a single abstract 
event by disjunction. 


“Aggregate declaration” on 
page 92.


and An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


apriori Indicates the probability of a 
problem occurring before looking at 
any of the symptoms as evidence.


“apriori keyword” on page 85.


ascending Indicates the direction when an 
access key has been defined for a 
table.


The description of ascending on 
page 74.


attribute Attributes describe the state of a 
managed object. Their values can 
be queried and manipulated by 
EMC Smarts clients and displayed 
in a console.


Chapter 6, “Attribute 
Declarations”on page 59.
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avg An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


binary A data type supported by MODEL. “Data types” on page 51.


boolean A data type supported by MODEL. “Data types” on page 51.


byte A data type supported by MODEL. “Data types” on page 51.


case The case operator uses the value of 
a selection expression to select one 
of a number of keys and the value 
expression associated with that key.


“Case operator” on page 111.


check A separator used to identify a 
guarded expression.


“Guarded events” on page 82.


computed Specifies an access type for an 
attribute. The value of a computed 
attribute is calculated on demand 
by evaluating an expression, when 
the value of the attribute is 
required.


“Computed attributes” on 
page 66.


const Indicates that the operation does 
not change the instance in the 
repository, it cannot assign to 
attributes of the class. However, it 
may change other parts of the 
repository.


“Operation Declarations” on 
page 99.
“Instance-only read lock” on 
page 106.


const value Declares a constant value.


constraint Constraint expressions are used to 
enforce limits on the values of 
attributes or combinations of 
attributes. Constraints are enforced 
at runtime, unlike ranges.
Constraints can also be used for 
relationshipsets.


“Constraints” on page 123.


default A key in a case evaluation 
expression operator.


“Case operator” on page 111.


definition A keyword used when defining an 
operation.


“Operation Declarations” on 
page 99.


delta A built-in function that is supplied 
by MODEL. The term delta(A), 
where A is an attribute, returns 
the difference between the 
current value of A and its 
previous value.


“Built-in functions” on 
page 113.


descending Indicates the direction when an 
access key has been defined for a 
table.


The description of descending on 
page 74.


double A data type supported by MODEL. “Data types” on page 51.


Table 2  MODEL keywords  (page 2 of 8)


Keyword Description Refer to
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else An operator that is used when 
evaluating expressions.


“Else operator” on page 110.


enum A data type supported by MODEL. 
Enumerated type assigns integer 
values to each of its tags.


“Enumerations” on page 52.


event A type of declaration that defines a 
basic event, meaning it is 
observable in the object where it 
occurs. 


“Event declaration” on 
page 81.


events_only Indicates that a proxy declaration is 
restricted to proxy only events, as 
opposed to events and attributes.


explains Indicates that this symptom of a 
problem is used for display 
purposes and does not affect the 
analysis. 
Indicates that this member of the 
<symptom_list> of a symptom is 
used for display purposes and does 
not affect the analysis. 


“explains keyword” on 
page 86.
“explains keyword” on 
page 89.


export Indicates that the associated 
event-driven behavior is visible 
outside of the Repository. 
EMC Smarts clients, such as the 
Global Console and adapters, can 
subscribe to exported event-driven 
behavior and receive notifications 
when they occur.


“Export declaration” on 
page 95.


external Indicates whether the literal text 
specified as the initial value of a 
string attribute will be externalized. 
The external keyword implies both 
static and readonly. When including 
the external keyword in a 
declaration, do not include the 
static and readonly keywords.


“Stored attributes” on 
page 63.


FALSE A valid value for a boolean data 
type.


“Data types” on page 51.


float A data type supported by MODEL. “Data types” on page 51.


foreach This keyword is used in constraint 
expressions to iterate over the 
contents of a relationshipset, 
applying a test to each element.


“Constraints” on page 123.


fragment A computation expression that my 
be embedded in other expressions.


get_row A keyword used in expressions to 
get a row from a table.


hard Modifies a constraint to indicate 
that it is always enforced and fatal 
to violate.


“Constraints” on page 123.


Table 2  MODEL keywords  (page 3 of 8)


Keyword Description Refer to
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idempotent Indicates that the operation, if 
called multiple times without an 
intervening put, will return the same 
value each call.


The description of idempotent on 
page 101.


if Indicates a guard clause in an event 
expression.


“Guarded events” on page 82.


implementation Designates text that is copied 
verbatim to the generated C++ code. 
This keyword is used at the end of 
an interface declaration.


“Interface header declaration” 
on page 57.


imported Reserved for future use.


in When the in keyword is included 
with an argument to an operation, it 
indicates that information passes 
from the caller to the operation. 


“in keyword” on page 103.


inout An operation argument direction 
modifier. 


“inout keyword” on page 104.


instrument A type of declaration that specifies 
the access method for all of the 
instrumented attributes of the class 
for which it is declared. 


“Instrument Declarations” on 
page 127.


instrumented Indicates an access type for an 
attribute. An instrumented attribute 
obtains its value through a standard 
protocol, such as SNMP, and 
requires a separate instrumentation 
declaration that ties the attribute to 
the protocol.


“Instrumented attributes” on 
page 68.


instrumented_op Reserved for future use.


int A data type supported by MODEL. “Data types” on page 51.


interface Defines a managed object class or a 
type of managed element in the 
Repository.


“Declaring an Interface” on 
page 55.


internal Indicates that the attribute or 
operation is not visible outside of 
the repository. 


“Operation Declarations” on 
page 99.


key A means to access a table. If a key is 
declared, then the table row must 
be a struct and the key must be a 
field of the struct.


“Table attributes” on page 73.


long A data type supported by MODEL. “Data types” on page 51.


loss Specifies the probability that the 
observable basic event is lost or not 
observed (its expression does not 
evaluate to true) even though it is 
occurring. 


“Event declaration” on 
page 81.


Table 2  MODEL keywords  (page 4 of 8)


Keyword Description Refer to
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max An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


min An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


obj A built-in function in MODEL. The 
term obj( 
<string_expression> returns 
the object whose name matches the 
result of the string expression. 


“Object” on page 114.


old The old keyword can be used before 
an attribute name in a constraint 
expression. When used, it indicates 
“check the attribute’s old value”.


“Constraints” on page 123.


or An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


out When the out keyword is included 
with an argument to an operation, it 
indicates that value of the argument 
is set by the operation and returned 
to the caller. 


“out keyword” on page 104.


polling_frequency A built-in function in MODEL. The 
term polling_frequency(A), 
where A is an attribute, returns the 
interval, in seconds, between 
successive polls of an attribute’s 
value.


“Polling frequency” on 
page 114.


problem A type of declaration that declares 
an event that may occur in instances 
of a class. A problem causes a set of 
symptoms and the problem 
declaration specifies these 
symptoms and a probability that 
each symptom will be observed 
when the problem occurs.


“Problem declaration” on 
page 83.


prod An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


propagate Declares that the value of the 
attribute is computed or copied 
from other objects through a 
relation.


“Propagated attributes” on 
page 71.


proxy Declares an interface (class) whose 
instances represent the information 
of other interfaces.


Table 2  MODEL keywords  (page 5 of 8)


Keyword Description Refer to
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rate A built-in function in MODEL. The 
term rate(A,T), where A is an 
attribute and T is a time interval, 
returns the rate at which A changed 
during the last T seconds. 


“Rate” on page 116.


rate_last An alternative to rate(A,T) that may 
be used for polled attributes in 
cases when rate interval T equals 
the polling period of A.


“Rate_last” on page 116


readonly Prevents write access to an 
attribute’s value.
Provided for computed 
relationships.
Performs a repository-wide read 
lock when used with an operation.
The readonly keyword, when used in 
conjunction with #pragma Local 
Operation, locks (for reading) only 
the object on which the operation is 
invoked. 


“Propagated attributes” on 
page 71.
“Computed attributes” on 
page 66.
“Instrumented attributes” on 
page 68.
“Relationship Declarations” 
on page 75.
“Repository-wide read lock” 
on page 105.
“Instance-only read lock” on 
page 106.


refine All properties defined for a class are 
inherited by its subclasses. The 
refine keyword is used to modify the 
properties specified by attribute, 
relationship, and event declarations 
in the subclass.


“Attribute Declarations” on 
page 59.
“Relationship Declarations” 
on page 75.
“Declaring Event-Driven 
Behavior in MODEL” on 
page 79.


relationship Defines a to-one connection 
between classes


“Relationship Declarations” 
on page 75.


relationshipset Defines a to-many connection 
between classes.


“Relationship Declarations” 
on page 75.


REMOTE_REPOSITORY The REMOTE_REPOSITORY keyword 
is used in conjunction with the 
instrument keyword. 


“Instrument Declarations” on 
page 127.


required Indicates that an attribute’s value 
must be initialized when an 
instance of the class is created. A 
transaction must be used to create 
and initialize the attribute.


The description of the required 
keyword on page 64.


return Specifies a return value from a 
function written in MODEL.


“Operation Declarations” on 
page 99.


row Declares an identifier in an SNMP 
row.


self A reference to the current instance 
in an expression.


“Syntax for expressions” on 
page 118.


set Indicates that the operation returns 
a set of values.


“Return_type parameter” on 
page 102.


short A data type supported by MODEL. “Data types” on page 51


Table 2  MODEL keywords  (page 6 of 8)


Keyword Description Refer to
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SNMP The SNMP keyword is used in 
conjunction with the instrument 
keyword. 
The instrument SNMP declaration 
connects the instrumented 
attributes to an SNMP object 
identifier (OID). 


“Instrument Declarations” on 
page 127.
“Instrumented attributes” on 
page 68.


soft Constraints may be either hard or 
soft. Soft constraints are currently 
treated similar to hard constraints.


“Constraints” on page 123.


spurious Specifies the probability that this 
observable basic event is not 
occurring, even though the event 
expression evaluates to true.


“Event declaration” on 
page 81.


static Declares the scope of a stored 
attribute. If the stored attribute is 
declared static, a single copy of the 
attribute value is shared by all 
instances of the interface.


“Stored attributes” on page 63


stored Specifies an access type for an 
attribute. The value of a stored 
attribute is specified in the 
model or set at runtime when 
the instance is created.
It is also a keyword used to specify 
the access type of a relationship. It 
specifies where and how 
information about the relationship 
is obtained.


“Stored attributes” on 
page 63.
“Relationship Declarations” 
on page 75.


string A data type supported by MODEL. “Data types” on page 51.


struct A data type supported by MODEL. “Structures” on page 53.


sum An aggregate operator that is used 
to determine the results when 
propagating attributes over a 
relationshipset.


“Attributes propagated over a 
relationshipset” on page 61.
“Propagated attributes” on 
page 71.


symptom A type of declaration that groups a 
set of basic events, symptoms, 
propagated symptoms and other 
problems that it can cause into a 
single event by conjunction. 


“Symptom declaration” on 
page 88.


table A type of data attribute. It is a 
collection of rows, each of which 
can be a scalar or a structure.


“Table attributes” on page 73.


timestamp The term timestamp(A), where A 
is an attribute, returns the time 
when the value of A was last 
changed. Used in conjunction with 
the timestamped keyword.


“Timestamp” on page 117.


Table 2  MODEL keywords  (page 7 of 8)


Keyword Description Refer to
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timestamped When an attribute is declared with 
the optional keyword timestamped, 
the Domain Manager creates a 
read-only unsigned integer whose 
value is the time that the attribute 
was last updated.


“Stored attributes” on 
page 63.


TRUE A valid value for a boolean data 
type.


“Data types” on page 51.


unique Defines an interface where only one 
instance of the interface, or any 
derived interface, may be 
instantiated at any given time.
When used with a table, it specifies 
that each row must have a 
unique key.
There is also a unique operator for 
set expressions.


“Interface header declaration” 
on page 57.
The description of the unique 
keyword on page 74.
“Operators for set 
expressions” on page 112.


unsigned Indicates an unsigned int data type 
in a class declaration.


unstringable Indicates an external type has no 
means to convert to/from a string 
representation.


void The value type returned when an 
operation has no return value.


“Return_type parameter” on 
page 102.


with An alternative to events_only. It is 
used in a proxy declaration to proxy 
all of the events and attributes of an 
interface (class).


Table 2  MODEL keywords  (page 8 of 8)


Keyword Description Refer to

Keywords 49







Basic Lexical Elements of MODEL

Table 3  C++ and other reserved words


and_eq extern sizeof


asm external static_cast


auto for switch


bitand friend template


bitor function this


bool goto throw


break handler try


catch inline type


causes mutable typedef


char namespace typeid


class new typename


compl not union


const_cast not_eq using


continue operator value


CORBA or_eq virtual


delete private volatile


do protected wchar_t


dynamic_cast public while


error_code register xor


explicit reinterpret_cast xor_eq


extern signed
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Identifiers
A MODEL identifier must start with an upper or lowercase letter but may contain any 
number of letters, numbers, and underscores after the first letter. You cannot use any 
MODEL or C++ keyword as an identifier.


The scope of an identifier declared in an interface is limited to the scope of that interface. 
Subclasses, however, extend the scope of an interface. All identifiers of a class are visible 
to its subclasses.


Data types
Table 4 on page 51 lists the data types supported by MODEL. 


Table 4  Supported types


Data Type Definition


Fundamental Types binary Binary data.


boolean Two possible values: TRUE or FALSE.


byte An unsigned 8-bit integer ranging from 0 to 
255.


double Any double-precision floating point 
number (similar to C++).


float Any single-precision floating point number 
(similar to C++).


int A 32-bit integer ranging from -2^31 to 
+(2^31 -1).


long A 64-bit integer ranging from -2^63 to 
+(2^63 -1).


short A 16-bit integer ranging from -32,768 to 
32,767.


string A NUL-terminated array of UTF-8 data.


unsigned int Unsigned 32-bit integer ranging from 0 to 
(2^32 - 1).


unsigned long Unsigned 64-bit integer ranging from 0 to 
(2^64 - 1).


unsigned short Unsigned 16-bit integer ranging from 0 to 
65,535.


User-defined Types enum Enumerated type that assigns integer 
values to each of its tags. Integer values 
may be positive, negative or zero.


struct A collection of fields, each field specifies 
its own type.
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Enumerations


An enumerated type contains a list of tags and assigns integer values to each of the tags. 
The integer values may be positive, negative or zero. Enumerations that are declared 
without numerical assignments start with 0 and increase by 1. 


Each tag must be unique within a namespace (global or within an interface); you cannot 
have two enumerations in the same namespace that contain the same tag.


The format for declaring an enumeration is as follows: 


The following example defines the enumeration OperationalState.


enum OperationalState {OFF, ON, UNKNOWN, TESTING};


Since the declaration does not specify values for any of the tags, the first tag is assigned 
the value 0. The value of each subsequent tag increments by one. Therefore, OFF is equal 
to 0, ON is equal to 1, UNKNOWN is equal to 2, and TESTING is equal to 3.


In this example, ON is assigned a specific value in the declaration.


enum OperationalState {OFF, ON = 4, UNKNOWN, TESTING};


OFF is equal to 0, and ON is equal to 4. Since UNKNOWN and TESTING have not been 
declared with a specific value, they increment by 1 from the value of the preceding tag. 
Therefore, UNKNOWN is equal to 5, and TESTING is equal to 6.


Enumerations can also be defined outside of an interface, in the global name space. 
However, as a best practice you should avoid global enumerations. You can declare an 
abstract interface and then define all of your enumerations in that one interface.


Once you have an enumeration defined, you can use the enumeration as a data type in 
other declarations, such as attributes and events. For example, the enumeration state_e is 
declared in the MyEquip class. The attribute OperationalState is then declared with the 
state_e data type, and initialized to one of the tags in the state_e enumeration. 


interface MyEquip : ICIM_ManagedElement
{


enum state_e { OK, MALFUNCTION, UNKNOWN };
attribute state_e OperationalState = UNKNOWN;
event malfunctioning


= OperationalState == MALFUNCTION;
}


You can also reference enumerations that are defined in other classes. If the class 
containing the enumeration is in another model file, then the model file with the 
enumeration must be referenced in your model file with the #include and #pragma 
include_h statements. 


<enum> ::= enum


<enum_name>


“{“ <tags_list> “}”


“;”


<tags_list> ::= <tag>


[“,” <tags_list>]


<tag> ::= <tag_name>


[ <tag_value> ]


<tag_value> ::= “=”


int
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An enumeration can be used as a data type in other interface declarations, using the 
syntax <interface_name>::<enumeration_name>. 


An enumeration tag can also be declared in one interface and referenced in another 
interface declaration, using the syntax <interface_name>::<tag_name>. 


In this example, the class OtherEquipment is defining an attribute that will use the 
enumeration defined in the MyEquip class. In addition, the UNKNOWN and MALFUNCTION 
tags are also referenced.


interface MyEquip : ICIM_ManagedElement
{


enum state_e { OK, MALFUNCTION, UNKNOWN };
attribute state_e OperationalState = UNKNOWN;
event malfunctioning


= OperationalState == MALFUNCTION;
}


interface OtherEquipment : ICIM_ManagedElement
{


attribute MyEquip::state_e OperState = MyEquip::UNKNOWN;
event Down


= OperState == MyEquip::MALFUNCTION;
}


Structures


Structures can be defined within an interface or outside of an interface, in the global name 
space. Within a namespace (interface or global), the structure name must be unique. 
However, as a best practice you should avoid global structures. 


Each structure defines a namespace for their fields. Therefore, two or more structures can 
have the same field names. 


The format for declaring a structure is as follows: 


<struct> ::= struct


<struct_name>


“{“


<fields_list> 


“}”


“;”


<fields_list> ::= <field>


[ <fields_list> ]


<field> ::= <field_type>


<field_name>


“;”


<field_type> ::= double


| float


| [unsigned] int


| [unsigned] long


| [unsigned] short


| boolean


| binary


| byte


| string


| <enum_type_name>
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In this example, the structure AuditTrailEntry is declared. This structure contains five 
fields.


struct AuditTrailEntry
{
        unsigned SerialNumber;
        unsigned Timestamp;
        string   User;
        string   ActionType;
        string   Text;
};


You can declare an attribute with a struct type:


attribute demoStruct AuditTrailEntry;
When you get the values, you use a dotted notation on the attribute name and the field 
name.


You can also use a structure when declaring a table attribute. In this example, each row in 
the AuditTrail table consists of the five fields of the AuditTrailEntry structure. In addition, 
the SerialNumber field is used as the unique key in the table.


table AuditTrail AuditTrailEntry
descending unique key SerialNumber
"The audit trail for the event.";
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Declaring an Interface

Overview
An interface defines a managed object class or a type of managed element in the 
Repository. An interface can be defined by an interface declaration or a forward 
declaration.


Forward declaration 


A forward declaration declares the name of an interface and indicates that its definition 
appears later in the MODEL file. A MODEL class cannot be referenced before it is declared. 
You can use the forward declaration to declare a class whose full declaration appears 
later. A forward declaration includes the keyword interface and the name of the interface.


Note: The relationship declaration is an exception to the rule that dictates that a MODEL 
class cannot be referenced before it is declared. A relationship declaration may declare a 
reciprocal class for the relationship, and the reciprocal class may not yet be declared. 


Interface declaration
An interface declaration is composed of an interface header statement followed by a 
series of interface definition statements enclosed by curly braces. Interface definition 
statements describe the properties of the class.


◆ Attributes, relationships, and operations on instances of the class.


◆ Problems and events associated with instances of the class and the causal relations 
among the instances.


◆ Access types for the attributes of the interface.


The syntax of an interface declaration: 


The declarations that define the properties of an interface are described in the following 
chapters. 


The names of each of these properties, such as an attribute, problem, relationship and so 
on, must be unique within an interface. For example, if you have an attribute named 
“Target1”, then you cannot name any other property of this class “Target1”.


<interface> ::= <interface_dcl>


| <forward_dcl>


<forward_dcl> ::= interface <interface_name>


<interface_dcl> ::= <interface_header> 


<interface_description>


"{"


<declarations>


[ <opt_implementation> ]


"}"


[ ; ]


<opt_implementation> ::= implementation


“:”


<user-entered text>
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The optional <opt_implementation> parameter defines text that is copied verbatim to the 
generated C++ code when the MODEL is compiled. In this example, the text “void init ( )” 
would be copied into the C++ file that is generated from the .mdl file.


interface MyClass1: TopClass
{
    refine FileName
    = "mymod/layout.xml";


    implementation:
            void init();
};


IMPORTANT


Do not call a Java implemented construct from within the C++ init( ) class.


Interface header declaration


An interface header declaration specifies the name of an interface and its inheritance 
specification. 


The optional keyword abstract defines an interface for which instances cannot be 
instantiated. Classes that can be directly instantiated must define implementations for all 
of their attributes. Classes that are declared as abstract and cannot be directly 
instantiated may specify attributes for which implementations are not defined. To 
instantiate instances of a subclass of an abstract class, the subclass must define 
implementations for all of its attributes. By default, an interface is not abstract.


The optional keyword unique defines an interface where only one instance of the 
interface, or any derived interface, may be instantiated at any given time. If you create an 
instance, and destroy it, you can then create another instance.


Inheritance
MODEL is a single-inheritance language: an interface can only inherit from one other 
interface. There are two base classes from which you can inherit: MR_ManagedObject and 
MR_MetaObject. MR_ManagedObject serves as the base class for all managed objects. 
When you develop a correlation model, the classes that represent types of managed 
objects should inherit from MR_ManagedObject. MR_MetaObject serves as the base class 
for objects that do not correspond to managed elements. Objects derived from 
MR_MetaObject may be used for configuration and control purposes. 


Interfaces are related in a subclass/superclass tree. The inheritance specification, 
<inheritance_spec>, declares the class that the interface inherits from. The inheritance 
specification parameter is specified with a colon (:) followed by the name of the 
superclass.


<interface_header> ::= [ abstract ][ unique ]


interface


<interface_name>


<inheritance_spec>


<inheritance_spec> ::= ":" <parent_class>
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All properties defined for a class are inherited by its subclasses. You can refine properties 
specified by attribute, relationship, and event declarations in the subclass. You can also 
add properties to a subclass to introduce a unique behavior or state.


interface NetworkAdapter;     /* Forward Declaration */


abstract interface ComputerSystem : MR_ManagedObject
{
}


interface Router : ComputerSystem
{
}
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Overview
Attributes describe the state of a managed object. Their values can be queried and 
manipulated by EMC Smarts clients and displayed in a console.


A data attribute can have a value of scalar, structure, or table type. A scalar value is one of 
the pre-defined set of types. A table is a collection of rows, each of which can be a scalar 
or a structure.


Access types for attributes
The value of an attribute can be accessed using one of four methods: stored in the 
Repository, computed on demand, instrumented (that is, accessed using an accessor), or 
propagated from other objects through a relationship.


◆ Stored attributes can have an initial value that is a constant. If the stored attribute is 
not declared as readonly, an EMC Smarts client such as an adapter can update or 
change the attribute’s value.


◆ The value of a computed attribute is calculated on demand, when the value of the 
attribute is required.


◆ Instrumented attributes obtain their value through an accessor. Instrumented 
attributes require a separate instrumentation declaration that ties the attribute to the 
protocol.


◆ The value of a propagated attribute is obtained from one or more instances of a 
related class through a relationship or relationshipset. A propagated attribute whose 
value is retrieved through a relationship returns a single value from the related object. 
A propagated attribute whose value is retrieved through a relationshipset is 
computed by applying an aggregate operator to a set of values, one value from each 
related object.
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When the value of an attribute is unavailable
A Domain Manager monitors those attributes necessary to determine when events that 
have been subscribed to occur. When the status of a monitored attribute changes, the 
Domain Manager evaluates the event expressions that depend on this attribute. If the 
Domain Manager is unable to retrieve the value of a monitored attribute, for whatever 
reason, the Domain Manager marks the attribute as unavailable.


When an attribute is marked as unavailable, the Domain Manager no longer attempts to 
retrieve its value. An event expression that uses the value of this attribute may also 
become unavailable, depending on how the attribute value is used in the event 
expression. “When the value of an expression is unavailable” on page 120 provides 
additional information regarding unavailable events.


There are several reasons why a Domain Manager might not be able to retrieve the value of 
an attribute.


◆ An instance that contains the attribute does not exist (was not created or was 
deleted). Typically, this affects propagated attributes whose value is retrieved through 
a relationship or a relationshipset.


◆ If the attribute is instrumented, the Domain Manager may not be able to retrieve its 
value because of external problems. For example, network congestion may impede 
the Domain Manager's attempts to retrieve the value of an attribute that is 
instrumented through a protocol.


When the status of an unavailable attribute changes, the Domain Manager automatically 
retrieves its value and evaluates any dependent event expressions.


MODEL also provides a default value for an attribute whose value is obtained by 
propagation from an empty relationshipset. In this case, the default value of the attribute 
is the identity value for the aggregate operator. 


Attributes propagated over a relationshipset


Attributes that propagate over a relationshipset must be of a numeric or Boolean type. The 
results returned by propagation over an empty relationshipset depend on the aggregate 
operator. Table 5 on page 61 lists the identity value of an empty relationshipset and the 
corresponding aggregate operator. 


Table 5  Identity result for aggregate operators


Aggregate Operator Identity Value


and True


or False


max Lowest possible value


min Highest possible value


sum 0


prod 1


avg Error
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The following example interface declares one propagated attribute for each aggregate 
operator. The value of each attribute propagates from a related class through a 
relationshipset. This example explains the identity values listed in Table 5 on page 61. 


interface Ex2 : MR_ManagedObject
{


propagate attribute boolean and A3 <= C3, R3;
propagate attribute boolean or A4 <= C4, R4;
propagate attribute int max A5 <= C5, R5;
propagate attribute int min A5 <= C6, R6;
propagate attribute int sum A7 <= C7, R7;
propagate attribute int prod A8 <= C8, R8;
propagate attribute int avg A9 <= C9, R9;


}


The and aggregate operator returns true for an empty set. You expect that inserting a true 
value to any set leaves the and aggregate unchanged. This can only occur if the identity 
value of the and aggregate operator is true. Similarly, the or aggregate operator returns a 
value of false when R4 is empty. You expect that inserting a value of false to any set leaves 
the or aggregate unchanged. This can only occur if the identity value of or is false.


The max aggregate operator returns the lowest possible value for an empty set. When you 
insert a value that is higher than the current maximum to R5, the value of A5 increases to 
reflect the new maximum value. This can only occur if the identity value of the max 
operator is the lowest possible value. Similarly, when you insert a value that is lower than 
the current minimum to R6, you expect the value of A5 to change accordingly. This can 
only occur if the identity value of the min operator is the highest possible value.


The sum aggregate operator returns a zero for an empty set. If you insert a value of one to 
R7, you expect the value of A7 to increase by one. This can only occur if the identity value 
of the sum operator is zero.


The prod aggregate operator returns a value of one for an empty set. When you insert a 
value of two to R8, you expect its value to double. This can only occur if the identity value 
of the prod operator is one.


The avg aggregate operator is different from the other aggregate operators in that it has no 
identity value. If A9 is initially empty and you insert a value of one, the average should be 
one, the only value in the set. However, the value of A9 in this case is A9 + 1/2. For A9 to 
equal one, its initial value would have to be one. If you substitute two for the one, the 
same result occurs. Because of this, there is no identity value that works with every 
possible value inserted into A9.


Minimizing the effects of unavailable attributes


You can, for certain situations, write MODEL code that prevents an attribute from 
becoming unavailable. For example, when the value for an attribute propagates from a 
related instance, you can write an event expression that determines whether that related 
instance exists before the Domain Manager retrieves the value of the attribute.


The following example illustrates this technique. The value of attribute A1 propagates 
from a related instance through relationship R1. Event E1 is only evaluated when the 
number of instances participating in R1 is greater than zero. The vertical bars (||) 
surrounding R1 produce a count of the related instances. If the count of R1 is not greater 
than zero, the Boolean expression evaluates to False. If the count of R1 is greater than 
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zero, the first term of the Boolean expression evaluates to True and the Domain Manager 
can safely retrieve the value of A1 to determine whether the second term, and the entire 
event expression, evaluate to true.


interface Example : MR_ManagedObject
{


relationship R1, Example2;
propagate attribute boolean A1 = Example2, R1;
event E1 = |R1| > 0 && A1;


}


Stored attributes
The value of a stored attribute is specified in the model or set at runtime when the 
instance is created. If the attribute is declared as readonly, its value cannot be updated or 
changed by an EMC Smarts client. A typical use of a stored attribute is to provide a name 
for an object as a string. 


The internal keyword indicates that this attribute is only visible within the generated C++ 
code. The attribute is not visible through an external interface, and therefore it cannot be 
viewed in a console. 


<attribute_dcl> ::= [ internal ]


[ static ][ readonly ]


[ stored ]


attribute 


[ external ]


<attribute_type>


[ <value_range> ]


<attribute_name>


[ required ]


[ timestamped ]


[ <attribute_description> ]


[ "=" <initial_value> ]


";"


|


refine 


stored


<attribute_name>


[ required ]


[ timestamped ]


[ <attribute_description> ]


[ “=” <initial_value> ]


";"


<value_range> ::= "["


<integer_literal>


“ “


".."


“ “


<integer_literal>


"]"
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Note: A computed attribute that is not marked as internal can use the internal attribute in 
an expression, thus making the internal attribute’s value visible to an external interface.


The optional keyword static declares the scope of the attribute. If the stored attribute is 
declared static, a single copy of the attribute value is shared by all instances of the 
interface.


The optional keyword readonly prevents write access to an attribute’s value. In this 
example, the value of the attribute is set to 865.0 and cannot be changed.


readonly attribute float LowOxygenPressureThreshold
        "Minimum operational oxygen pressure (psi)."
        = 865.0;


Note: A readonly attribute must be given an initial value.


The keyword attribute identifies this as an attribute declaration. The keyword stored 
declares the attribute’s access type. The stored keyword is optional because if you declare 
an attribute without a keyword specifying the access type, a stored attribute is created, by 
default.


The keyword external indicates whether the literal text specified as the initial value of a 
string attribute will be externalized. The external keyword implies both static and 
readonly. When including the external keyword in a declaration, do not include the static 
and readonly keywords. In this example, the <initial value>, Jim Smith, will be externalized.


interface Pitcher : MR_ManagedObject 
“The man who throws the baseball”
{
   attribute external string Name 
   “The name of the pitcher” = “Jim SMith”; 
}


The <attribute_type> parameter specifies an attribute’s data type. A stored attribute can be 
any one of the supported types listed in “Data types” on page 51.


The required keyword indicates that the value of the attribute must be initialized when an 
instance of the class is created. Therefore, the creation and initialization must be done 
using a transaction. Transactions can be written in ASL or using one of the remote APIs 
(Java, Perl or C). To set values it must be a write-transaction (read only transactions cannot 
create instances or assign values). This example shows the basic format of a 
write-transaction in ASL:


tx = transaction(WRITE_LOCK);
create instance
set instance's required attribute(s)' s values.
tx->commit();


When an attribute is declared with the optional keyword timestamped, the Domain 
Manager creates a readonly unsigned integer whose value is the time that the attribute 
was last updated. To retrieve this value, use the timestamp() function described in 
“Timestamp” on page 117. The time is calculated by counting the number of seconds that 
have elapsed since Midnight of 1 January 1970 (GMT). The last update is the most recent 
call to the put method for a stored attribute and the most recent poll for an instrumented 
attribute.
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Note: Attributes that are declared as stored cannot use the timestamped keyword with the 
keyword readonly. Only attributes declared as instrumented can use the timestamped 
keyword with the readonly keyword, as described in “Instrumented attributes” on 
page 68.


The optional <initial_value> parameter sets an initial value for the attribute when the 
object is instantiated. In this example, whenever an instance of the Engine class is 
created, the Temperature attribute for that instance will have an initial value of 0.


interface Engine : ICIM_Managed_Element
{


stored attribute float Temperature 
        "Internal gas temperature (fahrenheit)."
        = 0;
}


The optional <value_range> parameter indicates the expected range of the value. Currently, 
it does not impose any constraints on the variable’s value. However, you can use the 
range to set things, such as the end-points of slider bar. In this example, the 
MaxResponseTime attribute has a range of 0 to 60 with an initial value of 2.


attribute unsigned long [0 .. 60] MaxResponseTime
"The maximum response time (in seconds). The actual 
response time is compared against this threshold to
determine if the process is running slow."
= 2;


In this example, the enumeration state_e is defined. state_e is then used as the 
<attribute_type> in the attribute declaration.


enum state_e { OK, MALFUNCTION, UNKNOWN };
readonly attribute state_e OperationalState 


"Operational State of this device. Possible states are: "
" OK, MALFUNCTION, or UNKNOWN "
= UNKNOWN;


You can also define a structure and then use the name of the struct as the <attribute_type> 
in your attribute declaration.


Refine keyword


The keyword refine declares this attribute as a refinement of an attribute declared in a 
superclass of this class. 


The stored keyword is required if you are refining the access type of an attribute to the 
stored access type. 


The stored keyword is optional if you declared or refined the attribute to be the stored 
access type in the parent class. If you do not specify the access type in the refine 
statement, the access type defaults to the access type defined in the previous 
specification going up the class hierarchy. The previous specification is either a 
refinement of the attribute that includes the access type keyword or the original attribute 
declaration.


You can add/modify the description and the initial value of the attribute.
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Computed attributes
A Domain Manager determines the value of a computed attribute by evaluating an 
expression. You define an expression using the operators, functions, and types supported 
by MODEL. “Lexical elements for expressions” on page 108 provides additional 
information regarding operators, and “Data types” on page 51 describes the supported 
data types.


Computed attributes are used for calculating rates and displaying the information to an 
EMC Smarts client or for presenting information in readable format. 


The internal keyword indicates that this attribute is only visible within the generated C++ 
code. The attribute is not visible through an external interface, and therefore it cannot be 
viewed in a console.


The optional keyword readonly prevents write access to an attribute’s value. The default 
behavior of a computed attribute is readonly, even if the readonly keyword is omitted. 
However, when you refine a computed attribute the readonly flag will only be applied if 
you specifically set the readonly keyword in the original computed attribute. The refined 
computed attribute inherits the readonly flag from the computed attribute in the parent 
class. 


The keyword attribute indicates that this is an attribute declaration. The keyword 
computed declares the access type of the attribute.


<attribute_dcl> ::= [ internal ]


[ readonly ]


computed 


attribute


<attribute_type>


[ <value_range> ]


<attribute_name>


[ required ]


[ timestamped ]


[ <attribute_description> ]


["=" <expression>]


";"


|


refine


computed


<attribute_name>


[ required ]


[ timestamped ]


[ <attribute_description> ]


"=" <expression>


";"


<value_range> ::= "["


<integer_literal>


“ “


".."


“ “


<integer_literal>


"]"
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The <attribute_type> parameter specifies an attribute’s data type. A stored attribute can be 
any one of the supported types listed in “Data types” on page 51.


The MODEL syntax for a computed attribute and a stored attribute are similar. One 
important difference is the <expression> parameter. This parameter provides a way for you 
to write an expression that the Domain Manager uses to compute the attribute’s value. 
This expression must be a MODEL expression; it cannot be procedural code. “Syntax for 
expressions” on page 118 describes the syntax of expressions.


This example computes a value for the attribute CurrentUtilization.


computed attribute float CurrentUtilization
= ((TotalRate * 8) / (MaxSpeed + 0.001)) * 100;


Refine keyword


The keyword refine declares this attribute as a refinement of an attribute declared in a 
superclass of this class. 


The computed keyword is required if you are refining the access type of an attribute to the 
computed access type.


The computed keyword is optional if you declared or refined the attribute to be the 
computed access type in the parent class. If you do not specify the access type in the 
refine statement, the access type defaults to the access type defined in the previous 
specification going up the class hierarchy. The previous specification is either a 
refinement of the attribute that includes the access type keyword or the original attribute 
declaration.


When you refine a computed attribute the readonly flag will only be applied if you 
specifically set the readonly keyword in the original computed attribute. The refined 
computed attribute inherits the readonly flag from the computed attribute in the parent 
class.
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Instrumented attributes
The value of an instrumented attribute is retrieved by a Domain Manager through a 
standard protocol. The runtime support for instrumentation is provided by a component 
called an accessor. A Domain Manager includes an SNMP accessor for retrieving the 
values of SNMP MIB variables.


When an attribute is instrumented through the SNMP accessor, the accessor retrieves the 
value of the attribute from a remote SNMP agent. The SNMP accessor does this by polling 
the values of the SNMP MIB variables that correspond to the instrumented attribute. Only 
attributes necessary to evaluate events that have been subscribed to are actually polled.


The type of an instrumented attribute must match the type of the MIB variable retrieved by 
the SNMP accessor. When the SNMP accessor retrieves a MIB variable, it verifies that its 
type matches the type declared for the corresponding MODEL attribute. The SNMP 
accessor rejects a MODEL attribute of type enum because the type it retrieves from the 
SNMP agent is an integer. When the SNMP accessor detects a type mismatch, the Domain 
Manager logs an error and the user receives the error SNMP_EAGENTBUG.


The variable types that appear in MIBs are defined by Abstract Syntax Notation 1 (ASN.1). 
SNMP defines a base set of types on top of the ASN.1 types. Table 6 on page 68 lists the 
common MIB types, the corresponding SNMP type, and the corresponding MODEL 
attribute type. 


Table 6  MIB, SNMP, and MODEL Types


MIB Type SNMP Type MODEL Attribute Type


DisplayString OCTET STRING string


IpAddress OCTET STRING string - Requires the #pragma DotNotation. 
“#pragma DotNotation” on page 135 provides 
additional information.


Counter INTEGER unsigned int - Requires the #pragma WrapCounter. 
“Pragmas used with SNMP instrumentation” 
on page 135 provides additional information.


Gauge INTEGER unsigned int


TimeTicks INTEGER unsigned int


Integer32 INTEGER int


Counter32 INTEGER unsigned int - Requires the #pragma WrapCounter. 
“Pragmas used with SNMP instrumentation” 
on page 135 provides additional information.


Gauge32 INTEGER unsigned int


Unsigned32 INTEGER unsigned int


OID OBJECT IDENTIFIER string - Requires the #pragma Object ID. “#pragma 
ObjectID” on page 135 provides additional 
information.


Counter64 COUNTER64 unsigned long
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Developing a MODEL with instrumented attributes is a two-step process that requires you 
to complete steps during both MODEL development and at runtime. This section describes 
the MODEL requirements for attribute declarations and the syntax of instrumented 
attributes. A summary of the runtime requirements appears in “Summary of runtime 
requirements for SNMP instrumentation” on page 129.


To properly instrument an attribute, MODEL code must meet two conditions:


◆ It must contain attributes declared as instrumented. Furthermore, all of the 
instrumented attributes of a given instance must get their value from the same SNMP 
agent. When you retrieve values from an SNMP table, such as ifTable, the rule of 
thumb is to map a MODEL class to a row of an SNMP table. In the class, declare a 
separate instrumented attribute for each column of the table and create an instance 
to represent each row.


◆ It must contain an instrumentation declaration for each class with instrumented 
attributes. For SNMP instrumentation, the instrumentation declaration maps the 
instrumented attributes of a class to OIDs. “Instrument Declarations” on page 127 
describes the syntax of an instrumentation declaration.


The syntax of an instrumented attribute declaration is shown below. 


The internal keyword indicates that this attribute is only visible within the generated C++ 
code. The attribute is not visible through an external interface, and therefore it cannot be 
viewed in a console.


The keyword attribute identifies this as an attribute declaration. The keyword 
instrumented declares the access type of this attribute.


The <attribute_type> parameter specifies an attribute’s data type. An instrumented 
attribute can be any one of the supported types listed in “Data types” on page 51.


<attribute_dcl> ::= [ internal ]


[ readonly ]


instrumented 


attribute


<attribute_type>


[ <value_range> ]


<attribute_name>


[ <attribute_description> ]


";"


|


refine


instrumented


<attribute_name> 


[ <optional_description> ]


";"


<value_range> ::= "["


<integer_literal>


“ “


".."


“ “


<integer_literal>


"]"
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Note: SNMP does not support enumeration types. They may appear in a MIB as a list, 
however, they come across the network as integers.


An instrumented attribute does not require the use of the keyword timestamped because 
the SNMP accessor automatically maintains this information. You can retrieve the most 
recent time at which the value of an instrumented attribute changed as you would for a 
stored or computed attribute declared as timestamped. “Timestamp” on page 117 
provides additional information.


Refine keyword


The keyword refine indicates that this declaration is a refinement of an attribute in a 
related class.


The instrumented keyword is required if you are refining the access type of an attribute to 
the instrumented access type.


The instrumented keyword is optional if you declared or refined the attribute to be the 
instrumented access type in the parent class. If you do not specify the access type in the 
refine statement, the access type defaults to the access type defined in the previous 
specification going up the class hierarchy. The previous specification is either a 
refinement of the attribute that includes the access type keyword or the original attribute 
declaration.


Example of instrumented attribute


The following example shows an instrumented attribute, sysUpTime, whose value is 
retrieved from an SNMP-enabled device that supports MIB-II. The connection between this 
attribute and the sysUpTime MIB variable is demonstrated in “Instrument Declarations” 
on page 127.


interface AgentStatus
{


instrument SNMP{
sysUpTime = "1.3.6.1.2.1.1.3"


};


#pragma WrapCounter
readonly instrumented attribute unsigned sysUpTime


"The time (in hundredths of a second) since "
"the network management portion of the system "
"was last re-initialized.";


}


The WrapCounter pragma is used with instrumented attributes of an unsigned numeric 
type that get their value from a MIB counter variable. This pragma prevents rates and 
deltas that are computed over the attribute from returning a negative value. If the current 
value of the attribute is smaller than the previously retrieved value, the Domain Manager 
assumes that the counter has wrapped.


“MODEL Pragmas” on page 131 describes the available MODEL pragmas. “Built-in 
functions” on page 113 describes the rate and delta operators.
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Propagated attributes
An attribute declared as propagated obtains its value from an attribute in one or more 
instances of a related class. The value is retrieved from one instance for a relationship and 
one or more instances for a relationshipset. The type of a propagated attribute must be 
compatible with the type of the attribute in the related class. For example, you could 
declare a propagated attribute with the sum, prod, or avg aggregate operator as a float or 
a double, even if the values propagate from an attribute declared as an int.


MODEL supports two types of relationships: to-one, which are declared with the 
relationship keyword; and to-many, which are declared with the relationshipset keyword. 
The cardinality of a relationship determines the attribute type that can propagate.


◆ Any MODEL-supported type can propagate through a to-one relationship.


◆ Only Boolean or numeric types can propagate through a to-many relationshipset. You 
can, however, use a computed attribute or a set expression to avoid this limitation. 


<attribute_dcl> ::= [ internal ]


propagate


attribute


<attribute_type>


[ <aggregate_operator> ]


<attribute_name>


[ <attribute_description> ]


"<="


<class_name>


","


<relationship_name>


[ "," <attribute_name> ]


";"


| refine


propagate


attribute


[ <aggregate_operator> ]


<attribute_name>


[ <attribute_description> ]


"<="


<class_name>


","


<relationship_name>


[ "," <attribute_name> ]


";"


<aggregate_operator> ::= max


| min


| sum


| prod


| avg


| and


| or
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The internal keyword indicates that this attribute is only visible within the generated C++ 
code. The attribute is not visible through an external interface, and therefore it cannot be 
viewed in a console.


The keyword attribute identifies this as an attribute declaration.


The keyword propagate declares that the value of this attribute is computed or copied 
from other objects through a relation. If the relation that the attribute propagates through 
is a relationshipset, then the <aggregate_operator> parameter is required to specify how 
the attribute values from related objects are to be handled. An attribute that propagates 
through a relationshipset must be a numeric or Boolean type.


The <class_name> and <relationship_name> parameters specify the class and the 
relationship that the value of the attribute propagates from. The optional <attribute_name> 
parameter identifies the original attribute if it has a different name. If you do not provide a 
name, then the assumption is that the attribute has the same name in the related class.


Refining an existing propagated attribute


The keyword refine identifies this declaration as a refinement of a propagate attribute 
declared in a superclass.


The keyword attribute is required for a refinement of a propagate attribute declaration. A 
refinement can modify the class from which values propagate, the relationship through 
which the values propagate, the attribute that the value propagates from, and the 
aggregate operator.


Refining an attribute to be propagated


When you refine the access type of a stored or computed attribute to propagate, you need 
to provide the class name and relation name that the value propagates from. In addition, 
you must place a #pragma Uses Propagation before the attribute declaration in the parent 
class. If the pragma is not provided, a warning message is issued when the MODEL is 
compiled. “#pragma Uses Propagation” on page 134 provides additional information 
regarding this pragma.
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Table attributes
Tables provide a useful means for storing configuration and other data in a persistent and 
accessible manner. Because the Domain Manager’s Repository is persistent across 
restarts, the information is always available to an EMC Smarts client.


Tables should not be used to access variables from SNMP tables if you want to use this 
data in an event expression. Data stored in a MODEL table cannot be accessed through an 
event expression. “Instrumented attributes” on page 68 describes the technique for 
accessing and storing data from an SNMP table.


A table is a collection of rows. Table parameters, and their definitions, are similar to those 
of the attribute declaration. 


<table_dcl> ::= [ readonly ]


table


<table_name>


<row_type>


[ <table_key> ]


[ <table_description> ]


";"


| refine


<table_name>


[ <table_description> ]


";"


| propagate


table


<table_name>


<row_type>


[ <table_key> ]


[ <table_description> ]


"<="


<class_name>


","


<relationship_name>


[ "," <table_name> ]


";"


| refine


propagate


table


<table_name>


[ <table_description> ]


"<="


<class_name>


","


<relationship_name>


[ "," <table_name> ]


";"


<row_type> ::= double


| float


| [unsigned] int


| [unsigned] long
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The keyword table declares this attribute as a table.


The <row_type> parameter specifies the type of table row. For example, this declaration 
defines the SupportedRates table with a <row_type> of string.


table SupportedRates string


You can also declare a structure and then use the structure as the <row_type> in a table 
declaration. In this example, the structure circuit_alarms is declared in the Circuit class. 
The table AlarmTable is then declared in the MyNet class, using the circuit_alarms 
structure as its row type.


Interface Circuit : LogicalConnection
{
struct circuit_alarms
  {


string tableKey;
string Name;
int End;
unsigned receivedAt;
int Alarm;


  };
}
Interface MyNet
{
table AlarmTable Circuit::circuit_alarms unique key tableKey;
}


The optional <table_key> parameter, which includes the keyword key followed by the key’s 
name, specifies that the table can be accessed by a key. If a key is declared, then the table 
row must be a struct and the key must be a field of the struct. In the example above, the 
<row_type> is the structure circuit_alarms, and the key is the field tableKey.


You can also declare a direction for the key, ascending or descending, which affects how 
the table is read. When the optional keyword unique is specified, each row must have a 
unique key.


The keyword refine declares this table as a refinement of a table declared in a superclass. 
A refinement can change the table’s access type, name, and description. For a propagated 
table, a refinement can change the class from which the table propagates, the relationship 
through which the values propagate, and the table from which the values propagate.


| [unsigned] short


| byte


| binary


| string


| enum


| struct


<table_key> ::= [ ascending | descending ]


[ unique ]


key


<key_name>
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Overview
A relationship declaration defines a connection between classes. A relation can connect 
instances of different classes or instances of the same class. Relationships are important 
because attributes and events propagate along the traversal path specified by the 
relationship. 


When you declare a relationship from classA to classB, you are implicitly declaring a 
reciprocal relationship from classB to classA. This relationship pair is referred to as a 
relation.


Cardinality
Both relationships and relations have a cardinality. The cardinality of a relation is 
determined by the cardinality of its constituent relationships. A relationship from classA to 
classB may have cardinality of to-one or to-many. A cardinality of to-one means there is a 
single instance of classB related to a given instance of class A. A cardinality of to-many 
means that one or more instances of classB are related to a given instance of classA. The 
cardinality of the relation is one-to-one if both relationships are to-one, one-to-many or 
many-to-one if one relationship is to-one and the other is to-many, or many-to-many if 
both relationships are to-many.


MODEL provides two keywords to indicate the cardinality of a relationship: relationship 
and relationshipset. As you might expect, relationshipset declares a to-many relationship.


If you insert an instance into one end of a two-way relationship, the Repository guarantees 
that the inverse traversal path is correctly set. When an object is added or removed from 
the Repository, the Repository maintains the integrity of the relationship. If an object that 
participates in a relationship is deleted, the Domain Manager automatically removes it 
from the inverse traversal path.
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Declaring a relationship
Relationship declarations, like attribute declarations, are a basic building block for 
describing real-world objects. Attribute and relationship declarations share a similar 
syntax. 


The internal keyword indicates that this relationship is only visible within the interface 
(class) in which it is declared. The relationship or relationshipset is not visible through an 
external interface, and therefore it cannot be viewed in a console. 


The optional keyword readonly is provided for computed relationships. Computed 
relationships are treated as readonly, even if the keyword readonly is omitted.


The optional <access_type> parameter specifies where and how information about this 
relationship is obtained. By default, relationships are stored. Relationships declared as 
computed are limited to operators that result in a single object reference. The expression 
for a computed relationshipset can return a set of object references. The result of the 
expression is assigned to the other end of the relationship or ends of the relationshipset.


The <cardinality> parameter specifies whether the traversal path of this relationship 
declaration refers to one class instance or many class instances. The keyword relationship 
specifies a connection to, at most, one class instance; the keyword relationshipset 
specifies a connection to any number of class instances.


<relation_dcl> ::= [ internal ]


[ readonly ]


[ <access_type> ]


<cardinality>


<relationship_name>


","


<class_name>


[ "," <inverse_name> ]


[ <optional_key_spec> ]


[required]


[ <relationship_description> ]


[ "=" <expression> ]


";"


| refine


[ <access_type> ]


<relationship_name>


[ "," <class_name> ]


[ required ]


<relationship_description>


";"


<access_type> ::= stored


| computed


<cardinality> ::= relationship


| relationshipset


<optional_key_spec> ::= [ ascending | descending ]


[ unique ]


key


<key_name>
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The <class_name> parameter specifies the class with which the declaration establishes a 
relationship.


The optional <inverse_name> parameter specifies the name of the inverse traversal path in 
the other class. If specified, you must also declare the corresponding relationship or 
relationshipset in the other class. If the <inverse_name> parameter is omitted, a one-way 
relationship or relationshipset is created.


The <optional_key_spec> parameter is only provided for relationshipsets. The <key_name> 
parameter specifies the name of an attribute in the class. The attribute name must have a 
separate declaration in the class.


readonly attribute string KeyStr;


stored relationshipset 
        MemberOf, FurnitureStore, Members
        descending key KeyStr;


The required keyword indicates that the relationship must not be empty. If a class 
contains a required relationship, whenever an instance of the class is created, the 
relationship must be populated.


The following example declares a relation between engines and a space craft module. 
Each engine only provides thrust to maneuver one space craft module: a to-one 
relationship. However, each space craft module can be maneuvered by one or more 
engines: a to-many relationship.


interface Engine : ICIM_ManagedSystemElement
{


relationship Maneuvers, SpaceCraftModule, ManeuveredBy;
}
interface SpaceCraftModule
{


relationshipset ManueveredBy, Engine, Maneuvers;
}


The keyword refine declares this relationship as a refinement of an inherited relationship. 
To refine a relationship, both ends of the relationship must belong to the same inheritance 
hierarchy. A refined relationship uses the name of the inverse traversal path that appears 
in the original relationship declaration and its cardinality must be the same as that of the 
original relationship.
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Overview
This chapter describes the MODEL declarations that are used to model the behavior of 
objects in a managed system. These constructs enable you to specify the static knowledge 
required for event management.


When you begin adding event-driven behavior to your model, remember three important 
points:


◆ Problems propagate across related objects.


◆ A single problem can cause numerous observable basic events (symptoms).


◆ Problems may not be observable in the object where they occur.


MODEL declarations for defining event-driven behavior
MODEL provides a number of declarations for defining event-driven behavior in a 
managed system. Each of these has a particular purpose, as described below.


◆ An object created with the event declaration is referred to as a basic event. Repository 
objects created with event, problem, aggregate, symptom, propagate symptom, and 
propagate aggregate declarations are all referred to generically as events.


◆ An event declaration defines a basic event, meaning it is observable in the object 
where it occurs. An event declaration is defined by an expression over attributes or 
other events of the class, as described in “Event declaration” on page 81.


◆ A problem declaration is defined by the <symptom-list > parameter (lists the basic 
events, symptoms, propagated symptoms and other problems that it can cause). You 
can specify a probability for each member in the <symptom-list > because the causal 
relationship between the problem and its symptoms may be probabilistic. “Problem 
declaration” on page 83 describes how to declare a problem in MODEL.


◆ A symptom declaration groups a set of basic events, symptoms, propagated 
symptoms, and other problems that it can cause into a single event by conjunction. 
The event defined using the symptom declaration is then used as a member of the 
<symptom-list > parameter in a problem declaration. “Symptom declaration” on 
page 88 describes how to declare a symptom in MODEL.


◆ A propagate symptom declaration defines an event that propagates from a related 
object through a relationship. An event declared as a propagated symptom is 
intended to be used as one of the members of the <symptom-list> parameter in a 
problem declaration. “Propagate symptom declaration” on page 91 describes how to 
declare a propagate symptom in MODEL.
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◆ An aggregate declaration groups one or more basic events, problems, aggregates, or 
propagated aggregates declared for the same class into a single abstract event by 
disjunction. “Aggregate declaration” on page 92 describes how to declare an 
aggregate.


◆ A propagate aggregate declaration defines a set of events that are not observable in 
the object where they occur but whose effects propagate to related objects through a 
given relationship. “Propagate aggregate declaration” on page 94 describes how to 
declare a propagate aggregate.


The table, “Types of events that can be exported” on page 96, lists the types of events that 
may be exported to EMC Smarts clients that request to be notified when the event occurs.


Event declaration
An event declaration declares a basic event that is defined using an expression. A basic 
event declared using an expression is defined over attributes and other events of its class.


Basic events declared by an event declaration are intended to be used as a member of the 
<symptom-list> parameter in problem declarations. The Domain Manager creates a data 
structure called a codebook that lists the problems to which EMC Smarts clients have 
subscribed. The codebook also includes the basic events, specified by event declarations, 
that each problem can cause. These basic events are used by the Domain Manager to 
determine when a problem occurs. The Domain Manager reduces the codebook so that 
each problem is identifiable by a unique set of symptoms. 


<event_dcl> ::= event


<event_name>


[ <event_description> ]


[ <opt_loss> ]


[ <opt_spurious> ]


<event_implementation>


";"


| refine


event


 <event_name> 


[ <event_description> ]


[ <opt_loss> ]


[ <opt_spurious> ]


[ <event_implementation> ]


";"


<opt_loss> ::= loss


"(" <expression> ")"


<opt_spurious> ::= spurious


"(" <expression> ")"


<event_implementation> ::= "="


[ <event_guard> ]


<event_expression>


<event_guard> ::= if


<expression>


check
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The <opt_loss> parameter, indicated by the keyword loss, specifies the probability that this 
observable basic event is lost or not observed (its expression does not evaluate to true) 
even though it is occurring. Setting a value closer to one increases the likelihood that the 
basic event will be lost. The loss expression must evaluate to a floating point number 
greater than or equal to zero but less than or equal to one.


The <opt_spurious> parameter, indicated by the keyword spurious, is the converse of 
<opt_loss>. It specifies the probability that this observable basic event is not occurring, 
even though the event expression evaluates to true. The expression must evaluate to a 
floating point number greater than or equal to zero but less than or equal to one.


The <event_implementation> parameter specifies the expression that defines the basic 
event and, optionally, whether the event is guarded.


The optional keyword refine declares this basic event as a refinement of a basic event 
declared in a superclass. You can change all the parameters of a basic event through a 
refinement.


Event expressions
An <event_expression> can be declared using the names of other events, as well as the 
operators and syntax described in “Syntax for expressions” on page 118. There is one 
notable constraint on event expressions: they must return a Boolean value.


When the basic event is evaluated, the expression is computed. If the return value 
changes the status of the event (from true to false or from false to true), the Domain 
Manager sends the appropriate notify or clear notification to each client. The Domain 
Manager only sends a notification when the status of a basic event changes.


When the attributes used to create an event expression depend on values within the 
Repository, the Domain Manager can compute those expressions as necessary and send a 
notification precisely when the status of the basic event changes. However, if the 
attributes are instrumented and obtain their values from an external source, the process 
for obtaining those attribute values can affect when the Domain Manager determines that 
an event’s status has changed. For example, if the value of an attribute is retrieved by 
polling an SNMP agent, the responsiveness of the SNMP agent and the duration of the 
polling interval can affect when the basic event is recognized.


Guarded events
The <event_guard> parameter provides a method for preventing an event expression from 
being evaluated unless a specified condition is met. If the guard expression specified by 
the <event_guard> parameter, which must return a Boolean value, is true, then the event 
expression is evaluated. Guarded events are useful when there is a high cost associated 
with evaluating an event expression. Factors that can contribute to a high cost include 
expensive computations or operations such as SNMP polling.


In the following example, LowInboundUtilization is a guarded event. The expression 
(CurrentInboundUtilization < LowInboundThreshold) will not be evaluated unless 
ifOperStatus == 1. When ifOperStatus does not equal 1, then the two computed attributes 
will not be evaluated. This also saves on polling because the computed attributes are 
based on instrumented attributes.
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stored attribute int LowInThreshold
“Threshold for incoming traffic ” = 5;


computed attribute float ifInOctetsRate
"Rate that interface is receiving octets."


          = rate(ifInOctets, PollingInterval);


computed attribute float CurrentInUtilization
"The total number of input bits transmitted to this
interface in seconds expressed as a “
“ percentage of total bandwidth. " 
= ((ifInOctetsRate * 8) /  (ifSpeed + 0.01)) * 100;


event LowInboundUtilization
"Traffic flowing into this interface is below the
utilization threshold. "
= if ifOperStatus = = 1 


check (CurrentInUtilization < LowInThreshold);


Problem declaration
A problem declaration declares an event that may occur in instances of a class. A problem 
causes a set of symptoms and the problem declaration specifies these symptoms and a 
probability that each symptom will be observed when the problem occurs. There are three 
types of symptoms.


◆ Locally observable symptoms can be observed in the same object where the problem 
occurs. Local symptoms must be declared by separate event declarations in the same 
class as the problem declaration.


◆ A problem can cause a second problem within the same object. The second problem 
must be declared by a separate problem declaration in the same class as the original 
problem.


◆ A propagated event or problem can only be observed in related objects. A propagated 
event must be declared by a propagate symptom declaration in the same class as the 
problem. In addition, the events or problems must be declared in the class to which 
they propagate.


Symptoms are events specified by event, symptom, propagate symptom, and problem 
declarations. Note that a symptom can be a problem that causes other symptoms.
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When an EMC Smarts client subscribes to a problem, the Domain Manager adds the 
problem to its codebook. The Domain Manager also adds the set of symptoms necessary 
to uniquely identify this problem from other problems listed in the codebook. 


The keyword problem indicates that this is a problem declaration.


The <symptoms_list> parameter lists the basic events, problems, symptoms and 
propagated symptoms that this problem causes. Each member in the <symptoms_list> can 
include optional parameters:


◆ A <probability> parameter or explains keyword


◆ A <condition> parameter 


The <probability> parameter specifies the probability that the problem causes this 
symptom to occur. The <probability> parameter must evaluate to a floating point number 
greater than or equal to zero but less than or equal to one. The default probability is one, 
meaning that the problem always causes this symptom. 


The optional <condition> parameter provides a method for conditionally removing a 
symptom from a problem. The <expression> parameter must return a Boolean value. When 
the expression evaluates to false, the event is removed from the list of symptoms that this 
problem causes. When the expression evaluates to true, the event remains in the list of 
symptoms caused by the problem. Note that the value of the Boolean expression can 
change during runtime. However, the codebook must be recomputed before the correlator 
recognizes the change.


<problem_dcl> ::= problem


<problem_name>


[ <problem_description> ]


[<apriori>]


[ <symptoms_list> ]


";"


| refine


problem


<problem_name>


[ <problem_description> ]


[<apriori>]


<symptoms_list>


";"


<apriori> ::= apriori"(" <expression> ")"


<symptoms_list> ::= "=>"


<symptoms>


<symptoms> ::= <symptom>


["," <symptoms>]


<symptom> ::= <problem_name> | <event_name> |
<propagated_symptom_name> |
<symptom_name>


[<probability> | explains ]


[<condition>]


<condition> ::= if


<expression>
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The optional keyword refine declares this problem as a refinement of a problem declared 
in a superclass of this class. You can change all the parameters of a problem declaration 
through a refinement. The refine declaration, however, must include at least one item in 
its <symptoms_list>.


apriori keyword
The apriori keyword indicates the probability of the problem occurring before looking at 
any of the symptoms as evidence. The apriori value must be a floating point number 
greater than or equal to zero but less than or equal to one, and it can be an attribute that 
varies in value. 


Setting the apriori to 0.0 removes the problem from the codebook. Setting the apriori to 
1.0 indicates that the problem is always active, as long as there is one active symptom, 
and any required symptoms are active. A symptom is required when its <probability> 
parameter is set to 1.0 and the <opt_loss> parameter for the underlying basic event(s) that 
comprise the member is set to 0.0. Symptoms that are declared as required must be 
active for the problem to be active. 


If the apriori keyword is not included in the problem declaration, an apriori of 0.05 is 
applied.


For example, a light bulb can be either on or off. The light bulb can be off because the 
switch controlling the light is turned off or because of faulty wiring. The following classes, 
events, relationships, and problems are defined to describe this behavior:


interface Bulb {


event LightOff = LightStatus == FALSE;


problem Out apriori(0.01) => 
LightOff;


relationship ControlledBy, Switch, Controls;


relationship SuppliedBy, Wiring, Supplies;
}


interface Switch {


relationship Controls, Bulb, ControlledBy;


propagate symptom LightOff => 
Bulb, 
Controls;


problem Off apriori(0.5) => 
LightOff;


}


interface Wiring {


relationship Supplies, Bulb, SuppliedBy;


propagate symptom LightOff => 
Bulb, 
Supplies;


problem Bad apriori(0.000001) => 
LightOff;


}
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The apriori values indicate that the probability that the switch is turned off is much higher 
than the probability that the wiring is faulty. For the switch, the apriori is set to 0.5 
because it is off about half the time.


The apriori value can also be an attribute:


interface Bulb {


event LightOff = LightStatus == FALSE;


problem Out apriori(out_apriori) =>
LightOff;


attribute float out_apriori = (outPossible ? 0.01 : 0.0);


attribute boolean outPossible = TRUE;
}


explains keyword
When determining the most likely problem set that causes the currently observed 
symptoms, a problem becomes more unlikely as it has more and more missing symptoms. 
Because of that, you want to model the important causal symptoms, and not all of the 
consequential symptoms. 


The causal symptoms are those symptoms that, when active, indicate that the problem is 
active. These symptoms are part of the codebook and play a role in correlation. This is the 
causality and these symptoms are considered when determining whether the problem is 
the root-cause. 


However, you still want the system to relate the problem to the consequential symptoms 
and the explains keyword in the problem declaration is used to provide this linkage. The 
explains keyword indicates that the problem can explain (impact) the associated 
symptom, but that this explained symptom is not part of the codebook and is not used 
when determining whether the problem is active or the root-cause. 


For example, an Unresponsive problem is declared:


problem Unresponsive  =>
        UnresponsiveActivatorEvent, 
        AgentUnresponsive explains,
        HostedServicesImpact explains;


export UnresponsiveActivatorEvent, AgentUnresponsive; 


export HostedServicesImpact;


In this case, only the UnresponsiveActivatorEvent is added to the codebook as one of the 
causal symptoms of the Unresponsive problem.


The AgentUnresponsive and HostServicesImpact events have the explains keyword after 
them. This indicates that the Unresponsive problem explains (impacts) the 
AgentUnresponsive and HostServicesImpact events, but these two events are not added 
to the codebook or considered when determining whether the Unresponsive problem is 
active. However, the AgentUnresponsive and HostServicesImpact events will be displayed 
on the Impacts tab of the Unresponsive notification in the Global Console.
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You can also have a symptom in a problem be both a causal symptom and an explained 
symptom. In this example, the AgentUnresponsive event is added to the codebook as one 
of the core symptoms. However, it is also linked to the problem as a consequential 
symptom.


problem Unresponsive  =>
UnresponsiveActivatorEvent, 
AgentUnresponsive,
AgentUnresponsive explains,
HostedServicesImpact explains;


export UnresponsiveActivatorEvent, AgentUnresponsive;


export HostedServicesImpact;


Whenever the problem Unresponsive is active, if the AgentUnresponsive and 
HostedServicesImpact events are active, they will appear under the Impacts tab of the 
Notification Properties dialog for the Unresponsive problem.


The UnresponsiveActivatorEvent problem will not appear under the Impacts tab, but it is 
added to the codebook as one of the causal symptoms of the Unresponsive problem.
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Symptom declaration
A symptom declaration groups a set of basic events, problems, symptoms, and 
propagated symptoms under a single name to be used in a problem declaration. This is 
especially useful if the same set of basic events, problems, symptoms, and propagated 
symptoms are referenced in multiple problem declarations.


An event defined by a symptom declaration is not added to the codebook and the 
correlator does not diagnose its occurrence. Furthermore, a symptom declaration cannot 
be exported and is not available by subscription to EMC Smarts clients. 


The keyword symptom identifies this as a symptom declaration.


The <symptoms_list> parameter lists the basic events, problems, symptoms and 
propagated symptoms that this symptom declaration causes. Each member of the 
<symptoms_list> can include optional parameters:


◆ A <probability> parameter or explains keyword


◆ A <condition> parameter 


The <probability> parameter must evaluate to a floating point number greater than or equal 
to zero but less than or equal to one. The default probability is one, meaning that the 
symptom always causes this event.


<symptom_dcl> ::= symptom


<symptom_name>


[ <symptom_description> ]


[ <symptoms_list> ]


";"


| refine


symptom


<symptom_name>


[ <symptom_description> ]


[ <symptoms_list> ]


";"


<symptoms_list> ::= "=>"


<symptoms>


<symptoms> ::= <symptom>


["," <symptoms> ]


<symptom> ::= <problem_name> | <event_name> |


<propagated_symptom_name> |


<symptom_name>


[<probability> | explains ]


[ <condition> ]


<condition> ::= if


<expression>
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The optional <condition> parameter provides a method for conditionally removing an event 
from a symptom declaration. The <expression> parameter must return a Boolean value. 
When the expression evaluates to false, the event is removed from the list of events that 
are caused by this symptom. When the expression evaluates to true, the event remains in 
the list of events caused by the symptom. Note that the value of the Boolean expression 
can change during runtime. However, the codebook must be recomputed before the 
correlator recognizes the change. “Syntax for expressions” on page 118 provides 
information about the correct syntax for an expression.


The optional keyword refine declares this symptom as a refinement of a symptom 
declared in a superclass of this class. You can change all of the parameters of a symptom 
declaration through a refinement.


explains keyword
The explains keyword is used for display purposes and does not affect the analysis. It 
indicates that this member of the <symptoms_list> is explained by (impacted by) the 
symptom being declared. When this member of the <symptoms_list> is exported and 
active, it is displayed in the Global Console under the Impacts tab of the Notification 
Properties dialog for the problem that references this symptom declaration. However, it is 
not added to the codebook as one of the symptoms of the problem that references the 
symptom declaration, and therefore, is not considered when determining whether the 
problem is a root cause. Table 7 on page 96 provides a list of which types of events can be 
exported.


For example, a NoFuelSupply problem and a NoFuelSupplySymptom symptom are 
declared:


problem NoFuelSupply =>
        NoFuelSupplySymptom;


symptom NoFuelSupplySymptom =>
FuelTanksEmpty,
EngineDown explains;


event FuelTanksEmpty = FuelTanksLevel < 0.01 == FALSE;


event EngineDown == FALSE;


export FuelTanksEmpty, EngineDown, NoFuelSupply;


In this case, the FuelTanksEmpty event is added to the codebook as one of the symptoms 
of the NoFuelSupply problem.


The EngineDown basic event has the explains keyword after it. This indicates that the 
NoFuelSupply problem explains (impacts) the EngineDown basic event, and this event will 
be displayed on the Impacts tab of the NoFuelSupply notification in the Global Console. 
However, the EngineDown event is not considered when determining whether the 
NoFuelSupply problem is a root cause. In this example, only the FuelTanksEmpty event is 
added to the codebook and considered when determining a root cause. 
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You can also have a member of the <symptoms_list> be both caused and explained by this 
symptom.


problem NoFuelSupply =>
        NoFuelSupplySymptom;


symptom NoFuelSupplySymptom =>
FuelTanksEmpty,
EngineDown,
EngineDown explains;


event FuelTanksEmpty = FuelTanksLevel < 0.01 == FALSE;


event EngineDown == FALSE;


export FuelTanksEmpty, EngineDown, NoFuelSupply; 
In this example, both the FuelTanksEmpty and EngineDown events are added to the 
codebook as symptoms of the NoFuelSupply problem. But the EngineDown event is also 
included with the explains keyword after it. In this case, if the NoFuelSupply problem is 
active and the EngineDown event is active, the EngineDown event will be displayed on the 
Impacts tab of the NoFuelSupply notification in the Global Console.
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Propagate symptom declaration
A propagate symptom declaration defines an event that is not observable in the object 
where it occurs. The symptoms of this event propagate to one or more objects of related 
classes. The events that comprise a propagate symptom must be declared by basic event, 
problem, or propagate symptom declarations in the class where they occur.


The keywords propagate and symptom identify this as a propagate symptom declaration.


The <class_name> and <relationship_name> parameters identify the class and the 
relationship that the symptom propagates from. The <symptom_name> parameter must be 
used when the propagated symptom has a different name from the basic event in the 
originating class.


The keywords refine and propagate identify this declaration as a refinement of a 
propagate symptom declared in a superclass of this class. You can change all the 
parameters of a propagate symptom through a refinement.


An event created with a propagate symptom declaration cannot be exported and is not 
available by subscription to EMC Smarts clients.


The following example creates two classes: one class representing a light bulb, and a 
second class that represents a light switch. When the light switch is turned off, the light 
bulb is off.


The Bulb class has a basic event, LightOff, that is active when the light bulb is off. The 
Switch class propagates the value of the LightOff basic event from the Bulb Class, over the 
Controls relationship. The LightOff propagated symptom is then used to determine 
whether the Off problem is the root cause.


<propagate_symptom_dcl> ::= propagate


symptom


<symptom_name>


[ <symptom_description> ]


"=>"


<class_name>


","


<relationship_name>


[ "," <symptom_name> ]


";"


| refine


propagate


<symptom_name>


[ <symptom_description> ]


"=>"


<class_name>


","


<relationship_name>


[ "," <symptom_name> ]


";"

Propagate symptom declaration 91







Declaring Event-Driven Behavior in MODEL

interface Bulb {


event LightOff = LightStatus == FALSE;


problem Out => LightOff;


relationship ControlledBy, Switch, Controls;
}


interface Switch {


relationship Controls, Bulb, ControlledBy;


propagate symptom LightOff => Bulb, Controls;


problem Off => LightOff;
}


Aggregate declaration
An aggregate declaration groups one or more basic events, problems, aggregates or 
propagated aggregates into a single abstract event by disjunction. The aggregate becomes 
active when any one of the events in the set is active. The events grouped into an 
aggregate must be declared in basic event, problem, aggregate or propagate aggregate 
declarations in the same class.


Aggregates are not used in codebook correlation but they can be exported for subscription 
by other EMC Smarts clients. 


The keyword aggregate identifies this as an aggregate declaration.


The <events_list> parameter lists the basic events, problems, propagated aggregates, and 
aggregates that comprise the aggregate.


The optional keyword refine identifies this declaration a refinement of an aggregate 
declared in a superclass of this class. You can change all the parameters of an aggregate 
through a refinement.


<aggregate_dcl> ::= aggregate


<aggregate_name>


[ <aggregate_description> ]


[ "<=" <events_list> ]


";"


| refine


aggregate


<aggregate_name>


[ <aggregate_description> ]


"<="


<events_list>


";"


<events_list> ::= <event>


[ "," <event_list> ]


<event> ::= <event_name> | <problem_name> |
<propagated_aggregate_name> 


| <aggregate_name>
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The following example declares an aggregate, FuelSupplyCondition, that groups together 
the different types of events that indicate an error condition with the fuel supply. A 
problem with the fuel supply is indicated whenever the FuelTanksEmpty basic event or 
FuelSupplyBlocked problem is active.


event FuelTanksEmpty  "The fuel tanks are out of propellant."
        = TotalPropellantLevel <  0.01;


problem FuelSupplyBlocked 
"No propellant can reach the engine group."
=> EnginesDownSymptom;


propagate symptom EnginesDownSymptom
        => Engine, ConsistsOf, EngineDown;


aggregate FuelSupplyCondition 
"Problem with the engine group's fuel supply"
<= FuelTanksEmpty, FuelSupplyBlocked; 


export FuelSupplyBlocked,FuelTanksEmpty,FuelSupplyCondition;


Logic for aggregate processing


The value of an aggregate is determined as follows:


◆ If all underlying events are inactive, then the aggregate is inactive. 


◆ If any underlying event has an error, then this event overrides all inactive events. 
Therefore, if one underlying event is an error and the rest are inactive, the aggregate is 
an error (the same error that the underlying event is). If more than one underlying 
event has an error, then the error of the aggregate will be any one of those. An error 
value of pending takes precedence over all other error values (in the case of multiple 
underlying events with errors). 


◆ An active event overrides errors. Therefore, if one underlying event is active, the 
aggregate is active, regardless of the rest of the underlying events.
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Propagate aggregate declaration
A propagate aggregate is an event or group of events that are not observable in the object 
where it occurs. Instead, its symptoms occur in related objects and propagate to the 
object where the propagate aggregate is declared. Depending on how many symptoms of 
a propagate aggregate occurs, the codebook calculates a certainty (percentage value) that 
the propagate aggregate has occurred.


The events that comprise a propagate aggregate must be defined as basic event, problem, 
aggregate or propagated aggregate declarations in the class where they originate. 


The keywords propagate and aggregate identify this as a propagate aggregate declaration.


The <class_name> parameter identifies the class the event propagates from and 
<relationship_name> identifies the relationship that the event traverses. The <event_name> 
parameter must be used if the name of the propagate aggregate is different from the name 
of the event in the originating class.


The keywords refine and propagate identify this declaration as a refinement of a 
propagate aggregate declared in a superclass of this class. You can change all the 
parameters of a propagate aggregate declaration through a refinement.


<propagate_aggregate_dcl> ::= propagate


aggregate


<prop_aggregate_name>


[ <description> ]


"<="


<class_name>


","


<relationshipset_name>


[ "," <event_name> ]


";"


| refine


propagate


<prop_aggregate_name>


[ <description> ]


"<="


<class_name>


","


<relationship_name>


[ "," <event_name> ]


";"
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Logic for propagate aggregate processing


The value of a propagate aggregate is determined as follows:


◆ If all underlying events are inactive, then the propagate aggregate is inactive. 


◆ If any underlying event has an error, then this event overrides all inactive events. 
Therefore, if one underlying event is an error and the rest are inactive, the propagate 
aggregate is an error (the same error that the underlying event is). If more than one 
underlying event has an error, then the error of the propagate aggregate will be any 
one of those. An error value of pending takes precedence over all other error values (in 
the case of multiple underlying events with errors). 


◆ An active event overrides errors. Therefore, if one underlying event is active, the 
propagate aggregate is active, regardless of the rest of the underlying events. 


Export declaration
An export declaration is required to make the event-driven behavior declared for a class 
visible outside of the Repository. EMC Smarts clients, such as the Global Console and 
adapters, can subscribe to exported event-driven behavior and receive notifications when 
they occur. Table 7 on page 96 describes which types of event-driven behavior can be 
exported. 


The keyword export identifies this as an export declaration.


The <events> parameter lists the events to be exported. Each event must be declared in the 
same class as the export declaration. You can list multiple events, separating them with a 
comma, in a single export declaration. You can also specify multiple export declarations 
for a class.


The following example exports the FuelTanksEmpty event:


event FuelTanksEmpty = FuelTanksLevel < 0.01 == FALSE;


export FuelTanksEmpty;


<export> ::= export


<events>


";"


<events> ::= <event_name>


[ "," <events> ]
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Table 7 on page 96 lists the types of event-driven behavior that can be exported. 


Imported events
Imported events allows you to specify events for which the state reflects the state of the 
event with the same name, on an instance of the same name and class in another 
Manager. In addition to reflecting the state of the remote event, whenever the connection 
between the two Managers is severed, the imported event will be suspended, and 
automatically resumed as soon as the connection is resumed.


There are two steps you need take to ensure the correct operation of imported events.


1. Make sure the interface names for the classes are the same, and that the instance 
names of the instance you want to import the events are the same. 


2. Assign the remote Manager name to the ServiceName attribute in the Manager that 
will be importing the events.


Specifying imported events in MODEL


The following example shows how to specify imported events in MODEL. Note that the 
interface names for the classes are the same in both Manager MODEL files, as are the 
event names that are being imported.


interface TestIF : MR_ManagedObject
{
    event e1 "This event is imported " imported;
    export e1;


    event e2 "This one also"  imported;
    export e2;


    event a1 "This event is really an aggregate in the remote domain 
manager"  imported;


    export a1;


    aggregate a2
        "I can use all these events normally in this MODEL" 
        = e1, e2, a1;
    export a2;
}


Table 7  Types of events that can be exported


Type of event Can It be exported


Basic Event Yes


Problem Yes


Symptom No


Propagate Symptom No


Aggregate Yes


Propagate Aggregate Yes
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The remote Domain Manager MODEL could look like: 


interface TestIF : MR_ManagedObject
{


    attribute boolean p1 = FALSE;
    event e1 = p1;
    export e1;


    attribute boolean p2 = FALSE;
     event e2 = p2;
    export e2;


    aggregate a1 = e1, e2;
    export a1;
}
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Overview
Operations provide a method for manipulating objects and their properties. You can 
retrieve data based on attributes and topology, and you can also Get or Set attribute 
values (including internal attributes). Operations also allow you to perform computations, 
traverse relationships, and call other operations. 


Operations may be called by client programs, such as:


◆ dmctl


◆ ASL scripts


◆ Java API Client


◆ PERL API Client


In addition, get operations (readonly) may appear in computed attribute expressions.


Declaring an operation
An operation declaration includes the name of the operation, the type of its arguments, 
and the type of any returned values.


Note: There is no operation keyword. 


<operation_dcl> ::= [internal]


[static]


[const | readonly | idempotent]


<return_type>


<operation_name>


"(" [ <arguments> ] ")"


[ <operation_description> ]


<operation_definition>


";"


| refine


[ instrumented | stored ]


<operation_name>


[ <operation_description> ]


<op_definition_refinement> 


<return_type> ::= void


| error_code


| <value_type>


| set "(" <value_type> ")"


| <class_name>


| set "(" <class_name> ")"


<arguments> ::= <argument>


[","<arguments>]


<argument> ::= <in_argument>


| <inout_argument>


| <out_argument>
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The internal keyword indicates that this operation is only visible within the generated C++ 
code. The result of the operation is not visible through an external interface, and therefore 
it cannot be viewed in a console. 


Note: You can view the results of an internal operation in an external interface if you set 
the value of a computed attribute (not an internal computed attribute) equal to the results 
of the internal operation.


The optional keyword static declares the scope of the operation. If the operation is 
declared static, a single copy of the operation is shared by all instances of the interface.


The const keyword indicates that the operation does not change the instance in the 
repository, so it cannot assign values to attributes of the class. The const keyword is also 
used to obtain an instance-only read lock. “Instance-only read lock” on page 106 provides 
additional information on this type of repository lock.


The readonly keyword is used to obtain a repository-wide read lock. It indicates that the 
operation leaves the repository unchanged. A readonly operation may not assign to 
attributes of a class. “Repository-wide read lock” on page 105 provides additional 
information on this type of repository lock. 


The idempotent keyword indicates that the operation, if called multiple times without an 
intervening put, will return the same value each call.


<in_argument> ::= in


<argument_type>


<argument_name>


["="<expression>]


<inout_argument> ::= inout


<argument_type>


<argument_name>


<out_argument> ::= out


<argument_type>


<argument_name>


<argument_type> ::= <value_type>


| set "(" <value_type> ")"


| <class_name>


| set "(" <class_name> ")"


<operation_definition> ::= definition: <assignments>


<assignments> ::= <assignment>”,”<assignments>


| <assignment>


| <return_expression>


<assignment> ::= <identifier>"="<expression>


<return_expression> ::= return <expression>


<op_definition_refinement> ::= <operation_definition>


| "=" <expression>

Declaring an operation 101







Operation Declarations

The <value_type> parameter can be one of the supported types listed in “Data types” on 
page 51. The <class_name> parameter can be the name of any class in the repository, such 
as Engine, Host or Router. Examples are described in “Return_type parameter” on 
page 102.


The <expression> parameter has to be an EMC Smarts expression; it cannot be procedural 
code. “Writing Expressions in MODEL” on page 107 provides additional information.


Return_type parameter
The <return_type> parameter declares the type of value returned by the operation. The 
return value can either be one of the supported types listed in “Data types” on page 51 or 
it can be a class type.


The following example defines the getCelsiusTemperature operation, which has a 
<return_type> of float.


readonly float getCelsiusTemperature()
definition:
// Convert from Fahrenheit to Celsius
return (Temperature - 32) / 1.8;


This operation would be called on a class instance that contained the attribute 
Temperature. This operation gets the value of the local attribute Temperature (in degrees 
Fahrenheit) and returns the equivalent celsius temperature.


If the operation has no return value, use the keyword void. In this example, the operation 
doesn’t return any value, but it does set the Temperature attribute of the instance to the 
results of the expression.


void setCelsiusTemp (in float CTemp)
    definition: 
// Convert from input Celsius to Fahrenheit
   Temperature =  CTemp *  1.8 + 32;


An operation can also return a set of values or class objects. If this is the case, the 
keyword set should precede the <value_type> or <class_name> parameter. Sets are 
supported for every data type in Table 4 on page 51, except boolean and enumerations.


For example, an Engine class has a ManeuveredBy relationshipset to a ServiceModule 
class (each ServiceModule can maneuver one or more Engines). In this example, the 
getEngines operation returns the set of Engine instances that share the ManeuveredBy 
relationship with this instance of ServiceModule class.


readonly set(Engine) getEngines()
definition:
return Engine(ManeuveredBy);
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Refine keyword


The keyword refine declares this operation as a refinement of an operation declared in a 
superclass of this class. 


You can change the access to instrumented using the instrumented keyword or to 
non-instrumented using the stored keyword.


If you do not specify the access type in the refine statement, the access type of the 
operation defaults to the access type defined in the original declaration of this operation 
(the first definition going up the hierarchy class, in case the operation is successively 
refined.) 


You can provide multiple assignments and/or a return expression by specifying an 
<operation_definition> for the <op_definition_refinement>. 


If you specify an <expression> for the <op_definition_refinement> all assignments are 
removed and the return expression is replaced with the expression that has been 
provided.


Arguments
An operation declaration takes a list of arguments. Each argument requires one of the 
following keywords:


◆ in


◆ inout


◆ out


These keywords indicate the direction in which information passes between the caller and 
the operation. 


The <argument_type> parameter specifies the argument’s type, The argument’s type can 
either be one of the supported types listed in “Data types” on page 51 or it can be a class 
type. You can declare a set expression with the <argument_type> parameter, in which case 
the keyword set precedes the <value_type>. Sets are supported for every data type in 
Table 4 on page 51, except boolean and enumerations. The syntax for set expressions is 
the same as that for logical or arithmetic expressions. However, a special group of 
operators must be used. “Syntax for expressions” on page 118 describes the syntax of 
expressions, and “Operators for set expressions” on page 112 describes set operators.


in keyword
The in keyword indicates that the information passes from the caller to the operation. You 
can use the <expression> parameter to specify a default value, which may be either a literal 
or a more complicated expression. The syntax of <expressions> is described in “Syntax for 
expressions” on page 118. If you declare an argument with a default value, any successive 
arguments must also have a default value.


In this example, the operation setCelsiusTemp is passed the value of the variable CTemp 
(whose data type is float). This operation doesn’t return any value, but it does set the 
Temperature attribute of the instance to the results of the expression (CTemp *  1.8 + 32).
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void setCelsiusTemp (in float CTemp)
    definition:
    // Convert from input Celsius to Fahrenheit
   Temperature =  CTemp *  1.8 + 32;


inout keyword
The inout keyword indicates that the parameter has an initial value that is passed into the 
operation, but the value of the argument is then set by the operation and returned to the 
caller. The value of an inout parameter may be assigned to in the operation definition. You 
cannot define a default value for an inout argument.


In this example, an invokeDrivers operation is defined. It has two in parameters: the name 
of the element and the type of the element. It also includes an inout parameter: the object 
name.


#pragma Unlocked
    boolean invokeDrivers(in string elementName, 
                               in string elementType, 
                               inout string objectName);


Note: At this time, the remote API does not support the use of inout parameters.


out keyword
The out keyword indicates that the value of the argument is set by the operation and 
returned to the caller. You cannot define a default value for an out argument.


In this example, a findElement operation is defined. It has two in parameters: the name of 
the element and the type of the element. It also includes one out parameter, and the 
operation sets the value of this parameter.


boolean findElement(in string elementName,
in string elementType,
out MR_Object element);


Note: At this time, the remote API does not support the use of out parameters.
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Assignment and return_expression parameters
For <assignment>, the <identifier> is an attribute name with <expression> described in 
“Syntax for expressions” on page 118, where the result of <expression> is assigned to 
<identifier>.


If there is no <return_expression> defined and the operation has a return type other than 
void, the last <assignment> is used to provide the return value.


Repository locking states
An operation in a class instance may use one of five locking states with the repository:


◆ “No locking”


◆ “Repository-wide write lock” (the default)


◆ “Repository-wide read lock”


◆ “Instance-only write lock”


◆ “Instance-only read lock”


No locking


Using #pragma Unlocked before your operation results in no repository lock at all. You can 
lock the repository in your own code. However, even if you do your own locking, if you 
delete the object just as the operation or attribute is being dispatched to your code, you 
may get a crash.


Repository-wide write lock


A repository-wide write lock is the default lock obtained when invoking an operation.


Repository-wide read lock


The readonly keyword is used to obtain a repository-wide read lock.


In this example, an Engine class has a ManeuveredBy relationshipset to a ServiceModule 
class (each ServiceModule can maneuver one or more Engines). The getEngines operation 
returns the set of Engine instances that share the ManeuveredBy relationship with this 
instance of ServiceModule class.


readonly set(Engine) getEngines()
definition:
return Engine(ManeuveredBy);


The getEngines() operation doesn’t change the values of any attributes, but it does need 
to read all of the Engine instances that have a ManeuveredBy relationship to the instance 
that is calling the operation. Therefore, the readonly keyword is used to obtain a 
repository-wide read lock.
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Instance-only write lock


The #pragma Local Operation locks only the object on which the operation is invoked. 
“#pragma Local Operation” on page 134 provides an example and further discussion.


Instance-only read lock


There are two different methods to obtain a read lock on only the instance that is invoking 
the operation.


The readonly keyword, when used in conjunction with #pragma Local Operation, locks (for 
reading) only the object on which the operation is invoked. 


The const keyword, when used in conjunction with the #pragma Local Operation, also 
obtains a read lock on only the object on which the operation is invoked. 
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Overview
Unlike other chapters that discuss specific MODEL declarations, expressions are not a 
declaration in and of themselves. Expressions are used to define computed attributes, set 
expressions, operations, assignments, return expressions, and event expressions. The 
purpose of this chapter is to describe the syntax for these types of expressions.


Expressions allow you to manipulate information by combining it, comparing it, and 
performing other operations on it. The expressions in MODEL are composed of terms and 
operators. Terms are the basic units that you can combine and operators describe what 
actions are to be performed on the terms.


Set expressions are a special type of expression that enable you to evaluate, compare, 
and perform operations on sets of values. The operators for set expressions are described 
in “Operators for set expressions” on page 112. The syntax for set expressions is the same 
as that for expressions.


Lexical elements for expressions
The lexical elements for expressions include literals, operators, and the built-in functions 
provided by MODEL, as described in “Built-in functions” on page 113.


Literals


A literal is a value that represents a constant. Literals in MODEL may be integers, 
floating-point numbers, strings, or character literals.


Integer literals
Integer literals may be decimal, hexadecimal or octal. Integer literals may start with an 
optional unary minus sign or unary plus sign. 


A decimal integer is a sequence of the digits zero through nine; the first digit cannot be a 
zero. An octal integer starts with a zero and may contain the numbers zero through seven. 
A hexadecimal integer starts with a zero followed by the upper or lowercase letter x. It may 
contain the digits zero through nine and the upper or lowercase letters A through F.


Floating-point literals
Floating-point literals have many parts, some of which may be omitted. A floating-point 
literal may start with an optional minus sign followed by a series of digits, a decimal point, 
another series of digits, an upper or lowercase E, an optional plus or minus sign, a series 
of digits representing the exponent, and an optional upper or lowercase F. The decimal 
point is required, but you can omit the digits that appear before the decimal point or the 
digits that appear after the decimal point, but not both. The exponent, which starts with 
the letter E, may also be omitted. By default, a floating-point literal is treated as a 64 bit, 
floating-point number. When the trailing F is included, it is treated as a 32 bit, 
floating-point number.
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String literals
String literals are a sequence of characters enclosed by double quotes. You can create a 
multi-line string literal by terminating the first line of a large string literal with a double 
quote and a new line and enclosing the remaining section of the literal in double quotes 
on the next line, and so on, until the string is complete. This technique is used to provide 
descriptions for MODEL classes and their properties. You can also use escape characters 
in a string literal. An escape character consists of a backslash followed by one of the 
characters: n, t, v, b, r, f, a, \, ?, ", or up to three octal digits representing the octal value 
of a character.


Character literals
Character literals are enclosed in single quotes. They may be either a single character, or 
an escape character. The escape characters for character literals are the same as for string 
literals.


Enumeration literals
Enumeration literals are named integer literals. You can use negative values within the 
enumeration declaration. While you can assign fixed values to the enumerators, 
EMC Smarts does not recommend declaring multiple enumerators with the same value. 


Operators


MODEL supports the C and C++ operators listed in Table 8 on page 109. These operators 
behave the same in MODEL and C++ except where noted below. The precedence of 
operators, also similar to C++, is described in “Precedence of operators” on page 113. 


Table 8  Operators supported by MODEL (page 1 of 2)


Operator Type Symbol Definition


Unary +
-
!
~


unary plus
unary minus
logical negation
bitwise complement


Arithmetic *
/
%
+
-


multiply
divide
modulus
plus
minus


Shift >>
<<


right shift
left shift


Relational <
>
<=
>=


less than
greater than
less than or equal
greater than or equal


Equality ==
!=


equal to
not equal to
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MODEL does not use the following operators:


◆ Assignment operators (=, +=, -=, *=, /=, %=, >>=, <<=, &=, ^=, |=)


MODEL defines special behavior for the operators listed below.


◆ In MODEL, an expression that divides by zero produces an error result. For example, if 
an expression involving a zero divide defines a computed attribute, a get of that 
attribute’s value will return an error.


◆ The logical negation operator (!) may only be used on Boolean values.


Evaluation expression operators


The following evaluation operators differ slightly in MODEL from how they are generally 
used in C++ compilers. 


Else operator
The else operator evaluates the left-hand expression; if that result is not an error, then the 
value becomes the result of the else expression. The result types of the left and right-hand 
expressions must agree. If the left-hand expression does not return an error, the 
right-hand expression is not evaluated. For example:


instrumented attribute int i_state "In MIB as an enum, SNMP int";


computed attribute state_e safe_state
"Give a default value for failed get or conversion"
= state_e(i_state) else UNKNOWN;


Logic &&
||


logical and
logical or


Bitwise |
^
&


bitwise or
bitwise exclusive or
bitwise and


Conditional ?: conditional evaluation; if the test proves invalid, the 
result is the error from the test.
operand1 ? operand2 : operand3; 


On Error else on error evaluation


Selection case
 key
 default


selective evaluation


Table 8  Operators supported by MODEL (page 2 of 2)


Operator Type Symbol Definition

110 EMC Smarts Foundation MODEL Reference Guide







Writing Expressions in MODEL

Case operator
The case operator uses the value of a selection expression to select one of a number of 
keys and the value expression associated with that key. At runtime, an error is produced if 
the selection expression value does not match any of the key expression values.


Keys within a case operator can only be enumeratons or integers.


An example of the case operator:


interface MiddleClass : ConvClass
{


enum state_e {
UP = 1
DOWN = 4
UNKNOWN = 6


};
attribute state_e tEnum;


computed attribute int tCaseInt
=
case ( tEnum ) {


  key UP : 1;
   key DOWN :4;
   default : //falls through to key UNKNOWN
   key UNKNOWN : 6;


};
};


Combining expression operators
You can combine the previous operators with other expression operators. The following 
example illustrates how to convert an integer, instrumented attribute coming over the 
network to an enumeration:


readonly instrumented attribute int ifAdminStatus;


refine computed AdminStatus = 
case (ifAdminStatus) {


key 1:  UP;
key 2:  DOWN;
key 3:  TESTING;
default:  OTHER;


} else UNKNOWN;
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Operators for set expressions


Set expressions use their own group of terms and operators, as shown in Table 9 on 
page 112. The precedence of set operators is at the same level as the corresponding 
symbol for logical and arithmetic operators. Table 10 on page 113 provides additional 
information. 


Table 9  Operators for set expressions


Set Operator Definition


<term> in <setA>
<term> in <vector_expression>


Returns a Boolean value. The in operator checks that 
the given value from the left term is a member of the 
right term. The left term must be a scalar; the right 
term must be a set or vector expression.


| <setA> | Returns an integer that is the count of the number of 
members in setA.


<class_name>(<relationshipset>) Returns a set of all the objects in the relationshipset 
whose class matches the specified class name.


<setA> & <setB> Returns the set of elements that are members of both 
setA and setB. Both sets must have the same 
underlying type.


<setA> | <setB> Returns a set that includes all of the elements of both 
setA and setB. The members of both sets must be of 
the same type.


<setA> - <setB> Returns the members of setA that are not members of 
setB. Both sets must have the same underlying type.


<setA> -> <relationship> Determines the number of elements each member of 
setA is related to through the relationship. All these 
individual sets are then combined into a multiset. 
setA must be a set of objects.


unique(<vector_expression>) Returns a set of elements from the multiset where no 
element in the set appears more than once.
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Precedence of operators


Operators have rules of precedence and associativity to determine how expressions are 
evaluated. You can put expressions in parentheses to change the order in which 
operations are performed.


Outside of parentheses, unary operators have the highest precedence followed by 
arithmetic operators. The convention of arithmetic operators is that the multiplicative 
operators have precedence over the additive operators. Table 10 on page 113 lists the 
exact order of precedence and associativity for operators in MODEL. 


Built-in functions


The following terms are built-in functions supplied by MODEL. They typically appear in 
expressions, as described in “Syntax for expressions” on page 118. Although the syntax 
of MODEL permits you to use a function as a term in a complex expression, it is better to 
use a function in one attribute and store it in a variable.


Table 10  Precedence and associativity of operators


Operator Precedence Associativity


conversion, case, key, default Right to left


+ - ! ~ (unary) Right to left


* / % Left to right


+  - Left to right


<< >> Left to right


< <= > >= in Left to right


== ! = Left to right


& Left to right


^ Left to right


| Left to right


&& Left to right


|| Left to right


else Left to right


?: Right to left
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Delta
The term delta(A), where A is an attribute, returns the difference between the current 
value of A and its previous value. This is typically used for an instrumented attribute 
whose value is obtained by polling. 


interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{
        ifInOctets = "1.3.6.1.2.1.2.2.1.10",
    };


#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
    "The total number of octets received on the "
    "interface.";


    /* Compute Delta
     --------------- */
    readonly computed attribute int deltaifInOctets
    = delta(ifInOctets);
};


Conversion
The term type_name ( ) allows you to convert an expression to a predefined numeric 
type or to an enumeration type. Write the type name followed by the expression in 
parentheses. For example:


enum state_e {UP, DOWN, UNKNOWN};


attribute state_e tEnum;


attribute int tInt;


attribute int tEnum2Int "Convert to int"
=int(tEnum);


attribute state_e tInt2Enum "Convert to state_e"
=state_e(tInt);


Object
The term obj( <string_expression> )returns the object whose name matches the 
result of the string expression. This is useful for determining whether a particular object 
exists at runtime.


Polling frequency
The term polling_frequency(A), where A is an attribute, returns the interval, in 
seconds, between successive polls of an attribute’s value.


interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{
        ifInOctets = "1.3.6.1.2.1.2.2.1.10",
    };

114 EMC Smarts Foundation MODEL Reference Guide







Writing Expressions in MODEL

#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
    "The total number of octets received on the "
    "interface.";


    /* Compute Polling Frequency
     --------------------------- */
    readonly computed attribute int frequencyifInOctets
    = polling_frequency(ifInOctets);
};


Errnum
The term errnum(attribute_name) returns the error number for the last get of the 
attribute. For stored attributes the return value will always be zero (0). For all other 
attributes the return value can be either zero or non-zero.


Errstr
The term errstr(attribute_name) returns the string representation of the error for the 
last get of the attribute.


No_response
The no_response(attribute_name) returns TRUE if the error number for the last get of 
the attribute was MR_TIMEOUT or if the agent is marked unavailable.


abstract interface ICIM_Instrumentation : ICIM_MetaObject
"Instrumentation is the mechanism whereby information" "regarding a 


SystemElement is retrieved from the managed" "domain."
{


attribute boolean InstrumentationOK
"TRUE if the instrumentation is functioning” "properly."
=TRUE


abstract interface NetworkAdapter_Fault_SNMP : NetworkAdapter_Fault
"Instrumentation super-class for instrumented Network" "Adapters using 


SNMP."
{


instrument SNMP;


readonly instrumented attributes int ifAdminStatus;


refine computed InstrumentationOK
=errnum(ifAdminStatus) ==0 && no_response(ifAdminStatus) == 


FALSE
}


For both rate() and average(), below, arguments other than the first argument may be 
either an integer literal or the name of a numeric attribute whose value can be converted 
to an integer. That is, the value cannot be a string but may be integer, float, or unsigned. If 
the arguments are attribute names, then the value of the attribute is obtained at runtime 
by the monitoring system.
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Rate
The term rate(A,T), where A is an attribute and T is a time interval, returns the rate at 
which A changed during the last T seconds. The time interval may be an expression that 
evaluates to a numeric value.


interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{
        ifInOctets = "1.3.6.1.2.1.2.2.1.10",
    };


#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
        "The total number of octets received on the "
        "interface.";


    attribute unsigned pollingPeriod
        "The interval, in seconds, between "


 "successive polls."
        = 120;


   /* Compute the rate of ifInOctets 
      ------------------------------- */
    computed attribute float ifInOctetsRate
        = rate(ifInOctets, pollingPeriod);
};


Rate_last
The term rate_last(A, T) is an alternative to rate(A, T) that can be used for polled attributes 
in cases when rate interval T equals the polling period of A. 


The term rate_last(A,T) returns the difference between the current and the previous values 
of A divided by the time difference between when the two values were polled. 


If A was polled early, or if A was polled late on one polling cycle and polled on time on the 
next polling cycle, the two consecutive samples of A may not cover the rate interval T, in 
which case rate(A, T) will be calculated over the two polling cycles. 


The term rate_last(A, T), always uses two consecutive samples.


Average
The term average(A, T, N, P), where A is an attribute, T is a time interval, N is a count, 
and P is a percent, computes the average value of A over the interval T.


A is an attribute name whose values will be sampled and averaged.


T is the window size and is an integer representing the number of seconds over which the 
samples of A are collected and averaged.


N is the minimum number of samples. It is an integer that represents the minimum 
number of samples of A to collect during T. N and T are used to provide input to the polling 
period for A. For example, if T is 600 and N is 10 then you want a sample every 600/10 = 
60 seconds. Picking a small T and large N will cause very frequent polling of the attribute. 
The actual number of samples collected over an interval T is at least N. If you choose a 
large T and small N, then the actual number of samples may be many more than N 
because the repository collects one sample each time A is polled.
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P is the percentage of samples required without error to compute the average. It is an 
integer between 0 and 100. The check is the percentage of the actual number of samples 
that do not have an error. As noted above, the actual number of samples may be many 
more than N.


Timestamp
The term timestamp(A), where A is an attribute, returns the time when the value of A was 
last changed. A timestamp is returned in UNIX time format: an integer representing 
seconds since Midnight, 1 January, 1970 (GMT). You can only use the timestamp() 
operator on an attribute that is instrumented or has been declared with the timestamped 
keyword.


interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{
        ifInOctets = "1.3.6.1.2.1.2.2.1.10",
    };


#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
    "The total number of octets received on the "
    "interface";


    readonly computed attribute unsigned ifInOctetsTimestamp
    = timestamp(ifInOctets);
};


Previous
The previous(attribute_name) function returns the previous value. Therefore, 
previous(A), where A is an attribute, returns the previous value of attribute A.


This can be used for an instrumented attribute to retain the previous value of the attribute 
when the value cannot be obtained from the instrumentation source.


Is_server_disconnected
The is_server_disconnected(attribute_name) function returns TRUE if the error 
number for the last get of the attribute was MR_SUBSCRIPTION_SUSPENDED and the 
reason for being suspended is that the remote server was disconnected.


interface XYZ {


instrumented attribute boolean IsFlapping;
computed attribute boolean X_IsFlapping = 


is_server_disconnected(IsFlapping) ? previous(IsFlapping) : 
isFlapping;


...
}
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Syntax for expressions
The <expression> parameter is the top level of the expression hierarchy. The way the 
grammar is constructed embeds the operator precedence as well as describes the 
expressions. 


The operands on either side of the operator distinguish between set expressions and 
mathematical or logical expressions. 


The <binary_operator> and <unary_operator> parameters represent the operators described 
in “Operators” on page 109. With minor exceptions, the syntax of MODEL operators is 
similar to those of C and C++.


Literals, indicated by the <literal> parameter, include the familiar arithmetic, string, and 
character literals of C and C++. These are described in “Literals” on page 108.


The <function_name> and <arg_list> parameters refer to operations defined in the MODEL 
code and “Built-in functions” on page 113. 


The vertical bars around an expression, | <expression> |, return a count of the number of 
members in a set. “Operators for set expressions” on page 112 describes the list of set 
operators.


The <identifier> . <identifier> parameters select a field in a previously declared struct.


The self keyword references the current instance in the expression.


<expression_syntax> ::= <term>


| <term>


<binary_operator>


<expression>


<term> ::= <simple_term>


| <unary_operator>


<simple_term>


<simple_term> ::= <literal>


| <reference>


| "(" <expression> ")"


<reference> ::= <name>


| <function_name>


"(" <arg_list> ")"


| "|" <expression> "|"


<name> ::= <identifier>


| <identifier> "." <identifier>


| self

118 EMC Smarts Foundation MODEL Reference Guide







Writing Expressions in MODEL

Examples of set operators


You can perform operations on sets to evaluate and compare their contents. This section 
provides examples for the operators listed in Table 9 on page 112.


Count
The use of count is illustrated in the declaration of nPath, which is the number of members 
in Path.


computed attribute int nPath = |Path|;


Subset
The subclasses Target_Layer2a and Target_Layer2b and the computed relationshipsets 
isLayer2a and isLayer2b use the subset operator to get their values.


computed relationshipset isLayer2a, Target_Layer2a
= Target_Layer2a(Path);


computed relationshipset isLayer2b, Target_Layer2b
= Target_Layer2b(Path);


Intersection
The computed relationship SetIntersection uses the intersection operator to produce the 
intersection of the computed relationshipset isLayer2a and the relationship AltPath.


computed relationship SetIntersection, Target_Layer2a
= AltPath & isLayer2a;


Union
The computed relationship SetUnion uses the union operator to produce the union of the 
computed relationshipset isLayer2a and the relationship AltPath.


computed relationship SetUnion, Target_Layer1
= AltPath | isLayer2a;


Difference
The computed relationship SetDifference uses the difference operator to produce a set 
that includes the members of isLayer2a that are not members of AltPath.


computed relationship SetDifference, Target_Layer2a
= isLayer2a - AltPath;


Unique
The UniqueInt declaration uses the unique operator to return a set of values from the vInt 
attribute without any duplicate values.


set(int) UniqueInt
definition : return unique(Path->vInt);
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When the value of an expression is unavailable
When the Domain Manager marks an attribute as unavailable, it does so because it cannot 
determine the attribute’s value. For event expressions written with Boolean operators, the 
result of the expression, in certain situations, can be determined when the value of one of 
the attributes is known.


Boolean attributes


There are three possible results for an event expression written with a Boolean operator: 
True, False, and Unavailable.


Events E1 and E2 are both defined using attributes A1 and A2. The expression for event E1 
uses the Boolean AND operator while the expression for event E2 uses the Boolean OR 
operator.


interface Ex1 : MR_ManagedObject
{


event E1 = A1 && A2;
event E2 = A1 || A2;


attribute boolean A1;
attribute boolean A2;


}


When either attribute A1 or A2 has a value of unavailable, the result of expressions E1 and 
E2 may not be unavailable. The following tables illustrate how the Domain Manager 
evaluates each event expression.


Table 11 on page 120 shows all possible outcomes for event expression E1 when the 
value for one of its attributes, A1 or A2, is known. 


Table 12 on page 120 shows all of the possible outcomes for event expression E2 when 
the value for one of its attributes, A1 or A2, is known. 


Table 11  Truth table for event E1 = A1 && A2


Attribute A1


Attribute A2 True False Unavailable


True True False Unavailable


False False False False


Unavailable Unavailable False Unavailable


Table 12  Truth table for event E2 = A1 || A2


Attribute A1


Attribute A2 True False Unavailable


True True True True


False True False Unavailable


Unavailable True Unavailable Unavailable
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When the value of an unavailable attribute does not affect the result of the event 
expression, that result is given. For example, when A1 is False and A2 is True for event 
E2, the result is True because the Boolean OR operator requires that only one of the terms 
evaluate to True.


MODEL also applies a short circuit logic to expressions written with Boolean operators. For 
an event defined with Boolean AND, A2 is not evaluated when A1 is False because the 
result of the expression is already False. If A1 is True or Unavailable, the Domain 
Manager evaluates A2. For an event defined with Boolean OR, the Domain Manager does 
not evaluate A2 when A1 is True because the result is True regardless of the value of A2. 
If A1 is False or Unavailable, then the Domain Manager evaluates A2.
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Constraints

Overview
A constraint is a Boolean expression that is evaluated at the end of a write transaction or 
anytime a change (write) is made to an attribute or relationship. When the constraint is 
checked, the expression must evaluate to TRUE or the transaction fails and an error is 
returned. 


Constraint expressions are used to enforce limits on the values of attributes or 
combinations of attributes. Constraints are enforced at runtime, unlike ranges. Constraints 
can also be applied to relationshipsets.


Syntax
The syntax for a constraint on an attribute is: 


The hard keyword modifies a constraint to indicate that it is always enforced and fatal to 
violate. The hard keyword is the default.


The soft keyword is currently treated the same as the hard keyword.


The old keyword can be used before an attribute name in a constraint expression. When 
used, it indicates “check the attribute’s old value”. 


The <expression> parameter must evaluate to TRUE or an error is returned when the 
constraints are checked. The <expression> may not include &&, ||. ?:, or “else” operators.


attribute double timeOut= 0.0;
constraint timeOutNonNegative


= timeOut >= 0.0;


In this example, the constraint timeOutNonNegative was applied to the attribute timeOut. 
Therefore, if there is an attempt to assign a negative value to the attribute timeOut, the 
assignment will fail, the attribute will retain its old value, and an error will be returned.


The following example has the expression checking the old value of vChar when 
evaluating the constraint. In this example, the value of the attribute, vChar, must never be 
set to the same value twice in a row.


attribute int vChar;


hard constraint NotOld
“Requires that vChar never be set to the same value twice
in a row”
= old vChar != vChar;


<constraint> ::= [ hard | soft ]


constraint


<constraint_name>


[ <constraint_description> ]


“=” 


[ old ]


<expression>


“;”
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The syntax for a constraint on a relationshipset is: 


For each object in the relationshipset, the <expression> parameter must evaluate to TRUE 
or an error is returned when the constraints are checked. This form of constraint constrains 
the related class, therefore, you cannot use a unidirectional relationshipset; the inverse 
path must be available.


In the <expression> parameter, you get the value of the specified attribute in the related 
class using:


<iterator_name> @ <relatedClass> :: <attribute>


If the related class is a subclass of the one to which the relationshipset relates, then only 
instances of that class in the relationshipset are examined. The attribute must be 
declared, not inherited, in the related class. The expression may not include &&, ||, ?:, or 
‘else’ operators.


In this example, the constraint checks that every object in the relationshipset DrivenBy is a 
driver whose age is greater than 18.


interface Driver;


interface Car : MR_ManagedObject
{


relationshipset DrivenBy, Driver, Drives;


constraint age_constraint
= foreach i (DrivenBy) i@Driver::age > 18;


}


interface Driver : MR_ManagedObject
{


relationshipset Drives, Car, DrivenBY;


attribute int age;
}


<constraint> ::= [ hard | soft ]


constraint


<constraint_name>


[ <constraint_description> ]


“=” 


foreach


<iterator_name>


“(“ <relationshipset_name> “)”


<expression”


“;”
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Instrument Declarations

Overview
An instrumentation declaration specifies the access method for all of the instrumented 
attributes of the class for which it is declared. All of the attributes for a class must use the 
same instrumentation access method. For example, with SNMP an instrumentation 
declaration connects the instrumented attributes to an SNMP object identifier (OID). The 
SNMP accessor, the Domain Manager component that performs SNMP polling, retrieves 
the value of the corresponding MIB variable and updates the value of the instrumented 
attribute.


The Domain Manager automatically manages the interconnection between the SNMP 
accessor, the monitoring system, and the subscription mechanism. As noted previously, 
the Domain Manager only monitors for those attributes and events necessary to diagnose 
the problems to which an EMC Smarts client has subscribed. The SNMP accessor is aware 
of the monitoring structures connected to attributes that it instruments. If the value of an 
instrumented attribute is not required to evaluate an event expression, the SNMP 
accessor does not retrieve or update the value of that attribute.


Syntax


The keyword instrument indicates that this is an instrumentation declaration. The 
keywords SNMP and REMOTE_REPOSITORY declare the type of instrumentation, however, 
it is informational only. 


Each optional <instrument_mapping> parameter joins an instrumented attribute with the 
OID of the SNMP object. The syntax for declaring an instrumented attribute is described in 
“Instrumented attributes” on page 68.


The following example declares the instrumentation for three variables: if Descr, ifInOctets 
and ifOutOctets.


interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{
    ifDescr = "1.3.6.1.2.1.2.2.1.2",
    ifInOctets = "1.3.6.1.2.1.2.2.1.10",
    ifOutOctets = "1.3.6.1.2.1.2.2.1.16"
    };


    relationship Instruments,EthernetInterfac,InstrumentedBy;


    readonly instrumented attribute string ifDescr
    "User-settable description of this interface";


<instrumentation_dcl> ::= instrument


[ SNMP | REMOTE_REPOSITORY ]


["{" <instrument_mapping> "}" ]


“;”


<instrument_mapping> ::= <instrument_pair>


["," <instrument_mapping> ]


<instrument_pair> ::= <attribute_name> "=" 


<instrumentation_string>
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#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
    "The total number of octets received on the "
    "interface.";


#pragma WrapCounter
    readonly instrumented attribute unsigned ifOutOctets
    "The total number of octets transmitted on the "
    "interface.";
}


Summary of runtime requirements for SNMP instrumentation
The MODEL requirements for SNMP instrumentation include instrumented attributes and 
SNMP instrumentation. When you are ready to load your model into a Domain Manager, 
there are several additional steps you must complete.


The SNMP accessor is the component within the Domain Manager responsible for polling 
SNMP agents. You must provide the SNMP accessor with the following information.


◆ The polling parameters for the SNMP accessor. These include how often to poll, the 
number of retries to attempt for unsuccessful polls, and how long to wait before a 
timeout.


◆ The read community string for the SNMP agent.


◆ The IP address or hostname of the SNMP agent.


◆ Index number of the SNMP table. This is optional.


There are two methods for configuring the SNMP accessor. The recommended method is 
to use the EMC Smarts Framework. You may also connect an instance to the SNMP 
accessor through the EMC Smarts Manager’s C API.
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MODEL Pragmas

Overview
Pragmas are added to MODEL files to guide the MODEL compiler. In many cases, pragmas 
are required. Neglecting to use them will result in errors and code that does not properly 
compile.


Required pragmas
The pragmas described in this section are almost always required for meaningful MODEL 
code. There are two required pragmas:


◆ #pragma include_c


◆ #pragma include_h


#pragma include_c file-name


This pragma, which may appear anywhere in a MODEL file, causes the MODEL compiler to 
add a C preprocessor include statement for the given file-name to the generated .c file. 
The filename must be enclosed by quotes (““) or angle brackets (<>). The quotes or 
brackets are preserved in the generated file.


#pragma include_h file-name


This pragma, which may appear anywhere in the MODEL file, causes the MODEL compiler 
to add a C preprocessor include statement for the given file-name to the generated .h file. 
The filename must be enclosed by quotes (““) or angle brackets (<>). The quotes or 
brackets are preserved in the generated file.


Example of #pragma include_h and #pragma include_c
The example below is from the department.mdl file.


#include <repos/managed_object.mdl>


#pragma include_h <repos/managed_object.h>
#pragma include_c "department.h"
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Additional pragmas
The pragmas described in this section are not always required. However, you may be 
required to use these pragmas in certain situations to produce correct MODEL code.


#pragma Idempotent Get


This pragma is used with computed attributes, where you supply the code for the attribute 
put and get. It tells the monitoring system that the value of the attribute will change only if 
there is a put to the object. Thus, the monitoring system can treat this attribute as a stored 
attribute in terms of monitoring. If the user-defined attribute can change arbitrarily, then 
the monitoring system has to poll to detect changes.


#pragma ident “string”


This pragma provides a string for constructing an “RCS ident” comment in the generated 
code. The MODEL compiler will generate the following code in the generated .c file:


static const char SM_RCSIDSTRING[] = "string";


You can use a string of the form RCS $Id: $ to be substituted by RCS. Strings of this form 
can be extracted from the MODEL library and printed by the UNIX what program.


#pragma import


This pragma terminates a #pragma include block.


#pragma include


This pragma treats the input file, from this point until either the end of the file or a 
#pragma import, as part of the main file. Therefore, code is generated for declarations in 
included files. Normally, code is not generated for declarations in included files.


#pragma Leaf File


This pragma, which may appear anywhere in a MODEL file, helps the MODEL compiler 
generate more efficient code. It tells the MODEL compiler that the classes declared in this 
file do not have subclasses declared for them in any other file. The MODEL compiler 
generates an error message if another source file includes the file with this pragma and 
declares subclasses.
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#pragma Local Operation


This pragma locks only the object on which the operation is invoked. Normally, the MODEL 
compiler generates code so that invoking an operation implicitly locks the entire 
repository. 


#pragma Local Operation
    readonly string HighUtilization_attributes()


"Returns event format data for the HighUtilization event."
definition:


return "THRESHOLD  PCT UtilPct > MaxUtilPct"
               "PCT MaxUtilPct - -"


"KB  StorageSize - -"
               "KB  StorageUsed - -";


#pragma Uses Propagation


This pragma, which must appear before the attribute declaration to which it applies, tells 
the MODEL compiler that access to this attribute may require access to other Repository 
instances. This pragma should be used before any attribute that can be refined as 
propagated or as computed with an expression referring to other propagated attributes. 
This pragma locks the entire repository, however, the lock type (read/write) will be 
according to the type operation called on the attribute. For example, if you are setting the 
value of an attribute it will be a write lock.


#pragma Unlocked


This pragma can be used for either interfaces, attributes or operations. It tells the MODEL 
compiler not to lock the repository at all. You can lock the repository in your own code. 
However, even if you do your own locking, if you delete the object just as the operation or 
attribute is being dispatched to your code, you may get a crash. In addition, this is 
inherited, meaning that once you have marked an attribute or operation as unlocked, you 
cannot change it back to locked, even in a derived class.


Note: You can also use this pragma for interfaces, however, it is not recommended to 
unlock an entire interface.
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Pragmas used with SNMP instrumentation
The following pragmas typically appear before instrumented attributes whose values are 
retrieved from an SNMP agent.


#pragma WrapCounter


This pragma appears before attributes of type unsigned int that represent a wrapping 
counter, such as an octets counter on a router interface. This means that rates and deltas 
computed over this attribute can never be negative; if the later value is smaller than the 
earlier value, it is assumed that the counter has wrapped and the value is adjusted 
accordingly.


traced interface EthernetInterfaceStats : Instrumentation
{
    instrument SNMP{


ifInOctets = "1.3.6.1.2.1.2.2.1.10",
ifOutOctets = "1.3.6.1.2.1.2.2.1.16"


    };


#pragma WrapCounter
    readonly instrumented attribute unsigned ifInOctets
        "The total number of octets received on the interface.";


#pragma WrapCounter
    readonly instrumented attribute unsigned ifOutOctets
        "The total number of octets transmitted on the interface.";
}


#pragma ObjectID


This pragma appears before an instrumented attribute declaration of type string whose 
value is the OID of an SNMP device. This pragma tells the Repository to convert the OID 
type returned by the SNMP agent into a MODEL string.


#pragma DotNotation


This pragma appears before an instrumented attribute declaration of type string whose 
value is an IP address. This pragma tells the Repository to convert the OCTECT STRING type 
returned by the SNMP agent into a MODEL string.


#pragma HexNotation


This pragma appears before an instrumented attribute declaration of type string whose 
value is in hexadecimal form. This pragma tells the Repository to convert the hexadecimal 
value into a string. The only legal characters in such a string are the digits zero through 
nine and the letters A through F. Successive pairs represent the value of a single byte.
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Pragma warnings in the MODEL compiler
Using the proper pragmas is necessary to make MODEL generate the correct code. The 
MODEL compiler issues warnings about unrecognized pragmas as well as pragmas that 
are ignored.


“Unrecognized Pragma” warnings


The MODEL compiler issues “Unrecognized Pragma” warnings for the following pragma 
syntax errors:


◆ Incorrect spelling


◆ Incorrect capitalization


◆ Missing or extra spaces


“Ignored Pragma” warnings


Pragmas must be applied to top-level declarations. If you try to apply a pragma to a 
declaration refinement, it is ignored when you run the compiler. If the MODEL compiler 
discovers a pragma applied to a refinement, it will ignore it and issue a warning.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
This guide provides instructions for using the EMC Smarts Notification Module 
(EMC Smarts NOTIF) application within an EMC Smarts environment to process external 
events. EMC Smarts NOTIF is a configuration tool and run-time product for raw event and 
notification processing. Events and notifications are configured through the flexible 
graphical user interface, the EMC Smarts Notification Module Configuration Editor 
(EMC Smarts NOTIF Editor).


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide.


Audience
This guide is intended for users of EMC Smarts products with domain knowledge of how 
an event is to be processed and filtered. The person deploying and configuring 
EMC Smarts NOTIF should be familiar with the EMC Smarts Service Assurance Manager 
(Global Manager or SAM), Adapter Platform, and notifications. This guide is intended for 
any user who needs to manage and import external events into EMC Smarts Service 
Assurance Manager products.


EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For UNIX, this location is: /opt/InCharge/<product>.


◆ For Windows, this location is: C:\InCharge\<product>.


The <product> represents the EMC Smarts product to which the product belongs. For 
example, on UNIX operating systems, EMC Smarts Service Assurance Manager is, by 
default, installed to /opt/InCharge/SAM/smarts. On Windows operating systems, this 
product is, by default, installed to: C:\InCharge\SAM\smarts. This location is referred to as 
BASEDIR/smarts.
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Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge 
(on UNIX) or C:\InCharge (on Windows), but you cannot change the <product> location 
under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• XML Adapter


• EMC Smarts Adapter for UIM/O


Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory.


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide
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◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


FlexNet Publisher License Administration GuideThese documents are updated 
periodically. Electronic versions of the updated manuals are available on the EMC online 
support website:
https://support.emc.com


EMC Smarts Service Assurance Manager documentation
The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide


◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide
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◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Conventions used in this document
EMC uses the following conventions for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about  your account.


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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Introduction


This chapter consists of the following topics:


◆ EMC Smarts Notification Module overview ..............................................................  14
◆ EMC Smarts Service Assurance Manager Adapter Platform architecture ...................  15
◆ EMC Smarts NOTIF integration with Adapter Platform architecture ...........................  16
◆ EMC Smarts NOTIF architecture ...............................................................................  17
◆ EMC Smarts NOTIF processor functionality...............................................................  19
◆ EMC Smarts NOTIF Editor functionality.....................................................................  19
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EMC Smarts Notification Module overview
The EMC® Smarts® Notification Module (EMC Smarts NOTIF) augments the EMC Smarts 
solutions with event management features that are configurable through a graphical user 
interface. The EMC Smarts NOTIF user interface is referred to as the EMC Smarts 
Notification Module Configuration Editor (EMC Smarts NOTIF Editor). EMC Smarts NOTIF 
replaces the internal event and notification processing features of the standard EMC 
Smarts Service Assurance Manager Adapter Platform. EMC Smarts NOTIF provides the user 
with event and notification configuration access, maintenance, and documentation 
capabilities without requiring a complete understanding of the underlying products, and 
without requiring extensive application-specific coding.


EMC Smarts NOTIF represents an improvement over the standard EMC Smarts trap 
processing design. To configure the standard SNMP Trap Adapter to process traps, you 
must decide which traps should become notifications and how the notifications should 
appear at the Global Console. You can do this by editing the trap_mgr.conf file and then 
restarting the server. EMC Smarts NOTIF makes this process much more user-friendly and 
robust. With EMC Smarts NOTIF, you can make instantaneous trap processing 
configuration changes through the EMC Smarts NOTIF Editor without restarting any 
servers.


Efficient event and notification processing presents the most important information to the 
operator by using an EMC Smarts Service Assurance Global Console. EMC Smarts NOTIF 
enables the user to easily optimize the flow of events and notifications sent through any 
EMC Smarts system. Advantages of using EMC Smarts NOTIF include the following:


◆ Handles notifications in a consistent and extensive manner.


◆ Facilitates configuration of events and notifications through a flexible, user-friendly 
interface, the EMC Smarts NOTIF Editor.


◆ Allows for real-time reconfiguration of event and notification processing without 
server restarts.


◆ Applies to any event source.


◆ Integrates with standard EMC Smarts Service Assurance Manager (SAM) and Adapter 
Platform (OI) repositories and servers.


◆ Supports current EMC Smarts Service Assurance Manager Adapter Platform standard 
SNMP event functions (that is, expiration clearing, unknown agents, logging 
specifications, notification field setting).


◆ Provides converter tools for standard configuration sources (for example, 
trap_mgr.conf file).


◆ Packages event and notification configurations. This is useful for modular roll-out of 
configurations.


◆ Automatically generates an HTML-based document that provides information on all 
internal event and notification configuration objects for review and documentation 
purposes. 


◆ Requires no knowledge of the EMC Smarts Adapter Scripting Language (ASL).
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EMC Smarts Service Assurance Manager Adapter Platform 
architecture


To understand the event management capabilities and advantages that EMC Smarts NOTIF 
provides in an EMC Smarts implementation, it is important to understand the EMC Smarts 
Service Assurance Manager Adapter Platform architecture and the standard EMC Smarts 
trap processing design.


Figure 1 on page 15 is an example of a basic SAM configuration. The Adapter Platform 
imports topology and event information from third-party applications and prepares it for 
use by the Service Assurance Manager. Data from third-party applications should not be 
sent directly to SAM. The Adapter Platform creates notifications from the incoming 
information and can even associate these notifications to topology information supplied 
by another EMC Smarts application, such as the EMC Smarts IP Availability Manager as 
shown in Figure 1 on page 15. 


Figure 1  Standard EMC Smarts Service Assurance Manager Adapter Platform architecture


The Adapter Platform consists of the SNMP Trap Adapter, as shown in Figure 1 on page 15. 
The SNMP Trap Adapter parses SNMP traps received and generates notifications based on 
the contents of the traps. The SNMP Trap Adapter can receive SNMP v1, v2c, or v3 traps. 
However, it forwards only v1 or v2c traps. If SNMPv3 traps are received, they are converted 
to one of the other formats before being sent to a domain manager or to another trap 
receiver. 
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The EMC Smarts Service Assurance Manager Adapter Platform User Guide provides details 
on the Adapter Platform.


The SNMP Trap Adapter can be configured to handle many different types of traps through 
two configuration files associated with the SNMP Trap Adapter: 


◆ trapd.conf — This is the configuration file for the EMC Smarts SNMP Trap Adapter. This 
conf file determines what port number the trap adapter listens to for traps, and 
enables trap forwarding to EMC Smarts domain managers (like the IP Availability 
Manager) and the Adapter Platform. 


◆ trap_mgr.conf — This configuration file determines how specific traps are mapped into 
notifications that are sent to the Global Console.


EMC Smarts NOTIF integration with Adapter Platform architecture
EMC Smarts NOTIF allows you to filter and forward events and perform other event 
management configuration through Event Configuration Information (ECI) objects. The 
event configuration features of EMC Smarts NOTIF replace the trap_mgr.conf file in the 
Adapter Platform (OI) server shown in Figure 2 on page 17, which performs the event 
filtering and determines which traps are forwarded for further processing. The EMC Smarts 
NOTIF functions are overlaid on the standard EMC Smarts Service Assurance Manager 
Adapter Platform architecture as shown in Figure 2 on page 17. EMC Smarts NOTIF can be 
installed on an Adapter Platform server or a SAM server. 


EMC Smarts NOTIF also allows you to process notifications through Notification 
Configuration Information (NCI) objects. The notification processing features of 
EMC Smarts NOTIF replace the internal notification processing in the Adapter Platform or 
SAM server, depending on where EMC Smarts NOTIF is installed, as shown in Figure 2 on 
page 17.


“EMC Smarts NOTIF architecture” on page 17 provides details on ECI and NCI objects.
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Figure 2  Overlay of EMC Smarts NOTIF functions on Adapter Platform architecture


EMC Smarts NOTIF architecture
There are two main components of EMC Smarts NOTIF. The first is the real-time component 
which processes SNMP traps or other raw event types according to configuration settings. 
This configuration processing is performed on raw events by the Event Configuration 
Information (EventConfigInfo or ECI) objects. ECI objects determine whether a particular 
event will be processed, that is, whether a notification for an event will be created. ECI 
processing is discussed in Chapter 2, “Event Configuration Information Processing.”


The second EMC Smarts NOTIF component is notification processing, which is configured 
by the Notification Configuration Information (NCI) objects. NCI objects determine how 
notifications are processed. NCI processing is discussed in Chapter 3, “Notification 
Configuration Information Processing.”


It is important to note the separation of raw event processing (through ECI objects) versus 
notification processing (through NCI objects) since this allows EMC Smarts NOTIF to 
operate in various architectures. The EMC Smarts NOTIF Editor allows the user to 
manipulate the configuration settings for both ECI and NCI objects.


In an EMC Smarts implementation, EMC Smarts NOTIF can reside on a SAM server or an 
Adapter Platform Open Interface (OI) server. Figure 3 on page 18 shows how ECI and NCI 
objects are used in an EMC Smarts NOTIF solution where low-level raw events are filtered 
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and processed, and notifications are grouped within the Adapter Platform. An additional 
EMC Smarts NOTIF process is run within the SAM server to combine and group 
notifications from the adapter servers and other (analysis) servers.


Figure 3  EMC Smarts NOTIF ECI/NCI structure in an EMC Smarts environment


Advantages of EMC Smarts NOTIF architecture


In the EMC Smarts NOTIF Editor, you configure ECI objects to determine how you want to 
handle particular events. In the ECI setup window, in the EMC Smarts NOTIF Editor, you 
can select whether a particular raw event should be handled. If the event is to be 
processed, select the Active checkbox in the EMC Smarts NOTIF Editor as shown in 
Figure 6 on page 32. When you select whether a particular event is Active, you save the 
configuration to the local Adapter Platform server (File > Save Configuration or File > Save 
Configuration As... in the EMC Smarts NOTIF Editor), and you do not have to restart the 
Adapter Platform server.


The EMC Smarts NOTIF Editor also allows you to make changes to varbinds associated with 
ECI configuration parameters through the ECI setup window in the EMC Smarts NOTIF 
Editor. Without the EMC Smarts NOTIF Editor, you would have to do this by writing hook 
scripts.


“Setting up ECI configuration parameters” on page 32 provides details on how to 
configure ECI objects to handle incoming events.
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EMC Smarts NOTIF processor functionality
When the EMC Smarts NOTIF processor starts up on a server or the Remote > Reload server 
option in the EMC Smarts NOTIF Editor is selected, EMC Smarts NOTIF browses the 
BASEDIR/smarts/conf/<config> and local/conf/<config> directories for files that end in 
".ncf". The *.ncf files are EMC Smarts NOTIF configuration files. EMC Smarts NOTIF loads 
each*.ncf file into the EMC Smarts NOTIF processor and combines them to create the 
running configuration on the Adapter Platform or SAM server where EMC Smarts NOTIF is 
running.


The use of *.ncf files in EMC Smarts NOTIF is a major architectural change from previous 
versions of NOTIF. EMC Smarts NOTIF now loads configurations from *.ncf files, one at a 
time, rather than connect to an EMC Smarts repository. 


EMC Smarts NOTIF configuration files (*.ncf files) are XML files that you can edit using the 
EMC Smarts NOTIF Editor. “EMC Smarts NOTIF Editor functionality” on page 19 provides an 
overview of how the EMC Smarts NOTIF Editor works.


When EMC Smarts NOTIF reads an *.ncf configuration file and loads the entire 
configuration from the configuration directories (that is, the /conf/<icoi or /ics> or 
/local/conf/<icoi or /ics> directories), the cumulative configuration is written to an *.ncf 
file in the local/logs directory (for example, the INCHARGE-OI.<configfilename>.ncf file). In 
this way, you can determine the specific EMC Smarts NOTIF configuration elements that 
are running on a particular server. The *.ncf file written to the local/logs directory is 
generated when you either start up EMC Smarts NOTIF or select the Remote > Reload server 
option in the EMC Smarts NOTIF Editor.


When you install the EMC Smarts Service Assurance Manager version 9.2, EMC Smarts 
NOTIF is not enabled by default. You must start EMC Smarts NOTIF by performing the steps 
described in “Starting EMC Smarts NOTIF” on page 66.


EMC Smarts NOTIF Editor functionality
The EMC Smarts NOTIF Editor is designed to allow you to manipulate EMC Smarts NOTIF 
configuration files (*.ncf), both on the local machine that is running the EMC Smarts NOTIF 
Editor as well as remote servers. The EMC Smarts NOTIF Editor accesses local 
configuration *.ncf files under the File menu option, while remote operations are located 
under the Remote menu option. “Main menu options” on page 73 provides details on The 
EMC Smarts NOTIF Editor menu options.


The EMC Smarts NOTIF Editor provides key functions through the main menu such as 
retrieving configurations from remote servers, pushing (or storing) configurations to 
remote servers, and managing connections to remote servers. Figure 4 on page 21 
provides a schematic overview of the EMC Smarts NOTIF Editor functionality. 

EMC Smarts NOTIF processor functionality 19







Introduction

Local *.ncf file configuration options (File menu)


On the local server, you can edit an. *ncf file through the following File menu options:


◆ New Configuration
◆ Open Configuration
◆ Merge Configuration
◆ Save Configuration
◆ Save Configuration As
◆ Close Configuration


You can also import trap_mgr.conf files to your local server through the Import 
trap_mgr.conf File menu option. This option allows you to load the trap_mgr.conf files 
used to configure a TRAP-INCHARGE-OI server (SNMP Trap Adapter) into EMC Smarts NOTIF 
to replicate the standard file-based functionality.


“File menu options” on page 73 provides more information on File menu options.


Connecting to a remote server through the EMC Smarts NOTIF Editor (Remote > 
Manage connections)


Connections are defined within the EMC Smarts NOTIF Editor to access remote servers. 
Multiple connections may be defined and given a reference name for convenience. The 
Remote > Manage connections menu option is used to add remote server connections in 
the EMC Smarts NOTIF Editor. When you select this option, you type a connection 
reference name and connection details such as broker, domain, and user names. 


“Manage connections...” on page 88 provides more information on how to set up remote 
server connections.
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Figure 4  EMC Smarts NOTIF Editor functionality
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Remote *.ncf file configuration options (Remote menu)


After you have established the remote server connection through the Remote > Manage 
connections option, push or store a local *.ncf configuration file or package to a remote 
server through the following EMC Smarts NOTIF Editor options:


◆ Push to server
◆ Push package to server
After the configurations are pushed to a remote server, they do not become active on the 
remote server until you select the Remote > Reload Server option.


The Remote menu options associated with retrieving a running configuration or a specific 
*.ncf file from a remote server to a local server are:


◆ Retrieve running configuration from server 
◆ Retrieve a configuration file from server
This Remote > Edit a server’s settings option is used to change server settings on remote 
servers. One of the settings you can change on a remote server is whether EMC Smarts 
NOTIF is active on that server. “Starting EMC Smarts NOTIF” on page 66 provides details 
on the process for activating EMC Smarts NOTIF on a remote server by using the Edit a 
server’s settings option.


“Remote menu options” on page 80 provides more information on Remote menu options.
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CHAPTER 2
Event Configuration Information Processing 


This chapter describes Event Configuration Information (EventConfigInfo or ECI) 
processing. 


This chapter consists of the following topics:


◆ ECI processing overview ..........................................................................................  24
◆ Raw event normalization .........................................................................................  26
◆ Pushing events into EMC Smarts NOTIF ...................................................................  27
◆ ECI event matching..................................................................................................  28
◆ Designing ECI naming conventions..........................................................................  29
◆ Enumeration of keyword/value pairs .......................................................................  31
◆ Value substitutions .................................................................................................  32
◆ Setting up ECI configuration parameters..................................................................  32
◆ Copying ECI configuration parameters .....................................................................  43
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ECI processing overview
Event Configuration Information (ECI) processing involves two steps:


◆ Determining whether a raw event should be processed to create an unpublished 
notification that is passed to notification processing (that is, filtering events at the 
lowest level possible).


◆ Determining the instance/class/event name of the notification that should be created 
if the event is processed. 


Figure 5 on page 24 shows the overall flow of ECI processing steps. Chapter 3, 
“Notification Configuration Information Processing.” provides details on how ECI 
processing steps relate to the NCI processing steps.


Figure 5  ECI processing and NCI processing steps within EMC Smarts NOTIF
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Event information is passed to EMC Smarts NOTIF through a common structure. This 
packaging allows for common information to logically identify an event and pass 
additional information that may be used to further convert raw information into a specific 
notification. 


The packaging of the event data is performed by the specific adapter and should be 
referenced by the individual adapter documentation. The general format of the wrapper is 
explained in “Raw event normalization” on page 26. 


Events are grouped by three identifying fields: baseID, sub1ID, and sub2ID. An event is 
only processed if an associated ECI is found to match these fields.


After an ECI matches a given raw event, a series of configuration tests are performed on 
the raw event to determine if the event should be processed further. Configuration test 
checks on a raw event include the following parameters:


“Setting up ECI configuration parameters” on page 32provides details on all the available 
ECI configuration values. Failure of any raw event test prevents the ECI process from 
determining what unpublished notification will be created or updated. 


After basic event tests are complete, the event is formed into a notification. This phase of 
processing allows the instance, class, event name and all notification values to be 
changed based upon event data with variable substitution from raw event data. After this 
point, it is an unpublished notification that is no longer connected to the raw event, 
though the event data may be passed in the notification.


ECI configurations are saved as *.ncf files and remain unchanged through the stopping 
and starting of the Adapter Platform (OI) server. 


There are several ways in which ECI objects can be loaded or added into a SAM/Adapter 
Platform server. ECI objects can be:


◆ Defined by *.ncf files provided from other sources (that is, pre-packaged 
configurations).


◆ Created directly from the EMC Smarts NOTIF Editor from the Edit menu.


◆ Merged into the EMC Smarts NOTIF Editor based on specifications in the trap_mgr.conf 
file.


Additionally, the EMC Smarts NOTIF Editor provides a means to copy an existing ECI object 
as the basis for another, and to save all defined configurations to an .import file.


After a raw event arrives and the best ECI object match is found, the behavior of the 
configuration object is performed relative to the event. If ECI objects are modified with the 
EMC Smarts NOTIF Editor, the effects of the modifications take place when the next 
instance of the relevant event arrives.


Event Active The event must be active in order to be processed.


Is Managed Un-managed objects are not processed.


< x events in y minutes Sliding window squelch.


ASL hook Hard-coded test of other values.
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Raw event normalization
Raw events are passed to EMC Smarts NOTIF through adapters after being normalized into 
a common structure. This structure provides the required basic event information and 
additional data used for further processing. The format of the data stream is a 
pipe-separated ("|") string as shown below: 


<eventTimeStamp>|<eventAgent>|<eventBaseID>|<eventSub1ID>|<eventSub2ID 
>|<Keyword1|Value1>|
<Keyword2|Value2>.....


The pipe-separated data stream includes the following information:


◆ eventTimeStamp — Event occurrence time in UNIX time format; seconds since the 
Epoch


◆ eventAgent — Agent name or IP address


◆ eventBaseID — dot-separated hierarchical identifier string (abc.123.XYZ….) 
(for example, enterprise for SNMP)


◆ eventSub1ID — General identifier (generic trap number for SNMP)


◆ eventSub2ID — Specific identifier (specific trap number for SNMP)


◆ Keyword1|Value1 — Keyword|value pair (OID1|value for SNMP)


◆ Keyword2|Value2 — Keyword|value pair (OID2|value for SNMP)


The eventBaseID, eventSub1ID, and eventSub2ID parameters are used as the unique 
event identifiers to match with ECI objects. The number of Keyword|Value pairs is 
variable. Event IDs may use all three fields, the first two, or only the eventBaseID; it 
depends on the raw events being processed. 


For specific adapters, the adapter documentation provides details to obtain information 
on the composition of the ID strings and the Keyword|Value pair mapping.


EMC Smarts NOTIF replaces pipe character ("|") in field.(varbind) by double dashes ("--") to 
process the raw event.
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Pushing events into EMC Smarts NOTIF
EMC Smarts NOTIF uses a named queue to process incoming events. Events are 
normalized into a common structure and pushed into this queue through MODEL 
methods. The named queue for events is notifInterface::notifEventQueue. The method 
used to push an event into the queue is:


void pushEvent ( string encodedEvent, string sourceSystemId );


The encodedEvent is a pipe-separated ("|") string having the normalized format 
described in “Raw event normalization” on page 26. The sourceSystemId is a string 
identifying where this event came from. 


The following example ASL file shows how a raw SNMP event is pushed into EMC Smarts 
NOTIF:


rawEvent.asl


START {
.. eol


}
do {


queue = object("notifInterface", "notifEventQueue");
if(queue->isNull()) {


print(queue . " was null!");
return;


}


eventTimeStamp = time();
eventAgent = "192.168.1.100";
enterprise = "TestECI";
generic = "";
specific = "";
oid1 = "testOID";
oidValue1 = "test value";


completeString = eventTimeStamp . "|" . eventAgent . "|" . 
enterprise . "|" . generic . "|" . specific . "|" . oid1 . "|" . 
oidValue1;
queue->pushEvent(completeString, "rawEvent.asl");


}
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ECI event matching
EventConfigInfo objects (ECIs) are the configuration objects that instruct EMC Smarts 
NOTIF how to handle incoming raw events. When a raw event arrives, the best matching 
ECI is identified and that is used to determine if a notification should be created, and if so, 
the instanceName and eventName to be associated with the notification.


ECI objects are named based upon a tree structure from the most generic to the most 
specific field, in the form of eventBaseID_eventSubID1_eventSubID2. An example 
would be:


Vendor.Product.Version.Equipment.Type_EquipmentSubType_SpecificType


SNMP defines ECI objects as Enterprise_Generic_Specific. Examples of how these names 
relate to events are given in the following section. Table 1 on page 28 describes the ECI 
naming rules.


Matching examples When raw events are delivered to EMC Smarts NOTIF, EMC Smarts NOTIF finds the best 
match between a raw event and an ECI in its repository to handle that event. A best match 
is determined by first looking for an ECI that matches 
eventBaseID_eventSubID1_eventSubID2 (in SNMP, these fields are referenced as 
enterprise, generic, and specific fields). If the original event is not matched by an exact 
name for these parameters, wildcard evaluations are performed in order from right to left.


Examples of how EMC Smarts NOTIF matches raw events to ECI objects are:


Defined ECIs


1. ECI-ABC.123.XYZ_TEST_EVENT


2. ECI-ABC.123.XYZ_TEST_*


3. ECI-ABC.123.*_TEST_*


4. ECI-ABC.*_*_*


5. ECI-ABC.*_*


6. ECI-ABC.*


Table 1  ECI naming convention rules


eventBaseID naming rules


• May be any number of dot-separated fields, the last of which may be *


eventSub1ID and eventSub2ID naming rules


• May be explicit, *, or null 


• If eventSub2ID is explicit or *, eventSub1ID must be explicit or *


• eventSub1ID may exist with eventSub2ID null
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Designing ECI naming conventions
Although the naming of ECI objects is determined by the designer of the adapter, it is 
worth noting here as the entire structure of the ECI tree is based on how this is 
accomplished. As an example, assume that events are built based upon the date. Some 
events may use the time format mmm/dd/yyyy, others may use yyyy/mmm/dd. If the 
former is used, (mmm/dd/yyyy), the month shows up as the primary ID (eventBaseID), 
and the EMC Smarts NOTIF Editor branch shows based on month:


Raw event wrapper of IDs


DATE.Apr_01_1996


DATE.Apr_01_1997


Specific defined ECIs


ECI-DATE.Apr_01_1996


ECI-DATE.Apr_01_1997


EMC Smarts NOTIF Editor tree view


Apr -


01 -


1996
1997
1998
02 -


…


A single ECI may be defined to process any month of any year on a specific day by creating 
ECI-DATE.*_01_*


Raw event 
(eventBaseID_eventSub1ID_eventSub2ID
) ECI processing


ABC.123.XYZ_TEST_EVENT Uses ECI 1 — Exact match for all three 
eventBaseID_eventSub1ID_eventSub2ID fields


ABC.123.XYZ_TEST_FOX Uses ECI 2


ABC.123.xyz_TEST_EVENT Uses ECI 3


ABC.123.xyz_CAT_EVENT Uses ECI 4


ABC.123.XYZ_TEST Uses ECI 5 — Does not match ECI 4 since the eventSub2ID field is 


null


ABC.123.XYZ.wxy.zero Uses ECI 6 — Does not match ECI 4 or ECI 5 since the eventSub1ID 


and eventSub2ID fields are null
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However, a common ECI cannot be created to process any day of any year given this 
wrapper format. If the wrapper format was yyyy/mmm/dd, then the tree would appear as:


EMC Smarts NOTIF Editor tree view


1996 -


Apr -


01
02
...
1997 -


Apr -


01
02
...
1998 -


Apr -


...


In this case, an ECI could be ECI-DATE.*_*_01 to process any event on the 1st:


ECI-DATE.*_Apr_* to handle any event in April.


ECI-DATE.1996_*_* to handle any event in 1996.


ECI-DATE.*_*_* to handle any event.


There are two issues from the previous example, first is the view from the EMC Smarts 
NOTIF Editor where it is undesirable to have hundreds of ECI objects showing under one 
branch. Second is the selection of what fields are used for the eventBaseID, 
eventSubID1, eventSubID2 fields greatly impact how ECI objects are designed.


ECI notification naming


The ECI object is responsible for creating the unpublished notification that will be 
processed by the NCI thread for further processing. The primary keys for NCI matching are 
the instance ClassName and EventName, both of which are determined in the ECI as 
shown in Figure 8 on page 35.


Naming of the ECI is independent of the naming of the notification created by the ECI but 
consistency is important to avoid confusion. For example, ECI-EventABC could create a 
notification with an event named EventXYZ. Although this is possible, it is not desirable 
because the connection between an ECI and an NCI will not be apparent. Avoid 
inconsistent translations of event names to notification names.


A feature of the NCI name matching allows for the use of a wildcard at the end of the event 
name, for example: Down-on-port-*. It is important to construct the notification event 
name such that variables are placed at the end of the event name string. 
Down-on-port-5 may use the above event name in the NCI for a match whereas 
Port-5-Down does not facilitate an NCI wild carding match.
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Enumeration of keyword/value pairs
After EMC Smarts NOTIF has determined the appropriate ECI for a raw event, but before it 
starts processing, it will see if the values for the keyword/value pairs should be translated 
based on enumeration tables. For example, a keyword/value pair with 
OID =  .1.3.1.6.2.9.4432.12 may have a table that permits incoming values to be 
translated. The value 1 may mean off and the value 2 may mean on. In general, if an object 
ID (OID) has a translation table, EMC Smarts NOTIF converts the value supplied in the raw 
event to the translation value specified by the table.


In some situations, some devices may append additional nodes to the OID. For example, a 
device appends an IP address to the OID so that a given raw event might be 
.1.3.1.6.2.9.4432.12.192.168.1.234. EMC Smarts NOTIF allows you to flag an ECI as one 
which might have pairs that could use wildcard enumeration lookups. What this means is 
that EMC Smarts NOTIF will first see if there is an enumeration lookup table for 
.1.3.1.6.2.9.4432.12.192.168.1.234, and if none is found and wildcards are possible for 
the ECI, then EMC Smarts NOTIF would look for enumeration mapping tables for  
.1.3.1.6.2.9.4432.12.192.168.1, .1.3.1.6.2.9.4432.12.192.168, 
.1.3.1.6.2.9.4432.12.192, .1.3.1.6.2.9.4432.12, and so on till a lookup table is found or 
the name runs out of dot-separated values. This is a relatively computationally intense 
process, so EMC Smarts NOTIF also permits the administrator to set a maximum number of 
trailing nodes to check before giving up. In our example, where some devices are known to 
append IP addresses, the administrator might set the maximum number of trailing nodes 
to be four. 


To summarize wildcard enumeration lookups:


◆ At the system level (in the configuration file) indicate the maximum number of nodes 
to drop in checking for enumeration tables.


◆ For specific ECIs that are used with raw events that might have OIDs that need 
wildcard lookups, set the ECI Use Enum Wildcard flag to true.


Note this example is specific to SNMP, but any dot-separated keyword string will work in 
the same manner. A keyword/value pair may appear as Smarts.textSeverity = 
Critical and be processed by an enumeration of:


Critical -> 1


Major -> 2


....


The display name of enumerated values may be changed to make the EMC Smarts NOTIF 
Editor tree view more readable. For example, an enumerated value of 
.1.3.6.1.4.1.9.9.37.2.13 may not have much meaning to the reader, but typing a display 
name of Trap.Cisco.FRU.Status makes it easy to identify the actual use of the enumerated 
value.
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Value substitutions
The real-time substitution mechanism begins from the left of the string and finds the first 
substitution instructions. It evaluates that substitution and comes up with a new version 
of the string and starts again to evaluate from the left. Nesting of substitution strings may 
become complex and care should be taken to confirm desired results through testing. An 
example of using substitution values would be configuring the severity of an ECI to be 
$V2$, that is, the severity is set to the value of the second keyword/value pair. The 
severity of an ECI may also use something like $extract(extract(V2,"[",3),"= 
",1)$, but this requires a full understanding of the input string and substitution use. A 
description of the scripting system used within the substitution feature and a complete 
list of substitution values are listed in Appendix A, “Substitution Scripting and Values.”


Setting up ECI configuration parameters
After a matching ECI is identified for an incoming raw event, the configuration values for 
that ECI are used to process the event. You can set the configuration values for an ECI 
through the following tabs in the ECI Setup dialog box:


◆ General
◆ Event Setup
◆ Event Options
◆ User Defined
◆ Calc’d Values


This section provides screen shot examples of an ECI setup and descriptions of each field.


General values The General tab of the ECI Setup dialog box shown in Figure 6 on page 32 defines the 
basic behavior of the raw event. 


Figure 6  General tab of the ECI Setup dialog box


The fields in Figure 6 on page 32 are:
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◆ Active — Selecting this checkbox means that the corresponding raw alarm is to be 
handled.


◆ DedupOn — Selecting this checkbox means that the corresponding event will always 
be filtered unless the notification has cleared. If the DedupOn checkbox is not 
selected, every occurrence of the event will be forwarded with no filtering for 
deduplication.


◆ DedupResendInterval — If this value is greater than zero and the DedupOn option is 
selected, then the event will be resent if the time since the event was last published is 
greater than this number of seconds. For example, if the DedupResendInterval is 60, 
even if there is already one of these events, if it is more than 60 seconds old, it will be 
resent.


◆ ClearOnAcknowledge — Selecting this checkbox causes the resulting notifications to 
be cleared when acknowledged.


◆ InMaintenance — Selecting this checkbox means the event occurred in maintenance.


◆ Event Fork — Selecting this checkbox means that the raw matching event will also look 
for <ECI-name>-2 to create a second thread for additional processing. If the 
<ECI-name>-2 has Event Fork selected, EMC Smarts NOTIF will then look for 
<ECI-name>-3, and so on.


◆ TimeBasedThresholdActive — This checkbox should be selected if the values for 
TimeBasedThresholdCount and TimeBasedThresholdWindow are to be used for x 
times in y seconds time-based event thresholding (where x is the 
TimeBasedThresholdCount value and y is the TimeBasedThresholdWindow value). For 
example, select the TimeBasedThresholdActive checkbox if you want a particular 
event sent if it occurs three times in a 15-second window.


◆ TimeBasedThresholdCount — The number of events that occurs in a given amount of 
time (that is, the TimeBasedThresholdWindow value) that triggers the forwarding of a 
particular event. For example, if the TimeBasedThresholdCount value is 3, and the 
TimeBasedThresholdWindow value is 15, then that means the event should be sent if 
there are 3 of these events that occur in 15 seconds. This enables you to filter out the 
odd once-in-a-while event.


◆ TimeBasedThresholdWindow — The number of seconds in which a particular number 
of events (that is, the TimeBasedThresholdCount value) occur that triggers the 
forwarding of a particular event. The TimeBasedThresholdWindow is a sliding 
window; for example, event 1 that occurs at 1 second, event 2 that occurs at 14 
seconds and event 3 that occurs at 16 seconds will not generate a notification since 
all three of these events did not occur within a 15-second window, but event 4 that 
occurs at 18 seconds will create a notification because events 2, 3, and 4 occurred 
within a 15-second window. 


The DedupOn feature can be used with time-based event thresholding to prevent 
multiple notification updates. To explain how deduplication and time-based event 
thresholding work together, consider the example in which there are 3 events of the 
same type in 15 seconds, but the events are all deduplicated (that is the DedupOn 
checkbox is selected for this event type). 
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The underlying EMC Smarts NOTIF behavior would be:


1. The event is triggered the first time and ignored (since it has not yet hit the 3 
events in 15 seconds threshold requirement). 


2. The second and third events are deduplicated before they trigger the time-based 
thresholding rule. 


To deduplicate this event and have it trigger the threshold would require the event to 
come in an onset, then clear, then onset, then clear, and finally one last onset and 
clear. The reason is that the deduplication will deduplicate any event coming in 
unless it is a clear.


Time-based thresholding generally has no clear event so the ClearOnAcknowledge 
feature described above and/or the Expiration feature described in the Event Setup 
tab should be used to clear the notification. 


The ClearOnAcknowledge feature works at the SAM level, but does not by default clear 
the event if it came from the Adapter Platform. This can create confusion between 
notifications in the console between the Adapter Platform and SAM. 


◆ CheckIsManaged — Selecting this checkbox means that the IsManaged property of the 
instance for this event must be true in order for this event to be processed. If the 
IsManaged property of the instance for this event is false, then the event will be 
logged and dropped.


◆ UsesEnumWildcard — Selecting this checkbox means that this ECI might have 
keyword/value pairs that may use wildcard enumeration lookups.


“Enumeration of keyword/value pairs” on page 31 provides more information on this 
feature.


A useful tip for navigating through the EMC Smarts NOTIF Editor is that the description of a 
specific configuration parameter will display when your mouse hovers over a checkbox or 
data entry field in the EMC Smarts NOTIF Editor. Figure 7 on page 35 shows an example of 
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when the mouse-hover tool is used for the Event Fork checkbox for a particular ECI object. 
You can also use the mouse-hover tool for NCI object EMC Smarts NOTIF Editor 
parameters.


Figure 7  Example of mouse-hover tool in the EMC Smarts NOTIF Editor


Event Setup values The Event Setup tab of the ECI Setup dialog box shown in Figure 8 on page 35 defines the 
properties of the notification created by the raw event.


Figure 8  Event Setup tab of the ECI Setup dialog box


The fields in Figure 8 on page 35 are described below:


◆ ClassName — The class of the instance against which the notification is posted. This 
includes substitution values.


◆ ElementClassName — The class of the element. This includes substitution values.


◆ InstanceName — The name of the instance. This includes substitution values.


◆ ElementName — The name of the element. This includes substitution values.
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◆ EventName — The name of the event used in the notification. This includes 
substitution values.


◆ EventDisplayName — The name of the event displayed in the EMC Smarts Notification 
Log Console.


◆ State — The state used for the notification, which is either NOTIFY or CLEAR.


◆ Severity — The numeric EMC Smarts value or substitution value.


◆ Expiration — The length of time in seconds the notification will remain active.


◆ EventText — The text of the notification, which includes substitution values.


◆ Category — The category of the event used in the notification.


Event Options values


The Event Options tab of the ECI Setup dialog box shown in Figure 9 on page 36 defines 
additional event options for the notification. 


Figure 9  Event Options tab of the ECI Setup dialog box


The fields in Figure 9 on page 36 are described below:


◆ DisplayName — The display name of the event used in the notification.


◆ Description — The description of the event used in the notification.


◆ EventType — The type of event used in the notification, either DURABLE or MOMENTARY.


◆ ServiceName — The name of the service used in the notification.


◆ SysNameOrAddr — The system name or IP address associated with the event used in 
the notification.


◆ ASL — The ASL script called before the posting of this notification.


EMC Smarts NOTIF uses the value stored in ASL to determine which file to load. The 
named ASL script is invoked from the local/rules or /rules directories. For example, if 
you type icoi-trapd/sample_hook.asl in the ASL field in the EMC Smarts NOTIF Editor, 
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EMC Smarts NOTIF will look up local/rules/icoi-trapd/sample_hook.asl and 
rules/icoi-trapd/sample_hook.asl. Appendix B, “ASL and Java Interfacing with 
EMC Smarts NOTIF” provides more information on how to write ASL scripts for use 
with EMC Smarts NOTIF event processing.


◆ Java — The Java class called.


Appendix B, “ASL and Java Interfacing with EMC Smarts NOTIF” provides more 
information on how to write Java classes for use with EMC Smarts NOTIF event 
processing.


◆ Logfile — The name of the log file recording information about this event.


◆ UnknownAgent — The action taken if the agent is unknown, either CREATE which will 
create the object, or IGNORE which will discard this event.


◆ Event Stream — When set, the processor guarantees that all events with a given event 
stream name will be processed in the order in which they were received. If the Event 
Stream option is not set, there is no such guarantee. An example of a scenario in 
which setting the Event Stream for an ECI would be helpful is the following: a 
particular network component is flapping and is generating onsets and clears for a 
single alarm very quickly. In this scenario, EMC Smarts NOTIF could receive an onset 
and then a clear within a few milliseconds. When the ECI does not have an Event 
Stream set, EMC Smarts NOTIF could schedule the onset into one processing queue, 
and the clear into another. Because it is multithreaded, EMC Smarts NOTIF could then 
possibly process the clear first, which would be incorrect. By providing an Event 
Stream on the ECI, the user is mandating EMC Smarts NOTIF to process the onsets and 
clears in order, and the problem is solved. Many ECIs can have the same Event 
Stream, and that guarantees that all of the incoming events for any of those ECIs are 
processed in the order in which they were received.
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User Defined values The User Defined tab of the ECI Setup dialog box shown in Figure 10 on page 38 defines 
additional configurable fields that are passed to the notification. Substitution values may 
be used in these user-defined fields. Both ASL and Java hook scripts can be initiated from 
EMC Smarts NOTIF processing, which can overwrite these and other notification values.


Figure 10  User Defined tab of the ECI Setup dialog box


Calculated values The Calc’d Values tab of the ECI Setup dialog box shown in Figure 11 on page 38 defines 
calculated value instructions. The calculated values feature allows the user configuring 
EMC Smarts NOTIF to write simple scripts that use information from the event (or 
notification) being processed to calculate values for use in the EMC Smarts NOTIF 
processor. For example, a user could write a calculated value script that decides to discard 
an event when the value of SNMP trap varbind 3 (V3) is 0. Note that in the calculated 
values list in Figure 11 on page 38, literal values are enclosed with quotation marks (for 
example: “0”) and variables are not (for example: V3).


Figure 11  Calc’d Values tab of the ECI Setup dialog box
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Calculated values comprises of a condition (value) (conditional) (value) and assignment 
(attribute) (value). Substitution values are allowed in any value field as shown in Table 3 
on page 100 or select Help > Substitutions in the EMC Smarts NOTIF Editor.


Allowed conditionals include:


==, !=, <, <=, >, >=, contains, (left string contains right string), does not contain, (left string 
does not contain right string), starts with, ends with


== means equal, and != means not equal.


Legal assignment attributes include:


◆ ASLEnabled
◆ Category
◆ ClassName
◆ ClearOnAcknowledge
◆ DiscardTrap
◆ ElementClassName
◆ ElementName
◆ EventName
◆ EventText
◆ EventType
◆ Expiration
◆ InMaintenance
◆ InstanceName
◆ JavaEnabled
◆ Severity
◆ State
◆ UpdateUserDefinedFields
◆ UserDefined1 - 20
Examples of calculated values are the following:


◆ if V1 equals “1”, set Severity to “1”.
◆ if contains (SYS, “Demo”), set EventText to “Ignore events against”+SYS.


Adding calculated values
To add a calculated value to an ECI:


1. Select the ECI in the topology tree of the EMC Smarts NOTIF Editor.


2. Select the Calc’d Values tab.
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3. Click Add. The default Edit Calculated Value dialog box appears as shown in Figure 12 
on page 40.


Figure 12  Edit Calculated Value dialog box


4. Type the appropriate values in this dialog box to create the calculated value for the 
ECI. For example:


In the user-editable fields in the Edit Calculated Value dialog box, you must include dollar 
signs for varbind variables; otherwise the variable will be read as literal text. For example, 
if V11 (instead of $V11$) was typed in the Condition: field in the above example, 
EMC Smarts NOTIF would read the V11 entry as a literal text string (not as the value of 
V11).
Also, the text typed for values in conditions and assignments should be in upper case. For 
example, State -> CLEAR, not State -> clear.


5. Click OK. The calculated value appears in the calculated value list as shown in 
Figure 13 on page 41. 


In the calculated values list, literal values in the displayed calculated value are 
enclosed with quotation marks (for example: “5”) and variables are not (for example: 
V11).
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Figure 13  Example of adding a Calculated Value to an ECI


Editing calculated values
To edit a calculated value for an ECI:


1. Select the ECI in the topology tree of the EMC Smarts NOTIF Editor.


2. Select the Calc’d Values tab.


3. Select the calculated value you want to edit in the calculated value list.


4. Click Edit, or double-click the selected calculated value. The Edit Calculated Value 
dialog box appears as shown in Figure 14 on page 41.


Figure 14  Example of editing a Calculated Value for an ECI


5. Type the appropriate values in the Edit Calculated Value dialog box to edit the 
calculated value for the ECI. 


6. Click OK. The edited calculated value appears in the calculated value list.
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When editing calculated values, consider the following:


◆ Calculated value instructions are evaluated from first to last in order. Later instructions 
can reset values set in prior instructions. Therefore, the order in which the calculated 
value instructions appear in this list is important.


◆ Some assignments affect processing. If ASLEnabled is set to false, then the ASL 
script will not run, even if it is present. Similarly, if JavaEnabled is set to false, then 
the Java script will not run even if present.


◆ In the user-editable fields in the Edit Calculated Value dialog box, you must include 
dollar signs for varbind variables. Otherwise, the variable will be read as literal text. 
For example, if V11 (instead of $V11$) was typed in the Condition field, EMC Smarts 
NOTIF would read the V11 as a literal text string (not as the value of V11).


◆ Text typed for values in conditions and assignments in the Edit Calculated Value 
dialog box should be in upper case. For example, State -> CLEAR is an acceptable entry 
in the Edit Calculated Value dialog box. If the user types State -> clear in the calculated 
value assignment, EMC Smarts NOTIF will log an error.


◆ In the calculated values list in the right pane of the EMC Smarts NOTIF Editor, literal 
text is enclosed with quotation marks, and variables are not. For example:


if V3 equals “4”, set Severity to “2”


◆ When assigning to a boolean field, EMC Smarts NOTIF converts string values that are 
used for boolean expressions in the following manner:


1. Converts the string to lower case.


2. Removes any leading or trailing whitespace.


3. Uses true if the string is one of: true, yes or on, or if the string evaluates to an 
integer that is not zero. 
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Copying ECI configuration parameters
You can copy ECI objects to reduce configuration time. To copy an ECI object, right-click the 
ECI object in the topology tree in the left pane and select Copy as shown in Figure 15 on 
page 43. The original ECI object that you copy is referred to as the source. The new ECI 
object is referred to as the target. The source object’s properties are copied into the target 
object. Everything is copied except the DisplayName attribute.


Figure 15  ECI copy feature
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CHAPTER 3
Notification Configuration Information Processing


This chapter describes Notification Configuration Information (NCI) processing. This 
chapter consists of the following topics:


◆ NCI processing overview .........................................................................................  46
◆ NCI notification matching ........................................................................................  47
◆ Designing NCI naming conventions .........................................................................  50
◆ Setting up NCI configuration parameters .................................................................  51
◆ Copying NCI configuration parameters.....................................................................  62
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NCI processing overview
Notification Configuration Information objects (NCIs) are the configuration objects that 
instruct EMC Smarts NOTIF to handle incoming unpublished notifications. After 
EMC Smarts NOTIF completes the ECI processing phase, unpublished notifications are 
sent to the NCI portion of EMC Smarts NOTIF to process interactions between notifications. 
Figure 16 on page 46 shows the NCI processing steps. 


Figure 16  NCI processing steps


As shown in Figure 16 on page 46, when EMC Smarts NOTIF receives an incoming 
unpublished notification, it looks for a matching NCI object. If a matching NCI object is 
found for the incoming notification, EMC Smarts NOTIF checks several configuration 
parameters that are set in the NCI. If no matching NCI object is found for the incoming 
unpublished notification, the notification is published without further consideration.


When a matching NCI object is found for an incoming unpublished notification, the NCI 
processing portion of EMC Smarts NOTIF checks for the following configuration 
parameters:


1. Active property of the NCI object (that is, whether the Active checkbox is selected in 
the NCI setup EMC Smarts NOTIF Editor as shown in Figure 18 on page 52. If the NCI 
object is Active, EMC Smarts NOTIF continues to process that notification, checking 
the NCI configuration parameters listed below. If the NCI object is not Active, 
EMC Smarts NOTIF does not publish the notification. 


2. “Clearing behavior” on page 51 — EMC Smarts NOTIF checks to see if the incoming 
notification clears other notifications, or inversely, whether this notification is cleared 
by other notifications.
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3. “Publish delay” on page 54 — EMC Smarts NOTIF checks to see if there is a specified 
delay associated with the notification before further NCI processing continues.


4. “Causality” on page 54 — EMC Smarts NOTIF checks to see if this notification causes 
another notification, or inversely, if this notification is caused by another notification.


5. “Aggregation” on page 60 — EMC Smarts NOTIF checks to see if this notification 
aggregates from other notifications, or inversely, if this notification aggregates to 
another notification.


6. “NCI hook script” on page 61 — EMC Smarts NOTIF checks to see whether there is an 
ASL hook script that the NCI should call just before the notification is published (after 
all other NCI processing has been completed).


7. “Calculated Values” on page 62 — EMC Smarts NOTIF checks to see if there are any 
calculated values associated with the notification.


These NCI configuration values are used to process the notification. The NCI process of 
EMC Smarts NOTIF is an independent thread that receives information from other servers 
for the creation, deletion, and change of notifications through the ICS_NOTIFICATION hook 
script. It is not directly associated with ECI processing as shown in Figure 3 on page 18.


There are two reasons NCI objects exist within EMC Smarts NOTIF. They are either used to 
match incoming notifications, or they are used to create new notifications. In general, new 
notifications are those created because of aggregation.


NCI notification matching
When unpublished notifications are delivered to EMC Smarts NOTIF, it finds the best 
match between a notification and an NCI object in its repository to handle that 
notification. The notification must be active in order for it to be processed, that is, the 
Active checkbox in the NCI setup EMC Smarts NOTIF Editor must be selected as shown in 
Figure 18 on page 52. 


Processing of the notification begins by looking for an exact match of class and event. A 
best match is determined by first looking for an NCI object that matches the 
ClassName.EventName of the incoming notification. If that does not match an NCI, 
EMC Smarts NOTIF will do the following:


1. EMC Smarts NOTIF will first look for an NCI that matches ClassName.EventName* 
(any ending). EMC Smarts NOTIF looks for an NCI that contains an asterisk (*) at the 
end to see if the EventName in the notification can match to the beginning of the 
EventName in the NCI (for example, the NCI named Router.Down-* would match with 
the notification named Router.Down-2).


2. If there is no NCI EventName with a wildcard to match the EventName in the incoming 
notification, EMC Smarts NOTIF then begins to climb the class hierarchy to determine 
if a superior class will match. At each step up the hierarchy, EMC Smarts NOTIF first 
checks for an exact event name match then a wildcard match. In this manner, a single 
NCI object can handle sub-classed objects as well as event names with different 
suffixes.
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Note that EMC Smarts NOTIF expects either an exact event name match or a single 
wildcard match; ambiguities in wildcard matches will have indeterminate results as to 
which NCI configuration will be used for processing. A series of NCIs such as 
Router.Test-1-1-*, Router.Test-1-*, and Router.Test-* will have no determinate 
order; the first NCI found will be used with no further processing. Supporting the best 
match at the NCI EventName level has an exponential impact on processing speed and is 
not practical.
For the same reason, regex expressions are not supported within the NCI EventName 
string, only a trailing asterisk (*) is supported.
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Figure 17 on page 49 illustrates the NCI notification matching process.


Figure 17  NCI notification matching process
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Matching examples NCI objects can be created for specific class instances or subclasses based on the overall 
design and wildcarded EventNames. Examples of how EMC Smarts NOTIF matches 
notifications to NCI objects are provided below:


Defined NCIs


1. XYZ-Router.Event-1


2. Router.Event-1


3. Router.Event-*


4. UnitaryComputerSystem.Event-1


In the examples above, any subclass of router with an event name of Event-1 will be 
processed by the NCI named Router.Event-1 (that is, NCI 2), except for XYZ-Router 
which is a more specific router class definition. As a theoretical example, the NCI named 
XYZ-Router.Event-1* could represent the handling of any EventName other than that 
specified by Router.Event-1.


Designing NCI naming conventions
NCI objects are matched to incoming notifications based on the class and event name in 
the notification. The information in the notification is dependent on the underlying ECI 
process that created the NCI requirements. Therefore, the NCI requirements are 
determined in the configuration of the ECI object.


“ECI notification naming” on page 30 provides more information.


Incoming notification (ClassName.EventName) NCI processing


XYZ-Router and Event-1 uses NCI 1 — Exact match for ClassName and 
EventName


ABC-Router and Event-1 uses NCI 2 — ABC-Router is a router


ABC-Router and Event-2 uses NCI 3 — ABC-Router and Event-2 match the 
wildcard EventName


Host and Event-1 uses NCI 4f
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Setting up NCI configuration parameters
When setting up the configuration parameters for an NCI, there are six configuration 
parameters to consider:


◆ “Clearing behavior” on page 51
◆ “Publish delay” on page 54
◆ “Causality” on page 54
◆ “Aggregation” on page 60
◆ “NCI hook script” on page 61
◆ “Calculated Values” on page 62


Clearing behavior ClearsForAllNotifications


An NCI can specify that it ClearsForAllNotifications as shown in Figure 18 on page 52. 
Selecting the ClearsForAllNotifications checkbox means that the given notification created 
for an event will clear all active notifications involving the same instance and element as 
the given event. When such a notification is created through an NCI, EMC Smarts NOTIF 
considers all the notifications related to the same instance (except the notification 
triggering this behavior), and clears them. The original specification in the Event Setup tab 
in the ECI determines if the triggering notification will be a NOTIFY or a CLEAR as shown in 
Figure 8 on page 35.


Consider the following example of the ClearsForAllNotifications functionality. There are 
three notifications (the Down, Faulty, and ActingUp notifications) for the 
Element::Instance named Interface::FaultyInterface. There is something wrong with 
FaultyInterface and the Interface is generating several different error alarms.


Assume that you have an NCI called Interface.InterfaceIsGoodAgain with 
ClearsForAllNotifications = TRUE. FaultyInterface may send a trap that results in a 
notification like Interface_FaultyInterface_InterfaceisGoodAgain  being created 
when the interface finally fixes itself. This notification will trigger the NCI named 
Interface.InterfaceIsGoodAgain. The NCI ClearsForAllNotifications property will 
cause EMC Smarts NOTIF to clear all of the notifications against FaultyInterface. The 
InterfaceIsGoodAgain notification may or may not clear depending on its State 
(NOTIFY or CLEAR). Most users would have an ECI trigger InterfaceIsGoodAgain with a 
CLEAR state. The end result is that the device no longer shows active notifications on the 
console once the all clear trap is seen by EMC Smarts NOTIF.


Notifications on Interfaces other than FaultyInterface (since this is the Instance the 
InterfaceIsGoodAgain notification points to) would still remain active.

Setting up NCI configuration parameters 51







Notification Configuration Information Processing

If EMC Smarts NOTIF is running on a SAM server, you must use the 
ClearsForAllNotifications option with caution. If this option is enabled, then all 
notifications against that particular instance (that is, router) are cleared and this may 
override the Caused/CausedBy relationship in the SAM codebook correlation.


Figure 18  General tab of the NCI Setup dialog box


ClearsForOthers


You can specify more finely-tuned clearing of notifications in an NCI with the 
ClearsForOthers tab in the NCI Setup dialog box (see Figure 19 on page 53). The 
ClearsForOtherNotifications field in this tab allows you to specify one or more other NCIs 
that the given NCI clears for. After the specified notification is created, EMC Smarts NOTIF 
finds the existing notifications related to the same instance and with eventNames as 
specified in the ClearsForOtherNotifications setting. When the instance and event names 
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both match, the specified companion NCI(s) are cleared. For example, a .Disk.Purged 
notification may be configured to ClearsFor the .Disk.UsageExceeded and 
.Disk.UsageWarning notifications.


Figure 19  ClearsForOthers tab in the NCI Setup dialog box


ClearedByOthers


Inversely, a given NCI may be ClearedBy other notifications. In the ClearedByOthers tab, in 
the ClearedByOtherNotifications field, you can add all the notifications that clear this NCI. 
For example, as shown in Figure 20 on page 53, the NCI named Router.Alarm-3-1-3 is 
cleared by the Router.Alarm-4-1-4 notification.


Figure 20  ClearedByOthers tab in the NCI Setup dialog box
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Publish delay After an NCI is found for an incoming notification, clearing behaviors are performed as 
discussed in the previous section. After any clearing is done, the notification may have a 
delay prior to checking Causes, Aggregates, and getting published. This delay is set in the 
NCI (in the Publish Delay field in Figure 18 on page 52) and is specified in seconds. For 
example, if you set a publish delay for 60 seconds, that means that the notification will be 
held for a minute before any further NCI processing is performed. If a clearing comes in 
during that minute, then the notification will be discarded.


Causality You can configure an NCI to indicate that one notification causes another notification, or 
inversely, that one notification is caused by another notification. After EMC Smarts NOTIF 
checks an incoming notification for clearing behavior, and any publishing delay has 
expired, EMC Smarts NOTIF checks to see if the new incoming notification causes any 
other notifications or is caused by any existing notifications. If EMC Smarts NOTIF finds 
that the given notification causes or is caused by other notifications, EMC Smarts NOTIF 
relates the appropriate notifications. 


You set up causes/causedby relationships in the Causality tab in the NCI Setup dialog box. 
For example, to set up a relationship where NCI-Router.Alarm-145-3-116 causes 
NCI-Router.Alarm-7-2-5, you would do the following:


1. Click the Router.Alarm-145-3-116 NCI object in the topology tree of the 
EMC Smarts NOTIF Editor.


2. Select the Causality tab.


3. Click Add. 


4. The Add Causes Relationship dialog box appears, as shown in Figure 21 on page 54. 
Select NCI-Router.Alarm-7-2-5 in the Caused NCI: drop-down list and click Add.


Figure 21  Add Causes Relationship dialog box
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5. The Causality tab for NCI-Router.Alarm-145-3-116 now shows that it causes 
NCI-Router.Alarm-7-2-5, as shown in Figure 22 on page 55.


Figure 22  Causality tab shows NCI-Router.Alarm-145-3-116 cause NCI-Router.Alarm-7-2-5


When you click the Router.Alarm-7-2-5 NCI object in the topology tree of the 
EMC Smarts NOTIF Editor, the Causality tab shows that this NCI is caused by 
NCI-Router.Alarm-145-3-116, as shown in Figure 23 on page 55.


Figure 23  Causality tab shows NCI-Router.Alarm-7-2-5 cause NCI-Router.Alarm-145-3-116 
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In EMC Smarts systems, notifications usually occur on a particular instance within an 
element. For example, a Loss of Signal notification might occur on a Port instance within a 
Router element. EMC Smarts NOTIF can use a notification's instance and element to find 
other instances and elements, and then create causal relationships between the 
notifications on each of them.


EMC Smarts NOTIF traces causality through the EMC Smarts objects that correspond to the 
notifications. EMC Smarts NOTIF determines causality by tracing the topology objects in 
five ways:


◆ “Occurring on the same instance” on page 56
◆ “Occurring on an instance related to the notified instance” on page 56
◆ “Occurring on the same element” on page 57
◆ “Occurring on an instance related to the notified element” on page 58
◆ “Occurring on an element related to the notified element” on page 58


For example, in Figure 23 on page 55, the causality specification shows that the NCI 
named Router.Alarm-7-2-5 is caused by the notification Router.Alarm-145-3-116. 
The relationship between these two notifications is “Occurring on the same instance.”


The causality specification shows all the other notifications caused by a given 
configuration, and the relationship between the given notification’s instance or element 
to other instances or elements. The relationship tracing allows notifications of a different 
class and instance to be related, that is, an interface down may be caused by a router 
down.


Occurring on the same instance
The “Occurring on the same instance” causality relationship in the EMC Smarts NOTIF 
Editor allows a notification on an instance to be set to cause another notification on the 
same instance. For example, consider the creation of a notification 
PowerSupply::network:86.2.2.2:PowerSupply-1::Down (note this has class, 
instance, and eventName elements). Assume the corresponding NCI indicates this 
notification causes PowerSupply-1.NotRespondingToAgent notifications. The 
PowerSupply-1.Down notification is set to cause the 
PowerSupply-1.NotRespondingToAgent notification on the same instance, 
PowerSupply-1.


Occurring on an instance related to the notified instance
This causality relationship means that using a given notification's instance and the 
designated relationship you can find all other candidate instances. If there are active 
notifications for any of these instances, those notifications will be related to the first 
notification.


For example, assume the PowerSupply::network:86.2.2.2:PowerSupply-1::Down 
notification has a corresponding NCI that indicates this notification causes .Card.Down 
notifications for any Cards this PowerSupply is Underlying. The creation of the notification 
and the NCI would have EMC Smarts NOTIF look for notifications whose instances are 
Cards and eventName is Down, and which the PowerSupply is Underlying the Card. If any 
are found, they are related—the PowerSupply.Down notification is set to cause the other 
notifications. 
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The above scenario describes one notification causing another. The inverse scenario is 
also possible where for example, a .Card.Down notification is caused by 
PowerSupply.Down and the causality is the same instance through the LayeredOver 
relationship (that is, the Card is LayeredOver the PowerSupply).


Another same instance example is shown in Figure 24 on page 57 where an 
Interface.Down notification on a particular interface causes an 
Interface.Unresponsive notification for another interface, and the relationship is 
ConnectedTo. In this example, the Interface.Down notification for the Router-A-Port-1 
interface instance causes the Interface.Unresponsive notification for the 
Router-B-Port-5 interface instance. 


When the Interface::Router-A-Port-1::Down notification and the corresponding 
NCI are created, EMC Smarts NOTIF finds the instance (Interface::Router-A-Port-1) 
and follows the ConnectedTo relationship. This finds the Interface::Router-B-Port-5 
instance with the Interface.Unresponsive notification, and the two notifications are 
related. The Interface::Router-A-Port-1::Down notification causes the 
Interface::Router-B-Port-5::Unresponsive notification.


Figure 24  NCI causality relationship occurs on an instance related to a notified instance


Occurring on the same element
The “Occurring on the same element” causality relationship in the EMC Smarts NOTIF 
Editor allows a notification on an element to be set to cause another notification on the 
same element. For example, PowerSupply.Down may cause Router.Down. 


Let us slightly change the preceding example where the NCI is for 
PowerSupply::network:86.2.2.2:PowerSupply-1::Down, but it is specified as 
“occurring on the same element” in the EMC Smarts NOTIF Editor. Assume the 
.PowerSupply.Down causes .Router.Down. If a .PowerSupply.Down notification is 
created, EMC Smarts NOTIF will find its elements (probably Routers) and if any of those 
routers had .Router.Down notifications, then those notifications would be related to the 
.PowerSupply.Down notification. 


Interface::Router-A-Port-1


                       Notification 2
Interface::Router-B-Port-3::Unresponsive


Interface::Router-B-Port-3


                       Notification 1
      Interface::Router-A-Port-1::Down


ConnectedTo


ConnectTo


InstanceInstance


Causes
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   “OccurredOn”
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                         Local Host Server 
          (Objects must exist on this server)
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Occurring on an instance related to the notified element
The causes that flow from an element to an instance through a relationship are 
determined as follows: 


1. Find the element for a given notification


2. Use the specified relationship to find related instances


3. See if there are corresponding notifications


As an example, the PowerSupply::network:86.2.2.2:PowerSupply-1::Down NCI is 
specified as “occurring on an instance related to the notified element” in the EMC Smarts 
NOTIF Editor and the relationship is ComposedOf. Assume the .PowerSupply.Down 
Causes .Card.Down. If a .PowerSupply.Down notification is created, EMC Smarts NOTIF 
will find its element (probably a Router) then follow the ComposedOf relationship. This 
would find all the Router's Cards and if any of those cards had Card.Down notifications, 
then those notifications would be related to the .PowerSupply.Down notification. 


The advantage of this specification is that several objects within the element may be able 
to transfer causality without being directly related.


Looking at this causality in the inverse direction, the Card.Down NCI would show that 
relationship is followed in the instance to element direction and the relationship would be 
PartOf. When a Card.Down notification is created, it would follow its PartOf relationship to 
find an element, then look for all the notifications associated with that element, looking 
for a .PowerSupply.Down.


The “occurring on an instance related to the notified element” specification can be very 
processor-intensive for environments with large numbers of active notifications. 
Therefore, it is recommended that use of this specification be kept to a minimum.


Occurring on an element related to the notified element
Causes that flow from one element to a related element through a relationship are 
determined as follows: for a given notification, find its element. Then use the relationship 
to find another element. The notifications associated with the second element are 
examined for matches to the specified target notifications.


An example of an “occurring on an element related to the notified element” causality 
relationship is shown in Figure 25 on page 59 where an SNMPTrap.Down notification on a 
particular host causes an SNMPTrap.Unresponsive notification on a particular software 
service, and the relationship is HostsServices. 


In this example, the SNMPTrap::DummyHost::Down notification causes the 
SNMPTrap::DummySoftware::Unresponsive notification. When the SNMPTrap.Down 
notification is created, EMC Smarts NOTIF finds its element (the Host named 
test-host-1) and follows the HostsServices relationship. This finds the SoftwareService 
element named test-software-1, and any SNMP traps associated with this 
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SoftwareService element that have SNMPTrap.Unresponsive notifications. In this way, 
the SNMPTrap::DummySoftware::Unresponsive notification is related to (caused by) 
the SNMPTrap::DummyHost::Down notification. 


Figure 25  NCI causality relationship occurs on an element related to a notified element
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                       Notification 2
SNMPTrap::DummySoftware::Unresponsive


SoftwareService::test-software-1


                       Notification 1
      SNMPTrap::DummyHost::Down


HostsServices


 HostedBy


    Element
“OccurredOn”


Causes


Instance does not need to exist


                         Local Host Server 
          (Objects must exist on this server)


    Element
“OccurredOn”


Instance does not need to exist

Setting up NCI configuration parameters 59







Notification Configuration Information Processing

Aggregation Notification aggregation occurs when one or more notifications on the same instance 
trigger the creation of an Aggregate notification, which represents the summary of a 
complex problem. An Aggregate notification sets a notification based on other events 
being active. 


For example, assume an NCI is created where .NetworkConnection.Erratic is 
specified and it AggregatesFrom:


.NetworkConnection.HighBitErrorRate,


.NetworkConnection.LostPacketsExceeded


.NetworkConnection.ExcessiveFramingErrors


Aggregation is useful when any number of notifications indicate a common problem. The 
severity of the aggregate notification is that of the highest severity of the underlying 
notifications. When all underlying notifications have cleared or expired, the aggregate 
itself will clear. This roll-up effect is applicable only from a EMC Smarts NOTIF Editor 
perspective, the individual notifications will still have the isRoot attribute set to true. 
Aggregation is limited to notifications against the same class and element.


Notifications may be accessed either through the AggregatesFrom tab or the AggregatesTo 
tab as shown in Figure 26 on page 60 and Figure 27 on page 61. However, the Event Text 
field is only available in the AggregatesFrom tab. In this field you can type the text of the 
notification and you can provide substitution values for user-defined values.


Figure 26  AggregatesFrom tab of the NCI Setup dialog box
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In Figure 27 on page 61, note that unpublished notifications may aggregate to more than 
one aggregate notification.


Figure 27  AggregatesTo tab of the NCI Setup dialog box


Mixing aggregation and causes


A useful feature of EMC Smarts NOTIF is the ability to relate notifications both on the 
aggregation level and the causes relationship level. The aggregate notification function 
allows you to create an independent notification and then roll other notifications under its 
display; the CausedBy relationship allows notifications from other servers to then be 
rolled under the aggregate notification. The result is that only the aggregate notification is 
displayed as the root cause for notifications coming from multiple servers.


NCI hook script An NCI can be configured to call an ASL hook script just before notification publication; all 
other EMC Smarts NOTIF NCI processing is performed prior to this call. You can type the 
hook script in the ASL Hook Script field in the General tab of the NCI Setup dialog box (see 
Figure 18 on page 52). EMC Smarts NOTIF looks up ASL hook scripts in the local/rules or 
/rules directories. For example, if you type icoi-trapd/sample_hook.asl in the ASL Hook 
Script field in the General tab of the NCI Setup dialog box, EMC Smarts NOTIF will look up 
local/rules/icoi-trapd/sample_hook.asl and rules/icoi-trapd/sample_hook.asl.


“Writing ASL for use with EMC Smarts NOTIF NCI processing” on page 106 provides 
information on how to write an NCI ASL hook script.


EMC Smarts NOTIF passes the necessary information to reference the notification to the 
hook script. In return, the hook script passes a flag back to EMC Smarts NOTIF that 
indicates if the notification should be published. It is the responsibility of the hook script 
to determine if the notification should be deleted, modified, or related to other 
notifications.
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The hook script is called both on setting and clearing of a notification generated by 
external sources, but not for an aggregate notification created by this EMC Smarts NOTIF 
server. In that case, the hook script is only called for the onset of the aggregate since the 
clearing of the aggregate is done by the internal EMC Smarts processing.


Calculated Values The EMC Smarts NOTIF Editor allows you to define calculated value instructions for an NCI 
through the Calc’d Values tab. You can add and edit calculated values to an NCI in the 
same manner as you can for an ECI. 


The only difference in defining calculated values for an NCI as compared to an ECI is that 
the legal assignment attributes are different. Legal assignment attributes for NCI 
calculated values include:


◆ Discard
◆ ElementClassName
◆ EventDisplayName
◆ EventState
◆ EventText
◆ Severity
◆ UserDefined1 - 20


“Calculated values” on page 38 provides information on adding and editing calculated 
values.


Copying NCI configuration parameters
You can copy NCI objects to reduce configuration time. To copy an NCI object, right-click on 
the NCI object and select Copy as shown in Figure 28 on page 63. The original NCI object 
that you copy is referred to as the source. The new NCI object is referred to as the target. 
The source object’s properties are copied into the target object. Everything is copied 
except:


◆ The NotifConfigInfoRelationSpecifier instances that the NCI relates to
◆ The CausedBy attribute
◆ The Specifies attribute 
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The newly-copied NCI object therefore has the same AggregatesTo/
AggregatesFrom, ClearedByOthers/ClearsForOthers relationships and general attributes, 
but none of the Causes/CausedBy relationships or associated 
NotifConfigInfoRelationSpecifiers. This is intended by design. You must configure the 
Causes/CausedBy relationship information manually after the copy operation.


Figure 28  NCI copy feature
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CHAPTER 4
Using EMC Smarts NOTIF


This chapter describes how to use EMC Smarts NOTIF in SAM or Adapter Platform servers 
by using the EMC Smarts NOTIF Editor. 


The EMC Smarts NOTIF application is included in the EMC Smarts Service Assurance 
Manager server installation and the EMC Smarts NOTIF is included in the EMC Smarts 
Service Assurance Global Console installation. The EMC Smarts Installation Guide for 
SAM, IP, ESM, MPLS, VoIP, and NPM Managers provides information on how to install the 
EMC Smarts Service Assurance Manager.


This chapter consists of the following topics:


◆ Starting EMC Smarts NOTIF......................................................................................  66
◆ Using the EMC Smarts NOTIF Editor .........................................................................  70
◆ Generating EMC Smarts NOTIF documentation ........................................................  95
◆ Disabling EMC Smarts NOTIF ...................................................................................  96
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Starting EMC Smarts NOTIF
When you install the EMC Smarts Service Assurance Manager version 9.2, EMC Smarts 
NOTIF is not enabled by default; you must start EMC Smarts NOTIF by performing the 
following steps:


1. Set an environment variable in the BASEDIR directory path to ensure that Java can be 
successfully started for EMC Smarts NOTIF. 
In BASEDIR/smarts/local/conf/runenv_cmd.sh, add the following line:


SM_JAVA_ENABLED=YES


2. If your setup contains SNMPv3 devices, create a seedfile with the device information 
using the seedfile template in the IP Manager installation area.


To use the seedfile template to create a seed file:


a. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and 
type the following command to open the seedfile template:


sm_edit conf/seedfile


b. Press Enter.


c. Add the seed entries for the systems to be discovered.


d. Save and close the file.


3. Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of 
the default trap_mgr_parse.asl script in order for EMC Smarts NOTIF to process SNMP 
traps.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi
--port=9013 --model=sm_actions --output
--rules=icoi-trapd/Notif-trap_mgr_parse.asl --daemon


The --daemon option only works on UNIX systems, not Windows systems. Any 
customizations made to the original trap_mgr_parse.asl file in the 
BASEDIR/smarts/rules/icoi-trapd directory must be incorporated into the 
Notif-trap_mgr_parse.asl file in the BASEDIR/smarts/rules/icoi-trapd directory.


4. To process SNMPv3 traps, use the --seed option when starting the SNMP Trap Adapter 
to point to the seed file you have created, as mentioned in step 2 .


For example:


./sm_trapd -n TRAP-INCHARGE-OI --server=INCHARGE-OI
--config=icoi --port=162
--model=sm_actions
--seed=C:\InCharge\SAM\smarts\local\conf\icoi\seedfile
--rules=icoi-trapd\trap_mgr_parse.asl --traceSNMP --output
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5. Configure the Notif Trap Receiver as a service to automatically the SNMP Trap Adapter 
on system restart. 


For example:


sm_service install --force  --unmanaged  --startmode=runonce \
'--name=ic-notif-trap' \
'--description=Notif Trap Receiver' \
'/opt/InCharge/SAM/smarts/bin/sm_trapd' \
'--name=NOTIF-TRAP' \
'--server=INCHARGE-OI' \
'--output' \
'--config=icoi' \
'--port=1162' \
'--model=sm_actions' \
'--rules=icoi-trapd/Notif-trap_mgr_parse.asl'


6. Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the 
default SysLog_mgr.asl script in order for EMC Smarts NOTIF to process Cisco system 
log files.


For example:


./sm_adapter.exe --NTsErViCeNaMe=ic-syslog-adapter --name=SYSLOG-OI 
--server=INCHARGE-OI --tail=/var/log/syslog --model=sm_system 
--model=sm_actions --output icoi-syslog/Notif-SysLog_mgr.asl


One or more adapters can feed a single EMC Smarts NOTIF server.


7. Configure the Notif Syslog Adapter as a service to automatically the Syslog Adapter on 
system restart. 


For example:


sm_service install --force  --unmanaged  --startmode=runonce \
'--name=ic-notif-syslog' \
'--description=Notif Syslog Adapter' \
'/opt/InCharge9/SAM/smarts/bin/sm_adapter' \
'--name=NOTIF-SYSLOG' \
'--server=INCHARGE-OI' \
'--output' \
'--config=icoi' \
'--port=1162' \
'--model=sm_actions' \
'--model=sm_system'\
'--rules=icoi-syslog/Notif-SysLog_mgr.asl'\
'--tail=/opt/InCharge9/SAM/smarts/local/logs/sample.txt'


8. Launch the EMC Smarts NOTIF Editor by selecting Start > Programs > InCharge > 
EMC Smarts NOTIF Editor. 


You can also launch the editor by double-clicking the NotifGui.bat file (for Windows 
systems) or the NotifGui.sh file (for UNIX systems) in the BASEDIR/smarts/notif/editor 
directory.


9. Use the EMC Smarts NOTIF Editor to connect to the running Adapter Platform or SAM 
server. Select Remote > Edit a server's settings… in the EMC Smarts NOTIF Editor.
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10. The Connect to a Server dialog box appears that shows the list of available Adapter 
Platform or SAM server connections, as shown in Figure 29 on page 68. Choose a 
server in the Connect to a Server dialog box and click OK.


“Manage connections...” on page 88 describes how to populate the list of server 
connections. Clicking More... in the Connect to a Server dialog box launches the 
Manage Connections dialog box where you can add additional server connections, if 
desired.


Figure 29  Connect to a Server dialog box


11. Type the password to connect to the EMC Smarts server and click OK.


The first time you connect to a given server when you use the EMC Smarts NOTIF Editor 
during a given work session, you will be prompted for a password. After that, you are 
not prompted for a password on that server for the remainder of your work session. If 
you restart the EMC Smarts NOTIF Editor, you must type the password again the first 
time you use a connection.


Figure 30  Server connection Password dialog box


12. The Remote Server Settings dialog box appears that shows the server's current 
settings as shown in Figure 31 on page 69. In the Remote Server Settings dialog box, 
select the Activate EMC Smarts NOTIF checkbox, and then click OK. You can also 
change other server settings in the Remote Server Settings dialog box, if desired.


“Edit a server’s settings...” on page 87 provides more information on remote server 
settings.
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Figure 31  Remote Server Settings dialog box


13. Restart the Adapter Platform/SAM server. EMC Smarts NOTIF is now activated on the 
Adapter Platform/SAM server.


Server setting changes made in the Remote Server Settings dialog box are persistent. 
When you change server settings in the Remote Server Settings dialog box and click OK, 
the changes are saved to the Notif_Settings.import file that is generated and saved to the 
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server 
where EMC Smarts NOTIF is running. 


Server setting changes made in the EMC Smarts NOTIF Editor are preserved even if the 
repository is deleted. For example, if the repository was erased because you used the 
--norestore option for server startup, the server would still use the last saved settings from 
the EMC Smarts NOTIF Editor saved in BASEDIR/smarts/local/conf/<icoi or 
ics>/Notif_Settings.import. 
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Using the EMC Smarts NOTIF Editor
The EMC Smarts NOTIF Editor allows you to save and restore configurations into the 
internal ECI and NCI configuration objects used by the underlying event management 
processes. Through the EMC Smarts NOTIF Editor , you can view the ECI and NCI objects 
and the configuration settings associated with them through a simple tree-view structure. 
As shown in Figure 32 on page 70, the left pane of the EMC Smarts NOTIF Editor is used to 
navigate through EMC Smarts NOTIF objects, and the right pane displays configuration 
information about the selected object. 


The title bar for the EMC Smarts NOTIF Editor shows the source of the current 
configuration. In this case, it is an EMC Smarts NOTIF configuration file named running.ncf 
in the user’s BASEDIR/smarts/local/conf/icoi directory.


Figure 32  EMC Smarts NOTIF configuration objects in the EMC Smarts NOTIF Editor topology tree 


EMC Smarts NOTIF Editor tree view


The EMC Smarts NOTIF Editor allows you to browse the configuration objects associated 
within the server for each of the main classes. In the EMC Smarts NOTIF Editor topology 
tree view, there are four main classes:


◆ EnumValueMapping
◆ EventConfigInfo
◆ NotifConfigInfo
◆ NotifPackage
The expanded EMC Smarts NOTIF Editor view in Figure 33 on page 71 shows the 
EnumValueMapping configuration parameters for the EVM object named 
1.2.3.4.5.6.47.108.9. An ECI may be configured such that it requires an enumeration 
table lookup (an EVM object) based on the values in the incoming raw event. For example, 
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an ECI that is matched to a raw event with a keyword|value pair (OID|value for SNMP) of 
1.2.3.4.5.6.47.108.9|3 will result in a value of informational when EMC Smarts 
NOTIF checks the enumerated value mapping table as shown in Figure 33 on page 71. 


“Enumeration of keyword/value pairs” on page 31 provides more information on 
enumerated value mapping.


Figure 33  Enumerated value mapping for EVM-.1.3.6.1.4.1.9.9.385.1.3.1 


Figure 34 on page 72 shows the expanded view of the EventConfigInfo class. The figure 
shows the SNMP trap configuration parameters for a specific ECI named 
.1.2.3.4.5.6.47.108.10_6_10. 


“Setting up ECI configuration parameters” on page 32 provides more information on 
setting configuration parameters for ECI objects.
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Figure 34  SNMP trap configuration parameters for the ECI named 1.2.3.4.5.6.47.108.10_6_10


Figure 35 on page 72 shows the expanded view of the NotifConfigInfo class. Note that 
there is a Router.Alarm grouping of NotifConfigInfo objects: all the NCIs associated with 
router alarms are listed in this group. Figure 35 on page 72 shows the configuration 
parameters for a specific NCI named Router.Alarm-4-84-70. 


“Setting up NCI configuration parameters” on page 51 provides more information on 
setting configuration parameters for NCI objects.


Figure 35  Configuration parameters for the NCI named Router.Alarm-4-84-70


Figure 36 on page 73 shows the expanded view of the NotifPackage class. EMC Smarts 
NOTIF packages allow you to group EMC Smarts NOTIF objects into logical areas of 
separation. For example, a set of ECIs, NCIs, and EnumValueMapping objects that support 
SNMP traps might be assigned to the SNMP_Traps package as seen in Figure 36 on 
page 73.
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An object may only be assigned to a single package.


Figure 36  Settings for the NotifPackage named SNMP_Traps


Main menu options


The EMC Smarts NOTIF Editor allows you to manipulate EMC Smarts NOTIF configuration 
files (*.ncf), both on the local machine that is running the EMC Smarts NOTIF Editor as well 
as remote servers. The EMC Smarts NOTIF Editor accesses local configuration *.ncf files 
under the File menu option, while remote operations are located under the Remote menu 
option.


The EMC Smarts NOTIF Editor provides key functions through the main menu such as: 
managing connections to servers, editing server settings, creating, changing, merging, 
and saving configurations, retrieving configurations from remote servers, storing 
configurations on remote servers, and generating HTML documentation. The following 
sections describe all of the main menu functions.


File menu options
This section describes the options available under the File menu for local *.ncf file 
configurations. The File menu options are described in the order they appear in the 
EMC Smarts NOTIF Editor, as shown below.
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The File menu options associated with manipulating *.ncf files on your local server are:


◆ “New Configuration” on page 74
◆ “Open Configuration...” on page 74
◆ “Merge Configuration...” on page 75
◆ “Save Configuration” on page 76
◆ “Save Configuration As...” on page 76
◆ “Close Configuration” on page 76


The File menu options associated with importing a trap_mgr.conf file to your local server 
and generating an HTML version of all NCI objects are:


◆ “Import trap_mgr.conf” on page 76
◆ “Generate HTML” on page 78.


New Configuration 


This option creates a new configuration on the local server (that is, a new local *.ncf 
configuration file). The New Configuration option erases the memory of the EMC Smarts 
NOTIF Editor and opens a blank topology tree in the left pane with an untitled 
configuration file, as shown in Figure 37 on page 74.


Figure 37  New Configuration window in the EMC Smarts NOTIF Editor


Open Configuration... 


This option opens an existing configuration file on the local server. When this option is 
selected, EMC Smarts NOTIF looks for any *.ncf files in the 
BASEDIR/smarts/local/conf/<config> directory or the BASEDIR/smarts/conf/<config> 
directory on the local server. 


When you select File > Open Configuration, the Open Notif Config File dialog box appears, 
as shown in Figure 38 on page 74. Select the *.ncf file you would like to open and click 
Open. The selected configuration is loaded into the EMC Smarts NOTIF Editor.


Figure 38  Open Notif Config File dialog box
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Merge Configuration... 


This option adds another *.ncf file into the existing configuration in memory. Unlike the 
Create or Open Configuration options, the Merge Configuration option adds to or 
overwrites the existing configuration.


When you select this option, the Merge Notif Config File dialog box appears as shown in 
Figure 39 on page 75. Select the *.ncf file that you want to merge with your existing 
configuration and click Open.


Figure 39  Merge Notif Config file dialog box


If the two configurations (that is, the existing configuration and the configuration you want 
to merge) have the same object, a prompt appears to choose between Keep Existing, 
Always Keep Existing, Use Imported, or Always Use Imported (see Figure 40 on page 75). 
The “Always" options stop the prompting and EMC Smarts NOTIF uses that choice for the 
remainder of the merge operation. 


Figure 40  Merge Conflict dialog box
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Save Configuration 


This option saves the existing configuration to an *.ncf file on the local server. If the 
existing configuration is untitled, the EMC Smarts NOTIF Editor will prompt for a filename, 
and the Save dialog box will display, as shown in Figure 41 on page 76. Name your *.ncf 
file and click Save.


Figure 41  Save dialog box 


Save Configuration As...


This option saves your existing configuration to a new *.ncf file on the local server. You can 
name or rename (if the existing configuration already has a name) an existing 
configuration to a specified filename. When you select this option, the Save dialog box 
appears as shown in Figure 41 on page 76. Name your *.ncf file and click Save.


Close Configuration


The Close Configuration option clears the EMC Smarts NOTIF Editor memory. 


Import trap_mgr.conf 


The trap_mgr.conf files used to configure a TRAP-INCHARGE-OI server (SNMP Trap Adapter) 
may be loaded into EMC Smarts NOTIF to replicate the standard file-based functionally. All 
.conf file features and options are supported. Trap_mgr.conf files can be imported into a 
new configuration (File > New Configuration) or an existing open configuration (File > Open 
Configuration...) in the EMC Smarts NOTIF Editor.
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To import a trap_mgr.conf file into a new or open configuration:


1. In the EMC Smarts NOTIF Editor, select File > Import trap_mgr.conf.


2. The Loading trap_mgr.conf dialog box appears as shown in Figure 42 on page 77. 
Select the trap_mgr.conf file that you want to import and click Open.


Figure 42  Loading trap_mgr.conf dialog box


The configuration from the trap_mgr.conf file is loaded into the EMC Smarts NOTIF 
Editor.


If the trap definitions contain MAP statements, they will not be imported. You need to 
manually specify a value for the EnumeratedValue option in order to obtain the Map 
statements. Mapping statement functionally, (trap/varbind position dependant), is 
replaced with true enumerated value substitutions, (EVM's in NOTIF), that require 
OID's for generic substitution.  Aggregation definitions within trap_mgr.conf generally 
reference substitution names such as '$E$-$G$-$SomethingElse$,' which is 
undetermined within the scope of NOTIF aggregation. The user should review the 
trap_mgr.conf file to determine what EVM's and aggregations need to be created in 
NOTIF given the appropriate OID's and names.


3. In the EMC Smarts NOTIF Editor, click File > Save Configuration or File > Save 
Configuration As... to save the imported configuration. 


When you import configuration files, they only become persistent in the Adapter 
Platform or SAM server when you click Save Configuration or Save Configuration As... 
Otherwise, the imported configuration is only in memory (non-persistent).
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Generate HTML 


This option creates an HTML version of all NCI objects for review and documentation 
purposes. Index.html will provide the link to each EMC Smarts NOTIF instance (see 
“Generating EMC Smarts NOTIF documentation” on page 95).


Exit 


This option provides clean shutdown of the EMC Smarts NOTIF Editor. 


Edit menu options
This section describes the options available under the Edit menu for open configurations. 
The Edit menu options are described in the order they appear in the EMC Smarts NOTIF 
Editor, as follows:


The Edit menu options are:


◆ “Create EventConfigInfo” on page 78


◆ “Create NotifConfigInfo” on page 79


◆ “Create EnumValueMapping” on page 79


◆ “Create Package” on page 79


Create EventConfigInfo 


This creates a new ECI object through the EMC Smarts NOTIF Editor. When you select this 
option, the dialog box shown in Figure 43 on page 78 appears.


Figure 43  Create EventConfigInfo feature
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Create NotifConfigInfo


This creates a new NCI object through the EMC Smarts NOTIF Editor. When you select this 
option, the dialog box shown in Figure 44 on page 79 appears.


Figure 44  Create NotifConfigInfo feature


Create EnumValueMapping 


This creates a new EnumValueMapping object through the EMC Smarts NOTIF Editor. 
When you select this option, the dialog box shown in Figure 45 on page 79 appears.


Figure 45  Create EnumValueMapping feature


Create Package


Packages can be defined to group EMC Smarts NOTIF objects into sets for maintainability 
and transportability. These package sets can be created as a new NotifPackage object 
through the Create Package option. When you select this option, the dialog box as shown 
in Figure 46 on page 79 appears.


Figure 46  Create Package feature
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Remote menu options
This section describes the options available under the Remote menu for remote *.ncf file 
configurations. The Remote menu options are described in the order they appear in the 
EMC Smarts NOTIF Editor, as follows:


The Remote menu options associated with pushing (or storing) a local *.ncf configuration 
file or package to a remote server are:


◆ “Push to server...” on page 81
◆ “Push package to server...” on page 82
◆ “Reload server...” on page 83


The Remote menu options associated with retrieving a running configuration or a specific 
*.ncf file from a remote server to a local server are:


◆ “Retrieve running configuration from server...” on page 84
◆ “Retrieve a configuration file from server...” on page 85


The Remote > Edit a server’s settings menu option is used to edit server settings on a 
remote server. This menu option is used to activate EMC Smarts NOTIF on a remote server, 
as mentioned previously in the section “Starting EMC Smarts NOTIF” on page 66. Using 
this menu option creates persistent server settings. “Edit a server’s settings...” on 
page 87 provides details.


The Remote > Manage connections menu option is used to manage remote server 
connections. “Manage connections...” on page 88 provides details.
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Push to server...


The EMC Smarts NOTIF Editor allows you to manipulate the *.ncf files on a remote 
EMC Smarts NOTIF server by pushing (or storing) the EMC Smarts NOTIF Editor 
configuration to the remote server and optionally instructing EMC Smarts NOTIF within 
that server to reload the *.ncf files. Reloading of the *.ncf files reloads all *.ncf files in the 
corresponding BASEDIR/smarts/local/conf/<config> directories in the remote EMC Smarts 
NOTIF server. 


Ensure there are no conflicting configurations within multiple *.ncf files as the order in 
which these files are read is undetermined. Use only one *.ncf file on a remote server.


The Push to server option saves the existing open configuration to a file on a remote 
EMC Smarts NOTIF Adapter Platform or SAM server of your choice. When you select this 
option:


1. The Connect to a Server dialog box appears as shown in Figure 29 on page 68. Choose 
the remote server where you want to store your configuration and click OK. A prompt 
may appear to type a password to connect to the remote server as shown in Figure 30 
on page 68. 


The first time you connect to a given server when you use the EMC Smarts NOTIF Editor 
during a given work session, type a password when the prompt appears. After that, 
the prompt to type a password does appear on that server.


2. The Directory dialog box appears as shown in Figure 47 on page 81. Choose the 
directory location on the remote server where you want to store your configuration and 
click OK. 


Figure 47  Directory dialog box


3. The Select Remote File dialog box appears as shown in Figure 48 on page 81. This is 
the name of the *.ncf file that you are storing on the remote server. The *.ncf file is 
always stored to the BASEDIR/smarts/local/conf/<config> directory on the remote 
server. Select the *.ncf file you want to push to the remote server and click OK.


Figure 48  Select Remote File
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If an *.ncf file already exists in the /local/conf/<config> directory on the remote 
server, a prompt appears to overwrite the existing *.ncf file or cancel. 


4. The Push Complete dialog box appears as shown in Figure 49 on page 82. This dialog 
confirms that the *.ncf file has been pushed to the remote server and prompts you to 
reload the EMC Smarts NOTIF processor on that server so that the new configuration 
takes effect. 


Reloading of the *.ncf file on a remote EMC Smarts NOTIF server reloads all *.ncf files 
in the corresponding icoi/ics directories in that server. Care should be taken to ensure 
there are no conflicting configurations within multiple *.ncf files as the order in which 
these files are read is undetermined.


Figure 49  Push Complete dialog box


5. Click Yes to reload the EMC Smarts NOTIF processor to make the new configuration 
active on the remote server.


6. The Reload Complete dialog box appears as shown in Figure 50 on page 82. This 
dialog box confirms that the new configuration in the *.ncf file has been reloaded and 
is persistent in the remote server. Click OK.


Figure 50  Reload Complete dialog box


Push package to server...


This option allows you to store a selected *.ncf package to a remote server. When you 
select this option:


1. The Connect to a Server dialog box appears as shown in Figure 29 on page 68. Choose 
the remote server where you want to push the package and click OK.


2. The Directory dialog box appears as shown in Figure 47 on page 81. Choose the 
directory location on the remote server where you want to push the package and click 
OK. 
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3. The Select Remote File dialog box appears as shown in Figure 51 on page 83. Select 
the name of the *.ncf package file you want to push to the remote server and click OK. 


Figure 51  Select Remote File dialog box


4. The Push Complete dialog box appears as shown in Figure 52 on page 83. This dialog 
confirms that the *.ncf package file has been pushed to the remote server and 
prompts you to reload the EMC Smarts NOTIF processor on that server so that the new 
configuration package takes effect on that server. 


Reloading of the *.ncf file on a remote EMC Smarts NOTIF server reloads all *.ncf files 
in the corresponding icoi/ics directories in that server. Care should be taken to ensure 
there are no conflicting configurations within multiple *.ncf files as the order in which 
these files are read is undetermined.


Figure 52  Push complete for package dialog box


5. Click Yes to reload the EMC Smarts NOTIF processor to make the new configuration 
package active on the remote server.


6. The Reload Complete dialog box appears as shown in Figure 50 on page 82. This 
dialog box confirms that the new configuration in the *.ncf package file has been 
reloaded and is persistent in the remote server. Click OK.


Reload server...


This option allows you to request that a remote server running EMC Smarts NOTIF reload 
its *.ncf configuration files. The Reload server option is used to make configuration 
changes active on a remote server. For example, if an *.ncf configuration file is pushed to a 
remote server through the Push to server option, or a specific *.ncf package file is pushed 
to a remote server through the Push package to server option, the configuration changes 
on the remote server will not become active unless the Reload server menu option is 
selected.


Care should be taken to ensure there are no conflicting configurations within multiple 
*.ncf files on the remote server, as the order in which these files are read is undetermined. 
Use only one *.ncf file on a remote server.
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When you select the Reload server option in the EMC Smarts NOTIF Editor: 


1. The Connect to a Server dialog box appears as shown in Figure 29 on page 68. Choose 
the remote server where you want to reload the configuration file and click OK.


2. If there are other *.ncf files in the remote server besides the *.ncf file you are pushing 
from your local server to the remote server, note that all of the *.ncf files on the remote 
EMC Smarts NOTIF Adapter Platform or SAM server will be reloaded in the 
corresponding BASEDIR/smarts/local/conf/<config> directory.


3. After the remote server has reloaded the configuration file(s), the Reload Complete 
dialog box shown in Figure 50 on page 82 appears. This dialog box confirms that the 
new configuration in the *.ncf file has been reloaded and is persistent in the remote 
server. Click OK.


Retrieve running configuration from server...


This option retrieves a running configuration from a remote server (that is, the existing 
configuration running in the EMC Smarts NOTIF Editor on the remote server). When you 
select this option:


1. The Connect to a Server dialog box appears (see Figure 29 on page 68). Choose the 
remote server from which you want to retrieve the running configuration and click OK.


2. A progress bar at the bottom of the screen indicates that the running configuration 
from the remote server is being loaded into the EMC Smarts NOTIF Editor on the local 
server, as shown in Figure 53 on page 84. In this example, the running configuration 
being retrieved is a configuration file named running.ncf on a remote Adapter Platform 
server named OI81-Notif-ICB88-lin.


Figure 53  Loading a running configuration from a remote server


3. When the configuration data from the remote server is imported into the EMC Smarts 
NOTIF Editor on the local server:


• The EMC Smarts NOTIF configuration objects in the topology tree are populated 
(that is, there are now EnumValueMapping, EventConfigInfo, NotifConfigInfo, and 
NotifPackage objects in the tree), and 
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• The word “Ready” appears in the bottom-left corner of the EMC Smarts NOTIF 
Editor, as shown in Figure 54 on page 85.


Figure 54  Running configuration from remote server loaded into EMC Smarts NOTIF Editor


4. To save the configuration to your local server:


a. Select File > Save Configuration As... 
b. Name the .ncf file and select the directory on your local server where you want to 


store the configuration in the Save dialog box as shown in Figure 41 on page 76.


Retrieve a configuration file from server...


This option retrieves a specific named *.ncf file from the remote server’s configuration 
directories (that is, from the BASEDIR/smarts/conf/<config> or 
BASEDIR/smarts/local/conf/<config> directories). When you select this option:


1. The Connect to a Server dialog box appears as shown in Figure 29 on page 68. Choose 
the remote server from which you want to retrieve the specific *.ncf file and click OK.


2. The Directory dialog box appears as shown in Figure 47 on page 81. Choose a 
directory on the remote server from which you want to retrieve the *.ncf file and click 
OK. 


3. The File dialog box appears, as shown in Figure 55 on page 85. This dialog provides a 
drop-down list of the *.ncf files in the selected directory. 


If you are retrieving an *.ncf file from a remote server, and you have existing *.ncf file(s) on 
your local system, be careful to ensure that there are no conflicting configurations within 
multiple *.ncf files as the order in which these files are read is undetermined.


Select the *.ncf file you want to retrieve from the remote server and click OK.


Figure 55  File dialog box
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4. A progress bar at the bottom of the screen indicates that the selected remote *.ncf file 
is being loaded into the EMC Smarts NOTIF Editor on the local server, as shown in 
Figure 56 on page 86. In this example, the *.ncf file being retrieved is a configuration 
file named test-iter5.ncf on a remote Adapter Platform server named 
OI81-Notif-ICB88-lin.


Figure 56  Loading an .ncf file from a remote server


5. When the *.ncf file from the remote server is imported into the EMC Smarts NOTIF 
Editor on the local server:


• The EMC Smarts NOTIF configuration objects in the topology tree are populated 
(that is, there are now EnumValueMapping, EventConfigInfo, NotifConfigInfo, and 
NotifPackage objects in the tree), and 


• The word “Ready” appears in the bottom-left corner of the EMC Smarts NOTIF 
Editor as shown in Figure 57 on page 86.


Figure 57  .ncf file from a remote server is now loaded into the EMC Smarts NOTIF Editor


6. To save the configuration to your local server:


a. Select File > Save Configuration As... 
b. Name the .ncf file and select the directory on your local server where you want to 


store the configuration in the Save dialog box (see Figure 41 on page 76).
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Edit a server’s settings...


This option is used to change server settings on remote Adapter Platform/SAM servers. 
One of the settings you can change on a remote server is whether EMC Smarts NOTIF is 
active on that server. The process for activating EMC Smarts NOTIF on a remote server 
using the Edit a server’s settings... option is described in “Starting EMC Smarts NOTIF” on 
page 66.


To change settings on a remote Adapter Platform/SAM server:


1. Select Remote > Edit a server's settings. 


2. The Connect to a Server dialog box appears, as shown in Figure 29 on page 68. 
Choose the remote server where you want to change server settings and click OK.


3. The Remote Server Settings dialog box appears that shows the server's current 
settings as shown in Figure 58 on page 87. The options you can change in this dialog 
are defined in Table 2 on page 88.


Figure 58  Remote Server Settings dialog box


4. Make any setting changes to the remote server in the Remote Server Settings dialog 
box, and click OK.


5. Restart the Adapter Platform/SAM server.


Server setting changes made in the Remote Server Settings dialog box are persistent. 
When you change server settings in the Remote Server Settings dialog box and click OK, 
the changes are saved to the Notif_Settings.import file that is generated and saved to the 
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server 
where EMC Smarts NOTIF is running. 
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Manage connections... 


Connections are defined within the EMC Smarts NOTIF Editor to access remote servers. 
Multiple connections may be defined and given a reference name for convenience. To add 
a remote server connection in the EMC Smarts NOTIF Editor, perform the following steps: 


Table 2  Remote Adapter Platform/SAM server settings 


Parameter Type
Default 
value Use


Activate EMC Smarts 
NOTIF


Boolea
n


Off  Determines whether EMC Smarts NOTIF is active on the server.


Event Processors Integer 4 The number of threads desired to process incoming raw events. 
This setting also implicitly determines how many connections will 
exist in the EMC Smarts NOTIF connection pool. It is 
recommended that customers work with an EMC representative 
to determine the best ProcessCount number for their particular 
deployment.


Max Event Queue Size Integer -1 The maximum number of unprocessed events that can wait in the 
event queue. If the limit is exceeded, new events are dropped. 
The value “-1” means no limit.


Max Notification Queue 
Size


Integer -1 The maximum number of unprocessed notifications that can wait 
in the notification queue. If the limit is exceeded, new 
notifications are dropped. The value “-1” means no limit.


MaxEnumWildcard Integer 4 If an ECI's varbinds are checking for wildcard enumerations, 
EMC Smarts NOTIF drops up to this many nodes in looking for a 
match.


Number of Log Files Integer 6 The maximum number of log files EMC Smarts NOTIF maintains 
before deleting old ones.


LogSize Integer 2000000 When a EMC Smarts NOTIF log reaches this size (in kilobytes), 
the file is closed and a new one is started. The size of this setting 
must be between 0 and 2,097,152 KB inclusive. 


LogLevel Integer Events, Info, 
Warnings, 
Exceptions


The log level options are:
• Exceptions Only
• Events, Info, Warnings, Exceptions
• Everything, including debug info
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1. Select Remote > Manage Connections in the EMC Smarts NOTIF Editor. The Manage 
Connections dialog box appears as shown in Figure 59 on page 89.


Figure 59  Blank Manage Connections dialog box


2. Click Add.


3. The Input dialog box appears as shown in Figure 60 on page 89. Type a connection 
reference name (for example, Remote EMC Smarts NOTIF OI server) in the Input dialog 
box and click OK.


Figure 60  Input dialog box for remote server connection reference name


4. Fill in the new connection record in the right pane of the Manage Connections dialog 
box. An example is shown in Figure 61 on page 89.


Figure 61  Manage Connections dialog box with remote server connection reference name
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a. If you are connecting to a broker:


– Type the broker name in the Broker: field. 


– Click Browse Now and select a domain in the Domain: drop-down list as shown 
in Figure 62 on page 90.


– Type the username in the User: field.


If you are connecting to a broker that requires authentication, select the Requires 
Authentication checkbox and type the username in the User: field below the 
checkbox.


b. If you are connecting directly to a server (that is, the Broker: field is empty):


– Type the hostname in the Host: field.


– Select a domain in the Domain: drop-down list.


– Type the username in the User: field.


Figure 62  Selecting a domain in the Manage Connections dialog box


5. Click Test to try the remote server connection. If you are connected to the server, the 
Connected dialog box appears as shown in Figure 63 on page 90.


Figure 63  Connection confirmation dialog box
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6. Save the connection setup by clicking OK. An example of a completed connection 
setup is shown in Figure 64 on page 91.


Figure 64  Completed connection setup data in the Manage Connections dialog box


Connections are stored in the user's preferences data on the local system, so the 
connection data is persistent.


Help menu options
This section describes the options available under the Help menu. The Help menu options 
are described in the order they appear in the EMC Smarts NOTIF Editor, as shown below.
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The general Help menu options are:


◆ “About” on page 92


◆ “Substitutions” on page 92


The Help menu options associated with migrating configuration files or configurations 
from previous NOTIF versions to EMC Smarts NOTIF are under the Migration submenu:


◆ “Import from file...” on page 92


◆ “Import from an older NOTIF server...” on page 93


About 


Provides information regarding the current version of the EMC Smarts NOTIF Editor.


Substitutions 


Provides information about the substitution variables supported between raw event 
values and the notifications created through the EMC Smarts NOTIF Editor.


The Help menu options associated with importing configuration files to your local server 
are:


Import from file... 


The Import from file... option loads an .import file that contains NOTIF configuration 
objects from a previous NOTIF version into the EMC Smarts NOTIF Editor memory. This 
allows you to edit the configuration (if desired) in the EMC Smarts NOTIF Editor and save 
the configuration into an .ncf file. The Import from file... option migrates your previous 
NOTIF configuration .import file into EMC Smarts NOTIF and converts it into an .ncf file 
format.


To migrate an import configuration file from a previous NOTIF version into the EMC Smarts 
NOTIF Editor memory:


1. In the EMC Smarts NOTIF Editor, select Help > Migration > Import from file… 


2. The Loading Instances from an Import File dialog box appears as shown in Figure 65 
on page 92. Select the .import file with the NOTIF configuration objects (from the 
previous NOTIF version) that you want to migrate into the EMC Smarts NOTIF Editor and 
click Open.


Figure 65  Loading Instances from an Import File dialog box


The configuration from the .import file is loaded into the EMC Smarts NOTIF Editor.


3. In the EMC Smarts NOTIF Editor, click File > Save Configuration or File > Save 
Configuration As... to save the imported configuration. 
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When you import configuration files, they only become persistent in the Adapter 
Platform or SAM server when you click Save Configuration or Save Configuration As... 
Otherwise, the imported configuration is only in memory (non-persistent).


The Import from File option works as follows:


◆ If no configuration is open (that is, you just started the EMC Smarts NOTIF Editor, or 
you closed a configuration), the import will create a new configuration.


◆ If a configuration is open, the EMC Smarts NOTIF Editor will ask you if it should Cancel 
Import, Create New, or Add to Current (see Figure 66 on page 93).


Figure 66  Overwrite Configuration dialog box


◆ When creating a new configuration, if the current configuration is unsaved, the 
EMC Smarts NOTIF Editor warns of this and asks whether to proceed, as shown in 
Figure 67 on page 93.


Figure 67  Overwrite changed configuration dialog box


◆ When reading an object (during Create New or Add to Current configuration options), if 
the object does not exist, it will be created with default values.


◆ EMC Smarts NOTIF accepts incomplete objects in the import file. Missing attributes 
will be default values (if the object didn't exist) or existing values.


If an object selected in the EMC Smarts NOTIF Editor is changed by an import operation, 
the EMC Smarts NOTIF Editor may not refresh the view. You have to click elsewhere and 
then back to the changed object to see the update.


Import from an older NOTIF server... 


This option allows you to import a configuration from a running SAM 7.x/NOTIF 2.x server 
into the EMC Smarts NOTIF Editor and save it as an .ncf file on a SAM 9.2/EMC Smarts 
NOTIF server.
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This option functions in a similar fashion as the Import from file option previously 
described. For example, if no configuration is open, the import will create a new 
configuration; if a configuration is open, the EMC Smarts NOTIF Editor will ask you if it 
should Cancel Import, Create New, or Add to Current, and so on.


To import a configuration from an older NOTIF server:


1. In the EMC Smarts NOTIF Editor, select Help > Migration > Import from an older NOTIF 
server… 


2. The Connect to a Server dialog box appears, as shown in Figure 29 on page 68. 
Choose the running SAM 7.x/NOTIF 2.x server where you want to import the 
configuration from and click OK.


The configuration from the running SAM 7.x/NOTIF 2.x server is loaded into into the 
EMC Smarts NOTIF Editor.


3. Select Remote > Push to Server... 


4. The Connect to a Server dialog box appears. Choose the SAM 9.2 server where you 
want to push the older configuration to and click OK.


5. The Directory dialog box appears, as shown in Figure 47 on page 81. Choose the 
directory location on the SAM 9.2 server where you want to store your configuration 
and click OK.


6. The Select Remote File dialog box appears as shown in Figure 48 on page 81. This is 
the name of the *.ncf file you are storing on the SAM 9.2 server. The *.ncf file is always 
stored to the BASEDIR/smarts/local/conf/<config> directory on the SAM 9.2 server. 
Name the *.ncf file that you want to push to the SAM 9.2 server and click OK.


7. The Push Complete dialog box appears, as shown in Figure 49 on page 82. This dialog 
confirms that the *.ncf file has been pushed to the SAM 9.2 server and prompts you to 
reload the EMC Smarts NOTIF processor on that server so that the new configuration 
takes effect. 


Reloading of the *.ncf file on a remote EMC Smarts NOTIF server reloads all *.ncf files 
in the corresponding icoi/ics directories in that server. Care should be taken to ensure 
there are no conflicting configurations within multiple *.ncf files as the order in which 
these files are read is undetermined.


8. Click Yes to reload the EMC Smarts NOTIF processor to make the new configuration 
active on the SAM 9.2 server.


9. The Reload Complete dialog box appears as shown in Figure 50 on page 82. This 
dialog box confirms that the new configuration in the *.ncf file has been reloaded and 
is persistent in the SAM 9.2 server. Click OK.


In SAM 8.1 and above, the configurations are saved to the .ncf file and can be imported to 
SAM 9.2 using Open Configuration and Push to server operation . “Open Configuration...” 
on page 74 and “Push to server...” on page 81 provide more details.
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Generating EMC Smarts NOTIF documentation
A useful function provided by EMC Smarts NOTIF through the File, Generate HTML menu 
option is that it automatically creates an HTML-based document that includes information 
on all the EMC Smarts NOTIF internal configuration objects (EVM, ECI, NCI, and 
NotifPackage objects). This makes it easy to view all the EMC Smarts NOTIF event and 
notification information in one place. As shown in Figure 68 on page 95, index.html 
provides a link to each EMC Smarts NOTIF instance—in the example below the description 
is shown for the NotifConfigInfo object named Router.Alarm-3-1-3. 


Figure 68  EMC Smarts NOTIF HTML documentation


Ensure you regenerate the HTML file when you modify configurations.
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Disabling EMC Smarts NOTIF
The EMC Smarts NOTIF application cannot be uninstalled separately from SAM 9.2 
because the EMC Smarts NOTIF processor is included as part of the SAM 9.2 server 
application. However, you can disable EMC Smarts NOTIF on an Adapter Platform/SAM 
server by performing the following steps:


1. Launch the EMC Smarts NOTIF Editor by selecting Start > Programs > InCharge > 
EMC Smarts NOTIF Editor. 


You can also launch the editor by double-clicking the NotifGui.bat file (for Windows 
systems) or the NotifGui.sh file (for UNIX systems) in the BASEDIR/smarts/notif/editor 
directory.


2. Use the EMC Smarts NOTIF Editor to connect to the running Adapter Platform or SAM 
server where you want to disable EMC Smarts NOTIF . Select Remote > Edit a server's 
settings… and choose a server in the Connect to a Server dialog box.


3. The Remote Server Settings dialog box appears showing the server's current settings. 
In the Remote Server Settings dialog box, clear the Activate EMC Smarts NOTIF 
checkbox, and then click OK. 


4. Configure the SNMP Trap Adapter to use the default trap_mgr_parse.asl script instead 
of the Notif-trap_mgr_parse.asl script.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi
--port=9013 --model=sm_actions --output
--rules=icoi-trapd/trap_mgr_parse.asl --daemon


The --daemon option only works on UNIX systems, not Windows systems. Any 
customizations made to the Notif-trap_mgr_parse.asl file in the 
BASEDIR/smarts/rules/icoi-trapd directory must be incorporated into the 
trap_mgr_parse.asl file in the BASEDIR/smarts/rules/icoi-trapd directory.


5. Configure the Syslog Adapter to use the default SysLog_mgr.asl script instead of the 
Notif-SysLog_mgr.asl script.


For example:


./sm_adapter.exe --NTsErViCeNaMe=ic-syslog-adapter --name=SYSLOG-OI 
--server=INCHARGE-OI --tail=/var/log/syslog --model=sm_system 
--model=sm_actions --output icoi-syslog/SysLog_mgr.asl


One or more adapters can feed a single EMC Smarts NOTIF server.


6. Restart the Adapter Platform/SAM server.

96 EMC Smarts Notification Module User Guide







APPENDIX A
Substitution Scripting and Values


This appendix describes the scripting system used within the EMC Smarts NOTIF 
substitution feature and provides a list of substitution values that can be used in setting 
up configuration values for ECI objects.


This appendix consists of the following topics:


◆ Script parsing overview for substitution features .....................................................  98
◆ Built-in operators ....................................................................................................  99
◆ Built-in functions ....................................................................................................  99
◆ Substitution values for ECI configuration parameters.............................................  100
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Script parsing overview for substitution features
For substitution, the input is a string with embedded script. The embedded script is 
signalled by surrounding it with $:


◆ There is no script here. 


◆ There is $ script $ here. — Evaluates script and replaces it within the string.


◆ $ "There is " + script + " here." $ — This is equivalent. It's using + for concatenation of 
string literals. 


◆ This is a string without a $$ script — This is an example of embedding $ in a string 
without starting a script block.


Scripts have identifiers, quoted strings, and numbers:


◆ Identifiers must start with a letter or underscore and continue until the first non-letter, 
non-digit, non-underscore character:


• Examples of identifiers are foo, _bar, and abc123. 


• Examples of illegal identifiers are 2b (it starts with a digit), foo-bar (it has an 
embedded hyphen).


◆ Quoted strings start and end with the double quote character (“). To embed a double 
quote, use a backslash (\) before it. To embed a backward slash, use backward slash 
twice (\\):


• "This is a typical string." 


• "This is a string with \" an embedded double quote." 


• "This is a string with \\ a backslash." 


• "This is " not a legal string."


Whitespace in the script is ignored unless it is within a quoted string. 


Scripts may have function calls. A function call is an identifier followed by a set of zero or 
more comma-separated arguments. The arguments may be any valid expression. For 
example: 


◆ foo () 


◆ foo ( "string 1", bar ( identifier1, identifier2 ) )


For example, toUpper (E) would report the event's enterprise value string in upper case. 


Table 3 on page 100 lists the substitution values that can be used in ECI configuration 
parameters.
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Built-in operators
EMC Smarts NOTIF includes the following operators for use in scripting:


◆ str1 + str2 — Returns the concatenation of str1 and str2. 


"abc" + "def" ---> "abcdef" 


◆ number1 + number2 — Returns the sum of the two numbers. 


123 + 456 ---> "579" 


The script evaluation of EMC Smarts NOTIF is string-based. EMC Smarts NOTIF 
examines the two operands and, if both are legal numbers, it sums them. Otherwise, 
the two strings are concatenated. To ensure a concatenation regardless of string 
content, use the concat() function described.


◆ number1 * number2 — Returns the product of the two numbers. 


3 * 4 ---> "12"


Built-in functions
EMC Smarts NOTIF includes the following built-in functions for use in scripting:


◆ toLower (string) — Returns the string in lower case.


◆ toUpper (string) — Returns the string in upper case.


◆ sizeOf (string) — Returns the length of a string.


◆ substr (string, startPosition, length) — Returns a substring of the string, starting at 
'startPosition', for 'length' characters. The first character in the string is start position 
1 (this is different from many programming languages that use 0 for the first position). 
If the length requested exceeds the length available, all of the remaining characters 
are returned. If the start position is less than 1, an evaluation error occurs. If the start 
position is beyond the length of the string, an empty string is returned. 


◆ concat (string1, string2, ... ) — Returns the concatenation of two or more strings.  
concat ( "a", "b", "c" ) ---> "abc" 


◆ time (), time (formatString) — Returns the current time, optionally formatted according 
to a format string. The format string is the typical Java language date format string (for 
more information, see 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html. If no 
format string is provided, the system uses EEE, d MMM yyyy HH:mm:ss Z, which 
results in a timestamp such as: "Thu, 23 Aug 2007 16:01:21 -0400." 
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◆ extract (string, separator, field) — Splits the string using the 'separator' and returns 
the 'field'. The separator value is a regular expression (for information on how to 
format 'separator', see 
http://java.sun.com/j2se/1.4.2/docs/api/java/lang/String.html#split(java.lang.Stri
ng). If there are not enough resulting fields, an empty string is returned:


• extract ( "1,2,3,4,5,6", "," ,4 ) ---> 4 


• extract ( "abcdef", "c", 2 ) ---> "def" 


• extract ( "abcdef", "c", 3 ) ---> ""


Substitution values for ECI configuration parameters
Table 3 on page 100 lists the substitution values that can be used in ECI configuration 
parameters, such as User Defined values, Event Setup options, and Calculated values.


Table 3  Substitution values for ECI configuration parameters (page 1 of 2)


Substitution Value Description


$A$ The source text in the event.


$E$ The enterprise text in the event.


$N$ The ‘generic’ field in the event.


$S$ The ‘specific’ field in the event.


$T$ The timestamp in the event.


$SYS$ Given the source IP of the event, the node hosting the IP will be substituted.


$EVENTTEXT$ The current value of EventText.


$V1$ ----> $V20$ Replaced with the text value in the respective varbind.


$OID1$  ----> $OID20$ Replaced with the OID value in the respective varbind.


$UserDefined1$ ----> 
$UserDefined20$


Notification property that can be populated with any string.


$#$ Replaced with the number of varbinds in the event.


$*$ Replaced with text consisting of all varbind OIDs and values in the event.


$V*$ Replaced with text consisting of all varbind values in the event.


$Vx(n)c$ Varbind subfield extractor. If a varbind is itself a string with subfields that can be 
parsed with a character token, you can extract a particular subfield by using 
Vx(n)c, where:


• x is the varbind number (x value represents a varbind 1–10).


• n is the subfield desired (n value is a number specifying which of the 
subfields should be used in the substitution. Subfield numbering starts with 
0). 


• c is the tokenizer character. The c value is a single character that can be used 
as a tokenizer to parse the varbind string. In many cases this is a comma.


Example: if $V1 is Tempe,AZ,85284 then $V1(2), would give AZ.
This can also be done with the extract function. The extract function takes three 
parameters: string, separator, and field.
Example: if $V1 is Tempe,AZ,85284 then extract( $V1, ",", 2) would give AZ.
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$concat(string1, string2, ...)$ Will return the concatenation of two or more strings.
Example: $concat(a, b, c) would return abc.


$contains(textToSearch, 
textToLookFor)$


Will return true if textToLookFor exists in textToSearch string.


$endsWith(textToSearch, 
textToLookFor)$


Will return true if textToLookFor is at the end of textToSearch.


$extract(string, separator, 
field)$


Will split the string using the separator and returns the field.
Examples: 
extract ( "1,2,3,4,5,6", "," ,4 ) ---> 4 
extract ( "abcdef", "c", 2 ) ---> "def" 


$getAttribute(className, 
instanceName, attributeName)$


Will return the value of the given attribute from the given class and instance.


$sizeOf(text)$ Will return the number of characters in text. Text can itself be a substitution, such 
as $V1$.
Example: $sizeOf(True) would produce 4.


$startsWith(textToSearch, 
textToLookFor)$


Will return true if textToLookFor is at the start of textToSearch.


$substr(text, pos, length)$ Will extract characters from text starting at position pos for the specified length. 
Text can itself be a substitution, such as $V1$.
Example: $substr(unknown,4,2) will produce no.


$time(format)$ Will produce a string based on the current time. The substitutions are as follows:
• HH — 24 hour of day
• MM — Minute of hour
• SS — Second of minute
• MTH — Month of year (numeric)
• DD — Day of month
• YY — Year
• DOW — Day of week (3 char alphabetic)
The format characters take elements from the current time to create the text.
Examples: $time(DOW HH:MM) could produce the text Wed 22:04.


 $time(HH:MM:SS) could produce 15:23:40.


$toLower(text)$ Will convert the characters in text to lower case. Text can itself be a substitution, 
such as $V1$.
Example: $toLower(TrUe) would produce true.


$toUpper(text)$ Will convert the characters in text to upper case. Text can itself be a substitution, 
such as $V1$.
Example: $toUpper(cat) would produce CAT.


$varbindCount$ Will return the number of varbinds.


$varbindKeyValue$ Will return a list of each varbind in "key: value" format, separated by commas.


$varbindValues$ Will return a list of varbind values, separated by commas.


Table 3  Substitution values for ECI configuration parameters (page 2 of 2)


Substitution Value Description
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APPENDIX B
ASL and Java Interfacing with EMC Smarts NOTIF


This appendix discusses how to write ASL hook scripts and Java classes for use with 
EMC Smarts NOTIF event processing.


This appendix consists of the following topics:


◆ Writing ASL for use with EMC Smarts NOTIF ECI processing ....................................  104
◆ Writing ASL for use with EMC Smarts NOTIF NCI processing....................................  106
◆ Writing a Java class for use with EMC Smarts NOTIF event processing ....................  107
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Writing ASL for use with EMC Smarts NOTIF ECI processing
ASL hook scripts called from EMC Smarts NOTIF ECI specifications must include the 
following two additional definitions in the Input/Output Variables section:


DISCARD_TRAP = "";
UPDATE_USERDEF_FIELDS = "";


Sample ECI ASL hook script


A sample ECI ASL hook script is provided below for reference:


/* 
 * Sample-ECI.asl - Hook adapter for any ECI related customizations.
 */


debug = FALSE;   


// Input/Output variables.


CLASSNAME = "";
INSTANCENAME = "";
EVENTNAME = "";
SEVERITY = "";
EVENTTEXT = "";
CATEGORY = "";
EXPIRATION = "";
STATE = "";
INMAINTENANCE = "";
CLEARONACKNOWLEDGE = "";
EVENTTYPE = "";
ELEMENTCLASSNAME = "";
EVENTDISPLAYNAME = "";
ELEMENTNAME = "";
USERDEFINED1 = "";
USERDEFINED2 = "";
USERDEFINED3 = "";
USERDEFINED4 = "";
USERDEFINED5 = "";
USERDEFINED6 = "";
USERDEFINED7 = "";
USERDEFINED8 = "";
USERDEFINED9 = "";
USERDEFINED10 = "";
USERDEFINED11 = "";
USERDEFINED12 = "";
USERDEFINED13 = "";
USERDEFINED14 = "";
USERDEFINED15 = "";
USERDEFINED16 = "";
USERDEFINED17 = "";
USERDEFINED18 = "";
USERDEFINED19 = "";
USERDEFINED20 = "";


// Input Variables


TIMESTAMP = "0";
IPADDRESS = "";
SYSNAMEORADDR = "";
ENTERPRISE = "";
GENERIC = "9999";
SPECIFIC = "9999";

104 EMC Smarts Notification Module User Guide







ASL and Java Interfacing with EMC Smarts NOTIF

// Varbind and OID values
V1 = "";
V2 = "";
V3 = "";
V4 = "";
V5 = "";
V6 = "";
V7 = "";
V8 = "";
V9 = "";
V10 = "";
V11 = "";
V12 = "";
V13 = "";
V14 = "";
V15 = "";
V16 = "";
V17 = "";
V18 = "";
V19 = "";
V20 = "";


OID1 = "";
OID2 = "";
OID3 = "";
OID4 = "";
OID5 = "";
OID6 = "";
OID7 = "";
OID8 = "";
OID9 = "";
OID10 = "";
OID11 = "";
OID12 = "";
OID13 = "";
OID14 = "";
OID15 = "";
OID16 = "";
OID17 = "";
OID18 = "";
OID19 = "";
OID20 = "";


// Flag to discard the trap, when set to TRUE.
DISCARD_TRAP = "FALSE";


NotificationName = "";
MessageType = "";
NotifIntegration = "TRUE";


// Flag to update the UserDefined[1-20] fields and EventText, upon 
CLEAR


// when set to TRUE.
UPDATE_USERDEF_FIELDS = "FALSE";


if (debug) { print("Running my ECI Hook.asl "); }


START {
    .. eol
} do {


    // Default output is the same as input.


    // Set attributes in ICS_Notification.  Add any more customizations 
here ...
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    USERDEFINED3 = "Added this in custom ruleset";


    if (debug) { print("Done with my ECI Hook.asl ");}
    return;
}


/*
 * These variables describe the formatting of this file.  If you don't


 * like the template defaults, feel free to change them here (not in 
 * your .emacs file).


 *
 * Local Variables:
 * mode: C++
 * End:
 */


Writing ASL for use with EMC Smarts NOTIF NCI processing
A sample NCI ASL hook script is provided below for reference:


/* sampleNciHook.asl
 */
default debug = TRUE;
default detailedDebug = TRUE;


default NotificationName = "";
default DISCARD_IN_NOTIF = "";
DISCARD_IN_NOTIF = "FALSE";


icsNotificationFactory = object();
ics_domain_name = getServerName();


user = "HOOK";
aslName = this->ReadsRulesFrom->fileName;
myThread = thread();
auditText = " ".aslName." Thread=".myThread." ";


START {
    local errorOrSkip = FALSE;
    .. eol


    errorOrSkip : VERIFY_INPUT
    (!errorOrSkip)


    errorOrSkip : PRINT_SOMETHING
    (!errorOrSkip)
    
}


//Grab the ICS_Notification object using the name passed in.
VERIFY_INPUT {
    local error = FALSE;


    do {
        nObj = self->object(NotificationName);
        if (NotificationName == "" || nObj->isNull()) {
            print(time().auditText." Internal Error: ".
                  " could not find the notification".
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                  " object('".NotificationName."')!");
            error = TRUE;
        }


        return error;
    }
}


/* Sample activity.
*/
PRINT_SOMETHING {
    local skip = FALSE;


    do {
print(time().auditText.nObj->InstanceName." FROM NOTIF NCI 


HOOK");
}


}


Writing a Java class for use with EMC Smarts NOTIF event 
processing


In EMC Smarts NOTIF, you can write Java classes which can be called during event 
processing to:


◆ Modify the various parameters that are set prior to the notification being created. 


or


◆ Instruct EMC Smarts NOTIF to discard the event it is processing.


To use a custom Java class in the EMC Smarts NOTIF processor:


1. Write and compile one or more Java classes that implement the notifEventProcessor 
interface with the following requirements:


a. Your class must have a default constructor (one that takes no arguments).


b. The EMC Smarts NOTIF .jar file must be available to your Java compiler when 
building your class. The .jar file is BASEDIR/smarts/classes/notif.jar.


2. Package your class or classes in a .jar file.


3. Install your .jar file into the BASEDIR/smarts/local/classes directory.


4. Update the Notif-init.asl script to include your .jar file in the CLASSPATH:


a. Locate the Notif-init.asl file in the BASEDIR/smarts/rules/ics directory.


b. Use the sm_edit utility to edit the script (or manually copy it to the 
BASEDIR/smarts/local/rules/ics directory and edit it there).


The EMC Smarts System Administration Guide provides information on how to use the 
sm_edit utility.


c. Locate the lines that use add_archive to add the .jar file to the CLASSPATH.
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d. Duplicate one of those lines and replace the name of the .jar file with your own .jar 
file. Do not specify a path for the .jar file. The EMC Smarts NOTIF/SAM Java class 
loader is designed to look in local/classes for your .jar file.


e. Save the file.


f. Restart the SAM/Adapter Platform server to pick up the changed CLASSPATH.


5. Add your class name to an ECI in the EMC Smarts NOTIF Editor (the Java field in the 
Event Options tab as shown in Figure 9 on page 36) and save and deploy the new .ncf 
file.


EMC Smarts NOTIF Java API


This section provides the sources for the two interfaces that comprise the EMC Smarts 
NOTIF Java API.


notifEventProcessor


package com.emc.smarts.notif.api;
public interface notifEventProcessor
{


void process ( notifEventDataAccessor eda );
}


notifEventDataAccessor


package com.emc.smarts.notif.api;
public interface notifEventDataAccessor
{


public String getClassName();
public void setClassName(String className);


public String getInstanceName();  
public void setInstanceName(String val);


public String getEventName();  
public void setEventName(String val);


public String getSeverity();
public void setSeverity(String val);


public String getEventText();  
public void setEventText(String val);


public String getCategory(); 
public void setCategory(String val);


public String getExpiration();
public void setExpiration(String val);


public String getEventState(); 
public void setEventState(String val);


public boolean getInMaintenance();  
public void setInMaintenance(boolean val);


public boolean getClearOnAcknowledge();
public void setClearOnAcknowledge(boolean val);  


public String getEventType();  
public void setEventType(String val);


public String getElementClassName(); 
public void setElementClassName(String val);
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public String getElementName();  
public void setElementName(String val);


public String getUserDefined ( int i ); // 1-20  
public void setUserDefined ( int i, String val );


public boolean getDiscardTrap();
public void setDiscardTrap(boolean val);


// trap data
public String getTimestamp();  
public String getSource();  
public String getSysNameOrAddr();  
public String getEnterprise();  
public String getGeneric();  
public String getSpecific(); 
public String getVarbindValue(int which);
public String getVarbindOID(int which);


}


An example plug-in processor


A plug-in processor example is provided below for reference:


package com.example.notif;


import com.emc.smarts.notif.api.notifEventDataAccessor;
import com.emc.smarts.notif.api.notifEventProcessor;


public class MyNotifPlugin implements notifEventProcessor
{


// process gets called for each event matched to the ECI
public void process ( notifEventDataAccessor eda )
{


// if VarBind1 (aka V1) has value 'DiscardMe',
// discard this event
final String vb1 = eda.getVarbindValue ( 1 );
if ( vb1.equals ( "DiscardMe" ) )
{


eda.setDiscardTrap ( true );
}


}
}


Additional notes


◆ Note that varbind values are referred to by their natural numbers. The index of the 
value of the first varbind is 1, not 0. The example code above retrieves the value of the 
first varbind with eda.getVarbindValue ( 1 );


◆ When specifying your class in an ECI, use the full class name. For example, 
"com.example.notif.MyNotifPlugin". The string you specify is passed without 
modification to the JVM's default classloader via Class.forName ().


◆ Plug-in processors are intended to be lightweight and you must be careful not to 
deploy processors that do significant work in the constructor or during the call to 
process. Deploying a slow processor, especially if it is called from a frequently used 
ECI, can degrade performance of the entire SAM/Adapter Platform system.
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◆ It is also important to remember that the processor class will be instantiated for each 
event it handles. Processors that need to retain information across calls to process() 
can use static member data to do so, but keeping references to the 
notifEventDataAccessor instance is strongly discouraged. Doing so can delay the 
JVM's garbage collection of internal EMC Smarts NOTIF data structures and cause the 
system to use more memory than usual.


◆ Any exceptions (including Throwable) that occur during the execution of your class are 
logged as warnings in the EMC Smarts NOTIF log.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
The EMC Smarts Service Assurance Manager Operator Guide describes how to use the 
Global Console to access event information and diagnostic results that the Service 
Assurance Global Manager abstracted and consolidated from underlying domains.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Global Manager. IT managers who seek to understand the role of the 
Global Manager in the context of an EMC Smarts solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide Guide.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than  C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter

12 EMC Smarts Service Assurance Manager Operator Guide







Preface

Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide
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◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com

16 EMC Smarts Service Assurance Manager Operator Guide



http://support.emc.com





CHAPTER 1
Introduction


This guide is intended for operators who are responsible for acting upon the failures 
reported by the EMC Smarts Service Assurance Manager (Service Assurance) product. This 
chapter provides the following information:


◆ Overview.................................................................................................................  18
◆ Notification concepts ..............................................................................................  19
◆ Global Console overview .........................................................................................  20
◆ Watch4net ..............................................................................................................  44
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Overview
In a typical Operations center, there are several operators who may perform monitoring 
duties and assist with or perform problem resolution. In order to perform their duties, 
operators need information about their managed domains and the events that occur. For 
example, they may need information about topological relationships, sources of 
notifications, and how the events affect other infrastructure devices.


Console access is controlled by the user profile that is associated with a user account. 
Therefore, users might have access to different types of consoles and console operations. 
For example, a user might be able to browse for details but not be able to acknowledge a 
notification or add a view to a console. Also, certain features are controlled by your 
EMC® Smarts® license. The EMC Smarts Service Assurance Manager Configuration Guide 
provides additional console operations information.


Using the Global Console, an operator with access to the appropriate console operations 
can:


◆ Investigate topological information, including detailed information about an 
element’s internal components. Topological information is presented in a topological 
tree format and map representations.


◆ Monitor notifications and identify the causes of each failure and systems that the 
failure affects.


◆ Respond to notifications. For example, operators can take ownership of notifications, 
open trouble tickets, or ping a device.


◆ Save information, print information, and record tracking comments in notification 
audit logs.


In addition, users can perform administrative tasks such as configuring Global Managers 
and managing underlying Domain Managers if they have administrative privileges and 
access to those console operations. 


If you have installed EMC Watch4net 6.2 along with Service Assurance Manager 9.2, you 
can access various console components from within Watch4net. For more information on 
installing and configuring Watch4net, refer to the EMC Smarts SolutionPack Installation 
and Configuration Guide.


“Global Console overview” on page 20 contains a discussion of the layout and features of 
the Global Console. “Notification concepts” on page 19 includes a general discussion of 
notifications.
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Notification concepts
Service Assurance notifications are generated when abnormal conditions occur in your 
underlying managed domains. The underlying domains, such as EMC Smarts IP 
Availability Manager and EMC Smarts IP Performance Manager, pass the notifications and 
any relevant event or topological information to the Service Assurance Global Manager. 
The Global Manager, in turn, consolidates, abstracts, and passes the notifications to 
clients such as the Global Console or adapters.


Notifications are objects in the Global Manager or Adapter Platform. Notifications 
represent the events received from Domain Managers, adapters, or other underlying 
sources or notifications received from Global Managers or Adapter Platforms. Each 
notification consists of a set of attributes that describe properties of the notification, such 
as the severity of the notification and a textual description of the event. (“Notification Log 
columns” on page 59 contains a list of visible attributes.)


A notification list configured by your administrator determines which notifications appear 
in your console and are reflected in a map. Your administrator can use special filters to 
organize notifications by some useful criteria and then associate the filtered list with your 
user profile. As a result, your console may display all or a subset of possible notifications. 
As an operator, you can further refine your display by setting additional filters provided as 
console options.


The severity of notifications is reflected in severity icons, color-coded rows and indicator 
bars underneath map icons. “About notifications” on page 56 and “Displaying notification 
properties” on page 62 contains a description of notifications, severity icons, their color 
coding, and how to display their properties. “Representing notifications in maps” on 
page 88 includes a description of map icons and their color coding.


If a notification list does not include an event, notifications for the event will not appear in 
your console or be reflected in the map icons. For example, if a notification list excludes all 
events from a specific router, the router always appears with a normal state in the map. (If 
your console does not accurately reflect observed conditions, contact your administrator.)


Service Assurance information is archived at time intervals specified by the administrator 
and can be viewed later using a text editor. The archives include notifications that are 
acknowledged and their related audit logs. Once notifications are archived, they no longer 
display in the Global Console. The EMC Smarts Service Assurance Manager Configuration 
Guide includes information about archival parameters and the archived files.


Service Assurance notifications


Most of the notifications that appear in the Global Console are generated by underlying 
Managers. However, the Global Manager will generate a Session Disconnected notification 
when an underlying Manager disconnects from it. Also, if Business Impact Manager is 
deployed, the Global Manager will generate business impact notifications. Chapter 10, 
“Troubleshooting,” includes information about disconnect situations. The EMC Smarts 
Business Impact Manager User Guide includes information about business impact 
notifications.
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Detailed descriptions of diagnostic results for specific EMC Smarts applications like EMC 
Smarts IP Availability Manager, EMC Smarts IP Performance Manager, and EMC Smarts IP 
Discovery Manager are described in their respective user guides.


Types of managers


Depending upon your Service Assurance deployment, a Global Manager can be: a Service 
Assurance Global Manager or SAM Adapter Platform. 


A Domain Manager can be: an IP Availability Manager, IP Performance Manager, Discovery 
Manager, or Application Connectivity Monitor Manager. 


The term Manager refers to either a Global Manager or Domain Manager. 


Global Console overview
The Global Console is a collection of consoles: 


◆ The Notification Log Console presents notifications in tabular format. 


From the Notification Log Console for a selected notification, you can also open the 
Notification Properties workspace in a browser. The workspace may contain one or 
more apps that provide detailed information about the notification. Online help in the 
Companion UI provides complete information about the available apps and features.


◆ The Map Console graphically represents your topology in a map format. In the map, 
icons change color when they are affected by one or more abnormal conditions. 


◆ The Topology Browser Console represents the topology in a hierarchical format and 
provides topological information. 


◆ The Summary View Console represents overviews or summaries of notifications 
organized by meaningful criteria. 


◆ The Status Table Console represents the status of underlying infrastructure elements 
as they affect the collection objects (ServiceOffering, ServiceSubscriber, or any group 
created by your administrator) specified in the Status Table. 


◆ The Web Console provides Global Console functionality in a standard web browser.


◆ The Domain Manager Administration Console enables administrators to discover 
topology and manage underlying Domain Managers. 


The EMC Smarts IP Manager Concepts Guide contains information about discovery. 
Information about polling and thresholds accessed by the Domain Manager 
Administration Console for specific EMC Smarts applications is provided in their 
respective user guides.


◆ The Global Manager Administration Console enables administrators to configure 
Global Managers. 


The EMC Smarts Service Assurance Manager Configuration Guide includes information 
about the Global Manager Administration Console.


◆ The Topology Builder Console enables administrators to modify and refine the 
topology stored in the EMC Smarts repository. 
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This console is available if Business Impact Manager is deployed. The EMC Smarts 
Business Impact Manager User Guide includes information about the Topology Builder 
Console.


The following consoles display information from or manage:


◆ Global Managers — A Notification Log Console, Map Console, Summary Console, 
Status Table Console, Global Manager Administration Console, Topology Builder 
Console for Business Impact Manager, and views.


◆ Domain Managers — A Domain Manager Administration Console.


A Topology Browser Console or view can display information from Global Managers and 
Domain Managers.


After you log in, one or more consoles appear, depending upon your user profile. For 
example, if your user profile is configured for the Notification Log Console and Map 
Console, then two consoles will appear after you log in. Since Domain Managers do not 
maintain user profiles, if you log in to a Domain Manager, the Topology Browser Console 
appears first. 


You can also customize a console for your operational needs, save it, and continue to use 
it. For example, you can add one or more views to a console. 


The layout of each console, including menu options and toolbar buttons, is briefly 
described in the subsequent sections. More complete information about individual menu 
options is provided in subsequent chapters. Menu options and toolbar buttons might be 
disabled or not appear if you do not have access to those console operations.


Tool tips are available for each console. A tool tip provides information about console 
components, notifications, map icons, and summaries. To activate a tool tip, hold the 
cursor over the object. For example, in the Topology View topology tree, if you hold the 
cursor over a Global Manager, the tool tip provides the IP address and port number. If the 
text in an attribute field of the Notification Log is truncated, the full text is displayed in the 
tool tip.


The status bar for each console displays status Ready for example, and the following 
information:


◆ For a locally saved console, the directory path and its filename.


◆ For a remotely saved console, the Manager or IP address where it is saved, username, 
and the console name. 


If you logged in using a default user profile, the console name Notification Log 
appears unless the name has been modified by an administrator.


◆ For an unsaved console, the text "Not saved" appears.


To quickly open menus in the consoles, press Alt + underlined character. For example, to 
open the File menu, press Alt + F.
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View concepts


EMC Smarts information is displayed in the following views: 


◆ Notification Log


◆ Map


◆ Topology Browser


◆ Summary View


◆ Status Table


◆ Notification Properties


◆ Containment


Depending on your EMC Smarts deployment, you will see these views in a Global Console 
window, Web Console window (available through a Web Browser), in a Business 
Dashboard configured by your administrator, or in a third-party Web Portal product.


You or your administrator can configure views to display certain information, for example, 
by applying filters. These views can be saved and associated with user accounts and user 
profiles. Views that are saved in HTML (as Java applets) for display in web browsers are 
called dashboard viewlets. Dashboard viewlets are available when the EMC Smarts 
Business Dashboard is installed. 


You can display more than one view in a Global Console window. For example, if you wish, 
you can include a Notification Log view along with a Map and a Status Table in a console. 
“Tailoring your console with views” on page 158 includes additional information about 
managing view display.


In a view, to perform actions such as saving or deleting, or to access menu options, you 
need to activate the view. To do so, click anywhere in the view. The active view has a black 
border.


Availability of Dashboard viewlets


Generally, views that are available for the Global Console are available for the Web 
Console (as views), Business Dashboard (as dashboard viewlets), and third-party Web 
Portal products (as dashboard viewlets). Table 1 on page 22 indicates which views can be 
implemented as dashboard viewlets.


Table 1  View availability


Views Available as Dashboard viewlets?


Notification Log view Yes


Map Yes 


Summary view Yes


Status Table view Yes


Notification Properties view Yes


Containment view Yes


Topology Browser view No
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Layout of a Notification Log Console


The Notification Log Console is designed specifically for viewing notifications. It consists 
of one view, the Notification Log view. Figure 1 on page 23 illustrates one example of a 
Notification Log Console for an administrator. Your Notification Log Console may look 
slightly different.


“Notification Log menus and shortcut menus” on page 24 summarizes menu options for 
the Notification Log Console. “Notification Log Console toolbar buttons” on page 27 
summarizes toolbar buttons.


The notification list configured by your administrator is included in the title of the 
Notification Log view. For example, the title "Notification Log - Default" identifies a 
notification list named Default.


The Manager menu lists attached Global Managers. You can view notifications for a 
different attached Global Manager by selecting it from the menu. Domain Managers are 
not listed in the menu.


The notification legend and icons in the Severity column provide the color indicators that 
reflect the notifications’ severity.


You can also customize the Notification Log view with a filter. The filter enables you to 
select attributes and specify wildcard characters to control which notifications appear in 
the view.


Figure 1 on page 23 provides an example of a Notification Log Console for an 
administrator.


Figure 1  Notification Log Console for an administrator
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Notification Log menus and shortcut menus
Table 2 on page 24 summarizes the menus that are available for the Notification Log 
Console or view. The two menu items, Event and Log, are specific to the Notification Log. 
The Configure menu is displayed depending on your user access control privileges. 


Table 2  Notification Log menus and their options (page 1 of 3)


Menu Option Description


File New Opens a new console.


Open Opens an existing console, locally saved or 
remotely saved.


Close Closes an individual console.


Save Saves an unsaved console on a local or remote 
host. Saves a saved console to a 
previously-specified destination.


Save As Saves a console on a local or remote host.


Layout Arranges multiple views in a console and changes 
console title.


Exit Ends the session and closes all consoles.


Edit Find Instance Searches for any topological element in any class 
including application services, service offerings, 
service subscribers, and systems.


Find System Searches for a system (infrastructure element).


Recipients Opens the Recipient Editor dialog box for email or 
pager tools.


View Java Console Displays console debugging information, including 
store exceptions, errors reading attributes, and 
stack traces.


Message Log Displays communications sent from a Manager to 
the console.


Toolbar Toggles the display of the toolbar buttons.


Status Toggles the display of the status bar.


Add View Inserts a view in the current console.


Copy View Copies a view in the current console or to another 
new console.


Save View As 
dashboard Viewlet


Saves a view as a dashboard viewlet for the Web 
pages or third-party Web Portal products; Business 
Dashboard must be installed.


Delete View Removes a view from the current console.


Listen to Context Configures a view for context sharing.


Refresh Redisplays the console.


Manager Attach Connects to a Manager.


Detach Disconnects from a Manager.
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Configure Groups Creates groups or child groups of infrastructure 
elements. The EMC Smarts Service Assurance 
Manager Configuration Guide includes information 
about creating groups.


Global Manager 
Administration 
Console


Opens a Global Manager Administration Console 
for configuring Global Managers.


Domain Manager 
Administration 
Console


Opens a Domain Manager Administration Console 
for managing underlying Domain Managers.


Topology Builder Opens a Topology Builder Console. The EMC 
Smarts Business Impact Manager User Guide 
includes information about the Topology Builder 
Console.


Event Companion UI Opens the Notification Properties workspace in a 
browser for a selected notification. The workspace 
may contain one or more apps that provide 
detailed information about the notification. 
The EMC Smarts SolutionPack Installation and 
Configuration Guide provides configuration 
information for the EMC Smarts Companion UI.


Properties Displays notification properties for a selected 
notification.


Acknowledge Acknowledges a selected notification.


Unacknowledge Removes acknowledgement.


Take Ownership Assigns a username to a selected notification for 
problem resolution.


Release 
Ownership


Removes a username.


Add to Audit Log Adds comment entries to notification audit log.


Audit Log Opens the audit log.


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window.


Browse Detail Opens the Topology Browser view for the 
underlying Manager that contains the selected 
element in a secondary window.


Containment Displays an element’s components.


Show Map Opens the Map Console in a secondary window.


Mail Opens the email tool for a selected notification.


Page Opens the pager message tool for a selected 
notification.


Table 2  Notification Log menus and their options (page 2 of 3)


Menu Option Description
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Shortcut menus are also available when you right-click on selected entities. Table 3 on 
page 26 summarizes the options and selection criteria.


Log Select Columns Controls which columns are displayed in the 
Notification Log view.


Save log contents 
to file


Saves the contents of the Notification Log view 
locally as a text file.


Sort Columns Sorts columns in the Notification Log view.


Filter Specifies a filter for the Notification Log view.


Log Properties Changes the title of the Notification Log view and 
specifies continuous or scheduled display updates 
of notifications.


Freeze Display Stops the display from changing in the Notification 
Log view.


Help About Global 
Console


Lists Global Console information: version, contact, 
and outsourcing information.


Table 2  Notification Log menus and their options (page 3 of 3)


Menu Option Description


Table 3  Notification Log shortcut menus


Selection criteria Option Shortcut menu options


Right-click on or 
near the view title


Same as Log menu options.
For a Notification Log view launched from a summary, only the Select 
Columns option is available.


Right-click a 
column heading


Hide Column Hides a column from display.


Insert Column Inserts a column to the left of the selected column.


Right-click a 
notification


Same as Event menu options with the addition of maintenance tracking 
options, if enabled: Schedule Maintenance and Repair Time.
Plus, the Server Tools and Client Tools options for tools if they are 
enabled. The EMC Smarts Service Assurance Manager Configuration 
Guide includes information on configuring tools.
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Notification Log Console toolbar buttons
In the Notification Log Console, certain menu options are provided as toolbar buttons. 
They are summarized in Table 4 on page 27.


Table 4  Notification Log Console toolbar buttons


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves 
a saved console to a previously-specified destination.


Displays the Select Context(s) To Listen To dialog box for 
configuring context sharing.


Opens a browser for reporting. The EMC Smarts Report 
Manager User Guide includes additional information.


Displays the Notification Properties dialog box for a 
selected notification.


Acknowledges an active, selected notification.


Displays the Map Console for selected notification.
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Layout of a Map Console


The Map Console is designed specifically for viewing maps. When you open the Map 
Console (see Figure 2 on page 29), it consists of two panels.


Left panel
In the left panel, you can select a Global Manager from the Manager menu to see maps for 
that manager. The menu lists attached Global Managers. Domain Managers are not listed 
in the menu.


At the bottom of the left panel are two tabs: 


◆ The Topology tab displays a map tree that is a hierarchical representation of the 
attached Global Managers, classes of infrastructure elements, logical groups such as 
IP networks and VLANs, business services, software services, and the instances 
available for each class. 


◆ The Groups tab displays user-defined groups of topological elements if the groups 
exist. (Your administrator can create groups. The EMC Smarts Service Assurance 
Manager Configuration Guide includes information on groups.)


Different types of maps are available for the instances in each tab.


Right panel
The right panel displays the map. After you select an instance from the expanded map 
tree, the map displays and the selected device is surrounded by a blue box. Alternatively, 
if you used the Show Map option for a selected notification, this panel shows a map 
containing your selection. 


“Map menus and shortcut menus” on page 30 summarizes menu options for the Map 
Console. “Map Console toolbar buttons” on page 34 summarizes toolbar buttons specific 
to the Map Console.


The left arrowhead on the panel divider hides the map tree and enlarges the right panel for 
a larger display area. The right arrowhead on the panel divider unhides or enlarges the 
map tree.


Indicators, at the top of the right panel, show if coloring by root cause is enabled and the 
map’s layout type. “Adjusting the appearance of a map” on page 94 includes additional 
information.


A history field list box lists the current map (instance and map type) and other recently 
viewed maps. 


The map legend provides a list of map elements and color indicators. To view the legend, 
select Map > Map Legend.


You can customize individual maps with a map filter. The filter enables you to add and 
remove classes from a map.

28 EMC Smarts Service Assurance Manager Operator Guide







Introduction

You can customize the font and point size of the map icon text. The default map icon font 
is Helvetica. The default map icon font size is 12 point. The font and font size can be 
modified by changing the com.smarts.mapNodeText.font and the 
con.smarts.mapNodeText.fontsize properties. “Adjusting Java properties” on page 151 
provides detailed information.


Figure 2 on page 29 displays an example of a Physical Connectivity map.


Figure 2  Map Console
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Map menus and shortcut menus
Table 5 on page 30 summarizes the menus that are available for the Map Console. Two 
menus, Layout and Map, are specific to the Map Console. The Configure menu is displayed 
depending on your user access control privileges.


Table 5  Map menus and their options (page 1 of 3)


Menu Option Description


File New Opens a new console.


Open Opens an existing console, locally saved or 
remotely saved.


Close Closes an individual console.


Save Saves an unsaved console on a local or remote 
host. Saves a saved console to a previously 
specified destination.


Save As Saves a console on a local or remote host.


Layout Arranges multiple views in a console and changes 
console title.


Exit Ends the session and closes all consoles.


Edit Find Instance Searches for any topological element in any class 
including application services, service offerings, 
service subscribers, and systems.


Find System Searches for a system (infrastructure element).


View Java Console Displays console debugging information, including 
store exceptions, errors reading attributes, and 
stack traces.


Message Log Displays communications sent from a Manager to 
the console.


Toolbar Toggles the display of the toolbar buttons.


Status Toggles the display of the status bar.


Add View Inserts a view in the current console.


Copy View Copies a view in the current console or to another 
new console.


Delete View Removes a view from the current console.


Listen to Context Configures a view for context sharing.


Refresh Redisplays the console.


Manager Attach Connects to a Manager.


Detach Disconnects from a Manager.
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Layout Circular Layout Displays circular layout of a map.


Hierarchical 
Layout


Displays hierarchical layout of a map.


Organize Displays layout based on internal logic.


Notice: For a Multiprotocol Label Switching (MPLS) 
VPN map.


Orthogonal Layout Displays orthogonal layout of a map.


Manual Layout Enables manual positioning of nodes in a map.


Fit in Window Fits the map to the size of the right panel.


Map Save Map Saves an individual map.


Edit Map Filter Specifies a filter for a map.


Expand Map 
Element


Expands one or more individual nodes or 
elements.


Increment Hops Expands an entire map by one hop.


Decrement Hops Decreases an entire map by one hop.


Map Legend Displays a list of map icons and colors.


Print Map Prints a map.


Overview Opens the Overview window for magnification.


Reset Map Resets changes made to a map or returns to the 
saved map.


Set Background Specifies a user-defined background image for a 
map.


Node Labels For Network Protocol Manager (NPM) maps, 
enables the display of labels for routers.


Align nodes to grid Aligns nodes to the grid.


Grid options Displays map grid options.


Table 5  Map menus and their options (page 2 of 3)


Menu Option Description
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Shortcut menus are also available when you right-click on selected entities. Table 6 on 
page 32 summarizes the options and selection criteria.


Configure Groups Creates groups or child groups of infrastructure 
elements. The EMC Smarts Service Assurance 
Manager Configuration Guide contains information 
about creating groups.


Global Manager 
Administration 
Console


Opens a Global Manager Administration Console 
for configuring Global Managers. 


Domain Manager 
Administration 
Console


Opens a Domain Manager Administration Console 
for managing underlying Domain Managers.


Topology Builder Opens a Topology Builder Console. The EMC 
Smarts Business Impact Manager User Guide and 
the EMC Smarts Application Services Manager 
Discovery Guide contains information about the 
Topology Builder Console.


Edit Map Icons Assigns custom icons for a class or an instance.


Help About Global 
Console


Lists Global Console information: version, contact, 
and outsourcing information.


Table 5  Map menus and their options (page 3 of 3)


Menu Option Description


Table 6  Map shortcut menus (page 1 of 3)


Selection criteria Option Description


Right-click an 
instance in the 
Topology tab


Available maps for 
display


Available maps depend upon the selected 
instance.


Notice: “Types of maps” on page 90 includes 
additional information.


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window.


Browse Detail Opens the Topology Browser view for the 
underlying Manager that contains the selected 
element in a secondary window.


Containment Displays an element’s components.


Edit Map Icons Assigns custom icons for a class or an instance.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click an 
instance in the 
Groups tab


Available maps for 
display


Available maps depend upon the selected 
instance. 


Notice: “Types of maps” on page 90 includes 
additional information.
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Right-click in the 
background of a 
map 


Circular Layout Displays circular layout of a map.


Manual Layout Enables manual positioning of nodes in a map.


Hierarchical Layout Displays hierarchical layout of a map.


Orthogonal Layout Displays orthogonal layout of a map.


Organize For a Multiprotocol Label Switching (MPLS) VPN 
map, displays layout based on internal logic.


Fit in Window Fits the map to the size of the right panel.


Increment Hops Expands an entire map by one hop.


Decrement Hops Decreases an entire map by one hop.


Reset Map Resets changes made to a map or returns to the 
saved map.


Edit Map Icons Assigns custom icons for a class or an instance.


Set Background Specifies a user-defined background for maps.


Align nodes to grid Aligns nodes to the grid.


Grid options Displays map grid options.


Right-click a 
selected node in a 
map


Available maps for 
display


Available maps depend upon the selected 
instance.


Notice: “Types of maps” on page 90 includes 
additional information.


Notification 
Properties


Displays notification properties.


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window.


Browse Detail Opens the Topology Browser view for the 
underlying Manager that contains the selected 
element in a secondary window.


Containment Displays an element’s components.


Schedule 
Maintenance


Displays the Schedule Maintenance dialog box.


Edit Map Icons Assigns custom icons for a class or an instance.


Expand Map Element Expands one or more individual nodes or 
elements.


Map Window Opens another map in a secondary window.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Table 6  Map shortcut menus (page 2 of 3)


Selection criteria Option Description
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Map Console toolbar buttons
In the Map Console, certain menu options are provided as toolbar buttons. They are 
summarized in Table 7 on page 34.


Right-click a 
selected edge in a 
map


Notification 
Properties


Displays notification properties.


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window.


Browse Detail Opens the Topology Browser view for the 
underlying Manager that contains the selected 
element in a secondary window.


Table 6  Map shortcut menus (page 3 of 3)


Selection criteria Option Description


Table 7  Map Console toolbar buttons (page 1 of 2)


Button Description


Opens a Notification Log Console.


Displays the Select Context(s) To Listen To dialog box for 
configuring context sharing.


Opens a browser for reporting. The EMC Smarts Report 
Manager User Guide includes additional information.


Displays circular layout of a map. This is the default layout 
for all maps except for Business Services maps.


Button Description


Displays hierarchical layout of a map. This is the default 
layout for Business Services maps.


Displays orthogonal layout of a map.


Allows manual layout of a map, leaving nodes where you 
place them (important when you place nodes on a custom 
map background such as a geographic map).


For Multiprotocol Label Switching (MPLS) VPN map, 
displays layout based on internal logic.


Fits the map to the size of the right panel.


Zoom out, shrink map.
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Layout of a Topology Browser Console


The Topology Browser Console is designed specifically for viewing the topology of any 
Manager:


◆ For a Global Manager, the Topology Browser presents an abstracted topology.


◆ For a Domain Manager, the Topology Browser presents a complete topology.


It also displays detailed topology if a selected topology element has an underlying 
topology source. It consists of one view, the Topology Browser view. Figure 3 on page 36 
illustrates an example of a Topology Browser Console. 


In the left panel, you can select a Manager from the Manager menu to see the topology for 
that manager. You can expand each object in the topology tree and see its contents.


If multiple Managers are attached, the console displays the Managers one at a time, 
classes, instances of each class, and their relationships. For each object you select, a 
corresponding property sheet with one or more tabs is displayed in the right panel:


◆ For a Manager, the Modules and Threads tabs provide information about models, 
programs, and process threads.


◆ For classes, the Description and Attributes tabs describe the class and its attributes.


◆ For elements (instances):


• Attributes tab lists the attribute names, data types, values, and descriptions of the 
attributes. 


• Groups tab displays groups if the instance belongs to any groups. 


• Global Manager only, the Events tab displays notifications if they are generated.


Zoom in, magnify map.


Opens the Overview window.


Shows previous map.


Shows next map.


Expands selected node or element. A plus sign next to a 
node indicates that the node or element can be expanded.


Changes the color of map objects. Only objects 
experiencing root-cause events are colored. 


Table 7  Map Console toolbar buttons (page 2 of 2)
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In the Topology Browser Console, the menu options and toolbar buttons are the same as 
those in the Notification Log Console, except that the following do not exist for the 
Topology Browser Console. Table 2 on page 24 and Table 4 on page 27 provide 
information on Notification Log menus and their options and Notification Log Console 
toolbar buttons, respectively:


◆ Event and Log menus


◆ View menu options: Save as Viewlet and Listen to Context 


“Topology Browser shortcut menus” on page 37 summarizes shortcut menu options.


Figure 3 on page 36 illustrates a typical Topology Browser Console. In the left panel, the 
tree displays an instance of a probe, 172.16.1.254, and the right panel displays the 
Attributes tab for the probe.


Figure 3  Topology Browser Console

36 EMC Smarts Service Assurance Manager Operator Guide







Introduction

Topology Browser shortcut menus
Shortcut menus are also available when you right-click on selected entities. Table 8 on 
page 37 summarizes the options and selection criteria.


Table 8  Topology Browser shortcut menus


Selection criteria Option Description


Right-click in panel 
of the topology 
tree


Select Specifies a filter for a topology tree.


Refresh Tree Refreshes the tree contents.


Right-click an 
instance in the 
topology tree


Make Root Begins the tree with the selected instance as the 
root.


Browse Opens the Topology Browser view for the current 
Manager that contains the selected element in a 
secondary window.


Browse Detail Opens the Topology Browser view for the 
underlying Manager that contains the selected 
element in a secondary window.


Containment Displays an element’s components.


Show Map Opens the Map Console in a secondary window.


Schedule 
Maintenance


Displays the Schedule Maintenance dialog box.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click the 
notification in the 
Events tab


Properties Displays notification properties.


Browse Opens the Topology Browser view for the current 
Manager that contains the selected element in a 
secondary window.


Show Map Opens the Map Console in a secondary window.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click in the 
Group tab


Browse Opens the Topology Browser view for the current 
Manager that contains the selected element in a 
secondary window.


Show Map Opens the Map Console in a secondary window.
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Layout of a Summary View Console


The Summary View Console is designed to present overviews or summaries of 
notifications. The console consists of one view, the Summary view. Each summary 
represents information in a horizontal bar chart or pie chart, organized by meaningful 
criteria. For example, a summary can organize notifications by severity. A Summary View 
Console can present summaries for one or more Global Managers. Figure 4 on page 38 
illustrates an example of a Summary View Console. 


You can customize a summary. For example, you can edit its parameters to change its 
contents or apply a filter. You can also display a Notification Log view or map for a selected 
summary in a secondary window. Chapter 6, “Examining Summaries,” includes additional 
information.


In the Summary View Console, the menu options are the same as those in the Notification 
Log Console (see Table 2 on page 24), except that the Event and Log menus do not exist 
for the Summary View Console. One menu, Summary, is specific to the Summary View 
Console (see Table 9 on page 39). Shortcut menu options are summarized in Table 11 on 
page 40. Toolbar buttons are also summarized in Table 11 on page 40.


Figure 4  Summary View Console
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Summary View menu and shortcut menus
One menu, Summary, is specific to the Summary View Console. Table 9 on page 39 
provides additional information. Shortcut menu options are summarized in Table 10 on 
page 39.


Table 9 on page 39 summarizes the Summary menu.


Shortcut menus are also available when you right-click on selected entities. Table 10 on 
page 39 summarizes the options and selection criteria.


Table 9  Summary View menus and their options


Menu Option Description


Summary Edit Summary 
Parameters


Changes a summary’s contents, its title, and its 
chart type (horizontal bar or pie chart), and 
specifies continuous or scheduled display updates 
of notifications, alarmed elements, and impacts.


Filter Specifies a filter for a selected summary.


Show Notifications Displays a Notification Log view for a selected 
summary in a secondary window.


Move Summary 
Left


Moves a summary one cell to the left.


Move Summary 
Right


Moves a summary one cell to the right.


Add Summary Adds a summary to the Summary view.


Layout Specifies the maximum number of summaries per 
row in a Summary view.


Delete Summary Deletes a selected summary from the Summary 
view.


Table 10  Summary View shortcut menus


Selection criteria Option Description


Right-click on or 
near the summary 
title


Edit Summary 
Parameters


Changes a summary’s contents, its title, and its 
chart type (horizontal bar or pie chart), and 
specifies continuous or scheduled display updates 
of notifications, alarmed elements and impacts.


Filter Specifies a filter for a selected summary.


Show Notifications Displays a Notification Log view for a selected 
summary in a secondary window.


Show Map Displays a map for a selected summary in a 
secondary window.


Delete Summary Deletes a selected summary from the Summary 
view.


Right-click in a 
view


Add Summary Adds a summary to the Summary view.


Layout Specifies the maximum number of summaries per 
row in a Summary view.
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Shortcut menus for a Notification Log view for a summary are described in Table 3 on 
page 26. A Notification Log view for a summary only supports the shortcut menu that 
results from right-clicking a notification.


Summary View Console toolbar buttons
In the Summary View Console, certain menu options are provided as toolbar buttons. They 
are summarized in Table 11 on page 40.


Table 11  Summary View Console toolbar buttons


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves 
a saved console to a previously specified destination.


Displays the Select Context(s) To Listen To dialog box for 
configuring context sharing.


Opens a browser for reporting. The EMC Smarts Report 
Manager User Guide includes additional information.


Displays the Notification Properties dialog box for a 
selected notification.


Acknowledges an active, selected notification.


Displays the Map Console.


Edits the parameters of a selected summary. Changes a 
summary’s contents, its title, and its chart type, and 
specifies continuous or scheduled display updates of 
notifications.


Specifies a filter for a selected summary.


Displays a Notification Log view for a selected summary in 
a secondary window.


Moves a selected summary one cell to the left.


Moves a selected summary one cell to the right.
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Layout of a Status Table Console


A Status Table Console provides a high-level overview of the status of the underlying 
elements that affect the operation of business entities such as business processes, 
customers, and lines of business. 


The Status Table Console is available when the EMC Smarts Business Dashboard is 
installed.


The Status Table Console displays a grid comprised of the following:


◆ Primary Class (y-axis) — Selection from a group of collection objects (ServiceOffering, 
ServiceSubscriber, or any group created by your administrator). 


◆ Secondary Class (x-axis) — Selection from the group of corresponding instances of the 
Primary Class. Note that these options change as the Primary Class changes.


For example, for the class, Customer, a Status Table view can show the instances and 
notification status of the various service offerings available to the Customer class.


Your administrator can configure the groups (business entities) and Status Table views. 
“Configuring a Status Table view” on page 113 includes information on configuring Status 
Table views.


In the Status Table Console, the menu options are similar to those in the Notification Log 
Console (see Table 2 on page 24), except that the Event and Log menus do not exist for the 
Status Table Console. One menu, Status Table, is specific to the Status Table Console. 
“Status Table menu and shortcut menus” on page 43 contains additional information.
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Figure 5 on page 42 illustrates instances of the Service Offerings (x-axis) provided by the 
Service Subscribers listed on the y-axis.


Figure 5  Status Table Console
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Status Table menu and shortcut menus
One menu, Status Table, is specific to the Status Table Console. This menu includes one 
option, Configure Status Table. The Configure Status Table menu is displayed depending 
on your user access control privileges.


A shortcut menu is available when you right-click on the severity icon for an entity in the 
table, or on a class or instance name (on the x- and y-axis). Table 12 on page 43 defines 


the Status Table shortcut menu options.


Status Table Console toolbar buttons
In the Status Table Console, certain menu options are provided as toolbar buttons. They 
are summarized in Table 13 on page 43.


Client and server tools can be invoked from an instance node displayed in the Status 
Table.


Table 12  Status Table shortcut menus


Selection 
criteria Option Description


Right-click the 
severity icon for 
an instance


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window.


Containment Displays an element’s components.


Notification Properties Displays notification properties for that element.


Show Map Opens a map with that element as focus.


Server Tools Displays a submenu listing available server 
tools.


Client Tools Displays a submenu listing available client 
tools.


Table 13  Status Table Console toolbar buttons


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves 
a saved console to a previously specified destination.


Opens the Configure Status Table dialog box. 


Displays the Select Context(s) To Listen To dialog box for 
configuring context sharing.
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Watch4net


With the introduction of Watch4net 6.2, the user interface for Smarts products has been 
enhanced such that you have more choices for viewing the notifications and network 
activity monitored by the domain managers. You may choose from the following 
deployment scenarios: 


1. Classic Service Assurance Manager console views — This option provides 
management of the Service Assurance Manager server similar to earlier releases of 
the product.


2. Service Assurance Manager consoles displayed inside a Watch4net outer frame — This 
option requires installation of the SAM Web Console and configuration of Service 
Assurance Manager, Watch4net, and the EMC Smarts Console SolutionPack. This 
deployment option requires you to have separate logins for each product.


3. Service Assurance Manager with both Companion UI and Watch4net views — This 
option requires access to a virtual environment for installing Companion UI plus 
installation and configuration of SAM Web Console, Watch4net, and the EMC Smarts 
Console SolutionPack. This deployment option provides single sign-on capability. Use 
of an LDAP server is recommended. For more information on enabling single sign-on 
for SAM, refer to the EMC Smarts SolutionPack Installation and Configuration Guide.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides information for installing Service Assurance Manager and Service Assurance 
Manager Console.


The EMC Smarts SolutionPack Installation and Configuration Guide provides information 
for installing Watch4net and Companion UI and for configuring all of the components as 
an integrated solution.


SAM views through Watch4net


You can access the following SAM views by logging into Watch4net:


◆ Notification Log Console


◆ Map Console


◆ Summary View Console


◆ Status Table Console


◆ Web Console
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Starting a Session


This chapter contains the following information:


◆ Overview.................................................................................................................  46
◆ Run MSA server.......................................................................................................  46
◆ Opening the Global Console....................................................................................  47
◆ Opening an additional Global Console ....................................................................  49
◆ Opening a Web Console ..........................................................................................  50
◆ Closing a console and ending a session ..................................................................  51
◆ Attaching to different or multiple Managers.............................................................  52
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Starting a Session

Overview
A Global Console can be opened as an application in a Windows or environment, as a Web 
Console in a Web Browser, or with Java Web Start.


When you open a console at the beginning of your session, you will need to log in. This 
involves specifying your EMC Smarts username and password, broker information, and 
the Manager name for attachment.


If you initially attach to a Global Manager, one or more consoles display after you log in, 
depending upon your user profile or the default user profile. For example, if your user 
profile is configured for the Notification Log and Map Consoles, then two consoles will 
appear after you log in. If you attach to a Domain Manager, the Topology Browser Console 
appears first since Domain Managers do not maintain user profiles.


Run MSA server
You can run the MSA 2.0 server with the Tomcat server of SAM Console to use the MSA API. 


1. Go to http://java.com and install JRE 7 on your machine and locate the top level 
directory of the JRE 7 installation. 


2. Go to BASEDIR/local/conf and edit the runcmd_env.sh file to add the following lines:


SM_JAVA=<JAVA_HOME>/jre/bin;<JAVA_HOME>/jre/bin/client
SM_JAVAHOME=<JAVA_HOME>/jre


where, <JAVA_HOME> is the path to the top level directory of the JRE 7 installation.


3. Copy the file, msa20-dmt-9.1.1.0.143.war from BASEDIR/tomcat/webapps/msa 
directory to BASEDIR/tomcat/webapps directory.


4. Rename msa20-dmt-9.1.1.0.143.war under BASEDIR/tomcat/webapps directory to 
msa20-dmt.war.


5. Start the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat start


When the Tomcat server has started, themsa20-dmt.war file in the 
BASEDIR/tomcat/webapps directory will be extracted or deployed, and a new 
directory BASEDIR/tomcat/webapps/msa20-dmt will be created.


6. Stop the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat stop


7. Go to BASEDIR/tomcat/webapps/msa20-dmt/WEB-INF/classes, and edit the 
msa-sources.xml file to add the SAM server and Broker information.


8. Start the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat start


9. Type the following address in your web browser:


http://<host>:8080/msa20-dmt/msa/


Starting the MSA 2.0 server and the Tomcat server will not start the SAM Console. Start the 
Global Console as described in “Opening the Global Console” on page 47.
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Opening the Global Console 
This section describes how to start a Global Console session.


Opening a Global Console in a Windows environment


To start a new session and open a new console in a Windows environment:


1. Click Start in the Windows Taskbar. 


2. Select Programs > InCharge > EMC Smarts Global Console. 


The Please select Manager to attach dialog box appears.


Alternately, the Global Console can be started from a command line prompt from the 
<BASEDIR>\smarts\bin directory by issuing the sm_gui command and specifying 
parameters specific to the console.


Logging on and attaching to a Manager


Before the console appears, you are prompted to log in and attach to a Manager:


1. For the Broker field, the broker hostname and port number values (that were provided 
during the installation process) appear. You may need to change them; check with 
your administrator for the correct values. 


For example, in Figure 6 on page 47, the broker hostname is smarts-broker and the 
port number is 426.


Figure 6  Manager dialog box


2. Click the Manager list box or the Browse button to display a list of active (running) 
Managers. 


If the specified broker is a secure broker, when you click the Manager list box or the 
Browse button, you might be prompted to supply an EMC Smarts username and 
password for the broker, depending upon the security configuration. Click OK and 
then select a Manager from the displayed list.
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3. In the User name field, type your EMC Smarts username.


4. In the Password field, type your password.


5. Click OK. 


After you click OK, the console appears. To close the dialog box and end the session, 
click Cancel.


Older versions of consoles will not connect to new versions of the Service Assurance 
Manager server. When you attempt to connect to a new version of the Service Assurance 
Manager server using an older version of the console, please select Incharge Manager to 
attach message appears, as illustrated in Figure 7 on page 48. This message notifies you 
that the login failed and that you need to upgrade the Global Console to a compatible 
version of the Service Assurance Manager server.


Figure 7  Please select InCharge Manager to attach error message


This message appears when the SM_REJECT_OLD_CONSOLES parameter is configured to 
true. The SM_REJECT_OLD_CONSOLES parameter is located in the runcmd_env.sh file. 
Setting the SM_REJECT_OLD_CONSOLES parameter to true prohibits Service Assurance 
Manager (SAM) 7.0 consoles and previous versions of the console from connecting to the 
SAM 7.2 server. When this parameter is set to true, SAM 7.1 consoles and subsequent 
versions of the console connect successfully to the SAM 7.2 or later servers.


IPv6 address environments


In environments where domains can have IPv6 addresses, domain names appear in the 
Manager dialog box with the text [IPv6] amended to the domain name. In IPv6 
environments, two entries for each domain may exist; one entry for the domain’s IPv6 
address and another for the domain’s IPv4 address. If either address does not exist, the 
connection for that address is not included in the Manager dialog box. You can only 
connect to domains displaying a status of Running. Where both IPv4 and IPv6 connections 
display a status of running, you can choose either of the connections. If you choose a 
connection that uses an IP version that is not available, a message appears notifying you 
that the selected protocol is not available. 
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Opening an additional Global Console 
If you already started a session, you can open a new console or a saved console from your 
current console.


When opening a console saved on a server, you can select consoles saved in your user 
profile, saved in your user ID, and consoles saved globally.


Opening a new console 


You can open a new console from any running console in a session. Select one of the 
following consoles: 


◆ File > New > Notification Log Console


◆ File > New > Map Console


◆ File > New > Topology Browser Console


◆ File > New > Summary View Console


◆ File > New > Status Table Console


This opens a console and attaches it to the same Managers as the running console. In the 
status bar, the text "Not saved" appears since it is an unsaved console. The new console is 
part of the same session as the running console.


If the value “None” appears in the Manager menu, you need to select a Global Manager or 
a Manager from the menu, depending on the type of console. A new Summary View 
Console displays one default summary for each attached Global Manager.


Opening a locally saved console


To open a console saved on the host where the Global Console is running:


1. Select File > Open > Open Local. 
or 
Click the Open Local toolbar button. This displays the Open Console dialog box.


2. In the Open Console dialog box, select the console and click Open. This opens the 
console. The status bar displays the directory path and its filename.


Opening a remotely saved console


To open a console saved on the host where a Manager is running:


1. Select File > Open > Open Remote. This displays the Open Remote Console dialog box.


2. In the Open Remote Console dialog box, select the location of the saved console:


• Choose an Manager. 


• Select the console from the Load from list box.


3. Click OK. This opens the console. The status bar displays the Manager where it is 
saved, username, and the console name.
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Opening a Web Console
You can open a Web Console, which provides Global Console functionality, in a web 
browser. When you open a Web Console, the console opens within the browser, not in a 
separate window. 


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
includes browser requirement information.


If a message prompting you to install the latest J2SE Runtime Environment appears, click 
Yes (or the link) and follow the steps to install the software.


To open a Web Console:


1. Start your browser and point it at the following URL:


http://<Tomcat_host>:8080/webconsole/InChargeApplet.html


Where <Tomcat_host> is the name of the machine where the Tomcat Servlet Engine is 
installed; 8080 is the value for the port.


Tomcat Servlet Engine is installed as part of the Web Console or EMC Smarts Business 
Dashboard. The Tomcat Engine serves the files used by the Web application.


2. In the Java Security Warning dialog box, click Yes or Always.


Yes or Always grants the Web Console full access to your machine. This allows the 
console to connect to any Manager from your machine, provided your login ID has 
authorization, and the console can save files locally.


No allows the Web Console to run without full access to your machine. 


3. Log in as described in “Logging on and attaching to a Manager” on page 47.


Using Java Web Start (optional)


To use Java Web Start with the Web Console, specify the following URL or select its icon if 
Java Web Start is installed.


To download and install Java Web Start:


1. Start your browser and point it at the following URL:


http://<Tomcat_host>:8080/webconsole/globalConsoleCached.html


Where <Tomcat_host> is the name of the machine where the Tomcat Servlet Engine is 
installed; 8080 is the value for the port.


In the Java Security Warning dialog box, click Yes or Always.


Yes or Always grants the Web Console full access to your machine. This allows the 
console to connect to any Manager from your machine, provided your login ID has 
authorization, and the console can save files locally.


No allows the Web Console to run without full access to your machine. 
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2. Optionally, select the option to download and install the Java Web Start product and 
the application.


A Java Web Start icon will install on your desktop or your Start menu. To start the Web 
Console after this, click this icon.


3. Log in as described in “Logging on and attaching to a Manager” on page 47.


If you do not have Java Web Start installed, you might be prompted to use an automatic 
installer or be directed to a Sun Microsystems web page, depending upon your operating 
system or browser. 


The EMC Smarts Service Assurance Manager Dashboard Configuration Guide provides 
detailed Web Console and Java Web Start information.


Closing a console and ending a session
If you have one or more consoles running, you can close specific consoles or end the 
entire session.


Closing a console


To close a console:


1. Select File > Close. 


The Close command closes an individual console and the session continues. The 
Manager is not affected by this operation. 


If the console is the last opened one, you are prompted to confirm whether to close it. 


2. Click Yes to close it. 


When you close the last console, you end the session.


When you close a web-browser window, the console closes. If that is the only open 
window for this session, the session closes. In the Web Console, you may not be prompted 
to confirm closing the last open console.


Ending a session


To close a session and exit a console:


1. Select File > Exit.


2. Click Yes to confirm. All consoles that are part of the session are closed and the 
session ends. The Manager is not affected by this operation.
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Attaching to different or multiple Managers 
After you log in, if you need to use a different Manager, you can attach to another manager 
without exiting the console. If you detach from a Manager, you can attach to it again at any 
time.


If you need to access multiple Managers, you can attach to them, one at a time.


The attach procedure is similar to the logon procedure with some minor differences. For 
the attach procedure, you can use the same login username and re-enter your password or 
specify a different login ID. If you want to attach to a Manager using a different login ID, 
you do not have to start another Service Assurance session.


Detaching from a Manager
Detach from a Manager when you no longer want to interact with it. The detach operation 
does not stop the Manager. 


To detach from an Manager:


1. Select Manager > Detach.


2. Click Yes to confirm the detach.


If multiple Managers are attached, the Detach Manager dialog box appears. Select the 
Manager you want to detach and click OK or click Cancel.


For the detached Manager, the value “None” appears in the Manager menu; other 
attached Managers remain listed and available. If you are using the Summary View 
Console, the summaries for the detached Global Manager turn gray.


Attaching to a Manager
To attach to an Manager:


1. Select Manager > Attach. This displays the Attach Manager dialog box.


2. The last attached Manager appears in the Manager menu. If you want to reattach, 
accept the value. Or, click the Manager list box or the Browse button to select another 
Manager.


If the specified broker is a secure broker, when you click the Manager list box or the 
Browse button, you might be prompted to supply your EMC Smarts username and 
password, depending upon the security configuration. Click OK and then select a 
Manager from the displayed list.
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3. Type your password in the Password field.


You do not need to change the values for the Broker field or the Username field.


If you want to specify a different login ID, you can change the values for the User name 
and Password fields.


4. Click OK.


To close the dialog box without attaching to a Manager, click Cancel.


The name of Manager is listed in the Manager list box. If you are using the Summary 
View Console, the Global Manager’s name is listed at the bottom of a summary after it 
is added to the view.
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CHAPTER 3
Examining Notifications


As you monitor your managed domain, you might need to examine notifications or 
investigate their causes. You may also need to refine the appearance of diagnostic results 
in your console.


“Global Console overview” on page 20 includes descriptions of console layout and 
available menus.


This chapter contains the following information:


◆ Accessing notifications ...........................................................................................  56
◆ About notifications .................................................................................................  56
◆ Displaying notification properties............................................................................  62
◆ Adjusting the contents of a Notification Log view.....................................................  69
◆ Using filters ............................................................................................................  72
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Accessing notifications
Once you start a session, events may appear as notifications in your Notification Log 
Console and may update summaries in your Summary View Console. Or, you can display 
topological information in a map or topology tree.


Once any console is opened, there are alternative methods for accessing notification 
information:


◆ Add a Notification Log view to any console. Chapter 9, “Customizing Your Console,” 
includes information about views and adding views.


◆ Check the Events tab of the Topology Browser for any available notifications.


◆ Display notification properties by double-clicking an affected node 
(non-green color) in a map or on a selected notification.


◆ Use the Open a Notification Log console toolbar button to display a Notification Log 
view for a selected summary in a secondary window.


About notifications
When you are interpreting notifications, you should be aware of the different severity 
levels for notifications, and important attributes such as Source, IsRoot, and Impact that 
appear as columns in your console. This section also explains how to obtain more 
information about notification properties. 


Notification information is displayed in: 


◆ The Notification Log Console or view (including a view for a selected summary), when 
events occur.


◆ The Events tab of the Topology Browser for the object where the problem or event 
occurs.


◆ The Notification Properties view. “Displaying notification properties” on page 62 
contains additional information.


◆ Maps where notifications affect the state of icons. “Adjusting the appearance of a 
map” on page 94 contains additional information.


◆ Status Table Console, for status of the underlying elements that affect the operation of 
business entities. Chapter 7, “Examining Status Tables,” contains additional 
information.
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Notification naming convention


Each notification has a unique name. A notification’s name consists of the class name and 
instance name where the event occurred, and the event name. The notification naming 
convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, 
which occurred in instance R1 of the Router class. 


Unique notification names with this convention are displayed in the InternalEventHandle 
column. By default, the InternalEventHandle column is not displayed in the Notification 
Log Console, but you can add it by selecting Log > Select Columns. The Class, Name, and 
Event columns display a more readable form of this information.


The Notification Log Console will not list more than one notification with this name. If the 
event clears and occurs again before it is archived, the Count field is increased 
accordingly. “The notification life cycle” on page 116 contains additional information 
about notification archival.


Notification severity


Service Assurance generates the following five levels of severity for notifications:


◆ Critical


◆ Major


◆ Minor


◆ Unknown


◆ Normal


Each level has an associated severity icon, a unique color-coded icon. Table 14 on 
page 58 summarizes severity and how severity appears in the Notification Log Console.
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The notification list configured by your administrator determines which notifications 
appear in your console. If the notification list does not include an event, notifications for 
the event will not appear in your console. If your Notification Log Console does not 
accurately reflect observed conditions, contact your administrator.


When an event’s state changes from ACTIVE (notified) to INACTIVE (cleared), the 
notification turns transparent (white). An inactive state means that the event is no longer 
occurring. If an event recurs, the Global Manager sends another notification, the state of 
the event returns to active, and the event counter is incremented.


Table 14  Notifications and console display


Severity level Description Severity icon


Critical (red)
Severity 1


A critical notification identifies a fatal condition. It 
requires immediate attention.
When you receive multiple critical notifications, it 
means that Service Assurance has determined 
several independent fatal conditions. 


Major (orange)
Severity 2


This represents a serious condition. It requires 
immediate attention.


Minor (yellow)
Severity 3


This represents an abnormal condition. Action is 
required but the condition is not serious.


Unknown (blue)
Severity 4


This represents elements and/or events that are in 
an unknown state because of network or 
management connectivity failures. It requires 
investigation.


Normal (green)
Severity 5


This represents a normal state and is usually 
displayed when an event is informational.


Other indicators Description Color of item 


Inactive This indicates that the state cleared (changed to 
INACTIVE) and notification turns transparent. 


White with black text


Selected
Clicking on a notification selects it. Black border 


surrounding 
notification


Unmonitored or 
suspended


In the Notification Properties view, this indicates an 
event is unmonitored or suspended.


Gray text 
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Notification Log columns 


In the Notification Log view, notification attributes appear as column headings. Table 15 
on page 59 lists the column names and their descriptions. 


Table 15  Columns in the Notification Log view (page 1 of 3)


Column / Attribute Description


Acknowledged Indicates the event has been acknowledged.


Active Indicates if the event is active.


Category Represents a broad categorization of the event (for example, 
Availability against Temperature). Valid values can be: 
Availability, Discovery, Error, Operational, Performance, 
PowerSupply, Resource, Temperature, and IMPACT.


Certainty The certainty of this event.


Class Display name for the event class. 


ClassName Class name of the managed element where the event occurred. 
One of three attributes that uniquely identifies a notification, 
not modifiable. 


ClearOnAcknowledge Indicates whether the event is automatically cleared from the 
Notification Log view when the event is acknowledged.


Count The number of occurrences of this event starting from First 
Notify until Last Notify.
For a momentary event (no duration), each occurrence increases 
the count value regardless of the current event state. 
For a durable event (a duration), the count value increments 
whenever the event reoccurs (cleared and renotified).


Element Class The class name of the topology element associated with the 
event in the repository where this event resides. This may or 
may not have the same value as Class or may be empty.


Element Name The name of the topology element associated with the event in 
the repository where this event resides. The string is empty if 
there is no related element. This may or may not have the same 
value as InstanceName.


Event Display name for the event name.


Event State Indicates the state of the event. Values can be ACTIVE (notified), 
SUSPENDED, WAS_ACTIVE, or INACTIVE (cleared). 


Event Text A longer textual description of the event.


Event Type Indicates the nature of the event. Value can be either 
MOMENTARY or DURABLE. A momentary event has no duration. 
A durable event has a period during which the event is active 
and after which the event is no longer active.


EventName Name of the event. One of three attributes that uniquely 
identifies a notification, not modifiable. 
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First Notify First notification time. (This value is reset after an event is 
archived.)
Events diagnosed by an underlying domain include timestamps 
that accurately reflect when the event occurred. The Global 
Manager uses this value from the event for the 
FirstNotifiedAt/LastNotifiedAt times when it creates the 
notification.


Impact If Business Impact Manager is available, the sum of the weights 
for all affected elements. The default weight for each affected 
element is 1. Weights quantify the event impact on the 
infrastructure and business processes. A large numeric value 
indicates a large impact. 


In Maintenance Indicates whether this event occurred during a maintenance 
period.


InstanceName Name of the instance where the problem was diagnosed. One of 
three attributes that uniquely identifies a notification, not 
modifiable. 


InternalEventHandle A unique key (Name attribute) that identifies the notification.


IsProblem Yes indicates if (and only if) at least one of the source event 
types is “PROBLEM”, and other source event types are either 
“PROBLEM” or “UNKNOWN”.
No indicates that one or more of the source event types is 
“EVENT” or “AGGREGATE”.
Since filtering on IsRoot can result in transient behavior when 
events are received from multiple underlying sources, it is 
recommended to filter on IsProblem instead.


IsRoot Yes indicates that the current notification is the root event.
No indicates that the current notification is not a root event and 
is caused by another event. 
It is often useful to filter on IsRoot to find those notifications 
that require immediate attention.


Last Change Time of last event change.


Last Clear Last clear time. "Never" indicates the notification has never 
cleared.


Last Notify Last notification time.


Name Display name for the event instance.


Owner The username of the person responsible for handling the event.


Table 15  Columns in the Notification Log view (page 2 of 3)


Column / Attribute Description
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In the Notification Properties view, the Caused By tab and Impact tab provide more 
information about the IsRoot and Impact attributes, respectively:


◆ The Caused By tab lists another event that caused a selected notification if the IsRoot 
value is No. 


◆ The Impact tab lists all of the affected elements for the selected notification. 


The default weight can be changed by your administrator. Contact your administrator 
for acceptable values if you intend to specify this attribute in a notification filter. 


The EMC Smarts Service Assurance Manager Configuration Guide contains complete 
information about attributes.


Severity A graphical severity icon (color-coded icon) that categorizes the 
severity level of the event from the notifier's point of view:
1. Critical indicates a fatal condition and that the scope is broad 


(for example, an outage to a critical resource).


2. Major indicates a serious condition.


3. Minor indicates an abnormal condition but not a serious one.


4. Unknown indicates that elements and/or events that are in 
an unknown state because of network or management 
connectivity failures. 


5. Normal indicates a normal state and that an event is purely 
informational.


Table 14 on page 58 provides examples of the severity icons.


Source Identifies the software component(s) that diagnosed the event, 
where the event originated (for example, a Global Manager, 
Domain Manager, SAM Adapter Platform, or SAM adapter).
If there is more than one source, the attribute lists each 
separated by a comma. 
An intermediary Manager that relays an event is not listed as a 
source. For example, “Trap Processor” (SNMP Trap Adapter) is 
listed as the source of a notification and not the intermediary 
SAM Adapter Platform server.


SourceEventType Indicates the type of event from an underlying source or 
sources. Value can be: PROBLEM, EVENT, AGGREGATE, or 
UNKNOWN. The default value is UNKNOWN. (Not to be confused 
with Event Type.)


Ticket ID Trouble ticket ID.


UserDefined1 - 20 Twenty user-defined fields. Reserved for custom configuration.


Table 15  Columns in the Notification Log view (page 3 of 3)


Column / Attribute Description

About notifications 61







Examining Notifications

Displaying notification properties
To obtain detailed information about individual notifications, you can display notification 
properties information in either a dialog box, or a view, or in the Notification Properties 
workspace in the Companion UI. To do so, you can:


◆ Double-click a notification in the Notification Log view.


◆ Select a notification and click the Show Notification Properties toolbar button.


◆ Select Event > Properties.


◆ Right-click a selected notification and select the Properties option in the shortcut 
menu.


◆ Double-click a map icon if it is affected by active events and is no longer green. Or, 
right-click a selected map icon and select the Notification Properties option in the 
shortcut menu.


◆ Add a Notification Properties view using View > Add View.Select Event > Companion UI. 


◆ Right-click a selected notification and select the Companion UI option in the shortcut 
menu.


◆ When you select the Companion UI for the first time, you are prompted for your CUI 
user name and password. EMC recommends that you leave the browser open so you 
will not be prompted for your login credentials each time you select a notification. The 
Notification Properties workspace opens in a separate browser.


Depending on the type of event and information available for display, the Notification 
Properties view displays up to seven types of tabs and up to five buttons. The Smarts CUI 
Notification Properties workspace displays as many apps as you wish. Online help in the 
Companion UI provides complete information about the available apps and features.


In the Notification Properties view, the tabs are:


◆ General


◆ Audit Log


◆ Codebook


◆ Impact


◆ Details


◆ Caused By


◆ Aggregates


If a tab does not display but Fetch Details is enabled, click Fetch Details..


For the Notification Properties view, the buttons are:


◆ Refresh – Click this button to update values.


◆ Browse – Click this button to display the Topology Browser for the instance of the 
event.
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◆ Fetch Details – Click this button to display information from underlying Managers.


◆ Containment – Click this button to display containment information.


◆ Close – Click this button to exit the dialog box.


The Notification Properties view is available regardless of the notification’s state (active or 
inactive).


Depending upon the Global Manager’s configuration, the detailed information is retrieved 
from the Global Manager and may include information from underlying Managers. One 
indication is whether or not the Fetch Details button appears in the view:


◆ If the Fetch Details button does not exist, the information is retrieved from the Global 
Manager and its underlying Managers.


◆ If the Fetch Details button exists, the information is retrieved from only the Global 
Manager. 


To display information from the underlying Managers, click Fetch Details.


The Fetch Details button appears only if your administrator configured the 
FetchLocalNotificationProperties parameter to true. In this case, when you open the 
Notification Properties view, initially only the Global Manager information appears, and 
information from underlying servers is retrieved only when the Fetch Details button is 
pressed.


If the default setting (set to false) for the FetchLocalNotificationProperties parameter is 
used, the Notification Properties view initially displays all information, both the 
information from the Global Manager and information the Global Manger retrieves from 
the underlying servers. Set the FetchLocalNotificationProperties parameter to true in 
configurations where it may take the Global Manager a significant amount of time to 
retrieve the information from the underlying servers. This allows the initial notification 
properties information to appear quickly.


If you click the Fetch Details button and the information from the underlying servers takes 
a significant amount of time to appear, the Refresh button is disabled until the information 
from the underlying servers is displayed. During this time you can do other console 
operations.
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General tab


The General tab lists the current values of the notification attributes. 


Audit Log tab


The Audit Log tab displays the audit trail for the selected notification. 


In the log, each row is an entry. To view the full entry, select the row and click Show Full 
Entry. To insert additional entries, click Add to Audit Log.


System actions such as archiving and user actions such as acknowledgement, ownership, 
and actions performed using server and automatic tools are recorded as entries in the 
audit log. Inserted comments cannot be edited or deleted and are archived as part of the 
audit log. “Adding comments to a notification’s audit log” on page 140 contains 
additional information.


To save a copy of the current contents of an audit log locally as a text file, click Save table 
to file. In the Save table to file dialog box, you can choose field delimiters, whether to 
include column headers, and a location for the file. Click OK to save the audit log. “Saving 
audit log and containment information” on page 142 contains additional information.


Codebook tab


The Codebook tab only appears for a selected notification that represents a root-cause 
event from an underlying Manager. Such a notification, regardless of its severity, has a 
value of Yes for its IsRoot attribute. If a notification is notified as a root cause from 
multiple sources, one Codebook tab is displayed for each source. If the Codebook tab is 
not displayed but the Fetch Details button is enabled, click Fetch Details to display the tab.


The Codebook tab displays all symptomatic events used in the analysis of a root-cause 
event. The notification for an active symptomatic event indicates an abnormal condition in 
an underlying Manager. Notifications for symptomatic events are primarily displayed in 
this tab and might be displayed in the Notification Log Console. Their display in the 
console can be configured by your administrator. 


In the Codebook tab, information is presented as a tree. Each tree node represents a class 
associated with a symptomatic event. You can expand the node to display its instance or 
instances.


The coloring of an active notification for a symptomatic event is determined by its 
underlying source or whether the event has already been imported into the Global 
Manager. Typically, the coloring is:


◆ Orange if the symptomatic event is active.


◆ White with black text if the event is inactive.


◆ Gray text if the event is unmonitored or suspended.
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In the Codebook tab, if you right-click the background area, a menu with two options 
appears:


◆ Show Active Only 


Click this menu option to display either active and inactive symptomatic event. A 
check mark appears when only active events are displayed.


◆ Collapsed 


Click this menu option to collapse the tree hierarchy. To expand the subtree, select 
Collapsed again. A check mark appears when the collapsed state is selected.


When the tree hierarchy is collapsed, you can right-click or double-click an instance in 
the tree to display the Notification Properties dialog box to display additional 
information.


The instance’s tool tip provides information on the state of the symptomatic event. For 
example, use a tool tip to determine whether an event is unmonitored or suspended.


Impact tab


The Impact tab displays the objects affected by the selected notification. This tab appears 
for any type of event, including critical problems. Not all events affect other objects, so the 
Impact tab may not display. 


The tab presents information in a table. To sort it, click one of the column headings. In the 
table, you can view the affected object’s class and event.


For more information about an object, you can double-click its row to display the 
Notification Properties dialog box. Or, right-click it and select Browse to display a 
Topology Browser. You can also right-click a row and select Show Map to display it in a 
Map Console. 


“Caused By tab” on page 66 contains information on displaying the events which, in turn, 
cause the selected notification.


Client and server tools can be invoked from notifications displayed in the Notification 
Properties Impact tab.


Details tab


The Details tab displays the Manager (source), the object’s attributes and their 
corresponding values relevant to the event. If a notification has multiple sources, one 
Detail tab appears for each source.


The tab presents information in one of three formats: 


◆ A table of attributes and values


◆ A table of thresholds and their related attributes and values


◆ A sum or total value with a table of other attributes compared against a threshold 
value 
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A gray line may appear in place of an attribute value in either the Details tab of the 
Notification Properties view or the Attribute tab in the Topology Browser.


If a gray line appears in place of an attribute value, the value cannot be obtained by 
Service Assurance because:


◆ It is unnecessary for the underlying Manager to poll the attribute value of an external 
device at this time. To minimize network overhead, the Manager polls only those 
values it needs to analyze your devices. 


◆ The underlying Manager has encountered an error while polling the attribute value of 
an external device. For example, the device might be down, or it might be up but 
inaccessible due to network problems. In this case, you receive a notification of the 
critical problem, but the value remains unavailable. 


Caused By tab


The Caused By tab displays the events that are causing the selected notification. It also 
displays the objects where the events occur.


The tab presents information in a table. To sort it, click one of the column headings. 


For more information about an object, you can double-click its row to display the 
Notification Properties dialog box. Or, right-click it and select Browse to display a 
Topology Browser. You can also right-click a row and select Show Map to display it in a 
Map Console. 


Client and server tools can be invoked from notifications displayed in the Notification 
Properties Caused By tab.


Aggregates tab


The Aggregates tab appears if the selected notification is an aggregate. This tab enables 
you to examine the component notifications of an aggregate.


An aggregate is a notification that consists of one or more component notifications. 


The tab displays the components of the aggregate, their class, object names, and the 
Manager (source). If a notification has multiple sources, one Aggregates tab appears for 
each source. To sort the table of information, click one of the column headings. 


In the tab, a component notification is colored:


◆ According to its severity if it is active.


◆ White with black text if it is inactive.


◆ Gray text if it is unmonitored or suspended.

66 EMC Smarts Service Assurance Manager Operator Guide







Examining Notifications

For more information about a component notification, you can double-click it to display 
the Notification Properties dialog box. Or, right-click it and select Browse or Show Map to 
display a Topology Browser or a Map Console, respectively. 


Client and server tools can be invoked from notifications displayed in the Notification 
Properties Aggregates tab.


A map consideration


If you double-click a colored map node (or right-click a colored edge) and:


◆ One notification exists, the Notification Properties dialog box appears. 


◆ Multiple notifications exist, the Active Notifications dialog box appears. 


In the Active Notifications dialog box, select the notification you want to see and click 
Properties to display the Notification Properties view or click Close.


Notification Properties tab examples


Figure 8 on page 67 shows the active symptomatic events for an Interface Disabled 
notification for the interface IF-lab-gw.


Figure 8  Codebook tab
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Figure 9 on page 68 shows an audit log for a Router Unresponsive notification for the 
router moto-gw.


Figure 9  Audit Log tab


Figure 10 on page 68 shows objects affected by a Card Down notification for the card 
wrcaswsjc4/4.


Figure 10  Impact tab
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Adjusting the contents of a Notification Log view
To make it easier to examine the contents of your console(s), you can rearrange or adjust 
the contents. This section describes how to:


◆ Change the contents of a Notification Log view.


◆ Adjust the appearance of a Notification Log Console (for example, how to rearrange 
columns, sort by column, and control the display of columns).


You can also adjust the contents by applying filters. “Using filters” on page 72 contains 
additional information.


Chapter 9, “Customizing Your Console,” contains additional information on creating a 
customized console.


Changing the contents of a Notification Log view


In a single Notification Log view, you can display notifications from different Global 
Managers by changing the selection in the Manager menu. 


Adjusting the appearance of a Notification Log Console or view


In your Notification Log Console or view, you can:


◆ Control which columns are displayed.


◆ Adjust the column width.


◆ Rearrange the order of columns.


In the following sections, some menu options are not available when you display a 
Notification Log view for a summary. In this case, the Notification Log view only supports 
the menu options that result from right-clicking a notification (see Table 3 on page 26).


“Notification Log columns” on page 59 contains descriptions of notification columns.


Controlling the column display
Certain columns may be extraneous for your work. To control which columns display:


1. Select Log > Select Columns. Or, right-click in the area near the view title and select 
Select Columns in the shortcut menu. The Select Columns dialog box displays.


2. To add or hide a column from your display, select or clear the appropriate checkbox.


3. Click OK to apply your changes.


Optionally, you can right-click a column heading to hide it or to add another column next 
to it. 


◆ To hide a column, right-click its heading and select Hide Column in the shortcut menu. 


◆ To add a new column, right-click a column heading, select Insert Column in the 
shortcut menu, and select a new column in the submenu. The new column is inserted 
to the left of the selected column.
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Adjusting the column width
You can adjust the column width, if necessary. To adjust the width of a column, select the 
divider between column titles and drag it with the mouse. 


Rearranging the order of columns
To rearrange the order of columns, select a column title and drag it to the left or right.


To move a column, right-click a column heading, select Insert, and, in the submenu, select 
the column you want to move. The column is moved to the left of the selected column.


Sorting notifications


Two methods are available for sorting notifications: 


◆ Click Sort


◆ Column Sort Order dialog box


A Notification Log view, by default, is unsorted.


Click Sort method
To sort notifications by one column, click the column title you want to use for sorting. Note 
that a triangular marker appears in the column title:


◆ First click sorts the notifications in ascending order. The triangular marker points up.


◆ Second click sorts the notifications in descending order. The triangular marker points 
down.


◆ Third click disables the sort. The triangular marker is removed.


If you disable the Click Sort functionality and there are other sort columns specified in 
the Column Sort Order dialog box, the specified sort columns determine the sort 
order.


Columns that are moved and hidden from display may continue to affect the sort order.


Column Sort Order dialog box
To sort notifications by multiple columns:


1. Select Log > Sort Columns. Or, right-click in the area near the view title and select Sort 
Columns in the shortcut menu. The Column Sort Order dialog box displays.


2. Select the columns from the list boxes. Select Descending for a descending sort order; 
Ascending is the default.


If you already used Click Sort, your choice appears in the dialog box. You can also 
specify a Click Sort column. If you clear the Enabled checkbox, Click Sort is disabled 
until the next time you click a column title or select the Enabled checkbox.


The primary sort field is the Click Sort column or, if no Click Sort column is specified, 
the first field that you specify in the dialog box.


If you need to reset your selections, click Reset.
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3. Click OK to apply your changes.


Except for the Click Sort selection, sorting, as determined by the selected columns in the 
Column Sort Order dialog box, is retained if you save a console.


Updating and freezing notifications


You can:


◆ Control whether the display of notifications is updated continuously or at scheduled 
interval.


◆ Freeze the notifications and prevent the display from updating.


Specifying display updates for notifications
Notifications are constantly being updated in your console by default. If you want to 
control how often notifications are updated, you can specify a time interval for scheduled 
updates. 


You should consider the following before you specify a time interval:


◆ You should balance the update period between timely updates and the processing 
resources required to continually update the Notification Log Console. Check with 
your system administrator about an appropriate setting.


◆ Simultaneous displays of notifications might be inconsistent. If you specify a time 
interval for scheduled updates, users’ actions, including your own, that occur during 
the interval are not updated in the display until after the interval. For example, you 
might acknowledge a notification that another user has already acknowledged. If this 
is a concern, use the time interval feature (the Update Every field) sparingly.


To specify an interval for scheduled updates: 


1. Select Log > Log Properties. Or, right-click in the area near the view title and select Log 
Properties in the shortcut menu. The Log Properties dialog box displays. 


2. Clear the Update Continuously checkbox and specify the time in the Update Every 
field.


3. Click OK. 


Freezing your display
To stop notifications from changing in the display, select Log > Freeze Display. Or, 
right-click in the area near the view title and select Freeze Display in the shortcut menu. In 
the left corner of the view, a box icon appears.


To unfreeze the display, select Log > Freeze Display again or click the box icon. The box 
icon in the left corner is removed.
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Using filters
Filters enable you to control the contents of your console, view, or individual summaries. 
You apply a filter to notification attributes, any class, or instance, or both. For example, 
you may want to monitor only critical notifications with high impact on your business 
operations. There is one filter per view or summary. Filter criteria are saved if you save your 
consoles.


This section describes how to filter notifications with the Filter Builder dialog box. 
“Filtering summaries” on page 108 includes information on applying a topological filter to 
a summary using the Filter Builder.


“Filtering topology” on page 79 contains additional information about filtering a topology 
tree. “Filtering maps” on page 99 includes information about filtering class instances in a 
map.


Filtering notifications


You can apply a filter to your Notification Log view. The filter can consist of one or more 
criteria. Only notifications that match all of your criteria are displayed. Filter criteria are 
saved if you save your console.


Use one of the following methods to open the Filter Builder dialog box: 


◆ Click a Notification Log view and select Log > Filter. 


◆ Right-click in the title area of the view and select Filter in the shortcut menu. 


Layout of the Filter Builder
Initially, the Filter Builder dialog box opens with a blank Sheet1 tab. At the top, the Edit 
menu enables you to add, copy, or delete a Sheet tab. 


On the left, the green plus sign button enables you to add one filter criterion at a time. 
Menus for each filter criterion enable you to select a notification attribute and one of the 
following conditions, if applicable:


◆ A match condition such as a specific value or expression. You can also specify 
wildcard characters in a match condition. Values are case-sensitive. 


◆ The is child of condition (the IsA filter option) for notification attributes that have a 
class name for their value. “IsA (“is child class of”) filter option” on page 73 includes 
additional information.


If you want to treat a wildcard character as a text character, insert a backslash (\) before 
the wildcard character. For example, to filter on all event names that include a bracket, 
specify “*\]*”. (Do not include the quotation marks in the expression.)


The Helper button is displayed depending on the selected notification attribute. This 
button:


◆ Provides a list of acceptable values.


◆ Prompts you for a range of values.


◆ Enables you to define an expression.


If you add a wildcard character to an expression, the Helper button is disabled. 
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The red X button deletes a specific filter criterion.


At the bottom of the dialog box are the following buttons: OK, Cancel, and Refresh. To 
apply your filter and exit the dialog box, click OK. Click Cancel to exit without applying your 
changes. Refresh resets the Filter Builder dialog box to its original or previously applied 
filter criteria.


“Notification Log columns” on page 59 includes descriptions of notification attributes. 
Appendix A, “Wildcard Patterns,” includes a list of wildcards.


Pattern matching
When you create a filter, you can specify as many attribute-value pairs as you want. Each 
pair is a filter criterion. There is one filter per view. See Figure 11 on page 74 for an 
example.


To pass a filter, notifications must satisfy all conditions in at least one Sheet tab:


◆ In a Sheet tab, criteria are related to one another with a logical operator AND. To 
satisfy a given tab, notifications must satisfy all conditions specified in the tab. 


◆ Individual Sheet tabs are related to one another with a logical operator OR. 
Notifications must satisfy the conditions in at least one tab.


IsA (“is child class of”) filter option
The IsA filter option, displayed as is child of, only appears for notification attributes that 
have a class name for their value, including: Class, ClassName, and ElementClass.


To create an IsA filter for one of these notification attributes, select the class and the is 
child of option from the menus. To apply your filter and exit the dialog box, click OK. 


The Notification Log Console then displays only the notifications for instances of the 
specified class and all of its subclasses.


Only a single class name, without any wildcard characters of any kind, may be specified 
for an IsA filter.
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Example of a filter
To display only critical notifications for Down events for a router or a host that impact your 
business operations, specify: 


◆ A value of 1 for Severity, Down for Event


◆ A value of "~0" (not zero) for Impact, and any router or host


Figure 11  Filter Builder dialog box
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CHAPTER 4
Examining Topology


Service Assurance abstracts topological information from Managers and third-party 
applications. As you monitor your managed domain, you might need to examine your 
topology. The Topology Browser Console displays the topology of any attached Manager.


“Global Console overview” on page 20 includes descriptions of console layout and 
available menus.


This chapter contains the following information:


◆ Accessing topology .................................................................................................  76
◆ Available topological information and its representation .........................................  76
◆ Topology Browser Console or view...........................................................................  77
◆ Finding an instance or device ..................................................................................  80
◆ Using the Containment dialog box...........................................................................  81
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Accessing topology
This section describes alternative methods for accessing topological information.


Once any console is opened, there are alternative methods for accessing topological 
information:


◆ Add a Topology Browser view to any existing console. Chapter 9, “Customizing Your 
Console,” includes information about views and adding views.


The Topology Browser is not available as a dashboard viewlet. However, topology can 
be examined in the Business Dashboard, for example, by right-clicking a notification 
or map node, and selecting Browse or Browse Detail, or by clicking the Browse button 
in a Notification Properties or Containment view. These actions open an additional 
topology browsing window. 


◆ Browse opens the Topology Browser view in a secondary window to access topological 
information. Browse is available as a button in most secondary windows and dialog 
boxes or as an Event option in the menu for selected notifications. For example, the 
Browse button appears in the Notification Properties dialog box and the Find Instance 
dialog box. (The button is activated when you select a row in the table.)


◆ The Browse Detail option under Event menu opens the Topology Browser view with 
topology from an underlying Manager in a secondary window. 


◆ The Containment dialog box displays information and components for a selected 
element. “Using the Containment dialog box” on page 81 includes additional 
information.


Available topological information and its representation
For most situations, the Topology Browser Console and Map Console provide the most 
complete representations of your topology. 


There are different kinds of topological information. For example:


◆ Devices, logical groups such as IP networks and VLANs, and other infrastructure 
elements (such as network connections) that compose the domains managed by 
underlying Managers.


◆ User-defined groups of elements (configured by your administrator).


◆ Business elements such as application services, service offerings (such as Web 
hosting contracts), and service subscribers (such as customers, business units, or 
corporations). Service information and service classes may not be available for your 
site.


Topology is represented in a tree format as in the map tree and the Topology Browser 
Console or by map icons in a map.


Chapter 5, “Examining Maps,” includes information about the Map Console, including 
how maps represent topological information and map color-coding.
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Topology Browser Console or view
The Topology Browser (console, view, or secondary window) presents the topology of any 
Manager as a topology tree. Operators can view the topology of any attached Manager by 
selecting it from the Manager list box.


Displaying topology 


To display an expanded topology tree in the left panel, you need to select a Manager from 
the Manager menu above the left panel.


A plus (+) sign indicates unexpanded objects. (On some systems, an open circle appears 
instead of a plus sign.)


If you already used the Browse option, the Manager icon is already expanded beginning 
with the class of your selection. 


To navigate the topology tree:


1. Click the plus sign next to a class to view its elements (instances). 


2. Click an element in the topology tree to display tabs of information in the right panel.


3. Click the plus sign next to an element to display its relationships. 


4. Click the plus sign next to a relationship to display classes of related elements. 


5. Click the plus sign next to a related class to display the related instances.


To refresh the contents of a topology tree, right-click in the background area and select 
Refresh Tree from the shortcut menu. Then, expand the tree.


For each object you select, a corresponding property sheet with one or more tabs is also 
displayed:


◆ For an Manager, the Modules and Threads tabs provide information about models, 
programs, and process threads. For a Domain Manager, the Correlation tab also 
displays and provides correlation information such as the correlation interval.


◆ For classes, the Description and Attributes tabs describe the class and its attributes.


◆ For elements (instances):


• Attributes tab lists the attribute names, data types, values, and descriptions of the 
attributes. 


• Groups tab displays groups if the instances belong to any groups. 


• (Global Manager only) The Events tab displays notifications if they are generated. 
The Events tab does not display for a selected element of a Domain Manager.


If your user ID has the required authorization, for elements of a selected Domain 
Manager, you can modify attribute values. Double-click in the Value column, modify 
the value, and select Apply.
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In the Topology Browser, an individual object with a plus (+) sign does not open or expand 
if a class exceeds 1,000 instances. Instead, a node displays, reporting that there are more 
than 1,000 instances. This limit can be changed by specifying the 
com.smarts.maxTopoInstances property during console startup. Chapter 9, “Customizing 
Your Console,” provides detailed information on tailoring console properties. 


Select Edit > Find Instances to find an individual instance and display related topology. 
(“Finding an instance or device” on page 80 includes additional information.) 


Also, the tool tip displays the correct number of instances. To activate the tool tip, hold the 
cursor over the object you wish to expand.


Browse Detail 


The Browse Detail menu option is available:


◆ In the shortcut menu of the Topology Browser Console. Right-click a selected element 
in the tree and select Browse Detail in the menu.


◆ In the Event menu or the shortcut menu of the Notification Log Console. Right-click a 
selected notification and select Browse Detail in the menu.


◆ In a map. Right-click a node or an edge and select Browse Detail in the shortcut menu.


Browse Detail provides a submenu that lists all of the underlying Managers that contain 
the selected element in their topology. You can select one of the underlying sources and 
display it in a Topology Browser view. Figure 12 on page 78 shows an example.


Figure 12  Browse Detail example


If the underlying Manager is not attached to the console, the console establishes a 
connection automatically with your login ID. If this is not possible, you might be prompted 
to supply another EMC Smarts username and password. 
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If the selected element does not have any underlying sources, Browse Detail is disabled. 
Also, Browse Detail is not available for notifications generated by non-EMC Smarts 
sources such as third-party adapters.


For hierarchical Service Assurance deployments, you can select Browse Detail as many 
times as necessary to navigate to the desired Manager. 


Filtering topology


The topology filter enables you to control which classes and specific instances appear in 
the Topology Browser. You can specify a filter for each attached Manager and create a 
general filter for attached Managers that are not assigned filters. Filter criteria are saved if 
you save your consoles.


To specify filtering criteria:


1. Right-click in the topology tree panel. 


2. In the shortcut menu, select Select to display the Select tree content dialog box.


3. In the Select tree content dialog box, you can:


• Select All attached domains to apply the filter to all attached Managers.


• Select Current domain to apply the filter to the selected Manager.


• Display all the classes including classes without instances. Select the Show 
classes with no instances checkbox.


• Display one or more specific classes. Select the class. To select multiple classes, 
press the Ctrl key while making your selections.


• If you select classes that have instances, you can also select specific instances.


4. To make your changes take effect, you must click OK.


To undo filter changes:


1. Display the Select tree content dialog box.


2. Clear the Include only selected classes checkbox.


3. Click OK. 


To make additional changes, right-click and choose Select again. When the tree is 
expanded, you can select and right-click an instance and select the Make Root menu 
option. This will refresh the tree to list the selected instance as root. To return the display 
to the entire tree, right-click in the tree’s background and choose Select again.
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Finding an instance or device
If you need to locate an element by name, class, or IP address, use one of the following 
search tools. For example, if the class exceeds 1,000 elements and the Topology Browser 
does not expand, you can select the class in the Find Instance search tool to list all of its 
instances. After you receive search results, you can open the Topology Browser for 
topological information about the element, examine components of the element with the 
Containment dialog box, or display a map of it using Show Map.


In the consoles, the Edit menu lists the options, Find Instance and Find System:


◆ Use Find Instance to locate any topological element including application services, 
service offerings, service subscribers, and systems.


◆ Use Find System to locate systems or devices like routers and switches.


Finding an instance
To search for an instance:


1. Select Edit > Find Instance in your console. The Find Instance dialog box displays.


2. Fill in the fields, as described below. The fields are:


• Manager lists the Managers to search. Select one.


• Classes is a list of classes to search. You must select one or more classes. (To 
select multiple classes, press the Ctrl or Shift key while making your selections.)


• Instance name is the instance you want to find. You can specify a complete name, 
a partial name with wildcard characters, or the asterisk (*) wildcard if the name is 
unknown and you wish to search for all instances. Appendix A, “Wildcard 
Patterns,” includes a list of wildcards.


3. Click Find to start the search. The results display in a table.


The Find Instance dialog box limits the number of "matches" that display. If more than the 
limit number of matches is returned, a message displays asking you to refine your search.


The maximum number of instances that can display defaults to 1000 unless you configure 
the -Dcom.smarts.maxTopoInstances parameter to display more than 1000. The 
-Dcom.smarts.maxTopoInstances parameter limits the number of instances that are 
displayed in a topology tree. A new parameter, -Dcom.smarts.maxFindInstances, when 
configured, can override the -Dcom.smarts.maxTopoInstances parameter, for example, 
you can configure the value of the maxTopoInstances parameter to be a value of 3000 and 
the value for the maxFindInstances parameter to be a value of 500.


The value for the FindInstances parameter is not the number of instances searched, but 
the number of matches to be displayed. If the maxTopoInstances parameter is configured 
with a value of 100, the FindInstances parameter can still return matches for a class with 
150,000 instances, provided there are less than 100 "matches" for the search string 
among the 150,000 instances.
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Finding a system
To search for a system:


1. Select Edit > Find System in your console. The Find System dialog box displays.


2. Fill in the fields, as described below. The fields are:


• Manager lists the Managers to search. Select one.


• System name or IP Address to find lists the device or IP address you want to find. 
Specify the device name (for example, moto-gw), a complete name (for example, 
moto-gw.smarts.com), or an IP address. 


Wildcard characters are not permitted.


3. Click Find to start the search. 


If the server takes a significant amount of time searching for the specified system, the 
Find button is disabled until the server returns the search results. During this time you 
can perform additional console operations. 


Search results
After the search results display in the table, you can sort them by clicking one of the 
column headings. You can also select one of the table rows and click one of the buttons 
located at the bottom of the dialog box. The available buttons are:


◆ Browse – Click this button to display the Topology Browser for the instance.


◆ Containment – Click this button to display a Containment dialog box of the instance.


◆ Show Map – Click this button to display the instance in the Map Console.


◆ Close – Click this button to exit the dialog box.


Using the Containment dialog box
The Containment dialog box displays information about an element’s containment in 
tabular format. It provides information and components for a selected element. For 
example, for a selected port or interface, the Network Adapters tab displays its status, 
mode, current utilization, and the name of a peer network adapter. 


Containment is not available for user-defined groups and services.


Several methods exist to display a Containment dialog box. For example, you can display 
containment information in either a dialog box or a view. To do so, you can:


◆ From the map tree, select an instance in the map tree, right-click and select 
Containment in the shortcut menu.


◆ In a map, right-click a node and select Containment in the shortcut menu. For a normal 
(status color green) node, double-click it to display the dialog box.


◆ From Find Instance or Find System dialog boxes, click Containment.
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◆ In the Event menu or the shortcut menu, right-click a selected notification and select 
Containment in the menu.


◆ In the shortcut menu of the Topology Browser Console, right-click a selected element 
in the tree and select Containment in the menu.


◆ Add a Containment view using View > Add View. This view is context-sensitive, and can 
show containment information for the currently selected element in a different view in 
the same console, for example, if you select a notification in a Notification View in the 
same console.


If the server takes a significant amount of time to respond to a containment request, 
the Containment window displays the Getting data from ... message until the server 
returns the data. During this time, you can perform additional console operations.


In the Containment dialog box, information is organized using tabs. Each tab consists of a 
table. Depending upon the type of element and the type of analysis being performed by 
the underlying domain, different information is available.


For example, if EMC Smarts IP Performance Manager is enabled on the underlying Domain 
Manager, then tabs for memory, processor, and environment display. If IP Performance 
Manager is not enabled, the tabs do not display or specific columns such as 
CurrentUtilization appear blank. 


The following buttons are available: Refresh, Browse, Save Table, and Close. The Save 
Table button saves the contents of a selected tab locally as a text file. (“Saving audit log 
and containment information” on page 142 includes additional information.)


Containment dialog box example
Figure 13 on page 82 shows an example of a Containment dialog box for router moto-gw. 


Figure 13  Containment dialog box
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CHAPTER 5
Examining Maps


A map provides a graphical representation of your topology and, by default, is updated 
continuously. As you monitor your managed domain, you might need to examine the 
elements of your maps and investigate the active events that affect them. 


“Global Console overview” on page 20 includes descriptions of console layout and 
available menus.


This chapter contains the following information:


◆ Accessing maps ......................................................................................................  84
◆ Available topological information and its representation .........................................  85
◆ Representing notifications in maps .........................................................................  88
◆ Types of maps.........................................................................................................  90
◆ Adjusting the appearance of a map .........................................................................  94
◆ Customizing map backgrounds ...............................................................................  96
◆ Viewing large maps: Overview window ....................................................................  98
◆ Filtering maps .........................................................................................................  99
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Accessing maps
This section describes alternative methods for accessing individual maps and how to 
navigate among maps.


In addition to the different methods for opening available consoles (Chapter 2, “Starting a 
Session,”), you can access a map using the Show Map option from any existing console. 
Show Map functionality opens the Map Console and displays the default map for the 
selected element. Show Map is available as a button in some secondary windows and 
dialog boxes or as a menu option for selected notifications. For example:


◆ The Show Map button appears in the Find Instance and Find System dialog boxes. 
(The button is activated when you select a row in the table.)


◆ The Show Map option appears in the Event menu or the shortcut menu if you 
right-click on a selected notification.


◆ Use the Show Map button on the toolbar to display a default type of map for a 
selected summary. Show Map is enabled if a topological filter is specified for the 
summary. “Filtering summaries” on page 108 contains additional information.


If the Map Console is open, these options display the selected map in the currently 
open Map Console. A second Map Console does not open.


Opening a map


When you open a Map Console, you need to select a Global Manager from the Manager 
menu to display an expanded map tree in the Topology tab of the left panel. In a tree, a 
plus (+) sign indicates that the object or class can be expanded. (On some systems, an 
open circle appears instead of a plus sign.)


The Groups tab in the left panel displays a tree of user-defined groups for topological 
elements if groups exist. 


Different types of maps are available for the instances in each tab.


If relevant topological information is not available for a selected instance, a message 
appears, stating that a map is not available.


To open a map in either tab:


1. Select a Global Manager from the Manager menu to display an expanded map tree in 
the Topology tab.


Or, click the plus sign next to a group in the Groups tab:


• For a class in the Topology tab, you can view its elements (instances). 


• For a group in the Groups tab, you can view its subgroups.


2. For the default type of map, you can click an instance in the map tree. Or, right-click an 
instance and select the type of map you want to display from the shortcut menu. The 
map appears in the right panel.
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Also, you can right-click an icon in the existing map and select another type of map from 
the shortcut menu. 


If a saved map of a given map type exists for the selected element, it is displayed. “Saving 
a map” on page 143 includes additional information.


To display more than one map concurrently, right-click a node in an existing map. Then, 
select Map Window from the shortcut menu. Select a map type in the submenu. A 
secondary window displays the additional map. 


Navigating among maps


To navigate between multiple maps, the Map Console provides several navigation 
methods:


◆ The map tree — Select an element in the map tree to display the default type of map. 
Or, you can select an element in the tree, right-click, and select another type of map 
from the shortcut menu.


◆ A node in a map — Right-click a node in an existing map and select another map type 
from the submenu. 


◆ A history field list box — Lists the current map (instance and map type) and other 
recently viewed maps. To re-display a map, select it from the history field list box 
located in the top border of the Map Console.


◆ Previous and Next toolbar buttons — Enables you to move quickly between maps.


◆ Multiple windows of maps — Opens additional windows to concurrently display maps 
of your selected node. To do so, right-click a selected node in a map, select Map 
Window, and choose a map type.


Available topological information and its representation
The Map Console is designed especially to display information about a managed topology 
using a variety of map types. For example, the VLAN Connectivity map reveals the 
connections to a VLAN and the VLAN Membership map reveals the members of a VLAN.


You can broaden the scope of the map by expanding nodes and incrementing map hops to 
reveal additional relationships.


Map scope


For most maps, a map is centered around a selected node (for example, a device, IP 
network, VLAN, or service) and shows connections to the selected entity (one hop away). 
You can change the scope of the elements displayed in the map to see additional 
connected elements by incrementing the number of hops. You can expand an entire map, 
one or more individual devices, or a service one increment at a time. A hop is the distance 
between two nodes that are either physically or logically connected.
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◆ For an entire map, the scope of a map is defined by the number of hops from the focal 
object (boxed icon). Each time you select the Increment Hops option, a map expands 
by adding all nodes (and their edges) that are one hop away from any existing, 
expandable node.


◆ For individual devices, when you select a device and use the Expand Map Element 
option, a map expands by adding all nodes (and their edges) that are one hop away 
from the selected device. (You can select more than one individual device by pressing 
the Ctrl key while you use the Expand Map Element option.)


◆ For Storage Insight NAS and SAN Connectivity maps, when you select an edge with a 
plus sign (+) and use the Expand Map Element option, the edge expands by one hop.


Using the Expand Map Element option and the Increment Hops or Decrement Hops 
options together may result in unexpected behavior. To avoid this, use the Reset Map 
option after the Expand Map Element option but before you use the Increment Hops or 
Decrement Hops option.


The options Increment Hops, Decrement Hops, and Expand Map Element are not available 
for IP Network Membership, VLAN Membership, IP Network Physical Connectivity, VLAN 
Physical Connectivity, and any type of Group map. The scope of these maps always 
includes the set of devices in the selected IP network, VLAN, or group.


Applications and Business Services maps support the Expand Map Element option, but 
not Increment Hops.


Common map attributes


The following attributes, classified by entity, are common to all maps:


◆ Nodes — A node represents a device, IP network, VLAN instance, service subscriber, 
service offering, an application, or a user-defined group. The icon used to depict a 
node depends on the class of the instance. A severity icon bar underneath a node is 
colored to indicate that its state is normal, affected by one or more abnormal 
conditions, or unknown. A plus sign (+) next to a node indicates that it is connected to 
additional nodes not currently shown in the map. A box outlining a node indicates 
that the node is a map focal node. One or more nodes compose a map. You can 
incrementally expand the scope of the map to show the additional nodes connected 
to devices.


The com.smarts.map.showNormalBanner property determines whether normal map 
nodes display a green banner. The default value for this property is false, no banner is 
shown under normal nodes. If the node can be expanded, a small green + displays at 
the right side of the node. Setting the com.smarts.map.showNormalBanner property 
to true displays a full-width green banner below each normal map node. Chapter 9, 
“Customizing Your Console,” provides detailed console-property information.


◆ Edges — An edge represents a relationship or connection between nodes (for 
example, a physical connection such as a cable on a Physical Connectivity map), or 
participation in a logical group (for example, routers participating in a VLAN for a VLAN 
Connectivity map). The representation depends on the type of map. An edge that 
represents a topological instance is colored to indicate its status (for example, green 
for Normal). If an edge represents a relationship, it is colored black.
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Tool tips in maps


To activate a tool tip, hold the cursor over the object. A tool tip provides the following 
information for the following map icons: 


◆ A device (node). Tool tip lists the device’s name, model, location, contact, and 
description.


◆ An IP network (node). Tool tip lists the number of devices, by type, that are member 
systems of the IP network.


◆ A VLAN (node). Tool tip lists the number of devices, by type, that are member systems 
of the VLAN.


◆ A group (node). Tool tip lists the group’s name, number of individual members, and 
number of subgroups.


◆ A service (node):


• Software service. Tool tip lists the software service’s name, the device that hosts it, 
and a description. 


• Software service redundancy group. Tool tip lists the class and name of the object. 


• Service subscriber. Tool tip lists the service subscriber’s name and number of 
service offerings. 


• Service offering. Tool tip lists the service offering’s name and number of service 
subscribers.


◆ Edges:


• Physical connectivity or network connection. Tool tip lists interface and port 
endpoint information.


• All other map edges. Tool tip lists the object’s name at each endpoint.


Tool tip information for edges in Group maps is not available.


For example, a Physical Connectivity map containing routers, switches, and their 
physical connections, the tool tip displays:


• For each router and switch, the device’s name, model, location, contact, and 
description.


• For the physical connections, the interface or port number at each end of the 
connection.
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Representing notifications in maps 
In a map, the icons (nodes and edges) reflect the collective state of active events on an 
object. 


Understanding color coding and icons


Similar to notifications in the Notification Log Console, the map uses color to indicate that 
elements are affected by one or more abnormal conditions. A color-coded severity bar 
indicates the state of the node. 


The color-coded severity bar is not displayed for nodes whose state is normal, unless the 
com.smarts.map.showNormalBanner property is set to true.


The notification list configured by your administrator determines which notifications are 
reflected in your Map Console. If the notification list does not include an event, 
notifications for the event will not be reflected in the map icons. For example, if a 
notification list excludes all events from a specific router, the router always appears with a 
normal state in the map. If your Map Console does not accurately reflect observed 
conditions, contact your administrator.


Table 16 on page 88 summarizes the colors that display in a map. 


In an IP Network map, the node for an IP network is always normal, even if the network is 
inaccessible. 


Table 16  Colors and meanings


Condition
Severity icon (nodes 
only) Color (nodes and edges)


Critical event Red 


Major event Orange 


Minor event Yellow 


Unknown Light blue


Normal/okay Green 


Notice: The severity icon does not display for edges. However, the color of an 
edge is meaningful, as follows:


• Edges that represent topology instances are color-coded to reflect status.
• Edges that represent relationships such as VLAN Membership and IP 


Network Membership are colored black. 
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By default, the Normal status indicator is not displayed. However, you can change the 
setting that controls this display by setting the com.smarts.map.showNormalBanner to 
true. “Command syntax for the -D option” on page 151 contains additional information.


To view the icons and other visual indicators used in maps, select Map > Map Legend. 


Your administrator can configure custom map icons to represent map elements. The EMC 
Smarts Service Assurance Manager Configuration Guide contains additional information.


Displaying notification and topological information


To display detailed diagnostic information, you can:


◆ Double-click a node or group icon with a severity bar to display the Notification 
Properties dialog box. Or, right-click and select Notification Properties in the shortcut 
menu. “Displaying notification properties” on page 62 includes information about the 
Notification Properties dialog box.


If more than one notification affects the icon, you are prompted to select one. “A map 
consideration” on page 67 contains additional information.


Double-clicking a normal node (severity bar not displayed or green) displays the 
Containment dialog box if component information is available. “Using the 
Containment dialog box” on page 81 contains additional information.


◆ Right-click a selected edge (solid line or jagged line) in a Physical Connectivity, IP 
Network Connectivity, or VLAN Connectivity map. The shortcut menu lists Notification 
Properties and the Browse option for the Topology Browser.


◆ Right-click a selected node, select the Browse option, and view the colored events in 
the Events tab.
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Types of maps
The types of maps that are available depend on your license(s) and user profile. The Group 
maps need to be configured by your administrator and may not be available for your 
session. 


Network topology maps


The network topology maps and related classes are available for the IP Availability 
Manager or IP Performance Manager. 


Network topology maps contain elements such as IP networks, VLANs, routers, switches, 
and hosts, and various types of connections such as cables and trunk cables. The maps 
typically depict connectivity between elements or device membership. The EMC Smarts IP 
Availability Manager User’s Guide and the EMC Smarts IP Performance Manager and 
Server Performance Manager User’s Guide describe network topology maps in greater 
detail.


Types of network topology maps are:


◆ Physical Connectivity Map


◆ IP Network Connectivity Map


◆ IP Network Membership Map


◆ VLAN Connectivity Map


◆ VLAN Membership Map


Business Services maps


The Business Services map and related classes are available for the Business Impact 
Manager. 


Business Services maps display service subscribers (organizations, business units, lines 
of business (LOBs), departments, and customers), business processes, service offerings 
(for example, order capture, Router Services, Domain Name Service), software services 
(for example, InCharge services), redundancy groups, and related elements. The Business 
Services maps are available for infrastructure elements in the Topology tab and groups in 
the Groups tab.


The EMC Smarts Business Impact Manager User Guide describes Business Services maps.


Applications map


The Applications map and related classes are available for the Application Insight Domain 
Manager and Application Connectivity Monitor Domain Manager. 


An Applications map displays the topological elements related to the delivery of 
application services. Such elements may include the systems that host software services, 
redundancy groups, and checks. 


Applications maps are described more completely in EMC Smarts Application Insight 
documentation and EMC Smarts Application Connectivity Monitor documentation.
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Network Protocol Manager Connectivity maps


Network Protocol Manager (NPM) maps depict BGP and OSPF topologies and connectivity 
between topological elements.


Types of NPM maps are:


◆ An OSPF topology map contains elements such as OSPF areas, services, networks, 
neighbor relationships, and virtual links; and relationships and connections.


◆ A BGP topology map contains elements such as autonomous systems, BGP services, 
and BGP sessions; and relationships and connections.


◆ An EIGRP topology map contains EIGRP elements along with their relationships and 
connections.


◆ An IS-IS topology map shows the status of the IS-IS and transport network elements 
and their many relationships.


These maps are described more completely in EMC Smarts Network Protocol Manager 
documentation.


Multiprotocol Label Switching maps


Multiprotocol Label Switching (MPLS) maps depict MPLS topology. The maps might 
contain router, LSP, LSP hop, VPN, VRF, Forwarder, and PseudoWire elements, along with 
their relationships and connections. 


Types of MPLS maps are:


◆ LSP map


◆ LSP Hops map


◆ VPN map


◆ PseudoWire map


These maps are described more completely in EMC Smarts MPLS Manager 
documentation.


Storage Insight maps


Storage Insight maps depict storage network topology. The maps might contain storage 
network elements such as HostSystem and connections such as Powerpath_DataPath and 
PowerPathRedundancyGroup. 


Types of Storage Insight maps are:


◆ Storage Insight NAS Connectivity Map


◆ Storage Insight SAN Connectivity Map


These maps are described more completely in EMC Smarts Storage Insight Manager 
documentation.
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Multicast map


The Multicast map depicts multicast topology, such as instances of the MulticastService, 
MulticastGroup, MulticastTree, MulticastSource, and MulticastRedundancyGroup classes, 
and connectivity between topological elements. The maps in the Global Console show 
labels for devices with special roles within Multicast.


The type of Multicast map is Multicast Connectivity (distribution tree).


The Multicast map is described more completely in EMC Smarts Multicast Manager 
documentation.


VoIP map


For Voice Over IP (VoIP), the Applications map displays the topological elements related to 
the delivery of application services. Such elements may include the systems that host 
software services, redundancy groups, and checks. 


Group maps


A group consists of one or more infrastructure devices, IP networks, VLANs, subgroups, 
and services. Groups are created by your administrator and may not be available for your 
session. The EMC Smarts Service Assurance Manager Configuration Guide includes 
additional information on creating groups and importing data for groups.


A member can be an infrastructure device, IP network, VLAN, software service, service 
subscriber, or service offering. A member cannot be a subgroup.


A group map can display other groups (subgroups/child groups). To display the elements 
belonging to a group, double-click a selected group node. If the elements exceed 100, you 
are prompted to confirm whether to display them. 


For a high-level group, individual members not assigned to any subgroups do not display 
in a map. Members are only displayed for groups that do not have subgroups.


The group node is colored to indicate that its state is normal, affected by one or more 
abnormal conditions, or unknown. The color is determined by the highest severity 
condition affecting the elements of the group. For example, if an element is experiencing a 
critical failure, the status bar is colored red. Edges for groups do not change colors.


In a Connectivity group map, one solid line edge represents aggregated relationships. 
Elements of one group have one or more connections with elements of another group.


Types of group maps are:


◆ Group Physical Connectivity map. This map displays physical connectivity between 
group elements. The solid line edges between groups represent one or more physical 
connections between elements of different groups. The edges do not change colors to 
reflect their state. The number of hops cannot be changed.


◆ Group IP Network Connectivity map. In this map, an edge between two groups 
indicates that there are one or more IP networks common to the two groups. The 
group icon containing the IP network is displayed; an IP network icon is not displayed. 
The number of hops cannot be changed.
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◆ Group VLAN Connectivity map. In this map, an edge between two groups indicates that 
there are one or more VLANs common to the two groups. The group icon containing 
the VLAN is displayed; the VLAN icon is not displayed. The number of hops cannot be 
changed.


◆ Group Membership map. This map displays all of the elements of a selected group or 
a subgroup. The edges do not display. The concept of a hop is not applicable.


Group IPNetwork Connectivity map example
To display a Group IPNetwork Connectivity map:


1. Open the Map Console.


2. Select a group in the Groups tab.


3. Right-click and select Group IPNetwork Connectivity in the shortcut menu. The map 
displays.


Figure 14 on page 93 shows a Group IPNetwork Connectivity map for the group USA. 
Within the USA group, the subgroups have devices that share common IP networks. Notice 
that two subgroups, Denver and Boston, are orange, indicating serious (major) conditions.


Figure 14  Group IP Network Connectivity map
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Adjusting the appearance of a map
Several methods exist to adjust or fine-tune the appearance of your map. You can:


◆ Change the layout from circular to hierarchical. Right-click in the map and select 
Hierarchical Layout from the shortcut menu. Objects in your map are rearranged and 
the layout indicator changes accordingly.


◆ Change the layout from circular to orthogonal. Right-click in the map and select 
Orthogonal Layout from the shortcut menu. Objects in your map are rearranged and 
the layout indicator changes accordingly.


◆ Change the layout to manual. Right-click in the map and select Manual Layout from 
the shortcut menu. The initial positions of existing nodes are retained. (This option is 
especially useful for large, complex maps.) 


In manual layout, any new nodes or edges that appear later due to topology changes, 
the Expand Map Element option, or Increment Hops, display in the lower-left area of 
the map. You can drag them from the center to new positions that will be maintained 
as long as the layout type is manual. 


When elements on a map are removed from the topology, their corresponding 
representation on the map is also removed. When you view the map in Manual Layout, 
the remaining map elements are not repositioned. 


If you change the manual layout to circular or hierarchical, all manual positions are 
lost. If you save a map with manual layout, the positions are saved. To return to the 
map’s default layout or to its layout when last saved, select Map > Reset Map (this 
resets all map attributes). A layout indicator at the top of the right panel identifies the 
layout of a selected map.


◆ For a MPLS VPN map, change the layout based on internal logic. Right-click in the map 
and select Organize from the shortcut menu. 


◆ For NPM maps, enable the display of labels for routers. Right-click in the map and 
select Node Labels from the shortcut menu.


◆ Move or reposition individual nodes in the map by dragging them. 


To select multiple nodes, press Ctrl while making your selections.


◆ Enlarge the right panel and hide the map tree. To do so, click the left arrowhead on the 
panel divider. To display the map tree again, click the right arrowhead.


◆ Scale the entire map to fit the right panel of the Map Console. 
Right-click in the map and select Fit to Window from the shortcut menu.


◆ Magnify or shrink a map with Zoom or Overview toolbar buttons. 


◆ Increase or decrease the scope of your map by one increment at a time. This adds new 
nodes to or subtracts nodes from an existing map. 


Right-click in the map and select Increment Hops or Decrement Hops from the shortcut 
menu.

94 EMC Smarts Service Assurance Manager Operator Guide







Examining Maps

◆ Expand a selected node with the plus sign to increase the scope for it. Right-click the 
node and select Expand Map Element from the shortcut menu. This adds new nodes 
connected to the selected node.


To select multiple nodes, press Ctrl while making your selections and continue to 
press the Ctrl key when you select Expand Map Element.


Using the Expand Map Element option and the Increment Hops or Decrement Hops 
options together may result in unexpected behavior. To avoid this, use the Reset Map 
option after the Expand Map Element option but before you use the Increment Hops 
or Decrement Hops option.


◆ Add and remove classes using a filter. “Filtering maps” on page 99 contains additional 
information.


◆ Color only map objects experiencing root-cause events (IsRoot = Yes). Click the 
Color-by-Root-Cause toolbar button (tool tip labeled Toggle Root Cause Coloring). Map 
objects without root-cause events turn gray. Map objects with root-cause events are 
colored based only on the severity of the root-cause events.


The Color-by-Root-Cause indicator, at the top of the right panel, indicates when this 
option is enabled. This option remains enabled for all maps until you click the toolbar 
button again. 


For example, a router with two events—a non-root event (IsRoot = No) with severity 1 
and a root-cause event (IsRoot = Yes) with severity 2—is colored red. It is colored to 
reflect the collective state of the active events and, in this case, the most critical 
severity is 1 (red). If you click the Color-by-Root-Cause toolbar button, the router 
changes from red to orange, because the lone root-cause event has a severity 2.


◆ Specify a user-defined background. “Customizing map backgrounds” on page 96 
contains additional information.


To undo your adjustments, including those made by a filter, and reset the map back to its 
original layout, select Map > Reset Map.


“Saving a map” on page 143 contains additional information.


“Navigating among maps” on page 85 describes several navigation methods.


Chapter 9, “Customizing Your Console,” contains additional information on creating a 
customized console.
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Customizing map backgrounds
You can change the map background color and use custom background images.


Map background colors


By default, different kinds of maps are displayed with different color backgrounds. 
Table 17 on page 96 shows the default map background colors. 


You can set a parameter, com.smarts.mapBackgroundColor, to customize the background 
color. When the com.smarts.mapBackgroundColor property is specified, all maps display 
the specified background color. When a map is saved, the background color is not 
included in the saved information. “Command syntax for the -D option” on page 151 
contains additional information.


Creating custom backgrounds


You can create and install custom map backgrounds using your own images. Examples 
may include geographic maps, where map nodes are placed over the regions they serve, 
or organizational charts, where map nodes are placed over the organizational 
departments they serve.


Custom background requirements
Ensure that the map background file meets the following requirements:


◆ Required file format— Must be .gif format. 


The map background filename must be saved with the .gif extension. The .gif 
extension must be in lowercase. If the filename for your map background file is .GIF, 
save the file as .gif. To save the map background file with the .jpg extension, set the 
smarts.allowBGjpegs property to true. “Command syntax for the -D option” on 
page 151 provides additional information.


Table 17  Default map background colors


Background color Type of map


Light blue background Physical Connectivity and Group Physical Connectivity 
maps


Light yellow background IP Connectivity and Group IP Connectivity maps


Light green background VLAN Connectivity and Group VLAN Connectivity maps


Beige background IP Membership, VLAN Membership, and Group 
Membership maps 


Yellow background Business Services maps


Purple background Applications maps
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◆ Image size — Must be no larger than 1500 pixels high or 2000 pixels wide. 


◆ Image file location — Store the graphic file in the 
BASEDIR/smarts/local/images/<background directory> where, <background directory> 
is the host where the Global Manager is running. 


Adding a custom background
To add a custom map background, do the following:


1. Set the Map Console to Manual Layout (as opposed to Hierarchical, Circular, or 
Orthogonal Layout): Right-click the map and select Manual Layout from the shortcut 
menu. 


Setting the map to Manual Layout ensures that the position of map elements will not 
change in regard to one another or to their position on the map background. In 
addition, with Manual Layout, the Global Console automatically centers the map 
background within the map window.


2. Right-click the map and select Set Background from the shortcut menu. 


The Set Map Background dialog box displays that shows thumbnails of the map 
background images available in the BASEDIR/smarts/local/images/<background 
directory> where, <background directory> is the host where the Global Manager is 
running. 


3. In the Set Map Background dialog box, select an image, adjust the image size using 
the controls at the bottom of the dialog box, and then click OK. You can also click 
Apply to preview the map. 


The Global Console loads the image so that it is centered over the minimum 
rectangular bounding box that includes all of the map nodes.


4. After the map is loaded, you can move the map nodes to the appropriate locations on 
the background image. 


If you repositioned the nodes, right-click the map and select Fit in Window from the 
shortcut menu.


5. Save the map. When a saved map is opened, map nodes retain their position. “Saving 
a map” on page 143 contains additional information.


Removing a custom background
To remove a custom background and return to the default background:


1. Open the Set Map Background dialog box. 


2. Select No background image from the Map Background File list box.


3. Click OK.
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Viewing large maps: Overview window
The Overview window displays the entire contents of the map currently being viewed in 
the right panel as in Figure 15 on page 98. This feature is useful for viewing precise areas 
of a large map. 


To magnify areas in your map:


1. Click the Overview toolbar button or select Map > Overview.


2. Click and drag the pointer to outline a small rectangular area. This area is then 
magnified and displayed in the right panel. 


To resize the rectangle, click and drag its borders in the Overview window. The smaller 
you make the rectangle, the more magnified the view becomes in the right panel.


You can also move the rectangle to a new area as well, by clicking and dragging it. As 
the rectangle is moved, the view in the right panel changes accordingly. 


Figure 15  Map Console with Overview window
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Filtering maps
The map filter enables you to control which classes of instances appear in a specific map. 
You can remove classes of devices (systems) and logical groups and add them back again. 
Filter criteria are saved if you save your maps. “Saving a map” on page 143 includes 
additional information.


You can also filter a map by root cause. “Adjusting the appearance of a map” on page 94 
includes additional information.


Removing a class
To remove one or more classes:


1. Select Map > Edit Map Filter in the Map Console. The Map Filter dialog box displays.


2. Select a class from the Included Classes list.


3. Click Remove. The class is moved to the Filtered Classes list.


To remove another class, repeat step 2.


4. After the last selection, click OK.


Adding a class
To add one or more classes:


1. Select Map > Edit Map Filter in the Map Console.


2. Select a class from the Filtered Classes list.


3. Click Add. The class is moved to the Included Classes list.


To add another class, repeat step 2.


4. After the last selection, click OK.
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CHAPTER 6
Examining Summaries


The Summary View Console provides a graphical overview of notifications, alarmed 
elements, and business impact instances. By default, a summary is updated continuously. 
As you monitor your managed domain, you might need more information about a specific 
summary or to investigate the attributes that compose it. You may also need to add new 
summaries or modify existing ones.


“Global Console overview” on page 20 contains descriptions of console layout and 
available menus.


This chapter contains the following information:


◆ Accessing summary information............................................................................  102
◆ About summaries..................................................................................................  103
◆ Adjusting the contents of a Summary view ............................................................  104

Examining Summaries 101







Examining Summaries

Accessing summary information
This section describes another method to access summary information and how to 
navigate between a summary and its notifications or its default map.


In addition to the different methods for opening available consoles (Chapter 2, “Starting a 
Session,”), you can add a Summary view to any existing console to access summary 
information. (Chapter 9, “Customizing Your Console,” includes information about views 
and adding views.) 


To navigate between an individual summary and its corresponding Notification Log view:


1. Right-click the summary and select Show Notifications in the shortcut menu. Or, for 
the selected summary, click Summary > Show Notifications or the Show Notifications 
toolbar button. 


The Notification Log view for the selected summary displays in a secondary window. 


2. To return to the Summary view, click Close in the Notification Log view.


To navigate between an individual summary and its corresponding default map:


1. Right-click the summary and select Show Map in the shortcut menu. The default type 
of map for the selected summary displays in a secondary window. 


2. To return to the Summary view, click Close.


Show Map is enabled if a topological filter is specified for the summary. “Topology 
Filter dialog box” on page 108 includes additional information.
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About summaries
A summary provides a graphical overview (bar chart or pie chart) of notifications from one 
source, a Global Manager. A Summary view can contain several summaries attached to 
either the same Global Manager or to different Global Managers. 


Summaries can represent notifications for infrastructure elements and collection objects 
(ServiceOffering, ServiceSubscriber, or any group created by your administrator), 
organized in some meaningful way. The content is determined by summary parameters 
and, optionally, a filter. “Adjusting the contents of a Summary view” on page 104 includes 
information on summary parameters. “Filtering summaries” on page 108 includes 
additional information on filters.


When you are interpreting summaries, you should be aware of the different components of 
a summary and the information they represent. 


Summary components


A summary view is a graphical display of information in either a horizontal bar chart or a 
pie chart. The chart represents the number (horizontal bar chart) or percentage (pie chart) 
of counted items (notifications, alarmed elements, or impacts). For example, a chart might 
show the number of Notifications categorized by severity level, or the number of 
Notifications that have been acknowledged. “Displaying all elements by severity” on 
page 106 includes additional information on displaying elements by severity levels.


A summary includes the summary title, which is the user-configurable display name of the 
summary. The default title of a summary is the name of the group, service offering, 
subscriber, or Notification Log. In addition, the summary identifies the Global Manager 
that is the source of the summary information.


The summary represents the counts by numeric values (labels) and visually by horizontal 
bars or sections of a pie. 


If the criterion is Severity, the colors of the horizontal bars correspond to those in the 
Notification Log legend; otherwise, the colors are not significant. 


In a horizontal-bar chart, the labels are displayed as a vertical list along the left side of the 
bars, while the counts for each category are displayed horizontally across the bottom. In a 
pie chart, the sections represent the percentage of each category, with a legend indicating 
the category criteria.


To display the count or the percentage information in a tool tip, hold your cursor over a 
horizontal bar or pie section. 


“Modifying a new summary or an existing one” on page 105 includes instructions about 
changing the contents of a summary (for example, its title, counted elements, or criterion).
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Unavailable (gray) content
Sometimes, the contents of a summary turn gray. This occurs if: 


◆ The Global Console disconnects from the Global Manager. When the connection is 
re-established, the affected summaries in the Summary view are automatically 
recounted and displayed.


◆ A collection object specified for a summary’s topological filter is removed from the 
topology.


Calculation notes


Depending on the summary, when a counted item (an affected element, an event, or 
impact value) matches more than one value of the criterion, the sum of the detailed 
counts might exceed the totals. For example, if affected devices are counted by instance 
name such as RouterCore*, Router*, and Switch*, the detailed counts might exceed the 
number of affected devices in the total count because, for example, any instance name 
that matches RouterCore will also match Router, and will therefore be counted twice.


How percentages are calculated
To display percentages or total count, use a tool tip. Hold your cursor over a horizontal bar 
or pie section.


Percentages are calculated as follows:


◆ For counted elements, the percentage is the number of elements experiencing events 
for a given value of the criterion, divided by the total number of elements in the 
summary.


For example, for elements counted by the criterion severity, 12 (14 percent) for the 
value Critical indicates that 12 elements have critical events. This represents 14 
percent of 83 elements in a summary.


◆ For counted notifications, the percentage is the number of events for a given value of 
the criterion, divided by the total number of events in the summary. 


◆ For counted impact, the percentage is the sum of the impacts for all events for a given 
value of the criterion, divided by the sum of the impacts for all events in the summary. 


Adjusting the contents of a Summary view
Several methods exist to adjust the appearance of your Summary view. You can:


◆ Modify a new or an existing summary in a Summary view.


◆ Rename a summary.


◆ Specify a display update interval for a summary.


◆ Add a new summary to a Summary view.


◆ Delete a summary from a Summary view.


◆ Rearrange summaries within a Summary view.


◆ Apply a filter to a summary.
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You can also change the name of a Summary View Console, add different views to it, and 
save the console with customizations. Chapter 9, “Customizing Your Console,” contains 
additional information.


Modifying a new summary or an existing one


When you initially open a Summary View Console (File > New) or add a Summary view 
(View > Add View) to a console, it contains one default summary for each attached Global 
Manager. 


To modify a specific summary, edit its parameters and apply or change its filter, as 
illustrated in Figure 16 on page 105. Changes to a summary are saved when you save the 
console.


“Filtering summaries” on page 108 includes information on filters.


To edit summary parameters:


1. Click a summary.


2. Select Summary > Edit Summary Params. Or, right-click in the area near the summary 
title and select Edit Summary Params in the shortcut menu. The Edit Summary 
Parameters dialog box displays. 


Figure 16  Edit Summary Parameters dialog box


3. In the General tab, you can change the following:


• Manager — Select the Manager from the Manager menu.


• Chart Type — Select Horizontal Bar or Pie in the Chart Type menu.


• All elements by severity — Select this option to display all elements by severity in a 
summary.


• Title — Select the button for the empty Title field and type the new name. To return 
to the Default title, select the Use Default option.


• Update Interval — Select the Update Continuously checkbox, or clear the checkbox 
and specify the time in the Update Every field.
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4. Click Apply to see the results in the selected summary, then click OK when you are 
finished. Or, you can click the Attributes tab.


5. In the Attributes tab, you can change the summary parameters, as follows:


• Change the criterion used to organize the counts by selecting a category in the 
Count menu and an attribute in the categorized by menu. For example, you can 
choose to count notifications categorized by Class, or Alarmed Elements 
categorized by Acknowledged. “Notification Log columns” on page 59 includes 
attribute descriptions.


• Specify values for the criterion. For some attributes like Severity, the values are 
predefined. For other attributes like InstanceName, you can specify exact names or 
names with wildcard characters for pattern matching. Values are case-sensitive. 
(Appendix A, “Wildcard Patterns,” includes a list of wildcards.)


For some attributes like Event, there is an Enable Top 5 Occurrences checkbox, 
which is selected by default, and which sets the criteria to the five most frequently 
occurring values. You can clear the checkbox to specify your own criteria instead of 
the default “top 5”.


Use the Other checkbox to count events that do not match any of the values. 


6. Click Apply to see the results in the selected summary, then click OK when you are 
finished.


Displaying all elements by severity
To display all elements by severity in a Summary view, click the All elements by severity 
checkbox. When this option is selected, additional summary parameters are not required 
and the Attributes tab does not display. The resulting summary lists the number of 
alarmed elements as a fraction of the total number of elements. 


If an element has multiple severity notifications, the element is listed only once, at the 
highest severity notification level. For example, if a Global Manager has two elements, one 
element listed as normal and one element listed as having one Critical, one Major, and 
three Unknown notifications, the summary will list:


◆ One element as normal


◆ One element as Critical


When the All elements by severity option is selected, you cannot modify or set filter 
options for the summary. You can change the topological filer allowing you to select a 
group as the basis for the summary.
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Modifying a summary’s title


In the Edit Summary Parameter dialog box, you can also rename a summary. To rename a 
summary, specify a new name in the Title field of the Edit Summary Parameter dialog box 
and click OK. 


Specifying a display update interval for a summary


In the Edit Summary Parameter dialog box, you can also specify an interval for scheduled 
updates. Summaries are constantly being updated in your console by default. If you want 
to control how often summaries are updated, you can specify time intervals for scheduled 
updates. 


To specify an interval for scheduled updates: 


1. Clear the Update Continuously checkbox and specify the time in the Update Every 
field.


2. Click OK. 


Adding a new summary to a Summary view


To add a summary to a Summary view:


1. Click on the view to activate it. The active view has a dark gray border.


2. Select Summary > Add Summary. An additional summary appears in the Summary 
View Console.


Deleting a summary from a Summary view


To delete a summary from a Summary view:


1. Click on the summary you want to delete.


2. Select Summary > Delete Summary.


Rearranging summaries in a Summary view


You can reposition summaries with the arrow toolbar buttons. Click the toolbar button to 
move a summary one cell to the left or right. If another summary is next to the selected 
summary, click the toolbar button to change the order of the summaries.


To specify how many summaries appear per row in a Summary view:


1. Click the view.


2. Select Summary > Layout. The default value is four. Specify a number.


3. Click OK.
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Filtering summaries


The Summary view uses the same filtering mechanism as the Notification Log view except 
that there is an additional topological filter and a default filter criterion for active events. 
The default filter criterion for active events ensures that the summary represents only 
active events. There is one filter per summary. Filter criteria are saved if you save your 
console.


To customize a summary’s filter criteria, use the Filter Builder dialog box, which is 
accessed by right-clicking the area near the summary title and selecting Filter in the 
shortcut menu. 


A topological filter enables you to limit the display of notifications for all of the members 
of a specified collection object. A collection object can be a service offering, service 
subscriber, or any group created by your administrator.


If a topological filter is not specified, the total count indicates the number of affected 
elements for the entire topology and disables the Show Map toolbar button for a given 
summary.


In addition, you can apply filters from the Filter Builder dialog box that control which 
notifications might appear in the summaries. “Filtering notifications” on page 72 includes 
additional information.


Use one of the following methods to open the Filter Builder dialog box: 


◆ In the Summary View Console, click a summary and select Summary > Filter. 


◆ Right-click in the area near the summary title and select Filter in the shortcut menu. 


Topology Filter dialog box
The Topology Filter button appears in the Filter Builder dialog box when a summary is 
selected. To specify a topological filter:


1. In the Filter Builder dialog box, click Topology Filter. The Topology Filter dialog box 
appears.


2. In the Class Name menu, select a collection object (ServiceOffering, 
ServiceSubscriber, or group). 


The value None allows all of notifications to display in a summary unless you specify 
other filter criteria.


3. Select a class instance from the Select instance list.


If instances do not display in the Select instance list, click Get instances to retrieve a 
list. Depending upon your network configuration and if the collection object has 
thousands of instances, it might take a few minutes to retrieve a list.


Instances appear, by default, in the Select instance list if the collection object has 
fewer than 50 instances. “Adjusting Java properties” on page 151 includes 
information on the com.smarts.maxFilterInstances property.


The instance’s name displays as a summary title unless you specified a title using the 
Edit Summary Parameter dialog box. “Modifying a summary’s title” on page 107 
includes additional information.
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4. Click OK after your last selection. This immediately applies the topological filter to the 
selected summary and closes the Topology Filter dialog box. 


If you want, you can continue to create or modify filter criteria in the Filter Builder 
dialog box. Filter criteria specified in the Filter Builder affect notifications that might 
affect summaries. 


If you click Cancel in the Filter Builder dialog box after applying a topological filter, the 
newly created topological filter is not cancelled.
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CHAPTER 7
Examining Status Tables


A Status Table Console provides a high-level graphical overview of the status of underlying 
infrastructure elements as they affect the collection objects (ServiceOffering, 
ServiceSubscriber, or any group created by your administrator) specified in the Status 
Table. For example, in a Status Table view, you can determine at a glance which services or 
applications used by corresponding business elements are affected by the health of 
managed infrastructure elements.


A Status Table view is dynamically updated as the state of elements and notifications 
within the Global Manager’s topology is updated. In addition, the Status Table view is 
updated as elements are added or removed from the topology.


The ability to view and configure a Status Table is associated with your user profile. Your 
administrator can configure Status Table views and then associate them with your user 
profile. As a result, your console may or may not display Status Table information.


This chapter contains the following information:


◆ Accessing Status Table information .......................................................................  112
◆ About Status Table information .............................................................................  112
◆ Configuring a Status Table view.............................................................................  113
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Accessing Status Table information
To open a new Status Table Console from an existing console, select File > New > Status 
Table Console. The Status Table Console displays in a secondary window. 


To refresh the information in a row or column, click the name of an element in the row or 
column.


Another method to access Status Table information is to add the Status Table view to your 
console. Select View > Add View. “Tailoring your console with views” on page 158 includes 
additional information.


About Status Table information
The Status Table Console displays a grid comprised of the following:


◆ Primary Class (y-axis) — Selection from a group of collection objects (ServiceOffering, 
ServiceSubscriber, or any group created by your administrator). 


◆ Secondary Class (x-axis) — Selection from the group of corresponding instances of the 
Primary Class.


For example, if primary class, Customer, and secondary class, ServiceOffering is selected 
the Status Table view can show the instances and notification status of the various service 
offerings available to each customer.


For each point on the grid where an instance of the Secondary Class is located on a 
Primary Class row, the table displays the severity icon for the corresponding infrastructure 
element with the highest severity status, including the status, Normal. If there is no 
severity icon, there is no instance of that element for that class.


From the Status Table, you can obtain detailed information about the element by 
right-clicking its icon.


Client and server tools can be invoked from an instance node displayed in the Status 
Table.
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Examining element details


To see detailed information about an element, right-click the severity icon for the element, 
and then select one of the options, listed in Table 18 on page 113, from the shortcut 
menu.


Configuring a Status Table view
To configure a status table view:


1. Click the status table view to activate it. The active view has a black border.


2. Select Status Table > Configure Status Table. The Configure Status Table dialog box 
displays as illustrated in Figure 17 on page 113.


Figure 17  Configure Status Table dialog box


Table 18  Status Table shortcut menus


Selection 
criteria Option Description


Right-click the 
severity icon for 
an instance


Browse Opens the Topology Browser view for the current 
Global Manager that contains the selected 
element in a secondary window


Containment Displays an element’s components


Notification Properties Displays notification properties for that element


Show Map Opens a map with that element as focus


Server Tools Displays a list of server tools if enabled


Client Tools Displays a list of client tools if enabled
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The Configure Status Table dialog box contains two tabs:


◆ General — Options allow you to select a manager and to add a title and axis labels to 
the status table.


◆ Attributes — Functionality allows you to select multiple classes and class instances.


Adding a title and axis labels to the Status Table view


To add a title and axis labels:


1. Display the Configure Status Table dialog box.


2. From the General tab:


• Select the manager from the Manager list box.


• Type a title for the Status Table in the Title field.


• Type a label for the Primary axis in the Primary axis label field.


• Type a label for the Secondary axis in the Secondary axis label field.


3. Click OK.


Configuring the Status Table primary and secondary axes 


To configure the status table view’s primary and secondary axes:


1. Display the Configure Status Table dialog box.


2. Click the Attributes tab.


3. Select the classes for the Primary Class (y-axis) and the Secondary Class (x-axis).


4. Click OK.


The Status Table Console displays using the parameters you typed.


“Using Save” on page 165 includes information on saving your Status Table console.


The EMC Smarts Service Assurance Manager Dashboard Configuration Guide includes 
additional information about the Status Table as a dashboard viewlet.
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CHAPTER 8
Responding to Notifications


Operators can perform a variety of tasks in response to notifications or to changed states 
of map icons. Operators usually address the notifications based upon their severity and 
perform exploratory or corrective actions. This chapter provides step-by-step instructions 
for acting upon notifications and for saving and recording information.


Depending upon their user profiles defined by the EMC Smarts administrator, operators 
might have access to different types of consoles and console operations. 


Instructions apply to the following consoles: Notification Log, Map, Topology Browser, and 
Summary View, unless noted otherwise.


This chapter contains the following information:


◆ The notification life cycle.......................................................................................  116
◆ Taking action ........................................................................................................  122
◆ Saving and recording information .........................................................................  140
◆ HyperNotif Statistics .............................................................................................  146
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The notification life cycle
A notification can be in one of five states. If the Event State column in your Notification Log 
view is displayed, you can view the event state. The five event states are:


◆ UNINITIALIZED — The original event state of a notification.


The UNINITIALIZED state is not visible in the console because, like any client, the 
console does not receive uninitialized notifications.


◆ ACTIVE — The event state of a notification when an event occurs and the notification 
informs (notifies) a client of the event. 


When a notification is notified, the event state changes from the current value to 
ACTIVE. The notification displays in the Global Console unless an administrator sets a 
notification list filter that prevents it from displaying.


◆ SUSPENDED — The event state of a notification when the Global Manager can no 
longer receive information about an active notification (for example, an agent is not 
responding). 


In this case, the notification remains active although its event state changes to 
SUSPENDED and its severity level changes to Unknown (severity=4).


The SUSPENDED attribute is not applicable when the Broadcast Event State on Restart 
parameter system default is configured to FALSE. The “Defining System Defaults” 
section of the EMC Smarts Service Assurance Manager Configuration Guide provides 
detailed information.


◆ WAS_ACTIVE — The event state of a notification when an underlying Manager 
disconnects from a Global Manager (due to a network outage, for example) or a Global 
Manager is restarted.


In this case, the notification remains active although its event state changes to 
WAS_ACTIVE. If the session connection cannot be re-established, the severity level 
also changes to Unknown (severity=4). 


Once the session connection is re-established and the notification is re-notified, the 
WAS_ACTIVE state changes back to ACTIVE. If an underlying Manager fails to re-notify 
an active notification, the system clears the event and state of the notification 
changes from WAS_ACTIVE to INACTIVE. 


The WAS_ACTIVE attribute is not applicable when the Broadcast Event State on 
Restart parameter system default is configured to FALSE. The “Defining System 
Defaults” section of the EMC Smarts Service Assurance Manager Configuration Guide 
provides detailed information.


◆ INACTIVE — The event state of a notification when a notification has stopped 
occurring. When a notification is in the INACTIVE state, it is said to be cleared.
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Table 19 on page 117 summarizes possible event states of a notification and columns 
that might appear in your console.


“Notification severity” on page 57 includes a description of icons that correspond to 
severity levels.


Acknowledgement


Operators usually address the notifications based upon their severity and perform 
exploratory or corrective actions. “Taking action” on page 122 includes a list of actions.


One of the actions that an operator can take is acknowledgement. After an operator 
completes corrective actions or determines that notifications do not require attention, an 
operator can acknowledge active and inactive notifications. Acknowledgement informs 
fellow operators that they can ignore the specific notification. When an operator 
acknowledges a notification, the notification ownership (Owner field) is changed to the 
operator who acknowledged the notification and the value Yes displays in the 
Acknowledged field. 


Inactive notifications can also be automatically acknowledged by the Global Manager. 
When the Global Manager acknowledges an inactive notification, the notification 
ownership is changed to SYSTEM.


Acknowledgement does not change a notification’s state unless the notification attribute 
ClearOnAcknowledge is set to True for a specific notification. “Methods to clear active 
notifications” on page 118 includes information about the ClearOnAcknowledge attribute.


Table 19  Summary of event states


Event State column Active column Severity column


ACTIVE True Can be severity levels 1–5


SUSPENDED True Severity level 4


WAS_ACTIVE True Severity level 4


INACTIVE False Severity level from when 
notification was active


Notice: The UNINITIALIZED event state is not visible in the console.
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Methods to clear active notifications


Active notifications may become inactive (cleared) in the following ways:


◆ When an underlying Manager determines that an event is no longer occurring, the 
state of its notification is changed to inactive and the changed state is recorded in the 
audit log. The Manager, the source of the notification, clears the event. 


◆ If the source of the notification is not capable of clearing an event, the event can be 
cleared after an expiration interval provided by the source. 


◆ When the notification attribute ClearOnAcknowledge is set to True for a specific 
notification, the notification becomes inactive when an operator acknowledges it.


◆ When an underlying Manager fails to re-notify an active notification after a disconnect 
condition is restored, the state of the notification changes from WAS_ACTIVE to 
INACTIVE. The system clears the event. 


Notification archival


The system archives inactive notifications if: 


◆ They have been acknowledged. 


◆ The time interval set for the InactiveAutoArchiveIntervalArchival parameter has 
passed. The parameter is specified in the Service Assurance configuration file, 
ics-default.xml file. 


Related audit logs are also archived. Unacknowledged notifications cannot be archived. 
“Configuration parameters related to notifications” on page 121 includes information 
about archival parameters.


Archived notifications are removed from the Global Manager’s memory-resident database 
and are written to an archive file. The notification archive file is named 
global_manager.archive and located in the BASEDIR/smarts/local/logs directory.


After a notification is archived, the Global Manager treats a recurrence of that notification 
as though it were a first occurrence. The values of notification attributes start all over 
again: new First Notify time, Count starts at 1, and so on.


Removal from display


Notifications, active or inactive, are removed from the console display if they are:


◆ Filtered out by notification list filter criteria 


◆ Filtered out by console filter option


◆ Archived
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Example of a notification’s life cycle


Each notification has a unique name. A notification’s name consists of the class name and 
instance name where the event occurred, and the event name. The notification naming 
convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, 
which occurred in instance R1 of the Router class. 


The Notification Log Console will not list more than one notification with this name. If the 
event clears and occurs again before it is archived, the Count field is increased 
accordingly.


The following notification attributes are related to a notification’s state:


◆ First Notify — Is the first time a notification occurs.


◆ Last Notify — Is the last time a notification occurs.


◆ Last Clear — Is the last time a notification cleared.


◆ Last Change — Is the last time a notification changed.


◆ Count — Is the number of occurrences of an event starting from First Notify until Last 
Notify.


For the First Notify and Last Notify attributes, the timestamp value is provided by the 
underlying domain that diagnosed the event.


“Notification Log columns” on page 59 includes additional notification attributes 
information.


Table 20 on page 119 illustrates the states of the notification 
NOTIFICATION-Router_R1_Down. For the First Notify and Last Notify attributes, the 
timestamp value is provided by the underlying domain that diagnosed the event. Values 
for Last Change, Count, and Last Clear (not shown) are provided by the Global Manager.


When a Global Manager disconnects from an underlying Domain Manager, all notifications 
identified as ACTIVE are marked as WAS_ACTIVE. When the Global Manager reconnects to 
the underlying Domain Manager, the Global Manager refreshes its subscriptions and 
starts receiving currently active events from the Domain Manager. Existing WAS_ACTIVE 
notifications are interpreted as resubscription messages, not as re-occurrences of 
notifications. The notification is updated to a state of ACTIVE, the Last Change attribute is 
assigned the current time, and the Last Notify attribute value remains unchanged.


Table 20  States of NOTIFICATION-Router_R1_Down


Time User/system 
actions


Notification 
status


Time of first 
notify


Time of last 
notify


Time of last 
change


Count


2:00 Notify 1:00 1:00 2:00 1


2:15 Clear 1:00 1:00 2:15 1


2:25 Notify 1:00 2:25 2:25 2
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In this example, an Availability Manager generated a Down event at 1:00. 


At 2:00, the Global Manager connected to the Availability Manager and the Global 
Manager created the notification NOTIFICATION-Router_R1_Down for the Down event. The 
Global Manager retains the original timestamp of the event and stores it in the 
notification—First Notify and Last Notify are assigned the values of 1:00. The notification’s 
EventState is ACTIVE.


At 2:15, the notification is cleared.


At 2:25, the Availability Manager generated the same Down event again, the Availability 
Manager was already connected to the Global Manager, and the Global Manager 
reactivates the notification. The First Notify remains 1:00 and the Last Notify reads 2:25. 
The notification’s EventState changes to ACTIVE.


At 2:35, the notification is cleared. The notification’s EventState changes to INACTIVE.


At 3:00, the operator acknowledged the notification. The notification’s EventState 
changes to INACTIVE.


Notice at 3:05, the notification is archived and the archive action records the most recent 
values for First Notify, Last Notify, and Last Change. A notification cannot be archived until 
it has been acknowledged. Acknowledgement does not change a notification’s state 
unless the notification attribute ClearOnAcknowledge is set to True for a specific 
notification. The notification is removed from the notification view.


At 3:55, the Availability Manager generated a Down event again and the Global Manager 
created the notification again. After a notification is archived, the Global Manager treats a 
recurrence of that notification as though it were a first occurrence. The notification’s 
EventState is ACTIVE. The value of notification attributes start all over again: new First 
Notify time, Count starts at 1, and so on.


At 4:00, the Availability Manager disconnects from the Global Manager. The Global 
Manager marks the notification as WAS_ACTIVE. Last Change value is updated as 
whenever a change is applied to a notification.


At 4:05, the Availability Manager is restarted and reconnects to the Global Manager. Since 
a reconnection causes a client to re-subscribe to remote server’s events, all currently 
active alarms in the Availability Manager that the Global Manager subscribed are re-sent 
to the Global Manager. The Global Manager uses these event messages to update the 
event state of existing notifications. Notifications that did not previously exist or were 
INACTIVE before the disconnect, are notified with their Last Notify and Last Change times 


2:35 Clear 1:00 2:25 2:35 2


3:00 Acknowledge 1:00 2:25 3:00 2


3:05 Archived 1:00 2:25 3:00 2


3:55 Notify 3:55 3:55 3:55 1


4:00 Disconnect 3:55 3:55 4:00 1


4:05 Notify 3:55 3:55 4:05 1


Table 20  States of NOTIFICATION-Router_R1_Down (continued)


Time User/system 
actions


Notification 
status


Time of first 
notify


Time of last 
notify


Time of last 
change


Count
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initialized or updated appropriately, and the notifications’ EventState is ACTIVE. For 
existing WAS_ACTIVE notifications, the event message is interpreted as a re-subscription 
message, in other words not as a re-occurrence of the notification. The notification’s Last 
Notify does not change. Its EventState is updated to ACTIVE and Last Change time is 
assigned the current time since changes were applied to it. In short, Last Notify attribute 
value is not updated when a notification transitions from WAS_ACTIVE to ACTIVE.


Configuration parameters related to notifications


Inactive acknowledged notifications can be archived after a time interval specified by the 
System Administrator in the Global Manager Administration Console. The System 
Administrator can also specify an interval for INACTIVE unowned notifications to be 
automatically acknowledged. Related audit logs are also archived. Unacknowledged 
notifications cannot be archived.


Durable, momentary, and stale notifications


Some notifications are caused by durable events. A durable event has a measurable 
duration; it is active for a period of time (for example, a link failure). Durable events are 
sent from underlying Managers.


Other notifications are caused by momentary events. A momentary event occurs and is 
significant for only a specific point in time (for example, an authentication failure event for 
a device). 


Whether an event is durable or momentary is indicated in the Event Type column of your 
Notification Log Console. (“About notifications” on page 56 includes column descriptions 
and also severities.)


Sometimes, notifications become outdated (or "stale"). Due to network outages, it is 
possible that the underlying Managers disconnect from the Global Manager. At this point, 
a Session Disconnected notification displays to inform the operator that disconnected 
sources are detected. The notifications from the unavailable sources are not updated in 
the console. “Responding to disconnected Managers” on page 169 includes additional 
information. 
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Taking action
When an event occurs and Service Assurance generates a notification and displays a 
severity icon, you can respond and perform corrective procedures. 


You can:


◆ Acknowledge notifications.


◆ Take and release ownership of notifications while you are working on them.


◆ Invoke tools such as Telnet, Ping, email, or pager messages, or open and close trouble 
tickets if they have been configured by your administrator.


Acknowledging notifications


To inform your fellow operators that they can ignore a notification, you can acknowledge 
the notification if you have completed some corrective action for it or determined that it 
can be disregarded. You can acknowledge active and inactive notifications.


To acknowledge one or more notifications:


1. In the Notification Log Console, select a notification. (To select multiple notifications, 
press the Ctrl key while making your selections.) 


2. Select Event > Acknowledge in the Notification Console’s Event menu. (Alternatively, 
right-click the notification and select the Acknowledge option from the shortcut 
menu.) 


The value Yes displays in the Acknowledged field.


When a notification is acknowledged, an entry is added to its audit log. Acknowledged 
notifications may be archived after some period of time, depending on your Service 
Assurance configuration. By acknowledging a notification, you automatically take 
ownership of it.


Unacknowledging notifications


If you decide that certain acknowledged notifications do require additional attention, you 
can reset acknowledgement to unacknowledgement.


To unacknowledge notifications:


1. In the Notification Log Console, select a notification. 


To select multiple notifications, press the Ctrl key while making your selections.


2. Select Event > Unacknowledge in the Notification Console’s Event menu. Alternatively, 
right-click the notification and select the Unacknowledge option from the shortcut 
menu.


The value No displays in the Acknowledged field.


When notifications are unacknowledged, entries are added to their audit logs. 
Unacknowledged notifications are not archived. Unacknowledging a notification does not 
change its ownership.
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Taking ownership


To inform your fellow operators that you are working on a notification, you can insert your 
username in the notification’s Owner field. To do so:


1. In the Notification Log Console, select the notification. 


2. Select Event > Take Ownership or right-click and select Take Ownership from the 
shortcut menu. 


Your username is added to the Owner field and it is also recorded as an entry in the 
audit log.


The Owner field is informative; no additional rights are granted to the owner. Also, if there 
is an existing owner listed, you can overwrite it when you take ownership. 


Releasing ownership


To inform your fellow operators that you are no longer working on a notification, you can 
remove your username from the Owner field. To do so:


1. In the Notification Log Console, select the notification.


2. Select Event > Release Ownership or right-click and select Release Ownership from the 
shortcut menu. 


Your username is deleted from the Owner field and the deletion is also recorded as an 
entry in the audit log.


Scheduling maintenance


To inform your fellow operators that a specific managed element is entering its scheduled 
maintenance period, you can set the In Maintenance option in a notification. When a 
managed element enters its scheduled maintenance period, all active, existing, and newly 
generated notifications for the scheduled element or related managed entity display the In 
Maintenance option.


You can schedule maintenance by:


◆ Interactively using the console


◆ In bulk using the command line


By default, the Schedule Maintenance functionality is only enabled for administrators. If 
this functionality is not available to you, contact your administrator to have this 
functionality enabled for you. The EMC Smarts Service Assurance Manager Configuration 
Guide provides additional information on removing console operations.


The Schedule Maintenance functionality is available only for classes which belong to the 
following categories:


◆ UnitaryComputerSystem


◆ ICIMServiceConnection


◆ SoftwareService 
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◆ NetworkConnection


To schedule maintenance:


1. Ensure that the Business Impact Manager server is running and that the MBIM domain 
has been defined and enabled.


The EMC Smarts Service Assurance Manager Configuration Guide provides detailed 
information on defining and enabling domains.


2. In the Notification Log Console, right-click a notification.


The submenu appears.


3. Select Schedule Maintenance.


The Schedule Maintenance dialog box appears, as illustrated in Figure 18 on 
page 124.


Figure 18  Schedule Maintenance dialog box


4. Type the starting date and time for the maintenance period in the Start Date/Time 
fields.


5. Type the ending date and time for the maintenance period in the End Date/Time fields.


6. Type a reason for the maintenance period in the Explanation field.


7. Click OK.
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The notification for the managed element displays SchedMaint in the Event column, 
as illustrated in Figure 19 on page 125.


Figure 19  Notification displaying SchedMaint


Double-clicking the SchedMaint notification displays the Notification Properties 
dialog box. 


Table 21 on page 125 defines scheduled maintenance fields available in the General 
tab.


Table 21  Scheduled maintenance fields


Field Definition


UserDefined1 Defines the duration of the maintenance interval in seconds. 


Notice: If the user specifies a maintenance interval beginning 
before the current time, this duration will only be the time 
remaining until the end of the maintenance interval, not the length 
of the whole interval.  Example: If user specifies interval from 9:00 
to 10:00, and it is 9:30 when the Schedule Maintenance request is 
submitted, UserDefined1 will have the value of 30 minutes, not 60 
minutes. 


UserDefined2 Defines the end of the maintenance period. 


EventText Defines the following scheduled maintenance information:
• Start time
• End time
• User ID (identifies the user scheduling the maintenance)
• Explanation text (text entered in the Scheduled Maintenance 


dialog box’s Explanation field, see Figure 18 on page 124)
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When you schedule maintenance to begin in the future, a SchedMaint notification is 
created. When the maintenance period begins, the Service Assurance Manager server 
generates an InMaint notification. This notification lists only the maintenance period 
end time.


When the date and time of the scheduled maintenance period has arrived, the 
notification displays InMaint in the Event column, as illustrated in Figure 20 on 
page 126.


Figure 20  Notification displaying InMaint


The notification is cleared when the maintenance date and time have ended.


Clearing a scheduled maintenance period
To clear a scheduled maintenance notification:


1. In the Notification Log Console, right-click an InMaint notification.


2. Select Acknowledge.


The scheduled maintenance notification is cleared.


Deleting a scheduled maintenance period


You can only delete a scheduled maintenance notification if it has not entered the 
scheduled maintenance period. 


To delete a scheduled maintenance notification:


1. Log in to the console without user maint privileges.


2. In the Notification Log Console, right-click a SchedMaint notification.


3. Select Acknowledge.


The scheduled maintenance notification is removed.
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Forcing a scheduled maintenance period
If you have scheduled a maintenance period for the future, you can force a scheduled 
maintenance to take place immediately.


To force a scheduled maintenance:


1. Log in to the console with user maint privileges.


2. In the Notification Log Console, right-click a SchedMaint notification.


3. Select Acknowledge. 


4. Right-click the notification and select Schedule Maintenance.


The Schedule Maintenance dialog box appears.


5. Type the starting date and time for the maintenance period in the Start Date/Time 
fields.


6. Type the ending date and time for the maintenance period in the End Date/Time fields.


7. Type a reason for the maintenance period in the Explanation field.


8. Click OK.


Enabling maintenance tracking
To enable maintenance tracking:


1. Log in to the console.


2. Define and enable the MBIM domain.


The EMC Smarts Service Assurance Manager Configuration Guide provides detailed 
information on defining and enabling domains.


3. In the Domain Manager Administration Console, select INCHARGE-MBIM from the 
Manager list box, and select Topology > Add Source to launch the Add Source dialog 
box.


4. In the dialog box, select SA from the Element Type list box, type the name of the 
Service Assurance Manager server (for example, INCHARGE-SA) in the Element Name 
field, and then click OK to add the Service Assurance Manager server as a topology 
source.


5. In the Topology Browser Console, right-click the instance of the local Service 
Assurance Manager server in the InChargeDomain class.


A submenu appears.


6. Select Enable Maintenance.
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Disabling maintenance tracking
To disable maintenance tracking:


1. Log in to the console.


2. In the Topology Browser Console, right-click the instance of the local Service 
Assurance Manager server in the InChargeDomain class. 


A submenu appears.


3. Click Disable Maintenance.


Scheduling bulk maintenance


At times, you might want to schedule multiple devices and groups for maintenance. You 
can schedule multiple devices and groups for maintenance using a text file (for use with 
the bulk maintenance adapter) or an XML file (to be used with the sm_config 
functionality). When a group is scheduled for maintenance, a schedMaint notification for 
the group is created, resulting in all the members of the group being scheduled for 
maintenance.


Scheduling bulk maintenance using a text file
To schedule bulk maintenance using a text file:


1. Open a text editor.


2. Create a file with the format:


ClassName InstanceName startDate startTime endDate endTime


where the format for the startDate and endDate values is mm-dd-yyyy and the format 
for startTime and endTime values is HH::MM.


Values are delimited with space characters and comments are added with a pound 
character at the start of the line.


For example,


# This is the input file for bulk maintenance
# Hosts to be scheduled for maintence are
Host    MAJOR-WIN2K-VM  06-23-2009  16:00   06-23-2009  18:59 
Host    USENSMAJORL2E   06-23-2009  16:00   06-23-2009  18:59
# The following group is scheduled for maintence
SelectiveGroup HGRP-TL/G1 07-09-2009  11:58   07-15-2009  16:57


3. Save and exit the file.


4. Upload the file to the server.


“Loading the bulk maintenance text tile” on page 129 provides detailed information 
for uploading the text file to the server.
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Loading the bulk maintenance text tile


To load the bulk maintenance text tile:


1. Open a Command Prompt window.


2. Change directory to the smarts/bin directory.


3. Type the following command:


▼ Sm_adapter -s samserver --file=fileName --output=outputfileName 
../rules/ics/ics-bulk-maint.asl▲


▼ ▲ Type the command as one line.


Once the command is processed, a SchedMaint notification appears in the 
notification log, for the group object. At the start of the maintenance period, the 
SchedMaint notification is cleared. If a group is scheduled into maintenance, a 
scheduled maintenance notification or in maintenance notification is not generated 
for all devices in the group. However, if the SAM server receives any notifications for 
these devices within the scheduled maintenance period, the SAM server updates the 
in maintenance property to True. The EventText field of the notification displays the 
maintenance period scheduled for its group, for example:


“In maint, based on group HGRP-TL/G1, until 7-15-2009 16:57”


The output from the ics-bulk-maint.asl file is entered into the sm_adapter.log file. The 
domain manager diagnostics related to the bulk maintenance appear in the BIM 
domain manager log file.


Scheduling bulk maintenance using an XML file
To schedule bulk maintenance using an XML file:


1. Open an XML editor.


An XML template file, bulk-maint-sample.xml, is located in the conf/ics directory.


2. Create a file with the format:


<?xml version="1.0" encoding="iso-8859-1"?>
<!DOCTYPE ics_config SYSTEM "ics-config.dtd">
<ics_config version="2">
   <maintconfig className = "Host" instanceName = "hostb"


     startYear = "2009"
     startMonth = "7"
     startDay = "11"
     startHour= "10"
     startMinute= "20"
     endYear = "2009"
     endMonth = "7"
     endDay = "11"
     endHour= "12"
     endMinute = "20"/>


</ics_config>
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where the:


• Hour value is from 0–23 


• Minute value is from 0–59


• End date must be later then start date


• End time should be later than current time


When scheduling bulk maintenance for multiple devices, your XML file can contain 
multiple entries of the maintconfig element.


3. Save and close the file.


Save the file in the local/conf/ics directory. 


4. Upload the file to the server.


“Loading the bulk maintenance XML file” on page 130 provides detailed information 
on uploading the XML file to the server.


Loading the bulk maintenance XML file


To load the bulk maintenance XML file:


From a Command Prompt window, type the following command:


sm_config –s <SAMserverName> import –force <xmlfileName> 


The output from running the command is added to the SAM server log file.


Scheduling bulk maintenance for port and interface components
You schedule bulk maintenance for port and interface components by specifying the 
component’s SystemName, the device instance name, in either a text file or an XML file.


Scheduling bulk maintenance for port and interface components using a 
text file


To schedule bulk maintenance for port and interface components using a text file:


1. Open a text editor.


2. Create a file with the format:


ClassName InstanceName startdate startTime enddate endTime 
SystemName


where the:


• Format for the startdate and enddate values is mm-dd-yyyy and the format for 
startTime and endTime values is HH::MM.
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• SystemName is the name of the system that hosts the given port or interface. You 
can obtain the SystemName from the Topology Browser console.


Port and interface objects are not imported into SAM. There is no way to validate 
these object names in SAM. If an invalid port name or interface name is specified 
in the bulk maintenance input file, a notification for that element is created, even 
though the element is invalid (misnamed).


• Hour value is from 0–23 


• Minute value is from 0–59


• End date must be later then start date


• End time should be later than current time


Values are delimited with space characters and comments are added with a pound 
character at the start of the line.


For example,


# This is the input file for bulk maintenance for ports and interfaces
# Ports to be scheduled for maintence are
Port abc 08-05-2009 16:00 08-05-2009 19:00 router1 


3. Save and exit the file.


4. Upload the file into the server. 


“Loading the bulk maintenance text tile” on page 129 provides detailed information 
for uploading the text file to the server.


Scheduling bulk maintenance for port and interface components using an 
XML file


To schedule bulk maintenance for port and interface components using an XML file: 


1. Open an XML editor.


2. Create a file with the format:


<?xml version="1.0" encoding="iso-8859-1"?>
<!DOCTYPE ics_config SYSTEM "ics-config.dtd">
<ics_config version="2">


<maintconfig className = "Port" instanceName = "abc"
     startYear = "2009"
     startMonth = "7"
     startDay = "26"
     startHour= "10"
     startMinute= "00"
     endYear = "2009"
     endMonth = "7"
     endDay = "28"
     endHour= "16"
     endMinute = "00"
     systemName = "router1"/>


</ics_config>


where the:


• Hour value is from 0–23 
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• Minute value is from 0–59


• End date must be later then start date


• End time should be later than current time


• The port “abc” resides on router1, and router1 must be in the SAM topology. If 
router1 is not in the SAM topology, it ignores the entry in the XML file.


3. Save and close the file.


4. Upload the XML file to the server. 


“Loading the bulk maintenance XML file” on page 130 provides detailed information 
on uploading the XML file to the server.


Unscheduling bulk maintenance


If errors exist in the maintenance schedule, you might want to unschedule the devices 
from maintenance. If the devices to be unscheduled from maintenance have not entered 
their maintenance period, their corresponding schedMaint notification is archived. If the 
devices to be unscheduled from maintenance have entered their maintenance period, 
unscheduling the devices clears their corresponding InMaint notification and all the 
related notification’s InMaintenance attributes are set to false. If maintenance period for 
the devices to be unscheduled from maintenance has passed, unscheduling the devices 
from maintenance has not effect on their corresponding notifications.


Unscheduling bulk maintenance using a text file
Use the text file containing the original maintenance entries you want to remove from 
maintenance when removing devices from maintenance. Define the variable, 
removeSchedMaint, using the -D sm_adapter option.


To unschedule bulk maintenance using a text file:


From a Command Prompt window, type the following command:


▼ Sm_adapter –s SAMServer –DremoveSchedMaint=true --file=fileName 
../rules/ics/ics-bulk-maint.asl ▲


▼ ▲ Type the command as one line.


Unscheduling bulk maintenance using an XML file
To unschedule bulk maintenance using an XML file:


1. Open the original XML file containing the device entries you want to remove from 
maintenance in an XML editor.


2. Type the following line in the first device entry:


removeSchedMaint = “TRUE”
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The other device entries do not need to be modified. An example of the file is:


<?xml version="1.0" encoding="iso-8859-1"?>
<!DOCTYPE ics_config SYSTEM "ics-config.dtd">
<ics_config version="2">
   <maintconfig className = "Host" instanceName = "hostb"


     startYear = "2009"
     startMonth = "8"
     startDay = "11"
     startHour= "10"
     startMinute= "20"
     endYear = "2009"
     endMonth = "8"
     endDay = "11"
     endHour= "12"
     endMinute = "20"


      removeSchedMaint = “TRUE”/>
     <maintconfig className = "Router" instanceName = "10.9.131.17"


     startYear = "2009"
     startMonth = "8"
     startDay = "16"
     startHour= "13"
     startMinute= "00"
     endYear = "2009"
     endMonth = "8"
     endDay = "16"
     endHour= "14"
     endMinute = "20"/>


</ics_config>


3. Save and close the file.


Save the file in the local/conf/ics directory. An example XML file, 
bulk-maint-sample.xml, is located in the conf/ics directory.


4. Reload the XML file into the server.


“Loading the bulk maintenance XML file” on page 130 provides detailed information 
for loading the XML file into the server.


Scheduling repair time


The Repair Time dialog box is accessed from a root-cause notification. The Repair Time 
dialog box allows you to type an estimated repair time and have it display in a notification 
field. Any notifications that are caused by the selected notification also get the specified 
repair time.


The console does not support Repair Time as one of the standard default Notification 
Console columns. However, you can configure one of the User Defined columns to include 
this information. 


To access the Repair Time functionality, your administrator should configure one of the 
User Defined Notification Log Console columns to display the heading "Repair Time". Your 
administrator must enable the Schedule Maintenance Administration console operation 
for each user profile permitted to display the Repair Time dialog box. The “Modifying a 
notification list” section of the EMC Smarts Service Assurance Manager Configuration 
Guide provides detailed information.
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Repair time data is for informational purposes only.


To schedule repair time for a managed element:


1. In the Notification Log Console, right-click a notification.


2. Select Repair Time.


The Repair Time dialog box appears, as illustrated in Figure 21 on page 134.


Figure 21  Repair Time dialog box


3. Type the amount of time the repair will take to be complete.


4. Click OK.


The Repair Time notification field displays the time when the repair is expected to be 
completed.


About tools


A tool is a program that you can invoke in response to a notification or for a topology 
element. Such an action might be to ping or to Telnet to the affected system, or to open a 
trouble ticket for a specific notification.


The Global Console supports these types of tools:


◆ Server tools are executed by the Global Manager and are available to any console that 
attaches to the Global Manager. 


In console shortcut menus, the server tools are listed in the Server Tools submenu.


Server actions are also recorded as entries in the server’s audit log.


◆ Client tools are executed by the Global Console and are available to locally installed 
consoles.


In console shortcut menus, the client tools are listed in the Client Tools submenu. 
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Some tools prompt for runtime user-specified parameter values. If multiple instances are 
selected when you launch these tools, the Specify Options for get properties tool dialog 
box includes an option allowing you to specify values once and apply the specified values 
to all selected objects. With this option selected, you only need to type the runtime 
parameters once for all selected objects.


Your administrator can configure tools for server or client execution. For example, some 
available tools include:


◆ Ping


◆ Telnet


◆ Trouble tickets, opening and closing (server only)


◆ Email 


◆ Pager message 


◆ LSP Ping


◆ Launch ADM Web Console


◆ Get SCM Alert Details


◆ Get SCM Server Details


The Get SCM Alert Details and the Get SCM Server Details tools are only available from 
Global Consoles accessed through Windows Internet Explorer. 


In addition, your administrator can modify these sample tool programs, provided by EMC 
Corporation, and rename the menu options that appear in your consoles:


◆ Sample—Ping, Ping Interface, Ping Device, Ping All


◆ Sample—Telnet


◆ Sample—Open Trouble Ticket


◆ Sample—Close Trouble Ticket


The following sections describe how to use Ping and Telnet, open and close trouble 
tickets, display the Tool Output window, and use Email, pager message, and their 
recipients dialog box.
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Using ping and telnet


The tools ping and telnet are available from the Global Console. To invoke either tool:


1. Right-click one of the following selections:


• A notification in the Notification Log Console


• A map icon in the Map Console 


• A managed element in the topology tree of the Topology Browser Console 


2. Select a tool from the shortcut menu.


Server tools are listed under the Server Tools submenu. 


Client tools are listed under the Client Tools submenu.


These submenus only display if the tools are configured and are relevant for the 
selected entity.


Menu option names for these tools may have been modified by your administrator.


Opening and closing trouble tickets


Trouble tickets are sometimes used to track notifications while the operators are working 
on them. If the trouble ticket tools (Open and Close programs) are configured by your 
administrator, you can open a trouble ticket (insert a Ticket ID number) for a notification or 
close a trouble ticket. 


To open and close a trouble ticket for a notification, use the tools Open Trouble Ticket and 
Close Trouble Ticket, respectively. 


Menu option names for these tools may have been modified by your administrator.


Opening a trouble ticket
To open a trouble ticket:


1. Right-click a selected notification in the Notification Log Console.


2. In the shortcut menu, select Server Tools > Open Trouble Ticket.


Closing a trouble ticket
To close a trouble ticket for a notification:


1. Right-click a selection.


2. In the shortcut menu, select Server Tools > Close Trouble Ticket.
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Using the Tool Output window


Viewing tool output depends on the tool’s configuration. Typically, the output displays in 
the Tool Output shortcut window, which opens when the tool is invoked. 


In the Tool Output shortcut window, the buttons are:


◆ Stop — Stops the tool program while it is running. 


◆ Print — Prints the output to your default printer.


◆ Close — Closes the window after the tool program completes processing or is stopped; 
you cannot close the window while the tool is running. 


If the tool produces an error, a message is displayed in the window. (For Server tools, an 
error message is displayed in the window on the host where the console is running.)


For example, Figure 22 on page 137 displays the result for the Ping tool when it is invoked 
for a router notification.


Figure 22  Example of a Tool Output window


Email, Pager Message, and their recipients dialog box


The tools Mail and Pager are available in the Notification Log Console. 


To invoke either tool:


1. Right-click a selected notification in the Notification Log Console. (To include multiple 
notifications in your message, press the Ctrl key while making your selections.)


You can right-click the selection regardless of its state (active or inactive): A cleared 
problem can be as important as a problem that has occurred.


2. Select Mail or Page in the shortcut menu.


 This displays the Mail Action or Pager Action dialog box. 
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3. In the dialog box, fill in the fields. The Mail Action and Pager Action dialog boxes are 
the same, except for the Mail Subject field and the resulting action.


The dialog box fields are:


• Manager — Is the Manager for the recipients listed in the To field. If you are 
attached to multiple Managers, select one.


• To — Designates a recipient for the action. You must select a recipient. If you need 
to send an action to someone who is not listed, click Configuration to display the 
Recipients Editor dialog box and add the person to the list.


• Subject — Identifies the subject of the email message. You can change it if you 
wish.


• Message — Is the body of the email or pager message. The message text includes 
the event and related notification attributes. This is not always enough 
information, however, for the person receiving the message. You may wish to add a 
brief note that provides more information about the event.


4. Select the recipient.


If you open a Mail or Pager Action dialog box and the To section does not initially list 
recipients, you need to create a distribution list of recipients. “Preparing a distribution 
list” on page 138 includes instructions.


5.  Click OK to apply your changes and send the email or pager message.


The mail action uses the industry-standard SMTP for email. In the Recipients Editor dialog 
box, you need to verify the values in the Mail server and Sender email address section that 
define the values for the mail services running at your site.


Preparing a distribution list
The Recipients Editor dialog box enables you to create a list of people to receive email or 
pager actions. 


To open the Recipients Editor dialog box, select Edit > Recipients or click Configuration in 
an open Mail Action or Pager Action dialog box.


The Recipients Editor dialog box is divided into four sections: 


◆ Manager section lists the Manager for the recipients. If you are attached to multiple 
Managers, select one.


◆ Current Recipients section lists the recipients for a selected Manager. To delete an 
entry from the list, select it and click Delete. (To select multiple entries, press Ctrl 
while making your selections.) Click OK to apply your changes.


◆ The Recipient Information section is where you add new recipients to the list or change 
existing information. 


◆ Mail server and Sender e-mail address section. The information in this section must 
be correct in order to successfully send email. You can change the mail server name 
and email address:
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• The Mail server field must be set to the hostname where the mail services are 
running and should match the value specified by your system administrator in the 
Service Assurance Manager’s configuration. The default value is localhost. 


If you specify a mail server name in the Recipients Editor dialog box that is 
different from the configuration value, the value in the dialog box temporarily 
overrides the configuration value. To change the name permanently, contact your 
administrator.


• The Sender email address field identifies the operator who is sending the email. By 
default, it displays your email information. 


Adding a recipient
To add a recipient in Recipients Editor dialog box:


1. From the Manager list, select the manager where you want to save the recipient.


2. Provide the recipient’s name.


3. Add the recipient’s email address or pager number. When you choose an action, the 
appropriate phone number or email address is sent to the pager or email software.


4. Supply a password if it is required to send a pager message. The password value is 
passed as a parameter to the pager script.


5. (Optional) Add a description for your records. 


6. Click Apply or Create. The new recipient appears in the list of Current Recipients.


7. Click OK to apply your changes.


Launching an ADM web console


Use the Launch in Context functionality to open an Application Discovery Manager (ADM) 
Console in context. The ADM Console includes functionality to display detailed 
information about selected objects populated into the Service Assurance Manager as a 
result of the integration with ADM. The Launch ADM Web Console tool is available from the 
Map Console.


The EMC Smarts Application Discovery Manager Integration Guide provides detailed 
information.


To launch an ADM web console:


1. From the Map Console, right-click an object.


The shortcut menu displays.


2. Select Client Tools.


3. Select Launch ADM Web Console.


The ADM web console appears.
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Viewing SCM alert and server details


When the Service Assurance Manager is integrated with the Server Configuration Manager 
(SCM), the Global Manager can receive alerts from SCM, allowing you access to SCM 
reports listing the Change and Compliance alerts collected by the SCM for machines 
monitored by the Service Assurance Manager. 


The EMC SCM Integration with EMC Smarts Configuration and User Guide provides 
detailed information on configuring the integration between the Service Assurance 
Manager and SCM and viewing detail reports.


To view SCM alert and server details:


1. Right-click a Change or Compliance alert in the Notification Log Console.


2. In the shortcut menu, select Client Tools.


3. Select one of the following:


• Display SCM Alert Details — To display Alert Details Reports. 


• Display SCM Server Details — To display the Server Details Reports.


The report displays in a Report Viewer.


The Display SCM Alert Details and the Display SCM Server Details tools are only available 
from Global Consoles accessed through Windows Internet Explorer. 


Saving and recording information
In addition to acting upon notifications or the state of icons in maps, you may need to add 
comments to audit logs, save notification information and maps, and print tool output and 
maps.


Adding comments to a notification’s audit log


Sometimes for documentation purposes, you may need to add comments to an audit log 
for a specific notification. For example, you may want to log a summary of actions taken to 
solve a problem or list pending issues for the operators on the next shift. The inserted 
entries cannot be edited or deleted and they are archived as part of the audit log. 
Figure 23 on page 141 shows an example.


To add comments:


1. In the Notification Log Console, right-click a notification. 


The notification shortcut menu appears.


2. Click Add to Audit Log. 


Alternatively, select Event > Add to Audit Log from the console’s menu bar. 
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The Append new item to Audit Log dialog box displays. 


Figure 23  Append new item to Audit Log dialog box


3. Type your comments for one entry and click OK. For more than one entry, click Apply 
after each entry, then click OK when you are finished.


An alternate method for opening the Append new item to Audit Log dialog box is to open 
the Notification Properties dialog box. 


To open the Notification Properties dialog box:


1. In the Notification Log Console, right-click a notification.


The notification shortcut menu appears.


2. Click Properties.


Alternatively, select Event > Properties from the console’s menu bar.


3. Select the Audit Log tab.


4. Click Add to Audit Log. 


“Displaying notification properties” on page 62 includes additional information about the 
Notification Properties dialog box.


Saving Notification Log information


You can save the contents of a Notification Log view. The information is stored locally as 
an ASCII file. Each row of information is saved as a separate line of text in the file. The 
resulting file can be imported into other applications such as a spreadsheet program or 
printed.


To save notification information, in a Notification Log Console, select Log > Save log 
contents to file or right-click the view title and select Save Log Contents to File from the 
shortcut menu. 


In the Save log contents to file dialog box, you can choose format settings and a location 
for the file. 
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The Save log contents to file dialog box is divided into four sections and a Save location 
field: 


◆ Field delimiter — Separates each field within a line using a tab character or a 
user-specified character such as vertical bar (|). To specify a custom delimiter, click 
the Use custom delimiter option and specify the character; tab is the default.


◆ Column headers — Includes column headers as the first line. To exclude the headers, 
clear the Include column headers checkbox.


◆ Columns to include — Includes columns that are visible, which is the default, or all 
columns. 


◆ Notifications to include — Includes all notification rows, which is the default, or only 
selected rows.


◆ Save location — Specify a directory path and filename, including the file extension 
(.txt). If you do not specify a path, the file is saved locally to the 
BASEDIR/smarts/local/logs directory by default. Or, you can click Browse and choose 
a location in the Select filename dialog box.


Click OK or Apply to create the text file. If the file already exists, its contents are 
overwritten.


Saving audit log and containment information


You can save the contents of an audit log and a selected table of the Containment dialog 
box. The information is stored locally as an ASCII file. Each row of information is saved as a 
separate line of text in the file. The resulting file can be imported into other applications 
such as a spreadsheet program or printed.


To save the information, you can:


◆ In the Audit Log tab of the Notification Properties dialog box, click Save table to file. 


◆ For a selected tab in the Containment dialog box, click Save Table. 


In the Save table to file dialog box, you can choose format settings and a location for the 
file. 


The Save table to file dialog box is divided into two sections and a Save location field:


◆ Field Delimiter — Separates each field within a line using a tab character or a 
user-specified character such as vertical bar (|). To specify a custom delimiter, click 
the Use custom delimiter option and specify the character; tab is the default.


◆ Column Headers — Includes column headers as the first line. To exclude the headers, 
clear the Include column headers checkbox.


◆ Save location — Specify a directory path and filename, including the file extension 
(.txt). If you do not specify a path, the file is saved locally to the 
BASEDIR/smarts/local/logs directory by default. Or, you can click Browse and choose 
a location in the Select filename dialog box.


Click OK or Apply to create the text file. If the file already exists, its contents are 
overwritten.
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Saving a map


You can save a map of each map type for each instance in the map tree. The purpose of 
saving a map is to override the default map of the selected type (for example, Group 
Membership or VLAN Connection) for a specific device, IP network, VLAN, group, service, 
or application. 


To save a map, in the Map Console, select Map > Save Map. Click OK to acknowledge the 
informational message that displays the location of the saved map. The map is saved in 
the BASEDIR/smarts/consoles/<userid> directory on the host where the Global Manager is 
running. 


Some changes you make to the map before saving are also saved. These changes can 
include:


◆ Adjusted scope (for example, expanded nodes)


◆ Node positions


◆ Layout type (circular, hierarchical, or manual)


◆ Filtered classes


◆ User-defined backgrounds 


◆ Zoom level


If you use the Color-by-Root-cause toolbar button (tool tip labeled Toggle Root Cause 
Coloring) to color a map, the map coloring is not saved.


If the topology changes after a map is saved, the changes are applied to the information 
displayed in the map view when the map is redisplayed. (The saved map is updated only 
when the updated map is saved.)


If you save a map that already exists in your userid directory for a specific element and 
map type, it is replaced. 


When you click a managed element in the map tree, the Global Console queries the Global 
Manager for a saved map in the following order:


1. The Global Manager checks your remote directory, the 
BASEDIR/smarts/local/consoles/<userid> directory, for any saved maps for that 
element. If a saved map exists, it displays. 


2. If there is no saved map in your user directory, it then checks for a shared, saved map 
in the BASEDIR/smarts/local/consoles directory on the host where the Global 
Manager is running. 


3. If a saved map exists in the /consoles directory for the selected element, it displays. If 
no map exists, then the Global Console uses the default map for the selected element.
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Sharing a saved map


To share a map saved in your directory with other users, from a Windows command line , 
copy the saved map file from your BASEDIR/smarts/local/consoles/<userid> directory to 
the BASEDIR/smarts/local/consoles directory on the host where the Global Manager is 
running. Once the saved map has been copied to this directory, all users of the Domain 
Manager have access to view the saved map. The map file naming convention is described 
below.


Write permission to the remote host directory is required for the copy operation.


To share a saved map with only selected users, copy the saved map file to the 
BASEDIR/smarts/local/consoles/<userid> directory of each user who is to share the map. 


Map file naming convention
Maps are automatically assigned filenames by the Global Manager when they are saved. 
The filename given is a combination of the Global Manager name, the instance name, and 
the map type represented by a number. The suffix of the filename is icsvm. Table 22 on 
page 144 lists the numeric representation for each map.


For example, an INCHARGE-SA Global Manager Physical Connectivity map of router 
moto-gw is assigned the filename: 


INCHARGE-SAmoto-gw1.icsvm


Table 22  Map identification numbers (page 1 of 2)


Numeric representation Map type


1 Physical Connectivity


2 Physical Connectivity—VLAN


3 Physical Connectivity—IP network


4 IP Network Connectivity 


5 IP Network Membership


6 VLAN Connectivity 


7 VLAN Membership


8 Group Membership


9 Group Physical Connectivity


10 Group VLAN Connectivity


11 Group IP Network Connectivity


12 Business Services


13 Applications 


14 OSPF Connectivity


15 BGP Connectivity


16 Redundancy Group
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Printing a map


To print a map, in the Map Console, select Map > Print Map. In the window, you can select 
the following buttons:


◆ Print — Prints your map. The Print dialog box for your default printer displays. Check 
your settings for paper orientation and resolution if necessary. Click OK. 


◆ Print Setup — Enables you to format your map as follows:


• To print the whole map with all nodes, select the Print Entire Graph option.


• To print the portion of the map that appears in the Map window, select the Print 
Current Window option.


• To print selected elements that you have selected in the map, select the Print 
Current Selected option.


• To title the print, type the name in the Caption box, ensure that the Print Caption 
checkbox is selected. You can format the title using the Font button and the 
Position list box.


Also, you can format the print using the Margins, Multipage Printing and Other 
options.


Click OK.


◆ Zoom In and Zoom Out — To scale the map view.


◆ Fit In Window — Fits the map to the size of the panel.


◆ Close — Closes the window.


17 LSP


18 LSP Hops


19 VPN


20 PseudoWire


21 MultiCast Connectivity


22 SAN Connectivity 


23 NAS Connectivity


Table 22  Map identification numbers (page 2 of 2)


Numeric representation Map type
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Printing Tool Output


When you invoke a tool such as Ping or Open Trouble Ticket from the Global Console, the 
output usually displays in the Tool Output shortcut window. 


To print the output:


1. Click Print. The Print dialog box for your default printer displays. 


2. Check your settings for paper orientation and resolution if necessary. 


3. Click OK.


“Using the Tool Output window” on page 137 includes additional information about tool 
output.


HyperNotif Statistics
HyperNotif Statistics is a debug tool that reports two specific kind of notification data, 
namely Client Statistics and Server Statistics.


◆ Client Statistics — With respect to a Service Assurance Manager server, Client 
Statistics provides the notification data statistics for notifications received from the 
underlying Service Assurance Manager server. 


If the underlying Domain Manager is not a Service Assurance Manager 8.0 or later, 
then the data will not be available as there are no HyperNotif transactions. In such 
cases, use the debug tool dmdebug ---queues.


◆ Server Statistics — With respect to a Service Assurance Manager server, Server 
Statistics provides notification data statistics for notifications sent to each of the 
HyperNotif client connected to the Service Assurance Manager server. The HyperNotif 
Client can be:


• Service Assurance Manager Console


• Service Assurance Manager (Presentation server), under which lies this Service 
Assurance Manager (Aggregate server).


Command


The command to run the HyperNotifStatistics tool:


#dmctl  -s <server name> invoke ICS_NLManager::ICS-NLManager 
reportHyperNotifStats


Sample output


SA-9.0_NL-Driver-HyperNotif     [1 worker(s)]
Current Size 0 , max 0; processed entries 0
SM_ProtocolEngine-1 19527 SA    [1 worker(s)]
Current Size 0 , max 27; processed entries 32
SM_ProtocolEngine-4 3340 IC Console - V9.1.0.0  [0 worker(s)]
Current Size 0 , max 26; processed entries 29
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In the output:


◆ SA-9.0_NL-Driver-HyperNotif — Indicates the name of the thread along with the 
number of workers, which is the number of threads in the process.


◆ Current size — Indicates the current size of the queue. 


◆ Max — Indicates the maximum size of the queue, at any point in time. This is a 
historical data. 


◆ Processed entries — Indicates the total number of entries processed.


The HyperNotif Connections are cleaned up only after 45 minutes of inactivity. Therefore, 
the stale connections will be reported for that duration. For example, if a Service 
Assurance Manager Console is detached, or if a Console is closed, and the command is 
run, then the output will still show the stale connections.
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CHAPTER 9
Customizing Your Console


The Global Console can be customized according to an operator’s preferences. This 
chapter describes how to change the appearance of your console, customize it with views, 
and save the customized console. Two examples of consoles illustrate these 
customization options.


“Adjusting the contents of a Notification Log view” on page 69, “Filtering topology” on 
page 79, “Adjusting the appearance of a map” on page 94, and “Adjusting the contents of 
a Summary view” on page 104 include information about customizations that control the 
contents of your console.


This chapter contains the following information:


◆ Changing the console appearance.........................................................................  150
◆ Adjusting Java properties ......................................................................................  151
◆ Tailoring your console with views ..........................................................................  158
◆ Saving a console...................................................................................................  164
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Changing the console appearance
This section describes how to control the display of the toolbar buttons and status bar, the 
layout of multiple views, and how to revise the text in a console title bar.


Hiding the toolbar and status bar


In a Global Console, toolbar buttons are located below the menus and the status bar is 
located at the bottom of the console. You can control the display of the toolbar and status 
bar. For example, if you prefer to work without toolbar buttons, you can hide them:


◆ To hide the toolbar, select View > Toolbar to clear the Toolbar option.


◆ To hide the status bar, select View > Status to clear the Status option.


To re-display the hidden bar, reselect the appropriate option in the View menu.


Changing the console layout of views


If your console consists of multiple views, you can change the console layout by 
rearranging the views. To change the layout of a console: 


1. Select File > Layout to display the Console Layout dialog box. In the Console Panel 
Layout section of the dialog box, two list boxes appear:


• Panel determines which panel the Tile operation affects.


• Tile controls how multiple views in a panel are displayed. Right To Left places the 
views in a row. Top To Bottom stacks them one on top of the next.


2. Click OK.


You can also change the console layout while you are adding or copying views to a current 
console. In the Add View or Copy View dialog boxes, use the Console Panel list box. 
“Adding a view” on page 159 or “Copying a view in a current console” on page 160 
provides additional information.


Changing the title of a console


If you want, you can revise or replace the console title. To change the text in the title bar of 
a console: 


1. Select File > Layout to display the Console Layout dialog box. 


2. In the Title field, type the new console name.


3. Click OK. 
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Adjusting Java properties
The -D option for the sm_gui command enables you to adjust specific Java properties that 
affect the Global Console. For example, you can control the display of text for toolbar 
buttons, maps, and the font that displays throughout the console. You can also redefine 
the Java log file location and specify the connection timeout for the console.


Command syntax for the -D option


You can specify the sm_gui command with -D parameter options in the Service Assurance 
shortcut for Windows. (In the shortcut, open the Properties dialog box and specify the 
option in the Target field of the Shortcut tab.) You can also use sm_edit to add properties 
in the BASEDIR/smarts/conf/console/properties.conf file. When properties are added to 
the properties.conf file, the -D parameter options are not used. The tutorial information 
included in the properties.conf file provides additional information.


The -D option for the sm_gui command is:


▼sm_gui -Dproperty1=value1 -Dproperty2=value2-D ... 
-Dpropertyn=valuen ▲


This command must be typed on one line.


Specify the -D option for each property/value pair. For example, to change the font to Arial 
and set the font to 20 points, specify:


sm_gui -Dcom.smarts.font=Arial -Dcom.smarts.fontSize=20
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Properties and their acceptable values are listed in Table 23 on page 152.


Table 23  Properties and their values (page 1 of 6)


Property
Acceptable 
value Description


com.smarts.securityMessage string Defines the name of the ASCII file containing the 
security warning message.


Notice: The file must be located in the directory 
where the HTML and properties files are located.


com.smarts.server.logMessages true or false True — Causes the server to write messages to the 
server log file.
False — Does not cause the server to write 
messages to the server log file.


Notice: The ServerMesg_<userid>.log is created 
when the com.somarts.server.logMessages 
parameter is set to true. This log contains all sever 
events associated with a specific user. For 
example, if UserA is logged onto the system and 
the com.smarts.server.logMessages parameter is 
configured to true, messages would be written to 
SeverMesg_UserA.log.


com.smarts.mapNodeText.font string Allows the user to define the map icon font.
Default value: Helvetica


com.smarts.mapNodeText.fontSize integer Allows the user to define the map icon font size.
Default value: 12 point


com.smarts.connectionTimeout integer
(in seconds)


This property indicates the maximum amount of 
time that the console will wait for the Manager 
pulse check (the upTime attribute) to respond. If 
there is no response within the specified time, the 
console disconnects from the Manager. 
The default is 300 seconds (5 minutes).
Any integer between 1 - 89 is changed to a 
minimum value of 90.
Zero (0) or any integer below disables the timeout.


com.smarts.font string Enables a user-specified font to display 
throughout the Global Console. The font must be a 
Java-supported font appropriate for the operating 
system or it is ignored. The font should reside in 
the directory location as described by Java 
documentation.


com.smarts.fontSize integer Enables a user-specified font size to display 
throughout the Global Console. The font size must 
be compatible with the com.smarts.font property 
or it is ignored.


com.smarts.java.log fully qualified 
filename


If specified, the Java log contents are saved to the 
specified file. (The default is no file specified.)
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com.smarts.informs user-defined 
field


If specified, this property controls which 
underlying Managers are accessible by using 
Browse Detail from the Notification Log view. A 
user-defined field must be configured to contain 
the names of the underlying Managers. The EMC 
Smarts Service Assurance Manager Configuration 
Guide includes information about customizing 
user-defined notification attributes.


com.smarts.map.showAllBusiness  true or false True — Shows all nodes and edges in a Business 
Services map, including those that are not part of 
paths that originate from or terminate at the map 
central node. (This is the default.)
False — Shows the nodes and edges in a Business 
Services map that either originate from or 
terminate at the map central node.


com.smarts.map.showNormalBanner true or false True — Shows map nodes with the status of 
Normal with a green color bar underneath the icon.
False — Shows map nodes with the status of 
Normal without a green color bar underneath the 
icon. (This is the default.)


com.smarts.mapBackgroundColor string Enables you to specify a single background color 
for all maps. This parameter overrides the default 
color for all map types. Note that if the setting you 
enter is invalid, the background color for all maps 
will be white.
Use a six-character string, RRGGBB, where RR is a 
hexadecimal value between 00 and ff (= 0 to 255), 
specifying the red component; GG specifies the 
green component; and BB specifies the blue 
component. For example, to specify the beige 
color called “antique white” in Netscape, the 
string is: 
com.smarts.mapBackgroundColor=FAEBD7
“Map background colors” on page 96 includes 
information on default background colors.


com.smarts.maxFilterInstances integer Enables you to change the maximum number of 
instances that will automatically display in the 
Topological Filter tab. 50 is the default. If a class 
has more instances than the maximum number, 
you need to click Get instances to retrieve a list.


smarts.maps.maxGroupMembers a positive 
integer


A positive integer. This is the maximum number of 
members of a leaf group that will display for a 
Group Membership map without a prompt dialog 
box. The dialog box prompts the operator when 
there is a large number of members to display.
100 is the default.


com.smarts.maxTopoInstances integer Enables you to change the maximum number of 
instances that display for a class or relationship in 
the Topology Browser. 
The default is 1000. EMC Corporation recommends 
not changing the default unless it is necessary 
because it affects performance and usability.


Table 23  Properties and their values (page 2 of 6)


Property
Acceptable 
value Description
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com.smarts.viewer.hideToolbarText  true or false True — Hides the display text for the toolbar 
buttons. (This is the default.)
False — Shows the text for the toolbar buttons.


com.smarts.viewer.map.disableMaps true or false True — Disables the display of maps.
False — Does not disable maps. (This is the 
default.)


smarts.allowBGjpegs true or false True — Allows map background files to be saved in 
jpeg (.jpg) format.
False — Does not allow map background files to be 
saved in jpeg format.


com.smarts.disable_keepalives integer Enables you to disable KeepAlive messages for the 
Global Console. Specify a non-zero number to 
disable KeepAlive messages. Zero (0) enables 
KeepAlive messages.


com.smarts.log.level option Defines the level of messages written to the 
console java log. Options include:
• FATAL
• SEVERE
• SERIOUS
• DEFAULT (default option)
• WARNING
• INFO
• CONFIG
• DEBUG
• TRACE


Notice: Options are listed in order from display 
least information to display most information.


com.smarts.securityEnabled true or false True — Enables security. (This is the default when 
the sm_gui.exe is executed.)
False — Disables security.


Notice: This property must be specifically declared 
and set to true in the Web Console and in the 
viewlets.


smarts.remote.broker host:port Defines the default broker for domain attach 
dialog boxes.


com.smarts.writeable path string Defines the location of console logs.


com.smarts.debugConnection true or false True — Causes the server to write all console 
operation invocations received from the console to 
the server log file.
False — Does not cause the server to write console 
operation invocations received from the console to 
the server log file.


Table 23  Properties and their values (page 3 of 6)


Property
Acceptable 
value Description
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com.smarts.highLatency true or false True — Reduces the number of calls to the server 
to obtain property values. Returns larger packets 
of data containing bundled property values.
False — Smaller multiple calls are sent to the 
server to obtain multiple property values.
The highLatency parameter can be added to any 
Service Assurance Manager related dxa 
configuration file used to import data from an 
underlying server that is part of a high latency 
network environment. Examples of applicable dxa 
configuration files include dxa-conn.conf, 
dxa-sam.conf, and dxa-oi.conf. For the majority of 
configurations, the highLatency parameter will 
apply to the presentation Service Assurance 
Manager server (dxa-sam.conf) when the 
underlying aggregation Service Assurance 
Manager server is remotely located.


Notice: Before updating the dxa-conn.conf file, 
back up the file.


com.smarts.user.timezone timezone 
name


Causes the console to format all times and 
timestamps according to the specified time zone. 
Examples of acceptable values are: PST for U.S. 
Pacific Standard Time and GMT for Greenwich 
Mean Time.
The default is the time zone where the console is 
running.
Class TimeZone at the Java website includes 
additional information.


Notice: Older versions of the console used the Java 
user.timezone parameter to change the time zone, 
but the user.timezone parameter does not work 
with the Web Console or Java Web Start.


Table 23  Properties and their values (page 4 of 6)


Property
Acceptable 
value Description
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com.smarts.timestampFormat pattern-form
at string


Overrides the default formatting of timestamps in 
the console, for example, the First Notify, Last 
Notify, and Last Change fields in the notification 
view.
An example of the default format is 28 Mar 
17:08:09.
Using the new parameter, you can change this to a 
different format. The following examples illustrate 
different configurations of the 
com.smarts.timestampFormat parameter:
• 03.28 17:08:09-0500 — Displays the local time 


zone offset from GMT.
• 28 Mar 17:08:09 EDT — Displays the local time 


zone as text.
• 07.03.28 17:08:09 — Displays the year.
To configure the com.smarts.timestampFormat 
parameter, enter a Java SimpleDataFormat 
pattern-format string as the value of the 
parameter.
The format language for constructing the pattern 
string is specified in the Java J2SE 5.0 
documentation, available from the Sun website, in 
the description of the java.text.SimpleDateFormat 
class.
For example, the console’s default timestamp 
format is: dd MMM HH:mm:ss. The alternative 
formats illustrated above have the following 
pattern strings:
• "03.28 17:08:09-0500" "MM.dd HH:mm:ssZ" 


(to display the local time zone offset from GMT)
• "28 Mar 17:08:09 EDT" "dd MMM HH:mm:ss z" 


(to display the local time zone as text)
• "07.03.28 17:08:09" "YY.MM.dd HH:mm:ss" (to 


display the year)


Notice: Characters in the format string are case 
sensitive: "Z" means something different and will 
produce different strings than "z".


com.smarts.oldGetMap true or false Defines whether the console retrieves map data as 
a string or as formatted data. If set to true, the 
console retrieves map data as formatted data.
Default value: False


com.smarts.getMap.timeout integer Defines the time, in seconds, that the Get Map 
function tries to retrieve map data before the 
function times out. Once the Get Map function 
times out, the Get map timed out message 
appears.
Default value: 120


Table 23  Properties and their values (page 5 of 6)


Property
Acceptable 
value Description
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com.smarts.clientTool.setEnv true or false Defines the method of passing parameters to 
client scripts. If configured to true, the console 
directly loads parameters passed to the client 
script into the environment. 
Configuring this property to true, enables 
parameters with values that cause Windows 
parsing of the command to fail to be passed to the 
client script.
If configured to false (or when a value is not 
specified), the console passes parameters to the 
client scripts as command line arguments and 
requires the client script to parse the parameters 
to load them into the environment. 


Notice: Setting this property to false is backward 
compatible for existing scripts that parse the 
command line parameters and create environment 
variables. When this property is set to true, the 
script does not receive any command line 
parameters to parse, because the properties 
already exist as variables in the environment, as if 
the script had parsed and set them but without the 
script actually having to do so.


com.smarts.fasttopologybrowse option Defines whether the topology browser 
performance is enhanced for displaying related 
instance information. Options include:
• Off — Default value
• On — Speed up enhancement is activated with 


instance information sorted
• Nosort — Speed up enhancement is activated 


with instance information not sorted


Notice: When configuring this property to nosort, 
relation information displays more quickly in the 
topology tree in high latency environments 
because instance names are not sorted. When 
many related instances for a class are displayed, 
specific instances may be difficult to locate 
because instance names beginning with identical 
characters may not be grouped together. For 
example, when this property is configured to 
nosort, not all router instances beginning with the 
characters Chicago may be displayed together.


com.smarts.showDomainConsistsOf true or false Defines whether the InChargeDomainConsistsOf 
relationship displays in the topology view. If 
configured to false, the 
InChargeDomainConsistsOf relationship does not 
display in the topology view reducing the 
possibility of the console not responding. If 
configured to true, all the information for the 
ConsistsOf relationship displays in the topology 
view.
Default value: False


Table 23  Properties and their values (page 6 of 6)


Property
Acceptable 
value Description
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Increasing the Java heap space size


If the console runs out of memory, the maximum amount of heap space available to the 
console must be adjusted by specifying the -H (or --heapsize=) parameter to the sm_gui 
command.


The default heap allocation is 350 megabytes, which may not be sufficient for large or 
complex deployments.  (The previous default heap space size was 256 megabytes.)  As 
heap space becomes close to being fully allocated, the console tries to enter warning 
messages in the console’s Java Message Log.  But often, the memory is allocated in a 
single uninterrupted operation, resulting in no message being written to the console’s 
Java Message Log. For example, during the initial loading of notifications at startup time, if 
there are more than 60,000 notifications to be loaded and the available heap space is 
less than 270 megabytes, the console may close down without any warning message. 
However, in this example if just enough space is available, the console may become 
unresponsive due to Java’s attempts to find space in a garbage collection.  


To increase the Java heap space size, allocate additional heap space. For example, to 
allocate 800 megabytes of heap space, type the following from the command line:


sm_gui -H800M <other -D parameters ...>


The EMC Smarts Service Assurance Manager Dashboard Configuration Guide provides 
heap size considerations for the Web Console and Business Dashboard. 


Tailoring your console with views
The Global Console is usually defined by one default view, console-specific toolbar 
buttons, and menus. However, the Global Console can consist of multiple views. The 
following console views are available: Notification Log, Map, Topology Browser, Summary, 
Status Table, Notification Properties, and Containment. 


You can customize a console to display multiple views. For example, you can add a 
Topology Browser view to your Notification Log Console. Or, you can add three Notification 
Log views to a console; each view using a filter for specific notifications. Or, you can 
customize a Notification Log view and copy it in order to provide a consistent display and 
minimize your customization effort.


The following types of views, Notification Log, Topology Browser, Summary, Status Table, 
Notification Properties, and Containment, can be added, copied, or deleted in consoles. In 
the Map Console, the default Map view cannot be added, copied, or deleted. Also, a Map 
view cannot be added to a console. Unlike other types of consoles, there can only be one 
Map Console.


“Availability of Dashboard viewlets” on page 22 includes additional information about 
which views are available through the Global Console, Web Console, Business Dashboard, 
and third-party Web Portal products.
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Adding a view


To add a view: 


1. Select View > Add View. 


The Add View dialog box appears.


2. Click the View Type menu to list the available views. Select the view you want to add to 
the console. (A custom view is one that has been developed by a programmer to work 
with the Notification Log Console.)


3. Use the Console Panel list boxes to arrange views within the console:


• The Panel list box determines where the view appears within the console.


• The Tile list box determines how multiple views within the same panel are 
arranged. Views that are oriented horizontally, such as Notification Log, usually 
display better when they are tiled Top To Bottom.


4. Click OK. 


To add multiple views, reopen the Add View dialog box for each view you want to add.


Adding a custom view containing a Java component
To add a custom view containing a Java component in the console or in the Web console or 
dashboard:


1. Create a class derived from the component.


The component must be in a Java package that does not match any of the existing Java 
packages, for example, com.<customercompanyname>.


2. Create a jar file containing compiled class file(s).


The jar file is specified in the SM_CLASSPATH variable of the runcmd_env.sh. This 
variable can also be set in the individual command window.  The fully qualified path of 
the jar file must be specified.


Example:


SM_CLASSPATH=C:\SAM-NEC4\SAM\smarts\local\classes\foreign.jar


3. From the console, select View > Add View > Custom View.
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4. Type the full class path of the component in the Custom View field.


For example, if the component is compiled into the jar file as 
com.<customercompanyname>.Ourview.class, type 
com.<customercompanyname>.Ourview. 


The component appears in a new view in the console.


To add a view containing a Java component for Java Web Start, you must have your private 
jar file signed with the EMC certificate. Java Web Start requires all jar files to be signed 
with the same certificate.


Copying a view in a current console


To copy a view in the current console: 


1. Click the view you want to copy to activate it. The active view has a black border.


2. Select View > Copy View > Copy View. This displays the Copy View dialog box.


3. Use the Console Panel list boxes to arrange views within the console:


• The Panel list box determines where the view appears within the console.


• The Tile list box determines how multiple views within the same panel are 
arranged. Views that are oriented horizontally, such as Notification Log, usually 
display better when they are tiled Top To Bottom.


4. Click OK. 


This option is not available for the Map view.


Copying a view to a new console


You can copy the following views to a new console: Notification Log, Topology Browser, 
and Summary. 


To copy a view to a new console: 


1. Click the view you want to copy to activate it. The active view has a black border.


2. Select View > Copy View > Copy View as new console. 


The new console displays over the existing console.


This option is not available for Status Table, Notification Properties, Containment, or 
Map.
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Deleting a view


To delete a view from the console:


1. Click the view you want to delete to activate it. The active view has a dark gray border.


2. Select View > Delete View. 


Saving a view as a dashboard viewlet


To save a view as a dashboard viewlet:


1. Select View > Save View As dashboard viewlet. The Configure Save View as dashboard 
viewlet dialog box displays.


2. Select the manager from the list.


3. Click either Save for User or Save for Profile, and then select a user or user-profile from 
the list.


4. Select or type a name in the View Name field.


5. Click OK after your last selection. This immediately applies the parameters to the view 
and closes the dialog box.


The EMC Smarts Service Assurance Manager Dashboard Configuration Guide includes 
additional information on deploying dashboard viewlets.


Changing the title of a Notification Log view 


To change the title of a Notification Log view: 


1. Select Log > Log Properties to display the Log Properties dialog box. 


2. In the Title field, type the new view name. 


3. Click OK. 


This is useful when you have multiple Notification Log views with different filtering criteria.


Context sharing concepts


You can set up context sharing so that a selected entity in one view determines the 
content that is displayed in one or more other views. For example, you can set up context 
sharing so that each time you select a notification in a Notification Log, a Map view 
displays a map for that notification. In this example, the Notification Log acts as a source, 
while the Map view acts as a listener. Without context sharing, you have to select a 
notification in the Notification Log, right-click, and select Show Map to display a map for 
each notification.


Views can participate in context sharing as sources, listeners, or both. To enable context 
sharing, you need to configure listening views as described in “Setting up context 
sharing” on page 163. Source and listening views can also exist in separate consoles.
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Table 24 on page 162 shows the views that can act as sources and indicates which 
entities you can select to change the content in listening views.


The following views can act as listeners: 


◆ Notification Properties (listen only)


◆ Notification Log


◆ Summary


◆ Map


◆ Containment (listen only).


Table 24  Source views and elements for context sharing


Views that can act as sources Entity to select


Notification Log view Notification


Summary view Summary


Notice: When you select a summary as a source, the 
Notification Log configured as a listener displays the 
set of notifications associated with that summary.


Map view Node or edge


Status Table view (source only) One of the following classes on the y-axis:
• ServiceOffering and subclasses
• ServiceSubscriber and subclasses
• HierarchicalGroup
• SelectiveGroup
• ApplicationGroup
Any instance on the x-axis.


Topology view (source only) Topology instance
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Table 25 on page 163 describes the context sharing roles, and shows the icons that 
display when context sharing is implemented.


Context sharing is disabled for a Notification Log view if the Freeze Display option is 
enabled. To enable context sharing, first unfreeze the display by clicking the box icon in 
the title area. “Freezing your display” on page 71 includes additional information.


Setting up context sharing


To configure a view as a listener:


1. Select the view to make it active, and then select View > Listen to Context or click the 
Listen to Context toolbar button. The Select Context To Listen To dialog box displays 
with the options that are appropriate for that view.


2. Select one of the following options:


• Listen to ALL — Select all options that this view can listen to


• Collection Entity


• Instance 


• Summary


• Notification


3. Click OK after your last selection. This immediately applies the parameter to the view 
and closes the dialog box.


Table 25  Context sharing roles and icons


Role Description Icon


Source User selection in a source view changes the content in 
a listening view.


--


Listener The content changes based upon user selection in a 
source view. Any filters set for the listening view will 
continue to control the display.


--


In the title area, this icon indicates that a view is 
configured as a listener. The tool tip for the icon 
indicates which entities the view is configured to 
listen to.


In the title area, this icon indicates that a view is 
actively listening (a user selection in a source view is 
affecting the view).
When a Notification Log is configured as a listener, 
you can click this icon to display the original 
notifications again.
In the Notification and Map view, the tool tip for the 
icon indicates the entity the view is currently listening 
to.
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Removing context sharing


To remove context sharing from a view:


1. Select the view to make it active, then select View > Listen to Context or click the Listen 
to Context toolbar button. The Select Context(s) To Listen To dialog box displays.


2. Select Listen to NONE or any one of the available options that you do not want to listen 
to.


3. Click OK. The Listening to Context icons are removed from the listener view (if the view 
is no longer listening to any option).


Saving a console
After you customize your console, you can save your console locally on the host where the 
Global Console is running or remotely on the host where the Global Manager is running. 
Table 26 on page 164 summarizes the customizations and information that is saved for 
your console.


Console file naming conventions
In order for a console to be saved, you must follow these file naming conventions:


◆ Filenames must consist of letters, numbers, underscores, dashes, or any combination 
thereof. 


◆ Filenames must not contain spaces.


Examples of recommended filenames are: Console_SA, SA-Map, or 
Notification-Log3Views.


Table 26  Summary of saved customizations 


What’s saved What’s not saved


Console customizations (hidden bars, 
layout, titles, views)


Topology


Content customizations (filters and 
selections in the Column Sort Order dialog 
box, except for Click Sort)


Click Sort selections


The names of the Global Managers you 
attached to


The actual notifications or maps


Notice: To save maps, you must save them separately (“Saving a map” on page 143 
includes additional information.)
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Using Save 


To save a console:


1. Select File > Save or click the Save toolbar button. The Specify save destination dialog 
box appears if you are saving the console for the first time. 


2. Click the Local button or the Remote button in the dialog box and perform the steps 
described in “Saving a console locally” on page 165, starting with step 2.


If you have previously saved the console, your customizations are saved accordingly and 
the Specify save destination dialog box does not appear.


Saving a console locally


To save a console locally:


1. Select File > Save As > Save Local As. This displays the Save Console dialog box.


2. Type a name for the console in the Object name field. For a previously saved console, 
the name displays in the field. You can also specify another name with the extension 
.iccon.


3. Choose where you want to save the console or note the default location, 
BASEDIR/smarts/local/consoles.


4. Click Save.


5. In the Select Domains to Reattach dialog box, select one or more Manager that the 
saved console will automatically attach to when the console is opened. (To select 
multiple managers, press the Ctrl or Shift key while making your selections.)


This command saves the console settings to a local file. Whenever you start a session, to 
use the local console, you must open it from a running console (File > Open > Open Local).


Saving a console remotely


To save a console remotely:


1. Select File > Save As > Save Remote As. This displays the Save Remote Console dialog 
box, as shown in Figure 24 on page 165.


Figure 24  Save Remote Console dialog box


2. Select a location to save the console. Choose a Manager. 


3. The Save as field lists the names of existing remote consoles. For a previously saved 
console, the name displays in the field. You can also specify another name without the 
extension .iccon.

Saving a console 165







Customizing Your Console

If a remote console name appears in the field, the existing console might be part of 
your user profile. Contact your administrator to see if you should overwrite the existing 
console.


4. In the Select Domains to Reattach dialog box, select one or more Managers that the 
saved console will automatically attach to when the console is opened. (To select 
multiple managers, press the Ctrl or Shift key while making your selections.)


5. Click OK. To use the customized console, you must open it from a running console (File 
> Open > Open Remote).


6. (Optional) To share the console with other users, from a Windows command line , copy 
the console file from the BASEDIR/smarts/local/consoles/<userid> directory or the 
BASEDIR/smarts/local/consoles/<user_profile> directory to the 
BASEDIR/smarts/local/consoles directory on the remote host.


Write permission to the remote host directory is required for the copy operation.
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Troubleshooting


This chapter contains resolutions to common issues experienced by operators who are 
using the Global Console and includes the following information:


◆ Common issues and resolutions ...........................................................................  168
◆ Common issues for Companion UI.........................................................................  171
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Common issues and resolutions
The following topics are included in this section:


◆ “Checking Manager status” on page 168


◆ “Identifying a port number” on page 168


◆ “Refreshing the console” on page 169


◆ “Reattaching to a Manager” on page 169


◆ “Responding to disconnected Managers” on page 169


◆ “Accessing console message logs” on page 169


Checking Manager status


If you do not know the operational status of your Manager, use the brcontrol command or 
the Browse button in the Attach Manager dialog box to list the Managers and their status. 
The status listed for your Manager should be Running. If your Manager is not running, 
contact your administrator, consult the EMC Smarts System Administration Guide, or refer 
to your specific product’s Installation Guide for instructions on starting the Manager.


For the brcontrol command, type one of the command lines shown in Table 27 on 
page 168.


Identifying a port number


If you do not know the port number of a Manager, use the brcontrol command or the 
Browse button in the Attach Manager dialog box to display the port number. 


Table 27  The brcontrol command


Operating system Example


Windows (MS-DOS prompt) BASEDIR\smarts\bin\brcontrol
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Refreshing the console


If your console does not display properly, you can force the console to redisplay. For 
example, if fragments of menus or fields from dialog boxes linger after the menus or 
dialog boxes close, you can redisplay the console.


To refresh a console, select View > Refresh.


Reattaching to a Manager


Initially, when you log in to start a session, you specify the Manager to which you want to 
attach. Ordinarily, you do not have to attach again during your session.


If the machine running Service Assurance becomes unavailable, the Global Console polls 
the broker every 30 seconds and reattaches when the Manager is operational. “Attaching 
to a Manager” on page 52 includes instructions on manually attaching or reattaching to an 
EMC Smarts Manager.


If an EMC Smarts Manager disconnects, a Domain Disconnected message appears 
informing you that the manager disconnected and that the console will reconnect when 
the domain becomes available.


Responding to disconnected Managers


When underlying Managers disconnect from the Global Manager (for example, due to a 
network outage), the notifications from the unavailable sources are not updated in the 
console. The affected notifications, maps, and summaries no longer reflect the current 
conditions. 


If a disconnect situation occurs, a Session Disconnected notification informs you that a 
specific Manager is disconnected and a similar entry is added to the audit log.


When the Manager reconnects, the Session Disconnected notification clears, and it is 
recorded in the audit log.


If you receive a Session Disconnected notification, your administrator should investigate it 
for a network connection failure or an operational problem. The Manager may need to be 
restarted.


Accessing console message logs


The Global Console has two logs which are useful for troubleshooting:


◆ The Java console is the first tool to use for console debugging. It shows store 
exceptions, errors reading attributes, and stack traces. 


To collect the most information about potential console problems, specify the 
-Dcom.smarts.log.level=TRACE property.


Java console information can automatically be saved to a file on your local workstation 
by specifying the -Dcom.smarts.java.log=<filename> property. When specifying this 
property, the file is written in the <SM_WRITEABLE>/logs directory. 
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SM_WRITEABLE is an environment variable whose default value can be changed in the 
runcmd_env.sh. Use this console information to assist with debugging issues.


Before starting the console with the -Dcom.smarts.java.log=<filename> property, verify 
that the <SM_WRITEABLE>/logs directory exists under BASEDIR/smarts/local.


◆ The message log shows everything the Manager sends to the console while the log 
window is activated (opened or minimized). 


This information can automatically be saved to a file on your local workstation by 
specifying the -Dcom.smarts.server.logMessages=true property. When specifying this 
property, the file is written to the <SM_WRITEABLE>/logs directory. Use this information 
to assist with debugging issues when the console stops responding.


Before starting the console with the -Dcom.smarts.server.logMessages=true property, 
verify that the <SM_WRITEABLE>/logs directory exists.


To access the log views, select View > Java Console or View > Message Log.


In the Java console, the following warning is benign:


Warning: Could not get the full set of system properties
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Common issues for Companion UI
The following topics are included in this section:


◆ “HTTP error page” on page 171
◆ “Domain Manager not configured” on page 171
◆ “Internal error in the Global Manager, Global Console, or Smarts CUI” on 


page 171


When you launch Companion UI from a selected notification in the Notification Log 
Console or view, the following types of errors may appear as a web page in your browser.


HTTP error page
During launching if Companion UI encounters an error whereby it fails to access a service, 
an HTTP error page appears in your browser.


For example, if the Tomcat service is not running, the following error appears:


404 Page Not Found


Domain Manager not configured
If your Domain Manager is not configured as a data source in Companion UI , this error 
appears in your browser:


Launch Companion UI: <domain name> not configured. Please contact your 
System Administrator.


Contact your Smarts CUI administrator for assistance. Also, the EMC Smarts SolutionPack 
Installation and Configuration Guide provides information about adding data sources to 
Smarts CUI.


Internal error in the Global Manager, Global Console, or Smarts CUI
If an internal error occurs in the top-level Global Manager, Global Console, or Companion 
UI, this error appears in your browser:


Launch Companion UI: …


In a Smarts CUI deployment, the top-level Global Manager is configured as the SAM 
Presentation Server.
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Wildcard Patterns


This appendix includes the following information:


◆ Types of wildcard patterns.....................................................................................  174

Wildcard Patterns 173







Wildcard Patterns

Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character 
strings. You can use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a 
time. Basic wildcard patterns are defined in Table 28 on page 174. Characters that are not 
part of match constructs match themselves. The pattern and the incoming string must 
match completely. For example, the pattern abcd does not match the input abcde or abc. 


A compound wildcard pattern consists of one or more basic wildcard patterns separated 
by ampersand (&) or tilde (~) characters. A compound wildcard pattern is matched by 
attempting to match each of its component basic wildcard patterns against the entire 
input string. Compound wildcard patterns are listed in Table 29 on page 175.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) 
character, the compound is interpreted as if an asterisk (*) appeared at the beginning of 
the pattern. For example, the pattern ~*[0-9]* matches any string not containing any 
digits. A trailing instance of an ampersand character (&) can only match the empty string. 
A trailing instance of a tilde character (~) can be read as “except for the empty string.”


Spaces are interpreted as characters and are subject to matching even if they are adjacent 
to operators like “&”.


Table 28  Basic wildcard patterns (page 1 of 2)


Character Description


? Matches any single character. 
For example, server?.example.com matches server3.example.com and 
serverB.example.com, but not server10.example.com.


* Matches an arbitrary string of characters. The string can be empty. 
For example, server*.example.com matches server-ny.example.com and 
server.example.com (an empty match).


[set] Matches any single character that appears within [set]; or, if the first character 
of [set] is (^), any single character that is not in the set. A hyphen (-) within [set] 
indicates a range, so that [a-d] is equivalent to [abcd]. The character before the 
hyphen (-) must precede the character after it or the range will be empty. The 
character (^) in any position except the first, or a hyphen (-) at the first or last 
position, has no special meaning. 
For example, server[789-].example.com matches server7.example.com through 
server9.example.com, but not server6.example.com. It also matches 
server-.example.com.
For example, server[^12].example.com does not match server1.example.com or 
server2.example.com, but will match server8.example.com.
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Special characters for compound wildcard patterns are summarized in Table 29 on 
page 175.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, 
which represent nonnegative integer values. The matching characters are a 
non-empty string of digits whose value, as a nonnegative integer, is greater 
than or equal to n1 and less than or equal to n2. If either end of the range is 
omitted, no limitation is placed on the accepted number.
For example, 98.49.<1-100>.10 matches a range of IPv4 addresses from 
98.49.1.10 through 98.49.100.10. 
Example of an omitted high end of the range: <50-> matches any string of digits 
with a value greater than or equal to 50. 
Example of an omitted low end of the range: <-150> matches any value between 
zero and 150.
For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, 
with * matching no characters. Similarly, it matches strings like 9x, with * 
matching the trailing x. However, it does not match 11, because <1-10> always 
extracts the longest possible string of digits (11) and then matches only if the 
number it represents is in range.


| Matches alternatives. For example, ”ab|bc|cd” without spaces matches exactly 
the three following strings:  “ab”, “bc”, and “cd”. A | as the first or last character 
of a pattern accepts an empty string as a match.
Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) has 
no special meaning within a set ([set]) or range (<n1-n2>) construct.


Table 28  Basic wildcard patterns (page 2 of 2)


Character Description


Table 29  Compound wildcard patterns


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern 
is preceded by & (or is the first basic wildcard pattern in the compound wildcard 
pattern), it must successfully match. 
Example: *NY*&*Router* matches all strings which contain NY and also contain 
Router. 
Example: <1-100>&*[02468] matches even numbers between 1 and 100 inclusive. 
The <1-100> component only passes numbers in the correct range and the *[02468] 
component only passes numbers that end in an even digit. 
Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also 
contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a component 
basic wildcard pattern is preceded by ~, it must not match. 
Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 
except 10.20.30.50.
Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, 
except a Cisco router, with an address on network 10.20.30, except not 
10.20.30.10 through 10.20.30.20.
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Overview

Adapters and ASL
This document shows users how to create or modify custom adapters for EMC® Smarts® 
Domain Managers.


EMC Smarts adapters facilitate the communication of information between devices or 
applications and a Domain Manager. Adapters exist as either inflow adapters or outflow 
adapters. 


◆ Inflow adapters collect information and send it to a Domain Manager. These adapters 
can be used to initialize a Domain Manager with data such as topology information. 
They also can send, as they occur, event information and topology changes to a 
Domain Manager.


◆ Outflow adapters subscribe to a Domain Manager for a set of notifications. These 
adapters then pass the information to devices or other applications.


Figure 1 on page 12 shows the flow of information through an inflow adapter, a Domain 
Manager, and an outflow adapter. 


1. The inflow adapter collects information and passes it to the Domain Manager. 


2. The Domain Manager generates notifications.


3. The outflow adapter subscribes to a set of notifications.


4. The Domain Manager passes those notifications to the adapter. 


5. The outflow adapter passes the information to another entity.


Figure 1  Adapter overview


EMC Smarts installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed.


◆ For Windows, this location is C:\InCharge\<product>.


◆ For UNIX, this location is /opt/InCharge/<product>.


Optionally, you can specify the root of BASEDIR to be something other than:


◆ Windows: C:\InCharge


◆ UNIX: /opt/InCharge


However, you cannot change the <product> location under the root directory.


Domain Manager


X Y Z
0 1 0
1 1 0
0 0 1


Correlation
Engine


TopologyModel and


Outflow adapters


Inflow adapters
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The EMC Smarts System Administration Guide provides more information about the 
directory structure.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Adapter components


All adapters, regardless of type, consist of three basic components: front end, rule set and 
back end. These three components must be included as part of any adapter.


Front end
The front end collects information for processing in the rule set of the adapter. 


◆ The front end of an inflow adapter collects information an external entity.


◆ The front end of an outflow adapter collects information from Domain Manager 
notifications.


Rule set
Rule sets match, filter, and process information received from the front end. The 
processed information is handled by the back end.


Back end
The back end passes information processed by the rule set to other programs or devices. 


◆ The back end of an inflow adapter passes information to a Domain Manager. 


◆ The back end of an outflow adapter passes information from a Domain Manager to 
another device or location.


For example, in Figure 2 on page 14, if an adapter is designed to move SNMP data to a 
Domain Manager, its front end communicates with an SNMP device and its back end 
passes data to a Domain Manager.
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Figure 2  Adapter components


Adapter Scripting Language


The EMC Smarts Adapter Scripting Language (ASL) is used to construct the rule sets of 
adapters. These rule sets are responsible for matching incoming data with patterns and 
processing the matched data. ASL provides an easy-to-use method of moving data into or 
out of a Domain Manager.


Introduction to running adapters


The sm_adapter command starts ASL scripts. The file sm_adapter (sm_adapter.exe for 
Windows) is found in BASEDIR/smarts/bin. Adapters can receive information from files 
and send output to a file or to the screen. To run most of the sample scripts found in this 
guide, use this syntax:


sm_adapter --file=<input_file> <ASL_script_file>


The command starts an adapter that runs a user-supplied script <ASL_script_file>, reading 
data from the file, <input_file>.


Chapter 7, “Running Adapters,” provides additional information about the sm_adapter 
command.
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Setting the locale
A locale is the RFC-1766/3066 compliant specification for language and country. 


The scope of execution of an ASL script is within the context of a Domain Manager. Once 
connected, the locale can be changed by using the setLocale() function.   The syntax is:


<var> = setLocale(<locale>)


The return value is a string representation of the previous setting of the locale, or a default 
value if setLocale() has not yet been called.


The following example sets the locale to French as spoken in France.


old_locale = setLocale(”fr_FR”);
print(“The old locale was “.old_locale);


When setLocale() is called in ASL, the value of the locale is saved in thread-local storage. 
When an ASL script connects to a Domain Manager, the same thread is used for the 
lifetime of the connection session. Therefore, if you call setLocale(“fr_FR”) from an ASL 
script, then the locale is fr_FR for the duration of the ASL script. When the script ends, the 
Domain Manager thread goes away. Other ASL scripts, and other clients each have their 
own connection/session in their own thread, so each thread is independent of the others.


Locale effects on message rendering


Currently, the scope of the setLocale() operation influences text sent from the Domain 
Manager to the ASL script. Specifically, setLocale() affects textual data of these types:


◆ MODEL descriptions obtained from the following operations on SM_System:


• getOpDescription


• getEventDescription


• getPropDescription


• getClassDescription


◆ Error text obtained from the following operations on SM_API_Support:


• getErrorText


The scope of the setLocale() operation has no influence on any other textual data 
communicated between the ASL script and the Domain Manager.   Textual elements 
defined as part of modeled applications (aside from entity description data) are not 
affected by this operation.


Default locale when setLocale() is not called


The default locale to set for an ASL script is determined as follows:


1. The value of the SM_LOCALE environment variable.


2. If SM_LOCALE is not set equal to a value, then the default locale is set equal to en_US.
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String support
The ASL interpreter assumes that ASL Script files are UTF-8 encoded. The interpreter will 
recognize a valid UTF-8 BOM if it is present. The file may contain a valid UTF-8 BOM, but it 
is not required.


ASL is assumed to be working with UTF-8 strings all the time.   The string type in ASL is 
assumed to be a UTF-8 string.


You can print a string by performing the following:


◆ Extract the localized string.


◆ Apply substitutions to the string.


◆ Print the final rendered string.


Obtaining externalized strings


A built-in function for use by internal applications only (EMC Smarts and other EMC 
adopting applications) may be used to retrieve an externalized string. The 
getExternalString() function extracts a string, based on the table name, key, and locale 
that is passed to the function. The getExternalString() function then renders the extracted 
string given a list of substitutions (up to six). 


<var> = getExternalString(<table>, <key>, <locale>)


The <table> and <key> arguments are required.   The <locale> argument is optional.   The 
default value is the value of the SM_LOCALE environment variable. The return value is the 
UTF-8 encoded string that contains the text of the message defined in the table. 


The ASL script may then use the returned string as an argument in the print() built-in 
function, as shown in the following example: 


msg = getExternalString("SMS_MSG","SUCCESS","fr_FR");
print(msg);


Applying substitutions


Applying substitutions may be accomplished by using the formatString() built-in function. 
The formatString() function takes up to seven arguments:


<var> = formatString(<msg>[,<sub_1>][,<sub_2>][,<sub_3>][,<sub_4>][,<sub_5>][,<sub_6>])


The <msg> argument is the string variable which was extracted from a message table. Up to 
six substitution arguments may be specified.


The example below shows the use of the getExternalString() and formatString() built-in 
functions. 


# message table entry:
#
message_table MY_TABLE
message_code  OPER_FAIL_MSG, 
              "Operation &1 failed.  Reason: &2"
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---------------------------------------
// ASL fragment.   An attempt to perform some operation failed. 
// the variable 'operation' holds the name of the operation that
// failed, the variable 'reason' indicates the reason for the failure. 
// 
// extract the string using the default locale (SM_LOCALE)
//


format = getExternalString("MY_TABLE","OPER_FAIL_MSG");


// 
// format the substitutions
// 


output = formatString(format,operation,reason)


// 
// print the resulting string
// 


print(output);


Printing and logging
Messages that are printed by using the ASL print() built-in function are printed to each of 
the active logs in the Domain Manager process. There is no automatic translation of the 
message text. For example, if the message was obtained by calling getExternalString() by 
using a French locale, the message will appear both in the English log and the French log 
in French. The section provides additional information.


Retrieving and setting log, error and trace levels at runtime


There are three computed attributes available to get and set the log, error, and trace levels 
of a Domain Manager at runtime. These computed attributes, described in Table 1 on 
page 28, are available on the SM_JIIM_Support object. The SM_System object is a 
subclass of SM_JIIM_Support and also inherits these computed attributes.


The values of these computed attributes can be retrieved and set, and valid values are:


◆ None


◆ Emergency


◆ Alert


◆ Critical


◆ Error


◆ Warning


◆ Notice


◆ Informational,


◆ Debug


Fatal is a synonym for Critical.

Printing and logging 17







Overview

Retrieving the current level
You can retrieve the current levels of SM_System::SM-System::logLevel, 
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel. A string is 
returned which represents the current level, such as "Warning", "Error", or "Fatal". For 
example:


sm_system = object("SM_System", "SM-System");
curr_error_level = sm_system->errLevel;


Setting the level
To change the current levels, obtain a pointer to the object, and then set the value of 
SM_System::SM-System::logLevel, SM_System::SM-System::errLevel, or 
SM_System::SM-System::traceLevel to the appropriate level. 


In this example, the trace level setting is changed to None. 


sm_system = object("SM_System", "SM-System");
sm_system->traceLevel = "None";


When you change the log, error or trace levels a message is printed in the log file. The log 
message will appear similar to the following:


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6
JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl 
client (id 6), on host host1 with credentials tpadmin1 has changed 
the Trace level to None; in file 
"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458
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Rule set construction
A rule set is a group of rules that may match, filter, and execute actions to process data 
received from an adapter’s front end.


An ASL rule consists of blocks of patterns, filters, and actions. Patterns select the data to 
process by applying a pattern matching to the incoming datastream. Filters control 
whether actions are performed on matched data. Actions process the data.


An ASL rule has the basic form:


<RULE-NAME> {
<pattern-list>
}
filter {
<filter-list>
}
do {
<action-list>
}


Rules begin with a rule name. A rule name must consist of alphanumeric characters 
and/or an underscore (_). The first character of a rule cannot be a number. 


In this guide, by convention, no rule names contain lowercase letters.


Pattern, filter, and action blocks comprise the contents of a rule. None of the blocks are 
required.


Certain ASL words are reserved and should not be used, as described in “Reserved words” 
on page 140.


Braces surround the pattern list and demarcate the pattern block. A pattern block can 
contain one or more action blocks, but cannot contain any filter blocks. For actions 
performed before any pattern matching, an action block can be included inside of the 
pattern block before any pattern matching statements.


The word “filter” followed by a brace ( { ) marks the beginning of a filter block. Another 
brace ( } ) marks the end. A rule can contain no more than one filter block, and that block 
must appear after the pattern block.


The word “do” followed by a brace ( { ) marks the beginning of an action block. Another 
brace ( } ) marks the end. A rule can contain multiple action blocks placed inside a pattern 
block or outside of a pattern block. However, only one action block can appear outside of 
a pattern block.


In this example, the following rule associates a specific pattern with a specific action:


<RULE-NAME> {
<pattern-list> do {<action-list>}
<pattern-list> do {<action-list>}
<pattern-list> do {<action-list>}
}
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The pattern block shown in the example encompasses all of the patterns and all of the 
action blocks. In order to add a filter block, the brace marking the end of the pattern block 
has to follow the last pattern list. Filter information can be added before the last action 
block.


<RULE-NAME> {
<pattern-list> do {<action-list>}
<pattern-list> do {<action-list>}
<pattern-list> 
}
filter {<filter-list>}
do {<action-list>}


Rules can be called from other rules or in an action block. Rules cannot be called from a 
filter. 


<RULE-NAME> {
<OTHER-RULE>
}
filter {
<filter-list>
}
do {
<action-list>
}


Patterns and called rules can be interspersed with action blocks. 


<RULE-NAME> {
<pattern-list> 
do {<action-list>}
<OTHER-RULE>
}


Rules referenced by other rules are considered subordinate to the rule that references 
them. The rule that references a subordinate rule is referred to as superior. The flow of 
control of ASL processing passes from superior rules to subordinate rules and back.


Special rules


Three special rules exist: START, DEFAULT and EOF. Each of these rules must be in 
uppercase letters.


START rule
All rule sets must include a rule named START. The START rule marks the starting point of 
the ASL script when the adapter receives input. However, the START rule does not have to 
be the first rule listed in the script.


START {
<pattern-list>
}
filter {
<filter-list>
}
do {
<action-list>
}
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DEFAULT rule
If the input fails to match any patterns specified by the START rule and the rules called by 
the START rule, a rule named DEFAULT runs automatically. The purpose of the DEFAULT rule 
is to resynchronize the input stream. The DEFAULT rule has the same structure as any other 
rule. However, if the pattern matching of the DEFAULT rule fails, the ASL script aborts.


If the DEFAULT rule is not explicitly defined and the START rule fails, there is an implicit 
DEFAULT rule that is executed. This implicit DEFAULT rule matches the current line of input.


If the implicit DEFAULT rule was added to an ASL script, it would look like this:


DEFAULT {
..eol
}


The string "..eol" is an ASL pattern that, from a starting point, matches all characters up to 
and including an end-of-line. Chapter 4, “Pattern Matching and Filters,” provides 
additional information about patterns.


EOF rule
A rule named EOF runs at the end of an input file. The EOF rule can but should not include 
a pattern matching block. At the end of a file, there is no data for a pattern to match. The 
EOF rule is not required in an ASL script.


EOF 
do {
<action-list>
}


The EOF rule shown in the example does not include a pattern matching section. The 
braces associated with the pattern block are not needed if there is no pattern.
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Rule execution
The first rule executed in an ASL script is the START rule. The START rule runs repeatedly 
until all of the data input is processed. Data input is processed as it is matched with all of 
the patterns of a rule. 


Patterns are components either of the START rule or of other rules called from the START 
rule. As data matches patterns, the starting position for the next pattern match moves to 
the end of the matched data. The next match is tested from this new position and so forth.


The new starting position for pattern matches is permanent when all of the patterns 
associated with the START rule match. Patterns associated with the START rule include 
patterns from all of the rules subordinate to START. If the START rule and all of its 
subordinate rules have executed, the START rule executes again at the new starting 
position.


If patterns in subordinate rules fail to match, control passes to the immediately superior 
rule where an alternate, if it exists, is tried. If an alternate does not exist, the starting point 
for the match is reset to the point when the superior rule executed. Control is passed to 
the next superior rule and the next alternate is tested. This continues until a match is 
made or until the START rule does not match. 


The DEFAULT rule runs when the START rule fails. The DEFAULT rule contains its own pattern 
matching. When the DEFAULT rule matches, the starting point is permanently advanced 
and the START rule is executed. If the DEFAULT rule pattern match fails, the ASL script 
aborts.


The EOF rule runs when the data input is exhausted. It is not necessarily the last rule to 
execute because other rules might be subordinate.
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Operators and Expressions

Data and comments
This section describes the input datastream and the format of comments.


Data


The ASL input datastream consists of characters and markers. Characters include any 
character in the extended ASCII character set. Markers demarcate the boundaries of fields 
and records.


Comments


There are two different formats for comments. A comment is text that begins with two 
slashes (//) and all information to the right of the slashes is ignored. 


// ASL Script to read card information


A comment can also be marked as a block by using a slash followed by an asterisk at the 
beginning (/*) and an asterisk followed by a slash at the end (*/) of the comment block.


/* ASL Script to read card information
   created 1/30/2009 by FTW */
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Variables and their values
Variables are assigned values in an ASL script or at adapter startup. “Variable assignment 
at startup” on page 35 describes how to specify variable values at startup. 


ASL variables do not have a declared type, the values assigned to them are typed. Variable 
values can have the following types:


◆ numeric


ASL stores all numbers as double-floating point.


◆ string


◆ binary


◆ Boolean


◆ list


◆ table


◆ object handle


The section Chapter 6, “Interfacing with a Domain Manager,” provides additional 
information.


◆ datetime


The section “time() function” on page 85 provides additional information.


A variable name can consist of a letter or an underscore, followed by any number of 
letters, underscores, and digits. A variable name is case-sensitive. Uppercase and 
lowercase letters are distinct.


Certain ASL words are reserved and should not be used as identifiers or variables, as 
described in “Reserved words” on page 140.


Any variable can be assigned different types of values. For example, starting with a basic 
ASL statement:


x = ”string”;


The variable x can then be used to store a value:


x = 5.62;


It can also store a Boolean value:


x = TRUE;


For most values, ASL converts one type of value to the appropriate data type for use in a 
function or expression. In this example, the var_w variable is assigned a string of numeric 
characters.


var_w = ”3498”;


The variable, var_w, can be added to a number.


var_y = var_w+100;
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This statement is valid. The number 100 is added to the numeric equivalent of the value 
stored in var_w. There is no intermediate step.


The semicolon terminates the end of these assignment actions in ASL.


Type conversions


In some instances, automatic type conversion does not occur. Some functions return 
values of different types depending on the type of the value passed. For these cases, there 
are variable type conversion functions. Table 1 on page 28 shows the type of conversion 
functions. 


Lists and tables


Lists and tables are special types of values that can store sets of values. Any variable can 
store lists and tables. A value of any type can be assigned to a list or table.


List values
A list is an ordered set of values that are indexed numerically, starting with zero (0). The 
value assigned to a member of a list can be any value regardless of whether it is variable, 
constant value, a table, a list, or other value type. The list() function initializes the variable 
type to be of type list. An example is:


x = list();


Using this syntax, the list is empty. 


There are three methods to add members to a list. 


◆ The first method is:


x = list(<value_1>,<value_2>,<value_3>,...,<value_n>);


The list() function initializes a list. 


◆ The second method specifies an index and assigns a value. This method can also be 
used to change the existing value of a member in a list.


x[100] = value_1;


x[57] = value_2;
◆ The third method appends the value to the list. Using this method, ASL keeps track of 


the index value.


Table 1  Type conversion functions


Syntax Description


string(value) Converts the values as a string type.


boolean(value) Converts the values as a Boolean type. Any nonzero number is 
converted to TRUE. The only strings that convert are “true” and 
“false” including all capitalization variations.


numeric(value) Converts the values as a numeric type. All numeric values are 
stored as double-floating point.
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x += value_1;


Table values
Tables are associative lists. They exist as hashed arrays with a key and value pair 
(<key>,<value>) for each member. The keys for a table must be unique.


A variable may be initialized to be of type table. An example is:


y = table();


To add a value to a table, use the following syntax:


<table_name>[<key>] = <value>;


The value specified for the <key> or for the <value> can be of any value type.


Multicolumn tables can be implemented in two ways. 


The first method implements the multicolumn table as a table of tables:


START {
        .. eol
} do {
        x = table();
        x["a"] = table();
        x["a"]["b"] = 1;
        x["a"]["c"] = 2;
        print(x["a"]["b"]);
        print(x["a"]["c"]);
}


The second method implements the multicolumn table as a single table with joined key:


START {
        .. eol
} do {
        x = table();
        x["a|b"] = 1;
        x["a|c"] = 2;
        print(x["a|b"]);
        print(x["a|c"]);
}


The use of the vertical line character (“|”) to join the keys has no special meaning. Any 
character can be used.


Scope of variables


The scope of variables determines where the value associated with the variable can be 
accessed. In ASL, there are three scope levels:


◆ Local-scoped variables are accessible only from the rule where the variable is 
assigned a value and can be referenced in subordinate rules. 


◆ Driver-scoped variables are accessible from any rule in an ASL script. 


◆ Global-scoped variables are accessible from any adapter that runs on the same 
process where the variable is assigned a value.
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A local-scope variable cannot have the same name as a global-scoped variable.


Driver-scope
Driver-scoped variables are accessible from any rule in an ASL script. There are two 
lifetimes for driver-scoped variables: 


◆ Static 


◆ Record


The difference between the two lifetimes depends on where the variable is assigned a 
value. 


The longer lifetime for a driver-scoped variable is static. When a variable is assigned a 
value at the beginning of an ASL script, before the START rule is executed, it is static. Static 
variables maintain their value across uses of the START rule or until a new value is 
assigned. In Figure 3 on page 30, each time the START rule is invoked, the variable retains 
its value.


Figure 3  Example of a variable with a static lifetime


In the following example, the script counts the number of lines of data in a file. A variable 
is assigned to zero at the beginning of the script. The variable’s value is incremented for 
each line of input. At the end of the script, the value of the variable is printed. In this 
script, the START rule is invoked five times and the variable is not reset.


ASL Script (static_var.asl):
lines=0;
START {


.. eol
}
do {


lines = lines+1;
}


EOF do{
print("Number of lines ".lines);


}


30 EMC Smarts Foundation ASL Reference Guide







Operators and Expressions

Input: (static_var.txt):
line 1
line 2
line 3
line 4
line 5


Output:
$ sm_adapter --file=static_var.txt static_var.asl
Number of lines 5
$ 


The shorter lifetime for a driver-scoped variable is record. A driver-scoped variable has a 
record lifetime when it is assigned a value in a rule. The value of this variable does not 
change until it is reassigned a value or when the START rule exits. A driver-scoped variable 
with a record lifetime is undefined each time the START rule exits. In Figure 4 on page 31, 
each time the START rule is invoked, the variable is undefined.


Figure 4  Example of a variable with a record lifetime 


In the next example, the script demonstrates that driver-scoped variables keep their value 
until the START rule is invoked. In the script, a variable is assigned when the HI rule runs 
(x=TRUE). This variable holds its value when the action block of the program is invoked 
after the HI rule. When the START rule is invoked again, the input fails to match the pattern 
specified by the HI rule so the alternate rule to HI, the THERE rule, is invoked and the 
variable is not assigned a value in this rule. When the execution of the script reaches the 
action block, no variable exists.


ASL Script (record_var.asl):
START {


print("Starting again") 
/* print returns TRUE so can be
 * used outside of a do*/


HI|THERE
}
do {


if (defined(x))
//Tests whether variable exists
{print("x is defined");}


else {print("x is not defined");}
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}


HI {
"hi" eol


}
do { x=TRUE;}


THERE {
"there" eol


}


Input (record_var.txt):
hi
there


Output:
$ sm_adapter --file=record_var.txt record_var.asl
Starting again
x is defined
Starting again
x is not defined
$ 


A driver-scoped variable with a static lifetime remains static, even when a new value is 
assigned in a rule.


Local-scope
Driver-scoped variables have some limitations. For instance, they are not suitable for 
recursion, but local-scoped variables are suitable.


The following example shows a script that uses recursion and a driver-scoped variable. At 
first glance, the script looks like it reverses the order of words that are passed to it. A 
driver-scoped variable x with a record lifetime is used to store a value each time a rule is 
executed. Unfortunately, each time the recursion executes, the word assigned to the 
variable overwrites the existing value. The last value assigned to x is the value that is used 
for all of the recursions. Only the last word appears as output. 


ASL Script (2ndrule_var.asl):
START {


READANDPRINT
}
READANDPRINT {


x:word READANDPRINT|eol
}
do {


print(x);
}


Input (2ndrule_var.txt):
The dog ran.


Output:
$ sm_adapter --file=2ndrule_var.txt 2ndrule_var.asl
ran.
ran.
ran.
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ran.


$ 


Local variables are defined in a rule and have a separate value each time the rule runs. 
Local variables can be referenced in any subordinate rules. They cannot be accessed in 
any other rule. A local variable cannot have the same name as a global variable.


If a local variable is used in a recursive rule, each recursion contains an exclusive value for 
the variable, as shown in Figure 5 on page 33.


Local variables are declared in the pattern block of a rule. These declarations must occur 
before any pattern matching statements. Local variables override variables with the same 
name. Use this syntax to declare a local variable:


local <variable_name>;


Figure 5  Local variables used in a recursive rule


The following example demonstrates how use of a local variable instead of a driver-scoped 
variable changes the output of the script. 


The script reverses the order of words. The rule READANDPRINT iterates until it does not 
match. For each iteration, the value of the word scanned is stored in a local variable. When 
the end-of-line (eol) marker is reached, the READANDPRINT rule no longer matches and the 
recursive rules are completed with the action block. Each value of x is printed, which has 
the effect of reversing the order of the input. The section “End-of-line matches” on 
page 55 provides additional more information about eol markers.


ASL Script (local_var.asl):
START {


READANDPRINT
}
READANDPRINT {


local x = “end”;
x:word 
READANDPRINT|eol


}
do {


print(x);
}


Input: (local_var.txt):
The dog ran.


Output:
$ sm_adapter --file=local_var.txt local_var.asl
end
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ran.
dog
The


$ 


Global-scope
Adapters in the same server or threads in a single process can share global variables. 
Global variables can be of type numeric, string or boolean.


Lists and tables can also be used as global variables but it is not recommended. The ASL 
programmer must exercise caution when using global lists or tables to ensure that a single 
thread or adapter is the "writer" of the list or table. If more than one thread or adapter 
attempts to assign values to a list or table, the likely result will be data loss due to 
rewriting the variables’ values. There is no inherent mutex or lock arrangement in ASL to 
prevent this and it is up to the programmer to ensure against this.


Global variable declarations must be made in the static section of the script file, before 
any rules are declared.


A local variable cannot have the same name as a global variable.


Adapters in the same server or threads in a single process can share global variables. 
Global variables can be of type numeric, string or boolean.


Use this syntax to declare a global variable:


global <variable_name>;


Default variable values


A default assignment assigns a value only if the variable is undefined. 


default <variable_name>=<value_or_expression>;


The scope of a default variable is restricted to driver-scoped with a static lifetime. A value 
must be assigned to a variable declared as default. The value cannot be blank. An 
example of declaring a default variable is:


default x = 5;


Default variables assigned in an ASL script can be overridden by the value of the variables 
specified during the startup of an adapter with the -D option.


Any variable assignment not defined as default can override the default value and, if one 
exists, the value that was assigned by using the -d option. 


The following code fragment prints the number 1 if there is no integer value to assign to y.


x = 1;
default y = 1;


START
do
{       print("x=".x);
        print("y=".y);
        stop();
}
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Output with the -D option:


$ sm_adapter -Dx=2 -Dy=2 default.asl
x=1
y=2


Output without the -D option:


$ sm_adapter default.asl
x=1
y=1


Variable assignment at startup


Variable values can be assigned when the adapter is started by using the -D option. 
Variables assigned by using this method have a static lifetime. Default variables that are 
locally scoped cannot be assigned a value by using this method.


sm_adapter -D<variable_name>=<value>


The value that is assigned by the switch can be overridden by a standard variable 
assignment through either pattern matching or by a variable assignment statement. To 
define a variable so that the -D option overrides the value set in the ASL script, define the 
variable as a default variable in the ASL script.
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Operators
This section describes operators and their order of evaluation.


Arithmetic operators


The addition, subtraction, multiplication, division, and modulus operators can only be 
used with numeric values. The arithmetic operators are described in Table 2 on page 36.


Note: You can isolate the decimal portion of a number with the modulus operator by using 
the syntax: number%1.


For example, this script assigns numeric values to two variables. These numbers are used 
in addition, subtraction, multiplication, division, and modulus operations.


ASL Script (mathematic_do.asl):
START 
do {


a = 36;
b = 4;
print(“Addition “.a+b);
c = a-b;
print(“Subtraction “.c);
d = a*b;
print(“Multiplication “.d);
print(“Division “.b/a);
e = 10%b;
print("Modulus ".e);
stop();


}


Output:
$ sm_adapter mathematic_do.asl
Addition 40
Subtraction 32
Multiplication 144
Division 0.111111111111111
Modulus 2


$ 


Table 2  Arithmetic operators


Operator Description


+ Addition


- Subtraction


* Multiplication


/ Division


% Modulus
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String operators


The concatenation operator is the period (.). The concatenation operator forms a new 
string composed of two values. Variable conversion is handled automatically. 


In the pattern block of a rule, a period is not an operator that concatenates two strings. It 
forces two patterns to match together, as described in Chapter 4, “Pattern Matching and 
Filters.”. 


For example, in this script, four variables are assigned values. The first concatenation 
occurs within the first print statement. The second concatenation is a combination of two 
numbers and is assigned to the variable c. The new string represents a number and can be 
used in calculations.


ASL Script (concat_do.asl):
START 
do {


a = 657;
b = 9283;
x = “cat”;
y = ”dog”;
print(x.y);
c = a.b;
print(c);
stop();


}


Output:
$ sm_adapter concat_do.asl
catdog
6579283


$ 


Relational and logical operators


The relational and logical operators are described in Table 3 on page 37. 


Table 3  Relational and logical operators


Operator Description


== Equal to


!= Not equal to


> Greater than


< Less than


>= Greater than or equal to


<= Less than or equal to


&& Logical AND


|| Logical OR
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Precedence and order of evaluation


ASL evaluates operators in the following order:


1. ( )


2. * /


3. %


4. + -


5. == != < > <= >=


6. && || .


Parentheses are evaluated first. The logical AND, logical OR, and the concatenation 
operator are evaluated last. ASL evaluates operators with the same level of precedence 
from left to right. 
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Patterns
A pattern is a mechanism for matching input. A combination of markers, operators, and 
characters describes a pattern. This combination includes the data to match and the 
operators that control how and when the data matches. More complicated patterns are 
made from simpler patterns.


ASL compares patterns to an input of markers and characters. As each component of a 
pattern matches with data, the next pattern component is compared with the next 
segment of input. If all of the components of a pattern match, the pattern is considered a 
match. If any component of a pattern fails to match its corresponding data component, the 
pattern is not considered a match. 


A pattern that does not match fails. In most cases, when a pattern fails, the rest of the rule 
following that pattern does not execute.


As ASL matches patterns with data, the starting point for the next match moves to the 
position after the data that was matched. When a pattern fails, the starting position does 
not advance and may or may not go back to its original position, depending on how the 
rule containing the pattern is defined.


Figure 6 on page 40 shows that for the first match, the pattern is compared, starting with 
the left-most position in the data. The pattern matches.


Figure 6  Progression of a pattern being compared to data
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As the result of the successful match, the starting point for the next comparison, the 
second match, is immediately after the last successful data match. The pattern matches.


For the third match, the starting position is in a different location again because of the 
previous successful match. This comparison fails and the start position resets. Depending 
on the pattern, the start position resets to either the starting point for this comparison or 
to the beginning of the data.


Using a function in a pattern


Most ASL functions used in the action block of a script can be included in an ASL pattern 
match. The syntax of these functions, when used in a pattern block, is slightly different 
than when used in an action block. To use a function in a pattern block, use the following 
syntax:


function([<value>])


In a pattern block, do not use a semicolon with functions.


Pattern operators
This section describes pattern operators and their order of their order of precedence.


White space handling


White space is defined as one or more of any of the characters assigned to the delimiter 
variable, as described in “Customizing the delimiter” on page 63. By default, the space 
and tab characters are assigned to the delimiter variable. That means any number of 
contiguous space or tab characters constitute white space in the data. 


A pattern is made up of one or more pattern elements. There are many types of pattern 
elements. For example, keywords such as “word”, and “integer” are elements. An element 
can be a literal string (text surrounded by quotes). By default, ASL will ignore any white 
space in the data as it tries to match pattern elements. You can use the dot operator to 
keep ASL from ignoring white space in a pattern match, as described in “Dot operator” on 
page 43. 


When a literal pattern element contains whitespace, ASL does not ignore it. 


For example, if the pattern to match is:


"John" "Doe" integer “st” “Street”


Then ASL will match the following data equally.


John Doe 121st street
JohnDoe121stStreet
John Doe 121 st Street
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The following script matches a word followed by an integer and another word. The dot 
operator is not used, so the delimiters between the words in the data are automatically 
skipped (if they exist). The end-of-line (eol) for each line of data is not matched, which 
causes the START rule to fail. Notice that the second line of input matches even though 
there is no delimiter between the number, 42343, and the title, Manager.


ASL Script (wspace_match.asl):
START {


a:{word integer word}
}
do {


print("Matched with ".a");
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (wspace_match.txt):
Tony 25234 Employee
John 42343Manager
Output:
$ sm_adapter --file=wspace_match.txt wspace_match.asl
Matched with Tony 25234 Employee
Failed match
Matched with John 42343Manager
Failed match


Assignment operator


The characters matched to a pattern can be placed into a variable by using a colon (:) as an 
operator. The syntax of a variable assignment is:


<variablename>:<pattern>


ASL assigns all of the characters that match the pattern to the variable. If the pattern does 
not match, the variable is not assigned a value.


To assign patterns that have more than one element, use braces to group the elements. All 
the components within the braces must successfully match before the variable is assigned 
a value. The syntax is:


<variablename>:{<pattern_1> <pattern_2> <pattern_3> <pattern_4>}


The following script contains three variable assignments. The first and second variables 
are assigned the first and second word, respectively, in the datafile. The last variable is 
assigned an integer followed by two words. 


This last variable demonstrates how patterns can be grouped by using braces. Without the 
braces, the variable is assigned only the integer. 
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The last name in the input file causes the pattern to fail because there is no address 
information.


ASL Script (assign_match.asl):
START {


f_name:word l_name:word
address:{integer word word}
eol


}
do {


print(f_name);
print(l_name);
print(address);


}


DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (assign_match.txt):
John Doe 11 Main St.
Jane Doe 35 Oak Dr.
Bill Jones


Output:
$ sm_adapter --file=assign_match.txt assign_match.asl
John
Doe
11 Main St.
Jane
Doe
35 Oak Dr.
Failed Match
$ 


Dot operator


A single dot (.) between two elements of a pattern indicates that the second element must 
be matched immediately after the first. The dot can be separated from the two elements 
with white space. However, in this case, the white space does not indicate an optional 
delimiter. If a delimiter exists in the input data, this delimiter must be included as part of 
either the first or second element when using the dot operator. 


The following script matches an integer followed by a word. Only the integer is assigned to 
a variable and printed. In this example, the first two lines of data match this pattern. When 
a space is added between the integer and the word, as in line 3 of the data, the pattern 
fails.


ASL Script (sngldot_match.asl):
START {


a:integer.word
eol


}
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do {
print("Matched with ".a);


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (sngldot_match.txt):
95627XFR
34036TFR
11536 GBH


Output:
$ sm_adapter --file=sngldot_match.txt sngldot_match.asl
Matched with 95627
Matched with 34036
Failed match
$ 


Double-dot operator


The double-dot operator (..) matches all characters except for an end-of-line (eol). White 
space can surround the double-dot, but the dots must be together. This operator cannot 
stand alone. Another pattern must follow. The parser matches as few characters as 
possible before matching the pattern that follows. 


The following script matches any string of characters up to and including the word, Smith. 
The pattern fails on the second line of data because there is no Smith before the 
end-of-line (eol) is reached. In the DEFAULT rule, the double-dot operator matches 
everything until the end of the line.


ASL Script (dbldot_match.asl):
START {


a:{
.."Smith"} eol


}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (dbldot_match.txt):
3400 John V. Smith
3502 Kathy McCue
1401 Bruce Smith


Output:
$ sm_adapter --file=dbldot_match.txt dbldot_match.asl
Matched with 3400 John V. Smith
Failed match
Matched with 1401 Bruce Smith
$ 
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Alternative operator


The alternative operator (|) is used to specify an alternate pattern to match if the first 
pattern fails. This operator can be used in a series to create a list of alternatives. When a 
pattern in a list of alternatives matches, the remaining alternatives are not tested.


The alternative operator has the lowest level of precedence of all the pattern matching 
operators. Even the white space operator has a higher level of precedence.


Once an alternate matches, ASL does not back up to test other combinations. For example, 
if the input to an ASL script is:


abc


and the pattern matching is:


{"a"|"ab"} "c"


No match occurs because once “a” matches, “ab” is not tested. ASL compares the pattern 
“c” with the input character “b” and the pattern fails. In general, when constructing a 
series of alternates, it is better to place the more complex (or longer) patterns ahead of 
other patterns.


In the example, braces are used around the alternate expression to control how the 
pattern is evaluated because the alternate operator has the lowest level of precedence. 
Without the braces, the alternate to the pattern "a" is the pattern "ab" "c". “Grouping 
patterns” on page 47 provides additional information on controlling pattern evaluation.


The following script matches one of three numbers followed by an end-of-line. For the first 
number of the input file, the data matches the first alternative so nothing else is checked. 
The second number of the input file does not match any of the alternatives so the pattern 
fails. The third number does not match either the first or second alternative, but it does 
match the third.


ASL Script (alt_match.asl):
START {


a:{
"3400"|"4500"|"4127"} eol


}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}


do {
print("Failed match");


}


Input (alt_match.txt):
3400
3908
4127
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Output:
$ sm_adapter --file=alt_match.txt alt_match.asl
Matched with 3400
Failed match
Matched with 4127
$ 


Maybe operator


In cases where data to be matched might or might not exist in the input, use the maybe 
operator, which is a question mark (?). The maybe operator indicates that a pattern 
matches regardless of whether the matching data exists. ASL assigns a NULL string to a 
variable if a pattern with a maybe operator has no match.


The following script matches an employee number (an integer) and a name (of multiple 
words). The first and third lines of input match. An employee ID and a name exists. Even 
though there is no employee ID number, the second input line matches because ASL 
assigns the variable a NULL string.


ASL Script (0to1_match.asl):
START {
/* (The rep keyword indicates Repeated Pattern Matches) */


a:integer? b:rep(word) eol
}
do {


print("Employee ".b);
print("Employee ID ".a);


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (0to1_match.txt):
4120 Kathy Jones
John L. Doe
3901 David Smith


Output:
$ sm_adapter --file=0to1_match.txt 0to1_match.asl
Employee Kathy Jones
Employee ID 4120
Employee John L. Doe
Employee ID 
Employee David Smith
Employee ID 3901
$ 
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Grouping patterns


Patterns can be grouped by using braces {}. 


Grouping patterns together can extend the information assigned to a variable. For 
example,


x:{word word word}


The variable is assigned if the input consists of three strings. Without the braces, x is 
bound only to the value of the first word match.


Braces also can control how patterns are evaluated. The use of braces can be combined 
with operators:


{word integer}


The braces used in this example force the pattern to match a word followed by an integer 
or nothing at all. A single word or a single integer will not match this pattern.


Precedence of pattern operators


The order of precedence for pattern matching is as follows:


1. {}


2. :


3. whitespace . ..


4. ?


5. |


The alternative operator has the lowest precedence. For example, suppose there are four 
patterns: A, B, C, and D.


A B|C D


is equivalent to 


{A B}|{C D}


The example matches an input of A followed by B, or it matches an input of C followed by 
D.


Grouping patterns by using the braces has the highest level of precedence. For the 
patterns A, B, C, and D:


{A|B} C D


is not equivalent to 


A|B C D
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Pattern elements
Pattern elements are the building blocks for more complex patterns.


String matches


A string match is a match to one or more characters. An example of a string match is:


RULE {
“def”


}


In the example, the string is surrounded by double quotation marks. For every instance 
where quotation marks are used, they can be single or double quotation marks.


If the “def” pattern is compared with an input string of “defdefeedef,” the rule matches 
twice and fails when it reaches the “eedef.”


In the following script, the pattern used for matching is def. The pattern matches def twice 
and fails with the input of eed. When the pattern fails in this script, the DEFAULT rule runs, 
which matches the entire line.


In most of the examples in this chapter, the pattern to match is surrounded by the 
following, which assigns the matched data to the variable a:


a:{
}


“Assignment operator” on page 42 provides additional information.


It is not necessary to include a variable assignment as part of pattern matching. The 
matched data is printed by printing the contents of the variable a. 


ASL Script (str_match.asl):
START {


a:{
"def"}


}
do {


print("Matched with ".a);
}


DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (str_match.txt):
defdefead


Output:
$ sm_adapter --file=str_match.txt str_match.asl
Matched with def
Matched with def
Failed match


$
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The match for some characters requires a special syntax. Table 4 on page 49 contains the 
special characters. 


Pattern matches are by default case-sensitive. “Making patterns case-sensitive or 
case-insensitive” on page 64 discusses how to override the default.


Any character matches


The any() function returns a match if the character that is being evaluated matches any 
character in <character_string>.


any(<character_string>)


In the following script, the any() function matches with the first four characters of the input 
file. The next character causes the pattern to fail and the DEFAULT rule runs.


ASL Script (any_match.asl):
START {


a:any("abc")
}
do { print("Matched with ".a);
}
DEFAULT { ..eol
}
do {


print("Failed match");
}


Input (any_match.txt):
bbacxy


Output:
$ sm_adapter --file=any_match.txt any_match.asl
Matched with b
Matched with b
Matched with a
Matched with c
Failed match
$ 


Table 4  Match syntax for special characters


Character Syntax Notes


tab \t


single quotation mark (') \' The quotation marks surrounding the string that 
contains this code must be double quotes.


double quotation mark (") \" The quotation marks surrounding the string that 
contains this code must be single quotes.


backward slash (\) \\


carriage return \r In most cases, use the eol pattern match instead 
of carriage return. “End-of-line matches” on 
page 55 provides additional information.


line feed \n In most cases, use the eol pattern match instead 
of line feed. “End-of-line matches” on page 55 
provides additional information.
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Notany character matches


The notany() function returns a match if the character that is being evaluated does not 
match any character in the <character_string>.


notany(<character_string>)


In the following script, the notany() function matches the first three characters of the input 
file. The next character causes the pattern to fail and the DEFAULT rule runs.


ASL Script (notany_match.asl):
START {


a:notany("cx")
}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (notany_match.txt):
bbacbxy


Ouput:
$ sm_adapter --file=notany_match.txt notany_match.asl
Matched with b
Matched with b
Matched with a
Failed match
$ 


Char matches


A char match is a match to any character except for a field-separator or an end-of-line. To 
replace the char() function, the any() function has to have a character string that is 256 
characters long. In the following script, the character pattern matches with the letter a, the 
tab, the letter b, the space and finally the letter c before failing when it tries to match the 
eol.


ASL Script (char_match.asl):
START {


a:char
}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}
Input (char_match.txt):
a <tab> b c
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Output:
$ sm_adapter --file=char_match.txt char_match.asl
Matched with a
Matched with 
Matched with b
Matched with 
Matched with c
Failed match


Word matches


A word match is a match to a sequence of characters that ends with, but does not include, 
a delimiting character. Spaces, tabs, field-separators, and ends of line are the default 
delimiting characters. The delimiting characters can be redefined, as described in 
“Customizing the delimiter” on page 63.


The following script is an example of a word pattern that is a match of all characters up to, 
but not including the delimiter. The second time the rule is evaluated, the pattern 
matching starts with the delimiter. The second word match fails because there are no 
characters found before the delimiter is found.


ASL Script (word_match.asl):
START {


a:word
}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (word_match.txt):
city state country


Output:
$ sm_adapter --file=word_match.txt word_match.asl
Matched with city
Failed match
$
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Integer matches


The integer pattern matches a string of numeric characters that may or may not be 
preceded by a minus sign. Any non-numeric character except for a dash (minus sign) is not 
valid for integer matches. The integer pattern matches the first part of the string: 


83294IVBXR


For example, the following script matches each integer and the end-of-line. The match fails 
on the third line of data because there is a decimal point. At that point, the integer is 
matched with 214 and the pattern fails because eol is not a match for .56.


ASL Script (int_match.asl):
START {


a:integer eol
}
do {


print("Matched with ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (int_match.txt):
12300
-375
214.56


Output:
$ sm_adapter --file=int_match.txt int_match.asl
Matched with 12300
Matched with -375
Failed match
$ 


Floating-point number matches


The floating-point number pattern matches a string of numeric characters that may or may 
not be preceded by a minus sign, and that may or may not include a decimal point 
followed by other numbers. Any non-numeric character except for a period or a dash 
(minus sign) is not valid for floating-point matches. 


For example, this script matches each number and the corresponding end-of-line. Only the 
value of float is assigned to the variable so there are no extra lines between the lines of 
output.


ASL Script (float_matches.asl):
START {


a:float eol
}
do {


print("Matched with ".a);
}
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DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (float_match.txt):
173
-3.95
3453.45


Output:
$ sm_adapter --file=float_match.txt float_match.asl
Matched with 173
Matched with -3.95
Matched with 3453.45
$


Hexadecimal matches


The hexadecimal pattern matches a string of hexadecimal characters. These characters 
cannot be preceded by a minus sign. The hexadecimal pattern matches any numeric 
character and the letters a through f. The pattern does not match anything else. When ASL 
assigns a hexadecimal pattern to a variable, the numeric value is kept but not the 
hexadecimal value. 


The following script matches each hexadecimal number and the corresponding 
end-of-line. 


ASL Script (hex_match.asl):
START {


a:hex eol
}
do {


print("Matched with ".a);
}


DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (hex_match.txt):
ff2234
FF
23


Output:
$ sm_adapter --file=hex_match.txt hex_match.asl
Matched with 16720436
Matched with 255
Matched with 35
$ 
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Field-separator matches


A field-separator is inserted into input data by an adapter’s front end. When using input 
files, a field-separator is defined to replace a character of input such as a comma, colon, or 
a vertical bar (|). A field-separator represents a division of data that can include multiple 
words, integers, strings, and even end-of-line (eol). You can use fs to pattern match a 
field-separator, as described in “Field-separator translation” on page 123.


Do not confuse a field-separator with a delimiter. Even though a delimiter can be used to 
separate multiple words, it is best used as a word separator. A field-separator separates 
fields that can contain one or more words. Regardless of the value of the delimiting 
characters, a field-separator is implicitly defined as a delimiter. 


For example, the following script matches a name and an address, which are separated by 
a field-separator. In the input, the field-separator is a colon (:). The name is assigned from 
one or more repeated words that come before the field-separator. The address is assigned 
from the repeated words that follow the field-separator. 


The field-separator is defined when the adapter is run with the following option:


--field-separator 


The input is parsed by the front end and the field-separator is placed into the data.


ASL Script (fs_match.asl):
START {


a:rep(word) fs
b:rep(word) eol


}
do {


print("Name ".a);
print("Address ".b);


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (fs_match.txt):
Jay Ray:11 Main St
Jane Doe:34 Oak Dr


Output:
$ sm_adapter --field-separator=: --file=fs_match.txt fs_match.asl


Name Jay Ray
Address 11 Main St
Name Jane Doe
Address 34 Oak Dr
$ 
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End-of-line matches


One of the markers included in the input is the end-of-line (eol). The eol is added to the 
input data by the front end of the adapter. To match an end-of-line, use eol. 


The following script matches a word and an end-of-line. Notice that the output is different 
from many of the previous examples. 


◆ The first difference is that there were no messages for Failed match. All of the data 
matched. 


◆ The second difference is that there is a space between successive lines of output. This 
is because the eol match is included as part of the output.


ASL Script (eol_match.asl):
START {


a:{word eol}
}
do {


print("Matched with ".a);
}


DEFAULT {
..eol


}
do {


print("Failed match");
}
Input (eol_match.txt):
switch
router
card


Output:
$ sm_adapter --file=eol_match.txt eol_match.asl
Matched with switch


Matched with router


Matched with card
$ 


Repeated pattern matches


The rep() function repeats pattern matches or a rule for a specific number or for one or 
more matches. The syntax is:


rep(<ruleorpattern>[,<number>])


The rule or pattern to repeat is specified by using <ruleorpattern>. The <number> is optional 
and indicates the number of times to match the pattern. If the <number> is not included, 
the pattern is matched one or more times until it fails or until the pattern following it is 
matched. The pattern must match at least once.
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Table 5 on page 56 shows some sample uses of the rep() function. Each sample uses the 
letter P to denote a pattern. 


The following ASL script matches two numbers, one or more words, and then an 
end-of-line. 


◆ The first line of input is matched. There are two numbers followed by two words. 


◆ The second line of input is matched. There are two numbers and three words. The 
second rep() function is repeated until the end-of-line is reached.


◆ The third line of input fails. The line does not contain two numbers at the front of the 
line.


ASL Script (repeat_match.asl):
START {


a:rep(integer,2)
b:rep(word) eol


}
do {


print("Matched numbers ".a);
print("Matched with ".b);


}
DEFAULT {


..eol
}


do {
print("Failed match");


}


Input (repeat_match.txt):
3400 4127 cat dog
4 5 goat lamb cow
1 chicken horse


Output:
$ sm_adapter --file=repeat_match.txt repeat_match.asl
Matched numbers 3400 4127
Matched with cat dog
Matched numbers 4 5
Matched with goat lamb cow
Failed match
$


Table 5  Samples of the rep() function


Example Behavior Note


rep(P) P P P P P P ... Behaves as if a white space operator appears between each 
occurrence of P.


rep(.P) P.P.P.P.P.P.P. ... Behaves as if a dot operator appears between each occurrence 
of P.


rep(..P) ..P..P..P..P..P..P ... The double-dot operator ignores all patterns except for P.
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Boolean expressions


Boolean expressions can be added to a pattern list. If a Boolean expression fails, the 
pattern match also fails.


Boolean expressions are more commonly used in the filter section of a rule than in the 
pattern matching block. Unlike Boolean expressions in a pattern, a failing Boolean 
expression in a filter does not cause the rule to fail. 


The following script matches a name and an integer. The Boolean expression is: 


number>2


If the integer is greater than two, the match succeeds. 


For every line in the input, the word, the integer and the eol are successfully matched. 
When the Boolean expression causes the pattern to fail, the DEFAULT rule is executed and 
Failed Match is printed. 


ASL Script (bool_match.asl):
START {


animal:word 
number:integer
eol
number>2


}
do {


print("Animal ".animal);
print("Number ".number);


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (bool_match.txt):
elephants 4
moose 1
tigers 2
giraffes 3


Output:
$ sm_adapter --file=bool_match.txt bool_match.asl
Animal elephants
Number 4
Failed match
Failed match
Animal giraffes
Number 3
$
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Positional matching


As ASL matches input data, each character is evaluated until a pattern matches or fails. 
You can use two positional matching functions to specify the position where the parser 
starts to test a pattern.


◆ The tab() function


◆ The len() function


tab() function
With the tab() function, you can skip characters of input data by using the following 
syntax:


tab(<char_num>)


The value of <char_num> is the number of characters to skip from the starting position 
when the START rule is invoked. If <char_num> is not specified, the function returns the 
value of the position where the parser starts to test a pattern. 


It is not possible to use the tab() function to move backward (right to left) in the 
datastream. For example, from the first position of a string, you use the tab() function to go 
to position 20, but, you then cannot go back to position 15. You cannot use the tab() 
function to return to data already parsed. Also, the tab() function does not skip over 
markers.


With the assignment operator (:), you can assign all of the characters skipped to the 
variable or the current position if no characters are specified by using the following syntax:


<variable>:tab(<char_num>)


In the following script, the tab() function in this pattern is used to skip the first and middle 
names. The parser goes directly to the last name of each person in the list. In the input 
datafile, each field has a fixed length. The last name field starts at position 16.


At position 16, a single word is matched and assigned to a variable. Then, the current 
starting position of the next pattern is returned. This position varies because the word 
lengths are not equal.


ASL Script (tab_match.asl):
START {


tab(16) lname:word 
locate:tab() eol


}
do {


print("Last Name ".lname);
print("Tab ".locate);}


DEFAULT {
..eol


}


do {
print("Failed match");


}


Input (tab_match.txt):
John            Doe
Jane    Deborah Smith
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Output:
$ sm_adapter --file=tab_match.txt tab_match.asl
Last Name Doe
Tab 19
Name Smith
Tab 21
$ 


len() function
Another positional matching function is len(). The len() function advances the starting 
position from its current position, unlike the tab() function that works from the original 
starting position when the START rule is invoked. The syntax is as follows:


len(<char_num>)


The value of <char_num> is the number of characters to advance from its current position. 
If <char_num> is not specified, the function returns the value of the position where the 
parser would start to test a pattern. 


Like the tab() function, use of the assignment operator assigns all characters skipped to 
the variable. The len() function does not skip over markers.


In Figure 7 on page 59, because of the white space operator between each variable 
assignment, the space between fox and jumps is skipped. The len() function starts with 
the letter j. It ends at position 14, forcing tab (14) to return an empty string. This problem 
could be avoided by eliminating the delimiters, as described in “Customizing the 
delimiter” on page 63.


Figure 7  Example of positional matching
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Peek() function


The peek() function returns a value of TRUE or FALSE depending on whether the pattern 
passed to it matches the current input string. Use of the peek() function does not advance 
the starting position, so input can be scanned before other pattern matching. The peek() 
function stops scanning for a pattern when it reaches a marker.


peek(<pattern>)


The following script looks for the word horse in each input string. The double-dot operator 
is necessary in the pattern so that the peek() function will match any occurrence of the 
word horse in a pattern and not just when it appears first.


If the word horse is found in the input string, the peek() function is TRUE and the rule 
GETLINE executes. GETLINE assigns every word in the string to the variable a. The value of 
a is printed and the peek() function starts with the next input string. If the peek() function 
is FALSE, the rule GETLINE does not execute, but the DEFAULT rule does execute.


ASL Script (peek_match.asl):
START {


peek(..'horse') GETLINE
}
GETLINE{


a:rep(word) eol
}
do {


print("Horse found: ".a);
}


DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (peek_match.txt):
moose horse camel
elephant mule camel
goat llama horse
horse goat llama


Output:
$ sm_adapter --file=peek_match.txt peek_match.asl
Horse found: moose horse camel
Failed match
Horse found: goat llama horse
Horse found: horse goat llama
$
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Not() function


The not() function acts as a logical NOT. If the pattern argument of the function matches, 
the not() function returns failure to the match. When the argument does not match, the 
not() function returns a successful match. The starting point does not advance when the 
not() function is used. 


For example, the following script looks for input strings that do not contain the word 
horse.


◆ If the word horse is found in the input string, the peek() function matches but the not() 
function returns a failed match. In this case, the rule GETLINE does not execute.


◆ If the peek() function does not match, the not() function returns a successful match so 
the rule GETLINE executes.


ASL Script (not_match.asl):
START {


not(peek(..'horse'))
GETLINE


}
GETLINE{


a:rep(word) eol
}
do {


print("No horse: ".a);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (not_match.txt):
moose horse camel
elephant mule camel
goat llama horse
horse goat llama


Output:
$ sm_adapter --file=not_match.txt not_match.asl
Failed match
No horse: elephant mule camel
Failed match
Failed match
$ 


Matching through other rules


Pattern matching can be divided among various rules. From the START rule, other rules can 
be called. Rules that are called can have any or all of these sections: patterns, filters, or 
actions. 


Operators or functions that work with patterns also work with rules. For example, the rep 
function can repeat a rule:


START {
rep(<RULE1>) <RULE2>
}


Pattern elements 61







Pattern Matching and Filters

In the following script, two rules are called from the START rule, PERSON and LOCATION. 
Each rule uses the same pattern to find words until an end-of-line, but assigns values to 
different variables. The values of the variables are printed from an action block under 
START.


ASL Script (other_rules.asl):


START {
PERSON LOCATION


}
do {


print("Name: ".name);
print("Address: ".address);


}
PERSON {


name:rep(word) eol
}
LOCATION {


address:rep(word) eol
}


Input (other_rules.txt):
Jay Ray
11 Main St
Jane Doe
34 Oak Dr


Output:
$ sm_adapter --file=other_rules.txt other_rules.asl
Name: Jay Ray
Address: 11 Main St
Name: Jane Doe
Address: 34 Oak Dr
$ 


In the next example, the DATE and PLACE rules are called from START. The DATE and PLACE 
rules are separated by an alternative operator. For each line of text where DATE matches, 
PLACE is not tested. If DATE does not match, PLACE is tested. 


Notice how the variable assignment works in this example. When either DATE or PLACE 
matches, the entire matched string is returned and assigned to x. The end-of-line is added 
to the string, which affects the output.


ASL Script (operators_rules.asl):
START {


x:{DATE|PLACE}
}
do {


print("Day or place ".x);
}
DATE {


integer.rep("/".integer,2)
eol


}
PLACE {


integer word word eol
}
DEFAULT {


..eol
}
do {


print("Failed match");
}
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Input (operators_rules.txt):
01/05/99
11 Main St
camel horse mule
10/31/01
34 Oak Dr


Output:
$ sm_adapter --file=operators_rules.txt operators_rules.asl
Day or place 01/05/99


Day or place 11 Main St


Failed match
Day or place 10/31/01


Day or place 34 Oak Dr
$ 


End-of-file matches


The end of a file cannot be matched through pattern matching. However, there is a special 
rule, EOF, that runs when the end of a file is reached. “Special rules” on page 21 provides 
additional information about the EOF rule. 


Special variables
Special variables control how ASL evaluates patterns. These variables define the 
delimiters between words, case-sensitivity, and even the data input. 


Customizing the delimiter


You can redefine the delimiters by assigning a string to the built-in variable delim. Use the 
following syntax to define new delimiters:


delim=<string>;


The <string> defines the set of characters to use as delimiters.


The delimiter is specified at the beginning of a script or at the beginning of a rule, before 
any pattern matching. 


◆ If a delimiter statement is placed before all of the rules, the delimiters apply to all 
rules. 


◆ If a delimiter statement is placed in a rule, ASL overrides any previous delimiter 
definitions.


In this example, the delimiter is ":?" for RULE2, but "|" for RULE1 and RULE3. 


delim=":?";


START {
    RULE1 RULE2
}


RULE1 {
   delim="|";


RULE3
}
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The new delimiters override all of the default delimiters except for eol and fs. Each 
character included in the <string> is a separate delimiter.


delim = ":?";


When the string :? is assigned to delim, it defines two delimiters: a colon and a question 
mark. If input data contained the combination (“:?”), ASL interprets the data as two 
delimiters in series.


The match for some characters requires a special syntax. To use tabs and returns as 
delimiters, use the special syntax within the quotation marks, as described in Table 4 on 
page 49. 


For most cases, use the eol pattern match instead of line feed or carriage return. The eol 
character is a delimiter by default and cannot be overridden.


An alternative to using the delim variable is to use a combination of the rep() function and 
the notany() function. For example:


x:rep(notany(":?"))


In the example, ASL assigns to the variable x everything that appears up to a question 
mark or a colon.


Making patterns case-sensitive or case-insensitive


By default, pattern matching is case-sensitive. To override the default case-sensitivity, use 
the case variable. This variable can be used at the beginning of a script or at the beginning 
of a rule, before any pattern matching. The syntax of the case variable is:


case=[exact]|[ignore];


To match case-sensitive patterns, set case equal to exact. For patterns where case does 
not matter, set case equal to ignore. 


If a case variable is placed before all of the rules, the case setting applies to all rules. This 
can be overridden in a rule by using another case variable.


Switching the input of a pattern


For complicated inputs, the pattern matching can be divided among different rules by 
using the input variable. The input variable is assigned to a value which ASL uses for the 
pattern matching that follows the input. The input variable must come at the beginning of 
a rule, before any pattern matching but not at the beginning of a script. If the value 
assigned to the input variable does not end with an eol, an eol is appended to the value. 
The syntax is as follows:


input=<value>;


For example, the following script looks for lines of input that start with the string “Error:”. 
When it finds those strings, the rest of the words are assigned to the variable desc and the 
rule PROCESSDESC is called.


PROCESSDESC takes the variable desc as its input and performs pattern matching based 
on the input. The error level and error message are printed.
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The START rule processes the next line data and, if it is an error, PROCESSDESC runs again. 
At the end of the input file, the rule EOF runs. This rule prints a statement that the errors 
are processed.


ASL Script (input_ex.asl):
START {


"Error:" desc:rep(word) eol
PROCESSDESC


}
PROCESSDESC {


input=desc;
errornumber:integer
errorlevel:word
errormsg:rep(word)
eol


}
do {


print(errorlevel." ".errormsg);
}
DEFAULT {


..eol
}
do {


print("No Error");
}
EOF
do {


print();
print("Errors Processed");


}


Input (input_ex.txt):
Error: 2568 Severe Can't process
Status: 2358 Starting backup
Error: 1202 Warning Bad data
Error: 923 Critical Wrong Number


Output:
$ sm_adapter --file=input_ex.txt input_ex.asl
Severe Can't process
No Error
Warning Bad data
Critical Wrong Number


Errors Processed
$ 
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Filters
A filter determines whether the action block of a rule executes. When a filter fails, the 
subsequent action block does not execute. Unlike a pattern, if a filter fails, the rule it is 
called from does not fail.


A filter has the form:


filter {
{<filter-list>}
}


The <filter-list> must be a single Boolean expression. ASL evaluates this expression from 
left to right. If it is TRUE, ASL executes the actions in the do block. If it is FALSE, ASL does 
not execute the actions in the do block. 


Filter operators are listed in Table 6 on page 66. 


◆ Parentheses have the highest level of precedence. 


◆ The logical operators && and || have the lowest level of precedence. 


Although the filter-list must be a single Boolean expression, you can use the logical AND 
and logical OR to test for more than one condition. 


In the following script example, the filter controls whether an action is performed. The 
script matches a word and an eol. The value of the word is assigned to x.


The filter is true when x has the value “switch.” For the input file, this occurs in the first 
line and the fourth line. The action block is executed twice. The DEFAULT rule is never 
executed because the pattern always matches.


Table 6  Filter operators


Operator Definition


() Grouping operators


+ - * / % Arithmetic operators


== Equal to


!= Not equal to


> Greater than


< Less than


>= Greater than or equal to


<= Less than or equal to


&& Logical AND


|| Logical OR
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ASL Script (simple_filter.asl):
START {


x:word eol
}
filter {


x=="switch"
}
do {


print("Filter match: ".x);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (simple_filter.txt):
switch
router
card
switch


Output:
$ sm_adapter --file=simple_filter.txt simple_filter.asl
Filter match: switch
Filter match: switch
$


In the next example, the script matches a word and an eol. The value of the word is 
assigned to x. The filter is true when x has the value “switch,” or when it has the value 
“router.”


ASL Script (other_filter.asl):
START {


x:word eol
}
filter {


x=="switch" || x=="router"
}
do {


print("Filter match: ".x);
}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (other_filter.txt):
switch
router
card
switch


Output:
$ sm_adapter --file=simple_filter.txt simple_filter.asl
Filter match: switch
Filter match: router
Filter match: switch
$ 
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Filters can be useful for debugging. Setting a single variable at the beginning of a script 
can affect the actions that a script performs.


debug = TRUE;
START {
x:word eol
}
filter {
debug==TRUE
}
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Action block
The action block is executed for a rule when pattern matching succeeds (or does not exist) 
and the filter is TRUE (or does not exist). An action block uses the following form:


do {
<action-list>
}


Action lists can occur only within a do block. An action list is composed of statements. 
Statements include variable assignments, conditional actions, and rules. Each statement 
must end with a semicolon. An example of an action block is as follows:


do {
statement_1;
statement_2;
statement_3;
}


Operators


In the action block, statements are terminated with a semicolon (;). Although a semicolon 
is not required to immediately follow the statement, it must occur before the next 
statement.


All other operators used in the action block are described in “Operators” on page 36.


Iteration and control statements
Iteration and control statements are not followed by a semicolon. They may control other 
statements that require the use of semicolons.


foreach statement


The foreach statement iterates through all of the members of a list or a table. The syntax 
is:


foreach <variable> (<list_or_table_name>) {statements}


When the foreach statement is used with a list, the variable stores the value of each 
member of the list every time the foreach statement loops. The members returned are in 
numerical order by their list indices.


The following script matches numbers from an input file and stores the values in a list. The 
foreach statement cycles through every value stored in the list. Each value is printed and 
added to a subtotal, which is also printed.


ASL Script (foreachlist_do.asl):
data = list();
total = 0;
START {


rep(NUMBERS)|eol
}
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NUMBERS {
x:integer


}
do {


data += x;
}


DEFAULT {
..eol


}
do {


print("Failed match");
}


EOF 
do {


foreach i (data) {
total = total + i;
print("Number: ".i);
print("Subtotal ".total);


}
}


Input (foreachlist_do.txt):
2 4 8


Output:
$ sm_adapter --file=foreachlist_do.txt foreachlist_do.asl
Number: 2
Subtotal: 2
Number: 4
Subtotal: 6
Number: 8
Subtotal: 14
$ 


When the foreach statement is used with a table, the variable receives the keys to the 
members of the table. Tables have no inherent order. 


The next script matches numbers and words from an input file and stores the values in a 
table. The foreach statement cycles through every key stored in the table. Each key is 
printed as well as the associated value. The order in which the members of the table are 
printed is not necessarily the order in which the members were added to the table.


ASL Script (foreachtable_do.asl):
pop = table();
total = 0;
START {


rep(NUMBERS)
}
NUMBERS {


count:integer animal:word 
eol


}
do {


pop[animal] = count;
}
DEFAULT {..eol}
do {print("Failed match");}


EOF 
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do {
foreach w (pop)
{


print("Animal ".w);
print("Number ".pop[w]);


}
}


Input (foreachtable_do.txt):
2 cows
4 cats
6 dogs
8 chickens


Output:
$ sm_adapter --file=foreachtable_do.txt foreachtable_do.asl
Animal chickens
Number 8
Animal cows
Number 2
Animal cats
Number 4
Animal dogs
Number 6
$ 


while statement


The while statement repeats a block of statements while a condition is true. The syntax is 
as follows:


while <condition> {<statements>}


The following script has no pattern matching. The variable x is printed and incremented by 
one until it is no longer less than five. 


ASL Script (while_do.asl):
x=0;
START
do {


while x < 5
{


print(x);
x=x+1;


}
stop();


}


Input:
none


Output:
$ sm_adapter while_do.asl
0
1
2
3
4
$ 
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if else statement


The if else statements control what actions are performed based on the results of a 
conditional test. The syntax is as follows:


if (<conditional_test>) {<statements>} [else {<statements>}]


◆ If the conditional test is true, the statements following the test are executed.


◆ If the conditional test is false, the statements following the else are executed. 


The else portion of the statement is optional.


Note: The braces around the statements are required, even if there is only one statement.


In the following example, the if statements check whether a value to use in a table exists 
as a key or not. Each key in a table must be unique. In the script, if a key exists, the value 
associated with the key is added to the new value.


This script uses two if statements.


◆ The first if statement tests whether any of the existing keys match the name of the 
animal ready to be loaded into the table. If the animal name matches any of the 
existing keys, a flag is set to TRUE.


◆ The second if statement tests whether the flag is FALSE. If the flag is FALSE, the animal 
name and number are added to the table. If the flag is TRUE, the number of animals 
are added to the animal count already stored in the table.


ASL Script (if_do.asl):
z = table();
START {


rep(IMPORT)
}
IMPORT {


animal:word 
count:integer 
eol


}


do {
test="FALSE";
foreach i (z)
{


if (i == animal)
{


test="TRUE";
}


}
if (test=="FALSE")
{


z[animal]=count;
}
else
{


z[animal]=z[animal]+count;
}


}
EOF
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do {
foreach i (z)
{


print(i." count ".z[i]);
}


}


Input (if_do.txt):
dog 3
cat 4
canary 3
cat 2
dog 5
dog 1
cat 1


Output:
$ sm_adapter --file=if_do.txt if_do.asl
dog count 9
cat count 7
canary count 3
$ 


break statement


The break statement stops processing statements inside of a loop and exits the loop. The 
break statement is valid only inside of foreach or while loops.


This example is similar to the if statement example except that a break statement has 
been added. “if else statement” on page 73 provides additional information about the if 
statement. 


The break statement causes the test in the foreach statement to stop once the condition is 
TRUE rather than continuing to test.


ASL Script (break_do.asl):
z = table();
START {


rep(IMPORT)
}


IMPORT {
animal:word 
count:integer 
eol


}
do {


test="FALSE";
foreach i (z)
{


if (i == animal)
{


test="TRUE";
break;


}
}
if (test=="FALSE")
{


z[animal]=count;
}
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else
{


z[animal]=z[animal]+count;
}


}


EOF
do {


foreach i (z)
{


print(i." count ".z[i]);
}


}


break_do.txt (Input):
dog 3
cat 4
canary 3
cat 2
dog 5
dog 1
cat 1


Output:
$ sm_adapter --file=break_do.txt break_do.asl
dog count 9
cat count 7
canary count 3
$ 


continue statement


The continue statement starts the next iteration of a foreach statement or while statement. 
When ASL invokes the continue statement, the remaining statements in the foreach or 
while loop are skipped. The continue statement is not valid outside of a loop.


In the following example, an if statement checks whether values in a table are positive. For 
any number less than or equal to 0, the continue statement advances the foreach loop.


ASL Script (continue_do.asl):
x = table();


START {
LOAD


}
LOAD {


y:word z:integer eol
}


do {
x[y] = z;


}
EOF 
do {


foreach w (x)
//skip if not positive
{if (x[w]<=0)


{continue;
}


print(w." ".x[w]);
}


}
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Input (continue_do.txt):
elephant 0
goat -1
worm 100
chicken 7
dog 2
cat 0
moose 9


Output:
$ sm_adapter --file=continue_do.txt continue_do.asl
dog 2
moose 9
chicken 7
worm 100
$ 


Function reference
This section discusses the different types of functions that are available.


glob() function


The glob() function returns a TRUE or FALSE based on whether a pattern matches a string. 
The glob() function can be used as a conditional test for an if or while statement. The 
syntax is as follows:


glob(<pattern>, <string>)


The expression for a glob() function is a series of characters (or patterns) that are matched 
against incoming character strings. You use these expressions when you define matching 
criteria.


Matching is done strictly from left to right, one character or basic glob expression at a 
time. Characters that are not part of match constructs will match themselves. The pattern 
and the incoming string must match completely. For example, the pattern abcd does not 
match the input “abcde” or” abc”. 


A compound glob pattern consists of one or more basic wildcard patterns separated by 
ampersand (&) or tilde (~) characters. A compound wildcard pattern is matched by 
attempting to match each of its component basic wildcard patterns against the entire 
input string.
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The pattern used in the glob() function is not the same pattern used in the pattern block of 
an ASL script. The symbols that describe the pattern are described in Table 7 on page 77. 


Spaces are interpreted as characters and are subject to matching even if they are adjacent 
to operators like “&.”


If the first character of a compound wildcard expression is an ampersand (&) or tilde (~) 
character, the compound is interpreted as if an asterisk (*) appeared at the beginning of 
the pattern. For example, the following two expressions are equivalent to each other:


~*[0-9]*


*~*[0-9]*


Both of these expressions match any string that does not contain any digits. 


A trailing instance of an ampersand character (&) can match only the empty string. A 
trailing instance of a tilde character (~) can be read as “except for the empty string.”


Table 7  Symbols for a glob pattern 


Symbol Description


* Matches an arbitrary string of characters. The string can be empty.


? Matches any single character.


^ Acts as a NOT. Use this in conjunction with other symbols or characters.


[set] Matches:
• Any single character that appears within [set], or
• Any single character that is not in the set if the first character of [set] is (^).
A hyphen (-) within [set] indicates a range, so that [a-d] is equivalent to [abcd]. 
The character before the hyphen (-) must precede the character after it or the range 
will be empty. 
The character (^) in any position except the first, or a hyphen (-) at the first or last 
position, has no special meaning. 


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, 
which represent non-negative integer values. The matching characters are a 
non-empty string of digits whose value, as a non-negative integer, is greater than 
or equal to n1 and less than or equal to n2. If either end of the range is omitted, no 
limitation is placed on the accepted number.


| Matches alternatives. For example, ”ab|bc|cd” without spaces matches exactly the 
three following strings: “ab”, “bc”, and “cd”. A vertical bar (|) as the first or last 
character of a pattern accepts an empty string as a match.


\ Removes the special status, if any, of the following character. Backslash (\) has no 
special meaning within a set ([set]) or range (<n1-n2>) construct.


& “And Also” for a compound wildcard pattern. If a component basic wildcard 
pattern is preceded by & (or is the first basic wildcard pattern in the compound 
wildcard pattern), it must successfully match. 


~ “Except” for a compound wildcard pattern (opposite function of &). If a 
component basic wildcard pattern is preceded by ~, it must not match. 

Function reference 77







Actions

The following script prints sentences that contain the characters “Ship” or “ship.” 


ASL Script (glob_do.asl):
START {


sentence:rep(word) eol
}
do {


if (glob("*[Ss]hip*",sentence))
{print(sentence);}


}


Input (glob_do.txt):
I have a ship that floats.
Shipping is a big industry in Hong Kong.
The dog ate my homework.
I fell down and hurt my hip.
A boat is much smaller than a ship.


Output:
$ sm_adapter --file=glob_do.txt glob_do.asl
I have a ship that floats.
Shipping is a big industry in Hong Kong.
A boat is much smaller than a ship.
$ 


stop() function


The stop() function stops the current thread. No arguments are passed to the function. A 
call to the stop() function does not return.


If you call stop() in an ASL thread, and that thread is in a process that has other threads, 
the effect is to simply stop that thread. However, when the thread that is being stopped is 
the only thread that is running, then stopping that thread effectively shuts down the 
adapter (because the adapter shuts down when there are no more active threads). 


The syntax is as follows:


stop()


quit() function


The quit() function stops the back end, or the Domain Manager in the case of inflow 
adapters. No arguments are passed to the function. When the quit() function is 
encountered, the ASL script immediately ceases execution. 


A call to the quit() function does not return, except when you run sm_adapter with the -s 
option to connect the adapter to a remote Domain Manager, and then you call quit(). In 
this case, the remote Domain Manager initiates its shutdown procedure and the function 
does return. The calling script continues running while the remote Domain Manager shuts 
down (which may take more than a few seconds). The script may even interact with the 
back-end Domain Manager during the interval between calling quit() and the Domain 
Manager actually shutting down. And so long as the script never tries to interact with the 
back-end Domain Manager once it has shut down, the script can continue running 
indefinitely.
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The syntax to stop a remote adapter is as follows:


quit();


The syntax to stop the current adapter is as follows:


self->quit();


If you launch sm_adapter and do not specify a back end, the adapter 
becomes its own back end.  In such cases, quit() does the same thing 
as self->quit().


defined() function


The defined() function returns TRUE if a variable has a value.


This example is a refinement of the if example. The section “if else statement” on page 73 
provides additional information. 


By using the defined() function, several lines of the script are removed, including a foreach 
statement and an if statement.


The single if statement verifies whether a table key entry exists in the table. If the name 
exists, the number of animals is added to the animal count already stored in the table. If 
the name does not exist, the animal name and number are added to the table. 


ASL Script (defined_do.asl):
z = table();
START {


rep(IMPORT)
}
IMPORT {


animal:word 
count:integer 
eol


}


do {
if (defined(z[animal]))
{


z[animal]=z[animal]+count;
}
else
{


z[animal]=count;
}


}
EOF
do {


foreach i (z)
{


print(i." count ".z[i]);
}


}


Input (defined_do.txt):
dog 3
cat 4
canary 3
cat 2
dog 5
dog 1
cat 1
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Output:
$ sm_adapter --file=defined_do.txt defined_do.asl
dog count 9
cat count 7
canary count 3
$ 


undef() function


The undef() function clears a variable, including lists and tables, or a table member. A list 
entry cannot be undefined. An undefined variable has no value. Other statements and 
functions cannot use it until it is reassigned a value.


The undef() function cannot be used to undefine a global or static variable.


sizeof() function


The sizeof() function returns a number depending on the value passed to the function. The 
sizeof() function converts any values (except for a list or a table) to a string, and returns 
the number of characters in the string. For lists and tables, the sizeof() function returns the 
number of defined members. 


The syntax is one of the following:


◆ sizeof(<value>)


◆ sizeOf(<value>)


The following script matches a line of text in a file. The length of each line is measured and 
printed.


ASL Script (sizeOf_do.asl):
START {


x:rep(word) eol
}
do {


y = sizeof(x);
print("Length ".y);


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (sizeOf_do.txt):
This has a size of 21
size of 9


Output:
$ sm_adapter --file=sizeof_do.txt sizeof_do.asl
Length 21
Length 9
$ 
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substring() function


The substring() function returns a string. The returned string is a piece of the string passed 
to the function. The syntax is as follows:


substring(<string>, <starting_position>, <characters_to_return>)


The <starting_position> value indicates the beginning of the new substring taken from the 
<string>. The first position of a string is position 0. The <characters_to_return> value 
indicates the number of characters to return starting with starting_position. 


For the following script, the input is a 12-line text file. Each line has 10 characters.


For the first line of input, the substring() function returns the entire string. For subsequent 
lines of input, a character is removed from the beginning of the string.


When the starting position is greater than the number of characters in the original string, 
no characters are returned.


ASL Script (substring_do.asl):
y=0;
START {


x:word eol
}
do {


newstring=substring(x,y,10);
print("New string ".newstring);
y = y+1;


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (substring_do.txt):
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789
0123456789


Output:
$ sm_adapter --file=substring_do.txt substring_do.asl
New string 0123456789
New string 123456789
New string 23456789
New string 3456789
New string 456789
New string 56789
New string 6789
New string 789
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New string 89
New string 9
New string 
New string 
$ 


toLower() function


The toLower() function returns a string, converting any uppercase letters in the original 
string to lowercase. The syntax is as follows:


toLower(<string>);


For example, this script converts strings so that all of the letters following the first 
character in each word are lowercase.


For each word in a person’s name, the initial character is assigned to the initial variable 
and the remaining characters (if there are any) are assigned to the rest variable. The 
toLower() function converts the string stored in the rest variable to lowercase letters. Then, 
the characters stored in the initial and the rest variables are assigned to the fullname 
variable.


Once each name has been read and converted, ASL prints it before the next name is read 
and converted.


ASL Script (toLower_do.asl):
START {
do {fullname="";}


rep(READNAME) eol
}
do {


print(fullname);
}


READNAME {
initial:char.rest:word?


}


do {
rest = toLower(rest);
name=initial.rest;
fullname = fullname.name." ";


}
DEFAULT {


..eol
}
do {


print("Failed match");
}


Input (toLower_do.txt):
JOHN DOE
JANE Q PUBLIC


Output:
$ sm_adapter --file=toLower_do.txt toLower_do.asl
John Doe
Jane Q Public
$ 
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toUpper() function


The toUpper() function returns a string, converting any lowercase letters in the original 
string to uppercase. The syntax is as follows: 


toUpper(<string>);


The following script assigns the first letter of each word to the variable a. The a variable is 
concatenated with another variable, name, to form an acronym. The toUpper() function 
capitalizes the entire acronym before it is printed.


ASL Script (toUpper_do.asl):
name="";
START {


rep(FIRSTLETTER) eol
}
do {


print(toUpper(name));
}


FIRSTLETTER {
a:char.word?


}
do {


name=name.a;
}


DEFAULT {
..eol


}
do {


print("Failed match");
}


Input (to Upper_do.txt):
I see several tall buildings
New York City


Output:
$ sm_adapter --file=toUpper_do.txt toUpper_do.asl
ISSTB
NYC
$ 


print() function


The print() function sends strings it receives to each of the active logs in the Domain 
Manager process. There is no automatic translation of the message text. The syntax is as 
follows:


print(<argument>);


The value of the argument passed to the print() function can be any data type. The 
argument passed to a print() function is converted to a string before it is printed.
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To print special characters, use the syntax listed in Table 8 on page 84. 


The output of the print() function is dependent on the value of the computed attribute, 
enableLegacyPrint, in GA_Driver. When ASL scripts are run by using sm_adapter, the 
enableLegacyPrint attribute is set to TRUE. In all other cases it is set to FALSE. The default 
value of the enableLegacyPrint attribute is FALSE.


When the enableLegacyPrint is set to FALSE, the print output includes the time, date, 
thread id, and ASL script. When enableLegacyPrint is set to TRUE, only the string that is 
sent to the print() function is printed. 


You need an object handle to a GA_Driver object to set the enableLegacyPrint attribute. 
You can use "Null GA_Driver" which always exists.


In this example, the value of the enableLegacyPrint attribute is changed. The output of the 
print() function is also included.


START { } do {
print("default");
drv = object("GA_Driver", "Null GA_Driver");
drv->enableLegacyPrint = FALSE ? LOG,STOP;
print("new style");
drv->enableLegacyPrint = TRUE ? LOG,STOP;
print("legacy");
stop();


}


Output for "sm_adapter --output /tmp/foo.asl" :


default
[February 6, 2009 12:19:03 AM EST +527ms] t@1088432480 main
ASL_MSG-*-ASLP-/tmp/foo.asl: new style


legacy


sleep() function


The sleep() function temporarily stops the adapter. The syntax is:


sleep(<time_in_seconds>);


The sleep() function is passed a number, which represents the amount of seconds to 
sleep. The sleep() function returns TRUE.


Table 8  Print function special characters


Character Syntax Notes


tab \t


single quote (') \' The quotation marks surrounding the string 
containing this code must be double quotes.


double quote (") \" The quotation marks surrounding the string 
containing this code must be single quotes.


backward slash (\) \\


carriage return \r


line feed \n
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time() function


The time() function works with and without an argument. Without an argument, this 
function returns the current system time. With a numeric argument, the time() function 
adds the argument (as seconds) to the date and time January 1, 1970 00:00:00 GMT and 
returns the new time and date based on the current time zone information. 


The output type of the time() function can be controlled through type casting. By default, 
the function returns a string. If the function is converted to a numeric, the output is 
converted into an integer that represents the number of seconds since January 1, 1970 
00:00:00 GMT. 


For example:


x = string(time());
print(x);


The string() function returns the time in the following format:


DD-MONTH-YYYY HH:MM:SS


However, the following numeric function returns a number similar to 958159632. 


x = numeric(time());
print(x);


Type conversions also work when a value is passed as an argument to the function.


The following script prints the date and time, waits five seconds, and prints the date and 
time again. It also converts a number read from the input file into a date and time.


ASL Script (time_do.asl):
START {


y:integer eol
}
do {


print(time());
sleep(5);
print(time());
x = time(y);
print(x);


}


DEFAULT {
..eol


}
do {


print("Failed match");


Input (time_do.txt):
987517893


Output:
$ sm_adapter --file=time_do.txt time_do.asl
12-May-2000 03:28:47
12-May-2000 03:28:52
17-Apr-2001 10:31:33
$ 
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trace() function


The trace() function turns on or off an internal trace() function that traces how the code is 
parsing the passed parameters. You can turn on the function at a specific point in the code 
to validate that line. This function is useful when creating a rule and validating what is 
being matched.


The trace() function gives you access, from within ASL, to command line options available 
with the sm_adapter command with the following exceptions:


◆ There is no analog of sm_adapter - -traceRules because all rules have already been 
compiled by the time you could turn on tracing of rule compilation. 


◆ Calling the trace() function as trace(“input”,TRUE), turns on tracing at the front end, 
and has no command line equivalent under sm_adapter.


The syntax is as follows:


trace(<string>, <BOOLEAN>)


The <BOOLEAN> argument determines whether tracing is turned on or off.


Table 9 on page 86 lists valid values for <string>. 


For example:


START {
 x:rep(word) eol
 }
 do {
 trace ("parser", TRUE);
 trace ("input", TRUE);
 trace ("server", TRUE);
 }


hexToString() function


The hexToString() function converts values with a hexadecimal format into their equivalent 
ASCII characters. The function pairs the hexadecimal values and converts each pair. The 
syntax is as follows:


hexToString(<value>)


Table 9  Valid values for string


Value Description


parser Matches the input stream against the rule.


input Traces input from the front end.


server Traces the interaction of the remote wire protocol with the server.
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getRuleFileName() function


The getRuleFileName() function returns the filename of the currently executing rule file. 
The syntax is as follows:


getRuleFileName([<fullname>])


The <fullname> argument is optional. If it is omitted or passed as FALSE, only the base 
name of the rule filename is returned. Otherwise, the full name, including the path, is 
returned.


Returning values
By default, a rule returns the characters it matches. A patternless rule returns an empty 
string. Like other patterns, the returned value from a rule can be assigned to a variable.


a:RULE_A


The return statement overrides values returned by a rule. The syntax is:


return <value>;


ASL exits a rule immediately after a return statement. It does not execute any statements 
that follow a return statement.


The next script reads input that consists of a person’s name followed by a field-separator 
and an address. Both the name and address are corrected for capitalization: an uppercase 
letter at the beginning of a word, followed with lowercase letters for the rest of the word.


In the START rule, two variables are assigned values returned from the READWORDS rule. 
Every time the pattern in the START rule matches, the two variables are printed.


The READWORDS rule is a repetition of pattern matching followed by an action block. The 
action block converts the data so that the first letter of a word is capitalized and the rest of 
the letters are lowercase. The word is added to a string called tempstr.


At the end of the READWORDS rule, the return statement returns the correctly capitalized 
string. If there was no return statement, the READWORDS rule would return the string as it 
was read during the pattern matching.


ASL Script (return_do.asl):
START {


fullname:READWORDS fs
address:READWORDS eol


}
do {


print(fullname.address);
}


READWORDS {
do {tempstr = "";}
rep(READ_FIX)


do {return tempstr;
}


}
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READ_FIX {
initial:char.rest:word?


}
do {


initial = toUpper(initial);
rest = toLower(rest);
fixed=initial.rest;
tempstr = tempstr.fixed." ";


}


DEFAULT {
..eol


}
do {


print("Failed match");
}
Input (return_do.txt):
John Q Doe:11 MAin St.
JANE PUblic:387 OAK DR.
HENry HUDSON:9 ELM rd. 


Output:
$ sm_adapter --field-separator=: --file=return_do.txt return_do.asl
John Q Doe 11 Main St. 
Jane Public 387 Oak Dr. 
Henry Hudson 92 Elm Rd. 
$ 


Passing arguments to functions
Rules can act as functions, which can be called from both a pattern block and an action 
block. You can pass values to rules in ASL and receive values back by using the return 
statement, as described in “Returning values” on page 87. The syntax is as follows:


RULE(<variablename>)


The argument of a rule is a local variable.


The following script reads and counts the words in a file. The READWORD rule is passed an 
argument that is used as a counter. The count variable behaves as a local variable. 


ASL Script (rule_arg.asl):
START {


READWORD(1)
}


READWORD(count) {
local y = "end";
y:word
READWORD(count+1)|eol


}
do {


print(y." ".count);
}


Input (rule_arg.txt)
dog cat goat
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Output:
$ sm_adapter --file=rule_arg.txt rule_arg.asl
end 4
goat 3
cat 2
dog 1
$ 


Calling rules as functions from do blocks
Another rule may be called within any do block. Functions have the following generalized 
syntax.


FunctionName (arguments)
do
{


... ASL statement(s) ...


}


Any valid ASL expression may be used in the body of a function. This includes calls to 
other functions and recursive function calls.


Function may have any number of arguments, including no arguments, which are any data 
type that is supported by ASL.


Functions optionally return a value, which are also of any ASL data type. The return value 
may be a constant, or a variable declared within the scope of the function do block, as 
described in “Returning values” on page 87.


A function must be defined in the same ASL script where it is called, and may be defined 
before or after the location where it is referenced. The general syntax used to invoke a 
function references the function by name, passes the number and type of arguments 
expected by the function, and handles the return value, as shown.


Not all functions are required to return a value as shown in the example.


do {
... ASL statement(s) ...


arg1 = x;
arg2 = y;
ReturnValue = FunctionName (arg1, arg2);


... handle ReturnValue ...
}


A function may be defined only outside of a do block. That is, a function may not be 
defined within another function with the intent of referencing the inner function from 
another do block.
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The following is an example of a recursive function definition and call.


START
{ .. eol }
do {


foreach i (list(0,1,2,3,4,5)) {
print (i.”! = “.factorial(i));


}
}


factorial(x)
do {


if (x > 1)
return (x * factorial(x-1));


else
return (x);


}


This example produces the following results.


0! = 0
1! = 1
2! = 2
3! = 6
4! = 24
5! = 120


Exception handling
Exception handling can be added to any action components. Exception handling 
determines how errors from statements or functions are treated. The syntax is as follows:


<action> ? [LOG][,][FAIL|STOP|NEXT|IGNORE]


The question mark handles errors generated by the function. The keywords, that control 
how an exception is handled are described in Table 10 on page 90.


You can specify the LOG keyword with any of the other keywords.


Table 10  Exception handling keywords


Keyword Description


LOG The exception is reported to the English log file and the non-English log file, if 
specified. When a remote exception chain is logged by ASL, the locale defined 
in the SM_LOCALE environment variable will be used. The EMC Smarts System 
Administration Guide provides further information concerning the log files.


FAIL The current rule exits with a failure status. If the failed expression is associated 
with the START rule, the DEFAULT rule is executed.


STOP This is equivalent to calling the stop() function.


NEXT The processing of actions in the current expression block stops. The rule, 
however, is not treated as failed rule.


IGNORE The current action is ignored and processing continues as if nothing happened.
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To define the severity of the exception, arguments can be passed to LOG. Logging levels 
are set by using the syntax:


LOG("<logging_level>")


Valid logging keywords are (in increasing level of severity):


◆ Debug


◆ Notice or Informational


◆ Warning (Default log value)


◆ Error


◆ Fatal or Critical 


When the exception is not specified, the default behavior for exceptions is LOG, NEXT. In 
other words, when an exception occurs, the error is logged and no other actions are 
performed in the current action block. 


Do not confuse the question mark (?) used for exception handling with the question mark 
(?) used with patterns. “Maybe operator” on page 46 provides additional information. 


The following script demonstrates two different keywords to use for exception handling. 
The first exception occurs for:


print(x) ? IGNORE;


There is no value assigned to the variable x, so the function causes an exception. Since 
the keyword is IGNORE, the current line is skipped and the next line is executed.


The second exception occurs for:


print(y) ? FAIL;


There is no value assigned to the variable y, so the function causes an exception. Since 
the keyword is FAIL, the current action block is not completed (and the following print 
statement is not executed) and the START rule fails. Whenever the START rule fails, the 
DEFAULT rule is executed.


ASL Script (exception_do.asl)
START
do {


print("Hello");
print(x) ? IGNORE;
print("OK");
print(y) ? FAIL;
print(“Here I am”);


}
DEFAULT 
do {


print("Default rule");
stop();


}
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Input:
none


Output:
$ sm_adapter exception_do.asl
Hello
OK
Default rule
$ 
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ASL and the MODEL language
In order to create adapters that interact with a Domain Manager, it is necessary to 
understand how the Domain Manager is configured. The adapter creates, deletes, and 
interacts with instances of objects that are defined by using the MODEL language. 


The MODEL language is an object-oriented language used to construct a correlation model 
to describe a managed domain. The language is used to define a set of classes and the 
attributes, relationships, and events that are associated with the classes. 


Classes describe the objects that are modeled for use in a Domain Manager. Instances are 
specific occurrences of a class. For example, a class might describe a human and an 
instance of the class is someone named Bill.


Attributes describe a class and, for an instance of the class, include information about its 
present state. Examples of attributes include an element’s name and a counter that 
counts the number of packets traversing an interface.


Relationships define how instances are related to other instances. Relationships can be 
one-to-one, one-to-many, many-to-one, or many-to-many. When only a single instance can 
be related to another instance (or instances), it is a relationship. When multiple instances 
can be related to another instance (or instances), it is a relationshipset.


Events describe the failures that can occur for a class, the symptoms that these failures 
can cause, and the effect of failures. 


Symptoms can be described a follows:


◆ Local, meaning they are observed in the instance of the class.


◆ Propagated, meaning they are observed in instances related to the failing instances.


Once classes are specified, the model is loaded and run on a Domain Manager. Instances 
are created for each entity that is modeled. Each instance is associated with a class and 
has values for its attributes, relationships, and events. 


The models stored in a Domain Manager are static. Instances are dynamic and are stored 
in the repository, as shown in Figure 8 on page 95.

94 EMC Smarts Foundation ASL Reference Guide







Interfacing with a Domain Manager

Figure 8  Domain Manager with a model and repository


Instances in a Domain Manager consist of a table entry and data. The table entry includes 
the name of each instance and its class. Each instance name must be unique. The table of 
names always contains an entry for the NULL object.


The data associated with each instance includes properties such as attributes, operations, 
and the relationships between instances. The data also includes event information such 
as problems, symptoms, and events.


EMC Smarts MODEL Reference Guide provides additional information about MODEL.


Correlation model used for example scripts


All of the ASL script examples used in this chapter interact with a small correlation model. 
The model defines two types of objects: cards and ports, as shown in Figure 9 on page 96.
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Figure 9  Relationship between cards and ports


Cards and ports are separate classes. Each class has its own set of attributes and events. 
An instance of one class can be related to an instance of another class.


Cards have the following:


◆ A single attribute, CardDesc. This attribute is a string and has no default value.


◆ Two types of events. 


• The first type is a problem called Down. When all of a card’s ports are 
OperationallyDown, the card is Down. 


• The second type is an aggregate called Impaired. If any of the ports associated 
with a card is Down or if the card is Down, the card is Impaired.


Ports have the following:


◆ A single attribute, OperStatus. This attribute has a special data type that limits the 
values of the attribute to TESTING, UP, and DOWN. DOWN is the default value.


◆ Two types of events.


• The first type is a problem called Down. A port is Down when it is 
OperationallyDown. 


• A second type is a symptomatic event called OperationallyDown. When the port’s 
OperStatus attribute is set to DOWN, it causes the OperationallyDown event. 


In Figure 10 on page 97, the port’s attribute OperStatus is equal to DOWN.
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Figure 10  Events that affect ports and their related card


The attribute’s value causes the event OperationallyDown, which, in turn, causes the 
problem Down. Since the port participates in a PartOf relationship with the card, the card 
is also affected. The port has the problem Down and, as a result, the card has the 
compound event (aggregate), Impaired. The card is probably not down, because only one 
port (not all ports) is experiencing a problem.


Appendix C, “Card-Port MODEL Code,” describes the MODEL language code for this 
example. Figure 11 on page 98 is a diagram of this card and port model.
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Figure 11  Diagram of the card and port model
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Objects and instances
This section discusses how to create, delete and manipulate objects and instances.


Creating objects


The create() function creates an instance of a class or an instance with an object handle. 
The syntax is one of the following:


◆ create(<classname>, <objectname>);


◆ create(<objhandle>);


If the object being created already exists, the create() function returns a reference to that 
object or an error if the object exists and belongs to different class. 


If you specify an object handle (objhandle) and the object does not exist, the create() 
function creates the object and the object handle.


You can assign the result of the function to a variable (for example, objRef). This defines 
an object handle for the object.


objRef = create(<classname>, <objectname>);


The following script example loads instances of ports and cards. The name of the Domain 
Manager that contains the model is JS1.


ASL Script (create_obj.asl):
START {


CARD rep(PORT)
}


CARD {
"CARD:" cardname:word eol


}
do {


create("Card",cardname);
}


PORT {
portname:word eol


}
do {


create("Port",portname);
}


DEFAULT {
err:{..eol}


}
do {


print(err." Failed");
}


EOF
do {print("Complete");
}


Input (create_obj.txt):
CARD: CARD0


PORT00
PORT01
PORT02
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PORT03
CARD: CARD1


PORT10
PORT11
PORT12


CARD: CARD2
PORT20
PORT21
PORT22
PORT23
PORT24
PORT25


Output:
$ sm_adapter --server=JS1 --file=create_obj.txt create_obj.asl
Complete
$ 


Listing instances


The getInstances() function returns a list of object names for the given class, but does not 
return object handles. The syntax is as follows:


<listname> = getInstances(<classname>);


The following script example retrieves the names of all instances of the class “Card” and 
stores them in a list. The names stored in the list cannot be used by ASL to reference 
objects.


ASL Script (get_obj.asl):
START {


..eol
}


do {
x = getInstances("Card");
print(x);


}


Input:
none


Output:
$ sm_adapter --server=JS1 get_obj.asl
{ CARD0, CARD1, CARD2 }


$


Creating handles for existing objects


The object() function returns an object handle for existing objects. An object handle is a 
distinguished data type in ASL that represents a model class name and an object name. 
The syntax is one of the following:


◆ <objectRef> = object([<classname>,] <objectname>);


The name of the instance must be unique, therefore, the class name is optional.


◆ <objectRef> = object(<objhandle>);
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There are three ways to obtain a handle for an existing object:


◆ If you specify a class name and an object name, then the object() function returns the 
object handle for the specified object. ASL stores that information as <class>::<name>.


◆ If you specify an object handle (objhandle), then the object() function returns the 
object handle unchanged.


◆ If you specify an object name only, then the object() function returns the handle object 
and assumes the object name and the class name, MR_Object.


You can also create an object handle for future use for an object that does not exist.


For example: 


objref = object();


The following script retrieves the names of all instances of the class “Card” and stores 
them in a list. A foreach loop cycles through the list and adds each object, including its 
class, to a different list. The script prints both lists.


The lists demonstrate the difference between the getInstances() function and the object() 
function. The getInstances() function returns only the name of the object. The object() 
function returns the object handle for the object and ASL stores that information as 
<class>::<name>. The section “Listing instances” on page 100 describes the getInstances() 
function.


ASL Script (handle_obj.asl):
y = list();


START {
..eol


}
do {


x = getInstances("Card");
print(x);


foreach mem (x)
{y += object("Card",mem);
}


print(y);
}


Input:
none


Output:
$ sm_adapter --server=JS1 handle_obj.asl
{ CARD0, CARD1, CARD2 }
{ Card::CARD0, Card::CARD1, Card::CARD2 }


Attributes, relationships, and operations of objects


The attributes, relationships, and operations of an object are its properties. ASL assigns 
values to properties by using the following syntax:


<objectRef>-><property> = <value>;


The <objectRef> is the object handle for the object. You assign the object handle by using 
the create() or object() functions or through a relationship.
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The following script loads the names of all instances of the classes “Card” and “Port” into 
a Domain Manager. The datafile contains a card name followed by the ports associated 
with the card. As this script loads cards and ports, it creates a relationship between a card 
and its ports.


Relationships between objects in MODEL are paired. It is not necessary to define both 
relationships. Define one relationship. Its converse is defined by default.


ASL Script (properties_obj.asl):
START {


CARD rep(PORT)
}


CARD {
"CARD:" cardname:word eol


}
do {


cardObj = create("Card",cardname);
}


PORT {
portname:word eol
}


do {
portObj = create("Port",portname);
cardObj->ComposedOf += portObj;
print(portObj." ".cardObj);


}


Input (create_obj.asl):
CARD: CARD0


PORT00
PORT01
PORT02
PORT03


CARD: CARD1
PORT10
PORT11
PORT12


CARD: CARD2
PORT20
PORT21
PORT22
PORT23
PORT24
PORT25


Output:
$ sm_adapter --server=JS1 --file=create_obj.txt properties_obj.asl
Port::PORT00 Card::CARD0
Port::PORT01 Card::CARD0
Port::PORT02 Card::CARD0
Port::PORT03 Card::CARD0
Port::PORT10 Card::CARD1
Port::PORT11 Card::CARD1
Port::PORT12 Card::CARD1
Port::PORT20 Card::CARD2
Port::PORT21 Card::CARD2
Port::PORT22 Card::CARD2
Port::PORT23 Card::CARD2
Port::PORT24 Card::CARD2
Port::PORT25 Card::CARD2
$ 


The value stored in <objectRef>-><property >can also be assigned to an ASL variable. 
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<variable> = <objectRef>-><property>;


You can refer to properties indirectly. This is a two-step process. First, assign the property 
to a variable. Second, the variable can be used in place of the property in conjunction with 
an indirection operator (->*). 


propertyname = “property”;
objRef->*propertyname = "UP";


The syntax objRef->*variable allows you to access an attribute by variable. The following 
code sample assigns the attribute name to a variable, then makes a reference to that 
attribute through the indirection operator. The output is the creation class name of the 
given object.


variable = “CreationClassName”;
c = objRef->*variable;
print(c);


When you run this ASL script on a router object, the output is “Router”.


Deleting objects


The delete() method deletes an instance of a class. This function does not delete objects 
that are related to the deleted object. ASL creates an error if the object handle used with 
the delete() method points to an object that does not exist. The syntax of the delete() 
method is:


<objectRef>->delete();


The undef() function does not affect objects. Its use removes an assigned value from a 
variable. The section “undef() function” on page 80 provides additional information.


You can use += or -= operators to add or delete an object from a list of object handles in 
ASL or from a relationshipset in MODEL. “Modifying relationshipsets” on page 105 
provides additional information.


The following script deletes a card and its related ports. The script contains a default 
variable that specifies the card to delete. When the ComposedOf relationship is used, the 
ASL script creates a list of port objects to delete. The card is deleted first, followed by its 
ports. Exception handling causes the script to stop if the card object does not exist.


ASL Script (delete_obj.asl):
default delthis = "CARDX";


START {
..eol


}


do {
delthisObj = object(delthis);
relObj = delthisObj->ComposedOf?LOG,STOP;
x = delthisObj->delete();
foreach mem (relObj)


{
mem->delete();
}


print("Deleted ".delthis." and related ports");
}
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Input:
none


Output:
$ sm_adapter --server=JS1 -Ddelthis="CARD2" delete_obj.asl
Deleted CARD2 and related ports
$ 


Testing for null objects


The isNull() method tests whether an object handle points to a valid object. If this function 
returns TRUE, the object does not exist. The syntax is as follows:


<objectRef>->isNull();


For example, this script deletes the object PORT25 from the Domain Manager if it exists. 
The if statement uses the isNull() function to test if the object exists. An exclamation point 
is a logical NOT, so that if the object does exist, the condition is true for the if statement. 
The output demonstrates the case where the object exists and is deleted.


ASL Script (isnull_obj.asl):
START {


..eol
}


do {
delthisObj = object("Port","PORT25");
if (!delthisObj->isNull())


{
 delthisObj->delete();


   print("Deleted   ".delthisObj);
}


else { print(delthisObj." does not exist");}
}


Input:
none


Output:
$ sm_adapter --server=JS1 isnull_obj.asl
Deleted   Port::PORT25
$ 


Testing relationships


The is() function tests whether an object is a member of a relationship. The syntax is as 
follows:


is(<objectRef>-><Relationship>,<objectRef2>)


The <relationship> used in the is() function must be a valid relationship for the object or an 
error occurs. If <objectRef2> is related to <objectRef> by <Relationship>, the function returns 
TRUE. Otherwise, the function returns FALSE. 


This script tests objects of the class Port to see if they are related to CARD2. The script gets 
the list of ports by using the class Port. When the ports are printed, the class that is 
printed is MR_Object, which is the parent class of the Port and Card classes. The 
MR_Object class appears because a class is not specified for the object() function.


ASL Script (relation_obj.asl):
START {
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..eol
}
do {


cardObj = object("CARD2");
x = getInstances("Port");
foreach mem (x)


{
portObj = object(mem);
if (is(cardObj->ComposedOf,portObj))


{print(portObj." is related to ".cardObj);
}


}
}


Input:
none


Output:
$ sm_adapter --server=JS1 relation_obj.asl
MR_Object::PORT20 is related to MR_Object::CARD2
MR_Object::PORT21 is related to MR_Object::CARD2
MR_Object::PORT22 is related to MR_Object::CARD2
MR_Object::PORT23 is related to MR_Object::CARD2
MR_Object::PORT24 is related to MR_Object::CARD2
MR_Object::PORT25 is related to MR_Object::CARD2
$ 


In MODEL, all classes have a built-in property named CreationClassName. This property 
contains the class name.


Modifying relationshipsets


When a model relates many objects to one or more objects, it is a relationshipset. A 
relationshipset in MODEL is a list of object handles in ASL. You can manipulate this list by 
using the list operators described in Table 11 on page 105. 


Accessing a particular relationship in a relationshipset is a two-step process. First, load 
relationshipset into a list in ASL. Then, access a specific element in the list. For example:


x = objRef->rela_prop;
print(x[0]);


Table 11  List operators


Syntax Description


objRef->rela_prop += value; Adds a value to a relationshipset.


objRef->rela_prop -= value; Removes a value from a relationshipset.


x->rela_prop = object(""); Clears a single relationship.


x->rela_prop = list(y,z); Adds a list of object handles to a 
relationshipset.


x->rela_prop=list(); Clears a relationshipset.
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Retrieving description texts


There are several operations of the class SM_System that can be used to retrieve 
description texts or objects. The texts that are retrieved will be in the locale that was set 
either by the initial connection, or by the locale set by the most recent call to the 
setLocale(). 


If these operations are run outside of the context of a remote session, then the effective 
locale is CI_Locale::DEFAULT.


The getClassDescription() operation retrieves the descriptive text associated with the 
MODEL class name.


/// get model class description
string getClassDescription(in string className);


The getOpDescription() operation retrieves the descriptive text associated with a MODEL 
operation.


/// get model operation description
string getOpDescription(in string className, in string opName);


The getPropDescription() operation retrieves the descriptive text associated with a class 
property, such as an attribute.


/// get model property description
string getPropDescription(in string className, in string propName);


The getEventDescription operation retrieves the descriptive text associated with a MODEL 
event.


/// get model event description
string getEventDescription(in string className, in string eventName);


In this example, the description of the Attr1 attribute in the MyClass class is printed, in 
Japanese.


sysObj = object("SM_System","SM-System");
setLocale("ja_JP");
foo = sysObj->getPropDescription("MyClass","Attr1");
print(foo);


Tables, structures and enumerations
This section describes how to access, and how to clear the members of a MODEL table. It 
also describes how to access and update structures and enumerations.


Accessing tables in MODEL from ASL


Tables in MODEL are represented as lists in ASL. In MODEL, a table of structures is a list of 
lists in ASL. 


To return the structure in the MODEL table given the key (“F”), use the following syntax:


print(x->f[“F”]);
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Clearing the members of a table


To clear the members of a MODEL table, use the following syntax:


x->rela_prop=list();


Updating and accessing structure attributes in MODEL


Structures in MODEL are represented as lists in ASL. The number of items in the list in the 
ASL is equal to the number of fields in the corresponding structure of the MODEL. The first 
item in the list will correspond to the first field defined within the structure, and so on for 
each subsequent item.


For example, if the following structure is defined in Example.mdl, the following ASL code, 
Example.asl, shows how to reference the structure.


Example.mdl
interface Example_Struct:MR_ManagedObject
{


struct model_struct
{


int valueType;
string Value;


};


attribute model_struct asl_list;
};


Example.asl
START
{


do
{


// create an instance, ‘example’, of Example_struct
example = create (“Example_Struct”, “Example-Struct”);


// put values into a ‘model_struct’ structure:
// structure element ‘valueType’ is list element [0]
// structure element ‘value’ is list element [1]
struct_value = list();
struct_value[0] = 1;
struct_value[1] = “Structure Example”;


// set the value in the Example_struct instance
example->asl_list = struct_value;


// get values from a ‘model_struct’ structure
accessed_struct = list();
accessed_struct = example->asl_list;


// display the retrieved structure elements
print (accessed_struct);
stop();


}
}


The output of the example is the following:


$sm_adapter -M Example Example.asl
{1, Structure Example }
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Accessing enumerated data types in MODEL


Enumerated data types are represented as strings in ASL.


The following example shows the syntax to update an enumerated attribute with an enum 
value of TESTING:


x->enum_variable = “TESTING”;
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Type conversions between ASL and MODEL
MODEL cannot convert data from one type to another. The types of data available in 
MODEL are not the same as the types of data available in ASL. Table 12 on page 109 
shows how types of data in MODEL and ASL correspond. 


There is no MODEL type that corresponds to an ASL table.


Table 12  Correspondence between types of data in MODEL and ASL


MODEL ASL


Numeric (any type) Numeric (double)


binary binary


Table List


Relationship Object handle


Relationshipset List of object handles


boolean boolean


string string


External (User-defined) Type string


struct (a structure) List


enum string
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Domain Manager control
The following functions allow you to trigger Domain Manager actions from ASL. These 
actions either rebuild the correlation model or cause the Domain Manager to correlate 
events.


consistencyUpdate() function


The consistencyUpdate() function causes the Domain Manager to recompute the 
correlation rules. This function always returns, as soon as the request has been registered, 
with a TRUE value. The actual recomputation can take some time, and continues on the 
Domain Manager independently of the adapter. The syntax is:


consistencyUpdate()


correlate() function


The correlate() function causes the Domain Manager to correlate events. This function 
always returns, as soon as the request has been registered, with a TRUE value. The actual 
correlation computation continues on the Domain Manager independently of the adapter. 
The syntax is:


correlate()

110 EMC Smarts Foundation ASL Reference Guide







Interfacing with a Domain Manager

Events
This section describes how to retrieve event information.


getCauses() function


The getCauses() function returns a list of problems that cause an event. The function 
receives three arguments: class, instance, and event. The function returns the problems 
that cause the event based on the relationships among instances defined in the Domain 
Manager. The syntax is as follows:


getCauses(<classname>,<instancename>,<eventname>,[<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of 
problems that explain <eventname>, whether directly or indirectly, is returned. If it is 
passed as TRUE, only those problems that directly list <eventname> among the events they 
explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<problemname> },
{ <classname>,<instancename>,<problemname> },


...


getClosure() function


The getClosure() function returns a list of symptoms associated with a problem or 
aggregation. The function receives three arguments: class, instance, and event. The 
function returns the symptoms associated with the problem or aggregate based on the 
relationships among instances defined in the Domain Manager. The syntax is as follows:


getClosure(<classname>,<instancename>,<eventname>,[<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of 
problems that explain <eventname>, whether directly or indirectly, is returned. If it is 
passed as TRUE, only those problems that directly list <eventname> among the events they 
explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<symptomname> },
{ <classname>,<instancename>,<symptomname> }


getEventClassName() function


The getEventClassName() function returns a string with the name of the ancestor class 
associated with a class and an event. The ancestor class is where the event was originally 
defined. That is, the class in which the event definition statement, not any refinement, 
appeared. The syntax is as follows:


getEventClassName(<classname>,<eventname>)
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getEventDescription() function


The getEventDescription() function returns a string, defined in MODEL, that describes an 
event. The syntax is as follows:


getEventDescription(<classname>,<eventname>);


getEventType() function


The getEventType() function returns a string that classifies an event as a PROBLEM, EVENT, 
AGGREGATION, or SYMPTOM. The syntax is as follows:


getEventType(<classname>,<eventname>);


getExplainedBy() function


The getExplainedBy() function is the inverse of the getExplains() function. It returns those 
problems that the MODEL developer has listed as explaining this problem. The syntax is 
as follows:


getExplainedBy(<classname>,<instancename>,<eventname>[,<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of 
problems that explains <eventname>, whether directly or indirectly, is returned. If it is 
passed as TRUE, only those problems that directly list <eventname> among the events that 
they explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<symptomname> },
{ <classname>,<instancename>,<symptomname> }


getExplains() function


MODEL developers can add information to a problem in order to emphasize events that 
occur because of a problem. The getExplains() function returns a list of these events. The 
syntax is as follows:


getExplains(<classname>,<instancename>,<eventname>,[<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of 
problems that explains <eventname>, whether directly or indirectly, is returned. If it is 
passed as TRUE, only those problems that directly list <eventname> among the events that 
they explain are returned.


getChildren() function


The getChildren() function provides the list of classes derived from a particular class.


getChildren(<classname>[,recursive])


The recursive parameter is optional. If omitted or false, only the immediate child classes 
are retrieved. If true, all children, including those of derived classes are retrieved.
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Transactions, commit, and abort
When you modify objects in ASL scripts, the objects change as each modification occurs. 
Using transactions, you can commit many changes to the objects in a Domain Manager as 
a single change or choose to abort all of them. Use the following syntax to create a 
transaction:


<variable> = transaction();


You cannot assign a transaction to a global variable or to a statically scoped variable. After 
you assign the transaction to a variable, every change made to an object does not affect 
the object until you commit the transaction. If the you abort the transaction, any changes 
made will not affect the object. Use the following syntax to commit a transaction:


<variable>->commit()


Use the following syntax to abort a transaction:


<variable>->abort()


The changes made with a transaction are not visible outside of the ASL script until you 
commit the changes. Within a transaction, the same ASL script can see the proposed 
changes. Transactions also can control how other applications see objects before changes 
are committed or aborted by adding a single keyword. The syntax of a transaction with a 
keyword is:


<variable> = transaction([WRITE_LOCK|READ_LOCK|NO_LOCK]);


A keyword can be any one of those listed in Table 13 on page 113. 


You can nest transactions. When you nest a transaction, you must commit or abort the 
nested transaction before you commit or abort the previous transaction. 


ASL aborts any open transactions when the START rule completes.


A maximum of 16 transactions may be open concurrently.


The following script deletes a card and its related ports. The script contains a default 
variable that specifies the card to delete. Using the ComposedOf relationship, the ASL 
script creates a list of port objects to delete. The script deletes the card and its related 
ports at the same time through a transaction.


Table 13  Transaction keywords


Keyword Description


WRITE_LOCK While the transaction is open, no other process can modify or access 
information in the repository.


READ_LOCK Currently behaves as WRITE_LOCK.


NO_LOCK This is the default behavior. No locks exist until the ASL commits the 
transaction.
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ASL Script (deltrans_obj.asl):
default delthis = "CARDX";


START


do {
delthisObj = object(delthis);
relObj = delthisObj->ComposedOf?LOG,STOP;
deltrans=transaction();


x = delthisObj->delete();
foreach mem (relObj)


{
mem->delete();
}


deltrans->commit();
print("Deleted ".delthis." and related ports");
stop();


}


Input:
none


Output:
$ sm_adapter --server=JS1 -Ddelthis="CARD2" deltrans_obj.asl
Deleted CARD2 and related ports
$ 
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Error handling
This section describes functions that allow you to determine whether an error occurred, to 
get a description of the error and to reset the error state.


feError() function


Invoke the feError() function to determine if the front end has reported a failure to read 
data.


The function returns a Boolean value, where TRUE indicates an error occurred and FALSE 
indicates no error occurred. If an error occurred, invoke feErrorMsg() for a description of 
the error.


feErrorMsg() function


Invoke the feErrorMsg() function to get a description of the error indicated by the feError() 
function. feError() returns TRUE.


This function returns a string that describes the error. If no error condition exists, an empty 
string is returned.


feErrorReset() function


The feErrorReset() function is used with the feError() and feErrorMsg() functions to reset 
the error state. There is no return value for this function.
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Repositories


self->


Directs functions that interact with the repository to use the adapter’s repository and not 
the Domain Manager’s. Used in conjunction with adding objects to the adapter’s 
repository.


Naming and identity
This section describes functions used to retrieve names and identity of the rule which is 
running, what Domain Manager the script is running on, and the thread ID of the adapter.


getRuleFileName() function


The getRuleFileName() function returns the filename of the currently executing rule file as 
an argument.


Usage:


getRuleFileName ([<fullname>]);


where <fullname> is a string containing the complete path-qualified filename.


getServerName() function


The getServerName() function returns a string, which is the name of the Domain Manager 
associated with adapter that is invoking the ASL script.


thread() function


The thread() function returns the operating system thread ID that is associated with the 
adapter that is invoking the ASL script.
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Tracing ASL scripts
The ASL_Trace Model object is used to start and stop a trace from dmctl, the Java API, 
bootstrap.conf, and ASL. The ASL_Trace model object contains three methods. 


◆ start() method starts the tracing 


◆ stop() method stops the tracing


◆ isActive() method checks to see if a trace is in progress


interface ASL_Trace
start()
stop()
isActive() 


The trace contains timestamps for:


◆ Entry into ASL scripts


◆ Exit to ASL scripts


◆ Exit from ASL scripts 


For example, to use the tracing capability from dmctl:


1. Create an instance of the Model object. An instance named ASL-Trace is customary.


dmctl –s serverName create ASL_Trace::ASL-Trace


2. Invoke start/stop/isActive as needed.


dmctl –s serverName invoke ASL_Trace::ASL-Trace start
dmctl –s serverName invoke ASL_Trace::ASL-Trace stop


The output will appear similar to the following:


1 2009/02/26 13:26:15.175714600 1 000:00:00.000000000 NoteASLThread ThreadName=adapter 
1 2009/02/26 13:26:15.175714600 2 000:00:00.000000000 NoteLayout Record prefix fields: 
1 2009/02/26 13:26:15.175714600 3 000:00:00.000000000 NoteLayout Thread id, Date, Time, Seq, 
1 2009/02/26 13:26:15.175714600 4 000:00:00.000000000 NoteLayout Delta since prior record in 
thread, 
1 2009/02/26 13:26:15.175714600 5 000:00:00.000000000 NoteLayout RecordType. 
1 2009/02/26 13:26:15.175714600 6 000:00:00.000000000 NoteLayout Trace records continue with: 
1 2009/02/26 13:26:15.175714600 7 000:00:00.000000000 NoteLayout 
Entry|Exit|StopExit|ThrowExit|ThrowExit1|ThrowExit2, 
1 2009/02/26 13:26:15.175714600 8 000:00:00.000000000 NoteLayout 
Constructor|Destructor|Initialize|Multiplex, 
1 2009/02/26 13:26:15.175714600 9 000:00:00.000000000 NoteLayout this for ASL_Parser, Nest 
depth, Rule file name. 
1 2009/02/26 13:26:15.175714600 10 000:00:00.000000000 StartTrace 
1 2009/02/26 13:26:15.186840900 11 000:00:00.011126300 NoteDriver CreationClassName=GA_Driver 
Name=ASL-Trace1-Driver 
1 2009/02/26 13:26:15.187012400 12 000:00:00.000171500 Trace Entry Constructor 00000001002CA120 
0 tasl_trace1.asl 
1 2009/02/26 13:26:15.187184600 13 000:00:00.000172200 Trace Exit Constructor 00000001002CA120 
0 tasl_trace1.asl 
1 2009/02/26 13:26:15.187535500 14 000:00:00.000350900 Trace Entry Initialize 00000001002CA120 
0 tasl_trace1.asl 
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1 2009/02/26 13:26:15.187703000 15 000:00:00.000167500 Trace Exit Initialize 00000001002CA120 
0 tasl_trace1.asl 
1 2009/02/26 13:26:15.188291200 16 000:00:00.000588200 Trace Entry Destructor 00000001002CA120 
0 tasl_trace1.asl 
1 2009/02/26 13:26:15.188457500 17 000:00:00.000166300 Trace Exit Destructor 00000001002CA120 
0 tasl_trace1.asl 
1 2009/02/26 13:26:45.193438300 18 000:00:30.004980800 StopTrace


The log file is written to BASEDIR/smarts/local/logs as <serverName>.ASL_Trace.log. 


◆ If the BASEDIR/smarts/local/logs directory cannot be found, the log is written to the 
current working directory. 


◆ If the <serverName> is not available, the file name becomes ASL_Trace.log_<pid>.


The trace is written chronologically. Thus, traffic for several threads may be intermingled. A 
sort of the first 4 fields will produce traces for individual threads.


The record layout is noted when the trace is started. The prolog of each record is fixed. 
After that, each record contains a record type to provide summary program processing.


The ‘this’ pointer is logged, and can be used when tying the ASL trace to pstack samples.


Startup is automatic if the SM_ASL_TRACE environment variable is set to anything that 
does not lower case to 0, false, no, or off. 
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The sm_adapter command
The sm_adapter command starts ASL scripts. To run the command, you must specify the 
ASL rules file to run as well as choosing how the front end and back end of the adapter 
operate. The command syntax is:


sm_adapter [options...] [<rule set>]


The <rule set> is the ASL script that the adapter follows when it receives information.


The options control which Domain Manager and Broker the adapter connects to, and it 
also configures how the adapter runs. An adapter can run by using a variety of front end 
and back end components. The options are described in Table 14 on page 120.


The file, sm_adapter (sm_adapter.exe for Windows), is found in BASEDIR/smarts/bin.


Basic options


Table 14 on page 120 shows the options which enable you to name the adapter and 
control which Broker, MODEL library, and port the adapter uses.  


Table 14  sm_adapter basic options


Option Description


--broker=<location> Alternate Broker location as host:port. Also -b <location>.


--model=<model> Name of MODEL library to load. Also -M <model>.


--name=<name> Start a server registered under <name>. Also -n <name>.


--port=<xxxx> Alternate registration port. Use with --name.


--timeout=<secs> Set the timeout for server interaction. The timeout applies to the 
back end connection except when using the subscriber front end, in 
which case it applies to the front end. The argument is in seconds, 
and can be a decimal value. If the --timeout option appears with no 
value, 600 seconds is used. By default, there is no timeout.


--wait Wait for initial driver to complete.
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Table 15 on page 121 describes additional sm_adapter options. 


Table 15  Other sm_adapter options


Option Description


--accept=<host-list> Accept connections only from hosts on host-list, a comma-separated 
list of hostnames and IP addresses. You can also specify any instead of 
host-list to allow any host to connect. Default: --accept=any.


--daemon Run process as a daemon.


--errlevel=<level> Specify the minimum level at which error events are written to the 
standard error output. Possible values include: none, emergency, alert, 
fatal, critical, error, warning, notice, informational, debug. The default 
is warning. (Note that fatal is equivalent to emergency, alert, or 
critical.)


--help Print help and exit.


--loglevel=<level> Specify the minimum level at which event messages are written to the 
system logging facility. Possible values include: none, emergency, 
alert, fatal, critical, error, warning, notice, informational, debug. The 
default is error. (Note that fatal is equivalent to emergency, alert, or 
critical.)


--logname=<name> Specify the name used to identify the Smarts program in the system 
log.On UNIX systems, the default is the program name. On Windows 
systems, the default is the registered service name.


--output[=<file>] Messages generated from internal logging calls are directed to a log 
file. Log files are written to the BASEDIR/smarts/local/logs directory. If 
<file> is not specified, the value of --logname is used.
If a log file with specified name already exists, it is moved to a backup 
file, BASEDIR/smarts/local/logs/<file>.bak. If the backup file already 
exists, it is deleted.


--tracelevel=<level> Specify the minimum level at which a process stack trace is written to 
the standard error output. Possible values include: none, emergency, 
alert, fatal, critical, error, warning, notice, informational, debug. The 
default is fatal. (Note that fatal is equivalent to emergency, alert, or 
critical.)


--version Print program version and exit.
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Front end
The front end of the adapter is responsible for reading data from an input source and 
formatting it for processing by an ASL rule set. The adapter can run with one of the 
following front ends:


◆ File—Reads data from an ASCII file. 


◆ File tail—Is designed to read the log files of long-running Domain Managers. Like the 
file front end, the file tail front end reads data from an ASCII file. But instead of 
opening the file, reading the contents and closing the file, this front end opens the 
file, skips to its end and waits for additional lines to be written to the file.


◆ Program—Reads data from the output of a command pipeline. 


◆ Subscribe—Is used in outflow adapters. This front end connects to a Domain Manager 
and issues a set of subscription requests. Subsequent notifications received from the 
Domain Manager are formatted and delivered to the ASL rule set. There are many 
configuration options available with this front end. The options include selecting the 
subscription set to performing sophisticated smoothing and filtering of events.


Each front end is described in a subsequent subsection. A list of options is provided in 
“sm_adapter front end options” on page 128. Examples of the sm_adapter command with 
front ends are provided in “Sample front end invocations” on page 127.


File front end


The file front end reads data from an ASCII file. The front end opens and reads the file, 
feeds its contents to the rule set, then closes the file and terminates. This front end 
performs two special formatting translations:


◆ End-of-line translation


◆ Field-separator translation


The --file option of the sm_adapter command invokes this front end.


End-of-line translation
One of the more troublesome aspects of using a cross-platform file adapter is dealing with 
the end-of-line problem. On Windows systems, \r\n represents an end-of-line. On UNIX, a 
single \n represents an end-of-line. The file front end translates either a single \n or the 
\r\n sequence to an ASL end-of-line marker (eol), which eliminates this problem. 


Consider a file with one line, “hello world.” In a Windows system, this file contains the 
characters: 


h  e  l  l  o    w  o  r  l  d  \r  \n


Whereas, on a UNIX system, this file contains the characters:


h  e  l  l  o    w  o  r  l  d  \n


Using the file front end on either system feeds the following input stream into the rule set:


h  e  l  l  o   w  o  r  l  d  eol
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Field-separator translation
Many input files are structured as a series of records, where each record is represented as 
one line in the file. Each record (line) may be further separated into fields. The fields are 
normally delimited by a special character, such as the TAB character or perhaps the colon 
(:) character. 


To simplify the parsing of such files, you can specify a field-separator character with the 
--field-separator option of the sm_adapter command. Each occurrence of this character in 
the input file is replaced with an ASL field-separator marker (fs). By default, ASL does not 
translate characters to field-separator markers.


Consider the following line taken from the UNIX /etc/passwd file:


root:*:0:0:Admin:/:/bin/sh


Reading this line and using the file front end with the field-separator character set to the 
colon (:), feeds the following input stream into the rule set:


r o o t fs * fs 0 fs 0 fs A d m i n fs / fs / b i n / s h eol


This line can then be parsed with an ASL pattern:


word fs word fs integer fs integer fs word fs word fs word eol


The character replaced with an fs can never be seen by the rule set of the ASL script. The 
following pattern does not match the input stream:


word “:” word “:” integer fs integer fs word fs word fs word eol


File tail front end


The file tail front end is designed to read the log files of long-running Domain Managers. 
All of the characteristics of the file front end are present in the file tail front end. Unlike the 
file front end, however, the file tail front end does not simply open the file, read its 
contents, and then terminate. Rather it opens the file, seeks to the end of the file, and 
waits for additional lines to be written to the end of the file. As new lines appear, the front 
end feeds them to the rule set. The --tail option of the sm_adapter command invokes this 
front end.


Rotating Domain Manager log files
One of the difficulties in parsing Domain Manager log files is dealing with log file rotation. 
By their nature, Domain Manager log files grow over time. Most system administrators set 
up periodic jobs to remove or rename the log files to avoid consuming too much disk 
space. The file tail front end periodically checks if the file has been rotated. If so, the file is 
closed and reopened. The file is then read from the beginning. All entries in the newly 
opened file are fed into the rule set.


Program front end


The program front end reads data from the output of a command pipeline. Like the file 
front end, the program front end performs end-of-line and field-separator translations. 
This front end, for example, can parse the results of a SQL query issued by using a 
command-line SQL program.
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The --program option of the sm_adapter command invokes the program front end. This 
command string is executed by using the native command interpreter for the system. On 
UNIX, this is normally /bin/sh. On Windows, this is cmd.exe. When the front end object is 
created, the command is executed and a pipeline is created between the command and 
the front end. This pipeline combines both the stdout and stderr streams from the 
command into a single stream. 


Once the command exits (or once it closes stderr and stdout) the front end terminates.


Subscriber front end


The subscriber front end subscribes to a Domain Manager and feeds the subsequent 
notifications from the Domain Manager to the rule set. Subscriptions can be used for 
events, topology changes, and attribute changes.


Notification formatting
The Domain Manager generates a number of different kinds of notifications. Each 
notification received from the Domain Manager is streamed as a single record with an eol 
marker that identifies the end of the notification. Individual fields within each notification, 
for example the class name or instance name in an event notification, are separated by fs 
markers. The first field of all notifications is an integer timestamp in the standard UNIX 
format which indicates when the Domain Manager originally created the notification. The 
remaining fields of the notification record differ depending on the type of record.


Event notification records
Event notifications are received from the Domain Manager when the status of an event 
changes. In order to receive these notifications, you must subscribe to events in the 
Domain Manager. 


The ASL format of the notification record is:


 timestamp:    integer      fs
               “NOTIFY”     fs
 class:        word         fs
 instance:     word         fs
 event:        word         fs
 certainty:    float        fs
                            eol


Normally, the Domain Manager sends the following:


◆ Single notification message when an event becomes active 
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◆ Single clear message when the event is no longer active. 


If an event corresponds to a root-cause problem, it is possible that the certainty of the 
diagnosis will change over time. If the diagnosis certainty changes, the Domain Manager 
generates another notification. Notifications of this type are streamed in a slightly 
different manner:


timestamp:    integer            fs
              “CERTAINTY_CHANGE” fs
class:        word               fs
instance:     word               fs
event:        word               fs
certainty:    float              fs
                                 eol


The subscriber front end normally discards certainty changes that are less than 1% (0.01). 
This behavior can be disabled.


When the Domain Manager clears an event, the ASL format of the notification record is:


timestamp:    integer      fs
              “CLEAR”      fs
class:        word         fs
instance:     word         fs
event:        word         fs
                           eol


Object create record


When a new object is created in the Domain Manager’s repository, the Domain Manager 
sends an object create message. The ASL format of an object create record is:


timestamp:    integer       fs
              “CREATE”      fs
class:        word          fs
instance:     word          fs
                            eol


Object delete record
When an object is deleted from the Domain Manager’s repository, the Domain Manager 
sends an object delete message. The ASL format of an object delete record is:


timestamp:    integer       fs
              “DELETE”      fs
class:        word          fs
instance:     word          fs
                            eol


Class load record
When a new class is created in the Domain Manager’s repository, the Domain Manager 
sends a class load message. Classes are created when new MODEL-generated libraries are 
loaded. The ASL format of a class load record is:


timestamp:    integer           fs
              “CLASS_LOAD”      fs
class:        word              fs
                                eol
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Class unload record
When a class is deleted from the Domain Manager’s repository, the Domain Manager 
sends a class unload message. Deleting of classes is not currently supported in the 
Domain Manager so this message is not used.


timestamp:    integer           fs
              “CLASS_UNLOAD”    fs
class:        word              fs
                                eol


Relation change record
When a relationship changes between objects, the Domain Manager sends a relation 
change message. The ASL format of a relation change record is:


timestamp:    integer           fs
              “RELATION_CHANGE” fs
class:        word              fs
instance:     word              fs
relation:     word              fs
                                eol


Property change record
When an object’s property changes, the Domain Manager sends a property change 
message. The ASL format of a property change record is:


              “ATTR_CHANGE”     fs
class:        word              fs
instance:     word              fs
attribute:    word              fs
value:        word              fs
                                eol


Subscriber front end with a restartable Domain Manager


If the Domain Manager that is being sent subscriptions by the subscriber front end is a 
restartable Domain Manager, two additional messages are sent to the rule set: 


◆ One when a connection is made to the Domain Manager. 


◆ The other when the connection to the Domain Manager is lost.


Domain Manager connect record
When the connection to the Domain Manager is established, the Domain Manager sends a 
Domain Manager connect record. These records are sent to the rule set even if the front 
end issues no subscriptions. In fact, it is sometimes useful to use a subscriber front end 
with no subscriptions just for the purpose of being notified when the Domain Manager 
terminates and restarts. The ASL format of the Domain Manager connect record is:


timestamp:    integer           fs
              “CONNECT”         fs
server:       word              fs
                                eol
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Domain Manager disconnect record
When the connection to the Domain Manager is lost, the Domain Manager sends a 
Domain Manager disconnect record. Like the Domain Manager connect record, these 
records are generated even if no subscriptions to the Domain Manager are issued. The ASL 
format of the Domain Manager disconnect message is:


timestamp:    integer           fs
              “DISCONNECT”      fs
server:       word              fs
                                eol


Sample front end invocations


This section provides sample front end invocations, as described in Table 16 on page 127.  


Table 16  Sample front end invocations


Type of front end Invocation


File front end $ sm_adapter --file=/etc/passwd --field-separator=: passwd.asl


File tail front end $ sm_adapter --tail=/var/adm/messages syslog.asl


Program front end $ sm_adapter --program=”/bin/ps -ef” ps.asl


Subscriber front end $ sm_adapter --subscribe=”.*::.*::.*” --server=myDomainManager notify.asl


The value of the subscribe parameter is parsed into class, instance, and 
event expressions. The “::” string separates the individual patterns. 
Subscriptions are sent to the Domain Manager specified with the --server 
option. In addition to the event patterns, the subscribe option also allows 
you to qualify the types of events included in the subscription set. A 
qualification has the form:


--subscribe=”.*::.*::.*/paev”


The trailing /paev qualifies the subscription to include problems (p), 
aggregates (a), symptoms (e) in the subscription set, and verbose mode (v) 
which turns on subscription control messages. You can specify any 
combination of the letters p, a, e, and v. If no qualifier is specified, the 
default is problems only (/p).
To use the subscription front end in conjunction with a restartable Domain 
Manager, use the --rserver option in place of the --server option.
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sm_adapter front end options


Table 17 on page 128 describes the available sm_adapter front end options. 


Table 17  sm_adapter front end options


Option Description


--file=<path> Read input from a file. Also -f <path>.


--tail=<path> Read input by tailing a file. Also -t <path>.


--program=<cmd> Read input from a command pipeline. Also -p <cmd>.


--field-separator=C Translate 'C' to the field-separator (FS) marker. Valid only in conjunction 
with --file, --tail or --program. Also -F <C>.


--subscribe=<sub> Use the subscriber front end. Subscriptions are sent to the server 
specified with the --server option. The <sub> parameter is the subscription 
request. 
• If <sub> is 'topology', then a subscription for topology changes is 


requested. 
• If <sub> is of the form '<name>/n', then a subscription to NL <name> is 


requested.


Note: Only one NL subscription may be specified. 


• If <sub> is of the form C::I::E[/paev], 'C', 'I', 'E' are regexp patterns 
representing the classes, instances, and events to which to subscribe. 
The letters following a slash (/) are subscription qualifiers: 'p' means 
subscribe to problems; 'a' means subscribe to aggregates (impacts); 
and 'e' means subscribe to events. If none of these are present, 'p' is 
assumed. 'v' means run in verbose mode, which turns on subscription 
control messages. 


Otherwise, <sub> is a profile name in which the profile specifies what 
subscriptions are to be requested. A profile name may be optionally 
followed by the /v qualifier. 
Multiple --subscribe options can be specified.


--smoothing=<num> Event smoothing interval. This parameter is used by the subscriber front 
end to smooth event notifications (and clears) received from the server. 
Only events (or clears) that stay active (or cleared) for <num> seconds are 
fed into the input stream. The <num> must be a non-negative integer. The 
default value is 0 which disables smoothing.


--ignoreOld Ignore old notifications. This parameter is used by the subscriber front 
end. Notifications for events that were active before this adapter 
connected are not fed to the input stream.
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Rule set
The rule set parameter is used to specify the ASL parse rules that are applied to the input 
data. The name of the file that contains the ASL parse rules is added at the end of the 
sm_adapter command. For example:


sm_adapter [<options>] myRules.asl


sm_adapter rule set options


The sm_adapter rule set options are listed in Table 18 on page 129.


Back end
The back end of an adapter represents a Domain Manager. Object manipulations (for 
example, setting an attribute) within an ASL rule set are translated into EMC Smarts 
Remote API requests. The Domain Manager to which the API transmits the request is 
determined by the back end. Two back ends are available:


◆ Remote Domain Manager —Specifies a remote Domain Manager. 


◆ Restart-enabled Domain Manager — Specifies a remote Domain Manager, but the 
adapter handles automatic reconnects if the connection to the Domain Manager is 
broken.


The --server option to the sm_adapter command creates a remote Domain Manager back 
end.


% sm_adapter --server=myServer rules.asl


The restart-enabled Domain Manager back end is a specialization of the remote Domain 
Manager that adds automatic reconnect capabilities. When using a normal remote 
Domain Manager back end, the adapter terminates if one of the following occurs:


◆ Domain Manager is unavailable when the adapter starts.


◆ Domain Manager disconnects while the adapter is running.


The restart-enabled Domain Manager should be used in cases where you want the adapter 
to remain active when the Domain Manager is unavailable. The back end of a 
restart-enabled Domain Manager periodically attempts to reconnect to the Domain 
Manager. Once it succeeds, the connection is restored and the adapter continues to 
function. 


The restart-enabled back end is most useful in conjunction with the subscriber front end. 
The section “Subscriber front end with a restartable Domain Manager” on page 126 
provides additional information about using the restart-enabled Domain Manager with the 
subscriber front end.


Table 18  sm_adapter rule set options


Option Description


--D<var>=<value> Override the default value for a rule set variable.


--verify Validate rules only.
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Behavior of the restart-enabled Domain Manager


The restart-enabled Domain Manager provides a way to create an adapter that is robust in 
the face of communication problems with the Domain Manager.


Normally, errors encountered during the transmission of an operation to the Domain 
Manager result in an exception to the rule set. This exception normally terminates the 
adapter. With a restart-enabled Domain Manager, however, the exception is treated as a 
non-fatal error and it does not automatically terminate the parser. Once the Domain 
Manager connection is re-established, operations no longer result in exceptions but begin 
working properly again.


Using the restart-enabled Domain Manager from the command line
You can use the --rserver option of the sm_adapter command to create a restart-enabled 
Domain Manager back end.


$ sm_adapter --rserver=<Domain Manager_name> rules.asl


Back end options


Table 19 on page 130 describes the available back end options.


Table 19  sm_adapter back end options


Option Description


--server=self Connect driver to local repository, the default.


--server=null Do not connect to any server. Useful for debugging offline in 
combination with --traceServer.


--server=<name> Connect driver to remote server. Also -s <name>.


--rserver=<name> Auto-reconnect driver to remote server. Also -S <name>.


--description=<desc> Description of this adapter, sent to remote server.


--mcast=<name> Connect driver to a local subscription server. 
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Tracing operations


Rule set


When the adapter starts, rules contained in the rule set file are read in and compiled into 
an internal form. The compilation enables the adapter to parse the input data efficiently. If 
the trace attribute of the rule set object is set to TRUE, the adapter dumps a trace of the 
compiled rules after it has converted them to the internal form. This option is used for 
debugging purposes only.


Specify the --traceRules option with the sm_adapter command to set the trace attribute of 
the rule set object to TRUE.


Back end


All back ends of an adapter can trace all API operations transmitted to the Domain 
Manager. This is a very useful option for debugging a rule set. If you are using the 
sm_adapter command, specify the --traceServer option to enable back end tracing. The 
trace output includes the following:


◆ Timestamp


◆ Name of the Domain Manager


◆ Description of the operation sent to the Domain Manager


If the operation returns a value (for instance, if you are retrieving an object property), the 
retrieved value is also printed. 


For example, when the following ASL commands, 


obj = object(“MyClass”,“MyObject”);
obj->attr = TRUE;


are executed in a rule set that is connected to a Domain Manager with the name, 
ServerName, the commands result in the following trace output:


2-Feb-2009 14:26:11 ServerName: put(MyClass,MyObject,attr,TRUE)


Trace options


Table 20 on page 131 describes the available trace options. 


Table 20  Trace options


Option Description


--traceRules Trace rule compilation.


--traceServer Trace interactions with the back end server.


--traceParse Trace rule matching.


--trace Enable all tracing. Also -d.
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Stopping adapters
Adapters that do not stop on their own can be stopped by using SIGTERM for UNIX systems 
and the Task Manager for Windows.


You can create ASL scripts that include a stop() or quit() function. “stop() function” on 
page 78 and “quit() function” on page 78 provide additional information for the stop() and 
quit() functions, respectively.
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This appendix provides a summary of ASL syntax and a list of reserved words. It consists 
of the following sections:


◆ Syntax...................................................................................................................  134
◆ Reserved words ....................................................................................................  140
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Syntax
Table 21 on page 134 lists available ASL syntax. 


Table 21  ASL syntax  (page 1 of 6)


Syntax Description


!= Indicates not equal to.


+ Indicates an addition operator.


- Indicates a subtraction operator.


* Indicates a multiplication operator.


/ Indicates a division operator.


% Indicates a modulus operator. Calculates by using 
integer or floating-point numbers.


&& Indicates a logical AND.


. (Period) pattern matching. Indicates that the next 
pattern must be matched immediately.


. (Period) action block. Concatenates two strings.


.. (Double period) Used to indicate an undefined 
string of characters up to the next pattern match.


|| Indicates a logical OR.


+= Adds an object to a relationship.


? Pattern matching. Matches one or zero times.


? Action block. Exception handling operator.


< Indicates less than.


<= Indicates less than or equal to.


-= Removes an object from relationship.


== Indicates equal to.


> Indicates greater than.


-> Used to reference properties of an object.


->* Used to reference properties of an object by using a 
variable for the property name.


>= Indicates greater than or equal to.


any(<string>) Represents any character in its argument string.


boolean(<value>) Converts the argument to a TRUE or FALSE. All 
nonzero numbers are TRUE. Any other type is 
converted to an uppercase string and compared to 
TRUE or FALSE. If it does not match either, it returns 
an error. 


break Used to break out of a loop.
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case = [exact]|[ignore] A variable that determines whether string matches 
are case-sensitive (default is exact) or not.


char Represents a character, not an eol or fs.


consistencyUpdate() Causes the Domain Manager to recompute the 
correlation rules. 


continue Used to move to start of loop and start with the next 
element.


correlate() Causes the Domain Manager to correlate events. 


create(<classname>,<objectname>) Creates an object.


create(<objhandle>) Creates an object handle which represents an 
instance.


default Defines the value to use for a variable if the 
variable is not assigned a value.


defined(<variable>) Determines whether a variable is defined.


delete() Deletes an object on the Domain Manager.


delim Defines delimiters.


do Marks the beginning of an action block.


else {<statements>} Alternative actions when an if statement fails.


else if (<conditional expression>) 
{<statements>}


Represents a conditional statement that provides 
alternative actions when an if statement fails.


eol Represents the end of a line of data.


exact Used in conjunction with “case” to make all string 
matches case-sensitive.


FAIL Keyword for exception handling. Causes a rule to 
fail when an exception occurs.


FALSE A Boolean false.


feError() Returns a Boolean value. TRUE if the front end has 
reported a failure to read data.


feErrorMsg() If the feError() function is true, the feErrorMsg() 
function returns a string that describes the error.


feErrorReset() Resets the error state so that there is no error.


filter Marks the beginning of a filter block.


float Represents a floating number, including an 
optional minus sign.


foreach <variable> (<list_or_table>) 
{<statements>}


Iterates over the values of a list or the index of a 
table. Variable is assigned successive values of the 
list of table.


fs Represents a field-separator.


Table 21  ASL syntax  (page 2 of 6)


Syntax Description
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getCauses(<classname>,<objectname>, 
<eventname>[,<oneHop>])


Returns a list of problems that can cause that 
event. Each element of the list is a list that contains 
classname, objectname, and eventname of the root 
cause that causes that event.


getChildren(<classname>[,recursive]) Retrieves the list of classes derived from the 
specified class.
The recursive parameter is optional. 
• If omitted or false, only the immediate child 


classes are retrieved. 
• If true, all children, including those of derived 


classes are retrieved.


getClosure(<classname>,<objectname>,
<eventname>[,<oneHop>])


Given a root cause or aggregation (compound), 
returns a list of symptoms for that root cause. 
Returned list is similar to the getCauses() function.


getEventClassName(<classname>, 
<eventname>)


Returns a string with the name of the ancestor class 
associated with a class and an event. 


getEventDescription(<classname>, 
<eventname>)


Returns a description for an event. The description 
string is defined in MODEL.


getEventType(<classname>, <eventname>) Returns a string that indicates the type of the event 
(PROBLEM, EVENT, AGGREGATE).


getExplainedBy(<classname>, 
<instancename>,<eventname>[,<oneHop>])


Returns those problems which the MODEL 
developer has listed as explaining this problem.


getExplains(<classname>, 
<objectname>,<eventname>[,<oneHop>])


Given a root cause, returns the alternate closure as 
defined in MODEL.


getInstances(<classname>) Returns a list of strings (not object handles) that 
are the names of the instances of that class.


getRuleFileName([<fullname>]) Returns the filename of the currently executing rule 
file.


getServerName() Returns the name of the Domain Manager.


getExternalString(<table>, <key>, <locale>) Extracts a string given a table name, key, and 
locale, and renders the string given a list of 
substitutions (up to six).


glob(<pattern>,<string>) Enables glob style pattern matching. Standard glob 
syntax. Returns a Boolean.


global Defines the scope of a variable as global. If more 
than one adapter for a repository, global values can 
be shared.


hex Represents a hexidecimal number. There is no 
minus sign.


hexToString(<hexadecimal>) Converts a hexidecimal number (the argument) to a 
string.


if (<conditional expression>) {<statements>} Represents a conditional statement.


ignore Used in conjunction with “case” to make all string 
matches NOT case-sensitive.


Table 21  ASL syntax  (page 3 of 6)


Syntax Description
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IGNORE Exception handling, ignores exception and 
continue.


input=string Defines the input for parsing. 


integer Represents an integer, including an optional minus 
sign.


is(<objecthandle>-><Relate>,<object2handle>) Tests whether an object is a member of a 
relationship.


isNull() Tests whether an object handle points a valid 
object. If TRUE, object does not exist.


len(<number>) Moves the current starting position of an input 
string a number of characters.


list(<listitem1>,<listitem2>,<listitem3>,etc.) Creates a list variable. Can either be used with 
arguments or without.


local Variable scoping keyword.


LOG Keyword for exception handling. Writes to the 
system log when an exception occurs.


LOG(<loglevel>) Keyword for exception handling. Writes to the 
system log when an exception occurs and allows 
the classification of the exception’s severity.


NEXT Keyword for exception handling. Skips remaining 
actions in do block and goes to next rule.


NO_LOCK Argument passed to the transaction() function.


not(<pattern>) Does not match if pattern matches. Matches if the 
pattern does not.


notany(<string>) Matches any character not included its argument 
<string>.


numeric() Attempts to convert the argument to a number. If it 
is a Boolean, it returns 1 if TRUE and 0 is FALSE. If it 
is a string, it tries to interpret it as a number. If it 
cannot, an error occurs.


object([<classname>,]<objectname>) Converts a name to an object handle. 


object(<objhandle>) Returns an object handle.


peek(<pattern>) Prescan input for a pattern and match or fail it. The 
search position does not change by using peek.


print(<string>) Prints the argument string to the screen.


quit() Shuts down the EMC Smarts process the adapter is 
talking to. This can be the adapter or a Domain 
Manager.
Tells the back end to shut down.If you launch 
sm_adapter and do not specify a back end, the 
adapter becomes its own back end. In such cases, 
quit() does the same thing as self->quit().


READ_LOCK Argument passed to the transaction() function.


Table 21  ASL syntax  (page 4 of 6)
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rep(<pattern>[,<Number>]) Repeat pattern or rule a defined number of times or 
until it fails.


return <string> Returns a value from a do block.


self Same as self->.


self-> Directs functions that interact with the repository to 
use the adapters repository and not the Domain 
Manager's. Used in conjunction with adding 
objects to the adapter's repository.


setLocale(<locale>) The <locale> is the RFC-1766/3066 compliant 
specification for language and country. The return 
value is a string representation of the previous 
setting of the locale, or a default value if setLocale() 
has not yet been called.


sizeOf(<string>) Counts the number of characters in a string.


sizeof(<string>) Counts the number of characters in a string.


sleep(<number>) Causes the adapter to sleep for a certain number of 
seconds.


STOP Exception handling. Stops the ASL script.


stop() Stops the current thread. If you call stop() in an ASL 
thread, and that thread is in a process that has 
other threads, the effect is to simply kill that 
thread. But if that thread is the only thread, which 
is the typical case when using sm_adapter, 
stopping that thread effectively kills the adapter 
(because the adapter shuts down when there are 
no more active threads).


string(<value>) Converts the argument to a string.


substring(<string>,<start_pos>,
<num_chars_to_remove>)


Returns a new string that is a piece of the string 
passed to it.


tab(<integer>) Moves the starting position in an input string to the 
position passed to the function. This cannot be 
used to go backwards. If no argument is specified, 
this function returns the starting position for 
pattern matching in an input string.


table() Creates a table variable.


thread() Returns the thread ID of the thread that is running 
the adapter.


time() Returns the system time.


toLower(<string>) Converts string to lowercase letters.


toUpper(<string>) Converts string to uppercase letters.


trace(<string>,BOOLEAN) Makes tracing available from with ASL


Table 21  ASL syntax  (page 5 of 6)
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transaction([<WRITE_LOCK|READ_LOCK|
NO_LOCK>] )


Starts a repository transaction. Allows updates to a 
Domain Manager to be entered and then 
committed all at once. Needs to be committed 
before changes in the Domain Manager are 
accepted. Use the abort() function instead of the 
commit() function to remove changes. If a START 
rule begins before things are committed, they are 
automatically aborted. NO_LOCK is the default.


TRUE Boolean true.


undef() Undefines a variable. Appears as if the variable was 
never assigned.


while Conditional statement causes loop while condition 
is true.


word Represents a series of characters ending with, but 
not including, a delimiter.


WRITE_LOCK Argument passed to the transaction() function.


Table 21  ASL syntax  (page 6 of 6)
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Reserved words
Table 22 on page 140 lists the ASL words that are reserved and should not be used as 
identifiers or variables. The reserved words are case-sensitive. Parentheses () indicate 
functions. Not all of the reserved words are currently used. 


Table 22  ASL reserved words  


any() float ignore sizeOf()


boolean() foreach IGNORE sizeof()


break formatString() input rep()


case fs integer repository


char getCauses() is() sleep()


clear() getChildren() isNull() STOP


consistencyUpdate() getClassDescription() len() stop()


continue getClosure() list() string()


correlate() getEventClassName() local substring()


create() getEventDescription() LOG tab()


default getEventType() NEXT table()


defined() getExplainedBy() NO_LOCK thread()


delete() getExplains() not() time()


delim getExternalString() notany() toLower()


do getInstances() notify() toUpper()


else getOpDescription() numeric() trace()


eol getPropDescription() object() transaction()


exact getRuleFileName() peek()


FAIL getServerName() print() TRUE


FALSE glob() quit() undef()


feError() global READ_LOCK while


feErrorMsg() hex return() word


feErrorReset() hexToString() self WRITE_LOCK


filter if setLocale()
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This appendix describes the Domain Manager Control Program (dmctl) and how it 
interacts with a Domain Manager. It consists of the following sections:


◆ Description ...........................................................................................................  142
◆ dmctl syntax .........................................................................................................  143
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Description
The Domain Manager Control Program or dmctl is a command line tool for interacting with 
a Domain Manager. “dmctl syntax” on page 143 provides additional information. The 
dmctl can be used to query, modify, or receive notifications from a Domain Manager. 


The tool can do any of the following: 


◆ Execute commands typed at the command line


◆ Execute commands read from a batch file


◆ Interactively read commands typed in


If no batch file or command is specified, dmctl enters an interactive mode in which it 
prints a prompt and accepts typed user commands. If a batch file is specified, dmctl 
executes the commands in the batch file. Single commands can also be specified.


Command names can be abbreviated, usually to the shortest unique prefix. There are 
exceptions to allow a common command to be typed easily when an uncommon one 
conflicts with it, and conversely, to prevent the accidental typing of some commands. For 
example, getE is getEvents. The minimum abbreviation for getEventDescription is 
getEventD. The quit and exit commands cannot be abbreviated, and shutdown must 
appear as at least shut. Uppercase letters in command names are shown for clarity only. 
They can be typed in lowercase, with the same meaning.


In non-interactive mode, dmctl also accepts commands that subscribe to notifications 
from the Domain Manager. In that case, dmctl does not return, but continuously waits for 
notifications and prints them to standard out (stdout).


◆ In a command-line mode, the Domain Manager to interact with must be specified with 
the --server=<name> or -s <name> option.


◆ In batch or interactive mode, the Domain Manager to interact with can be specified 
later with the attach command.


ASL and dmctl


Issuing dmctl instructions is a good method to use to find out about the classes, 
attributes, events, relationships, and methods available in a Domain Manager. When you 
debug ASL scripts, dmctl is an effective tool to monitor the state of a Domain Manager.


Setting the locale


Locale is the RFC-1766/3066 compliant specification for language and country. For 
example, “fr_FR” refers to French as spoken in France.


The setLocale command can be used in dmctl to set the locale of a session, as described 
in “Setting the locale” on page 15. The types of text that the locale affects is the same as 
those described for an ASL script. The section “Locale effects on message rendering” on 
page 15 provides additional information.
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dmctl syntax
The basic syntax is:


dmctl [options...] [<command>]


When given a command or batch file to run, dmctl executes the commands and exits.


The options include those listed in Table 23 on page 143. 


Table 23  dmctl options


Option Description


--server=<name> Name of Domain Manager. This argument is used to identify 
the Domain Manager to connect to. If it is not specified, it can 
be set later, in interactive mode, by using the attach 
command. If it is in a host:port/name format, the specified 
host:port is used to locate Domain Manager name. Otherwise, 
if it is in a simple name format, name is located by the Broker.
Also -s <name>.


--broker=<location> Alternate Broker <host>:<port> location. If it is not specified, the 
Broker is located by the standard search order, as follows:
If the SM_BROKER environment variable is defined, use its 
value. Otherwise, use the default smarts-broker:426 location.
Either <host> or :<port> portions may be omitted, in which case 
the defaults smarts-broker and :426 are used, respectively.
Also -b <location>.


--file=<file> Input batch file. Given this option, dmctl executes the 
commands in the file and exits.
Also -f <file>.


--timeout[=<seconds>] Set a timeout on the remote execution of each command. A 
value of 0 specifies no limit. The default is 0 (no limit) in 
interactive mode, 60 (1 minute) in non-interactive mode. If 
--timeout is specified without an argument, a value of 60 
seconds is used. If a remote command takes too long, an error 
message is printed and dmctl immediately exits with the 
status ETIME.


--traceServer Trace actions performed in the Domain Manager.


--commands List dmctl commands and exit. 
Also -c.


--help Print help and exit.


--version Print program version and exit.
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At any given time, dmctl can be attached to (at most) one Domain Manager. The dmctl 
forwards all accepted commands to the attached Domain Manager, receives a response, 
and prints it to stdout. It is important to remember that the commands are invoked in the 
server process. The commands include those in Table 24 on page 144. 


Table 24  dmctl commands  (page 1 of 3)


Command Description


attach domain Attaches to the specified Domain 
Manager. Once a Domain Manager is 
attached, other commands can be 
invoked.


clear <class>::<instance>::<event> Forces a clear of the specified event.


create <class>::<instance> Creates a new instance in the 
repository.


consistencyUpdate Recomputes the codebook.


correlate Correlates now.


delete <class>::<instance> Deletes an instance from the 
repository.


detach Detaches from the Domain Manager. 
Another Domain Manager can now be 
attached with the attach command.


execute <program> [<arg1> ...] Executes a program. Program should 
be the base name of the program file, 
without the suffix or directory. For 
example, use “name” to load the 
program name.po.


exit Exits dmctl.


findInstances <class-pattern>::<instance-pattern> Lists instances that match given class 
and instance patterns.


get <class>::<instance>[::<property>] Lists all properties values or a given 
property value for a particular class 
instance.


getClasses Lists all classes in the repository.


getEvents <class> Lists all exported events defined in 
given class.


getEventDescription <class>::<event> Prints description of given event.


getInstances [<class>] Lists all instances in the repository, 
or all instances of the given class.


getModels Lists all models loaded to the 
Domain Manager.


getOperations <class> Lists all operations defined in given 
class.


getPrograms Lists all programs loaded to the 
Domain Manager.


getProperties <class> Lists all properties defined in given 
class.
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getThreads Lists all threads that are running in 
the Domain Manager.


insert <class>::<instance>::<property> <value> Inserts a value into a table or 
relationship.


invoke <class>::<instance> <op> [<arg1> ...] Invokes an operation of given 
instance.


loadModel <model> Loads a new MODEL library. The 
<model> should be the base name of 
the library. Do not specify a prefix or 
suffix with the name. 
Once a MODEL library is loaded, a 
prefix or suffix is added to the name. 
For example, libname.so (UNIX) or 
name.dll (Windows). 
After a MODEL library is loaded, the 
repository can be populated with 
instances of classes defined in that 
library.


loadProgram <program> Loads a new program.The <program> 
should be the base name of the 
program file. Do not specify a prefix 
or suffix with the name. 
Once a program is loaded, a prefix or 
suffix is added to the name. For 
example, name.po.
After a program is loaded, it can be 
executed with the execute command.


notify <class>::<instance>::<event> Forces notification of a given event.


ping Verifies that the Domain Manager is 
still alive.


put <class>::<instance>::<property> <value1> 
[<value2> ...] 


Sets value of given property.


quit Quits dmctl.


remove <class>::<instance>::<property> <value> Removes a value from a table or 
relationship.


restore <file> Restores the repository from a file. 
The <file> should not contain a 
directory portion; it is read from 
BASEDIR/smarts/local/repos.


shutdown Shuts down the Domain Manager.


save <file> [<class>] Saves the repository to a file. The 
<file> should not contain a directory 
portion. It is saved to 
BASEDIR/smarts/local/repos. If 
<class> is specified, then save only 
the sub-tree rooted at class.


Table 24  dmctl commands  (page 2 of 3)


Command Description
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setLocale <locale> Allows you to set the locale before a 
Domain Manager attach operation, 
and to change the locale while the 
session is open. The setLocale 
command will print the value of the 
previous setting on completion of the 
API call.
The default locale is set for a dmctl 
session as follows:
1. The value of the SM_LOCALE 


environment variable.


2. If SM_LOCALE is not set equal to a 
value, then the default locale is 
set equal to en_US.


status Displays the connection status.


subscribe 
<class-regexp>::<instance-regexp>::<event-regexp> ... 


Subscribes to problems and events 
that match the given patterns. The 
dmctl sends the subscription 
requests, and then loops indefinitely, 
printing the received notifications. 
The program exits only when the 
Domain Manager is shut down, or 
when interrupted.


subscribeEvents 
<class-regexp>::<instance-regexp>::<event-regexp> ... 


Subscribes to events that match the 
given patterns. The dmctl sends the 
subscription requests, and then 
loops indefinitely, printing the 
received notifications. The program 
exits only when the Domain Manager 
is shut down, or when interrupted.


subscribeProblems 
<class-regexp>::<instance-regexp>::<event-regexp> ...


Subscribes to problems that match 
the given patterns. The dmctl sends 
the subscription requests, and then 
loops indefinitely, printing the 
received notifications. The program 
exits only when the Domain Manager 
is shut down, or when interrupted.


Table 24  dmctl commands  (page 3 of 3)


Command Description
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APPENDIX C
Card-Port MODEL Code


This appendix provides the Card-Port MODEL as described in “Correlation model used for 
example scripts” on page 95. It consists of the following sections:


◆ Card-Port MODEL example.....................................................................................  148
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Card-Port MODEL example
The following example provides the Card-Port MODEL as described in “Correlation model 
used for example scripts” on page 95.


/* card.mdl - 
 *
 * Copyright (c) 2000, EMC Corporation
 * All Rights Reserved
 *
 * A simple model file for use as an example of writing and 
* building a small model.
 *
 */


// Include the "resource" class from the netmate heirarchy.


#include "nm/nm.mdl"


// Since we include nm.mdl for purposes of derivation, we must 
// have the generated .h file include nm.h


#pragma include_h "nm/nm.h"


///////////////////////////////////////////////////////////////
//
//  This is a very simple card.
//
///////////////////////////////////////////////////////////////


// The class Card
interface Card : MR_ManagedObject {


   // Attributes maintained for the class Card
   attribute string CardDesc
   "A brief description of the card";


   // Relationship between the class Card and
   // the class Port
   relationshipset ComposedOf, Port, PartOf
   "The ports in this card";


   // The notifications for the class Card
   export
      Down,             // Problems
      Impaired;         // Compound Notification


   problem Down
   "The card is down, causing all its ports to be "
   "operationally down"
   = OperationallyDown;


   propagate symptom OperationallyDown
   "Symptom observed on the ports in this card"
   = Port, ComposedOf, OperationallyDown;


   // Compound notification
   aggregate Impaired
   "The card or a port on this card is Down"
   = Down,
     PortDown;

148 EMC Smarts Foundation ASL Reference Guide







Card-Port MODEL Code

   propagate aggregate PortDown
   "The Down problem on ports in this card"
   = Port, ComposedOf, Down;


}


// The class Port
interface Port : MR_ManagedObject {


   // Attributes maintained for the class Port
   enum operStatus_e {
      TESTING   = 0,
      UP        = 1,
      DOWN      = 2
   };


   attribute operStatus_e operStatus
   "The operational status of the port"
   = TESTING;


   // relationship between the class Port and
   // the class Card
   relationship PartOf, Card, ComposedOf
   "The card this port is part of";


   // The notifications for the class Port
   export
      OperationallyDown,        // Symptom
      Down;                     // Problem


   event OperationallyDown
   "This port is not operational"
   = operStatus == DOWN;


   // Problem
   problem Down
   "The port is down"
   = OperationallyDown;


}
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
This document contains troubleshooting instructions and frequently asked questions and 
troubleshooting tips on the EMC Smarts Service Assurance Manager.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Global Manager. IT managers who seek to understand the role of the 
Global Manager in the context of an EMC Smarts solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide Guide.
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Preface

EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than  C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide
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◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.
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Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about  your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Troubleshooting 


This section provides basic troubleshooting steps for some of the tasks and issues you 
may encounter while using the EMC Smarts Service Assurance Manager. This is just a 
listing of a select few of the many questions and answers in our database. If you are 
encountering a more specific issue you may want visit the EMC Smarts forums or go to 
EMC online support. The following category of issues are covered: 


◆ Configuration issues ...............................................................................................  14
◆ Adapter issues ........................................................................................................  24
◆ NOTIF issues ...........................................................................................................  31
◆ Notification and event processing issues ................................................................  33
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Configuration issues
This section provides troubleshooting help for the following issues:


◆ “Synchronizing Service Assurance Manager with other Domain Managers” on page 15


◆ “Out-of-memory issue” on page 15


◆ “Checking status of underlying domain managers” on page 17


◆ “Identifying a port number” on page 17


◆ “Refreshing the console” on page 18


◆ “Reattaching to a Manager” on page 18


◆ “Responding to disconnected Managers” on page 19


◆ “Support is absent for IPv6 literal addresses in URLs” on page 19


◆ “Web Console or viewlets running out-of-memory” on page 20


◆ “SelectiveGroup and HierarchicalGroup instances lost when 
HierarchicalGroupManager is deleted or purged” on page 20


◆ “Inability to load dynamic library causes ASL errors” on page 22


◆ “Unable to build hierarchical groups while running group driver” on page 22


◆ “Containment view missing from Presentation SAM” on page 23
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Synchronizing Service Assurance Manager with other Domain Managers


Symptom
Unable to synchronize Service Assurance Manager with IP Availability Manager.


Recommended action
Run the following command to synchronize Service Assurance Manager with IP Availability 
Manager:


<basedir>/smarts/bin/dmctl -s <sam_server> invoke 
GA_DaemonDriver::<am_server>_Topo-Driver start


dmctl -s INCHARGE-SA invoke 
GA_DaemonDriver::INCHARGE-AM-PM_Topo-Driver start


Out-of-memory issue


Symptom
Subscriber queue keeps growing in the server for a client that has become inactive. The 
queue processing thread in the server gets blocked in the socket during a write-operation, 
when the client stops reading data off the socket. However, keepAlives continue to be 
sent, thus keeping the connection active. 


Possible cause
The out-of-memory issue may be occurring because there is a finite amount of memory 
process that can be used. Hence, if you have a very large topology or lot of notifications in 
the SAM repository, then it would result in hitting the limit. Memory usage increases to the 
maximum during topology synchronization because new topology objects are created 
during synchronization. 


Recommended action
The solutions recommended include:


◆ Refactoring of domains (short term solution): Redesign your deployment to deploy 
additional Global Managers in a hierarchical Service Assurance configuration. Instead 
of using one SAM, split them into two. For instance, if one SAM is configured with 20 
underlying domains, then start two SAMs with 10 each. This reduces the topology size 
and notification flow. Additionally, you can choose to reduce the archive interval from 
4 hours (default) to a shorter interval. Also, topology can be trimmed by avoiding 
import of unnecessary classes.


◆ Refine notification lists for users.


◆ Re-assess the topology synchronization configuration.


◆ Refine sets of trap and syslog notifications sent to SAM.


◆ Increase worker threads used for escalation.


◆ If you are on a lower version of SAM, migrate to a higher version. This is a good long 
term solution.


The EMC Smarts Service Assurance Manager Deployment Guide provides detailed 
guidelines and procedures for assessing and improving performance of your deployment.
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Logs or information to collect
◆ Run <BASEDIR>/smarts/bin/sm_monitor against the domain for collecting data every 


few hours.


◆ Use the <BASEDIR>/smarts/bin/sm_getinfo utility to collect logs and configuration 
settings if you intend to raise an issue with support.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides details on using the sm_getinfo utility to collect data to help in 
troubleshooting problems.
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Checking status of underlying domain managers


Symptom
Unable to figure out the operational status of the underlying domain manager. 


Recommended action
If you do not know the operational status of your underlying domain manager, use the 
brcontrol command or the Browse button in the Attach Manager dialog box to list the 
Managers and their status. The status listed for your Manager should be ‘Running.’ If your 
Manager is not running state, contact your administrator, consult the EMC Smarts System 
Administration Guide, or refer to your specific product installation guide for instructions 
on starting the Manager.


For the brcontrol command, type one of the command lines shown in Table 1 on page 17.


Identifying a port number


Symptom
Unable to find the port number of a domain manager. 


Recommended action
If you do not know the port number of a domain manager, use the brcontrol command or 
the Browse button in the Attach Manager dialog box to display the port number. 


Table 1  The brcontrol command


Operating system Example


Windows (MS-DOS prompt) <BASEDIR>\smarts\bin\brcontrol
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Refreshing the console


Symptom
Console display is distorted.


Recommended action
If your console does not display properly, you can force the console to redisplay. For 
example, if fragments of menus or fields from dialog boxes linger after the menus or 
dialog boxes close, you can redisplay the console.


To refresh a console, select View > Refresh.


Reattaching to a Manager


Symptom
Machine running Service Assurance Manager becomes unavailable.


Recommended action
Initially, when you log in to start a session, you specify the Manager to which you want to 
attach. Ordinarily, you do not have to attach again during your session.


If the machine running the Service Assurance Manager becomes unavailable, the Global 
Console polls the broker every 30 seconds and reattaches when the Manager is 
operational. EMC Smarts Service Assurance Manager Operator Guide includes 
instructions on manually attaching or reattaching to an EMC Smarts Manager.


If a EMC Smarts Manager disconnects, a Domain Disconnected message appears 
informing you that the Manager disconnected and that the console will reconnect when 
the domain becomes available.
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Responding to disconnected Managers


Symptom
Underlying Managers get disconnected from the Global Manager. 


Recommended action
When underlying Managers disconnect from the Global Manager (for example, due to a 
network outage), the notifications from the unavailable sources are not updated in the 
console. The affected notifications, maps, and summaries no longer reflect the current 
conditions. 


If a disconnect situation occurs, a Session Disconnected notification informs you that a 
specific Manager is disconnected and a similar entry is added to the audit log.


When the Manager reconnects, the Session Disconnected notification clears, and it is 
recorded in the audit log.


If you receive a Session Disconnected notification, your administrator should investigate it 
for a network connection failure or an operational problem. The Manager may need to be 
restarted.


Support is absent for IPv6 literal addresses in URLs


Symptom
Microsoft Internet Explorer (IE) web browser running on Windows XP does not support IPv6 
literal addresses in URLs. This limits the IPv6 console support in the Web Console and 
Business Dashboard because the URL for the Business Dashboard and/or Web Console 
HTML file cannot be specified as an IPv6 literal address in IE. Microsoft documents this as 
a known limitation in "IPv6 for Microsoft Windows: Frequently Asked Questions 
(http://www.microsoft.com/technet/network/ipv6/ipv6faq.mspx).


Firefox and Mozilla web browsers support IPv6 literal addresses in URLs.


Recommended action
Use Firefox or Mozilla web browsers instead of Microsoft IE if you need to use an IPv6 
literal address to access the Web Console or Business Dashboard.
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Web Console or viewlets running out-of-memory


Symptom
Depending on the heap space configured for the web browser in which the Web Console or 
Business Dashboard runs, the Web Console or the viewlets in the Business Dashboard 
may run out-of-memory. By default, the Web Console and viewlets allocate less heap 
space than the Global Console. Less heap space may result in out-of-memory errors in the 
Web Console or viewlets. For example, an out-of-memory error may occur in a Web Console 
that heavily uses large map background images.


Recommended action
If the Web Console or viewlets run out-of-memory, adjust the maximum amount of heap 
space that the Java Plug-in uses for dynamic memory allocation. For example, by 
specifying -Xmx256M as a runtime parameter you can increase the heap space allocation 
to 256 MB. The number can be set larger or smaller than 256 MB, depending on the 
resources available on the client machine running the web browser. To increase the heap 
space for the Java Plug-in:


1. Launch the Java Plugin Control Panel. For instructions, see:


http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-gui
de/jcp.html.


2. In the Java Plug-in Control Panel, click the Java tab.


3. In the Java tab page, click View in the Java Applet Runtime Settings box.


4. The Java Runtime Settings dialog box appears.


5. In the Java Runtime Settings dialog box, in the Java Runtime Parameters text entry field 
for your JRE, type the maximum heap-space runtime parameter (-Xmx) and a value for 
the parameter. For example:


-Xmx256M
6. Save your entry. Click OK to close the Java Runtime Settings dialog box. Then click OK 


to close the Java Control Panel.


Close and restart any web browser running on the host machine.


SelectiveGroup and HierarchicalGroup instances lost when 
HierarchicalGroupManager is deleted or purged


Symptom
If the HierarchicalGroupManager instance is deleted or purged due to some reason, the 
group instances are not visible. 


Recommended action
The HierarchicalGroupManager instance maintains relationships with HierarchicalGroups 
and SelectiveGroups. SelectiveGroups are created using SAM console and 
HierarchicalGroups are created from configuration files. Once HierarchicalGroupManager 
instance is purged, the group instances are not visible since the relationship information 
is lost even though group instances are present in the repository.
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In case of HierarchicalGroup instances, use the following steps to recreate them:


1. In the Global Manager Administration Console, expand INCHARGE-SA > ICS 
Configuration and click Business Templates.


2. Click Modify List on the Configure “Business Templates” screen.


3. On the Edit Business Template dialog-box, select a template from Selected Template 
Files and remove it.


4. From Available Template Files, add the template you just removed.


5. Click OK on the Edit Business Template dialog-box.


6. Click Apply on the Configure “Business Templates” screen.


7. Start the group driver by running the following command:


    dmctl -s INCHARGE-SA invoke GA_DaemonDriver::ICS-Group-Driver 
start


For recreating SelectiveGroup instances, run the following command:


./sm_adapter -s INCHARGE-linux ics/ics-restore-selectivegroup.asl
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Inability to load dynamic library causes ASL errors 


Symptom
In a typical SAM configuration, when the server is started it does not contain the dynamic 
library to load all custom classes, for example, UIM_O_AdapterManager. In a custom 
hierarchical SAM configuration, this may result in generating ASL errors. 


Recommended action
The following configuration must be made in the hierarchical SAM area to avoid the 
generation of ASL errors:


1. Copy dyn_uii.ldm and dyn_uii.mdl files from the Service Assurance Manager 
<BASEDIR>/smarts/model/ics files to the <BASEDIR>/smarts/local/model/top-sam 
folder. Here, top-sam is the custom folder created for the top-level SAM.


2. Restart the server.


Unable to build hierarchical groups while running group driver


Symptom
No map console groups are created running the GA_DaemonDriver using the dmctl -s 
INCHARGE-SA invoke GA_DaemonDriver::ICS-Group-Driver start command. 


Recommended action
If there are multiple hosts configured across groups, there may be an issue while creating 
hierarchical groups in SAM. Delete the disjointed hosts from the topology and the current 
map console structure, and run the script. 
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Containment view missing from Presentation SAM


Symptom
Containment view is missing from Presentation SAM, but is available in Aggregation SAM. 
The problem occurs because the Presentation SAM topology driver is hanging.


Recommended action
To resolve this issue:


1. Run the following command to determine the state of the topology driver:


<BASEDIR>/smarts/bin/dmctl -s <Pres SAM> get GA_DaemonDriver::<AGG 
SAM>_Topo-Driver


2. Compare the state of the topology driver with that of the SAM domain. If the topology 
driver state is GA_DRIVER_RUNNING, but the SAM domain topology does not indicate 
that topology sync is occurring, then the topology driver is hanging. The topology 
driver must only be running during a SAM domain topology sync. When no topology 
sync is occurring, the topology driver must display the status as GA_DRIVER_STOPPED.


3. If the topology driver is hung, restart the Presentation SAM domain to resolve the 
issue.


The ‘TimeOutTopo’ flag in the dxa-sam.conf file helps detect if a a driver hanging and will 
stop the driver so that the next topology sync will proceed normally. By default the 
TimeOutTopo flag is disabled. To enable the flag:


1. Open the dxa-sam.conf configuration file for editing in sm_edit as follows:


<BASEDIR>/sm_edit conf/ics/dxa-sam.conf


2. Find the ‘TimeOutTopo’ line. Remove the comment hash character (#) from the start of 
the line to enable the functionality, and increase the timeout value (in seconds). For 
instance change the line #TimeOutTopo 60 to TimeOutTopo 600.


The increased value (600) specified in the example and can be configured to a 
different value. From SAM 8.1 Service Pack 1 (SP1) release, the TimeOutTopo value is 
set to 600 seconds by default and the dxa-sam.conf configuration file still contains 
the option of changing the time out value. For more information on the TimeOutTopo 
flag, see the EMC Smarts Service Assurance Manager Configuration Guide. Earlier 
versions of SAM will not have a default value.


3. Run a reconfigure operation in Presentation SAM or restart the Presentation SAM 
domain for the changes to take effect in the active environment.
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Adapter issues
This section provides troubleshooting help for the following issues:


◆ “Notification adapter fails to start” on page 24


◆ “Notification adapter starts, but fails to connect to EMC Smarts Manager” on page 25


◆ “Email not received from Email Notifier” on page 27


◆ “Email received from Email Notifier, but not for all events” on page 28


◆ “File notifier does not create a log file containing notifications” on page 28


◆ “Not all events are recorded in the file notifier output” on page 29


◆ “No traps delivered to destination by trap notifier” on page 29


◆ “Not all traps delivered to destination by SNMP Trap Notifier” on page 30


◆ “Script is not invoked for Script Notifier Adapter” on page 30


Notification adapter fails to start


Symptom
Notification adapter appears not to start. The issue may be seen across Email Notifier 
Adapter, the Log File Notifier Adapter, the SNMP Trap Notifier Adapter, and the Script 
Notifier Adapter.


Recommended action
When a notification adapter appears not to start, check the status of its process or service.


For an adapter started with the sm_notify command


For Windows, check the Task Manager for the sm_notify process.


For an adapter started as a service


For Windows, to check the status of a service, use the Service control panel:


1. Click Start.


2. Select Settings > Control Panel > Administrative Tools > Services.


For UNIX


Type the command from the <BASEDIR>/smarts/bin directory:


./sm_service start <service_name> [<service_name> ...]


where <service_name> is the service you need to start.


Additionally, you can check the sm_notify_en_US_UTF-8.log present in the 
<BASEDIR>/local/logs folder or use the sm_getinfo utility to collect data to help 
troubleshoot the problem.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides details for using the sm_getinfo utility.
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Notification adapter starts, but fails to connect to EMC Smarts Manager


Symptom
Adapter starts successfully without any error, but cannot connect to an EMC Smarts 
Manager. The issue may be seen across Email Notifier Adapter, the Log File Notifier 
Adapter, the SNMP Trap Notifier Adapter, and the Script Notifier Adapter. 


Recommended action


When an adapter cannot connect to an EMC Smarts Manager, it is usually for one of the 
following reasons:


◆ EMC Smarts Manager is not running.


◆ Name of the EMC Smarts Manager is not the same as the name specified in the 
adapter’s configuration file.


◆ EMC Smarts Manager cannot be reached from the host running the adapter.


Check the status of the EMC Smarts Manager


Use the brcontrol command to check the status of the EMC Smarts Manager. The syntax is:


<BASEDIR>/smarts/bin/brcontrol


By default, this command returns a list of EMC Smarts Managers registered with the broker 
and their current state. The list indicates whether an EMC Smarts Manager’s state is 
RUNNING or DEAD. If the EMC Smarts Manager is not running or included in the list, restart 
the EMC Smarts Manager.


Check the name of the EMC Smarts Manager in the configuration file


The configuration file of each adapter contains the name of the EMC Smarts Manager to 
which it connects. This value in the configuration file can be overridden by using the 
--server option with the sm_notify command.


In cases where an adapter cannot connect, check that the --server option, if used, points 
to a valid EMC Smarts Manager. If that is not the issue, check that the appropriate 
EMC Smarts Manager is specified in the adapter’s configuration file. 


Table 2 on page 25 lists the configuration file and parameter to check for each adapter.


Check communication to the EMC Smarts Manager’s host


If the adapter and the EMC Smarts Manager run on different hosts, the adapter’s host 
might not be able to communicate with the EMC Smarts Manager’s host. From the 
adapter’s host, run the following command:


Table 2  Adapters and EMC Smarts Manager parameters


Adapter
Location and name (relative to 
<BASEDIR>/smarts/conf)


EMC Smarts Manager 
parameter


Email Notifier Adapter /notifier/mail-notify.conf serverName


Log File Notifier Adapter /notifier/file-notify.conf serverName 


SNMP Trap Notifier Adapter /notifier/trap-notify.conf serverName 
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dmctl --server=<InCharge_Manager> ping


The results of this command show whether the EMC Smarts Manager is alive or 
unavailable.
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Email not received from Email Notifier 


Symptom
When the Email Notifier Adapter starts and connects to the Domain Manager, the intended 
recipient receives no email.


Recommended action
The issue is usually caused due to an incorrect configuration. The configuration file for the 
Email Notifier Adapter is mail-notify.conf. This file resides in the 
<BASEDIR>/smarts/notifier directory.


There are three parameters that specify where the Email Notifier Adapter delivers 
information. Table 3 on page 27 lists these parameters.


Check the parameters in the configuration file and verify them with your email 
administrator. All three must have a valid value for the Email Notifier Adapter to work. For 
the changes to the configuration file to take effect, the adapter must be restarted.


Table 3  Parameters needed to receive email


Parameter Description


MailServer Name for the mail server. For example:
MailServer = "localhost"


SenderId Email address associated with the adapter. Users can reply to 
this address. This address must be recognized by the mail 
server. For example:
SenderId = "daemon@localhost"


Recipients A comma-separated list of the recipients of the emails. The
recipients in the list must be recognized by the mail server. For
example:
Recipients = "root@localhost,recipient@your_company.com"
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Email received from Email Notifier, but not for all events 


Symptom
Email Notifier Adapter does not seem to be sending messages for all of the correct events.


Recommended action
The issue could be that the subscription profile is incorrect or that you expect the adapter 
to be sending messages when notifications clear. To resolve the issue you can:


Modify the subscription profile


When the Email Notifier Adapter sends email, but does not send them for all expected 
events, the issue usually is improper subscriptions. “Specifying subscriptions in the 
configuration file” in the EMC Smarts Service Assurance Manager Notification Adapters 
User Guide contains instructions on modifying the subscription profile for this adapter.


Change the Email Notifier Adapter to send notifications of cleared events


By default, the Email Notifier Adapter does not send messages when a notification clears. 
It only sends messages for new notifications or when the certainty of the notification 
changes.


To enable the Email Notifier Adapter to send CLEAR notifications, change the following in 
the file, <BASEDIR>/rules/notifier/mail/mail-filter.asl:


START () {
OMIT_CLEAR_EVENTS
}
to
START () {
// OMIT_CLEAR_EVENTS
}


After making changes to the file, restart the adapter for the changes to take effect.


File notifier does not create a log file containing notifications 


Symptom
The Log File Notifier Adapter starts and connects to the EMC Smarts Manager, but it does 
not appear to create the notification file.


Recommended action
Check to ensure the filename is the one you expect. The Log File Notifier Adapter’s 
configuration file, file-notify.conf, contains the name of the notification file. The 
file-notify.conf file resides in the <BASEDIR>/smarts/conf/notifier directory. The parameter, 
fileName, defines the name of the notification file that the adapter creates for its output. 
The adapter always creates the notification file in the <BASEDIR>/smarts/local/logs 
directory. If you do not specify a value, the adapter creates a default file named 
<InCharge_Manager>-alarms.log.
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Do not confuse this adapter’s output file with its log file. The log file also appears in the 
<BASEDIR>/smarts/local/logs directory. You determine the log file’s name when the 
adapter starts using the --output command option. The default name of the log file is 
sm_notify.log. Never use the same name for both the notification file and the Log File 
Notifier Adapter’s log file.


Not all events are recorded in the file notifier output 


Symptom
The Log File Notifier Adapter sends information to the notification file, but does not send it 
for all of the correct events.


Recommended action
The issue usually is caused due to improper subscriptions. “Specifying subscriptions in 
the configuration file” in the EMC Smarts Service Assurance Manager Notification 
Adapters User Guide contains instructions on modifying the subscription profile for this 
adapter.


No traps delivered to destination by trap notifier 


Symptom
The SNMP Trap Notifier Adapter starts and connects to the EMC Smarts Manager and does 
not send the SNMP Traps.


Recommended action
The issue is usually the format of the parameter Destinations. The parameter, 
Destinations, is a table that contains the SNMP trap destinations. Each row in the table is 
surrounded by curly braces and consists of three different values: hostname or IP address, 
port number, and SNMP version. The values are separated by commas. There are two valid 
values for SNMP version: V1 and V2C. These values and the values for host name or IP 
address must be surrounded by quotation marks. The port number is an integer value with 
no quotation marks.


Each row in the table is separated from the next by a comma. Place a comma after the curly 
brace that marks the end of each row in the table except for the last. An outer set of curly 
braces defines the entire table. 


For example, the Destinations parameter could appear as follows:


Destinations = {
{"localhost", 162, "V1"},
{"other-host", 30162, "V2C"},
{"195.67.23.103",21539, "V2C"}
}


The SNMP Trap Notifier Adapter supports SNMP V1, SNMP V3, and V2C traps.
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Not all traps delivered to destination by SNMP Trap Notifier 


Symptom
The SNMP Trap Notifier Adapter sends traps, but does not send them for the correct 
events.


Recommended action
The issue is usually improper subscriptions. “Specifying subscriptions in the 
configuration file” in the EMC Smarts Service Assurance Manager Notification Adapters 
User Guide contains instructions on modifying the subscription profile for this adapter.


Script is not invoked for Script Notifier Adapter 


Symptom
This issue applies to the Script Notifier Adapter, where scripts are not invoked for the 
adapter.


Recommended action
To ensure that the script is invoked for the Script Notifier Adapter:


1. Ensure your script is located in <BASEDIR>/smarts/local/actions, and that it is 
readable and executable.


2. Check the configuration file to see that you have altered the file to include the correct 
name for the script you want to invoke.
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NOTIF issues
This section provides troubleshooting help for the following issues:


◆ “Unable to startup NOTIF” on page 31


◆ “NOTIF Java errors in server log” on page 32


Unable to startup NOTIF


Symptom
SAM or OI server logs indicate that NOTIF is active, but also indicate that NOTIF did not 
start. The following error message is generated:


Checking NOTIF settings for start flag...
Loading JVM interface...
Initializing JVM interface...
*** Notif start thread created; returning.
Program initialization call returned.
......<few more lines>.....
*** NOTIF DID NOT START!
com.emc.smarts.notif.entryPoints.notifIcEntryPoint$notifNotEnable
Exception: com.smarts.remote.SmRemoteException
Started: Specified property not found in class
MR-PROPERTY_NOT_FOUND-Specified property not found in class
SAM will continue to run without Notif


Recommended action
Check for the following:


◆ If the value for SM_JAVA_ENABLED parameter is set to YES in the runcmd_env.sh file. 
The The runcmd_env.sh file is located in the <BASEDIR>/smarts/local/conf directory.


◆ All libraries and jars are present in the lib and classes folder, respectively.


◆ SM_LIB_PATH contains the entry for the <BASEDIR>/smarts/lib and 
<BASEDIR>/smarts/local/lib.
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Logs or information to collect
◆ <server_name>.log


◆ Notif.<server_name>.audit.* files


◆ *.ncf files in server configuration directories in all the sitemod locations


◆ Use <BASEDIR>/smarts/bin/sm_getinfo utility to collect  logs and configuration 
settings if you intend to raise an issue with support.


The EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers 
provides details on using the sm_getinfo utility to collect data to help in 
troubleshooting problems.


NOTIF Java errors in server log


Symptom
‘ClassNotFound’ errors observed in SAM or OI server log depending on where NOTIF is 
configured.


Recommended action
Check if jars in notif-init.asl are available in the <BASEDIR>/smarts/classes or 
<BASEDIR>/smarts/local/classes folder.


Logs or information to collect
– <server_name>.log


– Notif.<server_name>.audit.0 files


– Individual trap logs (if applicable)


– *.ncf files in server config directories in all the sitemod locations
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Notification and event processing issues
This section provides troubleshooting help for the following issues:


◆ “Viewing subscriptions for an event” on page 33


◆ “Unsubscribing from disabled events” on page 33


Viewing subscriptions for an event 


Symptom
Unable to identify subscriptions for a given event, but able to view the bootstrap 
subscriptions.


Recommended action
Use the following command to view subscriptions associated with an event:  


dmctl> exec dmdebug subscriptions[=all] [output=]


Unsubscribing from disabled events


Symptom
Unable to unsubscribe from Disabled events using the Service Assurance Manager.


Recommended action
To allow the Service Assurance Manager to subscribe to all problem events except for 
Disabled events, modify the DXA file which is used by the Service Assurance Manager to 
communicate with underlying domains. This file is available under: 


<BASEDIR>/SAM/smarts/bin/sm_edit conf/ics/dxa-conn.conf 


In this file change: 


sub .*::.*::.*/p 


to: 


sub *::*::~Disabled/pg 


Using the "g" modifier, the ".*" becomes "*" for the class and instance.


Add, the ChoiceSubscription->glob = glob("*g*", Modifiers) line to the 
<BASEDIR>/SAM/smarts/bin/sm_edit rules/ics/ics-event-driver.asl file for the Service 
Assurance Manager not to filter the current Disabled events, for example:


ChoiceSubscription->symptoms = glob("*s*|*e*", Modifiers)
ChoiceSubscription->glob = glob("*g*", Modifiers)
ChoiceSubscription->quiet = TRUE


Unsubscribed events do not flow from the domain managers to the SAM server. So, 
disabling notifications using filters in the Global Manager Administration Console will not 
stop events flowing from the domain managers (IP, MPLS, EISM and so on) to SAM. The 
filters will only apply at the SAM and Console level, and as such will only stop the 
notification flow between SAM to the Console or restrict the display of notification on the 
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Console graphical user interface (GUI) even when notifications are received from the SAM 
server and directed to the GUI. Hence, it is recommended that to disable unwanted 
events, you unsubscribe those events. This will improve product performance.
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CHAPTER 2
Frequently Asked Questions


This section is a listing of commonly asked questions and answers on the EMC Smarts 
Service Assurance Manager. The following category of queries are addressed:


◆ Licensing queries ....................................................................................................  36
◆ Configuration queries..............................................................................................  39
◆ Trap processing queries ..........................................................................................  41
◆ NOTIF queries..........................................................................................................  48
◆ Notification and Event processing queries...............................................................  49
◆ Business Dashboard queries...................................................................................  53
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Licensing queries
This section answers the following frequently asked questions on licensing:


◆ “Splitting volume licenses” on page 36


◆ “Host ID for permanent license” on page 36


◆ “Restarting domains to load temporary license” on page 36


◆ “Restarting license server for permanent license” on page 37


◆ “Restarting domains to load permanent license” on page 37


◆ “Adding domain or device post license expiry” on page 37


◆ “Increasing number of licensed devices” on page 38


◆ “Configuration queries” on page 39


Splitting volume licenses


Query


Can I split  available volume licenses between multiple domains?


Answer


As long as the devices are in the same datacenter and they connect to the same license 
server, it will be possible to create two completely separate platforms, else new base 
licenses have to be acquired.


Host ID for permanent license


Query


Which is the Host ID we must use for a permanent FLEXnet license? Do we use one Host ID 
or do we use all host IDs? Here is the output of Lmutil:


lmutil - Copyright (c) 1989-2010 Flexera Software, Inc. All Rights 
Reserved. The FLEXnet host ID of this machine is ""002128a2aea2 
002128a2aea3 002128a2aea4 002128a2aea5""


Answer


It is recommended to use the first host ID.


Restarting domains to load temporary license


Query


Should we restart domains to load new licenses?


Answer


You need to restart your domains.
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Restarting license server for permanent license


Query


Should we restart the license server after receiving a new permanent license?


Answer


You need to place the license file in <BASEDIR>/smarts/local/conf folder in the installation 
directory of the license server.


Use the following command to read the new license:


<BASEDIR>/smarts/bin/lmutil lmreread -c port@license_server


or


<BASEDIR>/smarts/bin/system/lmutil lmreread -c port@license_server


Restarting domains to load permanent license


Query


I have loaded a new permanent license into the license server. Do I need to restart my 
domains?


Answer


Yes, if you have loaded features that enable new functionality such as NOTIF for Service 
Assurance Manager or Server Performance Manager for the IP Manager. 


No, you need not restart the domains if the new license contains additional blocks of 
volume licenses.


Adding domain or device post license expiry


Query


Once the license expires, is there a way in which I can start a new domain or add a new 
device into the topology?


Answer


No, you need to get a new license to start new domain servers. 
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Increasing number of licensed devices


Query


I want to understand how licensing works in a scenario where an existing EMC Smarts user 
wants to increase their number of licensed devices. If the user just increases the number 
of licensed devices, would it be valid to create two EMC Smarts platforms completely 
separated, without having to buy any additional licenses for SAM, BIM and so on? The 
requirement is to create another platform with no relationship with the prior one. For 
example, if the user has 1000 devices, would it be possible to do the following:


Platform 1: All modules, 300 devices


Platform 2: All modules, 700 devices


Or should this user buy an additional license for SAM and BIM?


Answer


As long as it is in the same datacenter, it should be possible to create two completely 
separate platforms. If not, new base licenses are required.
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Configuration queries
This section answers the following frequently asked questions on SAM configuration:


◆ “Editing .conf files” on page 39


◆ “Enabling SAM scheduling maintenance” on page 39


◆ “Obtaining information on users logged to domains” on page 39


◆ “Using ASL to create file outside of logs directory” on page 40


◆ “Accessing console message logs” on page 40


Editing .conf files


Query


When do I edit the trapd.conf and trap_mgr.conf files?


Answer


Edit the trapd.conf file when you want to forward traps; use this file to specify where to 
forward what set of traps. Edit the trap_mgr.conf if you are configuring the Adapter 
Platform to send notifications on to the Global Manager.


Enabling SAM scheduling maintenance


Query


I am unable to turn on the SAM Scheduling maintenance feature as the interface is grayed 
out. The necessary script files under the actions directory are also unavailable. The user 
does not have a BIM license. Is a BIM license required for the maintenance feature?


Answer


A BIM license is not a prerequisite for running the maintenance feature. However, the 
MBIM server needs to be running, with SAM domain configured as its source. Also, SAM 
should be subscribed to the MBIM domain.


Obtaining information on users logged to domains


Query


I need details on the SAM-Presentation login information. Is there a flag or setting that we 
can set to obtain details of whose logged into the domains?


Answer


The SM_OKLOGIN_LOGLEVEL environment variable enables the logging of successful 
logins at FATAL severity, rather than INFORMATIONAL. SM_OKLOGIN_LOGLEVEL is a 
Boolean. Set SM_OKLOGIN_LOGLEVEL=1 in the runcmd_env.sh file, located in the 
<BASEDIR>/smarts/local/conf folder. You must restart the domain for the change to take 
affect. 
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Using ASL to create file outside of logs directory


Query


Can we use ASL to create or write a file (ACT_FILE) outside of the logs directory?


Answer


No, you cannot create or write a file (ACT_FILE) outside of the logs directory using ASL.


Accessing console message logs


The Global Console has two logs which are useful for troubleshooting:


◆ The Java console is the first tool to use for console debugging. It shows store 
exceptions, errors reading attributes, and stack traces. 


To collect the most information about potential console problems, specify the 
-Dcom.smarts.log.level=TRACE property.


Java console information can automatically be saved to a file on your local workstation 
by specifying the -Dcom.smarts.java.log=<filename> property. When specifying this 
property, the file is written to the <BASEDIR>/smarts/local/logs directory. 


SM_WRITEABLE is an environment variable whose default value can be changed in the 
runcmd_env.sh. Use this console information to assist with debugging issues.


Before starting the console with the -Dcom.smarts.java.log=<filename> property , 
verify that the <SM_WRITEABLE>/logs directory exists under the 
<BASEDIR>/smarts/local folder. 


◆ The message log shows everything the Manager sends to the console while the log 
window is activated (opened or minimized). 


This information can automatically be saved to a file on your local workstation by 
specifying the -Dcom.smarts.server.logMessages=true property. When specifying this 
property, the file is written to the <SM_WRITEABLE>/logs directory. Use this information 
to assist with debugging issues when the console stops responding.


Before starting the console with the -Dcom.smarts.server.logMessages=true 
property, verify that the <SM_WRITEABLE>/logs directory exists under the 
<BASEDIR>/smarts/local folder.


To access the log views, select View > Java Console or View > Message Log.


In the Java console, the following warning is benign:


Warning: Could not get the full set of system properties.
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Trap processing queries
This section answers the following frequently asked questions on trap processing:


◆ “Difference between Notification Adapter and Adapter Platform” on page 41


◆ “Traps sent not reflected in Adapter Platform Server” on page 41


◆ “Check for agent sending traps” on page 42


◆ “Forwarding traps to servers” on page 42


◆ “Ensuring traps reach Adapter Platform” on page 43


◆ “Verifying trap forwarding” on page 43


◆ “Debugging SNMP Trap Notifier” on page 43


◆ “Trap exploder function” on page 44


◆ “Defining two SNMP traps in trap_mgr.conf file” on page 44


◆ “Number of traps adapter or exploder can process” on page 45


◆ “Improving performance of trap adapter and trap exploder” on page 45


◆ “Defining sm_adapter parameters” on page 46


◆ “Log levels defined” on page 47


Difference between Notification Adapter and Adapter Platform


Query


Are SAM Notification Adapter and the Adapter Platform the same?


Answer


No. The EMC Smarts Service Assurance Manager Notification Adapters convert SAM 
Notifications and log them either by writing to a file, emailing them, sending the 
notifications as traps, and so on. The Adapter Platform receives traps and processes them 
into notifications.


Traps sent not reflected in Adapter Platform Server


Query


When I send a trap, why don't I see it in the Adapter Platform server?


Answer


Check the following:


◆ Ensure that your trap OID, both generic and specific is configured within the 
trap_mgr.conf file. The file located under the <BASEDIR>/smarts/conf/icoi folder.


◆ Ensure that the agent sending the trap is in the Adapter Platform server topology.


◆ Ensure that you are giving the correct hostname and port to where your trap receiver is 
running.
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Check for agent sending traps


Query


How do I check if the agent sending the trap is in the Adapter Platform server?


Answer


The IP address of the device sending the trap must be in the Adapter Platform server, and 
must be hosted by (with a HostedBy relationship) some unified computing system (UCS) 
for the trap notification to be created. 


To check the HostedBy relationship, use your topology browser or use the following dmctl 
command:


dmctl -s <OI-Server> get IP::IP-<AgentIPAddress>::HostedBy


The result must not have a null value.


To use the topology browser, check under IP section, expand it, select your IP and see if 
that it has a HostedBy relationship.


The UnknownAgent is set to IGNORE by default. To create a trap notification in the Adapter 
Platform, the value for UnknownAgent must be set to CREATE in the trap configuration 
definition, else traps will be dropped.


Forwarding traps to servers


Query


How can I forward the Adapter Platform processed traps to the IP Availability Manager 
server?


Answer


Edit the trapd.conf file located under the <BASEDIR>/smarts/conf/icoi folder to include the 
IP address and Receiving Trap Port where the IP Availability Manager server is running in 
the FORWARD section. An example is provided below:


#           All generic traps (0 to 5) from network devices whose 
address 


#           matches 193.20.*.* will be sent to obelix port 7000, surya 
port 162 


#           and host 194.56.78.23 port 9000.
#
#     FORWARD: 193.20.*.* .* <0-5> * obelix:7000 surya 


194.56.78.23:9000
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Ensuring traps reach Adapter Platform


Query


How do I make sure that the traps are reaching the Adapter Platform?


Answer


Use one of the following methods:


◆ Shut down your the Adapter Platform.


◆ Start the default trap adapter with the same port as the Adapter Platform.


◆ Send your trap and check if the default trap adapter generates any output.


The EMC Smarts Service Assurance Manager Adapter Platform User Guide provides details 
on the procedures. 


Verifying trap forwarding


Query


How do I verify that the traps are getting forwarded by the forwarder?


Answer


Use one of the following methods:


◆ Check the <BASEDIR>/conf/trapd/trapd.conf to see which HostName:Port the traps are 
forwarded. 


◆ Start the default trap adapter on HostName with the specified Port. For example, 
sm_snmp -p 9987 trapd.


◆ Send a trap to the forwarder (default port: 9000) and check if you see any output of 
the trap sent to the HostName. 


Debugging SNMP Trap Notifier


Query


How do I debug the SNMP Trap Notifier?


Answer


In the <BASEDIR>/smarts/local/rules/notifier folder, look up the notify.asl file. This is the 
main rule set. Additionally, you can also see the trap-notify.asl in the trap directory. If you 
set debug=TRUE in these files you will be able to get sufficient debugging information.
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Trap exploder function


Query


Can I have the Trap Exploder send traps to both BGP and the Receiver?


Answer


Yes you can. Infact, you can send traps to any destination you like.


Defining two SNMP traps in trap_mgr.conf file


Query


Is it possible to define two SNMP traps in the trap_mgr.conf file - one to generate a 
notification and a second one to clear it?


Answer


Yes, it is possible to define two SNMP traps in the trap_mgr.conf file. As the trap is defined 
by the OID generic and specific, you can only have one definition for a particular 
combination. At times, the notify and clear are determined by the specific number, with 
one being notify and one being clear. If the status is contained in a varbind, you will need 
to use a single trap definition and then use the ASL option to set the action to notify or 
clear. An example is provided below:


----------------------------------------------------
BEGIN_TRAP .1.3.6.1.4.1.9.5.* 6 1
        ClassName:        Host
        InstanceName:     $SYS$
        EventName:        lerAlarmOn
        Severity:         2
        EventText:        Fddi PORT Ler Flag set to TRUE for : fddi PORT 


SMT Index = $V1$ And fddi PORT Index = $V2$
        Expiration:       600 
        State:            NOTIFY
        EventType:        DURABLE
END_TRAP


BEGIN_TRAP .1.3.6.1.4.1.9.5.* 6 2
        ClassName:        Host
        InstanceName:     $SYS$
        EventName:        lerAlarmOn
        State:            CLEAR
END_TRAP
-----------------------------------------------------


The trap_mgr.conf file located under the <BASEDIR>/smarts/local/conf/icoi/ folder 
provides more examples. 
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Number of traps adapter or exploder can process


Query


What is the maximum number of traps per second that the trap adapter or exploder can 
process?


Answer


The number of traps that can be processed depends on the trap configuration, mainly 
hook scripts and the execution of the findComputerSystem call. The ideal rate without any 
kind of delay should be about 30-40 traps per second, with 4 threads. But on an average, 
the trap processing rate is around 15 traps per second. Again, these numbers are very 
subjective to the environment and the configuration. 


Improving performance of trap adapter and trap exploder


Query


What is the best way to increase the performance of the trap adapter and trap exploder to 
better handle the traps hitting the exploder with more threads.


Answer


You can increase the performance of the trap adapter and trap exploder by:


◆ Keeping the number of threads for the Trap Exploder as default (1)


◆ Increasing the number of threads processing the traps for Trap Adapter


You can specify these values in the trapd.conf and the trap_mgr.conf files for the Trap 
Exploder and Trap Adapter, respectively. The trapd.conf and trap_mgr.conf files files are 
available under the <BASEDIR>/smarts/conf/icoi/ folder.


Find the line, #THREADS: 1 in the configuration files. The default value specified is 1. 
Retain the default entry for the trap exploder. For the trap adapter you can change the 
value for the threads to five.
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Defining sm_adapter parameters


Query


Can you define the sm_adapter parameters: --loglevel and --errlevel? What are the allowed 
levels and what is expected to be seen when they are set.  


Answer


Most messages printed by EMC Smarts code use the exception logging mechanism with 
something like CI_ExException(...).log(), or SM_System logXXX() calls from ASL. The 
exception logging mechanism can send messages to one of two receivers, which could be 
the:


◆ Log file


◆ System error logger, which is the syslog mechanism on UNIX systems and the Event 
Logger on Windows


The second mechanism has the potential to cause problems. On UNIX systems, the syslog 
files are typically on small partitions, for example, /var/tmp. There have been cases where 
attempts to start VI failed because it uses /var/tmp for temporary files, and /var/tmp is 
filled with a huge log of messages from the EMC Smarts server. Deleting the log file would 
temporarily solve the problem, but the system logger re-creates it and it will promptly start 
growing again. The exception logging mechanism is controlled by the severity level 
assigned to the message being logged. In the order from most to least severe, a message 
can have one of the following severity levels: 


Fatal, Error, Warning, Notice, Informational or Debug


You can individually assign, to each of the two receivers, the minimum severity level for 
messages to be sent to that receiver. By default, the log file receives messages of severity 
Warning or above, and the system error logger receives messages of severity Error or 
above. Two standard options available with all EMC Smarts main programs control these 
two levels: 


◆ --errlevel: controls the minimum level for writing to the log file


◆ --loglevel: controls the minimum level for sending to the system logging facility


If you use --help, you will see that there you can specify any of the listed severity levels as 
a value for either of these options, as well as a couple of additional levels that make sense 
to syslog, but which are synonyms for Fatal for the EMC Smarts code. In addition, you can 
specify None to completely disable a particular receiver. 


If it is inconvenient to change your startup scripts, you can use the SM_MAIN_OPTIONS 
environment variable.  Any standard option that appears in this variable becomes the 
default. You can override these default values on the command line.  Thus, after setting:


◆ SM_MAIN_OPTIONS=--loglevel=None


◆ export SM_MAIN_OPTIONS 


any EMC Smarts program you start will, by default will not send anything to the system 
error logging facility. To avoid having to actually look at the system log files always, you 
can set this in your .profile.
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Log levels defined


Query


What do the log levels mean?  


Answer


The log levels are defined below:


◆ \begin\item[FATAL]: Indicates a serious internal error.  A FATAL error is raised only in 
circumstances where continued execution of the entire application is in question. 
Unless otherwise handled by an application code, a FATAL exception in any thread will 
cause the entire program to exit. 


◆ \item[ERROR]: A serious error that indicates that a requested function cannot be 
accomplished. However, the application itself will normally be expected to continue. 
Unless otherwise handled by the application code, an ERROR exception in any thread 
causes that thread, but not the program as a whole, to exit.    


◆ \item[WARNING]: Indicates that something unexpected happened. While the 
requested function was completed, it may not have been completed exactly as 
expected. Unhandled exceptions of this and lesser priority are logged but do not 
necessarily cause a thread to exit.    


◆ \item[NOTICE]: Indicates that something unexpected happened that should be 
logged, but is not expected to interfere with normal functioning.


◆ \item[DEBUG]: A catch-all for debugging code.    


◆ \end: Despite these intended meanings, an application may catch even a FATAL 
exception that it knows how to recover from and continue operation.


There are a few exceptions to these definitions. For example, login failures are logged at 
FATAL level since they are considered important, even though they are completely 
recoverable as far as the application itself is concerned. There is an additional standard 
option, --tracelevel. An exception at this level or above causes a stack trace to be printed 
to the log file. This log tells you exactly where the exception was thrown, which may be 
more important that where it was caught and logged. By default, --tracelevel is set to Fatal. 
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NOTIF queries
This section answers the following frequently asked questions on NOTIF:


◆ “Error messages in Adapter Platform log file” on page 48


Error messages in Adapter Platform log file


Query


After enabling NOTIF, the following messages appear in the Adapter Platform log file:


◆ discardUnknownAgent.java. Got unknownAgentSetting: IGNORE


◆ discardUnknownAgent.java. Got ignoreUnknowns: true


Answer


Set the value for the environment variable, SM_JAVA_ENABLED to YES in the 
runcmd_env.sh file, available under the <BASEDIR>/smarts/local/conf/ directory.
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Notification and Event processing queries
This section answers the following frequently asked questions on notification and event 
processing:


◆ “Handling notification flooding” on page 49


◆ “Scenarios triggering NL_Delete” on page 50


◆ “Command to get queues” on page 50


◆ “Getting each notification to invoke the tool” on page 51


◆ “Identifying all subscriptions and subscribers to events” on page 51


◆ “Creating notifications using the Java API” on page 52


Handling notification flooding


Query


For an ASL notification adapter subscribing to NL_Notify, NL_Change, NL_Clear, NL_Delete 
events, what happens if there is a flood of notifications? Is SAM able to queue them 
internally and make sure it passes all of them to the subscribing modules? Does it make 
sense to implement a queue-like data structure in the ASL adapter to first buffer the 
notifications before processing them.


Answer


There is no need to create your own queue. The SAM server creates the queues internally, 
and then feeds the alarms one at a time into the ASL script. Once the START rule is 
complete, then the next notification will be processed. So, if you do not write an efficient 
ASL script then it becomes a bottleneck and the queues in SAM build up, using up 
memory, and subsequent crash. 


The only way that you can speed up the processing is by having multiple notification lists 
feeding multiple ASL scripts.
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Scenarios triggering NL_Delete 


Query


What are the scenarios in which NL_Delete will be triggered?


Answer


NL_Delete occurs when the event is archived or removed from the NL because of certain 
filtering actions.


Command to get queues


Query


What is the dmdebug command to get queues?


Answer


Run the following command to get queues:


dmctl> execute dmdebug --queues 


This prints information about all server queues in the system into the server log file. An 
example for the queue output is provided below:


SubscriberFE                                         [0 worker(s)]
Current size 0, max 369; processed entries 21843
Size           0-0.00            0-0.00            0-0.00             


0-0.00
Flow       21839+0.06        21803+0.05        21446+0.05         


17895+0.06
Late      0.0000+0.00       0.0000+0.00       0.0000+0.00        


0.0000+0.00


In the example, the first line gives you the name of the queue and the number of workers.


Subscriber Front Ends like the one cited here never have any workers, since they are not 
used as normal server queues.


The second line gives you the current size, and an exact maximum size. The total number 
of ‘processed entries’ indicates the total number of entries that have ever been pulled off 
the queue. 
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Getting each notification to invoke the tool 


Query


We have escalation policies set to run automatic server tools which text, page or email 
various recipients. We noticed that sometimes we do not get paged or emailed. I did some 
testing and it seems that only the first notification of an event invokes the tool, until the 
notification is archived. Is anyone familiar with how to get each notification to invoke the 
tool with each notification? Note that we are running SAM 8.1.0.1 on Windows 2008.


Answer


You can do it with two escalation policies, and using a tag value in a user defined field.


◆ The first escalation policy triggers on the following conditions and executes the 
automatic tool: 


• STATUS == ACTIVE


• USERDEFINED != TAG


◆ The second escalation policy triggers on the following conditions and clears out the 
tagged field:


• STATUS == INACTIVE


• USERDEFINED == TAG


Then if the notification becomes active again, the criteria for the first escalation policy are 
met again and the automatic tool will be invoked again.


Identifying all subscriptions and subscribers to events


Query


Is it possible to identify if there is somebody who is subscribed for a given event or see all 
subscriptions, not just the bootstrap subscriptions? 


Answer


Use the following command to see if anybody is associated with an event:  


dmctl> exec dmdebug subscriptions[=all] [output=]
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Creating notifications using the Java API


Query


We would like to create notifications in SAM directly from the Java API. Using the sm_ems 
command line interpreter is not an option. The device already exists within the IP/AM 
topology, but this is a Non-SNMP device. Messages are received through XML containing 
information on the notification details. It has to be through the Java API, and not use the 
ASL open adapter either as everything will run from a single adapter framework.


Answer


Use the dynamic model to define the new events that you want created. Then, you can use 
the Java API to toggle boolean flags. The EMC Smarts MODEL Reference Guide and the EMC 
Smarts Dynamic Modeling Tutorial provide examples of exporting new events.


If are using external instrumentation sources, you must use the "External" polling settings 
in AM/PM. To enable these, log into domain using the GUI, select the Domain Manager 
Administration Console > Polling and Thresholds. Once this is done, your instrumentation 
logic can set attributes in the instrumentation objects (follow the InstrumentedBy 
relationship in the Interface and IP objects).
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Business Dashboard queries
This chapter includes information for troubleshooting the EMC Smarts Business 
Dashboard and contains the following information:


◆ “Business dashboard troubleshooting overview” on page 53


◆ “Debugging the Web Console” on page 55


◆ “Configuring the log file directories” on page 56


◆ “Configuring the log files” on page 57


◆ “Sun Java Console (Plug-in message log)” on page 58


◆ “Log file location” on page 60


◆ “Increasing the heap space” on page 61


The information contained in this chapter should be checked against your installation 
before problems arise. Contact EMC Online support if it becomes necessary to clarify or 
resolve any questions or issues.


Business dashboard troubleshooting overview


When troubleshooting reasons why the Web Console stops responding, the following files 
and parameters are reviewed:


◆ Required files


When troubleshooting issues, EMC always asks for the following files:


• RPS files


• Service Assurance Manager server log files


• tomcat log files


• sm_monitor log files


• Console log files


• ics.conf files


The console log files include the EMC Smarts Java Message log file, the Sun Java 
Plug-in Console log file, and the EMC Smarts server messages received log file. By 
reviewing the console log files, EMC can clearly determine if the console stopped 
responding because the system ran out of memory, or if the issue was the result of 
some other error. Using the server log file, EMC can review what occurred at the time 
the console stopped responding; for example, was the server busy or was there some 
other exception.
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From prior experience, a Web Console or Global Console stops responding as a result 
of the machine running out of memory. 


◆ Debugging parameters


To have debugging information entered in the log files, you must have the console 
debugging parameters set by default, before you use the console and the console 
stops responding. You need to verify that the debugging information is being entered 
into the log files before there is a problem. Having the debugging parameters set 
ensures that no critical information is lost.


◆ Primary Java log file


The primary Java log file is the key tool used in diagnosing issues. This file gets 
overwritten at each startup time and is the file that saves the contents of the Console 
Java Log. Enable this file by typing the following command: 


-Dcom.smarts.java.log=<filename>


This file must be saved before the console is restarted.


◆ Asynchronous message log file


This log file is controlled by versioning. This file can get very large if the server is 
processing numerous notifications. Enable the asynchronous message log file by 
typing the following command:


Dcom.smarts.server.logMessages=true
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Debugging the Web Console


Query


How do I go about debugging the Web Console?


Answer


Table 4 on page 55 defines the parameters used to capture information when a Web 
Console stops responding. 


The parameters are configured in the Java Plug-in Control Panel.


Table 4  Web Console debugging parameters


Parameter Description


-Xmx350m -Dsun.net.inetaddr.ttl=0 This parameter gets around the broker failover cache 
problem.


-Dcom.smarts.server.logMessages=true This parameter logs all the asynchronous messages 
that the server sends to the console, primarily, 
notification adds/changes/deletes.


-Dcom.smarts.java.log=<name>-webconsol
e.log


This parameter saves the EMC Smarts Java Message 
Log content. This content is lost when the console 
stops responding.  This log file must be copied and 
saved before restarting the Web Console. Content 
included in this log file could provide information on 
why the console stopped responding. 
Restarting the Web Console overwrites this file.


-Dcom.smarts.log.level=TRACE This parameter results in maximum information 
being entered in the Java Message Log.


Heap size EMC has tested a heap size of 350 M
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Configuring the log file directories


Query


How do I set up the log file directories when the EMC Smarts GUI is running as a Web 
Console in Internet Explorer?


Answer


You can set up the log file directories for the com.smarts.server.logMessages and 
com.smarts.java.log files when the GUI is running as a Web Console in Internet Explorer. 
The parameters can be enabled if they are set in the Java Control Panel in the Windows 
workstations. To display the Java Control Panel, click Settings > Control Panel > Java. 


Internet Explorer defaults the console’s com.smarts.writeable parameter to the Windows 
desktop location where log files are written. You can verify this in the Sun Java Console 
window (not the Smarts Java Log file).


To verify that the com.smarts.writeable parameter is configured correctly:


From Internet Explorer, click Tools > Sun Java Console. 


The Java Console appears. An example of the type of information available from the Sun 
Java Console is:


Java Plug-in 1.4.2_06
Using JRE version 1.4.2_06 Java HotSpot(TM) Client VM
User home directory = C:\Documents and Settings\bm1.SMARTS 


----------------------------------------------------
c: clear console window
f: finalize objects on finalization queue
g: garbage collect
h: display this help message
l: dump classloader list
m: print memory usage
o: trigger logging
p: reload proxy configuration
q: hide console
r: reload policy configuration
s: dump system and deployment properties
t: dump thread list
v: dump thread stack
x: clear classloader cache
0-5: set trace level to <n>
---------------------------------------------------- 


Properties: com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable 
not found.


Defaulting com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable 
paths to: C:\Documents and Settings\bm1.SMARTS\Desktop 


The Properties line defines the location of the com.smarts.writable path. In this example, 
the path has been defaulted to the desktop and the user ID has been defined by default as 
the user ID for the specific Windows workstation (in the example, the user ID is: 
bm1.SMARTS).
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Configuring the log files


Query


How do I retrieve the log files when running the Web Console?


Answer


To retrieve the log files when running the Web Console: 


1. Verify that the log files have been configured. 


EMC Smarts Service Assurance Manager Dashboard Configuration Guide provides 
additional information on configuring log file directories.


2. Create a new folder labeled “logs” on the workstation's desktop.


Use Windows Explorer or a command prompt to go to the directory specified in the 
Java Console message and create the new folder. For example, the path for the folder 
could be C:\Documents and Settings\bm1.SMARTS\Desktop\logs. 


3. Click Settings > Control Panel > Java. 


The Java Control Panel appears.


4. Click Advanced and add a new Java Runtime Parameter. (For Java 1.5, click the Java tab 
and then click the View button to display the Java Runtime Settings window.) An 
example of the settings is:


-Dcom.smarts.server.logMessages=true 
-Dcom.smarts.java.log=ZZZZ 
-Dcom.smarts.log.level=TRACE
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5. Edit the -Dcom.smarts.java.log=ZZZZ to the name of your java log file. 


This log file does not get appended with versions. It needs to be saved before 
restarting the console. If the file is not saved before starting the console, the contents 
of the file are overwritten. 


After configuring the java log file location, when you run Internet Explorer, the log of server 
message log file and the java log file are written into the desktop's logs directory. The java 
log file lists trace level messages. 


Because the parameter was updated in the client’s Java Plug-in, you do not need to restart 
the tomcat application.


You need to configure the log files location before a console stops responding so that 
information about the console not responding can be retrieved. Verify that the two 
debugging files (webconsole.log and server_Mesg_<userid>.log) get written to the logs 
directory. 


Sun Java Console (Plug-in message log)


Query


How do I enable the Sun Java Plug-in and capture its content?


Answer


When the EMC Smarts GUI is run as a Web Console, important debugging information is 
written to the Sun Java Plug-in Console. When the GUI stops responding but Internet 
Explorer continues to run (for example, if the web browser window goes blank), it is 
helpful to capture the contents of the Sun Java Plug-in console.
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To enable the Sun Java Plug-in Console
To enable the Sun Java Plug-in Console:


1. From Settings, click Control Panel.


The Control Panel appears.


2. Double-click Java. 


The Java Control Panel appears.


3. Click Basic (for Java 1.4.2) or click Advanced for Java 1.5.


4. Expand the Java console option.


5. Click the Show Console option.


By default, the Sun Java Plug-in Console displays as a window (typically in the 
upper-left corner of the screen) in Internet Explorer. You can also display the Sun Java 
Console by clicking the Internet Explorer’s Tools menu and selecting the Sun Java 
Console. 


Capturing the Sun Java Plug-in Console content
To capture the Sun Java Plug-in Console content:


1. From the Java Console, click Copy.


The content displayed in the Sun Java Console is copied to the clipboard. 


2. Open a new file in a text editor and paste the clipboard contents into the new file. 


3. Save the file and send the file to EMC along with other debugging information.  


If you are reporting Web Console problems that did not cause the Web Console to stop 
responding, you should also copy, save, and send this log file.
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Log file location


Query


Where do I find the log files for debugging issues related to the Web Console?


Answer


Table 5 on page 60 defines the log file locations.


Table 5  Log file location


File/ or log name Location


rps file <BASEDIR>/smarts/local/repos/icf directory.
Run dmctl -s NA-SAM-PRES and invoke the 
ICF_PersistenceManager::ICF-PersistenceManager. Save this 
information before sending the rps file to ensure all notifications 
are saved to the rps. 


SAM server log <BASEDIR>/smarts/local/logs directory.


sm_monitor 
logs


<BASEDIR>/smarts/local/logs/SM_Monitor directory.


Tomcat logs <BASEDIR>/smarts/jakarta-tomcat-5.0.16/logs directory from 
where tomcat started.


ics.conf file <BASEDIR>/smarts/local/conf/ics directory. 


Console logs C:\Documents and Settings\<username>.SMARTS\Desktop\logs 
directory.
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Increasing the heap space


Query


How do I increase the heap size for the Java Plug-in and for Java Web Start.


Answer


If the Web Console or viewlets run out of memory, adjust the maximum amount of heap 
space that the Java Plug-in uses for dynamic memory allocation. By specifying -Xmx256m 
as a runtime parameter, for example, you can increase the heap space allocation to 256 
MB. The number can be set larger or smaller than 256 MB, depending on the resources 
available on the client machine running the web browser.


To increase the heap space for the Java Plug-in:


1. Launch the Java Control Panel. The Sun website provides instructions 
(http://java.sun.com).


2. In the Java Control Panel, click the Java tab.


3. In the Java Runtime Environment Settings section, click the View button. The Java 
Runtime Environment Settings dialog box appears.


4. In the Runtime Parameters field, type the maximum heap-space runtime parameter 
(-Xmx) and a value for the parameter. For example: -Xmx330m.


5. Click OK. 


6. Click the Java Control Panel Apply button. 


7. Terminate and restart any web browser running on the host machine.


For the Java Web Start, the heap space defaults to 350 megabytes.


Increasing Java Web Start heap space
To increase the heap space for the Java Web Start:


1. Using a text editor, open the 
<BASEDIR>/smarts/tomcat/webapps/webconsole/globalConsoleApp.jnlp file.


2. Locate the following line:


<j2se version="1.6.0+" max-heap-size="350M"/>
3. Change the max-heap-size variable value.


4. Save and close the file.
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Introduction

Terminology
Throughout this chapter and the chapters that follow, the term Manager is used to refer to 
an EMC® Smarts® IP Manager or Global Manager. The term IP Manager is used to refer to 
any of the following EMC Smarts Domain Managers:


◆ EMC Smarts IP Availability Manager


◆ EMC Smarts IP Performance Manager


◆ EMC Smarts IP Availability Manager Extension for NAS


Availability, features, and licensing
Dynamic Model is an extension of the EMC Smarts Managed Object Definition Language 
(MODEL). MODEL is integral to the EMC Smarts application development process. Its 
purpose is to render the schema and semantics of the EMC Smarts ICIM Reference 
specification. These libraries are loaded by Managers and are operated on by EMC Smarts 
applications. For an EMC Smarts application, all of the classes, relationships, attributes, 
and events are defined at compile time.


Dynamic modeling enables you to add new classes, and refine classes that are already 
defined in the data model libraries. These additions and refinements occur at runtime 
when the dynamic models are loaded into a Manager.


Availability of dynamic modeling


Dynamic modeling is supported on IP Manager s and Global Managers. All dynamic model 
examples in this tutorial pertain to the IP Manager and the Global Manager.


Features of dynamic modeling


The following features are provided by Dynamic Model:


◆ Classes may be made known to the system at runtime, when they are loaded into a 
Manager as a dynamic model.


◆ A dynamic model compiler that produces a file with a .ldm extension that can be 
loaded by a Manager.


◆ You can load a dynamic model when the Manager is started or after the Manager is 
running.


◆ When you load a dynamic model, the existing model class dependencies and the new 
dynamic model class dependencies are resolved.


◆ A new class may be defined that derives from any existing ICIM class that is part of the 
ICIM_ManagedElement and ICIM_MetaObject trees. The EMC Smarts ICIM Reference 
provides information for determining which classes fall under the 
ICIM_ManagedElement and ICIM_MetaObject trees.
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◆ An existing ICIM class may be extended by defining new attributes, events, 
aggregates, relationships, and operations for the class.


◆ An existing ICIM class may also be extended, with a separate license, by defining new 
problems and symptoms.


◆ You can refine relationships, events, aggregates, operations, and attributes that are 
inherited from an existing ICIM class.


◆ You can refine problems and symptoms in an existing ICIM class with a separate 
license.


Licensing of dynamic modeling


Two licenses are required to run Dynamic Modeling:


◆ SMA-SDM-C


A license to run the dynmodel compiler and generate .ldm files (the version of dynamic 
modeling files that can be loaded into a Manager). This license also allows you to load 
the .ldm files into a Manager.


◆ SMA-SDM-F


A license to run the dynmodel compiler on dynamic model files that have refined 
classes by adding new problems and symptoms.


The EMC Smarts System Administration Guide contains information concerning license 
administration.


EMC Smarts installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed.


◆ For Windows, this location is C:\InCharge\<product>.


◆ For UNIX, this location is /opt/InCharge/<product>.


Optionally, you can specify the root of BASEDIR to be something other than:


◆ Windows: C:\InCharge


◆ UNIX: /opt/InCharge


However, you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.
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Differences between MODEL and Dynamic Model
Although MODEL and Dynamic Model are used independently and involve different steps 
and tools, the dynamic model is fully derived from MODEL so many of the concepts that 
apply to MODEL also apply to the dynamic model. Familiarity with the EMC Smarts MODEL 
Reference Guide  is useful when working with dynamic models.


Table 1 on page 14 presents a summary of the differences between using MODEL to create 
a custom solution and using Dynamic Model to enhance an existing solution. 


The refine interface keyword


Dynamic model uses the refine interface keyword to indicate that any declarations that 
follow will modify an existing ICIM class. In MODEL, you cannot refine an existing class.


The refine keyword


In both Dynamic Model and MODEL, the refine keyword is used to refine existing inherited 
properties of a class, such as attributes, events, and so on. You can refine inherited class 
relationships, attributes and events when you create a new subclass. These class 
properties may be inherited from the parent class or any of the other classes up the 
inheritance tree to the base class.


Table 1  Differences between MODEL and Dynamic Model


Feature MODEL Dynamic Model


Define new classes ✓ ✓


Use “refine interface” to extend an existing ICIM 
class


No ✓


Use “refine interface” to extend a subclass of a 
new subclass


No ✓


Define new problems ✓ ✓ Requires an additional license


Define new relationships ✓ ✓


Refine existing relationships, events, aggregates, 
operations, and attributes


✓ ✓


Refine existing problems and symptoms ✓ ✓Requires an additional license


Define new symptoms ✓ ✓Requires an additional license


Define new events ✓ ✓


Define new stored attributes ✓ ✓


Define new propagated attributes ✓ ✓


Define new instrumented attributes ✓ ✓


Define new computed attributes ✓ ✓


Define new aggregates ✓ ✓


Define new operations ✓ ✓


Delete existing ICIM classes No No
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Restrictions of dynamic modeling


Preprocessor macros


Preprocessor macros, including the preprocessor statement “#include”, may not be used 
in Dynamic Model source code.


Pragmas


Only those pragmas that are listed in Table 4 on page 85, can be used with Dynamic 
Model. Pragmas that produce output in C++ source files may not be used, since Dynamic 
Model does not generate C++ source files.


User-defined source code


User-defined source code that produces C++ stubs may not be included in Dynamic Model 
source files.


ICIM_ManagedDomain


ICIM_ManagedDomain and any of its subclasses cannot be subclassed or refined.


Single class refinement


All refinements to a class must be contained in a single refine interface <classname> 
declaration. For example, you cannot have a refine interface Router declaration in the 
mymodel1.mdl file, and then another refine interface Router in the mymodel2.mdl. 
Likewise, you cannot have more than one refine interface Router declaration in the 
mymodel1.mdl file.


MODEL keywords and data types


The binary and byte MODEL keywords and data types can be used in any dynamic model 
file on any Manager. The binary data type represents binary data, and the byte data type 
represents an unsigned 8-bit integer ranging from 0 - 255.


The external MODEL keyword cannot be used in any dynamic model file on any Manager.
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Guidelines for developing dynamic models
Follow these guidelines when using dynamic models:


◆ Create and verify dynamic models on a test Manager prior to deploying them into any 
production environment. The test Manager may be started and stopped several times 
during the process to verify the results of each step.


◆ Create and edit the dynamic model files (those with extension .mdl) by using the 
sm_edit utility.


The .mdl files are created and edited by using sm_edit. The .ldm files that are 
generated by the dynmodel compiler must not be edited.


◆ Classes that are related to each other should be contained in the same dynamic model 
file.


◆ Dynamic model files can be loaded when a Manager is started or after the Manager is 
already running. “Location and loading of dynamic model files” on page 21 provides 
additional information.


◆ Perform a back up on the repository of the Manager before using dynamic modeling in 
a production environment.


◆ Precede any new attributes, classes, aggregates or events that are defined with a 
unique tag, such as USR_. You should not use SM_ as this prefix is already used by 
EMC Smarts.


◆ Do not use the external keyword in any dynamic model file on any Manager.


Changes made by using dynamic modeling might impact the performance and load of the 
Manager.
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Requirements for developing dynamic models
The following requirements must be followed when using dynamic model:


◆ Dynamic model filenames may contain ASCII letters (A..Z,a..z), ASCII numbers (0...9), 
and the underscore character (_), but may contain no other characters. The first 
character must be a letter.


◆ The dynamic model filename must be unique within the first 23 characters.


◆ The dynamic model file that you edit must have a .mdl filename extension.


◆ Dynamic model files must follow the syntax rules described in “Adding a class to the 
model” on page 73 and “Updating an existing class in the model” on page 75.


◆ All refinements to a class must be contained in a single refine interface <classname> 
declaration. For example, you cannot have a refine interface Router declaration in the 
mymodel1.mdl file, and then another refine interface Router in the mymodel2.mdl. 
Likewise, you cannot have more than one refine interface Router declaration in the 
mymodel1.mdl file.


◆ Dynamic model files (those with extension .ldm) must be located in either 
BASEDIR/smarts/local/model or BASEDIR/smarts/local/model/<config>. The <config> 
refers to the configuration directory that is specified on the command line when the 
Manager is started. “Loading dynamic models during Manager startup” on page 22 
provides further details.


It is recommended to have both the .mdl and .ldm versions of a dynamic model file 
located together in either the BASEDIR/smarts/local/model or 
BASEDIR/smarts/local/model/<config> directory.


◆ Dynamic model files (those with extension .ldm) must be loaded into each Manager 
that requires knowledge of the new topology and events.


◆ For Foundation 9.0- or 9.1-based Managers, dynamic model string files 
(<modelname>_mmbe.dat, <modelname>_mmle.dat) must be copied to the 
SM_SITEMOD/l10n directory even if you do no localization.


Note that:


• SM_SITEMOD is an environment variable that is set to BASEDIR/smarts/local by 
default.


• l10n stands for localization (“l” followed by 10 letters followed by “n”) and 
represents country-specific settings such as the representation of numbers, dates, 
and money.
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Development cycle
Several steps are involved in the development cycle of extending a model of a Manager, 
by using dynamic modeling. Figure 1 on page 18 illustrates the development cycle.


Figure 1  Steps involved in developing dynamic models
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The first five steps are common to all dynamic modeling development:


1. Add the new model elements to either a new dynamic model text file (.mdl) or an 
existing one. Appendix A, “Guidelines and Syntax for Dynamic Model Files,” contains 
additional information.


2. Compile the dynamic model text file into a file (with extension .ldm) that can be 
loaded into a Manager. The command used to compile the dynamic model file is 
described in Appendix B, “The dynmodel Command Syntax and Options.”


3. If you require the string literals in the dynamic model text file to be of a language other 
than the language in the dynamic model text file:


a. Copy the <modelname>_mm.txt file to <loc>.txt, and move it to the appropriate l10n 
subdirectory. The <loc> refers to a locale such as, fr_FR for French as spoken in 
France.


b. Edit <loc>.txt. Change the “root {” to “<loc> {” in the first line. Translate the string 
literals as required. Return to step 2 on page 19 .


4. From the BASEDIR/smarts/local/model directory, copy the following files to the 
SM_SITEMOD/l10n directory:


• Example1_mmbe.dat


• Example1_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.


5. Load the compiled dynamic model file into a Manager. Verify that the new model 
elements have been added to the list of classes or the list of properties by using the 
Global Console.


If you encounter errors, go back to step 1 on page 19 and make the appropriate 
modifications to your .mdl file. “Loading errors” on page 108 provides additional 
troubleshooting information.


6. If you have defined new classes, create or discover instances of those classes. 
Appendix C, “Methods of Creating Classes and Populating Attributes,” provides 
additional information.


7. If you have defined new attributes, populate the values of those attributes, either 
manually or by using the discovery mechanism. Appendix C, “Methods of Creating 
Classes and Populating Attributes,” provides additional information.


8. If you want to view the new classes, attributes, problems, aggregates or events in the 
Manager, configure the appropriate data exchange adapter (DXA) configuration file. 
Appendix D, “Updating the Global Manager,” describes DXA configuration.


9. If you added new events, add a subscription to the event in the appropriate 
bootstrap file.


10. Verify the topology in the Global Console.


If you encounter errors, go back to step 1 on page 19 and make the appropriate 
modifications. Appendix E, “Troubleshooting,” provides additional information.
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Model enhancement examples
This tutorial presents three different exercises:


◆ “Exercise 1 – Adding a New Printer Class” on page 23, adds a new printer class to the 
model.


◆ “Exercise 2 - Adding an Attribute to the Router Class” on page 39, adds a new attribute 
to an existing ICIM class. 


◆ “Exercise 3 - Polling for Values of Additional Attributes” on page 51, adds an event 
whose state is determined by a new attribute. The exercise also presents how to set 
up polling of the value for the new attribute.


The source files for the exercises are located in the following directory:


BASEDIR/smarts/examples/dynamic-model


The exercises are performed on test versions of an IP Manager named TEST_IP and a 
Global Manager named TEST_SA.


In Exercises 1 and 2, the test IP Manager is started with the bootstrap-am.conf file. 
Starting the test IP Manager with bootstrap-am.conf file causes the IP Manager to operate 
as an IP Availability Manager.


In Exercise 3, the test IP Manager is started with the bootstrap-am-pm.conf file. Starting 
the test IP Manager with bootstrap-am-pm.conf file causes the IP Manager to operate as 
an IP Availability Manager and an IP Performance Manager running as a single process 
(AM-PM).


The --config option (or just -c) in an IP Manager startup command points to the bootstrap 
files in the icf directory. The default bootstrap file is bootstrap.conf, which starts an IP 
Manager as an “AVAILABILITY_AND_PERFORMANCE_MANAGER” (AM-PM). The addition of 
the --bootstrap option in an IP Manager startup command points to a particular bootstrap 
file in the icf directory, such as bootstrap-am.conf, which starts an IP Manager as an 
“AVAILABILITY_MANAGER” (AM), or bootstrap-am-pm.conf, which also starts an IP 
Manager as an “AVAILABILITY_AND_PERFORMANCE_MANAGER” (AM-PM).
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Location and loading of dynamic model files
Dynamic model files can be located in either the BASEDIR/smarts/local/model or 
BASEDIR/smarts/local/model/<config> directories. The <config> refers to the configuration 
directory that was specified on the command line when the Manager was started.


Dynamic models can be loaded into a Manager during startup or while it is running.


The examples in this guide use the sm_server command to load the dynamic models into 
a Manager during startup. If you use sm_service to start your Manager, edit the command 
string that is used by sm_service to include the appropriate option to load your dynamic 
models. The EMC Smarts System Administration Guide provides additional information.


Loading dynamic models into a running Manager


The loadModel operation in the SM-System instance of the SM_System class is used to 
load a model into a running Manager. All dynamic model files must be located in the 
BASEDIR/smarts/local/model directory. The dmctl utility is used to invoke the loadModel 
operation. “Using dmctl” on page 88 provides additional information. The syntax for the 
command line is as follows:


BASEDIR/smarts/bin/dmctl -s <managername> [-b <broker>] invoke 
SM_System::SM-System loadModel <modelfilename> SM_DYNAMIC_LIBRARY


where:


◆ <managername> is the name of the Manager.


◆ (Optional) <broker> is the name of the Broker to which the Manager has been 
registered. The default Broker location is localhost:426.


◆ <modelfilename> is the name of the model file without the extension.


For example, you would type the following to load the Example3.ldm dynamic model file 
into the TEST Manager that is attached to the Broker on localhost:426.


BASEDIR/smarts/bin/dmctl -s TEST -b localhost:426 invoke 
SM_System::SM-System loadModel Example3 SM_DYNAMIC_LIBRARY


Do not include the .ldm file extension.


Verify that the model file was loaded. If you started your Manager with the -- output option, 
you can check the log file. Your output should be similar to the following:


[July 10, 2009 12:25:29 PM EDT +789ms] t@1120213312 LDM file processing #1
DYN-W-FILE_OPEN_OK- Reading
    '/opt/InCharge8/IP/smarts/local/model/Example3.ldm'


[July 10, 2009 12:25:44 PM EDT +141ms] t@1120213312 LDM file processing #1
MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +142ms] t@1120213312 LDM file processing #1
MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +143ms] t@1120213312 LDM file processing #1
MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10
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[July 10, 2009 12:25:44 PM EDT +144ms] t@1120213312 LDM file processing #1
DYN-W-CLASS_REFINE_CREATED- Interface NetworkAdapter_Performance_Setting
    refined from Example3.mdl:1


[July 10, 2009 12:25:44 PM EDT +145ms] t@1120213312 LDM file processing #1
MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1
MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1
MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +147ms] t@1120213312 LDM file processing #1
DYN-W-CLASS_REFINE_CREATED- Interface Interface_Performance_CiscoRouter
    refined from Example3.mdl:8


Loading dynamic models during Manager startup


A Manager can be started either without or with the --dynamic option. The use of the 
--dynamic option determines which .ldm files are loaded into the Manager.


Starting a Manager without the --dynamic option
If you start a Manager without the --dynamic option, all of the .ldm files in the 
BASEDIR/smarts/local/model/<config> directory will be loaded, where <config> refers to 
the configuration directory that is specified on the command line when the Manager is 
started.


In the following example, a Global Manager named TEST_SA is started without the 
--dynamic option:


sm_server -n TEST_SA -c ics --output


This example loads all of the .ldm files in the BASEDIR/smarts/local/model/ics directory 
because ics is the configuration directory that is specified in the command line.


Starting a Manager with the --dynamic option
If you start a Manager with the --dynamic option, all of the .ldm files in the following 
directories will be loaded:


◆ BASEDIR/smarts/local/model


◆ BASEDIR/smarts/local/model/<config>


where <config> refers to the configuration directory that is specified on the command line 
when the Manager is started.


In the following example, an IP Manager is started with the --dynamic option:


sm_server -n TEST_IP -c icf --output --dynamic


This example loads all of the .ldm files in the BASEDIR/smarts/local/model directory and 
in the BASEDIR/smarts/local/model/icf directory because dynamic and icf are specified in 
the command line.
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Exercise 1 – Adding a New Printer Class

Objectives
This exercise describes how to use Dynamic Model to add a new printer class without 
attributes or other properties to the following Managers:


◆ IP Manager


◆ Global Manager


This exercise also demonstrates how new instances can be classified in the new class, 
and then discovered. Instances of the new class will be discovered automatically, based 
on the device’s MIB object ID (OID) when the IP Manager is started.


This exercise should be performed on test versions of a Broker, IP Manager, and Global 
Manager. Before starting this exercise, back up the repository on the test Managers.


This exercise includes the following tasks:


◆ Create and compile a dynamic model file.


◆ Add a new printer class to the models in the IP Manager.


◆ Use the Global Console to view the new printer class.


◆ Set up the printer OID for discovery.


◆ Reload the dynamic model file into the IP Manager.


◆ Use the IP Manager to discover instances of the new class.


◆ Add the new printer class to the Global Manager.
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Exercise
After your network has been discovered, you might want to differentiate certain devices, 
such as personal computers or printers, from hosts in your topology. This exercise extends 
the model by adding a class to represent a printer. The printer class is declared without 
any additional properties, other than those attributes, events, and relationships that are 
inherited from its parent class.


A new class is declared as a subclass of an existing ICIM class. The key is to determine 
which class should be the parent class. This determination is based on several factors:


◆ How you want to search and report on the new class


◆ Functional similarities to existing elements in topology


◆ The events, attributes, and relationships that the new class needs to inherit


A printer is a physical element, on the same level as a router or a host. In this exercise, its 
parent class is the UnitaryComputerSystem, which is also the parent class of the router 
and host. A printer, router, and host all inherit the same attributes, events, and 
relationships from the UnitaryComputerSystem class.


The IP Manager counts the instances of the ICIM_UnitaryComputerSystem toward the 
system volume license. When your dynamic model classes inherit from 
ICIM_UnitaryComputerSystem, instances of that class will take advantage and participate 
on the full predefined IP Manager root cause analysis model, and therefore such instances 
will be counted towards the system volume license.


If the instances of your class do not need to participate on the full root cause analysis, you 
can inherit from either ICIM_System or ICIM_ComputerSystem. In addition, if you inherit 
from either ICIM_System or ICIM_ComputerSystem, you will have to add your new class 
into the appropriate DXA configuration file to transfer the topology to the Global Manager. 
Chapter 3, “Exercise 2 - Adding an Attribute to the Router Class,” provides information 
about adding a class and its associated attributes to DXA files.


In the following procedures, the syntax is the same as that used to declare any MODEL 
class. “Adding the new class” on page 74 provides more detail.


Use a unique prefix with new class names and other properties. The name must differ from 
existing ICIM classes and properties. “SM_” is used as a prefix in this exercise. Do not use 
“SM_” as this prefix is already used by EMC Smarts.
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Creating the dynamic model
In this example, an instance of a compiled dynamic model file named Example1.ldm is 
created in the BASEDIR/smarts/local/model/<conf> directory of the IP Manager 
installation area. The IP Manager is then started with the --dynamic command line option 
to load the compiled dynamic model file from BASEDIR/smarts/local/model.


To create the dynamic model:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to create a new model file named Example1.mdl:


sm_edit --create model/Example1.mdl


2. To declare the new printer class as a subclass of the UnitaryComputerSystem class, 
add the following lines to the Example1.mdl file:


interface SM_Printer:UnitaryComputerSystem
"Create a printer class inheriting from UCS"
{
}


3. Save and close the file.


The newly created Example1.mdl file is saved to the BASEDIR/smarts/local/model 
directory.
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Compiling the dynamic model
To compile the Example1.mdl model file:


1. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the IP Manager installation area:


cd BASEDIR/smarts/local/model


2. From the BASEDIR/smarts/local/model directory, enter the following command to 
compile Example1.mdl:


BASEDIR/smarts/bin/dynmodel Example1.mdl


If the compilation is successful, the dynmodel command does not produce any output to 
the command-line console. In addition, the following files are created in the 
BASEDIR/smarts/local/model directory:


◆ Example1.ldm


◆ Example1_mmbe.dat


◆ Example1_mmle.dat


◆ Example1_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model directory:


◆ Example1_mm


“Compilation errors” on page 107 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/local/model directory in the IP Manager installation area, copy 
the following files to the SM_SITEMOD/l10n directory:


◆ Example1_mmbe.dat


◆ Example1_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.
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Loading the new class into the IP Manager
Once the dynamic model has been compiled, you must load it into the IP Manager. The 
Printer class will appear in the topology of the IP Manager.


In this procedure, TEST_IP is the name of the test IP Manager. The IP Manager is started 
with the --dynamic command line option to pull the compiled dynamic model file from 
BASEDIR/smarts/local/model.


If the test IP Manager is already running, stop it.


To load the compiled dynamic model file into the test IP Manager:


Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to start the test IP Manager and load the compiled dynamic 
model file:


sm_server -n TEST_IP -c icf --broker=localhost:426 
--bootstrap=bootstrap-am.conf --output --dynamic


The startup code uses bootstrap-am.conf as the bootstrap file for the test IP Manager. 
The startup code also registers the test IP Manager as TEST_IP with the Broker that is 
running on port 426 of the local host. Substitute the bootstrap file and the Broker 
location with your bootstrap file and Broker location. As an example, you could 
substitute bootstrap-am.conf with bootstrap-am-pm.conf to start the IP Manager as an 
IP Availability Manager and an IP Performance Manager running as a single process 
(AM-PM).


In addition, all messages will be logged to a log file, such as 
BASEDIR/smarts/local/logs/TEST_IP_en_US_UTF-8.log.


To check that the compiled dynamic model file was loaded:


Go to the BASEDIR/smarts/local/logs directory and use any text editor to open the 
server log file.


If the new SM_Printer class has been processed successfully, the output from the 
sm_server command appears similar to:


[May, 27, 2009 12:23:33 PM EDT +999ms] t@4097444752 LDM file processing #1
DYN-W-FILE_OPEN_OK- Reading


    'BASEDIR/smarts/local/model/Example1.ldm'


[May, 27, 2009 12:23:47 PM EDT +200ms] t@4097444752 LDM file processing #1
DYN-W-CLASS_DEFINITION_CREATED- Interface SM_Printer created from


    Example1.mdl:3
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Verifying the new class in the IP Manager
Before trying to discover instances of the new printer class, verify that the SM_Printer class 
has been added to the data model of the test IP Manager.


To verify the presence of the new class:


1. Attach the Global Console to the test IP Manager (TEST_IP) and open a Topology 
Browser Console view of the Global Console.


The EMC Smarts Service Assurance Manager Operator Guide provides information 
about starting the Global Console, logging in, and attaching to an EMC Smarts 
application. The default administrative account is username admin and password 
changeme.


2. In the topology tree panel of the Topology Browser Console, right-click an open space, 
and select Select from the pop-up menu to display the Select tree content dialog box.


3. In the dialog box, select Show classes with no instances in current domain and 
click OK.


4. In the Topology Browser Console, verify that the SM_Printer class has been added, as 
shown in Figure 2 on page 29.


.


Figure 2  SM_Printer class in topology of TEST_IP


You can also use dmctl to verify whether the class is present in the topology. 
“Command-line mode” on page 88 provides further details.


TEST_IP
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Setting up the printer OID for discovery
Printers are network devices, but they are classified generically as a host by the 
EMC Smarts discovery process. You can, however, add such devices to a field certification 
file so that EMC Smarts:


◆ Properly recognizes the devices.


◆ Classifies the devices as instances of the new SM_Printer class.


Determine if the printer is already defined


You need to determine if the printer is already defined generically (TYPE = Host), in one of 
the existing EMC Smarts certification files. Certification files are named oid2type_*.conf 
and are found in the BASEDIR/smarts/conf/discovery directory.


If the printer OID is already present in one of the existing certification files, use the 
sm_edit utility to edit the particular oid2type file to comment out the entry.


In this procedure, the printer OID, .1.3.6.1.4.1.253.8.62.1.19.3.1.3, is also defined in 
BASEDIR/smarts/conf/discovery/oid2type_Misc.conf.


To remove the generic definition:


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
oid2type_Misc.conf file:


sm_edit conf/discovery/oid2type_Misc.conf


2. Comment out the entry for the duplicate OID by preceding the lines with a pound sign 
(#):


#.1.3.6.1.4.1.253.8.62.1.19.3.1.3 {
# TYPE = Host
# VENDOR = HP
# CERTIFICATION = VALIDATED
#
#INSTRUMENTATION:
#  Interface-Fault = MIB2
# Interface-Performance = MIB2
#}


3. Save and close the file. 


The modified version of the oid2type_Misc.conf file is saved to the 
BASEDIR/smarts/local/conf/discovery directory.
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Add the printer OID to the field certification file


To add the printer OID to the field certification file:


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
oid2type_Field.conf file:


sm_edit conf/discovery/oid2type_Field.conf


2. Add the following lines at the bottom of the file:


.1.3.6.1.4.1.253.8.62.1.19.3.1.3 {
TYPE = SM_Printer
VENDOR = XEROX
MODEL = Xerox Phaser 5500
CERTIFICATION = TEMPLATE


INSTRUMENTATION:
Interface-Fault                   = MIB2
Interface-Performance             = MIB2


}


The OID that is used in this example is for a particular model XEROX printer. Substitute 
this OID with an OID of a printer on your network. Modify the VENDOR and MODEL 
fields as required. The CERTIFICATION and INSTRUMENTATION fields must be entered 
as shown in this example. The IP Manager user documents provides additional 
information about the oid2type_Field.conf file.


These lines create an instance of the SM_Printer class each time that this model 
printer, designated by the OID (.1.3.6.1.4.1.253.8.62.1.19.3.1.3), is discovered in the 
network. The TYPE attribute designates this OID as a member of the SM_Printer class.


3. Save and close the file.


The modified version of the oid2type_Field.conf file is saved to the 
BASEDIR/smarts/local/conf/discovery directory.
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Reloading the dynamic model
Because the oid2type_Field.conf file is processed when a Manager is first started, TEST_IP 
must be stopped and restarted for any changes to take effect. The new class is loaded into 
the IP Manager.


The IP Manager is started with the --dynamic command line option to pull the compiled 
dynamic model file from BASEDIR/smarts/local/model.


To reload the compiled dynamic model file into the test IP Manager:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to stop the test IP Manager:


dmquit --force --server=TEST_IP


2. Enter the following command to start the test IP Manager and reload the compiled 
dynamic model file:


sm_server -n TEST_IP -c icf --broker=localhost:426 
--bootstrap=bootstrap-am.conf --output --dynamic


The startup code uses bootstrap-am.conf as the bootstrap file for the test IP Manager. 
The startup code also registers the test IP Manager as TEST_IP with the Broker that is 
running on port 426 of the local host. Substitute the bootstrap file and the Broker 
location with your bootstrap file and Broker location.
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Discovering an instance of the SM_Printer class
To discover a printer instance:


1. In the Topology Browser Console that is attached to the test IP Manager (TEST_IP), 
select Configure > Domain Manager Administration Console to launch a Domain 
Manager Administration Console.


2. In the Domain Manager Administration Console, initiate a discovery.


One method is to select Topology > Add Agent to display the Add Agent dialog box. In 
the dialog box, specify either the hostname or IP addsess of the printer.


The EMC Smarts IP Manager Concepts Guide describe various methods of discovery.


3. Verify that the printer has been added to the topology as an instance of the new 
SM_Printer class, as shown in Figure 3 on page 33.


Figure 3  Printer discovered as an instance of SM_Printer


TEST_IP


TEST_IP
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Adding the new class to the Global Manager
The new SM_Printer class has been loaded into the IP Manager but not into the Global 
Manager. You complete the following tasks to add the new class to the Global Manager 
and to enable the Global Manager to import the new class from the IP Manager:


◆ Compile and load the dynamic model into the Global Manager.


◆ Add the IP Manager as a source to the Global Manager.


These tasks should be performed on a test version of a Global Manager. Before starting 
this exercise, back up the repository on the test Global Manager.


Compile and load the dynamic model into the Global Manager


The dynamic model enhancements must be compiled and loaded into the Global 
Manager. Otherwise, the Global Manager has no awareness of the new SM_Printer class.


To compile and load the dynamic model file into the Global Manager:


1. Copy Example1.mdl from the IP Manager’s BASEDIR/smarts/local/model directory to 
the Service Assurance Manager’s BASEDIR/smarts/local/model directory.


2. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the Service Assurance Manager installation area:


cd BASEDIR/smarts/local/model


3. From the BASEDIR/smarts/local/model directory, enter the following command to 
compile Example1.mdl:


BASEDIR/smarts/bin/dynmodel Example1.mdl


If the compilation is successful, the dynmodel command does not produce any output 
to the command-line console. In addition, the following files are created in the 
BASEDIR/smarts/local/model directory:


• Example1.ldm


• Example1_mmbe.dat


• Example1_mmle.dat


• Example1_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model 
directory:


• Example1_mm


“Compilation errors” on page 107 provides additional information if you encounter 
errors.


4. From the BASEDIR/smarts/local/model directory in the Service Assurance Manager 
installation area, copy the following files to the SM_SITEMOD/l10n directory:


• Example1_mmbe.dat


• Example1_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.

34 EMC Smarts Foundation Dynamic Modeling Tutorial







Exercise 1 – Adding a New Printer Class

5. Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to start the test Global Manager and load the 
Example1.ldm file:


sm_server -n TEST_SA -c ics --broker=localhost:426 --output 
--dynamic


The startup code registers the test Global Manager as TEST_SA with the Broker that is 
running on port 426 of the local host. Substitute the Broker location with your Broker 
location.


Add the IP Manager as a source to the Global Manager


If you started your test IP Manager (TEST_IP) as an IP Availability Manager (AM), perform 
the procedure in this section. If you started your test IP Manager as an IP Availability 
Manager and an IP Performance Manager running as a single process (AM-PM), go to “Add 
the event subscription to the IP Manager DXA file” on page 65 for more information.


To add the IP Manager as a source to the test Global Manager:


1. In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), select File > New > Topology Browser Console to launch a Topology Browser 
Console.


2. In the Topology Browser Console, select Manager > Attach to launch the Attach 
Manager dialog box.


3. In the dialog box, enter the test Global Manager name (TEST_SA) and the login 
information (for example, admin and changeme) and click OK.


4. In the Topology Browser Console, select TEST_SA from the Manager drop-down menu.


5. In the Topology Browser Console, select Configure > Global Manager Administration 
Console to launch a Global Manager Administration Console.


6. In the left panel of the Global Manager Administration Console, expand the 
configuration tree to display the Domains.


7. Right-click Domains and then click the pop-up menu to launch the Domain Creation 
Wizard.


8. Consult Figure 4 on page 36 and follow the directions to create an IP Manager domain 
named TEST_IP. (Type TEST_IP in the Domain Name field and select INCHARGE-AM in 
the Copy Existing drop-down list.)
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Figure 4  Using the Domain Creation Wizard to create the TEST_IP domain for Exercise 1
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9. In the toolbar area of the Global Manager Administration Console, click the 
Reconfigure toolbar button ( ).


10. In the Server Reconfiguration confirmation dialog box that appears, click Yes.


11. In the Server Reconfiguration information dialog box that appears, click Close.


In response, the Global Manager:


◆ Creates an InChargeDomain object named TEST_IP and starts the appropriate 
topology and event drivers.


◆ Consults the Broker for the deployment and establishes a connection to the TEST_IP 
domain.


◆ Subscribes to and imports topology and events from the TEST_IP domain.


Verifying the presence of the SM_Printer class instance in the 
Global Manager


To verify the presence of the SM_Printer class in the test Global Manager:


1. In the Global Manager Administration Console that is attached to the test Global 
Manager (TEST_SA), select File > New > Topology Browser Console to launch a Topology 
Browser Console.


2. In the Topology Browser Console, verify that the SM_Printer class has been added, as 
shown in Figure 5 on page 37. 


Figure 5  SM_Printer class in the TEST_SA Global Manager
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3. Right-click the printer instance (CAXTON in this procedure) and select Show Map from 
the pop-up menu. The printer instance is displayed in a Map Console, as shown in 
Figure 6 on page 38.


Figure 6  Map view of the SM_Printer instance


4. If you have a custom icon to represent a printer, you can modify the icon that is used 
to display an instance of SM_Printer. The EMC Smarts Service Assurance Manager 
Configuration Guide has more information on custom icons for map nodes.

38 EMC Smarts Foundation Dynamic Modeling Tutorial







CHAPTER 3
Exercise 2 - Adding an Attribute to the Router 
Class


This chapter consists of the following sections:


◆ Objectives...............................................................................................................  40
◆ Exercise ..................................................................................................................  40
◆ Creating the dynamic model....................................................................................  41
◆ Compiling the dynamic model .................................................................................  42
◆ Copying files for localization ...................................................................................  42
◆ Loading the new attribute into the IP Manager.........................................................  43
◆ Verifying the new attribute in the IP Manager...........................................................  44
◆ Discovering an instance of the Router class .............................................................  45
◆ Populating the value of SM_SerialNumber ..............................................................  46
◆ Adding the new attribute to the Global Manager......................................................  46
◆ Verifying the presence of the SM_SerialNumber attribute in the Global Manager .....  50

Exercise 2 - Adding an Attribute to the Router Class 39







Exercise 2 - Adding an Attribute to the Router Class

Objectives
This exercise describes how to use Dynamic Model to add a new attribute to an existing 
ICIM class in the following Managers:


◆ IP Manager


◆ Global Manager


This exercise also demonstrates how the value of the new attribute can be populated.


This exercise should be performed on test versions of a Broker, IP Manager, and Global 
Manager. Before starting this exercise, back up the repository on the test Managers.


This exercise includes the following tasks:


◆ Create and compile a dynamic model file.


◆ Add an attribute to the existing Router class in the models of the IP Manager.


◆ Use the Global Console to view the new Router attribute.


◆ Use the IP Manager to discover an instance of the Router class.


◆ Add the new Router attribute to the Global Manager.


Exercise
This exercise describes how to add an attribute for the serial number to the existing Router 
class in order to extend the following models:


◆ IP Manager


◆ Global Manager


The syntax is the same as that used to declare any attribute in a MODEL class.


Use a unique prefix with new class names and other properties. The name must differ from 
existing ICIM classes and properties. “SM_” is used as a prefix in this exercise. Do not use 
“SM_” as this prefix is already used by EMC Smarts.
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Creating the dynamic model
In this example, an instance of a compiled dynamic model file named Example2.ldm is 
created in the BASEDIR/smarts/local/model/<conf> directory of the IP Manager 
installation area. The IP Manager is then started with the --dynamic command line option 
to load the compiled dynamic model file from BASEDIR/smarts/local/model.


To create the dynamic model:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to create a new model file named Example2.mdl:


sm_edit --create model/Example2.mdl


2. To add the serial number attribute to the Router class, add the following lines to the 
Example2.mdl file:


refine interface Router
{


stored attribute string SM_SerialNumber
"Custom serial number" 
= "NotAvailable";


}


3. Save and close the file.


The newly created Example2.mdl file is saved to the BASEDIR/smarts/local/model 
directory.
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Compiling the dynamic model
To compile the Example2.mdl model file:


1. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the IP Manager installation area:


cd BASEDIR/smarts/local/model


2. From the BASEDIR/smarts/local/model directory, enter the following command to 
compile Example2.mdl:


BASEDIR/smarts/bin/dynmodel Example2.mdl


If the compilation is successful, the dynmodel command does not produce any output to 
the command-line console. In addition, the following files and subdirectory are created in 
the BASEDIR/smarts/local/model directory:


◆ Example2.ldm


◆ Example2_mmbe.dat


◆ Example2_mmle.dat


◆ Example2_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model directory:


◆ Example2_mm


“Compilation errors” on page 107 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/local/model directory in the IP Manager installation area, copy 
the following files to the SM_SITEMOD/l10n directory:


◆ Example2_mmbe.dat


◆ Example2_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.
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Loading the new attribute into the IP Manager
Once the dynamic model has been compiled, you must load it into the IP Manager. The 
Router class appears in the topology of the IP Manager.


In this procedure, TEST_IP is the name of the test IP Manager. The IP Manager is started 
with the --dynamic command line option to pull the compiled dynamic model file from 
BASEDIR/smarts/local/model.


If the test IP Manager is already running, stop it.


To load the compiled dynamic model file into the test IP Manager:


Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to start the test IP Manager and load the compiled dynamic 
model file:


sm_server -n TEST_IP -c icf --broker=localhost:426 
--bootstrap=bootstrap-am.conf --output --dynamic


The startup code uses bootstrap-am.conf as the bootstrap file for the test IP Manager. 
The startup code also registers the test IP Manager as TEST_IP with the Broker that is 
running on port 426 of the local host. Substitute the bootstrap file and the Broker 
location with your bootstrap file and Broker location. As an example, you could 
substitute bootstrap-am.conf with bootstrap-am-pm.conf to start the IP Manager as an 
IP Availability Manager and an IP Performance Manager running as a single process 
(AM-PM).


In addition, all messages will be logged to a log file, such as 
BASEDIR/smarts/local/logs/TEST_IP_en_US_UTF-8.log.


To check that the compiled dynamic model file was loaded:


Go to the BASEDIR/smarts/local/logs directory and use any text editor to open the 
server log file.


If the new SM_SerialNumber attribute has been processed successfully, the output 
from the sm_server command appears similar to:


[September 11, 2009 4:27:08 PM EDT +263ms] t@1084463424 LDM file processing #1
DYN-W-FILE_OPEN_OK- Reading '/opt/InCharge8/IP/smarts/local/model/Example2.ldm'


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1
MRM-*-MRM_SET_PROP-Setting initial property of SM_SerialNumber to "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1
MRM-*-MRM_ACT_PROP-Actual initial value for SM_SerialNumber = "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +405ms] t@1084463424 LDM file processing #1
DYN-W-CLASS_REFINE_CREATED- Interface Router refined from Example2.mdl:1
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Verifying the new attribute in the IP Manager 
Before trying to populate the value of the new attribute, verify that the SM_SerialNumber 
attribute has been added to the Router class in the data model of the test IP Manager.


To view the presence of the new attribute:


1. Attach the Global Console to the test IP Manager (TEST_IP) and open a Topology 
Browser Console view of the Global Console.


The EMC Smarts Service Assurance Manager Operator Guide provides information 
about starting the Global Console, logging in, and attaching to an EMC Smarts 
application. The default administrative account is username admin and password 
changeme.


2. In the topology tree panel of the Topology Browser Console, right-click an open space, 
and select Select from the pop-up menu to display the Select tree content dialog box.


3. In the dialog box, select Show classes with no instances in current domain and click 
OK.


4. In the topology tree panel of the Topology Browser Console, select the Router class to 
display the attributes in the Attributes tab.


The SM_SerialNumber attribute appears, as shown in Figure 7 on page 44.


Figure 7  Serial number attribute added to the Router class in TEST_IP


TEST_IP
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Discovering an instance of the Router class
To discover a Router instance:


1. In the Topology Browser Console that is attached to the test IP Manager (TEST_IP), 
select Configure > Domain Manager Administration Console to launch a Domain 
Manager Administration Console.


2. In the Domain Manager Administration Console, initiate a discovery.


One method is to select Topology > Add Agent to display the Add Agent dialog box. In 
the dialog box, specify either the hostname or IP address of the router.


The EMC Smarts IP Manager Concepts Guide describes various methods of discovery.


3. Verify that the router has been added to the topology as an instance of the Router 
class. The initial value of the new SM_SerialNumber attribute will be “NotAvailable” as 
shown in Figure 8 on page 45.


Figure 8  Router discovered with the SM_SerialNumber attribute in TEST_IP
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Populating the value of SM_SerialNumber
To populate the values of the new Router attribute, use any of the methods described in 
Appendix C, “Methods of Creating Classes and Populating Attributes.”


After populating the value, rediscover the Router instance.


To rediscover the Router instance:


In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), right-click the Router instance and select Rediscover from the pop-up menu.


Adding the new attribute to the Global Manager
The new Router attribute has been loaded into the IP Manager but not into the Global 
Manager. Complete the following tasks to add the new attribute to the Global Manager 
and to enable the Global Manager to import the new attribute from the IP Manager:


◆ Compile and load the dynamic model into the Global Manager.


◆ Add the Router attribute to the IP Manager DXA configuration file in the Global 
Manager.


◆ Add the IP Manager as a source to the Global Manager.


These tasks should be performed on a test version of a Global Manager. Before starting 
this exercise, back up the repository on the test Global Manager.


Compile and load the dynamic model into the Global Manager


The dynamic model enhancements must be compiled and loaded into the Global 
Manager. Otherwise, the Global Manager has no awareness of the new Router attribute.


Typically, the model that is loaded into a Global Manager contains only those attributes 
that are needed to identify the object in the topology. The values of these types of 
attributes, such as model number and serial number, are not polled by the underlying 
Manager.


In addition, the Global Manager model does not contain any events or problems. If your 
dynamic model contains events or problems, remove the events after you copy the original 
.mdl file to the Service Assurance Manager’s BASEDIR/smarts/local/model directory. Then 
recompile the edited .mdl file (by using dynmodel) to create the .ldm file.


In this example, only an attribute is added to the Router class. You do not have to remove 
the events or problems before recompiling the file.


To compile and load the dynamic model into the Global Manager:


1. Copy Example2.mdl from the IP Manager’s BASEDIR/smarts/local/model directory to 
the Service Assurance Manager’s BASEDIR/smarts/local/model directory.


2. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the Service Assurance Manager installation area:


cd BASEDIR/smarts/local/model


3. From the BASEDIR/smarts/local/model directory, enter the following command to 
compile Example2.mdl:
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BASEDIR/smarts/bin/dynmodel Example2.mdl


If the compilation is successful, the dynmodel command does not produce any output 
to the command-line console. In addition, the following files are created in the 
BASEDIR/smarts/local/model directory:


• Example2.ldm


• Example2_mmbe.dat


• Example2_mmle.dat


• Example2_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model 
directory:


• Example2_mm


“Compilation errors” on page 107 provides additional information if you encounter 
errors.


4. From the BASEDIR/smarts/local/model directory in the Service Assurance Manager 
installation area, copy the following files to the SM_SITEMOD/l10n directory:


• Example2_mmbe.dat


• Example2_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.


5. Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to start the test Global Manager and load the 
Example2.ldm file:


sm_server -n TEST_SA -c ics --broker=localhost:426 --output 
--dynamic


The startup code registers the test Global Manager as TEST_SA with the Broker that is 
running on port 426 of the local host. Substitute the Broker location with your Broker 
location.


Add the Router attribute to the IP Manager DXA file


In the Service Assurance Manager installation area, the 
BASEDIR/smarts/conf/ics/ics-default.xml file designates which DXA configuration file is 
to be used to transfer events and topology from the IP Manager to the Global Manager. The 
ics-default.xml file contains the following sections for the IP Manager and indicates the 
DXA file for the IP Manager:


<domaintype
    name="INCHARGE-AM-SUITE"
    dxaConfFile="dxa-conn.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for INCHARGE-AM-SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
    <domainname>INCHARGE-AM</domainname>
</domaintype>


<domain name="INCHARGE-AM" enable="True"
    domaintypename="INCHARGE-AM-SUITE">
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    <description>AM analysis domain</description>
</domain>


<domaintype
    name="INCHARGE-AM-PM-SUITE"
    dxaConfFile="dxa-conn-perf.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for InCharge AM PM SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
</domaintype>


Because the test IP Manager (TEST_IP) was started as an IP Availability Manager (AM), its 
domain type is INCHARGE-AM-SUITE. If you started your test IP Manager as an IP 
Availability Manager and an IP Performance Manager running as a single process (AM-PM), 
you must load the INCHARGE-AM-PM-SUITE domain type into the Global Manager and then 
add the Router attribute to the dxa-conn-perf.conf file. Go to “Add the event subscription 
to the IP Manager DXA file” on page 65 for more information.


To add the Router attribute to the dxa-conn.conf file:


1. Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to open the dxa-conn.conf file:


sm_edit conf/ics/dxa-conn.conf


The first section of the dxa-conn.conf file provides a listing of the classes, and 
attributes of those classes, that will be transferred from the IP Manager to the Global 
Manager.


2. Just before the entry for the ICIM_UnitaryComputerSystem, add following two lines for 
the Router class (shown in bold):


# Remote Name of Class/Property           Mapped Name of Class/Property
server INCHARGE-AM


class Router
attr SM_SerialNumber


class   ICIM_UnitaryComputerSystem              Node
attr    Certification
attr    DisplayName
attr    Description
attr    Location
attr    Model
attr    PrimaryOwnerContact
attr    Type
attr    Vendor
rel     ConnectedVia


The addition of these two lines configures the Global Manager to receive attribute 
changes for the new SM_SerialNumber attribute of the Router class from the IP 
Manager.


The addition of the two lines is the only change that needs to be made to the 
dxa-conn.conf file.


3. Save and close the file.


The modified version of the dxa-conn.conf file is saved to the 
BASEDIR/smarts/local/conf/ics directory.
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Add the IP Manager as a source to the Global Manager


To add the IP Manager as a source to the test Global Manager:


1. In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), select File > New > Topology Browser Console to launch a Topology Browser 
Console.


2. In the Topology Browser Console, select Manager > Attach to launch the Attach 
Manager dialog box.


3. In the dialog box, enter the test Global Manager name (TEST_SA) and the login 
information (for example, admin and changeme) and click OK.


4. In the Topology Browser Console, select TEST_SA from the Manager drop-down menu.


5. In the Topology Browser Console, select Configure > Global Manager Administration 
Console to launch a Global Manager Administration Console.


6. In the left panel of the Global Manager Administration Console, expand the 
configuration tree to display the Domains.


7. Right-click Domains and then click the pop-up menu to launch the Domain Creation 
Wizard.


8. Consult Figure 4 on page 36 and follow the directions to create an IP Manager domain 
named TEST_IP. (Type TEST_IP in the Domain Name field and select INCHARGE-AM in 
the Copy Existing drop-down list.)


9. In the toolbar area of the Global Manager Administration Console, click the 
Reconfigure toolbar button ( ).


10. In the Server Reconfiguration confirmation dialog box that appears, click Yes.


11. In the Server Reconfiguration information dialog box that appears, click Close.


In response, the Global Manager:


◆ Creates an InChargeDomain object named TEST_IP and starts the appropriate 
topology and event drivers.


◆ Consults the Broker for the deployment and establishes a connection to the TEST_IP 
domain.


◆ Subscribes to and imports topology and events from the TEST_IP domain.
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Verifying the presence of the SM_SerialNumber attribute in the 
Global Manager


To verify the presence of the SM_SerialNumber attribute in the test Global Manager:


1. In the Global Manager Administration Console that is attached to the test Global 
Manager (TEST_SA), select File > New > Topology Browser Console to launch a Topology 
Browser Console.


2. In the Topology Browser Console, verify that the SM_SerialNumber attribute has been 
added to the Router class, as shown in Figure 9 on page 50.


Figure 9  SM_SerialNumber in the TEST_SA Global Manager


Note that if you did not populate the value of the attribute (see “Populating the value of 
SM_SerialNumber” on page 46), the value of SM_SerialNumber will still be 
“NotAvailable.”
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Objectives
This exercise is a complex example of using Dynamic Model to enhance the following 
Managers:


◆ IP Manager


◆ Global Manager 


This exercise should be performed on test versions of a Broker, IP Manager, and Global 
Manager. Before starting this exercise, back up the repository on the test Managers.


The purpose of the exercise is to:


◆ Poll for a new attribute.


◆ Generate an event based on the value of the attribute.


◆ Forward the new event to a Global Manager so that it can be displayed as a 
notification.


This exercise includes the following tasks:


◆ Determine the instrumentation class that will be refined to poll for the new attribute.


◆ Create and compile a dynamic model file:


• Define an additional MIB variable that can be polled by the IP Manager.


• Define a setting class for the new attribute.


• Refine an instrumentation class that will define the MIB OID to poll.


◆ Subscribe to the event in the IP Manager.


◆ Add a new threshold setting to the adapter-setting.asl file in the IP Manager.


◆ Load the dynamic model into the IP Manager.


◆ Discover an instance of the Router class.


◆ Verify the new attributes of the instrumentation class in the IP Manager.


◆ Use the Polling and Thresholds Console to verify the new threshold setting.


◆ Add the polled event to the Global Manager.


◆ Poll the values of the new attributes of the instrumentation class in real-time.


◆ Generate an event based on the values of the polled attribute.


◆ Have the Global Manager subscribe to and display notifications that are associated 
with the event.
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Exercise
In the EMC Smarts environment, an event is a stateful condition that is applied to a 
topology class in a Domain Manager. An event for a discovered topology object, at any 
given time, is either notified (active) or clear (inactive). Events are generated by the 
Domain Manager.


The Global Manager becomes aware of a generated event by subscribing to the event. The 
Global Manager will receive a NOTIFY message when the event becomes active, and a 
CLEAR message when the event clears.


Events are associated with topology objects, but are not objects themselves. 
Notifications, on the other hand, are objects that represent events. The Global Manager 
maps the data in an imported event to the attributes of a notification object.


In this exercise, the IP Manager polls for a new attribute and generates an event. The 
Global Manager subscribes to the event, and when the event is active the event 
notification is displayed in the Notification Log Console.


The new TS_HighOverrunRate event is triggered if the rate of increase of the locIfInOverrun 
attribute of the interface, expressed as a percentage of the inputPacketRate, exceeds a 
user defined threshold.


You do not need to copy and load the dynamic model enhancements (the file with 
extension .ldm) into the Global Manager. This exercise polls for a value and creates an 
event based on the polled value. However, the Global Manager model does not contain 
events. Instead, it contains only those attributes that are required to identify the device in 
topology.


Use a unique prefix with new class names and other properties. The name must differ from 
existing ICIM classes and properties. The prefix “TS_” is used in this example. Do not use 
“SM_” as this prefix is already used by EMC Smarts.
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Determining the instrumentation class
In this exercise, the IP Manager polls an additional attribute that measures the 
performance of the Ethernet connection with a Router.


The IP Manager uses instances of designated instrumentation classes to hold the polled 
attributes, in order to abstract the instrumentation details between device models. These 
instances are in relationship with the object that represents the device, which is where the 
event logic is defined. The event logic might depend on comparison with thresholds, 
which are stored in setting objects.


The instrumentation class that you need to refine can be determined from the 
oid2type_*.conf files, which are located in the BASEDIR/smarts/conf/discovery directory. 
In this example, the OID for a Cisco 2621XM router appears in the oid2type_Cisco.conf 
file.


The TS_locIfInOverrun variable is instrumenting the performance of an Ethernet 
connection. To determine the instrumentation class, locate 
Interface-Ethernet-Performance under INSTRUMENTATION in the device certification:


.1.3.6.1.4.1.9.1.469 {
    TYPE = Router
    VENDOR = Cisco
    MODEL = 2621XM
    CERTIFICATION = CERTIFIED
    CONT = Cisco-Router
    NEIGHBOR = Cisco-Cdp
    HEALTH = Cisco-Router


INSTRUMENTATION:
    Card-Fault                          = OldCiscoChassis
    Environment                         = CiscoEnvMon:DeviceID
    CPU/Memory                          = CiscoRouter:DeviceID
    Interface-Fault                     = MIB2
    Interface-Performance               = CiscoRouter
    Interface-Ethernet-Performance      = CiscoRouter_Ethernet
}


The name of the instrumentation class to refine is obtained by concatenating 
“Interface_Performance_” with the string that is associated with the 
Interface-Ethernet-Performance instrumentation type. The string CiscoRouter_Ethernet is 
associated with the Interface-Ethernet-Performance instrumentation type. Therefore, the 
name of the instrumentation class is Interface_Performance_CiscoRouter_Ethernet.


In the device certification for the Cisco 2621XM router, for example, 
Interface_Performance_CiscoRouter_Ethernet is the instrumentation class that is used to 
instrument the performance of Ethernet interface (IF) connections on discovered 2621XM 
routers.
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Creating the dynamic model
In this example, an instance of a compiled dynamic model file named Example3.ldm is 
created in the BASEDIR/smarts/local/model/<conf> directory of the IP Manager 
installation area. The IP Manager is then started with the --dynamic command line option 
to load the compiled dynamic model file from BASEDIR/smarts/local/model.


To create the dynamic model:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to create a new model file named Example3.mdl:


sm_edit --create model/Example3.mdl


2. To refine the setting class that sets the default value for the alarm threshold, add the 
following lines to the Example3.mdl file:


refine interface NetworkAdapter_Performance_Setting
{
        attribute float [0 .. 100] TS_OverrunThreshold
        "Acceptable upper threshold for Overruned packets, "
        "expressed as a percentage of the total number of input 
packets."
        = 10;
}


The NetworkAdapter_Performance_Setting class defines parameters that are common 
to the performance of all network adapters, such as utilization, errors, broadcast, and 
packet drops.


3. To refine the Interface_Performance_CiscoRouter_Ethernet instrumentation class that 
is used to poll for the attribute, add the following lines to the Example3.mdl file:


refine interface Interface_Performance_CiscoRouter_Ethernet
{
attribute float TS_OverrunThreshold
"The upper threshold for Overrun packet errors expressed as a percentage"
"of the total number of output packets."
= 10;


instrument SNMP {
TS_locIfInOverrun = "1.3.6.1.4.1.9.2.2.1.1.14"
};


readonly instrumented attribute int TS_locIfInOverrun
"The number of overrun errors.";


readonly computed attribute float TS_locIfInOverrunRate
= rate(TS_locIfInOverrun, PollingInterval);


computed attribute float TS_OverrunErrorRate
"The rate of ignored Overrun packets expressed in packets"
"per second."
= TS_locIfInOverrunRate;


#pragma Uses Propagation
readonly computed attribute float TS_OverrunErrorPct
"The rate of Overruned input packets expressed as a percentage"
"of total input packets."
= (TS_OverrunErrorRate / (InputPacketRate + 0.001)) * 100;
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event TS_HighOverrunRate
"Indicates that the percentage of packets with Overrun errors exceeds 


OverrunErrorThreshold"
= if NetworkAdapterOperational && (TS_OverrunThreshold < 100) && (MaxSpeed > 0)
check (TS_OverrunErrorPct > TS_OverrunThreshold);


export TS_HighOverrunRate;
}


These lines add five attributes to the Interface_Performance_CiscoRouter_Ethernet 
class:


• TS_OverrunThreshold (threshold attribute)


• TS_locIfInOverrun (instrumented attribute)


• TS_locIfInOverrunRate (computed attribute)


• TS_OverrunErrorRate (computed attribute)


• TS_OverrunErrorPct (computed attribute)


The instrumentation for an object, such as an interface, is generally defined in a 
separate class that is called an instrumentation class. The definition to poll for the 
value of the TS_locIfInOverrun MIB attribute is added in this instrumentation class. 
Classes of this type inherit from the parent class called ICIM_Instrumentation.


The instrument SNMP{} block defines the OID value that needs to be polled. Note that 
there is no leading period (“.”) in the specification of the OID. The value that is 
returned by polling the OID is stored in an attribute that is defined as an instrumented 
attribute. The EMC Smarts MODEL Reference Guide  provides the syntax of an 
instrumented attribute.


An event clause is used to define a new event. Events are defined in terms of 
expressions. In this example, a new event is defined that is called 
TS_HighOverrunRate. This event is triggered when the value of the following 
expression evaluates to true:


TS_OverrunErrorPct > TS_OverrunThreshold
if NetworkAdapterOperational and (TS_OverrunThreshold < 100) and 
(MaxSpeed > 0)


To ensure that the event is available to a client, an export declaration is required. The 
EMC Smarts MODEL Reference Guide  includes details on defining and exporting 
events.


4. Save and close the file.


The newly created Example3.mdl file is saved to the BASEDIR/smarts/local/model 
directory.
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Compiling the dynamic model
To compile the Example3.mdl model file:


1. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the IP Manager installation area:


cd BASEDIR/smarts/local/model


2. From the BASEDIR/smarts/local/model directory, enter the following command to 
compile Example3.mdl:


BASEDIR/smarts/bin/dynmodel Example3.mdl


If the compilation is successful, the dynmodel command does not produce any output to 
the command-line console. In addition, the following files and subdirectory are created in 
the BASEDIR/smarts/local/model directory:


◆ Example3.ldm


◆ Example3_mmbe.dat


◆ Example3_mmle.dat


◆ Example3_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model directory:


◆ Example3_mm


“Compilation errors” on page 107 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/local/model directory in the IP Manager installation area, copy 
the following files to the SM_SITEMOD/l10n directory:


◆ Example3_mmbe.dat


◆ Example3_mmle.dat


By default, SM_SITEMOD is set to BASEDIR/smarts/local.
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Subscribing to the new event in the IP Manager
One of the strengths of EMC Smarts technology is that expressions that are defined in an 
event are not evaluated and polled unless there is a subscription to that event. In order for 
the IP Manager to automatically begin polling and monitoring for the new event, you need 
to add a subscription to the IP Manager’s bootstrap-am-pm.conf file.


To add a subscription to the IP Manager’s bootstrap-am-pm.conf file:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to open the bootstrap-am-pm.conf file:


sm_edit conf/icf/bootstrap-am-pm.conf


2. In the GA_SubscriberProfile::PROFILE-default section, add the following line: 


{"Interface_Performace_CiscoRouter_Ethernet",".*","TS_HighOverrunRate",77879 }


The format is as follows:


{ <class>, <instance>, <event>, <subscription-level> },


where:


• <class> is the name of the class in double quotes.


• <instance> is the name of the instance in double quotes.


• <event> is the name of the event in the class in double quotes.


• <subscription-level> can have the following values:


– 77879 = problems, aggregates, events


– 77890 = aggregates


– 77825 = aggregates, events


– 77840 = problems, aggregates


If your entry is the last line in the GA_Subscriber section, ensure that you type a 
comma (,) at the end of the line before your entry.


3. Save and close the file.


The modified version of the bootstrap-am-pm.conf file is saved to the 
BASEDIR/smarts/local/conf/icf directory.
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Adding the new threshold to the adapter-setting.asl file
The new threshold attribute, TS_HighOverrunRate, must be added to the 
BASEDIR/smarts/rules/health/adapter-setting.asl file in the IP Manager installation area.


To add the threshold to the adapter-setting.asl file:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to open the adapter-setting.asl file:


sm_edit rules/health/adapter-setting.asl


2. In the APPLY_SETTING() section, add the following line (shown in bold):


if (!setObj->isNull()) {
REMOVE_PERF_INSTRUMENTATION(obj);
continue;


}


threshold_map += “TS_OverrunThreshold”;


if (obj->CreationClassName == "Port") {


The name of the threshold in the instrumentation object and in the setting object 
must be exactly the same name.


3. Save and close the file.


The modified version of the adapter-setting.asl file is saved to the 
BASEDIR/smarts/local/rules/health directory.


Loading the dynamic model into the IP Manager
Once the dynamic model has been compiled, you must load it into the IP Manager.


In this procedure, TEST_IP is the name of the test IP Manager. The IP Manager is started 
with the --dynamic command line option to pull the compiled dynamic model file from 
BASEDIR/smarts/local/model.


If the test IP Manager is already running, stop it.
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To load the compiled dynamic model file into the test IP Manager:


Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to start the test IP Manager and load the compiled dynamic 
model file:


sm_server -n TEST_IP -c icf --broker=localhost:426 
--bootstrap=bootstrap-am-pm.conf --output --dynamic


The startup code uses bootstrap-am-pm.conf as the bootstrap file for the test IP 
Manager. The startup code also registers the test IP Manager as TEST_IP with the 
Broker that is running on port 426 of the local host. Substitute the Broker location with 
your Broker location.


In addition, all messages will be logged to a log file, such as 
BASEDIR/smarts/local/logs/TEST_IP_en_US_UTF-8.log.


To check that the compiled dynamic model file was loaded:


Go to the BASEDIR/smarts/local/logs directory and use any text editor to open the 
server log file.


If the new SM_SerialNumber attribute has been processed successfully, the output 
from the sm_server command appears similar to:


[July 10, 2009 12:25:29 PM EDT +789ms] t@1120213312 LDM file processing #1
DYN-W-FILE_OPEN_OK- Reading
    '/opt/InCharge8/IP/smarts/local/model/Example3.ldm'


[July 10, 2009 12:25:44 PM EDT +141ms] t@1120213312 LDM file processing #1
MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +142ms] t@1120213312 LDM file processing #1
MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +143ms] t@1120213312 LDM file processing #1
MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +144ms] t@1120213312 LDM file processing #1
DYN-W-CLASS_REFINE_CREATED- Interface NetworkAdapter_Performance_Setting
    refined from Example3.mdl:1


[July 10, 2009 12:25:44 PM EDT +145ms] t@1120213312 LDM file processing #1
MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1
MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1
MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10
[July 10, 2009 12:25:44 PM EDT +147ms] t@1120213312 LDM file processing #1
DYN-W-CLASS_REFINE_CREATED- Interface Interface_Performance_CiscoRouter
    refined from Example3.mdl:8
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Discovering an instance of the Router class
To discover a Router instance:


1. In the Topology Browser Console that is attached to the test IP Manager (TEST_IP), 
select Configure > Domain Manager Administration Console to launch a Domain 
Manager Administration Console.


2. In the Domain Manager Administration Console, initiate a discovery.


One method is to select Topology > Add Agent to display the Add Agent dialog box. In 
the dialog box, specify either the hostname or IP address of the router.


The EMC Smarts IP Manager Concepts Guide and the EMC Smarts IP Manager User 
Guide describe various methods of discovery.


Verifying the new attributes in the IP Manager
Verify that the router and interface have been added to the topology by verifying that the 
new attributes for the Interface_Performance_CiscoRouter_Ethernet instrumentation class 
have been added to the data model of the test IP Manager.


To verify the presence of the new attributes:


1. In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), click an open space in the topology tree panel and press the Ctrl-Alt-M keys 
simultaneously to make all IP Manager classes available to the Global Console, 
including the meta classes.


2. In the topology tree panel of the Global Console, right-click an open space and select 
Refresh tree from the pop-up menu to refresh the content of the topology tree.


3. In the topology tree panel, click the + signs to expand the 
Interface_Performance_CiscoRouter_Ethernet class, then click an 
Interface_Performance_CiscoRouter_Ethernet instance to display the Attributes tab in 
the right panel.


4. In the Attributes tab, shown in Figure 10 on page 62, verify that the following 
attributes have been added to the Interface_Performance_CiscoRouter_Ethernet 
instance:


◆ TS_locIfInOverrun


◆ TS_locIfInOverrunRate


◆ TS_OverrunErrorPct 


◆ TS_OverrunErrorRate


◆ TS_OverrunThreshold
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Figure 10  Attributes tab with the new attributes before polling


5. In the topology tree panel, right-click an open space and select Refresh tree from the 
pop-up menu to refresh the content of the topology tree.


6. Press the Ctrl-Alt-M keys simultaneously to make only the default IP Manager classes 
available.


7. In the topology tree panel, click the + sign next to the IP Manager’s name to expand 
the topology tree. Only the default classes appear in the topology tree.


TEST_IP
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Verifying the new threshold in the IP Manager
In this example, the TS_OverrunThreshold attribute was added to the Ethernet 
Interface/Port Performance setting by refining the NetworkAdapter_Performance_Setting 
class. The NetworkAdapter_Performance_Setting class defines parameters that are used 
for monitoring performance characteristics of a network adapter. These include basic 
parameters that are common to all network adapters, such as utilization, errors, 
broadcast, and packet drops.


To verify that the TS_OverrunThreshold attribute was added to the Ethernet Interface/Port 
Performance setting:


1. In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), select Configure > Polling and Thresholds to launch the Polling and 
Thresholds Console.


2. In the Polling and Thresholds Console, click the Thresholds tab.


3. In the left panel, select Interface Groups.


4. Find the interface group to which your router interfaces are members.


5. In the left panel, under the appropriate interface group, select Settings > Ethernet 
Interface/Port Performance.


If your router interfaces are members of Other Interfaces, select Settings > Generic 
Interface/Port Performance.


6. Verify that the value of the TS_OverrunThreshold attribute can be set as shown in 
Figure 11 on page 63.


Figure 11  TS_OverrunThreshold attribute in the Thresholds tab


TEST_IP


TEST_IP
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7. In this example, subinterface performance analysis must be enabled. Scroll to the top 
of the Parameters tab. Enable subinterface performance analysis if disabled, as shown 
in Figure 12 on page 64.


Figure 12  Enabled subinterface performance analysis


8. Click the Apply button to save your configuration changes.


9. Click the Reconfigure toolbar button ( ) to make your configuration changes take 
effect.


TEST_IP


TEST_IP
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Adding a new event subscription to the Global Manager
You do not load the new event into the Global Manager because the Global Manager data 
model does not have to be enhanced to include the event itself.


You do, however, need to complete the following tasks to enable the Global Manager to 
import the new event from the IP Manager:


◆ Add the event subscription to the IP Manager DXA configuration file in the Global 
Manager.


◆ Add the IP Manager as a source to the Global Manager.


These tasks should be performed on a test version of a Global Manager. Before starting 
this exercise, back up the repository on the test Global Manager.


Add the event subscription to the IP Manager DXA file


In the Service Assurance Manager installation area, the 
BASEDIR/smarts/conf/ics/ics-default.xml file designates which DXA configuration file is 
to be used to transfer events and topology from the IP Manager to the Global Manager. The 
ics-default.xml file contains the following sections for the IP Manager and indicates the 
DXA file for the IP Manager:


<domaintype
    name="INCHARGE-AM-SUITE"
    dxaConfFile="dxa-conn.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for INCHARGE-AM-SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
    <domainname>INCHARGE-AM</domainname>
</domaintype>


<domain name="INCHARGE-AM" enable="True"
    domaintypename="INCHARGE-AM-SUITE">
    <description>AM analysis domain</description>
</domain>


<domaintype
    name="INCHARGE-AM-PM-SUITE"
    dxaConfFile="dxa-conn-perf.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for InCharge AM PM SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
</domaintype>


Because the test IP Manager (TEST_IP) was started as an IP Availability Manager and an IP 
Performance Manager running as a single process (AM-PM), its domain type is 
INCHARGE-AM-PM-SUITE. And because that domain type is not loaded into the Global 
Manager by default, you must load it into the Global Manager and then add the event 
subscription to the dm-conn-perf.conf file. The EMC Smarts Service Assurance Manager 
Configuration Guide provides the procedure for using the Import XML Domain 
Configuration server tool to load INCHARGE-AM-PM-SUITE.
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Event and notification subscriptions in the Global Manager are configured within DXA 
configuration files by using the sub keyword. Patterns (regular expressions) that are 
separated by “::” match the class name, instance name, and event name in the Manager. 


The syntax is as follows:


sub <classPattern>::<instancePattern>::<eventPattern>/<modifiers>


where:


◆ <classPattern> is the pattern to match for the class name.


◆ <instancePattern> is the pattern to match for the name of the instance.


◆ <eventPattern> is the pattern to match for the name of the problem or event.


◆ <modifiers> can have the following values:


• p = problem


• e = event


• a = aggregates


• n = notifications


To add the event subscription to the dxa-conn-perf.conf file:


1. Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to open the dxa-conn-perf.conf file:


sm_edit conf/ics/dxa-conn-perf.conf


2. In the subscription section of the file, add the following lines:


# Added for Dynamic Model
sub Interface_Performance_CiscoRouter_Ethernet::.*::TS_HighOverrunRate/e


3. (Optional) Set the severity and category of the notification that is created for this 
event. “Setting the notification characteristics of the event” on page 103 provides 
more information.


4. Save and close the file.


The modified version of the dxa-conn-perf.conf file is saved to the 
BASEDIR/smarts/local/conf/ics directory.
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Add the IP Manager as a source to the Global Manager


To add the IP Manager as a source to the test Global Manager:


1. In the Domain Manager Administration Console that is attached to the test IP Manager 
(TEST_IP), select File > New > Topology Browser Console to launch a Topology Browser 
Console.


2. In the Topology Browser Console, select Manager > Attach to launch the Attach 
Manager dialog box.


3. In the dialog box, enter the test Global Manager name (TEST_SA) and the login 
information (for example, admin and changeme) and click OK.


4. In the Topology Browser Console, select TEST_SA from the Manager drop-down menu.


5. In the Topology Browser Console, select Configure > Global Manager Administration 
Console to launch a Global Manager Administration Console.


6. In the left panel of the Global Manager Administration Console, expand the 
configuration tree to display the Domains.


7. Right-click Domains and then click the pop-up menu to launch the Domain Creation 
Wizard.


8. Consult Figure 13 on page 68 and follow the directions to create an IP Manager 
domain named TEST_IP. (Type TEST_IP in the Domain Name field and select 
INCHARGE-AM-PM in the Copy Existing drop-down list.)


9. In the toolbar area of the Global Manager Administration Console, click the 
Reconfigure toolbar button ( ).


10. In the Server Reconfiguration confirmation dialog box that appears, click Yes.


11. In the Server Reconfiguration information dialog box that appears, click Close.


In response, the Global Manager:


◆ Creates an InChargeDomain object named TEST_IP and starts the appropriate 
topology and event drivers.


◆ Consults the Broker for the deployment and establishes a connection to the TEST_IP 
domain.


◆ Subscribes to and imports topology and events from the TEST_IP domain.
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Figure 13  Using the Domain Creation Wizard to create the TEST_IP domain for Exercise 3
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Polling the new attributes
The Global Manager must be restarted for the subscription to the TS_HighOverrunRate 
event to take effect, and for the polling of the new attributes to commence.


If the test Global Manager is already running, stop it.


To start the polling of the new attributes:


Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to start the test Global Manager:


sm_server -n TEST_SA -c ics --broker=localhost:426 --output


The --dynamic option is not included in the startup command because the Global Manager 
data model does not have to be enhanced to include the event itself. Substitute the 
Broker location with your Broker location.


Once polling has started, the values of TS_locIfInOverrun, TS_locIfInOverrunRate, and 
TS_OverrunErrorPct, and TS_OverrunErrorRate will appear in the IP Manager’s topology, 
similar to what is shown in Figure 14 on page 69.


Figure 14  Attributes tab with the new attributes after polling


When the TS_HighOverrunRate event is triggered by the TS_OverrunErrorPct value, the 
TS_HighOverrunRate event is transferred to the Global Manager and displayed in the 
Notification Log Console.
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Guidelines and requirements
A dynamic model file describes the model elements that extend the basic EMC Smarts 
data model. The following guidelines apply to dynamic model files:


◆ Typically, those classes that are related to each other are contained in the same 
dynamic model file.


◆ Dynamic model filenames may contain ASCII letters (A..Z,a..z), ASCII numbers (0...9), 
and the underscore character (_), but may contain no other characters. The first 
character must be a letter.


◆ The dynamic model filename must be unique within the first 23 characters.


◆ The dynamic model file must have a .mdl filename extension.


◆ Use the sm_edit utility to create and edit the dynamic model files (those with 
extension .mdl).


◆ Dynamic model files must follow the syntax rules that are described in “Adding a class 
to the model” on page 73 and “Updating an existing class in the model” on page 75.


◆ All refinements to a class must be contained in a single refine interface <classname> 
declaration. For example, you cannot have a refine interface Router declaration in the 
mymodel1.mdl file, and then another refine interface Router in the mymodel2.mdl. 
Likewise, you cannot have more than one refine interface Router declaration in the 
mymodel1.mdl file.


◆ Precede any new attributes, classes, aggregates or events that are defined with a 
unique tag, such as USR_. You should not use SM_ as this is already used by 
EMC Smarts.


◆ Do not use the external keyword in any dynamic model files of any Manager.


◆ Dynamic model files must be located in either BASEDIR/smarts/local/model or 
BASEDIR/smarts/local/model/<config>, where <config> refers to the configuration 
directory that is specified on the command line when the Manager is started.


◆ The dynamic model files (those with extension .ldm) must be loaded into each 
Manager that requires knowledge of the new topology and events. The loading of the 
dynamic model files incorporates them into the runtime data model.


◆ When the option --dynamic is not added to the sm_server command, the Manager will 
load all dynamic model files that can be loaded into a Manager (those with extension 
.ldm) that are located in:


BASEDIR/smarts/local/model/<config>


where <config> refers to the configuration directory that is specified on the sm_server 
command line when the Manager is started.


Appendix B, “The dynmodel Command Syntax and Options,” provides information on 
creating dynamic model files that can be loaded into a Manager.
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◆ When the --dynamic option is specified on the sm_server command line, the Manager 
will load all dynamic model files that can be loaded into a Manager (those with 
extension .ldm) that are located in:


• BASEDIR/smarts/local/model


• BASEDIR/smarts/local/model/<config>


The <config> refers to the configuration directory that is specified on the sm_server 
command line when the Manager is started.


If a Manager is started by using sm_service, edit the sm_service command to include the 
--dynamic option.


Adding a class to the model
First, the class to be added needs to be declared, as described in “Adding the new class” 
on page 74. Next, it is compiled into a form that can be loaded into a Manager. Once the 
model that contains the new class is loaded into the Manager, any operations and 
facilities available for common EMC Smarts classes in the Manager are now available for 
the new class. However, additional steps are needed to actually discover and instantiate 
instances of the class.


Determining the parent of the new class


A new class is declared as a subclass of an existing ICIM class. The key is to determine 
which class should be the parent class. This determination is based on several factors:


◆ How you want to search and report on the new class


◆ Functional similarities to existing elements in topology


◆ The events, attributes, and relationships the new class needs to inherit


For example, suppose a class that represents a printer needs to be added to the model. A 
printer is a physical element, similar to a router, switch, or host. Therefore, the printer 
class can be defined as a subclass of UnitaryComputerSystem, which is the parent class of 
routers, switches, and hosts. The printer class inherits all of the attributes, relationships, 
and events of the UnitaryComputerClass class.


The IP Manager counts the instances of the ICIM_UnitaryComputerSystem toward the 
system volume license. If this is a problem for you, you can inherit from either 
ICIM_System or ICIM_ComputerSystem. However, if you inherit from either ICIM_System or 
ICIM_ComputerSystem you will have to add your new class into the appropriate DXA 
configuration file to transfer the topology to the Global Manager. Chapter 3, “Exercise 2 - 
Adding an Attribute to the Router Class,” provides information about adding a class and 
its associated attributes to dxa files.
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Adding the new class 


To add a new class to a model, use the interface keyword. The interface keyword indicates 
that any declarations that follow define a new class.


The syntax is as follows:


interface <class_name>:<parent_class>
{


<declarations>
}


Use a unique prefix with new class names and other properties, since the name must 
differ from existing ICIM classes and properties. “SM_” is used as a prefix in this example. 
Do not use “SM_” as this is already used by EMC Smarts.


In this example the printer class inherits from the UnitaryComputerSystem class, and is 
named SM_Printer.


interface SM_Printer:UnitaryComputerSystem
"Create a printer class inheriting from UCS"
{


stored attribute string SM_PrtrLocation
"Location of Printer"="";


}


The new class may include a description.


The EMC Smarts MODEL Reference Guide  describes the <declarations> syntax. In dynamic 
modeling, declarations include attributes, relationships, operations, problems, 
symptoms, aggregates, and events.
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Updating an existing class in the model
You may also make changes to the ICIM classes that already exist in the model installed on 
a Manager. An existing class can be extended by adding any of the following:


◆ Attribute


◆ Relationship


◆ Event


◆ Aggregate


◆ Problem


◆ Symptom


◆ Operation


However, when a Manager, such as an IP Manager, is started, its model is loaded from a 
library file. Dynamic modeling allows you to extend one of the classes in the library file by 
adding new properties, such as attributes and events. However, you cannot delete any 
class properties in the delivered library file.


In this example, several properties are declared in a class in the library file:


interface Host : ICIM_System
"Host is a computer system that represents a workstation or server."


{
    export Down,


 Unresponsive;
    
    relationship SystemPackagedIn, Chassis, PackagesSystems


    problem Down =>
Unresponsive, 
Unresponsive explains;


    event Unresponsive = IsUnresponsive;
    stored attribute boolean IsUnresponsive = FALSE;
    stored attribute boolean IsAgentUnresponsive = FALSE;
}


Dynamic modeling allows a new property to be added or one of the existing properties to 
be modified. However, the existing Unresponsive event, Down problem, 
SystemPackagedIn relationship, and the IsUnresponsive and IsAgentUnresponsive 
attributes cannot be deleted.


refine interface keyword


To modify an existing class, use the refine interface keyword. The refine interface keyword 
indicates that any declarations that follow will modify an existing ICIM class. 


All refinements to a class must be contained in a single refine interface <classname> 
declaration. For example, you cannot have a refine interface Router declaration in the 
mymodel1.mdl file, and then another refine interface Router in the mymodel2.mdl. 
Likewise, you cannot have more than one refine interface Router declaration in the 
mymodel1.mdl file.
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In this example, the stored attribute SM_RtrChassisType is added to the Chassis class. The 
Chassis class is one of the ICIM classes.


refine interface Chassis
{


stored attribute string SM_RtrChassisType;
}


Refining inherited class properties


You can refine inherited attributes, events, problems, symptoms, operations or 
relationships when you create a new subclass. These class properties may be inherited 
from the parent class or any of the other classes up the inheritance tree to the base class. 
The syntax for refining an inherited attribute, event, problem, symptom, operation or 
relationship is:


interface <child_class> : <parent_class>
{


refine <property declarations>
}


The refine syntax for each type of declaration such as an attribute, is the same as that 
described in the EMC Smarts MODEL Reference Guide . 


Adding an attribute


The syntax for adding a new attribute to an existing ICIM class is:


refine interface <ICIM_class_name>
{


<attribute declarations>
}


The following example adds the stored attribute SM_SerialNumber to the existing Router 
class.


refine interface Router
{


stored attribute string SM_SerialNumber
“Custom serial number stored in the Cisco”
“chassis-id MIB (.1.3.6.1.4.1.9.3.6.3)”
= “NotAvailable”;


}


For more information about attribute declarations and valid data types, see the EMC 
Smarts MODEL Reference Guide . 
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Adding a relationship


A new relationship (one-to-one or one-to-many) can be added to an existing ICIM class. 
The syntax for adding a new relationship to an existing ICIM class is:


refine interface <ICIM_class_name>
{


<relationship declarations>
}


The following example adds a relationship, OSInstalled, to the existing ICIM class, 
UnitaryComputerSystem.


refine interface UnitaryComputerSystem
{


relationshipset OSInstalled, SM_OperatingSystem, OSRunningOn;
}


The inverse relationship, OSRunninOn, must also be defined in the SM_OperatingSystem 
class.


For more information about relationship declarations, see the EMC Smarts MODEL 
Reference Guide .


Adding an event


A new event can be added to an existing ICIM class. The syntax for adding a new event to 
an existing ICIM class is:


refine interface <ICIM_class_name>
{


<event declarations>
}


The following example adds the IPForwardingOn event to the existing ICIM class, Host.


refine interface Host
{


propagate attribute int min SM_ipForwarding
"Value of ipFrowarding from SM_ipForwardingInstrument"
<=SM_ipForwardingInstrument, InstrumentedBy, SM_ipForwarding;


event IPForwardingOn "A Host has IPForwarding turned 
on" = SM_ipForwarding==1;


export IPForwardingOn;
}


For more information about event declarations, see the EMC Smarts MODEL Reference 
Guide .
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Adding an aggregate


A new aggregate can be added to an existing class. The syntax for adding a new aggregate 
to an existing class is:


refine interface <class_name>
{


<aggregate declarations>
}
The following example adds the DegradedWirelessConnectivity aggregate to the existing 
class, SM_WirelessAccessPoint:


refine interface SM_WirelessAccessPoint
{


stored attribute int MaxNumberIntended =20;


propagate attribute int max SM_SignalDegradation
<=SM_APInstrumentation, InstrumentedBy,
SM_SignalDegradation;


propagate attribute int max SM_NumberOfMACS
<=SM_APInstrumentation, InstrumentedBy,
SM_NumberofMACS;


event PoorConnectivity “AP MIB returns loss in
SignalPower (dB)” SM_SignalDegradation >10;


event MaxUsersReached “Number of users on a signal
AP device has been exceeded”
SM_NumberOfMACS>MaxNumberIntended;


aggregate DegradedWirelessConnectivity “Wireless
connectivity for the AP is degraded” <= PoorConnectivity,
MaxUsersReached;


export DegradedWirelessConnectivity;
}


For more information about aggregate declarations, see the EMC Smarts MODEL Reference 
Guide .


Adding a problem


A new problem can be added to an existing ICIM class. The syntax for adding a new 
problem to an existing ICIM class is:


refine interface <ICIM_class_name>
{


<problem declarations>
}
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The following example adds the IPForwarded problem to the existing ICIM class, Host:


refine interface Host
{


propagate attribute int min SM_ipForwarding
"Value of ipFrowarding from SM_ipForwardingInstrument"
<=SM_ipForwardingInstrument, InstrumentedBy, SM_ipForwarding;


event IPForwardingOn "A Host has IPForwarding turned 
on" = SM_ipForwarding==1;


problem IPForwarded =>
IPForwardingOn,
IPForwardingOn explains;


export IPForwardingOn;
export IPForwarded;


}


For more information about problem declarations, see the EMC Smarts MODEL Reference 
Guide .


Adding a symptom


A new symptom can be added to an existing ICIM class. The syntax for adding a new 
symptom to an existing ICIM class is:


refine interface <ICIM_class_name>
{


<symptom declarations>
}


For more information about symptom declarations, see the EMC Smarts MODEL Reference 
Guide .


Adding an operation


A new operation can be added to an existing ICIM class. The syntax for adding a new 
operation to an existing ICIM class is:


refine interface <ICIM_class_name>
{


<operation declaration>
}


For more information about operation declarations, see the EMC Smarts MODEL Reference 
Guide .
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Syntax and options
After you create dynamic model files, the class and property declarations must be 
compiled into a form that can be loaded by a Manager. The dynamic model compiler, 
dynmodel, is used to compile the modified model files.


The dynmodel compiler is located in the BASEDIR/smarts/bin directory.


The dynmodel command is used to invoke the dynamic model compiler on one or more 
files that contain model class definitions. The compiler checks the MODEL syntax but does 
not verify compatibility with other models, including name resolution. The dynamic model 
compiler generates a corresponding model file, for each input file, that can be loaded into 
a Manager. The generated files can be loaded by a Manager as part of the data model.


The syntax of the dynmodel command is:


dynmodel [<options>] <mdl-files>


where:


◆ <options> may be in any order, but must precede the .mdl files. Options are defined in 
Table 2 on page 82.


◆ <mdl-files> specify one or more files, separated by a space. 


Table 2  Command line options for the dynmodel command


option Description


-w Suppress generation of warning messages that are produced by the 
compiler.


-Wb,ProblemMode Compile dynamic model files that have added or refined problems 
and symptoms.


--help Prints the compiler’s command line options and then exits.


--version Prints the compiler’s version information and then exits.


--l10nsrc The base directory that holds locale source files. The default is 
l10nsrc.
When dynmodel generates Resource Packages, it incorporates files 
for each model based on <dir>/<pkg_id>.
where:
<pkg_id> is the model filename less its extension, plus _mm, and 
then truncated at 23 characters.
This option must be used in conjunction with the --locales option.


--locales A comma-delimited list of locales which correspond to localized text 
files to be incorporated into the Resource Package for model files.
This option must be used in conjunction with the --locales option.
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In the following example, the command line suppresses the generation of warning 
messages that are produced when compiling the mymodel.mdl file:


dynmodel -w mymodel.mdl


The dynmodel command creates the following files in the BASEDIR/smarts/local/model 
directory, where <modelname> is the name of a dynamic model. Table 3 on page 83 
describes the set of files that is created for each of the dynamic model files that are 
included on the command line. 


For example, the following commands compile the Asset.mdl and AssetUCS.mdl dynamic 
model files:


cd BASEDIR/smarts/local/model
BASEDIR/smarts/bin/dynmodel Asset.mdl AssetUCS.mdl


When the Asset.mdl and AssetUCS.mdl dynamic model files are compiled, the following 
set of files and directories are produced:


◆ Asset.ldm


◆ Asset_mmbe.dat


◆ Asset_mmle.dat


◆ Asset_mm.txt


◆ Asset_mm


◆ AssetUCS.ldm


◆ AssetUCS_mmbe.dat


◆ AssetUCS_mmle.dat


◆ AssetUCS_mm.txt


◆ AssetUCS_mm


Table 3  Files and directories generated by the dynmodel compiler


Generated file or directory Description


<modelname>.ldm The version of the dynamic model that is loaded into a 
Manager.


<modelname>_mmbe.dat The Big Endian message file for the MODEL interface, attribute, 
and event descriptions.


<modelname>_mmle.dat The Little Endian message file for the MODEL interface, 
attribute, and event descriptions.


<modelname>_mm.txt The Resource Package source that contains MODEL text.


<modelname>_mm A directory that is created for holding temporary files that are 
needed during the dynamic model compilation process.


Note: Do not remove this directory.
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Asset.ldm is the version of the dynamic model file that can be loaded 
by a Manager. Likewise, AssetUCS.ldm is the version of the dynamic 
model file AssetUCS.mdl that can be loaded by a Manager.


The dynamic model source files can be created and compiled in any directory. However, all 
compiled dynamic model files (those files with the .ldm extension) must reside in either 
the BASEDIR/smarts/local/model directory or the BASEDIR/smarts/local/model/<config> 
directory, in order to be loaded into a Manager. The <config> refers to the configuration 
directory that is specified on the sm_server command line when the Manager is started.


Using the --l10nsrc and --locales options


The --l10nsrc and --locales options cannot be used independently. You must either 
include both options on the command line or exclude both options from the command 
line.


The two options are applied uniformly to all model files on the command line. If you want 
to compile two (or more) models that have a different list of locales or with different 
l10nsrc base directories, you need to use two (or more) different dynmodel calls.


When dynmodel generates Resource Packages, it will incorporate files for each model 
based on <dir>/<pkg_id> (where <pkgId> is the model file name less its extension, plus 
_mm, then truncated at 23 characters.


In the following example, dynmodel compiles two models, model1 and model2:


dynmodel model1 model2 --l10nsrc=mysource --locales=ja,de


The dynmodel compiler incorporates ./mysource/model1_mm/ja.txt and 
./mysource/model1_mm/de.txt into model1’s .dat file. The dynmodel compiler also 
incorporates ./mysource/model2_mm/ja.txt and ./mysource/model2_mm/de.txt into 
model2's .dat file.


If you do not include the --l10nsrc and --locales options, dynmodel will not look for any 
localization .txt files, and the .dat file for the model will only support the native language 
of the .mdl file.
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Pragmas
Pragmas can be used in dynamic model files to convey SNMP MIB qualities, and other 
directives, to the dynamic model compiler. Table 4 on page 85 lists the available pragmas.


Table 4  Pragmas used in dynamic modeling


Pragma Description


#pragma DotNotation Specifies that an SNMP instrumented attribute is to be 
converted from dotted notation when retrieved from an SNMP 
agent.


#pragma HexNotation Specifies that an SNMP instrumented attribute is to be 
converted from hex notation when retrieved from an SNMP 
agent.


#pragma Local Operation Locks only the object on which the operation is invoked. 
Normally, the dynamic model compiler generates code so that 
invoking an operation implicitly locks the entire repository.


#pragma ObjectID Appears before an instrumented attribute declaration of type 
string whose value is the OID of an SNMP device. This pragma 
tells the repository to convert the OID type returned by the 
SNMP agent into a MODEL string.


#pragma Uses Propagation Must appear before the attribute declaration to which it 
applies. This pragma tells the dynamic model compiler that 
access to this attribute may require access to other repository 
instances. Use this pragma before any attribute that can be 
refined as propagated or as computed with an expression that 
refers to other propagated attributes. This pragma locks the 
entire repository, however, the lock type (read/write) will be 
according to the type of operation called on the attribute. For 
example, if you are setting the value of an attribute, it will be a 
write lock.


#pragma WrapCounter Specifies that an SNMP instrumented attribute is to be treated 
as a wrapping counter, which affects comparisons of previous 
and current values.

Pragmas 85







The dynmodel Command Syntax and Options

86 EMC Smarts Foundation Dynamic Modeling Tutorial







APPENDIX C
Methods of Creating Classes and Populating 
Attributes


This appendix consists of the following sections:


◆ Overview.................................................................................................................  88
◆ Using dmctl.............................................................................................................  88
◆ Populating attributes by using an EMC Smarts API...................................................  91
◆ Discovery customization .........................................................................................  92

Methods of Creating Classes and Populating Attributes 87







Methods of Creating Classes and Populating Attributes

Overview
For new classes that are added by dynamic modeling, instances of the class must be 
discovered and added to the repository. In addition, new attributes need to be populated 
with values.


There are several methods that may be used to create instances of new classes or to 
populate values of new attributes:


◆ The dmctl command


◆ Text file accessed by one of the EMC Smarts APIs (PERL, C, Java)


◆ Adapter Scripting Language (ASL) scripts


◆ Working with scripts that are invoked as part of the postprocessing phase of the 
discovery mechanism


Using dmctl
The dmctl command is a command line tool for interacting with a Manager. It may be used 
to create instances of new classes or manually populate attributes in a Manager. It can 
either execute commands typed at the command line, execute commands read from a 
batch file, or interactively read commands that the you type.


If the Global Manager is already running, and you use dmctl to modify class properties 
that it subscribes to, you need to re-synchronize the topology. “Synchronizing topology 
changes with the Global Manager” on page 91 provides additional information.


Command-line mode


To run dmctl in command-line mode, connect to the Manager and enter the command by 
using the following syntax:


BASEDIR/smarts/bin/dmctl -s <managername> [--broker=<host>:<port>] 
<commandname> <commandparams>


where:


◆ <managername> is the name of the Manager.


◆ <host> is the host on which the Broker resides.


◆ <port> is the port on the host from which the Broker can be accessed.


◆ <commandname> is the name of the command.


◆ <commandparams> is the list of the parameters for the command.


The --broker option is optional. The default value is localhost:426.
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The following command starts dmctl interacting with the TEST Manager and creates an 
instance of the SM_Printer class, named HP_Printer1:


BASEDIR/smarts/bin/dmctl -s TEST create SM_Printer::HP_Printer1


You can also use dmctl to verify that a class has been added. For example:


BASEDIR/smarts/bin/dmctl -n TEST_IP getInstances <classname>


where <classname> is the name of the class that you want to verify.


If the class is not loaded, dmctl will display output similar to:


MR-E-CLASS_NOT_FOUND_EX-Cannot find class '<classname>'


If the class has been added, dmctl will output a (possibly empty) list of instances.


Interactively


To run dmctl interactively, connect to the Manager as follows:


BASEDIR/smarts/bin/dmctl -s <managername> [--broker=<host>:<port>]


where:


◆ <managername> is the name of the Manager.


◆ <host> is the host on which the Broker resides.


◆ <port> is the port on the host from which the Broker can be accessed.


The --broker option is optional. The default value is localhost:426.


The following command starts dmctl interacting with the TEST Manager that is registered 
with the Broker that is running on the local host and port 426. At the prompts, type the 
username and password.


BASEDIR/smarts/bin/dmctl -s TEST --broker=localhost:426


The output appears similar to the following:


>dmctl -s TEST --broker=localhost:426
Server TEST User: admin
admin’s Password: XXXXXXX
Domain Manager Control Program (v9.0.0.1) -- Type ‘help’ for a


list of commands.
Attached to ‘TEST’
dmctl>


Once you are attached to the Manager, use the create command to create an instance of a 
class:


create <classname>::<instancename>


where:


◆ <classname> is the name of the class.


◆ <instancename> is the name of the instance of the class.
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For example, enter the following command to create an instance of the SM_Printer class, 
named HP_Printer1:


dmctl>create SM_Printer::HP_Printer1


The getClasses command lists all of the classes in the repository.


You can also populate the value of an attribute by using the put command:


put <classname>::<instancename>::<propertyname> <value>


where:


◆ <classname> is the name of the class.


◆ <instancename> is the name of the instance of the class.


◆ <propertyname> is the name of the property in the class instance.


◆ <value> is the value of the property.


For example, enter the following command to populate the value of the SM_SerialNumber 
attribute associated with router-1.mynet.com (an instance of the Router class):


dmctl>put Router::router-1.mynet.com::SM_SerialNumber 123456abc


The getProperties command lists all of the properties for a class. The syntax is 
getProperties <class>.


Batch mode


The dmctl command may also be run in batch mode by passing it a filename. The batch file 
is created by using a text editor and consists of a series of dmctl commands, with one 
command per line.


The following batch file creates two instances of the Printer class, and sets the value of the 
SM_SerialNumber attribute for an instance of the Router class:


create SM_Printer::HP_Printer1
create SM_Printer::HP_Printer2
put Router::lab-gw::SM_SerialNumber 123456abc


Before running dmctl in batch mode, change the directory to the location of the batch file. 
The following example runs dmctl in batch mode:


BASEDIR/smarts/bin/dmctl --server=TEST_IP --broker=localhost:426 
--file=test_dmctl_batch.txt
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Synchronizing topology changes with the Global Manager


If the Global Manager is already running, and you modify class properties that it 
subscribes to, you need to resynchronize the topology in order for Global Manager to 
reflect the changes. From the command line, enter the following command:


BASEDIR/smarts/bin/dmctl -s <GlobalManagername> invoke 
GA_Driver::<managername>_Topo-Driver start▲


where:


◆ <GlobalManagername> is the name of the Global Manager.


◆ <managername> is the name of the underlying Manager that is being synchronized.


For example:


BASEDIR/smarts/bin/dmctl -s TEST_SA invoke 
GA_Driver::TEST_IP_Topo-Driver start


Populating attributes by using an EMC Smarts API


PERL API


The following is an example of a PERL script that can be used to populate the value of the 
SM_SerialNumber attribute in the Router class. The EMC Smarts Perl Reference Guide 
provides additional information.


use InCharge::session;


#Establish a connection to the EMC Smarts Server
$session=InCharge::session->new(server=>"TEST_EX2",


broker =>"localhost:426",
user=>"admin",
password=>"ad1");


# Create a handle to the object router-1.mynet.com
$deviceHandle=$session->object("Router","router-1.mynet.com");


# Retrieve value of current Serial Number
$currentSerial=$deviceHandle->{SM_SerialNumber};
print "Current Serial Number: $currentSerial \n";


#Assign a value to the attribute SM_SerialNumber of device 
router-1.mynet.com


$deviceHandle->{SM_SerialNumber}="123456abc";


# Print the new value
print "New Serial is: $deviceHandle->{SM_SerialNumber}";
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ASL


The following is an example of an ASL script that can be used to populate the value of the 
SM_SerialNumber attribute in the Router class. The EMC Smarts ASL Reference Guide 
provides additional information.


START{
 ..eol
 }
 do
 {
 /* Retrieve existing value */
 objHandle=object("Router","router-1.mynet.com");


 print("Current serial: ".objHandle->SM_SerialNumber);
 
 /* Assign a new value */


 objHandle->SM_SerialNumber="123456abc";
 print("New serial: ".objHandle->SM_SerialNumber);


  
 stop();


 }


Discovery customization
This example populates the value of SM_SerialNumber (an attribute in the Router class) 
by querying a MIB. The postprocessing scripts can be used to query a MIB during 
discovery.


First, a driver is created that sets up the process of querying the MIB for the value of 
SM_SerialNumber. A driver is an instance of the GA_Driver class, and in this example it is 
defined in an import file. The import file is loaded into the test IP Manager when it is 
started with the sm_server command.


During a discovery, the custom-end-system.asl script is automatically run for each device 
after Phase III (discovery probing). Additional rules are added to this file. Within these 
rules, if the object is a router, it launches the driver that was created when the import file 
was read into memory. The driver executes and retrieves the values in the appropriate OID. 
The results are then forwarded to an ASL script that parses the input and populates the 
value of the SM_SerialNumber attribute.


This process is summarized in Figure 15 on page 93.
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Figure 15  Using the discovery postprocessing mechanism


Creating the driver


First, you create a driver that sets up the process of querying the MIB for the value of 
SM_SerialNumber.


A driver is an instance of the GA_Driver class, and is composed of three parts:


◆ Front End — The source of the input (defined by the ReadsInputFrom attribute of the 
GA_Driver class).


◆ Rule Set — The ASL script that parses through the input string to determine the values 
of the attributes (defined by the ReadsRulesFrom attribute of the GA_Driver class).


◆ Back End — The repository where the attribute values that are parsed from the input 
string are stored.


In this example, the back end is the Manager that is started with the sm_server command 
and loads the import file. The value for the root OID in this example is for a Cisco router, 
Cisco chassis-id MIB (3).


DISCOVERY_serialNumber.import custom-end-system.asl


1


The import file is loaded into the Manager 
memory at runtime. An instance of 
GA_Driver is created that defines the input 
source, how the input is parsed, and which 
repository the attribute value is stored in.


This discovery postprocessing 
script is executed during the 
discovery process.


2


3


This discovery postprocessing script 
invokes the GA_Driver that was loaded into 
memory when the Manager was started.


The GA_Driver performs an SNMPWalk to 
retrieve the value from the MIB


4


The input that is retrieved is parsed by 
this ASL script (defined by the GA_Driver) 
and assigned to the appropriate instance 
and attribute.


5dynmodel-sn.asl
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To create an import file:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to create a new import file named 
DISCOVERY_serialNumber.import:


sm_edit --create conf/discovery/DISCOVERY_serialNumber.import


2. Add the following lines to the DISCOVERY_serialNumber.import file:


GA_Driver::DynModel-SerialNumber-Driver {


ReadsInputFrom = SNMP_WalkFE::DynModel-SN-FrontEnd
{


retries =5
rootOIDs = {


{ 10, ".1.3.6.1.4.1.9.3.6.3" }
}
trace=FALSE


}


ReadsRulesFrom = GA_RuleSet::DynModel-SN-RuleSet
{ fileName = "discovery/dynmodel-sn.asl"


trace=FALSE}


waitForCompletion =TRUE
}


3. Save and close the file.


The newly created DISCOVERY_serialNumber.import file is saved to the 
BASEDIR/smarts/local/conf/discovery directory.


In this import file, an instance of the GA_Driver class is created, named 
DynModel-SerialNumber-Driver. Because an OID is queried for its value, a SNMP_WalkFE 
front end is used. The SNMP_WalkFE instance, DynModel-SN-FrontEnd, does the 
following:


◆ Retrieves all of the MIB objects under a set of root OIDs.


◆ Converts the values to ASCII and markers.


◆ Passes them to the ASL file that is defined to parse the input.


In this import file, the ASL file is defined by the ReadRulesFrom attribute as 
discovery/dynmodel-sn.asl.
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Editing custom-end-system.asl


During a discovery, the custom-end-system.asl script is automatically run for each device 
after Phase III (discovery probing). At the end of the custom-end-system.asl script is a 
section where you can add your own processing for each device, as shown in Figure 16 on 
page 95.


Figure 16  Modifying custom-end-system.asl


To add custom processing:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to open the custom-end-system.asl file:


sm_edit rules/discovery/custom/custom-end-system.asl


2. Just after Add processing rules here in the START rule, add the following lines:


/* Check first if the object is a router since you have only added
* serial number of the router class */


if (nodeObj->CreationClassName =="Router")
{


/* Setup a handle to the internal GA_Driver's
GA_Parameters instance for custom-end-system.asl */


  cesObj=this->findMyParameters();
    


/* This statement creates the object handle to the
* driver defined in our import file
* DISCOVERY_serialNumber.import. */


DynModelSerialNumberDriverObj = 
object("DynModel-SerialNumber-Driver");


/* Now you kick off the GA _Driver that you have defined
* in the import file whose purpose is to poll the device
* for some MIB values and return it.   You start the driver
* by calling the operation startWithParamters and pass as an
* argument the parameters that are available through cesOBJ.


  *


START {
    /*
     * Add Parsing rules here.
     */
    .. eol
} do {
    /*
     * Add processing rules here.
     */


    stop();
}


New processing rules are added 
here.
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  * Note, since the driver in the import file uses
* SNMPWalkFE as the frontend, the results from this
* front end are in the form of OID|Value
* for example, a sample output is: 
* .1.3.6.1.2.1.25.1.1.0|6297154|;  
* therefore the ASL script dynmodel-sn.asl
* defined by the driver in the import file has to
* parse the output in this format.
*/


print("Starting DynModel-SerialNumber-Driver...");
DynModelSerialNumberDriverObj->startWithParameters(cesObj);


}


3. Save and close the file.


The modified version of the custom-end-system.asl file is saved to the 
BASEDIR/smarts/local/rules/discovery/custom directory.


Creating the script to parse the value of SM_SerialNumber


This script parses the results of the SNMPWalk to retrieve the value of SM_SerialNumber.


To create the script:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to create a new ASL file named dynmodel-sn.asl:


sm_edit --create rules/discovery/dynmodel-sn.asl


2. Add the following lines to the dynmodel-sn.asl file:


/* Create a handle to the SNMP Agent object */
agentObj=object(AgentName);


/* Test that the results are not null */
if (agentObj->isNull()  ) {


print("***********Error in dynmodelsn.asl********");
stop();
}


/* DEBUG= TRUE; */


/* Get a handle to the actual device by using the getSystem
operation available through the agent object handle */
nodeObj=agentObj->getSystem();


print("NODE:".nodeObj->DisplayClassName);


START{
SERIAL 


}


/* fs is need as field separators in this parsing.*/


/* This OID matches what was defined in the import file */


serialNumberOID {
".1.3.6.1.4.1.9.3.6.3"


}
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SERIAL{
oid:{ serialNumberOID.".".integer } fs
serial:word fs
}


do{
/* As the snmpwalk returns a value without knowing the
type, you need to use hexToString to convert the
 * result from hex to ASCII string */


serial=hexToString(serial);


/* Assign the results to the new SM_SerialNumber
attribute */
nodeObj->SM_SerialNumber=serial;


stop();
}


3. Save and close the file.


The newly created dynmodel-sn.asl file is saved to the 
BASEDIR/smarts/local/rules/discovery directory.


Restarting the IP Manager


Once the driver has been created, and the custom-end-system.asl and dynmodel-sn.asl 
files have been edited, the IP Manager needs to be restarted.


To restart the IP Manager and reload the compiled dynamic model file into the IP Manager:


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to stop the test IP Manager:


dmquit --force --server=TEST_IP


2. Enter the following command to start the test IP Manager and reload the compiled 
dynamic model file:


sm_server -n TEST_IP -c icf --broker=localhost:426 
--bootstrap=bootstrap-am.conf --output --dynamic


The startup code uses bootstrap-am.conf as the bootstrap file for the test IP Manager. 
The startup code also registers the test IP Manager as TEST_IP with the Broker that is 
running on port 426 of the local host. Substitute the bootstrap file and the Broker 
location with your bootstrap file and Broker location.
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Updating the Global Manager

Loading the dynamic model enhancements
If the new topology needs to be accessible by the Global Manager, then the dynamic 
model files must be compiled and loaded into the Global Manager. In addition, the Global 
Manager configuration file must be modified to subscribe to new events.


To compile and load the dynamic model enhancements into the Global Manager:


1. Copy the appropriate dynamic model files (.mdl files) to the Service Assurance 
Manager’s BASEDIR/smarts/local/model directory.


2. Remove any problems or events from the dynamic model files.


3. Enter the following command to change to the BASEDIR/smarts/local/model directory 
in the Service Assurance Manager installation area:


cd BASEDIR/smarts/local/model


4. Compile the dynamic model files. For example, from the BASEDIR/smarts/local/model 
directory, enter the following command to compile Example2.mdl:


BASEDIR/smarts/bin/dynmodel Example2.mdl


If the compilation is successful, the dynmodel command does not produce any output 
to the command-line console. In addition, the following files are created in the 
BASEDIR/smarts/local/model directory:


• Example2.ldm


• Example2_mmbe.dat


• Example2_mmle.dat


• Example2_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model 
directory:


• Example2_mm


5. Copy the dynamic model string files to the SM_SITEMOD/l10n directory. Using the 
compilation of Example2.mdl as an example, from the BASEDIR/smarts/local/model 
directory, copy the following files to the SM_SITEMOD/l10n directory:


• Example2_mmbe.dat


• Example2_mmle.dat


6. Go to the BASEDIR/smarts/bin directory in the Service Assurance Manager installation 
area and enter the following command to load the compiled dynamic model files into 
the Global Manager:


sm_server -n TEST_SA -c ics --broker=localhost:426 --output 
--dynamic
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Transferring topology and events
In the Service Assurance Manager installation area, the ics-default.xml file in the 
BASEDIR/smarts/conf/ics directory is the configuration file for the Global Manager. This 
file designates which DXA file is used to transfer events and topology from a particular 
Manager to the Global Manager. The DXA files are also located in the 
BASEDIR/smarts/conf/ics directory.


The ics-default.xml file contains the following sections for the IP Manager and indicates 
the DXA file for the IP Manager:


<domaintype
    name="INCHARGE-AM-SUITE"
    dxaConfFile="dxa-conn.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for INCHARGE-AM-SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
    <domainname>INCHARGE-AM</domainname>
</domaintype>


<domain name="INCHARGE-AM" enable="True"
    domaintypename="INCHARGE-AM-SUITE">
    <description>AM analysis domain</description>
</domain>


<domaintype
    name="INCHARGE-AM-PM-SUITE"
    dxaConfFile="dxa-conn-perf.conf"
    MinimumCertainty="0.01"
    SmoothingInterval="65">
    <description>Type for InCharge AM PM SUITE</description>
    <hook enable="False">ics/dxa-sample-hook.asl</hook>
</domaintype>


For the example in Exercise 2, because the test IP Manager was started as an IP Availability 
Manager, the ics-default.xml file designates dxa-conn.conf for the IP Manager.


Transferring topology


The first section of the DXA configuration file provides a listing of what classes, and 
attributes of those classes, will be transferred from the Manager to the Global Manager. If 
an attribute has been added to an existing ICIM class, and you want that attribute to 
appear in the Global Manager, then the class and attribute must be added to this listing.


You use the sm_edit utility to edit the DXA configuration file.
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For the example in Exercise 2, you use sm_edit to open the dxa-conn.conf file and add 
following two lines for the Router class (shown in bold) just before the entry for the 
ICIM_UnitaryComputerSystem:


# Remote Name of Class/Property           Mapped Name of Class/Property
server INCHARGE-AM


class Router
attr SM_SerialNumber


class   ICIM_UnitaryComputerSystem              Node
attr    Certification
attr    DisplayName
attr    Description
attr    Location
attr    Model
attr    PrimaryOwnerContact
attr    Type
attr    Vendor
rel     ConnectedVia


The addition of these two lines configures the Global Manager to subscribe to topology 
changes for the new SM_SerialNumber attribute of the Router class.


Transferring events


In order for the event that is generated by one of the IP Manager Managers to appear in the 
Global Manager, you need to edit the appropriate DXA configuration file to subscribe to 
the new event.


Events are based on expressions that are created based on attribute values. These 
attribute values are not polled for unless there is a subscription to the event that utilizes 
this value.


Subscribing to the event


Event and notification subscriptions in the Global Manager are configured within DXA 
configuration files by using the sub keyword. Patterns (regular expressions) separated by 
"::" match the class name, instance name, and event name in the Manager. 


The syntax is as follows:


sub <classPattern>::<instancePattern>::<eventPattern>/<modifiers>


where:


◆ <classPattern> is the pattern to match for the class name.


◆ <instancePattern> is the pattern to match for the name of the instance.


◆ <eventPattern> is the pattern to match for the name of the problem or event.


◆ <modifiers> can have the following values:


• p = problem


• e = event


• a = aggregates


• n = notifications

102 EMC Smarts Foundation Dynamic Modeling Tutorial







Updating the Global Manager

For example:


# Subscriptions
.
sub     ICIM_UnitaryComputerSystem::.*::DiscoveryError/e
sub     ICIM_UnitaryComputerSystem::.*::Unresponsive/e
.
To subscribe to a new event, add a line to the Subscriptions section. For example, to 
subscribe to a new IPForwardingOn event in the Host class, add the following line:


sub     Host::.*::IPForwardingOn/e


Setting the notification characteristics of the event


The next section of the DXA file defines the category and severity associated with each of 
the subscribed events:


#COMPUTER SYSTEMS
sev ICIM_ComputerSystem         Unresponsive    Operational   4
sev ICIM_UnitaryComputerSystem  DiscoveryError  Discovery     3
.


The syntax is:


sev <Class_Name> <Problem_Event_Name> <category> <severity_code>


where <severity_code> can have one of the following values:


◆ 1 = red, critical.


◆ 2 = orange, major.


◆ 3 - yellow, minor.


◆ 4 = cyan, unknown.


◆ 5 = green, normal.


The EMC Smarts IP Availability Manager documentation provides additional information 
concerning the valid values for <category>.


To set the category and severity of an event that you have created, add a new line to this 
section. For example, to define the severity and category for the new IPForwardingOn 
event, add the following line:


sev  Host IPForwardingOn  Operational   3
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Troubleshooting

Overview
This appendix describes common problems and their resolutions. The problems are 
categorized as:


◆ Compilation


Errors that may occur while compiling dynamic models.


◆ Loading


Errors that may occur while loading dynamic models into a Manager.


◆ Discovery


Errors that may occur when discovering new classes and populating attributes.
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Compilation errors


License server does not support compiling dynamic model files


The following error may be encountered when using the dynmodel compiler to compile 
dynamic model files. This error indicates that the license for the 
DK_DYN_MODEL_COMPILE feature has not been installed for this product.


BASEDIR\smarts\local\model>..\..\bin\dynmodel.exe Example2.mdl
[October 7, 2009 4:35:21 PM GMT+05:30 +950ms] t@3584 <Primary Thread>
LIC-E-ECHECKOUT-While attempting to check out license for 


DK_DYN_MODEL_COMPILE
LIC-EFLEXLM-FlexLM returned the following error message: "No such 


feature exists.


  . Feature:       DK_DYN_MODEL_COMPILE
  . License path: BASEDIR/smarts/local/conf/SAM80-IP81-all-temp90.lic
  . FLEXnet Licensing error:-5,357
  . For further information, refer to the FLEXnet Licensing End User 


Guide,
  . available at "www.macrovision.com"."


Solution


Install the SMA-SDM-C license. The EMC Smarts System Administration Guide provides 
additional information concerning license administration.


License server does not support compiling dynamic model files with problems and 
symptoms


The following error may be encountered when you are trying to compile dynamic model 
files that contain new problems or symptoms, or when you are trying to refine existing 
problems or symptoms. This error indicates that the SMA-SDM-C license has not been 
installed for this product.


BASEDIR\smarts\local\model>..\..\bin\dynmodel.exe Example3.mdl
[October 7, 2009 4:36:55 PM GMT+05:30 +254ms] t@5016 <Primary Thread>
LIC-E-ECHECKOUT-While attempting to check out license for 


DK_DYN_MODEL_PROBLEM
LIC-EFLEXLM-FlexLM returned the following error message: "No such 


feature exists.


  . Feature: DK_DYN_MODEL_PROBLEM
  . License path: BASEDIR/smarts/local/conf/SAM80-IP81-all-temp90.lic
  . FLEXnet Licensing error:-5,357
  . For further information, refer to the FLEXnet Licensing End User 


Guide,
  . available at "www.macrovision.com"."


Solution


Install the SMA-SDM-C license. The EMC Smarts System Administration Guide provides 
additional information concerning license administration.
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Loading errors
If you include the --output option with the sm_server command that is used to load 
dynamic models into a Manager, the following error messages are written to the server log 
file. Otherwise, the error messages are displayed on the command console.


Missing ICU files


The following error is encountered when the <modelname>_mmbe.dat and 
<modelname>_mmle.dat files have not been copied over to the SM_SITEMOD/l10n 
directory, after using use the dynmodel compiler to compile the dynamic model files.


[September 28, 2009 3:30:19 PM EDT +834ms] t@1119086912 LDM file 
processing #1


DYN-W-CANT_LOAD_DAT-Can't load ICU dat file 'Example1_mm' version 
4ac10ddd (pkgname 'Example1_mm4ac10ddd')


 CI-REGISTER_PKG-Error occurred while registering package 
'Example1_mm4ac10ddd'; in file 
"/work/blackcurrent/DMT-9.0.0.X/1189/smarts/clsapi/ci_i18n.c" at 
line 290


 I18N-EACCES_PKGFILE-Cannot access resource bundle file


ICU, for International Components for Unicode, is an Open Source set of C/C++ and Java 
libraries for Unicode and software internationalization support.


Solution


From the BASEDIR/smarts/local/model directory, copy the <modelname>_mmbe.dat and 
<modelname>_mmle.dat files to the SM_SITEMOD/l10n directory.


For example, copy the following files to the SM_SITEMOD/l10n directory:


◆ Example1_mmbe.dat


◆ Example1_mmle.dat


You must copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory every time that you use dynmodel to compile the 
<modelname>.mdl file.
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Duplicate OID entries


The following error is encountered when an OID is defined in more than one oid2type file. 
In this example, the printer OID was added to 
BASEDIR/smarts/conf/discovery/oid2type_Field.conf so that this printer would be added 
to the topology as an instance of SM_Printer. However, this OID is also defined in another 
oid2type file.


[November 3, 2009 12:35:08 PM EST +668ms] t@1150445888 InCharge Framework
ASL_MSG-*-ASLP-discovery/discovery-init.asl: 
DSCV-W-While loading oid2type files, the following entries are duplicate


[November 3, 2009 12:35:08 PM EST +668ms] t@1150445888 InCharge Framework
ASL_MSG-*-ASLP-discovery/discovery-init.asl: .1.3.6.1.4.1.11.2.3.9.1 in file: 


BASEDIR/smarts/local/conf/discovery/oid2type_Field.conf


Solution


Determine which oid2type_*.conf file contains the duplicate entry. Use the sm_edit utility 
to edit the oid2type file that contains the duplicate entry and comment out the entry. 


For example, the printer OID in this error is also defined in 
BASEDIR/smarts/conf/discovery/oid2type_Misc.conf. 


1. Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and enter 
the following command to open the oid2type_Misc.conf file:


sm_edit conf/discovery/oid2type_Misc.conf


2. Comment out the entry for the duplicate OID by preceding the lines with a pound sign 
(#):


#.1.3.6.1.4.1.11.2.3.9.1 {
# TYPE = Host
# VENDOR = HP
# CERTIFICATION = VALIDATED
#
#INSTRUMENTATION:
# Interface-Fault= MIB2
# Interface-Performance= MIB2
#}


3. Save and close the file.


The modified version of the oid2type_Misc.conf file is saved to the 
BASEDIR/smarts/local/conf/discovery directory.


4. Restart the Manager with the --dynamic option.
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Manager cannot restore topology


An error, similar to the following, is encountered when you try to start a Manager


[November 3, 2009 12:11:00 PM EST +288ms] t@1141098816 InCharge Framework
ICF-E-EINIT-While initializing the InCharge application
 ICF-ERESTOREREPOS-While attempting to restore topology from file 


BASEDIR/smarts/local/repos/icf/TEST_IP.rps
 MR-CANTCREATE_INSTANCE-'SM_Printer::CAXTON' could not be created.  ; in file 


"/work/blackcurrent/DMT-9.0.0.X/1201/smarts/local/repos/mr/dyn_acc.c" at line 
2829


 MR-CLASS_NOT_FOUND-Class of given name 'SM_Printer' not found; in file 
"/work/blackcurrent/DMT-9.0.0.X/1201/smarts/local/repos/mr/dyn_acc.c" at line 
1709


[November 3, 2009 12:11:00 PM EST +430ms] t@1141098816 InCharge Framework
SVIF-N-SHUTDOWN-Shutting down...


This error is occurring because you have an instance of a class in the repository, but the 
class is not defined in the data model of the Manager. Similar errors occur for attributes, 
events, operations, problems, symptoms, or aggregates that are in the repository, but not 
defined in the data model of the Manager.


For example, a dynamic model file was previously loaded into the Manager. The dynamic 
model file added a new class called, SM_Printer. An instance of the SM_Printer class was 
discovered and added to the repository of the Manager.


Now, when you invoke the sm_server command the appropriate dynamic model file must 
be in the proper directory. The directory is determined by whether or not you are including 
the --dynamic option on the sm_server command line. If you are not loading the dynamic 
model enhancements into the Manager’s data model, the SM_Printer class does not exist 
in the Manager’s data model. The instance of SM_Printer still exists in the repository, and 
the system tries to restore the instance of SM_Printer that was previously discovered. 
However, the class does not exist.


Solution


If you want the dynamic model enhancements and the previously discovered topology to 
be restored in the Manager, then place your dynamic model in the appropriate directory. 
The directory is based on your use of the --dynamic option when you invoke sm_server.


Including the --dynamic option on the command line when you start up a Manager loads 
all of the .ldm files in the following directories:


◆ BASEDIR/smarts/local/model 


◆ BASEDIR/smarts/local/model/<config>


where <config> refers to the configuration directory that is specified on the command line 
when the Manager is started.


If you start a Manager without the --dynamic option, only the .ldm files in the following 
directory will be loaded:


◆ BASEDIR/smarts/local/model/<config>


where <config> refers to the configuration directory that is specified on the command line 
when the Manager is started.
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If you want to discard the dynamic model enhancements, including any topology changes 
that were discovered for the dynamic model enhancements, invoke the sm_server 
command with the --ignore-restore-errors option:


BASEDIR/smarts/bin/sm_server -n TEST -c icf --broker=localhost:426 
--bootstrap=bootstrap-am.conf --ignore-restore-errors


Unable to open <ldmfilename>


The .ldm file, <ldmfilename>, cannot be opened by the Manager from the 
BASEDIR/smarts/local/model directory.


Solution


Verify that <ldmfilename> has the correct read permissions. This error should be fairly rare 
because most Managers are started by root. They have administrative privileges.


DYN-E-CLASS_NAME_ALREADY_EXIST


The name of a class that is declared in the .mdl source file, at the given line number, 
conflicts with an existing class name in the configuration that has already been loaded.


Solution


You must choose a different class name:


1. Edit the .mdl file.


2. Run dynmodel.


3. Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory.


4. Restart the Manager with the --dynamic option.


DYN-E-STRUCT_NAME_ALREADY_EXISTS


The name of a structure that is declared in the .mdl source file, at the given line number, 
conflicts with an existing structure name in the configuration that has already been 
loaded.


Solution


You must choose a different structure name.


1. Edit the .mdl file.


2. Run dynmodel.


3. Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory.


4. Restart the Manager with the --dynamic option.

Loading errors 111







Troubleshooting

DYN-E-ENUMERATION_NAME_ALREADY_EXISTS


The name of an enumeration that is declared in the .mdl source file, at the given line 
number, conflicts with an existing enumeration name in the configuration that has already 
been loaded.


Solution


You must choose a different enumeration name. 


1. Edit the .mdl file.


2. Run dynmodel.


3. Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory.


4. Restart the Manager with the --dynamic option.


DYN-E-ATTRIBUTE_NAME_ALREADY_EXISTS


The name of an attribute that is declared in the .mdl source file, at the given line number, 
conflicts with an existing attribute name in the configuration that has already been 
loaded.


Solution


You must choose a different attribute name.


1. Edit the .mdl file.


2. Run dynmodel.


3. Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory.


4. Restart the Manager with the --dynamic option.


DYN-E-EVENT_NAME_ALREADY_EXISTS


The name of an event that is declared in the .mdl source file, at the given line number, 
conflicts with an existing name in the configuration that has already been loaded.


Solution


You must choose a different event name.


1. Edit the .mdl file.


2. Run dynmodel.


3. Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the 
SM_SITEMOD/l10n directory.


4. Restart the Manager with the --dynamic option.
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DYN-E-NO_AGGREG_OP


A property that is propagated across a relationshipset needs an aggregation operator. The 
Dynamic MODEL compiler cannot tell whether a name is a relation or a relationshipset 
until runtime, so it does not require an aggregation operator. This message is followed by 
the class name, propagated property name, and relationshipset name.


<classname>:<property>:<relationshipset>


Solution


Find the .mdl source file that declares the propagated property and add the aggregation 
operator to the propagated property declaration.


Discovery errors


Class property changes do not appear in the Global Manager


You modified class properties, such as attribute values, in the underlying Manager, but 
you do not see those changes reflected in the Global Manager. The problem is that the 
topology in the underlying Manager and the Global Manager are no longer synchronized. 


Solution


You can synchronize the topology between an underlying Manager and the Global 
Manager by:


◆ Initiating a discovery.


◆ Using the dmctl command. “Synchronizing topology changes with the Global 
Manager” on page 91 provides additional information.


Running the ASL scripts


ASL-ERROR_PUT


The following error usually occurs when there is a misspelling or missing capital letters. 
For example, the following error was generated because filename was used instead of 
fileName:


# ASL-ERROR_PUT-While attempting to set property 'filename' of object
#     'GA_RuleSet::DynModel-OS-RuleSet'
#CI-EGENERIC-filename
# MR-PROPERTY_NOT_FOUND-Specified property not found in class
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ASL-ERROR_CREATE


The following error was generated due to a syntax error. For example, GA_RulesSet was 
used instead of the correct GA_RulesSet


# ASL-ERROR_CREATE-While attempting to create the object
#    'GA_RulesSet::DynModel-OS-RuleSet'
# CI-EGENERIC-GA_RulesSet
# MR-CLASS_NOT_FOUND-Class of given name not found
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The ICIM Reference
Managed Object Definition Language (MODEL) is integral to the EMC Smarts application 
development process. Its purpose is to render the schema and semantics of the EMC 
Smarts ICIM Reference specification. MODEL is compiled, producing data model libraries 
that describe the model. These libraries are loaded by a Manager and are operated on by 
EMC Smarts applications. For an EMC Smarts application, all of the classes, relationships, 
attributes, events, and so on are defined at compile time.


Dynamic Modeling is an extension of the existing MODEL language, building on the same 
core implementation and principles. It enables you to add new classes, and refine classes 
that are already defined in the data model libraries, at runtime when the Dynamic Models 
are loaded into an Manager.


The ICIM represents logical and physical components of managed systems across 
networked technology domains. By using an object-oriented representation, it is a 
conceptual view of the problem domain that provides Managers with semantics that 
support root-cause analysis.


EMC Smarts models are object-oriented.


◆ The notion of class provides a mechanism for encapsulating a managed element’s 
state or properties. Two semantic properties that are especially useful for root-cause 
analysis are relationship and event. Relationship expresses the correlation 
dependencies between classes. Events are those actions that cause transitions within 
the model.


◆ The object-oriented inheritance construct allows new classes to be derived from 
existing classes. The construct is a mechanism for specialization within the model, 
while preserving model semantics for the new class. New classes inherit not only the 
properties of the base class but its semantics as well.


◆ The object-oriented instance construct provides a mechanism for separating the 
model representation of a managed element from its actual implementation. This 
construct supports desirable modeling goals, where the model is conceptual and 
generalized, and independent of any particular implementation within the problem 
domain. With respect to ICIM, this means that the correlation model, represented by 
classes, is separated from the domain topology, represented by instances. So ICIM is 
a true model, in the sense that it can accurately conceptualize, or model, particular 
implementations without prior knowledge.
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Representing systems with MODEL
An ICIM class is actually defined by describing the class as an interface. This behavior is 
consistent with the programming practice of information hiding, where program elements 
are known and fully described by their interface and not by their implementation. To 
accomplish this end, a language is needed to establish syntactic rules for the interface 
itself and for programs that use the interface. For EMC Smarts, the Managed Object 
Definition Language (MODEL) was developed to describe ICIM classes.


The MODEL is a textual notation with a syntax that supports a common way of 
representing heterogeneous elements. The MODEL also enables tools, such as compilers 
and analysis programs, to be applied to the model, and defines semantic constructs that 
support the correlation model.


The following example shows a simple MODEL interface declaration:


interface MyExample : ICIM_ManagedSystemElement
“An interface to generate an event when value > threshold.”
{ 


attribute int MyValue = 0; 


attribute int MyThreshold = 50; 


event MyValueOverThreshold = MyValue > MyThreshold; 
export MyValueOverThreshold; 


}; 


The interface has a name identifier, MyExample, and inherits from a base class, 
ICIM_ManagedSystemElement. The interface may also include a comment that describes 
the interface.


Constructs that support the correlation model include:


◆ Typed attributes


◆ The attribute int


◆ Events that are computed by and exported from the interface: event and export


The MODEL compiler generates the C++ source code that is needed to access an 
interface’s attributes and to monitor the event conditions and generate an event 
notification. The generated source code is linked as an executable model library, which is 
loaded by a Manager whose analysis programs operate on the loaded model.


Add your model source file to the makefile that is used to build the system. Executing the 
appropriate makefile invokes the model compiler for your model file, producing C++ 
source code and header files. The C++ compiler is then called to produce an object file for 
linking. (The filename extension of the executable model is specific to your operating 
system.) Your model object file is linked with EMC Smarts model libraries and produces an 
executable model of the domain, which includes your application.


To execute your application, start a Manager by using sm_server. Specify the model 
executable to load on the sm_server command line.
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Differences between MODEL and Dynamic Model
EMC Smarts ICIM models are typically compiled into shared libraries, with their interfaces 
exported as C++ header files. Applications, such as the IP Manager and the Global 
Manager, that use the MODEL libraries link to the libraries at compile time.


The binding of applications to models at compile time imposes a limitation on 
applications because the applications are not aware of all properties of an interface at 
compile time. This limitation occurs because ICIM models are intended to be general 
enough to support a large customer base.


A particular customer, for whom more interface properties would be useful, must, 
however, limit an application’s programs to only what is made available by the ICIM 
models.


Dynamic modeling is a step toward solving this problem. It allows delays in binding 
between the model and the applications that operate on the model. Instead of binding at 
compile time, as with the traditional MODEL, interfaces may now effectively be made 
known at runtime, when the interfaces are loaded into a Manager as a dynamic model.


Figure 17 on page 119 shows the differences between using MODEL and Dynamic Model.
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Figure 17  Simplified MODEL and Dynamic Model methodology comparison


The obvious differences between the process of creating a traditional model executable 
and creating a dynamic model executable is that intermediate C++ source code is not 
generated and the dynamic model is not linked into the system during the build phase. 
Instead, the dynamic model compiler is invoked to directly produce a file with a .ldm 
extension that can be loaded by a Manager. When the Manager is started, and the 
dynamic model is loaded, the existing model class dependencies and the new dynamic 
model class dependencies are resolved.
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Dynamic model files can be loaded when a Manager is started or after the Manager is 
already running.


Note the following:


◆ There are other files that are produced by the MODEL compiler and by the Dynamic 
Model compiler. Figure 17 on page 119 is a simplified view to highlight the major 
differences. A more detailed explanation of the MODEL compiler is available in the 
EMC Smarts MODEL Reference Guide .


◆ Although MODEL and Dynamic Model are used independently and involve different 
steps and tools, the dynamic model is fully derived from MODEL. Therefore, many of 
the concepts that apply to MODEL also apply to the dynamic model. Familiarity with 
the EMC Smarts MODEL Reference Guide  is useful when working with Dynamic Model.
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PREFACE


As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.


Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.


This document was accurate at publication time. Go to EMC Online Support 
(https://support.emc.com) to ensure that you are using the latest version of this 
document.


Purpose
This document describes the configuration and operation of the EMC Smarts XML Adapter 
and is intended for integrators using the EMC Smarts XML Adapter to exchange topological 
information between EMC Smarts and other applications.


Audience
This guide is intended for administrators who are responsible for deploying, installing, 
and configuring the Global Manager. IT managers who seek to understand the role of the 
Global Manager in the context of an EMC Smarts solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should 
also read the EMC Smarts Service Assurance Manager Deployment Guide and the EMC 
Smarts System Administration Guide Guide.
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EMC Smarts Service Assurance Manager installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed:


◆ For Windows, this location is: C:\InCharge\<product>.


On Windows operating systems, this product is, by default, installed to: 
C:\InCharge\SAM\smarts. This location is referred to as BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something other than C:\InCharge 
(on Windows), but you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure of EMC Smarts software.


EMC Smarts Service Assurance Manager
The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager (Global Manager), includes Business Impact Manager 
(BIM) and Failover System


◆ Global Console


◆ Business Dashboard


◆ Companion UI


◆ SAM Native Adapters:


• Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter, Script 
Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


• Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, 
sm_ems command-line interface)


• EMC Smarts Adapter for UIM/O


• XML Adapter
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Related documentation
In addition to this document, EMC Corporation provides a help system for command line 
programs as well as product documentation.


Help for command line programs


Descriptions of command line programs are available as HTML pages. The index.html file, 
which provides an index to the various commands, is located in the 
BASEDIR/smarts/doc/html/usage directory. 


EMC Smarts documentation


Readers of this guide may find the following related documentation helpful:


◆ Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


◆ EMC Smarts Common Information Model (ICIM) 1.11 Reference for Non-Service 
Assurance Manager Products


◆ EMC Smarts Common Information Model (ICIM) Reference for Service Assurance 
Manager


◆ EMC Smarts Foundation Documentation Portfolio


◆ EMC Smarts System Administration Guide


◆ EMC Smarts ASL Reference Guide


◆ EMC Smarts Perl Reference Guide


◆ EMC Smarts Dynamic Modeling Tutorial


◆ EMC Smarts MODEL Reference Guide


◆ FlexNet Publisher License Administration Guide


EMC Smarts Service Assurance Manager documentation


The following documents are relevant to users of the EMC Smarts Service Assurance 
Manager:


◆ EMC Smarts Service Assurance Manager Release Notes


◆ EMC Smarts Open Source License and Copyright Information


◆ EMC Smarts Service Assurance Manager Introduction


◆ EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, VoIP, and NPM Managers


◆ EMC Smarts Service Assurance Manager Deployment Guide


◆ EMC Smarts Service Assurance Manager Configuration Guide


◆ EMC Smarts Service Assurance Manager Operator Guide


◆ EMC Smarts Service Assurance Manager Dashboard Configuration Guide


◆ EMC Smarts Business Impact Manager User Guide


◆ EMC Smarts Failover System User Guide


◆ EMC Smarts Service Assurance Manager Notification Adapters User Guide


◆ EMC Smarts Service Assurance Manager Adapter Platform User Guide
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◆ EMC Smarts Adapter for Unified Infrastructure Manager/Operations Configuration 
Guide


◆ EMC Smarts XML Adapter User Guide


◆ EMC Smarts Notification Module User Guide


◆ EMC Smarts Service Assurance Manager Troubleshooting Guide


◆ EMC Smarts Companion UI Online Help


◆ EMC Smarts Companion UI Open Source License and Copyright Information for GPLv3 
as Included with a Distribution of SLES 11


◆ EMC Smarts Service Assurance Manager Documentation Portfolio


The EMC Smarts Documentation Catalog provides documentation resources for other 
EMC Smarts products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1. If the documentation is not accessible to all users of the EMC Smarts product, copy 
the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a 
shared drive on your LAN, so that operators and others can view the documentation.


2. To search throughout the documentation library, open the Acrobat Reader software:


a. Select Edit > Search, and type a word or phrase.


b. Select All PDF Documents in, in the Where would you like to search option, and 
type the pathname of the location where the PDF documents reside.


If you have more than one EMC Smarts product installed, you can set up cross-product 
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each 
product into this common documentation directory path.
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Conventions used in this document
EMC uses the following convention for special notices:


NOTICE is used to address practices not related to personal injury.


Typographical conventions


EMC uses the following type style conventions in this document:


Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)


Italic Use for full titles of publications referenced in text


Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options


Monospace italic Use for variables.


Monospace bold Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/). Users of the Windows operating 
systems should substitute back slashes (\) for forward slashes.


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as 
they appear in Windows. Under UNIX, the consoles appear with slight differences. For 
example, in views that display items in a tree hierarchy such as the Topology Browser, a 
plus sign appears for Windows and an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to EMC Smarts programs 
such as Domain Managers, Global Managers, and adapters.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:


techpubcomments@emc.com
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CHAPTER 1
Introduction 


This chapter describes the purpose of the EMC Smarts XML Adapter (XML Adapter) and the 
files that make up its framework and contains the following information:


◆ Purpose of the XML Adapter ....................................................................................... 16
◆ Framework description................................................................................................. 18
◆ Structure of the XML document .................................................................................. 20

Introduction 15







Introduction

Purpose of the XML Adapter
An adapter controls the communication of information between devices or applications 
and a Manager. An adapter normalizes topology and event information from sources other 
than EMC® Smarts®. Typical sources include SNMP traps or system log files. Once 
normalized to the ICIM data model, the information is transferred to a Manager (including 
either Service Assurance Global Manager or Domain Manager).


Adapters work with third-party applications in a variety of ways to import topology and 
event information and prepare it for use by the Global Manager. The XML Adapter is ideal 
for exchanging topology information with a system for which there is no native 
EMC Smarts adapter. The XML Adapter can import topology into a Global Manager or 
underlying domain as well as export from a Global Manager or Domain Manager. Using the 
XML Adapter, topology information can be exchanged between Global Managers or 
underlying domains. 


XML Adapter process


When importing topology into EMC Smarts, start with an XML document that complies 
with the ICIM/XML standard and represents any topological elements managed by 
EMC Smarts. The XML document is imported into the Manager using the XML Adapter and 
the objects are migrated into the repository of the Manager. Figure 1 on page 16 illustrates 
the XML Adapter import process.


Figure 1  EMC Smarts XML Adapter import process


The XML Adapter can import a large set of topology elements in one process or it can be 
used to make incremental updates to existing objects in the repository. 


InCharge XML Adapter


ASL File


Data Source
or 


InCharge Manager


XML file


InCharge Manager
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When exporting topology from EMC Smarts, the XML Adapter extracts topological 
information from the Manager and produces an ICIM/XML-compliant document. Figure 2 
on page 17 illustrates the export process for the XML Adapter.


Figure 2  EMC Smarts XML Adapter export process


The XML Adapter provides a structured method for transferring information in and out of a 
running Manager. Use it to perform these tasks, including:


◆ Adding or deleting objects


◆ Setting the value of attributes


◆ Inserting objects in or removing objects from relationships


InCharge XML Adapter


ASL File


InCharge Manager


XML file
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Framework description
This section includes the following information:


◆ ICIM/XML DTD specification


◆ ICIM/XML document


◆ Command-line interface (sm_xml)


◆ ASL script


ICIM/XML DTD specification


The Document Type Definition (DTD) defines the building blocks of the XML document 
structure. It provides a list of allowable elements that can be used in the XML file. XML 
tags are formally described in this document. The DTD is declared as an external 
document. 


Attributes are used to associate name-value pairs within elements. Attributes may appear 
only within open tags of the element. Attribute-list declarations in the DTD are used to 
define the set of attributes pertaining to a given element type or to provide default values 
for attributes.


The type of information associated with the source objects must be identical to the 
information associated with objects in the repository. For example, to import objects from 
an existing data source, ensure that the data source and the target repository database 
contain the same information in the same format, prior to importing. If the information 
models do not correspond exactly, you will lose data. The DTD specification is a guide to 
correctly map your data to objects to the repository. 


“ICIM/XML DTD specification” on page 30 contains detailed ICIM/SML DTD information.


ICIM/XML document


Each XML document has both a physical and a logical structure. Physically, the document 
is composed of units called entities. An entity may refer to other entities to cause their 
inclusion in the document. A document begins in a "root" or document entity and is 
structured with objects, attributes and relationships. Logically, the document is composed 
of declarations, elements, comments, character references, and processing instructions, 
all of which are indicated in the document by explicit markup. 


The XML DTD contains markup declarations that provide a grammar for the XML 
documents. 


Each XML document contains one or more elements, the boundaries of which are 
delimited by open and close tags. Each element has a type (object, attribute, or 
relationship) and may have a set of attribute specifications. Each attribute specification 
has a name and a value. 


Chapter 2, “ICIM XML Elements,” contains detailed information on the structure of the 
ICIM/XML document.
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Command-line interface (sm_xml) 


The sm_xml command line utility is used to perform the import and export functions to the 
Manager. The sm_xml file (sm_xml.exe on Windows) is found in BASEDIR/smarts/bin. This 
interface can receive information from the Manager and send the output to a file or to 
standard output. It can also import a file of defined objects into the repository. 


XML export ASL script


When exporting repository objects to XML, this adapter script extracts the EMC Smarts 
objects to be represented in the XML output file. This Adapter Scripting Language (ASL) 
file utilizes the Adapter Scripting Language in addition to some unique commands for 
extracting the objects into an XML output file. A sample file, xml-export-sample.asl, is 
located in BASEDIR/smarts/rules/xml-if.


Chapter 4, “Exporting EMC Smarts Information to XML,” contains detailed information on 
exporting EMC Smarts information to XML.
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Structure of the XML document
The basic building blocks of an XML document are elements, attributes, and values. "Tag" 
is a general term that can be used for elements and attributes. A relevant sample of the 
ICIM/XML DTD is provided with each of the following descriptions.


Element 


An element is a tag that is a container for subelements and attributes. For example, the 
object element contains defining information for the instance you are adding into the 
repository.


The root element, <icim>, is shown as the opening and closing tags for the entire file. For 
example, the ICIM/XML DTD allows you to import and export object, relationship, and 
attribute elements:


<!ELEMENT object ( attribute | relationship )* >


<!ELEMENT relationship ( object )* >


<!ELEMENT attribute (
        char | string | int | unsignedint | short |


 unsignedshort | long | unsignedlong | boolean | struct | float   
| double )* >


Attribute declaration (attribute list)


Attribute declarations, as defined in the ATTList of the DTD, expand the details of an 
element. All elements utilize a name declaration to identify it as well as a method 
declaration that instructs the adapter on whether to insert, update, or delete information 
about the element.


An attribute, as defined by the Attribute List in the DTD help identify the object instance. 
This should not be confused with an ICIM object attribute that describes the particular 
instance. For example:


<!ATTLIST object
        class     CDATA #IMPLIED
        name      CDATA #IMPLIED
        method    ( delete | update ) "update" >


<!ATTLIST relationship
        name      CDATA #REQUIRED
        method  ( insert | remove | put ) "put" >


Value 


The value setting of the attribute declaration is paired with the declaration in name=value 
groupings. The values define the properties of the element you are adding, modifying, or 
deleting in the repository. 


In the following example, the Object element is made up of an element start tag (<object>), 
attributes (Class, Name, and Method), values ("Application," "Banking," and "update"), 
and a close tag for the element (</Object>): 


<object class="Application" name="Banking" method="update" />
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Rules for a well-formed XML document


Follow these syntax rules when creating an XML document:


◆ Root element contains all other elements 


◆ Elements and subelements are properly nested:
<A><B></B></A> not <A><B></A></B>


◆ All elements have start and close tags:
<object>Router</object> as opposed to <object>Router


◆ Start and close tags should match cases:
<B>word</B> not <B>word</b>


◆ Attribute declaration values should be in single or double quotes:
<attribute name="Customer 1">  not 
<attribute name=Customer 1>

Structure of the XML document 21
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CHAPTER 2
ICIM XML Elements


This chapter describes the elements used in ICIM XML and the syntax required to use 
them properly. “ICIM/XML DTD specification” on page 30 includes a complete version of 
the ICIM/XML DTD.


This chapter contains the following information:


◆ Element declarations ..............................................................................................  24
◆ Attribute-list declarations........................................................................................  24
◆ Object elements......................................................................................................  26
◆ Attribute elements ..................................................................................................  27
◆ Relationship elements ............................................................................................  29
◆ ICIM/XML DTD specification ....................................................................................  30
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ICIM XML Elements

Element declarations
The XML document type declaration contains or points to markup declarations that 
provide a grammar for a class of documents. This grammar is known as a document type 
definition or DTD. 


Four elements are defined within the ICIM/XML document:


◆ ICIM Root


◆ Objects


◆ Attributes


◆ Relationships


For each element declaration, you may have a set of attribute declarations that can 
include the class, name, or method of the element.


The ICIM Root element is created when the XML document is generated. Create the 
remaining elements.


Attribute-list declarations
For each ICIM/XML element, there is an attribute-list declaration that defines values for 
that element.  Attribute-list declarations specify the name, datatype, and default value (if 
any) of each attribute associated with a given element type.  The attribute-list also defines 
whether the value is required or implied.  If the value is required, define it in the 
document.  If the value is implied, there is a default value for that attribute.


The syntax of the ATTLIST is defined as:


<!ATTLIST <element-name> <attribute-name> <attribute-type> 
default-value>


Class


The class attribute defines the ICIM objects with common properties, common behaviors, 
and similar relationships.  Examples of classes are Switches, Routers, Applications, 
Service Subscribers, and Service Offerings.  Any class already modelled and existing in 
your current repository is allowable in the XML document.


Name


This attribute identifies a unique name of the element or subelement displayed in the 
repository.
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Method


The method attribute is used to declare the specific topology change you want to make.   
In the following examples, the Service Offering named GE is being updated and deleted:


<object class="ServiceOffering" name="GE" method="update" />
<object class="ServiceOffering" name="GE" method="delete" />


Table 1 on page 25 identifies the methods associated with each element type.


A "put" associates a value or structure of values with an object. If a value already exists, it 
will be overwritten. An “insert” adds a value to a set of attributes if the attribute allows for 
multiple values. If the attribute can only have one value, then using the insert method will 
replace the existing single value. Propagated attributes, instrumented attributes, and 
computed attributes cannot be modified with the insert or put methods.


Table 1  Method descriptions for ICIM XML references


Element Method Description


<object> update Modifies the properties of an existing object or 
creates the object if it does not exist.


delete Removes an object from the repository.


<attribute> insert Adds a value to a set of attributes.


remove Removes an attribute from an object.


put Assigns a value to an attribute.


<relationship> insert Adds an object to a relationship.


remove Removes an object from a relationship.


put Assigns an object or set of objects to a 
relationship.
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Object elements
An <object> element identifies a repository object.


In the ICIM/XML DTD specification, the object element is declared as:


<!ELEMENT object (attribute | relationship)> 


This declares the EMC Smarts object element to be modified. Nested in this element will 
be subelements that define the attribute information associated with it. The subelement 
of the object element can be one or more ICIM attributes or ICIM relationships.


<Object> element attribute list declarations
An example of an <object> element attribute list declaration is:


<!ATTLIST object 
       class     CDATA #IMPLIED 


name      CDATA #IMPLIED
method    ( update | delete ) "update" >


Table 2 on page 26 identifies the attribute declarations for the <object> element. If the 
object you specify does not already exist in the repository, define the class of the instance 
to be created.


An object will have zero or more attributes or relationships within one declaration.


Table 2  Attribute-list declarations for the object element


XML attribute Description Possible value
Value 
required/implied


class The ICIM class of the 
object being declared.  
This can be any ICIM 
class name.


CDATA Implied
Default is MR_Object


name Name of the object 
instance.


CDATA Implied
No default value


method Specifies the desired 
topology change. You 
can delete or update 
an existing object. 
An update will create 
the object if it does not 
exist in the repository.


delete 
update


Implied
Default is "update"
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Attribute elements
An attribute element specifies a property present for a particular object element.  
Attributes expand the details of an object. For instance, DisplayName is an attribute of the 
element Application and sets how the instance will be identified in the Global Console.  An 
attribute declaration includes the attribute’s type and value.  The value describes the 
state of the instance. 


The attribute element must be nested within the object element.


<Attribute> element attribute-list declarations
For the <attribute> element, the ATTLIST is defined as:


<!ELEMENT attribute ( 
char    | string        | int     | unsignedint 
short   | unsignedshort | long    | unsignedlong  | 
boolean | struct        | float   | double        )* >


<!ATTLIST attribute 
name      CDATA #REQUIRED
method ( insert | remove | put ) "put" >


Table 3 on page 27 identifies the attribute list declarations for the <attribute> element.


For example, the following sample identifies an Application named App-BankingDataBase 
having a display name of Banking:


<object class="Application" name="APP-BankingDataBase">
<attribute name="DisplayName">


<string>Banking</string>
</attribute> 


</object>


In this example, the UtilizationThreshold attribute is set with an integer datatype:


<attribute name="UtilizationThreshold">
<int>75</int>


</attribute>


Table 3  Attribute-list declarations for the attribute element


XML attribute Description Possible value Value required/implied


name Name of the object 
instance.


CDATA Required


method Specifies the desired 
topology change.  You 
can create a new 
attribute, remove an 
existing attribute, or 
update (put) an existing 
attribute.


insert 
remove 
put


Implied
Default is "put"
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Applying multiple attributes to an object
Since an attribute element can have one or more values within one declaration, you must 
be able to apply values in multiples. If the target to be modified is a table, the <attribute> 
element may be modified using a <struct> tag to modify multiple values. A struct is a 
collection of different datatypes. It allows you to apply a set of values to an element (such 
as string, integer, boolean). For example, to add two properties of different types (string 
and unsignedshort) to the AgentInfoSet attribute, use the following syntax:


<attribute name="AgentInfoSet" method="insert">
<struct>


<string>public</string>
<unsignedshort>162</unsignedshort>


</struct>
</attribute>


If an object contains an attribute called IntegerList, which contains a list of three integers, 
this attribute can be set in the following way:


<attribute name="IntegerList">
<struct>


<int>4</int>
<int>8</int>
<int>9</int>


</struct>
</attribute>


If the attribute represents an IntegerList2, which has an unspecified number of integers, it 
can be imported in the following manner:


<attribute name="IntegerList2">
<struct><int>4</int></struct>
<struct><int>8</int></struct>
<struct><int>9</int></struct>


</attribute>
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Relationship elements
A relationship maps instances of one class to instances of the same or another class.  For 
each relationship, an inverse relationship may also exist that maps from the related class 
back to the originating class.  


The <relationship> element modifies a relationship.  Like the <attribute> element, 
<relationship> may be used to put, insert, or remove an object from a relationship.


<Relationship> element attribute list declarations
Am example of the <relationship> element is:


<!ELEMENT relationship ( object )* >
<!ATTLIST relationship 


name      CDATA #REQUIRED
method  ( insert | remove | put ) "put" >


Table 4 on page 29 identifies the attribute declarations available for the <relationship> 
element.


For example, to add the HostedBy relationship between the application Banking and the 
host BankingHost, use the following syntax:


<object class="Application" name="Banking">
<relationship name="HostedBy" method="put" />


<object class="Host" name="BankingHost" method="update" />
</relationship>


</object>


If multiple objects are specified when the method is "insert" (or "remove") then all are 
inserted (or removed).  The methods "put" and "insert" are equivalent if the relationship is 
a singleton.  The "remove" method may be used to clear a singleton relationship:


<relationship name="HostedBy" method="remove" />


A relationship can have zero or more objects associated with it within one declaration, 
meaning you may want to add a relationship even if you do not have a specific object to 
assign to it. To declare zero objects, put or insert the NULL object declaration:


<relationship name="HostedBy"> 
<object/>


</relationship>


Table 4  Attribute-list declarations for the relationship element


XML attribute Description Possible value Value required/implied


name Name of the object 
instance.


CDATA Required


method Specifies the desired 
topology change. You can 
create a new relationship, 
delete an existing 
relationship, or update an 
existing relationship.


insert 
remove 
put


IMPLIED
Default is "put"
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ICIM/XML DTD specification
The ICIM/XML DTD file is icim_xml.dtd and is in BASEDIR/smarts/rules/xml-if. The 
contents of this file cannot be modified. The icim_xml.dtd file contains the following: 


<!ELEMENT icim ( object )* >
<!ATTLIST icim source CDATA #IMPLIED >


<!ELEMENT object ( attribute | relationship )* >
<!ATTLIST object
        class     CDATA #IMPLIED
        name      CDATA #IMPLIED
        method    ( delete | update ) "update" >


<!ELEMENT relationship ( object )* >
<!ATTLIST relationship
        name      CDATA #REQUIRED
        method  ( insert | remove | put ) "put" >


<!ELEMENT attribute (
        char | string | int | unsignedint | short |


 unsignedshort | long | unsignedlong | boolean | struct | float   
| double )* >


<!ATTLIST attribute
        name      CDATA #REQUIRED
        method ( insert | remove | put ) "put" >


<!ELEMENT string          ( #PCDATA ) >
<!ELEMENT char            ( #PCDATA ) >
<!ELEMENT int             ( #PCDATA ) >
<!ELEMENT unsignedint     ( #PCDATA ) >
<!ELEMENT short           ( #PCDATA ) >
<!ELEMENT unsignedshort   ( #PCDATA ) >
<!ELEMENT long            ( #PCDATA ) >
<!ELEMENT unsignedlong    ( #PCDATA ) >
<!ELEMENT boolean         ( #PCDATA ) >
<!ELEMENT float           ( #PCDATA ) >
<!ELEMENT double          ( #PCDATA ) >
<!ELEMENT struct          ( 


char | string | int | unsignedint | short |
unsignedshort | long  | unsignedlong | boolean |
struct| float | double )* >
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CHAPTER 3
Building Topology in XML


This chapter explains how to use the ICIM XML elements to build the XML document for 
use in exchanging topology information with a Manager. It contains the following 
information:


◆ Overview.................................................................................................................  32
◆ Using XML for EMC Smarts ......................................................................................  32
◆ Adding and updating topology ................................................................................  32
◆ Removing topology .................................................................................................  36
◆ Datatypes ...............................................................................................................  37
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Building Topology in XML

Overview
The XML document is a database. The following actions can be controlled using XML:


◆ Add topology


◆ Update topology


◆ Delete topology


◆ Assign values to an attribute, relationship, or relationship set


◆ Insert and remove information in a table attribute or relationship set


Using XML for EMC Smarts
Working with objects in XML means you are creating, updating, and removing instances of 
classes in the Manager. Classes cannot be added to EMC Smarts using the XML Adapter; 
only add instances and relationships can be added to existing classes.   


This section contains XML excerpts to introduce the basic XML declarations to use to 
import topology changes. This set of examples is importing Business Impact Manager 
topology into the Service Assurance Manager. For some examples, a Services Map in the 
Global Console illustrates the results of the topology import.


Adding and updating topology
This section shows examples to represent new objects, relationships, and attributes in 
XML.


Adding objects


Importing instances requires creating objects in the XML file. Two ServiceSubscriber 
instances, called Cust1 and Cust2, are created in the XML file, for example:


<icim>
<object class="ServiceSubscriber" name="Cust1" />
<object class="ServiceSubscriber" name="Cust2" />


</icim>
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By default, the method for an object element is "update," so it is unnecessary to specify it. 
If the object does not exist, then the update method automatically adds it to the 
repository. Figure 3 on page 33 illustrates a Services Map and topology browser after 
importing these Service Subscribers. 


Figure 3  Map of imported Service Subscribers


Adding attributes


Adding attribute elements requires nesting the attribute declaration within the 
appropriate object declaration. This example adds the Display Name attribute to the 
Service Subscribers you created. This changes the Display Name of "Cust1" to "Customer 
1" and "Cust2" to "Customer 2". For example:


<icim>


<object class="ServiceSubscriber" name="Cust1" method="update">
<attribute name="DisplayName" method="put">
    <string>Customer 1</string>
</attribute>


</object>


<object class="ServiceSubscriber" name="Cust2" method="update">
<attribute name="DisplayName" method="put">
    <string>Customer 2</string>
</attribute>


</object>


</icim>

Adding and updating topology 33







Building Topology in XML

Figure 4 on page 34 illustrates the Services Subscribers with their new display names.


Figure 4  Map of imported Service Subscribers with new display names


Adding relationships using the put method


Adding relationships requires nesting the relationship declarations within the object 
declarations. Using the "put" method means you are assigning the only attribute intended 
for that object. The following example shows how to add a Service Offering called 
"EastCoast" and use the "Subscriptions" relationship to associate that offering with the 
Customer 1 subscriber created previously. For example:


<icim>


    <object class="ServiceSubscriber" name="Cust 1" method="update">


<relationship name="Subscriptions" method="put">
     <object class="ServiceOffering" name="EastCoast" />


</relationship>


    </object>


</icim>
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Figure 5 on page 35 illustrates the new Service Offering, EastCoast and Services 
Subscriber, Customer 1 with a Subscriptions relationship.


Figure 5  Map of imported Service Subscribers and Service Offering


Adding relationships using the insert method


Using the "insert" method allows you to add to the list of attributes intended for that 
object. The following example shows how to insert another Service Offering called 
MidWest into the Subscriptions relationship for Customer 1. For example:


<icim>
<object class="ServiceSubscriber" name="Cust 1" method="update">


 <relationship name="Subscriptions" method="insert">
    <object class="ServiceOffering" name="MidWest" />
</relationship>


    </object>
</icim>
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Figure 6 on page 36 illustrates the new Service Offering, MidWest, and Services 
Subscriber, Customer 1 with a Subscriptions relationship.


Figure 6  Map of imported Service Subscribers and Service Offering


Removing topology
This section describes how to remove topology from a Manager.


Attempting to perform the following tasks causes a runtime error when you import the XML 
file:


◆ Deleting a nonexistent object


◆ Deleting a nonexistent attribute or relationship


Removing objects


To remove an object from the repository, use the "delete" method for an object element 
that already exists. For example, to delete the ServiceSubscriber called Cust 2, use the 
following syntax:


<object class="ServiceSubscriber" name="Cust 2" method="delete" />
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Removing attributes and relationships


To remove a particular attribute or relationship for an object, adhere to the syntax of the 
ICIM/XML DTD. This means that the relationship and attribute updates must be nested 
within the appropriate object declaration. For example, to remove the Subscriptions 
relationship from the EastCoast service offering, use the following syntax:


<icim>


    <object class="ServiceSubscriber" name="Cust 1" method="update">
<relationship name="Subscriptions" method="remove">


       <object class="ServiceOffering" name="EastCoast" />
</relationship>


    </object>


</icim>


The topology returns to look as it did in Figure 5 on page 35.


Datatypes
Table 5 on page 37 lists the datatypes supported in the ICIM/XML DTD. 


Table 5  Supported datatypes


Value Description


boolean Datatype defined as two possible values (such as 0 or 1, on or 
off, true or false) 


char Any single ASCII character


double Any double-precision floating point number (similar to C++)


float Any single-precision floating point number (similar to C++)


int A 32-bit integer ranging from -2^31 to +(2^31 -1)


long A 64-bit integer ranging from -2^63 to +(2^63 -1)


short A 16-bit integer ranging from -32,768 to 32,767


string An ordered list of characters


struct A collection of fields, each field specifies its own type


unsignedint Unsigned 32-bit integer 232-1


unsignedlong Unsigned 64-bit integer ranging from 264-1 to +263 -1


unsignedshort Unsigned 16-bit integer 216-1
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Overview
Exporting object data to an XML file is a convenient way to move and store repository 
information in a format that can be used across the web or by another Manager.


To export data to XML, you must define an ASL script that queries the repository. In the 
ASL script, you specify the information and matching criteria for the objects to be gathered 
and exported. A sample ASL file, xml-export-sample.asl, is provided in 
BASEDIR/smarts/rules/xml-if. 


The XML Adapter invokes the specified ASL script against the specified Manager and 
produces the specified XML output file. Figure 7 on page 40 illustrates the process for 
exporting EMC Smarts data in XML.


Figure 7  Process diagram: Exporting EMC Smarts data in XML


The ASL Export script
A template for the ASL Export script, called xml-export-sample.asl, is installed in 
BASEDIR/smarts/rules/xml-if. Use ASL to modify the functionality of the local copy of the 
script. Use the sm_edit utility to modify the ASL script so that a copy is made in the local 
directory and the proper permissions are associated to it. Appendix A, “Understanding the 
sm_edit Utility,” includes information on using the sm_edit utility.


To open a file called xml-export-sample.asl using sm_edit:


▼# BASEDIR/smarts/bin>sm_edit 
BASEDIR/smarts/rules/xml-if/xml-export-sample.asl ▲


▼ ▲ indicates the command should be typed on one line.


Save this file with a new name, replacing "sample" with an appropriate grouping name (for 
example, "Services" for an ASL file intended to gather information on Service Subscribers 
and Service Offerings).
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Understanding the ASL script


A thorough understanding of ASL is required to work in the export script. The EMC Smarts 
ASL Reference Guide provides detailed information on working with the Adapter Scripting 
Language.


The first rule executed in the ASL script is the START rule. The START rule runs repeatedly 
until all the data input is processed. This rule invokes other rules or can specify which 
objects, attributes, and relationships to export. 


Data input gets processed as it is matched with all the patterns of a rule. The START rule 
has components in which the request details are defined. 


The XML headers and the ICIM root element are added automatically to the XML document 
by the sm_XML Adapter. The ASL script is responsible for gathering and adding the object, 
attribute, and relationship elements to the XML file.


Any modifications to the action blocks are made after the following comment:


"NOTE:  Customize the script from this point on"


These modifications define the specific information to retrieve from the repository. 


After the ASL script is executed, the closing tag for the ICIM root element is added to the 
document automatically.
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Building the ASL Export script
This section describes how to retrieve specific instances of objects, build foreach 
statements and use the builder statements to export the exact information you need from 
the repository.


The ASL file is constructed from these functions and statements: getInstance, foreach 
statements and builder statements.


getInstance function


The getInstances function returns a list of object names for the given class. The syntax of 
the getInstances function is:


listname = getInstances(<classname>);


For example, to retrieve all instances of the ServiceSubscriber class and add them to your 
XML document, begin with the following line:


EXPORT_SERVICESUBSCRIBER {
} do {
  svcSubList = getInstances("ServiceSubscriber");
...
}


Once the objects you want to export are defined, then define how to handle them. Use the 
builder statements described in “builder statements” on page 43 and the foreach 
statements that follow to complete this task.


foreach statement


The foreach statement iterates through all the members of a list or a table. The syntax of 
the foreach statement is:


foreach variable (listortablename) {statements}


When the foreach statement is used with a loop, the variable stores the value of each 
member of the list every time the foreach statement loops. The members returned are in 
numerical order by their list indices.


Building on our ServiceSubscriber example above, add the following statements:


EXPORT_SERVICESUBSCRIBER {
} do {


svcSubList = getInstances("ServiceSubscriber")? LOG, NEXT;
foreach svcSub (svcSubList) {


builder->addObject(svcSub, "ServiceSubscriber");
builder->addAttribute(svcSub, "DisplayName");
builder->addObjectClosing();


    }
}
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builder statements


Each element is created and formatted in the ICIM/XML document using builder 
statements that define the objects, attributes, and relationships. The syntax for the 
builder statements is as follows:


builder-> <BuilderStatement>(<Argument>,"<Value>");


Object element type builder statements
An object element requires two builder statements. Table 6 on page 43 describes the 
builder statements and arguments for an object element.


For example, to export an instance of the ServiceSubscriber class to the XML document, 
the builder statement resembles this:


foreach svcSub (svcSubList) {
builder->addObject(svcSub, "ServiceSubscriber");
builder->addAttribute(svcSub, "DisplayName");
builder->addObjectClosing();


Relationship element type builder statements
A relationship element has two required builder statements. Table 7 on page 43 describes 
the builder statements and arguments for a relationship element.


For example, to export all the objects with a Subscriptions relationship to the XML 
document, the builder statement resembles this:


builder->addRelationship("Subscriptions");
foreach...


builder->addRelationshipClosing();


Table 6  Builder statements for the object element type


Builder statement Description Arguments
Required / 
optional


addObject() Adds the instance to the XML 
document.  It creates the open tag for 
the object declaration. 


Instance Name Optional


Class Name Required


Method Optional


addObjectClosing() Adds the closing tag for the object 
declaration in the XML file.  


No Arguments N/A


addNullObject Adds a null object "<object/>" into the 
output XML document.


No Argument N/A


Table 7  Builder statements for the relationship element type


Builder statement Description Arguments
Required / 
optional


addRelationship( ) This adds the relationship to 
the XML document.  It 
creates the open tag for the 
relationship declaration. 


Relationship  Name Required


Method Optional


addRelationshipClosing () Adds the closing tag for the 
relationship declaration in 
the XML file.  


No Arguments N/A
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Attribute element type builder statements
An attribute element has only one required builder statement. Table 8 on page 44 
describes the builder statement and arguments for an attribute element.


The closing builder statement is unnecessary for this element because there is no 
recursive part so we can predict the end of the statement.


Since the ICIM/XML DTD requires that attribute definitions are nested within an object 
definition, this builder statement is defined with an object element. For example, to export 
instances of the ServiceSubscriber class, with their display names, to the XML document 
the builder statement resembles the following:


builder->addObject(svcSub, "ServiceSubscriber");
builder->addAttribute (svcSub, "DisplayName");
builder->addObjectClosing();


String builder statement
Optionally, you can add text into the XML document along with any of the declarations. 
After any of the builder statements defined above, you can use the addText statement. The 
argument may be any string that complies with the ICIM/XML DTD. Table 9 on page 44 
describes the builder statement and arguments for this element.


For example, to export instances of the ServiceSubscriber class, with their display names, 
and additional text that says Sample Offering to the XML document, use the following 
syntax:


builder->addObject(svcSub, "ServiceSubscriber");
builder->addAttribute (svcSub, "DisplayName");
builder->addObjectClosing();
builder->addText("<object class=\"ServiceOffering"\) name=\"Sample 


Offering"\ method=\"update"\ />;


Table 8  Builder statements for the attribute element type


Builder statement Description Arguments
Required / 
optional


addAttribute( ) This adds the attributes of the 
instance to the XML document.  


Instance  Name Required


Attribute Name Required


Method Optional


Table 9  Builder statements for the string


Builder statement Description Arguments
Required / 
optional


addText( ) Adds optional text to the XML 
declaration. 


String Required
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Parsing the XML
The resulting XML generated by the ASL script and the XML Adapter is passed through a 
validating parser. This is to ensure compliance with the ICIM/XML DTD. This parser, 
enables the XML Adapter to read and write XML data.


EMC Corporation provides the Xerces XML Parser with the installation of the XML Adapter.


Running sm_xml for export
Table 10 on page 45 describes four export-specific parameters associated with the 
sm_xml utility.


The resulting XML is passed through a validating parser. If the document is noncompliant 
with the ICIM/XML DTD, an error will appear and the program will exit with a nonzero exit 
status. When an error occurs, the XML is still written to standard output.


Table 10  XML exporter command parameters


Parameter Description Optional flag


Options:


--server=<name> Name of the Manager from which you are retrieving 
repository information. By default, this Manager name is 
INCHARGE.


-s


--broker=<location> Alternate location of the EMC Smarts broker. Must be 
typed as host:port. The default is the broker specified 
for the Manager at installation.


-b


Commands:


export 
--xmlfile=<output-xml
file> <asl-script>


Export an XML document using the XML export ASL script 
named <asl-script>.  By default, the XML is written to 
standard output.


Optionally, the XML can be written to a file if you specify: 
--xmlfile=<output-xmlfile>.


-x 
<output-xmlfil
e>


Command arguments:


output=<xmlfile> Name of the resulting XML file (and qualified path to save 
the file). Optionally, you can choose not to define a 
directory and filename and the resulting XML will be 
displayed in standard output.


-x 


<asl-script> The ASL rule script used to export the EMC Smarts 
topology. The adapter will look for the ASL script in 
BASEDIR/local/rules/xml-if first. If it is not found there, it 
will locate it in BASEDIR/rules/xml-if.


N/A
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For example, to generate an XML file called InChargeApplications.xml containing 
information from a Manager called INCHARGE, with an ASL Export script called 
xml-export-Applications.asl, use the following command:


▼sm_xml --server=<INCHARGE> export --xmlfile=InChargeApplications.xml 
xml-export-Applications.asl▲


▼ ▲ indicates the command should be typed on one line.


Sample ASL Export script
In this example ASL script, you are requesting XML output for all instances of the 
ServiceSubscriber class, the ServiceOfferings to which they are subscribed, and the 
Applications that compose the ServiceOfferings:


/* xml-export-sample.asl
 *
 * Copyright (C) 2003, System Management ARTS (SMARTS)
 * All Rights Reserved
 *
 * Sample Rule Set to export the topology of the ServiceSubscribers, 


the
 * ServiceOfferings they are subscribed to, the Applications that these
 * ServiceOfferings are composedOf, and the Hosts that Host these
*  Applications from the server into an XML document that will confirm 
* to the ICIM/XML DTD specifications.
 *
 * This is a sample xml-export-*.asl file. Users should make copies of 


this
 * file, and edit them according to their needs. But they should always 


name
 * these asl files according to the Naming convention, 


xml-export-<name>.asl
 */


/*
 * the XML_Builder object
 */
default builderName = "";
aslname = " ".getRuleFileName().": ";
builder = self->object("XML_Builder", builderName)? LOG, STOP;
if (builder->isNull()) {
    print(aslname."ERROR: The Wrapper object has not been created.");
    print(aslname."ERROR: Please make sure the CREATE_BUILDER is called 


".
                        "before calling the INITIALIZE rule in the 


script.");
    stop();
}


/*
 * NOTE: Customize the script from this point on.
 */


START() {
    .. eol
    EXPORT_BIM_INSTANCES
}


EXPORT_BIM_INSTANCES {
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    EXPORT_SERVICESUBSCRIBER
    EXPORT_SERVICEOFFERRING
    EXPORT_APPLICATION
}
EXPORT_SERVICESUBSCRIBER {
} do {
    /*
     * Get all the instances of ServiceSubscriber class and start 


adding to the
     * XML Document.
     */
    svcSubList = getInstances("ServiceSubscriber")? LOG, NEXT;
    foreach svcSub (svcSubList) {
        svcSubObj = object("ServiceSubscriber", svcSub)? LOG, IGNORE;
        builder->addObject(svcSub, "ServiceSubscriber");
        builder->addAttribute(svcSub, "DisplayName");
        builder->addRelationship("Subscriptions");
        /*
         * Get all the ServiceOffering objects that each of these
         * ServiceSubscribers subscribe to, and add them to the 


document.
         */
        foreach svcOffObj (svcSubObj->Subscriptions) {
            builder->addObject(svcOffObj->Name, 


svcOffObj->CreationClassName);
            builder->addObjectClosing();
        }
        builder->addRelationshipClosing();
        builder->addObjectClosing();
    }
}
EXPORT_SERVICEOFFERRING {
} do {
    /*
     * Get all the instances of ServiceOffering class and start adding 


to the
     * XML Document.
     */
    svcOffList = getInstances("ServiceOffering")? LOG, NEXT;
    foreach svcOff (svcOffList) {
        svcOffObj = object("ServiceOffering", svcOff)? LOG, IGNORE;
        builder->addObject(svcOff, "ServiceOffering");
        builder->addAttribute(svcOff, "DisplayName");
        builder->addRelationship("ConsistsOf");
        /*
         * Get all the <infrastructure> objects that each of these
         * ServiceOfferings consists of, and add them to the document.
         */
        foreach infObj (svcOffObj->ConsistsOf) {
            builder->addObject(infObj->Name, 


infObj->CreationClassName);
            builder->addObjectClosing();
        }
        builder->addRelationshipClosing();
        builder->addObjectClosing();
    }
}


EXPORT_APPLICATION {
} do {
    /*
     * Get all the instances of Application class and start adding to 


the
     * XML Document.
     */
    appList = getInstances("Application")? LOG, NEXT;
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    foreach app (appList) {
        appObj = object("Application", app)? LOG, IGNORE;
        builder->addObject(app, "Application");
        builder->addAttribute(app, "DisplayName");
/*
         * Get the Host object that this Application is HostedBy,
         * and add it to the document.
         */
        hostObj = appObj->HostedBy;
        builder->addRelationship("HostedBy");
        builder->addObject(hostObj->Name, hostObj->CreationClassName);
        builder->addObjectClosing();
        builder->addRelationshipClosing();


        /*
         * Get all the Transaction objects that these Applications 


Produce and
         * Consume, and export them to the XML Document also.
         */
        builder->addRelationship("Produces");
        foreach trans (appObj->Produces) {
            builder->addObjectClosing();
        }
builder->addRelationshipClosing();


        builder->addRelationship("Consumes");
        foreach trans (appObj->Consumes) {
            builder->addObject(trans->Name, trans->CreationClassName);
            builder->addObjectClosing();
        }
        builder->addRelationshipClosing();


        builder->addObjectClosing();
    }
}
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Importing Information into EMC Smarts


This chapter describes how to import XML data into the repository and contains the 
following information:


◆ XML import process ................................................................................................  50
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XML import process
To import an XML document containing topology, events, or other objects, your XML 
document must comply with the ICIM/XML DTD. Figure 8 on page 50 illustrates the XML 
import process. You may have a utility that exports the desired topology data as XML using 
a unique DTD as in Option A. If this is the case, use an XSL Transformation (XSLT), which is 
a language for transforming XML documents into other XML documents. 


Alternatively, you can manually create an XML file that complies with the ICIM/XML DTD as 
in Option B.


When your XML document is ready, use the sm_XML Adapter to import the new objects 
into the repository. Figure 8 on page 50 displays the import process.


Figure 8  Process diagram: Importing XML data into EMC Smarts


Before importing XML


It is unnecessary to shut down the Manager before you import the XML file. However, when 
importing, verify your XML is valid according to the ICIM/XML DTD. The DTD file, called 
icim_xml.dtd is located in BASEDIR/smarts/conf/xml-if.


A runtime error is generated if the XML importer cannot execute the instructions encoded 
in the XML document. By default, the importer skips any element (or child element) 
containing an error. It continues with the next element and generates a report of errors at 
the end. 
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To determine if the XML is valid and complies with the ICIM/XML DTD, run the following 
command:


▼sm_xml --server=<INCHARGE> import <Applications.xml>
--verify▲


▼ ▲ indicates the command should be typed on one line.


If there are any errors within your XML document, they are listed so that you can address 
them.


If you create an object with read-only attributes (such as ICS_Notification), those 
attributes may cause a runtime error. 


Running sm_xml to import XML 


Table 11 on page 51 describes the command parameters to use with sm_xml.


For example, to import a file called Applications.xml into a Manager called INCHARGE, use 
the following command:


sm_xml import --exit-on-error Applications.xml 


Table 11  XML exporter command parameters


Parameter Description Optional flag


Options:


--server=<name> Name of the target manager. By default, this manager name is INCHARGE. -s


--broker=<location> Alternate location of the EMC Smarts broker. Must be typed as host:port. 
The default is the broker specified for the manager at installation.


-b


Commands:


import [--exit-on-error] 
[--verify] <input-xmlfile>


Import an XML document called <input-xmlfile>.
Optionally, the XML can be verified without importing it to the manager 
using --verify.  Additionally, using --exit-on-error, the XML can be imported, 
but the import process will stop when an error is detected.


Command arguments:


<input-xmlfile> The XML file used to import the EMC Smarts topology. N/A


--exit-on-error This option allows you to import the XML, but stops the import process 
when a runtime error is encountered.  
By default, without this command option, a runtime error is reported, but 
the import process resumes at the next element.


Notice: Anything imported prior to the runtime error remains in the 
repository.


-e


--verify This option validates the XML file against the ICIM/XML DTD specification, 
but does not import the XML to the Manager.


N/A
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Handling runtime errors
A runtime error is generated if the XML importer cannot execute the instructions encoded 
in the XML document.  By default, the importer skips any element (or subelement) 
containing an error.  It continues with the next element and generates an error report at 
the end.  


There are two ways to avoid the runtime error:


◆ --verify:  Without importing the ICIM/XML document, run the XML to see if it will be 
validated by the parser.


◆ --exit-on-error:  By default, objects will be imported as they are interpreted from 
the XML document and any invalid objects will be identified in a summary file.  Use 
this command option to quit the import process when the adapter detects an error.  


Any objects imported before the error was detected will remain in the repository. 
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APPENDIX A
Understanding the sm_edit Utility


As part of the EMC Smarts deployment and configuration process, you need to modify 
certain files. User modifiable files include configuration files, rule set files, templates, and 
files (such as seed files, and security configuration files) that contain encrypted 
passwords. Original versions of these files are installed into appropriate subdirectories 
under the BASEDIR/smarts/ directory.


Original versions of files should not be altered. If a file requires modification, it must be 
stored as a local copy of the file in BASEDIR/smarts/local or one of its subdirectories. 


Example 1 Modify serverConnect.conf


EMC Smarts software is designed to first search for user modifiable files in 
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not 
found in the local area, EMC Smarts software then searches appropriate nonlocal 
directories.


To facilitate proper file editing, EMC Corporation provides the sm_edit utility with every 
EMC Smarts products. When used to modify an original version of a file, this utility 
automatically creates a local copy of the file and places it in the appropriate location 
under BASEDIR/smarts/local. This ensures that the original version of the file remains 
unchanged. You can invoke sm_edit from the command line. Optionally, you can configure 
Windows so that sm_edit is automatically invoked when user-modifiable files are 
double-clicked in Windows Explorer.


To invoke the sm_edit utility from the command line, specify the path and the name of the 
file to edit under BASEDIR/smarts. If multiple EMC Smarts products are running on the 
same host, invoke sm_edit from the bin directory of the product with the files to edit. 


Example 2 Edit a configuration file


To edit the configuration file for connecting to a server (serverConnect.conf), invoke the 
sm_edit utility as follows: 


/opt/InCharge/SAM/smarts/bin>sm_edit conf/serverConnect.conf


In this example, the sm_edit utility automatically creates a local copy of the 
serverConnect.conf file in the /opt/InCharge/SAM/smarts/local/conf directory and opens 
the file in a text editor. If a local version of the file already exists, the sm_edit utility opens 
the local version in a text editor. In addition, sm_edit creates any necessary 
subdirectories.


The EMC Smarts System Administration Guide provides additional information about the 
sm_edit utility.
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CHAPTER 1
Introduction


This chapter consists of the following sections:
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◆ Overview of a simple API Perl script.........................................................................  15
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Introduction

Fundamental concepts
The EMC® Smarts® Perl API provides a programmable interface with EMC Smarts Domain 
Managers. You can use it to perform various actions such as:


◆ Getting information about a running Domain Manager


◆ Creating or deleting objects in the domain topology


◆ Getting or setting data about objects in the topology


◆ Executing operations that are declared for an object class


The EMC® Smarts® Remote Application Programming Interface (API) for Perl allows 
developers to create Perl scripts that connect to Domain Managers as clients to exchange 
information, manipulate data, or drive Domain Manager actions. The API provides access 
to all Domain Manager features, by using a syntax and logic that mirrors what is available 
through the Adapter Scripting Language (ASL) and the dmctl utility in a way that is natural 
to Perl developers. The API runs on Windows and UNIX platforms that support Perl 5.6.1 
and Perl 5.8.x. 


When using the provided Perl 5.8.8 version, the API uses a Flow module, which replaces 
IO::Socket and enables encryption and “keep alive” functionality. If you use Perl 5.6.1 
there is no encryption or keep alive functionality.


The API also supports IPv4 and IPv6 environments.


In order to create scripts that interact with a Domain Manager, it is necessary to 
understand how the manager is configured.


A script developed using the Perl API can create, delete and interact with instances of 
interfaces in a Domain Manager. The interfaces are defined using the MODEL language, 
compiled and loaded into a Domain Manager. The MODEL language is an object-oriented 
language used to construct a data model to describe a managed domain. The language is 
used to define a set of classes and the attributes, relationships, operations, and events 
that are associated with the classes.


EMC Smarts installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed.


◆ For Windows, this location is C:\InCharge\<product>.


◆ For UNIX, this location is /opt/InCharge/<product>.


Optionally, you can specify the root of BASEDIR to be something other than:


◆ Windows: C:\InCharge


◆ UNIX: /opt/InCharge


However, you cannot change the <product> location under the root directory.


The EMC Smarts System Administration Guide provides more information about the 
directory structure.


Where to get help
EMC support, product, and licensing information can be obtained as follows:
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Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Classes


Classes describe the objects that are modeled for use in a Domain Manager. For example, 
Router is the name of a class, and all routers that are managed by a domain are 
represented as Router objects in the domain. Every object in a class shares the same set 
of attributes, although the values of the attributes differ. Hence, every router has an IP 
address, an attribute, but the actual addresses are different. PowerSupply is also a class, 
but power supplies do not have IP addresses. However, the event, power outage, is 
relevant to the PowerSupply class but not to routers. Therefore, a model class is a 
grouping of all objects that are similar in nature but not in detail. 


Every model class has a number of properties, events and operations defined for them. 
The API provides functions for obtaining details of these definitions.


Instances


Object instances are specific occurrences of a class. For example, a class might describe a 
human, and an instance of the class could be an object named Bill.


Properties - Attributes and relationships


Every instance in a EMC Smarts domain has a set of properties associated with it. These 
are values that describe the object. There are two distinct types of class properties 
supported by EMC Smarts software: attributes and relationships.


Attributes
Attributes describe a class and for an instance of the class include information about its 
present state. Examples of attributes include an element’s name and a counter that 
counts the number of packets traversing an interface. Attributes are simple strings, 
integers, booleans, or enumerations.


Relationships
Relationships define how instances are related to other instances. Relationships can be 
one-to-one, one-to-many, many-to-one or many-to-many. 


◆ When only a single instance can be related to another instance, or instances, it is 
known as a relationship. 


◆ When multiple instances can be related to another instance, or instances, it is known 
as a relationshipset.
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Operations


Operations are actions that are specific to a class of object. For example, you can get the 
associated network adapter name for a MAC address but not for a router. 


The API provides a mechanism for invoking these class-specific actions, by passing 
information to them through arguments, and by obtaining the results of the action.


Events


Events describe the failures that can occur for a class, the symptoms that these failures 
create, and the effect of such failures. Symptoms can be local, observed in the instance of 
the class, or propagated, observed in instances related to the failing instances. 


Primitives - Basic Domain Manager interface


Primitives are Perl functions that provide the basic interface between a client application 
and the Domain Manager.


A number of these are likely to be used directly by scripts and will be familiar to ASL 
developers. These include getInstances(), getChildren(), getExplainedBy().


Others are normally hidden from view because higher level features can be used instead, 
which ultimately call the primitives. For example, primitives that are not normally used 
directly are get() and invoke(). These are the calls that allow an instance's properties to be 
queried and its operations to be called. In both the API for Perl and ASL, these calls are 
normally invoked by using a classic object-oriented syntax.


The EMC Smarts ASL Reference Guide provides further information about the EMC Smarts 
data structures.


The Perl API is implemented as a set of Perl modules, which individual Perl scripts may 
access, by using the familiar “use” directive. InCharge::session and InCharge::object offer 
the principal interface, which respectively provide connection sessions to Domain 
Managers and access to objects within those managers. Simultaneous sessions to 
multiple Domain Managers may be established within a single Perl script. Properties and 
methods of objects within those managers may be accessed as with C++, offering 
somewhat broader functionality than that afforded by ASL.


Encryption


Messaging between the client and Domain Manager can be encrypted, by using the Perl 
API. Encryption is dependent upon the values set for the environment variables 
SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL. If these values are not 
specified, encryption is automatically negotiated between the client and Domain 
Manager. The EMC Smarts System Administration Guide provides further information 
about encryption.


“Keep Alive” messaging


The Perl API also supports “Keep Alive” messaging to maintain active connections 
between the client and DM, as discussed in the EMC Smarts System Administration Guide.
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Transcoding character data


You must transcode character data from your code page to UTF-8 before placing the 
character data into the remote API buffer. Data will be returned to your Remote API client 
application bindings as UTF-8 strings.


Setting environment variables


You must define the following variables to run a Perl script within the EMC Smarts 
environment from the command line.:


◆ SM_HOME 
◆ SM_WRITABLE 
◆ SM_AUTHORITY
◆ SM_BROKER 
◆ SM_BROKER_DEFAULT 
◆ SM_SITEMOD 
◆ SM_INCOMING_PROTOCOL
◆ SM_OUTGOING_PROTOCOL


You can find further information on these variables in the EMC Smarts System 
Administration Guide. 


To set these variables, enter the following command to start the bash environment:


BASEDIR/smarts/bin/runcmd bash


bash$>


A Perl script to define the variables can now be run within this bash environment.


“Keep Alive” and encryption requirements
The Perl API now supports “Keep Alive” and encrypted communications when run with the 
version of Perl supplied by EMC. You should use the sm_perl command that is shipped 
with the EMC Smarts software, in order to successfully run the Perl API.


You can use a pure Perl implementation without keepalive or encryption by setting the 
environment variable SM_DISABLE_FLOW_WRAPPER.


Overview of a simple API Perl script
The general approach to writing a script that uses the Remote Perl API is to follow these 
basic steps:


1. Open a session.


Initialize a session, and obtain a reference to it, by using either 
InCharge::session->init() or InCharge::session->new(), as appropriate.


use InCharge::session;
$session = InCharge::session->init( );
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• To have the script’s user supply the session connection details on the command 
line (such as the broker, domain name, username and password), choose the init() 
method. The init() method will parse the command line arguments supplied to the 
Perl script and use them to setup the connection. The section “init” on page 38 
provides additional information.


• To give the script greater control over the details that are used to establish the 
connection, choose the new() method. The section “new” on page 36 provides 
additional information.


2. Work with the domain.


Call the primitives required, by using the session reference obtained in step 1, and 
manipulate the data. For example,


foreach $class ( sort $session->getClasses() ) {
foreach $inst (


sort $session->getInstances($class))
{


print $class . "::" . $inst . "\n”;
}


}


3. Close the session.


Once the script has finished working with the domain, the session should be closed.


$session->detach( );


Where access to the operations or properties of domain objects (such as routers and 
interfaces) is required, you use the features of the InCharge::object module. The script 
obtains an InCharge::object reference, and then uses it to access the required 
information. For example.


1. Establish a session.


use InCharge::session;
$session = InCharge::session->init();


2. Obtain an object reference.


Before an object in the domain can be accessed, the script needs to obtain an 
InCharge::object reference to the object of interest, by using the object() method of 
the session handle.


$obj = $session->object( "Router::gw1" );


3. Manipulate the object.


The reference obtained in step 2 can now be used to access the properties and 
operations of the object. Properties can be accessed, by using Perl's hashing syntax 
and operations can be invoked, by using Perl's object-oriented syntax conventions.


$type = $obj->{Type};
$obj->{Vendor} = "Cisco";
$fan1 = $obj->findFan( 1 );


4. Close the session.


As before, the session should be closed when no longer required.


$session->detach( );
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Using primitives and object references
The API provides function calls for accessing all the low-level facilities of Domain 
Managers. Each of these primitives can be invoked with reference to the InCharge::session 
handle, described in step 1 on page 15, and takes arguments that exactly match the API 
syntax.


The API also provides an object-oriented abstraction layer that allows Perl code to access 
the Domain Manager, by using a syntax that is very similar to ASL. For example, in ASL you 
can list the vendors of all routers, by using this logic:


routers = getInstances( "Router" );
foreach router ( routers ) {


obj = object( "Router", router );
vendor = obj->Vendor;
print( router . " - " . vendor );


}


When using the Perl API to perform the same action, the code looks like this:


@routers = $session->getInstances( "Router" );
foreach $router ( @routers ) {


$obj = $session->object( "Router", $router );
$vendor = $obj->{Vendor};
print $router . " - " . $vendor . "\n”;
}


The two code fragments in the ASL and Perl API example are very similar. The first main 
difference is a matter of syntax. Perl uses ``$'' and ``@'' to denote scalar and array 
variables, and {..} to denote object properties, which are hash table lookups. The second 
difference is that the object( .. ) and getInstances( .. ) functions are called with reference to 
a session handle in the Perl code.


Event subscription


The Perl API provides mechanisms for subscribing to and acting upon events generated by 
Domain Managers.


The EMC Smarts programming model delivers two different modes of client/server 
communication. The most direct is where a client makes a request of the Domain Manager 
which acts on the request and responds. A simple example of this is an object query or 
update. For example, the action of obtaining the vendor of a particular device is one such 
query. In Perl, this query would be encoded in a manner similar to the following fragment.


use InCharge::session; 
use InCharge::object;


$session = InCharge::session->init( );
$device = "Router::gw1";
$obj = $session->object( $device );
$vendor = $obj->{Vendor};
print $vendor . "\n”;


The second mechanism provides asynchronous notifications through subscriptions and is 
used when the client program needs to listen for events generated by the Domain 
Manager in response to other external events. One example would be a script that waits 
for the Vendor field of a particular router to change. In Perl, this could be coded in the 
following way.
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use InCharge::session; 
use InCharge::object;


$session = InCharge::session->init( );
$observer = $session->observer( );
$device = "Router::gw1";
$session->propertySubscribe($device, "Vendor", 30 );
while ( 1 ) {
@event = $observer->receiveEvent( );
print "Vendor $event[2]::$event[3] is now \


$event[5]\n”;
}


The following sections provide an overview of mechanisms for creating and controlling a 
number of different types of subscriptions.


Registering an observer


In order to allow a Domain Manager to send subscribed events to a client program, the 
client must first register itself with the Domain Manager as an event observer.


In Perl, this is done by using the observer() method of the InCharge::session module. Two 
steps are required:


1. Connect to the Domain Manager and get a valid session object handle.


First, the client must connect to the Domain Manager which establishes a new 
InCharge::session connection. This is done by using either the 
InCharge::session->new() or InCharge::session->init() methods.


Here are some example code fragments that achieve this goal:


$session = InCharge::Session->init( )


The following example uses the InCharge::session->new() method to establish a 
connection, and provides the broker and server options.


$session = InCharge::session->new(
broker=>"192.168.0.3",
domain=>"INCHARGE"


);


Establishing a connection with the InCharge::session->new() method allows the 
connection options to be specified explicitly by the script itself.


2. Attach an observer to the Domain Manager session.


Once the script has obtained a handle that references the script/server connection 
($session in step 1 on page 18), it can be used to obtain a second connection to the 
notification engine of the Domain Manager. This is obtained by using the observer() 
method on the InCharge::session handle just obtained. The following code performs 
this action.


$observer = $session->observer();


This $observer handle now references a second link between the client script and the 
Domain Manager, which is used to pass subscribed events to the client in real time.


The observer connection can be closed, detached, or destroyed by using the detach() 
object method:


$observer->detach();
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This action has the side effect of cancelling any outstanding subscriptions.


Subscribing to notifications


Once the client has registered itself as an observer, the next step is to inform the Domain 
Manager about which events the observer wants to receive notifications. EMC Smarts 
allows clients to subscribe to a number of different types of events. These are listed in 
Table 1 on page 19. 


This table gives the names of the methods used to subscribe to and unsubscribe from 
different types of notifications.


The following code segment is an example script that subscribes to changes of the Vendor 
field of every device in the topology:


$session = InCharge::session->init( );
$obs = $session->observer();
foreach $name ( $session->getClassInstances(


"ICIM_UnitaryComputerSystem" ) ) {
$session->propertySubscribe("::$name", "Vendor", 30);
}


Receiving notifications


Once the script has registered as an observer, and subscribed to the notifications of 
interest, it then proceeds to listen for events and process them as required. The event 
reception method call is receiveEvent(). This returns an array of up to five values.


For the purposes of the descriptions that follow, assume that events are returned in the 
array @event, as shown in the following script fragment:


@event = $observer->receiveEvent( );


Should the script require the event to be a single string with a separator used to delimit 
the fields, in the style of the ASL language, then the application can use the standard Perl 
join function:


$fs = "|";
$event = join( $fs, $observer->receiveEvent( ) );


Table 1  Subscription methods summary


Method type Description Method API call


property Notifications about changes to specified object 
properties in the ICIM database. For example, 
when the “Vendor” field of Router::gw1 changes


propertySubscribe
propertyUnsubscribe


topology Notifications about changes to the topology, 
such as the creation and deletion of objects. This 
does not refer to object property changes.


topologySubscribe
topologyUnsubscribe


event Notifications about the posting and clearing of 
events and changes to their state.


subscribe
unsubscribe
subscribeAll
unsubscribeAll
getSubscriptionState
IsSubscribed
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The receiveEvent() method can take an optional parameter to specify a timeout in 
seconds, which may be fractional. If no event arrives within the specified time, a 
pseudo-event of type TIMEOUT is returned. For example,


@event = $observer->receiveEvent( 0.25 );


If no timeout is specified, the call waits forever.


The first element of the @event array, accessed by using the Perl syntax: $event[0], 
contains the event's timestamp measured by using normal UNIX time_t semantics 
(number of seconds since midnight January 1, 1970).


The second element of the @event array, $event[1], contains a text string that describes 
the type of event received.


The array elements from $event[2] to $event[$#event] have meanings that depend on the 
semantics of the event type given in $event[1].


Event notification records
Event notifications are received from the Domain Manager when the status of an event 
changes. The format of the notification record is shown in Table 2 on page 20. 


Normally, the Domain Manager sends a single notification message when an event 
becomes active and a single clear message when the event is no longer active. If an event 
corresponds to a root-cause problem, it is possible that the certainty of the diagnosis will 
change over time. If the diagnosis certainty changes, the Domain Manager generates 
another notification. Notifications of this type are streamed in a slightly different manner. 
This difference in behavior is a feature of the front-end Perl API, not the Domain Manager. 
The Domain Manager sends NOTIFY messages in both cases. The API keeps internal notes 
about active events, and changes the event type accordingly, as shown in Table 3 on 
page 20. 


Table 2  Notification record - NOTIFY


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “NOTIFY”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


$event[5] Event certainty (FLOAT)


Table 3  Notification record - CERTAINTY_CHANGE (page 1 of 2)


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CERTAINTY_CHANGE”


$event[2] Object class name (STRING)
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Table 4 on page 21 describes the format of the record when an event is cleared by the 
Domain Manager. 


Object create/delete records
An object create message is sent by the Domain Manager when a new object is created in 
the manager’s repository. Table 5 on page 21 describes the format of an object create 
record. 


An object delete message is sent by the Domain Manager when an object is deleted from 
the manager’s repository. Table 6 on page 21 describes the format of an object delete 
record. 


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


$event[5] Event certainty (FLOAT)


Table 3  Notification record - CERTAINTY_CHANGE (page 2 of 2)


Event record entry Description


Table 4  Notification record - CLEAR


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CLEAR”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


Table 5  Notification record - CREATE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CREATE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


Table 6  Notification record - DELETE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “DELETE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)
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Class load records
A class load message is sent by the Domain Manager when a new class is created in the 
manager’s repository. Classes are created when new MODEL-generated libraries are 
loaded. Table 7 on page 22 describes the format of a class load record.  


Relation/property change records
A relation change message is sent by the Domain Manager when a relationship between 
objects changes. Table 8 on page 22 shows the format of a relation change record. 


A property change message is sent by the Domain Manager when an object’s property 
changes. The format of a property change record is shown in Table 9 on page 22. 


Table 7  Notification record - CLASS_LOAD


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CLASS_LOAD”


$event[2] Class name (STRING)


Table 8  Notification record - RELATION_CHANGE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “RELATION_CHANGE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Relation name (STRING)


Table 9  Notification record - ATTR_CHANGE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “ATTR_CHANGE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Property name (STRING)
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Domain Manager connect/disconnect records
A Domain Manager disconnect record is generated when the connection to the server is 
lost. This differs somewhat from ASL operation. The “observer” on page 40 describes the 
proper handling of DISCONNECT events if the restartableServer operation is appropriate. 
These records are generated even if no subscriptions to the Domain Manager are issued. 
The format of the Domain Manager disconnect message is shown in Table 10 on page 23. 


Note: There is no CONNECT record. In ASL, these are an artifact of the resartableServer 
front-end that the Perl API does not provide. The restartableServer affords a means of 
invisibly attempting a reconnection. The CONNECT message is an indication of success. 
The Perl API instead gives an immediate error on failure of the InCharge::session-->init() 
method or similar. It remains for the developer to provide retry logic to successfully 
connect.


Subscription status records
When the Domain Manager receives a subscription request, it normally sends a 
notification back to the client to indicate whether or not the request was accepted. In the 
event of an error, such as an invalid event name being specified, the Domain Manager 
does not report an error by using normal Perl die semantics. Instead, a notification is used 
to report that the subscription was rejected. The format of the ACCEPT/REJECT message is 
shown in Table 11 on page 23. 


Table 10  Notification record - DISCONNECT


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “DISCONNECT”


$event[2] Domain name (STRING)


Table 11  Notification record - ACCEPT, REJECT, (PROPERTY)


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “ACCEPT” or “REJECT” or “PROPERTY_ACCEPT” or “PROPERTY_REJECT”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event or property name (STRING)
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Event suspension records
Under certain circumstances, the Domain Manager will elect to suspend events if they are 
temporarily irrelevant. For example, when an aggregation contains no triggering events, a 
SUSPEND message is sent to the subscribed client. The format of the SUSPEND message 
is shown in Table 12 on page 24. 


Timeout records
If no event arrives within the time specified as the optional argument to receiveEvent(), a 
TIMEOUT record is returned, whose message format is shown in Table 13 on page 24. 


Table 12  Notification record - SUSPEND (PROPERTY)


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “SUSPEND” or “PROPERTY_SUSPEND”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event or property name (STRING)


$event[5] Descriptive message (STRING)


Table 13  Notification record - TIMEOUT


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “TIMEOUT”


$event[2] Domain name (STRING)
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InCharge::Object

Overview
The InCharge::object module provides the interface to Domain Manager repository 
objects. With it you can:


◆ Get or set an object’s attributes


◆ Invoke an object’s operations


Name
InCharge::object 


Synopsis
use InCharge::session;
$obj = $session->object( $class, $instance );
$value = $obj->get( "PropertyName" );
$value = $obj->{PropertyName};
$obj->put( "PropertyName", $value );
$obj->{PropertyName} = $value;
$rtn = $obj->invoke( "OperationName", .. arguments .. );
$rtn = $obj->OperationName( .. arguments .. );


The InCharge::object module allows objects in the Domain Manager repository to be 
manipulated in an object-oriented style, similar to the ASL language.


Description
An InCharge::object reference is required to access the properties or methods of a Domain 
Manager object. This reference is returned from the object() or create() methods of the 
InCharge::session module. Both methods allow access to preexisting objects, but the 
create() method will also create the object if it does not already exist. While create() 
always accesses the Domain Manager, object() may or may not depending on the 
invocation technique.


$obj = $session->object( "Router", "edgert1" );
$obj = $session->object( "Router::edgert1" );
$obj = $session->create( "Router", "newrouter" );


Whenever you specify the details of a repository instance to work within the API you have a 
choice of two syntaxes. You can either specify the object class and instance names as 
individual arguments, or run them together with a delimiting double-colon (::). The API 
handles these two forms identically.


If you do not know the class to which an object belongs, you can either use a class 
argument of undef, or a string with nothing before the double-colon (::). For example,


$obj = $session->object( undef, "edgert1" );
$obj = $session->object( "::edgert1" );


The option of omitting the class name does not work with the InCharge::session->create() 
method because the Domain Manager cannot create an object without knowing which 
class to use. It does work with InCharge::session->object() and related calls because the 
process of referring to an existing instance can legitimately include a query to identify the 
object's class.
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If you choose not to provide the class name in these calls, the API does additional work to 
determine the object's class, which imposes a slight performance penalty.


Once an object reference has been created, it can be used to invoke the object's 
operations or access its properties. Access to an object's attributes or properties can be 
obtained by using calls shown in the following example.


$vendor = $obj->get( "Vendor" );
$vendor = $obj->{Vendor};
($vendor,$model) = $obj->get( "Vendor", "Model" );
%properties = $obj->get( );
$obj->put( "Vendor", "Cisco" );
$obj->{Vendor} = "Cisco";
$obj->put(Vendor => "Cisco", Model => "2010" );


These examples show that object properties can be accessed by using either the get() and 
put() methods or the psuedo-hash syntax. The latter syntax is preferred because it is 
closer to the original built-in ASL language logic.


Two special internal properties can be accessed by using the hash syntax only. These give 
the name of the class and instance to which the object reference refers. Treat them as 
read-only fields.


$obj->{_class}           BUT NOT: $obj->get("_class")
$obj->{_instance}        BUT NOT: $obj->get("_instance")


Object operations can be invoked by using the invoke() method, or directly, as in the 
example:


@ports = $obj->invoke( "findPorts" );
@ports = $obj->findPorts();
$port = $obj->


invoke( "makePort", "1.0", "PORT-rt1/1.0", "Port" );
$port = $obj->makePort( "1.0", "PORT-rt1/1.0", "Port" );


Again, the latter syntax, calling the operation directly, is preferred.


Use the invoke() method to access an object operation that duplicates the name of any of 
the built-in methods of the InCharge::object class.


◆ The first of these calls the new() operation of the object in the repository.


◆ The second calls the built-in new() method of the InCharge::object class.


$obj->invoke( "new", "qtable" );
$obj->new( "qtable" );


Note that InCharge::object is used for accessing ICIM instance operations and properties 
only. If you make other ICIM calls that refer to instances, such as subscribe(), use the 
features of InCharge::session directly. The following line of code is invalid:


$obj->propertySubscribe( "Vendor" );


Instead, use one of the following:


◆ The first alternative:


$session->propertySubscribe($class, $instance, "Vendor");


◆ The second alternative:
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$session->propertySubscribe( $obj, ``Vendor'' );


The reason you have to use one of these two alternative methods is because the 
propertySubscribe is not a repository class operation, but rather it is a primitive.


dmctl -s <domain> getOperations <classname> | more


Likewise, to determine what properties can be accessed by using the InCharge::object 
module use:


dmctl -s <domain> getProperties <classname>


Functions and methods


object


$object = $session->object( $class, $instance );


The object() method creates a new object reference.


get


The get() method is used to retrieve the value of the specified properties of the object, 
such as the value of an attribute. In addition, the call “get_t” on page 29 also extends the 
functionality of the get() method by returning additional information that identifies the 
data type (for example, STRING) of the property value. 


The get() and get_t() primitives throw an error when used to access a nonexistent property 
or one that cannot be retrieved for any reason, whereas the psuedo-hash syntax simply 
returns an undef value. This difference allows the Data::Dumper logic to display an entire 
object without an error even when some properties cannot be retrieved.


Single property
You can access the content of a property whose name is held in a variable by using the 
Perl typical logic, as shown:


$result = $obj->{$property_name};


In this example, the value of the $propname variable is retrieved:


$propname = "Vendor";
$value = $obj->{$propname};


Multiple properties
You can also get multiple values in a single get() call by listing all the property names as 
arguments, by using the following syntax:


$result = $obj->get( $property_name [, $property_name ...] )


The results are returned in an array. This is faster than using multiple single-property get() 
calls. In this example, the value of the Vendor and Type attributes are retrieved:


( $vendor, $type ) = $obj->get( "Vendor", "Type" );
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All properties and relationships 
You can also call get() with no arguments, in which case, a hash is created that contains all 
the object properties and relations, as shown:


%all_properties = $obj->get( )


There is no syntactical advantage, but there is a significant speed advantage.


Return value types
The type of return value depends on the calling syntax used, get() or hash(), and the Perl 
evaluation context, scalar or array, as shown in Table 14 on page 29. 


For example, if the attribute MyValue is declared as an integer in the MODEL code, then 
the return type for that property will be an integer. Multiple values are always returned in 
an array or array reference.


get_t


The get_t() method is like the get() method, except that it returns the type of return value 
as well as the value itself. The data types are encoded as integer numbers. If the return is 
an array, then $value will receive a reference to the array. If the return is a scalar, then 
$value will hold it. The $session->TYPE() method can be used to convert the $type integer 
value to a mnemonic string.


($type, $value) = $obj->get_t( $property_name );


There is a second syntax that gets the types and values for multiple properties. Each 
type/value pair is held in a two-element subarray within the returned data.


@types_and_values =
$obj->get_t( $prop1 [, $prop2 [, prop3 .. ] ] )


There is also a third syntax gets the types and values for all the properties and relations of 
the object and stores them in a hash, indexed by the property names. 


%all_property_types_and_values = $obj->get_t( );


Example:


$obj = $session->object( "Router::gw1" );
( $type, $value ) = $obj->get_t( "Vendor" );
print "Vendor value ='$value', \


type = ".$session>TYPE($type)."\n”;


This example will print:


Table 14  Return type for call syntax and Perl evaluation context


Expression syntax Property type
Return type in scalar 
context Return type in array context


$obj->{prop} scalar scalar scalar in [0]


$obj->{prop} array array ref array ref in [0]


$obj->get(“prop”) scalar scalar scalar in [0]


$obj->get(“prop”) array array ref array
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Vendor value='CISCO', type = STRING


put


$object->put( $property_name, $value );


The put() method allows fields of the object to be modified in the Domain Manager 
repository.


This method is used in a number of ways. However, the use of the pseudo-hash syntax is 
the preferred option for syntactic equivalence with the Domain Manager native ASL 
language, as shown:


$obj->put( "Vendor", "Cisco" );
$obj->{Vendor} = "Cisco";


$obj->{ComposedOf} = [ ];


To set more than one property in a single call, use multiple name:value pairs, such as:


$obj->put(Vendor => "Cisco",
PrimaryOwnerContact => "Joe Bloggs");


You can also set more than one property in a single call, by using the following syntax:


%updates = ( Vendor => "Cisco",
PrimaryOwnerContact => "Joe Bloggs");


$obj->put( %updates );


When using either syntax to set a relationship or list property, use a reference to a Perl 
array, such as:


$obj->{ComposedOf} = [ $a, $b, $c ];
$obj->put( "ComposedOf", \@things );


Use insertElement() and removeElement() to add or remove elements from a list.


isNull


$boolean = $object->isNull();


The isNull() method tests to see whether the object is present in the repository.


TRUE means that the object is not present. FALSE means it is present.


invoke


reply = $object->invoke( $operation, ... arguments ... );


The invoke() method calls the named repository class operation on the object.


The arguments passed should be as expected by the operation. If the operation returns a 
scalar value, the call should be called in a scalar context. If it returns an array, it should be 
invoked in an array context.


The preferred way of achieving the same result is to use the operation name directly. Thus, 
the following are equivalent but the latter is preferred.
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$obj->invoke( "makePort", "1.0", "First port", "Port" );
$obj->makePort( "1.0", "First port", "Port" );


You can also use the invoke_t() method, described in “invoke_t” on page 31 to return 
additional information.


invoke_t


( $type, $value ) = 
$object->invoke_t($operation, .. args .. )>


Invokes the named class operation on the object in the same way as invoke(), but 
invoke_t() also returns the type of data returned by the call. 


The data types are encoded as integer numbers. If the return is an array, then the $value 
will receive a reference to the array. If the return is a scalar, then $value will hold it.


insertElement


$obj->insertElement( $relation, @object[s] );


Inserts the specified objects into an object relationship.


One or more can be specified to be inserted.


$obj->insertElement( "ComposedOf",
"Interface::IF-ether1", 
"Interface::Loopback/0");


$obj->insertElement( "ComposedOf", @interfaces );


removeElement


$obj->removeElement( $relation, @item[s] );


Removes the specified items from an object relationship.


One or more items can be specified to be removed.


$obj->removeElement( "ComposedOf",
"Interface::IF-ether1", 
"Interface::Loopback/0" );


$obj->removeElement( "ComposedOf", @interfaces );


delete


$obj->delete( ) 


Deletes the specified item from the repository, and from any relationships it belongs to. 
The delete() function does not remove any objects that had a “contains” type of 
relationship with the object being deleted. For example, calling delete() on a Router 
instance would remove that instance from the repository and remove that instance from 
any relationships that it was part of. However, the delete() function would not remove the 
Card objects to which the Router instance shares a “ComposedOf” relationship. 


Consider using the remove() operation, if one exists, instead for a more complete action. 
For example, calling remove() on a Router will cause the Card objects it is composed of to 
be removed (which in turn could cause the Ports/Interfaces to be removed, and so on).
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notify


$obj->notify( $event_name );


Notifies the specified event for the object.


$objref->notify( "Unresponsive" );


clear


$obj->clear( $event_name );


Clears the specified event for the object.


$objref->clear( "Unresponsive" );


countElements


$count = $obj->countElements( $relation )


Counts the number of elements in the given relationship. The countElements method will 
throw an error if $relation is not a relationship.


$count = $obj->countElements( "ComposedOf" );
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Overview
The InCharge::session module provides the interface to Domain Managers. With it you 
can:


◆ Attach to a Domain Manager


◆ Create and destroy objects


◆ Invoke operations


◆ Subscribe to Domain Manager events


Name
InCharge::session


Synopsis
 use InCharge::session;


There are three different syntaxes that you can then choose from to connect to the Domain 
Manager:


◆ $session = InCharge::session->init( );


◆  $session = InCharge::session->new( "INCHARGE" );


◆  $session = InCharge::session->new(


broker=>"localhost:426",


domain=>"INCHARGE",


username=>"noddy",


password=>"bigears",


traceServer => 1


locale=>”en_US”


 );


 $object = $session->object( "Host::toytown1" );
 $object = $session->create( "Router::crossroads" );


(... and continuing with the methods described in the following 
sections...)


Description
This module provides the mechanisms for accessing a Domain Manager in a manner that 
is similar to that employed by the ASL language. It provides the main access point to 
domains, allowing scripts to establish client/server connections and to obtain 
InCharge::object references that can be used to manipulate the objects in the topology.


The locale argument to the InCharge::session module allows you to set the locale of the 
session (the client locale). 
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You can use the InCharge::session->setLocale() method to change the locale for the 
session, while it is connected.


The default locale to set for a Perl client is determined by looking in the following places.


1. The value of the SM_LOCALE environment variable.


2. The default is en_US.


Chapter 1, “Introduction,” provides an overview of this and the other InCharge::* modules 
and a simple tutorial description of how they are used.


Function groups
InCharge::session provides access to five kinds of functions: session management, 
Domain Manager primitives, utility, wrapper, and locale specification.


Session management functions


Functions in this group are the principle functions of the module. They are used for 
managing the Perl client/Domain Manager connection. You can use these functions within 
a script to attach, detach, listen for events, and create InCharge::object references.


Domain Manager primitive functions


The InCharge::session module permits access to the low-level primitive functions of the 
Domain Manager, allowing actions such as getClasses() and getInstances() to be 
performed. These primitives do not all exactly mirror the interface provided by dmctl or the 
native ASL language. For example, dmctl has a save command that does not have an exact 
primitive equivalent, but there are two primitives that can be invoked to give the same 
results. These are storeClassRepostity() and storeAllRepository(). Where primitives exist 
that semantically match dmctl or ASL commands but differ in name, aliased names are 
provided to give syntactic compatibility.


Utility functions


This group includes functions to provide additional logical assistance to writers of Perl 
scripts to be used with the Resource Package software.


Wrapper functions


This group of functions provides wrappers around the primitives to provide an interface 
that is more consistent with the ITOps native ASL language and dmctl utility.


Wrapper functions of this type are provided only for functions where the syntax and 
semantics of the primitive are not compatible with ASL or dmctl. The save example, 
described in “Domain Manager primitive functions” on page 35, is one such function.
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Specifying the client locale


The InCharge::session module provides a function that enables you to set the locale of the 
session (the client locale).


Error handling
Errors are reported back to the invoking script by using Perl's die mechanism, and can be 
caught by using Perl’s eval function. This is typical Perl coding practice and mimics the 
try-throw-catch logic of Java and C++. “Error handling” on page 59 provides further 
information.


Session management functions
The following session management functions are provided.


new


$session = InCharge::session->new( .. options .. );


The new function first establishes a connection between the calling Perl script and a 
Domain Manager. It then returns a tied reference that can be used thereafter to 
manipulate the domain and the entities contained in its repository.


If the domain name is the sole option passed, it can be specified without the domain=> 
key.


The username and password options are required if connecting to a server with 
authentication features enabled. If neither of these arguments is given, the 
clientConnect.conf file is used to determine the username and password or the 
mechanism to obtain them.


Option to specify the Broker
broker => $host[:$port]


This option specifies the Broker from which the domain details are to be lifted. The string 
consists of a hostname or IP address followed by an optional port number, delimited by a 
colon. The section “Conventions for specifying IPv6 addresses” on page 100 describes 
how to specify an IPv6 address.


The default host is localhost, and the default port is 426.


Option to specify the domain
This option specifies the name of the domain to be used. If the host and port details are 
also given, then the API does not refer to the broker to determine them. The default 
domain name is INCHARGE.


There are two different syntaxes that can be used to specify the domain:


◆ domain => [$host:$port/]$domain


◆ server => [$host:$port/]$domain
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The option name “server” can be used in place of “domain” and the two options have the 
same meaning.


Option to specify the username
This option specifies the name of the user to be used in connecting to the domain. If user 
or username is specified, then password must also be specified, as described in “Option 
to specify the password” on page 37. If the username is not given, then the API refers to 
the clientConnect.conf file to determine the authentication information to use when 
establishing the connection.


There is no default username.


There are two different syntaxes that can be used to specify the username:


◆ user => $user_name


◆ username => $user_name


If no username is specified, the script inspects and interprets the SM_AUTHORITY 
environment variable in the same way that the main ITOps software does and may 
prompt the user for the username and password by using the standard I/O device.


Option to specify the password
This option specifies the password for the user given with the username option.


password => $password


The username and password must both be supplied, or neither of them must be specified.


Option to specify a description of the script
This option describes the role of the script and is noted by the Domain Manager for use in 
debug and other logging messages. Its contents are not significant, otherwise. The default 
is Perl-Client. 


description => $description


Option for specifying server-level tracing
If this option is specified and given a true value, non-zero, then server-level tracing is 
turned on. This causes the Domain Manager to log information about every primitive call 
invoked by the script. 


When server-level tracing is turned on, it results in a large amount of data written to the 
server's log file.


It is recommended to use this sparingly since it also has a negative impact on the Domain 
Manager's performance. 


traceServer => 1
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Option for specifying response timeout
This option specifies the timeout to be enforced while waiting for responses from the 
Domain Manager to primitive requests. The default value is 120 seconds. You may 
increase the value, if necessary, but do not set it to a value below 120 seconds. 
Otherwise, slow to-process requests will fail in a manner that looks like a communication 
link failure between the script and the Domain Manager. 


timeout => $timeout


Option for specifying the session locale
The locale option allows you to set the locale of the session (the client locale).


locale=>locale


You can use the InCharge::session->setLocale() method to change the locale for the 
session, while it is connected.


init


$session = InCharge::session->init( );


This function is the simplified version of InCharge::session->new(). It parses the script’s 
command line, looking for options that specify the Broker, Domain Manager username, 
password, trace, timeout, and locale options. Then it invokes the primitive 
InCharge::session->new() with those arguments and passes back the result.


InCharge::session->init() looks for the following script command line arguments.


--broker=<brokerIP[:bokerPort]>   (also: -b)
--server=<domain-name>            (also: -s)
--user=<username>                 (also: -u)
--password=<password>             (also: -p)
--traceServer
--timeout
--locale=<locale>


If neither the --user (or -u) and --password (or -p) are specified, the script makes use of the 
SM_HOME/conf/clientConnect.conf file to determine the username and password to be 
employed. Comments are included in the file for detailing this mechanism. This 
mechanism is turned on by specifying the value <STD> for the SM_AUTHORITY environment 
variable.


If the InCharge::session->init() functions encounters a command line syntax error, it calls 
usageError, in the main script, which the developer must provide. A single large text string 
that contains a description of the standard options handled is passed as the argument to 
usageError, which enables the author to include information about the standard options 
as well as any nonstandard ones provided. If the usageError subroutine does not exist, a 
default error message is printed on STDERR.
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Note that the init() function consumes (removes) the command line arguments it handles 
from @ARGV as it processes them. Therefore you can access the @ARGV array after its 
execution to process additional arguments without needing to skip the standard ones. 
However, you cannot use the init command twice in the same script without first saving 
and restoring the contents @ARGV, as in the example:


@SAVE = @ARGV;
$session1 = InCharge::session->init( );
@ARGV = @SAVE;
$session2 = InCharge::session->init( );


The locale argument to the InCharge::session init method allows you to set the locale of 
the session (the client locale).


You can use the InCharge::session->setLocale() method to change the locale for the 
session, while it is connected.


The default locale to set for a Perl client is determined as follows:


1. The value of the SM_LOCALE environment variable.


2. If the SM_LOCALE variable is not set, then the default is en_US.


broken


$flag = $session->broken( );


The broken() function returns non-zero (TRUE) if the session with the Domain Manager is 
broken in some way.


A return value of non-zero indicates connection or protocol failures. To continue working 
with a broken session, the script should call the reattach() function, and then reestablish 
the event subscription profiles required.


reattach


$session->reattach( );


Reestablishes a connection that has been detached or broken.


The reattach() function can be called to reconnect to a server to which the connection has 
been lost. Reestablishing the connection does not automatically reestablish observer 
sessions, subscriptions, transactional or other session state information.


If the call is used to reattach a session that had an active observer, the observer 
connection is closed as a side effect of the action and must be reopened separately.


This function should be called after a [13] I/O Error is thrown by any of the Domain 
Manager access calls in order to shut down and reopen the socket, leaving the session in 
a working state. If this step is not taken, there is a danger that residual packets on the 
connection would cause synchronization problems between the client and Domain 
Manager. “Error handling” on page 59 describes error prefixes, including the [13] prefix.
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The reattach() primitive does not return a new session identifier, but does refresh the 
referenced one. This is not a dup() style of action.


detach


$session->detach( );


The detach() function enables you to detach from the domain referred to by $session.


This function can be used for either a session, created using InCharge::session->new(), or 
an observer session, created using InCharge::session->observer().


If this is used to detach a session with an active observer, the observer is also closed.


This call does not completely destroy the $session reference contents but retains enough 
information to allow the session to be reestablished. Thus, it is possible to call 
$session->reattach() to reconnect to the Domain Manager by using the same parameters 
as were used in the initial connection. However, the event subscriptions need to be 
reestablished explicitly in this event.


observer


$observer_session = $session->observer( .. options .. );


The observer() function creates and returns a reference to a connection to a Domain 
Manager on which subscribed events can be received.


This establishes a new socket between the client and Domain Manager. Once connected, 
events can be subscribed to by using the various subscribe methods, and they can be 
received by using:


@event_info = $observer_session->receiveEvent( );


Specifying the option connectEvents => 1 to the observer() function causes server 
disconnection to be notified as a DISCONNECT event rather than an [13] I/O Error. 
However, unlike ASL, the reconnection is not performed automatically. The script can use 
the $session->reattach() call to attempt an explicit reconnection and must then reestablish 
any event subscriptions and other contexts.


Specifying the option ignoreOld => 1 causes events generated before the connection was 
established to be discarded automatically. The use of this option is not generally 
recommended since the atomicity of time measurement on Windows NT and UNIX makes 
its results somewhat unpredictable.


Repeated calls to the observer() method of a session return references to the same 
observer. It is not possible to create multiple observers on the same session.


receiveEvent


@event = $observer_session->receiveEvent( [ $timeout ] );


Listen for subscribed events from the Domain Manager.
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The received events are returned as an array or, in scalar context, a reference to an array 
containing three or more elements. “Event subscription” on page 17 describes the 
different events to which you can subscribe.


The first element of all events is the timestamp, on the Domain Manager's system clock, 
and not the client's clock. The second element is a string defining the event type. The 
other elements are event-specific.


The $timeout is optional, and specifies a timeout period, in seconds, that the script is 
prepared to wait for an incoming event. If no event arrives in this time period, an event of 
type TIMEOUT is returned. The $timeout can be specified in fractions of a second, or 
“float”; for example, 0.25 = a quarter second.


object


$obj = $session->object( $objectname );


Creates a new InCharge::object reference that can be used to invoke methods of the 
InCharge::object module.


As an example, to obtain the value of the Vendor field for a particular object, use:


$obj = $session->object( "::gw1" );
$vendor = $obj->{Vendor};


You can even combine these into a single line, such as:


$vendor = $session->object( "::gw1" )->{Vendor};


The $objectname parameter can be specified in any of the styles shown in the following 
examples:


◆ object( 'Router::gw1' )


In this example, the $objectname parameter is a single string where both the class 
and instance names are specified with double colons (::) delimiting them. If variables 
are to be used to specify the relevant parts of the string, then it is important that at 
least the variable before double-colon (::) is encased in braces because without them, 
Perl will give the (::) characters its own meaning. 


◆ object( 'Router', 'gw1' )


In this example, the $objectname parameter is specified as two strings with one for 
the class and one for the instance name. 


◆ object( '::gw1' )


In this example, the $objectname parameter is specified as one string with the class 
name missing. The API will make a query to the Domain Manager to discover the actual 
class for the object which causes a minor performance penalty. 


◆ object( undef, 'gw1' )


In this example, the $objectname parameter is specified as two parameters with the 
first one undefined. This also results in the API performing a Domain Manager query. 


◆ object( 'gw1' )
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In this example, the $objectname parameter is specified as a single parameter that 
does not include the double-colon (::) delimiter, which must contain just the instance 
name. A Domain Manager query is performed to determine the relevant class name. 


An important difference between the API and the native ASL language is that if you create 
an object, using object(), in native ASL without specifying the class name, the language 
assumes that the class MR_Object can be applied. This restricts the level of property and 
operation access that can be used. The API queries the repository to determine the actual 
class for the instance, giving complete access to the resulting object's features.


create


$obj = $session->create( $objectname );


Similar to the object() call, described in “object” on page 41, the create() call creates an 
InCharge::object valid reference through which a specified instance can be manipulated. 
However, unlike object(), the create() method creates the object if it does not already 
exist.


Since it has the ability to create objects, it is important that the object name specified as 
an argument includes both the instance name and the class name. You cannot use the 
::instance or (undef, $instance) syntaxes for specifying the object name. You can, 
however, use either the Class::Instance or ($class, $instance) syntax described for the 
object() method.


Unlike the createInstance() primitive, it is not an error to call the create() method for an 
object instance that already exists. In this case, the call is equivalent to the 
$session->object() call and it simply returns the InCharge::object valid reference to the 
instance.


callPrimitive


RESULT = $session->callPrimitive($primitiveName, @arguments)


Calls the specified Domain Manager primitive, passing the primitive the arguments and 
returning its result.


For most primitives, this is a complex invocation sequence. However, it is only actually 
needed when a primitive and a method of the InCharge::session module share the same 
name, and you wish to use the primitive version.


The following are equivalent, although the first is preferred.


@list = $session->getInstances( "Router" );
@list = 


$session->callPrimitive("getInstances", "Router");


The put() primitive is one of the few primitives where these two ways of calling it are not 
equivalent. This is because the InCharge::session module exports its own variant of the 
method. If you must gain access to the primitive version, you will need to use the 
callPrimitive() mechanism. However, this is not recommended, since the syntax is 
complex. The “put” on page 47 provides further details.
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The type of the RESULT in array or scalar context is dependant on the primitive that is 
being called. In general:


◆ If the primitive returns a scalar you get a scalar or, in array context, a single element 
array.


◆ If the primitive returns an array you get an array, in array context, or array reference, in 
scalar context.


Utility functions
The following utility functions are provided.


TYPE


$number = $session->TYPE( $string );
$string = $session->TYPE( $number );


The TYPE() function converts a Domain Manager data type symbolic name to its internal 
numeric code, or converts an internal numeric code to its symbolic name. So the following 
prints “13”:


print $session->TYPE( "STRING" ) . "\n”;


The following code prints “STRING”:


print $session->TYPE( 13 ) . "\n”;


getFileno


$fno = $session->getFileno( );


The getFileno( ) function returns a number that refers to the socket used for the 
script/server connection. 


On Windows platforms, this function returns a unique number associated with the 
connection handle that refers to the socket used by the script/server connection. 


Do not use this function with the Perl select statement to listen for events from multiple 
domains by using multiple observer objects. Instead, use the new select function: 
InCharge::session::select.


getProtocolVersion


$ver = $session->getProtocolVersion( );


The getProtocolVersion( ) function returns the protocol version number supported by the 
Domain Manager. This is a single integer number derived by the following calculation.


( major * 10000 ) + (minor * 100) + revision


Hence, version “V5.1” is represented by the number 50100, and version “V4.2.1” is 
represented by 40201.
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primitiveIsAvailable


$boolean = $session->primitiveIsAvailable( $primitive_name )


The primitiveIsAvailable() function checks whether the named primitive is available in the 
Domain Manager.


A value of 1 means that it is available, and value of 0 means that it is not available, either 
because it is an undefined primitive or it was introduced in a later version of the Domain 
Manager software.


if ( $session->primtiveIsAvailable (
"getMultipleProperties" ) {


$vendor, $model ) = $session->getMultipleProperties (
$obj, [ "Vendor", "Model" ] );


} else {
$vendor = $obj->{Vendor};
$model = $obj->{Model};


}


select


@ret = InCharge::session::select(\@observerList, $timeout);


The select() function checks if there are data to be read for each observer in 
@observerList.


@ret returns a list of handles in which the value:


◆ 1 represents that the observer has data to read


◆ 0 indicates that there are no data to be read.


The $timeout parameter indicates how many seconds the function select should wait 
before returning the result. It can be called with an undef value for no wait time.


Example of usage:


@ret = InCharge::session::select(<ref_list>,<timeout>);


where:


◆ <ref_list> is a reference to the list of observers that will be checked.


◆ <timeout> is the number of seconds to wait before returning. For immediate return, use 
the argument undef.


The following script returns an array with the result for each checked observer.


use InCharge::session;
use Data::Dumper;
my %common = (user => "admin", password => "changeme");
$mask = "";
$i=0;
foreach $dom ( "INCHARGE-AM", "INCHARGE-SA" ) {


$sess{$dom} = InCharge::session->new( %common, domain => $dom );
$obs{$dom} = $sess{$dom}->observer( );
@obsList[$i]= $obs{$dom};


       $sess{$dom}->subscribe( ".*::.*::.*/pa" );
#$fn{$dom} = $obs{$dom}->getFileno()."\n";
#vec($mask, $fn{$dom}, 1) = 1;
$i++;


}
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$i=0;
for ( ; ; ) {
       $i=0;


@obsRet = InCharge::session::select( \@obsList, undef);
foreach $obsR ( @obsRet ) {


#next unless (vec($rout, $fn{$dom}, 1));
@event = $obsR->receiveEvent( );
print "$obsR->{domain} - ".join( ", ", @event ). "\n";
$i++;


}
}


Specifying the locale while connected
The setLocale() method may be used to indicate the locale in which text will be returned to 
the client for the session, while it is connected.


If the locale has not been set for the session while connecting or the setLocale() method 
has not been called, then the session locale is determined as follows:


1. The value of the SM_LOCALE environment variable.


2. The default is en_US.


Retrieving and setting log, error and trace levels at runtime
There are three computed attributes available to get and set the log, error, and trace levels 
of a Domain Manager at runtime. These computed attributes, described in Table 15 on 
page 45, are available on the SM_System object. 


The values of these computed attributes can be retrieved and set, and valid values are:


◆ None


◆ Emergency


◆ Alert


◆ Critical


◆ Error


Table 15  Computed attributes to retrieve and set log, error, and trace levels at runtime


Computed Attributes Description


logLevel The minimum exception level for sending messages to the system error 
logger. The logLevel attribute is a string, and can be any one of the values 
set for the --loglevel command line option:


errLevel The minimum exception level for writing messages to the log files. The 
errLevel attribute is a string, and can be any one of the values set for the 
--errlevel command line option. 


traceLevel Used to print a stack trace to the ITOps log file when an exception at this 
level or above occurs. Exceptions below this level do not write a stack 
trace. The traceLevel attribute is a string, and can be any one of the values 
set for the --tracelevel command line option. 
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◆ Warning


◆ Notice


◆ Informational,


◆ Debug


Fatal is a synonym for Critical.


Retrieving the current level


You can retrieve the current levels of SM_System::SM-System::logLevel, 
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel. A string is 
returned which represents the current level, such as "Warning", "Error", or "Fatal". For 
example:


my $smsystem = $session->object("SM_System","SM-System");
my $curr_error_level = $sm_system->{errLevel};


Setting the level


To change the current levels, obtain a pointer to the object, and then set the value of 
SM_System::SM-System::logLevel, SM_System::SM-System::errLevel, or 
SM_System::SM-System::traceLevel to the appropriate level. 


In this example, the trace level setting is changed to None. 


my $smsystem = $session->object("SM_System","SM-System");
$sm_system->{traceLevel} = "None";


When you change the log, error or trace levels a message is printed in the log file. The log 
message will appear similar to the following:


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6
JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl 
client (id 6), on host host1 with credentials tpadmin1 has changed 
the Trace level to None; in file 
"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458


Wrapper functions
The following functions add varying degrees of wrapper logic round the ITOps primitives, 
to make them more compatible with the native ASL language. 


save


$session->save( $filename [, $class ] );


The save() function saves the repository in the specified file. If a class name is specified, 
then only the instances of that class are saved.
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put


$session->put( $object, $property, $value );


It is not recommended that the put() method be used extensively. Instead, use the 
features of InCharge::object.


This method changes the value of an object property. This version differs from the put_P() 
primitive in that the latter requires the value type to be specified explicitly, whereas this 
version determines and caches the type. The following calls are, therefore, equivalent, 
although the first is preferred.


$obj = $session->object( "Router::gw1" );
$session->{Vendor} = "Cadbury";
$obj->put( "Vendor", "Cadbury" );
$obj->put( Vendor => "Cadbury" );
$session->put( "Router::gw1", "Vendor", "Cadbury" );
$session->object( "Router::gw1" )->{Vendor} = "Cadbury";
$session->callPrimitive( "put_P", "Router", "gw1",


"Vendor",[ "STRING", "Cadbury" ] );


When giving a value to an array property, such as the ComposedOf relationship, pass an 
array reference as shown in the following example:


$obj->{ComposedOf} = [
"Interface::IF-if1",
"Interface::IF-if2"
];


Also, you can set more than one property in a single call. This can reduce complexity in the 
script layout but has minimal performance advantage.


$obj->put(
Vendor   => "CISCO",
Model    => "2500",
Location => "Behind the coffee machine"


);


invoke


RESULT = $session->invoke($object, $operation[, @arguments]);


It is not recommended that this method be used extensively. Instead, use the features of 
InCharge::object.


This method invokes the specified object operation, passing it the listed arguments and 
returning the RESULT.


The type of the RESULT depends on the usual Perl concept of array or scalar context, as 
well as the definition of the operation being called. In general:


◆ If it returns a scalar you get a scalar or, in array context, a single element array. 


◆ If it returns an array you get an array, in array context, or array reference, in scalar 
context.
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This method's semantics and syntax differ from the primitive method invokeOperation() in 
that the latter needs to have the types of the arguments specified explicitly. Whereas for 
this method, the InCharge::session module version discovers and caches the operation 
argument types and does not require the arguments to be listed in arrays of array 
references.


Additional documentation about the operations that exist for a particular class can be 
obtained by using the dmctl utility, as shown:


dmctl -s DOMAIN getOperations CLASSNAME


The following examples are equivalent; the first example is preferred.


◆ Example 1:


$obj = $session->object( "Router::gw1" );
$fan= $obj->findFan( 2 );


◆ Example 2:


$fan = $session->invoke( "Router::gw1", "findFan", 2 );


◆ Example 3:


$fan = $session->callPrimitive( "invokeOperation","Router", "gw1", 
"findFan",[ [ "INT", 2 ] ]
);


invoke_t


($type, $value) =
$session->invoke_t( $object, $operation [, @arguments]


);


The invoke_t() function is identical to invoke() except that the return indicates both the 
type and the value of the returned data.


The value is a Perl scalar, if the operation returns a scalar, or an array reference, if the 
operation returns an array. The type will contain one of the Domain Manager internal type 
codes. For example, “13” is the code for a string.


findInstances


@instances =
$session->findInstances( $c_patn, $i_patn [, $flags] )


or


@instances =
$session->findInstances( "${c_patn}::${i_patn}" [, $flags] )


Finds instances that match the class and instance patterns, according to rules specified in 
the flags.


The $flags is a set of characters that modifies the way the call works.

48 EMC Smarts Foundation Perl Reference Guide







InCharge::Session

A flag of “n” means that subclasses are not recursed into. Therefore, instances in 
matching classes only are returned. Without “n”, instances of matching classes and their 
subclasses are returned.


A flag of “r” means that UNIX-like RegEx matching is used during the search. If the “r” flag 
is not specified, the search uses glob pattern matching.


The RegEx version that is supported is the UTF-8 and Unicode regexp compliant engine 
(coming from ICU).


The default is no flags, therefore, the search uses glob pattern matching and recursion.


Results are returned as a list of strings, each of which contains a class and instance name 
delimited with double-colon (::).


The search strings are anchored as if the “^” and “$” had been used in the UNIX-style 
pattern. Therefore, “rr*” matches “rred” but not “herring”, whereas “`*rr*” matches both 
of them.


Example:


@found = $session->findInstances( "Router::gw*", "n" );


getCauses


@events = $session->getCauses( $objectname, $event [, $oneHop] );


The getCauses() function returns a list of problems that cause an event.


The function arguments are class, instance (possibly combined into one, for example, 
SM_System::SM-System), and event. The function returns the problems that cause the 
event based on the relationships among instances defined in the Domain Manager.


The oneHop parameter is optional: 


◆ If it is omitted or passed as FALSE, the full list of problems that explain eventname, 
whether directly or indirectly, is returned. 


◆ If it is passed as TRUE, only those problems that directly list eventname among the 
events they explain are returned.


The function returns an array of array references with the format:


[
[ <classname::instancename>,<problemname> ],
[ <classname::instancename>,<problemname> ],
...


]


The class and instance names are returned as a single double-colon (::) delimited string, 
giving two strings per returned event in total. This is different from the native ASL language 
which returns the class and instance names separately, giving three strings for each event.
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Example:


@causes =
$session->getCauses( "Router::gw1",


"MightBeUnavailable"
);


getClosure


@events = $session->getClosure($object, $eventname[, $oneHop]);


The getClosure() function returns a list of symptoms associated with the problem or 
aggregate based on the relationships among instances defined in the Domain Manager.


The oneHop parameter is optional:


◆ If it is omitted or passed as FALSE, the full list of problems that explain eventname, 
whether directly or indirectly, is returned. 


◆ If it is passed as TRUE, only those problems that directly list eventname among the 
events they explain are returned.


The function returns an array of array references with the format:


[
[ <classname::instancename>,<problemname> ],
[ <classname::instancename>,<problemname> ],
...


]


The class and instance names are returned as a single double-colon (::) delimited string, 
giving two strings per returned event in total. This is different from the native ASL language 
which returns the class and instance names separately, giving three strings for each event.


Example:


@symptoms =
$session->getClosure( "Router::gw1", "Down", 0 );


getExplains


@events = $session->getExplains($object, $eventname[, $onehop ]);


MODEL developers can add information to a problem in order to emphasize events that 
occur because of a problem. The getExplains() function returns a list of these events.


The $onehop parameter is optional:


◆ If it is omitted or passed as FALSE, the full list of problems that explain $eventname, 
whether directly or indirectly, is returned. 


◆ If it is passed as TRUE, only those problems that directly list eventname among the 
events they explain are returned.


The function returns an array of array references with the format:


[
[ <classname::instancename>,<problemname> ],
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[ <classname::instancename>,<problemname> ],
...


]


The class and instance names are returned as a single double-colon (::) delimited string, 
giving two strings per returned event in total. This is different from the native ASL language 
which returns the class and instance names separately, giving three strings for each event.


getExplainedBy


@events = $session->getExplainedBy($object, $event[, $onehop ]);


The getExplainedBy() function is the inverse of the getExplains() function.


It returns those problems (or events) which the MODEL developer has listed as explaining 
this event.


The $onehop parameter is optional:


◆ If it is omitted or passed as FALSE, the full list of problems that explain $event, 
whether directly or indirectly, is returned. 


◆ If it is passed as TRUE, only those problems that directly list $event among the events 
they explain are returned.


The function returns an array of array references with the format:


[
[ <classname::instancename>,<problemname> ],
[ <classname::instancename>,<problemname> ],
...


]


The class and instance names are returned as a single double-colon (::) delimited string, 
giving two strings per returned event in total. This is different from the native ASL language 
which returns the class and instance names separately, giving three strings for each event.


subscribe and unsubscribe


$session->subscribe( $C, $I, $E [, $flags ] );
$session->subscribe( "$C::$I::$E[/$flags]" );
$session->unsubscribe( $C, $I, $E [, $flags ] );
$session->unsubscribe( "$C::$I::$E[/$flags]" );


These functions subscribe, or unsubscribe, to notifications of the specified events. “$C”, 
“$I”, “$E” must be regexp patterns that represent the classes, instances, and events to 
which to subscribe.


The unsubscribe() function is the inverse of subscribe().
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The $flags value is a bitwise combination of the values or a more mnemonic string as 
shown in Table 16 on page 52. 


As a compatibility aid, the $flag can also be specified as a string of letters. In this case, 
each of the letters are subscription qualifiers: 


◆ “p” means subscribe to problems


◆ “a” means subscribe to aggregates (impacts)


◆ “e” means subscribe to events. 


If “p”, “a” or “e” are not present, “p” is assumed. 


◆ “v” means run in verbose mode, which turns on subscription control messages.


The action of these options is the same as that provided by the sm_adapter program’s 
--subscribe= option.


Examples:


$session->subscribe( "Router", ".*", ".*", "/pev" );
$session->subscribe( "Router::.*::.*/peav" );
$session->subscribe( $obj, ".*", 0x3 );
$session->unsubscribe( $obj, ".*", 0x3 );


Table 16  Subscription flag parameter values


Flag bitfield value Description


0x000001 Simple event


0x000002 Simple aggregation


0x000010 Problem


0x000020 Imported event


0x000040 Propagated aggregation


0x0000ff All


0x001000 Expand subclasses


0x002000 Expand subclasses events


0x004000 Expand aggregations


0x008000 Expand closures


0x010000 Sticky


0x020000 Undo all


0x040000 Quiet accept


0x080000 Quiet suspend


0x100000 Glob
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transaction, abortTxn and commitTxn


$session->transaction( [ $flag ] );
$session->abortTxn( );
$session->commitTxn( );


These functions start, commit, and abort transactions. 


Using transactions, you can commit many changes to the objects in a Domain Manager as 
a single atomic transaction, or choose to abort all of them. Use the following syntax to 
create a transaction:


$session->transaction();


After initiating the transaction, every change made to an object does not affect the object 
until you commit the transaction. If the transaction is aborted, any changes made will not 
affect the object. Use the following syntax to either commit or abort a transaction.


$session->commitTxn( );


or


$session->abortTxn( );


The changes made with a transaction are not visible outside of the script until the changes 
are committed. Within a transaction, the same script can see the proposed changes. 
Transactions also can control how other applications see objects before changes are 
committed or aborted by adding a single keyword. 


The syntax of a transaction with a keyword is:


$session->
transaction(["WRITE_LOCK"|"READ_LOCK"|"NO_LOCK"]);


A keyword can be any one of those described in Table 17 on page 53. 


Transactions may be nested. When you nest a transaction, you must commit or abort the 
nested transaction before you commit or abort the previous transaction.


The API aborts any open transactions when the script terminates.


Example:


#! /usr/local/bin/Perl
$session = InCharge::session->init( );
$delthis = shift @ARGV;
$delthisObj = $session->object($delthis);
@relObj = @{ $delthisObj->{ComposedOf} };
$session->transaction();
$x = $delthisObj->delete();


Table 17  Transaction lock options


Keyword Description


WRITE_LOCK While the transaction is open, no other process can modify or access 
information in the repository.


READ_LOCK The behavior of READ_LOCK is the same as WRITE_LOCK.


NO_LOCK This is the default behavior. No locks exist until the script commits the 
transaction.
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foreach $mem (@relObj) {
$mem->delete();


}
$session->commitTxn();
print("Deleted ".delthis." and related ports\n”);


In the example, the script deletes a card and its related ports. The script is invoked with an 
argument that specifies the card to delete. Using the ComposedOf relationship, the script 
creates a list of port objects to delete. The script deletes the card and its related ports at 
the same time through a transaction that ensures that no other script can see the 
intermediate stage with an incompletely deleted suite of objects.


delete


$session->delete( $object );


The delete() function deletes the specified object instance from the repository.


This does not clean up all the object interdependencies and links. For a cleaner object 
deletion, use the remove() operation, if one exists, for the object class in question. The 
section “invoke” on page 89 also provides additional information to the related invoke() 
primitive.


The delete() method can be called in one of two ways.


$session->delete( $object );


or


$object->delete();


getEventType


$type = $session->getEventType( $class, $event );


Given a class and event name, the getEventType() function returns a string that describes 
the type of the event. The possible strings returned are described in Table 18 on page 54. 


Example:


$type = $session->getEventType( "Router", "Down" );


To obtain the low-level numeric type codes, instead of descriptive strings, use the 
getEventType() primitive, as shown.


Table 18  Event types


Event type literal Description


EVENT Event


AGGREGATION Aggregation


SYMPTOM Symptom


PROBLEM Problem


UNKNOWN Error indication
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$type = 
$session->primitive( "getEventType", "Router", "Down" );


getServerName


$session->getServerName( );


The getServerName() function returns the name of the Domain Manager to which the 
session is connected.


insertElement


$session->insertElement( $object, $relation, @item[s] );


The insertElement() function inserts one or more elements into an object relationship.


It is suggested that the insertElement() feature of the InCharge::object module be used 
instead, as shown.


$obj->insertElement( $relation, @item[s] );


removeElement


$session-E>removeElement( $object, $relation, @item[s] );


The removeElement() function removes one or more elements from an object relationship, 
such as ComposedOf. 


It is recommended that the removeElement() feature of the InCharge::object module be 
used instead, as shown.


$obj->removeElement( $relation, @item[s] );
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Primitive naming conventions
The Domain Manager primitives are low-level remote calls that are supported by the API. 
These primitives provide the standard protocol between client applications, such as 
dmctl, ASL adapters, API scripts, and the Domain Manager. 


Name


InCharge::primitives 


Conventions


The names given to the primitives follow a convention of using lowercase, except for the 
first letter of the second and subsequent words of multiword names. For example, to get 
operation arguments, the name of the primitive is getOperationArguments.


Where the resulting names are overly long, the API provides shorter aliases; 
getOperationArguments() has the alias getOpArgs(). Typically, the word “Operation” is 
shortened to “Op”, and “Property” is shortened to “Prop”, however, both the long and 
shortened name can be used. Both forms are described in the following sections.


Since primitives are designed to be called by using the InCharge::session, where a 
primitive name conflicts with a module function, the name of the primitive has the string 
“_P” concatenated onto it in order to differentiate the two. Script authors are discouraged 
from using these “_P” versions since higher-level versions are available through 
InCharge::session and, in some cases, InCharge::object that are easier to use.


Where a primitive returns a value that may be of any type, a second version of the call is 
provided that returns both the numeric type code and the return value. The name of this 
extended version is the same as the lesser original but with “_t” appended. You can also 
specify “_T” instead of “_t”, in which case when the primitive returns an 
ANYVAL_ARRAY_SET (that is, a structure of structures), the fields of the structures are also 
accompanied by their types. This is a reference to a two-element array containing type and 
value for each structure field.


The primitive names are similar to those used in the C++ API. Where the names do not 
match those used by ASL or dmctl, aliases are provided. For example, the ASL command 
get Instances() is called get Leaf Instances() in the C++ API. Therefore, the API allows both 
names to be used. The C++ name is the name used for the actual primitive and the ASL 
name is provided as an alias.


The C interface for EMC Smarts software, on the other hand, uses function names that look 
like sm_property_unsubscribe(). They start with “sm_” and use all lowercase words 
delimited by underscores. This set of functions is less complete than the C++ equivalent 
interface and does not provide a one-to-one match of all the Domain Manager primitives. 
The API for Perl does not provide a match for the C interface function names.


Primitive calling conventions
All the functions described in this document must be invoked with reference to a valid 
object of the InCharge::session module. These object references are created by using 
InCharge::session->object(), InCharge::session->create(), or 
InCharge::session->getInstances().
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The general approach used for calling primitives is as follows:


1. Initialize a session and obtain a reference to it.


$session = InCharge::session->init( );


2. Call the primitives required, by using the session reference. For example:


foreach $class ( sort $session->getClasses() ) {
foreach $inst (


sort $session->getInstances($class))
{


print $class . "::" . $inst . "\n”;
}


}


3. Close the session.


$session->detach( );


Where access to operations or properties of Domain Manager repository objects is 
required you are discouraged from using the get(), put() and invokeOperation() primitives, 
but encouraged to use the features of the InCharge::object module instead. Using this 
approach, the script obtains an InCharge::object reference, which is used to access the 
required information. For example,


1. Establish a session.


$session = InCharge::session->init();


2. Create an InCharge::object valid reference to the object of interest.


$obj = $session->object( "Router::gw1" );


3. Manipulate the object by using the reference.


$type = $obj->{Type};
$obj->{Vendor} = "Cisco";
$fan1 = $obj->findFan( 1 );


4. Close the session.


$session->detach( );


Error handling
All the functions and methods of objects in the API modules throw errors by using the Perl 
die command. In order to catch any errors that may occur, the eval() function can be used 
and the “$@” variable inspected after the event. This is common Perl scripting practice. 
The error message is rendered in the locale set by the client session. 


The example shown in the following script will abort if the router “gw1” does not exist in 
the topology at the line where the name of the vendor is queried, and the last line will not 
be executed.


use InCharge::session;
$session = InCharge::session->init();
$vendor = $session 


->object( "Router::gw1" )
->get("Vendor”);


print "Vendor is $vendor\n”;
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To trap this possible error, the code can be modified as follows.


use InCharge::session;
$session = InCharge::session->init();
$vendor = eval{


$session ->object( "Router::gw1" ) ->get(Vendor);
};
if ( $@ ) {


print "Error obtaining the Vendor property\n”;
} else {


print "Vendor is $vendor\n”;
}


For more details about using this mechanism, refer to the section on the eval and die 
functions in the Perl function man pages.


All error messages thrown by the API start with a number in square brackets. This is the 
error code and classifies the error as being one of those listed in Table 19 on page 60. The 
remainder of the error text gives a verbose description of the specific error that was 
thrown. Where additional numeric codes are relevant, these are included in a second or 
subsequent set of square brackets.


The following example script attempts a connection with a Domain Manager and prompts 
for a username and password if the connection fails due to an authentication error: code 4.


my $domain = "SAM1";
my $user = undef;
my $passwd = undef;
for ( ; ; ) {


$session = eval{ InCharge::session->new(
domain => $domain,
username => $user,
password => $passwd);


}
if ( $@ =~ m/^\[4\]/ ) {


print "Login: ";    chomp $user   = <STDIN>;
print "Password: "; chomp $passwd = <STDIN>;


} elsif ( $@ ) {
die $@; # Some other fault


} else {
last;   # Success !


}
}


Error codes
Table 19 on page 60 provides a description of the different error codes and their 
associated types. 


Table 19  Error codes 


Error code Error type Description


1 Syntax error Wrong number of arguments, missing argument, or too many 
arguments


2 System error System call error; e.g., socket creation failed


3 Connection error Socket connection error
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Data types
The names of the variables used in the primitive descriptions, in the following sections, to 
denote the arguments and return values indicate the data type passed or expected. 
Although every effort has been made to use self-descriptive argument names in this 
guide, some need further explanation.


$session


The $session data type is a reference to a valid InCharge::session object - created by using 
InCharge::session->new() or InCharge::session->init(). All Domain Manager primitives 
should be called with reference to an InCharge::session object, as shown: 


$session = InCharge::session->init();
@list = $session->getClassInstances( "Router" );


$object


The $object data type is the specification of a repository object to be acted upon.


4 Authentication error Authentication error


5 HTTP error Other session init failure (HTTP error in second number, such 
as “[5][301]”


6 Bad argument Argument content or type error, or invalid name, invalid 
option, or wrong type, such as a scalar argument being 
passed but a reference was required


7 Broker error Cannot attach to Broker


8 No domain Domain not registered with Broker


9 Protocol error Protocol error, data size error, or unsupported protocol format


10 Isolated Not attached


11 Invalid operation Invalid or illegal operation


12 Bad function Bad function call or primitive name


13 IO error Socket IO error


14 Timeout Timer expired


15 DM error Error returned by Domain Manager


16 Not cached Reply missing from cache


17 Configuration error A required configuration element, such as an environment 
variable, is either missing or contains invalid data


Table 19  Error codes  (continued)


Error code Error type Description
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This can be given in one of the formats described in Table 20 on page 62. 


@objects


The @objects data type is a list of objects is to be returned, which is only used as a return 
type.


The return is an array of object name strings in the “ClassName::InstanceName” format.


$symptom, @symptoms


A number of calls return lists of symptoms. These are represented as an array of array 
references. Each subarray consists of four elements, each of which has the following 
significance:


$x[0] = type (INT)
$x[1] = certainly (FLOAT)
$x[2] = object (STRING - class::instance)
$x[3] = event/symptom name (STRING


You can gain access to the elements by using one of the following syntaxes:


◆ $list[ $record_number ] -> [ $field_number ]


◆ $listref -> [ $record_number ] -> [ $field_number ]


The first syntax is used where the list is held in an array variable. The second syntax is 
used when the list is held in an array pointed to by a reference.


Table 20  Formats to specify a repository object


Format Description


'class::instance' This format uses a single string, containing both the class and instance 
name with two colons between them. 
$n =


$session->countElements("Router::gw1",
"ComposedOf");


'::instance' This format uses two parameters, where the first contains the class and 
the second contains the name of the instance.
$n = $session->countElements( "::gw1",


"ComposedOf" );


$class, $instance This format uses two parameters, where the first contains the class and 
the second contains the name of the instance.
$n = 


$session->countElements( "Router",
"gw1", "ComposedOf" );


undef, $instance This format uses two parameters. The first parameter contains the Perl 
undef value, to indicate that it is unknown. This causes the API to 
perform a query to determine that name of the object's class. This 
syntax can only be used to refer to existing objects.
$n = $session->countElements(undef, "gw1",


"ComposedOf");


InCharge::object 
reference


This format is used whenever an object name is required. It is also 
possible to pass an InCharge::object reference.
$obj = $session->object( "Router::gw1" );
$n = $session->countElements( $obj, 


"ComposedOf" );
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$symptomData, @symptomData


Symptom data is returned as an array of nine values, as described in Table 21 on page 63. 
When a list of symptoms is returned, it is formatted as an array of array references where 
each subarray contains the nine fields for a single symptom. 


$type, @types


The Domain Manager protocol uses a range of integer values to identify the types of data 
being passed. These are used when a primitive is permitted to handle more than one data 
type as an argument or return value. For example, the invoke() primitive can take 
arguments of any type, such as integer, string, and Boolean. When specifying a type as a 
primitive function argument you can either use the numeric value or the mnemonic string, 
as shown in the following example. For a string, either use “13” or “STRING”. When type 
codes are returned by primitives, they are always returned as the numeric code.


To convert from the numeric code to the mnemonic string and back, use one of the built-in 
TYPE methods of the InCharge::session module, as shown:


◆ $mnemonic = $session->TYPE( $code )


◆ $code = $session->TYPE( $mnemonic )


Table 22 on page 63 describes the type code values that are used. 


Table 21  Symptom data codes


Symptom data code Description and type


$x[0] state (INTEGER)
0 = active
1 = inactive
2 = suspended
3 = not monitored


$x[1] last occurrence (LONG INTEGER)


$x[2] instance display name (STRING)


$x[3] class display name (STRING)


$x[4] event type (INTEGER)


$x[5] event certainty level (FLOAT)


$x[6] event class (STRING)


$x[7] event instance (STRING)


$x[8] event name (STRING)


Table 22  Type codes (page 1 of 2)


Constant Literal Description


0 VOID void (nothing)


1 ERR error condition


2 BOOLEAN boolean (1 = true, 0 = false)


3 INT signed integer
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$freshness


Where the function argument list takes a freshness parameter, this refers to how fresh the 
property being accessed by the function should be. This applies to polled or derived 
properties that may need recalculating or repolling if the property was last updated more 
than the specified $freshness seconds ago.


4 UNSIGNED unsigned integer


5 LONG signed long integer


6 UNSIGNEDLONG unsigned long integer


7 SHORT signed short integer


8 UNSIGNEDSHORT unsigned short integer


9 FLOAT floating point


10 DOUBLE double length floating point


12 CHAR 1-byte character


13 STRING string


14 OBJREF object (class and instance)


15 OBJCONSTREF constant object reference


16 BOOLEAN_SET set of booleans


17 INT_SET set of signed integers


18 UNSIGNED_SET set of unsigned integers


19 LONG_SET set of signed long integers


20 UNSIGNEDLONG_SET set of unsigned long integers


21 SHORT_SET set of signed short integers


22 UNSIGNEDSHORT_SET set of unsigned short integers


23 FLOAT_SET set of floating point numbers


24 DOUBLE_SET set of double length floats


26 CHAR_SET set of 1-byte characters


27 STRING_SET set of strings


28 OBJREF_SET set of objects (class and instance)


29 OBJCONSTREF_SET set of constant object references


30 ANYVALARRAY set of values (types included)


31 ANYVALARRAY_SET two-dimensional array of values


Table 22  Type codes (page 2 of 2)


Constant Literal Description
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classExists


$boolean = $session->classExists( $class )


The classExists function returns 1 if the specified class exists or 0 otherwise.


if ( $session->classExists( "Router" ) ) {
print "Router class exists\n”;


}


consistencyUpdate


$session->consistencyUpdate( )


The consistencyUpdate() function causes the Domain Manager to recompute the 
correlation codebook.


correlate


$session->correlate( )


The correlate() function triggers the “Code book” correlation actions, where symptoms are 
analyzed and correlated into problems.


countChildren


$count = $session->countChildren( $class )


The countChildren() function counts the child classes of the specified class. 


$class = "ICIM_UnitaryComputerSystem";
$n = $session->countChildren($class);


countClassInstances


$count = $session->countClassInstances( $class )


The countClassInstances() function counts the number of objects that exist for a specified 
class, or those that would be returned by a call to getClassInstances().


$n = $session->countClassInstances( "Router" );


countClasses


$count = $session->countClasses( )


The countClasses() function counts the number of classes present in the system.


$n = $session->countClasses( );
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countElements


$count = $session->countElements( $object, $relation )


The countElements() function counts the number of elements in the specified 
relationship.


$n = $session->countElements("Router::gw1","ComposedOf");


countInstances


$count = $session->countInstances( )


The countInstances() function counts the total number of objects in the repository, of all 
classes.


$n = $session->countInstances( );


countLeafInstances


$count = $session->countLeafInstances( $class )


The countLeafInstances() function counts the number of leaf objects that exist for a 
specified class, those that would be returned by a call to getLeafInstances().


$n = $session->countLeafInstances( "Router" );


countf


$count =
$session->countf( $object, $relationship, $freshness )


The countf() function counts the number of elements in the specified relationship, such as 
countElements(). The contents of the relationship will be refreshed if the values are older 
than $freshness seconds. The section “$freshness” on page 64 provides additional 
information.


createInstance


$session->createInstance( $object )


Use the InCharge::session->create() function instead, as described in Chapter 3, 
“InCharge::Session.”


The createInstance() function creates a new ICIM object instance. The object specification 
must include both a class name and unique instance name.


$session->createInstance( "Router::fred" );


deleteInstance


$session->deleteInstance( $object )
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Use the InCharge::session->delete() or InCharge::object->delete() function instead, as 
described in Chapter 2, “InCharge::Object” and Chapter 3, “InCharge::Session.”


Deletes the specified object instance from the repository. Note that this does not clean up 
all the object interdependencies and links. When the Domain Manager has a MODEL 
based on ICIM, for a cleaner object deletion, you can use the remove() operation, if one 
exists for the object class in question. The section “invoke” on page 89 provides 
additional information.


$session->deleteInstance( "ACT_File::myFile" );


deleteObserver


$session->deleteObserver( )


The deleteObserver() function is an alias for purgeObserver(). The section 
“purgeObserver” on page 94 provides additional information.


Consider this an internal call. Use $session->detach() instead, as discussed in Chapter 3, 
“InCharge::Session.”


The deleteObserver() function reverses the effect of getObserverId(), deregistering the 
script as an observer.


$session->deleteObserver();


eventIsExported


The eventIsExported() function is an alias for getEventExported(). The section 
“getEventExported” on page 76 provides additional information.


execute


The execute() function is an alias for executeProgram(). The section “executeProgram” on 
page 67 provides additional information.


executeProgram


@thread = $session->executeProgram( $program, \@args )


The executeProgram() function is an alias for execute(). The section “execute” on page 67 
provides additional information.


The executeProgram() function executes an EMC Smarts program, passing arguments to it.


The following example runs the dmdebug plug-in, displaying statistics information on the 
stdout file of the sm_server process.


@thread = $session->executeProgram (
"dmdebug", [ "dmdebug", "--stats" ] );
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exists


The exists() function is an alias for instanceExists(). The section “instanceExists” on 
page 89 provides additional information.


findInstances_P


Use the findInstances() function from the InCharge::session module instead. 


@objects = $session->findInstances_P(
$class-pattern, $instance-pattern, $flag )


Finds instances that match the class and instance patterns, according to rules specified in 
the flags.


When used by the console GUI, the $flag value is 0x101000, which requests subclass 
expansion and glob pattern matches. When used by dmctl, the value 0x001000 is used 
which requests RegEx pattern matches and subclass expansion.


The value of $flag consists of the following values OR’d in any combination, according to 
the options required.


0x001000 = Expand-subclasses. With this flag set, the contents of subclasses of those 
classes that match are also returned.


0x100000 = Glob. This causes the match to be done by using ICIM glob() matches rather 
than UNIX regex syntax, which is used otherwise.


@list = $session->findInstances_P(
"Router", "s*", 0x100000 );


@list = $session->findInstances_P(
 "ICIM_UnitaryComputerSystem", ".*", 0x001000);


forceNotify


forceNotify( $object, $event, $notified, $expires)


Notifies, or clears, the specified event.


The $notified and $expires parameters are both timers:


◆ If $notified is greater than or equal to $expires, then the event is cleared. 


◆ If $notified is less-than $expires then the event is notified, or raised. The actual values 
of these parameters are not significant.


# to notify an event:
$session->forceNotify("Router::gw1",


 "Unresponsive", 0, 1);
# to clear an event:
$session->forceNotify("Router::gw1",


 "Unresponsive", 0, 0);
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get


RETURN = $session->get( $object, $property )


Use the features of the InCharge::object module instead, as described in Chapter 2, 
“InCharge::Object” and Chapter 3, “InCharge::Session.” 


Gets the contents of the specified property of the object.


The return type is scalar, array, or array reference as appropriate.


$vendor = $session->get( "Router::gw1", "Vendor" );
@parts = $session->get( "Router::gw1", "ComposedOf" );


The preferred implementation is:


$object = $session->object( "Router::gw1" );
$vendor = $object->{Vendor};
@parts = $object->{ComposedOf};


get_t and get_T


($type, $value) = $session->get_t( $object, $property )


Like get(), this returns the contents of the specified property, however, get_t() also returns 
a code for the type of the data. The returned value will be a scalar or array reference, as 
appropriate.


( $type, $value ) = $session->get_t(
"Router::gw1", "Vendor" );


( $type, $value ) = $session->get_t(
"Router::gw1", "ComposedOf" );


The get_t() variant of this call also returns the types of values contained in complex 
structures. Where get_t() returns a value, get_T() returns a type code and value in a 
two-element array.


getAggregationEvents


@list = $session->getAggregationEvents( $object,
$eventname, $flag)


The getAggregationEvents() function gets the names of the events that are aggregated to 
the specified event, which must be an aggregation event type.


◆ If $flag is false, then the events directly aggregated are returned.


◆ If $flag is true, then the aggregation tree is walked, and the names of all 
nonaggregation events that the specified event ultimately depends on are returned.


@list = $session->getAggregationEvents(
"Router::gw1", "PowerSupplyException", 1 );


getAllEventNames


@events = $session->getAllEventNames( $class )
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The getAllEventNames() function is an alias for getEvents(). The section “getEvents” on 
page 75 provides additional information.


The getAllEventNames() function gets the list of all events of all types, including 
symptoms, problems, aggregates, and events, in no particular order.


The getEventNames() call is similar but omits the problems from the list.


@list = $session->getAllEventNames( "Router" );


getAllInstances


@instances = $session->getAllInstances( )


The getAllInstances() function gets the names of all instances present in the ICIM 
database.


The getAllInstances() function can potentially return a very large array and should not be 
used.


getAllProperties and getAllProperties_t


@properties = $session->getAllProperties( $object, $flag );


The getAllProperties() function returns the names and values of all the properties of the 
specified object:


◆ If $flag is 0, attributes only are returned. 


◆ If $flag is 1, relations only are returned.


◆ If $flag is 2, both attributes and relations are returned.


The @properties array contains an even number of elements, where the odd-numbered 
ones are the property names, and the even-numbered are the matching values. This 
convention means that you can treat the result as a Perl hash, as shown in the following 
examples:


◆ The first example:


%props = $s->getAllProperties( $obj, 2 );
print "Object Name is $props{Name}\n”;


◆ The second example:


use Data::Dumper;
print Dumper( \%props );


The “_t” variation of the call returns data types as well as values.


Consider using the get() or get_t() functions of the InCharge::object module with no 
arguments instead of this call, as shown in the following example:


%props = $obj->get( );
print Dumper( \%props );

70 EMC Smarts Foundation Perl Reference Guide







Primitives

getArgDirection


$direction = $session->getArgDirection( $class, $operation, $argname )


The getArgDirection() function gets a flag to indicate whether the specified operation 
argument is an IN or OUT argument:


◆ IN arguments are denoted by the value 0 and refer to argument values passed from 
the script to the Domain Manager.


◆ OUT arguments are denoted by the value 1 and refer to variables into which the 
operation puts result information.


Nearly all arguments to all operations of all classes are IN arguments.


OUT arguments are not supported by the remote access protocol, which is beyond the 
scope of the API, dmctl, and ASL.


$direction = $session->getArgDirection(
"Router", "getFan", "identifier" );


getArgType


$type = $session->getArgType( $class, $operation, $argname )


The getArgType() function is an alias for getOpArgType() and getOperationArgumentType(). 
The sections “getOpArgType” on page 79 and “getOperationArgumentType” on page 79 
provide additional information.


The getArgType() function gets the type of the specified argument for the specified class 
operation. The section “$type, @types” on page 63 describes the possible data types.


$type = $session->getArgType( "Router", "makeFan", "className" );


getAttributes


The getAttributes() function is an alias for getAttributeNames(). The section 
“getAttributeNames” on page 71 provides additional information.


getAttributeNames


@properties = $session->getAttributeNames( $class )


The getAttributeNames() function is an alias for getAttributes(). The section 
“getAttributes” on page 71 provides additional information.


The getAttributeNames() function gets the list of all attributes for the specified class.


Attributes are properties that are not relations. For class Router, Vendor is an attribute but 
ComposedOf is not, however, both are properties. The getAttributeTypes() call returns the 
types of these attributes.


@list = $session->getAttributeNames( "Router" );
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getAttributeTypes


@types = $session->getAttributeTypes( $class )


The getAttributeTypes() function gets the list of type codes associated with the attribute 
names returned by getAttributeNames().


The types returned by this call and the names returned by getAttributeNames() are in the 
same order, such that the type of $property[$n] is given in $type[$n]. The section “$type, 
@types” on page 63 provides a description of the possible values.


@list = $session->getAttributeTypes( "Router" );


getByKey


RESULT = $session->getByKey( $object, $table,
 [ $keytype, $keyvalue ] )


The getByKey() function gets the entry in the named table from the object, indexed by its 
key.


Tables are properties that can contain arrays of values.


@driver = $session->getByKey(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ] );


getByKey_t and getByKey_T


($type, $value) = $session->getByKey_t( $object, $table,
 [ $keytype, $keyvalue ] )


Identical to getByKey() but returns a code for the type of the result as well.


($type, $data) = $session->getByKey_t(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ] );


getByKeyf


RESULT = $session->getByKeyf( $object, $table,
 [ $keytype, $keyvalue ], $freshness )


Identical to getByKey() but takes the “freshness” of the entry into account. The section 
“$freshness” on page 64 provides additional information.


@driver = $session->getByKeyf(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ], 120 );


getByKeyf_t and getByKeyf_T


($type, $value) = $session->getByKeyf_t( $object, $table,
 [ $keytype, $keyvalue ], $freshness )


Identical to getByKey_t() but takes the “freshness” of the entry into account. The section 
“$freshness” on page 64 provides additional information.
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($type, $data) = $session->getByKeyf_t(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ], 120 );


getChildren


@classes = $session->getChildren( $class )


The getChildren() function gets the list of classes that are child classes of a specified one, 
that is, classes derived from the base class.


$class = "ICIM_UnitaryComputerSystem";
@list = $session->getChildren($class);


getClassDescription


$text = $session->getClassDescription( $class )


The getClassDescription() function gets a textual description of the class.


The fixed string “no description available” is returned if the class programmer has not 
provided a description message for the class.


$description = $session->getClassDescription( "Router" );


getClassHierarchy


@hierarchy = $session->getClassHierarchy( );


The getClassHierarchy() function returns an array of information that provides a complete 
description of the hierarchy of domain model classes.


Each element of the array is a reference to a three-element subarray, as described in 
Table 23 on page 73. 


getClassInstances


@instances = $session->getClassInstances( $class )


The getClassInstances() function gets the list of instances of a specified class.


The return is a list of strings that contain the instance names without the class name. For 
example, “fred” is returned rather than “Router::fred”. This differs from getLeafInstances() 
in that this call returns the members of the class and any derived classes, whereas 
getLeafInstances() returns only the members of the specified class.


@names = $session->getClassInstances( "Router" );


Table 23  Class hierarchy descriptor


Array element Description


$x[0] name of ICIM class


$x[1] name of the class’s parent class


$x[2] class is abstract flag: 1 = yes, 0 = no
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getClasses


@classes = $session->getClasses( )


The getClasses() function gets the list of classes present in the system.


The following code fragment displays the list of all instances of all classes in the database.


foreach $class ($session->getClasses()) {
foreach ($session->getClassInstances($class)) {
print "${class}::$_\n”;


}
}


getCorrelationParameters


@info = $session->getCorrelationParameters( )


The getCorrelationParameters() function returns a nine-element array, each element of 
which contains a parameter relating to the Domain Manager correlation mechanism.


The array elements are described in Table 24 on page 74. 


getEnumVals


@strings = $session->getEnumVals( $class, $property )


The getEnumVals() function returns the list of strings that represent the possible values for 
an enumerated property.


The returned list of strings can be used to present a list of valid values to the user in the 
form of a selection menu. If this primitive is used to refer to a property that is not an 
enumerated one, an error is thrown.


@values = $session->getEnumVals( "Router", "Type" );


Table 24  getCorrelationParameters return values


Element Description


info[0] max problems (INT)


info[1] correlation interval (INT)


info[2] codebook radius (FLOAT)


info[3] correlation radius (FLOAT)


info[4] lost symptom probability (FLOAT)


info[5] spurious symptom probability (FLOAT)


info[6] time limit (INT)


info[7] suspend correlation (BOOLEAN)


info[8] provide explanation (BOOLEAN)
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getEvents


The getEvents() function is an alias for getAllEventNames(). The section 
“getAllEventNames” on page 69 provides additional information.


getEventCauses


@symptoms = $session->getEventCauses( $object, $eventname, $flag )


The getEventCauses() function gets a list of the Root causes, or problems, that the 
specified event can be considered to be a symptom of.


The getProblemClosure() primitive provides the reverse mapping. This is the mechanism 
used to populate the codebook tab for an event property sheet in the administrative 
console.


The $flag parameter is optional:


◆ If it is passed as TRUE, the full list of problems explaining eventname, whether directly 
or indirectly, is returned. 


◆ If it is passed as FALSE, only those problems that directly list eventname among the 
events they explain are returned.


@causes = $session->getEventCauses(
"Router::gw1", "MightBeUnavailable", 1 );


getEventClassName


$class = $session->getEventClassName( $class, $event )


The getEventClassName() function returns a string with the name of the ancestor class 
associated with a class and an event. The ancestor class is where the event was originally 
defined, that is, the class in which the event definition statement, not any refinement, 
appeared.


$class = $session->getEventClassname( "Router", "Down" );


getEventDescription


$text = $session->getEventDescription( $class, $event )


The getEventDescription() function returns a string, defined in MODEL, that describes an 
event.


$descr = $session->getEventDescription("Router", "Down");


getEventExplainedBy


@symptoms = $session->getEventExplainedBy( $object, $event, $flag )


Use InCharge::session->getExplainedBy instead, as discussed in Chapter 3, 
“InCharge::Session.”
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The getEventExplainedBy() function returns the list of symptoms that are explained by the 
specified impact event.


The $flag is a boolean that indicates whether the event impact tree is to be walked during 
the processing of the request.


@list = $session->getEventExplainedBy(
"Router::gw1", "DownImpact", 1);


getEventExported


$boolean = $session->getEventExported( $class, $event )


The getEventExported() function is an alias for eventIsExported(). The section 
“eventIsExported” on page 67 provides additional information.


Returns one of the following:


◆ 1 if the specified event is exported by the class
◆ 0 if it is not exported.


Events that are not exported are hidden from view in the GUI.


if ( $session->getEventExported( "Router", "Down" ) ) {
print "Event is exported\n”;


}


getEventNames


@events = $session->getEventNames( $class )


The getEventNames() function gets the list of events handled by the specified class.


Some of the returned events are exported while others are not, as described in 
“getEventExported” on page 76. Unlike getAllEventNames(), this call does not return 
problems names.


@list = $session->getEventNames( $class );


getEventSymptoms


@events = $session->getEventSymptoms( $class, $event )


The getEventSymptoms() function returns the list of events that are symptoms of the 
specified one.


@symptoms =
 $session->getEventSymptoms( "Router", "Down" );


getEventType_P


$eventtype = $session->getEventType_P( $class, $event )
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Consider using InCharge::session->getEventType instead, as discussed in Chapter 3, 
“InCharge::Session.” The “_P” is included in the name to avoid confusion with the 
InCharge::session function of the same name.


This primitive returns a numeric code that indicates the type of the specified event. 
Possible values are shown in Table 25 on page 77. 


$eventtype = $session->getEventType_P( "Router", "Down");


The primitive version of this call must be called by using the primitive function as shown 
because there is an InCharge::session method of the same name, provided for functional 
compatibility with ASL.


getInstances


The getInstances() function is an alias for getClassInstances(). The section 
“getClassInstances” on page 73 provides additional information.


getInstrumentationType


$type = $session->getInstrumentationType( $object )


The getInstrumentationType() function returns the instrumentation type for a specified 
object.


$type =
$session->getInstrumentationType("Router::gw1");


getLeafInstances


@instances = $session->getLeafInstances( $class )


Table 25  getEventType return codes


Return code Event type


0 Event


1 Aggregation


2 Symptom


3 Causality


4 Problem


5 Imported event


6 Propagated Aggregation


7 Propagated Symptom


8 Same type
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The getLeafInstances() function is an alias for getInstances(). The section “getInstances” 
on page 77 provides additional information.


The getLeafInstances() function gets the list of instances of a specified class.


The return is a list of strings that contain the instance names without the class name. For 
example, “fred” is returned rather than “Router::fred”. This differs from 
getClassInstances() in that this call returns only the members of the specified class, 
whereas the getClassInstances() call returns the members of the class and its derived 
classes.


@names = $session->getLeafInstances( "Router" );


getLibraries


@libs = $session->getLibraries( )


The getLibraries() function is an alias for getModels(). The section “getModels” on 
page 78 provides additional information.


The getLibraries() function gets the list of libraries loaded into the system.


getModels


The getModels() function is an alias for getLibraries(). The section “getLibraries” on 
page 78 provides additional information.


getMultipleProperties and getMultipleProperties_t


Use the get() and get_t() functions of the InCharge::object module with multiple 
arguments instead of this call, as shown in the example.


( $vendor, $model ) = $obj->get( "Vendor", "Model" );


The syntax of the primitive itself is:


◆ @values = $session->getMultipleProperties( $object, \@propnames);


◆ @values = $session->getMultipleProperties_t($object, \@propnames);


For example:


($vendor,$model) =
$session->getMultipleProperties( $obj,


 [ "Vendor", "Model" ] );


The argument is a reference to an array that contains the names of the properties to be 
returned.


getObserverId


$id = $session->getObserverId()
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Do not call this primitive directly, but make use of the InCharge::session->observer() 
function instead.


The getObserverId() function creates and returns a new observer ID.


The deleteObserver() primitive reverses this action. The section “deleteObserver” on 
page 67 provides additional information.


getOpArgType


The getOpArgType() function is an alias for getArgType(). The section “getArgType” on 
page 71 provides additional information.


getOpArgs


@argnames = $session->getOpArgs( $class, $operation )


The getOpArgs() function is an alias for getOperationArguments(). The section 
“getOperationArguments” on page 79 provides additional information.


The getOpArgs() function gets the names of the arguments for a specified class operation.


The argument names are returned in the order in which they should appear in the 
argument list when invoking the operation.


@list = $session->getOpArgs( "Router", "makeIP" );


getOpDescription


$text = $session->getOpDescription( $class, $operation )


The getOpDescription() function is an alias for getOperationDescription(). The section 
“getOperationDescription” on page 80 provides additional information.


The getOpDescription() function returns a textual description of the specified class 
operation.


$description = $session->getOpDescription(
"Router", "makeIP");


getOperationArguments


The getOperationArguments() function is an alias for getOpArgs(). The section 
“getOpArgs” on page 79 provides additional information.


getOperationArgumentType


The getOperationArgumentType() function is an alias for getArgType(). The section 
“getArgType” on page 71 provides additional information.
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getOperationDescription


The getOperationDescription() function is an alias for getOpDescription(). The section 
“getOpDescription” on page 79 provides additional information.


getOperationFlag


The getOperationFlag() function is an alias for getOpFlag(). The section “getOpFlag” on 
page 80 provides additional information.


getOperationReturnType


The getOperationReturnType() function is an alias for getOpReturnType(). The section 
“getOpReturnType” on page 81 provides additional information.


getOperations


The getOperations() function is an alias for getOpNames(). The section “getOpNames” on 
page 80 provides additional information.


getOpFlag


$flag = $session->getOpFlag( $class, $operation )


The getOpFlag() function is an alias for getOperationFlag(). The section “getOperationFlag” 
on page 80 provides additional information.


The getOpFlag() function gets the flag associated with the specified class operation.


The value returned is between 0 and 3, as defined Table 26 on page 80. 


$flag = $session->getOpFlag( "Router", "makeIP" );


getOpNames


@operations = $session->getOpNames( $class )


The getOpNames() function is an alias for getOperations(). The section “getOperations” 
on page 80 provides additional information.


The getOpNames() function gets the list of operations for the specified class.


The operations are returned as an array of strings that contain their names.


@list = $session->getOpNames( "Router" );


Table 26  getOpFlag return codes


Return code Operation


0 No flag


1 Idempotent


2 Constant


3 Read only
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getOpReturnType


$type = $session->getOpReturnType( $class, $operation )


The getOpReturnType() function is an alias for getOperationReturnType(). The section 
“getOperationReturnType” on page 80 provides additional information.


The getOpReturnType() function returns the return type code for the specified class 
operation.


By using this function, you can determine whether the operation returns an integer, a 
string, an object, or a list. The type codes returned are integer numbers, as described in 
Table 22 on page 63.


$type_code = $session->getOpReturnType(
"Router", "makeIP" );


getParentClass


$class = $session->getParentClass( $class )


The getParentClass() function returns the name of the class from which the specified class 
is derived.


This is the logical inverse of getChildren().


$parent = $session->getParentClass( "Router" );


getProblemClosure


@symptoms = $session->getProblemClosure( $object, $eventname, $flag )


Use InCharge::session->getClosure() in preference to this call.


Lists the events, or symptoms, that contribute to a specified problem. The 
getEventCauses() primitive is the inverse of this one. The section “getEventCauses” on 
page 75 provides additional information.


@list = $session->getProblemClosure(
"Router::gw1", "Down", 1 );


getProblemExplanation


@list = $session->getProblemExplanation( $object, $eventname, $flag )


Use InCharge::session->getExplains() in preference to this call.


MODEL developers can add information to a problem in order to emphasize events that 
occur because of a problem. This function returns a list of these events.
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@list = $session->getProblemExplanation( "Router::gw1", 
"Down", 1 );


getProblemNames


@list = $session->getProblemNames( $class )


The getProblemNames() function gets the event names of problems associated with the 
specified class.


@problems = $session->getProblemNames( "Router" );


getProblemSymptomState


@symptomData = $session->getProblemSymptonState( $object, $eventname )


The getProblemSymptomState() function returns data about all the symptoms that 
indicate the specified problem, including significant state information.


@list = $session->getProblemSymptonState( "Router::gw1", "Down");


getPrograms


@list = $session->getPrograms( )


The getPrograms() function gets the list of ``programs'' that are running in the Domain 
Manager.


Typically the reply list includes “dmboot” and “icf.”


@progs = $session->getPrograms( );


getPropAccess


$access = $session->getPropAccess( $class, $property )


The getPropAccess() function returns a number that indicates the level of access to the 
specified property.


$access = $session->getPropAccess( "Router", "Vendor" );


The return value effectively identifies the method by which the property value is obtained 
internally. Possible values and their meanings are listed in Table 27 on page 82. 


Table 27  getPropAccess return codes 


Return code Property access level


0 No access


1 Stored


2 Computed


3 Instrumented
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getPropDescription


$text = $session->getPropDescription( $class, $property )


The getPropDescription() function is an alias for getPropertyDescription(). The section 
“getPropertyDescription” on page 83 provides additional information.


The getPropDescription() function returns a textual description of the named class 
property.


$descr =
$session->getPropDescription( "Router", "Vendor" );


getProperties


The getProperties() function is an alias for getPropNames(). The section “getPropNames” 
on page 84 provides additional information.


The functionality of the C++ function getProperties() is available through the 
getMultipleProperties() primitive, and more easily through the get() method of the 
InCharge::object module.


Primitive getProperties() is aliased to getPropNames() in order to provide dmctl syntax 
compatibility.


getPropertyDescription


The getPropertyDescription() function is an alias for getPropDescription(). The section 
“getPropDescription” on page 83 provides additional information.


getProperties


The getProperties() function is an alias for getPropNames(). The section “getPropNames” 
on page 84 provides additional information.


For C++ developers, the C++ API call getProperties() is referred to as 
getMultipleProperties(). However, the InCharge::object->get() is an easier way to use this 
functionality.


4 Propagated


5 Uncomputable


6 Computed with expression


Table 27  getPropAccess return codes  (continued)


Return code Property access level
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getPropertyType


The getPropertyType() function is an alias for getPropType(). The section “getPropType” on 
page 85 provides additional information.


getPropIsReadonly


$boolean = $session->getPropIsReadonly( $class, $property )


The getPropIsReadonly() function indicates whether the specified class property is 
read-only.


if ( $session->getPropIsReadonly( "Router", "Vendor" ) ) {
print "Vendor is readonly\n”;


} else {
print "Vendor can be changed\n”;


}


getPropIsRelationship


$boolean = $session->getPropIsRelationship( $class, $property )


The getPropIsRelationship() function indicates whether the specified class property is a 
relationship.


if ( $session->getPropIsRelationship( "Router",
 "ComposedOf" ))


{
print "ComposedOf is a relationship\n”;


}


getPropIsRequired


$boolean = $session->getPropIsRequired( $class, $property )


The getPropIsRequired() function indicates whether the specified class property is 
required to have a value.


$needed =
$session->getPropIsRequired( "Router", "Vendor" );


getPropNames


@list = $session->getPropNames( $class )


The getPropNames() function retrieves the names of all the properties of a given class.


getPropRange


@range = $session->getPropRange( $class, $property )


The getPropRange() function returns the range of valid values for the class property, 
provided the property has been defined.


This applies to a very limited number of properties of integer type, typically in polling 
configuration classes.
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( $min, $max ) = $session->getPropRange(
"DialOnDemand_Interface_Setting",
"MaximumUptime" );


getPropType


$type = $seesion->getPropType( $class, $property )


The getPropType() function is an alias for getPropertyType(). The section 
“getPropertyType” on page 84


Returns the data type for a specified class property.


The section “$type, @types” on page 63 describes the possible data types. This call always 
returns the integer number representation of the type.


$type = $session->getPropType( "Router", "Vendor" );


getPropertySubscriptionState


$state = $session->getPropertySubscriptionState(
$object, $property )


The getPropertySubscriptionState() function gets the current state of subscription to the 
specified event.


The possible reply values are listed in Table 28 on page 85. 


getRelatedClass


$class = $session->getRelatedClass( $class, $property )


The getRelatedClass() function returns the name of the class of object that can be related 
to the specified class through the property, which must be a relationship.


$class =
$session->getRelatedClass( "Router", "ComposedOf" );


getRelationNames


@properties = $session->getRelationNames( $class )


The getRelationNames() function is an alias for getRelations(). The section “getRelations” 
on page 86 provides additional information.


Table 28  getPropertySubscriptionState return codes


Return code Subscription state


0 Unsubscribed


1 Pending


2 Subscribed


3 Suspended
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The getRelationNames() function gets the names of all the relationship properties for the 
specified class.


@relationships = $session->getRelationNames( "Router" );


getRelations


The getRelations() function is an alias for getRelationNames(). The section 
“getRelationNames” on page 85 provides additional information.


getRelationTypes


@types = $session->getRelationTypes( $class )


The getRelationTypes() function returns a list of type numbers for the relationships which 
are returned by the getRelationNames() call.


@types = $session->getRelationTypes( "Router" );


The section “$type, @types” on page 63 describes the possible data types.


getReverseRelation


$property = $session->getReverseRelation( $class, $property )


The getReverseRelation() function returns the name of the other end of a relationship pair 
denoted by the specified property name.


The inverse of ComposedOf is PartOf.


$relationship = $session->getReverseRelation(
"Router", "ComposedOf");


getSubscriptionState


$state = $session->getSubscriptionState( $object, $event )


The getSubscriptionState() function gets the current state of subscription to the specified 
event.


The possible values are listed in Table 29 on page 86. 


getThreads


@list = $session->getThreads( )


Table 29  getSubscriptionState return codes 


Return code Subscription state


0 Unsubscribed


1 Pending


2 Subscribed


3 Suspended
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The getThreads() function returns a list of threads that run in the current Domain Manager 
system.


Each element of the returned array is a reference to a four-element array. The four values 
that describe each thread are as they are described in Table 30 on page 87. 


This example prints the thread IDs and names of all threads in thread ID order.


foreach $t ( sort { $a->[0] <=> $b->[0] }
$session->getThreads( ) ) {


print $t->[0] . " - " . $t->[1] . "\n”;
}


getf


RETURN = $session->getf( $object, $property, $freshness )


The getf() function gets the contents of the specified property of the object with reference 
to its freshness. The section “$freshness” on page 64 provides additional information. 


The return type is scalar, array, or array reference, as appropriate, as described in “Data 


types” on page 61.


$vendor = $session->getf( "Router::gw1", "Vendor", 240 );
@parts =


$session->getf( "Router::gw1", "ComposedOf", 360 );


getf_t and getf_T


($type, $value) = $session->getf_t( $object, $property, $freshness )


Like getf(), the getf_t() function returns the contents of the specified property but getf_t() 
also returns a code for the type of the data. The section “$freshness” on page 64 provides 
additional information.


The returned value will be a scalar or array reference, as appropriate.


( $type, $value ) =
$session->getf_t( "Router::gw1", "Vendor", 240 );


( $type, $value ) =
$session->getf_t("Router::gw1", "ComposedOf", 360);


getfAllProperties and getfAllProperties_t


%properties = $session->getfAllProperties($object, $flag, $freshness);


Table 30  getThreads return codes


Return array element Thread information


$t[0] Process ID


$t[1] name


$t[2] State


$t[3] Status
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The getfAllProperties() function is the same as getAllProperties(), but takes the freshness 
of the values into account, and refreshes any stale properties before returning the results, 
that is, those that are older than $freshness seconds. The section “$freshness” on 
page 64 provides additional information.


The section“getAllProperties and getAllProperties_t” on page 70 provides a description of 
the $flag.


getfMultipleProperties and getfMultipleProperties_t


@values = $session->getfMultipleProperties( $object, 
 \@propNames,
 $freshness );


The getfMultipleProperties() function is like getMultipleProperties(), but refreshes values 
that are staler than $freshness seconds and need re-polling. The section “$freshness” on 
page 64 provides additional information.


The propNames argument must be a reference to an array of property names. For example,


@props = qw(Vendor Model Type);
($v,$m,$t) =


$session->getfMultipleProperties($obj, \@props, 30);


hasRequiredProps


$boolean = $session->hasRequiredProps( $class )


Indicates whether or not the specified class has any properties that are flagged as 
required.


$reqd = $session->hasRequiredProps( "Router" );


insertElement_P


$session->insertElement_P($object,
$relation,
[ $type, $value ])


Use the InCharge::object::insertElement() function instead, as described in discussed in 
Chapter 2, “InCharge::Object.” The “_P” on the end of the primitive name is used to avoid 
confusion between it and the InCharge::session and InCharge::object versions of the 
same call.


The InsertElement_P() function inserts something into a relationshipset.


In order to access the low-level primitive version of this call, you must invoke it by using 
the primitive method because the InCharge::session module also has its own variant.


$session->insertElement_P(,"Router", "ComposedOf",
[ "OBJREF", "Fan::fan1" ]);
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instanceExists


$boolean = $session->instanceExists( $object )


The InstanceExists() function is an alias for exists(). The section “exists” on page 68 
provides additional information.


Use the ASL-like function InCharge::object::isNull() instead of this primitive. Note that the 
sense of the return value is reversed.


Indicates whether or not the named object is present in the repository.


However, the class name and instance name should be specified in the $object 
parameter.


$exists = $session->instanceExists( "Router::gw1" );


invoke


The invoke() function is an alias for invokeOperation(). The section “invokeOperation” on 
page 89 provides additional information.


invoke_t and invoke_T


The invoke_t() and invoke_T() functions are an alias for invokeOperation_t(). The section 
“invokeOperation_t and invokeOperation_T” on page 90.


invokeOperation


RESULT = $session->invokeOperation($object, $operation, \@args)


The invokeOperation() function is an alias for invoke(). The section “invoke” on page 89 
provides additional information.


Use the features of the InCharge::object module instead, as described in Chapter 2, 
“InCharge::Object.”


The invokeOperation() function invokes a class operation on a specified object, passing 
the parameters to the operation.


The syntax of the arguments list requires it to be a reference to an array, each element of 
which is a reference to a two-element array containing the data type and value. Because of 
the awkward syntax, using the InCharge::object module provides a more natural style of 
interface. For example:


$result = $session->invokeOperation(
"Router::gw1", "makeInterface",
[
[ "INT", 1 ],
[ "STRING", "interface-1" ],
[ "STRING", "Interface" ]
] );
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The argument types, such as INT and STRING in this example, can be specified by using 
either their type names, as shown in this example, or numeric codes. “$type, @types” on 
page 63 describes the mapping.


invokeOperation_t and invokeOperation_T


( $type, $value ) =
$session->invokeOperation_t($object, $operation, \@args)


The invokeOperation_t() function is an alias for invoke_t(). The section “invoke_t and 
invoke_T” on page 89 provide additional information.


The invokeOperation_t() function is identical to invokeOperation(), except that the return 
indicates the type of the returned data as well.


( $type, $value ) = $session->invokeOperation_t(
"Router::gw1", "makeInterface",
[
[ "INT", 1 ],
[ "STRING", "interface-1" ],
[ "STRING", "Interface" ]
] );


The “_T” variation also embeds type codes into the fields of returned complex structures.


isAbstract


$boolean = $session->isAbstract( $class )


The isAbstract() function indicates whether the specified class is abstract.


An abstract class is one from which other classes are derived but which cannot have any 
objects.


$class = "ICIM_UnitaryComputerSystem";
$flag = $session->isAbstract( $class );


isBaseOf


$boolean = $session->isBaseOf( $class1, $class2 )


The isBaseOf() function returns TRUE if $class2 is a base class of $class1, that is, $class1 
is derived from $class2. 


For the purposes of this query, all classes are taken to be derived from themselves.


$class1 = "Router";
$class2 = "ICIM_UnitaryComputerSystem";
$is_it = $session->isBaseOf( $class1, $class2 );


isBaseOfOrProxy


$boolean = $session->isBaseOfOrProxy( $class1, $class2 )
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The isBaseOfOrProxy() function returns TRUE (1) if $class2 is a base class or proxy class of 
$class1.


$class1 = "Router";
$class2 = "ICIM_UnitaryComputerSystem";
$is_it = $session->isBaseOfOrProxy( $class1, $class2 );


isInstrumented


$boolean = $session->isInstrumented( $class )


The isInstrumented() function indicates whether the specified class has associated 
instrumentation.


$flag = $session->isInstrumented( "TCPConnect" );


isMember


$boolean = $session->isMember( $object1, $relation, $object2)


The isMember() function returns TRUE if $object2 is a member of the specified $object1 
relationship.


$flag = $session->isMember( "Router::strrtbos",
"ComposedOf",
"Interface::IF-strrtbos/1" );


isMemberByKey


$boolean = $session->isMemberByKey( $object, $table,
$keytype, $keyvalue] )


The isMemberByKey() function indicates whether an entry in the named object table 
exists.


$exists = $session->isMemeberByKey(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ] )


isMemberByKeyf


$boolean = $session->isMemberByKeyf( $object, $table,
[$keytype, $keyvalue], $freshness)


The isMemberByKeyf() function is similar to isMemberByKey(), but with reference to the 
freshness of the value. The section “$freshness” on page 64 provides additional 
information.


$exists = $session->isMemeberByKeyf(
"GA_CompoundDriver::Bridge-Generic-Driver",
"drivers", [ "INT", 10 ], 120 )


isMemberf


$boolean = $session->isMemberf( $object1, $relation,
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$object2, $freshness )


The isMemberf() function returns TRUE if $object2 is a member of the specified $object1 
relationship. If the $relation is a computed or polled value and is more than $freshness 
seconds old, it is refreshed first. The section “$freshness” on page 64 provides additional 
information.


$flag = $session->isMemberf( "Router::strrtbos",
"ComposedOf",
"Interface::IF-strrtbos/1",
240 );


isSubscribed


$boolean = $session->isSubscribed( $object, $event )


The isSubscribed() function returns TRUE if the specified event has been subscribed to by 
the calling process.


$subscribed = $session->isSubscribed( "Router::gw1", "Down");


loadLibrary


$session->loadLibrary( $library )


The loadLibrary() function is an alias for loadModel(). The section “loadModel” on 
page 92 provides additional information.


The loadLibrary() function loads a library, model, into sm_server memory.


$session->loadLibrary( $libname );


loadModel


The loadModel() function is an alias for loadLibrary(). The section “loadLibrary” on 
page 92 provides additional information.


loadProgram


$session->loadProgram( $program )


The loadProgram() function loads the named program into sm_server memory.


$session->loadProgram( "dmdebug" );


noop


$session->noop()


The noop() function is an alias for ping(). The section “ping” on page 93 provides 
additional information.


This is a type of ping. It sends a null command string to the Domain Manager, and thus 
determines whether the client/server link is active.

92 EMC Smarts Foundation Perl Reference Guide







Primitives

notify


The section “notify” on page 32 provides a description of notify().


ping


The ping() function is an alias for noop(). The section “noop” on page 92 provides 
additional information.


propertySubscribe


$session->propertySubscribe( $object, $property, $interval )


The propertySubscribe() function subscribes to notifications of changes to the specified 
object property. “Event subscription” on page 17 provide an overview of subscribing to 
events in a Domain Manager.


The actions of this call are reversed by propertyUnsubscribe().


$session->propertySubscribe( "Router::gw1",
"Vendor", 30 );


propertySubscribeAll


$session->propertySubscribeAll( $flags,$class_pattern,
$instance_pattern,
$property_pattern, $interval);


The propertySubscribeAll() function subscribes to changes in all the matching properties 
in the matching objects.


The meaning of the $flags is described for the subscribe() session function. 


The actions of this call are reversed by propertyUnsubscribeAll(). The section 
“propertyUnsubscribeAll” on page 93 provides additional information.


$session->propertySubscribeAll( 0, "Router", "gw1",
".*", 30 );


propertyUnsubscribe


$session->propertyUnsubscribe( $object, $property )


The propertyUnsubscribe() function reverses the effect of the propertySubscribe() call. The 
section “propertySubscribe” on page 93 provides additional information.


$session->propertyUnsubscribe( "Router::gw1", "Vendor" );


propertyUnsubscribeAll


$session->propertyUnsubscribeAll( $flags, $class_pattern,
 $instance_pattern,
 $property_pattern );


The propertyUnsubscribeAll() function unsubscribes from changes in all the matching 
properties in the matching objects.
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The meaning of the $flags is described for the subscribe() session function.


purgeObserver


The purgeObserver() function is an alias for deleteObserver(). The section 
“deleteObserver” on page 67 provides additional information.


put_P


$session->put_P( $object, $property, [ $type, $value ] )


The put_P() function writes the specified value to the specified object property.


The put_P() function is the low-level primitive that the put() function of InCharge::session 
uses, and is called when using the hash dereferencing syntax of InCharge::object.


The reader is encouraged to use the InCharge::object logic.


The following examples are essentially equivalent:


◆ The first example


$obj = $session->object( "Router::gw2" );
$obj->{Vendor} = "Cisco";


◆ The second example


$obj->put( "Vendor", "Cisco" );


◆ The third example


$ojb->put( Vendor => "Cisco", PrimaryOwnerContact => "Joe Blog" );


◆ The fourth example


$session->put( "Router::gw", "Vendor", "Cisco" );


◆ The fifth example


$session->put_P( "Router::gw", "Vendor", [ "STRING", "Cisco" ] );


quit


$session->quit( )


The quit() function is an alias for shutdown(). The section “shutdown” on page 95 
provides additional information.


The quit() function closes down the Domain Manager cleanly, saving the configured parts 
of the repository to disk.


removeElement_P


$session->removeElement_P( $object, $relation, [ $type, $value ] )
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Use InCharge::object::removeElement() instead of this primitive. The “_P” in the name is 
there to save ambiguity between this primitive and the InCharge::session and 
InCharge::object equivalents.


The removeElement_P() function removes an element from an object relationship, such as 
ComposedOf.


In order to access the low-level primitive version of this call, invoke it by using the 
primitive method because the InCharge::session module has a method of the same name 
that provides an enhanced interface.


$session->removeElement_P("Router::gw", "ComposedOf",
 [ "OBJREG", "Host::pingu6" ] );


removeElementByKey


$session->removeElementByKey($object, $table, [$keytype, $keyvalue])


The removeElementByKey() function removes a set-valued property by key.


restoreRepository


$session->restoreRepository( $filename, $purgeflag )


The restoreRepository() function restores the repository from file, optionally purging 
existing repository contents in the process.


$session->restoreRepository( "save.rps", 0 );


setCorrelationParameters


$session->setCorrelationParameters( @info )


The setCorrelationParameters() function sets the Domain Manager correlation parameters.


The section “getCorrelationParameters” on page 74 describes the fields of the @info 
array. The following example sets the correlation interval to 20 seconds.


@info = $session->getCorrelationParameters( );
$info[1] = 20;
$session->setCorrelationParameters( @info );


shutdown


The shutdown() function is an alias for quit(). The section “quit” on page 94 provides 
additional information.


storeAllRepository


$session->storeAllRepository( $filename )
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Use the InCharge::session->save() method instead.


The storeAllRepository() function saves the repository in the named file, which is located 
in the directory $SM_HOME/repos. The directory name must not contain any path 
separator characters.


$session->saveAllRepository( "save.rps" );


storeClassRepository


$session->storeClassRepository( $filename, $class )


Use the InCharge::session->save() method instead.


The storeClassRepository() function saves the repository for the named class in the 
specified file.


$session->saveClassRepository( "save.rps", "Host" );


subscribeEvent


$session->subscribeEvent( $object, $event )


The subscribeEvent() function subscribes to a specific event without using wildcard 
pattern matching, unlike subscribeAll().


The function unsubscribeEvent() cancels subscriptions that were established by using 
subscribeEvent(). The section “unsubscribeEvent” on page 98 provides additional 
information.


$session->subscribeEvent( "Router::gateway39", "Down" );


subscribeAll


Use InCharge::session->subscribe() instead.


topologySubscribe


$session->topologySubscribe( )


The topologySubscribe() function subscribes to notifications of topology updates.


The subscription/observer mechanism is described in detail in “Event subscription” on 
page 17. API subscriptions topology subscriptions may be reversed by using 
topologyUnsubscribe().
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topologyUnsubscribe


$session->topologyUnsubscribe( )


The topologyUnsubscribe() function cancels topology subscriptions previously requested 
with the topologySubscribe() function. The section “topologySubscribe” on page 96 
provides additional information.


$session->topologyUnsubscribe( );


transactionAbort


$session->transactionAbort( )


Use InCharge::session->abortTxn instead.


The transactionAbort() function aborts a transactional block previously started by using 
transactionStart(). The section “transactionStart” on page 97 provides additional 
information.


transactionCommit


$session->transactionCommit( )


Use InCharge::session->commitTxn() instead.


The transactionCommit() function commits a transactional block previously started using 
transactionStart(). The section “transactionStart” on page 97 provides additional 
information


transactionStart


$session->transactionStart( $lock_code )


Use InCharge::session->transaction() instead.


The transactionStart() function starts a transaction block, which may subsequently be 
aborted or committed by using transactionAbort()/transactionCommit(). 


sub SM_READ_LOCK { 1 };
$session->transactionStart( SM_READ_LOCK );
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The $lock_code values have the possible values shown in Table 31 on page 98. 


unsubscribeAll


Use InCharge::session->unsubscribe() instead.


unsubscribeEvent


$session->unsubscribeEvent( $object, $event )


Use InCharge:session::unsubscribe() instead.


The unsubscribeEvent() function unsubscribes from the event previously subscribed by 
using subscribeEvent(). The section “subscribeEvent” on page 96 provides additional 
information.


Table 31  Lock code literals


Lock code Literal


0 SM_NO_LOCK


1 SM_READ_LOCK_ONLY


2 SM_READ_LOCK


3 SM_WRITE_LOCK
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APPENDIX A
IPv6 Considerations


This appendix provides important information about the use of the Perl API in an IPv6 
environment. It consists of the following sections:


◆ Conventions for specifying IPv6 addresses............................................................  100
◆ Controlling name resolution ..................................................................................  101
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Conventions for specifying IPv6 addresses
Internet Protocol version 6 (IPv6) uses colons (:) in its addresses instead of periods (.), 
which are used in Internet Protocol version 4 (IPv4).


Sometimes when you use EMC Smarts APIs or command-line utilities, you need to specify 
an IP address with a port number. The port number is delimited by a colon (:). (The 
combination of an IP address and port number is also called a socket.) 


For the IPv6 address and port number to be interpreted correctly, specify the IPv6 address 
by using one of the following conventions:


◆ Enclose the IPv6 address within a pair of double quotation marks and square 
brackets. The syntax is:


"[ipv6_address]:port"


For example:


"[2001:0db8::0010]:65000"


◆ Enclose the IPv6 address with a pair of back slashes and square brackets. The syntax 
is:


\[ipv6_address\]:port


For example:


\[2001:0db8::0010\]:65000


◆ If the port is a default port, omit the port number and specify only the IPv6 address. 
No additional convention notations are needed. 


For example, for an IPv6 address and the default port of 162, specify:


2001:0db8::0010


No default port is specified.


These conventions are required for EMC Smarts APIs and command-line utilities, such as 
sm_snmpwalk, dmctl, and sm_tpmgr. 
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Controlling name resolution
The order in which name resolution is performed depends on how you specify a hostname 
and whether the SM_IP_VERSIONS environment variable is set.


When a user specifies a hostname for an EMC Smarts utility or the Perl API, the behavior 
occurs in the following order:


1. If the hostname includes an explicit Internet Protocol (IP) protocol (the suffix to the 
right of the colon), the hostname is resolved to an address of that protocol. For 
example:


• frame.someDomain.emc.com:v4 —Resolves to an IPv4 address.


• frame:v6 —Resolves to an IPv6 address.


• frame:v4v6 —Resolves to an IPv4 address, or, if that fails, to an IPv6 address.


• frame:v6v4 —Resolves to an IPv6 address, or, if that fails, to an IPv4 address.


2. If the hostname does not include an explicit IP protocol, the utility searches for the 
SM_IP_VERSIONS environment variable and uses the setting specified for variable. 
The SM_IP_VERSIONS environment variable is described in “The SM_IP_VERSIONS 
environment variable” on page 101.


3. If the environment variable is not set and the IP protocol is not explicitly provided, the 
default behavior is to resolve the hostname as an IPv6 address, or, if that fails, to an 
IPv4 address (the behavior for the v6v4 suffix). 


Additional information about discovery and name resolution is provided inEMC Smarts IP 
Manager documentation including the EMC Smarts IP Manager Deployment Guide.


The SM_IP_VERSIONS environment variable 


The SM_IP_VERSIONS environment variable enables you to control the Internet Protocol 
(IP) version used for name resolution. 


This affects EMC Smarts utilities that use a command line (for example, dmctl), some ASL 
scripts, the Perl API, and DNS lookup of undiscovered hostnames.


The variable can be set depending on the order in which you want to do name resolution. 
If the variable is not set, and the IP protocol is not explicitly provided (for example, 
frame.someDomain.emc.com:v4), the default behavior is to resolve the hostname as an 
IPv6 address, or, if that fails, to an IPv4 address. The variable should be set to the Internet 
Protocol version that is predominate for the network. 


To set this variable, add it to the runcmd_env.sh file, which is located in the 
BASEDIR/smarts/local/conf directory of the product.


The syntax of the environment variable is:


SM_IP_VERSIONS="ip_value"
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Table 32 on page 102 lists acceptable values for the SM_IP_VERSIONS environment 
variable. 


Detailed instructions about setting environment variables and information about the 
runcmd_env.sh file is provided in the EMC Smarts System Administration Guide.


Table 32  Acceptable values for the SM_IP_VERSIONS environment variable


ip_value Description


"V4" Hostname is resolved to an IPv4 address.


"V6" Hostname is resolved to an IPv6 address.


"V4V6" Hostname is resolved to an IPv4 address. If that fails, the Domain Name 
System server tries to resolve the hostname to an IPv6 address.


"V6V4" Hostname is resolved to an IPv6 address. If that fails, the Domain Name 
System server tries to resolve the hostname to an IPv4 address (default).


Note: The acceptable value can also be lowercase ("v4", "v6", "v4v6" or "v6v4").
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Introduction

Overview
As a network administrator, you should configure the EMC® Smarts® Foundation software 
to meet the needs of your operations. To accomplish this, you may need to perform one or 
more tasks as described in this chapter.


EMC Smarts installation directory
In this document, the term BASEDIR represents the location where EMC Smarts software is 
installed.


◆ For Windows, this location is C:\InCharge\<product>.


◆ For UNIX, this location is /opt/InCharge/<product>.


Optionally, you can specify the root of BASEDIR to be something other than:


◆ Windows: C:\InCharge


◆ UNIX: /opt/InCharge


However, you cannot change the <product> location under the root directory.


This guide provides more information about the directory structure.


Where to get help
EMC support, product, and licensing information can be obtained as follows:


Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:


https://support.emc.com


Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.


Setting the locale
A locale is a combination of language and country identifiers, and the specification of the 
locale is important for the purpose of externalized textual data. Clients and Domain 
Managers can be running in different locales but it is important that textual data 
transferred to a client as part of error handling by the Domain Manager appear in the 
language and country of the client. Chapter 2, “Locale,” describes how to specify the 
locales.


Locating and modifying files
Some files can be modified to meet the needs of your network environment. Chapter 3, 
“Locating and Modifying Files,” describes the directory structure of the EMC Smarts 
software. The chapter also discusses the files that can be modified and how to locate the 
files and provides procedures for modifying those files. Additionally, the chapter 
describes the files created by EMC Smarts Foundation software (for example, logs, 
repositories, and saved consoles), and details how to control their location.
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Licensing the software
EMC Smarts software requires a license file to function. To evaluate the software, you can 
obtain a time-limited evaluation license that provides access to specified features. After 
you purchase the software, you will need to set up a permanent license file. Chapter 4, 
“License Administration,” provides procedures for obtaining both evaluation and 
permanent license files for your software. Topics include:


◆ Setting up the license file
◆ Starting the FlexNet Publisher license server
◆ Pointing the software to the license server 
◆ Licensing additional programs and adding licenses


Controlling the startup of EMC Smarts programs
EMC Smarts programs can either be installed as services or as manual processes. 
Chapter 5, “Controlling Startup,” provides procedures that use the sm_service utility to:


◆ Install programs as services


◆ Start and stop services 


◆ Start and stop processes


◆ Modify the runtime parameters of services


Securing access to software
Security is a critical concern in the world of large-scale distributed networks. Therefore, 
EMC Smarts security provides a means by which network administrators can set up 
security to control access to the software. Chapter 6, “Securing Access to the Software,” 
describes how security works, as well as the authentication processes used by the 
software. It then provides procedures for setting up security and controlling access to 
EMC Smarts programs. The chapter also discusses how to set up encrypted connections 
between EMC Smarts clients and servers.


Operation of the Broker
Client programs, such as a console or an adapter, use the Broker to determine where 
Managers are running. When a Manager starts, it registers the hostname of the machine it 
is running on, as well as the TCP port it is listening to, with the Broker. Thereafter, clients 
retrieve this information from the Broker so that they can communicate with the Manager. 
Chapter 7, “Operation of the Broker,” describes the functions of the Broker, provides 
procedures for viewing the Broker’s registry, and explains how to change the Broker’s 
environment variables.

Licensing the software 11







Introduction

Managing log files
Log files grow indefinitely, though slowly, under normal conditions, and need to be 
managed. In addition, EMC Smarts software can maintain up to 999 backup log files of 
each log. For example, if you are generating two log files, MYDM_en_US_UTF-8.log and 
MYDM_fr_UTF-8.log file, you can maintain up to 999 backup log files for the 
MYDM_en_US_UTF-8.log and 999 backup log files for the MYDM_fr_UTF-8.log.


You can configure the number of log files retained by the software. Chapter 9, “Managing 
Log Files,” discusses the management of log files, and describes how to “roll over” the 
files.
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What is a locale
A locale is a set of parameters that defines:


1. Language


2. Country (or region)


3. Other specific cultural elements that vary


For the purpose of externalized textual data, the language and country data of the locale 
specification are important.


Languages are specified in two lowercase ASCII letters. Some examples are en for English 
and fr for French.


Country identifiers are specified as two or three uppercase ASCII letters. Some examples 
are: US, CA, FR, and JP, for United States, Canada, France, and Japan, respectively. 


“Standards” on page 16 provides more information on language codes and country 
identifiers.


A locale is a combination of the language and country identifiers into one string, 
connected by the underscore (_) character. For example, the locale for English (en) as 
spoken in the United States (US) is defined as en_US.


Client and Domain Manager use different locales


Client programs may be running in a locale that is not the same as the locale of the 
Domain Manager. For example, a Domain Manager may be running in a process where the 
locale is specified as “French as used in France.” Different end-users of an application 
may be concurrently connected, and use different locales, for example “German as 
spoken in Germany,” and “Spanish as spoken in Spain,” or “German as spoken in 
Austria.”


It is important that textual data transferred to the client as part of error handling by the 
Domain Manager appear in the language and country of the client. A German client will 
see German exception messages, even if the client application is connected to a Domain 
Manager whose preferred language (for logging) is French.


The server will respect the locale of the client when rendering several types of textual 
output. Applications may also use classes and methods in the clsapi subsystem to enable 
locale-aware operations, where appropriate.
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Locale types
Each process’ locale is determined by the SM_LOCALE environment variable, as seen by 
that process. When a client process attaches to a server process, they negotiate on the 
locale for that session. The SM_LOCALE environment variable is discussed in 
“SM_LOCALE” on page 161.


Process locale


You can specify the locale of any program, such as a client, Broker, server, utility by using 
the SM_LOCALE environment variable.   For all such programs, the initialization logic 
validates the specified value, and ensures that all internationalization features can use it 
predictably.


The locale can also be specified for Java applications. Use the Java property 
com.emc.cmp.dmt.locale on the startup of the Java Virtual Machine or on the command 
line of any program that supports the -java command operand.


Client locale


The locale of a client program may be different from the locale of the Domain Manager. 
There are two different types of client locales:


◆ Client process locale


◆ Client session locale


The client process locale and the client session locale do not need to be the same.


Client process locale
The client process locale is the locale that is set by the SM_LOCALE variable in the 
environment of the client program, such as dmctl, brcontrol, and others. The client 
process locale is used by default when rendering messages generated in the client 
process.


Client session locale
The client session locale is the locale that is sent to a Broker or Domain Manager in two 
possibly ways:


◆ The client process locale is by default sent to the Domain Manager, and identifies the 
initial session locale.


◆ The client session locale can be changed by calling the setLocale() or 
setRemoteLocale() method. Calling one of these methods causes a protocol verb 
to be executed at the server, which causes the server to remember the client session 
locale.


The client program may use the setLocale() client API calls to indicate to the Domain 
Manager a select locale. Setting the locale that the Domain Manager remembers for the 
client does not change the configured setting of the client process locale.
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Domain Manager process locale


The Domain Manager process locale is the one set by the SM_LOCALE variable in the 
environment of the Domain Manager. The Domain Manager locale primarily influences 
logging output, and does not impact the processing of locale for client processes or the 
client sessions. Conversely, the client locale, configured or set by API call, does not 
influence the locale handling for the Domain Manager output.


Support locale


The process locale specified by SM_LOCALE and the Java property specifies the language 
for output that the user sees. However, EMC engineering and support teams must be able 
to interpret log data and other output in English. Programs, primarily server processes, will 
always generate diagnostic information in the support locale, which is en_US. The main 
impact of the difference between the process locale and the support locale applies to the 
software logging system.   See “Overview of message logging” on page 134 for more 
details. 


Standards
Several internationalization standards apply directly to the software. 


Unicode


Unicode is the universal standard of encoding for written characters and text, covering all 
known world languages. UTF-8 (8-bit form) is used by the software applications.


ISO 639 language codes


Languages are specified in two lowercase ASCII letters. Some examples of standard codes 
for language are: en, fr, and ja for English, French, and Japanese respectively.


ISO 3166 country codes


This standard defines the universally recognized codes for county (or region). There are 
two alphabetic standards for country codes: 


◆ ISO-3166-1 Alpha-2 describes the two-letter codes.


◆ ISO-3166-1 Alpha-3 describes the three-letter codes.


Country identifiers are specified as two or three uppercase ASCII letters. For example, US 
for United States and JP for Japan.


Language and country identifiers are combined into one string, connected by the 
underscore character. For example, en_US for English as used in the US, and ja_JP for 
Japanese as used in Japan.
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Directories
Table 1 on page 18 lists software directories and a brief description of their contents. 


In addition to the common subdirectories, the EMC Smarts Service Assurance Manager 
(/SAM) includes two additional subdirectories: /actions (client and server) and /consoles.


Table 1  Directories


Directory Contents


/bin Executables for starting and interacting with Domain Managers as well as 
utilities.


/classes Software jar files and third-party jar files upon which EMC Smarts programs 
depend.


/conf Domain Manager configuration files.


/doc User and reference guides.


/examples Sample files for C, C++, and Java APIs as well as examples of MODEL 
applications and JIIM.


/include The .h and .mdl files for components of the software programs.


/integration Sample probe for the integration accessor.


/l10n The l10n directory name is a lowercase L, followed by the number 10 and 
then a lowercase n.
Contains Resource Packages (which hold externalized and localized data, 
such as error strings).


/lib Shared libraries. 


/local Top-level directory where local copies of configuration, rules, and script files 
are created and stored.
The default location where files such as repository and log files are written. 
The /local/l10n directory contains new Resource Packages introduced by 
update kits, patches, language packs, and so on.


/perl Files used for the Perl API.


/rules ASL rule sets. 


/script Utility scripts such as the license server installation scripts.


/symbols Symbols for debugging and gathering extended information about stack 
traces (Windows only).
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User-modifiable files
The EMC Smarts software installation includes system files, configuration files, ASL rule 
set files, scripts, templates, as well as third-party software files that the EMC Smarts 
software uses.


Never alter system files, such as executables, shared libraries, MODEL files, and setup 
files. Do not alter third-party software system files provided with the Java Runtime 
Environment.


As part of the configuration process, you will need to make changes to some of the 
user-modifiable files. The following are examples of user-modifiable files:


◆ Configuration files, such as discovery.conf, clientConnect.conf, and 
serverConnect.conf (you are required to edit these)


◆ ASL rule sets, such as syslog_mgr.asl


◆ Sample actions, such as ics-ping and ics-telnet


◆ Template files used to import data, such as service.data.template and 
topology-group.data.template


Original versions of configuration files, ASL rule sets, scripts, and template files are 
installed to the BASEDIR/smarts/conf, BASEDIR/smarts/rules, and 
BASEDIR/smarts/script directories. When you need to alter a file in one of these 
directories, make those changes to a local copy of the file. By default, local copies of 
user-modifiable files should reside in BASEDIR/smarts/local or one of its subdirectories. 
The software is designed to first search for user-modifiable files in BASEDIR/smarts/local 
or one of its subdirectories. If a modified version of a file is not found in the local area, the 
software then searches appropriate non-local directories.


To edit a file, invoke the sm_edit utility from the BASEDIR/smarts/bin directory. When 
used, sm_edit automatically opens a local copy of the specified file and saves the 
modified file to its appropriate location. “Modifying EMC Smarts files” on page 20 
provides further information about how to use the sm_edit utility.


You should:


◆ Only modify local copies of user-modifiable files.


◆ Always retain the original, unedited, version of these files.


Table 2 on page 19 identifies the default subdirectories that include user-modifiable files 
found under BASEDIR/smarts/local. The subdirectories vary by product. 


Table 2  Subdirectories for user-modifiable files


Installation path Directory Description


BASEDIR/smarts/local /actions Tool scripts


/conf Configuration files


/data Import files 


/rules ASL rules files 
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The BASEDIR/smarts/local directory has been reserved for directories with local copies of 
user-modifiable files as well as writable files such as logs and repository files. It typically 
contains directories listed in Table 2 on page 19. During installation, the software may 
create empty subdirectories under the BASEDIR/smarts/local directory. These directories 
are reserved for use for future service packs and Rolling Patches. The exception is the 
BASEDIR/smarts/local/bin directory that contains files necessary for the successful 
installation of the software on Windows 2003 (Enterprise Edition) operating systems.


In addition, the BASEDIR/smarts/local/conf directory contains the runcmd_env.sh file, 
which is created during installation. The runcmd_env.sh is a file for setting environment 
variables, including the default location for the Broker. You can edit this file to change the 
default location of the Broker or to define any EMC Smarts Foundation-wide environment 
variable. “Methods for setting environment variables” on page 147 provides information 
about setting environment variables.


The product-specific naming convention used for subdirectories under 
BASEDIR/smarts/local/conf and BASEDIR/smarts/local/rules (as well as their non-local 
counterparts) typically reflects the product or module within a product that uses the files.


You can alter the location for rules files, as described in “Controlling the location for rule 
set files” on page 23.


If EMC installs a site-specific patch at your location, then additional directories may be 
included under BASEDIR/smarts/local. Never alter files in any of these additional 
subdirectories.


Modifying EMC Smarts files


After you install the application, you may need to modify files as part of the configuration 
process. For example, if you want to secure access to the software, you need to change the 
password for the Admin account in the serverConnect.conf and clientConnect.conf files.


To modify files, use sm_edit utility that is installed with the software.


You must use the sm_edit utility that is included with the installation of a product to 
modify files applicable to that product. Do not, for example, edit IP Manager files with the 
sm_edit that is installed with the Service Assurance Manager.


When invoked, sm_edit opens the specified file in a text editor. This utility ensures that 
modified files are always saved to the appropriate local area and that non-local copies of 
all files remain unchanged. If an appropriate subdirectory does not exist for the file you 
are modifying, sm_edit creates the appropriate subdirectory before saving the modified 
file to that location. For files with header information set for encryption, sm_edit encrypts 
certain fields in the file. In addition, sm_edit preserves the file permissions of modified 
files, which helps ensure that important configuration files are not altered by 
unauthorized users.
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You can configure Windows to automatically invoke the sm_edit utility when you open a 
file through Windows Explorer, as described in “Associating files with sm_edit on 
Windows” on page 22.


To use sm_edit from the command line, specify the filename and include the subdirectory 
under /local where the file resides. For example, to edit the discovery.conf file, enter the 
following command by using administrative privileges:


BASEDIR/smarts/bin> sm_edit conf/discovery/discovery.conf


In this example, sm_edit searches in the BASEDIR/smarts/local/conf/discovery directory 
for the discovery.conf file. If it finds discovery.conf, it opens the file in a text editor. If 
sm_edit does not find discovery.conf in the BASEDIR/smarts/local/conf/discovery 
directory, it creates a local copy of discovery.conf and writes it to the 
BASEDIR/smarts/local/conf/discovery directory.


If the appropriate subdirectory does not exist in the local area for the file you are 
modifying, sm_edit creates that subdirectory and saves the modified file there. This 
ensures that the original version of the file remains unchanged.


Specifying the text editor used by the sm_edit utility
The sm_edit utility is not a text editor. Instead, it uses the text editor that is specified by 
one of the following means:


◆ SM_EDITOR environment variable, as described in “Environment variables for users” 
on page 149.


◆ VISUAL environment variable


◆ EDITOR environment variable


◆ If the SM_EDITOR, VISUAL or EDITOR environment variables are not defined, sm_edit 
uses the following:


• Edit program on UNIX


• WordPad program on Windows


You can also specify the editor that sm_edit should use by providing the --editor argument 
when invoking the utility.
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Associating files with sm_edit on Windows


On Windows systems, you can configure the system so that sm_edit is automatically 
invoked when an EMC Smarts file is opened through the Windows Explorer file browser. 
You do this by associating the appropriate file extensions with the sm_edit utility.


If you have more than one product installed on the same host, this association works 
correctly only with one product (the product from which the associated sm_edit is run). For 
the other products, you must run the sm_edit by using a command prompt in the product 
that contains the file to modify.You can associate the following file types with sm_edit:


◆ For configuration files, use .conf.


◆ For ASL rulesets, use .asl.


◆ For data import files, use .template.


It is possible that another software program uses one or more of these file extensions. If 
an association between these file types and another program already exists, and you 
change the association, you may affect the operation of that software. In addition, the 
sm_edit utility will not open a file outside of the BASEDIR/smarts hierarchy. Attempting to 
open such a file will cause an error.


Associating file types on Windows systems
To associate a file extension with the sm_edit utility, use the following procedure:


1. From Windows Explorer, locate a user-modifiable file within a product module or 
product. For example, the discovery.conf file located in the 
BASEDIR/smarts/conf/discovery directory of a given product.


2. Right-click the file and select Open With > Choose Program.


3. From the Open With dialog box, select Other.


4. Select the sm_edit utility in the BASEDIR/smarts/bin directory to add sm_edit to the 
program selection list.


5. Choose sm_edit from the Open With program list.


6. Select the checkbox beside “Always use this program to open these files.”


7. Click OK.


8. Repeat this procedure, except for steps 3 and 4, for each file type that you associate 
with the sm_edit utility.


To remove a file type association from the sm_edit utility, clear the checkbox beside 
“Always use this program to open these files.”
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Locating user-modifiable files
It is important to understand how the software locates user-modifiable files at runtime. In 
general, when looking for a user-modifiable file, the software first searches in 
BASEDIR/smarts/local or one of its subdirectories. If the file is not found, the software 
then proceeds to look for the file in directories that are not intended to contain modified 
files. For example, when the software searches for a configuration file, it first looks in 
BASEDIR/smarts/local/conf. If the file is not found, then the software proceeds to look in 
BASEDIR/smarts/conf.


BASEDIR/smarts can refer to different product directories. Therefore, the configuration file 
in this example could be a configuration file for any product such as the IP Manager or 
Service Assurance Manager.


Controlling the location for rule set files


To locate your ASL rule sets in an area other than the default location 
(BASEDIR/smarts/local/rules), set the SM_RULESET_PATH environment variable. When 
you set SM_RULESET_PATH, the software first searches for rule set files in that path 
location or in one of its subdirectories. If the file is not found, the software then proceeds 
to look in the default location for modifiable rule set files.


To set SM_RULESET_PATH, add it to the runcmd_env.sh file.


You normally only define the SM_RULESET_PATH environment variable if you are writing 
custom ASL rule sets to work with your software.


Appendix A, “Environment Variables,” provides further information about 
SM_RULESET_PATH.


Controlling location of the user modified files


In case you would like to run more than one domain manager out of a single installation 
direcotry you can use the SM_SITEMOD variable to specify a separate local directory 
structure for each domain.


This allows you to specify configuration files unique to each domain, yet still use the same 
core files that are not different between sites. 


The SM_SITEMOD variable provides a search list that InCharge uses to locate files. This list 
is used to find files users can, and in some cases must, modify to use InCharge at their 
site. Such files include configuration files, ASL rulesets, and scripts. The components of 
the list are separated by colons (:) on UNIX and semicolons (;) on Microsoft Windows. The 
default value of SM_SITEMOD is: BASEDIR/smarts/local:BASEDIR/smarts. You will need to 
change this value for each domain to first search BASEDIR/smarts/<domain_local >then 
BASEDIR/smarts/local and the BASEDIR/smarts. Follow these steps:


1. Create a diectory for each domain.


$mkdir /opt/InCharge/smarts/local_d1.
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2. Place a file that is unique for this domain under /opt/InCharge/smarts/local_d1.


$mkdir /opt/InCharge/smarts/local_d1/conf/trapd
$cp   /opt/InCharge/smarts/conf/trapd 
/opt/InCharge/smarts/local_d1/conf/trapd


3. Define SM_SITEMOD for the current shell or Unix of the Command prompt on 
Windows. 


For Unix,


export 
SM_SITEMOD=/opt/InCharge/IP/smarts/local_d1:/opt/InCharge/IP/smarts
/local:/opt/Incharge/IP/smarts


For Windows,


C:\set 
SMS_ITEMOD=C:\InCharge\IP\smarts\local_d1;C:\InCharge\IP\smarts\loc
al;C:\InCharge6\IP\smarts


4. Use sm_edit to modify the rest of the files that are specific to this domain.


5. Configure sm_service command such that every time the domain starts up, it loads 
files from the proper directory.


For Unix,


sm_service install --force --name=ic-am-pm-server-2 
--description="INCHARGE-AM-PM for Site 2" --startmode=runonce 
--env=SM_SITEMOD=/opt/InCharge/IP/smarts/local_d1:/opt/InCharge/IP/
smarts/local:/opt/Incharge/IP/smarts 
/opt/InCharge/IP/smarts/bin/sm_server --name=INCHARGE-AM-PM-2 
--config=icf --bootstrap=bootstrap-am-pm.conf --port=0 
--subscribe=default --ignore-restore-errors --output
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Writing output files
The BASEDIR/smarts/local directory is also the default location for files written by the 
EMC Smarts software. Writable files include logs, saved consoles, and repository files. If 
desired, you can alter the location for log files, as described in “Controlling where the 
software writes log files” on page 26. Table 3 on page 25 defines the default 
subdirectories found under BASEDIR/smarts/local that contain writable files.  


For Service Assurance Manager, the BASEDIR/smarts/local/logs directory includes a 
<manager_name>.audit file. This file contains audit entries that are added to all 
notifications in Service Assurance Manager. The entries, which are in time order, include 
the following information: date/time, notification name, source, user, and action.


The directory also includes a <manager_name>-statistics.log. This file contains entries for 
every invocation of the following operations:


dmctl -s <manager_name> invoke ICS_ActionManager::ICS-ActionManager 
dumpStatistics <filename>


dmctl -s <manager_name> invoke 
ICS_AutoActionManager::ICS-AutoActionManager dumpStatistics 
<filename>


The <filename> is optional; otherwise, it is <manager_name>-statistics.log.


The information in this file enables network personnel to monitor the execution of custom 
actions and the performance of administrator-defined escalations.


Controlling where the software writes output files


The software defines the location of writable files by using the SM_WRITEABLE 
environment variable. By default, SM_WRITEABLE is defined as BASEDIR/smarts/local.


This means the following:


◆ Saved consoles are written to BASEDIR/smarts/local/consoles.


◆ Log files are written to BASEDIR/smarts/local/logs.


◆ Repository files are written to BASEDIR/smarts/local/repos.


If you want all writable files to be written elsewhere, set the path by using the 
SM_WRITEABLE environment variable.


To set SM_WRITEABLE, add the variable to the runcmd_env.sh file.


Table 3  Default subdirectories for writable files


Installation path Directory Description


BASEDIR/smarts/local /consoles EMC Smarts consoles that have been saved.


/logs Manager and adapter log files that the software has 
written. Also where archived notifications are saved.
Note that installation and uninstallation logs are 
written to the BASEDIR/smarts/setup/logs directory.


/repos Repository files that the software has written. 
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Controlling where the software writes log files


If you want the software to write log files to an area other than the default location, set the 
path by using the SM_LOGFILES environment variable.


To set SM_LOGFILES, add the variable to the runcmd_env.sh.


SM_LOGFILES takes precedence over SM_WRITEABLE, as described in “SM_LOGFILES” on 
page 170.


sm_logerror


On Solaris and Linux systems, every ITOps process creates a child process, sm_logerror, at 
startup. This process has one purpose: to print a stack trace of its parent (by invoking the 
pstack program) should the parent request it (which usually happens only when the 
parent encounters a fatal error).


Every ITOps process also starts a child running an external authenticator, sm_authority (in 
the default configuration). This program either gets client credentials to send to a 
Manager, or checks credentials received by a Manager. Since the authenticator itself is a 
an ITOps program, it starts its own sm_logerror. Thus, if you follow the tree of processes 
under an sm_server, you might find:


sm_server
sm_logerror
sm_authority


sm_logerror


Both sm_logerror and sm_authority spend their time reading a pipe that connects them to 
the process that created them. However, this process is not necessarily their parent. When 
the Manager starts as a service:


◆ The Domain Manager runs as a daemon after starting sm_logerror and sm_authority.


◆ The original sm_server process is replaced by a different one.


◆ The child processes, sm_logerror and sm_authority, become orphans and are then 
inherited by the init process, which is always process 1.


The new sm_server process retains its connection to the pipes that connected the original 
to the sm_logerror and sm_authority processes, and the processes work as intended.


These processes must not be "killed". Killing sm_logerror will make it impossible to print a 
stack trace, and make debugging more difficult. Killing sm_authority will cause connection 
attempts to fail when credentials cannot be obtained or checked.
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Using the smgetinfo utility to create a support package
The sm_getinfo utility is used by customers to collect data for troubleshooting EMC Smarts 
Manager (server) problems. The utility backs up the current configuration for a server by 
creating a tar archive of all files and user customizations that are essential to 
troubleshooting the server. Customers then email the tar archive to EMC Customer 
Support for problem resolution.


sm_getinfo files


The sm_getinfo utility, which is supported on Solaris, Linux, and Windows, creates three 
types of files in the installation directory area from which it is invoked. The files are shown 
in Figure 1 on page 27 and described in Table 4 on page 27.


Figure 1  sm_getinfo file tree


BASEDIR


logs


local


smarts


logs


MANIFEST smgetinfo_filessmgetinfo<date>.tar.gz


smgetinfo-versions.log.<date>


Table 4  sm_getinfo-created files  (page 1 of 2)


Filename Description


Files in logs directory


sm_getinfo<date>.tar.gz
Example:
sm_getinfo26Mar2012-015952.tar.gz


A compressed tar archive in which the 
sm_getinfo utility stores a server ‘s log files, 
repository files, core files (Solaris, Linux) or 
dump files (Windows), user-modified files (using 
sm_edit), user-introduced files, and system 
environment information. The actual content of 
the tar archive depends on the user-specified 
options on the sm_getinfo invocation command 
line.
The name of the tar archive includes the date 
when the tar archive was created.


MANIFEST A text file that lists all of the files that the 
sm_getinfo utility includes in the tar archive.
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sm_getinfo command-line syntax


You run the sm_getinfo utility from the BASEDIR/smarts/bin directory. The options that 
you specify on the invocation command line determine which files are included in the 
sm_getinfo-created tar archive.


Here is the command line syntax for sm_getinfo:


sm_perl sm_getinfo.pl
| --server <server name> --pid <server process ID>
| --broker <location>
| --log [<number of latest logs>]
| --nolog
| --repos [--latest]
| --norps
| --core
| --all
| --version
| --help
| --smmonitor “<sm_monitor options>”
| --flush


where:


◆ <> Angle brackets are user-supplied parameter values (variables).


◆ [ ] Square brackets are optional entries.


◆ | Vertical bar symbols are alternate selections.


Files in logs/smgetinfo_files directory


smgetinfo-versions.log.<date>
Example:
smgetinfo-versions.log.26Mar2012-020004


Example of other files in smgetinfo_files:
TTP-Installed-versions.log.26Mar2012-020005


A log file in which the sm_getinfo utility writes 
information about a server’s log file or 
repository file that is larger than 700 megabytes 
(MB). The sm_getinfo utility does not include 
any log or repository file in a server’s tar archive 
that exceeds 700 MB.
In addition, sm_getinfo writes system 
information to the log file.
The name of the log file includes the date when 
the log file was created.


Table 4  sm_getinfo-created files  (page 2 of 2)


Filename Description
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The command-line options are described in Table 5 on page 29. 


Table 5  Command-line options for the sm_getinfo utility 


Option Description


--server |<server name> --pid <server 
process ID> | -s <server name> -p <server 
process ID>


Specifies the EMC Smarts server name and PID against 
which the sm_getinfo utility will collect information. To 
dump a core file for a running server on Solaris or Linux, 
the pid option must be provided. Also, the server name 
is used to invoke the sm_monitor tool.


--broker <location> | -b <location> Specifies an alternate Broker location as host:port.


--log [<number of latest logs>] | 
-l [<number of latest logs>]


For each EMC Smarts server, collects and stores a 
user-specified number of latest logs or all generated log 
files that are in the BASEDIR/smarts/local/logs 
directory.
Note that whenever collecting a log, the related .audit 
and .archive files should be collected as well.
If a server name is specified, only the files that 
correspond to the server will be collected. To avoid 
generating a too-large tar archive (too large to email), 
any log file that is larger than 700 MB will be excluded 
and its information will be logged in 
smgetinfo-versions.log<date>.


--nolog | -g Excludes log files when collecting local files. This option 
and --log are mutually exclusive.


--repos [--latest] | -r [-t] For each EMC Smarts server, collects and stores the 
latest repository file or all repository files. If a server 
name is specified, only the file corresponding to the 
server will be collected. Any repository file that is larger 
than 700 MB will be excluded and its information will be 
logged in smgetinfo-versions.log<date>.


--norps | -n Excludes repository files when collecting local files. This 
option and --repos are mutually exclusive.


--core | -c Collects and stores the core files (Solaris, Linux) or 
dump files (Windows) that are generated by the 
EMC Smarts software, and the corresponding logs.


--all | -a All data and files in BASEDIR/smarts/local and 
BASEDIR/smarts/setup directories will be collected and 
stored. If --all option is specified, the other options will 
be ignored except --server and --pid.


--version | -v Print version information and exit.


--help | -h Print usage information and exit.


--smmonitor “<sm_monitor options>” | 
-m “<sm_monitor options>”


Specifies the options for running sm_monitor, which 
will override the default options “-m run-all -z.”
Approximately two cycles are run to collect the required 
information. The collected information is output to the 
BASEDIR/smarts/local/logs/SM-Monitor-<server name> 
directory.


--flush | -f Force a flush. Needed when the sm_getinfo utility is 
invoked from a remote host.
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sm_getinfo invocation examples


To gather the five latest logs, enter:


sm_perl sm_getinfo.pl  --logs 5


To gather the latest repository data and core files, enter:


sm_perl sm_getinfo.pl  --repos --latest --core


To gather the entire BASEDIR/smarts/local directory, enter:


sm_perl sm_getinfo.pl  --all


To invoke sm_monitor, enter:


On UNIX/Linux:


sm_perl sm_getinfo.pl -s <server name> -m “-m correlation -z”


On Windows:


sm_perl sm_getinfo.pl -s <server name>  -m “-m mem”


sm_getinfo data collection


If no command-line option is specified, the sm_getinfo utility will store the following 
information in the tar archive:


◆ For each server, the latest server log file in BASEDIR/smarts/local/logs and the related 
.audit and .archive files in BASEDIR/smarts/local/logs. If a server name is specified, 
only the files that correspond to the server will be collected. To avoid generating a 
too-large tar archive (too large to email), any log file that is larger than 700 MB will be 
excluded and its information will be logged in smgetinfo-versions.log<date>.


◆ For each server, the latest repository file in BASEDIR/smarts/local/repos. If a server 
name is specified, only the repository file for the server will be archived. Any 
repository file that is larger than 700 MB will be excluded and its information will be 
logged in smgetinfo-versions.log<date>.


◆ The local files that are not in the BASEDIR/smarts/local/logs and repos directories 
and changed since last temporary test patch (TTP) and patch.


◆ The new local files that are not in the BASEDIR/smarts/local/logs and repos 
directories and were added since the last TTP and patch.


◆ All local files except the files in logs and repos directories if no TTP or patch is 
installed.


◆ All files in the BASEDIR/smarts/setup/info and BASEDIR/smarts/setup/logs 
directories.


◆ Core files (Solaris, Linux) or dump files (Windows) that are generated by the 
EMC Smarts software, and the corresponding server log files. On UNIX or Linux, some 
library (lib) files that are related to the cores are also collected.
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◆ EMC Smarts TTP or patch version information. Additionally, it verifies MD5 checksum 
for the installed TTP files and the files that are listed in manifest.md5 in the 
BASEDIR/smarts/setup/info directory.


◆ The data collected by sm_monitor. If a server name is specified, only the files that 
correspond to the server will be collected.


◆ The data generated by the EMC Ionix ITOps Health Monitor.


◆ System environment information.
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Overview of the steps to set up license management
You should use the license administration procedures in this chapter in conjunction with 
the procedures in each EMC Smarts product’s installation guide and in the FlexNet 
Publisher License Administration Guide. To complete the procedures, you will need 
administrative privileges for both the EMC Smarts software and the host systems on which 
the software is running.


For licensing and license management, EMC Smarts Foundation products rely on a 
third-party licensing software product, FlexNet Publisher®, from Flexera Software™ 
Corporation. The FlexNet Publisher licensing software is installed automatically during the 
software installation process.


You will need to perform the following to complete the licensing process for your 
EMC Smarts products:


1. Obtain and setup one of the following license files from EMC: 


• Temporary — time-limited.


“Obtain and set up a temporary license file” on page 39 provides further 
information.


Setting up a temporary license file is a postinstallation task. 


• Permanent — not time-limited.


“Obtain and set up a permanent license file” on page 40 provides further 
information.


For installation upgrades (such as upgrading entire products or adding products to 
an existing directory), obtaining and setting up a permanent license file is 
performed before the upgrade installation. 


For new installations or migrations (that use a new or different directory), setting 
up a license file is a postinstallation task. 


The installation guide that accompanied your product describes the order of 
installation tasks. The migration guide that accompanied your product describes 
the license migration procedure.


2. For permanent license files only, do one of the following:


• Use an existing FlexNet Publisher license server that you already installed for other 
software applications. “Use an existing FlexNet Publisher license server” on 
page 44 provides additional information.


• Install and configure the FlexNet Publisher license server provided with the 
EMC Smarts software. “Install and configure the FlexNet Publisher license server” 
on page 43 provides additional details.
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License components and process flow
Licensing involves the following components:


◆ FlexNet Publisher license server—The FlexNet Publisher license server authenticates 
EMC Smarts products. The FlexNet Publisher license server consists of two types of 
processes: a license manager daemon and one or more vendor daemons. On 
Windows, both processes run as services.


• The license manager daemon receives the initial contact from products and passes 
the connections to a vendor daemon. It also manages all of the vendor daemons.


• A vendor daemon is a process that controls how many licenses are in use, as 
defined in a permanent license file. There is a vendor daemon for each vendor who 
has a FlexNet Publisher-licensed product on the network.


◆ Vendor daemon for EMC Smarts—The vendor daemon for EMC Smarts is the process 
that grants and records the licenses for EMC Smarts software.


◆ Permanent license file—The permanent license file is generated by EMC. It controls 
access to applications and features as well as limits the number of systems 
discovered by EMC Smarts products.


◆ EMC Smarts products—These products communicate with the FlexNet Publisher 
license server to request a license.


EMC recommends that the FlexNet Publisher license server run on the same host as 
the Broker.


Process flow
Figure 2 on page 36 shows a FlexNet Publisher license server, a vendor daemon for 
EMC Smarts, and a permanent license that resides on the same host as the license server.
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Figure 2  Process flow


For all EMC Smarts products, the SM_LICENSE variable specifies the port and host where 
the FlexNet Publisher license server resides.


The process flow is as follows:


1. An EMC Smarts product sends a request to the FlexNet Publisher license server for a 
license to access an application or a feature. In the case of a Global Console, a console 
relies on its Manager to send a request for licenses to access console features.


2. The FlexNet Publisher License Manager daemon receives the request and passes it to 
the vendor daemon for EMC Smarts.


3. The vendor daemon for EMC Smarts reads the permanent license file and checks if a 
license is available.


• If a license is available, the EMC Smarts product is allowed to use the application 
or feature. 


• If a license is not available, the vendor daemon for EMC Smarts writes an error 
message to BASEDIR/smarts/local/logs/flexlm.log and the application or feature 
does not work. Also, an error message is written to the log file of the Manager that 
requested the license (for example, 
BASEDIR/smarts/local/logs/MYDM-SA_en_US_UTF-8.log).
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Examples of license files
EMC generates license files according to the FlexNet Publisher license file format. This 
section provides an example of a temporary license file and a permanent license file. The 
FlexNet Publisher License Administration Guide provides a more complete descriptions of 
file format syntax.


Temporary license file example


A temporary license file is not user-modifiable. 


For illustrative purposes, the following example is an excerpt of a smarts.lic file for 
EMC Smarts Foundation software version 9.0.


FEATURE DMC_CORR sm_lmgrd92 9.0 04-dec-2008 uncounted 1C8F62B2E672 \
HOSTID=DEMO SN=DO315530889 START=4-nov-2008


FEATURE AD_PEM sm_lmgrd92 9.0 04-dec-2008 uncounted 53BCCF735983 \
HOSTID=DEMO SN=DO315530889 START=4-nov-2008


FEATURE AP_ICSRV sm_lmgrd92 9.0 04-dec-2008 uncounted FFE23AFEFAF8 \
HOSTID=DEMO SN=DO315530889 START=4-nov-2008


FEATURE DMC_DECS sm_lmgrd92 9.0 04-dec-2008 uncounted 5A1809C9A688 \
HOSTID=DEMO SN=DO315530889 START=4-nov-2008


The temporary license file consists of a list of applications or features. Each line begins 
with the FEATURE keyword.


Each FEATURE line includes the following:


◆ Feature name


◆ Vendor daemon name (sm_lmgrd92)


◆ Feature version 


◆ Expiration date


◆ Number of concurrent licenses, which is “uncounted” in this case


◆ Authentication signature for the feature 


◆ HOSTID=DEMO value that indicates that the feature is not bound to any particular host 


◆ Serial number (SN) to identify the FEATURE line 


◆ Start date


Permanent license file example


A permanent license file is user-modifiable. In most cases, you do not have to modify the 
permanent license file. The only values that you can safely change without damaging the 
licensing process are as follows:


◆ Port number for the FlexNet Publisher license server. 


◆ Directory path to the vendor daemon for EMC Smarts.


◆ Keyword PORT=<port_value>. Add this keyword and value pair to the VENDOR line for 
the vendor daemon for EMC Smarts if a firewall is present.
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For illustrative purposes, the following example is an excerpt of a <host_ID>.smarts.lic file:


SERVER this_host 80cdc5dc 1744
VENDOR sm_lmgrd92 BASEDIR/smarts/bin/sm_lmgrd92
USE_SERVER
INCREMENT DMC_CORR sm_lmgrd92 9.0 permanent 1 1454E7768847 \
        DUP_GROUP=SITE SN=OR54127 TS_OK
INCREMENT AP_ICSRV sm_lmgrd92 9.0 permanent 1 9639EDFD001C \
        DUP_GROUP=SITE SN=OR54127 TS_OK


The permanent license file consists of information for the FlexNet Publisher license server 
(SERVER line), the vendor daemon (VENDOR line), and a list of applications or features 
(FEATURE or INCREMENT line). The USE_SERVER line does not affect the server and is used 
by the application.


◆ The SERVER line includes the following:


• Value “this_host” (which is a required literal, that is, not enclosed in quotation 
marks).


• Host ID of the system where the FlexNet Publisher license server resides.


• Port number of the FlexNet Publisher license server. The default port number is 
1744.


◆ The VENDOR line includes the name of the vendor daemon for EMC Smarts 
(sm_lmgrd92) and the directory path to the vendor daemon.


◆ The USE_SERVER line does not specify any arguments or keywords.


◆ Each INCREMENT line includes the following:


• Feature name


• Vendor daemon name (sm_lmgrd92)


• Feature version


• Expiration date, which is “permanent” in this case


• Number of concurrent licenses (1 for example)


• Authentication signature for the feature


• Duplicate grouping that indicates site license sharing


• Serial number (SN) to identify the INCREMENT line


• Indication of whether access to the application by using a Terminal Server window 
is allowed
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Obtain and set up a temporary license file
“Temporary license file example” on page 37 presents an excerpt of a temporary license 
file. Note that an evaluation copy of the Global Console does not require a temporary 
license file.


A temporary license file is time-limited. It enables you to use specified features for a 
limited period of time, according to an evaluation agreement.


Because a temporary license file contains only uncounted licensed features, it does not 
require that a FlexNet Publisher license server be running in order to use it. An uncounted 
licensed feature has an associated license count of 0 (unlimited).


To obtain and set up a temporary license file:


1. Complete an evaluation request and an evaluation agreement.


2. Contact your sales representative or go to Service Center on EMC Online Support 
(https://support.emc.com) and create a service request indicating that you need a 
temporary (evaluation) license file. 


3. A License will be sent to the email address included in the order.


The name of the license file has a .lic file extension:


a. Do not modify the license file contents. 


b. Do not copy and paste its contents to another file. 


4. If required, you can rename the name of the license file:


a. The file must have the .lic file extension


b. Do not include a space before the .lic.


5. In the installation directory of each product that you are evaluating, do the following:


a. Place a copy of the temporary license file (<license_name>.lic) in the 
BASEDIR/smarts/local/conf directory. For example, for an IP Manager installation 
on a Windows host:


C:\InCharge\IP\smarts\local\conf\<license_name>.lic


b. Go to the BASEDIR/smarts/bin directory and enter the following command to open 
the runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


c. Find the SM_LICENSE variable and edit it to point to the license file. For example, 
on a Windows host:


SM_LICENSE=C:\InCharge\IP\smarts\local\conf\<license_name>.lic


Ensure that the name and extension of the license file in the SM_LICENSE variable 
definition match the name and extension of the license file.


d. Save and close the file.
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The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


e. Any Manager that was launched from this installation directory before you edited 
the runcmd_env.sh file needs to be restarted. Chapter 5, “Controlling Startup,” 
describes how to start services.


For a host on which multiple EMC Smarts products are installed, you can install the 
temporary license in just one installation directory and then set the SM_LICENSE variable 
for each product to point to that one location.


How to renew a temporary license file


To renew a temporary license file, you must request another temporary license file. Follow 
the instructions in“Obtain and set up a temporary license file” on page 39.


Obtain and set up a permanent license file
“Permanent license file example” on page 37 presents an excerpt of a permanent license 
file. A permanent license file defines the number of available licenses for each application 
or feature, and the number of devices that an EMC Smarts manager such as EMC Smarts IP 
Availability Manager can discover. A permanent license file does not expire.


1. Contact your sales representative or go to Service Center on EMC Online Support 
(https://support.emc.com) and create a service request indicating that you need a 
permanent license file. 


You will receive a License Authorization Code (LAC) letter. 


2. Delete any previous temporary license file in the BASEDIR/smarts/local/conf 
directory.


3. Determine the host id of the computer where the FlexNet Publisher license server is 
running:


• UNIX: BASEDIR/smarts/bin/lmutil lmhostid


• Windows: BASEDIR\smarts\bin\lmutil lmhostid


The output should resemble the following:


BASEDIR/smarts/bin/lmutil lmhostid


lmutil - Copyright (c) 1989-2012 Flexera Software, Inc. All Rights 
Reserved.
The FLEXnet host ID of this machine is “000c293226ec”


4. Following the instructions in the LAC letter, go to EMC Online Support 
(https://support.emc.com) and access the License Management home page to 
retrieve your license file. Provide the host id of the computer where the FlexNet 
Publisher license server is running.


You will be emailed the license file.


Use the license as is. Do not rename the file. Do not modify the file contents. Do not 
copy and paste its contents to another file.
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5. Save the permanent license file, smarts.lic, in the BASEDIR/smarts directory on the 
host where the license server is or will be running. EMC recommends that this location 
be the same host and BASEDIR/smarts as for the Broker.


Do not save the permanent license file (smarts.lic) to the BASEDIR/smarts/local/conf 
directory. The install_license script will fail if it finds a permanent license file in this 
directory. Also, do not save a permanent license file to the BASEDIR/smarts/script or 
BASEDIR/smarts/conf directory.


6. By default, the FlexNet Publisher license server uses port 1744 to listen for requests. If 
port 1744 is used by another required process on the server:


a. Use any text editor to open the BASEDIR/smarts/smarts.lic file.


b. Locate the line that starts with SERVER. This line contains the hostname, host id, 
and port of the license server, similar to:


SERVER this_host 8323fcbf 1744


c. Change the SERVER port number from the default (1744) to the required port 
number.


d. Save and close the permanent license file.


7. If the FlexNet Publisher license server must communicate through a firewall to the 
EMC Smarts Foundation products:


a. Configure security policies (rules) to enable a one-way connection from the FlexNet 
Publisher license server and the Broker to the various products. 


b. Determine the appropriate port to be used by the FlexNet Publisher license server 
to respond to requests. This port is used by the vendor daemon for EMC Smarts 
which grants and records the licenses for the software. The port number for the 
vendor daemon must be different from the SERVER port number.


c. Use any text editor to open the BASEDIR/smarts/smarts.lic file.


d. Locate the line that starts with VENDOR, similar to:


VENDOR sm_lmgrd92 BASEDIR/smarts/bin/sm_lmgrd92


e. Append the PORT keyword and assigned port number to the end of the VENDOR 
line in the permanent license file:


VENDOR sm_lmgrd92 BASEDIR/bin/sm_lmgrd92 PORT=<port_number>


f. Save and close the permanent license file.


g. If you request licenses for additional products or additional device licenses follow 
instructions   “Add another permanent license to a running license server” on 
page 45.
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Rehost license


Rehost is the process of moving activated entitlements from one device or machine to a 
different device or machine. An entitlement is a record of the software you are entitled to 
use. For example, Global Console 25 Pack is represented as SMA-GC-25P.


If you are a customer who has already interacted with the EMC licensing team and 
obtained your license by following instructions in the LAC letter, setup for the first time, 
you can rehost a license without opening an Service Request with EMC.


Go to EMC Online Support and access the License Management home page. You need one 
of four options to search for existing installed license keys and follow the prompts to move 
the key to a new host. For example, choose 


◆ A rehost may be partial (moving a portion of the entitlements) or


◆ A rehost may be full (moving everything on the device or machine).


For example, a full rehost would be completed when a new server is installed and replaces 
an existing server. The entitlements would be rehosted and locked to the new server in the 
licensing system by using the "Locking ID" of the new server. If you do no have LAC letter 
contact licensing team by opening a Service Request on https://support.emc.com.


Regenerate license


Regeneration is a process of recreating activated entitlements. If you have already 
interacted with the EMC licensing team and obtained your license by following instructions 
in the LAC letter, you can regenerate a license without emailing EMC.


Go to EMC Online Support and access the License Management home page. Click the 
Activation tab and choose Regenerate License. Use the online help to obtain additional 
information.
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Install and configure the FlexNet Publisher license server
The FlexNet Publisher license server is installed using the install_license script:


◆ By default, the install_license script is located in the BASEDIR/smarts/script directory. 


◆ The install_license script must be run on the same system where the license server 
runs.


◆ Administrative privileges are required.


1. If operating in a firewall environment, make sure that the ports specified in the 
SERVER and VENDOR lines of the permanent license file are open.


2. Change to the BASEDIR/smarts/script directory.


3. Install the FlexNet Publisher license server by using the install_license script. Specify 
the full path to the permanent license file.


On UNIX systems, for example, the command is:


install_license.sh install <path to license file>/smarts.lic


On Windows systems, for example, the command is:


install_license.cmd install <path to license file>\smarts.lic 


4. Start the FlexNet Publisher license server. You must have administrative privileges.


UNIX systems:


/etc/init.d/SMARTS-License start


Windows:


To start the license server manually, do the following as administrator:


a. Select Start > Settings > Control Panel > Administrative Tools.


b. Select Services.


c. Select the FLEXlm License Manager service.


d. Right-click and choose Start.


When the FlexNet Publisher license server is started, it runs in the background and 
automatically starts the vendor daemon for EMC Smarts programs, running as:


• UNIX: daemon


• Windows: service
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5. Verify that the FlexNet Publisher license server started by checking your Manager log 
file.


a. Start your Manager, as described in Chapter 5, “Controlling Startup.”


b. Use any editor to open the Domain Manager log file. The log filename is based 
upon the Manager’s name (for example, MYDM-SA_en_US_UTF-8.log) and the log 
file is located in the BASEDIR/smarts/local/logs directory.


c. In the Manager log file, locate two messages that indicate success:


– ICF-N-LICENSEDFEATURE-Enabling


– ICF-N-RESTOREFINISH-PersistenceManager: restore finished 


The log filename is based upon the Manager’s name (for example, 
MYDM-SA_en_US_UTF-8.log) and the log file is located in the 
BASEDIR/smarts/local/logs directory. 


Use an existing FlexNet Publisher license server
You can use an existing FlexNet Publisher license server that is being used for other 
software applications. The FlexNet Publisher version of the license server must be version 
11.9 in order to manage the vendor daemon for EMC Smarts. Consult your FlexNet 
Publisher License Administration Guide for more complete information.


1. Copy the permanent license file, smarts.lic, to the host where the FlexNet Publisher 
license server resides.


2. On other hosts wherever EMC Smarts software is installed, modify the SM_LICENSE 
variable in the runcmd_env.sh file to specify the port and host of the FlexNet Publisher 
license server.


a. Go to the BASEDIR/smarts/bin directory and enter the following command to open 
the runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b. Locate the line starting with SM_LICENSE:


SM_LICENSE=<port>@<hostname>


c. Specify the correct port number and hostname of the FlexNet Publisher license 
server, as in the following example:


SM_LICENSE=1744@System1


d. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.
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Add another permanent license to a running license server
If you need to add new features or increase the number of licenses:


1. Contact your sales representative or go to Service Center on EMC Online Support 
(https://support.emc.com) and create a service request and provide the completed 
Permanent License Information Request form.


You will receive a License Authorization Code (LAC) letter. 


2. Following the instructions in the LAC letter, access EMC Online Support, Licensing 
option, to retrieve your license file, smarts.lic. Provide the host id of the computer 
where the FlexNet Publisher license server is running. 


The .lic file will be sent to the customer.


3. Use any text editor to modify the new file so that the port number and path match 
those in the original license file.


4. Copy the new file to BASEDIR/smarts/local/conf.


5. Force the license server to reread the license files. In the BASEDIR/smarts/bin 
directory, with administrative privileges, enter:


lmutil lmreread -c <port>@<lic_host>


• UNIX example


BASEDIR/smarts/bin/lmutil lmreread -c 1744@localhost


• Windows example


BASEDIR\smarts\bin\lmutil lmreread -c 1744@localhost


You do not need to restart Managers. There can be multiple permanent license files in the 
BASEDIR/smarts directory. The FlexNet Publisher license server will read all files with the 
.lic suffix.


The FlexNet Publisher License Administration Guide provides additional information about 
the lmreread utility.
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Change the license server port in a running license server
Once the permanent license has been installed, you can change the port on which the 
FlexNet Publisher license server runs. 


1. Use any text editor to open the BASEDIR/smarts/smarts.lic file.


2. Locate the line that starts with SERVER. This line contains the hostname, host id, and 
port of the license server. In this example, the port number is 1744.


SERVER this_host 8323fcbf 1744


3. Change the SERVER port number to the required port number.


4. Save the permanent license file.


5. Enter the following command from the BASEDIR/smarts/bin directory to force the 
license server to restart:


lmutil lmreread -c <port>@<lic_host>


6. Enter the following command from the BASEDIR/smarts/bin directory to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


The runcmd_env.sh file should resemble the following:


SM_BROKER_DEFAULT=localhost:426
SM_LICENSE=1744@SYSTEM1 
SM_SNMP_BUG_COMPATIBLE=TRUE
SM_INCOMING_PROTOCOL=1,0
SM_OUTGOING_PROTOCOL=1,0


7. Set the SM_LICENSE variable to the <port>@<lic_host> of the FlexNet Publisher license 
server.


8. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


At this point, any EMC Smarts program that is started from this installation directory 
will use the applicable environment variables that are specified in the runcmd_env.sh 
file.


9. EMC Smarts programs that were previously launched from this installation directory 
need to be restarted for any new environment variable to take effect. Chapter 5, 
“Controlling Startup,” describes how to start services.
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Enable communication through a firewall in a running license 
server


1. Add the PORT keyword and port number to the second line of the permanent license 
file, labeled VENDOR, as shown:


SERVER this_host 80cdc5dc 1744
VENDOR sm_lmgrd92 BASEDIR/smarts/bin/sm_lmgrd92 PORT=<port_number>
USE_SERVE
INCREMENT DMC_CORR sm_lmgrd92 9.0 permanent 1 1454E7768847 
DUP_GROUP=SITE SN=OR54127 TS_OK


Do not remove the 1744 default port value from the SERVER line.


2. Force the license server to restart. Invoke this command from the BASEDIR/smarts/bin 
directory with administrative privileges:


lmutil lmreread -c <port>@<lic_host>


Use of multiple FlexNet Publisher license servers
More than one FlexNet Publisher license server may be required depending on your 
deployment. If there is more than one Broker for the installation, there may be good 
reason to use more than one license server. In general, you should run a FlexNet Publisher 
license server on each host that runs a Broker. 


Each FlexNet Publisher license server will need its own permanent license file. Each 
permanent license file controls the applications, features, and the number of blocks of 
licenses for discovered devices. Excess licenses on one system cannot be allocated to 
another. For each license server, perform the steps described in “Obtain and set up a 
permanent license file” on page 40.


In certain cases, you may use multiple FlexNet Publisher license servers in your network 
for the same reasons that you split a topology or choose different locations for Managers: 
geographical requirements, corporate organizational requirements, or the network’s 
security design. Multiple license servers require a corresponding number of permanent 
license files.


Also, when multiple FlexNet Publisher license servers are used, each EMC Smarts IP 
Availability Manager will use blocks of volume licenses from a specific license server. 
Therefore, the license blocks must be divided among multiple licenses and the 
appropriate license must be deployed to each license server. Then, IP Availability 
Managers that rely on a specific license server will have the appropriate volume licenses 
to support the systems that they must manage. If multiple license servers are used, 
ensure that EMC is aware of the configuration details. 
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Upgrade licensing during EMC Smarts software upgrades
1. Before you upgrade the software, check the release notes if a new license file is 


required.  If not, then you can continue using your existing license. If a new license is 
required then request one by opening an Service Request on EMC Online Support 
https://support.emc.com.


You will receive a License Authorization Code (LAC) letter. 


2. Upgrade the installation to the new version.


THe FlexNet server will be upgraded with the rest of the software.


3. Modify the new license file to match the port number in the existing license file.


4. Replace the existing <BASEDIR>/smarts/local/conf/smarts.lic with the new license file.


5. Start the license server.


6. Start your application.


Note: No action is required on hosts that were pointing to this license server before 
the upgrade.


Run older versions of license files in parallel
For some upgrades, installations, and migration scenarios, it is necessary that the FlexNet 
Publisher license server accept a newer permanent license file, as well as license files for 
older software. In this instance, a single license server manages both the old and the new 
permanent license files.


1. Install the newer software on the same system in a different directory than the older 
software. 


2. If you have not already obtained and setup the new smarts.lic file in your 
BASEDIR/smarts directory on the system where the FlexNet Publisher license server 
will run, do so. “Obtain and set up a permanent license file” on page 40 provides 
additional information.


3. If you have not already installed the FlexNet Publisher license server by using the 
install_license script, do so. “Install and configure the FlexNet Publisher license 
server” on page 43 provides additional information.


4. Copy and rename the old license file license.dat from the BASEDIR/smarts/local/conf 
directory of the old installation to legacy_license.lic and place the file in the new 
installation directory, BASEDIR/smarts/local/conf.


5. Use the sm_edit utility to open the old license file, legacy_license.lic. In this case, use 
sm_edit instead of any text editor because sm_edit will save the file to the correct 
local directory with the proper permissions.


For example on Windows, issue:


BASEDIR\smarts\bin> sm_edit conf\legacy_license.lic
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6. In the legacy_license.lic file, change the following in the first two lines:


• On the SERVER line, change hostname to this_host.


The “this_host” is a literal term that MUST BE in the license file. Do not put 
quotation marks around the literal, this_host.


• On the SERVER line, change the port from 744 to 1744 (or the port for the FlexNet 
Publisher license server if it is different).


• On the DAEMON line, change the vendor daemon path from sm_lmgrd to the full 
directory path for the old daemon; for example, on UNIX, 
/opt/InCharge/<product>/bin/sm_lmgrd. For Windows, use sm_lmgrd.exe.


In order for the new FlexNet Publisher license server to find the old daemon 
process, specify the BASEDIR/smarts directory for the location of the old 
installation. In the following examples, host_ID is the system where the newer 
FlexNet Publisher license server is running. Do not modify the host ID. 


Here is an example of a license file:


SERVER this_host host_ID 1744
DAEMON sm_lmgrd BASEDIR/smarts/bin/sm_lmgrd


7. Stop the old license server. Use the procedure in “Starting and stopping the license 
server” on page 52 except substitute stop for start. 


8. Uninstall the old license server by using the install_license script. Replace the 
parameter install with uninstall, as described in “Uninstall the FlexNet Publisher 
license server” on page 51. 


9. For the older product , modify the following to reflect the port and the system where 
the newer FlexNet Publisher license server is running. The value for <license_host> is 
the system where the newer FlexNet Publisher license server resides.


Modify the SM_LICENSE variable in the runcmd_env.sh file to specify port 
1744@<license_host>.


10. Start the new FlexNet Publisher license server, as described in “Starting and stopping 
the license server” on page 52.


11. To check that the FlexNet Publisher license server loaded the old and new license files, 
look at the license server’s log file, BASEDIR/smarts/local/logs/flexlm.log. The log 
should not contain errors.


12. Restart the older Managers, by using the documentation that accompanied the older 
EMC Smarts software.
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Overview of the install_license script
This section describes the install_license script and explains how the script installs a 
FlexNet Publisher license server that is provided with EMC Smarts software. The same 
script is also used to uninstall the FlexNet Publisher license server. The FlexNet Publisher 
License Administration Guide provides further information if you already use an existing 
FlexNet Publisher license server for other software applications.


The install_license script, provided by EMC, performs several functions:


◆ Installs a FlexNet Publisher license server, as described in “Install and configure the 
FlexNet Publisher license server” on page 43.


◆ Installs the permanent license file into the BASEDIR/smarts/local/conf directory. 
(Initially, the permanent license file is saved to the BASEDIR/smarts directory on the 
system where the license server will run.)


Also, when the script installs the permanent license file into the 
BASEDIR/smarts/local/conf directory, the script changes the permanent license 
filename from <host_id>.smarts.lic to smarts.lic.


◆ Adds the SM_LICENSE variable in the runcmd_env.sh file so that the variable specifies 
the <port>@<lic_host> of the FlexNet Publisher license server.


◆ For UNIX, it configures the system so that the FlexNet Publisher license server starts 
automatically when the system boots. 


◆ For Windows, the install_license script creates a service for the FlexNet Publisher 
license server and the service starts automatically when the system boots.


Do not use the install_license script if you are adding more licenses or features. Instead, 
you should follow the instructions in “Upgrade licensing during EMC Smarts software 
upgrades” on page 48.
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Uninstall the FlexNet Publisher license server
When you uninstall the license server, the order in which you uninstall EMC Smarts 
products is significant. The installation guide that accompanied your product provides 
instructions.


Also keep the following points in mind:


◆ When uninstalling all of your EMC Smarts products, you must also uninstall the 
FlexNet Publisher license server. 


◆ If any EMC Smarts product needs to remain in your network and uses the FlexNet 
Publisher license server, do not uninstall the FlexNet Publisher license server or the 
product where the permanent license file resides. 


◆ If you uninstall EMC Smarts products without uninstalling the FlexNet Publisher 
license server, a message displays that the FlexNet Publisher (lmgrd) service is still 
running. 


◆ An EMC Smarts product will not start if it is unable to contact the FlexNet Publisher 
license server. 


To stop and uninstall the FlexNet Publisher license server:


1. Stop the FlexNet Publisher license server. Use the procedure in “Starting and stopping 
the license server” on page 52 and substitute stop for start. 


2. Execute the install_license script with the uninstall command from the 
BASEDIR/smarts/script directory. You must do so with administrative privileges.


On UNIX systems, for example, the command is:


BASEDIR/smarts/script> install_license.sh uninstall


On Windows systems, for example, the command is:


BASEDIR\smarts\script> install_license.cmd uninstall
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License server administration tools
FlexNet Publisher provides several utilities for managing licenses. These include utilities 
for the following:


◆ Diagnosing licensing problems


◆ Forcing the license server to reread the license files


◆ Monitoring the status of all licensing activities including feature usage


Instructions on using these utilities can be found in the FlexNet Publisher License 
Administration Guide.


The utilities are automatically installed on:


◆ UNIX in the BASEDIR/smarts/bin directory.


◆ Windows in the BASEDIR\smarts\bin directory.


If you are not familiar with FlexNet Publisher, you may want to read the FlexNet Publisher 
documentation. A PDF version of the FlexNet Publisher License Administration Guide is 
automatically installed with the EMC Smarts documentation in the 
BASEDIR/smarts/doc/pdf directory. The name of the file is fnp_licAdmin.pdf.


Verify the FlexNet Publisher license server version


To verify the version of the FlexNet Publisher license server, use the -v option for the 
FlexNet Publisher license server command. Enter this command with administrative 
privileges:


BASEDIR/smarts/bin/lmgrd -v


The output will be similar to the following:


lmgrd v11.9.0.0 build 87342 x64_lsb - Copyright (c) 1988-2012 Flexera 
Software, Inc. All Rights Reserved.


Starting and stopping the license server


The FlexNet Publisher license server (lmgrd) is automatically installed in the 
BASEDIR/smarts/bin directory. The FlexNet Publisher license server runs in the 
background and automatically starts the vendor daemon for EMC. It runs as:


◆ Daemon on UNIX 


◆ Service on Windows 


Run the FlexNet Publisher license server at all times to ensure continuous operation of 
EMC Smarts software. A Manager (Global Manager or Manager) will not start if it is unable 
to contact the license server. Adapters and the Global Console will run if they are unable to 
contact the license server, but they will display an error message.
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The command for starting and stopping the FlexNet Publisher license server varies 
according to the operating system on which it runs. When you invoke the install_license 
script, this command is added to the proper system-specific directory so that the 
command is invoked when the system starts and, for Windows, the service starts. 


The procedure to manually start and stop the FlexNet Publisher license server is described 
as follows.


One of two possible options must be supplied with the command. You must have 
administrative privileges to run these commands. 


The start option starts the process; the stop option ends the process.


Solaris:


/etc/init.d/SMARTS-License start


Linux:


/etc/init.d/SMARTS-License start


Windows:


To start the license server on Windows manually, do the following as administrator:


1. Select Start > Settings > Control Panel > Administrative Tools.


2. Select Services.


3. Select the FLEXlm License Manager service.


4. Right-click and choose Start (or Stop).


License checking by an EMC Smarts application
When an EMC Smarts application starts up, it prints a list of features that are licensed, 
followed by a list of the features that are not licensed. The second list starts with The 
following feature(s) are not licensed, followed by a list of features, one per line. That list is 
intended to help in the resolution of licensing problems.
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Volume licensing for EMC Smarts IP Availability Manager
The EMC Smarts permanent license controls the number of discovered systems. The 
FlexNet Publisher license server maintains a pool of licenses that get checked out in 
blocks to IP Availability Manager products on an as-needed basis. A block consists of 50 
devices. Products check out additional licenses one block at a time, as described in 
“Discovery and licenses” on page 56. 


Determining the total number of licenses


Each permanent license file contains a line that defines the number of licensed systems. 
The line begins with the phrase INCREMENT AP_SYSTEM_VOLUME. The total volume of 
system licenses is determined by the sum of licenses that are granted through 
AP_SYSTEM_VOLUME in all of the license files.


An example of line in the license file is:


INCREMENT AP_SYSTEM_VOLUME sm_lmgrd92 7.0 permanent 10 DE07382C7891
VENDOR_STRING=BlockSize=50


This example shows the volume information of system licenses. The number 10 indicates 
that there are ten blocks of licenses. Each block contains 50 licenses. Multiplying the two 
produces the total number of systems licensed by the permanent license file; the result is 
500.


Determining the number of checked-out licenses


Two utilities help to keep track of the number of checked-out licenses:


◆ The lmstat option of the lmutil utility shows the total number of license blocks that are 
checked out from the FlexNet Publisher license server.


◆ The sm_tpmgr utility shows the number of system licenses that are checked out and 
the number of system licenses that are used for a single Manager.


Total number of checked-out licenses
The lmstat option of the lmutil utility shows the total number of licenses checked out from 
the FlexNet Publisher license server. The output of the utility can be confined to the 
number of license blocks checked out for devices. 


Invoke this command from the BASEDIR/smarts/bin directory with administrative 
privileges:


lmutil lmstat -c <port>@<lic_host> -f AP_SYSTEM_VOLUME 


The following example shows the number of device license blocks checked out from the 
license server running on port 1744 on the host, host2:


BASEDIR/smarts/bin/lmutil lmstat -c 1744@host2 -f AP_SYSTEM_VOLUME 
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This command returns the following information:


lmutil - Copyright (c) 1989-2010 Flexera Software, Inc. All Rights 
Reserved.


Flexible License Manager status on Fri 11/12/2010 18:06


[Detecting lmgrd processes...]
License server status: 1744@host2
    License file(s) on host2: smarts.lic-1744:


host2: license server UP (MASTER) v10.1


Vendor daemon status (on fawn.smarts.com):


sm_lmgrd92: UP v10.1
Feature usage info:


Users of AP_SYSTEM_VOLUME:  (Uncounted, node-locked)


  "AP_SYSTEM_VOLUME" v6.2, vendor: sm_lmgrd92
  uncounted nodelocked license locked to NOTHING (hostid=ANY)


    root smarts1 /dev/tty (v3.00) (host2/1744 607031), start Tue 10/19 
18:12


    root smarts1 /dev/tty (v3.00) (host2/1744 454338), start Tue 10/19 
18:12


This output shows that the FlexNet Publisher license server is managing a total of five 
license blocks (or 250 devices). Two IP Availability Managers running on host1 have 
checked out three license blocks (One license block is not shown). One IP Availability 
Manager running on host2 has checked out two license blocks.


Checked-out licenses and license blocks for a single IP Availability Manager
To determine the total number of checked-out licenses for a single IP Availability Manager, 
specify the --sizes option for the sm_tpmgr command. This shows the total number of 
system licenses.


Invoke this command from the BASEDIR/smarts/bin directory with administrative 
privileges:


sm_tpmgr -s <availability_manager> --sizes


The output should include information about the number of checked-out system licenses 
and the current number of counted systems. The difference between the two numbers 
shows the number of unused licenses for a single license block. 


The following example shows that 50 system licenses (One block) have been checked out, 
38 of the licenses have been used, 450 system licenses remain (9 blocks), and the current 
limit of discovered systems is 500 (10 blocks):


Total System Volume Licenses CheckedOut:               50
Total Systems in Topology:                             38
Remaining Blocks of System Licenses in License Server: 9
Current System Limit:                                  500
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Discovery and licenses


Volume licensing applies to EMC Smarts IP Availability Managers and permits the product 
to discover a predetermined number of systems. 


As more devices are added to the topology, the block fills to its limit of 50. When this limit 
is reached, the product checks out another block of licenses. Blocks are checked out one 
at a time and a new block will not get checked out until all of the licenses in the previous 
block are used. Any unused blocks are checked back in at the end of the discovery 
process. 


For example, an IP Availability Manager with no topology starts an autodiscovery process. 
It checks out a block of system licenses. When it adds the 50th device to its topology, the 
IP Availability Manager checks out a new block of system licenses. Supposing, however, 
that it does not find any other device, it will check the empty block back into the FlexNet 
Publisher license server when discovery ends.


Limiting discovery
There are a couple of options to consider for sizing constraints. Discovery filters can limit 
the number of devices found during the discovery process. IP Availability Managers can 
also be restricted with an upper limit of discovered systems.


You can limit the number of systems automatically discovered by an IP Availability 
Manager by setting autodiscovery filters. The EMC Smarts IP Manager Reference Guide 
provides additional information about configuring discovery filters.


You can limit the number of systems that are added to the topology by setting a system 
limit on the discovery. By default, the system limit is set to 50 systems. If you change the 
system limit, you should consider making the limit a multiple of 50, the block size for 
device licenses.


Exceeding license limit
If the number of discovered devices exceeds the licensed number of systems, you will 
receive an OutOfLicense event notification and all excess systems are placed in the 
Pending List.


Returning unused license blocks
When a product shuts down with the sm_service or dmquit command, the license blocks 
checked out to the product are returned to the license pool. If the product does not shut 
down gracefully, the license blocks return to the license pool, but not as quickly as for a 
gracefully shut-down product.
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Troubleshooting
This section describes resolutions to common issues experienced by administrators.


If your issue is not listed in this section, make sure you have the following information 
available before contacting EMC Global Services:


◆ The host ID of the system where the FlexNet Publisher license server is installed.


◆ The exact error message or a copy of log file. The FlexNet Publisher license server 
provided by EMC uses the log file BASEDIR/smarts/local/logs/flexlm.log.


◆ The log file used by the Manager. The log filename is based upon the Manager’s name 
(for example, MYDM.log) and the log file is located in the BASEDIR/smarts/local/logs 
directory.


◆ For an IP Availability Manager, output of the sm_tpmgr command with the --sizes 
option. An example is described in “Checked-out licenses and license blocks for a 
single IP Availability Manager” on page 55.


◆ Output of the lmstat utility with the -c and -a options. For example, invoke this 
command from the BASEDIR/smarts/bin directory with administrative privileges:


lmutil lmstat -c <port>@<lic_host> -a


◆ A copy of your purchase order (PO).


◆ The permanent license file.


Evaluation software no longer runs


EMC Smarts software installed for an evaluation is no longer operational. Check the 
expiration date listed in the temporary license file. An example is described in “Temporary 
license file example” on page 37.


Messages in the flexlm.log file


The FlexNet Publisher license server provided by EMC uses the log file 
BASEDIR/smarts/local/logs/flexlm.log.


Messages such as IN and OUT indicate that a product such as a Global Manager or 
Manager checked licenses in or out.


Another common message begins with UNSUPPORTED FEATURE, which indicates that the 
product (Manager) requested to use a feature that the vendor daemon does not support.


The FlexNet Publisher License Administration Guide description of the Debug Log File 
provides an additional explanation of messages.
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Need to determine the FlexNet Publisher license server and all licenses served


To find out information about your existing licensing deployment, use the lmstat utility 
with the -a option. This displays the name of your FlexNet Publisher license server and its 
port number, the location of your permanent license file, the status of the vendor daemon 
for EMC Smarts, and feature usage such as the number of licenses in use.


Invoke the following command from the BASEDIR/smarts/bin directory with administrative 
privileges:


For example, for UNIX, invoke:


BASEDIR/smarts/bin/lmutil lmstat -a


For example, on Windows, invoke:


BASEDIR\smarts\bin\lmutil lmstat -a


The lmstat utility does not provide information about temporary (“uncounted”) licenses 
unless you perform additional configuration. The FlexNet Publisher License Administration 
Guide provides further information and additional lmstat options.


Cannot find license error


An error message, Can’t Find License, occurs in the Manager’s log file (for example, 
BASEDIR/smarts/local/logs/MYDM.log). Check that the values specified for the 
SM_LICENSE variable in the runcmd_env.sh file of your EMC Smarts product are correct. 


On other systems wherever EMC Smarts software is installed, verify that the SM_LICENSE 
variable in the runcmd_env.sh file specifies the port and host of the FlexNet Publisher 
license server.


1. Invoke the following command from the BASEDIR/smarts/bin directory to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


2. Locate the line starting with SM_LICENSE:


SM_LICENSE=<port>@<hostname>


3. Verify that the line specifies the correct port number and hostname of the FlexNet 
Publisher license server, as in the following example. Modify the port and hostname if 
required:


SM_LICENSE=1744@System1


4. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


Changing an IP address and its effect on licensing


Changing a system’s IP address does not affect permanent or trial licensing. Permanent 
licensing is only affected if the host ID changes; it is not affected by changing the 
hostname.


To change the IP address:
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1. Stop all of the EMC Smarts services.


2. Change the IP address of the system.


3. Reboot and then restart all EMC Smarts services.


The hostname of the system can change but the host ID must remain the same. If the host 
ID changes, a new permanent license will be required. 


Error occurs when starting additional Domain Managers


The Unable to Obtain License error occurs when you attempt to start a Manager. It occurs 
when you exceed the number of licenses listed in your permanent license file. 


For example, the following error appears in the Manager’s log file (for example, 
BASEDIR/smarts/local/logs/MYDM.log).


RSRV-E-ELICENSE-Unable to obtain license
 LIC-ECHECKOUT-While attempting to check out license for AP_ICSRV
 LIC-EGENERIC-Licensed number of users already reached
  . Feature:       AP_ICSRV
  . License path:
    1744@localhost
  . FLEXlm error:  -4,132
  . For further information, refer to the FlexNet Publisher License 


Administration Guide,
  . available at "www.flexerasoftware.com".


In the permanent license file, look for the line AP_ICSRV. It should look similar to this:


INCREMENT AP_ICSRV sm_lmgrd92 7.0 permanent 3


The 3 means you are only allowed to start three IP Managers such as IP Availability 
Managers and IP Performance Managers. “Permanent license file example” on page 37 
provides additional information about the INCREMENT line. In order to run more IP 
Managers, contact your account manager or go to Service Center on EMC Online Support 
(https://support.emc.com) and create a service request to obtain a new license.


License file corrupted when attempting to edit license file


The Unable to Obtain License error occurs as the result of a corrupted license file. For 
example, the following error appears in the Manager’s log file (for example, 
BASEDIR/smarts/local/logs/MYDM.log):


Error Message : RSRV-E-Unable to obtain license  LIC-While attempting 
to check out license for AP_ICSRV (version=3.0)


The license file was copied and pasted from an email attachment and then saved to a text 
file. This process wrapped the individual lines in an unexpected manner and added 
additional line breaks which corrupted the license file.


Use the trial license file or permanent license file from the email attachment sent by EMC. 
Never attempt to edit a license file without the assistance of EMC Global Services.
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Cannot restart FlexNet Publisher license server after applying a Service Pack


You shut down all running EMC Smarts processes including the FlexNet Publisher License 
Manager service before installing a Service Pack and then cannot restart the FlexNet 
Publisher License Manager service after the upgrade completes.


This problem likely occurred because the <host_ID>.smarts.lic file incorrectly exists in 
BASEDIR/conf and in BASEDIR/local/conf. The Service Pack reconciliation process 
assumes that the license file in BASEDIR/conf is to be used so it renames the file in 
BASEDIR/local/conf. As a result, the FlexNet Publisher License Manager service cannot be 
restarted.


To resolve this issue, rename the file in BASEDIR/local/conf back to <host_ID>.smarts.lic 
and start the FlexNet Publisher License Manager Service.


If you have not yet installed a Service Pack, use the sm_getinfo utility as described in 
“Using the smgetinfo utility to save modifications” on page 30 to create a backup file and 
move the backup file to a temporary directory or archive. Or, you can copy the permanent 
license file to a temporary directory. After you apply the Service Pack, you can retrieve the 
permanent license file from the backup file and restart the FlexNet Publisher License 
Manager service.


•
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Introduction to Service Assurance Suite (SA Suite) and its 
licensing


This section on licensing applies only if you have upgraded from a standalone (non-SA 
Suite deployment) to the SA Suite. The new SA Suite licensing does not apply to a 
standalone install of any of the Smarts products - the existing product-centric licensing 
still applies. The SA Suite is a bundle of products / functionality (Smarts products, EMC 
M&R, and NCM) orderable as a single part number / SKU and licensing is consistent 
across all products in the SA Suite. Table 6 on page 61 provides information on Standard 
and Advanced editions of the SA Suite.


Contact your account representative for more information on the SA suite. There are no 
differences in the licensing methodology between Standard and Advanced editions of the 
SA Suite. Advanced uses the same device method as Standard. All examples or references 
apply to both Standard and Advanced.


In the SA Suite, licensing has moved to the device scalability (number of network adapters 
a device has) and the number of network adapters is translated into a Managed Object 
(MO) count. A device can consume one (1) or more MO licenses based on the device 
scalability. This can be compared to a point-based licensing system.


The SA Suite looks at the number of network adapters that are on a device and the SA 
Suite defines a device as having 24 or less network adapters - this equates to one (1) MO.  
The state of the network adapters (managed versus unmanaged) is not a consideration in 
the SA Suite licensing because in the SA Suite, all functionality is applied to the suite-level 
and not at the product level.  For example, with NCM as part of the suite, managing the 


Table 6  Products - Standard / Advanced


Products Standard/Advanced


Smarts Service Assurance Manager (SAM) Standard / Advanced


Smarts IP Manager (IP) Standard / Advanced


Smarts VoIP Availability Manager (VoIP-AM) Standard / Advanced


Smarts Server Manager (ESM) Standard / Advanced


Smarts Network Protocol Manager (NPM) Standard / Advanced


Smarts Network Configuration Manager (NCM) Standard / Advanced


EMC M&R Standard / Advanced


Smarts Application Connectivity Monitor (ACM) Standard / Advanced


Smarts SAM Adapters Standard / Advanced


Alcatel 5620 SAM Adapters (ASAM) Advanced Only


Smarts Multicast (MCAST) Advanced Only


Smarts MPLS Manager (MPLS) Advanced Only
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configuration of a device is at the device level and not at the network adapters level, 
hence the state of the network adapter(s) is not a governing factor in the MO license 
determination of a device.


SA Suite defines a device as having 24-ports/interfaces. If a device has more than twenty 
four (24) ports/interfaces, it counts each group of 24-ports/interfaces as a device (or MO). 
Hence for devices that are greater than 24-ports/interfaces, there is a conversion factor of 
the number of ports/interfaces on the device to a MO license count. For example, if a 
device has 528-ports/interfaces, the MO count for the device would be 528 / 24 = 22 MO.


For some devices such as Access Points (AP) and VoIP Phones, the calculation of the MO 
license count for these devices is a 10:1 conversion, meaning ten (10) APs / VoIP phones 
= one (1) MO license count.


All license count conversions (Device:MO) are rounded up in all calculations.


Table 7 on page 62 provides the Device:MO license count conversions used within the SA 
Suite:


Table 7  Pricing model based on Managed Devices and Managed Objects


There is no change to the actual license files and the existing licensing technology is used. 
This new methodology is used only as a price calculation and auditing tool. It is not 
enforced by Smarts and the existing enforcement based on AP-SystemVolume licenses is 
still applicable. Further, the new licensing does not apply to Smarts IP. It applies to the SA 
Suite.


Switch/router classification and conversion examples


528-port switch / router


◆ If only physical ports are counted


Category License consumption MD:MO ratio Calculation


Network Adapters


• Less than or equal to 
24-ports/interfaces


Each device consumes one (1) 
license


1:1


• Greater than 
24-ports/interfaces


Each group of 24 
ports/interfaces consume one 
(1) license


1:x Round-up


Servers


Physical or Virtual Each server consumes one (1) 
license


1:1


IP Phones Ten (10) IP phones consume one 
(1) license


10:1 Round-up


Access Points Ten (10) access points consume 
one (1) license


10:1 Round-up
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• All Virtual Switches as part of virtual compute infrastructure are counted and 
charged by hypervisors


• The cost to manage the device is based on the Managed Ports and Interfaces on 
the devices in increments of 24.


◆ If the switch is managed:


• Each 24-ports/interfaces equate or convert to one (1) MO


• 1:X conversion in multiple of 24 physical ports/interfaces


• For a 528 port switch, calculation for MO would be:


– Number of Managed Objects = Switch physical ports / 24 (rounded up to the 
next whole number)


– Number of Managed Objects = 528/24 = 22 MO


– Managed Devices:Managed Objects = 1:22


SA Suite license count report


This section of licensing applies only if you have upgraded from a standalone (non-SA 
Suite deployment) to the SA Suite. The new SA Suite licensing does not apply to a 
standalone install of any of the Smarts products - the existing product-centric licensing 
still applies.


The SA Suite has been enhanced to include the ability to report the managed devices and 
ports, and the corresponding managed objects (MO) count based on the point-based 
device counting scheme as discussed above, in a CSV format. This report utility is 
available as a script, so that it can be scheduled in your native operating system.


To generate the report:


1. Open the command-line interface (CLI) on the host your Smarts IP domain is installed 
and go to the /opt/InCharge/IP/smarts/bin folder.


2. Type the following command:


sm_perl sm_licenseUtilization.pl -b <broker>


For example:


sm_perl sm_licenseUtilization.pl -b localhost:2233


This will create a report in CSV format under the <BASEDIR>/smarts/local/logs/ folder.
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Root access requirement on UNIX and Linux
Super-user access is required on UNIX and Linux systems for running the following:


◆ sm_server - Domain Manager, handling ICMP packets, SNMP trap receiving on default 
port 162


◆ brstart - Broker on default port 426


◆ sm_trapd - SNMP trap receiving on default port 162


A Domain Manager must bind to multiple low numbered (less than 1024) ports for ICMP 
traffic. In addition, the default port for starting a Broker (426) and SNMP trap processing 
port (162) are also low-numbered ports. Access to low-numbered ports requires root 
access on UNIX and Linux systems.


You can also start a Domain Manager with root access and then open additional ports as a 
non-root user, if this is required. “Running as non root on UNIX and Linux systems” on 
page 81 provides additional information.


Overview of services
EMC Smarts Foundation programs can be installed as services. A service is a program that, 
once started, is intended to run continuously. A service is administered by the sm_service 
utility. Programs installed as services start automatically upon system reboot; those not 
installed as services (manual processes or disabled processes) require that you issue 
commands to start and stop them as necessary.


EMC recommends that you install EMC Smarts Foundation programs as services. You are 
prompted to make this choice during the software installation. When you choose to install 
a program as a service, the installation process automatically sets up the program 
accordingly.


The following are examples of programs that should be installed as services:


◆ Broker


◆ Service Assurance Global Manager


◆ Service Assurance Adapter Platform (including the SNMP Trap Adapter and Syslog 
Adapter)


◆ IP Availability Manager and IP Performance Manager


Although services start automatically upon system reboot, there will be occasion for you to 
manually start (and stop) a program that was installed as a service. “Starting and stopping 
services with sm_service” on page 74 describes starting and stopping services.


If you choose not to install a program as a service, the program is installed as a manual 
process. If you install a program as a manual process, you can later change it to run as a 
service, described in “Installing programs as services with sm_service” on page 71.
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In addition, you can modify a service’s settings, as described in “Modifying service 
parameters with sm_service” on page 76.


The sm_service utility cannot be used with the Failover System. The EMC Smarts Failover 
System User Guide provides specific information about starting, stopping, and configuring 
the Failover System scripts.


About the sm_service utility
The sm_service is a cross-platform utility that sets up the environment for standard 
EMC Smarts Foundation applications (for example, the Broker, Domain Managers, and 
adapters), and that installs those applications as services.


Additionally, the sm_service utility can start non-EMC Smarts applications.


The implementation of the sm_service utility on:


◆ UNIX includes two separate programs: sm_serviced, a long-running, system-level 
program, and sm_service, a command-line tool that communicates user requests to 
sm_serviced.


◆ Windows involves the Windows Service Manager and sm_service, a command-line 
tool that communicates user requests to Windows Service Manager. The sm_serviced 
program is not applicable for Windows platforms.


The sm_service utility is installed with the software (one per system), and is used from the 
BASEDIR/smarts/bin directory. Select the BASEDIR/smarts with the latest version of 
software. The utility can only be used to control services on the local machine.


sm_serviced and ic-serviced
UNIX includes two separate programs: sm_serviced, a long-running, system-level 
program, and sm_service, a command-line tool that communicates user requests to 
sm_serviced.


The sm_serviced, the component of the sm_service utility that manages programs 
installed as services (either at installation, or by way of the sm_service command line), is 
installed with the software on UNIX systems during the installation process, and 
automatically starts its operations.


Thereafter, a script, ic-serviced, can be used to start and stop sm_serviced. The script is 
stored in a system-specific location: /etc/init.d on Solaris and Linux. The control of 
services can be affected through sm_service. “The sm_service command line” on page 69 
provides additional information.


The ic-serviced script includes several variables. Default settings are assigned to the 
variables during the installation process. If necessary, the value for the 
SM_SERVICE_STARTDIR variable can be edited. The default setting for this variable is / and 
specifies the directory into which core files are written. If it is changed, the setting must 
point to a directory on a file system with enough free space to hold a core file of the 
system’s largest server.
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Contact EMC Global Services for information about editing the remaining variables at the 
beginning of the ic-serviced script.


The ic-serviced script enables you to start and stop sm_serviced on UNIX systems and to 
check the status of sm_serviced.


If sm_serviced is not already running, issue the following command with administrative 
privileges to start it:


/etc/init.d/ic-serviced start


To stop sm_serviced and all of the services managed by it, issue the following command 
with administrative privileges:


/etc/init.d/ic-serviced stop


To check that sm_serviced is running and responding, issue the following command with 
administrative privileges:


/etc/init.d/ic-serviced status


If you uninstall the first software you installed, the ic-serviced script will be removed from 
the system. 
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The sm_service command line
The sm_service command line is the tool through which you communicate user requests 
to sm_serviced. The basic syntax for the command line is:


sm_service <action> <options> <arguments>


Standard options


Table 8 on page 69 lists the standard options that can be used with the sm_service utility. 


Table 8  Standard options for sm_service (page 1 of 2)


Options Description


--help Print the help text and exit.


--version Print the program version and exit.


--logname=<name> Use <name> to identify sender in the system log. 
Default: The program's name.


--loglevel=<level> Minimum system logging level. The level can be: None, Emergency, 
Alert, Fatal, Critical, Error, Warning, Notice, Informational, Debug. 
Note that Fatal is equivalent to Emergency, Alert, or Critical.
Default: Error.


--errlevel=<level> Minimum error printing level. The level can be: None, Emergency, 
Alert, Fatal, Critical, Error, Warning, Notice, Informational, Debug. 
Note that Fatal is equivalent to Emergency, Alert, or Critical.
Default: Warning.


--tracelevel=<level> Minimum stack trace level. The level can be: None, Emergency, Alert, 
Fatal, Critical, Error, Warning, Notice, Informational, Debug. Note that 
Fatal is equivalent to Emergency, Alert, or Critical.
Default: Fatal. 


--output[=<file>] Redirect output (stdout and stderr). The filename is <file>, or the 
--logname value if <file> is omitted. Log files are always placed in 
$SM_LOGFILES or $SM_WRITEABLE/logs.
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The following example highlights the use of a standard option:


BASEDIR/smarts/bin/sm_service --help


sm_service actions
Table 9 on page 70 lists the actions that can be performed with the sm_service utility.


The following example highlights an action with several install options:


BASEDIR/smarts/bin/sm_service install --name=ic-broker 
--startmode=runonce BASEDIR/smarts/bin/brstart --port=1234


--facility=<facility> Instructs the program to log any syslog messages with the specified 
syslog facility (UNIX/Linux only). The default is Daemon. 
The <facility> setting can be one of the following:
• Kern
• User 
• Mail
• Daemon
• Auth
• Lpr
• News
• Uucp
• Cron
• Local0
• Local1 
• Local2
• Local3
• Local4
• Local5
• Local6
• Local7


-- Stop scanning for options.


Table 8  Standard options for sm_service (page 2 of 2)


Options Description


Table 9  sm_service actions


Actions Description


install Installs a program as a service. It can also be used to modify the 
parameters of a service.


show Displays the status of the installed services. It can also display the 
command lines of specified services so that they can be replicated on 
other systems.


start Starts one or more installed services.


stop Stops one or more installed services.


isstopped Exits with a non-zero status if the requested set of services is in a state of 
not running.


remove Removes one or more installed services.
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Installing programs as services with sm_service
If, at installation, you installed a program to run as a service, the service will automatically 
start up when your system reboots. If you did not install a program as a service, you can 
use sm_service to install it as a service at any time.


The install action enables you to install a program as a service. After you define the name, 
description, startmode, and path of the program, sm_service stores the information in an 
sm_service database located in the /var/smarts directory (on UNIX). The sm_service then 
uses the information to start and run the program as a service. You must have 
administrative privileges to enter this command.


The syntax for the sm_service install action is:


sm_service install [<install options>] <name> path/to/exe [<args>...]


In addition to the common install options, such as name, description, and startmode, the 
command line must include an absolute path to the program you want to the program that 
you want to install as a service. Arguments that apply to the program, that you are 
installing as a service, can follow the path.


For example:


UNIX


BASEDIR/smarts/bin/sm_service install --name=ic-broker 
--startmode=runonce BASEDIR/smarts/bin/brstart --port=1234


Windows


BASEDIR\smarts\bin\sm_service install --name=ic-broker 
--startmode=runonce BASEDIR\smarts\bin\brstart --port=1234


Install options


Table 10 on page 71 lists the install options that can be used with the sm_service utility. 


Table 10  Install options for sm_service (page 1 of 2)


Options Description


--force Overwrite an existing service with the same name. The option is 
used to update or modify the parameters of an existing service.


"--description=<DESC>" A short description of the service. Enclose the option with double 
quotation marks.
On Windows platforms, the description will appear in the first 
column of the Service Control Manager window (the "Descriptive 
Name").
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Examples of the sm_service install action


The following provides examples of sm_service install action command lines.


UNIX


BASEDIR/smarts/bin/sm_service install --name=ic-broker 
--startmode=runonce BASEDIR/smarts/bin/brstart --port=1234


BASEDIR/smarts/bin/sm_service install --name=trapadapter 
--startmode=runonce --env=SM_BROKER=localhost:1234 


BASEDIR/smarts/bin/sm_trapd


Windows


BASEDIR\smarts\bin\sm_service install --name=ic-broker 
--startmode=runonce BASEDIR\smarts\bin\brstart --port=1234


BASEDIR\smarts\bin\sm_service install --name=trapadapter 
--startmode=runonce --env=SM_BROKER=localhost:1234 


BASEDIR\smarts\bin\sm_trapd


--startmode=<mode> The service start policy. Where <mode> is one of the following:
• runonce (start automatically when sm_serviced starts)
• automatic (starts automatically when sm_serviced does not 


detect that it is running)
• manual (requires an explicit start request) 
• disable (cannot be started).
Default: runonce


--env=<NAME>=<VALUE> A <NAME>=<VALUE> pair which will be placed in the process 
environment of the launched service. As many --env pairs as 
necessary can be specified. <VALUE> may contain one or more 
values, separated by commas.
The syntax <NAME>= (with no specified value) has the effect of 
unsetting <NAME> in the environment of the launched program.
The --env arguments are applied left to right as they appear on the 
command line, and this ordering is preserved in the database.


Table 10  Install options for sm_service (page 2 of 2)


Options Description
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Displaying installed services and their status
On UNIX systems, the sm_service show action displays previously installed services and 
their status.


On Windows, the sm_service show action displays the parameters of a service. To display 
the status of a service on Windows systems, you need to access the Control Panel: 
Settings > Control Panel > Administrative Tools > Services.


The syntax for the action is as follows. You must enter this command with administrative 
privileges:


sm_service show <name> [<name> ...]


The show action has one option:


--cmdline


When the action is used with its --cmdline option, it displays the sm_service command 
line that installed the program as a service. The command line can be reproduced and 
used for installing the requested service(s) on another system.


In the absence of the --cmdline option, the show action displays the status of the named 
service (or all services, when <name> is not given), including:


◆ Whether the service is running


◆ The name of the service


◆ A brief description of the service


Examples of the sm_service show action


The following provides an example of the sm_service show action.


For the status of a service, enter the following with administrative privileges:


BASEDIR/smarts/bin/sm_service show ic-broker


Output:


RUNNING ic-broker


For the command line of a service, enter the following with administrative privileges:


BASEDIR/smarts/bin/sm_service show --cmdline ic-broker


Output:


BASEDIR/smarts/bin/sm_service install 
--force 
--name=ic-broker 
--description=”EMC Broker” 
--env=SM_CLIENTCONNECT=brokerConnect.conf 
--startmode=runonce 
BASEDIR/smarts/bin/brstart 
--port=426 
--restore=BASEDIR/smarts/local/repos/broker/broker.rps 
--output
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Starting and stopping services with sm_service
The sm_service utility can be used to start and stop programs when necessary. However, 
the programs, which can be either manual processes or services, must be installed with 
sm_service before you can use this action.


To start a program, enter the following command with administrative privileges from the 
<BASEDIR>/smarts/bin directory:


sm_service start [options]


To stop a program, enter the following command with administrative privileges from the 
<BASEDIR>/smarts/bin directory:


sm_service stop [options]


Start options


Table 11 on page 74 lists the options for the start action.


Stop options


Table 12 on page 74 lists the options for the stop action.


Examples of the sm_service start and stop actions


The following provides examples of the sm_service start and stop actions.


For the start action, enter the following command with administrative privileges:


BASEDIR/smarts/bin/sm_service start ic-broker


For the stop action, enter the following command with administrative privileges:


BASEDIR/smarts/bin/sm_service stop ic-broker


Table 11  Start options for sm_service


Options Description


<name> [<name>...] Start specified processes.


--all Start all automatic or runonce services that are not running. (UNIX 
only).


--pattern= Start all processes with absolute paths that match the wildcard 
pattern.


Table 12  Stop options for sm_service


Options Description


<name> [<name>...] Stop specified processes.


--all Attempt to stop all running services (UNIX only).


--pattern= Stop all processes with absolute paths that match the wildcard 
pattern.


--force Do not consider it an error if the service is not running.

74 EMC Smarts Foundation System Administration Guide







Controlling Startup

Checking whether services are stopped


The isstopped action for sm_service exits with a non-zero status if any of the requested 
set of services are not running. 


Table 13 on page 75 lists the options for the isstopped action.


Examples of the sm_service isstopped action


The following provides examples of the sm_service isstopped actions on UNIX. These 
examples also show the use of wildcards.


The isstopped action verifies whether all of the services started from the BASEDIR/smarts 
directory are stopped:


sm_service isstopped --pattern ‘BASEDIR/smarts/*’


This example checks if all Managers are stopped:


sm_service isstopped --pattern ‘*sm_server*’


Starting and stopping services from the Windows desktop


Programs that are installed as services can also be started and/or stopped from the 
Windows desktop.


To start a service from the Windows desktop:


1. Select Start > Settings > Control Panel > Administrative Tools.


2. Select Services.


3. Select the EMC Smarts service.


4. Select Start. 


To stop a service, select Stop instead of Start.


Table 13  isstopped options for sm_service


Options Description


<name> [<name>...] Return status for specified processes.


--all Return the status of all processes.


--pattern= Return the status of all processes with absolute paths that match the 
wildcard pattern.
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Modifying service parameters with sm_service
The parameters for a service can be modified with the sm_service install action. “Installing 
programs as services with sm_service” on page 71 provides additional information. The 
--force option, which overwrites the existing parameters, must be used with the install 
action when you modify a service.


The syntax for the sm_service install action (to modify service parameters) is:


sm_service install --force


You must enter this command with administrative privileges.


To modify service parameters:


1. Stop the existing service with the sm_service stop action.


2. Use the sm_service show action with the --cmdline option to display the command 
line that was used to install the existing service.


3. Use the sm_service install action with the --force option, copy the displayed command 
line from step 2  after the --force option, and modify the parameters that need to be 
changed.


4. Start the modified service.


Removing services with sm_service
One or more existing services can be removed from the system, when necessary, with the 
sm_service remove action.


The syntax for the sm_service remove action is:


sm_service remove <name> [<name>...]


You must have administrative privileges to enter this command.


Example of the sm_service remove action


The following provides an example of the sm_service remove action.


BASEDIR/smarts/bin/sm_service remove trapadapter


You must have administrative privileges to enter this command.

76 EMC Smarts Foundation System Administration Guide







Controlling Startup

Default parameters for services
During installation, EMC Smarts Foundation products can be installed as services. When 
installed as services, default values are specified for the parameters that are associated 
with the services.


This section lists the default parameters associated with EMC Smarts Foundation 
products, and briefly describes them. The installation guide that accompanied your 
product provides examples of using the sm_service install command.


If you need to modify the default parameters of a currently installed service, use the steps 
found in “Modifying service parameters with sm_service” on page 76.


Common sm_server options


Several sm_server options are common to all Managers that are installed as services (the 
IP Availability Manager, for example, and the Service Assurance Manager). Table 14 on 
page 77 lists these sm_server options.


Exceptions to these parameters are noted and described with the default parameters for 
the individual products. 


Table 14  Common sm_server options (page 1 of 2)


Options Description


--name=<name> Specifies the name of the Manager (Manager or Global Manager). 
The name can contain alphanumeric characters (a-z, A-Z, 0-9) 
and the underscore (_) character. Do not include spaces.


--config=<cfg> Specifies the sm_server configuration file to use. Configuration 
files are loaded from the directories 
BASEDIR/smarts/local/conf/<cfg> and 
BASEDIR/smarts/conf/<cfg>.


--port=<port> Specifies the alternate Manager port.


--bootstrap=<file> Specifies the alternate bootstrap configuration file. The file name 
is relative to the configuration directory (as set by the --config 
option). The default is bootstrap.conf.


--ignore-restore-errors Indicates ignore errors encountered while restoring the saved 
topology. 


--norestore Indicates do not attempt to restore any saved objects.


--subscribe=<sub> Start a subscription adapter that automatically subscribes to the 
specified notifications.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b 
<location>.


--output[=<file>] Redirects the output (stdout and stderr). The file name is <file>, or 
the --logname value if <file> is omitted. Log files are always placed 
in BASEDIR/smarts/local/logs.


--daemon Run the program as a daemon (UNIX only). Messages generated 
from internal logging calls are directed to the log file. Log files are 
written to the BASEDIR/smarts/local/logs directory.
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To display a complete list of the sm_server options on your system, enter the following 
command with administrative privileges:


BASEDIR/smarts/bin/sm_server --help


--facility=<facility> Instructs the program to log any syslog messages with the 
specified syslog facility (UNIX/Linux only). The default is 
Daemon. 
The <facility> setting can be one of the following:
• Kern
• User 
• Mail
• Daemon
• Auth
• Lpr
• News
• Uucp
• Cron
• Local0
• Local1 
• Local2
• Local3
• Local4
• Local5
• Local6
• Local7


--clean-topology Migrates the customized Polling and Threshold settings from a 
previous version of an EMC Smarts product to a new version of 
the product.
Here is an example command:
sm_server -n <name of old domain> -c icf --clean-topology 


--ignore-restore-errors --output --daemon 
After the old domain’s repository file is “cleaned,” that is, after 
all but the customized Polling and Thresholds settings have been 
removed from the old domain’s repository file, a user places the 
repository file in the new domain’s 
BASEDIR/smarts/local/repos/<config> directory, to become the 
new domain’s initial repository file.
<config> refers to the configuration directory that is specified on 
the command line when the old domain is started.


Table 14  Common sm_server options (page 2 of 2)


Options Description
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Common sm_adapter options


Several sm_adapter parameters are common to all adapters that are installed as services 
(the Syslog Adapter, for example, and the SNMP Trap Adapter). Table 15 on page 79 lists 
these sm_adapter parameters or options.


Exceptions to these parameters are noted and described with the default parameters for 
the individual products. 


To display a complete list of the sm_adapter options on your system, enter the following 
command with administrative privileges:


BASEDIR/smarts/bin/sm_adapter --help


Table 15  Common sm_adapter options


Options Description


--name=<name> Specifies the name of the adapter.


--model=<name> Specifies the name of model library to load.


--tail=<path> Specifies read input by tailing a file.


--rserver=<name> Specifies auto-reconnect parser to Manager.


--server=<name> Specifies connect parser to Manager.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b 
<location>.


--output=<file> Directs the output (stdout and stderr). The file name is <file>, or the 
--logname value if <file> is omitted. Log files are always placed in 
BASEDIR/smarts/local/logs.


--daemon Run the program as a daemon (UNIX only). Messages generated from 
internal logging calls are directed to the log file. Log files are written 
to the BASEDIR/smarts/local/logs directory.


--facility=<facility> Instructs the program to log any syslog messages with the specified 
syslog facility (UNIX/Linux only). The default is Daemon.
The <facility> setting can be one of the following:
• Kern
• User 
• Mail
• Daemon
• Auth
• Lpr
• News
• Uucp
• Cron
• Local0
• Local1 
• Local2
• Local3
• Local4
• Local5
• Local6
• Local7
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Common sm_sdi options


Several sm_sdi options are common to the components of the SQL Data Interface Adapter 
that are installed as services. Table 16 on page 80 lists these sm_sdi options.


Exceptions to these parameters are noted and described with the default parameters for 
the individual products. 


To display a complete list of the sm_sdi options on your system, enter the following 
command with administrative privileges:


BASEDIR/smarts/bin/sm_sdi --help


Table 16  Common sm_sdi options


Options Description


--broker=<location> The alternate Broker location as host:port. Also -b <location>.


--name=<name> The name of the SQL Data Interface Adapter component. Also -n 
<name>.


--config=<cfg> Specifies the directory of the sm_sdi configuration files: 
sdi_ics.conf, sdi_sql.conf and sdi_odbc.conf. Configuration files are 
loaded from the directories BASEDIR/smarts/local/conf/<cfg> and 
BASEDIR/smarts/conf/<cfg>.


--bootstrap=<file> Specifies the alternate bootstrap configuration file. The filename is 
relative to the configuration directory (as set by the --config option). 
The default is bootstrap.conf.


--nonpriv Allow sm_sdi to run under a nonprivileged user ID. This option must 
be specified in order for a nonprivileged user to start sm_sdi.

80 EMC Smarts Foundation System Administration Guide







Controlling Startup

Running as non root on UNIX and Linux systems
Table 17 on page 81 describes two options that are used in conjunction with each other to 
run as non root. These two options are only available on UNIX and Linux systems. These 
options are available for the sm_server, brstart, and sm_adapter commands. 


The --privopen and --run-as-user options are used in conjunction to run a Domain 
Manager with non root privileges. The Domain Manager can startup as root, open 
privileged ports, and change to a non root user.


You can open multiple ports by repeating the <arg> parameter. Each instance is separated 
by a comma (,). For example:


--privopen=UDP:v4:161,#2
--privopen=IP:1,#6 
--privopen=IP:v6:58,#6
--run-as-user=testuser1


Table 17  Additional options for running as non root on UNIX and Linux systems


Options Description


--privopen=<arg>[,<arg>]
Note: This option is only used in conjunction with the --run-as-user 
option to run as non root.


Opens privileged sockets. The <arg> parameter has the following 
syntax:
<type>[:<family>]:<port>[,#<count>]
where:
• <type> is one of the following:


• TCP (for a TCP connection)
• UDP (for a datagram)
• IP (for a raw socket)


• <family> is one of the following:
• :v4 (IPv4 address family)
• :v6 (IPv6 address family)
If <family> is not specified, the address family defaults to IPv4.


• <port> is one of the following:
• The required privileged port for a TCP socket
• The required privileged port for a UDP socket
• The protocol for IP


• <count> is the number of sockets of the type, family and port. The 
default count is 1. 


--run-as-user=<username>
Note: This option is only used in conjunction with the --privopen 
option to run as non root.


Specifies a valid user name.
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In this example:


◆ The first privopen line opens two UDP IPv4 sockets on port 161.
◆ The second privopen line opens six raw IPv4 sockets for ICMP.
◆ The third privopen line opens six raw IPv6 sockets for ICMPv6.


After the sockets are opened, the process will change to run as user, “testuser1.” 
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Securing Access to the Software


This chapter consists of the following sections:
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Configuring security requires time and effort. Before configuring security, carefully 
consider your requirements along with the trade-offs between system security, time 
allocated for system administration, and usability.
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Security features
EMC Smarts software provides multiple levels of security which administrators can use to 
secure their system and control access to it. The various levels of security can be 
implemented through:


◆ Authentication and user privileges


Client-server connections can be controlled on both the client and server sides of the 
system. The system is secured by using authentication records and by assigning 
connection privileges on the server side. When a client initiates a connection to a 
server, the client must supply appropriate authentication to the server before the 
connection (as defined by the connection privileges) is permitted. “Configuring 
authentication” on page 88 provides detailed information.


◆ Encrypted passwords


Passwords can be encrypted in the serverConnect.conf, clientConnect.conf, and 
brokerConnect.conf files, which are located in the BASEDIR/smarts/conf directory of 
each EMC Smarts software installation. Encryption is based on a secret phrase, 
common to all of the EMC Smarts applications that must interact, and is used to 
encrypt password fields in the authentication records. “Encrypted passwords” on 
page 104 provides detailed information. 


Passwords can also be encrypted in seed files. “Encrypted seed files” on page 106 
provides detailed information.


◆ Encrypted connections


The software provides several levels of security above cleartext communication:


• Encryption based on the site secret


• Diffie Helman-Advanced Encryption Standard (DH-AES)


• DH-AES used in conjunction with the site secret


• Transport Layer Security (TLS) v1.2 with or without Federal Information Processing 
Standard (FIPS) Publication 140-2 validated cryptography.


The levels of security are configured by way of values for environment variables. 
“Encrypted connections” on page 106 provides detailed information.


The security features are enabled with default settings when you install the software. The 
default security settings are thoroughly documented and permit access to the system. As 
a result, you should change the default usernames, passwords, and the secret phrase to 
enforce access control to the software. In addition, you should restrict access to the 
security configuration files, as described in “Specifying alternate security configuration 
files” on page 98.


An administrator can also place access restrictions on certain console operations by 
applying user profiles. This ability to restrict users to certain operations is described in the 
EMC Smarts Service Assurance Manager Configuration Guide.
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How security works
EMC Smarts security features apply to authentication and communication connections.


Authentication occurs whenever a client program initiates a connection to a server 
program. The client passes a username and a password to the server. The server 
determines whether the client is allowed to connect and, if the connection is allowed, 
what privileges the client is granted.


Secure communication connections are implemented:


◆ Encryption based on the site secret


◆ Diffie Helman-Advanced Encryption Standard (DH-AES)


◆ DH-AES used in conjunction with the site secret


◆ Transport Layer Security (TLS) v1.2 with or without Federal Information Processing 
Standard (FIPS) Publication 140-2 validated cryptography.


In Foundation 9.2, a FIPS 140 enabled Broker is able to communicate with FIPS 140 
enabled Domain Managers as well as non FIPS 140 enabled Domain Managers. In 
addition, a FIPS 140 enabled Domain Manager is able to communicate with FIPS 140 
enabled Domain Managers as well as non FIPS 140 enabled Domain Managers.


To properly configure the security system, you must understand how the security system 
works. The answers to the following questions will help:


◆ Which programs are servers and which are clients?


◆ How does a server authenticate a client?


◆ How does a client obtain a username and password to pass on to a server?


◆ How does encryption apply to authentication as well as communication connections?


For the UNIX account that is used to run EMC Smarts processes, if the system 
administrator sets explicit permissions for the file mode creation mask (the umask) for a 
parent process, EMC Smarts software respects those permissions. For processes started 
by the sm_serviced program that is described in “sm_serviced and ic-serviced” on 
page 67, the umask permission is inherited.


Server and client programs for the software


Knowing which EMC Smarts programs function as servers and which function as clients 
can help you understand how to configure security. Simply stated, a client is any 
EMC Smarts program that initiates a connection to another EMC Smarts program. 
Programs can act both as a client and as a server.
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Table 18 on page 86 lists some server and client programs and shows how they can 
interact. 


Table 18  EMC Smarts server and client programs


Server programs Client programs


Broker Service Assurance Failover System


Command-line utilities such as dmctl and 
brcontrol


Global Console users


Global Manager


Notification Adapters


Service Assurance Adapter Platform


Tools 


Report Manager


Beacon


Application Connectivity Monitor


Global Manager Service Assurance Failover System


Broker


Command-line utilities (dmctl)


Global Console users


Notification Adapters


Tools


Global Manager


Report Manager


Service Assurance Adapter Platform Broker


Command-line utilities (dmctl)


Global Manager


sm_ems


SNMP Trap Adapter


Syslog Adapter


IP Availability Manager Global Console


IP Performance Manager Global Console


Beacon Global Console


Application Connectivity Monitor Global Console
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The Broker functions as both a server and a client. In addition, when Service Assurance 
Managers are deployed in a multi-tiered environment, a Service Assurance Manager may 
also function as both a server and a client.


The server and client programs that are listed in Table 18 on page 86 can be installed on 
the same host. For example, it is common for the Broker and a Service Assurance Manager 
to run on the same host.


Server authentication


When a client program initiates a connection to a server, it must provide an EMC Smarts 
username and password. A server authenticates a connection request by comparing the 
EMC Smarts username and password it receives from a client to the authentication 
records in its configuration file, serverConnect.conf. The server uses the first 
authentication record that matches the information sent by the client.


The authentication records are reread for each attempted connection so any changes to 
the file will take effect immediately.


The Global Console always displays a log-on dialog box where a user must enter a 
username and password. Other username and password or be configured to automatically 
send the username and password.


For example, when a Global Console connects to a Service Assurance Manager, it sends a 
username and password to the Service Assurance Manager. The Service Assurance 
Manager compares the credentials to the authentication record listed in its 
serverConnect.conf file. If the first matching record allows the connection, the Service 
Assurance Manager accepts the connection and grants the user the privileges that are 
specified by the authentication record. If the username and password do not match an 
authentication record, the connection is refused.


Client authentication


Other than the Global Console, most Most clients, by default, automatically send 
authentication information to the server. This information is stored in a clientConnect.conf 
file. A client that uses automatic authentication reads the records in the order that they 
appear, selecting the first record whose login username matches the user that runs the 
client and whose target matches the name of the server that is being connected to. Once it 
finds a match, the client sends the username and password to the target server as 
authentication credentials. If the authentication succeeds, the server tells the client its 
access privilege. If the authentication fails, the server refuses the connection and the 
failure is recorded in the server’s log file.


Client authentication files are reread for each attempted connection. As such, you can edit 
the configuration files at any time and the changes take effect immediately.


The Broker uses its own client connection file, brokerConnect.conf. 
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For example, when a Domain Manager (such as an EMC Smarts IP Availability Manager) 
registers with a Broker, the Domain Manager sends a username and password from its 
clientConnect.conf to the Broker. The Broker checks the username and password against 
the records in its serverConnect.conf. Based on the results, it will grant or deny a 
connection. 


However, when the Broker checks whether a registered Domain Manager is alive (by 
pinging the manager), the Broker must authenticate with that Domain Manager. To do this, 
it finds a username and password in its brokerConnect.conf file to send to the Domain 
Manager. The Domain Manager checks for the username and password in its 
serverConnect.conf and either grants or denies the right for the Broker to ping it.


Encryption


By default, non-FIPS 140 mode encryption is enabled during the installation process. All 
EMC Smarts products and applications that interact with each other must share a common 
secret phrase, and the same FIPS 140 mode. The security configuration files and files with 
passwords to SNMPv3 devices all contain encrypted information.


The basis for encryption is a secret phrase that gets transformed into the imk.dat file. This 
file is the basis of encryption for EMC Smarts programs. The programs use the site secret 
to encrypt passwords in the configuration files and keywords in seed files, as well as to 
encrypt connections between programs.


Configuring authentication
This section describes the components of authentication. It covers the content and syntax 
of the security files, the default authentication records provided in each file, and how to 
specify alternate security configuration files.


Syntax of the security files


This section describes the syntax of the serverConnect.conf, clientConnect.conf, and 
brokerConnect.conf files.


Each file consists of one or more authentication records, each of which contains four 
fields. Note the following:


◆ A line that starts with two forward slashes (//) or a pound sign (#) is considered a 
comment and ignored.


◆ The fields of each authentication record are separated by colons (:).


◆ Any white space before, after, or between fields, is ignored. If the field value contains 
a space, you need to add an escape character, the backslash (\), before the space. 
When a backslash is encountered, the following character loses any special 
significance and is used as is.


The first line of each of the configuration files contains encryption information. Do not 
change this line unless you want to disable encryption. To comment out the line, add a 
second pound sign.
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The clientConnect.conf, brokerConnect.conf, and serverConnect.conf are read from top to 
bottom. For example, when a client selects a record for automatic authentication, it uses 
the first record with a matching target and username. If that username is denied a 
connection by the server, the client does not try again. The ordering of authentication 
records is important because you can use wildcards for certain fields. In general, more 
specific authentication records should be listed first. Appendix B, “Wildcards,” provides 
additional information about wildcards.


Server authentication records


Server authentication involves setting up authentication records in the 
serverConnect.conf file. Each record contains information to control access to a particular 
server, a username and password, and a connection privilege. To modify this file, use the 
sm_edit utility as described in “Modifying EMC Smarts files” on page 20.


Always use sm_edit utility to edit the serverConnect.conf. This is particularly important if 
the passwords are encrypted. When you use the sm_edit utility to edit the file, it saves 
changes to the file in BASEDIR/smarts/local/conf and encrypts the passwords; it does not 
modify the default, non-encrypted version of the file. 


Description of serverConnect.conf
The serverConnect.conf file defines who can connect to which server and what privileges 
they are granted. By default, separate versions of the file reside in the 
BASEDIR/smarts/conf and the BASEDIR/smarts/local/conf directories on the system 
where the server is running. The first version does not contain encrypted passwords, so 
the default values are accessible by anyone who can read the file. The version in 
BASEDIR/smarts/local/conf contains encrypted passwords.


The format of a record in serverConnect.conf is:


<target>:<ITOps username>:<password>:<privilege>
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Table 19 on page 90 describes the four fields of an authentication record in the 
serverConnect.conf file. 


Remember that during the authentication process the server receives a connection target, 
EMC Smarts username, and password from a client. The server checks each of its records 
looking for a match. When it finds the first match, it sends the appropriate privilege back 
to the client. Otherwise, the server logs the failed authentication.


Table 19  Field descriptions for serverConnect.conf


Field Definition Value


<target> Name of the server for which 
this connection is intended.
A server will only read this 
line if its name matches the 
value of the target field.


Can be a matching pattern with wildcards or 
one of the following special values:
• <BROKER> indicates that this record applies 


only to the Broker.
• ~<BROKER> indicates this record applies to 


all servers except the Broker.


<EMC Smarts 
username> 


Username for the client 
requesting a connection.


Can be a matching pattern with wildcards or 
the following special value:
• <DEFAULT> is provided for legacy clients that 


cannot send a username.
• <AUTO> is provided for site-specific 


credentials.


<password> Password for the user 
requesting a connection.


Can be a password or one of the following 
special values:
• <SYS> indicates that the username must be 


a valid login name on the local system. The 
server passes the credentials to the host 
operating system for validation.


• <DEFAULT> is provided for legacy clients that 
cannot send a password.


• <AUTO> is provided for site-specific 
credentials.


<privilege> Access privileges of the 
client.


Valid values include:
• All
• Monitor
• None
• Ping
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Connection privileges
Connection privileges are specified in the serverConnect.conf file, and authentication 
features provide for four levels of privileges:


◆ All provides full access to all server functions. It is required for all adapter-to-server 
and server-to-server connections and by all command line utilities, with a few 
exceptions. This level of authorization is also required by administrative consoles. 
However, this level of access can be further restricted through user profiles. The EMC 
Smarts Service Assurance Manager Configuration Guide provides additional 
information about using user profiles to restrict access to console operations.


◆ Monitor access supports a monitoring console. A monitoring console cannot change 
server database or configuration parameters except in special circumstances such as 
acknowledgement of notifications. Only consoles support Monitor access. If you run a 
secure Broker, the Broker must also support ping 
(<BROKER>:BrokerNonsecure:Nonsecure:ping).


◆ None prevents access to the server. This privilege can be used to explicitly prevent a 
user from accessing the server.


◆ Ping is a special access privilege that allows connections to a server, but only to ping 
the server and check whether it is functioning. A Broker requires Ping access to check 
the status of servers and is sufficient to allow the dmctl command line utility to 
connect to a server and execute the ping command.


Client authentication records


Most clients connect to servers without requiring a user to enter a username or password. 
When this happens, a client parses a configuration file for a username and password to 
send to the server for authentication instead of prompting a user. Most clients use the 
clientConnect.conf. The Broker uses its own file, brokerConnect.conf.


The Broker only uses brokerConnect.conf to send authentication to other processes so 
that it can ping them.


Description of clientConnect.conf and brokerConnect.conf
By default, these files are located in the BASEDIR/smarts/conf directory. The sm_edit 
utility saves changes to the file in BASEDIR/smarts/local/conf and does not modify the 
original version of the file.


The format of a record in the clientConnect.conf or brokerConnect.conf is:


<login user>:<target>:<ITOps username>:<password>


Table 20 on page 92 describes the four fields of an authentication record in the 
clientConnect.conf and brokerConnect.conf files.
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It is important to remember that an EMC Smarts program runs under the login name of the 
user who started it. This has several implications:


◆ A user account must provide sufficient privileges for the program to function properly. 
For example, a Manager may need to run with root privileges because it sends ICMP 
pings or receives SNMP traps.


◆ A Domain Manager is as a Broker, and the Broker is listening on port 426. Port 426 is a 
privileged port, meaning the process must be running as root to open the port. Ports 
numbered below 1024 require root privileges. 


A process, without being root, can connect to a process listening on a port below 
1024.


◆ A user’s system login name must correspond to an EMC Smarts username in the 
clientConnect.conf file or an EMC Smarts username and password will not be sent to a 
server for authentication. In the clientConnect.conf record, a user’s login name and 
EMC Smarts username do not have to be identical.


Table 20  Fields for clientConnect.conf and brokerConnect.conf


Field Definition Value


<login user> System login name of the 
person or process 
attempting a connection.


Can be a matching pattern with wildcards.


<target > Name of the server to 
which the client is trying to 
connect.


Can be a matching pattern with wildcards or 
one of the following special values:
• <BROKER> indicates that this record 


applies only to the Broker.
• ~<BROKER> indicates this record applies 


to all servers except the Broker.


<EMC Smarts 
username> 


Username that is sent to 
server for authentication.


Can be a username or one of the following 
special values:
• <USERNAME> indicates that the username 


under which the current process is logged 
in as is sent as the EMC Smarts username.


• <PROMPT> indicates that the client 
program asks the user to provide an 
EMC Smarts username.


• <AUTO> is provided for site-specific 
credentials.


• <DEFAULT> mimics legacy client 
authentication.


<password> Password that is sent to 
the server for 
authentication.


Can be a password or one of the following 
special values:
• <PROMPT> indicates that the client 


program asks the user to provide a 
password.


• <AUTO> is provided for site-specific 
credentials.


• <DEFAULT> mimics legacy client 
authentication.
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Running without root privileges
All Domain Managers do not need to send ICMP pings or receive SNMP traps and, 
therefore, do not need to run with root privileges.


◆ Start a Broker on a port that is not privileged. The software registers the following non 
privileged ports:


• Broker is port 426


• Domain Manager is port 4426


The Broker could be started on port 4426 if a well-known port is required.


◆ Domain Managers can startup as root, open privileged ports, and then change to a 
non root user, as described in “Running as non root on UNIX and Linux systems” on 
page 81.


Special authentication values


Special authentication describes the configuration of the serverConnect.conf, 
clientConnect.conf and brokerConnect.conf by using the special values <SYS>, <PROMPT>, 
<AUTO>, and <DEFAULT>. These values control system, site-specific and legacy 
authentication.


System authentication
System authentication uses the operating system username and password to 
authenticate clients. This method is configured in serverConnect.conf. By using this 
method, you give every console operator an account on the host on which the server runs. 
The operators log in by using the username and password defined for that account. (The 
account can be disabled to prevent actual interactive access to the system.) By using this 
method:


◆ Each console operator has a unique username and password. 


◆ Accesses to the system can be traced to a particular user. 


◆ Access can be individually revoked. 


The use of <SYS> for the password allows the use of common password administration 
across applications and avoids having the password appear in cleartext in the file in 
unencrypted installations.


This mechanism can readily be extended to provide similar controlled access for 
administrators. For example, you could add the following records to serverConnect.conf:


* : fred|george : <SYS> : All
* : * : <SYS> : Monitor


This example would grant the users “fred” and “george” All access, once they provide the 
passwords for their accounts on the host. Other users providing the correct password are 
granted Monitor access. 
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You could even define a class of administrative users, for example, with usernames that 
start with ADM and provide all other users with Monitor access.


* : ADM* : <SYS> : All
* : * : <SYS> : Monitor


Console applications automatically prompt for a username and password and do not use 
clientConnect.conf. In console applications, passwords display as masked characters (*) 
to avoid displaying the passwords in cleartext. In order for nonconsole applications to 
prompt, the value <PROMPT> must be used for the EMC Smarts username and password in 
clientConnect.conf.


Network account authentication
In UNIX systems, the system authenticates a username based on its password. In 
Windows, a response to the prompt will be checked against the local domain. If the 
system must check with any other Windows Domain Manager, the format of the username 
must include the correct Windows domain as well as the username:


user_name@domain_name


Prompting for authentication
In order for nonconsole applications to prompt for a username and password, the 
corresponding fields in clientConnect.conf must contain <PROMPT>. The client must be 
attached to a terminal, in order for the system to prompt the user. Lines containing a 
<PROMPT> are skipped by programs that are not attached to a terminal, even if they would 
otherwise be selected.


Responses to <PROMPT> are checked against username and password fields in 
serverConnect.conf. 


Site-specific authentication
Site-specific authentication uses a site’s secret to authenticate connections. When 
corresponding records in serverConnect.conf and clientConnect.conf contain the <AUTO> 
value for both the EMC Smarts username and password, the client generates a password 
by using its secret. The server validates the password to accept or reject the connection.


Do not use this method unless you have changed the default site secret. The default site 
secret is known to all EMC Smarts installations.


So for connections to a particular Domain Manager (such as Service Assurance Manager), 
you could define a record in serverConnect.conf:


GM-Company-1:<AUTO>:<AUTO>:All


Then define a corresponding record in the clientConnect.conf files on the different hosts 
connecting to the server:


*:GM-Company-1:<AUTO>:<AUTO>

94 EMC Smarts Foundation System Administration Guide







Securing Access to the Software

As long as both the client and server use the same secret phrase, the server will 
authenticate each connection to the Domain Manager.


Do not use <AUTO> for the brokerConnect.conf if it is used for other connections, because 
the Broker does not need All access, only Ping.


Legacy system authentication
To provide the ability to interoperate with older software, which may not support 
authentication, EMC Smarts software provides a “default account” mechanism. When an 
incoming connection does not provide any authentication information, a server 
substitutes the standard username and password with <DEFAULT>. After that substitution, 
the <DEFAULT>/<DEFAULT> authentication information is validated in exactly the same way 
any other username/password combination is validated. 


An incoming connection that explicitly specifies <DEFAULT>/<DEFAULT> is permitted. It is 
treated in exactly the same way as a connection that supplied no authentication 
information.


Default authentication records


This section describes the authentication records enabled by default. These default 
settings provide examples of user records in serverConnect.conf as well as examples of 
how automatic authentication can be set up in clientConnect.conf and 
brokerConnect.conf.


Authenticating legacy software
The Broker uses the following record in serverConnect.conf to authenticate legacy client 
connections and provide full access. The target field, with a value of <BROKER>, identifies 
that the Broker is the sole target for authentication. There are no corresponding entries in 
the clientConnect.conf or brokerConnect.conf. “Legacy system authentication” on page 95 
provides additional information on the <DEFAULT> value.


<BROKER> : <DEFAULT> : <DEFAULT> : All


In this configuration, the Global Console will not prompt for a username and password 
when connecting to the Broker. The default configuration defines a nonsecure Broker, 
equivalent in security to EMC Smarts software prior to version 5.0.


Automating client authentication to the Broker
EMC Smarts programs connect to the Broker under the following conditions:


◆ When a server starts, it connects to the Broker as a client to register itself.


◆ When a client, including a console, needs to connect to a server, it connects to the 
Broker to query it for the server's location.
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The record in serverConnect.conf specifies that the Broker should grant any client that 
sends the EMC Smarts username BrokerNonsecure and the password Nonsecure full 
access to the Broker.


<BROKER> : BrokerNonsecure : Nonsecure : All


The automatic authentication record in clientConnect.conf applies to any client that 
supports authentication and needs to connect to the Broker. This record specifically 
selects the Broker as its target.


* : <BROKER> :BrokerNonsecure : Nonsecure


These two records define a nonsecure configuration for the Broker. In this configuration, 
consoles do not prompt for a username and password when connecting to the Broker. 
“Configuring a secure Broker” on page 110 provides additional information regarding a 
secure Broker configuration. 


Automating Broker authentication to servers
The Broker periodically pings all registered servers to determine their status. When the 
Broker does this, it acts as a client. This record in serverConnect.conf permits the Broker to 
ping a server to check if it is running.


* : BrokerPing : Ping : Ping


The brokerConnect.conf file contains an automatic authentication record, the only record 
in the file.


* : * : BrokerPing : Ping


“Connection privileges” on page 91 provides additional information about the Ping access 
permission.


Authenticating administrative users
The default administrative record provides full access to any server by using the 
serverConnect.conf file.


* : admin : changeme : All


This record authenticates clients that provide the EMC Smarts username “admin” and the 
password “changeme”. This account grants administrative privileges or full access, which 
is denoted by the value of All in the privilege field.


Change the password for this account after installation. You must make any changes to the 
corresponding records in both the serverConnect.conf and clientConnect.conf files. 
Replace the admin user only after you have set up a corresponding administrative account 
in the Global Manager. You should never remove or disable an administrative account in 
the Global Manager. 
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The corresponding automatic authentication record in clientConnect.conf grants any 
client, which uses the file, full access to any server by using the corresponding record in 
the serverConnect.conf file.


* : * : admin : changeme


Since this record appears later in the clientConnect.conf file than the interactive users 
record (* : * : <PROMPT> : <PROMPT>), only noninteractive clients will be granted full access, 
unless interactive users enter the correct username ("admin") and password 
("changeme"). 


“Connection privileges” on page 91 provides additional information about the All access 
permission.


Authenticating Global Console users
Two records in serverConnect.conf provide the console with monitoring access to servers. 
The first authenticates console users who provide the EMC Smarts username


“maint” and the password “maint”.


* : maint : maint : Monitor


The second console record authenticates console users who provide the EMC Smarts 
username “oper” and the password “oper”.


* : oper : oper : Monitor
Consoles do not use clientConnect.conf for authentication (there is no automatic 
authentication). The console prompts the user for a username and password and passes 
the information to the server for authentication.


User profile restrictions can be used to further limit certain Global Console operations, as 
described in theEMC Smarts Service Assurance Manager Configuration Guide.


EMC recommends that you create separate accounts for each operator. Comment out 
these records and use the authentication record that uses the system login facility.


Authenticating users with a valid system account
The last default authentication record in serverConnect.conf permits users with a valid 
login account on the system where the server is running to connect. A client that uses this 
authentication record must enter a valid system username and password. For 
authentication, the system username becomes the EMC Smarts username. This record 
provides monitoring privileges.


* : * : <SYS> : Monitor
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Authenticating users interactively
This authentication record in the clientConnect.conf prompts users to enter an 
EMC Smarts username and password. This does not guarantee that the connection will be 
successful. The server must be able to validate the username and password by using its 
serverConnect.conf file.


* : * : <PROMPT> : <PROMPT>


The position of this authentication record in the default clientConnect.conf file is 
important. Because it uses wildcard patterns to match for both login user and target, this 
record is always selected for interactive connections, even if a following record also 
matches. Noninteractive programs skip this record because they cannot prompt for 
information.


This record could match the following serverConnect.conf authentication records, as 
described in the following:


* : * : <SYS> : Monitor
In “Authenticating Global Console users” on page 97:


* : maint : maint : Monitor


* : oper : oper : Monitor


In “Authenticating users with a valid system account” on page 97


* : * : <SYS> : Monitor


Specifying alternate security configuration files


You can define separate serverConnect.conf and clientConnect.conf files on hosts where 
multiple servers or clients are running. This enables you to configure a system where 
certain users and/or servers use one file, and other users and/or servers reference a 
different file. Some installations can share the same BASEDIR/smarts, but have 
requirements that stipulate that the servers and/or clients operate differently. 


Two environment variables allow you to specify distinct configuration files:


◆ SM_SERVERCONNECT 


◆ SM_CLIENTCONNECT 


For each variable, the absolute path to the alternate security file must be specified. 
Because you specify the filename, you can have multiple files in the same directory.


For server programs, you can specify an alternate serverConnect.conf file, by setting the 
SM_SERVERCONNECT variable in the command line that starts the server.
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For example, the following steps set the value of the SM_SERVERCONNECT environment 
variable to point to the server_Connect_IP.conf file.


1. Use the sm_service show action with the --cmdline option to display the existing 
command line for the program. You must have administrative privileges when typing 
the following command.


BASEDIR/smarts/bin/sm_service show --cmdline ic-am-server


Output:


BASEDIR/smarts/bin/sm_service install 
--name=ic-am-server 
--description=“EMC Smarts IP Availability Manager” 
--startmode=runonce 
BASEDIR/smarts/bin/sm_server 
--name=INCHARGE-AM 
--config=icf 
--bootstrap=bootstrap-am.conf 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


2. Use the sm_service install action with the --force option to add the environment 
variable to the command line. The --env option specifies the environment variable.


BASEDIR/smarts/bin/sm_service install 
--force 
--name=ic-am-server 
--description=“EMC Smarts IP Availability Manager” 
--startmode=runonce 
--env=SM_SERVERCONNECT=BASEDIR/smarts/conf/serverConnect_IP.conf 
BASEDIR/smarts/bin/sm_server 
--name=INCHARGE-AM 
--config=icf 
--bootstrap=bootstrap-am.conf 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


3. Do one of the following:


• Start the program.


• Stop and restart the program.


For client programs, you can specify an alternate clientConnect.conf file by setting the 
SM_CLIENTCONNECT variable in the runcmd_env.sh file.
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Controlling authentication
The environment variable SM_AUTHORITY controls the authentication security features 
provided by the software. The authentication features are enabled by default. If necessary, 
you can set the value of this variable to disable them. This environment variable must be 
set on each system where EMC Smarts software is running.


The environment variable SM_AUTHORITY can have one of two values:


◆ <STD> enables security


◆ <NONE> disables security


When no value is specified, which is the default, the software treats this the same as 
<STD>.


The angle brackets (< >) are required.


When SM_AUTHORITY is set to <NONE>, the software behaves as if no security features are 
in effect:


◆ Clients do not read clientConnect.conf and never prompt for a username or password. 
They always send <DEFAULT>/<DEFAULT> as their credentials.


◆ Servers ignore any incoming username or password and grant any connection All 
access.


Setting the SM_AUTHORITY variable


To add and set the SM_AUTHORITY environment variable in the runcmd_env.sh file:


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


2. Use the following syntax to add the SM_AUTHORITY variable and its value:


SM_AUTHORITY=”<STD>”


3. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


At this point, any EMC Smarts program that is started from this installation directory 
will use the applicable environment variables that are specified in the runcmd_env.sh 
file.


4. EMC Smarts programs that were previously launched from this installation directory 
need to be restarted for any new environment variable to take effect. Chapter 5, 
“Controlling Startup,” describes how to start services.
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Changing Cryptographic Settings


Changing Pseudo-random Number Generators (PRNG) algorithm


The Smarts Global Console SSL implementation uses ECDRBG128 (Dual EC DRBG) as the 
default PRNG algorithm.  Following NIST's decision to recommend against the use of 
Dual_EC_DRBG, it is recommended that you discontinue the use of Dual EC DRBG, and 
move to a different PRNG (HMACDRBG128) at this time.


Changing the use of the default PRNG algorithm:


Add the following line in the java.security file located at BASEDIR/_jvm/lib/security/ 
directory. 


◆ com.rsa.crypto.default.random = HMACDRBG128


This change needs to be applied to the following components:


◆ "Smarts Global Console


◆ "Any other custom programs written by you using DMT Java remote API


Encryption
By default, encryption (non-FIPS 140 mode) is enabled during the installation process. 
The basis for encryption is a secret phrase that gets transformed into the file imk.dat.


The transformation of the site secret into the imk.dat files differs, depending on whether 
encryption is set to FIPS 140 mode. EMC Smarts programs using FIPS 140 mode 
encryption cannot use the same imk.dat file as EMC Smarts programs using non-FIPS 140 
mode. Therefore, all clients and servers using an imk.dat file must all be set to the same 
FIPS 140 mode.


The programs use the site secret to encrypt passwords in the configuration files and 
passwords to SNMP v3 devices in seed files, as well as to encrypt connections between 
programs. 


At installation, encryption is enabled with a default secret phrase. This phrase is:


Not a secret (literally)


and the imk.dat file can be copied. The imk.dat is found in the BASEDIR/smarts/local/conf 
directory. 


The imk.dat file can only be copied to other systems with the same operating system (OS), 
OS version, and FIPS 140 mode setting. 


To raise the level of security, you need to change the secret phrase by using the 
sm_rebond utility. Thereafter, the secret phrase should be changed periodically to 
maintain a secure system.
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The secret phrase should be treated with the same care as a root password or highest 
level system administration password.


Changing the secret


The sm_rebond utility changes the secret phrase and re-encrypts the files affected by the 
secret. This utility prompts for the old secret phrase and the new phrase, then generates 
an imk.dat file and updates all the files containing encrypted information. This utility 
affects all of the applications that run on the same host and use the same imk.dat file.


The sm_rebond utility shuts down all of the processes run from the product that were 
started by using sm_service or sm_serviced, and that use the same imk.dat file. The 
sm_rebond utility re-encrypts the security files and the seed files, then restarts the 
processes once the phrase and encryption changes are made. All other processes should 
be shut down manually before running the utility and restarted once the utility is finished.


To change the secret, perform the following steps:


1. Use the sm_rebond utility. You must enter this command with administrative 
privileges.


sm_rebond --basedir=<base directory>


For the <base directory>, enter the path for the directory in which the software that is to 
be rebonded is installed.


2. When the utility prompts for the old secret phrase, enter it.


3. When the utility prompts for the new secret phase, enter it. The secret phrase can 
consist of a combination of printable characters, integers and special characters. The 
secret phrase cannot be more than 1,024 characters long.


4. Re-enter the new secret to confirm it.


5. Close the utility.


The sm_rebond utility encrypts only files that reside in BASEDIR/smarts/local/conf and 
three levels of subdirectories below that. To encrypt files outside of that directory area, 
contact EMC Global Services.


When using the sm_rebond utility to change the default password for SNMPvV3 password 
encryption, ensure that all the passwords for the Domain Managers in your deployment 
are the same. 
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Using the secret for multiple products and sites


The secret phrase can be used across multiple products and sites. To use the secret 
phrase across products and sites, EMC Corporation recommends that you perform the 
following steps:


1. Install one or more EMC Smarts products on one or more hosts.


2. If short periods of interrupted communications are not detrimental, stop the 
Managers. However, if the products also use cleartext connections, you can use the 
sm_rebond utility without stopping the Managers. Only that product will lose 
connections for a short period of time.


3. Use the sm_rebond utility to change the secret phrase for each product on each host.


The secret phrase must be exactly the same for each product on each host in order for 
the applications to make connections.


4. Use the sm_edit utility to update the security configuration files and seed files of the 
products as needed.


5. Restart the Managers if applicable.


Using the secret across large numbers of sites
For large numbers of sites, you can perform the following steps:


1. Install an EMC Smarts product at the primary site.


2. Use the sm_rebond utility to change the secret phrase.


3. Use the sm_edit utility to update the security configuration files and seed files of the 
product as needed.


4. Copy the imk.dat file, as well as the configuration files and seed files to the other 
installations of the software.


The imk.dat file can only be copied to other systems with the same operating system (OS), 
OS version, and FIPS 140 mode setting.


You will not have to use the sm_rebond utility on the other Managers if the files are moved 
to the Managers before the Managers are started.


Locking the secret


If access to encrypted data is a critical issue for your organization, EMC provides the 
option to lock the imk.dat file. This disables copies of the imk.dat file, even by restoration 
from a backup process. For more information about this level of security, contact EMC 
Global Services.
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Encrypted passwords
The encryption process uses the secret to encrypt passwords contained in the security 
configuration files. The first line of the serverConnect.conf, clientConnect.conf, and 
brokerConnect.conf files indicates the appropriate field to which encryption is applied.


The first line in the file must read as follows. It must begin with a pound sign (#).


#<encrypted field>:1.0:<n>


The value n refers to the position of the Password field in the configuration file’s record 
and should not be changed: 


◆ For serverConnect.conf, this value is 3. 


◆ For clientConnect.conf and brokerConnect.conf, this value is 4. 


To disable encryption, add a second pound sign (#) at the beginning of the line.


Installation encrypts the password fields in the files by using the default secret. The 
encrypted files reside in BASEDIR/smarts/local/conf.


Encrypting passwords


Password is the only field in the security configuration files that is encrypted. The 
configuration files are located in the BASEDIR/smarts/local/conf directory of a product.


To type or change a password in a security configuration file:


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
security configuration file:


sm_edit conf/<security configuration file>


For example, to open the serverConnect.conf file:


sm_edit conf/serverConnect.conf


2. Review the contents of the file. For example, the serverConnect.conf file may include 
lines similar to the following:


#
<BROKER>  :<DEFAULT> :<DEFAULT> :All
Smarts    :admin     :<SYS>     :All
Smarts-WP :user5     :Password  :Ping
Smarts    :operator  :Password  :Monitor
Smarts    :*         :<SYS>     :None
#


Encrypted passwords are preceded by <E-1.0>


3. Delete the current password and replace it with the new password in cleartext. If the 
current value is encrypted, delete the <E-1.0> tag that marks the password as 
encrypted as well as the current password. The special values <DEFAULT>, <PROMPT>, 
<SYS>, and <AUTO> in the files are not encrypted.


4. Save and close the file.
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The modified version of the security configuration file is saved to the 
BASEDIR/smarts/local/conf directory.


The appropriate values are encrypted as part of the process.


5. Repeat the steps for all of the security configuration files.


6. Restart the Managers if applicable.


If a security configuration file already includes the first line for encryption, specify the 
sm_edit utility with the --noedit option to encrypt the file without opening it. You must 
have administrative privileges when entering this command.


BASEDIR/smarts/bin/sm_edit --noedit conf/<security configuration file>
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Encrypted seed files
The encryption for a seed file only applies to certain information that applies to SNMP v3 
devices. For these devices, a keyword that contains the authentication password can be 
encrypted.


The first line of the seed file must read as follows; it must begin with a pound sign (#).


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


The AUTHPASS and PRIVPASS keywords specify the authentication and privacy passwords 
for an SNMP v3 device.


To disable encryption, add a second pound sign (#) at the beginning of the line.


If a seed file already includes the first line for encryption, specify the sm_edit utility with 
the --noedit option to encrypt the file without opening it. You must have administrative 
privileges when entering this command.


BASEDIR/smarts/bin/sm_edit --noedit conf/<security configuration file>


Encrypted connections
Software components communicate over TCP connections by using the EMC Smarts 
Remote API. Clients which are using Remote API connections, authenticate themselves to 
servers by sending credentials, nominally a username and password. When the 
credentials are passed as cleartext, they can be snooped from the network or accessed by 
using man-in-the-middle configurations.


You can encrypt certain connections by using different keys for the Advanced Encryption 
Standard based on a combination of the Diffie Helman standard and the site secret 
associated with the installation. “Encryption” on page 101 provides additional 
information about the site secret.


Encrypted connections do not work with EMC Smarts Adapter for NetIQ AppManager.


Levels of encryption


The software provides several levels of security above cleartext communication as shown 
in Table 21 on page 107 and Table 22 on page 107.
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Any encryption based on the site secret should only be used once the secret phrase has 
been changed by using sm_rebond described in “Changing the secret” on page 102. The 
Global Console supports cleartext (Level 0), Diffie Helman-Advanced Encryption Standard 
(Level 1), and TLSv1.2 encrypted connections.


Table 21  Encryption levels for connections for non-FIPS 140 mode


Security level Description Advantages Disadvantages


0, CLEAR, or 
CLEARTEXT


no encrypted 
communication


• Backwards compatibility
• No configuration (default 


behavior)


• No security
• Passwords passed to 


servers as cleartext


1 DH-AES • No site secret needed
• No configuration (default 


behavior for new 
installations) 


• Protects against 
eavesdroppers


• Slower connection than 
cleartext or level 2 security


• Not secure against active 
attacks


2 Encryption 
based on site 
secret


• Protects against 
eavesdropping and active 
attack


• Almost as fast as 
cleartext


Must set site secret and keep 
it common across all 
communicating entities


3 DH-AES and site 
secret


Protects against 
eavesdropping and active 
attack, even by those who 
know the site secret


• Slower connection than 
cleartext or level 2 security


• Must set site secret and 
keep it common across all 
communicating entities


Not applicable TLSv1.2 • Standards-based • Incompatible with previous 
releases of the software


• Slower than cleartext


Table 22  Encryption for connections for FIPS 140 mode


Description Advantages Disadvantages


TLSv1.2 with FIPS 140 
cryptography


• Standards-based
• Compatible with FIPS 140-2 


compliant cryptography


• Incompatible with previous 
releases of the software


• Slower than cleartext
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Encrypting connections in non-FIPS 140 mode


In Foundation 9.2 onwards, Domain Managers and Brokers running in non-FIPS 140 mode 
can interact with Domain Managers and Brokers running in non-FIPS 140 mode or FIPS 
140 mode. Although a Domain Manager running in non-FIPS 140 mode can interact with a 
Domain Manager running in FIPS 140 mode, the two applications cannot interoperate with 
one another because they cannot share encrypted data such as SNMPv3 credentials.


EMC Smarts applications that are based on 9.1 foundation or later software, and running 
in non-FIPS 140 mode use TLSv1.2 encrypted connections by default. This behavior is 
different than the behavior for EMC Smarts applications that are based on pre-9.1 
foundation software, where the encryption for encrypted connections was configured by 
using two environment variables, SM_INCOMING_PROTOCOL and 
SM_OUTGOING_PROTOCOL. These environment variables are ignored if the 
communicating applications are TLS-capable, but are honored when a TLS-capable 
application is interacting with a non-TLS-capable application. 


For pre-9.1 applications that are operating in non-FIPS 140 mode, encrypted connections 
are configured by using two environment variables:


◆ SM_OUTGOING_PROTOCOL— Controls the connections that an EMC Smarts 
application that is acting as a client is allowed to initiate.


◆ SM_INCOMING_PROTOCOL— Controls the connections that an EMC Smarts application 
that is acting as a server is allowed to accept.


Each of these environment variables can contain a list of security levels, except for TLS 
security, which cannot be controlled by using these variables. If you specify more than 
one, separate them with commas. If you do not set the variable, it is the same as 
specifying “0” or CLEARTEXT.


When two or more security levels are supported in common, the largest level number is 
used. For example, if a client has SM_OUTGOING_PROTOCOL set to "0,1" and the server 
has SM_INCOMING_PROTOCOL set to "0,1,2", the connection uses the highest common 
level, level 1.


The order in which the different levels are specified for the environment variables has no 
significance—for example, "0,1" and "1,0" behave exactly the same.


Applications that do not support encryption are treated as only having a cleartext level of 
encryption.


When the two ends of the connection do not match, such as when 
SM_OUTGOING_PROTOCOL is 3 at server A and SM_INCOMING_PROTOCOL is 2 at server B, 
a connection cannot be formed. Both client and server will report errors.
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To set the environment variables so that they can be used by the programs of an 
EMC Smarts product, edit the runcmd_env.sh file, which is located in the 
BASEDIR/smarts/local/conf directory of that product.


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


2. Review the contents of the file. The default values for the SM_INCOMING_PROTOCOL 
and SM_OUTGOING PROTOCOL are 1 and 0.


SM_INCOMING_PROTOCOL=1,0
SM_OUTGOING_PROTOCOL=1,0


3. Update the values for the variables to meet the needs of your system.


For example, to raise security to the next highest level, change 1 to 2:


SM_INCOMING_PROTOCOL=2,0
SM_OUTGOING_PROTOCOL=2,0


4. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


5. Restart the Managers if applicable.


Encrypting connections in FIPS 140 mode


In FIPS 140 mode, the software uses Transport Layer Security v1.2 and ignores the 
SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL settings. Because of this, in 
Foundation pre-9.1 (but not in 9.1 or later versions), a FIPS 140-enabled Domain Manager 
cannot interact with a non FIPS 140-enabled Domain Manager.


Setting the environmental variable SM_FIPS140 to true enables FIPS 140 mode. 
“SM_FIPS140” on page 154 provides additional information.


You must enable FIPS 140 mode before the Broker and Domain Managers are started.


Suggested encrypted connections in non-FIPS 140 mode


EMC recommends that you configure your system to use encrypted connections wherever 
possible.


◆ Brokers should be able to communicate with cleartext as well as encryption in both 
SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL, or in TLSv1.2, if a client 
only supports cleartext. This is required in this configuration since the Broker acts as 
both a client and a server, and must be able to communicate with every component in 
the system. Brokers do not need to support cleartext if all clients can make encrypted 
connections.


◆ If a Domain Manager must connect to a client that only supports cleartext, set 
SM_OUTGOING_PROTOCOL to cleartext as well as encryption.
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◆ Adapters based on Foundation 9.2 onwards use TLSv1.2 to communicate by default. 
Only adapters that register with the Broker (--name option) can accept incoming 
connections. If you have adapters that accept incoming connections from clients that 
are not TLS-capable, setting SM_INCOMING_PROTOCOL to require encryption is 
appropriate.


Also, if the adapter must connect, or be connected, to clients that support only 
cleartext, then add the cleartext option to the appropriate variable.


◆ Configure any components that must run on networks outside the management 
domain with both SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL set to 
encryption. Depending on the level of encryption, this will prevent snooping or 
man-in-the-middle attackers. You will not be able to connect directly to such a 
component by using a console.


Replacing or importing TLS certificates
By default, a Smarts Domain Manager generates a self-signed TLS certificate that it will 
present to the incoming TLS connections. However, you can configure a certificate to use 
by performing the following step:


◆ "Place the certificate and key files in $SM_SITEMOD/conf/tls/$DOMAIN.crt and 
$SM_SITEMOD/conf/tls/$DOMAIN.key


Where $DOMAIN is the name of the domain used to register with the broker. The files must 
be in PKCS#8, PEM encoded form with no password.


Self-signed certificates generated by Smarts are stored in the process memory. To 
regenerate default self-signed TLS certificates, stop and restart Smart processes. 


Configuring a secure Broker
You can configure the Broker to run in a secure manner. Use of a secure Broker results in 
the following changes to how the software runs:


◆ Consoles prompt for a username and password to connect to the Broker. Without a 
secure Broker, consoles connect to the Broker without authenticating.


◆ Other servers and clients use their respective clientConnect.conf files to determine 
what credentials to send to the Broker, just as they use clientConnect.conf to 
determine what credentials to send to a server. In particular, you can configure the 
clientConnect.conf files so that clients and servers prompt for connections to the 
Broker, as the console does, or specify the password in clientConnect.conf.


To configure and run a secure Broker, complete the following steps: 


1. Choose a unique EMC Smarts username and password for the secure Broker 
credentials. The new username and password will be used by both servers and 
clients:


• Servers will use these credentials to register with the Broker.


• Clients will use these credentials to connect to the Broker and determine the 
location of a server.
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For example, you could use the username “SecureBroker” and the password “Secure”. 
Choose a unique EMC Smarts username and password.


2. Use the sm_edit utility to open a local copy of the clientConnect.conf file, located in 
BASEDIR/smarts/local/conf. Edit this file, used by all clients and servers, so that 
EMC Smarts programs send the SecureBroker/Secure credentials when connecting to 
the Broker.


a. Comment out the following line:


*:<BROKER>:BrokerNonsecure:Nonsecure


b. Type a new line configuring a secure Broker. This new line is added below the 
BrokerNonsecure line that you commented out. For example:


#*:<BROKER>:BrokerNonsecure:Nonsecure
*: <BROKER> : SecureBroker : Secure


Conversely, you can configure clientConnect.conf so that clients and servers 
prompt for connections to the Broker, as well as other servers. This involves 
replacing the password, Secure in this example, with <PROMPT>.


*: <BROKER> : SecureBroker : <PROMPT>


3. Use sm_edit to make the following changes to the local serverConnect.conf file used 
by the Broker:


• Delete the line granting <DEFAULT>/<DEFAULT> access to the Broker.
• Change the BrokerNonsecure/Nonsecure line to grant Ping access rather than All 


access. Do not, however, delete this authentication record.
• Add a new authentication record that grants All access to the SecureBroker/Secure 


credentials. This new record must be below the BrokerNonsecure/Nonsecure 
record. For example:


<BROKER>:BrokerNonsecure:Nonsecure:Ping
<BROKER> : SecureBroker : Secure : All
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Additional safeguards
In addition to encrypted passwords and encrypted connections, you can secure your 
system by using the file permissions of the operating system, by limiting access to the 
security configuration files, and by limiting access to the servers.


Using file permissions


You can limit access to the security configuration files by using the permissions feature of 
the operating system. Only select users should be allowed access to the files. The users 
must include those who launch the EMC Smarts applications requiring access to the 
authentication records.


Limiting access to the configuration files


You should configure security in such a way that each security file is only readable by 
those programs or users that require it. The security configuration files installed with 
EMC Smarts software, which should be edited after installation, are readable by anyone.


Because Managers and the Broker typically run with administrative privileges, the 
serverConnect.conf and brokerConnect.conf files should only be readable by users with 
administrative privileges and no one else.


The simplest method for creating a secure setup for users and client programs is to 
provide two separate clientConnect.conf files. One clientConnect.conf file, which can 
remain readable by anyone, should only contain entries that make client programs prompt 
for passwords. This clientConnect.conf file will not contain passwords.


For client programs, create a separate clientConnect.conf file that contains the 
authentication information necessary for non-prompting programs to access Managers. 
This clientConnect.conf should only be readable by the user(s) under which these 
programs run. Client programs use the SM_CLIENTCONNECT environment variable to find 
this clientConnect.conf file. You can specify SM_CLIENTCONNECT in the service startup file 
for each service. For clients that are installed as services, you can use the --env option to 
the sm_service utility to edit the parameters of a service.


Limiting access to servers


The --accept option to the sm_server command, described in 
“SM_SNMP_BUG_COMPATIBLE” on page 151, provides another method of access control. 
This option limits the hosts that can connect with the server. Before other security 
measures occur, incoming connections must pass the --accept option before 
authenticating.
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Example security configurations
You can configure EMC Smarts installations to use a variety of levels of security. Higher 
levels of security require more administrative effort, as well as extra effort on the part of 
users of the system, but give you better control of the use of EMC Smarts software. The 
appropriate level of security for your site is determined by the policies and procedures of 
your organization.


This section describes two levels of security, and their advantages and disadvantages. 
You can choose one of these levels, or combine characteristics of several.


Default security


When initially installed, default security uses the security configuration files with 
encrypted passwords based on the default secret phrase. The connection protocols are 
set to use Transport Layer Security v1.2, Diffie Helman encryption, and cleartext. With the 
default security, you need to change the passwords for the usernames in the security 
configuration files. Default security prevents casual inspection, but does not pose much of 
a deterrence from more strenuous efforts.


It is essential that you change the default passwords for the usernames before using the 
system in a production environment.


While the default security provides basic authentication, it does not provide much 
manageability or security. The oper/oper credentials must be known to all console 
operators; the admin/changeme credentials must be known to all administrators. This 
makes it difficult to know who is actually connected to a server, based on their username. 
In addition, you cannot revoke the rights of one user without changing the username and 
password for all users at the same access level.


The serverConnect.conf and clientConnect.conf files include authentication records that 
improves user administration. First, besides the oper/oper credentials, there are 
maint/maint credentials that also provide Monitor access. This illustrates how one might 
define shared usernames that are still differentiated on the basis of role. Second, 
serverConnect.conf contains the following line:


* : * : <SYS> : Monitor


Anyone who can provide a username and password that the operating system considers 
valid is also granted Monitor access. In this scenario, you can give every console operator 
an account on the host on which the server they access runs. These operators log in by 
using the username and password defined for that account. The account can be disabled 
to prevent actual interactive access to the system. In this way, each console operator gets 
a unique username and password. Accesses to the system can be traced to a particular 
user, and access can be individually revoked. Specifying <SYS> for the password avoids 
having to potentially create a number of records in serverConnect.conf.
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This mechanism can readily be extended to provide similar controlled access for 
administrators. For example, you could add the following records to serverConnect.conf:


* : fred|george : <SYS> : All
* : * : <SYS> : Monitor


This would give the users “fred” and “george”, if they provide the passwords for their 
accounts on the host, All access. You could even define a class of administrative users, for 
example, with usernames that start with ADM.


* : ADM* : <SYS> : All
* : * : <SYS> : Monitor


Customized security


Customized security uses security files (with encrypted passwords), a new secret phrase, 
and passwords for the EMC Smarts usernames in the security files that are different than 
their default values. Under customized security, connection protocols are set to use the 
site secret and cleartext. This setup protects against eavesdropping and active attacks as 
well as casual inspection.


To configure customized security:


1. Create a new secret phrase by using sm_rebond, as described in “Changing the 
secret” on page 102.


2. Change the username and passwords in serverConnect.conf, clientConnect.conf, and 
brokerConnect.conf.


These should provide access control by individual users. Consider using system 
authentication to authenticate Global Console users, as described in “System 
authentication” on page 93. The new usernames and passwords should also address 
connections between servers and servers or servers and clients.


If your software resides on a single host, a single username and password for 
automatic client authentication is usually sufficient. However, if you have clients, such 
as adapters, on multiple hosts, or generally in different security domains, you may use 
different usernames and passwords for manageability. For example, if there is reason 
to believe that the username and password from one machine have been 
compromised, you can change them without having to change the configuration on 
any other machine.


To achieve such a configuration, you need to assign unique usernames and passwords 
to clients that you consider to reside in separate security domains. Add a line to grant 
access to each such username/password credential to the serverConnect.conf file of 
each server the client will access. Add a corresponding line to the clientConnect.conf 
file that the client will use.


If you have multiple security domains on a single host, use the SM_CLIENTCONNECT 
environment variable so that different clients read different clientConnect.conf files. You 
can use the --env option of the sm_service utility to set the environment value when the 
service starts.
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3. Configure the different components to communicate with encrypted connections. The 
types of allowed connections depend on the versions of EMC Smarts software in use.


• Most connections should be encrypted. The Broker does not need to support 
cleartext if all clients can make encrypted connections. “Encrypted connections” 
on page 106 provides additional information.


4. At the highest security level, you should run with a secure Broker as well. Setting up a 
secure Broker is described in “Configuring a secure Broker” on page 110.

Example security configurations 115







Securing Access to the Software

116 EMC Smarts Foundation System Administration Guide







CHAPTER 7
Operation of the Broker


This chapter consists of the following sections:
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Overview of the Broker
A client application, such as a console or an adapter, utilizes the Broker to determine 
where Managers are running. When a Manager starts, it registers with the broker:


◆ Hostname of the machine that it is running on.


◆ TCP port that it is listening on.


Clients retrieve this information from the Broker so that they can communicate with the 
Manager.


The Broker registry maintains the following information:


◆ Name of the Manager, including the host and TCP port it is running on.


◆ Status of each Manager.


The Broker checks the status of each Manager every five minutes by connecting to the 
host on which EMC Smarts is running and determining if the process is running 
properly. If the Broker is unable to connect or the process is not running, the Broker 
changes the status of the Manager to Dead.


• Running indicates that the Broker is able to communicate with the Manager.


• Dead indicates that the Manager exited unexpectedly or is unreachable. When a 
Manager properly shuts down, it notifies the Broker and the Broker removes it from 
its registry.


• Unknown indicates that the Broker was restarted and that it is querying its list of 
Managers to determine their state.


◆ Process ID of each Manager. This is the process ID assigned by the host’s operating 
system. In some cases when the Broker is restarted, the process ID of each Manager is 
set to zero to indicate the Broker does not know the process ID of the Manager.


◆ Last time the state of the Manager changed. This value is set when the Manager 
registers with the Broker and is updated if the Broker determines that the Manager is 
dead. When the Broker restarts, it changes the status of Managers marked Unknown 
to Running or Dead.


The Broker changes the status of the Manager to Dead when it cannot connect to the 
Manager. However, the Broker continues to try to connect to the Manager every five 
minutes. If the Broker succeeds in connecting to the Manager, it changes its status back to 
Running.
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Viewing the registry of the Broker
The Broker is a component of an EMC Smarts application. The Broker is designed to 
automatically start each time the host on which it is installed is started.


You can use the brcontrol utility to view the list of registered programs.


To view the contents of the Broker from a command prompt, use the following command:


BASEDIR/smarts/bin/brcontrol [-b <host>:<port>]


If the Broker resides on another system, specify the -b option with the host and port 
number.


How the clients find the Broker
The Broker facilitates communication between clients and Managers. During installation, 
you are prompted for the host location of the Broker and its port number. This information 
is stored in the SM_BROKER_DEFAULT environment variable. This variable is used by all 
EMC Smarts programs to find the Broker. The default host setting for the variable is 
localhost, and the default port setting is 426.


A client performs the following steps to determine the Broker’s location.


1. Verifies whether the Broker’s location was specified as an option at startup. When this 
option is specified, no other options are checked.


2. Checks the value of the SM_BROKER_DEFAULT environment variable. If this variable is 
set, no other options are checked.


3. Checks if the Broker is running on the host smarts-broker and listening on TCP port 
426.


4. If smarts-broker is not defined, the program checks port 426 on localhost.


The hostname smarts-broker is usually an alias, such as a DNS CNAME.
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How to change the Broker environment variable
The default location of the Broker is specified at installation and stored in the 
SM_BROKER_DEFAULT environment variable. 


There are two scenarios in which you may need to change the value of the environment 
variable after the software is installed.


◆ If during installation, the default Broker host and/or port settings were changed, but 
the typed values are incorrect.


◆ If the Broker is automatically installed when you install an EMC Smarts Foundation 
application or the adapters. Because only one Broker should be active on a network, 
the Broker on one of the hosts must be disabled, and the Broker environment variable 
on that host must point to the host where the Broker is running. This typically occurs 
when an EMC Smarts application is installed on one host and the adapters are 
installed on a second host. 


Correcting the Broker settings


In the first scenario, you must edit the Broker host and/or port value in two places. 


1. First, change the SM_BROKER_DEFAULT environment variable in the runcmd_env.sh 
file, which is located in the BASEDIR/smarts/local/conf directory:


SM_BROKER_DEFAULT=<host>:<value>


where:


• <host> is the location of the Broker.


• <value> represents the port of the Broker.


The defaults are localhost for the location and 426 for the port.) Edit the location and 
port as needed.


This variable becomes the default for all EMC Smarts Foundation programs and any 
subsequent installations for this host.


2. Additionally, you must change the --port value in the sm_service install Broker 
command line to match the port value you set in the SM_BROKER_DEFAULT 
environment variable.


Use the sm_service show action with the --cmdline option to display the existing 
install Broker command line.


BASEDIR/smarts/bin/sm_service show --cmdline ic-broker


Output:


BASEDIR/smarts/bin/sm_service install 
--name=ic-broker 
--description=”EMC Broker” 
--env=SM_CLIENTCONNECT=brokerConnect.conf 
--startmode=runonce 
BASEDIR/smarts/bin/brstart 
--port=<PORT> 
--restore=BASEDIR/smarts/local/repos/broker/broker.rps 
--output
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Then use the sm_service install action with the --force option to change the port value 
for the Broker.


BASEDIR/smarts/bin/sm_service install 
--force 
--name=ic-broker 
--description=”EMC Broker” 
--env=SM_CLIENTCONNECT=brokerConnect.conf 
--startmode=runonce 
BASEDIR/smarts/bin/brstart 
--port=<NEW VALUE> 
--restore=BASEDIR/smarts/local/repos/broker/broker.rps 
--output


Securing the Broker
Securing access prevents unauthorized usage of the Broker, and protects it from being 
modified (for example, Managers being deleted from the Broker). Authenticating users 
and determining their privileges are accomplished by using two files: serverConnect.conf 
and brokerConnect.conf. These files ensure that only authorized users access the Broker. 
You must modify the local copies of these files, which are located in 
BASEDIR/smarts/local/conf. “Configuring a secure Broker” on page 110 provides 
additional information.
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CHAPTER 8
Continuous Audit of Client Connections


This chapter describes a framework for exposing information about client connections, 
threads, and other aspects of EMC Smarts applications. It consists of the following 
sections:


◆ Overview of continuous auditing of client connections ..........................................  124
◆ System Element objects ........................................................................................  125
◆ Client data persists after connection terminates....................................................  128
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◆ Viewing SM_ElementManager attribute values ......................................................  130
◆ Changing SM_ElementManager attribute values....................................................  131
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Overview of continuous auditing of client connections
The foundation software on which EMC Smarts applications are built is essentially a 
sophisticated and specialized object database. It consists of MODEL class libraries, tools, 
commands, and utilities.


By exposing information about client connections, threads, and other aspects of an 
EMC Smarts application as MODEL objects in the repository, the foundation’s tools, such 
as multi-language client libraries, subscription facilities, and analysis can be used to 
query and report on the application itself. A client connection is any connection that is 
initiated by a remote client, such as a Global Console, remote repository accessor, data 
exchange adapter, dmctl, Perl client, Java client, or C++ client.


The following enhancements are intended to improve the serviceability of EMC Smarts 
applications by making more information about client connections easily accessible 
through normal foundation mechanisms.


To disable logging, do the following:


1. Open the runcmd_env.sh file where the broker was started using the command 
line.


2. Run sm_edit:<Basedir>/smarts/bin/sudo ./sm_edit 
<Basedir>/local/conf/runcmd_env.sh.


3. Add or edit the following line in the runcmd_env.sh file:


SM_NO_LOG_CLIENTS=TRUE


4. Save and close the runcmd_env.sh file. 


5. Restart the Smarts broker service.
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System Element objects
Two MODEL classes, SM_SystemElement and SM_ElementManager, are used to expose 
information about an application’s client connections, threads, and queues. 
SM_ElementManager is responsible for managing the subclasses of SM_SystemElement.


SM_SystemElement


The SM_SystemElement class is an abstract base class for the SM_Client, SM_CThread, 
and SM_Queue classes, which are defined in Table 23 on page 125 and shown in Figure 3 
on page 125. 


Figure 3  SM_SystemElement modeling


An SM_Client object and an SM_CThread object are created whenever a client successfully 
establishes an API connection to the application. A client’s SM_Queue object and a 
second SM_CThread object are created when and if a subscription request is made by the 
client.


Table 23  SM_SystemElement subclasses


Subclass name Description


SM_Client An external representation of an incoming client connection. It has 
attributes that represent information about the connection.


An SM_Client is served by SM_CThreads and SM_Queues.


SM_CThread An external representation of the internal thread that is associated with a 
client connection. It has attributes that represent information about the 
internal thread.


SM_Queue An external representation of the internal queue that is associated with a 
client connection. It has attributes that represent information about the 
internal queue.


SM_Client


SM_CThread SM_Queue


ServedBy/
Serves


Note: Directed lines (        ) represent Relationships.


ServedBy/
Serves


ServedBy/
Serves
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SM_ElementManager


The SM_ElementManager class manages the life cycle of SM_SystemElement objects. It is 
a singleton class (the instance is SM_ElementManager::SM-ElementManager) and has 
attributes for configuring various aspects of the life cycle management. The key attributes 
for SM_ElementManager are listed in Table 24 on page 126. 


Table 24  Key attributes for SM_ElementManager  (page 1 of 2)


Attribute Value Description


Enabled Boolean
Default: TRUE


Enables or disables the tracking of client 
connections to this application:
• A value of TRUE enables the tracking of 


client connections.
• A value of FALSE disables the tracking of 


client connections.


RecentHighestFD Unsigned long integer
This attribute is 
read-only.


Highest file descriptor (highest socket 
number) in recent use, for a client 
connection to this application.


FDLimit Unsigned long integer
This attribute is 
read-only.


Maximum number of file descriptors (socket 
numbers) that this application is allowed to 
use for client connections at any one time.
For an application on a Solaris- or 
Linux-based host, the file-descriptor limit is 
imposed on the application by the OS as 
long as that limit is 1024 or less. If that limit 
is more than 1024, the foundation startup 
code sets the limit to 1024.
FDLimit is not supported for Windows.


FDWarningHeadroom Unsigned integer
Default: 100


An integer in the following equation that 
determines when the number of file 
descriptors for this application increases to 
an unacceptable level:
Number of file descriptors  > FDLimit – 
FDWarningHeadroom
For example, if FDLimit = 1024 and 
FDWarningHeadroom = 100, the number of 
file descriptors increases to an 
unacceptable level when that number is 
greater than 924.
FDWarningHeadroom is not supported for 
Windows.
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ReapInterval Unsigned long integer
Default: 60 seconds


Interval, in seconds, between successive 
expiry scans of terminated client 
connections for this application.
This attribute works in conjunction with two 
other attributes, ClientRetainTime and 
AbnormalClientRetainTime, to determine 
when an expiry scan deletes (reaps) the 
client objects and data for a terminated 
connection:
• For any normally terminated connection, 


the expiry scan deletes the associated 
client objects and data when the time 
between the connection’s termination 
timestamp and the current time exceeds 
the ClientRetainTime.


• For any abnormally terminated 
connection, the expiry scan deletes the 
associated client objects and data when 
the time between the connection’s 
termination timestamp and the current 
time exceeds the 
AbnormalClientRetainTime.


The effective retain time for a normally 
terminated connection is 1/2 the 
ReapInterval plus the ClientRetainTime.
The effective retain time for an abnormally 
terminated connection is 1/2 the 
ReapInterval plus the 
AbnormalClientRetainTime.


ClientRetainTime Unsigned long integer
Default: 60 seconds


The least amount of time, in seconds, 
between when a normally terminated 
connection ends and when the client 
objects and data that are associated with 
that connection are deleted from the 
repository.


AbnormalClientRetainTime Unsigned long integer
Default: 900 seconds
(15 minutes)


The least amount of time, in seconds, 
between when an abnormally terminated 
connection ends and when the client 
objects and data that are associated with 
that connection are deleted from the 
repository.


RequestLogSize Unsigned long integer
Default: 25


Size of the request log for client 
connections for this application. By default, 
the 25 most recent requests and their 
responses are recorded.
Setting RequestLogSize to 0 disables the 
collection of request information for client 
connections.
Like the rest of the client data, the request 
information persists for a client connection 
until the associated SM_Client and its 
threads and queues are deleted.


LogClients Boolean
Default: TRUE


TRUE indicates that this application will log 
the client connects and disconnects in its 
log file.


Table 24  Key attributes for SM_ElementManager  (page 2 of 2)


Attribute Value Description

System Element objects 127







Continuous Audit of Client Connections

Client data persists after connection terminates
When a connection terminates, the SM_ElementManager does not immediately delete the 
associated client objects and client data. Instead, the SM_ElementManager does a 
periodic scan and removes the client objects and the client data only after a certain 
amount of time has passed. In this way, you, as an administrator, can examine details 
about a connection even after it has terminated.


File descriptor usage warning event
The SM_ElementManager receives the file descriptor (socket number) for a new client 
connection. On Solaris and Linux hosts, there is a hard limit to the number of file 
descriptors that an application can use at any one time. Exceeding that limit is an 
irrecoverable condition that forces the application to exit with a fatal error.


SM_ElementManager keeps track of the file descriptors and uses its FDLimit and 
FDWarningHeadroom attribute values to determine when the number of file descriptors 
increases to an unacceptable level. When that limit is exceeded, the SM_ElementManager 
asserts the HighFDUsageWarning event.


The HighFDUsageWarning event is not supported for Windows.
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Acquiring client information
You can get information about the clients for an application by going to the 
BASEDIR/smarts/bin directory of the application and entering dmctl command that 
include any of the following command options:


◆ who command option


• who


Lists the clients that are currently logged in to the application.


• who <n>


Provides information about the client with connection ID n.


• who is <n>


Provides information about the client with connection ID n.


• who am I


Provides information about the dmctl client that you am using.


• who is [ACTIVE | ENDED | FAILED| KILLING | KILLED | ABNORMAL| ALL]


Lists the clients whose state matches the one specified. The state names are not 
case-sensitive; for example, who is ACTIVE and who is active are both acceptable.


◆ w command option


Uses same argument options as who command option. who and w are variants of the 
same command and show slightly different data: who is more focused on from whom 
or where a connection originates, and w is more focused on what a connection is 
doing. The w command option also shows summary data about the target application, 
such as the number of connections, uptime, and so on.


◆ kill <connection ID>


Disconnects the client connection that is identified by the connection ID. Mainly used 
to terminate clients that have failed to disconnect gracefully.


◆ getActivity <connection ID>


Displays the most recent requests and responses from the client with the specified 
connection ID.


Examples:


dmctl -s <application name> who is 14


dmctl -s <application name> w is active


dmctl -s <application name> kill 14


dmctl -s <application name> getActivity 14


The last example command returns as many requests as the target application holds for a 
client that has a connection ID of 14. By default, that number is 25, which is determined 
by the RequestLogSize attribute of the SM_ElementManager. For each returned request, 
the command also returns the application’s resulting response/error to the request.
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Here is an excerpt of the return for a dmctl getActivity command:


dmctl> getActivity 2887
Activity record starts at October 18, 2012 12:10:34 AM EDT +654ms


ELAPSED RSPTIME DIR  MESSAGE
:00.000         ---> invokeOperation ICS_ConfigurationManager 


ICS-ConfigurationManager exportConfigFor { ConsoleOperation }
:00.008 :00.008 <--- OK
.
.
.
:00.076         ---> get InCharge_Feature OI CreationClassName
:00.076 :00.000 <-!- MR-E-OBJECT_NOT_FOUND-Object class::name 


'InCharge_Feature::OI' not found; in file 
"/work/tancurrent/DMT-9.2.0.0/42/smarts/repos/mr/dyn_acc.c" at line 1590


.


.


.
:01.105         ---> getf ICS_NotificationList ICS_NL-Default listName -1
:01.105 :00.000 <--- OK


Activity record ends at October 18, 2012 12:10:35 AM EDT +760ms


The first and last lines show the period of time that the activity log for the connection 
spans. In between are the log entries.


Each log entry has an elapsed time (which is shown relative to the “Activity record starts” 
time), an optional response time, a direction, and a message. The direction is a right arrow 
for a request to the application, a left arrow for a response, and a left arrow with an 
exclamation point (<-!-) for an error response.


The message is the request summary for a request, “OK” for a response, or error text for an 
error response. The response time for a request is empty, and the response time for a 
response shows the time difference between the time of the request and the response.


Viewing SM_ElementManager attribute values
You can view SM_ElementManager attribute values by entering the following dmctl 
command from the BASEDIR/smarts/bin directory of the target application:


dmctl -s <application_ name> get 
SM_ElementManager::SM-ElementManager::<attribute_name>


For example:


dmctl -s INCHARGE-MPLS-TOPOLOGY get 
SM_ElementManager::SM-ElementManager::FDLimit


To view all values in one invocation, enter the following dmctl command:


dmctl -s <application_ name> get SM_ElementManager::SM-ElementManager 
| more
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Changing SM_ElementManager attribute values
EMC recommends that you do not change SM_ElementManager attribute values. However, 
if you want to change an attribute value, you can do so by entering the following dmctl 
command from the BASEDIR/smarts/bin directory of the target application:


dmctl -s <application_ _name> put 
SM_ElementManager::SM-ElementManager::<attribute name> <attribute 
value>


For example:


dmctl -s INCHARGE-MPLS-TOPOLOGY put 
SM_ElementManager::SM-ElementManager::RequestLogSize 30


The command-modified parameters are persistent, which means that your modifications 
are saved to disk when the application is shut down and are not reset when the 
application is restarted. Two exceptions are RecentHighestFD and FDLimit, which are 
initialized at application startup.
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Managing Log Files


This chapter consists of the following sections:


◆ Overview of message logging ................................................................................  134
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Overview of message logging
Figure 4 on page 134 presents an overview of message logging.


Figure 4  Message logging


All EMC Smarts Foundation processes (applications) such as Domain Managers, Global 
Managers, Adapter Platforms, and Adapters create log files that contain status 
information and error reports. Some processes use the exception logging mechanism that 
is shown in Figure 4, while others write directly to stdout or stderr.
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When a process is started with the --output option, the status information and error 
reports are written to at least one log file. One log file is always created, but two different 
versions of the log file may be created, depending on the settings of the SM_LOCALE and 
SM_ENCODING_OUPUT environment variables.


The name of a log file has the following syntax:


<name>_<locale>_<encoding>.log


where:


◆ <name> in the log filename column is determined by the rules that apply to the --output 
command option, as described in “Command-line options that control messages” on 
page 137.


◆ <locale> is based on the value of the SM_LOCALE environment variable.


◆ <encoding> is based on the value of the SM_ENCODING_INPUT environment variable. 
“SM_LOCALE” on page 161 and “SM_ENCODING_*” on page 161 provide additional 
information.


A log file whose locale is en_US (default value of SM_LOCALE) and encoding is UTF-8 
(default value of SM_ENCODING_INPUT) is always created when the --output option is 
provided. 


◆ If the SM_LOCALE environment variable specifies the English locale (en_US), and the 
SM_ENCODING_OUTPUT environment variable specifies UTF-8, then the English log is 
the only log file produced.


◆ If the SM_LOCALE variable specifies a locale other than en_US, or the 
SM_ENCODING_OUTPUT environment variable specifies something other than UTF-8, 
a second log file is created. Log messages written to this second log are localized 
according to the setting of the SM_LOCALE variable, if such a localization exists.


◆ If SM_LOCALE specifies an invalid locale (one for which EMC Smarts software has not 
been localized), English log data will result in the process log file.
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Table 25 on page 136 summarizes the filename, locale and encoding of the log files that 
are produced, including the system log containers. 


Table 26 on page 136 provides several examples of SM_LOCALE and 
SM_ENCODING_OUTPUT variable settings and the resultant logs. 


The volume of output to the system log containers is controlled by the --loglevel option. 
The volume of output to the log files is controlled by the -–errlevel option, and by the 
environment variables that control filtering on specific error tables and error codes.


Log file management behavior applies to both log files. Log rolling is managed in a 
synchronized fashion so that data in multiple logs can be correlated. Thus, when the 
English log rolls, the non-English log, if it is being produced, will also roll.


Table 25  Log filenames, locales and encodings


Log use Log filename (if –output is used) Locale Encoding


English log <name>_en_US_UTF-8.log


For example, 
MYDM_en_US_UTF-8.log


en_US UTF-8


Non-english log <name>_<locale>_<encoding>.log


For example, 
MYDM_ja_JP_<encoding>.log


Defined by 
SM_LOCALE


Specified by the 
SM_OUTPUT_ENCODING 
variable. 


UNIX syslog Defined by 
SM_LOCALE


UTF-8 (permitted and 
expected by the new IETF 
syslog-protocol RFC, still 
in a draft form)


Win Event Log Defined by 
SM_LOCALE


UTF-16


Table 26  SM_LOCALE and SM_OUTPUT_ENCODING examples


SM_LOCALE setting SM_OUTPUT_ENCODING value Logs that are produced


en_US UTF-8 <name>_en_US_UTF-8.log


en_US ShiftJIS <name>_en_US_UTF-8.log
<name>_en_US_ShiftJIS.log


fr UTF-8 <name>_en_US_UTF-8.log
<name>_fr_UTF-8.log


zh GB <name>_en_US_UTF-8.log
<name>_zh_GB.log
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Command-line options that control messages


EMC Smarts messages are controlled by the following standard options for the sm_service 
command and environment variables.


For the sm_service options that use a minimum security level, the level can be: none, 
emergency, alert, fatal, critical, error, warning, notice, informational, and debug. Note that 
fatal is equivalent to emergency, alert, or critical. Figure 4 on page 134 displays the range 
of security levels.


◆ Option --output[=<file>]


Write all logging output for an EMC Smarts application to a log file in the 
BASEDIR/smarts/local/logs directory. The name of the log file is 
<file>_<locale>_<encoding>.log, or the --logname value if <file> is omitted. If --output is 
not specified in the invocation line, then no logs are produced.


◆ Option --errlevel=<min_severity_level>


Used by the exception logging mechanism to determine the minimum exception level 
for writing messages to the log files. By default, --errlevel is set to warning. Exceptions 
below this level are not written to the log files.


◆ Option --loglevel=<min_severity_level>


Used by the exception logging mechanism to determine the minimum exception level 
for sending messages to the system error logger. By default, --loglevel is set to error. 
Exceptions below this level are not forwarded to the system error logger.


◆ Environment variable SM_MAIN_OPTIONS


Used to set the defaults for the standard options for all applications. For example,


SM_MAIN_OPTIONS=--loglevel=None


sets the default exception level to none for the system error logger, meaning that, by 
default, the exception logging mechanism will not send any messages to the system 
error logger.


You can specify a space-separated list of standard options for SM_MAIN_OPTIONS, 
exactly as the options would appear on the invocation line. Of course, when starting 
an application, you can override a globally specified default by including the 
appropriate option and new value in the command line.


◆ Environment variable SM_LOGFILES


Used to change the default log location for log files from BASEDIR/smarts/local/logs 
to a user-specified location.


Example


SM_LOGFILES=/u/ps/johndoe/ic/logs


This command results in the writing of the log files to the /u/ps/johndoe/ic/logs 
directory.


“The sm_service command line” on page 69 provides additional information about 
sm_service command options. Appendix A, “Environment Variables,” provides additional 
information about environment variables.
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Retrieving and setting log, error and trace levels at runtime
There are three computed attributes available to get and set the log, error, and trace levels 
of a Domain Manager at runtime. These computed attributes, described in Table 27 on 
page 138, are available on the SM_JIIM_Support object, and are therefore available from 
within JIIM code. The SM_System object is a subclass of SM_JIIM_Support and also 
inherits these computed attributes. The values of these computed attributes can be 
retrieved and set by using dmctl. 


Retrieving the current level
To retrieve the current levels, invoke the get method on SM_System::SM-System::logLevel, 
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel. Invoking the 
get method will return a string representing the current level such as Warning, Error, or 
Fatal. 


In this example the error level setting in the MYDM Domain Manager is retrieved, by using 
dmctl:


dmctl -s MYDM get SM_System::SM-System::errLevel 


Warning


Setting the level
To change the current levels, invoke the put method on SM_System::SM-System::logLevel, 
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel, and the level is 
changed appropriately. 


In this example, the trace level setting is changed to None in the MYDM Domain Manager. 


dmctl -s MYDM put SM_System::SM-System::traceLevel None


When you change the log, error or trace levels by using the put method on one of these 
computed attributes, dmctl does not return anything. However, a message is printed in the 
log file. The log message will appear similar to the following:


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6
JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl 
client (id 6), on host host1 with credentials tpadmin1 has changed 
the Trace level to None; in file 
"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458


Table 27  Computed attributes to retrieve and set log, error, and trace levels at runtime


Computed Attributes Description


logLevel The minimum exception level for sending messages to the system error 
logger.The logLevel attribute is a string, and can be any one of the values 
set for the --loglevel command line option.


errLevel The minimum exception level for writing messages to the log files. The 
errLevel attribute is a string, and can be any one of the values set for the 
--errlevel command line option.


traceLevel Used to print a stack trace to the log file when an exception at this level 
or above occurs. Exceptions below this level do not write a stack trace. 
The traceLevel attribute is a string, and can be any one of the values set 
for the --tracelevel command line option. 

138 EMC Smarts Foundation System Administration Guide







Managing Log Files

Log files
When the --output option is specified for the sm_server sm_service command, each 
Manager stores its working history in a log file. Every time a Manager starts, it writes 
information to the log file when one of the following occurs:


◆ Error


◆ Connection is lost


Log files are, by default, written to the BASEDIR/smarts/local/logs directory. The 
SM_WRITEABLE environment variable specifies the default locations for log files and other 
output files such as repositories and saved consoles, as described in “SM_WRITEABLE” on 
page 170.


Also, the location where log files are saved can be separately controlled with the 
SM_LOGFILES environment variable, as described in “SM_LOGFILES” on page 170.


All log files have a .log file type. The default name of a log file is based on the Manager's 
name. For example, if the name of the Manager is MYDM, then the name of the English log 
file is MYDM_en_US_UTF-8.log. To change the default name, specify a filename with the 
--output option for the sm_server sm_service command. 


The names of log files written by adapters are described in their respective user’s guides. 


EMC Smarts programs can maintain up to 999 different copies of backup log files for each 
log that is being generated. For example, if you are generating two log files, 
MYDM_en_US_UTF-8.log and MYDM_fr_UTF-8.log file, you can maintain up to 999 backup 
log files for the MYDM_en_US_UTF-8.log and 999 backup log files for the 
MYDM_fr_UTF-8.log.


The number of saved log files is determined by the value of the SM_BACKUP_FILE_LIMIT 
environment variable. When a Manager starts up, it renames a file that matches its log 
filenames and adds a .bak suffix to the name (for example, MYDM_en_US_UTF-8.log to 
MYDM_en_US_UTF-8.log.bak). If a file with this name already exists, it is renamed 
MYDM_en_US_UTF-8.log.NNN, and a new MYDM_en_US_UTF-8.log.bak is created. By 
default, programs save three log files, which does not include the active log file. 


Log file management behavior applies to both log files.   Log rolling is managed in a 
synchronized fashion so that data in multiple logs can be correlated.   Thus, when the 
non-English log rolls, the English log, if it is being produced, will also roll. 
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Diagnostic header


Every log file (initial and after any log rolling) starts with a diagnostic header which 
indicates the startup and current information for a process. 


The diagnostic header is as follows:


MAIN_MSG-*-STARTUP-The following lines are routine diagnostic output; this is not a crash.
================================================================================
Start of process debug and runtime information:
================================================================================


<the standard header included with a stacktrace>


================================================================================
End of process debug and runtime information
================================================================================


The standard header for a stacktrace includes:


◆ Command line arguments of the process


◆ Which libraries are loaded


◆ The environment


Example
The diagnostic header will appear similar to the following example:


[July 15, 2009 10:58:41 AM MST +106ms] t@6084 platform
MAIN_MSG-*-STARTUP-The following lines are routine diagnostic output; this is not a crash.
================================================================================
Start of process debug and runtime information:
================================================================================
WinNT 200120:


C:/CMP/DMT90/bin/system/sm_server.exe -n TEST_OUT_M -c icf --broker=localhost:426 --output
DMT: V9.0.0.0(90743), 09-Jul-2009 12:01:53 Copyright 1995-2009, EMC Corporation - Build 1169
sm_clsapi.dll (90743) 09-Jul-2009 16:19:12 UTC


sm_rclt.dll (90744) 09-Jul-2009 16:52:37 UTC


sm_servif.dll (90744) 09-Jul-2009 16:52:45 UTC


sm_server.exe (90751) 09-Jul-2009 23:41:33 UTC


    time=Wed Jul 15 10:58:41 2009 (1247680721)
 pid=5986


    SM_HOME=C:/CMP/DMT90
    CWD=C:\CMP\DMT90\bin
Environment:
    ALLUSERSPROFILE=C:\Documents and Settings\All Users
    APPDATA=C:\Documents and Settings\user1\Application Data
    CLIENTNAME=Console
    CommonProgramFiles=C:\Program Files\Common Files
    COMPUTERNAME=COMP1
    ComSpec=C:\WINNT\system32\cmd.exe
    DEFLOGDIR=C:\Documents and Settings\All Users\Application Data\McAfee\DesktopProtection
    FP_NO_HOST_CHECK=NO
    HOMEDRIVE=H:
    HOMEPATH=\
    HOMESHARE=\\someDrive\user1$
    HummPATH=C:\Program Files\Hummingbird\Connectivity\10.00\Accessories\;
    JAVA_HOME=C:\jdk1.6.0_02
    LM_LICENSE_FILE=17955@smarts-lmgr92.smarts.com
    LOGONSERVER=\\CORP3
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    MAVEN_HOME=C:\maven-2.0.7
    NUMBER_OF_PROCESSORS=2
    OS=Windows_NT
    
Path=C:/CMP/DMT90/local/bin/system;C:/CMP/DMT90/local/bin/system;C:/CMP/DMT90/bin/system;C:/C
MP/DMT90/local/lib;C:/CMP/DMT90/local/lib;C:/CMP/DMT90/lib;/opt/dev/foo/bin/system;/opt/dev/f
oo/lib;C:/jdk1.6.0_02/jre/bin;C:/jdk1.6.0_02/jre/bin/server;C:/maven-2.0.7/bin;C:/WINNT/syste
m32;C:/WINNT;C:/WINNT/System32/Wbem;C:/perl;C:/jdk1.6.0_02/bin;"C:/Program Files/Common 
Files/EMC";C:/Program Files/Windows Imaging/
    PATHEXT=.COM;.EXE;.BAT;.CMD;.VBS;.VBE;.JS;.JSE;.WSF;.WSH
    PROCESSOR_ARCHITECTURE=x86
    PROCESSOR_IDENTIFIER=x86 Family 6 Model 23 Stepping 6, GenuineIntel
    PROCESSOR_LEVEL=6
    PROCESSOR_REVISION=1706
    ProgramFiles=C:\Program Files
    PROMPT=$P$G
    RoxioCentral=C:\Program Files\Common Files\Roxio Shared\9.0\Roxio Central33\
    SESSIONNAME=Console
    SM_AUTHORITY=<NONE>
    SM_BROKER=localhost:426
    SM_BROKER_DEFAULT=localhost:426
    SM_DEF=/opt/dev/foo
    SM_DEFHOME=/opt/dev/foo
    SM_FIXED=C:/CMP/DMT90;/opt/dev/foo
    SM_HOME=C:/CMP/DMT90
    SM_JAVA=C:\jdk1.6.0_02\jre\bin;C:\jdk1.6.0_02\jre\bin\server;
    SM_JAVAHOME=C:\jdk1.6.0_02\jre
    SM_JDK_HOME=C:\jdk1.6.0_02
    SM_LICENSE=17955@smarts-lmgr92.smarts.com
    SM_MAX_MONITORING_THREADS=1
    SM_PIPEDIR=\\\\.\\pipe\\smarts\\
    
SM_POP_1=PATH=C:\maven-2.0.7\bin;C:\WINNT\system32;C:\WINNT;C:\WINNT\System32\Wbem;C:\Program 
Files\Common Files\Roxio Shared\DLLShared\;C:\Program 
Files\Hummingbird\Connectivity\10.00\Accessories\;;c:\Program Files\Microsoft SQL 
Server\90\Tools\binn\;C:\Program Files\Perforce;C:\perl;C:\jdk1.6.0_02\bin;"C:\Program 
Files\Common Files\EMC";C:\Program Files\Windows Imaging\
    SM_POP_2=LM_LICENSE_FILE=
    SM_POP_3=SM_LIBPATH=
    SM_POP_4=SM_BROKER=
    SM_POP_5=SM_BROKER_DEFAULT=
    SM_POP_6=SM_PROCESS_PATH=
    SM_PROCESS_PATH=C:/CMP/DMT90/bin/system/sm_server.exe
    SM_SITEMOD=C:/CMP/DMT90/local;C:/CMP/DMT90;/opt/dev/foo/local;/opt/dev/foo
    
SM_SYMBOL_PATH=C:/CMP/DMT90/local/symbols;C:/CMP/DMT90/symbols;/opt/dev/foo/local/symbols;/op
t/dev/foo/symbols;C:/WINNT/symbols/dll;C:/WINNT/system32
    SM_WRITEABLE=C:/CMP/DMT90/local
    SystemDrive=C:
    SystemRoot=C:\WINNT
    TCL_LIBRARY=/opt/dev/foo/lib/tcl
    TEMP=C:\DOCUME~1\user1\LOCALS~1\Temp
    TMP=C:\DOCUME~1\user1\LOCALS~1\Temp
    UATDATA=C:\WINNT\system32\CCM\UATData\D9F8C395-CAB8-491d-B8AC-179A1FE1BE77
    USERDNSDOMAIN=someDomain.EMC.COM
    USERDOMAIN=someDomain
    USERNAME=user1
    USERPROFILE=C:\Documents and Settings\user1
    VS80COMNTOOLS=C:\Program Files\Microsoft Visual Studio 8\Common7\Tools\
    VSEDEFLOGDIR=C:\Documents and Settings\All Users\Application Data\McAfee\DesktopProtection
    windir=C:\WINNT
================================================================================
End of process debug and runtime information
================================================================================
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Date and timestamp, and thread id in each log message


The date and timestamp is written at the beginning of each log record. The thread id is 
also included in each log record, following the date and timestamp. For example:


[March 2, 2012 3:31:18 PM EDT +357ms] t@3012557744 SM_ProtocolEngine-1
SVIF_MSG-*-DSM-SM_DebugServer: purgeObserver()


Message at the end of a rolled log


When rolling a log, a message is printed at the bottom of the log file before it is rolled. The 
message is similar to the following example:


MAIN-N-Closing this log file at March 19, 2009 9:48:19 PM EDT; 
continuing in


<BASEDIR>/local/logs/MYDM_en_US_UTF-8.log


Starting a new log file
You can request that a Manager or adapter create a new log file, often referred to as rolling 
over a log file. Typically, this is done when a log file becomes quite large. Log files grow 
indefinitely, though slowly, under normal conditions.


Most log files are small and rolling over a log file is not necessary. However, if you need to 
start a new log file, use the following methods:


◆ For UNIX systems only, use the kill or roll_log commands.


◆ For Windows systems, use the roll_log command.


You can repeat the log file roll-over process as many times as you like. If you need to retain 
log files beyond the limit specified by the SM_BACKUP_FILE_LIMIT environment variable, 
copy or at least rename the .log.bak files as soon as they are created.


Log rolling is managed in a synchronized fashion so that data in multiple logs can be 
correlated.   Thus, when the English log rolls, the non-English log, if it is being produced, 
will also roll. 


The kill command method for UNIX systems
On UNIX systems only, it is possible to request that a Manager or an adapter process “roll 
over” its log files. You do this by sending a SIGUSR1 signal to the process ID writing the log 
file. Use the kill command of your shell:


kill -USR1 <pid>


Upon receipt of the USR1 signal, a Manager or adapter process first writes an 
informational message to the end of the current log file, repeats the steps it executed at 
startup, and creates a new log file and a backup log file. All subsequent logging 
information is recorded to the new file.


To determine the process number <pid>, you can use the brcontrol utility or for an adapter, 
use the system’s ps command. 
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The roll_log command method
The roll_log command is invoked through the dmctl utility, which requires that you attach 
to a Manager or adapter with administrative privileges. The syntax of the command is:


exec roll_log [<file-name>]


The <file-name> option enables you to specify a new name for current and subsequent log 
files. If you omit this option, the current naming convention is retained. If you specify a 
name, the new log file uses that name. Any new log files created with roll_log will also use 
this name if a different name is not specified. The new name specified by <file-name> is 
handled in exactly the same manner as the --output option of the sm_server command.


On UNIX, for example, to start a new log file for a Manager named MYDM, enter:


BASEDIR/smarts/bin/dmctl -s MYDM exec roll_log


On Windows, the equivalent command is:


BASEDIR\smarts\bin\dmctl -s MYDM exec roll_log


When roll_log is invoked, the Manager or adapter does the following:


1. Writes an informational message to the end of the current log files.


2. Repeats the steps it executed at startup.


3. Creates a new log file and a backup log file for each log file that was currently running.


All subsequent logging information is recorded to the new files.
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Controlling the number of saved log files
EMC Smarts software can retain up to 999 rolled over log files for each log that is being 
generated. For example, if you are generating two log files, MYDM_en_US_UTF-8.log and 
MYDM_fr_UTF-8.log file, you can maintain up to 999 backup log files for the 
MYDM_en_US_UTF-8.log and 999 backup log files for the MYDM_fr_UTF-8.log.


The number of log files retained is determined by the value of SM_BACKUP_FILE_LIMIT. 
When a Manager starts up, it renames a file that matches its log filename, adding a .bak to 
the name. If there is an existing .bak file, the .bak will be replaced with .NNN.


For example, if the SM_BACKUP_FILE_LIMIT environment variable is set to 5, the process is 
as follows:


1. A log file is created and it is named MYDM_en_US_UTF-8.log.


2. The MYDM_en_US_UTF-8.log file created in step 1 is rolled over:


• The MYDM_en_US_UTF-8.log file created in step 1 is renamed to 
MYDM_en_US_UTF-8.log.bak.


• A new MYDM_en_US_UTF-8.log file is created.


3. The MYDM_en_US_UTF-8.log file created in step 2 is rolled over:


• The MYDM_en_US_UTF-8.log.bak file renamed in step 2 is now renamed to 
MYDM_en_US_UTF-8.log.001.


• The MYDM_en_US_UTF-8.log file created in step 2  is renamed to 
MYDM_en_US_UTF-8.log.bak.


• A new MYDM_en_US_UTF-8.log file is created.


4. The MYDM_en_US_UTF-8.log file created in step 3  is rolled over:


• The MYDM_en_US_UTF-8.log.bak file renamed in step 3  is renamed to 
MYDM_en_US_UTF-8.log.002.


• The MYDM_en_US_UTF-8.log file created in step 3  is renamed to 
MYDM_en_US_UTF-8.log.bak.


• A new MYDM_en_US_UTF-8.log file is created.


5. The MYDM_en_US_UTF-8.log file created in step 4  is rolled over:


• The MYDM_en_US_UTF-8.log.bak file renamed in step 3  is renamed to 
MYDM_en_US_UTF-8.log.003.


• The MYDM_en_US_UTF-8.log file created in step 4 is renamed to 
MYDM_en_US_UTF-8.log.bak.


• A new MYDM_en_US_UTF-8.log file is created.


6. Because the limit of MYDM_en_US_UTF-8.log.NNN files that are retained is set to 3, 
when the MYDM_en_US_UTF-8.log file created in step 5  is rolled over:


• The oldest log file, MYDM_en_US_UTF-8.log.001 from step 3 , is deleted.
• The MYDM_en_US_UTF-8.log.bak file renamed in step 5  is renamed 


MYDM_en_US_UTF-8.log.004.
• The MYDM_en_US_UTF-8.log file created in step 5  is renamed 


MYDM_en_US_UTF-8.log.bak.
• A new MYDM_en_US_UTF-8.log is created.
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Environment Variables


This appendix describes the environment variables that are used by EMC Smarts 
Foundation software. It consists of the following sections:


◆ How variable values are interpreted ......................................................................  146
◆ Methods for setting environment variables............................................................  147
◆ Environment variables for users ............................................................................  149
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How variable values are interpreted
This section describes how the software interprets the value of an environment variable. If 
a variable, such as SM_BROKER_DEFAULT, requires that its value be formatted in a 
particular manner, it is noted in the description of the variable.


How integer variables are interpreted


When the value of an environment variable is to be expressed as an integer, the software 
interprets the value of the variable as follows:


◆ Any leading white space is skipped. If the next character is a plus sign (+) or a minus 
sign (-), it is also skipped. If the next character was a minus sign, the final numeric 
value is negated.


◆ If the value starts with a number other than zero, it may contain only the digits zero 
through nine, and it is considered a decimal number.


◆ If the value starts with “0x” or “0X”, it may contain the digits zero through nine, as 
well as the letters “a” through “f” and “A” through “F”. At least one digit or letter must 
follow the “x” or “X”. The value is treated as a hexadecimal number.


◆ If the value starts with a zero and is not followed by a “x” or “X”, it may contain only 
the digits zero through seven, and it is treated as an octal number.


Otherwise, the variable does not represent a numeric value. In most cases, an error 
message is printed. In a few cases, the numeric value is simply taken to be zero.


Table 28 on page 146 provides examples of numeric values and how they are interpreted 
by the software. 


Table 28  Examples of numeric values


Numeric value Meaning


"0" The value zero.


" 10" The value ten. The leading white space is ignored.


"+010" The value eight, octal.


"0x10" The value sixteen, hexadecimal.


"-123" The value negative one hundred twenty-three.


"abc" An illegal value, may be treated as zero.


"019" An illegal value, leading zero makes it octal, but octal numbers cannot 
contain a nine. This value may be treated as zero.


"1 " An illegal value, leading white space is ignored but trailing white space is 
not. This value may be treated as zero.


"0X" An illegal value, at least one digit or letter must follow the “OX”. This 
value may be treated as zero.


"- 23" An illegal value, embedded white space is not permitted. This value may 
be treated as zero.
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How Boolean variables are interpreted


When an environment variable is expressed as a Boolean, the software interprets the 
value of the variable, when set, as follows:


◆ If the value starts with a letter, an uppercase “T” or a lowercase “t” or an uppercase 
“Y” or a lowercase “y”, the variable is interpreted as true. If the value starts with any 
other letter, the variable is interpreted as false.


◆ If the value can be interpreted as an integer variable, and it has a value of zero, the 
variable is interpreted as false. If the value is anything other than zero, the variable is 
interpreted as true.


◆ For any other value, the variable is interpreted as false.


Methods for setting environment variables
You can use one of the following methods to set an environment variable. The difference 
between these methods is that one sets the environment variable across an EMC Smarts 
product and the other sets the environment variable for a particular program.


Setting an environment variable product-wide


When necessary, you can set an environment variable so that a product installed in that 
location can use it. For example, the SM_BROKER_DEFAULT variable, the value of which is 
set during installation, is used in this manner.


To set an environment variable so that it can be used by the programs of a product, add it 
to the runcmd_env.sh file, which is located in the BASEDIR/smarts/local/conf directory of 
that product.


Here is an example procedure for adding the SM_AUTHORITY environment variable to the 
runcmd_env.sh file:


1. Go to the BASEDIR/smarts/bin directory and enter the following command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


2. Use the following syntax to add the SM_AUTHORITY variable and its value:


SM_AUTHORITY=”<STD>”


3. Save and close the file.


The modified version of the runcmd_env.sh file is saved to the 
BASEDIR/smarts/local/conf directory.


At this point, any EMC Smarts program that is started from this installation directory 
will use the applicable environment variables that are specified in the runcmd_env.sh 
file.


4. EMC Smarts programs that were previously launched from this installation directory 
need to be restarted for any new environment variable to take effect. Chapter 5, 
“Controlling Startup,” describes how to start services.
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Setting an environment variable for a program


You can also set an environment variable so that it only affects a particular program. 
Typically, this is done by adding the environment variable to the program’s sm_service 
command line. For example, if you want a Manager to use a particular serverConnect.conf 
file, you would specify the SM_SERVERCONNECT variable in the sm_service command line 
for that program.


The following example sets the value of the SM_SERVERCONNECT environment variable to 
point to the server_Connect_IP.conf file.


1. Use the sm_service show action with the --cmdline option to display the existing 
command line for the program. You must have administrative privileges when typing 
this command.


BASEDIR/smarts/bin/sm_service show --cmdline ic-am-server


Output:


BASEDIR/smarts/bin/sm_service install 
--name=ic-am-server 
--description=“EMC Smarts IP Availability Manager” 
--startmode=runonce 
BASEDIR/smarts/bin/sm_server 
--name=INCHARGE-AM 
--config=icf 
--bootstrap=bootstrap-am.conf 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


2. Use the sm_service install action with the --force option to add the environment 
variable to the command line. The --env option specifies the environment variable.


BASEDIR/smarts/bin/sm_service install 
--force 
--name=ic-am-server 
--description=“EMC Smarts IP Availability Manager” 
--startmode=runonce 
--env=SM_SERVERCONNECT=BASEDIR/smarts/conf/serverConnect_IP.conf 
BASEDIR/smarts/bin/sm_server 
--name=INCHARGE-AM 
--config=icf 
--bootstrap=bootstrap-am.conf 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


3. Do one of the following:


◆ Start the program.


◆ Stop and restart the program.
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Environment variables for users
The following list of environment variables can be applied to the software.


◆ “SM_DISPLAY”


◆ “SM_EDITOR”


◆ “SM_SNMP_BUG_COMPATIBLE”


◆ “SM_ENABLE_ESM_EVENT_MAPPING”


◆ “SM_ENABLE_SNMP_SET”


◆ “SM_MAIN_OPTIONS”


◆ “SM_OUTGOING_PROTOCOL”


◆ “SM_INCOMING_PROTOCOL”


◆ “SM_FIPS140”


◆ “SM_DISABLE_KEEPALIVES”


◆ “SM_IP_VERSIONS”


◆ “SM_MAX_MONITORING_THREADS”


◆ “SM_AUDIT_CLIENT_ACTIONS”


◆ “SM_AUDIT_ALL_CONNECTIONS”


◆ “SM_NO_LINE_FOLD”


◆ “SM_FOLD_WIDTH”


◆ “SM_HOSTSFILE”


◆ “SM_MAX_SESSION_VERSION”


◆ “SM_MIN_PKTSIZE_COMPRESS”


◆ “SM_SNMP_ALLOW_DUP_ENGINEID”


◆ “SM_SNMP_MAX_MESSAGE_SIZE”


◆ “SM_ASL_MAX_STACK_DEPTH”


◆ “SM_REGISTER_ADDR”


◆ “MALLOC_ARENA_MAX_”


◆ “SM_LOCALE”


◆ “SM_ENCODING_*”


◆ “SM_JAVA_PACKAGE_ROOT”


◆ “SM_JDK_HOME”


◆ “SM_JAVA”


◆ “SM_JAVAHOME”
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◆ “SM_BROKER_DEFAULT”


◆ “SM_BROKER”


◆ “SM_BROKER_NTHREADS”


◆ “LM_LICENSE_FILE”


◆ “SM_LICENSE”


◆ “SM_LMGRD_LICENSE_FILE”


◆ “SM_LMGRD92_LICENSE_FILE”


◆ “SM_AUTHORITY”


◆ “SM_KEYFILE”


◆ “SM_CLIENTCONNECT”


◆ “SM_OKLOGIN_LOGLEVEL”


◆ “SM_SERVERCONNECT”


◆ “SM_DATETIME_FORMAT”


◆ “TZ”


◆ “LC_TIME”


◆ “SM_LOG_ROLL_SIZE”


◆ “SM_BACKUP_FILE_LIMIT”


◆ “SM_LOG_NAME_CUSTOM”


◆ “SM_LOGFILES”


◆ “SM_WRITEABLE”


◆ “SM_RULESET_PATH”


◆ “SM_COUNT_REPOS_LOCKS”


◆ “SM_REPOS_LOCKS_LIMIT”


◆ “SM_SUBSCRIPTION_TRACE”


◆ “SM_IGNORE_DYNMODEL_ERRORS”


SM_SITEMOD


The SM_SITEMOD variable provides a directory search list that Smarts software uses to 
locate files. This list is used to find files that users can, and in some cases must, modify to 
use Smarts at their site. Such files include configuration files, ASL files, and scripts. For 
locating a file, the directories listed in SM_SITEMOD are searched in the same order as 
they are specified. The components of the list are separated by colons (:) on UNIX and 
semicolons (;) on Windows.


The default value of SM_SITEMOD is <smarts>/local:<smarts>. For specifying a new search 
directory, one only has to set SM_SITEMOD to the new directory. The "runcmd" wrapper 
program that is used to launch all Smarts executables, internally constructs the actual 
search path, by appending the known search paths to the user specified path.
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It is strongly recommended that SM_SITEMOD be only specified in the service installation 
command line. Setting SM_SITEMOD in runcmd_env.sh is not recommended, as it 
sometimes causes the internally constructed search path to get overridden, which may 
cause certain components to not work correctly.


The Console does not currently support SM_SITEMOD.


SM_DISPLAY


This environment variable specifies the location of a client’s X Window System display 
(typically for a console user). Output from a server tool that uses the X protocol is directed 
to the display specified by SM_DISPLAY. Only EMC Smarts Service Assurance Manager 
uses this variable.


SM_EDITOR


This environment variables enables you to set the text editor that is invoked by the 
sm_edit utility. When SM_EDITOR is not defined, the sm_edit utility uses the value of one 
of the following system environment variables: VISUAL then EDITOR. If these environment 
variables are not defined, the sm_edit utility uses the following editors:


◆ Edit editor on UNIX systems


◆ WordPad editor on Windows systems


SM_SNMP_BUG_COMPATIBLE


Implementation of the SNMP protocol is strict in that the software only sends or receives 
SNMP messages that conform to the SNMP standard. By default, the software only accepts 
conforming SNMP messages. Unfortunately, not all SNMP implementations are as strict. 
The result is that EMC Smarts programs may receive nonconforming SNMP messages. 


In some cases, the software can successfully interpret and handle nonconforming 
messages. If you set the SM_SNMP_BUG_COMPATIBLE environment variable, the software 
will accept the nonconforming SNMP messages in two cases:


◆ When the type of an SNMP variable is not the required type but the value can be 
unambiguously interpreted as the required type. An example is when a TimeTicks 
variable type is sent as an Unsigned32 or non-negative Integer32 variable.


◆ When the type of an SNMP variable is inconsistent with the version of the SNMP 
protocol that delivers the message. An example is when a Counter64 variable is sent 
in a version 1 (v1) SNMP message.


When the SM_SNMP_BUG_COMPATIBLE environment variable is set, any invalid SNMP 
message that is accepted by the software is logged at a warning level to pinpoint the 
source of the invalid SNMP message and to determine the reason why it is invalid.


SM_SNMP_BUG_COMPATIBLE is a Boolean.
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SM_ENABLE_ESM_EVENT_MAPPING


This environment variable is set to TRUE by default in the runcmd_env.sh file. It is 
applicable only to Service Assurance Manager and Adapter Platform (OI Server) 
installations.


This variable ensures that the Audit History is preserved post upgrade for active 
VMwareESX and vNIC notifications. In case some ESX or Virtual Interface instances remain 
in the alert state before and post upgrade, Server Manager will notify them as alerts for 
Hypervisor and VirtualInterface instances. Service Assurance Manager will map them to 
VMwareESX and vNIC if they were active before the upgrade. After the problem clears, the 
notifications will be archived. This allows you to keep a complete history of the problem 
and the user actions performed on the notification. Post archival, new outages are 
displayed under the new class name.


SM_ENABLE_SNMP_SET


This environment variable is disabled by default.


◆ When set to 1, it enables the use of the SM_SNMP_Actions::Set( ) method.


◆ When it is disabled (set to 0), the method cannot be used to set the value of an OID


SM_MAIN_OPTIONS


The environment variable SM_MAIN_OPTIONS enables you to set default values for the 
standard options supported by the software, as described in Table 29 on page 153. You 
can override the values specified by SM_MAIN_OPTIONS by providing alternative values 
on the command line.


For example, if you set SM_MAIN_OPTIONS to --errlevel=fatal, programs will record all 
errors with a level of fatal or higher.
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Table 29  Standard options supported by SM_MAIN_OPTIONS (page 1 of 2)


Standard option Definition


--accept=<hosts> Specify a list of hosts, by name or IP address, from which programs 
accept connections. Multiple entries should be separated by 
commas. 
By default, programs accept connections from any host. Programs 
that accept connections are dmstart, sm_server, sm_adapter, and 
sm_trapd. Note that sm_adapter and sm_trapd accept only 
connections when started with the --name option.
To limit connections to the host on which the software is installed, 
specify the name or IP address of the host instead of localhost.


--daemon Run the program as a daemon (UNIX only). Messages generated 
from internal logging calls are directed to the log file. Log files are 
written to the BASEDIR/smarts/local/logs directory.


--facility=<facility> Instructs the program to log any syslog messages with the specified 
syslog facility (UNIX/Linux only). The default is Daemon.
The <facility> setting can be one of the following:
• Kern
• User 
• Mail
• Daemon
• Auth
• Lpr
• News
• Uucp
• Cron
• Local0
• Local1 
• Local2
• Local3
• Local4
• Local5
• Local6
• Local7


--errlevel=<level> Specify the minimum level at which error events are written to the 
standard error output. Possible values include: none, emergency, 
alert, fatal, critical, error, warning, notice, informational, debug. The 
default is warning. (Note that fatal is equivalent to emergency, alert, 
or critical.)


--loglevel=<level> Specify the minimum level at which event messages are written to 
the system logging facility. Possible values include: none, 
emergency, alert, fatal, critical, error, warning, notice, informational, 
debug. The default is error. (Note that fatal is equivalent to 
emergency, alert, or critical.)
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SM_OUTGOING_PROTOCOL


This environment variable controls the kinds of connections that a program that is acting 
as a client is allowed to initiate, when not using FIPS 140 mode. It can contain one or more 
numbers. These numbers specify the security level at which communications can occur. If 
more than one is specified, they must be separated with commas. If the variable is not set, 
it is the same as specifying 0.


SM_INCOMING_PROTOCOL


This environment variable controls the kinds of connections that a program that is acting 
as a server is allowed to accept, when not using FIPS 140 mode. It can contain one or more 
numbers. If more than one is specified, they must be separated with commas. If the 
variable is not set, it is the same as specifying 0.


SM_FIPS140


This environment variable controls enables and disables FIPS mode:


◆ TRUE = Enable FIPS 140 mode


◆ FALSE = Disable FIPS 140 mode (default)


When FIPS 140 mode is enabled, the software uses Transport Layer Security v1.2, and the 
settings of SM_OUTGOING_PROTOCOL and SM_INCOMING_PROTOCOL are ignored.


--logname=<name> Specify the name used to identify the program in the system log. On 
UNIX systems, the default is the program name. On Windows 
systems, the default is the registered service name.


--output[=<file>] Messages generated from internal logging calls are directed to a log 
file. Log files are written to the BASEDIR/smarts/local/logs 
directory. If <file> is not specified, the value of --logname is used.
If a log file with specified name already exists, it is moved to a 
backup file, BASEDIR/smarts/local/logs/<file>.bak. If the backup file 
already exists, it is deleted.


--tracelevel=<level> Specify the minimum level at which a process stack trace is written 
to the standard error output. Possible values include: none, 
emergency, alert, fatal, critical, error, warning, notice, informational, 
debug. The default is fatal. (Note that fatal is equivalent to 
emergency, alert, or critical.)


--useif=<IP address> Specifies the IP address that the program should use as the source 
address for outgoing ICMP and SNMP packets and the destination 
address for which it accepts incoming ICMP and SNMP packets. <IP 
Address> must be a *v4* address.


--version Print the version of the program.


Table 29  Standard options supported by SM_MAIN_OPTIONS (page 2 of 2)


Standard option Definition
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SM_DISABLE_KEEPALIVES


This environment variable controls whether KeepAlive messages for the EMC Smarts 
proprietary inter-process communication (IPC) protocol are used. To disable KeepAlive 
messages, specify a nonzero number. To enable KeepAlive messages, specify a zero (0). 
KeepAlive messages are enabled by default.


The EMC Smarts proprietary IPC uses KeepAlive messages to test TCP connections 
between EMC Smarts clients and Managers. In order for a Manager to detect whether a 
client is temporarily unresponsive or has permanently dropped the TCP connection, the 
client sends a KeepAlive message as an out-of-band byte of TCP urgent data every 90 
seconds to indicate that the client is still connected. If the Manager does not receive 
periodic KeepAlive messages, it concludes that the client has dropped the connection and 
shuts down the server end of the connection.


Bear in mind that in some cases, not receiving KeepAlive messages from the client could 
be due to other software applications and hardware not supporting TCP urgent data, not 
the result of the connection being down.


Under certain circumstances, the client’s operating system might incorrectly insert the 
urgent data into the regular data stream, which corrupts the regular data stream and 
causes problems in the connection. If the urgent data byte leaks in at the point where the 
next command is expected, the leak can result in an invalid handler code and generate 
additional messages in the Manager’s log file.


In rare cases when communication issues exist, you may disable KeepAlives by specifying 
a nonzero number for the SM_DISABLE_KEEPALIVES environment variable. Because this 
workaround might cause Managers (whose clients have disconnected) to experience 
memory growth and run out of memory, work with your EMC customer support team to 
optimize your network operation environment if the problem persists.


To control KeepAlive messages for only the Global Console, specify the Java property 
com.smarts.disable_keepalives as described in the EMC Smarts Service Assurance 
Manager Operator Guide.


The SM_DISABLE_KEEPALIVES environment variable has no effect on version 9.2 and later 
connections that use Transport Layer Security. 


SM_IP_VERSIONS


The SM_IP_VERSIONS environment variable enables you to control the address family 
used for hostname resolution. It affects the following:


◆ EMC Smarts utilities that use a command line (for example, sm_snmpwalk, dmctl, 
sm_tpmgr) 


◆ Name resolution during discovery


◆ ASL scripts


◆ Ping


◆ DNS lookup
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SM_IP_VERSIONS also controls which ports a Domain Manager listens on:


◆ If SM_IP_VERSIONS is set to "v4" or "v6", a Domain Manager will only open sockets 
and listen on that address family. 


◆ If SM_IP_VERSIONS is set to "v4v6" or "v6v4", a Domain Manager will listen on both 
address families.


The SM_IP_VERSIONS setting is also dependent on the address family as follows:


◆ If you are running on a system which only supports a single address family, it is 
recommended that SM_IP_VERSIONS be set to "v4" or "v6", as appropriate. 


◆ If you are running on a system which supports both address families, set it to the 
value which best describes your administrative preferences.


The variable can be set depending on the order in which you want to do hostname 
resolution.If the variable is not set, and the address family is not explicitly provided on the 
command line (for example, frame.someDomain.emc.com:v4), the default behavior is to 
resolve the hostname as an IPv4 hostname. The variable should be set to the address 
family that is predominate for the network. 


To set this variable, add it to the runcmd_env.sh file, which is located in the 
BASEDIR/smarts/local/conf directory of the product.


The syntax of the environment variable is:


SM_IP_VERSIONS="<ip_value>"


Table 30 on page 156 lists acceptable values for the SM_IP_VERSIONS environment 
variable. 


Detailed instructions about setting environment variables and information about the 
runcmd_env.sh file is provided in the “Methods for setting environment variables” on 
page 147.


Table 30  Acceptable values for the SM_IP_VERSIONS environment variable


ip_value Description


"V4" The hostname is resolved to an IPv4 hostname (default).


"V6" The hostname is resolved to an IPv6 hostname.


"V4V6" The hostname is resolved to an IPv4 hostname. If that fails, the Domain 
Name System server tries to resolve the hostname to an IPv6 hostname.


"V6V4" The hostname is resolved to an IPv6 hostname. If that fails, the Domain 
Name System server tries to resolve the hostname to an IPv4 hostname.


Note: The acceptable value can also be lowercase ("v4", "v6", "v4v6" or "v6v4").
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SM_MAX_MONITORING_THREADS


The SM_MAX_MONITORING_THREADS environment variable represents the maximum 
number of monitoring threads that the monitoring system will use for monitoring changes. 
The default value is 3. 


The recommended values are described in Table 31 on page 157. 


SM_AUDIT_CLIENT_ACTIONS


Setting the SM_AUDIT_CLIENT_ACTIONS environment variable equal to 1 produces the log 
if the client requests it. However, even if the client requests it, auditing does not occur if it 
has not been enabled on the server with either the SM_AUDIT_CLIENT_ACTIONS variable, 
or the SM_AUDIT_ALL_CONNECTIONS environment variable, which is described in 
“SM_AUDIT_ALL_CONNECTIONS” on page 157.


SM_AUDIT_ALL_CONNECTIONS


Setting the SM_AUDIT_ALL_CONNECTIONS environment variable equal to 1 forces the 
logging even if the client does not request it. If you set SM_AUDIT_ALL_CONNECTIONS 
equal to 1, then you do not have to set SM_AUDIT_CLIENT_ACTIONS, described in 
“SM_AUDIT_CLIENT_ACTIONS” on page 157.


If you set SM_AUDIT_ALL_CONNECTIONS, you do not need to modify the client. However, if 
you suspect a specific client you might still want to use the by-request-only access 
provided by SM_AUDIT_CLIENT_ACTIONS to reduce the amount of logging coming from 
other sources.


SM_NO_LINE_FOLD


The environment variable SM_NO_LINE_FOLD can be set to prevent the line wrapping in 
log files. Add the following lines to the BASEDIR/local/conf/runcmd_env.sh file: 


export SM_NO_LINE_FOLD
SM_NO_LINE_FOLD="TRUE"


You can use any string value for SM_NO_LINE_FOLD, it is only if it has no string associated 
with it that lines fold.


SM_FOLD_WIDTH


The SM_FOLD_WIDTH environment variable removes the default line wrapping of 
exception messages in the log file. The lines will only wrap if SM_FOLD_WIDTH=X where X 
specifies the column at which to fold the lines. 


Table 31  Recommended values for SM_MAX_MONITORING_THREADS


Platform Recommended value


Windows 2003
Windows 2008


1


All other supported platforms Up to 3, but no more than the number of CPUs on the machine.
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SM_HOSTSFILE


On 32-bit Solaris builds of the software, a bug in the Solaris system libraries prevents 
/etc/hosts from being read properly if more than 256 file descriptors are in use. If you set 
SM_HOSTSFILE=1 in the environment, then /etc/hosts is read using application code, 
bypassing the system libraries as a work-around to this problem.


This work-around only handles IPv4 addresses in /etc/hosts. The work-around does not 
work for IPv6 addresses, and will not read /etc/ipnodes (or /etc/inet/ipnodes). IPv6 
addresses obtained from DNS are handled properly in all cases. If it is necessary to obtain 
IPv6 addresses from /etc/ipnodes, you should use the 64-bit version of the product.


SM_HOSTSFILE is only available on Solaris versions of the software. It operates in both 32 
and 64-bit builds, but since the 64-bit system libraries work properly, it is recommended 
that it not be set on 64 bit builds.


SM_MAX_SESSION_VERSION


SM_MAX_SESSION_VERSION is an environment variable that controls the maximum 
version of the protocol session that is negotiated by the peer. The valid levels are 
described inTable 32 on page 158,  


Encryption negotiation also uses SM_INCOMING_PROTOCOL and 
SM_OUTGOING_PROTOCOL to determine exactly the level that is negotiated.


If the previous behavior of out-of-band (OOB) KeepAlives is required, set this variable to 2.


SM_MIN_PKTSIZE_COMPRESS


The SM_MIN_PKTSIZE_COMPRESS environment variable enables compression for flow 
frames >= <size>. By default, compression is disabled.


◆ If unset or equal to 0, SM_MIN_PKTSIZE_COMPRESS enables compression with a 
reasonable default size.


◆ To disable compression, set SM_MIN_PKTSIZE_COMPRESS to a large value (>65536).


Table 32  Valid levels for SM_MAX_SESSION_VERSION


Level Description


0 Legacy. No KeepAlives. No encryption


1 Encryption. No KeepAlives.


2 Encryption and KeepAlives. This level is the default value.


3 Encryption and Inband KeepAlives. Also supports compression.
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SM_SNMP_ALLOW_DUP_ENGINEID


The SNMP V3 component will not interact with two devices with the same engine Id in the 
managed domain in accordance to RFC 2574 (User-based Security Model (USM) for 
version 3 of the Simple Network Management Protocol (SNMPv3) ), namely section 2.2: 
2.2. Replay Protection. Each SNMP engine maintains three objects: snmpEngineID, which 
(at least within an administrative domain) uniquely and unambiguously identifies an 
SNMP engine.


When the environment variable SM_SNMP_ALLOW_DUP_ENGINEID is set, the SNMP Lcd 
will index the specific engine data by ip:port instead of engineId thus allowing interaction 
with networks not conforming with section 2.2 of RFC2574. The recommended way of 
enabling this feature is to add SM_SNMP_ALLOW_DUP_ENGINEID=1 in the 
local/conf/runcmd_env.sh.


SM_SNMP_MAX_MESSAGE_SIZE


SM_SNMP_MAX_MESSAGE_SIZE is an environment variable that controls the maximum 
size of the SNMP datagram that is processed. The default value is 8k (8192 bytes).


The default size can be overridden by setting the environment variable 
SM_SNMP_MAX_MESSAGE_SIZE to the required maximum size. For example, setting 
SM_SNMP_MAX_MESSAGE_SIZE equal to 16384 sets the maximum to 16k, which is 
double the default value.


If you try to set SM_SNMP_MAX_MESSAGE_SIZE to less than 1472 (the recommended 
minimum for UDP/IPv4 per RFC-3417, section 3.2), it will be silently adjusted to be exactly 
1472.


Although SM_SNMP_MAX_MESSAGE_SIZE can be used to set the maximum SNMP 
datagram size to less than the default 8k, this is strongly discouraged.


If you try to set SM_SNMP_MAX_MESSAGE_SIZE greater than 64k (65536 bytes), it will be 
set to exactly 65536. A value of 65536 bytes is the largest possible datagram size 
supported by UDP. 


Setting SM_SNMP_MAX_MESSAGE_SIZE to large values will increase server memory 
usage. This is especially true for trap processing during periods of high trap reception rate. 
Therefore, this option should only be used when it is needed to communicate with SNMP 
devices sending unusually large datagrams. Only increase the setting of this environment 
variable on the specific Domain Managers which manage those devices. 
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SM_ASL_MAX_STACK_DEPTH


In order to avoid a recursive ASL script to crash the server, a limit of 700 calls has been 
placed on the recursion of ASL scripts. When this happens a message is logged similar to:


ASL-W-ERROR_PARSE-While parsing rule 'START'
 ASL-PARSER_STACK_OVERFLOW-ASL engine has exceeded the stack limit of 


700 during execution  
 ASL-CALL_STACK_HEADING-Generating execution trace of RuleSet: 


/emc/ferren/DEV/p-dmt90rel/smarts/ga/linux_rhAS40-x86-64/debug/tasl
stackoverflow.asl


  ASL-CALL_STACK_RULE-   RuleName: R1, Line: 19
  ASL-CALL_STACK_RULE-   RuleName: R1, Line: 19
  ASL-CALL_STACK_RULE-   RuleName: R1, Line: 19


If you have a valid (non-recursive) case where the stack depth of ASL needs to be over 
700, the limit can be changed by setting the environment variable 
SM_ASL_MAX_STACK_DEPTH.


If the value is too high, process stack overflow can occur resulting in server crash.


SM_REGISTER_ADDR


When a server is running on a machine which has more than one IPv4 and/or more than 
one IPv6 address, it selects one address from each protocol family to register with the 
Broker. The selection of which address is arbitrary. The selection algorithm is not 
documented and subject to change.


On a fully-connected network, the arbitrary selection is usually satisfactory, but there may 
be situations where it is required to force a specific address to be registered. This can be 
accomplished by setting the environment variable SM_REGISTER_ADDR. The value can be 
an IPv4 address literal, an IPv6 address literal, or one of each, delimited by a comma.


If you specify an address for one protocol family, the other one will revert to using the 
original arbitrary selection algorithm.


There is no checking to verify that the specified address is configured or reachable. 
Specifying an incorrect value can result in a non-functional server. It is recommended that 
this option only be used in specific situations where the default behavior is unacceptable.


An IPv4 example:


SM_REGISTER_ADDR=10.5.24.105


An IPv6 example:


SM_REGISTER_ADDR=fe80::218:8bff:fe48:50b1


Both v4 and v6. The order is not important:


SM_REGISTER_ADDR=fe80::218:8bff:fe48:50b1,10.5.24.105
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MALLOC_ARENA_MAX_


The MALLOC_ARENA_MAX_ environment variable controls the maximum number of arenas 
that can be created for a process using the ptmalloc library. An arena is a data structure 
used by ptmalloc for maintaining reuse of free memory.


When the ptmalloc library is loaded and initialized it determines whether the 
MALLOC_ARENA_MAX_ environment variable has been defined in the environment 
variable set:


◆ When the MALLOC_ARENA_MAX_ is not defined in the environment variable set, there 
is no maximum number of arenas. This is the default.


◆ If MALLOC_ARENA_MAX_ is set to any positive integer, then that number defines the 
number of arenas.


Variables that control the locale and encoding


These variables specify the local and encoding used by the programs.


SM_LOCALE


The SM_LOCALE environment variable specifies the appropriate language and region in 
which you want to see output. In general, SM_LOCALE must be specified consistently with 
advice in IETF RFC 1766/3066. If you do not specify a value for SM_LOCALE, it defaults to 
en_US.


ICU allows for some flexibility on the case (upper and lower) of the language and country 
codes and for the separator character used to join the two. 


EMC Smarts software will convert the value specified in SM_LOCALE to a normalized form 
that can be recognized by all ICU library functions which take a locale argument. The 
normalization (done by calling the ICU function, uloc_canonicalize) enables ICU library 
functions to perform predictably.


export SM_LOCALE=ja_JP
sm_server –-name=Tokyo


SM_ENCODING_* 


There are four SM_ENCODING_* environmental variables that can be set. 


◆ SM_ENCODING_SHELL indicates the encoding used by the shell, primarily useful for 
specifying what encoding is used for command line arguments.


◆ SM_ENCODING_SYSTEM indicates the encoding used for internal interaction with the 
operating system. 


• Primarily dictates the encoding used for file system access. 


• Secondarily indicates the encoding used when internally accessing the 
environment.


◆ SM_ENCODING_INPUT indicates the encoding used by stdin.


◆ SM_ENCODING_OUTPUT indicates the encoding used by stdout and stderr.
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Tuning the SM_ENCODING_INPUT and SM_ENCODING_OUTPUT values is primarily useful if 
you are redirecting or piping text somewhere other than the shell.


The behaviors of these variables is different on Windows and UNIX.


On Windows the behavior is:


◆ If SM_ENCODING_SHELL is not set, then its value will default to the current Windows 
"Active Code Page."


◆ SM_ENCODING_SYSTEM will always be ignored since there is only one valid possible 
value, and it is set internally.


◆ If SM_ENCODING_INPUT is not set, then its value will default to the current Windows 
"OEM Code Page."


◆ If SM_ENCODING_OUTPUT is not set, then its value will mirror SM_ENCODING_INPUT.


Separate values are necessary due to the way the Windows command shell (cmd.exe) 
behaves.


On UNIX the behavior is:


◆ If SM_ENCODING_SHELL is not set, then its value will default to "UTF-8."


◆ If SM_ENCODING_SYSTEM is not set, then its value will mirror SM_ENCODING_SHELL.


◆ If SM_ENCODING_INPUT is not set, then its value will mirror SM_ENCODING_SHELL.


◆ If SM_ENCODING_OUTPUT is not set, then its value will mirror SM_ENCODING_INPUT.


In UNIX it generally makes sense to set all four values identically.


The following example sets the encoding to Shift_JIS.


export SM_ENCODING_INPUT=Shift_JIS
export SM_ENCODING_OUTPUT=Shift_JIS
export SM_ENCODING_SHELL=SHIFT_JIS
export SM_ENCODING_SYSTEM=Shift_JIS
sm_server –-name=Osaka
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Variables that control Java settings


These variables specify the Java settings.


SM_JAVA_PACKAGE_ROOT


The SM_JAVA_PACKAGE_ROOT environment variable can be used to specify the java 
package root.


SM_JDK_HOME


The SM_JDK_HOME environment variable is used to indicate the location of the JDK, if 
present. If you provide the location of the JDK while running the appropriate setup script, 
the SM_JDK_HOME variable will be defined in the runcmd_env.sh file.


If you are using a 64-bit version of the software, then you should set SM_JDK_HOME to the 
location of a 64-bit version of the JDK. Likewise, if you are using a 32-bit version of the 
software, then you should set SM_JDK_HOME to indicate the location of a 32-bit version of 
the JDK.


SM_JAVA


The SM_JAVA environment variable specifies a Java Runtime Environment (JRE) other than 
that in BASEDIR/smarts/jre. The contents are the paths to the libraries of the JRE. On UNIX, 
the value of SM_JAVA is added to the LD_LIBRARY_PATH (Solaris and Linux). On Windows, 
the value of SM_JAVA is added to the PATH.


This variable is optional. If left unset, runcmd_env.sh will assume standard paths relative 
to the value of SM_JAVAHOME.


SM_JAVAHOME


The SM_JAVAHOME environment variable is used in conjunction with SM_JAVA to specify a 
non-standard JRE. It specifies the location of the JRE, and defines the value of the JVM's 
"java.home" system property.


◆ If SM_JAVAHOME is left unset and SM_JDK_HOME was specified, then SM_JAVAHOME 
will effectively be set to SM_JDK_HOME/jre. 


◆ If left unset and SM_JDK_HOME is also unset, and if the BASEDIR/jre directory exists, 
then SM_JAVAHOME will effectively be set to BASEDIR/jre.
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Variables that control the Broker


These variables control the location of the Broker.


SM_BROKER_DEFAULT


This environment variable specifies the default location of the Broker. When you install 
the software, you are prompted for the host location of the Broker and its port number. 
The Broker’s location can be specified in any one of the following formats: “host:port”, 
“host” or “:port”. When the host or port values are omitted, the default value is used. The 
default host value is “smarts-broker” or “localhost”. The default port value is 426. If the 
location of the Broker changes, you must edit the runcmd_env.sh file on all systems where 
EMC Smarts Foundation software is installed. In addition, you may have to edit the Broker 
startup script.


The software follows these steps to determine the Broker’s location:


1. Verifies whether the Broker’s location was specified as an option at startup. When this 
option is specified, no other options are checked.


2. It checks the value of the SM_BROKER_DEFAULT environment variable. If this variable 
is set, no other options are checked.


3. It checks if the Broker is running on the host smarts-broker and listening on TCP port 
426.


4. If smarts-broker is not defined, the program checks port 426 on localhost.


The hostname smarts-broker is usually an alias, such as a DNS CNAME.


SM_BROKER


This environment variable should only be set in special cases when you want to override 
the default Broker. For example, if you have to temporarily move your Broker in an 
emergency or test situation, you could set this variable.


Under normal circumstances, you should use the SM_BROKER_DEFAULT environment 
variable to set the default location of the Broker.


SM_BROKER_NTHREADS


This environment variable determines the maximum number of threads that the Broker 
can use. Valid values are 20 through 128, with a default value of 20.


If a user sets SM_BROKER_NTHREADS to an invalid string or a value less than 20, the value 
is set to 20 (default). If a user sets the variable to a value greater than 128, the value is set 
to 128.
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Variables that control FlexNet Publisher licensing


These variables control the FlexNet Publisher licensing.


LM_LICENSE_FILE


The LM_LICENSE_FILE environment variable is used by the FlexNet Publisher license 
software. This variable specifies the location of the license files or the license servers 
(port@host). In many cases, this variable has already been set for another software 
product that also uses the FlexNet Publisher license software.


The user does not have to set this environment variable; instead, use SM_LICENSE. The 
"runcmd" wrapper program that is used to launch all Smarts executables internally sets 
LM_LICENSE_FILE based on SM_LICENSE_FILE.


SM_LICENSE


The value of the SM_LICENSE environment variable is either the full pathname to the 
license file itself, or it is port@host which means that there is a license server running at 
that port on that host.


SM_LMGRD_LICENSE_FILE


Similar to LM_LICENSE_FILE, this FlexNet Publisher variable is the vendor-specific 
environment variable that specifies the location of the license files or the license servers. 
When both LM_LICENSE_FILE and SM_LMGRD_LICENSE_FILE are set, the 
SM_LMGRD_LICENSE_FILE environment variable takes precedence.


The FlexNet Publisher License Administration Guide provides additional information about 
the LM_LICENSE_FILE and SM_LMGRD_LICENSE_FILE environment variables. The FlexNet 
Publisher License Administration Guide is automatically installed with the EMC Smarts 
documentation into the BASEDIR/smarts/doc/pdf directory. The name of the file is 
fnp_licAdmin.pdf. 


SM_LMGRD92_LICENSE_FILE


Similar to LM_LICENSE_FILE, this FlexNet Publisher variable is the vendor-specific 
environment variable that specifies the location of the license files or the license servers. 
When both LM_LICENSE_FILE and SM_LMGRD_LICENSE_FILE are set, the 
SM_LMGRD_LICENSE_FILE environment variable takes precedence.


The FlexNet Publisher License Administration Guide provides additional information about 
the LM_LICENSE_FILE and SM_LMGRD_LICENSE_FILE environment variables. The FlexNet 
Publisher License Administration Guide is automatically installed with the EMC Smarts 
documentation into the BASEDIR/smarts/doc/pdf directory. The name of the file is 
fnp_licAdmin.pdf. 


The user does not have to set this environment variable. The FlexNet licensing software 
automatically derives a value for this based on the LM_LICENSE_FILE variable.


Variables that control security


These variables specify the security used by EMC Smarts programs.
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SM_AUTHORITY


This environment variable determines the selection of the authority programs used by the 
software for different parts of the authentication process. For example:


SM_AUTHORITY=IDENTIFY=<program1>,AUTHENTICATE=<program2>


where:


◆ <program1> is the program granting credentials


◆ <program2> is the program validating credentials. 


Program1 and program2 may refer to the same program.


◆ SM_AUTHORITY=<STD> means:


SM_AUTHORITY=IDENTIFY=sm_authority,AUTHENTICATE=sm_authority


◆ SM_AUTHORITY=<NONE> means:


SM_AUTHORITY=IDENTIFY=sm_authnone,AUTHENTICATE=sm_authnone


◆ SM_AUTHORITY=someAuthority means:


SM_AUTHORITY=IDENTIFY=someAuthority,AUTHENTICATE=someAuthority


Optional arguments can be specified after the authority name. A comma may not be 
included within the program name. A comma may appear in the arguments if the 
argument is quoted.


If SM_AUTHORITY is not specified, SM_AUTHORITY=<STD> is assumed.


SM_KEYFILE


This environment variable specifies the location of the imk.dat file. By default, this 
variable refers to BASEDIR/smarts/local/conf/imk.dat.


SM_CLIENTCONNECT


This environment variable enables you to specify an alternate location for the 
clientConnect.conf client-side authorization file. You must specify the full path, including 
the filename. The default location is the BASEDIR/smarts/local/conf/clientConnect.conf 
directory.


SM_OKLOGIN_LOGLEVEL


This environment variable enables the logging of successful logins at ERROR severity, 
rather than NOTICE.


SM_OKLOGIN_LOGLEVEL is a Boolean.
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SM_SERVERCONNECT


This environment variable enables you to specify an alternate location for the 
serverConnect.conf server-side authorization file. You must specify the full path, including 
the filename. The default location is the BASEDIR/smarts/local/conf/serverConnect.conf 
directory.


Variables that control date and time formatting


Managers and adapters format dates and times for printing in log files, archive files, and 
various messages. You can control many aspects of this formatting with the following 
variables.


Most dates and times displayed in consoles are formatted by the consoles themselves 
and are not controlled by these variables.


Additional information can be found on many systems, such as:


◆ man pages on UNIX systems


◆ Microsoft Developer Network (MSDN) on Windows systems


If these are not available on your system, various sites on the Web publish this 
information.


SM_DATETIME_FORMAT


The SM_DATETIME_FORMAT environment variable determines the format of timestamps in 
server log files. The SM_DATETIME_FORMAT environment variable can be set to several 
different values. The default is SI_DAT_LONG.


The following examples show the output, based on the setting of SM_DATETIME_FORMAT:


SM_DATETIME_FORMAT=SI_DAT_LOCALE_NEUTRAL
  1969/12/31 20:00:42


SM_DATETIME_FORMAT=SI_DAT_SHORT
  31/12/69 20:00


SM_DATETIME_FORMAT=SI_DAT_MEDIUM
  31 déc. 1969 20:00:42


SM_DATETIME_FORMAT=SI_DAT_LONG
  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=SI_DAT_FULL
  mercredi 31 décembre 1969 20:00:42 États-Unis (New York)


SM_DATETIME_FORMAT=SI_DAT_DEFAULT
  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=
  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=SI_DAT_UTC (similar to SI_DAT_LOCALE_NEUTRAL but in 
UTC regardless of the setting of TZ)


  1970/01/01 01:00:42


SM_DATETIME_FORMAT=SI_DAT_ISO8601
  1970-01-01T01:00:42.000Z
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EMC has created a new value, SI_DAT_CUSTOM, which enables the Foundation software to 
recognize the old SM_FORMAT_* environment variables (SM_FORMAT_DATE, 
SM_FORMAT_TIME, and SM_FORMAT_DATETIME). The SM_FORMAT_* environment 
variables were deprecated in Foundation 9.0 because their date-time formats are not 
internationalization (I18N) capable.


Dropping support for the SM_FORMAT_* variables affected custom parsing scripts that 
were based on the date-time format of those variables. To enable users to continue using 
their custom parsing scripts, EMC created SI_DAT_CUSTOM.


Because the date-time formats for the SM_FORMAT_* variables are only meaningful under 
English locales, EMC recommends that you use the other date-time formats that are 
available through the SM_DATETIME_FORMAT variable.


If SM_DATETIME_FORMAT is not set to SI_DAT_CUSTOM, the old SM_FORMAT_* variables 
will not be considered by the Foundation software.


TZ


This system environment variable determines which time zone is used when formatting a 
time. As such, it controls the conversion from an internal time base to the appropriate 
local time. The syntax is TZ=NNNshh:mmDDD, where:


◆ NNN is the time zone name.


◆ s is an optional sign.


◆ hh and mm are the offset in hours and minutes from GMT. Positive offsets represent 
time zones behind GMT, negative offsets represent those ahead of GMT.


◆ DDD is the corresponding name of Daylight Savings time when it is in effect.


For example, in the eastern United States, TZ is set to EST5EDT - eastern standard 
time/eastern daylight time, where EST is five hours behind GMT.


All UNIX systems use a system initialization file to set this variable. Windows systems time 
zone settings are usually set with the Date/Time functionality available from the Control 
Panel. However, the TZ variable can be used to change the lengthy format of the time zone 
on a Windows system. If you set TZ=EST5EDT on a Windows system, “Eastern Daylight 
Time” is replaced by “EDT”.


LC_TIME


This system environment variable controls the formatting of dates and times. By default, 
Managers use time and date formats that are sensitive to locale settings. For example, if 
you chose a date format that includes the name of the day of the week, in the English 
locale, the first weekday is formatted as Monday, while in the French locale it is formatted 
as Lundi.


If LC_TIME is not set, the system variable LC_ALL is used. If LC_ALL is not set either, the 
system variable LANG is used. Finally, if LANG is not set, a default “C locale” (essentially 
US English) is used, except on Windows systems where the system default is used.


The locale names and available locales are system specific.
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Variables that control reading and writing files


These variables control the location of output, such as log files and repository. They also 
control the location from which EMC Smarts reads files, such as ASL scripts.


SM_LOG_ROLL_SIZE


This environment variable determines the size to which a server log file may grow before 
the server creates a new log file. The size can be any value between 5 megabytes 
(5,000,000 bytes) and 2 gigabytes (2,000,000,000 bytes), with a default value of 200 
megabytes.


A user appends a suffix letter, k for kilobytes, M for megabytes, or G for gigabytes, to a 
user-specified integer value, to indicate that the integer value is to be multiplied by 1024, 
1048576, or 1073741824, respectively. As examples, 200M indicates a value of 200 
megabytes, 1G indicates a value of 1 gigabyte, and 2G indicates a value of 2 gigabytes.


If a user sets SM_LOG_ROLL_SIZE to a value less than 5 megabytes, the value is set to 
5 megabytes. If a user sets SM_LOG_ROLL_SIZE to a value greater than 2 gigabytes, the 
value is set to 2 gigabytes.


The number of retained log files is determined by the value of SM_BACKUP_FILE_LIMIT. If 
you set SM_LOG_ROLL_SIZE to a value such that the log rolls frequently, you should also 
set SM_BACKUP_FILE_LIMIT to a higher value than the default value of 3. You should keep 
at least seven days worth of log files.


Log rolling by cron jobs is still supported.


SM_BACKUP_FILE_LIMIT


This environment variable determines the number of log files that are saved by the server. 
A server creates a new log file when the server is restarted or when the log file is rolled 
over. “Managing Log Files” on page 133 provides additional information, including an 
example.


Valid values are 0 through 999, with a default value of 3. If SM_BACKUP_FILE_LIMIT is set 
to 0, only the current log file and a backup of the previous log file are saved. If a user sets 
the variable to an invalid string or a negative value, the value is set to 3(default). If a user 
sets the variable to a value greater than 999, the value is set to 999.


The value for SM_BACKUP_FILE_LIMIT applies to each version of a log file that a server is 
configured to generate. For log files MYDM_en_US_UTF-8.log and MYDM_fr_UTF-8.log, for 
example, the EMC Smarts software can retain up to 999 rolled over log files for each of 
these log files.
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SM_LOG_NAME_CUSTOM


This environment variable SM_LOG_NAME_CUSTOM enables you to specify the earlier log 
naming convention for your locale specific log, that is, use pre-Foundation V9.X log 
naming. The <locale>_<encoding> string is not appended to the base log name.


When SM_LOG_NAME_CUSTOM is set to TRUE, <locale>_<encoding> will not be attached to 
the non-English logs, or, if there is only one log (English log), <locale>_<encoding> will not 
be attached to that log. The <locale>_<encoding> will be attached to the English log if there 
are two logs (local and English).


Examples If the server is started with option --output=name with SM_LOCALE=en_US and 
SM_ENCODING_OUTPUT=UTF-8, only name.log is created in the BASEDIR/local/logs 
directory.


If the server is started with option --output=name with SM_LOCALE=fr_FR and 
SM_ENCODING_OUTPUT=UTF-8, name.log and name_en_US_UTF-8.log files are created in 
the BASEDIR/local/logs directory.


If the server is started with option --output=name with SM_LOCALE=en_US and 
SM_ENCODING_OUTPUT=ISO-8859-15, name.log and name_en_US_UTF-8.log files are 
created in the BASEDIR/local/logs directory.


If you use --output without a <name>, the output uses the server name to create the log file.


SM_LOGFILES


This environment variable is used to specify the location where log files should be written. 
Setting this variable is optional. If there is no value assigned to this variable, the log files 
will be written to the location SM_WRITEABLE/logs. If you set SM_LOGFILES, you must also 
create the /logs directory at the location specified by the variable.


This variable takes precedence over the value of the SM_WRITEABLE environment variable.


SM_WRITEABLE


This environment variable specifies the location where the software writes output files 
such as repositories, log files, and saved consoles. By default, the location is set to 
BASEDIR/smarts/local. If you set the SM_WRITEABLE variable, you must also create the 
underlying directories.


Table 33 on page 170 lists the directories whose location is controlled by SM_WRITEABLE:


The location where log files are saved can be separately controlled with the SM_LOGFILES 
environment variable.


Table 33  Directories controlled by SM_WRITEABLE


Subdirectory Contents


/consoles Saved consoles


/logs Log files


/repos Repository files
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SM_RULESET_PATH


By default, programs only invoke ASL scripts located in the BASEDIR/smarts/rules 
directory, the BASEDIR/smarts/local/rules directory, or a subdirectory of one of these 
directories. You can use this environment variable to specify additional locations from 
which EMC Smarts programs can invoke ASL scripts.


When set, the directories specified by SM_RULESET_PATH are searched before the system 
defaults.


Variables that control thread locks


These variables control thread locking in the programs.


SM_COUNT_REPOS_LOCKS


A Manager crashes whenever the stack used by a thread exceeds the space allocated. 
Threads acquire locks to access instances in the Manager’s repository. If a thread exceeds 
a certain number of locks, then the lock fails with an error code of ELOOP and a message is 
written to the log file.


This environment variable is used to control lock counting. SM_COUNT_REPOS_LOCKS 
must be set before starting the Manager. By default, the lock counting is turned off. To 
enable lock counting, set SM_COUNT_REPOS_LOCKS to TRUE, yes, or 1. 


SM_REPOS_LOCKS_LIMIT


This environment variable determines the number of locks which, if exceeded, causes the 
ELOOP error. SM_REPOS_LOCKS_LIMIT must be an integer number. The default value is 50. 


EMC recommends a value that is less than 100. Setting low values might cause legitimate 
requests to fail and affect analysis. Setting high values might allow the thread to run out of 
stack space before reaching the lock count limit. 


Variables that control log subscription changes and Dynamic Modeling errors


These variables control the tracing of subscription changes and the ignoring of DynModel 
errors.


SM_SUBSCRIPTION_TRACE


This environment variable controls the tracing of subscription changes. Subscription 
tracing is enabled by default, which means that subscription changes will appear in the 
server log by default. Similar messages will appear when new clients connect to the server 
and issue subscriptions.


Valid values are 0 and 1, with a default value of 1. Disabling subscription tracing is not 
recommended, but can be achieved by setting SM_SUBSCRIPTION_TRACE=0. To enable it 
again, set SM_SUBSCRIPTION_TRACE=1.
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SM_IGNORE_DYNMODEL_ERRORS


This environment variable enables the server to ignore DynModel errors and continue to 
run. In earlier releases, if you tried to refine an existing attribute, on finding the DynModel 
error that is not recoverable, the server application (Manager) would stop and write an 
error message to its log. This behavior is the default behavior in this release.


Valid values are TRUE and FALSE, with a default value of FALSE. Setting 
SM_IGNORE_DYNMODEL_ERRORS=TRUE causes the server to ignore DynModel errors and 
continue to run.
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Wildcards


This appendix shows you how to use a wildcard pattern in a text field to match a number of 
objects instead of specifying each object by name. It consists of the following sections:


◆ Types of wildcard patterns.....................................................................................  174

Wildcards 173







Wildcards

Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character 
strings. You can use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a 
time. Basic wildcard patterns are defined in Table 34 on page 174. Characters that are not 
part of match constructs match themselves. The pattern and the incoming string must 
match completely. For example, the pattern abcd does not match the input abcde or abc. 


A compound wildcard pattern consists of one or more basic wildcard patterns separated 
by ampersand (&) or tilde (~) characters. A compound wildcard pattern is matched by 
attempting to match each of its component basic wildcard patterns against the entire 
input string. Table 35 on page 175 describes compound wildcard patterns.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) 
character, the compound is interpreted as if an asterisk (*) appeared at the beginning of 
the pattern. For example, the pattern ~*[0-9]* matches any string not containing any 
digits. A trailing instance of an ampersand character (&) can only match the empty string. 
A trailing instance of a tilde character (~) can be read as “except for the empty string.”


Spaces are interpreted as characters and are subject to matching even if they are adjacent 
to operators like “&”. 


Table 34  Basic wildcard patterns (page 1 of 2)


Character Description


? Matches any single character. 
For example, server?.example.com matches server3.example.com and 
serverB.example.com, but not server10.example.com.


* Matches an arbitrary string of characters. The string can be empty. 
For example, server*.example.com matches server-ny.example.com and 
server.example.com (an empty match).


[set] Matches any single character that appears within [set]; or, if the first character of 
[set] is (^), any single character that is not in the set. A hyphen (-) within [set] 
indicates a range, so that [a-d] is equivalent to [abcd]. The character before the 
hyphen (-) must precede the character after it or the range will be empty. The 
character (^) in any position except the first, or a hyphen (-) at the first or last 
position, has no special meaning. 
For example, server[789-].example.com matches server7.example.com through 
server9.example.com, but not server6.example.com. It also matches 
server-.example.com.
For example, server[^12].example.com does not match server1.example.com or 
server2.example.com, but will match server8.example.com.
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Special characters for compound wildcard patterns are summarized in Table 35 on 
page 175.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, 
which represent non-negative integer values. The matching characters are a 
non-empty string of digits whose value, as a non-negative integer, is greater 
than or equal to n1 and less than or equal to n2. If either end of the range is 
omitted, no limitation is placed on the accepted number.
For example, 98.49.<1-100>.10 matches a range of IP addresses from 
98.49.1.10 through 98.49.100.10. 
Example of an omitted high end of the range: <50-> matches any string of digits 
with a value greater than or equal to 50. 
Example of an omitted low end of the range: <-150> matches any value between 
zero and 150.
For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, 
with * matching no characters. Similarly, it matches strings like 9x, with * 
matching the trailing x. However, it does not match 11, because <1-10> always 
extracts the longest possible string of digits (11) and then matches only if the 
number it represents is in range.


| Matches alternatives. For example,”ab|bc|cd” without spaces matches exactly 
the three following strings:  “ab”, “bc”, and “cd”. A | as the first or last character 
of a pattern accepts an empty string as a match.
Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) has 
no special meaning within a set ([set]) or range (<n1-n2>) construct.


\\ Removes the special status of the characters (, ), [, ], <, and >. For example, the 
pattern \\(A\\) matches the string (A).


Table 34  Basic wildcard patterns (page 2 of 2)


Character Description


Table 35  Compound wildcard patterns


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern 
is preceded by & (or is the first basic wildcard pattern in the compound wildcard 
pattern), it must successfully match. 
Example: *NY*&*Router* matches all strings which contain NY and also contain 
Router. 
Example: <1-100>&*[02468] matches even numbers between 1 and 100 inclusive. 
The <1-100> component only passes numbers in the correct range and the *[02468] 
component only passes numbers that end in an even digit. 
Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also 
contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a component 
basic wildcard pattern is preceded by ~, it must not match. 
Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 
except 10.20.30.50.
Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, 
except a Cisco router, with an address on network 10.20.30, except not 
10.20.30.10 through 10.20.30.20.

Types of wildcard patterns 175







Wildcards

176 EMC Smarts Foundation System Administration Guide







INDEX

A
Access privileges


All  91
Monitor  91
None  91
Ping  91


Additional safeguards  112
File permissions  112
Limiting access to servers  112


Alternate security configuration files
Specifying  98


ASL script
SM_RULESET_PATH  171


Audit file  25
Authentication


record format  89, 91
Authority programs


Specify selection  166
Availability Manager


see IP Availability Manager


B
brcontrol utility  119
Broker


brcontrol  119
Clients locating  164
Manager


Process ID  118
State last changed  118
Status  118


Ping access privilege  91
Registry  118
Secure  110, 115
Security  87
TCP port  119


BROKER token  90, 92, 95
brokerConnect.conf  87


Description  91
Encrypted passwords  104
Syntax  88


C
Client process locale  15
Client session locale  15
clientConnect.conf


BROKER token  92
DEFAULT token  92
Description  91
Encrypted passwords  104
login user field  92
password field  92
PROMPT token  92
record format  91


Syntax  88
target field  92
username field  92
USERNAME token  92


Configuration files
runcmd_env.sh  20


Country codes  16


D
Default parameters for services  77
DEFAULT token  90, 92
Diffie Helman-Advanced Encryption Standard  84, 85
Disabling security  100
Displaying installed services  73
dmctl utility  25


roll_log  143
Domain Manager


Running as non root  81


E
EDITOR  21
ELOOP error  171
Enabling security  100
Encoding


Setting for internal interaction with operating system  
161


Setting for shell  161
Setting for stdin  161
Used by stdout and stderr  161


Encrypted connections  106
Configuring  109


Encrypted passwords  104
Encryption  101
encryption standard


Federal Information Processing Standard (FIPS) 
Publication 140-2  84, 85


Environment variables
Boolean values  147
Date and time formatting  167
EDITOR  21
Hexadecimal values  146
How values are interpreted  146
Integer values  146
LC_TIME  168
LM_LICENSE_FILE  165
Octal values  146
runcmd_env.sh  20, 120
Setting  147
SM_AUDIT_ALL_CONNECTIONS  157
SM_AUDIT_CLIENT_ACTIONS  157
SM_AUTHORITY  100, 166
SM_BACKUP_FILE_LIMIT  139, 144, 169
SM_BROKER  164

EMC Smarts Foundation System Administration Guide 177 







Index

SM_BROKER_DEFAULT  119, 120, 164
SM_BROKER_NTHREADS  164
SM_CLIENTCONNECT  98, 166
SM_COUNT_REPOS_LOCKS  171
SM_DISABLE_KEEPALIVES  155
SM_DISPLAY  151
SM_EDITOR  21, 151
SM_ENABLE_SNMP_SET  152
SM_ENCODING_INPUT  161
SM_ENCODING_OUTPUT  161
SM_ENCODING_SHELL  161
SM_ENCODING_SYSTEM  161
SM_FOLD_WIDTH  157
SM_HOSTSFILE  158
SM_IGNORE_DYNMODEL_ERRORS  172
SM_INCOMING_PROTOCOL  108, 154
SM_IP_VERSIONS  155
SM_JAVA  163
SM_JAVA_PACKAGE_ROOT  163
SM_JAVAHOME  163
SM_JDK_HOME  163
SM_KEYFILE  166
SM_LICENSE  36, 165
SM_LMGRD_LICENSE_FILE  165
SM_LOCALE  161
SM_LOG_NAME_CUSTOM  170
SM_LOG_ROLL_SIZE  169
SM_LOGFILES  26, 137, 170
SM_MAIN_OPTIONS  137, 152
SM_MAX_MONITORING_THREADS  157
SM_NO_LINE_FOLD  157
SM_OKLOGIN_LOGLEVEL  166
SM_OUTGOING_PROTOCOL  108, 154
SM_REPOS_LOCKS_LIMIT  171
SM_RULESET_PATH  23, 171
SM_SERVERCONNECT  98, 167
SM_SNMP_BUG_COMPATIBLE  151
SM_SUBSCRIPTION_TRACE  171
SM_WRITEABLE  25, 139, 170
TZ  168
VISUAL  21


Error level
Retrieve at runtime  138
Set at runtime  138


Evaluation license file  39
Exception messages


Line wrapping in log file  157


F
Federal Information Processing Standard (FIPS) Publication 


140-2 encryption standard  84, 85
Firewall


One-way connection  41
flexlm.log  36, 57
FlexNet Publisher  34


Document (PDF)  34, 52
License server  35, 44
LM_LICENSE_FILE  165
log file  36, 57
Tools  52


FlexNet Publisher SM_LMGRD_LICENSE_FILE  165
Force logging  157


G
Global Console


Client  86
Security prompting  87


H
Host ID


And IP address  58


I
ic-serviced  67
Indicating the location of the JDK  163
install_license script  43, 50
Installing programs as services  71
Integer values  146
IP Availability Manager


Discovery and volume licensing  56
ISO 639 Language Codes  16


J
Java package root specification  163


K
KeepAlive messages  155
kill command  142


L
Language codes  16
LC_TIME  168
Licensing


Block of licenses  54
Components  35
Determining number of licenses in use  58
Discovery and volume licensing  56
Examples of license files  37
flexlm.log file  36, 57
FlexNet Publisher license server  35, 44
FlexNet Publisher software  34
host ID, host_ID  38
Hostname  59
How to obtain


A license file  40
install_license script  43, 50
Installation upgrade  34
Installing license server  43, 50
Multiple sites  47
New installation  34
Number of licenses  38
Permanent license file  34
Renew a temporary license file  40
Requirements  34


For temporary license file  39
Rules for


Permanent license file  37

178 EMC Smarts Foundation System Administration Guide







IndexIndex

Running old license files  48
Set up


Permanent  34
SM_LICENSE  36
smarts.lic  37
Starting license server  43, 53
Stopping license server  53
System IP address  58
Temporary license file  39
Tools  52
Travelling license file  39
Troubleshooting  57
Types of daemons  35
Uninstalling license server  51
Upgrade  48
Utilities for volume licensing  54
Verifying version of license server  52
Volume licensing  54


LM_LICENSE_FILE  165
Locale


Client process  15
Client session  15
Definition  14
Process  15
Support  16


Locating the Broker  164
Lock counting  171
Log files  134


Adapter  139
Audit file  25
Controlling the number  139, 144
Date and timestamp  142
Diagnostic header  140
FlexNet Publisher log file  36
Line wrapping of exception messages  157
Manager log file  139
Message at end of rolled log  142
Naming convention  139
Prevent line wrapping  157
Retrieve error level at runtime  138
Retrieve log level at runtime  138
Retrieve trace level at runtime  138
Rolling over  136, 139, 142
Setting error level at runtime  138
Setting log level at runtime  138
Setting trace level at runtime  138
Starting a new one  142
Statistics log file  25
Thread id  142
UNIX syslog  136
Win Event  136


Log level
Retrieve at runtime  138
Set at runtime  138


Log successful logins  166
login user  92


M
Manager


Status


Dead  118
Running  118
Unknown  118


Matching
Pattern  174


Maximum number of monitoring threads in monitoring system 
 157


Modifying service parameters  76
monitoring performance  157


O
Operator


Wildcard  174


P
Passwords


Encrypting  104
Pattern  174
Pattern matching  174
performance of monitoring system  157
Permanent license file  34
privopen option  81
process ID  142
Process locale  15
PROMPT token  92


R
Removing services  76
roll_log command  143
runcmd_env.sh  20, 120, 147
Running as non root  81


S
Script


install_license  50
Secret phrase  101


Changing  102
Locking  103
Using for multiple suites and sites  103


Security
Access privileges


All  91
Monitor  91
None  91
Ping  91


Automatic authentication  87
Broker  87
brokerConnect.conf


Description  91
Syntax  88


clientConnect.conf
Description  91
Syntax  88


Diffie Helman-Advanced Encryption Standard  84, 85
Enabling or disabling  100
Encryption  88, 101
Global Console  87
Network account authentication  94

EMC Smarts Foundation System Administration Guide 179







Index

serverConnect.conf
Description  89
Syntax  88


Security configuration
Examples  113


Security feature  84
Authentication  84
Encrypted passwords  84


Seed file
Encrypted  106


serverConnect.conf
BROKER token  90, 95
DEFAULT token  90
Description  89
Encrypted passwords  104
password field  90
privilege field  90
record format  89
Syntax  88
SYS token  90
target field  90
username field  90


Setting environment variables  147
sm_adapter  79


common options  79
SM_AUDIT_ALL_CONNECTIONS  157
SM_AUDIT_CLIENT_ACTIONS  157
SM_AUTHORITY  100, 166


Setting the variable  100
sm_authority program  26
SM_BACKUP_FILE_LIMIT  139, 144, 169
SM_BROKER  164
SM_BROKER_DEFAULT  119, 120, 164
SM_BROKER_NTHREADS  164
SM_CLIENTCONNECT  98, 166
SM_COUNT_REPOS_LOCKS  171
SM_DISABLE_KEEPALIVES  155
SM_DISPLAY  151
sm_edit utility  19, 20, 21, 151


Encrypting passwords  105, 106
SM_EDITOR  21, 151
SM_ENABLE_SNMP_SET  152
SM_ENCODING_INPUT  161
SM_ENCODING_OUTPUT  161
SM_ENCODING_SHELL  161
SM_ENCODING_SYSTEM  161
SM_FOLD_WIDTH  157
SM_HOSTSFILE  158
SM_IGNORE_DYNMODEL_ERRORS  172
SM_INCOMING_PROTOCOL  108, 154
SM_IP_VERSIONS  155
SM_JAVA  163
SM_JAVA_PACKAGE_ROOT  163
SM_JAVAHOME  163
SM_JDK_HOME  163
SM_KEYFILE  166
SM_LICENSE  36, 165
SM_LMGRD_LICENSE_FILE  165
SM_LOCALE  15, 161
SM_LOG_NAME_CUSTOM  170


SM_LOG_ROLL_SIZE  169
sm_logerror  26
SM_LOGFILES  26, 137, 170
SM_MAIN_OPTIONS  137, 152
SM_MAX_MONITORING_THREADS  157
SM_NO_LINE_FOLD  157
SM_OKLOGIN_LOGLEVEL  166
SM_OUTGOING_PROTOCOL  108, 154
SM_REPOS_LOCKS_LIMIT  171
SM_RULESET_PATH  23, 171
sm_server


common options  77, 80
SM_SERVERCONNECT  98, 167
sm_service


actions  70
install action  71
install options  71
remove action  76
show action  73
standard options  69
start action  74
start options  74
stop action  74
stop options  74, 75


sm_serviced  67
SM_SNMP_BUG_COMPATIBLE  151
SM_SUBSCRIPTION_TRACE  171
sm_tpmgr command  55
SM_WRITEABLE  25, 139, 170
smarts.lic  37
SNMP  151
Specify non-standard JRE  163
Starting and stopping services  74
Starting license server  43, 53
statistics log file  25
Stopping license server  53
Support locale  16
SYS token  90


T
TCP


Broker port  119
Threads


Maximum number of monitoring threads  157
Time zone  168
Trace level


Retrieve at runtime  138
Set at runtime  138


Trial license file  39
TZ  168


U
Unicode  16
UNIX syslog  136
USERNAME token  92
Utilities


brcontrol  119
dmctl


roll_log  143

180 EMC Smarts Foundation System Administration Guide







IndexIndex

sm_edit  19, 20, 151


V
VISUAL  21
Volume licensing  54


W
Wildcard  174


Chart of operators  174
Win Event Log  136
Windows Domain Manager  94
Work-around for 32-bit Solaris library bug  158

EMC Smarts Foundation System Administration Guide 181







Index

182 EMC Smarts Foundation System Administration Guide





		Introduction

		Overview

		Setting the locale

		Locating and modifying files

		Licensing the software

		Controlling the startup of EMC Smarts programs

		Securing access to software

		Operation of the Broker

		Managing log files



		Locale

		What is a locale

		Client and Domain Manager use different locales



		Locale types

		Process locale

		Client locale

		Domain Manager process locale

		Support locale



		Standards

		Unicode

		ISO 639 language codes

		ISO 3166 country codes





		Locating and Modifying Files

		Directories

		User-modifiable files

		Modifying EMC Smarts files

		Associating files with sm_edit on Windows



		Locating user-modifiable files

		Controlling the location for rule set files

		Controlling location of the user modified files



		Writing output files

		Controlling where the software writes output files

		Controlling where the software writes log files

		sm_logerror



		Using the smgetinfo utility to create a support package

		sm_getinfo files

		sm_getinfo command-line syntax

		sm_getinfo invocation examples

		sm_getinfo data collection





		License Administration

		Overview of the steps to set up license management

		License components and process flow

		Examples of license files

		Temporary license file example

		Permanent license file example



		Obtain and set up a temporary license file

		How to renew a temporary license file



		Obtain and set up a permanent license file

		Rehost license

		Regenerate license



		Install and configure the FlexNet Publisher license server

		Use an existing FlexNet Publisher license server

		Add another permanent license to a running license server

		Change the license server port in a running license server

		Enable communication through a firewall in a running license server

		Use of multiple FlexNet Publisher license servers

		Upgrade licensing during EMC Smarts software upgrades

		Run older versions of license files in parallel

		Overview of the install_license script

		Uninstall the FlexNet Publisher license server

		License server administration tools

		Verify the FlexNet Publisher license server version

		Starting and stopping the license server



		License checking by an EMC Smarts application

		Volume licensing for EMC Smarts IP Availability Manager

		Determining the total number of licenses

		Determining the number of checked-out licenses

		Discovery and licenses



		Troubleshooting

		Evaluation software no longer runs

		Messages in the flexlm.log file

		Need to determine the FlexNet Publisher license server and all licenses served

		Cannot find license error

		Changing an IP address and its effect on licensing

		Error occurs when starting additional Domain Managers

		License file corrupted when attempting to edit license file

		Cannot restart FlexNet Publisher license server after applying a Service Pack



		Introduction to Service Assurance Suite (SA Suite) and its licensing

		Switch/router classification and conversion examples

		SA Suite license count report





		Controlling Startup

		Root access requirement on UNIX and Linux

		Overview of services

		About the sm_service utility

		sm_serviced and ic-serviced

		The sm_service command line

		Standard options

		sm_service actions



		Installing programs as services with sm_service

		Install options

		Examples of the sm_service install action



		Displaying installed services and their status

		Examples of the sm_service show action



		Starting and stopping services with sm_service

		Start options

		Stop options

		Examples of the sm_service start and stop actions

		Checking whether services are stopped

		Examples of the sm_service isstopped action

		Starting and stopping services from the Windows desktop



		Modifying service parameters with sm_service

		Removing services with sm_service

		Example of the sm_service remove action



		Default parameters for services

		Common sm_server options

		Common sm_adapter options

		Common sm_sdi options



		Running as non root on UNIX and Linux systems



		Securing Access to the Software

		Security features

		How security works

		Server and client programs for the software

		Server authentication

		Client authentication

		Encryption



		Configuring authentication

		Syntax of the security files

		Server authentication records

		Client authentication records

		Special authentication values

		Default authentication records

		Specifying alternate security configuration files



		Controlling authentication

		Setting the SM_AUTHORITY variable



		Changing Cryptographic Settings

		Changing Pseudo-random Number Generators (PRNG) algorithm

		Changing the use of the default PRNG algorithm:



		Encryption

		Changing the secret

		Using the secret for multiple products and sites

		Locking the secret



		Encrypted passwords

		Encrypting passwords



		Encrypted seed files

		Encrypted connections

		Levels of encryption

		Encrypting connections in non-FIPS 140 mode

		Encrypting connections in FIPS 140 mode

		Suggested encrypted connections in non-FIPS 140 mode



		Replacing or importing TLS certificates

		Configuring a secure Broker

		Additional safeguards

		Using file permissions

		Limiting access to the configuration files

		Limiting access to servers



		Example security configurations

		Default security

		Customized security





		Operation of the Broker

		Overview of the Broker

		Viewing the registry of the Broker

		How the clients find the Broker

		How to change the Broker environment variable

		Correcting the Broker settings



		Securing the Broker



		Continuous Audit of Client Connections

		Overview of continuous auditing of client connections

		System Element objects

		SM_SystemElement

		SM_ElementManager



		Client data persists after connection terminates

		File descriptor usage warning event

		Acquiring client information

		Viewing SM_ElementManager attribute values

		Changing SM_ElementManager attribute values



		Managing Log Files

		Overview of message logging

		Command-line options that control messages



		Retrieving and setting log, error and trace levels at runtime

		Log files

		Diagnostic header

		Date and timestamp, and thread id in each log message

		Message at the end of a rolled log



		Starting a new log file

		Controlling the number of saved log files



		Environment Variables

		How variable values are interpreted

		How integer variables are interpreted

		How Boolean variables are interpreted



		Methods for setting environment variables

		Setting an environment variable product-wide

		Setting an environment variable for a program



		Environment variables for users

		Variables that control the locale and encoding

		Variables that control Java settings

		Variables that control the Broker

		Variables that control FlexNet Publisher licensing

		Variables that control security

		Variables that control date and time formatting

		Variables that control reading and writing files

		Variables that control thread locks

		Variables that control log subscription changes and Dynamic Modeling errors





		Wildcards

		Types of wildcard patterns



		Index










 


Support Matrix 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


 


Abstract 


Smarts 9.4.2 Suite can be installed in a typical or a fully 
distributed, multi-machine production environment. The 
hardware and software prerequisites for each of these 
deployments are provided in this document.  
 
September, 2016 
 
 


 
 
 


 


EMC® Smarts® SAM, IP, ESM, MPLS, NPM, 
OTM, and VoIP Managers 9.4.2 Support Matrix 
 
Version 9.4.2.0 
302-003-122 
REV 01 







 2 Support Matrix 


Table of Contents 
Table of Contents .............................................................................................. 2 


Revision history ................................................................................................ 3 


Operating system requirements .......................................................................... 3 


Note: ............................................................................................................... 3 


Operating system recommended patches ............................................................ 4 


Browser requirements for Web Console and Business Dashboard ........................... 6 
Java Web Start requirements for Web Console ............................................................. 6 


Interoperability ................................................................................................. 7 


Upgrade........................................................................................................... 7 


Hardware requirements ..................................................................................... 7 
Service Assurance Manager requirements ....................................................................... 8 


Hardware for several platform equipment tiers ............................................................ 8 
Disk space requirements for Service Assurance Manager Console ................................ 8 
CPU, memory, data disk space requirements ............................................................... 8 


IP Manager requirements ............................................................................................... 9 
EMC Server Manager requirements ................................................................................. 9 


Server Manager supported managed devices and software .......................................... 9 
MPLS/NPM/VOIP/OTM Manager requirements .............................................................. 11 


 
 







 3 Support Matrix 


Revision history 
Date Comment 


September 2016 First version of the document 


Operating system requirements 
Service Assurance Manager, IP Manager, MPLS Manager, Server Manager, Network 
Protocol Manager, Optical Transport Manager and VoIP Availability Manager are 
supported on operating systems: 


Operating system Supported version  Notes 


Red Hat Enterprise Linux  


(Native/Virtual*) 


• Red Hat Enterprise Linux  5.10 and 
5.11– 64 bit 


• Red Hat Enterprise Linux 6.6, 6.7 
and 6.8– 64 bit 


• Red Hat Enterprise Linux 7.0, 7.1 
and 7.2– 64 bit 


Veritas cluster is not supported 
on Linux platforms. 


 


 


CentOS Linux 


(Native/Virtual*) 


• CentOS 6.6, 6.7 and 6.8– 64 
bit 


• CentOS 7.0, 7.1 and 7.2– 64 
bit 


Veritas cluster is not supported 
on Linux platforms. 


 


Microsoft Windows 2012 R2 


SE and EE 


(Native/Virtual*) 


• Microsoft Windows Server 2012 
R2– 64 bit 


 


Additionally, for SAM Console: 


• Microsoft Windows Vista – 32 /64 
bit 


• Microsoft Windows 7 – 32/64 bit 


 


Note: 
 


* = Support for virtualized deployments may vary per hypervisor due to the nature of 
integration between OS and hypervisor.  
•         VMWare: best practices are offered on VMWare hypervisors for the above operating 
systems 
•         All other hypervisors:  SA Suite may be deployed on other hypervisors but EMC does 
not support performance and interoperability issues between the OS layer and 
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hypervisor.  We do not have best practices for deploying on non-VMware hypervisors. 
Check with hypervisor vendor to address issues not reproducible on physical or VMWare 
deployed environments. 
• Java SE runtime environment (JRE) 8 update 91 is used for 9.4.2 products on all 


supported platforms. 


Operating system recommended patches 
Operating system patches that are required for the IP Manager, Service Assurance 
Manager, MPLS Manager, Server Manager, Network Protocol Manager, Optical 
Transport Manager and VoIP Availability Manager. If the installation program does not 
detect the required patches, it will stop or may not function predictably.  


Operating system Required patch 


Red Hat Enterprise Linux 5.10 
and 5.11 


 


• glibc-2.2.4-32.i386 


• glibc-2.2.4-32.x86_64 


• glibc-common-2.2.4-32 


• compat-libstdc++-33-3.2.3-61.x86_64 


• compat-libstdc++-33-3.2.3-47.3.i686 


• redhat-lsb library 


Additionally, for Service Assurance Manager Console, 


On Red Hat Enterprise Linux 5.x: 


• libstdc++ 4.1.2-44.i386 


• libXi-1.0.1-3.1.i386 


• libXext-1.0.1-2.1.i386 


• libXtst-1.0.1-3.1.i386 


• libXrender- 0.9.1-3.1.i386 


• compat-libstdc++-296-2.96-138.i386 


Note: When installing on a 64-bit Linux platform, both 64-bit and 
32-bit libraries are required. 


Red Hat Enterprise Linux 6.6, 6.7 
and 6.8 


CentOS 6.6, 6.7 and 6.8 


• glibc-2.2.4-32.i686 


• glibc-2.2.4-32.x86_64 


• glibc-common-2.2.4-32 


• compat-libstdc++-33-3.2.3-61.x86_64 


• compat-libstdc++-33-3.2.3-47.3.i686 


• redhat-lsb library 
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Additionally, for Service Assurance Manager Console, 


On Red Hat Enterprise Linux 6.x / CentOS 6.x: 


• libstdc++-4.4.6-3.i686 


• libstdc++-4.4.6-3.i686 


• libXi-1.3-3.i686 


• libXext-1.1-3.i686 


• libXtst-1.0.99.2-3.i686 


• libXrender-0.9.5-1.i686 


• compat-libstdc++-296-2.96-144.i686 


Note: When installing on a 64-bit Linux platform, both 64-bit and 
32-bit libraries are required. 


Red Hat Enterprise Linux 7.0, 7.1 
and 7.2 


CentOS 7.0, 7.1 and 7.2 


• glibc-2.2.4-32.i686 


• glibc-2.2.4-32.x86_64 


• glibc-common-2.2.4-32 


• compat-libstdc++-33-3.2.3-61.x86_64 


• compat-libstdc++-33-3.2.3-47.3.i686 


• redhat-lsb-4.1-24.x86_64 


Additionally, for Service Assurance Manager Console, 


On Red Hat Enterprise Linux 7 / CentOS 7: 


• libstdc++-4.4.6-3.i686 


• libXi-1.3-3.i686 


• libXext-1.1-3.i686 


• libXtst-1.0.99.2-3.i686 


• libXrender-0.9.5-1.i686 


Note: When installing on a 64-bit Linux platform, both 64-bit and 
32-bit libraries are required. 
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Browser requirements for Web Console and Business 
Dashboard 
The EMC Smarts Global Console can also be deployed as either: 


• EMC Smarts Web Console 


Or 


• EMC Smarts Business Dashboard 


Note: Tomcat Servlet Engine version 8.0.23 is installed as part of the Web Console/ 
Business Dashboard. The Tomcat Servlet Engine serves the files used by the web 
applications. 


Users who display Business Dashboard viewlets in a web browser, or want to use the 
Web Console, require the following software: 


Browser Version Notes 


Google Chrome 37 or later Refer to the release notes for the 
steps/workaround provided for 
launching in Google Chrome 
version till 44 and 45 or later 


Internet Explorer 10.0 and 11.0 For Windows, the browser must 
have JavaScript enabled. 


Mozilla Firefox 32 or later  


 


JRE 8 update 91 web browser plug-in must be installed on the client workstation. If 
the JRE is not installed on the client workstation, then you will be prompted to install 
it when you launch the Web Console or Business Dashboard. 


Note: In SAM 9.4.2, Red Hat Enterprise Linux 5, 6 and 7, CentOS 6 and 7, Windows 
Server 2012 use JRE 1.8 update 91. 


Java Web Start requirements for Web Console 


Java Web Start is optional and can be invoked when the Web Console is run. 


Java Web Start must be installed and configured on the client machine: 


• For Linux, contact your system administrator to install and configure Java Web 
Start 


• For a Windows client, after you launch the web console, depending on the 
browser, use an automatic installer. 


The EMC Smarts Service Assurance Manager Dashboard Configuration Guide provides 
information about using the Web Console. 
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Interoperability 
Smarts Service Assurance Suite 9.4.2.0 products interoperate with the following 
products as mentioned in the below table.  


 


 


 


Upgrade 
   


• In place upgrades from 9.3.0.x to 9.4.2 will be supported for Smarts. 
• Migration from 9.3.0.x  to 9.4.2 will be supported for Smarts. 


 


Hardware requirements 
 


Minimum hardware requirements for CPUs, memory, and data disk space for the 
products. If you install more than one product on a system, the system must meet the 
total memory and disk space requirements for those products. CPU refers to the 
number of physical CPU cores and not the number of CPUs that are displayed when 
hyperthreading is activated. 


Note: When Service Assurance Suite 9.4.2 is deployed in a bare metal (non-VMware) 
environment, do not use hyperthreading. When hyperthreading is enabled, the 
Service Assurance Suite software runs more slowly and performance is adversely 
affected. 
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Service Assurance Manager requirements 


System requirements for Service Assurance Manager. 


Hardware for several platform equipment tiers 
 


Operating system CPUs Memory (RAM) Disk space 


Red Hat Enterprise Linux 4 8 GB 


The memory requirements will 
change based on the size of the 
topology. 


40 GB 


CentOS 40 GB 


Microsoft Windows Server 40 GB 


 
Note:  Refer to EMC Smarts SAM Version 9.4.2 Performance Benchmarking and Sizing 
Guidelines document for planning SAM deployment. 


Disk space requirements for Service Assurance Manager Console 
 
 


Operating system CPUs Memory (RAM) Disk space 


Red Hat Enterprise Linux 1 2 GB 8 GB 


CentOS 8 GB 


Microsoft Windows Server 8 GB 


 


CPU, memory, data disk space requirements 


Minimum requirements for CPUs, memory, and data disk space that is used by the 
software for writable files such as logs, repository files, and output files. 


EMC Smarts product CPUs Memory (RAM) Disk space 


EMC Smarts Service Assurance 
Manager Adapter Platform 


1  512 MB 2 GB each 


Syslog Adapter 1 512 MB 2 GB each 


SNMP Trap Adapter 1 512 MB  2 GB each 


XML Adapter 1 512 MB Depends on the size of the 
output file being exported; upto 
200 MB.  
For example, the XML Adapter 
communicates with 5 Service 
Assurance Global Managers 
and each output file is 200 MB, 
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then 1 gigabyte (GB) is 
required. 


 


IP Manager requirements 


 


Operating system CPUs Memory (RAM) Disk space 


Red Hat Enterprise Linux 4 8 GB 


The memory requirements will 
change based on the size of the 
topology. 


40 GB 


CentOS 40 GB 


Microsoft Windows Server 40 GB 


 
Note:  Refer to EMC Smarts IP Version 9.4.2 Performance Benchmarking and Sizing 
Guidelines document for planning IP deployment. 


 


 EMC Server Manager requirements 
 


Operating system CPUs Memory (RAM) Disk space 


Red Hat Enterprise Linux 4 8 GB 


The memory requirements will 
change based on the size of the 
topology. 


40 GB 


CentOS 40 GB 


Microsoft Windows Server 40 GB 


 


Note:  Refer to EMC Smarts ESM Version 9.4.2 Performance Benchmarking and Sizing 
Guidelines document for planning ESM deployment. 


 


Server Manager supported managed devices and software 
 


Feature Devices and Software 


VMware management • VMware vSphere 4.x 


• VMware vSphere 5 


• VMware vSphere 5.5 


• VMware vSphere 6.0 


• VMware ESX Cluster 


Note: Ensure that the VM tools are installed on each managed 
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VMware virtual machine, as described in VMware documentation. 


Microsoft cluster management • Windows Server 2008 


• Xeon (Microsoft cluster feature only) 


Process monitoring Any machine that is running an SNMP agent (native or otherwise) 
that supports HOST-RESOURCE-MIB. 


 


Hardware and operating system 
monitoring 


Devices that support the following systems on Windows 2008 
and Linux: 


• Dell OpenManager 


• IBM Director 


• HP Systems Insight Manager 


Devices that support the following system on Windows: 


• WMI 


Devices that support the following system on  Linux: 


• Sun Management Center 


Load balancer F5 BIG-IP F5 BIG-IP load balancer devices and software: 


• 6400 


• 6800 


• 8800 


• 9.1.2 


• 9.4.x 


 


 


Hyper V • As a child partition of Hyper-V in Windows 2008 


• As a child partition of Hyper-V in RHEL AS 5 


Citrix Xen Server • Citrix Xen Server  6.2 


VMWare NSX  for vSphere • NSX 5.x 


• NSX 6.0 


OpenStack KVM  • Kilo 


• Mitaka 
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Note: Keystone versions v2 and v3 are supported. 


 


 


 


MPLS/NPM/VOIP/OTM Manager requirements 


 


Operating system CPUs Memory (RAM) Disk space 


Red Hat Enterprise Linux 2 4 GB 


The memory requirements will 
change based on the size of the 
topology. 


40 GB 


CentOS 40 GB 


Microsoft Windows Server 40 GB 
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CHAPTER 1
Overview


This chapter describes the EMC Smarts Service Assurance Manager, EMC Smarts IP 
Manager, EMC Smarts MPLS Manager, EMC Smarts Server Manager, EMC Smarts Network 
Protocol Manager, EMC Smarts Optical Transport Manager, and EMC Smarts VoIP 
Availability Manager, their compatibility with other EMC Smarts products, and installation 
tasks. It consists of the following topics:


◆ Product contents.....................................................................................................  10
◆ Product and version compatibility ...........................................................................  14
◆ Installation tasks overview......................................................................................  14
◆ Upgrade tasks overview ..........................................................................................  16
◆ Migration tasks overview.........................................................................................  17
◆ Uninstallation tasks overview..................................................................................  19
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Product contents
This document provides installation, upgrade, migration, and uninstallation procedures 
for:


◆ EMC Smarts Service Assurance Manager


◆ EMC Smarts IP Manager


◆ EMC Smarts MPLS Manager


◆ EMC Smarts Server Manager


◆ EMC Smarts Network Protocol Manager


◆ EMC Smarts Optical Transport Manager


◆ EMC Smarts VoIP Availability Manager


The EMC Smarts Service Assurance Manager includes the following products:


◆ Service Assurance Manager


The EMC Smarts Service Assurance Manager product includes the following 
components:


• Global Manager


• EMC Smarts Broker


• EMC Smarts MBIM — Maintenance and Business Impact Manager Server


• Generic notification adapters such as Log File, SNMP Trap, Script, and email


• EMC Data Access API


– Smarts Foundation EMC Data Access API (Smarts EDAA)


– Alert EMC Data Access API (EDAA)


– EMC Smarts Data Web Applications (Tomcat)


– EMC Smarts Notification Exchange (Rabbit MQ)


– EMC Smarts Notification Cache (ElasticSearch)


Some components, such as Business Impact Manager, require licensing.


◆ EMC M&R — EMC M&R is distributed with Service Assurance Suite. The Service 
Assurance Suite Installation and Configuration Guide for EMC M&R provides 
installation and configuration instructions. The SolutionPack for EMC Smarts 
Summary Sheet article provides instructions for installing the SolutionPack for EMC 
Smarts. The How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts 
article provides instructions on configuring Service Assurance Manager to work with 
EMC M&R. 
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◆ Global Console


The Global Console product is the graphical interface for all EMC Smarts products.


Global Console functionality can also be deployed as a Web Console or a Business 
Dashboard.


◆ Adapter Platform


The SAM Adapter Platform product provides functionality to import and normalize 
topology and events from outside the EMC Smarts domain.


◆ Syslog Adapter


The Syslog Adapter product reads and processes system log (Syslog) messages. It 
requires the SAM Adapter Platform. 


◆ Smarts Notification Module


The Smarts Notification Module (NOTIF) augments EMC Smarts solutions with event 
management features that are configured through a graphical user interface (the 
Smarts NOTIF Editor). Smarts NOTIF enables the user to easily optimize the flow of 
events and notifications sent through any EMC Smarts system. Smarts NOTIF can be 
installed on either the SAM server or Adapter Platform server, or both. The internal 
event and notification processing features of the standard SAM Adapter Platform are 
replaced by Smarts NOTIF.


Smarts NOTIF functionality and architecture is discussed in the EMC Smarts 
Notification Module User Guide.


◆ Smarts Notification Module Cisco Syslog Processing Adapter


The Smarts Notification Module Cisco Syslog Processing Adapter (referred to as the 
Smarts NOTIF Cisco Syslog Adapter) replaces the log file processing features of the 
standard Syslog Adapter. The Smarts NOTIF Cisco Syslog Adapter processes the log file 
information into useful notifications with or without the use of ASL scripts. 


The EMC Smarts Notification Module Cisco Syslog Processing Adapter Installation and 
User Guide provides additional information on this adapter.


◆ SNMP Trap Adapter


The SNMP Trap Adapter product reads SNMP traps and forwards traps to any 
EMC Smarts application. It requires the SAM Adapter Platform. 


◆ XML Adapter


The XML Adapter product imports and exports topology from any EMC Smarts 
application.


The EMC Smarts IP Manager includes the following products:


◆ IP Availability Manager


◆ IP Performance Manager
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◆ IP Server Performance Manager


◆ IP Availability Manager Extension for NAS


The EMC Smarts MPLS Manager includes the following products:


◆ EMC Smarts MPLS Manager is composed of three servers:


• MPLS Topology Server


• MPLS Monitoring Server


• MPLS Analysis Server


◆ MPLS VPN-Tagging Server


The EMC Smarts Network Protocol Manager includes the following products:


◆ EMC Smarts Network Protocol Manager for BGP


◆ EMC Smarts Network Protocol Manager for EIGRP


◆ EMC Smarts Network Protocol Manager for IS-IS


◆ EMC Smarts Network Protocol Manager for OSPF


The EMC Smarts Server Manager includes the Server Manager software.


The EMC Smarts Optical Transport Manager includes the following products:


◆ EMC Smarts Optical Transport Manager for Next Generation WDM


◆ EMC Smarts Optical Transport Manager for SDH (Topology and Analysis)


◆ EMC Smarts Optical Transport Manager for PDH (Topology and Analysis)


◆ EMC Smarts Optical Transport Manager for WDM (Topology and Analysis)


◆ EMC Smarts Optical Transport Manager for IP Cross Domain Analysis


◆ EMC Smarts TMF814 Cisco CTM Adapter for OTM


◆ EMC Smarts TMF814 Ciena On-Center Adapter for OTM


The VoIP Availability Manager includes the following products:


◆ EMC Smarts VoIP Availability Manager


◆ EMC Smarts VoIP Enablement Pack for Avaya


◆ EMC Smarts VoIP Enablement Pack for Cisco


◆ EMC Enablement Pack for ACME


◆ EMC Smarts VoIP Integration Pack for VoIP Performance Manager
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Installation directory structure


The installation directory structure is shown in Figure 1 on page 14. All EMC Smarts 
products use the same basic installation directory structure.


In Figure 1 on page 14, notice that:


◆ BASEDIR, which is not an environment variable, is used in documentation to represent 
the top-level directory structure of an EMC Smarts product software installation. 


For UNIX, this location is /opt/InCharge/<product>.


For Windows, this location is C:\InCharge\<product>.


BASEDIR represents:


• For MPLS Manager —<installation_root_directory>/MPLS


• For IP Manager — <installation_root_directory>/IP


• For Service Assurance Manager — <installation_root_directory>/SAM


• For Server Manager — <installation_root_directory>/ESM


• For Network Protocol Manager — <installation_root_directory>/NPM


• For Optical Transport Manager — <installation_root_directory>/OTM


• For VoIP Availability Manager — <installation_root_directory>/VoIP


By default, EMC Smarts software is installed to BASEDIR/smarts. 


Optionally, you can specify the root of BASEDIR to be something different, but you 
cannot change the <product> location under the root directory. 


◆ The EMC Smarts sm_edit utility ensures that modified files are always saved to the 
appropriate local area and that base (original) copies of the files remain unchanged. 
Appendix A, “The sm_edit utility,” provides additional information.


The EMC Smarts System Administration Guide provides detailed information about the 
directory structure for EMC Smarts software and the sm_edit utility.
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Figure 1  Installation directory structure


Product and version compatibility
The EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix 
provides information about the 9.4.2 products and the compatible versions of the 
EMC Smarts products. 


Installation tasks overview
To install EMC Smarts Service Assurance Manager, IP Manager, MPLS Manager, Server 
Manager, Network Protocol Manager, Optical Transport Manager, or the VoIP Availability 
Manager, you need to meet the requirements or perform the tasks that are listed in Table 1 
on page 14.


To install additional components to an existing installation, you can perform an 
installation or an upgrade.


_jvm (dir)


_uninst (dir)


smarts (dir)


sm_edit utilitylocal (dir)


actions (dir)


bin (dir)


classes (dir)


conf (dir)


actions (dir)


bin (dir)


classes (dir)


conf (dir)


Installation root directory


Product suite directory
BASEDIR


Location of
base files


Location of
customized files


Table 1  Installation requirements and tasks (page 1 of 2)


Before you install


The Broker and FlexNet license host should be installed, 
configured, and operating.


EMC Smarts System Administration Guide
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The Global Console, Global Manager, and Service 
Assurance products should be installed, configured, and 
licensed.


EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, 
NPM, OTM, and VoIP Managers


EMC M&R product should be installed, configured, and 
licensed.


• Service Assurance Suite Installation and Configuration 
Guide for EMC M&R


• SolutionPack for EMC Smarts Summary Sheet article
• How to Set Up SAM, EMC M&R, and the SolutionPack 


for EMC Smarts article


IP Manager should be installed, configured, and 
licensed. After IP Manager is installed, you can install or 
upgrade other Smarts products.


EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, 
NPM, OTM, and VoIP Managers


Review the important release issues for the product 
being installed.


EMC Smarts Release Notes for SAM, IP, ESM, MPLS, NPM, 
OTM, and VoIP Managers


Obtain an evaluation or permanent license for the 
product.


“Obtain and install a temporary license file” on page 95


Determine if the products are supported on your 
platform.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Review the patch requirements for your operating system. EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Determine if your system meets the hardware 
requirements.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Installation method


Install the product. Select one of the following installation methods:
• “Install using Wizard mode” on page 24
• “Install using CLI mode” on page 28
• “Install using Unattended mode” on page 30


After you install


Save your license in the proper location:
• Evaluation license – Save <license_name>.lic to the 


BASEDIR/smarts/local/conf directory.
• Permanent license – Use the procedures described in 


the EMC Smarts System Administration Guide.


“Obtain and install a temporary license file” on page 95


If your product is part of a deployment that requires the 
Federal Information Processing Standard (FIPS) 
Publication 140-2, a U.S. government computer security 
standard governing cryptographic modules, perform the 
procedure to enable products in FIPS mode.


“Support for FIPS 140-2 for 9.4.2 products” on page 34


If you installed the products as services, start them for 
the first time. 


• “Starting services on UNIX” on page 97
• “Start programs” on page 98


Verify the current state of the products and the Broker. “Verify the product status” on page 102


Optional task:
After modifying your configuration files on one 
installation, you can use the deployment utility to create 
a deployment package of your configuration changes and 
deploy the package on other installations.


“Deployment utility overview” on page 89


Table 1  Installation requirements and tasks (page 2 of 2)
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Upgrade tasks overview
To upgrade, you need to meet the requirements or perform the tasks that are listed in 
Table 2 on page 16. 


Table 2  Upgrade installation requirements and tasks (page 1 of 2)


Before you upgrade


Review the release notes for important issues. EMC Smarts Release Notes for SAM, IP, ESM, MPLS, NPM, 
OTM, and VoIP Managers


Determine if the products are supported for your 
platform.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Determine if your system meets the hardware 
requirements.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Upgrade installation


The order in which you upgrade products depends on 
whether the EMC M&R UI is included in your deployment. 
Upgrade the products in the following order:
1. Top-most SAM server


If EMC M&R is included, this is the Presentation SAM 
server.
If EMC M&R is not included, this is the top-most SAM 
server and related Service Assurance products and 
consoles in your deployment, either a SAM server or 
the top SAM server in a hierarchical SAM deployment. 


2. If EMC M&R is included, update EMC M&R platform 
(core) components and the SolutionPack for EMC 
Smarts.


Ensure that communication exists between the 
Presentation SAM server and the SolutionPack for EMC 
Smarts.


3. An Aggregation SAM server if it is a hierarchical SAM 
deployment.


4. IP Manager.


5. Any order: Server Manager, MPLS Manager, Network 
Protocol Manager, and VoIP Availability Manager.


Notice: Presentation SAM server is the server that is 
configured in the SolutionPack for EMC Smarts for use 
with the EMC M&R UI. This does not mean that a 
hierarchical SAM is required.


• For EMC Smarts products: “Performing an Upgrade” on 
page 45


• For EMC M&R platform components: Service 
Assurance Suite Installation and Configuration Guide 
for EMC M&R


• SolutionPack for EMC Smarts Summary Sheet article 
• How to Set Up SAM, EMC M&R, and the SolutionPack 


for EMC Smarts article


After you install


Evaluate your custom code and review the tools for 
restoring user customization.


“Custom file migration use cases” on page 83


(Optional) Update your license, if you installed additional 
products and they are not licensed features.
Otherwise, existing licenses are supported for 9.4.2 
products. No user action is required.


“Obtain and install a temporary license file” on page 95
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Migration tasks overview
To migrate to Version 9.4.2, you need to meet the requirements or perform the tasks that 
are listed in Table 3 on page 17.


If your product is part of a deployment that requires the 
Federal Information Processing Standard (FIPS) 
Publication 140-2, a U.S. government computer security 
standard governing cryptographic modules, perform the 
procedure to upgrade products in FIPS mode.


“Upgrading 9.4.2 products in FIPS mode” on page 54


If you installed the products as services, start them for 
the first time. 


• “Starting services on UNIX” on page 97
• “Start programs” on page 98


Verify the current state of the products and the Broker. “Verify the product status” on page 102


(Optional) After performing an upgrade and modifying 
your configuration files on one installation, you can use 
the deployment utility to create a deployment package of 
your configuration changes and deploy the package on 
other installations. After deploying the package on other 
installations, you do not have to run the migrate utility to 
merge your customizations.


“Deployment utility overview” on page 89


Table 2  Upgrade installation requirements and tasks (page 2 of 2)


Table 3  Migration requirements and tasks (page 1 of 2)


Before you migrate


Review the release notes for important issues. EMC Smarts Release Notes for SAM, IP, ESM, MPLS, NPM, 
OTM, and VoIP Managers


Determine if the products are supported for your 
platform.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix


Determine if your system meets the hardware 
requirements.


EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix
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Installation and migration


The order in which you migrate products depends on 
whether the EMC M&R UI is included in your deployment. 
Perform the migration in the following order:
1. Top-most SAM server


If EMC M&R is included, this is the Presentation SAM 
server.
If EMC M&R is not included, this is the top-most SAM 
server and related Service Assurance products and 
consoles in your deployment, either a SAM server or 
the top SAM server in a hierarchical SAM deployment. 


2. If EMC M&R is included, migrate or update EMC M&R 
platform (core) components and the SolutionPack for 
EMC Smarts.


Ensure that communication exists between the 
Presentation SAM server and the SolutionPack for EMC 
Smarts.


3. An Aggregation SAM server if it is a hierarchical SAM 
deployment.


4. IP Manager.


5. Any order: Server Manager, MPLS Manager, Network 
Protocol Manager, and VoIP Availability Manager.


Notice: Presentation SAM server is the server that is 
configured in the SolutionPack for EMC Smarts for use 
with the EMC M&R UI. This does not mean that a 
hierarchical SAM is required.


• For EMC Smarts products: “Performing a Migration” on 
page 55.


• For EMC M&R platform components: Service 
Assurance Suite Installation and Configuration Guide 
for EMC M&R


• SolutionPack for EMC Smarts Summary Sheet article 
• How to Set Up SAM, EMC M&R, and the SolutionPack 


for EMC Smarts article


After you install


Evaluate your custom code and review the tools for 
restoring user customization.


“Custom file migration use cases” on page 83


If you installed the products as services, start them for 
the first time.


• “Starting services on UNIX” on page 97
• “Start programs” on page 98


Save your license in the proper location:
• Evaluation license – Save <license_name>.lic to the 


BASEDIR/smarts/local/conf directory.
• Permanent license – Use the procedures described in 


the EMC Smarts System Administration Guide.
(Optional) Update your license, if you installed additional 
products and they are not licensed features.
Otherwise, existing licenses are supported for 9.4.2 
products. No user action is required.


“Obtain and install a temporary license file” on page 95


Verify the current state of the products and the Broker. “Verify the product status” on page 102


(Optional) After performing a migration and modifying 
your configuration files on one installation, you can use 
the deployment utility to create a deployment package of 
your configuration changes and deploy the package on 
other installations. After deploying the package on other 
installations, you do not have to run the migrate utility to 
merge your customizations.


“Deployment utility overview” on page 89


Table 3  Migration requirements and tasks (page 2 of 2)
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Uninstallation tasks overview
To uninstall the product, you need to meet the requirements or perform the tasks that are 
listed in Table 4 on page 19.


Table 4  Uninstallation requirements and tasks 


Before you uninstall


Review uninstall prerequisites. “Performing an Uninstallation” on page 111


Uninstallation


Uninstall the product. • “Uninstall using Wizard mode” on page 117
• UNIX only, “Uninstall using CLI mode” on page 118
• “Uninstall using Unattended mode” on page 119
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CHAPTER 2
Performing an Installation


This chapter describes how to install a new installation of the EMC Smarts Service 
Assurance Manager, EMC Smarts IP Manager, EMC Smarts MPLS Manager, EMC Smarts 
Server Manager, EMC Smarts Network Protocol Manager, EMC Smarts Optical Transport 
Manager, and EMC Smarts VoIP Availability Manager. It consists of the following topics:


◆ Installation overview ...............................................................................................  22
◆ Installation prerequisites ........................................................................................  23
◆ Install the product...................................................................................................  23
◆ Add additional features to a new installation...........................................................  34
◆ Support for FIPS 140-2 for 9.4.2 products ...............................................................  34
◆ Next steps...............................................................................................................  38
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Installation overview
The installation flow is shown in Figure 2 on page 22. A new installation installs a new 
version of a product on a host system that either has no software installed or has a 
previous version of the software installed. Chapter 4, “Performing an Upgrade,” provides 
instructions to install an upgrade installation.


Figure 2  New installation flowchart
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Installation prerequisites
Fulfill the following prerequisites before starting the installation:


◆ Ensure that you have superuser (User ID 0) or administrative privileges on the target 
host. The installation program will halt if you do not have the appropriate privileges.


◆ Ensure that the required operating system patches have been installed. Clicking More 
Information during the installation process will launch the System Information 
window and the Pass/Fail status of the operating system patches. The EMC Smarts 
SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix provides 
information on operating system patches.


◆ Determine the location of the EMC Smarts Broker.


You must specify the location of the Broker during a new installation of EMC Smarts 
software. Typically, this location is chosen during the design of the EMC Smarts 
software deployment and before any installation begins. Consult with your 
deployment planner or check the build guide that documents your deployment to 
determine the name of the host where the Broker was installed and the port that the 
Broker uses. 


If the location is the same host where you are installing this product, the installation 
program will automatically install the Broker if it is not already on the host.


◆ (Service Assurance Manager only) Decide whether your operators will use the Service 
Assurance Manager Notification Console (classic SAM functionality) or the 
SolutionPack for EMC Smarts (in EMC M&R) to view and acknowledge notifications. If 
you plan to use the SolutionPack for EMC Smarts, you must install additional features 
and services when you install Service Assurance Manager.


Install the product
You acquire the software for the EMC Smarts Service Assurance Manager, EMC Smarts IP 
Manager, EMC Smarts MPLS Manager, EMC Smarts Server Manager, EMC Smarts Network 
Protocol Manager, EMC Smarts Optical Transport Manager, and EMC Smarts VoIP 
Availability Manager in one of two ways:


◆ From the installation CD/DVD-ROM.


Insert the CD/DVD-ROM into the optical drive of the host system. Appendix C, 
“Procedures for CD/DVD-ROMs,” describes how to access the optical drive for various 
operating systems.


When you insert the installation CD/DVD, several minutes might pass between the 
InstallShield preparation screen and the EMC Smarts splash screen/installation 
dialog boxes. Be patient. Do not eject/reinsert the CD/DVD to start a second install 
process.


◆ From the EMC online support website.


Go to the EMC online support website and download the installation file that is 
specific to your platform.


You install each product in one of three ways: Wizard mode, CLI mode, or Unattended 
mode.
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Install using Wizard mode


Wizard mode provides a graphical user interface to the installation program for UNIX and 
Windows platforms.


On UNIX systems, Wizard mode uses the X Window System to display the installation 
wizard. The host on which you install the EMC Smarts software and the host where you log 
in must be configured to run the X Window System. Before starting the installation 
program using the Wizard mode, verify that the X Window System is running.


At the start of the installation, the installation program detects and stops all services, 
scheduled jobs, and processes that use programs or libraries that are running from the 
previous installation. It also stops the service daemon, sm_serviced, if it is running.


Be aware that In some cases, on Windows, services cannot be stopped by the installation 
program because multiple threads are locking the services. In those cases, use the 
Windows Control Panel to stop the services manually.


For instructions on installing the Service Assurance Manager Server in wizard mode, 
complete the steps in the following section. To install other Service Assurance Manager 
products after Server install, refer to “Installing the Service Assurance Manager Console, 
or the Smarts NOTIF Editor, or both” on page 32, and “Add additional features to a new 
installation” on page 34.


Running Wizard mode
1. Run the setup command that is appropriate for the operating system as shown in 


Table 5 on page 24.


Table 5  Server setup command syntax for Wizard mode (page 1 of 2)


Product Operating system Setup command


Service Assurance Manager Server


Notice: For setup command syntax for other 
Service Assurance Manager products, refer to 
“Installing the Service Assurance Manager 
Console, or the Smarts NOTIF Editor, or both” 
on page 32.


Linux ./setup-SAM-9_4_2_0-linux64.bin


Windows setup-SAM-9_4_2_0-win64.exe


IP Manager Linux ./setup-IP-9_4_2_0-linux64.bin


Windows setup-IP-9_4_2_0-win64.exe


MPLS Manager Linux ./setup-MPLS-9_4_2_0-linux64.bin


Windows setup-MPLS-9_4_2_0-win64.exe


Server Manager Linux ./setup-ESM-9_4_2_0-linux64.bin


Windows setup-ESM-9_4_2_0-win64.exe
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UNIX users: If the current directory is not set in your PATH variable, prepend the 
command with./ (a period followed by a forward slash).


The InstallShield wizard dialog box appears and closes. The Shutdown Programs 
dialog box and the Welcome screen appear.


2. Click OK in the Warning dialog box.


If stopping services is necessary, you will be prompted with specific instructions later 
in the installation process.


3. Click Next in the Welcome screen.


Next is disabled if you do not have administrative privileges and a message also 
appears. To install, you must restart the installation with the appropriate privileges.


4. Read and accept the EMC Corporation end user license agreement and click Next.


5. If the installation program detects an existing installation of the same product, the 
Upgrade or Install screen appears. In the Upgrade or Install screen, select Install 
products to a new directory.


6. Click Next to accept the default installation directory or type your preferred directory 
and click Next. 


The default installation directory is:


If you specify a directory, the directory name cannot contain spaces. If the specified 
directory does not exist, it will be created. If you do not have write privileges, an error 
message appears.


Network Protocol Manager Linux ./setup-NPM-9_4_2_0-linux64.bin


Windows setup-NPM-9_4_2_0-win64.exe


Optical Transport Manager Linux ./setup-OTM-9_4_2_0-linux64.bin


Windows setup-OTM-9_4_2_0-win64.exe


VoIP Availability Manager Linux ./setup-VOIP-9_4_2_0-linux64.bin


Windows setup-VOIP-9_4_2_0-win64.exe


Table 5  Server setup command syntax for Wizard mode (page 2 of 2)


Product Operating system Setup command
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7. In the Installation Type screen, select:


• Complete to install all the products, including the EMC Data Access API (EDAA) 
feature. Click Next.


• Custom to install a specific product. Click Next.


a. In the Choose Products screen, clear the checkboxes for products that you do 
not want to install (by default, all products are selected).


b. (Service Assurance Manager only) 


If you plan to use the EMC M&R UI and the Service Assurance Manager in this 
installation as the Presentation SAM server (interoperate with the SolutionPack 
for EMC Smarts), ensure you select Service Assurance Manager and EMC Data 
Access API (EDAA).


If you want to use the Service Assurance Manager and the EMC Data Access API 
(EDAA) feature without the EMC M&R UI, ensure you select Service Assurance 
Manager and EMC Data Access API (EDAA).


c. Click Next.


8. In the Services Selection screen, select the products that you want to install as 
services and click Next. If you do not install services at this point, you will need to 
install them manually later.


For Service Assurance Manager services, you have two choices:


• Select EMC Smarts Service Assurance Manager Server if you plan to run only the 
Service Assurance Manager.


• Select EMC Smarts Service Assurance Manager Server (notification cache 
publishing) if you plan use the EMC M&R UI and the Service Assurance Manager.


When installed as services, the products start automatically whenever the host starts 
up. EMC Corporation recommends that EMC Smarts products be installed as services 
whenever possible.


If you are migrating from a previous version to 9.4.2 on the same host, you need to 
decide whether to install services during the 9.4.2 installation or to install them 
manually after the installation. Installing services during the installation will override 
the services for the previous version of installed products.


For the same-host migration scenario, and assuming that you want to continue to run 
the previous version of installed products, you have two choices:


• Install services during the 9.4.2 installation and then, after the installation, 
manually install services with unique names for the previous version of installed 
products.


• Do not install services during the 9.4.2 installation and then, after the installation, 
manually install services with unique names for the 9.4.2 products.


Appendix B, “Manually Installing Services,” describes how to install services 
manually.
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9. (Service Assurance Manager only) If you selected the EMC Smarts Service Assurance 
Manager Server (notification cache publishing) service, select the EMC Data Access 
API services for:


• EMC Smarts Data Web Applications (Tomcat) 


• EMC Smarts Notification Exchange (Rabbit MQ)


• EMC Smarts Notification Cache (ElasticSearch)


10. (MPLS Manager only) The Domain Group Naming screen is displayed. Either accept the 
default (INCHARGE-MPLS) or enter a new name. 


The domain group name is the name given to the MPLS Manager that is made up of 
MPLS Topology Server, MPLS Monitoring Server, and MPLS Analysis Server. If you 
change the name of the MPLS Manager, the names of the three servers are changed 
accordingly. 


You may want to define Domain Groups by geographical coverage. You could create a 
Domain Group for corporate headquarters and change INCHARGE-MPLS to HQ-MPLS, 
and later, a group for South America as SA-MPLS. The only requirement at this time is 
that you must install all services for any Domain Group on the same host. Even if you 
know that you are going to change the name of the Domain Group, you can perform 
the renaming step later, either through the Global Console or through a script from the 
command line. Appendix D, “Using the MPLS server_config Utility,” provides more 
information.


11. In the Broker Specification screen, specify the EMC Smarts Broker.


• If you are installing the Broker as a service, specify the port. The hostname defaults 
to localhost, where localhost is a literal name.


• If the Broker is already running on this host, keep the default values.


• If the Broker is running on another host, specify the hostname of that system and 
the port that the Broker uses.


Click Next to continue.


12. The Installation Criteria screen appears. Review the list of products that will be 
installed and the target installation directory. At the bottom of the list, the total 
amount of disk space that is required for the selected products is provided so that you 
can verify that adequate disk space is available. To install the products, click Next and 
the Installation Progress screen appears.


13. Upon completion, the Installation Summary shows informational messages such as 
successful confirmations, error messages, and warnings. Investigate any errors or 
warnings.


If Next appears, your system needs to be rebooted because one or both of the 
following tasks are pending on the system:


• A system-protected file was replaced during the installation and requires a restart.


• A pending restart was triggered by another application or by an operating system 
patch installation.


Click Next and then reboot your system. Otherwise, click Finish to exit the installation.
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The installation program writes an install log file to the BASEDIR/smarts/setup/logs 
directory, unless the installation fails at the very start, in which case the installation 
program writes the log file to the /tmp directory. The log file is a text file with the 
naming convention Install.<product>.<productversionNumber>.log.


14. If your product is part of a deployment that requires the Federal Information 
Processing Standard (FIPS) Publication 140-2, a U.S. government computer security 
standard governing cryptographic modules, follow the instructions in “Support for 
FIPS 140-2 for 9.4.2 products” on page 34.


15. “Next steps” on page 38 provides post-installation tasks.


For instructions on installing the Service Assurance Manager Server in CLI mode, complete 
the steps in the following section. To install other Service Assurance Manager products 
after Server install, refer to “Installing the Service Assurance Manager Console, or the 
Smarts NOTIF Editor, or both” on page 32.


Install using CLI mode


CLI mode provides a text-based method for invoking the installation program. This mode 
is intended for UNIX platforms with non-graphics consoles. The CLI mode follows the same 
process flow as the Wizard mode but uses text rather than graphics.


Running CLI mode
To start the CLI mode, invoke the setup command with the -console command-line option.


Table 6  Setup command syntax for CLI mode (page 1 of 2)


Product Operating system Executable


Service Assurance Manager 
Server


Linux ./setup-SAM-9_4_2_0-linux64.bin -console


Windows setup-SAM-9_4_2_0-win64.exe -console


Service Assurance Manager 
Console


Linux ./setup-CONSOLE-9_4_2_0-linux.bin -console


Windows setup-CONSOLE-9_4_2_0-win.exe -console


IP Manager Linux ./setup-IP-9_4_2_0-linux64.bin -console


Windows setup-IP-9_4_2_0-win64.exe -console


MPLS Manager Linux ./setup-MPLS-9_4_2_0-linux64.bin -console


Windows setup-MPLS-9_4_2_0-win64.exe -console


Server Manager Linux ./setup-ESM-9_4_2_0-linux64.bin -console


Windows setup-ESM-9_4_2_0-win64.exe -console
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User selections and navigation in CLI mode
During the installation and uninstallation processes, you are prompted with a series of 
steps and menus:


◆ For prompts, accept the default value or select another choice. The default values are 
indicated in brackets. To accept the default value, press Enter. To reply “yes,” enter y 
or Y; to reply “no,” enter n or N. Do not press Delete because doing so will cause the 
process to terminate with an error message.


◆ For selections in menus, accept the default selections or type the number of the item 
and press Enter. The default values are indicated in brackets or as pre-defined 
selections in menus. An X is used to indicate the selected item. When you are finished 
making selections, type zero (0) and press Enter.


If you incorrectly type an entry, press 5 to repeat the prompt and select the correct value. 
Arrow keys and the Backspace key are not supported.


To navigate between each step, use the keys described in Table 7 on page 29.


If your product is part of a deployment that requires the Federal Information Processing 
Standard (FIPS) Publication 140-2, a U.S. government computer security standard 
governing cryptographic modules, follow the instructions in “Support for FIPS 140-2 for 
9.4.2 products” on page 34.


“Next steps” on page 38 provides post-installation tasks.


Network Protocol Manager Linux ./setup-NPM-9_4_2_0-linux64.bin -console


Windows setup-NPM-9_4_2_0-win64.exe -console


Optical Transport Manager Linux ./setup-OTM-9_4_2_0-linux64.bin -console


Windows setup-OTM-9_4_2_0-win64.exe -console


VoIP Availability Manager Linux ./setup-VOIP-9_4_2_0-linux64.bin -console


Windows setup-VOIP-9_4_2_0-win64.exe -console


Table 6  Setup command syntax for CLI mode (page 2 of 2)


Product Operating system Executable


Table 7  Navigation keys 


Key Operation


1 Next, continue to the next step


2 Previous, go back to the previous step


3 Cancel, terminate the program


5 Redisplay, repeat the step


0 Accept the marked ([X]) menu choice
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Install using Unattended mode


Unattended mode is supported for all operating systems, but separate response files are 
needed for UNIX and Windows systems. Unattended mode reads the selections and 
settings for the installation from a user-modifiable response file, which enables you to 
easily duplicate the installation on many computer systems. Manual intervention is not 
necessary after you execute the setup command.


The response file, named <product>-response.txt, is located on the CD/DVD-ROM in the 
/utils directory. The file provides instructions and examples of command line options that 
are passed to the installation program in Unattended mode. The command line options 
are organized by process flow, which is almost identical to that of Wizard mode or CLI 
mode.


For instructions on installing the Service Assurance Manager Server in Unattended mode, 
complete the steps in the following section. To install other Service Assurance Manager 
products after Server install, refer to “Installing the Service Assurance Manager Console, 
or the Smarts NOTIF Editor, or both” on page 32.


Modifying the response file
To modify the response file:


1. Copy the response file from the CD/DVD’s /utils directory to a directory on your host, 
for example, to the /tmp directory.


2. Using a text editor, modify the values for the command line options in the response 
file:


a. Specify the target directory.


b. Select a directory for the process log file.


c. Select the products to install. Ensure that the property value for the product is set 
to true.


d. Select the products to start as services. Ensure that the property value for the 
product is set to true.


e. Specify the location of the Broker. By default, the location is set to localhost at port 
426.


3. Save the file.


Running Unattended mode
To start the Unattended mode, invoke the setup command with the -options 
command-line option, followed by the full path to the response file as described in Table 8 
on page 31.
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For example for MPLS Manager, to start the Unattended mode of installation on Linux 
when the response file is located in /opt/home, enter:


./setup-MPLS-9_4_2_0-linux64.bin -options /opt/home/MPLS_SUITE-response.txt


If your product is part of a deployment that requires the Federal Information Processing 
Standard (FIPS) Publication 140-2, a U.S. government computer security standard 
governing cryptographic modules, follow the instructions in “Support for FIPS 140-2 for 
9.4.2 products” on page 34.


“Next steps” on page 38 provides post-installation tasks.


Table 8  Setup command syntax for Unattended mode 


Product Operating system Executable


Service Assurance 
Manager Server


Linux ./setup-SAM-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-SAM-9_4_2_0-win64.exe -options <path>\<product>-response.txt


Service Assurance 
Manager Console


Linux ./setup-CONSOLE-9_4_2_0-linux.bin -options <path>/<product>-response.txt


Windows setup-CONSOLE-9_4_2_0-win.exe -options <path>\<product>-response.txt


IP Manager Linux ./setup-IP-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-IP-9_4_2_0-win64.exe -options <path>\<product>-response.txt


MPLS Manager Linux ./setup-MPLS-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-MPLS-9_4_2_0-win64.exe -options <path>\<product>-response.txt


Server Manager Linux ./setup-ESM-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-ESM-9_4_2_0-win64.exe -options <path>\<product>-response.txt


Network Protocol Manager Linux ./setup-NPM-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-NPM-9_4_2_0-win64.exe -options <path>\<product>-response.txt


Optical Transport Manager Linux ./setup-OTM-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-OTM-9_4_2_0-win64.exe -options <path>\<product>-response.txt


VoIP Availability Manager Linux ./setup-VOIP-9_4_2_0-linux64.bin -options <path>/<product>-response.txt


Windows setup-VOIP-9_4_2_0-win64.exe -options <path>\<product>-response.txt


where <path> is the fully qualified path to the response file and <product> is the product name, for example, IP_NETWORK_SUITE, 
MPLS_SUITE, or SAM_SUITE.
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Additional Service Assurance Manager installation tasks


If you are installing other Service Assurance Manager components such as the:


◆ Service Assurance Manager Console 
◆ Smarts NOTIF Editor
◆ Both the Service Assurance Manager Console and the Smarts NOTIF Editor


follow one of the installation procedures for each component included in, “Installing the 
Service Assurance Manager Console, or the Smarts NOTIF Editor, or both” on page 32.


You can view and acknowledge notifications in the Notification Console in Service 
Assurance Manager or you can manage notifications from the EMC M&R user interface by 
installing the SolutionPack for EMC Smarts. The SolutionPack for EMC Smarts Summary 
Sheet article provides installation instructions. The How to Set Up SAM, EMC M&R, and 
the SolutionPack for EMC Smarts article provides instructions on configuring Service 
Assurance Manager to work with EMC M&R. 


Installing the Service Assurance Manager Console, or the Smarts NOTIF Editor, or 
both


This section describes the steps for installing the Service Assurance Manager Console, or 
the Smarts NOTIF Editor, or both the Service Assurance Manager Console and the Smarts 
NOTIF Editor. Make sure you install the Service Assurance Manager Server first.


Install Service Assurance Manager Console, or the Smarts NOTIF Editor, or both using Wizard mode
To install the Service Assurance Manager Console:


1. Run the Setup command appropriate for the operating system listed in Table 9 on 
page 32.


The InstallShield wizard dialog box appears and closes. The Shutdown EMC Smarts 
Programs dialog box and the Welcome screen appear.


2. Click OK in the Warning dialog box.


If stopping services is necessary, specific instructions prompts appear later in the 
installation process.


3. Click Next in the Welcome screen.


Next is disabled if you do not have administrative privileges and a message also 
appears. To install, you must restart the installation with appropriate privileges.


4. Read and accept the EMC Corporation end user license agreement and click Next.


Table 9  Console setup command syntax for Wizard mode


Operating system Setup command


Linux ./setup-CONSOLE-9_4_2_0-linux.bin


Windows setup-CONSOLE-9_4_2_0-win.exe
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5. If the installation program detects an existing installation of the same product, the 
Installation Type screen appears. 


Select Install the product to a new directory.


This screen does not display if you are installing the product for the first time on the 
system.


6. Click Next to accept the default installation directory or type your preferred directory 
and click Next.


If you specify a directory, the directory name cannot contain spaces. If the specified 
directory does not exist, it will be created. If you do not have write privileges, an error 
message appears.


7. In the Setup screen, select one of the following:


• Complete to install all Service Assurance Manager Console components. Click 
Next.


• Custom to install a specific product. Click Next.


a. Clear products that you do not want to install (by default, all products are 
selected). From this screen, you may choose to install either the Global Console 
or the Smarts NOTIF Editor. 


b. Click Next.


8. In the type of Global Console installation screen, select:


• Global Console, Web Console, and Business Dashboard. Click Next. 


• Global Console. Click Next.


9. The Services Selection screen appears. Select the products that you want to install as 
services and click Next. If you do not install services at this point, you must install 
them manually later.


If you have an older version of a service running on the host, you must stop that 
service before installing a new version of the service.


When installed as services, EMC Smarts products start automatically when the system 
starts up. If the system is stopped and restarted, the EMC Smarts products restart 
automatically. EMC Corporation recommends that EMC Smarts products be installed 
as services whenever possible. If any of the products that are being installed can be 
started as services, these products are displayed in the services selection screen. 


10. Specify the EMC Smarts Broker:


• If the Broker is already running on this host, keep the hostname default value and 
change the Broker port accordingly if it is not running on port 426.


• If the Broker is running on another host, specify the hostname of that system and 
the port the Broker uses.


Click Next to continue.
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11. Review the list of products that will be installed and the target installation directory. At 
the bottom of the list, the total amount of disk space required for the selected 
products is provided so that you can verify that adequate disk space is available. To 
install the products, click Next and the Installation Progress screen appears.


12. Upon completion, the Installation Summary displays informational messages such as 
successful confirmations, error messages, and warnings. Click Finish to exit the 
installation. It is not necessary to restart the system after installation.


Investigate any errors or warnings. The log file is a text file with the naming convention 
Install.<product>.<productversionNumber>.log. It is located in the 
BASEDIR/smarts/setup/logs directory. If the installation process fails, the log files are 
located in the /tmp directory. 


13. “Next steps” on page 38 provides information on post-installation tasks.


Install Service Assurance Manager Console, or the Smarts NOTIF Editor, or both using CLI mode
“Install using CLI mode” on page 28 provides information on installing Service Assurance 
Manager Console, or the Smarts NOTIF Editor, or both using CLI mode.


Install Service Assurance Manager Console, or the Smarts NOTIF Editor, or both using unattended 
mode


“Install using Unattended mode” on page 30 provides information on installing Service 
Assurance Manager Console, or the Smarts NOTIF Editor, or both using unattended mode.


Add additional features to a new installation
If after installing a new installation you want to add products to the new installation, run 
the installation again, select the Add additional features option in the Upgrade or install 
screen, and select all products that are already installed plus any other products that you 
would like to install in the new installation. Then proceed to “Next steps” on page 38.


Support for FIPS 140-2 for 9.4.2 products
The Federal Information Processing Standard (FIPS) Publication 140-2 is a U.S. 
government computer security standard governing cryptographic modules. FIPS 140 is 
required for any software purchased by the U.S government and U.S military. This release 
specifically addresses U.S Government accounts which require FIPS 140 compliance.


A configuration parameter, SM_FIPS140, has been introduced for FIPS 140 in the 
runcmd_env.sh file. The SAM or EMC Smarts administrator can enable or disable this 
parameter as required. The default value of this parameter is FALSE.
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FIPS 140 mode allows you to use SNMP V1, SNMPV2C, SNMP V3, with SHA and AES 128 
protocols. FIPS 140 does not support the DES privacy protocol or the MD5 authentication 
protocol. When you discover an SNMPv3 device, you need to select the option “V3” in the 
“Add Agent” window. The “Authentication Protocol” option lists only SHA and not MD5, 
and the “Privacy Protocol” option lists only AES and not DES. This is because MD5 and 
DES are not supported in FIPS 140 mode. When you discover SNMPv3 devices with MD5 
and DES protocol as seed, the devices go to the Pending List and display as “Invalid” or 
“Unsupported SNMP V3 protocol.”


FIPS 140 mode cannot be enabled or disabled after a server is started. FIPS 140-enabled 
Domain Managers such as MPLS Manager, IP Manager, Service Assurance Manager, and 
Server Manager can work only with the SAM Global Console 9.x or later for FIPS 140-2 
mode.


A non-FIPS 140 mode Broker will not be able to communicate with a FIPS 140-enabled 
Manager (IP server, SAM server, or Domain Manager). Trying to establish such a 
connection will result in the enabled Manager going into a DEAD state after couple of 
minutes. Communication should always happen between FIPS 140-enabled Brokers and 
Managers.


Inter-domain and FIPS 140 Broker communication happens only when the Broker, 
Managers, and the SAM Console are all in FIPS 140 mode, else the application will not be 
operational.


This section covers the following scenarios for FIPS 140:


◆ “Enabling FIPS 140 mode on a new installation” on page 35


◆ “Disabling FIPS 140 mode” on page 38


◆ “Verify the FIPS 140 mode status” on page 103


Enabling FIPS 140 mode on a new installation


When you install a 9.4.2 product, FIPS 140 is not enabled by default. You must enable FIPS 
140 on a clean installation or an upgrade, before the servers are started, using the 
following procedure:


1. Back up the imk.dat, brokerConnect.conf, serverConnect.conf and clientConnect.conf 
files from the existing installation. These files are located in the BASEDIR/local/conf 
folder.


The backup is necessary in case you need to disable FIPS 140 mode and remove FIPS 
140-2 encryption.
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2. Run the following command at the command line prompt:


sm_rebond --upgrade --basedir=<BASEDIR>/smarts


For example for Service Assurance Manager, run the command:


UNIX


sm_rebond --upgrade --basedir=/opt/InCharge/SAM/smarts


Windows


sm_rebond --upgrade --basedir=C:\InCharge\SAM\smarts


The path must be set to the default install path. Regardless of the FIPS 140 state, the 
sm_rebond command must be invoked from the BASEDIR where the software is 
installed, not from any other product installation area which also has the sm_rebond 
utility.


3. When prompted, type a password to regenerate the imk.dat file. The default password 
is Not a secret.


4. Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. The 
file is located under the BASEDIR/smarts/local/conf directory.


Enabling FIPS 140 mode on SAM Web Console
1. Perform steps 1 - 3 as described in the section, “Enabling FIPS 140 mode on a new 


installation”  on page 35.


2. Go to the <BASEDIR>/smarts/jre/lib/security folder, and in the java.security file, 
change:


“sun.security.rsa.SunRsaSign” to “com.rsa.jsafe.provider.JsafeJCE” and 
“com.sun.net.ssl.internal.ssl.Provider” to “com.rsa.jsse.JsseProvider.”


3. Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This 
file is located under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global 
Console installation.
or
Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui 
command.
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Enabling FIPS 140 mode on SAM Dashboard
1. Perform steps 1 - 3 as described in the section, “Enabling FIPS 140 mode on a new 


installation”  on page 35.


2. Set the value for the com.smarts.fips_mode to TRUE in the corresponding 
webconsole.properties file (located under 
<BASEDIR>/InCharge/CONSOLE/smarts/tomcat/webapps/webconsole folder)
or
dashboard.properties file (located under 
<BASEDIR>/InCharge/CONSOLE/smarts/tomcat/webapps/templates).


3. Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This 
file is located under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global 
Console installation.
or
Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui 
command.


Enabling FIPS 140 mode on SAM NOTIF
1. Perform steps 1 - 3 as described in the section, “Enabling FIPS 140 mode on a new 


installation”  on page 35.


2. Go to the <BASEDIR>/CONSOLE/smarts/notif/editor/ or the 
<BASEDIR>/SAM/smarts/notif/editor folder, and edit the NotifGui.bat/NotifGui.sh file 
to replace the string, “com.netmg.notif.gui.NotifApplication” with 
“-Dcom.smarts.fips_mode=true com.netmg.notif.gui.NotifApplication.”


3. Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This 
file is located under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global 
Console installation.
or
Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui 
command.


If you install the servers as a service on Linux platforms, the services will start 
automatically after you issue the sm_rebond command. First stop the services, modify 
SM_FIPS140=TRUE in the runcmd_env.sh file, and then manually start the services.


After enabling FIPS 140 mode, when you start the broker and the SAM server, you may see 
the following message in the server log: 


“CI-W-NOCGSS-No certificate loaded for INCHARGE-AM, generating 
self-signed certificate.”


This message is generated because FIPS 140 requires secure communication, which can 
be achieved using SSL. If this certificate is not available, the SAM Manager generates a 
self-signed certificate. This message is benign in nature and does not impact functionality.
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Disabling FIPS 140 mode


To disable FIPS 140:


1. Replace the imk.dat, brokerConnect.conf, serverConnect.conf and clientConnect.conf 
files in the BASEDIR/local/conf folder, with the copies saved from prior to ““Enabling 
FIPS 140 mode on a new installation” on page 35”. If you do not have a copy of these 
files saved, contact Technical Support.


2. Set the value for the SM_FIPS140 parameter to FALSE in the runcmd_env.sh file. This 
file is located under BASEDIR/smarts/local/conf/runcmd_env.sh.


3. Restart all processes, such as the Broker, Domain Managers, SAM Global Manager, 
and Global Console.


RPS files started under FIPS mode cannot be re-used in non-FIPS mode. Domains will need 
to be started either from scratch or pre-FIPS RPS files can be used in cases where 
topologies have not changed. Restoring from older RPS files may not be productive as it 
will not contain any recent topology.


Next steps
Perform the following tasks:


◆ “Obtain and install a temporary license file” on page 95 describes tasks for obtaining 
and saving a new license file.


◆ Chapter 5, “Performing a Migration,” describes additional tasks if you are migrating 
from a previous version of the product.


◆ Chapter 7, “Verifying the Installation,” describes tasks for verifying the proper 
installation of the software and starting services.


◆ For EMC Smarts Optical Transport Manager (OTM), complete the post-installation 
configuration tasks as described in Appendix E, “EMC Smart Optical Transport 
Manager Configuration.”
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CHAPTER 3
NAS Installation and Startup


This chapter covers installation and startup issues for the EMC Smarts IP Availability 
Manager Extension for NAS. Topics in this chapter are:


◆ Overview.................................................................................................................  40
◆ Installing and starting the HTTPS Adapter service ....................................................  40
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Overview
The NAS Extension is installed with the IP Availability Manager. After installation, the IP 
Availability Manager can discover NAS devices, and perform root cause and impact 
analysis on these devices. 


Configuring the NAS Extension involves the tasks summarized in Table 10 on page 40.


Installing and starting the HTTPS Adapter service
The NAS Extension software includes an adapter process (the HTTPS Adapter), which 
probes the Celerra devices using the HTTPS/XML probe to obtain internal topology 
information. While the installation of this adapter is automatic, you must install the 
service and start it manually. Install the HTTPS Adapter as a service and start the service 
manually, as described next for UNIX and Windows.


Once started, the HTTPS Adapter registers with the Broker. The EMC Smarts System 
Administration Guide provides more information about starting services.


UNIX:


To install the HTTPS Adapter as a service on UNIX, issue the following command:


# sm_service install --force --unmanaged --startmode=manual \
'--name=<service_name>' \
'--description=<Smarts description>' \
'BASEDIR/smarts/bin/sm_adapter_java' 
'--name=<HTTPS_Adapter_Name>' \
'--output=<HTTPS_Adapter_Name>.log' \
'-J' \
'nas_probe.jar'


Table 10  Steps for configuring the NAS Extension


Procedure Reference


If necessary, configure the HTTPS Adapter to 
support access to the managed Celerra 
devices.


For information about this requirement, refer to 
the “Configuring Control Station usernames and 
passwords” chapter in the EMC Smarts IP 
Manager User Guide.


If necessary, configure external Control 
Station and Data Mover IP addresses.


For information about this requirement, refer to 
the “Configuring Control Station and Data Mover 
IP addresses” chapter in the EMC Smarts IP 
Manager User Guide, which also refers you to the 
appropriate EMC documentation, if needed.


Install the HTTPS Adapter as a service and 
start the service.


“Installing and starting the HTTPS Adapter 
service” on page 40.


Start the IP Availability Manager. EMC Smarts Installation Guide for SAM, IP, ESM, 
MPLS, NPM, OTM, and VoIP Managers


Start the Global Manager. EMC Smarts Installation Guide for SAM, IP, ESM, 
MPLS, NPM, OTM, and VoIP Managers. 
For configuration information, refer to the EMC 
Smarts Service Assurance Manager Configuration 
Guide.


Start the Global Console. EMC Smarts Installation Guide for SAM, IP, ESM, 
MPLS, NPM, OTM, and VoIP Managers.
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Where:


<service_name> is the name registered to the service daemon. You may choose any 
name you wish for this name; for example, ic-remote-nas. When you issue the 
sm_service show command, this name appears.


<Smarts description> is the description of the service. You may create any description 
you wish; for example, Smarts remote NAS adapter.


<HTTPS_Adapter_Name> is the name of the HTTPS Adapter, as registered with the 
Broker; for example, the default name is remote-nas.


You can also specify the Broker and Port, if the IP Availability Manager with NAS Extension 
is registered with a Broker and Port other than the default, localhost:426. To do this, 
add the following arguments to the end of the command:


--broker=<IP Address or Hostname>:<Port Number>


where <IP Address or Hostname> identifies the host on which the Broker is running, 
and <Port Number> identifies which port is used by the Broker. Please note that a 
colon separates the hostname from the port.


To start the service, type the following command:


# BASEDIR/smarts/bin/sm_service start <service_name> 


To stop the service, issue the following command:


# BASEDIR/smarts/bin/sm_service stop <service_name> 


Windows:


To install the HTTPS Adapter as a service on Windows, type the following command on one 
line:


▼ sm_service install --force --name=<service_name> 
--description=<Smarts description>
--startmode=manual BASEDIR\smarts\bin\sm_adapter_java.exe  
"--name=<HTTPS_Adapter_Name>" 
"--output=<HTTPS_Adapter_Name>.log" "--jar=nas_probe.jar" ▲


Where:


<service_name> is the name registered to the service registry; this name must be 
unique to the registry. You may choose any name you wish for this name so long as the 
name has no white spaces. The following is an example, ic-remote-nas. When you 
issue the sm_service show command, this name appears.


<Smarts description> is the description of the service. You may create any description 
you wish but it is easier to find the service if all EMC Smarts services are grouped 
together. An example service description is Smarts remote NAS adapter. Service 
names display alphabetically in the Name column of the Services window located at 
Control Panel/Administrative Tools, so the example description will follow Smarts 
Performance Manager and precede Smarts Service Assurance Manager.


<HTTPS_Adapter_Name> is the name of the HTTPS Adapter, as registered with the 
Broker; for example, the default name is remote-nas.
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You can also specify the Broker and Port, if the IP Availability Manager with NAS Extension 
is registered with a Broker and Port other than the default, localhost:426. To do this, 
add the following arguments to the end of the command:


--broker=<IP Address or Hostname>:<Port Number>


Where <IP Address or Hostname> identifies the host on which the Broker is running, 
and <Port Number> identifies which port is used by the Broker. Please note that a 
colon separates the hostname from the port.


To start the service, go to the Services window and select the service name, or issue the 
following command at a command prompt:


# BASEDIR\smarts\bin\sm_service start <service_name> 


To stop the service, go to the Services window and select the service name, or issue the 
following command:


# BASEDIR\smarts\bin\sm_service stop <service_name> 


Running HTTPs adapter in FIPS mode


The NAS subsystem was changed to provide FIPS 140 support. Hence you need to 
download additional JAR (Java Archive) files, else errors are seen in the NAS log when you 
run NAS discovery.


Example NAS Log Error Snippet:


MAIN_MSG-*-STDFD_OUT-stdout: javax.net.ssl.SSLException: 
java.security.InvalidKeyException: Illegal key size


[June 17, 2011 6:37:49 PM GMT+05:30 +227ms] t@1084229984 platform
MAIN_MSG-*-STDFD_OUT-stdout:


at com.rsa.sslj.x.aJ.b(Unknown Source)
at com.rsa.sslj.x.aJ.a(Unknown Source)
at com.rsa.sslj.x.aJ.b(Unknown Source)
at com.rsa.sslj.x.aU.d(Unknown Source)
at com.rsa.sslj.x.aU.a(Unknown Source)
at com.rsa.sslj.x.aU.h(Unknown Source)
at com.rsa.sslj.x.cI.startHandshake(Unknown Source)
at 
com.smarts.nas_probe.ControlStationInterface.getSSLSocket(ControlSt
ationInterface.java:314)
at 
com.smarts.nas_probe.ControlStationInterface.post(ControlStationInt
erface.java:75)
at 
com.smarts.nas_probe.ControlStationInterface.getReply(ControlStatio
nInterface.java:58)
at com.smarts.nas_probe.XMP.NasXML(XMP.java:25)


Caused by: com.rsa.sslj.x.ax: java.security.InvalidKeyException: 
Illegal key size
at com.rsa.sslj.x.aJ.b(Unknown Source)
at com.rsa.sslj.x.cR.k(Unknown Source)
at com.rsa.sslj.x.t.f(Unknown Source)
at com.rsa.sslj.x.t$a.run(Unknown Source)
at com.rsa.sslj.x.aJ$a$a.run(Unknown Source)
at java.security.AccessController.doPrivileged(Native Method)
at com.rsa.sslj.x.aJ$a.run(Unknown Source)
... 7 more


[June 17, 2011 6:37:49 PM GMT+05:30 +229ms] t@1084229984 platform
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MAIN_MSG-*-STDFD_OUT-stdout: e
Caused by: java.security.InvalidKeyException: Illegal key size


at javax.crypto.Cipher.a(DashoA13*..)
at javax.crypto.Cipher.init(DashoA13*..)
at javax.crypto.Cipher.init(DashoA13*..)
at com.rsa.sslj.x.Y.<init>(Unknown Source)
......


With BSAFE SSL-J, some of the FIPS 140 cryptographic algorithms require Unlimited 
Strength Jurisdiction Policy Files.


Unlimited Strength Jurisdiction Policy JAR Files for NAS discovery
Download and install the Unlimited Strength Jurisdiction Policy Files to run the NAS 
adapter in FIPS mode using the following steps:


1. Download the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy 
Files 8 from the Oracle website.


2. Extract the local_policy.jar and US_export_policy.jar files from the downloaded zip 
file. 


3. Go to the smarts/jre/lib/security directory and then back up the existing policy files in 
this path. 


4. Overwrite the local_policy.jar and US_export_policy.jar files to the 
smarts/jre/lib/security directory.


If you want to switch back from FIPS mode to non-FIPS mode, reset SM_FIPS140 to FALSE. 
You do not need to remove the Unlimited Strength Jurisdiction Policy Files.
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CHAPTER 4
Performing an Upgrade


This chapter describes how to install an in-place upgrade installation for the EMC Smarts 
IP Manager, EMC Smarts MPLS Manager, EMC Smarts Server Manager, EMC Smarts 
Network Protocol Manager, and EMC Smarts VoIP Availability Manager. Upgrade topics 
include: 


◆ Upgrade installation overview .................................................................................  46
◆ Upgrade installation prerequisites ..........................................................................  49
◆ Upgrade the product ...............................................................................................  49
◆ Add additional features to an upgrade installation ..................................................  53
◆ Upgrading 9.4.2 products in FIPS mode...................................................................  54
◆ Next steps...............................................................................................................  54

Performing an Upgrade 45







Performing an Upgrade

Upgrade installation overview
This chapter describes how to perform an upgrade installation for the IP Manager, Service 
Assurance Manager, MPLS Manager, Server Manager, Network Protocol Manager, and VoIP 
Availability Manager. An upgrade installation applies a new version of software to an 
existing version in the same directory on the same host. An “upgrade installation” is also 
known as an “in-place upgrade.” During an upgrade installation, new product services are 
not available to install, unless you select additional products during the upgrade 
procedure.


You can upgrade the versions of software listed in the EMC Smarts SAM, IP, ESM, MPLS, 
NPM, OTM, and VoIP Managers Support Matrix to Version 9.4.2 using the in-place upgrade 
instructions provided in this chapter. 


The upgrade installation flow is shown in Figure 3 on page 47.


The order in which you upgrade products depends on whether the EMC M&R UI is included 
in your deployment. When deciding which Global Manager or underlying Domain Manager 
to upgrade first, perform the upgrade in the following order:


1. Start with the top-most SAM server.


• If EMC M&R is included, this is the Presentation SAM server.


• If EMC M&R is not included, this is the top-most SAM server and related Service 
Assurance products and consoles in your deployment, either a SAM server or the 
top SAM server in a hierarchical SAM deployment. 


2. If EMC M&R is included, update EMC M&R platform (core) components and the 
SolutionPack for EMC Smarts.


Ensure that communication exists between the Presentation SAM server and the 
SolutionPack for EMC Smarts.


For information, consult the Service Assurance Suite Installation and Configuration 
Guide for EMC M&R, the SolutionPack for EMC Smarts Summary Sheet article, and the 
How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts article.


3. An Aggregation SAM server if it is a hierarchical SAM deployment.


4. IP Manager.


5. Any order: Server Manager, MPLS Manager, Network Protocol Manager, and VoIP 
Availability Manager.


Presentation SAM server is the server that is configured in the SolutionPack for EMC 
Smarts for use with the EMC M&R UI. This does not mean that a hierarchical SAM is 
required.
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Figure 3  Upgrade installation flowchart
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Installer tasks


During an upgrade installation, the installation program performs the following tasks:


1. Detects and stops all services, scheduled jobs, and processes that use programs or 
libraries that are running from the existing installation. It also stops the service 
daemon, sm_serviced, if it is running.


Be aware that in some cases, on Windows, services cannot be stopped by the 
installation program because multiple threads are locking the services. In those 
cases, use the Windows Control Panel to stop the services manually.


If the broker is running on the host with a IP Manager, then it will have to be stopped 
during an upgrade. The broker has to be stopped to prevent the impact on all the 
other applications running on the system.


2. Creates a backup copy of your customizations in the 
<BASEDIR>/smarts/.migrate.bkp.<version> directory.


3. Removes the patch, if any, from the existing installation.


4. Installs the software.


5. Prompts you to merge your customizations files in the 
BASEDIR>/smarts/.migrate.bkp.<version> directory to the BASEDIR/smarts/local 
directory.


Installer-called utilities


The installation program invokes the sm_migrate utility to backup the existing 
user-customized files and base files. It also presents the sm_migrate command to be run 
after the 9.4.2 installation to complete a three-way merge of the following sets of files:


◆ Existing user-customized files in the <BASEDIR>/smarts/.migrate.bkp.<version> 
directory.


◆ Existing base files in the <BASEDIR>/smarts/.migrate.bkp.<version> directory.


◆ 9.4.2 base files in the BASEDIR/smarts directory


The sm_migrate utility invokes another utility, the sm_merge utility, for each of the files 
that requires a three-way merge. Chapter 6, “Migration Utilities,” explains how the 
sm_migrate and sm_merge utilities work.
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Upgrade installation prerequisites
Fulfill the following prerequisites before starting the upgrade installation:


◆ Ensure that you have superuser (User ID 0) or administrative privileges on the target 
host. The installation program will halt if you do not have the appropriate privileges.


◆ Ensure that the required operating system patches have been installed. Clicking More 
Information during the installation process will launch the System Information 
window and the Pass/Fail status of the operating system patches. The EMC Smarts 
SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix provides 
information on operating system patches.


◆ Remove all the unused files in the /local directory. The unused files will also include 
RPS files and custom files created by you. The upgrade process uses the sm_migrate 
utility that creates a backup of all the files in the local directory and copies them back 
to local directory after the upgrade. RPS and custom files can be large, and may slow 
down the process.


◆ Disk space requirement—During an upgrade installation, the installer creates a 
backup of files in actions, conf, model, repos, rules, script directories. Ensure that you 
have disk space of twice the size of these directories available on the system. After 
the upgrade and verifying the installation, you can archive or remove the backup 
directories. This requirement is in addition to the minimum disc requirement outlined 
for each product in the EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP 
Managers Support Matrix.


Upgrade the product
You upgrade each product in one of three ways: Wizard mode, CLI mode, or Unattended 
mode. 


Perform the following tasks:


1. Review the important release issues found in your product-specific release notes.


2. On the host where the target existing installation resides, log in as superuser (User ID 
0) or administrator.


3. Mount the CD/DVD-ROM. Appendix C, “Procedures for CD/DVD-ROMs,” provides more 
information. 


4. Choose Wizard mode, CLI mode (UNIX only), or Unattended mode. The setup 
commands for invoking Wizard mode, CLI mode, and Unattended mode are listed in 
Table 5 on page 24, Table 6 on page 28, and Table 8 on page 31.


• In Wizard mode or CLI mode, make the following additional selections:


– In the Upgrade or Install screen, select Upgrade existing suite and click Next or 
enter [1].


– In the Target Installation Selection screen (in which an existing product is 
selected unless the product was previously installed to more than one 
directory, in which case you will see multiple choices), select a target 
installation directory and click Next or enter [1].
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– In the Choose Products screen, all of the existing products are selected to be 
upgraded. You can select additional products to add to the installation.


For Service Assurance Manager only, add EMC Data Access API (EDAA) if the 
Service Assurance Manager in this upgrade is going to be configured in the 
SolutionPack for EMC Smarts and will be used as the Presentation SAM server 
for the EMC M&R UI.


– Specify any additional local directories created using SM_SITEMOD. Click Next 
or enter [1].


• In Unattended mode, specify the following additional options in the response file 
(<product>-response.txt). All previously installed products must have their product 
options set to “true” in the response file.


– Uncomment the -W INSTALL_TYPE.INSTALL_CHOICE=UPGRADE option.


– Uncomment the -W SITEMOD_BEAN.SITEMODS_VAR option, and provide one or 
more directory locations to perform an upgrade. You can provide the name of 
the directories, or the directory name with absolute path.


For example, on Linux:


-W SITEMOD_BEAN.SITEMODS_VAR=local-1:/opt/InCharge/SAM/smarts/Local-2
:local-3


on Windows:


-W SITEMOD_BEAN.SITEMODS_VAR=C:\InCharge\smarts\SAM\local3
;C:\InCharge\SAM\smarts\local2


For specifying directory separators, use : on Linux and ; on Windows.


– Uncomment the -W MERGE_OPTION_UPGRADE.MERGE_CHOICE=MERGE option 
to perform the merge.


– Uncomment the -W MERGE_OPTION_UPGRADE.MERGE_CHOICE=NOMERGE 
option to not perform the merge.


– Uncomment the -P <product>.installLocation option and set its property value to 
the installation directory of the target installation. The installation directory 
must end with /<product>.


– Ensure the property value is set to “true” for each product that is already 
installed plus any other product that you would like to add to the installation.


5. The installation program displays the Directories created using SM_SITEMOD screen 
which allows you to back up local directories that were created with SM_SITEMOD. If 
you used SM_SITEMOD to create local directories, enter a list of local directories. Click 
Next or enter [1].


The installation program then runs the sm_migrate utility to create a backup file of the 
user-customized files and base files in the existing installation. The backup file, 
named .migrate.bkp.<version>, is saved to the BASEDIR/smarts directory.
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On a Windows-based host, extracting the sm_migrate utility and performing a 
migration takes a considerable amount of time. Be patient. Do not stop the migration 
process.


6. The installation program removes the patch, if any, from the existing installation and 
installs the 9.4.2 software.


7. After the installation, the installation program shows the Restore User Configurations 
Instructions screen, which presents the sm_migrate command for restoring the old 
user-customizations in the .migrate.bkp.<version> backup file to the 
BASEDIR/smarts/local directory. The screen provides two options:


a. Yes, merge the files - Select this option if you want the utility to automatically 
merge the files modified by you.


b. No, I will merge them later - Select this option if you want to manually merge 
the files modified by you.


Click Next or enter [1] to view the Installation Summary.


For Service Assurance Manager, the upgrade process inserts the _edaa user entry into 
the security configuration file serverConnect.conf and the runcmd_env.sh file. The 
upgrade process does not modify the clientConnect.conf, brokerConnect.conf, and 
imk.dat files. The upgrade process does not insert the _edaa user entry into the files 
of Domain Managers.


For Domain Managers, copying the security configuration files clientConnect.conf, 
serverConnect.conf, brokerConnect.conf, runcmd_env.sh, and imk.dat is not 
supported in an upgrade installation. You can manually copy the security 
configuration files using sm_migrate utility as described in “Restoring customizations 
after an upgrade installation” on page 81.


8. The Installation Summary shows informational messages such as successful 
confirmations, error messages, and warnings. Investigate any errors or warnings.


If Next appears, your system needs to be rebooted because one or both of the 
following tasks are pending on the system:


• A system-protected file was replaced during the installation and requires a restart.


• A pending restart was triggered by another application or by an operating system 
patch installation.


Click Next or enter [1] and then reboot your system. Otherwise, click Finish or enter [1] 
to exit the installation.


The installation program writes an install log file to the BASEDIR/smarts/setup/logs 
directory, unless the installation fails at the very start, in which case the installation 
program writes the log file to the /tmp directory. The log file is a text file with the 
naming convention Install.<product>.<productversionNumber>.log.
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9. Evaluate your custom code. Review the “Custom file migration use cases” on page 83. 
The sm_migrate utility migrated all user-customized files from the existing installation 
to the BASEDIR/smarts/local directory in the 9.4.2 installation. Review the output of 
the sm_migrate utility and evaluate if you would like to keep the user-customized files 
in the new installation.


“Configuration migration process logs” on page 87 provides more information on the 
log files that are created after the migration of user-customized files.


10. Depending on your deployment, ensure that the 
BASEDIR/smarts/local/conf/runcmd_env.sh file includes the environment variables, 
SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate 
with EMC Smarts products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with 
EMC Smarts products based on Foundation versions prior to 9.0.0.0 Build 1345. 


“Check the version number” on page 94 provides the sm_server --version command 
to determine the Foundation (DMT) version.


To ensure that the runcmd_env.sh file includes the environment variables:


a. Go to the BASEDIR/smarts/bin directory and enter this command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b. Search for the environment variables. If they do not exist, add one or both 
depending on your deployment:


SM_TLS_PROTOCOLS=+TLSv1.1
SM_ALLOW_LEGACY_CRYPTO=TRUE


c. Save and close the file.


11. If you plan to use the EMC M&R UI and the Service Assurance Manager in this upgrade 
is the Presentation SAM server for the EMC M&R UI, you need to use the sm_service 
command to install the ic-sam-server-pres service, and then remove the existing 
ic-sam-server service. 


Presentation SAM server is the server that is configured in the SolutionPack for EMC 
Smarts for use with the EMC M&R UI. This does not mean that a hierarchical SAM is 
required. 


In addition to the ic-sam-server-pres service, ensure that you have installed the 
smarts-elasticsearch service, the smarts-rabbitmq service, and the smarts-tomcat 
service if you did not select them during the upgrade installation.


Appendix B, “Manually Installing Services,” provides the sm_service syntax for the 
Presentation SAM server, Tomcat, Rabbit MQ, and ElasticSearch.


To remove the ic_sam_service service, type this command from the 
<BASEDIR>/smarts/bin directory:


sm_service remove --name=ic-sam-server
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The EMC Smarts System Administration Guide provides more information about how 
to use the sm_service command.


12. In this upgrade, if you plan use the EMC M&R UI and the Configuration Manager to 
configure IP Manager settings, you need to register the Configuration Manager and the 
IP Managers with the service command that includes the EMC Data Access API service 
option (--edaa). The Service Assurance Suite How to Maintain IP Manager Settings 
article explains how to use the Configuration Manager to configure IP Manager 
settings. 


13. Optional for IP Manager, run the repository file migration utility (sm_migraterps) to 
make the repository file compatible with the newer 9.4.2 version of the software as 
described in “Automatically migrate topology for IP Manager using RPS utility” on 
page 88. 


14. If you installed additional products and they are not licensed features, obtain and 
save a new license file as outlined in “Obtain and install a temporary license file” on 
page 95.


Otherwise, existing permanent licenses are supported for 9.4.2 products. No user 
action is required.


15. If your product is part of a deployment that requires the Federal Information 
Processing Standard (FIPS) Publication 140-2, a U.S. government computer security 
standard governing cryptographic modules, follow the instructions in “Upgrading 
9.4.2 products in FIPS mode” on page 54.


16. If you installed the products as services, start the services. “Starting services on UNIX” 
on page 97 or “Starting services on Windows” on page 97 provides more information. 


17. Verify the current state of the products and Broker. “Verify the product status” on 
page 102 provides more information.


18. Initiate a discovery. Consult the discovery guide or user guide for your product for 
more information on this procedure. 


19. For Server Manager, 


a. In the Domain Manager Administration Console, right-click on the ESM server 
(INCHARGE-ESM, by default) in the left pane and select the Load All ESM Host 
monitoring data from Backup option.


b. Perform a discovery (Topology > Discover All) from the ESM server.


All of the applications that were configured prior to the upgrade are restored and 
Server Manager starts to monitor those applications.


Add additional features to an upgrade installation
If after installing an upgrade installation you want to add products to the upgrade 
installation, run the installation again, select the Add additional features option in the 
Upgrade or install screen, and select all products that are already installed plus any other 
products that you would like to install in the upgraded installation.
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Upgrading 9.4.2 products in FIPS mode


Upgrading in FIPS mode is not available for Server Manager.


9.4.2 products do not use a Federal Information Processing Standard (FIPS 140-2) 
approved encryption algorithm to protect the imk.dat file. By default, the 9.4.2 imk.dat file 
uses MD5, which is not a FIPS-approved algorithm. Hence, while upgrading from previous 
versions of products to Version 9.4.2, the imk.dat file needs to be regenerated in order to 
run in the FIPS mode.


In order to convert an existing installation to FIPS, use the sm_rebond (in non-FIPS mode) 
first to get everything re-encoded in a FIPS compatible way. The steps are as follows:


1. Run the following command at the command line prompt:


sm_rebond --upgrade --basedir=<BASEDIR>/smarts


The path must be set to the default install path. Regardless of the FIPS 140 state, you 
must run the sm_rebond command from the BASEDIR where the software is installed, 
not from any other product installation area which also has the sm_rebond utility. 


For example for Service Assurance Manager, run the command:


Linux


sm_rebond --upgrade --basedir=/opt/InCharge/SAM/smarts


Windows


sm_rebond --upgrade --basedir=C:\InCharge\SAM\smarts


2. When prompted, type a password to regenerate the imk.dat file. The default password 
is Not a secret.


3. Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. The 
file is located under the BASEDIR/smarts/local/conf directory.


Next steps
Chapter 7, “Verifying the Installation,” describes tasks for verifying the proper installation 
of the software and starting services.
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CHAPTER 5
Performing a Migration


This chapter provides instructions for migrating previous versions of the EMC Smarts 
Service Assurance Manager, EMC Smarts IP Manager, EMC Smarts MPLS Manager, EMC 
Smarts Server Manager, EMC Smarts Network Protocol Manager, EMC Smarts Optical 
Transport Manager, and EMC Smarts VoIP Availability Manager to a new version. It consists 
of the following topics:


◆ Migration overview..................................................................................................  56
◆ Install and migrate on the same host.......................................................................  57
◆ Install and migrate on a different host .....................................................................  60
◆ Review license file migration ...................................................................................  64
◆ Post-migration tasks ...............................................................................................  68
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Migration overview
Consult the EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support 
Matrix for software versions that require a manual migration to Version 9.4.2.


Two methods are available:


◆ Install and migrate on the same host


◆ Install and migrate on a different host


After the installation, run the sm_migrate utility to backup the user-customized files in the 
previous version and migrate the files to the new version. Chapter 6, “Migration Utilities,” 
explains how the sm_migrate utility works.


Disk space requirement—During a migration, the sm_migrate creates a backup of files in 
actions, conf, model, repos, rules, script directories. Ensure that you have disk space of 
four times the size of these directories available on the system. After the migration and 
verifying the installation, you can archive or remove the backup directories. This 
requirement is in addition to the minimum disk requirement outlined for each product in 
the EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix.


Server name requirement for migration—To preserve notification history and the original 
Source attributes of notifications in the Service Assurance Manager, the server names of 
underlying Domain Managers should remain the same. This way at the end of the 
migration of all EMC Smarts Domain Managers, the SAM server can correctly associate the 
pre-existing topology and notifications with the topology and events coming from 
migrated Domain Managers. For example, if the 9.4 Server Manager has a server name 
INCHARGE-ESM, do not change it to a different name for the 9.4.2 release.


Make sure that you read “Install and migrate on the same host” on page 57 and “Install 
and migrate on a different host” on page 60 in their entirety before proceeding.


Remove all the unused files in the /local directory. The unused files will also include RPS 
files and custom files created by you. The sm_migrate utility creates a backup of all the 
files in the local directory and copies them back to local directory. RPS and custom files 
can be large, and may slow down the process.
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Install and migrate on the same host
To migrate from a previous version of a product to the new, current 9.4.2 version on the 
same host, you must: 


1. Install the 9.4.2 product and specify an installation directory that is different from the 
one that is used for the previous installation.


2. Stop the old services for the previous version, if necessary.


For UNIX, keep the service daemon (the sm_serviced component) running. If 
sm_serviced is stopped, all EMC Smarts products will stop and will need to be 
restarted.


In some cases, on Windows, the installation program cannot stop the services, 
because multiple threads are locking the services. In those cases, use the Windows 
Control Panel to stop the services manually.


For most cases, the installation program detects and stops all services, scheduled 
jobs, and processes that use programs or libraries that are running from the existing 
installation.


It also stops the service daemon, sm_serviced, if it is running.


3. Migrate user-customized files from the previous installation to the new installation.


4. Reuse the customized Polling and Thresholds settings from the old repository.


Detailed instructions are described in “Migration procedure for the same host” on 
page 58.


For a test lab environment, since the two installations are on the same host, you can run 
both installations in parallel. For parallel installations, both installations connect to the 
same Broker and Global Manager, as long as the old and new product service and 
sm_server names are unique. In this case, you will need to rename the service and 
sm_server for the previous product version. Managers registered with the same Broker 
must have unique names.


For a production environment, EMC Corporation recommends that you decommission the 
previous version of product.


The order in which you upgrade products depends on whether the EMC M&R UI is included 
in your deployment. When deciding which Global Manager or underlying Domain Manager 
to migrate first, perform the migration in the following order:


1. Start with the top-most SAM server.


• If EMC M&R is included, this is the Presentation SAM server.


• If EMC M&R is not included, this is the top-most SAM server and related Service 
Assurance products and consoles in your deployment, either a SAM server or the 
top SAM server in a hierarchical SAM deployment. 


2. If EMC M&R is included, migrate or update EMC M&R platform (core) components and 
the SolutionPack for EMC Smarts.


Ensure that communication exists between the Presentation SAM server and the 
SolutionPack for EMC Smarts.
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For information, consult the Service Assurance Suite Installation and Configuration 
Guide for EMC M&R, the SolutionPack for EMC Smarts Summary Sheet article, and the 
How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts article.


3. An Aggregation SAM server if it is a hierarchical SAM deployment.


4. IP Manager.


5. Any order: Server Manager, MPLS Manager, Network Protocol Manager, and VoIP 
Availability Manager.


Presentation SAM server is the server that is configured in the SolutionPack for EMC 
Smarts for use with the EMC M&R UI. This does not mean that a hierarchical SAM is 
required.


Migration procedure for the same host


To migrate the previous version of the product to the new version on the same host, 
perform the following tasks:


1. Review the important release issues for the 9.4.2 product, as described in the EMC 
Smarts Release Notes for SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers.


2. Determine that the products that you are installing are supported for your platform. 
The EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix 
provides more information.


3. Determine if the host has enough disk space and memory to accommodate so both 
versions of the product can co-exist. The EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, 
and VoIP Managers Support Matrix provides more information.


4. Mount the CD/DVD-ROM on the host as described in Appendix C, “Procedures for 
CD/DVD-ROMs.”


5. Uninstall any temporary test patches (TTPs), if they exist, in your old installation.


If a TTP has been installed on a Service Pack, you must first uninstall the TTP. 
Otherwise, the TTP files will be treated as files modified by you and copied to the local 
directory in the new installation area. 


6. Install the new version of the product on the same host as described in Chapter 2, 
“Performing an Installation.”


• Specify an installation directory that is different from the old installation directory 
so both versions of the product can co-exist. 


• Install products as services. These services overwrite the old stopped services.


If you need to continue to run the previous versions of the products, manually install 
services for them with unique names and start them.


The installation program installs the 9.4.2 software.
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7. Run the sm_migrate utility to copy user-customized files from the previous installation 
to the new 9.4.2 installation. “Migrating customizations on the same host” on 
page 76 provides instructions.


Run the sm_migrate utility immediately after the installation and before you start any 
services or modify any files in the new installation. The sm_migrate utility will not 
merge any files from the previous installation local directory, if the same files are 
present in the new installation BASEDIR/smarts/local directory. 


8. Evaluate your security settings. “Migration of security configuration files” on page 85 
provides more information.


9. Evaluate the environment variables in the old runcmd_env.sh file. “Migration of 
security configuration files” on page 85 provides more information.


10. Evaluate your custom code. Review the “Custom file migration use cases” on page 83 
to plan your post-migration steps. The sm_migrate utility migrated all user-customized 
files from the previous installation to the BASEDIR/smarts/local directory in the new 
installation. It also made a backup copy of the files under the 
BASEDIR/smarts/.migrate.bkp.x.x directory (for example, .migrate.bkp.2.0.0.0). 
Review the output of the sm_migrate utility and evaluate if you would like to keep the 
user-customized files in the new installation.


11. Save your license in the proper location or (optional) update your license:


• Temporary license—copy the license file, smarts.lic, to the 
BASEDIR/smarts/local/conf directory on the system where the EMC Smarts 
software is installed. If you installed multiple EMC Smarts products on the same 
system, each product requires a separate copy of smarts.lic.


• Permanent license—use the procedures described in the EMC Smarts System 
Administration Guide.


If you installed additional products and they are not licensed features, obtain and 
save a new license file as outlined in “Obtain and install a temporary license file” on 
page 95.


Otherwise, existing licenses are supported for 9.4.2 products. No user action is 
required.


12. Depending on your deployment, ensure that the 
BASEDIR/smarts/local/conf/runcmd_env.sh file includes the environment variables, 
SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate 
with EMC Smarts products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with 
EMC Smarts products based on Foundation versions prior to 9.0.0.0 Build 1345. 


“Check the version number” on page 94 provides the sm_server --version command 
to determine the Foundation (DMT) version.


a. Go to the BASEDIR/smarts/bin directory and enter this command to open the 
runcmd_env.sh file:
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sm_edit conf/runcmd_env.sh


b. Search for the environment variables. If they do not exist, add one or both 
depending on your deployment:


SM_TLS_PROTOCOLS=+TLSv1.1
SM_ALLOW_LEGACY_CRYPTO=TRUE


c. Save and close the file.


13. Rename the repository file before reusing it. 


a. Locate the existing repository file that was copied to the 
BASEDIR/smarts/local/repos/icf directory in the new 9.4.2 installation.


b. Rename the repository file by removing the version number extension. For 
example, the repository file INCHARGE-MPLS-ANALYSIS.rps.3.1.0.2 should be 
renamed to INCHARGE-MPLS-ANALYSIS.rps without the version number extension.


14. Optional for IP Manager, run the repository file migration utility (sm_migraterps) to 
make the repository file compatible with the newer 9.4.2 version of the software as 
described in “Automatically migrate topology for IP Manager using RPS utility” on 
page 88. 


15. If you installed the products as services, start them for the first time. “Starting services 
on UNIX” on page 97 or “Starting services on Windows” on page 97 provide more 
information. 


16. Verify the current state of the products and Broker. “Verify the product status” on 
page 102 provides more information. 


17. For Server Manager, 


a. In the Domain Manager Administration Console, right-click on the ESM server 
(INCHARGE-ESM, by default) in the left pane and select the Load All ESM Host 
monitoring data from Backup option.


b. Perform a discovery (Topology > Discover All) from the ESM server.


All of the applications that were configured prior to the migration are restored and 
Server Manager starts to monitor those applications.


18. Decommission the previous version of the products. For instructions, refer to the 
uninstallation chapter in the installation guide for the previous software version.


Install and migrate on a different host
If you want to run the new version of the 9.4.2 product before decommissioning the 
previous version, you must:


1. Install the new version of the 9.4.2 product on a different host.


2. Migrate any customized configuration file changes to the new installation. 


Detailed instructions are described in “Migration procedure for a different host” on 
page 61.
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Since the two installations are on different hosts, you can run both installations in 
parallel. You have the option of:


◆ Having both installations connect to the same Global Manager and Broker.


Managers registered with the same Broker must have unique names. In this scenario, 
stop and rename the services for the previous version and, when you install the 9.4.2 
product, the installation program will use the default server names.


◆ Having multiple instances of the Global Manager and Broker with each instance 
assigned to a different version of the product.


For a production environment, EMC Corporation recommends that you decommission the 
previous version of product.


The order in which you upgrade products depends on whether the EMC M&R UI is included 
in your deployment. When deciding which Global Manager or underlying Domain Manager 
to migrate first, perform the migration in the following order:


1. Start with the top-most SAM server.


• If EMC M&R is included, this is the Presentation SAM server.


• If EMC M&R is not included, this is the top-most SAM server and related Service 
Assurance products and consoles in your deployment, either a SAM server or the 
top SAM server in a hierarchical SAM deployment. 


2. If EMC M&R is included, migrate or update EMC M&R platform (core) components and 
the SolutionPack for EMC Smarts.


Ensure that communication exists between the Presentation SAM server and the 
SolutionPack for EMC Smarts.


For information, consult the Service Assurance Suite Installation and Configuration 
Guide for EMC M&R, the SolutionPack for EMC Smarts Summary Sheet article, and the 
How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts article.


3. An Aggregation SAM server if it is a hierarchical SAM deployment.


4. IP Manager.


5. Any order: Server Manager, MPLS Manager, Network Protocol Manager, and VoIP 
Availability Manager.


Presentation SAM server is the server that is configured in the SolutionPack for EMC 
Smarts for use with the EMC M&R UI. This does not mean that a hierarchical SAM is 
required.


Migration procedure for a different host


To migrate the previous version of the product to the new version on a different host, 
satisfy or perform the following tasks:


1. Review the important release issues for the 9.4.2 product, as described in the EMC 
Smarts Release Notes for SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers.

Install and migrate on a different host 61







Performing a Migration

2. Determine that the products that you are installing are supported for your platform. 
The EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers Support Matrix 
provides more information.


3. Determine if the host has enough disk space and memory to accommodate so both 
versions of the product can co-exist. The EMC Smarts SAM, IP, ESM, MPLS, NPM, OTM, 
and VoIP Managers Support Matrix provides more information.


4. Mount the CD/DVD-ROM on the host as described in Appendix C, “Procedures for 
CD/DVD-ROMs.”


5. Uninstall any temporary test patches (TTPs), if they exist, in your old installation.


If a TTP has been installed on a Service Pack, you must first uninstall the TTP. 
Otherwise, the TTP files will be treated as files modified by you and copied to the local 
directory in the new installation area. 


6. Install the new version of the product on the different host as described in Chapter 2, 
“Performing an Installation.”


The installation program installs the 9.4.2 software.


7. Run the sm_migrate utility to copy user-customized files from the previous installation 
to the new 9.4.2 installation. “Migrating customizations to a different host” on 
page 78 provides instructions.


Run the sm_migrate utility immediately after the installation and before you start any 
services or modify any files in the new installation. The sm_migrate utility will not 
merge any files from the previous installation local directory, if the same files are 
present in the new installation BASEDIR/smarts/local directory. 


8. Evaluate your security settings. “Migration of security configuration files” on page 85 
provides more information.


9. Evaluate the environment variables in the old runcmd_env.sh file. “Migration of 
security configuration files” on page 85 provides more information.


10. Evaluate your custom code. Review the “Custom file migration use cases” on page 83 
to plan your post-migration steps. The sm_migrate utility migrated all user-customized 
files from the previous installation to the BASEDIR/smarts/local directory in the new 
installation. It also made a backup copy of the files under the 
BASEDIR/smarts/.migrate.bkp.x.x directory (for example, .migrate.bkp.2.0.0.0). 
Review the output of the sm_migrate utility and evaluate if you would like to keep the 
user-customized files in the new installation.


11. Save your license in the proper location or (optional) update your license:


• Temporary license—copy the license file, smarts.lic, to the 
BASEDIR/smarts/local/conf directory on the system where the EMC Smarts 
software is installed. If you installed multiple EMC Smarts products on the same 
system, each product requires a separate copy of smarts.lic.


• Permanent license—use the procedures described in the EMC Smarts System 
Administration Guide.
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If you installed additional products and they are not licensed features, obtain and 
save a new license file as outlined in “Obtain and install a temporary license file” on 
page 95.


Otherwise, existing licenses are supported for 9.4.2 products. No user action is 
required.


12. Depending on your deployment, ensure that the 
BASEDIR/smarts/local/conf/runcmd_env.sh file includes the environment variables, 
SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate 
with EMC Smarts products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with 
EMC Smarts products based on Foundation versions prior to 9.0.0.0 Build 1345. 


“Check the version number” on page 94 provides the sm_server --version command 
to determine the Foundation (DMT) version.


a. Go to the BASEDIR/smarts/bin directory and enter this command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b. Search for the environment variables. If they do not exist, add one or both 
depending on your deployment:


SM_TLS_PROTOCOLS=+TLSv1.1
SM_ALLOW_LEGACY_CRYPTO=TRUE


c. Save and close the file.


13. Rename the repository file before reusing it. 


a. Locate the existing repository file that was copied to the 
BASEDIR/smarts/local/repos/icf directory in the new 9.4.2 installation.


b. Rename the repository file by removing the version number extension. For 
example, the repository file INCHARGE-MPLS-ANALYSIS.rps.3.1.0.2 should be 
renamed to INCHARGE-MPLS-ANALYSIS.rps without the version number extension.


14. Optional for IP Manager, run the repository file migration utility (sm_migraterps) to 
make the repository file compatible with the newer 9.4.2 version of the software as 
described in “Automatically migrate topology for IP Manager using RPS utility” on 
page 88. 


15. If you installed the products as services, start them for the first time. “Starting services 
on UNIX” on page 97 or “Starting services on Windows” on page 97 provide more 
information. 


16. Verify the current state of the products and Broker. “Verify the product status” on 
page 102 provides more information.


17. For Server Manager, 


a. In the Domain Manager Administration Console, right-click on the ESM server 
(INCHARGE-ESM, by default) in the left pane and select the Load All ESM Host 
monitoring data from Backup option.


b. Perform a discovery (Topology > Discover All) from the ESM server.
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All of the applications that were configured prior to the migration are restored and 
Server Manager starts to monitor those applications.


18. Decommission the previous version of the products. For instructions, refer to the 
uninstallation chapter in the installation guide for the previous software version.


Review license file migration
This section provides the procedure for migrating the license server. The EMC Smarts 
System Administration Guide provides complete information about EMC Smarts licensing, 
including deployment considerations and troubleshooting.


Before you begin, you need to be aware of the following considerations:


◆ You can use your existing license file, provided that you have not: acquired more 
features, increased the number of licenses, or changed machines (host IDs).


If you have acquired more features, increased the number of licenses, or changed 
machines, then you must obtain a new license file. To obtain a permanent license file, 
complete a Support Request (SR) form, which you can find on the EMC support 
website http://support.emc.com.


◆ You will need to use the FlexNet 11.12.1.5 license server provided with EMC Smarts 
version 9.4.2 software. The setup instructions are described in the following 
subsection.


FlexNet software is backward-compatible. For example, a newer license manager 
daemon (lmgrd) will work with older vendor daemons and older FlexNet-licensed 
products. So a FlexNet 11.12.1.5 license server provided with EMC Smarts version 
9.4.2 software will work with FLEXlm license files distributed for EMC Smarts version 
9.x software, but not the other way round.


This license migration procedure is similar to the procedure used to set up licensing for a 
new installation with the following differences:


◆ You can reuse your existing license file for step 3 .


◆ You stop the old license server in step 6  and uninstall it in step 8 .


◆ If you set up the new FlexNet license server on the same system as the old license 
server, you do not need to modify the SM_LICENSE variable for your other EMC Smarts 
software installations. 


For the following procedure, you need administrative privileges for both the EMC Smarts 
software and the systems on which the software is running.


In this discussion, a temporary license file is referred to as <license_name>.lic and a 
permanent license file is referred to as <host_id>.<license_name>.lic. If you install a license 
server with the install_license script described later, you should be aware that the script 
changes the permanent license filename from <host_id>.<license_name>.lic to 
<license_name>.lic.
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Migrate permanent license and set up FlexNet license server


On the system where the EMC Smarts Broker resides, perform these steps to migrate the 
permanent license file and set up the new server:


1. If you have not already installed the 9.4.2 software, do so. Install the software on the 
same system in a different directory than the older software. 


If you installed the software on a different system, open a Support Request (SR) on the 
EMC support website http://support.emc.com to request a new license.


2. If you previously used a temporary license (copied <license_name>.lic to the 
BASEDIR/smarts/local/conf directory), you need to delete it because it will cause the 
install_license script to fail later in step 5 .


3. Copy your existing permanent license file, <host_id>.<license_name>.lic, from the old 
installation directory to the new BASEDIR directory on the system where the license 
server will run.


Typically, this location should be the same host and BASEDIR as for the EMC Smarts 
Broker. By default, BASEDIR is /opt/InCharge/<product> for UNIX and 
C:\InCharge\<product> for Windows.


If you obtained a new permanent license file, save the attachment to a file named 
<host_id>.<license_name>.lic in your BASEDIR directory on the system where the 
license server will run. 


Do not save the permanent license file (<host_id>.<license_name>.lic) to the 
BASEDIR/smarts/local/conf directory. The install_license script will fail if it finds a 
permanent license file in this directory. Also, do not save a permanent license file to 
the BASEDIR/smarts/script or BASEDIR/smarts/conf directory.


Later, as the result of step 5 , the install_license script installs the permanent license 
file into the BASEDIR/smarts/local/conf directory. 


4. If necessary, you may need to change the port for the FlexNet license server (which will 
be installed in step 5 ). For example, if the default port, 1744, is used by another 
process, the FlexNet license server can run on a different port. Do not make any 
changes to the permanent license file unless you need to change the port.


Use any text editor to open the <host_ID>.<license_name>.lic file. The first line of the 
permanent license file, labelled SERVER, contains the hostname, host ID, and port of 
the license server, as shown in the following example:


SERVER this_host 8323fcbf 1744


Change the port number from the default (“1744”) on the SERVER line and save the 
file. 


The EMC Smarts System Administration Guide for instructions contains information on 
deploying the FlexNet license server on the opposite side of a firewall from your other 
Smarts software installations.
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5. Install the FlexNet license server using the install_license script. By default, this file is 
located in the BASEDIR/smarts/script directory. 


You must run the install_license script on the same system where the license server 
runs. This script requires superuser privileges (user ID 0) for UNIX, and administrator 
privileges for Windows. You must specify the full path to the permanent license file.


For example, the command on UNIX systems is:


▼#/opt/InCharge/SAM/smarts/script>install_license.sh install 
<path to license file>/<host_ID>.<license_name>.lic ▲


On Windows systems, for example, the command is:


▼ C:\InCharge\SAM\smarts\script>install_license.cmd install 
<path to license file>\<host_ID>.<license_name>.lic ▲


▼ ▲ indicates this command should be typed as one line.


In addition to installing the FlexNet license server, the install_license script performs 
other functions such as configuring the license server to start when the system 
reboots. The EMC Smarts System Administration Guide provides additional 
information.


6. Stop the old license server. Use the same command in step 7  except substitute stop 
for start. 


7. Start the FlexNet license server. The FlexNet license server runs as a daemon on UNIX 
and as a service on Windows and automatically starts the vendor daemon for 
EMC Smarts. Run the command appropriate for your platform.


Linux:


# /etc/init.d/SMARTS-License start


Windows:


To manually start the license server, follow these steps as an administrator:


1. Select Start > Settings > Control Panel > Administrative Tools.


2. Select Services.


3. Select the FlexNet License Manager service.


4. Right-click and select Start.


5. Verify that the new FlexNet license server started by checking your EMC Smarts 
Manager log file. To do so, start your EMC Smarts Manager and view the 
EMC Smarts Manager log file for two messages that indicate success: 


• ICF-N-LICENSEDFEATURE-Enabling 


• ICF-N-RESTOREFINISH-PersistenceManager: restore finished 


The log filename is based upon the EMC Smarts Manager’s name (for example, 
INCHARGE-SA.log) and the log file is located in the BASEDIR/smarts/local/logs 
directory. 
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“Start services” on page 97 provides instructions on starting your EMC Smarts 
Manager.


On the system where the FlexNet license server and EMC Smarts Broker reside, for a 
permanent license file, you do not need to edit the SM_LICENSE variable in the 
runcmd_env.sh file for that product, because by default the install_license script adds 
the SM_LICENSE variable with the appropriate values.

If other products were already deployed on the same system, you do not need to 
manually edit the SM_LICENSE variable in the runcmd_env.sh file for those products if 
the new FlexNet license server is set up on the same system as the old license server. 

If the new FlexNet license server is set up on a different system than the old license 
server or if you installed other 9.4.2 products on the same system, you need to 
manually edit the SM_LICENSE variable in the runcmd_env.sh file for those products. 
“Access to FlexNet license server using SM_LICENSE” on page 67 provides additional 
information.

For example, if the Service Assurance Manager and IP Manager reside on System1 and 
the install_license script is invoked from the /opt/InCharge/SAM/smarts/script 
directory, the script modifies the variable, but you will have to modify the variable for 
the 9.4.2 IP Manager.


8. Uninstall the old license server using the install_license script. 


For example, command on UNIX systems is:


# /opt/InCharge/SAM/smarts/script>install_license.sh uninstall 


Command on Windows systems is:


C:\InCharge\SAM\smarts\script>install_license.cmd uninstall 


Access to FlexNet license server using SM_LICENSE


If you set up the new FlexNet license server on the same system as the old license server, 
you do not need to modify the SM_LICENSE variable for other EMC Smarts software 
installations. You can skip this task.


When you install EMC Smarts software on more than one system, you must ensure that the 
EMC Smarts software on each system can connect to the FlexNet license server in order to 
be able to check out licenses. For the system where you installed the FlexNet license 
server, the SM_LICENSE variable is added automatically by the install_license script. For 
other EMC Smarts software installations, you need to modify the variable.


To set up licensing for other products or the Global Console, you need to set the 
SM_LICENSE variable to specify the <port>@<lic_host> of the FlexNet license server. 


Use the sm_edit utility to edit the SM_LICENSE variable in the runcmd_env.sh file. The 
runcmd_env.sh file resides in the BASEDIR/smarts/local/conf directory of the product.
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Perform the following steps:


1. For UNIX, invoke sm_edit from the BASEDIR/smarts/bin directory:


% sm_edit conf/runcmd_env.sh


To open runcmd_env.sh on Windows, invoke sm_edit utility as follows:


C:\>sm_edit conf\runcmd_env.sh


For example on Windows, type:


C:\InCharge\SAM\smarts\bin>sm_edit conf\runcmd_env.sh


2. Set the SM_LICENSE variable to <port>@<lic_host> of the FlexNet license server. 


The runcmd_env.sh file should resemble the following:


SM_BROKER_DEFAULT=localhost:426
SM_LICENSE=1744@SYSTEM1 
SM_SNMP_BUG_COMPATIBLE=TRUE
SM_INCOMING_PROTOCOL=1,0
SM_OUTGOING_PROTOCOL=1,0


3. Save the runcmd_env.sh file and close it.


Any EMC Smarts program within a product started after this point will use the 
applicable environment variables specified in the runcmd_env.sh file. EMC Smarts 
programs that are already running need to be restarted for any new environment 
variable to take effect. “Start services” on page 97 provides instructions on starting 
services.


Configuring license server behind the firewall


If the FlexNet license server is deployed on the opposite side of a firewall from your IP 
installation, you need to perform the following changes in the permanent license file:


1. Open the permanent license file for editing in an appropriate editor.


2. Type PORT=<port_number> after the line
VENDOR sm_lmgrd92 /opt/InCharge/IP/smarts/bin/system/sm_lmgrd92


After making the changes, it must look similar to:
VENDOR sm_lmgrd92 /opt/InCharge/IP/smarts/bin/system/sm_lmgrd92
PORT=<port_number>


3. Save and close the permanent license file.


Post-migration tasks
Perform these tasks after the data migration steps are complete:


1. “Rename the repository file” on page 69


2. “Ensure that the Broker host:port is updated in the runcmd_env.sh files” on page 69


3. “Remove the old out-of-date service entries” on page 70


4. “Change the secret phrase to match rest of deployment” on page 70


5. “Uninstall the old software” on page 70
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Rename the repository file


For a same host or different host migration, the old repository file is copied to the 
BASEDIR/smarts/local/repos/icf directory in the 9.4.2 installation. Because the repository 
file has a version number extension (for example, .2.0 extension), rename the repository 
file without the .2.0 extension before using it.


As further information, regardless of whether the old installation is on a Windows system 
or a UNIX system, sm_migrate saves the old repository file and all other customization 
files in DOS (Windows) format. If the new installation is on a UNIX system, sm_migrate 
automatically converts the repository file and all other customization files to UNIX format.


Ensure that the Broker host:port is updated in the runcmd_env.sh files


If you are installing the 9.4.2 Broker during the installation to a location that is different 
from where the Broker for the previous installation resides, for each server that is 
registered with the Broker, you need to use the sm_edit utility to edit the 
SM_BROKER_DEFAULT variable in the runcmd_env.sh file in each of those server’s 
BASEDIR/smarts/local/conf directory with the hostname (and port) of the host system 
that is running the Broker:


If the Broker host is resolved using a DNS name, this step is not necessary. It is 
recommended not to use Name Server Caching Daemon (NSCD) to cache DNS lookups 
(the host’s database) in Linux.


1. Run BASEDIR/smarts/bin/sm_service show --cmdline (UNIX) or 
BASEDIR\smarts\bin\sm_service.exe show --cmdline (Windows) from your older 
product to get a listing of all installed services. Save the output. For example:


C:\InCharge\IP\smarts\bin\sm_service.exe show --cmdline


2. For each service that you have installed, you will see output similar to the following:


sm_service install --force --name=ic-broker 
--description=”EMC Broker” 
--env=SM_CLIENTCONNECT=brokerConnect.conf --startmode=runonce 
C:\InCharge\IP\smarts\bin\brstart.exe --port=426 
--restore=C:\InCharge\IP\smarts/local/repos/broker/broker.rps 
--output


where ic-broker is the name of the service for which you are interested.


While performing a migration, if you select to retain the security configuration files, ensure 
to update the parameters SM_LICENSE, SM_FIXED, SM_JAVAHOME in the runcmd_env.sh 
file with the 9.4.2 installation path.
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Remove the old out-of-date service entries


Use the following command to remove all old services that are going to be replaced by the 
9.4.2 product:


<BASEDIR>/smarts/bin/sm_service remove <service name>


If you are installing under Windows operating systems, you must restart the server to 
remove all traces of the services that you uninstalled. However, do not restart the server 
before the 9.4.2 product configuration (renaming services, servers, editing settings, and 
so on) is completed.


For UNIX, you also need to point the product to the new 9.4.2 services that will be 
installed. Do this by making a copy of /etc/init.d/ic-serviced, change the SMHOME 
variable to point to the 9.4.2 services, and place it in the 9.4.2 /etc/init.d directory.


Change the secret phrase to match rest of deployment


If the rest of the deployment uses a different site secret, and assuming that you want to 
employ secure communications between the component applications in the deployment, 
you need to change the site secret of this installation to match the rest of deployment. You 
do so by using the deployment’s site secret to recreate and encrypt the 
clientConnect.conf, serverConnect.conf, brokerConnect.conf, and .imk.dat files in the 
BASEDIR/smarts/local/conf directory of this installation.


Use the sm_rebond command to encrypt the files. For example, from the 
BASEDIR/smarts/bin directory, enter:


sm_rebond --basedir=/opt/InCharge/IP/smarts


The EMC Smarts System Administration Guide provides complete information about the 
security files and encryption.


Uninstall the old software


If the new version of the product is functioning properly, all data has been migrated to the 
new version, and all services are functioning properly, you should uninstall the previous 
version of the product.


For Windows only, if you use the Windows “Add/Remove Programs” capability at this 
point, you will be incorrectly uninstalling version 9.4.2 instead of the previous version. 
Therefore, you must uninstall the older product applications by using the uninstaller.exe 
from the older base directory.


Uninstalling the previous version of the product will prevent conflicts if the previous 
version is started by mistake while 9.4.2 is running. Chapter 8, “Performing an 
Uninstallation,” provides more information. 


Uninstall will display errors if services were installed by the installation program when the 
old version was installed, but were removed manually in a later step. The uninstall process 
will display errors because it will not find the services when it tries to remove them.
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Migration Utilities


This chapter describes the migration utilities and provides procedures for using them. The 
chapter consists of the following topics:


◆ Customization migration utility overview .................................................................  72
◆ sm_migrate function ...............................................................................................  74
◆ Customization migration procedures.......................................................................  76
◆ Perform a rollback...................................................................................................  82
◆ Custom file migration use cases..............................................................................  83
◆ Three-way merge utility ...........................................................................................  86
◆ Automatically migrate topology for IP Manager using RPS utility ..............................  88
◆ Deployment utility overview ....................................................................................  89
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Customization migration utility overview
The sm_migrate utility is used to migrate user-customized files from an old installation to 
a new installation, where the old installation and the new installation are in different 
installation directories or, for an upgrade installation, in the same installation directory. 
User-customized files include user-modified files (using sm_edit), user-introduced files, 
and the repository file.


If TTPs (Temporary Test Patch) are installed on a previous installation of SAM, you must 
first uninstall the TTP and then run the utility. Else, TTP files will be treated as files 
modified by you and copied to the local directory in the new installation area.


When migrating a customized file from an old installation to a new installation, if a file 
with the same name exists in the local directory of the new installation, the Customization 
Migration Utility does not modify or overwrite it. The utility skips all such files being 
considered for merging. For files being considered to be copied-over, the utility migrates 
the files with the old version number appended to the file name.


sm_migrate modes of operation


The sm_migrate has seven command-line options:


◆ --old (or -o)


◆ --new (or -n)


◆ --archive (or -a)


◆ --upgrade (or -u)


◆ --rollback (or -r)


◆ --silent (or -s)


◆ --sitemod (or -l)


◆ --help (or -h)


These command-line options can be used in pairs in the command line to achieve eight 
different modes of operation described below.


SAME HOST MODE
This mode is used when the new installation and the old installation are on the same host, 
in two separate locations. In this mode, sm_migrate migrates all customizations 
(non-binary files that have been modified or introduced by you in the old installation) from 
the old installation to a new installation.
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All files that were modified or newly introduced in the old installation must be present only 
under the BASEDIR/smarts/ directory.

When you use the --sitemod option, the migration utility will migrate all customized old 
files for all user created locals.


DIFFERENT HOST - OLD MODE
This mode is used when the new installation and the old installation are on different 
hosts. In this mode, sm_migrate backs up and creates tar or a zip archive (file) of the 
customizations in the old installation. The tar or zip file resides in the location specified by 
you while executing the utility.


To run the utility from an older version of a Smarts product that does not have the 
migration utility, you must copy the sm_migrate.pl script and certain Perl files (packaged 
in migratePerlPkg.zip file) and place them in the appropriate locations. The sm_migrate.pl 
must be placed in the bin directory and the Perl package must be placed under the 
BASEDIR/smarts/local folder and extracted there.

When you use the --sitemod option, the migration utility will migrate all customized old 
files for all user created locals.


After running DIFF_HOST_OLD mode and before running DIFF_HOST_NEW mode, you must 
manually move the tar or zip archive from the old host to the new host, preferably under 
the smarts directory of your new installation.


DIFFERENT HOST - NEW MODE
This mode is also used when the new installation and the old installation are on different 
hosts. In this mode, sm_migrate migrates the customizations from the tar or zip archive 
that was created in the old installation to the local directory under the new installation 
and attempts to merge the files from your new installation with the files present in the 
backup archive wherever applicable, and places them in your new local directory.


UPGRADE MODE
This mode is used during an in-place upgrade, where the installer creates a backup of the 
files modified or newly introduced by you in the old installation into a 
.migrate.bkp.<old_version> backup directory and merges them into a new installation. This 
mode has been designed for the installer, but can be invoked by you too.


This mode must not be invoked by you if there are multiple .migrate.bkp.<version> 
directories under the <BASEDIR/smarts directory.
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ROLLBACK MODE
In any execution of the migration utility, before the utility migrates your customizations 
from the backup directory to your new installation, it creates a backup of certain files in 
your current new local and stores it in a .rollback_<version_timestamp> directory. Also, it 
records the version and timestamp before any migration.


The rollback option allows you to reverse the changes made by the migration utility by 
restoring the local version in your new installations using files from the 
.rollback_<version_timestamp> directory. Rollback will contain only those locals which are 
part of migration.


In some scenarios, if a file is copied to the new installation with .<old_version> extension, 
then this file is not deleted when a rollback is performed.


The rollback action is restricted only to rollback points that were recorded in your current 
version. For example if you upgrade from 9.3.0.0 to 9.4.0.0, and then install a patch (for 
example, 9.4.0.1), the rollback utility will not allow you to rollback to your 9.4.0.0 local 
version. You have to manually uninstall the patch in order to rollback to 9.4.0.0.


You can use the rollback option only after an in-place upgrade or if you have previously run 
the migration utility either in the SAME_HOST, DIFFERENT_HOST or UPGRADE_NEW modes.


“Perform a rollback” on page 82 describes the procedure for carrying out a rollback.


sm_migrate function
The customization migration utility is capable of four major functions, which include:


◆ Copying all non-binary files from the <BASEDIR>/smarts/local folder that have been 
modified or introduced by you in the previous version of the product into the 
appropriate backup directories under the <BASEDIR>/smarts directory of the new 
installation. Table 11 on page 74 provides details on the backup directories created 
by the utility during the migration and upgrade process.


Table 11  Details of backup folders created by sm_migrate utility


Scenario
Name and location of backup folders under 
<BASEDIR>/smarts


Migration on same host .migrate.bkp.<old_version>, 
.rollback_<version_timestamp>


Migration on different host old mode user-defined tar or zip file name, 


Migration on different host new mode .rollback_<version_timestamp>,
.migrate.bkp.<old_version>


Upgrade .migrate.bkp.<old_version>, 
.rollback_<version_timestamp>
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For files that have been modified by you, the utility also creates a copy of the base 
files from the <BASEDIR>/smarts folder. These files are backed up into 
.migrate.bkp.<old_version> directory. The original and the local versions of the files 
from the old installation will be needed when the utility attempts to merge your 
changes with the new installation files.


Under the smarts/.migrate.bkp.<old_version> and backup.tar or backup.zip directory 
you can find files with the following extensions:


• .custom - files from the <BASEDIR>/smarts/local folder introduced by you and are 
not part of the default installation


• .local - files from the <BASEDIR>/smarts/local folder that are part of the default 
installation and have been modified from their original version, using sm_edit.


• .base - the <BASEDIR>/smarts version of these files with .local extension


“Custom file migration use cases” on page 83 provide details.


◆ Copying the cacert.sso certificate file from <BASEDIR>/smarts/jre/lib/security directory 
into the .migrate.bkp.<old_version>/jre/lib/security directory to retain the certificate 
file.


◆ Copying all files you have added into the <BASEDIR>/smarts/local folder of the new 
installation. This allows for an easy and automatic migration of all customer files to 
the new installation, so that no manual step is required for moving the files from the 
backup directory.


All files, customized or newly introduced in the existing installation, must be present 
under the <BASEDIR>/smarts/ folder only. The utility also copies the RPS files found in 
the old_local. 


◆ Merging .asl, .import, .conf, .xml, .pl, .sh and .cmd files modified by you into the new 
installation. The utility first backs up the corresponding files from the old_base, and 
then migrates the files from .migrate.bkp.<old_version> backup directory to the new 
installation.


This is an optional function and you may skip it.


In order to merge the configurations from the existing installation into the new 
installation, the utility uses files from:


• Original base installation (previous installation with <file_name>.base extension)


• Local directory of the previous installation (files you have modified with a 
<file_name>.local extension)


• New installation (with <file_name> extension)


The files to be merged are put in the new_local after performing a three-way merge 
between the two files in the backup directory and the corresponding file in the new 
base.

sm_migrate function 75







Migration Utilities

◆ Rolling back changes made by the sm_migrate utility in your current installation. It 
creates a backup of the new_local, and allows you to rollback to multiple stages of 
backup, as long as the changes were carried out in your current version. The backup 
consists of all .conf, .import, .asl, .mdl, .xml, .template, .sh, .conflict, .automerge, 
.cmd, .dat, and .bat files found in the new_local.


Soft links created for product related files in the UNIX environment are not handled by 
sm_migrate utility.


Customization migration procedures
Run the sm_migrate utility immediately after the installation and before you start any 
services or modify any files in the new installation. Back up the BASEDIR/smarts/local 
directory in the new installation before you run sm_migrate.


When you run the sm_migrate utility, ensure that you run only one instance of sm_migrate 
utility.


On a Windows host, be aware that performing a migration takes a considerable amount of 
time. Be patient. Do not stop the migration process.


Migrating customizations on the same host


Use the following steps to migrate customizations on the same host:


1. Go to the BASEDIR/smarts/bin directory of the new installation and type the following 
command on one line to invoke the sm_migrate utility:


sm_perl sm_migrate.pl --old=<BASEDIR>/smarts (old installation) 
--new=<BASEDIR>/smarts (new installation) 
--sitemod=<BASEDIR>/smarts/local;local1


For example:


IP Manager c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge93\IP\smarts --new=c:\Incharge94\IP\smarts 
--sitemod=c:\Incharge94\IP\smarts\local1; 
c:\Incharge94\IP\smarts\local2


Service Assurance 
Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge\SAM\smarts --new=c:\Incharge\sam\smarts 
--sitemod=c:\Incharge94\SAM\smarts\local1; 
c:\Incharge94\SAM\smarts\local2


MPLS Manager c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge93\MPLS\smarts --new=c:\Incharge94\MPLS\smarts 
--sitemod=c:\Incharge94\MPLS\smarts\local1; 
c:\Incharge94\MPLS\smarts\local2
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Server Manager c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge\ESM\smarts --new=c:\Incharge\ESM\smarts 
--sitemod=c:\Incharge94\ESM\smarts\local1; 
c:\Incharge94\ESM\smarts\local2


Network Protocol 
Manager


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge\NPM\smarts --new=c:\Incharge\NPM\smarts 
--sitemod=c:\Incharge94\NPM\smarts\local1; 
c:\Incharge94\NPM\smarts\local2


Optical Transport 
Manager


c:\InCharge\OTM\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge\OTM\smarts --new=c:\Incharge\OTM\smarts 
--sitemod=c:\Incharge\OTM\smarts\local1; 
c:\Incharge\OTM\smarts\local2


VoIP Availability 
Manager


c:\InCharge\VoIP\smarts\bin>sm_perl sm_migrate.pl
--old=c:\Incharge\VoIP\smarts --new=c:\Incharge\VoIP\smarts 
--sitemod=c:\Incharge94\VoIP\smarts\local1; 
c:\Incharge94\VoIP\smarts\local2


The utility carries out the following steps:


• Verifies the presence of the existing installations in the specified directories.


• Determines the files in the old installation that must be copied.


• Lists the files that were modified by you. The utility skips files that were introduced 
by the patch but not modified by you.


• Copies the user-modified files to a backup directory in the 
BASEDIR/smarts/.migrate.bkp.<old_version> directory in the new installation.


2. Press y or any other key to start the file merge utility (sm_merge), and then press 
Enter. The sm_merge utility is invoked individually for each of the files that may 
require a three-way merge. (“Three-way merge utility” on page 86 provides details.) 
Once the utility completes merging the files, a message is displayed that indicates 
successful completion of the process.


or 


Press n to skip the invocation of the sm_merge utility.


3. Review the files (merged, auto-merged and .conflict) after the migration is over. Take 
appropriate actions as mentioned in the “User Action” column in “Custom file 
migration use cases” on page 83.


4. Press y or any other key to copy security configuration files, and then press Enter. This 
will copy the security configuration files from .migrate.bkp.<version>/conf to local/conf 
of the new installation.


or


Press n to skip the copying of security configuration files.
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Migrating customizations to a different host


Use the following steps to migrate customizations on remote hosts:


1. Prepare to archive the customizations made in the old installation into a tar or zip 
archive by copying the following files:


• Perl packages: Copy migrateperlpkg.zip from the BASEDIR/smarts/perl directory in 
the new installation to the BASEDIR/smarts/local directory of the old installation. 
For Linux and CentOS, use the unzip migrateperlpkg.zip command, and on 
Windows use the WinZip software to extract the contents in the zipped file to the 
BASEDIR/smarts/local directory.


• sm_migrate.pl utility: Copy this file from the BASEDIR/smarts/bin directory of the 
new installation to the BASEDIR/smarts/bin directory of your old installation.


2. Go to the BASEDIR/smarts/bin directory of your old installation and enter the 
following command on one line to generate an archive of the customizations:


sm_perl sm_migrate.pl --old=<BASEDIR>/smarts (old installation) 
--archive=<BASEDIR>/smarts/<tar or zip file to contain 
customizations> ----sitemod==<BASEDIR>\smarts\local1; 
=<BASEDIR>\smarts\local2


It is recommended to save the archive with .zip extension if you are installing the 
9.4.2 product on a Windows platform and .tar extension if you are installing the 9.4.2 
product on Linux and CentOS platforms.


For example:


IP Manager c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge93\IP\smarts 
--archive=c:\InCharge93\IP\smarts\backup.zip 
--sitemod=c:\InCharge93\IP\smarts\local1;c:\InCharge93\IP\
smarts\local2


Service Assurance 
Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge\SAM\smarts 
--archive=c:\InCharge\SAM\smarts\backup.tar 
--sitemod=c:\InCharge\SAM\smarts\local1;c:\InCharge\SAM\
smarts\local2


MPLS Manager c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge93\MPLS\smarts 
--archive=c:\InCharge93\MPLS\smarts\backup.zip 
--sitemod=c:\InCharge93\MPLS\smarts\local1;c:\InCharge93\MPLS\
smarts\local2


Server Manager c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge\ESM\smarts 
--archive=c:\InCharge\ESM\smarts\backup.tar 
--sitemod=c:\InCharge\ESM\smarts\local1;c:\InCharge\ESM\smarts\
local2
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Network Protocol 
Manager


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge\NPM\smarts 
--archive=c:\InCharge\NPM\smarts\backup.tar 
--sitemod=c:\InCharge\NPM\smarts\local1;c:\InCharge\NPM\
smarts\local2


Optical Transport 
Manager


c:\InCharge\OTM\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge\OTM\smarts 
--archive=c:\InCharge\OTM\smarts\backup.tar 
--sitemod=c:\InCharge\OTM\smarts\local1;c:\InCharge\OTM\
smarts\local2


VoIP Availability 
Manager


c:\InCharge\VoIP\smarts\bin>sm_perl sm_migrate.pl 
--old=c:\InCharge\VoIP\smarts 
--archive=c:\InCharge\VoIP\smarts\backup.tar 
--sitemod=c:\InCharge\VoIP\smarts\local1;c:\InCharge\VoIP\smarts\
local2


The utility carries out the following functions:


• Verifies the presence of an existing installation in the specified directory.


• Determines the files that must be copied.


• Lists the files that were modified by you. The utility skips files that were introduced 
by the patch but not modified by you.


• Archives the backup directory into the specified tar or zip archive.


3. Transfer the tar or zip archive that is created in step 2  to the BASEDIR/smarts directory 
on the host with the 9.4.2 installation.


4. Go to the BASEDIR/smarts/bin directory of your new installation and enter the 
following command on one line to migrate the customizations from the old installation 
to your new installation:


sm_perl sm_migrate.pl --new=<BASEDIR>/smarts (new installation) 
--archive=<BASEDIR>/smarts/<tar or zip file that contains 
customizations>


For example:


IP Manager c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge93\IP\smarts\backup.zip 
--new=c:\InCharge93\IP\smarts


Service Assurance 
Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge\SAM\smarts\backup.tar 
--new=c:\InCharge\SAM\smarts


MPLS Manager c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge93\MPLS\smarts\backup.zip 
--new=c:\InCharge93\MPLS\smarts


Server Manager c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge\ESM\smarts\backup.tar 
--new=c:\InCharge\ESM\smarts
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Network Protocol 
Manager


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge\NPM\smarts\backup.tar 
--new=c:\InCharge\NPM\smarts


Optical Transport 
Manager


c:\InCharge\OTM\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge\OTM\smarts\backup.tar 
--new=c:\InCharge\OTM\smarts


VoIP Availability 
Manager


c:\InCharge\VoIP\smarts\bin>sm_perl sm_migrate.pl 
--archive=c:\InCharge\VoIP\smarts\backup.tar 
--new=c:\InCharge\VoIP\smarts


In a Windows environment, you may notice that it takes a longer time to extract the 
sm_migrate.pl utility and carry out a migration. This behavior is expected and hence 
do not stop the migration process.


The utility completes the following steps:


• Verifies the presence of the new installation in the specified directory and the 
existence of the specified tar or zip archive.


• Reads the tar or zip archive and determines the files that must be copied.


• Copies the files from the tar or zip archive to a backup directory in 
BASEDIR/smarts/.migrate.bkp.<old_version>.


• Creates <BASEDIR>/smarts/.rollback_<version_timestamp> directory


• Lists the files that were modified by you.


5. Press y or any other key to start the file merge utility (sm_merge), and then press 
Enter. The sm_merge utility is invoked individually for each of the files that may 
require a three-way merge. (“Three-way merge utility” on page 86 provides details.) 
Once the utility completes merging the files, a message is displayed that indicates 
successful completion of the process.


or 


Press n to skip the invocation of the sm_merge utility.


6. Review the files (merged, auto-merged and .conflict) after the migration is over. Take 
appropriate actions as mentioned in the “User Action” column in “Custom file 
migration use cases” on page 83.


7. Press y or any other key to copy security configuration files, and then press Enter. This 
will copy the security configuration files from .migrate.bkp.<version>/conf to local/conf 
of the new installation.


or


Press n to skip the copying of security configuration files.
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Restoring customizations after an upgrade installation


During an upgrade, the installer creates a backup of your customizations and places them 
in the <BASEDIR>/smarts/.migrate.bkp.<version> directory. 


If during the installation you choose to skip migrating the files back into your new local 
directory, you may either manually migrate or merge the files into your new local 
installation directory or run the sm_migrate utility in the UPGRADE mode to perform this 
action.


Use the following steps to run the sm_migrate utility:


1. Go to the <BASEDIR>/smarts/bin folder.


2. Type the following command to migrate the backup directory to the new installation:


./sm_perl sm_migrate.pl
--new=<new installation location up to and including smarts> 
--upgrade --silent


It is optional to specify the --silent option in the command. Setting the --silent option 
does not print any messages to the screen. Using this option with sm_migrate utility 
will invoke the sm_merge utility automatically and does not prompt for your input.


For example:


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl
--new=c:\InCharge\SAM\smarts --upgrade


The utility carries out the following functions:


• Identifies the <BASEDIR>/smarts/.migrate.bkp.<old_version> directory. The 
directory contains all files that were introduced by you in the previous version of 
the application. It also contains files that have been modified by you in the 
previous install under local and the version of those files from <BASEDIR>.


• Copies the files introduced by you back under <BASEDIR>/local.


• Prompts you to run the sm_merge utility and merges the files in your new 
installation with the files contained in the backup directory wherever applicable, 
and places the resultant files in your new local directory.


• Creates <BASEDIR>/smarts/.rollback_<version_timestamp> directory


• On completion, it lists the files which were introduced or modified by you and the 
merge status of the files.


3. Press y or any other key to start the file merge utility (sm_merge utility), and then press 
Enter. The utility is invoked individually for each of the files that may require a 
three-way merge. “Three-way merge utility” on page 86 provides details. Once the 
utility completes merging the files, a message is displayed indicating successful 
completion of the process.


or 


Press n to skip the invocation of the file merge utility.
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You may use an additional --silent option to avoid this prompt. In which case, by 
default, the utility will attempt the three-way merge.


4. Press y or any other key to copy security configuration files, and then press Enter. This 
will copy the security configuration files from .migrate.bkp.<version>/conf to local/conf 
of the new installation.


or


Press n to skip the copying of security configuration files.


5. Review the files (merged, auto-merged and .conflict) after the migration is over. Take 
appropriate actions as mentioned in the 'User Action' column in “Custom file 
migration use cases” on page 83.


Perform a rollback
Use the following steps to rollback changes made by the sm_migrate utility:


1. Go to the <BASEDIR>/smarts/bin folder of your new installation, and type the following 
command to rollback the changes made by sm_migrate utility to your new installation:


./sm_perl sm_migrate.pl --new=<new_installation location _upto_and 
including smarts> --rollback [--silent]


It is optional to specify the [--silent] option in the command. The [--silent] option 
allows you to carry out the rollback without any prompts.


For example:


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl
--new=c:\InCharge\SAM\smarts --rollback


The utility carries out the following steps:


• Looks in the rollback record and displays the possible timestamps you can rollback 
to. If the utility finds more than one possible rollback timestamp, it allows you to 
choose a specific timestamp, and requests a confirmation for rollback. In the Silent 
mode, the utility chooses the latest timestamp by default, and proceeds with the 
rollback without an explicit request for confirmation. 


• Cleans the current local directory - the utility traverses the current local directory 
and deletes all the .conf, .import, .asl, .mdl, .xml, .template, .sh, .bat and .cmd 
files, except the clientConnect.conf, serverConnect.conf, brokerConnect.conf and 
runcmd_env.sh files.


• Traverses the backup directory for rollback and copies back all the files into the 
current local directory.
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Custom file migration use cases
The use cases for custom file migration and resulting backup and merge activities are 
described in Table 12 on page 83.


<file_name> with no extension represents a base file that is present under the 
BASEDIR/smarts directory of the new installation. 


Table 12  Custom file migration use cases  (page 1 of 3)


Use case Backup action Merge Action


User actionOld installation


New installation: 
BASEDIR/smarts/
.migrate.bkp.<version>


New_installation:
BASEDIR/smarts/local


There is a local copy of a file, 
and changes were introduced 
by you. The file is also used in 
the new base installation.


Back up the base and the local 
copies of the file. The base 
copy is backed up with “base” 
extension, as
<file_name>.base.


The local copy will be backed 
up with “local” extension, as
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


Run sm_merge for:
• <file_name>.base
• <file_name>.local
• <file_name>


Merge Outcome:
• Changes made by you are 


merged into the new file 
and placed in 
<New_installation>/smarts/l
ocal/<file_name>.conf


• If the changes made by you 
could not be merged 
without a conflict, a .conflict 
file is generated and placed 
in 
<New_installation>/smarts/l
ocal/<file_name>.conflict


• Because the three-way 
merge utility works at a 
string level and not at a 
code level for files such as 
.asl, .xml, .cmd, and .sh, the 
merge result of these files is 
appended with .automerge 
extension. Review the files, 
and if the changes are 
acceptable, save the file 
without .automerge 
extension.


• Files with .import and .conf 
extension are not appended 
with an automerge 
extension on successful 
merge.


• For conflict files, review the 
conflict file, manually 
resolve the conflict, and 
save the file without a 
.conflict extension.


There is a file in old base, old 
local and the same file exists in 
new base.


No backup action. No merge. No user action required.


There is a file in old base and 
the same file exists in new 
base.


No backup action. No merge. No user action required.


The local copy of the file that 
was introduced by a patch and 
later modified by you. The file 
exists in the new base, but 
does not exist in the old base.


Back up the local copy of the 
file. The local copy will be 
backed up with “local” 
extension, as 
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


sm_merge utility will compare 
<file_name>.local and 
<file_name>.


Merge Outcome:
<file_name>.conflict


Review the conflict file, 
manually resolve the conflict 
and save the file without a 
.conflict extension.
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There is a local copy of the file, 
and changes were introduced 
by you, but the file is no longer 
used in the new release.


Backup the base and the local 
copies of the file. The base 
copy is backed up with “base” 
extension, as
<file_name>.base.


The local copy will be backed 
up with “local” extension, as
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


No merge The files remain in the backup 
directory. Determine if the 
customization is still relevant 
to the new installation.


The local copy of the file was 
introduced by a patch, and 
changes were made by you. 
The file does not exist in either 
the new or old base.


Backup the local copy of the 
file. The local copy will be 
backed up with “local” 
extension, as 
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


No merge Determine if the customization 
is still relevant to the new 
installation.


There is a local copy of the file, 
and changes were made by 
you. The file is also used in the 
new version, and there is 
already a local copy of the file 
in the new local.


Backup the local copy of the 
file. The local copy will be 
backed up with “local” 
extension, as 
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


No merge The sm_merge gives 
precedence to the files in 
new_local. No changes will be 
made to the files that are 
already under new_local.
Key exceptions to the rule are 
covered in the “Migration of 
security configuration files” on 
page 85.


There is a local copy of the file, 
and custom code was 
introduced by you. This code 
does not exist in either the old 
or the new base.


Back up the local copy of the 
file. The local copy will be 
backed up with “custom” 
extension, as 
<file_name>.custom.


No merge.
Copy the files (without the 
.custom extension) from New 
Installation: 
BASEDIR/smarts/.migrate.bkp.
<version> to New installation: 
BASEDIR/smarts/local


Determine whether these 
custom files are still needed in 
your new installation.


There is a local copy of the file, 
and custom code was 
introduced by you. This file is 
also used in the new base.


Back up the local copy of the 
file. The local copy will be 
backed up with “custom” 
extension, as 
<file_name>.custom.


No merge.
Copy the files (without the 
.custom extension) from New 
Installation: 
BASEDIR/smarts/.migrate.bkp.
<version> to New installation: 
BASEDIR/smarts/local
The file is copied with 
.<old_version> extension.


Determine whether these 
custom files are still needed in 
your new installation.


Table 12  Custom file migration use cases  (page 2 of 3)


Use case Backup action Merge Action


User actionOld installation


New installation: 
BASEDIR/smarts/
.migrate.bkp.<version>


New_installation:
BASEDIR/smarts/local
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Migration of security configuration files


The sm_migrate utility prompts you for copying the security configuration files 
serverConnect.conf, clientConnect.conf, brokerConnect.conf, runcmd_env.sh and imk.dat. 
You can either choose to copy these files into the local directory of the new installation or 
configure these files later, manually.


If you choose to copy and have changed the site secret in your previous installation, you 
need to run the sm_rebond command to encrypt the files. For example:


./sm_rebond --basedir=C:\InCharge\IP\smarts


After copying the files, the data in the old runcmd_env.sh file is appended to the new 
runcmd_env.sh file and the new 9.4.2 version data is commented.


Migration of security configuration files is not supported on cross platforms.


Migration of dynamic model files


The dynamic model files (files with .mdl and .ldm extension) are backed up in the 
.migrate.bkp.<version> directory. These files are not considered by sm_migrate utility for 
merging. Remove the .ldm file from the local directory of the new installation. Recompile 
the .mdl file before it is used in the new installation. A new .ldm file will be generated once 
you recompile the .mdl file.


There is a local copy of the file, 
and changes were made by 
you. The file is also used in the 
new version, and there is 
already a local copy of the file 
in the new local introduced by 
a patch.


Back up the base and the local 
copies of the file. The base 
copy is backed up with “base” 
extension, as 
<file_name>.base.
The local copy will be backed 
up with “local” extension, as 
<file_name>.local.
Local name will be customized 
name of local.
For example: 
<file_name>.local123.


Run sm_merge for:
• <file_name>.base
• <file_name>.local
• <file_name>


Merge Outcome:
• Changes made by you are 


merged into the new file 
and placed in 
<New_installation>/smarts/l
ocal/<file_name>.conf


• If the changes made by you 
could not be merged 
without a conflict, a .conflict 
file is generated and placed 
in 
<New_installation>/smarts/l
ocal/<file_name>.conflict


• Because the three-way 
merge utility works at a 
string level and not at a 
code level for files such as 
.asl, .xml, .cmd, and .sh, the 
merge result of these files is 
appended with .automerge 
extension. Review the files, 
and if the changes are 
acceptable, save the file 
without .automerge 
extension.


• Files with .import and .conf 
extension are not appended 
with an automerge 
extension on successful 
merge.


• For conflict files, review the 
conflict file, manually 
resolve the conflict, and 
save the file without a 
.conflict extension.


Table 12  Custom file migration use cases  (page 3 of 3)


Use case Backup action Merge Action


User actionOld installation


New installation: 
BASEDIR/smarts/
.migrate.bkp.<version>


New_installation:
BASEDIR/smarts/local
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The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


Three-way merge utility
The three-way merge utility, sm_merge, helps incorporate configuration changes (made in 
the .conf, .import .asl, .xml, .pl, .sh, and .cmd files) from an old installation into a new 
installation of a product. The utility performs a three-way merge on each of the files that 
you have modified. 


The utility uses <file_name>.base, <file_name>.local, and <file_name>, and finds the largest 
sequence of lines that is common to all three files (this sequence need not necessarily be 
continuous lines). This largest sequence of lines is called the Longest Common 
Subsequence (LCS). Then, for each of the three files, it finds groups of lines in between 
two consecutive lines in the LCS. These groups are referred to as “content blocks.” The 
utility compares these content blocks to decide on merge as given in Table 12 on page 83.


Use cases for content block comparison


The scenarios for comparison of content blocks during the three-way merge process are 
described in Table 13 on page 86. In this table, X, Y, and Z represent the content blocks, 
one from each of the three files. 


Table 13  Content block comparison use cases (page 1 of 2)


Scenario Content block comparison Result


XYY
• Content block in the <file_name>.base 


looks like X
• Content block in <file_name>.local 


looks like Y
• Content block in the <file_name> looks 


like Y


The following content blocks are picked up:
• Content block in <file_name>.base = X


AllowPrivateIPAsName FALSE


• Content block in <files_name>.local = Y
AllowPrivateIPAsName TRUE


• Content block in <file_name> = Y
AllowPrivateIPAsName TRUE


Result: Y 
Since the <file_name>.local 
version and the <file_name> 
version of the content blocks 
match, the Y version is picked.


XYX 
• Content block in the <file_name>.base 


looks like X
• Content block in the <file_name>.local 


looks like Y
• Content block in <file_name> looks 


like X


 The following content blocks are picked up:
• Content block in <file_name>.base = X


ERXIfExcludeSysPattern 
router*


• Content block in <files_name>.local = Y
ERXIfExcludeSysPattern *


• Content block in <file_name> = X
ERXIfExcludeSysPattern 
router*


Result : Y 
This is the case where the file 
modified by you (Y) is 
preserved and is written to 
new_local.
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During this process, modifications done on each of the files in the old installation are 
merged into the new installation. The utility identifies the files to be copied and copies 
them into a predefined new directory in the new installation with an appropriate suffix. 
Table 12 on page 83 provides details on the files which will be copied:


The utility performs the following functions:


◆ Automated analysis of the differences between any two files (for example, File A and 
File B), while also considering the parent file. 


◆ Incorporates the changes done to the parent file in File A and File B, and automatically 
merges the two changes. This type of merge is used in revision control systems.


◆ It maintains a record of the conflicts encountered during the merge process in a 
.conflict file.


In case the utility is unable to merge the files due to some conflict, it creates a .conflict file 
for each file. The .conflict file provides details of the files which were not completely 
merged by the three-way utility. Each conflicting instance is recorded in the .conflict file. 
You can review the .conflict files to spot the conflicts, and manually resolve the 
differences.


Configuration migration process logs


Table 14 on page 87 lists the logs files that are created for the modified customization 
migration process. These files are available under the BASEDIR/smarts/setup/logs 
directory. 


X Y Z 
• Content block in the <file_name>.base 


looks like X
• Content block in the <file_name>.local 


looks like Y
• Content block in the <file_name> looks 


like Z. This is the case where a 
.conflict file is created.


The following blocks sections are picked up:
• Content block in <file_name>.base = X


#Enable/Disable discovery of 
VLANs 
PropagateVRIfAlias  FALSE


• Content block in <files_name>.local = Y
#Enable/Disable discovery of 
Router 
PropagateVRIfAlias  TRUE 


• Content block in <file_name> = Z
#Enable/Disable discovery of 
Multicast # New install 
changes
PropagateVRIfAlias  FALSE


Result: Conflict 
All three content blocks will be 
written into a .conflict file.


Table 13  Content block comparison use cases (page 2 of 2)


Scenario Content block comparison Result


Table 14  Log file and description  (page 1 of 2)


Log file name Description


Config_migration_copy.log Logs information about files that were modified during the 
previous installation, and those which were backed up in the 
new installation.


Config_migration_merge.log Logs information about the files on which three-way merge was 
performed. It also mentions whether the merge process was 
successful or if any conflicts arose during the process.
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Automatically migrate topology for IP Manager using RPS utility
The repository file (RPS) migration utility (sm_migraterps) automatically converts the RPS 
file created by the previous version of the software to an RPS file compatible with the 
newer version of the software. For example, you can use the utility to automatically 
convert the IP 9.3.0.0 RPS file into a compatible version of IP Manager 9.4. This tool allows 
the administrator to quickly migrate the product without going through a rediscovery of 
the entire topology.


The RPS migration utility supports migration from IP Manager 9.x.x versions to IP Manager 
9.4.x and later.


If you are migrating from IP Manager 9.3.x, running the RPS migration utility is optional. 
For example, if you have an IP Manager 9.3 repository file that includes virtual switch 
systems in the topology, use the sm_migraterps utility to remove VirtualSwitchSystemLink 
and make the repository compatible for IP Manager 9.4.2.


This section covers the following:


◆ “Functions of RPS migration utility” on page 88


◆ “Running RPS migration utility” on page 88


Functions of RPS migration utility


The utility performs the following functions:


◆ Creates a temporary and a backup copy of the RPS file to be migrated. On successful 
migration, the backup file is deleted. The tool then renames the temporary file as the 
new RPS and, the original RPS file as the backup file with a .v70 suffix. 


◆ Checks for the existence of the source RPS file. Users must ensure that they are using a 
valid source RPS file.


Running RPS migration utility


It is recommended to run the RPS migration utility only once. A second run will overwrite 
the older backup file.


To run the RPS migration utility:


1. Go to the <BASEDIR>/smarts/bin folder.


<file_name>.conf.MergeLog
<file_name>.asl.MergeLog
<file_name>.import.MergeLog
<file_name>.xml.MergeLog
<file_name>.sh.MergeLog
<file_name>.cmd.MergeLog


For each type of file (.conf, .import .asl, .xml, .sh, and .cmd) 
merge logs are created. These logs record the lines which the 
three-way merge process copied from the previous installation, 
lines which were retained as-is, and those where conflicts were 
observed.


Table 14  Log file and description  (page 2 of 2)


Log file name Description
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2. Copy the previous version of the RPS file to the <BASEDIR>/smarts/bin folder.


3. Type the following command: 


sm_migraterps <rps_file> --trace <logfilename>


It is optional to specify the --trace option in the command. The --trace option provides 
a line-by-line description with regard to the RPS migration processing. 


The RPS file is converted and written to a temporary file. If no errors are detected 
during the conversion, then the original RPS file will be renamed with a '.v70' suffix, 
and the temporary file will be renamed to the original. If any errors are encountered 
during file conversion, the original RPS file remains unchanged. 


4. Copy the migrated RPS file into the <BASEDIR>/smarts/local/repos/icf folder. 


5. Use the --ignore-restore-errors option in the sm_service command to start the IP 
Manager with the migrated repository file. Otherwise, the IP Manager may generate 
errors and may not start up with the migrated repository file.


6. Initiate a full discovery (Discover All). Consult the discovery guide or user guide for 
your product for more information on this procedure. 


A full discovery is required for the new version features and changes to take effect.


Deployment utility overview
The Deployment Utility allows you to deploy customizations and configuration changes 
from an existing installation to another installation on the same version of a product. The 
deployment can be carried out on the same host or between two different hosts running 
the same operating system.


The utility is useful if you have to apply the same configurations on multiple installations 
of a product. Use the utility if you have:


◆ Multiple new installation running on the same or multiple hosts that will need to share 
the same configuration and customizations.


◆ Multiple installations on the same or multiple hosts that are upgraded and will share 
the same configuration and customizations.


In both cases, you will need to start with one installation where you make all your 
modifications to configuration files, <BASEDIR>/smarts/local files and, create and compile 
dynamic models. Then, run the sm_deploy utility to create a package that contains your 
modifications. Use the sm_deploy utility to apply the files collected from the first 
installation to the rest of your installations. 


The Deployment Utility performs the following three functions:


◆ Create a package


◆ Deploy the package


◆ Rollback
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Create a package


The utility enables you to create a deployment package which consists of all the 
customizations made to files in an installation. In SAM, by specifying a broker and server 
information when you run the utility, you can collect configuration settings from RPS into 
the package. 


Deploy the package


The utility enables you to deploy a previously collected deployment package into other 
installations of the same product running on the same version and operating system as 
the original installation. If you have collected configuration settings from SAM RPS, the 
configurations will be available in the file, <SAM_server>.xml under local/conf/ics 
directory. 


Rollback


Before deploying the package into an installation, the utility creates a rollback directory 
containing the backup copy of files from the current installation which will be used incase 
of a rollback action. You can rollback your configuration to that in your rollback directory, 
only if the version of your current installation is the same as the version of the installation 
when the rollback directory was created.


Soft links created for product related files in the UNIX environment are not handled by 
sm_deploy utility.


Running the Deployment utility


To run the Deployment utility, go to <BASEDIR>/smarts/bin directory and type the following 
command:


./sm_perl sm_deploy.pl <options>


where, <options> refers to the options specified in the section,“sm_deploy modes of 
operation” on page 90.


sm_deploy modes of operation


The sm_deploy has the following command-line options:


◆ --install=<dir> – To install the utility.


◆ --create=<file> – To create the deployment package.


◆ --deploy=<file> – To deploy the package.


◆ --rollback – To rollback the configuration changes.


◆ --broker – The broker to which the SAM server is attached. Use this option to collect 
configuration settings from SAM RPS.


◆ --server – The SAM server whose configuration settings from RPS are to be collected.


◆ --clean – To clean the files in the local directory.


◆ --silent

90 EMC Smarts Installation Guide for SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers







Migration Utilities

◆ --sitemod – To specify customer specific local directories.


◆ --help


The deployment utility must be used with at least one of these options.


If you want to run this utility from older versions of EMC Smarts products, you must copy 
the sm_migrate.pl script, sm_deploy.pl script and, the Perl files packaged in a .zip file 
from the 9.4.2 installation to the corresponding locations in the old installation.


To create a deployment package


1. Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the 
following command:


./sm_perl sm_deploy.pl --install=<BASEDIR>/smarts 
--create=<archive-name.tar> --sitemod==<BASEDIR>/smarts/local


2. The utility identifies the files with customizations from the local directory under 
<BASEDIR>/smarts directory of the installation that need to be copied to the 
deployment package. Local directory can be local1, local2.


3. The utility copies the files from the local directory to the deployment backup directory 
.deploy.bkp<pdt>.<version> under <BASEDIR>/smarts, archives these files to a specified 
archive file and then deletes the backup directory.


Manage RPS file settings across multiple installations


The method of extracting the configuration settings from an RPS file into the deployment 
package varies between SAM, IP, and VoIP Managers.


For SAM, use the deployment utility to extract the configuration settings from the RPS file.


Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the following 
command:


./sm_perl sm_deploy.pl --install=<BASEDIR>/smarts 
--create=<archive-name.tar> --broker=<host:port> 
--server=<SAM_server>


If a server is specified, the utility collects the configurations into the file, 
<SAM_server>.xml under local/conf/ics directory.


This can be a convenient way to deploy the configurations of aggregate SAM domain since 
they often share the same configuration.


For IP, use the sm_settings.pl script of the IP-Configuration Manager tool to export the 
Polling and Threshold groups from an existing domain and import them into the 
IP-Configuration Manager to be deployed further on other domains.


For more information on loading settings into IP-Configuration Manager, refer to the EMC 
Smarts IP Manager User Guide.


For VoIP Availability Manager, Network Protocol Manager, MPLS Manager, and Server 
Manager, the configuration settings from an RPS file must be manually configured in all 
other installations of these products.
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To deploy the package


1. Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the 
following command:


./sm_perl sm_deploy.pl --install=<TargetBASEDIR>/smarts 
--deploy=<archive-name.tar>


The utility extracts the archive into the backup directory .deploy.bkp<pdt>.<version> 
under <BASEDIR>/smarts.


2. Creates a rollback directory with the backup of files from the target installation which 
will be used incase of a rollback action. Rollback will contain local folders which are 
part of the deployment package.


3. Copies all the files from the deployment package to the local directory of the target 
installation. 


4. Overwrites the files that are part of both, the deployment package and the local 
directory of the target installation.


5. If the --clean option is specified, the files in the local directory of the target installation 
that are not part of the deployment package are deleted. 


Or


If --clean option is not specified, the files in the local directory of the target installation 
that are not part of the deployment package are retained.


To deploy the SAM RPS settings, 


◆ Manually import the <SAM_server>.xml file from local/conf/ics directory to the 
directory in the target installation by typing the following sm_config command:


./sm_config --server=<SAM_server> import --force <SAM_server>.xml


To Rollback


1. Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the 
following command:


./sm_perl sm_deploy.pl --install=<TargetBASEDIR>/smarts --rollback


The utility displays all the rollback directory locations to which you can rollback.


2. Copies the files from the local directory of the installation whose rollback directory you 
choose to rollback to, into the corresponding location in your current installation.


If your current directory is a rollback directory location, it will not be displayed in the list of 
rollback directory locations to which you can rollback.
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CHAPTER 7
Verifying the Installation


This chapter describes tasks for confirming proper installation of the Service Assurance 
Manager, IP Manager, MPLS Manager, Server Manager, Network Protocol Manager, Optical 
Transport Manager, and VoIP Availability Manager. It consists of the following topics:


◆ Check the version number.......................................................................................  94
◆ Obtain and install a temporary license file...............................................................  95
◆ Start services ..........................................................................................................  97
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◆ Service and program startup options.......................................................................  99
◆ Start Smarts NOTIF ................................................................................................  100
◆ Verify the product status .......................................................................................  102
◆ Verify the FIPS 140 mode status ............................................................................  103
◆ Collect system information....................................................................................  104
◆ Configuration Scanner Tool ...................................................................................  108
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Check the version number
When you run a utility to report the version number of the software, you will see both the 
version number for the product as well as the version number for the underlying 
foundation software. These two version numbers might differ.


To verify the version number, enter the following command from the 
<BASEDIR>/smarts/bin directory:


sm_server --version


UNIX users: If the current directory is not set in your PATH variable, prefix the command 
with ./ (a period followed by a forward slash).


This command should return the following information:


◆ Operating system (OS) name on which the product is running and the OS version 
identifier.


◆ Version number of the product. 


◆ Version number of the foundation (DMT) code, foundation build number, the date and 
time that the build was made as well as whether you have installed a 64-bit version of 
the software. If you installed the 64-bit version, you will see a “/64” after the 
foundation and the product version number.


The “sm_server --version” output is the following:


Operating System <Identifier>
<product>: V<Number>(<InternalBuild>), <Date> 
Copyright 1995-2012, EMC Corporation - Build <Build>
Foundation V<Number>(<InternalBuild>), <Date>
Copyright 1995-2012, EMC - Build <Build>


For example, for IP Manager, the output might look similar to:


linux_rhAS50-x86-64/206320000
IP_NETWORK_SUITE: V9.4.2.0(152199), 13-Jul-2016 04:01:27 Copyright 


1995-2016, EMC Corporation - Build 29
Foundation V9.4.2.0(152138), 10-Jul-2016 15:01:00 Copyright 1995-2016, 


EMC Corporation - Build 8


The product version number is displayed during the Wizard mode installation on the 
InstallShield screen.


Be aware that product versions vary and do not always match the software foundation 
version number. For example, if you select the About from the Help menu in the Global 
Console, you may see a different number.
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Obtain and install a temporary license file
To obtain a temporary (evaluation) license, complete a Support Request (SR) form, which 
you can find on the EMC support website http://support.emc.com.


Your EMC account team will send you a temporary (evaluation) <license_name>.lic file 
through email. Copy the license file to the BASEDIR/smarts/local/conf directory on the 
host system where you have installed the EMC Smarts software.


◆ If multiple products run on the same host, copy the license file to the 
BASEDIR/smarts/local/conf directory for each product.


◆ If a product runs on multiple hosts, copy the license file to the 
BASEDIR/smarts/local/conf directory on each host where the software is installed. 


Edit the SM_LICENSE variable in runcmd_env.sh on each host where EMC Smarts software 
is installed to specify the full path and file name of a single license file. When multiple 
products are installed on the same host, each product will include a runcmd_env.sh in its 
BASEDIR/smarts/local/conf directory.


If the temporary license file has a different extension, do not rename it. Instead, ensure 
that the name that is entered for the SM_LICENSE variable matches that of the license file.


Temporary licenses are time-limited. At the end of the trial period, the software will no 
longer start. The trial license has an expiration date. The system generates two events 
alerting users about the expiration of the trial license: LicenseExpirationWarning and 
LicenseExpired. Table 15 on page 96 provides details on the events associated with the 
license expiration alert generation process.
For illustrative purposes, the following example is an excerpt of a smarts.lic file: 


FEATURE DMC_CORR sm_lmgrd92 9.0 04-dec-2012 uncounted 123456789ABC \
HOSTID=DEMO SN=DO315530889 START=4-nov-2008
FEATURE AD_PEM sm_lmgrd92 9.0 04-dec-2012 uncounted 123456789ABC \
HOSTID=DEMO SN=DO315530889 START=4-nov-2012
FEATURE AP_ICSRV sm_lmgrd92 9.0 04-dec-2012 uncounted 123456789ABC \
HOSTID=DEMO SN=DO315530889 START=4-nov-2012
FEATURE DMC_DECS sm_lmgrd92 9.0 04-dec-2012 uncounted 123456789ABC \
HOSTID=DEMO SN=DO315530889 START=4-nov-2012


A temporary license file is not user-modifiable, and it consists of a list of applications or 
features; each line begins with the FEATURE keyword. Each FEATURE line includes the 
feature name, the vendor daemon name (sm_lmgrd92), the feature version, the expiration 
date, the number of concurrent licenses that is “uncounted” in this case, the 
authentication signature for the feature, the HOSTID=DEMO value that indicates that the 
feature is not bound to any particular host, the serial number (SN) to identify the FEATURE 
line, and a start date.


Events and attributes for license expired alert


Table 15 on page 96 and Table 16 on page 96 provides details on the event and attributes 
associated with the license expired alert generation process.

Obtain and install a temporary license file 95







Verifying the Installation

The EMC Smarts System Administration Guide provides instructions for installing 
temporary and permanent licenses.


You will not be able to start new domain after a license expires. New devices can be added 
to the topology and discovery can be performed during the grace period, but new domains 
cannot be started using the same license. A fresh license is required to start new domain 
servers. You can extend the grace period on your license by a year. A special request 
asking for additional grace period on the AP_SYSTEM_VOLUME license feature has to be 
sent. Discovery and auto-discovery depends on this AP_SYSTEM_VOLUME license feature. 


A new domain cannot be started even with this special license file. For example, if the 
license is expiring on 9/15/2011, and five domains are pointing towards the license 
server, then even after expiration, the five domains will continue to work till 9/15/2012. 
However, if we start a new domain server after 9/15/2011 and it is pointing towards the 
same license file, it will not work. You will need to a new license to start a new domain 
server. Also, if your temporary license expires and if you are within the grace period, you 
will not be able to either restart existing domain managers if they are stopped, or add any 
new device in the existing topology.


Table 15  Event for license expired alert generation


Event Description
Subscribed to by
the Global Manager


LicenseExpirationWarning Indicates that the system license expiration has reached 
the remaining days threshold limit. This is defined as 
follows: 
(Number of license remaining days <= License expiration 
warning threshold).
An event will be generated if the remaining days is less 
than the LicenseExpirationWarningThreshold value. The 
event will be cleared if:
• The license expires 
• A permanent license is obtained
or 
• The new trial license is valid for over 30 days


Yes - When the license expiration 
threshold is reached, a 
LicenseExpirationWarning 
notification is generated in the 
Service Assurance Manager server.


LicenseExpired This event is generated when the number of days 
remaining for the expiration of a license reaches 0, that 
is, when the value for the 
NumberOfLicenseRemainingDays attribute reaches 0.


Yes - When the 
NumberOfLicenseRemainingDays 
value reaches 0, a notification is 
generated in the Service Assurance 
Manager server.


Table 16 Attributes for license expired alert generation


Attribute Description Default value


LicenseExpirationWarningThreshold The number of days before license expiration for which 
the event will be generated. The default value is set to 30 
days. 


30


NumberOfLicenseRemainingDays The number of days for which the license is effective. This 
is auto-calculated from expiration date and current date. 


NA
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Start services
EMC Corporation recommends installing EMC Smarts products as services. If you installed 
the products as services, you must start them for the first time. These services start 
automatically upon system reboot.


Start the Broker service first if it is not running.


Starting services on UNIX


Verify the status of the service daemon before starting a service.


Verifying the status of the service daemon
Use the ic-serviced command to check the status of the service daemon. The path to the 
ic-serviced command varies by operating system.


CentOS


On CentOS systems, enter the following command to verify the status of the service 
daemon:


/etc/init.d/ic-serviced status


If the sm_serviced process does not respond, the process is not running. Start the service 
by entering the command:


/etc/init.d/ic-serviced start


Linux


On Linux systems, enter the following command to verify the status of the service daemon:


/etc/init.d/ic-serviced status


If the sm_serviced process does not respond, the process is not running. Start the service 
by entering the command:


/etc/init.d/ic-serviced start


Starting services
To start or stop an EMC Smarts service, use the sm_service utility. Type the command from 
the BASEDIR/smarts/bin directory:


sm_service start <service_name> [<service_name> ...]


where <service_name> is each service you need to start. Table 17 on page 99 provides a 
list of service names.


Starting services on Windows


To start an EMC Smarts service from the Windows desktop:


1. Select Start > Settings > Control Panel > Administrative Tools.


2. Select Services.
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3. Right-click the EMC Smarts service.


4. Select Start.


Start programs
You can start EMC Smarts programs from the terminal when the program is not intended to 
be long-running or to perform testing. EMC Corporation does not recommend using this 
method in a production environment.


The EMC Smarts System Administration Guide provides a complete description of the 
command syntax.


To start a program, type the command with the appropriate options on one line.


◆ For UNIX, invoke the command from the BASEDIR/smarts/bin directory. Prefix the 
command with ./ (a period followed by a forward slash).


◆ For Windows, invoke the command from the C:\BASEDIR\smarts\bin directory.


Starting the EMC Smarts Broker


./brstart --port=426 --output


Starting a Manager


▼ ./sm_server --name=<server_name>
--config=<config_directory>
--port=0
--ignore-restore-errors
--output ▲


▼▲ indicates the command must be typed on one line.


For UNIX, to run the program in the background, use the daemon option.


Service Assurance Manager Console crashes when running commands on a Linux platform 
since the FIPS library fails to load. SELinux prevents the shared libraries, libcryptocme2.so 
and libccme_base.so from loading because of the existence of text relocation in the 
library.


The following workarounds are available to avoid the SAM Console crash:


1. Run the following commands to change the file context for the shared libraries, 
libcryptocme2.so and libccme_base.so to textrel_shlib_t:


chcon -t textrel_shlib_t libcryptocme2.so
chcon -t textrel_shlib_t libccme_base.so


2. Set the parameter setenforce to 0 to run SELinux in permissive mode.


3. Navigate to Edit /etc/selinux/config and set the parameter SELINUX to Disabled.
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Service and program startup options
Table 17 on page 99 lists service names, server names, and configuration directories for 
EMC Smarts products. 


Table 17  Default service names, server names, and configuration directories (page 1 of 2)


Product Service name Server name Config directory


Broker ic-broker Not applicable Not applicable


IP Manager


IP Availability Manager ic-am-server INCHARGE-AM icf


IP Performance Manager ic-pm-server INCHARGE-PM icf


IP Availability and Performance 
Manager


ic-am-pm-server INCHARGE-AM-PM icf


Service Assurance Manager


Service Assurance Manager Server ic-sam-server INCHARGE-SA ics


Service Assurance Manager Adapter 
Platform Server


ic-icoi-server INCHARGE-OI icoi


SNMP Trap Adapter ic-trapd-receiver TRAP-INCHARGE-OI icoi


Syslog Adapter ic-syslog-adapter SYSLOG-INCHARGE-OI Not applicable


Business Impact Manager MBIM INCHARGE-MBIM bim


MPLS Manager


MPLS Analysis Server ic-mpls-analysis INCHARGE-MPLS-ANALYSIS mpls-a


MPLS Monitoring Server ic-mpls-monitoring INCHARGE-MPLS-MONITORING mpls-m


MPLS Topology Server ic-mpls-topology INCHARGE-MPLS-TOPOLOGY mpls-t


MPLS VPN-Tagging Server ic-vpn-tagging VPN-TAGGING vpn-tagging


Server Manager


Server Manager ic-esm-server INCHARGE-ESM esm


Network Protocol Manager products


Network Protocol Manager for BGP ic-npm-bgp-server INCHARGE-BGP conf/bgp


Network Protocol Manager for EIGRP ic-npm-eigrp-server INCHARGE-EIGRP conf/eigrp


Network Protocol Manager for IS-IS ic-npm-isis-server INCHARGE-ISIS conf/isis


Network Protocol Manager for OSPF ic-npm-ospf-server INCHARGE-OSPF conf/ospf


Optical Transport Manager


Optical Transport Manager for Next 
Generation WDM


ic-wdm-ng-server OTM-WDM-NG wdm-ng


Optical Transport Manager for SDH 
(Topology)


ic-sdh-topology-serv
er


OTM-SDH-TOPOLOGY osm-t


Optical Transport Manager for SDH 
(Analysis)


ic-sdh-analysis-serv
er


OTM-SDH-ANALYSIS osm-a
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◆ Appendix B, “Manually Installing Services,” provides the default service and program 
parameters that are used for the service install commands.


◆ The EMC Smarts System Administration Guide provides information in regard to the 
sm_server, sm_adapter, and sm_trapd programs.


Start Smarts NOTIF
To start Smarts NOTIF:


1. Set an environment variable in the BASEDIR directory path to ensure that Java can be 
successfully started for Smarts NOTIF. In BASEDIR/smarts/local/conf/runcmd_env.sh, 
add the following line:


SM_JAVA_ENABLED=YES


2. Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of 
the default trap_mgr_parse.asl script so that Smarts NOTIF processes SNMP traps. For 
example:


./sm_service install --force --unmanaged --startmode=runonce \
'--name=ic-notif-trap' \
'--description=Notif Trap Receiver' \
'/opt/InCharge/SAM/smarts/bin/sm_trapd' \
'--name=NOTIF-TRAP' \
'--server=INCHARGE-OI' \
'--output' \
'--config=icoi' \
'--port=1162' \
'--model=sm_actions' \
'--rules=icoi-trapd/Notif-trap_mgr_parse.asl'


Optical Transport Manager for PDH 
(Topology)


ic-pdh-topology-serv
er


OTM-PDH-TOPOLOGY pdh-t


Optical Transport Manager for PDH 
(Analysis)


ic-pdh-analysis-serv
er


OTM-PDH-ANALYSIS pdh-a 


Optical Transport Manager for WDM 
(Topology)


ic-wdm-topology-ser
ver


OTM-WDM-TOPOLOGY wdm-t


Optical Transport Manager for WDM 
(Analysis)


ic-wdm-analysis-ser
ver


OTM-WDM-ANALYSIS wdm-a


Optical Transport Manager for IP 
Cross Domain Analysis


ic-xd-otm-ip-server OTM-WDM-TOPOLOGY icxd-ao 


TMF814 Cisco CTM Adapter for OTM ic-tmf814-cisco-ctm-
adapter


OTM-CISCO-ADAPTER tmf814Cisco


TMF814 Ciena On-Center Adapter 
for OTM


ic-tmf814-ciena-onc
tr-adapter


OTM-CIENA-ADAPTER tmf814Ciena 


VoIP Availability Manager


VoIP Availability Manager ic-voip-server VoIP-AM conf/voip


VoIP Notification Trap Adapter ic-voip-notification-
trapd-receiver


TRAP-INCHARGE-VOIP conf/voip


Table 17  Default service names, server names, and configuration directories (page 2 of 2)


Product Service name Server name Config directory
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The --daemon option only works on UNIX systems, not Microsoft Windows systems. 
Any customizations made by the customer to the original trap_mgr_parse.asl file in 
the BASEDIR/smarts/rules/icoi-trapd directory must be incorporated into the 
Notif-trap_mgr_parse.asl file in the BASEDIR/smarts/rules/icoi-trapd directory.


3. Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the 
default SysLog_mgr.asl script in order for Smarts NOTIF to process Cisco system log 
files.


For example:


./sm_service install --force --unmanaged --startmode=runonce \
'--name=ic-notif-syslog' \
'--description=Notif Syslog Adapter' \
'/opt/InCharge/SAM/smarts/bin/sm_adapter' \
'--name=NOTIF-SYSLOG' \
'--server=INCHARGE-OI' \
'--output' \
'--config=icoi' \
'--port=1162' \
'--model=sm_actions' \
'--model=sm_system'\
'--rules=icoi-syslog/Notif-SysLog_mgr.asl'\
'--tail=/opt/InCharge/SAM/smarts/local/logs/sample.txt'


One or more adapters can feed a single Smarts NOTIF server.


4. Launch the Smarts NOTIF Editor by selecting Start > Programs > InCharge > Smarts 
NOTIF Editor. 


You can also launch the editor by double-clicking the NotifGui.bat file (for Windows 
systems) or the NotifGui.sh file (for UNIX systems) in the BASEDIR/smarts/notif/editor 
directory.


5. Use the Smarts NOTIF Editor to connect to the running SAM server or Adapter Platform 
server. Select Remote > Edit a server's settings in the Smarts NOTIF Editor. The Connect 
to a Server dialog box appears, showing the list of available Adapter Platform and 
SAM server connections. 


6. Choose a server from the list of available server connections in the Connect to a Server 
dialog box and click OK.


If server connections are not displayed, perform the following to populate the list of 
server connections:


a. Click More in the Connect to a Server dialog box. The Manage Connections 
dialog box appears where you can add server connections. 


b. Click Add in the Manage Connections dialog box. The Input dialog box appears. 


c. Enter a connection reference name (for example, “Remote Smarts NOTIF OI 
server”) in the Input dialog box and click OK. 
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d. Fill in the new connection record in the right pane of the Manage Connections 
dialog box.


e. Click OK to save the connection setup.


The Remote Server Settings dialog box appears that shows the server's current 
settings.


7. Select the Activate Smarts NOTIF checkbox, and then click OK.


You can also change other server settings in the Remote Server Settings dialog box if 
necessary. 


8. Restart your SAM server or Adapter Platform server.


Server setting changes made in the Smarts NOTIF Editor Remote Server Settings 
dialog box are persistent. When you change server settings in the Remote Server 
Settings dialog box and click OK, the changes are saved to the Notif_Settings.import 
file that is generated and saved to the BASEDIR/smarts/local/conf/<icoi or ics> 
directory in the Adapter Platform or SAM server where Smarts NOTIF is running. Server 
setting changes made in the Smarts NOTIF Editor are preserved even if the repository 
is deleted. For example, if the repository is erased because you used the --norestore 
option for server startup, the server uses the last saved settings from the Smarts 
NOTIF Editor saved in BASEDIR/smarts/local/conf/<icoi or ics>/Notif_Settings.import.


The EMC Smarts Notification Module User Guide includes information on how to use the 
Smarts NOTIF Editor. 


Verify the product status
You can determine the current state of the products that register with the Broker by typing 
the following command from the BASEDIR/smarts/bin directory:


./brcontrol


This command displays a list of EMC Smarts Managers and adapters that are registered 
with the Broker, their states (RUNNING, DEAD, UNKNOWN), process IDs, port numbers, and 
the last time that their states changed.


Also check any log files for the products. Typically, these log files are in 
BASEDIR/smarts/local/logs.


More than one log file may be generated due to changes in the foundation code that 
supports internationalization. The EMC Smarts System Administration Guide provides 
additional information on log files.
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If only one log file per server is desired, use sm_edit to update the 
BASEDIR/smarts/local/conf/runcmd_env.sh file. To get a single log file, set the following 
environment variables:


export SM_LOCALE=en_US (or appropriate locale code)
export SM_ENCODING_OUTPUT=UTF-8


Verify the FIPS 140 mode status
To verify if the installation is running in FIPS-140 mode, run the following command in the 
dmctl mode:


get SM_System::SM-System::FIPS


The value for this parameter must be TRUE.


You can also check for the status of FIPS 140 in the log files in the 
BASEDIR/smarts/local/logs directory. When the Broker and server start in FIPS 140 mode, 
a message similar to the following one is written to the Broker and server log files:


RSA BSAFE: MES 3.2.4 26-May-2012/64(0), FIPS: RSA BSAFE Crypto-C Micro 
Edition FIPS 140-2 Module 3.0.0.0/64(0), May 31 2008 13:19:56


Common issues


Domain registers with the broker, but appears DEAD after a few minutes


The domain is in FIPS 140 mode but the broker is not.


Domain is not able to register with the broker


The Broker is in FIPS 140 mode but the domain is not.


Broker or Domain log entry


CI-N-EWHILE-While executing function "queue_work”CI-EFLOWID-For flow 
CI_FlowTCP_U [Flow in negotiations Accepted physical flow] PHYSICAL 
@0x0000000000a38db  . *:v4:44445 KS N/A, KR N/A  . Open fd=10, conn 
August 17, 2011 3:27:43 PM EDT, disc N/A,  . 127.0.0.1:44445 -> 
127.0.0.1:58347, tmo 0 00:00:15 N/S 1/0 CI-EWHILE-While executing 
function ""CI_FlowTLS_U::handshake”” 
CI-BSAFE-error:1407609C:SSLroutines:SSL23_GET_CLIENT_HELLO:http 
request: ; in file "s23_srvr.c" at line 746


The entry might also appear as: SSL routines:SSL23_GET_CLIENT_HELLO:unknown protocol.


This may be because the Domain (or Broker) is in FIPS 140 mode but the client is not. It 
may also be that the client is a non-Smarts client (for example a load balancer’s HTTP 
check). In that case, switch the load balancer to HTTPS check.


Client error


CI-E-EWHILE-While executing function 
""CI_FlowTLS_U::handshake””CI-BSAFE-error:1408F10B:SSL 
routines:SSL3_GET_RECORD:wrong version number: ; in file "s3_pkt.c" 
at line 553CI-TLSPE-TLS protocol error


This may be because the Domain or Broker is not FIPS 140 capable but the client is 
operating in FIPS 140 mode.
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Log errors


[July 11, 2011 5:09:41 PM EDT +385ms] t@31 PollingQueue 
#8CI-E-EDECRYPT-Cannot decrypt.CI-EDECRYPT-Cannot decrypt.[July 11, 
2011 5:09:41 PM EDT +386ms] t@31 PollingQueue 
#8IA-E-ERROR_EXECUTING_ACTION-Error executing action 
MA-PerlScript-sihou513a.CI-EDECRYPT-Cannot decrypt.


This may be because the Imk.dat version or the password does not match between 
domains. Ensure that the password and the version matches across all installs that inter 
operate.


Error on startup of domain or other tools


[August 8, 2011 8:29:07 PM EDT +466ms] t@3916876800 <Primary 
Thread>CI-F-EBLACKSTRING_CONTEXT-While creating the 
contextCRPT-CRYPTO_MD5_INIT_FAILED-Failed to initialize the context 
for MD5 algorithm


This may be because you are trying to use a v1 imk.dat file in FIPS 140 mode. Ensure that 
you use v2.1 for FIPS 140 compatibility.


Collect system information
The sm_getinfo utility is used to collect data for troubleshooting EMC Smarts Manager 
(server) problems. The utility backs up the current configuration for a server by creating a 
tar archive of all files and user customizations that are essential to troubleshooting the 
server. Customers then email the tar archive to EMC Customer Support for problem 
resolution.


sm_getinfo files


The sm_getinfo utility, which is supported on CentOS, Linux, and Windows, creates four 
types of files in the installation directory area from which it is invoked. The files are shown 
described in Table 18 on page 104.


Table 18  Files created by the sm_getinfo utility (page 1 of 2)


Filename Description


Files in BASEDIR/smarts/local/logs directory


sm_getinfo<date>.tar.gz
Example:
sm_getinfo26Mar2012-015952.tar.gz


A compressed tar archive in which the sm_getinfo utility stores a 
server ‘s log files, repository files, core files (CentOS, Linux) or dump 
files (Windows), user-modified files (using sm_edit), user-introduced 
files, and system environment information. The actual content of the 
tar archive depends on the user-specified options on the sm_getinfo 
invocation command line.
The name of the tar archive includes the date when the tar archive 
was created.


MANIFEST A text file that lists all of the files that the sm_getinfo utility includes 
in the tar archive.


Files in BASEDIR/smarts/local/logs/smgetinfo_files directory
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sm_getinfo command-line syntax


You run the sm_getinfo utility from the BASEDIR/smarts/bin directory. The options that 
you specify on the invocation command line determine which files are included in the 
sm_getinfo-created tar archive.


Here is the command line syntax for sm_getinfo:


sm_perl sm_getinfo.pl
| --server <server name> --pid <server process ID>
| --broker <location>
| --log [<number of latest logs>]
| --nolog
| --repos [--latest]
| --norps
| --core
| --all
| --version
| --help
| --smmonitor “<sm_monitor options>”
| --flush
| --smconfigscan


where:


◆ <> Angle brackets are user-supplied parameter values (variables).


◆ [ ] Square brackets are optional entries.


◆ | Vertical bar symbols are alternate selections.


smgetinfo-versions.log.<date>
Example:
smgetinfo-versions.log.26Mar2012-020004


Example of other files in smgetinfo_files:
TTP-Installed-versions.log.26Mar2012-020005


A log file in which the sm_getinfo utility writes information about a 
server’s log file or repository file that is larger than 700 megabytes 
(MB). The sm_getinfo utility does not include any log or repository file 
in a server’s tar archive that exceeds 700 MB.
In addition, sm_getinfo writes system information to the log file.
The name of the log file includes the date when the log file was 
created.


Final_sm_getinfo<timestamp>.tar
Example:
Final_sm_getinfo20Sep2012-005855.tar


The -k or --smconfigscan command invokes the Configuration 
Scanner tool, and generates the Final_getinfo-<timestamp>.tar, along 
with other Configuration Scanner tool-related files.


Notice: If the sm_getinfo utility is run without the -k or --smconfigscan 
command, a getinfo-<timestamp>.tar output file will be generated 
without Final_ appended to the output. This implies that you will be 
running the sm_getinfo tool as usual.


Table 18  Files created by the sm_getinfo utility (page 2 of 2)


Filename Description
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The command-line options are described in Table 19 on page 106. 


Table 19  Command-line options for the sm_getinfo utility  (page 1 of 2)


Option Description


--server <server name> --pid <server 
process ID> | -s <server name> -p <server 
process ID>


Specifies the EMC Smarts server name and PID against which 
the sm_getinfo utility will collect information. To dump a core file 
for a running server on CentOS or Linux, the pid option must be 
provided. Also, the server name is used to invoke the 
sm_monitor tool.


--broker <location> | -b <location> Specifies an alternate broker location as host:port.


--pid <pid> | -p <pid> PID of Domain Manager used to run gcore.Not applicable on 
Windows.


--log [<number of latest logs>] | 
-l [<number of latest logs>]


For each EMC Smarts server, collects and stores a user-specified 
number of latest logs or all generated log files that are in the 
BASEDIR/smarts/local/logs directory.
Note that whenever collecting a log, the related .audit and 
.archive files should be collected as well.
If a server name is specified, only the files that correspond to the 
server will be collected. To avoid generating a too-large tar 
archive (too large to email), any log file that is larger than 700 
MB will be excluded and its information will be logged in 
smgetinfo-versions.log<date>.


--nolog | -g Excludes log files when collecting local files. This option and 
--log are mutually exclusive.


--repos [--latest] | -r [-t] For each EMC Smarts server, collects and stores the latest 
repository file or all repository files. If a server name is specified, 
only the file corresponding to the server will be collected. Any 
repository file that is larger than 700 MB will be excluded and its 
information will be logged in smgetinfo-versions.log<date>.


--norps | -n Excludes repository files when collecting local files. This option 
and --repos are mutually exclusive.


--core | -c Collects and stores the core files (CentOS, Linux) or dump files 
(Windows) that are generated by the EMC Smarts software, and 
the corresponding logs.


--all | -a All data and files in BASEDIR/smarts/local and 
BASEDIR/smarts/setup directories will be collected and stored. 
If --all option is specified, the other options will be ignored 
except --server and --pid.


--version | -v Print version information and exit.


--help | -h Print usage information and exit.


--smmonitor “<sm_monitor options>” | 
-m “<sm_monitor options>”


Specifies the options for running sm_monitor, which will 
override the default options “-m run-all -z.”
Approximately two cycles are run to collect the required 
information. The collected information is output to the 
BASEDIR/smarts/local/logs/SM-Monitor-<server name> 
directory.
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sm_getinfo invocation examples


To gather the five latest logs, enter:


sm_perl sm_getinfo.pl  --logs 5


To gather the latest repository data and core files, enter:


sm_perl sm_getinfo.pl  --repos --latest --core


To gather the entire BASEDIR/smarts/local directory, enter:


sm_perl sm_getinfo.pl  --all


To invoke sm_monitor, enter:


On Linux:


sm_perl sm_getinfo.pl -s <server name> -m “-m correlation -z”


On Windows:


sm_perl sm_getinfo.pl -s <server name>  -m “-m mem”


sm_getinfo data collection


If no command-line option is specified, the sm_getinfo utility will store the following 
information in the tar archive:


◆ For each server, the latest server log file in BASEDIR/smarts/local/logs and the related 
.audit and .archive files in BASEDIR/smarts/local/logs. If a server name is specified, 
only the files that correspond to the server will be collected. To avoid generating a 
too-large tar archive (too large to email), any log file that is larger than 700 MB will be 
excluded and its information will be logged in smgetinfo-versions.log<date>.


◆ For each server, the latest repository file in BASEDIR/smarts/local/repos. If a server 
name is specified, only the repository file for the server will be archived. Any 
repository file that is larger than 700 MB will be excluded and its information will be 
logged in smgetinfo-versions.log<date>.


◆ The local files that are not in the BASEDIR/smarts/local/logs and repos directories 
and changed since last temporary test patch (TTP) and patch.


◆ The new local files that are not in the BASEDIR/smarts/local/logs and repos 
directories and were added since the last TTP and patch.


--flush | -f Force a flush. Needed when the sm_getinfo utility is invoked 
from a remote host.


--smconfigscan | -k


Notice: This option is available for IP 
Manager only.


Invokes the configuration scanner tool to provide a snapshot of 
all the customizations introduced by you in your current 
installation. “Configuration Scanner Tool” on page 108 provides 
more information on how to use the tool.


Table 19  Command-line options for the sm_getinfo utility  (page 2 of 2)


Option Description
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◆ All local files except the files in logs and repos directories if no TTP or patch is 
installed.


◆ All files in the BASEDIR/smarts/setup/info and BASEDIR/smarts/setup/logs 
directories.


◆ Core files (UNIX) or dump files (Windows) that are generated by the EMC Smarts 
software, and the corresponding server log files. On Linux, some library (lib) files that 
are related to the cores are also collected.


◆ EMC Smarts TTP or patch version information. Additionally, it verifies MD5 checksum 
for the installed TTP files and the files that are listed in manifest.md5 in the 
BASEDIR/smarts/setup/info directory.


◆ The data collected by sm_monitor. If a server name is specified, only the files that 
correspond to the server will be collected.


◆ The data generated by the EMC Smarts Health Monitor (SHM).


◆ System environment information.


Configuration Scanner Tool


This tool is available only for IP Manager.


The Configuration Scanner tool scans for configuration changes in your current 
installation. It scans for customizations with regard to the following:


◆ Polling and threshold settings: The tool presents the non-default values and settings. 
That is, the tool generates a list of polling settings and threshold parameters that 
have changed from their default values, along with details of all the groups they are 
associated with. The output also includes tagging settings. In case of CLI settings, the 
tool collects and displays the username and the associated matching criteria.


◆ Configuration files: The tool generates a list of files that have changed from the default 
installation. The tool scans the files in the SM_SITEMOD and base installation and 
does a two-way difference analysis to figure out what files have changed, and displays 
the list of files, flagged appropriately as modified or added. For discovery.conf, 
name-resolver.conf and tpmgr-param.conf files, the tool parses through the content 
and presents the difference at an attribute->value pair level.


The clientConnect.conf, serverConnect.conf, brokerConnect.conf, .imk.dat files and 
the l10n classes and Perl directories are excluded from the scan.


The tool ignores service pack and patch files that are not modified by you. 
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Running the Configuration Scanner tool from the sm_getinfo utility


To run the Configuration Scanner tool:


1. Go to the <BASEDIR>/smarts/bin folder.


In this document, the term BASEDIR represents the location where EMC Smarts 
software is installed. For example:


For UNIX, this location is: /opt/InCharge/<product>.


For Windows, this location is: C:\InCharge\<product>.


On UNIX operating systems, IP Availability Manager is, by default, installed to: 
/opt/InCharge/IP/smarts. On Windows operating systems, this product is, by default, 
installed to: C:\InCharge\IP\smarts. This location is referred to as BASEDIR\smarts. 
Optionally, you can specify the root of BASEDIR to be something different, but you 
cannot change the <product> location under the root directory.


2. Type the following command:


sm_perl sm_getinfo <options> -k (or --smconfigscan)


An example for the command is provided below:


sm_perl sm_getinfo --broker=localhost:5086 --server=INCHARGE-AM 
--smconfigscan


or


sm_perl sm_getinfo -b localhost:5086 -s pserver --smconfigscan


The tool has four command-line options: --broker and --server. You can use these 
options in various combinations and in any order. The details of the options are 
provided below:


◆ --broker= <location> or -b <location> is the name of the broker if you are using a broker 
other than your default broker. For example: localhost:400.


It is optional to specify a broker. If a broker is not specified, the tool picks up the 
broker in the runcmd_env.sh file as the default.


◆ --server=<name> or -s <name> is the name of the Smarts server.
For example: --server=INCHARGE-AM.


It is optional to specify a server. If a server is not specified, the tool skips the scan for 
polling and threshold settings, and does only a configuration file scan. However, if the 
server is running from a location other than the current working directory, the tool 
scans for polling and threshold settings, but skips the check for file differences and 
proceeds with packaging the output.


Once you run the command, the tool carries out the following steps:


• Connects to the IP server and scans for changes to the polling and threshold 
setting values, and writes the findings to an output file. 
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When prompted for domain login credentials, type the username and password for 
connecting to the domain.


• Maintains lists of files it has determined as modified or introduced by you and lists 
of files that were changed by TTPs, if any.


• For some special files, that is, discovery.conf, tpmgr-param.conf and 
name-resolver.conf), the tool invokes an adapter to parse the contents of the 
modified and base version of these files. It presents a detailed account of the 
changes you have made at an attribute->value pair level in the 
sm_configscan_report-<time_stamp>.txt report file. 


As the tool starts the adapter and accesses your running server to gather 
information, you will be prompted for login credentials. Type the credentials you 
provided earlier for connecting to the domain.


• Creates a sm_configscan.<time_stamp>.tar file at 
<BASEDIR>/smarts/local/logs/sm_getinfo-<time_stamp>.tar, which contains the 
.configscan.<version_number> directory, report file and the logs.


• Cleans up your environment by removing any directories and files it had created, 
except for the tar file and the report file. It closes any servers or brokers it had 
started. 
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CHAPTER 8
Performing an Uninstallation


This chapter describes how to uninstall the EMC Smarts Service Assurance Manager, EMC 
Smarts IP Manager, EMC Smarts MPLS Manager, EMC Smarts Server Manager, EMC Smarts 
Network Protocol Manager, EMC Smarts Optical Transport Manager, and EMC Smarts VoIP 
Availability Manager. It consists of the following topics:


◆ Before uninstallation.............................................................................................  112
◆ Uninstall EMC Smarts products .............................................................................  117
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Before uninstallation
You should complete the following tasks before uninstalling the product:


◆ “Remove manually installed services” on page 112


◆ “Determine order for removing products (UNIX only)” on page 112


◆ “Uninstall when same product software is installed twice (Windows only)” on 
page 113


◆ “Detect and stop programs” on page 113


◆ “Uninstall the FlexNet License Server” on page 116


Remove manually installed services


Services that you manually installed with sm_service command are not removed by the 
uninstallation program. You must remove these services manually before uninstalling the 
product software.


To remove a service, invoke sm_service from the BASEDIR/smarts/bin directory:


1. Use sm_service to list installed services.


sm_service show


2. Remove the manually installed service.


sm_service remove ic-<service name>


where <service name> is the name of the service. For example, ic-am-server or 
ic-sam-server.


Determine order for removing products (UNIX only)


When uninstalling EMC Smarts products from the same server, the product that was 
installed first must be uninstalled last. During the installation of the first product, the 
EMC Smarts Service Database is created and the other products subsequently access it. 
Uninstalling the product installed first will also uninstall the Service Database that will 
disable the sm_service command for those products, prevent their proper operation and 
uninstallation.


You can determine what product software was installed first by performing this check:


1. Use a text editor to open the ic-serviced script.


• For CentOS, ic-serviced is located in the /etc/init.d directory


• For Linux, ic-serviced is located in the /etc/init.d directory


2. Find the value of the SMHOME variable.


The value of SMHOME indicates which product was installed first.
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Uninstall when same product software is installed twice (Windows only)


If you installed the same product to different locations on the same host system, do not 
use Add/Remove Programs to uninstall. Uninstall the EMC Smarts product as follows:


1. Open a command-line prompt, go to the BASEDIR\_uninst directory of the target 
EMC Smarts product, and enter the following command to initiate a Wizard mode 
uninstallation:


uninstaller.exe


2. Complete the uninstallation beginning with step 2  as described in “Uninstall using 
Wizard mode” on page 117.


Detect and stop programs


Before upgrading or uninstalling your product, you must stop all EMC Smarts services, 
EMC Smarts scheduled jobs, and any other process that uses programs or libraries 
running from the EMC Smarts product.


Detecting programs
The sm_plist utility identifies all EMC Smarts programs that are running for any product on 
your machine. You can use the sm_plist utility whenever you need to identify EMC Smarts 
programs that are running (for example, before applying a service pack or patch and 
uninstalling the product software).


To use the utility, invoke it from the BASEDIR/smarts/script directory. The utility displays 
active programs in a window: 


1. Go to the BASEDIR/smarts/script directory.


2. Start the sm_plist utility:


On UNIX, enter


./sm_plist.sh <BASEDIR2>


On Windows, enter


cscript sm_plist.vbs <BASEDIR2>


where BASEDIR is the directory where the sm_plist utility is installed and BASEDIR2 
represents the location of any EMC Smarts product.


Stopping active programs (UNIX)
To stop active EMC Smarts programs (UNIX):


1. Stop active EMC Smarts services using the sm_service utility from 
BASEDIR/smarts/bin:


./sm_service stop --all


sm_serviced waits 30 minutes after sending a shutdown request to a process. If the 
process is still running after 30 minutes, sm_serviced terminates it.
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2. Determine if any EMC Smarts services are still running by using the brcontrol utility 
from BASEDIR/smarts/bin:


./brcontrol -b <host>:<port>


Based on the location of the Broker, go to the appropriate step, as indicated in 
Table 20 on page 114. 


3. Stop any EMC Smarts server that is still running. If the Broker is on the host, stop the 
local Broker:


• To stop any server that is still running, use the dmquit utility from 
BASEDIR/smarts/bin:


./dmquit --server=<server name> -b <host>:<port>


• To stop the local Broker from BASEDIR/smarts/bin:


./brquit --broker=localhost:<port>


4. Determine if any other EMC Smarts processes are still running and shut the processes 
down:


• Detect the processes using the following command:


ps -ef | grep “sm_”


If a list is displayed, note the process ID (pid) of these active EMC Smarts 
processes.


Do not stop or kill the service daemon process, sm_serviced.


• Shut down these EMC Smarts processes (except sm_serviced) using the following 
command:


kill <pid>


Table 20  Next steps for detecting and stopping programs 


The Broker is on the . . . And this displays . . . Do this . . .


Same host “Error attaching to 
Broker” message


The Broker is not running. Go to step 4 .


List of servers 
registered with the 
Broker


• The Broker or service daemon did not shut 
down.


• If any servers are still running on the host, 
these did not shut down.


Go to step 3 .


Different host List of servers 
registered with the 
Broker


• If any servers are still running on the host 
where you will install the EMC Smarts 
software, these did not shut down. Go to 
step 3 .
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Stopping active programs (Windows)
To stop a service from the Windows desktop, use the Microsoft Management Console:


1. Select Settings > Control Panel.


2. At the Control Panel, select Administrative Tools.


3. At the Administrative Tools folder, select Services.


4. At the Services window, locate any running EMC Smarts services. These services start 
with the words “EMC Smarts,” “Smarts,” or “InCharge.” For each of these services, 
right-click the service and then select Stop.


Do not stop the Broker service.


5. Repeat step 4 until all EMC Smarts services are stopped.


6. Open a command prompt and determine if any Managers are running by using the 
brcontrol utility from BASEDIR\smarts\bin:


brcontrol -b <host>:<port>


7. Stop any EMC Smarts server that is still running using the dmquit utility from 
BASEDIR/smarts/bin:


./dmquit --server=<server name> -b <host>:<port>


8. If the Broker is installed on the same host, use the brquit utility from 
BASEDIR/smarts/bin to stop it:


brquit --broker=localhost:<port>


9. Press Ctrl+Alt+Delete. The Windows Security dialog box appears.


10. Click Task Manager. The Windows Task Manager appears.


11. Select the Processes tab.


Allow up to 30 minutes before performing the next step. EMC Smarts servers with 
large topologies can take considerable time to stop while saving the topology to the 
repository. Stopping processes prematurely may corrupt your repository file.


12. In the Processes tab, look in the column labeled Image Name for sm_server. 
Right-click each sm_server, and then select End Process.


13. In the Processes tab, look for other Image Names that start with sm_, for example, 
sm_notify, sm_adapter, sm_beacon, and so on. Right-click each instance, and then 
select End Process.


Do not shut down any sm_authority or sm_logger processes. The sm_authority and 
sm_logger processes are child processes of an EMC Smarts server. The child 
processes will stop when the parent process stops.
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Uninstall the FlexNet License Server


When uninstalling all of your EMC Smarts products that use a specific FlexNet License 
Server, you must also uninstall the FlexNet License Server. 


If any EMC Smarts products will remain in your network and use the FlexNet License 
Server, do not uninstall either the license server or the EMC Smarts product where the 
permanent license file resides.


If you uninstall EMC Smarts products without uninstalling the FlexNet License Server, a 
message displays that the FlexNet (lmgrd) service is still running. Remember that an 
EMC Smarts application will not start if it is unable to contact the license server. 


To stop and uninstall the FlexNet License Server:


1. Stop the FlexNet License Server. 


CentOS


/etc/init.d/SMARTS-License stop


Linux


/etc/init.d/SMARTS-License stop


Windows


To manually stop the license server on Windows, do the following:


• Select Start > Settings > Control Panel > Administrative Tools.


• Select Services.


• Select the FlexNet License Server service.


• Right-click and select Stop.


2. Run the install_license script, with the uninstall command, from 
BASEDIR/smarts/script.


On UNIX, enter:


install_license.sh uninstall


On Windows, enter:


install_license.cmd uninstall
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Uninstall EMC Smarts products
EMC Smarts product software uses the InstallShield program to install and uninstall 
products. For UNIX, you invoke the uninstallation program from the system prompt. For 
Windows, you use the Add/Remove Programs, except when the same product is installed 
in multiple locations on the same host system. Failure to use the appropriate method will 
result in an unstable system and/or inconsistent product directories.


Do not manually delete the installed product directories. 


Also, if you plan to reinstall the product, save all of the customized files that are in the 
BASEDIR/smarts/local directory before performing the uninstallation. The uninstallation 
program will remove all of the files and directories in the BASEDIR/smarts directory, and 
then remove the smarts directory.


Uninstall using Wizard mode


Wizard mode provides a graphical user interface to the uninstallation program for UNIX 
and Windows platforms.


On UNIX systems, Wizard mode uses the X Window System to display the installation 
wizard. The host on which you install the EMC Smarts software and the host where you log 
in must be configured to run the X Window System. Before starting the installation 
program, verify that the X Window System is running.


1. Invoke the uninstaller program:


• On UNIX, go to the BASEDIR/_uninst directory and enter:


uninstaller.bin


• On Windows, use Windows Control Panel:


a. Click Start > Settings > Control Panel.


b. Double-click Programs and Features.


c. From the Program and Features window, select the appropriate product.


d. Click Uninstall/Remove.


2. Click Next in the Welcome screen to continue. 


3. In the Product Selection screen, click Next to uninstall the entire product (by default, 
all products are selected) or deselect products that should remain installed. 


4. Review the list of products that will be uninstalled and the target installation directory. 
Once you click Next, you cannot cancel the uninstallation process.


If necessary, click Back to return to the Product Selection screen to revise your 
selections. 


To uninstall the products, click Next; the Uninstallation Progress screen appears.
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5. Upon completion, the Uninstallation Summary shows informational messages such as 
successful confirmations, error messages, and warnings. Investigate any errors or 
warnings.


If Next appears, your system needs to be rebooted. Click Next and then reboot your 
system. Otherwise, click Finish to exit the uninstallation. 


The uninstallation program will remove all of the files and directories in the 
BASEDIR/smarts directory, and then remove the smarts directory.


The uninstallation program will also write an uninstall log file to the BASEDIR directory, 
unless the uninstallation fails at the very start, in which case the installation program 
will write the log file to the /tmp directory. The log file is a text file with the naming 
convention Uninstall.<product>.<productversionNumber>.log.


Uninstall using CLI mode


To uninstall an EMC Smarts product or product:


1. Go to the BASEDIR/_uninst directory and enter the following command:


uninstaller.bin -console


During the uninstallation processes, you are prompted with a series of steps and 
menus. You can either accept the default value or select another choice. The default 
values are indicated in brackets or as predefined selections (checkmarks) in menus. 
To accept the default value, press Enter.


When replying to a prompt, you can either accept the default value or select another 
choice.
To reply yes, enter Y
To reply no, enter N.
Do not press Delete; doing so will cause the process to terminate with an error 
message.


For selections in menus, you can accept default selections or type the number of the 
item and press Enter. An X appears next to the item. When you are finished making 
selections, type zero (0) and press Enter.


If you incorrectly type an entry, press 5 to repeat the prompt and select the correct 
value. Arrow keys and the backspace key are not supported.


Upon completion, the Uninstallation Summary displays informational messages such 
as successful confirmations, error messages, and warnings.


2. Press Enter to continue. If necessary, the installation program will prompt to restart 
your computer. 


3. Press 1 to restart immediately or press 2 to restart later.


4. If you chose not to restart your computer, press 3 to finish.


5. Upon completion, the uninstallation program will remove all of the files and 
directories in the BASEDIR/smarts directory, and then remove the smarts directory.


The uninstallation program will also write an uninstall log file to the BASEDIR directory, 
unless the uninstallation fails at the very start, in which case the installation program 
will write the log file to the /tmp directory. The log file is a text file with the naming 
convention Uninstall.<product>.<productversionNumber>.log.
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Uninstall using Unattended mode


The Unattended mode enables you to automate the removal of the EMC Smarts products.


1. Invoke the uninstallation program with appropriate options for the operating system:


• On UNIX systems, go to the BASEDIR/_uninst directory and enter the following 
command:


uninstaller.bin -silent 


• On Windows system, go to the BASEDIR\_uninst directory and enter the following 
command:


uninstaller.exe -silent 


2. Upon completion, the uninstallation program will remove all of the files and 
directories in the BASEDIR/smarts directory, and then remove the smarts directory.


The uninstallation program will also write an uninstall log file to the BASEDIR directory, 
unless the uninstallation fails at the very start, in which case the installation program 
will write the log file to the /tmp directory. A non-zero status indicates a failure. The 
log file is a text file with the naming convention 
Uninstall.<product>.<productversionNumber>.log.
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This appendix describes how to use the sm_edit utility. It consists of the following topics:
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sm_edit
As part of the EMC Smarts deployment and configuration process, you need to modify 
certain files. User modifiable files include configuration files, rule set files, templates, and 
seed files that contain encrypted passwords. Original versions of these files are installed 
into appropriate subdirectories under the BASEDIR/smarts/ directory.


The original versions of files should not be altered. If a file must be modified, a new 
version should be created and then stored as a local copy of the file in 
BASEDIR/smarts/local or one of its subdirectories.


When EMC Smarts software requires one of these files, it is designed to first search for a 
modified file in BASEDIR/smarts/local or one of its subdirectories. If a modified version of 
a file is not found in the local area, EMC Smarts software then searches corresponding 
BASEDIR/smarts directories for the original version of the file.


To ease file editing and storage, EMC Corporation provides the sm_edit utility with the 
every EMC Smarts product. When invoked, sm_edit opens the specified file in a text 
editor. This utility ensures that modified files are always saved to the appropriate local 
area and that non-local copies of all files remain unchanged. If an appropriate 
subdirectory does not exist for the file you are modifying, sm_edit creates the appropriate 
subdirectory before saving the modified file to that location. For files with header 
information set for encryption, sm_edit encrypts certain fields in the file. In addition, 
sm_edit preserves the file permissions of modified files, which helps ensure that 
important configuration files are not altered by unauthorized users.


The EMC Smarts System Administration Guide provides instructions on how to configure 
the utility to use a specific editor.


sm_edit example
To use sm_edit from the command line, specify the file name and include the subdirectory 
under BASEDIR/smarts/local where the file resides. For example, to edit the trapd.conf, 
enter the following command from the BASEDIR/smarts/bin directory:


sm_edit conf/trapd/trapd.conf


In this example, sm_edit searches in the BASEDIR/smarts/local/conf/trapd directory for 
the trapd.conf file. If it finds the trapd.conf file, it opens the file in a text editor. If sm_edit 
does not find the trapd.conf file in the BASEDIR/smarts/local/conf/trapd directory, it 
creates a local copy of the trapd.conf file and writes it to the 
BASEDIR/smarts/local/conf/trapd directory.


The EMC Smarts System Administration Guide provides additional information about the 
sm_edit utility.
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APPENDIX B
Manually Installing Services


This appendix describes how to install services manually for the EMC Smarts Service 
Assurance Manager, EMC Smarts IP Manager, EMC Smarts MPLS Manager, EMC Smarts 
Server Manager, EMC Smarts Network Protocol Manager, EMC Smarts Optical Transport 
Manager, and EMC Smarts VoIP Availability Manager. It consists of the following topics:


◆ Overview...............................................................................................................  124
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◆ Services for the IP Manager ...................................................................................  125
◆ Services for the Service Assurance Manager ..........................................................  131
◆ Services for the MPLS Manager .............................................................................  137
◆ Services for the Server Manager ............................................................................  139
◆ Services for the Network Protocol Manager installation .........................................  140
◆ Services for the Optical Transport Manager ...........................................................  143
◆ Services for the VoIP Availability Manager .............................................................  148
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Overview
If you did not install services when you installed the EMC Smarts products, you may install 
services manually. Services are programs that, once started, are generally intended to run 
continuously. Components installed as services start automatically upon system reboot; 
those not installed as services (manual processes or disabled processes) require that you 
issue commands to start and stop them as necessary.


EMC Corporation recommends that EMC Smarts products be installed as services 
whenever possible. Typical reasons to install products as services include the following 
conditions:


◆ (IP Manager only) There is a need to install services for a single product instead of the 
combined IP Availability Manager and IP Performance Manager products (for example, 
IP Availability Manager alone or IP Performance Manager alone). “Selection of 
bootstrap files when installing services” on page 124 provides more information.


◆ During installation of the product software, you chose to start product components 
manually and now want to run the components as services.


◆ Multiple instances of a single product component running as a service are required. 
During installation, you can install only a single instance of a product component as a 
service.


To manually install a product as a service, use the sm_service install command with the 
appropriate set of options. 


The EMC Smarts System Administration Guide provides a complete description of the 
command syntax.


Selection of bootstrap files when installing services


When you install IP Manager 9.4.2 with all services selected, both IP Availability Manager 
and IP Performance Manager services are installed. The default configuration file, 
bootstrap.conf, is used by the IP Manager 9.4.2 installer.


If your deployment supports only IP Availability Manager or IP Performance Manager, you 
must manually install these services for the IP Manager(s) using a bootstrap file different 
from bootstrap.conf.


Broker services 
This section provides the default UNIX and Windows commands that are used to install 
the service manually for the Broker. Type the command on one line.


UNIX ▼ BASEDIR/smarts/bin/sm_service install 
--force
--name=ic-broker
“--description= EMC Smarts Broker”
--env=SM_CLIENTCONNECT=brokerConnect.conf
--startmode=runonce
BASEDIR/smarts/bin/brstart
--port=426
--output
--restore=BASEDIR/smarts/local/repos/ broker/broker.rps ▲
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Windows ▼ BASEDIR\smarts\bin\sm_service install 
--force 
--name=ic-broker 
“--description= EMC Smarts Broker”
--env=SM_CLIENTCONNECT=brokerConnect.conf 
--startmode=runonce 
BASEDIR\smarts\bin\brstart.exe 
“--port=426” 
“--output” 
“--restore=BASEDIR\smarts\local\repos\ broker\broker.rps"▲


▼▲ indicates that this command must be typed as one line.


Services for the IP Manager
Here are the UNIX commands used to install services manually for the underlying servers 
in the IP Manager.


IP Availability Manager-only server


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-am-server
“--description= EMC Smarts IP Availability Manager Server”
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-AM
--config=icf
--bootstrap=bootstrap-am.conf
--port=0
--subscribe=default
--ignore-restore-errors
--output▲


Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-am-server
“--description= EMC Smarts IP Availability Manager Server”
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
“--name=INCHARGE-AM” 
“--config=icf” 
“--bootstrap=bootstrap-am.conf” 
“--port=0” 
“--subscribe=default” 
“--ignore-restore-errors” 
“--output”▲
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IP Availability Manager-only server (interacting with EMC M&R)


Use this syntax for the IP Availability Manager if you plan use the EMC M&R UI to configure 
IP Manager settings. 


The Service Assurance Suite How to Maintain IP Manager Settings article explains how to 
use the IP Availability Manager with the Configuration Manager to configure IP Manager 
settings. The SolutionPack for EMC Smarts Summary Sheet article provide information on 
viewing notifications from the EMC M&R user interface. The Service Assurance Suite 
Documentation Index, available on the EMC Community Network (ECN), provides links to 
related documentation.


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-am-server
“--description= EMC Smarts IP Availability Manager Server”
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-AM
--config=icf
--bootstrap=bootstrap-am.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--output▲


Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-am-server
“--description= EMC Smarts IP Availability Manager Server”
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
“--name=INCHARGE-AM” 
“--config=icf” 
“--bootstrap=bootstrap-am.conf” 
“--port=0” 
“--edaa=ip\2.0” 
“--ignore-restore-errors” 
“--output”▲


IP Performance Manager-only Server


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-pm-server
“--description= EMC Smarts IP Performance Manager Server”
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-PM
--config=icf
--bootstrap=bootstrap-pm.conf
--port=0
--subscribe=default
--ignore-restore-errors
--output▲
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Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-pm-server 
"--description= EMC Smarts IP Performance Manager Server" 
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
"--name=INCHARGE-PM" 
"--config=icf" 
"--bootstrap=bootstrap-pm.conf" 
"--port=0" 
"--subscribe=default" 
"--ignore-restore-errors" 
"--output"▲


IP Performance Manager-only Server (interacting with EMC M&R)


Use this syntax for the IP Performance Manager if you plan use the EMC M&R UI to 
configure IP Manager settings. 


The Service Assurance Suite How to Maintain IP Manager Settings article explains how to 
use the IP Performance Manager with the Configuration Manager to configure IP Manager 
settings. The SolutionPack for EMC Smarts Summary Sheet article provide information on 
viewing notifications from the EMC M&R user interface. The Service Assurance Suite 
Documentation Index, available on the EMC Community Network (ECN), provides links to 
related documentation.


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-pm-server
“--description= EMC Smarts IP Performance Manager Server”
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-PM
--config=icf
--bootstrap=bootstrap-pm.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--output▲


Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-pm-server 
"--description= EMC Smarts IP Performance Manager Server" 
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
"--name=INCHARGE-PM" 
"--config=icf" 
"--bootstrap=bootstrap-pm.conf" 
"--port=0" 
"--edaa=ip\2.0" 
"--ignore-restore-errors" 
"--output"▲
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IP Availability and Performance Manager Server 


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install 
--force 
--name=ic-am-pm-server
“--description= EMC Smarts IP Availability Manager and Performance 
Manager Server” 
--startmode=runonce 
/opt/InCharge/IP/smarts/bin/sm_server 
--name=INCHARGE-AM-PM 
--config=icf
--bootstrap=bootstrap-am-pm.conf 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output▲


Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-am-pm-server 
"--description= EMC Smarts IP Availability Manager and Performance 
Manager Server" 
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
"--name=INCHARGE-AM-PM" 
"--config=icf" 
"--bootstrap=bootstrap-am-pm.conf" 
"--port=0" 
"--subscribe=default" 
"--ignore-restore-errors" 
"--output"▲


IP Availability and Performance Manager Server (interacting with EMC M&R)


Use this syntax for the IP Availability and Performance Manager if you plan use the EMC 
M&R UI to configure IP Manager settings. 


The Service Assurance Suite How to Maintain IP Manager Settings article explains how to 
use the IP Availability and Performance Manager with the Configuration Manager to 
configure IP Manager settings. The SolutionPack for EMC Smarts Summary Sheet article 
provide information on viewing notifications from the EMC M&R user interface. The Service 
Assurance Suite Documentation Index, available on the EMC Community Network (ECN), 
provides links to related documentation.


UNIX ▼ /opt/InCharge/IP/smarts/bin/sm_service install 
--force 
--name=ic-am-pm-server
“--description= EMC Smarts IP Availability Manager and Performance 
Manager Server” 
--startmode=runonce 
/opt/InCharge/IP/smarts/bin/sm_server 
--name=INCHARGE-AM-PM 
--config=icf
--bootstrap=bootstrap-am-pm.conf 
--port=0 
--edaa=ip/2.0
--ignore-restore-errors 
--output▲
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Windows ▼ C:\InCharge\IP\smarts\bin\sm_service install 
--force 
--name=ic-am-pm-server 
"--description= EMC Smarts IP Availability Manager and Performance 
Manager Server" 
--startmode=runonce 
C:\InCharge\IP\smarts\bin\sm_server.exe 
"--name=INCHARGE-AM-PM" 
"--config=icf" 
"--bootstrap=bootstrap-am-pm.conf" 
"--port=0" 
"--edaa=ip\2.0" 
"--ignore-restore-errors" 
"--output"▲


IP Configuration Manager


UNIX /opt/InCharge/IP/smarts/bin/sm_service install
--force
--name=ic-ip-configuration
"--description=EMC Smarts IP Configuration Manager"
--startmode=runonce
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-CM
--config=icf-c
--bootstrap=bootstrap.conf
--port=0
--subscribe=default
--ignore-restore-errors
--nodx
--output


Windows C:\InCharge\IP\smarts\bin\sm_service install
--force
--name=ic-ip-configuration
"--description=EMC Smarts IP Configuration Manager"
--startmode=runonce
C:\InCharge\IP\smarts\bin\sm_server.exe
"--name=INCHARGE-CM"
"--config=icf-c"
"--bootstrap=bootstrap.conf"
"--port=0"
"--subscribe=default"
"--ignore-restore-errors"
"--nodx"
"--output"
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IP Configuration Manager (interacting with EMC M&R)


Use this syntax for the Configuration Manager if you plan use the EMC M&R UI to configure 
IP Manager settings. 


The Service Assurance Suite How to Maintain IP Manager Settings article explains how to 
use the Configuration Manager to configure IP Manager settings. The SolutionPack for EMC 
Smarts Summary Sheet article provide information on viewing notifications from the EMC 
M&R user interface. The Service Assurance Suite Documentation Index, available on the 
EMC Community Network (ECN), provides links to related documentation.


UNIX /opt/InCharge/IP/smarts/bin/sm_service install
--force
--unmanaged
--startmode=runonce
--name=ic-ip-configuration-edaa
"--description=EMC Smarts IP Configuration Manager for EDAA"
/opt/InCharge/IP/smarts/bin/sm_server
--name=INCHARGE-CM 
--config=icf-c
--bootstrap=bootstrap.conf
--port=0
--edaa=ip/2.0
--ignore-restore-errors
--nodx
--output


Windows C:\InCharge\IP\smarts\bin\sm_service install
--force
--unmanaged
--startmode=runonce
--name=ic-ip-configuration-edaa
"--description=EMC Smarts IP Configuration Manager for EDAA"
C:\InCharge\IP\smarts\bin\sm_server.exe
"--name=INCHARGE-CM"
"--config=icf-c"
"--bootstrap=bootstrap.conf"
"--port=0"
"--edaa=ip\2.0"
"--ignore-restore-errors"
"--nodx"
"--output"
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Services for the Service Assurance Manager
This section provides default service parameters for the EMC Smarts Service Assurance 
Manager.


EMC Smarts Broker


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install
--force
--startmode=runonce
--name=ic-broker
--description="EMC Smarts Broker"
--env=SM_CLIENTCONNECT=brokerConnect.conf
/opt/InCharge/SAM/smarts/bin/brstart
--port=426
--restore=/opt/InCharge/SAM/smarts/local/repos/broker/broker.rps
--output▲


Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service.exe install 
--force
--startmode=runonce
--name=ic-broker
--description="EMC Smarts Broker"
--env=SM_CLIENTCONNECT=brokerConnect.conf
C:\InCharge\SAM\smarts\bin\brstart.exe
--port=426 
--restore=C:\InCharge\SAM\smarts\local\repos\broker\broker.rps▲


Service Assurance Manager (Presentation SAM server)


UNIX /opt/InCharge/SAM/smarts/bin/sm_service install 
--force  
--unmanaged  
--startmode=runonce 
--name=ic-sam-server-pres
--description=”EMC Smarts Service Assurance Manager Server 


(notification cache publishing)” 
/opt/InCharge/SAM/smarts/bin/sm_server 
-n INCHARGE-SA-PRES
--config=ics
--port=0
--edaa=sam-presentation/2.0
--bootstrap=bootstrap-amqp.conf
--ignore-restore-errors
--output


Windows C:\InCharge\SAM\smarts\bin\sm_service install --force  --unmanaged  
--startmode=runonce 


“--name=ic-sam-server-pres” 
“--description=EMC Smarts Service Assurance Manager Server 


(notification cache publishing)” 
C:\InCharge\SAM\smarts\bin\sm_server
“-n INCHARGE-SA-PRES” 
“--config=ics”
“--port=0” 
“--edaa=sam-presentation\2.0” 
“--bootstrap=bootstrap-amqp.conf” 
“--ignore-restore-errors”
“--output”
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Service Assurance Manager (Global Manager)


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install
--force
--unmanaged
--name=ic-sam-server
--startmode=runonce 
--description="EMC Smarts Service Assurance Manager


Server"
/opt/InCharge/SAM/smarts/bin/sm_server
--name=INCHARGE-SA
--config=ics
--port=0
--ignore-restore-errors
--output▲


Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service.exe install
--force
--name=ic-sam-server
--startmode=runonce 
--description="EMC Smarts Service Assurance Manager


Server"
C:\InCharge\SAM\smarts\bin\sm_server.exe
--name=INCHARGE-SA
--config=ics
--port=0
--ignore-restore-errors
--output▲


Business Impact Manager server


UNIX ▼/opt/InCharge/SAM/smarts/bin/sm_service install 
--startmode=runonce
--name=MBIM
--description=”EMC Smarts MBIM – Maintenance and Business Impact 
Manager Server”
/opt/InCharge/SAM/smarts/bin/sm_server
--name=INCHARGE-MBIM
--config=bim
--port=0
--ignore-restore-errors
--output▲


Windows ▼C:\InCharge\SAM\smarts\bin\sm_service.exe install 
--startmode=runonce
--name=MBIM
--description=”EMC Smarts MBIM – Maintenance and Business Impact 
Manager Server”
C:\InCharge\SAM\smarts\bin\sm_server.exe
--name=INCHARGE-MBIM
--config=bim
--port=0
--ignore-restore-errors
--output▲
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Adapter Platform


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install
--force
--unmanaged
--name=ic-icoi-server
--startmode=runonce 
--description="EMC Smarts SAM Adapter Platform Server"
/opt/InCharge/SAM/smarts/bin/sm_server
--name=INCHARGE-OI
--config=icoi
--port=0
--ignore-restore-errors
--output▲


Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service.exe install
--force
--name=ic-icoi-server
--startmode=runonce 
--description="EMC Smarts SAM Adapter Platform Server"
C:\InCharge\SAM\smarts\bin\sm_server.exe
--name=INCHARGE-OI
--config=icoi
--port=0
--ignore-restore-errors
--output▲


Business Dashboard


UNIX ▼ /opt/InCharge/CONSOLE/smarts/bin/sm_service install
--force
--unmanaged
--name=ic-business-dashboard
--startmode=runonce 
--description="EMC Smarts Servlet Engine"
/opt/InCharge/CONSOLE/smarts/bin/sm_tomcat
--output
start▲


Windows ▼ C:\InCharge\CONSOLE\smarts\bin\sm_service.exe install
--force
--name=ic-business-dashboard
--startmode=runonce 
--description="EMC Smarts Servlet Engine"
C:\InCharge\CONSOLE\smarts\bin\sm_tomcat.exe
--output
start▲
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Syslog Adapter


Before you configure the Syslog Adapter, identify the location of the SYSFILE you want the 
adapter to tail and parse and ensure that sm_service install command line for the 
ic-syslog-adapter identifies this location. The EMC Smarts Service Assurance Manager 
Adapter Platform User Guide provides more information on configuring the Syslog 
Adapter.


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install 
--force
--unmanaged
--name=ic-syslog-adapter
--startmode=runonce
--description="EMC Smarts Syslog Adapter"
/opt/InCharge/SAM/smarts/bin/sm_adapter
--name=SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output icoi-syslog/syslog_mgr.asl▲


Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service.exe install
--force
--name=ic-syslog-adapter
--description="EMC Smarts Syslog Adapter"
--startmode=runonce
C:\InCharge\SAM\smarts\bin\sm_adapter.exe
--name=SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output icoi-syslog/syslog_mgr.asl▲


SNMP Trap Adapter


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install
--force
--unmanaged
--name=ic-trapd-receiver
--startmode=runonce 
--description="EMC Smarts SNMP Trap Adapter"
/opt/InCharge/SAM/smarts/bin/sm_trapd
--name=TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--seed=seedfile
--model=sm_actions
--output
--rules=icoi-trapd/trap_mgr_parse.asl▲
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Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service.exe install
--force
--name=ic-trapd-receiver
--startmode=runonce 
--description="EMC Smarts SNMP Trap Adapter"
C:\InCharge\SAM\smarts\bin\sm_trapd.exe
--name=TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--seed=seedfile
--model=sm_actions
--output
--rules=icoi-trapd/trap_mgr_parse.asl▲


Notif trap Adapter


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install --force -unmanaged
--startmode=runonce
--name=ic-notif-trapd-receiver
--description="EMC Smarts NOTIF SNMP Trap Adapter"
/opt/InCharge/SAM/smarts/bin/sm_trapd
--name=NOTIF-TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--model=sm_actions
--rules=icoi-trapd/Notif-trap_mgr_parse.asl
--seed=seedfile
--output▲


Windows ▼ C:\InCharge\SAM\smarts\bin>sm_service install --force
--name=ic-notif-trapd-receiver
--description="EMC Smarts NOTIF SNMP Trap Adapter"
C:\InCharge\SAM\smarts\bin\sm_trapd.exe
--name=NOTIF-TRAP-INCHARGE-OI
--server=INCHARGE-OI
--config=icoi
--port=162
--model=sm_actions
--rules=icoi-trapd/Notif-trap_mgr_parse.asl
--seed=seedfile
--output▲


Notif syslog adapter


UNIX ▼ /opt/InCharge/SAM/smarts/bin/sm_service install --force --unmanaged 
--startmode=runonce
--name=ic-notif-syslog-adapter
--description="EMC Smarts Syslog Adapter"
/opt/InCharge/SAM/smarts/bin/sm_adapter
--name=NOTIF-SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output icoi-syslog/Notif-SysLog_mgr.asl▲
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Windows ▼ C:\InCharge\SAM\smarts\bin\sm_service install --force
--name=ic-notif-syslog-adapter
--description="EMC Smarts Syslog Adapter"
C:\InCharge\SAM\smarts\bin\sm_adapter.exe
--name=NOTIF-SYSLOG-INCHARGE-OI
--rserver=INCHARGE-OI
--tail=/var/log/syslog
--model=sm_system
--model=sm_actions
--output icoi-syslog/Notif-SysLog_mgr.asl▲


EMC Smarts Data Web Applications (Tomcat)


UNIX /opt/InCharge/SAM/smarts/bin/sm_service install --force  --unmanaged  
--startmode=runonce 
--name=smarts-tomcat 
--description=”EMC Smarts Data Web Applications (Tomcat)”
/opt/InCharge/SAM/smarts/bin/sm_tomcat 
--ignoreme


Windows C:\InCharge\SAM\smarts\bin\sm_service install --force  --unmanaged  
--startmode=runonce 
“--name=smarts-tomcat” 
“--description=EMC Smarts Data Web Applications (Tomcat)” 
C:\InCharge\SAM\smarts\bin\sm_tomcat 
“--ignoreme”


EMC Smarts Notification Exchange (Rabbit MQ)


UNIX /opt/InCharge/SAM/smarts/bin/sm_service install --force  
--unmanaged  --startmode=runonce
--name=smarts-rabbitmq
--description=”EMC Smarts Notification Exchange (Rabbit MQ)” 
/opt/InCharge/SAM/smarts/bin/sm_rabbitmq
--ignoreme


Windows C:\InCharge\SAM\smarts\bin\sm_service install --force  
--unmanaged  --startmode=runonce 
“--name=smarts-rabbitmq” 
“--description=EMC Smarts Notification Exchange (Rabbit MQ)”
C:\InCharge\SAM\smarts\bin\sm_rabbitmq 
“--ignoreme”


EMC Smarts Notification Cache (ElasticSearch)


UNIX /opt/InCharge/SAM/smarts/bin/sm_service install --force  
--unmanaged  --startmode=runonce 
--name=smarts-elasticsearch 
--description=”EMC Smarts Notification Cache (ElasticSearch)” 
/opt/InCharge/SAM/smarts/bin/sm_elasticsearch 
--ignoreme
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Windows C:\InCharge\SAM\smarts\bin\sm_service install --force  
--unmanaged  --startmode=runonce 
“--name=smarts-elasticsearch” 
“--description=EMC Smarts Notification Cache (ElasticSearch)” 
C:\InCharge\SAM/smarts\bin\sm_elasticsearch 
“--ignoreme”


Services for the MPLS Manager
This section provides the default UNIX and Windows commands that are used to install 
services manually for the MPLS Manager. Type the command on one line.


For the MPLS Manager, when you install the services manually, if you specify custom 
service and server names instead of the default names listed in Table 17 on page 99, you 
must run a script next. Running the script is required so that proper domain 
communication can be established. Appendix D, “Using the MPLS server_config Utility,” 
provides information about the script.


MPLS Topology Server


When you start the MPLS Manager for the first time (and only the first time) after migrating 
from the previous version to the new version, you must start the MPLS Topology Server 
with the --ignore-restore-errors option.


UNIX ▼ /opt/InCharge/MPLS/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-topology 
--description=”EMC Smarts MPLS Topology Server” 
/opt/InCharge/MPLS/smarts/bin/sm_server 
--name=INCHARGE-MPLS-TOPOLOGY 
--config=mpls-t 
--ignore-restore-errors 
--output▲


Windows ▼ C:\InCharge\MPLS\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-topology 
--description=”EMC Smarts MPLS Topology Server” 
C:\InCharge\MPLS\smarts\bin\sm_server.exe 
--name=INCHARGE-MPLS-TOPOLOGY 
--config=mpls-t 
--ignore-restore-errors 
--output▲
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MPLS Monitoring Server


UNIX ▼/opt/InCharge/MPLS/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-monitoring 
--description=”EMC Smarts MPLS Monitoring Server” 
/opt/InCharge/MPLS/smarts/bin/sm_server 
--name=INCHARGE-MPLS-MONITORING 
--config=mpls-m 
--ignore-restore-errors 
--output▲


Windows ▼ C:\InCharge\MPLS\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-monitoring 
--description=”EMC Smarts MPLS Monitoring Server” 
C:\InCharge\MPLS\smarts\bin\sm_server.exe 
--name=INCHARGE-MPLS-MONITORING 
--config=mpls-m 
--ignore-restore-errors 
--output▲


MPLS Analysis Server


UNIX ▼ /opt/InCharge/MPLS/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-analysis 
--description=”EMC Smarts MPLS Analysis Server” 
/opt/InCharge/MPLS/smarts/bin/sm_server 
--name=INCHARGE-MPLS-ANALYSIS 
--config=mpls-a 
--ignore-restore-errors 
--output▲


Windows ▼ C:\InCharge\MPLS\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-mpls-analysis 
--description=”EMC Smarts MPLS Analysis Server” 
C:\InCharge\MPLS\smarts\bin\sm_server.exe 
--name=INCHARGE-MPLS-ANALYSIS 
--config=mpls-a 
--ignore-restore-errors 
--output▲
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MPLS VPN-Tagging Server


UNIX ▼ /opt/InCharge/MPLS/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-vpn-tagging 
--description=”EMC Smarts MPLS VPN-Tagging Server” 
/opt/InCharge/MPLS/smarts/bin/sm_server 
--name=VPN-TAGGING 
--config=vpn-tagging 
--ignore-restore-errors 
--output▲


Windows ▼ C:\InCharge\MPLS\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-vpn-tagging 
--description=”EMC Smarts MPLS VPN-Tagging Server” 
C:\InCharge\MPLS\smarts\bin\sm_server.exe 
--name=VPN-TAGGING 
--config=vpn-tagging 
--ignore-restore-errors 
--output▲


Services for the Server Manager
This section provides the default UNIX and Windows commands that are used to install 
the service manually for the EMC Smarts Server Manager. Type the command on one line.


Server Manager


UNIX ▼ opt/InCharge/ESM/smarts/bin/sm_service install 
--force  
--unmanaged
--name=ic-esm-server 
--description=”EMC Smarts Server Manager (ESM)” 
--startmode=runonce 
opt/InCharge/ESM/smarts/bin/sm_server 
--name=INCHARGE-ESM 
--config=esm 
--subscribe=default 
--output 
--ignore-restore-errors▲


Windows ▼ C:\InCharge\ESM\smarts\bin\sm_service.exe install
--force
--unmanaged
--name=ic-esm-server
--description=”EMC Smarts Server Manager (ESM)”
--startmode=runonce
C:\InCharge\ESM\smarts\bin\sm_server.exe
--name=INCHARGE-ESM
--config=esm
--subscribe=default
--output 
--ignore-restore-errors▲
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Services for the Network Protocol Manager installation
This section provides the default UNIX and Windows commands that are used to install 
services manually for the Network Protocol Manager. Type the command on one line.


Network Protocol Manager for BGP


UNIX (IPv6 and IPv4 
mode)


/opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-bgp-server
--description=”EMC Smarts NPM for BGP Server” 
--startmode=runonce
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-BGP
--config=bgp
--port=0
--subscribe=default
--output


Windows (IPv6 and 
IPv4 mode)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-bgp-server
--description=”EMC Smarts NPM for BGP Server”
--startmode=runonce
C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-BGP
--config=bgp
--port=0
--subscribe=default
--output


UNIX (IPv4 mode only) /opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-bgp-server
--description=”EMC Smarts NPM for BGP Server”
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-BGP
--config=bgp
--port=0
--bootstrap=bootstrap-ipv4.conf
--subscribe=default
--output


Windows (IPv4 mode 
only)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-bgp-server
--description=”EMC Smarts NPM for BGP Server”
--startmode=runonce 
C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-BGP
--config=bgp
--bootstrap=bootstrap-ipv4.conf
--port=0
--subscribe=default
--output
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Network Protocol Manager for EIGRP


UNIX /opt/InCharge/NPM/smarts/bin/sm_service install 
--force 
--name=ic-npm-eigrp-server 
--description=”EMC Smarts NPM for EIGRP Server” 
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server 
--name=INCHARGE-EIGRP 
--config=eigrp 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


Windows C:\InCharge\NPM\smarts\bin\sm_service.exe install 
--force 
--name=ic-npm-eigrp-server 
--description=”EMC Smarts NPM for EIGRP Server” 
--startmode=runonce 
C:\InCharge\NPM\smarts\bin\sm_server.exe 
--name=INCHARGE-EIGRP 
--config=eigrp 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output


Network Protocol Manager for IS-IS


UNIX (IPv6 and IPv4 
mode)


/opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-isis-server
--description=”EMC Smarts NPM for ISIS Server”
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-ISIS
--config=isis
--port=0
--subscribe=default
--output


Windows (IPv6 and 
IPv4 mode)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-isis-server
--description=”EMC Smarts NPM for ISIS Server”
--startmode=runonce 
C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-ISIS
--config=isis
--port=0
--subscribe=default
--output
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UNIX (IPv4 mode only) /opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-isis-server
--description=”EMC Smarts NPM for ISIS Server”
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-ISIS
--config=isis
--port=0
--bootstrap=bootstrap-ipv4.conf
--subscribe=default
--output


Windows (IPv4 mode 
only)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-isis-server
--description=”EMC Smarts NPM for ISIS Server”
--startmode=runonce 
--C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-ISIS
--config=isis
--port=0
--bootstrap=bootstrap-ipv4.conf
--subscribe=default
--output


Network Protocol Manager for OSPF


UNIX (IPv6 and IPv4 
mode)


/opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-ospf-server
--description=”EMC Smarts NPM for OSPF Server”
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-OSPF
--config=ospf
--port=0
--subscribe=default
--output


Windows (IPv6 and 
IPv4 mode)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-OSPF-server
--description=”EMC Smarts NPM for OSPF Server”
--startmode=runonce 
C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-OSPF
--config=ospf
--port=0
--subscribe=default
--output
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UNIX (IPv4 mode only) /opt/InCharge/NPM/smarts/bin/sm_service install
--force
--name=ic-npm-OSPF-server
--description=”EMC Smarts NPM for OSPF Server”
--startmode=runonce 
/opt/InCharge/NPM/smarts/bin/sm_server
--name=INCHARGE-OSPF
--config=ospf
--port=0
--bootstrap=bootstrap-ipv4.conf
--subscribe=default
--output


Windows (IPv4 mode 
only)


C:\InCharge\NPM\smarts\bin\sm_service.exe install
--force
--name=ic-npm-OSPF-server
--description=”EMC Smarts NPM for OSPF Server”
--startmode=runonce 
C:\InCharge\NPM\smarts\bin\sm_server.exe
--name=INCHARGE-OSPF
--config=ospf
--port=0
--bootstrap=bootstrap-ipv4.conf
--subscribe=default
--output


Services for the Optical Transport Manager
This section provides the default UNIX and Windows commands that are used to install 
the services manually for the EMC Smarts Optical Transport Manager. Type the command 
on one line.


EMC Smarts Optical Transport Manager for Next Generation WDM


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-wdm-ng-server 
--description=”EMC Smarts Optical Transport Manager for Next 
Generation WDM” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-WDM-NG
--config=wdm-ng 
--subscribe=default 
--ignore-restore-errors
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-wdm-ng-server
--description=”EMC Smarts Optical Transport Manager for Next 
Generation WDM”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-WDM-NG
--config=wdm-ng
--subscribe=default
--ignore-restore-errors
--output 
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EMC Smarts Optical Transport Manager for SDH (Topology)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-sdh-topology-server 
--description=”EMC Smarts Optical Transport Manager for SDH 
Topology” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-SDH-TOPOLOGY
--config=osm-t 
--subscribe=default 
--ignore-restore-errors
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-sdh-topology-server
--description=”EMC Smarts Optical Transport Manager for SDH 
Topology”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-SDH-TOPOLOGY
--config=osm-t
--subscribe=default
--ignore-restore-errors
--output 


EMC Smarts Optical Transport Manager for SDH (Analysis)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-sdh-analysis-server 
--description=”EMC Smarts Optical Transport Manager for SDH 
Analysis” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-SDH-ANALYSIS
--config=osm-a 
--subscribe=default 
--norestore
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-sdh-analysis-server
--description=”EMC Smarts Optical Transport Manager for SDH 
Analysis”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-SDH-ANALYSIS
--config=osm-a
--subscribe=default
--norestore
--output 
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EMC Smarts Optical Transport Manager for PDH (Topology)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-pdh-topology-server 
--description=”EMC Smarts Optical Transport Manager for PDH 
Topology” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-PDH-TOPOLOGY
--config=pdh-t 
--subscribe=default 
--ignore-restore-errors
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-pdh-topology-server
--description=”EMC Smarts Optical Transport Manager for PDH 
Topology”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-PDH-TOPOLOGY
--config=pdh-t
--subscribe=default
--ignore-restore-errors
--output 


EMC Smarts Optical Transport Manager for PDH (Analysis)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-pdh-analysis-server 
--description=”EMC Smarts Optical Transport Manager for PDH 
Analysis” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-PDH-ANALYSIS
--config=pdh-a 
--subscribe=default 
--norestore
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-pdh-analysis-server
--description=”EMC Smarts Optical Transport Manager for PDH 
Analysis”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-PDH-ANALYSIS
--config=pdh-a
--subscribe=default
--norestore
--output 

Services for the Optical Transport Manager 145







Manually Installing Services

EMC Smarts Optical Transport Manager for WDM (Topology)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-wdm-topology-server 
--description=”EMC Smarts Optical Transport Manager for WDM 
Topology” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-WDM-TOPOLOGY
--config=wdm-t 
--subscribe=default 
--ignore-restore-errors
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-wdm-topology-server
--description=”EMC Smarts Optical Transport Manager for WDM 
Topology”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-WDM-TOPOLOGY
--config=wdm-t
--subscribe=default
--ignore-restore-errors
--output 


EMC Smarts Optical Transport Manager for WDM (Analysis)


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-wdm-analysis-server 
--description=”EMC Smarts Optical Transport Manager for WDM 
Analysis” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-WDM-ANALYSIS
--config=wdm-a 
--subscribe=default 
--norestore
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-wdm-analysis-server
--description=”EMC Smarts Optical Transport Manager for WDM 
Analysis”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-WDM-ANALYSIS
--config=wdm-a
--subscribe=default
--norestore
--output 
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EMC Smarts Optical Transport Manager for IP Cross Domain Analysis


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-xd-otm-ip-server 
--description=”EMC Smarts Optical Transport Manager - IP CrossDomain 
Analysis Server” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-WDM-TOPOLOGY
--config=icxd-ao 
--subscribe=default 
--ignore-restore-errors
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-xd-otm-ip-server 
--description=”EMC Smarts Optical Transport Manager - IP CrossDomain 
Analysis Server
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-WDM-TOPOLOGY
--config=icxd-ao 
--subscribe=default
--ignore-restore-errors
--output 


EMC Smarts TMF814 Cisco CTM Adapter for OTM


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-tmf814-cisco-ctm-adapter 
--description=”EMC Smarts TMF814 Cisco CTM Adapter for OTM” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-CISCO-ADAPTER
--config=tmf814Cisco 
--subscribe=default 
--norestore
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-tmf814-cisco-ctm-adapter 
--description=”EMC Smarts TMF814 Cisco CTM Adapter for OTM”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-CISCO-ADAPTER
--config=tmf814Cisco 
--subscribe=default
--norestore
--output 
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EMC Smarts TMF814 Ciena On-Center Adapter for OTM


UNIX opt/InCharge/OTM/smarts/bin/sm_service install 
--force  
--unmanaged
--startmode=runonce 
--name=ic-tmf814-ciena-onctr-adapter 
--description=”EMC Smarts TMF814 Ciena On-Center Adapter for OTM” 
opt/InCharge/OTM/smarts/bin/sm_server 
--name=OTM-CIENA-ADAPTER
--config=tmf814Ciena 
--subscribe=default 
--norestore
--output 


Windows C:\InCharge\OTM\smarts\bin\sm_service.exe install
--force
--unmanaged
--startmode=runonce
--name=ic-tmf814-ciena-onctr-adapter 
--description=”EMC Smarts TMF814 Ciena On-Center Adapter for OTM”
C:\InCharge\OTM\smarts\bin\sm_server.exe
--name=OTM-CIENA-ADAPTER
--config=tmf814Ciena 
--subscribe=default
--norestore
--output 


Services for the VoIP Availability Manager
This section provides the default UNIX and Windows commands that are used to install 
services manually for the VoIP Availability Manager. Type the command on one line.


VoIP Availability Manager


UNIX /opt/InCharge/VoIP/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-voip-server 
--description=”EMC Smarts VoIP Availability Manager” 
--env=SM_JAVA_ENABLED=YES 
/opt/InCharge/VoIP/smarts/bin/sm_server 
--name=VoIP-AM 
--config=voip 
--port=0 
--subscribe=default 
--ignore-restore-errors 
--output
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Windows C:\InCharge\VoIP\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-voip-server 
“--description=EMC Smarts VoIP Availability Manager” 
“--env=SM_JAVA_ENABLED=YES” 
C:\InCharge\VoIP\smarts\bin\sm_server.exe 
“--name=VoIP-AM”
“--config=voip” 
“--port=0” 
“--subscribe=default” 
“--ignore-restore-errors” 
“--output”


VoIP Notification Trap Adapter


UNIX /opt/InCharge/VoIP/smarts/bin/sm_service install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-voip-notification-trapd-receiver 
--description=”EMC VoIP Notification Trap Adapter” 
/opt/InCharge/VoIP/smarts/bin/sm_trapd 
--name=TRAP-INCHARGE-VOIP 
--server=INCHARGE-OI 
--config=voip 
--port=9002 
--model=sm_actions 
--rules=voip/voip_trap_mgr_parse.asl 
--output=TRAP-INCHARGE-VOIP


Windows C:\InCharge\VoIP\smarts\bin\sm_service.exe install 
--force 
--unmanaged 
--startmode=runonce 
--name=ic-voip-notification-trapd-receiver 
--description=”EMC VoIP Notification Trap Adapter” 
C:\InCharge\VoIP\smarts\bin\sm_trapd.exe 
--name=TRAP-INCHARGE-VOIP 
--server=INCHARGE-OI 
--config=voip 
--port=9002 
--model=sm_actions 
--rules=voip\voip_trap_mgr_parse.asl 
--output=TRAP-INCHARGE-VOIP
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APPENDIX C
Procedures for CD/DVD-ROMs


This appendix includes commands and examples for working with a CD/DVD-ROM to 
install or upgrade product software. It consists of the following topics:


◆ Mounting a CD/DVD-ROM on UNIX systems ...........................................................  152
◆ Loading a CD/DVD-ROM on Windows ....................................................................  153
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Mounting a CD/DVD-ROM on UNIX systems
Use the following procedure to find the instructions appropriate for your operating system:


1. Insert the CD/DVD-ROM into the optical drive.


2. If the CD/DVD-ROM is automatically mounted, continue to step 3 . Otherwise, select 
the appropriate mount command as shown in Table 21 on page 152. 


3. Change to the CD/DVD-ROM directory by typing the appropriate command from 
Table 22 on page 152. 


Table 21  Mounting the CD/DVD-ROM for UNIX operating systems 


Operating 
system Commands and examples


CentOS # mount -o ro -F hsfs <device> /mnt


Example:
# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /mnt


Linux # mount <device>


Example:
# mount /dev/cdrom /mnt/cdrom


where <device> is the mount point for the optical drive.


Table 22  Changing to the CD/DVD-ROM directory in UNIX operating systems 


Operating 
system Command


CentOS If Volume Manager (VM) is running:
# cd /cdrom/<os>/<product>_SUITE/suite


If VM is not running:
# cd /mnt/suite


Linux If Automount is running:
# cd /cdrom/<os>/<product>_SUITE/suite


If Automount is not running:
# cd /mnt/cdrom/suite


where: <os> is the operating system, for example, CentOS_64, linux_64, or winnt_64.
<product> is the product software, for example, IP or MPLS.
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Loading a CD/DVD-ROM on Windows
The installation program starts automatically on Windows systems when AutoPlay or 
AutoRun is enabled:


1. Insert the CD/DVD-ROM into the optical drive. If AutoPlay or AutoRun is enabled, the 
installation program starts automatically using the Wizard mode.


2. If the installation program does not start, use Windows Explorer to locate the top-level 
folder of the mounted CD/DVD-ROM.


3. Locate the \product directory on the CD/DVD-ROM and double-click the setup 
executable.


If you want to run CLI mode or Unattended mode on a Windows system, you need to 
disable the AutoPlay or AutoRun feature. To do so, press and hold the Shift key for 
approximately 10 seconds while inserting the CD/DVD-ROM into the optical drive.
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APPENDIX D
Using the MPLS server_config Utility


This appendix pertains to the MPLS Manager. It provides an overview of the split topology 
architecture, an overview of the server_config utility used to rename domain groups and 
domains, and instructions on how to run the script.


◆ Use the server_config.pl script to change domain names ......................................  156
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Use the server_config.pl script to change domain names


Purpose


When installed and unless the default domain name is changed during installation, MPLS 
Manager is configured with the default domain group name of INCHARGE-MPLS.


From this default domain group name, the three MPLS Manager server names are 
constructed by appending the function specific suffix to the default domain group name:   


◆ INCHARGE-MPLS-TOPOLOGY


◆ INCHARGE-MPLS-MONITORING


◆ INCHARGE-MPLS-ANALYSIS


TOPOLOGY, MONITORING, and ANALYSIS are always appended to the Domain Group name 
to generate the three MPLS Manager domain managers.


A script (server_config.pl) is provided to make it easier to define server names, to update 
names, and populate the domain names changes to the default configurations files. Once 
updated, these new domain names are used by the TOPOLOGY, MONITORING and 
ANALYSIS servers.


Run the script


After the different servers have been installed with the default domain manager's names, 
you can use the server_config script to customize the domain managers’ names. 


The MPLS Manager post installation script uses the sm_perl command from either the 
MPLS BASEDIR/smarts/bin directory or from the location where the server_config.pl post 
installation script is located. 


From the Perl /bin directory
Invoke the post installation script from the directory where the MPLS Manager post 
installation script is located.


sm_perl server_config.pl -o <OldGroupName> -n <NewGroupName> -b <BASEDIR>


From the MPLS installation directory
Invoke the post installation script from the directory where Perl is installed.


./sm_perl <BASEDIR>/smarts/script/mpls-tma/server_config.pl -o <OldGroupName> -n
<NewGroupName> -b <BASEDIR>


Invoke the command line script server_config.pl options from the BASEDIR/smarts/bin/ 
directory as follows:


◆ Install services with default name if they have not been installed previously (see 
Example ).


server_config.pl -i -o <OldGroupName> -n<NewGroupName> -b<BASEDIR>


◆ Rename services that have been installed previously (see Example ).
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server_config.pl -o <OldGroupName> -n<NewGroupName> -b<BASEDIR>


◆ Generate a list of services that have been installed previously (see Example ).


server_config.pl -s -b <BASEDIR>


◆ Display information on how to run the script with examples (see Example ).


server_config.pl -h


Example 1 server_config.pl -i -o “INCHARGE-MPLS” -n “HQ-MPLS” -b 
opt/InCharge/MPLS/smarts/


Example 2 server_config.pl -o “INCHARGE-MPLS” -n “HQ-MPLS” -b 
opt/InCharge/MPLS/smarts/


Example 3 server_config.pl -s -b opt/InCharge/MPLS/smarts/


Example 4 server_config.pl -h


Script options


Following are the required and optional command line script parameters: 


Avoid using the following special characters when entering text strings for 
<OldGroupName> and <NewGroupName>: $ / \ 


Table 23  server_config.pl script command line options (page 1 of 2)


Option Purpose


--install-service
or
-i


Indicates that the service needs to be installed. 
• This parameter must be used with the --old-group, --new-group, and 


--basedir parameters.
• If the services are not installed, they are installed.
• If services are already installed, they are uninstalled and reinstalled with 


the NewGroupName.


--old-group="<OldGroupName>" 
or
-o "<OldGroupName>" 


A required value that specifies the old group name to be changed. 
• You must include the OldGroupName variable string in double quotes.
• This parameter must be used with the --new-group and --basedir 


parameters.
• If services are running, will terminate without doing anything.


--new-group="<NewGroupName>" 
or 
-n "<NewGroupName>"


A required value that specifies the new group name.
• You must include the NewGroupName variable string in double quotes.
• This parameter must be used with the --old-group and --basedir 


parameters.
• If services are running, will terminate without doing anything.


--basedir=<BASEDIR> 
or 
-b <BASEDIR>


A required value which specifies the installation base directory. 
• This parameter must be used with the --old-group and --new-group 


parameters.
• If services are running, will terminate without doing anything.
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The order of the parameters is not important.


Always include the BASEDIR of the installed services in the command line. The only 
instances where you do not have to include it is when using the Help (-h) option.


Following are the steps that the script performs once invoked:


1. If the local directory BASEDIR/smarts/local/conf/mpls-tma does not already exist, it is 
created and a copy of the original mpls-tma.conf file from the 
BASEDIR/smarts/conf/mpls-tma directory is copied to it.


2. If a service corresponding to the <OldGroupName> is installed, the following process is 
initiated:


a. If the service is running and the user command line argument is not -s or --show, 
the script displays an error message and exits. You must stop the services before 
you can rename them.


b. If the service is not running and the Service Daemon is running, then the script 
uninstalls the service for the current <OldGroupName>, installs the service for the 
<NewGroupName>, then continues to step 4.


c. If the service is not running and the Service Daemon is not running, then the script 
displays a warning that there is potential for mismatch, uninstalls the service for 
the current <OldGroupName>, installs the service for the <NewGroupName>, then 
continues to step 4.


3. If a service corresponding to the <OldGroupName> is not installed, the following 
process is initiated:


a. If the installation option (--i or -install-service) is not specified, the scripts does not 
install the service.


b. If the installation option (--i or -install-service) is specified and if the Service 
Daemon is running, the script installs the service corresponding to the 
<NewGroupName>.


c. If the installation option (--i or -install-service) is specified and if the Service 
Daemon is not running, the script warns you that you must start it and exits without 
further action.


--show 
or 
-s


Indicates that you want to see the current group names, services and Domain 
Manager names. 
• With this option, no changes are made to either the service or the 


configuration file. 
• This parameter must be used with the --basedir parameter.


--help 
or 
-h


--help or -h shows command line parameters and examples.
This parameter is used alone.


Table 23  server_config.pl script command line options (page 2 of 2)


Option Purpose
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4. After step 2  or step 3  are performed, the script copies the previous local 
configuration file to a backup file named .<OldGroupName><.bak>


5. The script then replaces the <OldGroupName> with <NewGroupName> in 
BASEDIR/smarts/local/conf/mpls-tma/mpls-tma.conf and terminates.
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APPENDIX E
EMC Smart Optical Transport Manager 
Configuration


This appendix provides instructions on configuring EMC Smarts Optical Transport Manager 
to communicate with the Global Manager component of the EMC Smarts Service 
Assurance Manager.


This appendix consists of the following topics:


◆ Prerequisites.........................................................................................................  162
◆ Configuring Optical Transport Manager..................................................................  163
◆ Configuring the Service Assurance Manager ..........................................................  171
◆ Configuring the presentation layer Global Manager ...............................................  172
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Prerequisites


Optical Transport Manager


Before you configure Optical Transport Manager, one or more of the following Optical 
Transport Manager domain managers must be installed:


◆ Optical Transport Manager for SONET/SDH


◆ Optical Transport Manager for PDH


◆ Optical Transport Manager for WDM


◆ Optical Transport Manager for Next Generation WDM


Except for the OTM for Next Generation WDM, each of the above domain managers has a 
Topology/Monitoring server and an Analysis server. 


If you installed the Optical Transport Manager for WDM NG (Next Generation), you must 
install and configure EMC M&R, the SolutionPack for Optical Wavelength Services, and the 
SolutionPack for EMC Smarts. The Service Assurance Suite Documentation Index, 
available on the EMC Community Network (ECN), provides links to these documents.


Note: In each domain, except for the OTM for Next Generation WDM domain, both 
Topology server and Analysis server must be installed and configured. In addition, OTM-IP 
XD may be installed and configured.


Note: The Optical Transport Manager and adapters do not need to be installed on the 
same host. However, you must register each component with the same EMC Broker that 
the Global Manager which manages the component is registered with.


SAM servers used with OTM


When OTM is connected to an IP XD Manager (IP cross-domain manager), three SAM 
servers should be started:


1. Connect the first SAM server to the OTM domains only.


2. Connect the second SAM server to the IP domain servers only.


3. Connect the third SAM server to the SAM servers described in steps 1 and 2 
(connecting OTM domains and other analysis domains) and to the OTM-IP XD Manager 
server.


Global Manager


To configure and use the Global Manager with OTM, the following components must be 
installed on appropriate hosts in your network:


◆ Broker


◆ Global Console 


◆ Global Manager
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Configuring Optical Transport Manager


OTM settings


The various Optical Transport Manager Domain Manager servers, except for the Next 
Generation WDM Domain Manager, need to know the names of the other servers in order 
to communicate with each other for the following purposes:


◆ For importing topology from a Topology server to an Analysis server within a given 
domain. For example, from the SDH Topology server to the SDH Analysis server.


◆ For running post-processing in one domain after a topology change or update in 
another domain.


All OTM Domain Managers use this same file for configuration. The file is named 
otm-settings.conf and is found in the BASEDIR/smarts/conf directory.


To modify the otm-settings.conf file, use the sm_edit utility as described in Appendix A, 
“The sm_edit utility.”


The configurable parameters, by default, look like this:


wdmTopologyServerName="OTM-WDM-TOPOLOGY"
sdhTopologyServerName="OTM-SDH-TOPOLOGY"
pdhTopologyServerName="OTM-PDH-TOPOLOGY"
wdmAnalysisServerName="OTM-WDM-ANALYSIS"
sdhAnalysisServerName="OTM-SDH-ANALYSIS"
pdhAnalysisServerName="OTM-PDH-ANALYSIS"


Change the names of the servers as needed for your configuration. Comment out any 
servers you are not using by adding a pound sign (“#”) at the beginning of the line.


IMPORTANT


You must specify both Topology and Analysis servers of any Domain Manager.


Configuring EMC M&R for the OTM Next Generation WDM Manager


To configure EMC M&R for the OTM Next Generation WDM Manager, you need to specify 
the EMC M&R service location and EMC M&R login credentials. Perform these steps:


1. Specify the EMC M&R service location.


The OTM Next Generation WDM Manager fetches topology data from the EMC M&R 
time-series database, using the EMC M&R Web-service APIs. You need to configure the 
M&R host or hosts (in case of multiple databases) which run the Web Service Backend 
with the OTM Next Generation WDM Manager. 


a. Open the <BASEDIR>/smarts/mnr-adapter/MNR.conf file with the sm_edit utility:


bin/sm_edit conf/mnr-adapter/MNR.conf
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b. Locate the following section. Remove the comment characters (#) and make the 
required changes:


# <MnR_InstanceName> {
# HostName = <FQDN of the Host where the M&R server is running. 
Default is "localhost">
# Port = <The port on which the M&R frontend is running. Default 
is 58080>
# ListenerPort = <The port on which the M&R HTTP Listener is 
running. Default is 55442>
# Protocol = HTTP/HTTPS <Protocol for accessing the M&R server. 
Default is HTTP>
# }
#


For example: 


itops-tco-116.lss.emc.com {
HostName = itops-tco-116.lss.emc.com
}


c. If your deployment has multiple M&R hosts (in case of multiple databases) which 
run the Web Service Backend, copy the code section in Step b and modify it 
accordingly.


d. Save the file.


2. Supply the EMC M&R login credentials for the OTM Next Generation WDM Manager. 


a. Open the Service Assurance Manager Global Console attached to the OTM Next 
Generation WDM Manager (OTM-WDM-NG, for example).


b. In the Topology Browser Console, select Configure > Domain Manager 
Administration Console.


c. In the Domain Manager Administration Console, select Configure > Polling and 
Thresholds.


d. Select the Device Access tab.


e. Expand EMC M&R Access Configuration > EMC M&R Access > Settings and select 
MnR Access Setting.


f. Type the EMC M&R username (admin, for example) for the UserID field and the 
password for the Password field.


g. Click Apply to save the changes.


h. (Required) Reconfigure the OTM Next Generation WDM Manager.


Once you specify the EMC M&R login credentials, they persisted in the domain 
manager's repository in an encrypted format. Repeat this step only if the EMC M&R 
access credentials need to be changed.
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Configure the RabbitMQ service for the OTM Next Generation WDM Domain Manager


To configure the RabbitMQ service for OTM Next Generation WDM Manager, you need to 
set the SM_AMQP_LOCATION environment variable in the runcmd_env.sh file and ensure 
the RabbitMQ security credentials are correct in the clientConnect.conf file. Perform these 
steps:


1. Specify the RabbitMQ location.


The OTM Next Generation WDM Domain Manager receives events from EMC M&R 
though the RabbitMQ service. The default RabbitMQ service which is part of the 
EMC Smarts Service Assurance manager is used for this purpose. You need to set 
SM_AMQP_LOCATION environment variable in the OTM runcmd_env.sh file.


a. Go to the BASEDIR/smarts/bin directory and enter this command to open the 
runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b. Add the SM_AMQP_LOCATION environment variable with the RabbitMQ location:


SM_AMQP_URL=amqp://<host>:5672/


The default AMQP port is 5672. If a different port is in use for some reason, use 
that port for the SM_AMQP_URL environment variable.


c. Save and close the file.


2. Ensure the RabbitMQ credentials are correct.


The security credentials for the RabbitMQ server are read from the OTM 
clientConnect.conf file. 


• If the default username or password is not changed in the RabbitMQ, this step is 
not required. 


• If the RabbitMQ credentials are changed for some reason, specify the new 
credentials in the OTM clientConnect.conf file. 


To do so, perform:


a. Go to the BASEDIR/smarts/bin directory and enter this command to open the 
clientConnect.conf file:


sm_edit conf/clientConnect.conf


b. Add the following line in the clientConnect.conf file anywhere before the 
"*:*:admin:changeme" line at the end.


*:AMQP-C/*:<username>:<password>


OTM-Extensions


The OTM-Extensions module is installed as part of the SAM installation. It provides 
additional OTM functionality to an existing installation of the Service Assurance Manager.
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Configuration scenarios


There are multiple scenarios in which OTM can be configured with SAM. These are covered 
in the following sections:


◆ “Configuring OTM for a two-level hierarchical SAM” on page 166


◆ “Configuring OTM for a single SAM installation” on page 169


◆ “Configuring OTM for a three-level hierarchical SAM” on page 169 


Configuring OTM for a two-level hierarchical SAM
Two-level hierarchy could mean either of the following scenarios:


Figure 4  Two-level hierarchical SAM: Scenario A


MBIM SAM-PRES


IP, MPLS,… SAM-OTM


OTM
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Figure 5  Two-level hierarchical SAM: Scenario B


In Scenario B, the SAM-AGG configuration is the same as that for SAM-OTM in Scenario A 
since this is the SAM that is directly attached to the OTM servers. Therefore, the 
configuration procedure is the same for both scenarios.


To configure OTM for a two-level hierarchical SAM, perform the following steps:


1. Create a directory for SAM-PRES. For purposes of this procedure, the term top-sam is 
used.


a. cd {SAM BASEDIR}/smarts/local/conf


b. mkdir top-sam


2. A new parameter XDUpdateImpactList is introduced. By setting this parameter to 
TRUE, a synchronization between SAM-PRES and SAM-OTM (in case of Figure 1) or 
SAM-PRES to SAM-AGG (in case of Figure 2) and SAM-OTM occurs whenever an OTM 
notification status update is detected for processing. 


From the {SAM BASEDIR}/smarts/local/conf/ics folder, edit the dxa-sam.conf file.


Note: Modifying the dxa-sam.conf file is applicable in all instances where a top-level 
SAM installation communicates with an underlying SAM installation.


a. Open dxa-sam.conf


b. Add the following line to the end of the file:


XDUpdateImpactList TRUE


c. Save and close the file.


MBIM SAM PRESMBIM SAM-PRES


SAM-AGG


MPLSIP OTM
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3. Traverse to the top-sam directory.


a. cd {SAM BASEDIR}/smarts/local/conf/top-sam


4. Copy the contents of the {SAM BASEDIR}/smarts/conf/ics and {SAM 
BASEDIR}/smarts/local/conf/ics directories to the {SAM 
BASEDIR}/smarts/local/conf/top-sam directory.


a. cp -p {SAM BASEDIR}/smarts/conf/ics/*.* .


b. cp -p {SAM BASEDIR}/smarts/local/conf/ics/*.* .


5. In the top-sam directory, edit the dxa-sam.conf file. 


a. Open dxa-sam.conf using the sm_edit utility.


b. Add these lines to the bottom of the file after the "#Subscribe to a Notification List" 
comment section.


# NLName/n
sub     Default/n
#sub    ALL_NOTIFICATIONS/n
notification
attr UserDefined1
attr UserDefined2
attr UserDefined3
attr UserDefined4
attr UserDefined5
attr UserDefined6
attr UserDefined7
attr UserDefined8
attr UserDefined9
attr UserDefined10


6. In the top-sam directory, you must copy the following lines to the weights.conf file.


Note: This step is applicable for all top-level SAM installations.


a. Copy the following lines:


ClassWeight OpticalNetworkElement          0
ClassWeight TopologicalLink                0
NotificationClassWeight HighOrder_Circuit             1
NotificationClassWeight LowOrder_Circuit              1
NotificationClassWeight ClientCircuit                 1
NotificationClassCheck TopologicalLink
NotificationClassCheck DropSideTopologicalLink
NotificationClassCheck BBFiberLink
NotificationClassCheck BBTopologicalLink
NotificationClassCheck BBDropSideTopologicalLink
NotificationClassCheck Equipment
NotificationClassCheck Card
NotificationClassCheck EquipmentProtectionGroup
NotificationClassCheck FiberLink
NotificationClassCheck FiberBundle
NotificationClassCheck OpticalNetworkElement
NotificationClassCheck HighOrder_Trail
NotificationClassCheck LowOrder_Trail
NotificationClassCheck Transponder
NotificationClassCheck Amplifier
NotificationClassCheck PTP
NotificationClassCheck Conduit


b. Open the weights.conf file using the sm_edit utility.
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c. Paste the lines that you copied to the end of this file.


d. Save and close the file.


7. Restart the server for the new settings to take effect.


Note: This procedure is used as the baseline for other configuration scenarios in this 
appendix.


Configuring OTM for a single SAM installation


Figure 6  Single OTM and SAM installation


Note: The procedure for the standard two-level hierarchical SAM configuration, 
“Configuring OTM for a two-level hierarchical SAM” on page 166, is used as the baseline 
procedure for this configuration.


Perform step 6  from the standard two-level hierarchical SAM configuration to copy lines to 
the weights.conf file. Ignore the reference to the top-sam directory in this step.


Configuring OTM for a three-level hierarchical SAM 
Three-level hierarchical SAM includes SAM-presentation, SAM-AGG (aggregate), and 
SAM-OTM (SAM to which OTM servers directly attach). 


MBIM SAM-PRESMBIM


IP, MPLS,… OTM
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Figure 7  Three-level hierarchical SAM


In the three-level hierarchical configuration, SAM-Pres and SAM-AGG implementation 
could be:


◆ running out of the same installation (same SAM BASEDIR) or


◆ running out of separate installations (two separate SAM BASEDIRs).


Configuring SAM-Pres and SAM-AGG having same SAM BASEDIR


Note: The procedure for the standard two-level hierarchical SAM configuration, 
“Configuring OTM for a two-level hierarchical SAM” on page 166, is used as the baseline 
procedure for this configuration.


The following would be the differences from the standard two-level hierarchical SAM 
configuration and a three-level hierarchical SAM configuration using the same SAM 
{BASEDIR} to prepare the configuration.


Note: As in the two-level SAM hierarchical configuration, the SAM base installation will be 
considered to be the SAM-OTM area.


◆ Create and configure Presentation SAM by following the steps detailed in “Configuring 
OTM for a two-level hierarchical SAM” on page 166.


◆ Start the SAM-PRES (presentation level SAM) using the following command:


./sm_server -b <broker name & Port No> -n SAM-PRES -c top-sam 
--ignore-restore-errors --output --daemon


Where top-sam is the name of the configuration directory created for SAM-PRES.


MBIM SAM-PRES


SAM-AGG


IP MPLS SAM-OTMIP, MPLS,… SAM-OTM


OTM
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Configuring SAM-Pres and SAM-AGG having different SAM BASEDIRs


Note: The procedure for the standard two-level hierarchical SAM configuration, 
“Configuring OTM for a two-level hierarchical SAM” on page 166, is used as the baseline 
procedure for this configuration.


The following would be the differences between the standard two-level hierarchical SAM 
configuration and a three-level hierarchical SAM configuration using different SAM 
{BASEDIR}.


◆ The server to be used for SAM-OTM (1st level SAM) must have the configuration steps 
done that pertain to SAM-OTM from the two-level hierarchical configuration. See 
“Configuring OTM for a two-level hierarchical SAM” on page 166.


◆ The server to be used for SAM-AGG (2nd level SAM) must have the configuration steps 
done that pertain to top-sam directory level from the two-level hierarchical 
configuration. This configuration must be done in the BASEDIR area (/local/conf/ics) 
for this SAM installation. See “Configuring OTM for a two-level hierarchical SAM” on 
page 166.


◆ The server to be used for SAM-PRES (3rd level SAM) must have the configuration steps 
done that pertain to top-sam directory level from the two-level hierarchical 
configuration. This configuration would be done in the BASEDIR area (/local/conf/ics) 
for this SAM installation. See “Configuring OTM for a two-level hierarchical SAM” on 
page 166.


Note: When starting the three SAMs which could be located on different machines, care 
must be taken to use the same broker:port for all of them in the runcmd_env.sh files. For 
example "SM_BROKER_DEFAULT=machinename:6666", where machinename is the name 
of the machine, where the Broker and the OTM-SAM were started.


Configuring the Service Assurance Manager
Configure the Service Assurance Manager (Global Manager) to specify each Optical 
Transport Manager as its source: 


1. In the Global Console attached to the Global Manager, select Configure > Global 
Manager Administration Console to open the Global Manager Administration Console.


2. In the left panel, select ICS Configuration > IC Domain Configuration > Domains.


3. Select the domain name for your Optical Transport Manager to display its 
configuration window (right panel). Depending upon your deployment, the domain 
names may include:


• OTM-SDH-ANALYSIS


• OTM-SDH-TOPOLOGY


• OTM-PDH-ANALYSIS


• OTM-PDH-TOPOLOGY


• OTM-WDM-ANALYSIS
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• OTM-WDM-TOPOLOGY


• OTM-IP-XD


4. In the configuration window, ensure that the Enabled checkbox is selected.


If the Enabled checkbox is not selected:


a. Select the Enabled checkbox.


b. Click the Reconfigure button, then the Yes button.


c. In the Server Reconfiguration information dialog box, click Close.


For complete information about the Global Manager Administration Console and Service 
Assurance configuration tasks, consult the EMC Smarts Service Assurance Manager 
Configuration Guide.


Configuring the presentation layer Global Manager
If you are deploying Optical Transport Manager in a hierarchical configuration, you will 
need to configure the presentation layer Global Manager as described in this section. 


The hierarchical aggregation configuration shown in Figure 8 on page 173, uses multiple 
Global Managers at the aggregation layer to address the following configurations:


◆ More than 10 underlying domains: EMC Corporation recommends that each Global 
Manager at the aggregation layer supports a maximum of 10 EMC Smarts domains. 
The example in Figure 8 on page 173, therefore, could support 20 domains.


◆ Geographically separate groups of domains: Using a standard Global Manager 
configuration would force some domains to connect to a Global Manager over a 
high-latency link. Additional Global Managers at the aggregation layer would be 
located in the same geographical area as the domains.


To ensure that acknowledgements and ownership of notifications are properly 
propagated, Service Assurance clients should only connect to the Global Manager at the 
top-level, presentation layer.
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Figure 8  Hierarchical aggregation Domain Manager configuration


Hierarchical aggregation is one example of hierarchical configuration.


The presentation layer Global Manager, or any Global Manager that does not connect 
directly to a OTM Domain Manager, needs to be configured using the following procedure 
to avoid duplicate OTM processing in the top level.


Note: This configuration should only be made to the top-level Global Manager or 
Managers, not the Global Managers which are directly connected to OTM servers.


Refer “Configuring OTM for a two-level hierarchical SAM”  on page 166 for further 
instructions.
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APPENDIX F
Configuration Scanner tool Sample Output


This appendix provides sample output for the Configuration Scanner tool. It consists of the 
following topics:


◆ Files created by Configuration Scanner tool ...........................................................  176
◆ Sample outputs ....................................................................................................  176
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Files created by Configuration Scanner tool
The following files are created by the tool:


◆ sm_configscan_report-<time_stamp>.txt: This is the report file created by the 
Configuration Scanner tool. This file contains:


• List of files installed by the TTP, if any


• List of files introduced by the user


• Modifications made to the discovery.conf, tpmgr-param.conf and 
name-resolver.conf files


• List of file differences for each modified file


• List of modifications found in the server 


“Report when server is specified” on page 177 and “Report when server is not 
specified” on page 182 provides sample outputs.


◆ sm_configscan-<time_stamp>.tar: This tar file contains the following:


• A copy of the Configuration Scanner report file


• sm_configscanner.log


• A copy of runcmd_env.sh


• ConfigScanAdapter.log


• PnTallOutput.txt: lists all the settings found on the server


• A directory containing the DIFF files for each modified files


The output files for the configuration scanner tool is available under the
<BASEDIR>/smarts/local/logs/Final_sm_getinfo<timesatamp>.tar file. 


Sample outputs
This section provides sample outputs for the following:


◆ “Running Configuration Scanner tool with server name” on page 176


◆ “Report when server is specified” on page 177


◆ “Running Configuration Scanner tool without server name” on page 182


◆ “Report when server is not specified” on page 182


Running Configuration Scanner tool with server name


You can run the tool by specifying a running server in the command line. In this scenario, 
the tool scans for changes you have made in the values of both the polling and threshold 
settings and configuration files. A sample output is provided: 


C:\InCharge\IP\smarts\bin>sm_perl sm_getinfo -s INCHARGE-AMPM -k
Executing sm_configscan ...
===============================================================sm_moni


tor about to run!
Please enter the correct credentials in clientConnect.conf
Or be prepared to enter the credentials below:
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===============================================================Getting 
hardware Info...


Getting AMPM show-dm-process info...
MAIN-N-Closing this log file at August 28, 2012 4:02:24 AM EDT; 


continuing in
C:\InCharge\IP\smarts\local\logs\AMPM-show-dm-proc-28Aug2012-040223_en


_US_UTF-8.log
Getting AMPM stacktrace info...
Exiting eval via last at C:/InCharge/IP/smarts/bin//sm_monitor.pl line 


180.
Getting AMPM queues info...
Getting AMPM subscriptions info...
Getting AMPM threads info...
Getting AMPM flows info...
Getting AMPM clients info...
Getting netstat info...
Getting tasklist info...
Getting log file...
Getting rps files...
Getting Monitor...
Getting Accessor Ping...
Getting Accessor Poll...
Getting Problems...
Getting instrumentation for IP...
MAIN-N-Closing this log file at August 28, 2012 4:05:13 AM EDT; 


continuing in
C:\InCharge\IP\smarts\local\logs\AMPM-instrumentation-28Aug2012-040223


_en_US_UTF-8.log
Deleting files: 


C:\InCharge\IP\smarts\local\logs\smgetinfo_files\*smgetinfo-version
s.log*


Getting the Smarts server version ...
Getting the Executable versions ...
Getting the Local lib versions ...
Getting the lib versions ...
Getting the list of installed TTPs ...
No TTPs currently installed
No patches currently installed.
Archiving the files...
Writing to sm_getinfo28Aug2012-040132.tar.zip ...
... Done writing to Final_sm_getinfo28Aug2012-040132.tar.zip
Please send the file: 


C:\InCharge\IP\smarts\local\logs\Final_sm_getinfo28Aug2012-040132.t
ar.zip to EMC Support


Report when server is specified


The following is the sample of the report when the tool is run specifying a running server in 
the command line:


Version: IP.9.1.0.0
These files have been modified in the installation:
===================================================
C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf
C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf
C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Cisco.conf
C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Misc.conf
C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf
These files have been introduced in the installation: 
=====================================================
C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps
C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps.bak
Server Name: INCHARGE-AMPM
The following Polling and Threshold settings were modified in the 


installation: 
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============================================================
POLLING::Polling Groups::5620 SAM Managed Systems::Connectivity 


Polling - External Poller::InstrumentCards
  Current Value : TRUE
  Default Value : FALSE
POLLING::Polling Groups::ComputeFabric::Environment 


Polling::PollingInterval
  Current Value : 120
  Default Value : 240
POLLING::Polling Groups::ComputeFabric::Environment Polling::Retries
  Current Value : 4
  Default Value : 3
POLLING::Polling Groups::ComputeFabric::Connectivity 


Polling::PollingInterval
  Current Value : 30
  Default Value : 240
POLLING::Polling Groups::Routers::Environment Polling::PollingInterval
  Current Value : 30
  Default Value : 240
THRESHOLD::Interface Groups::1 Gb Ethernet::Ethernet Interface/Port 


Performance::BroadcastThreshold
  Current Value : 10
  Default Value : 15
The following changes were made to some special configuration files: 
============================================================
File: C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf
  Attribute Name : MetroEthernetEnabled
    Current Value  : TRUE
    Default Value  : FALSE
    Comment        : Modified
  Attribute Name : defaultTimeout
    Current Value  : 2000
    Default Value  : 1000
    Comment        : Modified
  Attribute Name : defaultRetries
    Current Value  : 8
    Default Value  : 5
    Comment        : Modified
  Attribute Name : defaultSNMPAutoRetries
    Current Value  : 4
    Default Value  : 3
    Comment        : Modified
  Attribute Name : DiscoveryAddrPref
    Current Value  : "IPV4FIRST_IPV6NEXT"
    Default Value  : "IPV6FIRST_IPV4NEXT"
    Comment        : Modified
  Attribute Name : numberProbeThreads
    Current Value  : 15
    Default Value  : 10
    Comment        : Modified
  Attribute Name : LicenseThresholdPercentage
    Current Value  : 40
    Default Value  : 90
    Comment        : Modified
File: C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf
  Attribute Name : NameFormat
    Current Value  : "TM_USESEEDNAME"
    Default Value  : "TM_USEAUTONAME"
    Comment        : Modified
  Attribute Name : TM_USEAGENTADDRESS
    Current Value  : 3
    Default Value  : 4
    Comment        : Modified
  Attribute Name : TM_USEPRIVATEIP
    Current Value  : 4
    Default Value  : 3
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    Comment        : Modified
File: C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf
  Attribute Name : maxOIDsPerPacketForASNMP
    Current Value  : 15
    Default Value  : 19
    Comment        : Modified
  Attribute Name : GetBulkPattern-.1.3.6.1.4.1.1872.1.15
    Current Value  : TRUE
    Default Value  : 
    Comment        : Newly added
  Attribute Name : GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15
    Current Value  : 1.5
    Default Value  : 
    Comment        : Newly added
  Attribute Name : GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15
    Current Value  : 2.5
    Default Value  : 
    Comment        : Newly added
  Attribute Name : IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4
    Current Value  : 
    Default Value  : 39|53|1
    Comment        : Removed
  Attribute Name : IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8
    Current Value  : 
    Default Value  : 37
    Comment        : Removed
The following are two way text differences:
===========================================
<--- C:/InCharge/IP/smarts/conf/discovery/discovery.conf --->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 54 to 54 >>>>>>>>>>>>>>
defaultRetries = 5 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 54 to 54 <<<<<<<<<<<<<<
defaultRetries = 8 
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 61 to 61 >>>>>>>>>>>>>>
defaultTimeout = 1000
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 61 to 61 <<<<<<<<<<<<<<
defaultTimeout = 2000
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 82 to 82 >>>>>>>>>>>>>>
defaultSNMPAutoRetries = 3 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 82 to 82 <<<<<<<<<<<<<<
defaultSNMPAutoRetries = 4 
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 97 to 97 >>>>>>>>>>>>>>
numberProbeThreads = 10
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 97 to 97 <<<<<<<<<<<<<<
numberProbeThreads = 15
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 280 to 280 >>>>>>>>>>>>>>
DiscoveryAddrPref =  "IPV6FIRST_IPV4NEXT"
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
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<<<<<<<<<<<<<< From line: 280 to 280 <<<<<<<<<<<<<<
DiscoveryAddrPref =  "IPV4FIRST_IPV6NEXT"
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 287 to 287 >>>>>>>>>>>>>>
MetroEthernetEnabled = FALSE
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 287 to 287 <<<<<<<<<<<<<<
MetroEthernetEnabled = TRUE
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 290 to 290 >>>>>>>>>>>>>>
LicenseThresholdPercentage = 90 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 290 to 290 <<<<<<<<<<<<<<
LicenseThresholdPercentage = 40 
<=============== End Difference ===============>
<----------------------------------------------->
<--- C:/InCharge/IP/smarts/conf/discovery/name-resolver.conf --->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 19 to 18 >>>>>>>>>>>>>>
#NameFormat = "TM_USESEEDNAME"
NameFormat = "TM_USEAUTONAME"
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 18 to 19 <<<<<<<<<<<<<<
NameFormat = "TM_USESEEDNAME"
#NameFormat = "TM_USEAUTONAME"
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 30 to 29 >>>>>>>>>>>>>>
AutoNameOrder 3 TM_USEPRIVATEIP
AutoNameOrder 4 TM_USEAGENTADDRESS
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 29 to 30 <<<<<<<<<<<<<<
AutoNameOrder 3 TM_USEAGENTADDRESS
AutoNameOrder 4 TM_USEPRIVATEIP
<=============== End Difference ===============>
<----------------------------------------------->
<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Cisco.conf ->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 12369 to 12370 >>>>>>>>>>>>>>
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 12370 to 12384 <<<<<<<<<<<<<<
.1.3.6.1.4.1.9.1.916 {
TYPE = Firewall
VENDOR = Cisco
MODEL = ciscoASA5580sc
CERTIFICATION = CERTIFIED
CONT = Cisco-Entity
HEALTH = Cisco-Entity
INSTRUMENTATION:
CPU/Memory = CiscoRouter:DeviceID
Interface-Fault = MIB2
Interface-Performance = MIB2
}
<=============== End Difference ===============>
<----------------------------------------------->
<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Misc.conf -->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 8816 to 8806 >>>>>>>>>>>>>>
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.1.3.6.1.4.1.10734.1.3.8 {
TYPE = Firewall
VENDOR = TippingPoint
MODEL = TippingPointIPS
CERTIFICATION = CERTIFIED
CONT = MIB2-IfStack
INSTRUMENTATION:
Interface-Fault = MIB2
Interface-Performance     = MIB2
}
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 8806 to 8816 <<<<<<<<<<<<<<
#.1.3.6.1.4.1.10734.1.3.8 {
# TYPE = Firewall
# VENDOR = TippingPoint
# MODEL = TippingPointIPS
# CERTIFICATION = CERTIFIED
# CONT = MIB2-IfStack
#
#INSTRUMENTATION:
# Interface-Fault = MIB2
# Interface-Performance = MIB2
#}
<=============== End Difference ===============>
<----------------------------------------------->
<--C:/InCharge/IP/smarts/conf/discovery/tpmgr-param.conf --->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 40 to 40 >>>>>>>>>>>>>>
IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 40 to 40 <<<<<<<<<<<<<<
#IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 125 to 125 >>>>>>>>>>>>>>
IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 125 to 125 <<<<<<<<<<<<<<
#IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 554 to 554 >>>>>>>>>>>>>>
#GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 554 to 554 <<<<<<<<<<<<<<
GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 565 to 565 >>>>>>>>>>>>>>
#GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 565 to 565 <<<<<<<<<<<<<<
GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 576 to 576 >>>>>>>>>>>>>>
#GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 576 to 576 <<<<<<<<<<<<<<
GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5
<=============== End Difference ===============>
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<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 582 to 582 >>>>>>>>>>>>>>
maxOIDsPerPacketForASNMP 19
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 582 to 582 <<<<<<<<<<<<<<
maxOIDsPerPacketForASNMP 15
<=============== End Difference ===============>
<----------------------------------------------->


Running Configuration Scanner tool without server name


You can run the tool without specifying a running server in the command line. In this 
scenario, the tool only scans for changes you made to the configuration files. A sample 
output is provided:


C:\InCharge\IP\smarts\bin>sm_perl sm_getinfo -k
Executing sm_configscan ...
Deleting files: 


C:\InCharge\IP\smarts\local\logs\smgetinfo_files\*smgetinfo-version
s.log*


Getting the Smarts server version ...
Getting the Executable versions ...
Getting the Local lib versions ...
Getting the lib versions ...
Getting the list of installed TTPs ...
No TTPs currently installed
No patches currently installed.
Archiving the files...
Writing to sm_getinfo28Aug2012-044639.tar.zip ...
... Done writing to Final_sm_getinfo28Aug2012-044639.tar.zip
Please send the file: 


C:\InCharge\IP\smarts\local\logs\Final_sm_getinfo28Aug2012-044639.t
ar.zip to EMC Support


Report when server is not specified


The following is the sample of the report when the tool is run without specifying a running 
server in the command line:


Version: IP.9.1.0.0
These files have been modified in the installation: 
===================================================
C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf
C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf
C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Cisco.conf
C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Misc.conf
C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf
These files have been introduced in the installation: 
=====================================================
C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps
C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps.bak
The following changes were made to some special configuration files: 
===============================================================
File: C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf
  Attribute Name : MetroEthernetEnabled
    Current Value  : TRUE
    Default Value  : FALSE
    Comment        : Modified
  Attribute Name : defaultTimeout
    Current Value  : 2000
    Default Value  : 1000
    Comment        : Modified
  Attribute Name : defaultRetries
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    Current Value  : 8
    Default Value  : 5
    Comment        : Modified
  Attribute Name : defaultSNMPAutoRetries
    Current Value  : 4
    Default Value  : 3
    Comment        : Modified
  Attribute Name : DiscoveryAddrPref
    Current Value  : "IPV4FIRST_IPV6NEXT"
    Default Value  : "IPV6FIRST_IPV4NEXT"
    Comment        : Modified
  Attribute Name : numberProbeThreads
    Current Value  : 15
    Default Value  : 10
    Comment        : Modified
  Attribute Name : LicenseThresholdPercentage
    Current Value  : 40
    Default Value  : 90
    Comment        : Modified
File: C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf
  Attribute Name : NameFormat
    Current Value  : "TM_USESEEDNAME"
    Default Value  : "TM_USEAUTONAME"
    Comment        : Modified
  Attribute Name : TM_USEAGENTADDRESS
    Current Value  : 3
    Default Value  : 4
    Comment        : Modified
  Attribute Name : TM_USEPRIVATEIP
    Current Value  : 4
    Default Value  : 3
    Comment        : Modified


File: C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf
  Attribute Name : maxOIDsPerPacketForASNMP
    Current Value  : 15
    Default Value  : 19
    Comment        : Modified
  Attribute Name : GetBulkPattern-.1.3.6.1.4.1.1872.1.15
    Current Value  : TRUE
    Default Value  : 
    Comment        : Newly added
  Attribute Name : GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15
    Current Value  : 1.5
    Default Value  : 
    Comment        : Newly added
  Attribute Name : GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15
    Current Value  : 2.5
    Default Value  : 
    Comment        : Newly added
  Attribute Name : IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4
    Current Value  : 
    Default Value  : 39|53|1
    Comment        : Removed
  Attribute Name : IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8
    Current Value  : 
    Default Value  : 37
    Comment        : Removed
The following are two way text differences:
===========================================
<--- C:/InCharge/IP/smarts/conf/discovery/discovery.conf --->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 54 to 54 >>>>>>>>>>>>>>
defaultRetries = 5 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
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<<<<<<<<<<<<<< From line: 54 to 54 <<<<<<<<<<<<<<
defaultRetries = 8 
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 61 to 61 >>>>>>>>>>>>>>
defaultTimeout = 1000
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 61 to 61 <<<<<<<<<<<<<<
defaultTimeout = 2000
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 82 to 82 >>>>>>>>>>>>>>
defaultSNMPAutoRetries = 3 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 82 to 82 <<<<<<<<<<<<<<
defaultSNMPAutoRetries = 4 
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 97 to 97 >>>>>>>>>>>>>>
numberProbeThreads = 10
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 97 to 97 <<<<<<<<<<<<<<
numberProbeThreads = 15
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 280 to 280 >>>>>>>>>>>>>>
DiscoveryAddrPref =  "IPV6FIRST_IPV4NEXT"
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 280 to 280 <<<<<<<<<<<<<<
DiscoveryAddrPref =  "IPV4FIRST_IPV6NEXT"
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 287 to 287 >>>>>>>>>>>>>>
MetroEthernetEnabled = FALSE
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 287 to 287 <<<<<<<<<<<<<<
MetroEthernetEnabled = TRUE
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 290 to 290 >>>>>>>>>>>>>>
LicenseThresholdPercentage = 90 
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 290 to 290 <<<<<<<<<<<<<<
LicenseThresholdPercentage = 40 
<=============== End Difference ===============>
<----------------------------------------------->
<--C:/InCharge/IP/smarts/conf/discovery/name-resolver.conf -->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 19 to 18 >>>>>>>>>>>>>>
#NameFormat = "TM_USESEEDNAME"
NameFormat = "TM_USEAUTONAME"
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 18 to 19 <<<<<<<<<<<<<<
NameFormat = "TM_USESEEDNAME"
#NameFormat = "TM_USEAUTONAME"
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 30 to 29 >>>>>>>>>>>>>>
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AutoNameOrder 3 TM_USEPRIVATEIP
AutoNameOrder 4 TM_USEAGENTADDRESS
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 29 to 30 <<<<<<<<<<<<<<
AutoNameOrder 3 TM_USEAGENTADDRESS
AutoNameOrder 4 TM_USEPRIVATEIP
<=============== End Difference ===============>
<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Cisco.conf-->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 12369 to 12370 >>>>>>>>>>>>>>
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 12370 to 12384 <<<<<<<<<<<<<<


.1.3.6.1.4.1.9.1.916 {
TYPE = Firewall
VENDOR = Cisco
MODEL = ciscoASA5580sc
CERTIFICATION = CERTIFIED
CONT = Cisco-Entity
HEALTH = Cisco-Entity


INSTRUMENTATION:
CPU/Memory = CiscoRouter:DeviceID
Interface-Fault = MIB2
Interface-Performance = MIB2
}
<=============== End Difference ===============>
<----------------------------------------------->
<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Misc.conf -->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 8816 to 8806 >>>>>>>>>>>>>>
.1.3.6.1.4.1.10734.1.3.8 {
TYPE = Firewall
VENDOR = TippingPoint
MODEL = TippingPointIPS
CERTIFICATION = CERTIFIED
CONT = MIB2-IfStack


INSTRUMENTATION:
Interface-Fault           = MIB2
Interface-Performance     = MIB2
}
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 8806 to 8816 <<<<<<<<<<<<<<
#.1.3.6.1.4.1.10734.1.3.8 {
# TYPE = Firewall
# VENDOR = TippingPoint
# MODEL = TippingPointIPS
# CERTIFICATION = CERTIFIED
# CONT = MIB2-IfStack
#
#INSTRUMENTATION:
# Interface-Fault           = MIB2
# Interface-Performance     = MIB2
#}
<=============== End Difference ===============>
<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/tpmgr-param.conf --->
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 40 to 40 >>>>>>>>>>>>>>
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IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 40 to 40 <<<<<<<<<<<<<<
#IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 125 to 125 >>>>>>>>>>>>>>
IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 125 to 125 <<<<<<<<<<<<<<
#IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 554 to 554 >>>>>>>>>>>>>>
#GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 554 to 554 <<<<<<<<<<<<<<
GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 565 to 565 >>>>>>>>>>>>>>
#GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 565 to 565 <<<<<<<<<<<<<<
GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 576 to 576 >>>>>>>>>>>>>>
#GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 576 to 576 <<<<<<<<<<<<<<
GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5
<=============== End Difference ===============>
<============== Start Difference ==============>
>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 
>>>>>>>>>>>>>> From line: 582 to 582 >>>>>>>>>>>>>>
maxOIDsPerPacketForASNMP 19
<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
<<<<<<<<<<<<<< From line: 582 to 582 <<<<<<<<<<<<<<
maxOIDsPerPacketForASNMP 15
<=============== End Difference ===============>
<----------------------------------------------->
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How to migrate archived events after updating the SolutionPack for 


EMC® Smarts®  
Last update 6/20/2014  


Introduction 


The SolutionPack for EMC Smarts consists of following components: 


 EMC Smarts Server Manager (ESM) - Collects Topology information and data for these reports 
in EMC M&R (Watch4net): Reports for Hypervisors, VirtualMachines, vCenters, Load Balancers, 
and so forth. 


 EMC Smarts Events - The Smarts-listener receives notifications from the EMC Service Assurance 
Manager (SAM) domain. Since notifications may come from other domain too, it is important to 
keep all server times in sync (EMC M&R, SAM and each underlying domain server). 


 EMC Smarts Health - EMC Smarts health collection is now part of the emc-smarts-collect 
package. It collects information for processors, memory and so forth. 


 EMC Smarts Performance - Reports the performance of the devices in IP AM-PM and other 
domains. 


 The SolutionPack for EMC Smarts is closely integrated with Service Assurance Manager version 
9.3 so that operators can manage Notifications from the underlying Smarts domains from within 
the EMC M&R (Watch4net) User Interface.   


Note: “EMC M&R” replaces the name, “Watch4net” in EMC products that use version 6.4 as their 
underlying monitoring and reporting platform. This change affects customers using Service Assurance 
Manager version 9.3 with EMC M&R version 6.4 and associated SolutionPacks. 


In the past, different databases were used in Watch4net for active and inactive (archived) events. When 
you upgrade older Watch4net releases to 6.4, you need to consider which database you want to use to 
show the event history in the reports. This article provides several use cases to choose from so you can 
configure your reports to show data from different sources. 


Watch4net 6.1 or earlier Choice of database: 
- Legacy datastore database holds both active and inactive (archived) 
event data 
- MySQL database holds active and inactive (archived) event data 


Watch4net 6.2 and higher MySQL database holds both active and inactive (archived) event data 


Watch4net 6.3 and higher Choice of database: 
- MySQL database holds active and inactive (archived) event data 
- Datastore database holds inactive (archived) event data. When 
Datastore is chosen, the MySQL database is still used but it holds only 
active event data. 
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The SolutionPack for EMC Smarts, version 2.0, is released as part of EMC M&R (Watch4net) version 6.4. 
There is an option in the Events screen of the SolutionPack for EMC Smarts that automates the 
migration of archived event data from the 6.3.x and 6.4 MySQL database to the Datastore database. You 
may choose to migrate the inactive (archived) data because it no longer shows up in your reports after 
you switch from MySQL to Datastore in the Database Type field of the Events Configuration window. 


To include data from earlier Watch4net releases in your 6.4 reports, you can point the reports to more 
than one database.  


Review the use cases and follow the procedures that apply to your deployment goals.  


Prerequisites 


 Back up the configuration files that will change before migrating or updating software. You may 
back up either from the GUI or with CLI commands. The Reference section at the end of this 
article provides more details. 


 If you are migrating from an older Watch4net release to 6.4, update core modules and 
SolutionPackBlocks in the correct order before migrating the archived event data. (A Launch-
Update script is available from the EMC Online Support website to help with the upgrade 
process for software versions 6.3.x and higher.) The EMC M&R (Watch4net) Version 6.4 
Installation and Configuration Guide provides additional information.  


 Obtain the hostnames or IP addresses of the servers where the databases and Default Tomcat 
servers are running. When you edit configuration files, replace the italic text shown in the 
examples with the actual host name or IP address. For example, replace mysql-db-host with the 
host name for the MySQL database. For Tomcat :: Default - hostname-or-IP, replace hostname-
or-IP with the Tomcat default server hostname or IP address. 


Use Case 1: Install SolutionPack for EMC Smarts 2.0 configured with MySQL 


database 
Installed Software: EMC M&R (Watch4ne)t version 6.4. SolutionPack for EMC Smarts is not installed. 


Goal: Install SolutionPack for EMC Smarts 2.0 and use only  as the Database Type (In this 


configuration, the MySQL database holds both the active and inactive (archived) events.) 


1. Install EMC M&R (Watch4net) Version 6.4. (The SolutionPack for EMC Smarts is available in 


Centralized Management > SolutionPack Center after you install or upgrade to version 6.4.) 


Install the SolutionPack for EMC Smarts. The SolutionPack for EMC Smarts Summary Sheet 


article and the How to Set Up SAM, EMC Smarts, and the SolutionPack for EMC Smarts article 


provide instructions. 


2. During installation, choose  as the Database Type in the Events section of the 


SolutionPack configuration window. (  is the default entry. With the new reuse 


configuration feature in 6.4, you may need to choose “Add a new Event database” option and 


then choose Database Type.) 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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3. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) 


>  Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  
 


a. Look for  and uncomment the 
Resource Links  


 


 


4.  Restart the Tomcat service to make the change effective. 


Use Case 2: Installation of SolutionPack for EMC Smarts 2.0 configured with 


Datastore database 
Installed Software: EMC M&R (Watch4net) version 6.4. The SolutionPack for EMC Smarts is not installed. 


Goal: Install the SolutionPack for EMC Smarts and configure it to use Datastore for inactive (archived) 


events. (In this configuration, the MySQL database continues to be used, but it holds only active events.) 


1. Install EMC M&R (Watch4net) Version 6.4. (The SolutionPack for EMC Smarts is available in 


Centralized Management > SolutionPack Center after you install or upgrade to version 6.4.) 


Install the SolutionPack for EMC Smarts. The SolutionPack for EMC Smarts Summary Sheet 


article and the How to Set Up SAM, EMC Smarts, and the SolutionPack for EMC Smarts article 


provide instructions. 


2. During installation choose  as the Database Type in the Events section of the 


SolutionPack configuration window. (With the new reuse configuration feature in 6.4, you may 


need to choose “Add a new Event database” option and then choose Database Type.) 


3. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) 


>  Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  
 


a. Look for 


 and uncomment that section: 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA





4 
 


4. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) > 
Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  


  


 Comment the Resource Links in this section:  
 so MySQL will not be used.


 Uncomment the Resource Links in this section:  


5. Restart the Tomcat service to make the change effective 


6. Start the Datastore service 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Start the APG-Datastore:Default 


service. 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


 (for Linux) or 


(for Windows). 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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7. Log in to the host running EMC M&R (Watch4net). 


8. To configure the Datastore database, connect to Datastore with this command: 


.  


9. From the prompt, copy and paste in the contents of 


. This will 


create the schema.  


10. The Event Processing Manager can now be loaded: 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Select Event-Processor-Manager::emc-


smarts and click the Start button to start the service. (Replace the instance name with 


one from your deployment if different from .) 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


(for Linux) or 


(for Windows). 


(Replace the instance name with one from your deployment if different from 


.) 


11. To verify that schema has loaded, type the following from the datastore-client command 


prompt: 


 


b. In the resulting output, you will see something similar to 1 row (for example, 


). 


Use Case 3: Show data from both MySQL and Datastore databases in reports 


Installed software: EMC M&R (Watch4net) version 6.4 and Smarts SolutionPack installed with  as 
the Database Type.  


Goal: Adjust the configuration so that reports show data from both MySQL and APG Datastore 
databases without migrating archived events that are currently saved in the MySQL Database.  Only 
newly archived events will be written to the APG Datastore.  Events that have been archived before APG 
Datastore was configured will remain in MySQL according to the retention policy. 


Steps 


1. Install EMC M&R (Watch4net) Version 6.4. (The SolutionPack for EMC Smarts is available in 
Centralized Management > SolutionPack Center after you install or upgrade to version 6.4.) 
Install the SolutionPack for EMC Smarts. The SolutionPack for EMC Smarts Summary Sheet 
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article and the How to Set Up SAM, EMC Smarts, and the SolutionPack for EMC Smarts article 
provide instructions. 


Note: If you are upgrading SolutionPack for EMC Smarts  at a version lower than 1.4, you must 
add the database block before you can proceed with Events block configuration. To add the 
block, go to Centralized Management > SolutionPackCenter and select the 2.0 version of the 
SolutionPack for EMC Smarts. Click the Install button. You will be prompted to install only the 
database block. Complete the install process and ensure the instance name matches the name 
used for the other blocks in the installed SolutionPack for EMC Smarts. 


2. During the Smarts SolutionPackBlock update process, ensure you select  as the 
Database Type in the Events configuration window. (With the new reuse configuration feature 
in 6.4, you may need to choose “Add a new Event database” option and then choose Database 
Type.) 


3. Post installation go to Centralized Management > Logical Overview > Miscellaneous > Web-


Servers (1) > Tomcat :: Default - hostname-or-IP, expand configuration files and edit 


conf/server.xml.   


a. Look for 


 and uncomment the resource link for that section. For 


example: 


b. Add the following entry to the file: (Add this entry just before the section entitled 


) 


 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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4. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) > 


Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  
  


a. Comment the Resource Links in this section:  


, so MySQL will not be used. 


b. Uncomment the Resource Links in this section:  
 


c. Copy-paste this entry: 


5. Restart the Tomcat service to make the change effective. 


6. Start the Datastore service. 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Start the APG-Datastore:Default 


service. 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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 (for Linux) or 


(for Windows). 


7. Log in to the host running EMC M&R (Watch4net). 


8. To configure the Datastore database, connect to Datastore with this command: 


.  


9. From the prompt, copy and paste in the contents of 


. This will 


create the schema.  


10. The Event Processing Manager can now be loaded: 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Select Event-Processor-Manager::emc-


smarts and click the Start button to start the service. (Replace the instance name with 


one from your deployment if different from .) 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


(for Linux) or 


(for Windows). 


(Replace the instance name with one from your deployment if different from 


.) 


11. To verify that schema has loaded, type the following from the datastore-client command 


prompt: 


 


b. In the resulting output, you will see something similar to 1 row (for example, 


). 


12. Ensure the SolutionPack for EMC Smarts reports include this filter: #RPE2:ALL. Use the Edit 
mode to add the filter if it is not available in the report.  (The Reference section provides a 
screen shot of RPE2:ALL.) 


13. View Smarts SolutionPack reports. Confirm the reports include notifications from the time 
before and after the Datastore Database Type was enabled. 


Note: Datastore holds inactive (archived) events. By default, there is a delay of one day after an 
event becomes inactive before it moves into the Datastore database. 
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Use Case 4: Migrate archived events from MySQL to Datastore so reports 


display archived event data from one source only 


Installed software: EMC M&R (Watch4net) version 6.4 and SolutionPack for EMC Smarts 1.4.2 or later 
installed with MySQL as the Database Type.  


Goal: Adjust the configuration in the SolutionPack for EMC Smarts Database Type field from  to 
. Migrate existing archived notifications to the Datastore database so that reports pull 


archived events from only one source. 


Steps 


1. From Centralized Management > SolutionPacks > Infrastructure, click the EMC Smarts 
SolutionPack. 


2. Click the Pencil icon by the Events SolutionPackBlock to edit the entries: 


a. In the Database Type field, choose . 
b. Click Reconfigure. 


3. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) > 


Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  
 


4. Look for 


 and uncomment that section: 


5. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) 
>  Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  


  


 Comment the Resource Links in this section:  
 so MySQL will not be used.


  



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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 Uncomment the Resource Links in this section:  


6. Restart the Tomcat service to make the change effective 


7. Start the Datastore service 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Start the APG-Datastore:Default 


service. 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


 (for Linux) or 


(for Windows). 


8. Log in to the host running EMC M&R (Watch4net). 


9. To configure the Datastore database, connect to Datastore with this command: 


.  


10. From the prompt, copy and paste in the contents of 


. This will 


create the schema.  
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11. The Event Processing Manager can now be loaded: 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Select Event-Processor-Manager::emc-


smarts and click the Start button to start the service. (Replace the instance name with 


one from your deployment if different from .) 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


(for Linux) or 


(for Windows). 


(Replace the instance name with one from your deployment if different from 


.) 


12. To verify that schema has loaded, type the following from the datastore-client command 


prompt: 


a.  


In the resulting output, you will see something similar to 1 row (for example, 
). 


13. Now you are ready to migrate the archived event data from MySQL to Datastore. From 
Centralized Management > SolutionPacks > Infrastructure, click the EMC Smarts SolutionPack. 


14. Click the Pencil icon by the Events SolutionPackBlock to edit the entries: 


a. Select the checkbox for Do you want to configure advanced setting  
b. Select checkbox for Enable archived events migration 
c. Click Reconfigure 


15. After one hour, verify the migration is complete by checking the MySQL events database. If the 
events_archive table row count is 0 in the MySQL events database, all of the archived events 
have migrated to the Datastore database. 


16. Using mysql-client, issue this command to verify migration is complete: 


Look for row count of zero:


17. Using datastore-client, run the below command and verify that the archived  events are added 
to datastore. Here is an example: 
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Note: Datastore holds inactive (archived) events. By default, there is a delay of one day after an 
event becomes inactive before it moves into the Datastore database. 


18. After all of the events have migrated, deselect the Migration enable checkbox to disable 
migration. 


Use Case 5: Install EMC M&R (Watch4net) 6.4 and display (6.1.x) archived 


event data in the 6.4 SolutionPack for EMC Smarts reports 


Installed software: Watch4net version 6.1.x. Customer installs EMC M&R (Watch4net) version 6.4. 


Goal: Point 6.4 SolutionPack for EMC Smarts reports to show data from two datastores (6.1.x Datastore 
and 6.4 Datastore) for archived event reporting. 


Steps 


1. Install EMC M&R (Watch4net) Version 6.4. (The SolutionPack for EMC Smarts is available in 
Centralized Management > SolutionPack Center after you install or upgrade to version 6.4.) 
Install the SolutionPack for EMC Smarts. The SolutionPack for EMC Smarts Summary Sheet 
article and the How to Set Up SAM, EMC Smarts, and the SolutionPack for EMC Smarts article 
provide instructions. 


2. During the Smarts SolutionPackBlock update process, ensure you select  as the 
Database Type in the Events configuration window. Refer to Use Case 2 for details. 


3. Post installation go to Centralized Management > Logical Overview > Miscellaneous > Web-
Servers (1) >  Tomcat :: Default - hostname-or-IP, expand configuration files and edit 
conf/server.xml.   


a. Look for 


 and uncomment the resource link for that section. 


b. Add the following entry to the file: (Add this entry just before the section entitled 


) 


 


Note: In the entry shown below, replace  with the hostname of the 6.1.x 


legacy datastore server 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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4. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) >  


Tomcat :: Default - hostname-or-IP, expand the Configuration files and edit:  
  


5. Restart the Tomcat service to make the change effective. 


6. Start the Datastore service 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Start the APG-Datastore:Default 


service. 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


 (for Linux) or 


(for Windows). 


7. Log in to the host running EMC M&R (Watch4net). 


8. To configure the Datastore database, connect to Datastore with this command: 


.  


9. From the prompt, copy and paste in the contents of 


. This will 


create the schema.  


 


 


10. The Event Processing Manager can now be loaded: 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA





14 
 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Select Event-Processor-Manager::emc-


smarts and click the Start button to start the service. (Replace the instance name with 


one from your deployment if different from .) 


b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


(for Linux) or 


(for Windows). 


(Replace the instance name with one from your deployment if different from 


.) 


11. To verify that schema has loaded, type the following from the datastore-client command 


prompt: 


 


b. In the resulting output, you will see something similar to 1 row (for example, 


). 


12. Ensure the SolutionPack for EMC Smarts reports include this filter: #RPE2:ALL. Use the Edit 
mode to add the filter if it is not available in the report. (The Reference section provides a 
screen shot of RPE2:ALL.) 


13. View the SolutionPack for EMC Smarts reports. Confirm the reports include archived events 
from the old and new databases. 


Note: Datastore holds inactive (archived) events. By default, there is a delay of one day after an 
event becomes inactive before it moves into the Datastore database. 


Use Case 6: Migrate from Watch4net 6.2.x to 6.4 and display (6.2.x) archived 


event data in the 6.4 SolutionPack for EMC Smarts reports 


Installed software: Watch4net 6.2.x with installed SolutionPack for EMC Smarts at a version lower than 
1.4. 


Goal: Migrate to EMC M&R (Watch4net) 6.4 and update to version 2.0 of SolutionPack for EMC Smarts. 
Configure reports one of two ways: 


 Option 1: Point the 6.4 SolutionPack for EMC Smarts reports to MySQL (for the 6.2 archived event 
history) and to Datastore (for 6.4 archived events) 


 Option 2: Migrate the archived event data from MySQL to Datastore. Ensure the 6.4 SolutionPack 
for EMC Smarts reports show archived event data only from Datastore. (See Use Case 4 to review 
the detailed steps.) 
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Steps 


1. Migrate core modules and SolutionPackBlocks from Watch4net 6.2.x to Watch4net 6.3.x and 
then upgrade to version 6.4. The Watch4Net 6.3 Installation and Configuration Guide provides 
instructions for migrating to 6.3.x. The EMC M&R (Watch4net) Version 6.4 Installation and 
Configuration Guide provides instructions on upgrading from 6.3.x to 6.4.  (The SolutionPack for 
EMC Smarts is available in Centralized Management > SolutionPack Center after you install or 
upgrade to version 6.4.) Install the SolutionPack for EMC Smarts. The SolutionPack for EMC 
Smarts Summary Sheet article and the How to Set Up SAM, EMC Smarts, and the SolutionPack 
for EMC Smarts article provide instructions 


Note: You must add a new database block to the SolutionPack for EMC Smarts before you can 
proceed. To add the block, go to Centralized Management > SolutionPackCenter and select the 
2.0 version of the SolutionPack for EMC Smarts. Click the Install button. You will be prompted to 
install only the database block. Complete the install process and ensure the instance name 
matches the name used for the other blocks in the installed SolutionPack for EMC Smarts. 


2. Update the SolutionPackBlocks associated with the SolutionPack for EMC Smarts. During the 
Smarts SolutionPackBlock update process, ensure you select  as the Database Type 
in the Events configuration window.  


3. Reconfigure each of the Smarts SolutionPackBlocks. 


Option 1: Point reports to both databases 


1. After completing the update and reconfigure process, go to Centralized Management > Logical 
Overview > Miscellaneous > Web-Servers (1) > Tomcat :: Default - hostname-or-IP, expand 
Configuration files and edit . 


a. Add a new data source to access old archived events from MySQL.  Here is the new 
entry to add to the file for the archived MySQL database: 


 Comment the Resource Links in this section,


so the 6.4.x version of MySQL will not be used.



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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c. Add or uncomment the Resource Links in this section:   


2. From Centralized Management > Logical Overview > Miscellaneous > Web-Servers (1) > 


Tomcat :: Default - hostname-or-IP, expand Configuration files and edit  


 


Add this section to .               


    


 


3. Ensure the Smarts SolutionPack reports include this filter: #RPE2:ALL. Use the Edit mode to add 
the filter if it is not available in the report.  (The Reference section provides a screen shot of 
RPE2:ALL.) 


4.  Restart the Tomcat service to make the change effective. 


5. Start the Datastore service. 


a. If starting from Centralized Management, navigate to Physical Overview and select the 


Backend server hosting the Datastore database. Start the APG-Datastore:Default 


service. 



http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA

http://itops-dev-149.lss.emc.com:58080/centralized-management/#/logical/misc/Web-Servers/-834606118?server=c2Y5YjZmZTk4&module=dG9tY2F0&instance=RGVmYXVsdA
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b. If using CLI commands, navigate to the installation  folder (for example, 


) and issue the 


 (for Linux) or 


(for Windows). 


6. Log in to the host running Watch4net 


7. To configure the Datastore database, connect to the Watch4net Datastore with this command: 


.  


8. From the prompt, copy and paste in the contents of 


. This will 


create the schema. The Event Processing Manager can now be loaded. 


9. To verify the schema has loaded, type the following from the datastore-client command 


prompt: 


 


b. In the resulting output, you will see something similar to 1 row (for example, 


). 


10. View Smarts SolutionPack reports. Confirm the reports include archived events from the time 
before and after the Datastore Database Type was enabled.  


Option 2: Migrate archived events from MySQL to APG Datastore database 


Use Case 4 provides the necessary steps. 


 


Reference  
This section provides  


 Suggestions for backing up configuration files before you start the event migration process. 


 Screen snap of the #RPE2ALL filter that has to be added to SolutionPack for EMC Smarts reports 
when migrating from older configurations to version 2.0. 


 Screen snap of Archived Events migration window  
 


Back up files from Centralized Management 


Select the configuration file(s) that will be edited in Centralized Management and download them as a 


zip file. Name the zip file after the instance name (Example: sm-collector-emc-smarts-files.zip). Move 


the zip file to a known folder (such as \tmp\backup). The file(s) in the zip have the content at that point 


of time and the saved content can be copied or pasted into the File Edition window and Saved.  
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Back up files from the command line interface (CLI) 


Use either standard *NIX/Linux/Windows utilities or run the diagnostic command (  or 


). This creates a zip containing ALL your configuration files. The zip file will be saved 
into a location like /tmp/DiagnosticFiles.tar.gz (the script prints that location on completion). 
 
Example of issuing the ./diagnostic.sh command to obtain the backup: 
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#RPE2:ALL 


Example of adding #RPE2:ALL filter to SolutionPack for EMC Smarts reports in Edit mode: 
 


 
 
 
 


  







22 
 


Example of Archived Events migration screen 


 


 


Troubleshooting and getting help 


EMC support, product, and licensing information can be obtained as follows: 


Product documentation and licenses 


Obtain product documentation including release notes and installation instructions for this product on 
EMC Online Support at: https://support.emc.com > Support by Product > Product Name > 
Documentation. For product licenses, navigate to support.emc.com > Service Center > Product 
Registration & Licenses. 


Updates to software and documentation 


The most recent updates to software and documentation are available only on EMC Online Support. Log 
into EMC Online Support (https://support.emc.com) today to retrieve the latest updates and 
documentation for your product prior to installation. 


Logging into EMC Online Support 


If you do not have an EMC Online Support account, set one up by going to: https://support.emc.com 
and clicking Register Now. Follow the online registration steps and ensure that you fill in all required 
fields, including your business email address. Once your registration is processed, you will receive an 
email confirming access and providing additional information regarding completion of your registration 
and initial log in. 
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Technical support 


For technical support, click Create Service Requests or Contact Customer Service on EMC Online Support 
at https://support.emc.com. To open a service request through EMC Online Support, you must have a 
valid support agreement. Contact your EMC Sales Representative for details about obtaining a valid 
support agreement or to answer any questions about your account. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Copyright © 2014 EMC Corporation. All Rights Reserved. 
Published: June, 2014 
EMC believes the information in this publication is accurate as of its publication date. The information is 
subject to change without notice. 
THE INFORMATION IN THIS PUBLICATION IS PROVIDED "AS IS." EMC CORPORATION MAKES NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND WITH RESPECT TO THE INFORMATION IN THIS 
PUBLICATION, AND SPECIFICALLY DISCLAIMS IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. 
Use, copying, and distribution of any EMC software described in this publication requires an applicable 
software license.  
For the most up-to-date listing of EMC product names, see EMC Corporation Trademarks on EMC.com 








License Administration 
Guide
FlexNet Publisher 2014 R1 (11.12.1)







Legal Information


Copyright Notice
Copyright © 2014 Flexera Software LLC. All Rights Reserved.


This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, 
if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by 
any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by 
Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software 
LLC intellectual property rights, whether by estoppel, implication, or otherwise.


All copies of the technology and related information, if allowed by Flexera Software LLC, must display this notice of copyright and ownership in 
full.


FlexNet Publisher incorporates software developed by others and redistributed according to license agreements. Copyright notices and licenses 
for these external libraries are provided in a supplementary document that accompanies this one.


Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see http://www.flexerasoftware.com/intellectual-property. All other 
brand and product names mentioned in Flexera Software products, product documentation, and marketing materials are the trademarks and 
registered trademarks of their respective owners.


Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other entity of the United 
States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the Software, or any related 
documentation of any kind, including technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in 
accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement 227.7202 
for military purposes. The Software was developed fully at private expense. All other use is prohibited.


Book Name: License Administration Guide


Part Number: FNP-11121-LAG01


Product Release Date: March 2014



http://www.flexerasoftware.com/company/intellectual-property.htm





Contents

Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11


1 Overview of Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13


License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14


Using a License Server With License Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15


2 Trusted Storage  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17


Overview of Trusted Storage  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17


Automated Delivery of Licenses to a License Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17


Using Licenses From Trusted Storage on a License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18


Trusted Storage Components on a License Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18


Using a License Server With Trusted Storage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19


Distribution of Node-Locked Licenses to Networked Machines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20


Single-Action vs Composite Transactions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22


Comparison of Trusted Storage and License Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23


License Files and Fulfillment Records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23


Locking of Licenses Using Hostid or Trusted Storage  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24


Licensing in Virtual Environments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25


Binding in a Virtual Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25


Best Practices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25


3 Reading a License File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27


License File Format Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27


License File Syntax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28


SERVER Lines. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28


VENDOR Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30


USE_SERVER Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

License Administration Guide FNP-11121-LAG00 3







Contents

FEATURE and INCREMENT Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31


Publisher-Defined Required Keywords  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .32


Optional Publisher-Defined Keywords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33


Optional Keywords Defined by the License Administrator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36


Character Limitations in Keyword Values. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36


Sort Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37


Changes in FEATURE and INCREMENT Line Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37


PACKAGE Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38


UPGRADE Lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40


Feature Lines in Decimal Format  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .41


Order of Lines in the License File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .41


4 Locating Licenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43


Determining the Location of the License File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43


Setting the License Search Path Using an Environment Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .44


Order of Searching for a License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45


5 Managing License Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47


Modifying License Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47


Configuring the Port Used by the License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48


6 Hostids for Supported Platforms  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49


Hostid Formats. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49


Obtaining System Hostids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49


Special Hostids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .56


Ethernet Hostids  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .57


Hostids to Support Virtualization Policy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58


Hostids to Support Cloud Licensing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58


7 License Models. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59


Floating (Concurrent) Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .59


Node-Locked Licenses Using Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60


Mixed Node-Locked and Floating Licenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60


Counted vs. Uncounted Licenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61


Mobile Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .61


Node-Locked to a Laptop Computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62


Node-locked to a FlexNet ID Dongle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62


Node-Locked to a FlexNet ID Dongle with FLOAT_OK . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62


Using a FlexNet ID Dongle for Mobile Licensing Using a FLOAT_OK License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62


FLEXID with FLOAT_OK Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .63


License Borrowing with BORROW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64

4 FNP-11121-LAG00 License Administration Guide







Contents

Initiating License Borrowing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64


Application Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64


Running the lmborrow Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65


Setting the LM_BORROW Environment Variable Directly  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65


Borrowing a License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66


Clearing the Borrow Period  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66


Checking Borrow Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66


Returning a Borrowed License Early  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67


Support for License Borrowing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67


Node-locked to a User Name. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .67


Fulfilled from a Prepaid License Pool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68


8 Selecting a License Server Machine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69


License Server Sockets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69


License Server CPU Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70


License Server Disk Space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70


License Server Memory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70


Network Bandwidth for License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70


License Server Locally Mounted Disks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71


License Server Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71


Running the License Server on a Virtual Machine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72


Running the License Server in a Cloud . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72


9 lmadmin License Server Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73


Downloading and Installing lmadmin License Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .74


System Requirements for lmadmin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .74


Additional Installation Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .75


Using the License Server Installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .75


License Server Directory Structure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78


Upgrading lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78


Using lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80


Manually Starting the License Server Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80


Manually Stopping the License Server Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81


Accessing the License Server Management Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81


Viewing the lmadmin Log Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .82


Managing lmadmin from the Command Line. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83


Adding a Vendor Daemon to lmadmin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83


Configuring the License File Upload Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .84


Installing lmadmin License Server Manager as an Operating System Service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85


Running FlexNet Publisher License Server as a System Service With Non-Elevated Privileges  . . . . . . . . . . . . . . . . . . .87


lmadmin Command-line Arguments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .89


Extending lmadmin License Server Capability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100

License Administration Guide FNP-11121-LAG00 5







Contents

Using the lmadmin Web Service Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100


Creating an lmadmin Alerter Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100


10 lmgrd - License Server Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103


lmgrd Command-Line Syntax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103


Starting the License Server Manager on UNIX Platforms. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105


Manual Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105


Automatic Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .106


Starting the License Server Manager on Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107


Manual Start from the Command Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107


Configuring the License Server Manager as a Windows Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107


Configuring the License Server Manager Service for a Delayed Start  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .108


Manually Start the License Server Using the lmtools Utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .109


Automatically Start the License Server when System Starts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111


11 Migrating from lmgrd to lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113


A Fundamental Mode Change. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .113


Command Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .114


lmadmin License Administration Functions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .115


12 Using License Administration Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117


Command-Line Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .117


Common Arguments for lmutil . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .119


lmborrow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .119


Initiating Borrowing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .120


Clearing the Borrowed License Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .121


Purging Expired Licenses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .121


Determining Borrowed-License Status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .121


Returning a Borrowed License Early  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .122


lmdiag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123


lmdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .124


lmhostid  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125


lminstall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .128


lmnewlog. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .129


lmpath . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .130


lmremove (in License-File-Based Licensing) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .131


lmremove (in Trusted-Storage-Based Licensing)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .132


lmreread . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .136


lmstat. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .137


lmswitch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .140


lmswitchr. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .140


lmver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .141


lmtools (Windows only). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .142

6 FNP-11121-LAG00 License Administration Guide







Contents

13 Managing the Options File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145


Creating an Options File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .146


Options File Syntax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .147


AUTOMATIC_REREAD . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .150


ACTIVATION_LOWWATER. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .150


ACTIVATION_ EXPIRY_DAYS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .151


BORROW_LOWWATER . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152


DAEMON_SELECT_TIMEOUT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152


DEBUGLOG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .153


EXCLUDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .153


EXCLUDE_BORROW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .154


EXCLUDE_ENTITLEMENT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .154


EXCLUDEALL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .156


FQDN_MATCHING . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .156


GROUP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .158


GROUPCASEINSENSITIVE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .158


HOST_GROUP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .159


INCLUDE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .159


INCLUDE_BORROW. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .160


INCLUDE_ENTITLEMENT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161


INCLUDEALL  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161


LINGER . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .162


MAX. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .163


MAX_BORROW_HOURS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .164


MAX_OVERDRAFT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .165


NOLOG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .165


REPORTLOG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .166


Reporting on Projects with LM_PROJECT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .166


RESERVE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .166


TIMEOUT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .167


TIMEOUTALL  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .168


How the Vendor Daemon Uses the Options File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .168


Rules of Precedence in Options Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .169


Options File Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .169


Simple Options File Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .169


Limiting Access for Multiple Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171


EXCLUDE Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171


EXCLUDE_ENTITLEMENT Example  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .172


INCLUDE Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .172


INCLUDE_ENTITLEMENT Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .172


14 Ensuring License Availability  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175


Redundancy Using the License Search Path. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .175

License Administration Guide FNP-11121-LAG00 7







Contents

Limitations of Redundancy Using the License Search Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .176


Overview of Three-Server Redundancy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .177


Configuring License Servers for Three-Server Redundancy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .179


Managing License Servers in a Three-Server Redundant Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .180


Using Other Capabilities with Three-Server Redundancy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .181


Troubleshooting Tips and Limitations for Three-Server Redundancy. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .183


15 Managing Virtualized License Servers for File-Based Licensing . . . . . . . . . . . . . . . . . .  185
Binding Solutions in a Virtual Environment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .185


Binding Agent lmbind . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .185


Setting Up a Virtual License Server on VMware ESX  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .186


Using the UUID Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .186


Using a Bare-Metal Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .187


Note About Binding in This Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .187


Binding With the LMB_ETHER hostid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .187


Setting Up a Virtual License Server on Microsoft Hyper-V. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .188


Using the UUID Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .188


Using a Bare-Metal Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .189


Note About Binding in This Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .189


Binding With the LMB_ETHER hostid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .189


Setting Up a Virtual License Server on VMware ESXi or XenServer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .191


Using the UUID Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .191


Using a Bare-Metal Hostid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .191


Note About Binding in This Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .192


Binding With the LMB_ETHER hostid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .192


Installing lmbind on the Hypervisor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193


Installing lmbind for VMware ESX (with Linux Console OS) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193


Installing lmbind for Microsoft Hyper-V  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193


lmbind Command Line Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .194


Additional Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .195


Virtualization Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .195


16 Licensing in a Cloud-Computing Environment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  201


Licensing Challenges in a Cloud Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .201


Scope of Support for Cloud Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .202


Use Cases for Licensing Software in the Cloud . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .202


Case 1: Traditional Served and Unserved Licensing in a Public Cloud  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .203


Binding Elements Required for Case 1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .203


License Administrator Tasks for Case 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .203


Case 2: Virtual Appliance Licensing in a Public Cloud  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .204


Basic VA Licensing Scenario  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .204


Binding Element Required for Case 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .204

8 FNP-11121-LAG00 License Administration Guide







Contents

License Administrator Tasks for Case 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .205


Case 3: Traditional Served and Unserved Licensing in a Virtual Private Cloud . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .205


Basic VPC Licensing Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .205


Binding Elements Required for Case 3  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .206


License Administrator Tasks for Case 3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .206


Hostids for Binding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .207


Supported Hostid Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .207


Retrieving and Specifying Hostids . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .209


17 IPv6 Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  211


Capabilities that Support IPv6  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .211


Deploying License Servers in Mixed Protocol Environments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .212


Using Wildcards in an IPv6 Address  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .214


18 Managing Licenses from Multiple Software Publishers . . . . . . . . . . . . . . . . . . . . . . . . .  215


Overview of Multiple License Management Strategies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .215


Multiple Systems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .216


Starting the License Servers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .217


Using lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .217


Using lmgrd. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .218


One System with Multiple License Server Instances . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .219


Starting the License Servers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .220


Using lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .220


Using lmgrd. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .221


One System with One License Server and Multiple License Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222


Starting the License Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .223


Using lmadmin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .223


Using lmgrd. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .224


Managing Multiple License Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .224


Managing Multiple File in lmadmin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .225


Managing Multiple Files in lmgrd . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .225


Defining the License File List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .225


Additional Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .226


Combining License Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .226


Starting the License Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .227


Criteria for Combining License Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .227


How to Combine License Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .228


Version Component Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .228


19 Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  229


General Troubleshooting Hints. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .229


FLEXLM_DIAGNOSTICS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .230

License Administration Guide FNP-11121-LAG00 9







Contents

Level 1 Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .230


Level 2 Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .230


Level 3 Content (Version 6.0 or Later Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .231


20 Error Codes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  233


Error Message Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233


Format 1 (short)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .234


Format 2 (long) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .234


Error Code Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .234


21 Report Log File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  245


Managing Report Log Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .245


Enabling Report Log Output for a Vendor Daemon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246


Redirecting Report Log Output for a Vendor Daemon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246


22 Debug Log File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247


Managing Debug Log Output  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .247


Capturing Debug Log Output for a License Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .247


Capturing Debug Log Output for a Particular Vendor Daemon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .248


Redirecting Debug Log Output for a Running Vendor Daemon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .248


Limiting Debug Log Output for a Vendor Daemon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .248


License Server Diagnostics in the Debug Log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .248


Debug Log Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249


Informational Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .249


Configuration Problem Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .251


Daemon Software Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .252


23 Identifying FlexNet Publisher Versions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  255


Version Compatibility Between Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .255


Determining the License File Version  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .256


Version Summary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .256


24 Environment Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  265


How to Set Environment Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .265


Windows Registry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .265


Precedence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .265


Environment Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .266


Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  269

10 FNP-11121-LAG00 License Administration Guide







Introduction 

This document describes FlexNet Publisher licensing for license administrators. It describes how to setup and 
administer FlexNet Publisher licensing for license models that require a license server.:


Table 1 • License Administration Guide Chapter Overview


Section Content


This section An overview of the contents of this document.


Overview of Licensing Overview of licensing and specifically licensing using license files.


Trusted Storage An overview of licensing using license rights held in trusted 
storage.


Reading a License File A description of the elements in a license file.


Locating Licenses How to locate licenses so that they are available to FlexEnabled 
applications.


Managing License Files Modifying license files.


Hostids for Supported Platforms Details of hostids available by platform and information about 
choosing an Ethernet address as hostid.


License Models Overview of basic license models and methods of licensing for 
laptops that may be provided by your software publisher.


Selecting a License Server Machine What to consider when selecting the machine on which to install 
the license server software.


lmadmin License Server Manager Description of how to install and use lmadmin as your license 
server.
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Migrating from lmgrd to lmadmin A comparison of lmgrd and lmadmin.


lmgrd - License Server Manager How to use lmgrd as your license server.


Using License Administration Tools How to use license administration tools to manage licenses and 
license servers.


Managing the Options File Using the options file to control license utilization and the license 
server.


Ensuring License Availability Methods of providing failover protection for license servers.


Managing Virtualized License Servers 
for File-Based Licensing


Virtualization of a license server.


Licensing in a Cloud-Computing 
Environment


Setup of licensing model in an Amazon EC2 environment.


IPv6 Support Installing and configuring license servers in IPv6 and mixed IPv4 
and IPv6 environments.


Managing Licenses from Multiple 
Software Publishers


Strategies for managing licenses from multiple software 
publishers.


Troubleshooting Tips and information about generating additional diagnostic data.


Error Codes A list of FlexNet Publisher error codes.


Report Log File Enabling and managing report log output.


Debug Log File Enabling and managing debug log output.


Environment Variables Environmental variables that may be used with FlexNet Publisher.


Identifying FlexNet Publisher Versions Version compatibility between components and brief details of 
functional changes for each major version of FlexNet Publisher.


Table 1 • License Administration Guide Chapter Overview


Section Content
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Overview of Licensing

FlexNet Publisher is a method of providing software licensing that has two basic components:


• FlexEnabled application - the software application that requires a license.


• A license - contains the license rights that define how the software application can be used.


Typically the license defines:


• What software functionality can be used. Functions provided by the software can be separately licensed. The 
licensed functions are referred to as features. When multiple features are defined, different versions of the 
product can be licensed by including different feature sets. For example, the license for the ‘demo’ version of 
the product could include the feature ‘trial’, the ‘standard’ version of the product the features ‘trial’ and ‘basic’ 
and the ‘professional’ version ‘trial’, ‘basic’ and ‘extend’ features.


• What versions of the software can be used.


• How many copies of the software can be running.


• The systems on which the software can be used.


• The period during which the software can be used.


These and other items in the license define how the software can be used and collectively are referred to as a 
license model.


The license can be stored:


• In a license file - a text file, file_name.lic, whose contents are protected by signatures that are authenticated 
by the FlexNet Publisher licensing components.


• In trusted storage - a secure location whose contents are encrypted. Licenses are stored as fulfillment 
records. Fulfillment records in trusted storage can be read only by FlexNet Publisher licensing components.


The FlexEnabled application can obtain a license directly, either from a license file or from local trusted storage on 
the same machine. Some license models, described as served, provide licenses that are held centrally by a license 
server and used by FlexEnabled applications connected to the license server across a TCP/IP network. 
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License Server

This document describes how to install and use a license server to provide licenses for FlexEnabled products that 
use served license models. The basic license model that requires a license server is referred to by several names 
depending on the context:


• Concurrent


• Floating


Concurrent licenses allow a fixed number of concurrent users to use licensed features at any one time. The license 
server controls the use of these licenses, which are not normally locked to a specific machine, and float on the 
network. FlexNet Publisher provides for many variations of this basic license model, for example the use of a set of 
concurrent licenses can be restricted to a group of users.


License Server
The basic components of a FlexNet Publisher license server are as illustrated in the following diagram:


• License server manager - lmadmin (or lmgrd) supplied by your software supplier or available from Flexera 
Software.


• License file - Created by your software supplier. In this document the supplier of a FlexEnabled application is 
referred to as the publisher.


• Vendor daemon - Created by the publisher. Each publisher has their own vendor daemon. If you have 
FlexEnabled applications from several publishers, you will need to install multiple vendor daemons.


• Debug log - Written by the license server manager.


Figure 1-1: FlexNet Publisher license server
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The following components may be present on a license server:


• Options file - optional file that you create. Use it to limit license usage; for example, to allocate particular 
licenses to a user or group of users.


• Report log - optional file that can be used by FlexNet Manager, Flexera Software’s license management 
product. You enable report logging using the options file.


• Trusted storage - some publishers use trusted storage to store licenses. When trusted storage is used, the 
publisher provides additional components (not shown on Figure 1-1) that create trusted storage and add 
licenses to it. See Trusted Storage for an overview.


Using a License Server With License Files
The following gives an outline of the steps in installing a license server and using it to serve licenses from license 
files. For further information about each of these steps, read the relevant sections of this document. 


1. Choose the machine(s) on which the license server(s) will be installed.


• Determine the number of licenses and machines on which FlexEnabled applications will be installed. See 
Selecting a License Server Machine for further information.


• Consider what method, if any, you want to use to ensure that, whenever possible, licenses are available to 
your end users. See Ensuring License Availability for further information.


2. Install the license server components.


The publisher will supply a copy of their vendor daemon and instructions for installing it. Additionally, either the 
publisher provides the license server manager (lmadmin or lmgrd), or you can download a copy from the 
Flexera Software website. It is recommended that you install the latest version of the license server manager.


3. Obtain details of the license server machine(s) and send them to the publisher.


Normally publishers supply concurrent licenses that are locked to a specific license server. When licenses are 
held in license files, they are locked to the license server using an identity obtained from the machine. This 
identity is called a hostid and is platform-specific. There are several different hostids available for each 
platform. The publisher will provide instructions on what hostid they are using for your licenses and platforms. 
They may supply an application that you can run to obtain the hostid or ask you to use the FlexNet Publisher 
utility, lmhostid, which you can download from the Flexera Software website. If you are using lmadmin, it 
displays the standard hostids for the machine on which it is running in System Information.


Depending on the license model, the publisher may require other details of your license server, the machine 
on which it is running, and details of your network.


4. Install licenses on the license server.


The publisher may specify a particular location for the license files on the license server. When no specific 
location is required, see information in Locating Licenses for instructions.


5. Install the FlexEnabled application on end user machines.


The publisher will supply installation instructions for installing the FlexEnabled application.
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6. Set up end user machines to access the license server.


There are several methods of configuring the end user machine to access a single license server or multiple 
license servers. These depend on the contents of the license files supplied by the publisher and your license 
server(s) configuration. See information in Locating Licenses for instructions.


7. Optionally, create an options file.


If you want to limit license usage, configure logging, or turn off the automatic reread of licenses, create an 
options file and install it in the same directory as the vendor daemon. See instructions in Managing the 
Options File.


8. Configure and start up the license server manager.


There is a fundamental difference between the configuration of lmadmin and lmgrd, so the processes required 
for each are separately outlined here:


lmadmin - The configuration settings are permanent and mainly set using the user interface. For details see 
lmadmin online help and Using lmadmin.


lmgrd - the configuration settings are set when lmgrd is started. They are not persistent. For details see lmgrd 
- License Server Manager.


You can manage and monitor the operation of the license server using the license server manager. lmadmin 
provides direct management and monitoring of the license server through its user interface; lmgrd provides limited 
information as command-line output. Additional utilities are provided on the Flexera Software website for 
management and monitoring of the license server. For details, see Using License Administration Tools. For more 
comprehensive monitoring and reporting of license usage, use FlexNet Manager. FlexNet Manager is a Web-based 
administration and reporting tool for FlexNet licenses and license servers.
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Trusted Storage

Some publishers use trusted storage to store licenses. They might store all of their licenses in trusted storage or 
use a combination of licenses held in license files and in trusted storage. You can use a single license server to 
serve licenses from both license files and trusted storage.


Overview of Trusted Storage
Trusted storage is a secure location that is locked to the machine on which it is located using a combination of 
machine identities. The contents of trusted storage are encrypted and can only be accessed by FlexEnabled 
components. This method of storing licenses enables your publisher to provide additional license models and 
automate some licensing processes.


Automated Delivery of Licenses to a License Server
Trusted storage is maintained by licensing life-cycle operations, such as license activations, returns, repairs, and 
upgrades. These life-cycle operations are performed through transactions normally issued over a network 
connection between the license server and the publisher’s activation server. However, when a network connection 
is not available, the messages that implement these transactions can be transmitted by other means.


Activation is the basic licensing life-cycle operation between the license server and the publisher’s activation server. 
This operation configures your trusted storage for specific use by the publisher and writes a fulfillment record to it. 
The fulfillment record contains licenses defined using a similar format to that used for licenses held in license files.


The remaining life-cycle operations between a license server and the publisher’s activation server maintain the 
trusted-storage licenses and are optional:


• Return - Returns a fulfillment record (and the licenses it contains) from trusted storage to the publisher server 
it was issued by.


• Repair - Repairs compromised fulfillment records in trusted storage.
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• Upgrade to a new version - The old license is returned to the publisher’s activation server so that 
entitlement to the upgrade can be checked and new licenses transmitted using an activation operation.


• Rehost of license server - When you need to move a license server to a different machine, a combination of 
return and then activation operations can provide a completely automated transfer. 


Note • Not all publishers provide these facilities.


Using Licenses From Trusted Storage on a License 
Server


Two types of licenses can be used in trusted storage on a license server. Your publisher may provide either or both 
of these types of license. They are used to provide different licensing models.


• Concurrent - allows a fixed number of concurrent users to use licensed features at any one time. The license 
server controls the use of these licenses, which are not normally locked to a specific machine, and float on the 
network. FlexNet Publisher provides for many variations of this basic license model, for example the use of a 
set of concurrent licenses can be restricted to a group of users.


• Activatable - licenses are distributed by the license server to network machines to provide local licenses for 
FlexEnabled applications. In this license model FlexEnabled components on the network machine request a 
license from the license server. License rights held in trusted storage on the license server are transferred to 
trusted storage on the network machine. This provides a license that is locked to the network machine. 
Depending on which license models your publisher is providing, these licenses may be of limited duration and 
automatically return to the license server when they expire on the network machine, or may be transferred to 
the network machine ‘permanently’.


Trusted Storage Components on a License Server
The basic components of a FlexNet Publisher license server that uses licenses held in trusted storage are as 
illustrated in the following diagram:


• License server manager - lmadmin (or lmgrd) supplied by your publisher or available from Flexera Software.


• Bootstrap license file - Created by your publisher. Required for starting the license server manager when 
the license server is using trusted storage to store all its licenses.


• Vendor daemon - Created by the publisher. This must be the publisher vendor daemon that can access 
trusted storage. Ensure that you always use the correct vendor daemon supplied by the publisher: an earlier 
version that is only able to use license files will not be able to use licenses held in trusted storage.


• Trusted storage - Contains licenses in fulfillment records.
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• Server activation utility - A FlexEnabled component that manages the transactions with the publisher server 
and creates and manages the contents of trusted storage.


Figure 2-1:  License Server Using Licenses in Trusted Storage


The following components not shown on the diagram may be present on the license server:


• Debug log - Written by the license server manager.


• Options file - Optional file that you create.


• Report log - Optional file used by FlexNet Manager. 


Using a License Server With Trusted Storage
The following gives an outline of the steps in installing a license server and using it to serve licenses from trusted 
storage. For further information about each of these steps read the relevant sections of this document. 


1. Choose the machine(s) on which the license server(s) will be installed.


• Determine the number of licenses and machines on which FlexEnabled applications will be installed. See 
Selecting a License Server Machine for further information.


• Consider what method, if any, you want to use to ensure that whenever possible licenses are available to 
your end users. See Ensuring License Availability for further information.


2. Install the license server components.


The publisher will supply a copy of his vendor daemon and instructions for installing it. The latest license 
server manager, lmadmin, displays details of licenses held in trusted storage; lmgrd includes information about 
concurrent licenses held in trusted storage but does not display details of activatable licenses. Therefore, it is 
recommended that you install lmadmin as your license server manager. Either the publisher provides this 
component, or you can download a copy from the Flexera Software website. It is recommended that you 
install the latest version of the license server manager.
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3. Install licenses on the license server.


The publisher will supply instructions and software that requests licenses from the publisher server. This 
process may be completely transparent to you. The publisher provides the interface for the installation of 
licenses so publisher’s licensing solutions may differ greatly. FlexNet Publisher is designed to allow publishers 
maximum flexibility in licensing models and processes.


4. Install the FlexEnabled application on end user machines.


The publisher will supply installation instructions for installing the FlexEnabled application and optionally any 
further FlexEnabled components.


5. Set up end user machines to access the license server to obtain concurrent licenses.


There are several methods of configuring the end-user machine to access a single license server or multiple 
license servers. These depend on the contents of any license files that may optionally be supplied by the 
publisher and your license server(s) configuration. See information in Locating Licenses for instructions.


6. Optionally, create an options file.


If you want to limit license usage, configure logging or turn off the automatic reread of licenses, create an 
options file and install it in the same directory as the vendor daemon. See instructions in Managing the 
Options File.


7. Configure and start up the license server manager.


8. Optionally, install node-locked licenses on end user machines using activatable licenses from the license 
server.


The publisher will supply instructions for requesting licenses from the license server. Additional components 
may be installed on the end user machine for this licensing model, see Distribution of Node-Locked Licenses 
to Networked Machines.


Distribution of Node-Locked Licenses to 
Networked Machines


The distribution of licenses from a license server to machines running FlexEnabled applications via a network is 
one license model that can be provided using activatable licenses held in trusted storage on a license server. 
FlexEnabled components on the network machine send a request for a license to the license server. The vendor 
daemon processes this request and if a suitable license is available transfers it to the network machine.
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The FlexEnabled components on the network machine install the license in trusted storage. Trusted storage is 
locked to the network machine and thus licenses held in trusted storage are node-locked to that machine.


Figure 2-2: FlexEnabled components for trusted storage on a network machine


The FlexEnabled components required to implement the distribution of node-locked licenses to networked 
machines using trusted storage are:


• License server manager - Use lmadmin as the license server manager as it displays details of activatable 
licenses held in trusted storage.


• Vendor daemon - Created by the publisher. This must be the publisher vendor daemon that can access 
trusted storage. Ensure that you always use the correct vendor daemon supplied by the publisher: an earlier 
version that is only able to use license files will not be able to use licenses held in trusted storage.


• Trusted storage on license server - Contains activatable licenses that can be transferred to a networked 
machine. Concurrent licenses can only be used to implement floating license models. 


• Server activation utility (not shown) - The FlexEnabled component on the license server that requests and 
loads licenses into the server’s trusted storage from the publisher. This utility also manages the contents of the 
server’s trusted storage through return, repair, and modify requests.


• Application activation utility - A FlexEnabled component that requests a license from the enterprise license 
server or the publisher’s activation server and creates and manages the contents of trusted storage. The 
publisher can integrate this functionality into a component that provides other functions (for example, the utility 
could be integrated into the FlexEnabled application installer).


• Trusted storage on the network machine - Contains licenses locked to the machine.


• FlexEnabled application - The application that requires the license. Note that this component must have 
been built by your publisher so that it can access trusted storage. You must ensure that you use the correct 
version of the application.


You can use the options file to restrict the distribution of node-locked licenses to network machines. See Managing 
the Options File for details.
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Single-Action vs Composite Transactions
FlexNet Publisher supports two transaction types for performing the licensing life-cycle operations for trusted 
storage:


• Single-Action Transactions


• Composite Transactions


Single-Action Transactions


Single-action transactions perform one licensing action per transaction. For example, using single-action 
transactions to activate two fulfillment records from a FlexNet license server to a FlexEnabled client can involve up 
to three separate transactions (one to configure trusted storage and two to activate the two fulfillment records). All 
licensing life-cycle operations performed between the license server and FlexEnabled clients must use single-
action transactions. 


Note • Single-action transactions are also supported for life-cycle operations between the publisher’s activation 


server and the license server, but best practice is to use composite transactions for these operations. 


Composite Transactions


Composite transactions are supported for life-cycle operations between only the publisher’s activation server and 
the license server (not between the license server and FlexEnabled clients). A single composite transaction uses 
one request from the license server and one response from the publisher’s activation server to perform any 
number of activations, repairs, returns, and upgrades on the license. For example, a composite transaction can 
perform any of the following licensing life-cycle operations, providing greater flexibility in managing trusted-storage 
license rights:


• Return one or more fulfillment records


• Activate one or more fulfillment records


• Modify one or more fulfillment records (for example, to change the license count)


• Combinations of these actions to perform partial or full returns or upgrades


Additionally, composite transactions store more details about the activation than single-action transactions do, 
allowing a better chance to fully recover a trusted storage on the license server should errors occur. 


Note • Although single-action transactions are supported for licensing life-cycle operations between the 


publisher’s activation server and the license server, best practice is always to use composite transactions for such 


operations. 
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Comparison of Trusted Storage and License 
Files


This section gives an overview of the significant differences between FlexEnabled products that use trusted 
storage and those that use license files. However, significant these changes might be, the methods for defining 
license rights in trusted storage are based on the methods for defining rights in license files. So if you have been 
using FlexEnabled products for years, the majority of your knowledge is directly applicable to licenses held in 
trusted storage.


License Files and Fulfillment Records
The license model is defined primarily in the feature definition lines (FEATURE and INCREMENT) in a license file. 
There are the same feature definition lines inside fulfillment records in trusted storage. See the following diagram 
that shows a typical lmadmin display for a fulfillment record.


Figure 2-3: License server fulfillment record displayed by lmadmin


The fulfillment record PR-589df128 provides 10 activatable licenses for the product PRprofessional. Each 
activatable license licenses two features: PRbasic and PRadvanced. These two feature definition lines (in this 
example INCREMENT lines) are packaged together in a single fulfillment record. 
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Licenses held in trusted storage use all the mandatory fields and may contain most of the attributes described in 
Reading a License File. The following are the exceptions:


• BORROW - Normally this feature definition line attribute is not used for licenses held in trusted storage, the 
publisher will provide this licensing model using the Distribution of Node-Locked Licenses to Networked 
Machines using trusted storage on the network machine.


• HOSTID - Normally this feature definition line attribute is not required for licenses held in trusted storage, see 
Locking of Licenses Using Hostid or Trusted Storage for details of how licenses are locked to a host machine.


• SUPERSEDE - This feature definition line attribute is not supported for licenses held in trusted storage. A 
combination of return and activation operations are used to remove the license for the old version of the 
application and replace it with a new license.


The following line types are not supported in trusted storage:


• UPGRADE (a combination of returns and activations are used for an upgrade)


• PACKAGE (a fulfillment record effectively packages multiple feature definition lines)


Note •  When other functions for package suites are required, a license file with a PACKAGE line can be 


provided.


• SERVER (not needed)


• VENDOR (lmadmin provides direct vendor-daemon configuration)


• VM_PLATFORMS (not needed)


• USE_SERVER (not needed)


Locking of Licenses Using Hostid or Trusted Storage
When license files are used, licenses are locked to a machine using a hostid. This identifies either the machine or a 
FlexNet ID dongle that is attached to a machine. The hostid is incorporated into the licenses supplied by the 
publisher so you must supply details of hostids before the publisher can provide your licenses. This procedure is 
repeated when licenses need to be moved to another machine.


Trusted storage is locked to the machine on which it is created using machine identities retrieved automatically by 
the FlexEnabled components when trusted storage is created. The licenses held in trusted storage are locked to 
the machine because they are held securely within trusted storage.
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Licensing in Virtual Environments
The server-side activation utility can run inside a virtual machine. See Chapter 15, “Virtualization Support,”for the 
list of hypervisors that FlexNet Publisher supports.


Binding in a Virtual Environment
FlexNet Publisher automatically uses the appropriate binding elements when running in a virtual environment, if 
they are available. Binding is to differentiate between Physical and virtual environments and the legacy bind-to-
VMID policy is deprecated. The binding elements are:


•  MAC address- used on physical environments is now used in virtual environments as well and is a deal 
breaker.


•  UUID (universally unique ID) - A binding identity used to configure trusted storage on the virtual machine, 
previously the only binding identity used in virtual environments; this is now a deal breaker.


• Generation ID-Is a property of a virtual machine available in some environments. Where it is available it is 
used as a binding identity; it is a deal breaker.


A binding item is a deal breaker if, when it changes, trust should be lost regardless of the number of binding items 
that still match. Since all binding identities used in virtual environments are deal breakers, trust will always be lost 
of any of them change


Note • Support for trusted-storage in virtualized environments does not require the lmbind utility.


Best Practices


To Avoid Trusted-Storage Breakage


If the publisher chooses to bind trusted storage to the VMID, this binding breaks should the UUID (from which the 
VMID is derived) ever change or is no longer available. The break prevents license leakage when virtual machine 
images are cloned. However, if you manage a virtualized environment where virtual machines are moved between 
different native (physical) systems, you do not want trusted storage to break each time you move a machine 
instance. 


To prevent breakage, use these best practices:


• Do not change MAC address of the virtual machine.


• Do not change the UUID of the virtual machine when it is moved. (Normally, UUIDs change only if the virtual 
machine is cloned.)


• Save the configuration file (or at least the UUID) of each virtual machine on which trusted-storage license 
activation is performed. This file ensures that the UUID value used at the time of activation is available should 
you need to revert to this value.
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• Should trusted storage break, use the activation utility to issue a repair request; or reset the virtual machine’s 
UUID to the value it had at activation time (powering the machine off and then on after the reset).


To Avoid Issues with the Licensing Life-Cycle Operations


Although both composite and single-action transactions are supported for licensing life-cycle operations between 
the publisher’s activation server and the license server, best practice is always to use composite transactions in 
virtual environments. Issues can arise if you attempt to mix composite and single-action transactions, mainly 
because composite transactions support UMN3 and UMN5 while single-action transactions do not. For example, if 
a composite transaction is used initially to activate licenses on a virtual machine, the UMN3, if obtained, becomes 
the primary UMN for requester verification. If a single-action transaction is used later to return a license, the 
process fails because the return request contains no UMN3 to identify the requesting machine.
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Reading a License File

A license file contains information required to manage licenses for a FlexEnabled application. This information 
includes:


• License server names and hostids


• VENDOR names and paths to vendor daemon executables


• Feature information


The license file must be accessible to systems that run the FlexEnabled application or a license server. For details 
see Locating Licenses and Ensuring License Availability. 


License File Format Overview
License files begins with either a single SERVER line or three SERVER lines (when configured for three-server 
redundancy) followed by one or more VENDOR lines, followed by one or more FEATURE or INCREMENT lines. In 
some cases, the license file requires no SERVER line and no VENDOR line. 


Note • Eight-bit Latin-based characters are fully supported in license files, options files, log files, and FlexEnabled 


application environments. 


See Counted vs. Uncounted Licenses for more information on SERVER and VENDOR line requirements. 


You can modify these elements in the license file:


• On the SERVER line: 


• Host names on the SERVER lines


• TCP/IP port numbers 


• HEARTBEAT_INTERVAL and PRIMARY_IS_MASTER properties
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• On the VENDOR line:


• Paths to the vendor daemon.


• Options file paths


• TCP/IP port numbers (for firewall support only)


• The USE_SERVER line. 


• On the feature definition lines: 


• The values in keyword=value pairs on FEATURE lines, if keyword is specified in lowercase


• You can use the \ line-continuation character to break up long lines. 


See Also
Ensuring License Availability
Counted vs. Uncounted Licenses


License File Syntax
This section describes the contents of the license file, including SERVER lines and VENDOR lines. This is an 
example of a license file for a single VENDOR name with two features.


SERVER my_server 17007ea8 1700
VENDOR sampled 
FEATURE f1 sampled 1.000 01-jan-2013 10 SIGN=”<...>” 
FEATURE f2 sampled 1.000 01-jan-2013 10 SIGN=”<...>” 


This example allows the license server, called my_server with the hostid 17007ea8, to serve ten floating licenses 
for each feature, f1 and f2 to any user on the network.


SERVER Lines
The SERVER line specifies the host name and hostid of the license server and the TCP/IP port number of the 
license server manager (lmadmin or lmgrd). Normally a license file has one SERVER line. Three SERVER lines 
mean that you are using license servers configured for three-server redundancy. The absence of a SERVER line 
means that every feature definition line in the license file is uncounted. 


The hostids from the SERVER lines are computed into the license key or signature on every feature definition line. 
For this reason, make sure you keep SERVER lines together with any feature definition lines as they were sent from 
the software publisher.


The format of the SERVER line is:


SERVER host hostid [port] [PRIMARY_IS_MASTER] [HEARTBEAT_INTERVAL=seconds]

28 FNP-11121-LAG00 License Administration Guide







Chapter 3: Reading a License File
License File Syntax

For example: 


SERVER my_server 17007ea8 21987


The following table describes the attributes on this line. 


Table 3-1 • SERVER Line Format


Field Description


host The system host name or IP address. String returned by the UNIX hostname or 
uname -n command. On NT/2000/XP, ipconfig /all; on Windows 95/98/ME, 
winipcfg /all return the host name.


hostid Usually the string returned by the lmhostid command. This is changed only by 
your publisher.


port TCP/IP port number to use. A valid number is any unused port number 
between 0 and 64000. On UNIX, choose a port >1024, since those <1024 are 
privileged port numbers. If no TCP/IP port number is specified, one of the 
default ports in the range of 27000–27009 is used.


You must specify a port number when the SERVER line defines license servers 
configured for three-server redundancy.


Note • For security purposes, best practice is not to use a default port for the license 
server. Instead, specify a port number outside of the range 27000 through 27009.


PRIMARY_IS_MASTER Used with license servers configured for three-server redundancy to indicate 
how master control is transferred between the primary and secondary servers.


• If this is set and the primary server goes down, when the primary server 
comes back up again, it will always become the master.


• If this is not set and the primary server goes down, the secondary server 
becomes the master and remains the master even when the primary 
server comes back up. The primary can only become the master again 
when the secondary license server fails. 


If both primary and secondary go down, licenses are no longer served. The 
tertiary server never becomes the master. 


This parameter is optional and is placed on the first SERVER line in the license 
file. You must be running a version 10.8 or later vendor daemon to use this 
parameter.
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See Also
Ensuring License Availability


VENDOR Lines
The VENDOR line specifies the daemon name and path. The license server uses this line to start the vendor 
daemon, and the vendor daemon reads it to find its options file. The format of the VENDOR line is shown below.


VENDOR vendor [vendor_daemon_path]\
[[OPTIONS=]options_file_path] [[PORT=]port]


where:


HEARTBEAT_INTERVAL=
seconds


Used with license servers configured for three-server redundancy to indicate 
how long a license server waits to receive a heartbeat from another license 
server in the triad before shutting itself down. The seconds value is used in the 
following equation to calculate the timeout:


• timeout = (3 x seconds) + (seconds - 1)


Valid timeout value is 0-120. If not specified, the default value for seconds is 20, 
equating to an actual timeout value of 79 seconds. Valid values for the seconds 
value are 0–30.


Note • When the seconds value exceeds 30, lmadmin displays the Heartbeat Interval 
value as -1 along with the an error message “Invalid three server redundancy 
configuration, valid timeout values are 0 - 120".


This parameter is optional and is placed on the first SERVER line in the license 
file. You must be running a version 10.8 or later vendor daemon to use this 
parameter. 


Table 3-2 • VENDOR Line Format


Field Description


vendor Name of the vendor daemon used to serve some features in the file. This name 
cannot be changed. 


Table 3-1 • SERVER Line Format


Field Description
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See Also
Managing the Options File for further information regarding options file contents.


USE_SERVER Line
The USE_SERVER line takes no arguments and has no impact on the license server. When the application sees the 
USE_SERVER line, it ignores everything in the license file except the preceding SERVER lines and transfers checkout 
validation to the vendor daemon.


USE_SERVER is recommended since it improves performance when a license server is used. For uncounted 
features, USE_SERVER is used to force logging of usage by the daemons.


FEATURE and INCREMENT Lines
A FEATURE and INCREMENT lines describe the license model for a product. Only the first FEATURE line for a 
given feature name is processed by the vendor daemon. If you want to have additional copies of the same feature 
(for example, to have multiple node-locked, counted features), then you must use multiple INCREMENT lines. 
INCREMENT lines form license groups, or pools, based on the following fields:


• feature name


vendor_daemon_path Optional path to the executable for this daemon. Generally, the license administrator 
is free to install the vendor daemon in any directory. It is recommended, however, 
that it be installed in a local directory on the license server. 


If omitted, the license server looks for the vendor daemon binary in: 


• the current directory


• the path specified in license server’s $PATH environment variable


• in the directory where the license server is located


If vendor_daemon_path is blank, then any option or TCP/IP port number 


specifications require the OPTIONS= and PORT= strings.


options_file_path Full path to the options file for this daemon. An options file is not required. 


If omitted, the vendor daemon, by default, looks for a file called vendor.opt (where 
vendor is the vendor daemon name) located in the same directory as the license file.


port Vendor daemon TCP/IP port number.


The default, if port is not specified, is chosen by the operating system at run-time. 
Sites with Internet firewalls need to specify the TCP/IP port number the daemon 
uses. If a TCP/IP port number is specified on the VENDOR line, there may be a delay 
restarting the vendor daemon.


Table 3-2 • VENDOR Line Format


Field Description
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• version


• DUP_GROUP


• FLOAT_OK


• HOST_BASED


• HOSTID


• PLATFORM


• USER_BASED


• VENDOR_STRING (if configured by the publisher as a pooling component)


• TZ


• VM_PLATFORMS


If two lines differ by any of these fields, a new group of licenses, called a license pool, is created in the vendor 
daemon, and this group is counted independently from other license pools with the same feature name. A 
FEATURE line does not give an additional number of licenses, whereas an INCREMENT line always gives an 
additional number of licenses.


The basic feature definition line format is:


{FEATURE|INCREMENT} feature vendor feat_version exp_date num_lic [optional_attributes] SIGN=”<...>”


Publisher-Defined Required Keywords


The six fields after the feature definition line keyword are required and have a fixed order. They are defined by the 
software publisher and cannot be changed. Table 3-3 presents these fields in the order they must appear.


Table 3-3 • Feature Definition Line Required Fields 


Field Description


feature Name given to the feature by the software publisher.


vendor Name of the vendor daemon; also found in the VENDOR line. The specified daemon 
serves this feature.


feat_version Version of this feature that is supported by this license. When this field contains a 
date with the format yyyy.mmdd, this defines a date-based version that you can set 
as an Alert in the license server manager, lmadmin.


exp_date Expiration date of license in the format dd-mmm-yyyy, for example, 07-may-2013. 
Note: If exp_date is the string “permanent” or the year is 0 (or 00, 000, 0000) then the 
license never expires.
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Optional Publisher-Defined Keywords


Table 3-4 lists attributes that may appear in a FEATURE or INCREMENT line. They are supplied at the discretion of 
the software publisher to define the license model. If present in the FEATURE or INCREMENT line, they must 
remain there and cannot be altered by the end user. These attributes have a keyword=value syntax where keyword 
is in uppercase. 


num_lic Number of concurrent licenses for this feature. If the num_lic is set to the string 
“uncounted” or 0, the licenses for this feature are uncounted and no license server is 
required but a hostid on the FEATURE line is required. See Counted vs. Uncounted 
Licenses.


SIGN=sign or


AUTH=...


SIGN= signature to authenticate this FEATURE line.


If your publisher has deployed his vendor daemon using the common vendor 
daemon technology, signatures are embedded within the AUTH= keyword. Contact 
your publisher for further details.


Table 3-4 • Attributes Set by the Software Publisher 


Attribute Description


BORROW[=n] Enables license borrowing for a particular feature definition line. n is the number of 
hours that the license is borrowed. The default borrow period is 168 hours, or one 
week.


DUP_GROUP=... The syntax is:


DUP_GROUP=NONE|SITE|[UHDV]


U = DUP_USER


H = DUP_HOST


D = DUP_DISPLAY


V = DUP_VENDOR_DEF


Any combination of UHDV is allowed, and the DUP_MASK is the OR of the 
combination. For example, DUP_GROUP=UHD means the duplicate grouping is 
(DUP_USER|DUP_HOST|DUP_DISPLAY), so for a user on the same host and 
display, additional uses of a feature do not consume additional licenses.


Table 3-3 • Feature Definition Line Required Fields 


Field Description
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FLOAT_OK
[=server_hostid]


Enables mobile licensing via FLEXID with FLOAT_OK for a particular feature 
definition line. This feature definition line must also be node-locked to a FLEXID.


When FLOAT_OK=server_hostid is specified on a FEATURE line:


The server_hostid must refer to the same host that appears on the SERVER line of 
the license file.


The license server runs only on the system with the hostid that lmhostid returns 
equal to the server_hostid specified with FLOAT_OK.


HOSTID=
"hostid1


[hostid2 ...


hostidn]"


Id of the host to which the feature line is bound. hostid is determined with the 


lmhostid utility. This field is required for uncounted licenses; but can be used for 
counted licenses as well. See Hostids for Supported Platforms for more 
information.


HOST_BASED[=n] Host names must be specified in INCLUDE statements in the options file, and the 


number of hosts is limited to num_lic, or the number specified in =n.


ISSUED=dd-mmm-yyyy Date issued.


ISSUER="..." Issuer of the license.


NOTICE="..." A field for intellectual property notices.


ONE_TS_OK Detects when a node-locked uncounted license is used by an application running 
under remote desktop.


OVERDRAFT=n The overdraft policy allows a software publisher to specify a number of additional 
licenses which users are allowed to use, in addition to the licenses they have 
purchased. This allows your users to not be denied service when in a “temporary 
overdraft” state. Usage above the license limit is reported by the FlexNet Manager 
reporting tool.


PLATFORMS="..." Usage is limited to the listed platforms. 


SN=serial_num Serial number, used to identify FEATURE or INCREMENT lines.


START=dd-mmm-yyyy Start date.


SUITE_DUP_GROUP=.
..


Similar to DUP_GROUP, but affects only the enabling FEATURE line for a package 
suite. It limits the total number of users of the package to the number of licenses, 
and allows the package to be shared among the users that have the SUITE 
checked out.


Table 3-4 • Attributes Set by the Software Publisher 


Attribute Description
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SUPERSEDE=
"f1 f2 ..."


If this appears, all INCREMENT or FEATURE lines for the specified feature that were 
issued earlier than the ISSUED date for the SUPERSEDE are superseded by this line 
and become ineffective. (SUPERSEDE also overrides those INCREMENT and FEATURE 
lines for the feature that have no ISSUED date.)


SUPERSEDE_SIGN=
{f1:xxxx, f2:xxxx) 


SUPERSEDE_SIGN=
{p1:xxxx, p2:xxxx) 


Overrides the license models of all feature definition lines or package lines defined 
as the value.


TS_OK FlexNet Publisher detects when a node-locked uncounted license is running under 
Windows Terminal Server. To run the application via a Terminal Server client 
window, TS_OK must be added to the FEATURE line. Without TS_OK, a user running 
on a Terminal Server client is denied a license.


TZ=
[SERVERTZ|


<[+-]hh<.30|.45>


<:[+-]hh<.30|.45>>>]


Enforces license usage for a feature relative to a time zone; where the time zone is 
specified and measured relative to Greenwich Mean Time (GMT). The computer 
system on which the FlexEnabled application is running must be within the 
specified time zone or range of time zones, or in the same time zone as the license 
server (using the value SERVERTZ). 


USER_BASED[=n] Users must be specified in INCLUDE statements in the options file, and the number 
of users are limited to num_lic, or the number specified in =n.


VENDOR_STRING="..." This is a custom value defined by the software publisher and enclosed in double 
quotes.


VM_PLATFORMS=
[PHYSICAL | VM_ONLY]


Restricts feature usage to virtual machines (VM_ONLY) or to physical machines 
(PHYSICAL). If this keyword is not present, FlexEnabled applications can be run on 
both physical and virtual machines (default behavior).


Table 3-4 • Attributes Set by the Software Publisher 


Attribute Description
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Examples


FEATURE sample_app sampled 2.300 31-dec-2013 20 SIGN=”<...>”
INCREMENT f1 sampled 1.000 permanent 5 HOSTID=INTERNET=195.186.*.* NOTICE="Licensed to \


Sample corp" SIGN=”<...>”


Optional Keywords Defined by the License Administrator


The following attributes listed in Table 3-5 are optional and are under control of the license administrator. These 
attributes have a keyword=value syntax where keyword is in lowercase.


Character Limitations in Keyword Values


In places where a keyword value in a FEATURE or INCREMENT line is a string surrounded with double quotes (“...”), 
the string can contain any characters except the following:


• Single or double quotes (within the surrounding double quotes)


Table 3-5 • Optional Feature Line Attributes 


Attribute Description


asset_info="..." Additional information provided by the license administrator for asset 
management.


dist_info="..." Additional information provided by the software distributor.


sort=nnn Specifies sort order of license file lines. See Sort Rules.


user_info="..." Additional information provided by the license administrator.


vendor_info="..." Additional information provided by the software publisher.
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• The backslash character sequence:  \  (space+backslash+space)


• The double-backslash character sequence:  \\  (space+backslash+backslash+space) 


Sort Rules


Feature definition lines are automatically sorted when they are read from the license file. The default sorting rules 
are is as follows: 


1. License file. Automatic sorting does not occur across files in a license search path.


2. Feature name.


3. FEATURE before INCREMENT.


4. Uncounted before counted.


5. Version, earlier versions before later versions.


6. Issued date, in reverse order, newest first. The date is taken from ISSUED= or START=.


7. Original order is otherwise maintained.


To turn off automatic ordering, add sort=nnn to the feature definition line, where nnn is the same on all lines; nnn 
specifies the relative sort order. The default sort order value is 100. Lines with a sort order value of less than 100 
are sorted before all lines without this attribute, and lines with a sort order value greater than 100 appear after all 
unmarked lines. All lines with the same number are sorted as they appear in the file.


Changes in FEATURE and INCREMENT Line Format


The following lists the significant changes in the format of feature definition lines and when additional keywords 
were introduced.


• Version 7.1 and earlier feature definition line format uses license_key:


{FEATURE|INCREMENT} feature vendor feat_version exp_date \
num_lic [optional_attributes] SIGN=”<...>”


The version 7.1 and earlier format is understood by the current release. 


• The SIGN= keyword introduced in the version 7.1.


• For version 7.1 through version 8.0 client libraries and vendor daemons, the feature definition line must have a 
SIGN= signature and, for backward compatibility with version 8.1 and earlier, can contain a license_key:


{FEATURE|INCREMENT} feature vendor feat_version exp_date \
num_lic [license_key] [optional_attributes] SIGN=”<...>” 


• license_key obsoleted in version 8.1 client library and vendor daemon


• The keyword “permanent” for exp_date introduced in version 6 client library.


• The keyword “uncounted’ for num_lic introduced in version 6 client library.


• BORROW keyword introduced in version 8.0 client library and vendor daemon.
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• FLOAT_OK keyword introduced in version 8.0 client library and vendor daemon.


• TS_OK keyword introduced in version 8.0 client library and vendor daemon.


• AUTH keyword introduced in version 10.8 client library and vendor daemon.


PACKAGE Lines
The purpose of the PACKAGE line is to support two different needs:


• To license a product SUITE, or


• To provide a more efficient way of distributing a license file that has a large number of features, which largely 
share the same FEATURE line arguments.


A PACKAGE line, by itself, does not license anything—it requires a matching feature definition line to license the 
whole package. A PACKAGE line is shipped by your software publisher with a product, independent of any 
licenses. Later, when you purchase a license for that package, one or more corresponding feature definition lines 
enable the PACKAGE line.


Example


PACKAGE package vendor [pkg_version] COMPONENTS=pkg_list \
[OPTIONS=SUITE] [SUPERSEDE[="p1 p2 ..."] ISSUED=date]
SIGN=”<...>”


Table 3-6 lists the PACKAGE line fields. They must appear in the order listed.


Table 3-6 • PACKAGE Line Fields 


Field Description


package Name of the package. The corresponding feature definition line must have 
the same name.


vendor Name of the vendor daemon that supports this package.


pkg_version Provide the version of the package. The corresponding feature definition 
line must have the same version. 
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Examples


PACKAGE suite sampled 1.0 SIGN=”<...>” \
COMPONENTS="comp1 comp2" OPTIONS=SUITE


FEATURE suite sampled 1.0 1-jan-2013 5 SIGN=”<...>”


COMPONENTS=pkg_list List of package components. The format is:


feature[:version[:num_lic]]


Packages must consist of at least one component. Version and count are 
optional, and if left out, their values come from the corresponding feature 


definition line. num_lic is only legal if OPTIONS=SUITE is not set—in this 
case the resulting number of licenses is num_lic on the COMPONENTS 
line multiplied by the number of licenses in the feature definition line. 
Examples:


COMPONENTS="comp1 comp2 comp3 comp4"
COMPONENTS="comp1:1.5 comp2 comp3:2.0:4"


OPTIONS=SUITE Optional field. Used to denote a package suite.


If set, the corresponding feature of the same name as the package is 
checked out in addition to the component feature being checked out.


If not set, then the corresponding feature of the same name as the package 
is removed once the package is enabled; it is not checked out when a 
component feature is checked out.


OPTIONS=
SUITE_RESERVED


Optional field. If set, reserves a set of package components. Once one 
package component is checked out, all the other components are reserved 
for that same user. 


SUPERSEDE
[="p1 p2 ..."]


Optional field. Used in conjunction with ISSUED date. Replaces all 
PACKAGE lines for the same package name with previous or no ISSUED 
dates.


ISSUED=
dd-mmm-yyyy


Optional field. Used in conjunction with SUPERSEDE in the PACKAGE line. 
Replaces all PACKAGE lines for the same package name with previous or 
no ISSUED dates.


SIGN=sign or


AUTH=...


SIGN= signature to authenticate this FEATURE line.


If your publisher has deployed his vendor daemon using the common 
vendor daemon technology, signatures are embedded within the AUTH= 
keyword. Contact your publisher for further details.


Table 3-6 • PACKAGE Line Fields 


Field Description
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This is a typical OPTIONS=SUITE example. There are two features, “comp1” and “comp2,” which are each version 
1.0, each with five non-expiring licenses available. When “comp1” or “comp2” is checked out, “suite” is also 
checked out. 


PACKAGE suite sampled 1.0 SIGN=”<...>”\
COMPONENTS="apple:1.5:2 orange:3.0:4"


FEATURE suite sampled 1.0 1-jan-2013 3 SN=123 SIGN=”<...>”


In this example, the component version overrides the feature version, and the number of licenses available for any 
component is the product of the three licenses for “suite” and the number of licenses for that component. The 
result is equivalent to:


FEATURE apple sampled 1.5 1-jan-2013 6  SN=123 SIGN=”<...>”
FEATURE orange sampled 3.0 1-jan-2013 12 SN=123 SIGN=”<...>”


Note • The following lists changes to PACKAGE lines:


• Ability to store PACKAGE lines in separate files introduced in version 6 client library.


• pkg_version field required is mandatory.


• AUTH keyword introduced in version 10.8 client library and vendor daemon.


UPGRADE Lines
UPGRADE feature vendor from_feat_version to_feat_version \
exp_date num_lic [options ... ] SIGN=”<...>”


All the data is the same as for a FEATURE or INCREMENT line, with the addition of the from_feat_version field. An 
UPGRADE line removes up to the number of licenses specified from any old version (>= from_feat_version) and 
creates a new version with that same number of licenses.


For example, the two lines provide three version 1.0 licenses of f1 and two version 2.0 licenses of f1.


INCREMENT f1 sampled 1.000 1-jan-2013 5 SIGN=”<...>” 
UPGRADE f1 sampled 1.000 2.000 1-jan-2013 2 SIGN=”<...>” 


An UPGRADE line operates on the closest preceding FEATURE or INCREMENT line with a version number that is 
>= from_feat_version, and < to_feat_version.
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Feature Lines in Decimal Format
Licenses can be represented in decimal format. Decimal has the advantage that it is simpler to type in, and often 
the licenses are much shorter. A simple demo license in readable format:


FEATURE f1 sampled 1.00 1-jan-2013 0 HOSTID=DEMO SIGN=”<...>” 


and its decimal equivalent:


sampled-f1-00737-55296-1825


If needed, decimal lines can be mixed with readable format lines in a license file. Use the lminstall command to 
convert decimal licenses to readable format. 


See Also
lminstall for additional information on the lminstall command.


Order of Lines in the License File
The order of the lines in a license file is not critical. They are sorted when they are processed so that in most cases 
the optimal result is achieved. However, version 7.0 and earlier versions of FlexEnabled applications and license 
servers implicitly impose an ordering to license file lines. Note the following suggestions for ordering lines in the 
license file:


• Place FEATURE lines before INCREMENT lines for the same feature. 


The rules regarding FEATURE lines include the following: 1) only the first counted FEATURE line is observed 
by the license server, and 2) if both a FEATURE line and INCREMENT lines exist, the FEATURE line must 
appear first.


• Where multiple counted FEATURE lines exist for the same feature, make sure the desired FEATURE line 
appears first.


All but the first is ignored.


• Place node-locked, uncounted lines before floating lines for the same FEATURE. Otherwise, it is possible 
the floating license is consumed instead of the node-locked license, resulting in denial for other users.


• The placement of a USE_SERVER line affects behavior. A USE_SERVER line is recommended. Normally, 
the USE_SERVER line is placed immediately after the SERVER line. However, place any uncounted 
licenses not served by SERVER before the USE_SERVER line. Make sure each user that needs the 
uncounted license has direct access to a current copy of the file. The advantage to placing USE_SERVER 
right after the SERVER line is users don’t need up-to-date copies of the license file.


See Also
Sort Rules 
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Locating Licenses

This section covers various topics that are related to the ability of FlexEnabled applications to locate licenses. The 
following are described:


• Determining a location for license files on a license server


• Configuring the machine where the FlexEnabled application is running to access licenses.


Determining the Location of the License File
Software publishers often recommend a specific location for your license file. You have the following options for 
making your licenses available to all systems:


• Place the license file in a partition which is available to all systems in the network that need it.


• Copy the license file to each of the individual systems.


• Set the LM_LICENSE_FILE or VENDOR_LICENSE_FILE (where VENDOR is the vendor daemon name) environment 
variable on the machines where the FlexEnabled applications are running to access license files or license 
servers. For details see Setting the License Search Path Using an Environment Variable.


Do not choose a location for a license file where the path to the license file contains the @ symbol. The @ symbol 
is used to identify a license server as illustrated in Table 4-1. 


Note • A directory path that contains an @ symbol results in an error.


Since the vendor daemon keeps track of license usage, and since the license file contains encrypted data to 
protect it against modification, you may move and copy the license file as much as necessary.


On Windows, if the application cannot find the license file, the user is presented with a dialog that asks the user to 
specify the license file location, the license server, or license fulfillment from the internet.
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For counted licenses, no matter which option you choose, you must first copy lmadmin or lmgrd and the vendor 
daemon to a location that the FlexEnabled application can access on the network.


Setting the License Search Path Using an 
Environment Variable


Most applications specify a location where they expect to find the license file and install it automatically. However, 
you can change the license file location by setting the LM_LICENSE_FILE environment variable to a license search 
path. Wherever a license search path is specified, it can consist of one or more of the following entries. On UNIX, 
the license search path entries are separated by colons ‘:’ and on Windows, the entries are separated by 
semicolons ‘;’.


• The full path to the license file


• A directory containing one or more license files with a .lic extension


• One of the following port settings:


• The port setting port@host setting, where port and host are the TCP/IP port number and host name from 
the SERVER line in the license file. 


• The shortcut specification, @host, if the license file SERVER line uses a default TCP/IP port or specifies a 
port in the default port range (27000–27009).


• A three-server redundant triad. The triad is a single entry on the license search path and is specified using 
a comma-separated list of three port@hosts (for example, port1@host1,port2@host2,port3@host3).


Table 4-1 shows some examples of LM_LICENSE_FILE and VENDOR_LICENSE_FILE environment variable settings.


Table 4-1 • Environment Variable Specification Examples


LM_LICENSE_FILE or 
VENDOR_LICENSE_FILE Setting Description


40000@myserver Used where the SERVER line in the license file is the following:


SERVER myserver 17007ea8 40000 


• host = myserver


• port = 40000


@myserver Used where the SERVER line in the license file is the following:


SERVER myserver 17007ea8 


• host = myserver


• port = None specified. A default TCP/IP port number in the 
range of 27000-27009 is used.
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Applications accept an environment variable (or Windows Registry) named VENDOR_LICENSE_FILE, where VENDOR is 
the vendor daemon name, for example, DEMO_LICENSE_FILE. This environment variable’s scope is limited to just 
those applications from software publisher using the VENDOR name. 


With lmgrd and lmutil (lmstat, lmdown, and so on), the -c option overrides the setting of the LM_LICENSE_FILE 
environment variable.


Note • Some applications do not recognize the LM_LICENSE_FILE environment variable. FlexEnabled Java 


applications, in particular, do not recognize it.


Order of Searching for a License
A FlexEnabled application looks for a license file as follows:


1. When the VENDOR_LICENSE_FILE environment variable has been set for the publisher of the application, 
then items in the license search path set in this environment variable are searched in order.


2. The items in a license search path set in the LM_LICENSE_FILE environment variable are searched in order.


3. When any license file specified in a license search path contains a USE_SERVER line, then a license is 
requested from the license server specified in the SERVER line. Any FEATURE and INCREMENT lines entries 
after the USE_SERVER line in the license file are ignored.


4. When the environment variables are not set and the FlexEnabled application does not specify the location of 
the license, then the following default locations are searched:


• On UNIX - /usr/local/flexlm/licenses/license.dat


• On Windows - C:\flexlm\license.dat


When licenses are held in trusted storage on the same machine as the FlexEnabled application, normally the 
publisher will have configured the application to search local trusted storage first and then look for license files as 
previously described.


C:\licenses; 


40000@host1,40000@host2,40000@host3


License search path on a Windows system. Unserved licenses 
are stored in C:\licenses; served licenses are obtained from the 
three-server redundant triad 
40000@host1,40000@host2,40000@host3.


licenses:40000@myserver:40000@mybackup
server


License search path on a UNIX system. Unserved licenses are 
stored in the local directory licenses; served licenses are 
obtained from either myserver or mybackupserver. In the first 
instance, a license is requested from myserver; if this fails, 
mybackupserver is tried.


Table 4-1 • Environment Variable Specification Examples


LM_LICENSE_FILE or 
VENDOR_LICENSE_FILE Setting Description
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See Also
Managing Multiple License Files for more information about LM_LICENSE_FILE.
Environment Variables
Ensuring License Availability
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Managing License Files

This section describes how license files may be modified. For detailed information about modifications required 
when combining license files see Managing Licenses from Multiple Software Publishers.


Modifying License Files
License files usually begin with a SERVER line (or three lines for three-server redundant servers) followed by one or 
more VENDOR lines, followed by one or more FEATURE or INCREMENT lines. In some cases, the license file 
requires no SERVER line and no VENDOR line.


You can modify these elements in the license file:


• Host names on the SERVER lines


• TCP/IP port numbers on the SERVER lines (useful for firewall support)


• Three-server redundant configuration for a set of SERVER lines


• Paths on the VENDOR lines


• Options file paths on the VENDOR lines


• Optional TCP/IP port numbers on the VENDOR lines (useful for firewall support)


• USE_SERVER line


• Values in keyword=value pairs on FEATURE lines, if keyword is specified in lowercase


Use the \ line-continuation character to break up long lines.
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Configuring the Port Used by the License Server
The port used by the license server can be specified in the license file used to start the license server. This method 
is the only way to configure the port setting when lmgrd is used as the license server manager. When using 
lmadmin as the license server manager, the port can be configured directly using the lmadmin user interface or the 
lmadmin -licPort command-line option.


Task: To configure the port using lmgrd


1. Add the port number to the SERVER line as illustrated in the following example SERVER line:


SERVER pat 17003456 2837


where pat is the host name of the license server machine, 17003456 is the hostid of the license server machine 
and 2837 is the TCP/IP port number used by the license server.


2. Use the license file that contains the SERVER line that includes the port number to start lmgrd.
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Hostids for Supported Platforms

FlexNet Publisher uses system identifiers, called hostids, to node-lock licenses to a machine. The system 
identifiers may be system specific. For example, all Sun Microsystems systems have a unique hostid. 


Hostid Formats
Numeric, 32-bit hostids are normally used in hexadecimal format. On some systems, the system command returns 
the ID in decimal format. Use a # character before the hostid to indicate a decimal number. For example, if the 
system command returns 2005771344, FlexNet Publisher accepts #2005771344. Alternatively, convert the decimal 
value to hexadecimal.


Obtaining System Hostids
The lmhostid utility prints the exact hostid that FlexNet Publisher requires on any given system. If your hostid 
contains characters other than the ASCII A through Z, a through z, or 0 through 9, use the -utf8 option with 
lmhostid. To view a correct representation of the resulting hostid, use a utility, such as Notepad, that can display 
UTF-8 encoded strings. 


lmadmin displays hostids available for the license server on the System Information tab.


Note • For the following cases, do not use the System Information tab in the lmadmin user interface to obtain 


hostids. Instead, use the methods described in the Hostid Procurement Methods table.


• When the license server is operating on a virtual machine but bound to the physical hardware—A 


limitation in lmadmin causes the System Information tab to show virtual machine values for Host Name, Host 


Domain Name, IPv4 Address, IPv6 Address, Ethernet Address, and Volume Serial Number rather than the 


physical machine values. 
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• When running license clients or a license server in an Amazon EC2 environment—At this time, the 


System Information page is unable to show hostids specific to the Amazon EC2 environment.


The following table lists some sample lmhostid and alternate methods to obtain the required hostid for each 
system architecture. FlexNet Publisher also supports a group of special hostids and vendor-defined hostids. 


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid


AIX (RS/6000, PPC) 32-bit hostid lmhostid As a best practice it is 
recommended to use lmhostid 
and that most of the time, the 
uname rule applies. 


uname -m For example, returns 
000276513100. Remove last two 
digits and use remaining last 
eight digits.


02765131


HP
(32-bit and 64-bit 
non-Itanium 
platforms)


32-bit hostid lmhostid


or


uname -i Convert returned value 
to hex, or prepend with #.


778DA450 or #2005771344


HP
(64-bit Itanium)


machine 
identification


lmhostid


or


getconf CS_PARTITION_IDENT 


Prefix returned value with 
“ID_STRING=”


ID_STRING=9c766319-
db72-d411-af62-
0060b05e4c05


Mac OS X Ethernet address lmhostid -ether 000A277EA17E


Note • This command lists all available Ethernet addresses, active or 
inactive.


/sbin/ifconfig enx


where enx is the Ethernet 
interface name (with x a value 
from 0 to 9); remove colons from 
returned value.


000A277EA17E


FlexNet ID USB 
port dongle 


lmhostid -flexid FLEXID=9-b28520b9
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Linux Ethernet address lmhostid -ether 00400516E525


Note • This command lists all available Ethernet addresses (active or 
inactive), including those for team-bonding virtual adaptors.


/sbin/ifconfig 
<ethernet_name>


where <ethernet_name> is one of 
these Ethernet interface names:


• ethx 


• Other name type (for 
example, p3p4)


• bond0 (for a team-bonding 
virtual adaptor)


Remove colons from returned 
HWaddr.


00400516E525


FlexNet ID USB 
port dongle


lmhostid -flexid FLEXID=9-b28520b9


Bare-metal 
binding for  
specific virtual 
platforms 
(lmbind installed 
directly on the 
VMware ESX or 
Hyper-V 
hypervisor)


lmhostid -ptype <virtual 
machine type> -hostname


lmhostid -ptype <virtual 
machine type> -hostdomain


lmhostid -ptype <virtual 
machine type> -internet


lmhostid -ptype <virtual 
machine type> -ether


where <virtual machine type> is  
VMW for VMware or HPV for Hyper-
V. For example, 
lmhostid -ptype HPV -ether


Only available on Hyper-V: 
lmhostid -ptype HPV -vsn


VMW_HOSTNAME=MyHost


HPV_HOSTNAME=MyHost


Note • LMB_* hostids are recommended as best-practice for bare-
metal hostids instead of these hostids. While these hostids are limited 
to working with a specific hypervisor, LMB_* hostids have the 
advantage of working for any supported hypervisor.


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid
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Linux
(continued)


General bare-
metal binding 
(lmbind installed 
directly on the 
hypervisor or on 
a remote 
physical 
machine)


lmhostid -ptype LMB -ether


lmhostid -ptype LMB -internet 


lmhostid -ptype LMB -hostname


lmhostid -ptype LMB -flexid 


LMB_ETHER=0019d22f8672


LMB_FLEXID=9-19dD22f86


Note • This hostid type supports license servers running in Amazon 
EC2, VMware, Hyper-V, or Xen environments. Additionally, dongle 
support includes LMB_FLEXID=9 and LMB_FLEXID=10 only. The 
dongle driver must be installed on the lmbind machine before you can 
obtain the hostid.


UUID 
(Universally 
Unique Identifier) 
for virtual 
machines


lmhostid -ptype <virtual 
machine type> -uuid


where <virtual machine type> is 
one of these:


• VMW for VMware (deprecated)


• HPV for Hyper-V (deprecated)


• VM for Xen, VMware, or 
Hyper-V (recommended)


For example, 
lmhostid -ptype VM -uuid


VM_UUID=DF440538-8EB7-
11DC-BBDA-FE7FE89E000F


Note • Obtaining this hostid requires that HAL (Hardware Abstraction 
Layer) subsystem 0.5.1 or later be running. (In turn, this version 
requires Linux Kernel 2.6.11 or later.) The required HAL daemon 
version ships with RHEL 5.0 or later and SUSE Linux 10 or later. If the 
HAL subsystem is not available (for example, on later Linux releases 
such as RHEL 7), the FNP Licensing service must be installed. To do 
this certificate-only customers will need to ensure “install_fnp.sh --cert” 
is run from the publisher directory with root- privilege at install time. 


Elastic IP (EIP) 
address in 
Amazon EC2 
environment


lmhostid -ptype AMZN -eip AMZN_EIP=184.72.45.35


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid
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AMI Instance ID 
in Amazon EC2 
environment


lmhostid -ptype AMZN -iid AMZN_IID=i51e04315...S
IGN=xxx


Linux
(continued)


Enforced 
physical 
machine hostid 
type


lmhostid -ptype PHY 
<hostidtype>


where <hostidtype> is one of 
these:


-ether      -string


-hostname   -display


-internet   -flexid


-user       -long


PHY_ETHER=000ffe7fe89e


Note • Unlike the LMB_* hostids, the PHY_* hostids do not require 
lmbind and force license servers to run on physical machines.


Sun 32-bit hostid lmhostid


or


hostid


170a3472


ethernet address lmhostid -ether 00400516E525


Windows Ethernet address lmhostid 00B0A9DF9A32


Note • This command lists all available Ethernet addresses (active or 
inactive), including those for team-bonding virtual adaptors.


Disk serial 
number


DIR C: (look for Volume Serial 
Number is and remove -)


DISK_SERIAL_NUM=
3e2e17fd


FlexNet ID 
parallel or USB 
port dongle


lmhostid -flexid FLEXID=9-b28520b9


Note • For parallel port dongles, the parallel port must be configured 
in bi-directional mode.


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid
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Windows
(continued)


Bare-metal 
binding on 
specific virtual 
platforms  
(lmbind installed 
directly on the 
VMware ESX or 
Hyper-V 
hypervisor)


lmhostid -ptype <virtual 
machine type> -hostname


lmhostid -ptype <virtual 
machine type> 
-hostdomain


lmhostid -ptype <virtual 
machine type> -internet


lmhostid -ptype <virtual 
machine type> -ether


where <virtual machine type> is 
VMW for VMware or HPV for Hyper-
V. For example, 
lmhostid -ptype HPV -ether


Only available on Hyper-V: 
lmhostid -ptype HPV -vsn


VMW_HOSTNAME=MyHost


HPV_HOSTNAME=MyHost


Note • LMB_* hostids are recommended as best-practice for bare-
metal hostids instead of these hostids. While these hostids are limited 
to working with a specific hypervisor, LMB_* hostids have the 
advantage of working for any supported hypervisor.


General bare-
metal binding on 
virtual platforms  
(lmbind installed 
directly on the 
hypervisor or on 
a remote 
physical 
machine)


lmhostid -ptype LMB -ether


lmhostid -ptype LMB -internet 


lmhostid -ptype LMB -hostname


lmhostid -ptype LMB -flexid


LMB_ETHER=0019d22f8672


LMB_FLEXID=9-19dD22f86


Note • This hositd type supports license servers running in Amazon 
EC2, VMware, Hyper-V, or Xen environments. Additionally, dongle 
support includes LMB_FLEXID=9 and LMB_FLEXID=10 only. The 
dongle driver must be installed on the lmbind machine before you can 
obtain the hostid.


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid
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Windows
(continued)


UUID 
(Universally 
Unique Identifier) 
for virtual 
machines


lmhostid -ptype <virtual 
machine type> -uuid


where <virtual machine type> is 
one of these:


• VMW for VMware (deprecated)


• HPV for Hyper-V (deprecated)


• VM for Xen, VMware, or 
Hyper-V (recommended)


For example, 
lmhostid -ptype VM -uuid


VM_UUID=DF440538-8EB7-
11DC-BBDA-FE7FE89E000F


Elastic IP (EIP) 
address in 
Amazon EC2 
environment


lmhostid -ptype AMZN -eip AMZN_EIP=184.72.45.35


AMI Instance ID 
in Amazon EC2 
environment


lmhostid -ptype AMZN -iid AMZN_IID=i51e04315...S
IGN=xxx


Enforced 
physical 
machine hostid 
type


lmhostid -ptype PHY 
<hostidtype>


where <hostidtype> is one of the 
following:


-ether      -string


-hostname   -display


-internet   -flexid


-user       -long


-utf8       -vsn


PHY_ETHER=000ffe7fe89e


Note • Unlike the LMB_* hostids, the PHY_* hostids do not require 
lmbind and force license servers to run on physical machines


Table 6-1 • Hostid Procurement Methods


Hardware Platform Hostid Type this command:  Example hostid
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Special Hostids
FlexNet Publisher contains a number of special hostid types that apply to all platforms. These hostid types are valid 
to use in both SERVER lines and FEATURE lines, wherever a hostid is required. 


Table 6-2 • Special Hostid Types


Hostid Description


ANY Locks the software to any system (meaning that it does not lock anything).


DEMO Similar to ANY, but only for use with uncounted FEATURE lines.


COMPOSITE=
<composite_


hostid>


Locks the software to a composite hostid. A composite hostid is a hashed 12-character 
hexadecimal value formed by combining the values of one or more simple hostids types, 
as defined by the software publisher. Note that composite hostids are not returned by 
lmhostid, LMTOOLS, or lmadmin: when composite hostids are used, the software publisher 
will provide a utility that determines the publisher’s composite hostid. On some systems 
multiple composite hostids may be provided, any of which may be used to identify the 
system that the software is locked to.


DISPLAY=
<display>


Locks the software to a display. On UNIX, <display> is /dev/ttyxx (which is always /dev/
tty when an application is run in the background) or the X-Display name. On Windows, it 
is the system name or, in the case of a terminal server environment, the terminal server 
client name (version 8 or later FlexEnabled applications only)


HOSTNAME=
<host>


Locks the software to computer host name <host>.


ID=<n> Functionally equivalent to the ANY hostid—it runs on any system. The difference is that the 
license is unique and is used to identify the end user. This hostid is used to lock the 
license server (on the SERVER line) or the FlexEnabled application (on the feature definition 
line). The number can have dashes included for readability—the dashes are ignored.


Examples:


• ID=12345678 is the same as


• ID=1234-5678 is the same as


• ID=1-2-3-4-5-6-7-8
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Examples


FEATURE f1 demo 1.0 1-jan-2013 uncounted \
HOSTID=FLEXID=9-a6300015f SIGN=”<...>”


or


FEATURE f1 demo 1.0 1-jan-2013 uncounted \
HOSTID=INTERNET=10.10.10.* SIGN=”<...>” 


Ethernet Hostids
The Ethernet address is used on some system architectures as the hostid. An ethernet address is a 6-byte quantity, 
with each byte specified as two hexadecimal digits. Specify all twelve hex digits when using an Ethernet address as 
a hostid. For example, if the ethernet address is 8:0:20:0:5:ac, specify 0800200005ac as the hostid.


Several devices with an ethernet address can be attached to a machine; some of these might be virtual devices 
that generate a different ethernet address each time they are activated. An example of a virtual device that might 
generate an ethernet address is VPN (virtual private network) software.


Some devices that have an ethernet address can be detatchable from the machine. For example, a laptop plugged 
into a docking station uses the ethernet address of the docking station; however, when it is disconnected from the 
docking station, the ethernet address is no longer available. A wireless adapter also has an ethernet address and 
this address is not available when either the wireless adapter is removed from the machine or when the wireless 
adapter is disabled, but still physically attached to the machine.


When lmhostid returns multiple ethernet hostids, ensure that you choose a permanent or stable hostid to identify 
your machine.


INTERNET=
<IP_address(es)>


Locks the software to an Internet IP address, or group of IP addresses. Wildcards are 
allowed. For example, 198.156.*.* means any host with a matching internet IP address. 
The main use is to limit usage access by subnet, implying geographic area. For this 
purpose, it is used on the feature definition line as a hostid lock. 


For more information about obtaining this hostid, see the -internet option for lmhostid.


Note • (Windows only) If a Windows machine is connected to a VPN, lmhostid -internet returns 
the virtual adapter IP address. To ensure that this command returns the physical adaptor IP address 
during checkouts, the user needs to perform this workaround: Run regedit, navigate to 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\Tcpip\Linkage, locate the 
Bind parameter, and edit the adapter order so that the physical adapter is listed first. Run ipconfig/
registerdns to put the edit into effect.


USER=<user> Locks the software to user name <user>. User names specified in license files cannot 
contain spaces.


Table 6-2 • Special Hostid Types


Hostid Description

License Administration Guide FNP-11121-LAG00 57







Chapter 6: Hostids for Supported Platforms
Hostids to Support Virtualization Policy

Note • FlexNet Publisher considers the address of any team-bonding virtual adaptor (for teamed Ethernet 


interfaces) as a stable identifier for use as a permanent hostid. 


Hostids to Support Virtualization Policy
Your software publisher may choose to enforce a virtualization support policy using the special hostid constructs in 
the license file. Depending on the policy, the FlexNet publisher license server might be limited to running only on 
physical machines or only on virtual machines from specific vendors or might have no enforcement at all regarding 
virtual machine platforms. When the bare metal binding technology is used, an additional binding agent 
component (lmbind) is needed to run on either the console operating system (COS) of the virtual machine 
environment or on a remote physical machine connected to the virtual machine via the lmbind communication 
protocol.


Hostids to Support Cloud Licensing
The hostids listed in this chapter for the Amazon EC2 environment support typical use cases for licensing software 
in a cloud. For a description of these use cases and the hostids, see Chapter 16, “Licensing in a Cloud-Computing 
Environment”.
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License Models

License rights are created by the software publisher. License rights specify floating (concurrent) usage, node-
locked (both counted and uncounted), or any combination of floating, counted, and uncounted.


Floating (Concurrent) Licenses
A floating license means anyone on the network can use the FlexEnabled application, up to the limit specified in 
the license file or fulfillment record (also referred to as concurrent usage or network licensing). Floating licenses 
have no hostids on the individual FEATURE lines. Floating licenses requires a license server manager and a vendor 
daemon to be running to count the concurrent usage of the licenses.


An example of a license file that provides floating licenses is:


SERVER lulu 17007ea8 
VENDOR sampled 
FEATURE f1 sampled 1.00 1-jan-2013 2 SIGN=”<...>”
FEATURE f2 sampled 1.00 1-jan-2013 6 SIGN=”<...>”
FEATURE f3 sampled 1.00 1-jan-2013 1 SIGN=”<...>”


This license file specifies that two licenses for feature f1, six licenses for feature f2, and one license for feature f3 
are available anywhere on the network that can access the license server, called lulu. The license server manager 
uses one of the default TCP/IP ports.


The equivalent floating licenses are held in trusted storage as a fulfillment record that contains the same FEATURE 
lines as in the license file without any SERVER or VENDOR lines.
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Node-Locked Licenses Using Hostid
This section describes node-locked licenses using a hostid. Licenses held in trusted storage are node-locked 
because trusted storage is locked to a machine, see Locking of Licenses Using Hostid or Trusted Storage for an 
explanation.


Node-locking means the FlexEnabled application can be used on one system or a set of systems only. A node-
locked license has a hostid on the FEATURE line that identifies a specific host. There are two types of node-locked 
licenses: uncounted and counted.


If the number of licenses value is set to either zero (0) or uncounted, then the license will not be counted which 
allows the license to be used an unlimited number of times. This configuration does not require a license server 
because it is not necessary to count the concurrent usage of the features.


The following license file allows unlimited usage of feature f1 on the systems with hostids of 17007ea8 and 
1700ab12:


FEATURE f1 sampled 1.000 1-jan-2013 uncounted HOSTID=17007ea8 SIGN=”<...>” 
FEATURE f1 sampled 1.000 1-jan-2013 uncounted HOSTID=1700ab12 SIGN=”<...>” 


Alternately, these two FEATURE lines could have been issued by your software publisher with a hostid list:


FEATURE f1 sampled 1.000 1-jan-2013 uncounted HOSTID="17007ea8 1700ab12” SIGN=”<...>” 


If these were the only FEATURE lines in this license file, neither the license server manager or vendor daemon are 
necessary and you do not need to start one. 


The following license file provides three licenses for feature f1, locked to the system with hostid 1300ab43. Since 
the license server and licenses are locked to the same system, the daemons run on the same system that runs the 
FlexEnabled application.


SERVER lulu 1300ab43 1700
VENDOR sampled /etc/sampled
FEATURE f1 sampled 1.00 1-jan-2013 3 HOSTID=1300ab43 SIGN=”<...>”


Mixed Node-Locked and Floating Licenses
Uncounted node-locked and concurrent usage licenses can be mixed in the same license file. 


The following license file allows unlimited use of feature f1 on systems 17007ea8 and 1700ab12, while allowing 
two other licenses for feature f1 to be used anywhere else on the network:


SERVER lulu 17001234 1700
VENDOR sampled C:\flexlm\sampled.exe
FEATURE f1 sampled 1.00 1-jan-2005 uncounted HOSTID=17007ea8 SIGN=”<...>” 
FEATURE f1 sampled 1.00 1-jan-2005 uncounted HOSTID=1700ab12 SIGN=”<...>” 
FEATURE f1 sampled 1.00 1-jan-2005 2 SIGN=”<...>” 


This configuration requires a license server manager and vendor daemon because the licenses on the third 
FEATURE line are counted.
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Counted vs. Uncounted Licenses
 The license model (as defined in the license file on the end user machine) determines whether a license server is 
needed. If all feature definition lines have a license count set to either zero (0) or uncounted, then the customer 
does not need a license server. This type of license is called uncounted. Alternatively, if any features have a non-
zero license count, then the customer needs a license server to count those licenses. If a software publisher wants 
to use FlexNet Publisher without a license server, they must issue uncounted licenses.


The license server can serve uncounted licenses also. This is often done so that:


• Transactions can be logged into the report log for all license requests, which can then be reported on by 
FlexNet Manager


• Options file constraints can be applied to the licenses


To have uncounted licenses served, include a SERVER line in the license file, and put the USE_SERVER line 
immediately after the SERVER line. The vendor daemon serves the uncounted licenses, and the USE_SERVER line 
indicates to applications that requests must go to the license server for authorization.


Mobile Licensing
End users often want to use applications on computers that do not have a continuous connection to a license 
server. These situations include:


• Working on a laptop


• Using a computer both at work and at home


• Working from several different computers not connected to a license server


FlexNet Publisher supports licenses that allow one of several kinds of mobile licensing:


• Node-locked to a laptop 


• Node-locked to a FlexNet ID dongle


• Node-locked to a FlexNet ID dongle with FLOAT_OK keyword 


• License borrowing with BORROW keyword 


• Node-locked to a user name


• Fulfilled from a prepaid license pool


• Optionally when provided by the publisher, Distribution of Node-Locked Licenses to Networked Machines 
using trusted storage can be used.


You should use license rehosting if an enterprise wants to move a license without using one of these methods. The 
software publisher must generate a new node-locked license file for each new client computer. Rehosting requires 
administrative overhead because the software publisher must be involved with each move. 
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Node-Locked to a Laptop Computer
 To use a license exclusively on one laptop computer, the license should be node-locked to that computer. When 
the license is held in a license file, it resides on the laptop computer. Any license held in trusted storage on a laptop 
computer is node-locked to the laptop.


Node-locked to a FlexNet ID Dongle
To move a license between different systems, it can be locked to a FlexNet ID dongle (a dongle that connects to a 
parallel or USB port). You can move this license between systems by installing a copy of the license file with a 
hostid set to the FLEXid of the dongle on each system and moving the dongle from one system to another. Since 
the license is tied to the dongle, only the system with the dongle can use the license.


FlexNet ID dongles are made available by your software publisher. Your software publisher can also provide you 
with an installer that installs drivers for all FlexNet ID dongles.


Node-Locked to a FlexNet ID Dongle with FLOAT_OK
Because the hostid of the dongle (the FLEXID) defines the license server and the license floats on the network, this 
method has an advantage over simply using a license locked to a FLEXID. 


The software publisher issues you a dongle; a license file with a FEATURE line node-locked to the FLEXID of the 
dongle and that contains the FLOAT_OK keyword. One dongle and FEATURE line containing the FLOAT_OK 
keyword is needed for each instance of a license that is mobile. When the dongle is attached to a license server, 
the license floats on the network. When the dongle is removed from the license server, the license is available only 
on the standalone computer. 


This method supports parallel or USB dongles. Because it is simpler to attach multiple USB dongles to a computer, 
they may be preferable.


Using a FlexNet ID Dongle for Mobile Licensing Using a FLOAT_OK 
License


The software publisher provides a dongle, a dongle driver installer, and a license file that contains a FEATURE line 
node-locked to the FLEXID containing the FLOAT_OK keyword. A license administrator then:


1. Installs the license file on the license server.


2. Installs the FlexNet ID dongle driver on the license server. 


3. Attaches the dongle to the license server. 


4. Starts the license server or rereads the license file 


While the dongle is attached to the license server, the node-locked license associated with it floats on the network. 
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Task: To transfer a license from the pool of floating licenses to a disconnected computer:


1. Copy the license file containing the FLOAT_OK node-locked FEATURE line from the license file on the license 
server to a license file on the client in the location where the FlexEnabled application expects to find its license 
file. 


2. Install the dongle driver on the client computer, if it is not already installed.


3. Move the dongle matching the node-locked FEATURE line from the license server to the client. When the 
dongle is removed from the license server, this license is unavailable on the network. 


4. Disconnect the client computer from the network. Now the license is available on the computer with the 
dongle, even though that computer is disconnected from the network. 


Task: To return the license to the license server so it floats on the network again:


1. Remove the dongle from the client and replace it on the license server.


2. Reread the license file for the license server that serves the floating version of the license by running lmreread. 


When the dongle is returned to the license server, the FLOAT_OK license does not float on the network again 
until lmreread is run. 


FLEXID with FLOAT_OK Example


The following is a sample license file. It is shipped with two dongles: FLEXID=9-34efc1d8 and FLEXID=9-30eb7ff6.


SERVER myhost ANY
VENDOR sampled
FEATURE f1 sampled 1.0 permanent uncounted FLOAT_OK \


HOSTID=FLEXID=9-34efc1d8 SIGN=”<...>”
FEATURE f1 sampled 1.0 permanent uncounted FLOAT_OK \


HOSTID=FLEXID=9-30eb7ff6 SIGN=”<...>”


The user installs the license file and the two dongles on the license server. When attached to the license server, 
each uncounted FLOAT_OK license floats on the network and allows a single use. Therefore, up to two users can 
use f1 on the end user’s network, except on the license server itself, where the license use is disallowed. 


If a user wants to work at home, the user installs a license file that contains the FEATURE line node-locked to 
FLEXID=9-34efc1d8 (this only needs to be done once), transfers the dongle with FLEXID=9-34efc1d8 from the 
license server to the client, and installs the dongle driver on the client computer (this also only needs to be done 
once). The user disconnects the client computer from the network and uses the transferred FLOAT_OK license on 
the client computer. The license server allows only the single remaining FLOAT_OK license to float on the network.


After returning the dongle to the license server, the license administrator runs lmreread so the returned license can 
float again.
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Note • FLOAT_OK keyword introduced in version 8.0 client library, license server manager, and vendor daemon. All 


components must be version 8.0 or later in order to use FLOAT_OK.


License Borrowing with BORROW
This method of implementing mobile licensing is used only when license rights are held in license files.


If a license is to be used on a computer that is intermittently connected to a license server, that license can be 
issued as a floating license with the BORROW keyword. A BORROW license can be borrowed from a license server 
via a special checkout and used later to run an application on a computer that is no longer connected to the 
license server. License borrowing must be enabled by a software publisher before a user can borrow licenses.


With license borrowing, a software publisher issues a floating license with a FEATURE line that contains the 
BORROW keyword. A user specifies the expiration date a borrowed license is to be returned and runs the 
application while connected to the network which writes borrowing information on the client computer. The license 
server keeps the borrowed license checked out. The FlexEnabled application automatically uses the local 
borrowing data to do checkouts during the borrow period. If enabled by the software publisher, borrowed licenses 
can be returned early, that is, before the borrow period expires. Upon the earlier of either the expiration of the 
borrow period or the early return of a borrowed license, the local borrowing data no longer authorizes checkouts 
and the license server returns the borrowed license to the pool of available licenses. No clock synchronization is 
required between the license server and the system running the FlexEnabled application. 


Initiating License Borrowing 


If a software publisher has enabled license borrowing by issuing a license file that contains a FEATURE line with 
the BORROW keyword, an user initiates license borrowing in one of three ways:


• Using the borrowing interface in application, if provided in the application


• Running the lmborrow utility to set LM_BORROW 


• Setting the LM_BORROW environment variable directly 


Application Interface


The user initiates license borrowing this way only if the application provides a borrowing interface. Information 
about this is supplied by the software publisher. 

64 FNP-11121-LAG00 License Administration Guide







Chapter 7: License Models
Mobile Licensing

Running the lmborrow Utility


lmborrow is one of the lmutil/lmtools utilities. To initiate borrowing, the user runs lmborrow from the command 
line or through lmtools:


lmborrow {vendor|all} enddate [time]


where vendor is the vendor daemon that serves the licenses to be borrowed, or all specifies all vendor daemons 
in the license server. enddate is the date the license is to be returned in dd-mmm-yyyy format. time is optional and is 
specified in 24-hour format (hh:mm) in the FlexEnabled application’s local time. If time is unspecified, the checkout 
lasts until the end of the given end date. 


For example:


lmborrow sampled 20-aug-2007 13:00


Setting the LM_BORROW Environment Variable Directly


The lmborrow utility is a user interface to set LM_BORROW in either the registry (Windows) or in $HOME/
.flexlmborrow (UNIX). LM_BORROW can also be set directly as an environment variable: 


today:{vendor|all}:enddate[:time]


where:


For example:


LM_BORROW=15-aug-2013:sampled:20-aug-2013:13:00


In this example, one or more licenses served by the sampled vendor daemon are borrowed on August 15, 2013, 
and are scheduled to be returned at 1 P.M. on August 20, 2013. 


Table 7-1 • LM_BORROW Environment Variable Arguments


Argument Description


today Today’s date in dd-mmm-yyyy format. Any checkouts done on this date create local 
borrow information. If a checkout is done on a different date than this date, no local 
borrowing information is created. 


vendor Vendor daemon that serves the licenses to be borrowed, or all specifies all vendor 
daemons in the license server.


enddate Date the license is to be returned in dd-mmm-yyyy format.


time Optional. time is specified in 24-hour format (hh:mm) in the FlexEnabled 
application’s local time. If time is unspecified, the checkout lasts until the end of the 
given end date.
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Borrowing a License
To borrow a license for a desired feature, on the same day and the same system that the user runs lmborrow or 
sets LM_BORROW (and while still connected to the network), the user runs the application to check out and borrow 
the license. If the user runs the application more than once that day, no duplicate license is borrowed. No license is 
borrowed if the application is run on a day different than the date borrowing was set to be initiated.


For example, say that today you want to borrow a license for the PageWizard feature for a week. The PageWizard 
feature is served by the sampled vendor daemon. Today, while you are connected to the network, run lmborrow or 
set LM_BORROW directly. For example:


lmborrow sampled enddate 


Today, after you run lmborrow, while you are connected to the network, run the application that checks out a license 
for the PageWizard feature. After the license is checked out, close the application and disconnect your system from 
the network. The license that you just checked out stays checked out from the license server until the borrow 
period expires—that license now is used on your disconnected system until the borrow period expires. Once 
checked out, it remains checked out for the full borrow period. The borrow period cannot be renewed until the 
period has expired.


Clearing the Borrow Period
Once you have borrowed all the licenses that you need for the current borrow period (defined by the LM_BORROW 
environment variable), prevent licenses for any additional features from being borrowed by running lmborrow -


clear. This clears the LM_BORROW setting in the registry (Windows) or $HOME/.flexlmborrow (UNIX). lmborrow -
clear does not clear the local information about licenses you have already borrowed. 


Checking Borrow Status


Task: To print information about borrowed features:


1. Issue the following command on the system from which they are borrowed:


lmborrow -status


The system that borrowed the features does not have to be connected to the network to determine the status.
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Returning a Borrowed License Early


Task: To return a borrowed license before the borrow period expires:


1. Reconnect the borrowing system back to the network.


2. From the same system that initiated the borrowing, issue the command:


lmborrow -return [-c license_file_list] feature


This option may or may not be allowed by your software publisher. Check directly with your software publisher to 
determine if they support borrowed licenses being returned early.


Support for License Borrowing
See the following sections for more information about the utilities and keywords in the options file that support 
license borrowing:


• lmborrow utility


• lmdown utility


• lmstat utility


• BORROW_LOWWATER keyword


• EXCLUDE_BORROW keyword


• INCLUDE_BORROW keyword


Note • BORROW keyword introduced in version 8.0 client library, license server manager, and vendor daemon. All 


components must be version 8.0 or later in order to use BORROW.


Node-locked to a User Name
This method of implementing mobile licensing is used only when license rights are held in license files.


If a license is to be used exclusively by one user on different systems, that license can be node-locked to the user’s 
user name. The license file is copied to the different systems on which the user might work; the user’s user name 
must be identical on each system. For this method to be useful, individual user names in an organization must be 
unique. Note that a user name, when used in a license file in this way, cannot contain spaces. 
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Fulfilled from a Prepaid License Pool
In this method, the user buys a prepaid number of license-days from the software publisher. The user can then 
fulfill a license using a partial amount of the total license-days for the given borrow period, node-locked to a 
particular system. For example, in preparation for a business trip (or even during a business trip), the user fulfills a 
license that expires in five days that is node-locked to their laptop. Each fulfillment can be node-locked to a 
different system (or even multiple times to the same system), thus allowing mobility of license usage within the pre-
paid number of license-days.


This model is like pay-per-use because each fulfillment is made from a decreasing number of license-days. It is 
different than other pay-per-use models because, once node-locked to a system, that system is allowed unlimited 
use of the application until the license expires. This short-term license cannot be returned early; once fulfilled, 
those license-days cannot be refunded. Other pay-per-use models charge based on the number of times the 
application is used.
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Selecting a License Server Machine

When selecting a machine on which to install a license server, select a stable system; do not choose systems that 
are frequently rebooted or shut down. Normally, it is not required that each system be the same architecture or 
operating system as other license servers or the client machines on which the FlexEnabled applications are 
running.


The following sections discuss the resources used by the license server. When you select a machine on which to 
install a license server, you may need to consider whether it has sufficient resources. For small numbers of licenses 
(under about 100), most of these system limits are not a problem on any workstation.


License Server Sockets
When using TCP/IP ports, each FlexEnabled application connected to a license server uses one or more sockets. 
Depending on how the publisher implemented licensing, the FlexEnabled application may need one or more 
sockets. Ask the publisher for this information. The per-process system limit for file descriptors determines the 
number of sockets available to the license server. The total number of sockets that the license server uses is 
slightly larger than the total number needed by the FlexEnabled applications that connect to it.


If the number of sockets required by the license server on a single system becomes excessive, then one solution is 
to run multiple license servers and split the licenses between them. This reduces the networking traffic to each 
license servers Redundancy Using the License Search Path for instructions and information about this 
configuration. Your publisher will need to agree to issue new license files, if you want to move licenses from an 
existing license server. If the licenses are held in trusted storage, the publisher may provide an automated process 
for returning them and activating them on another license server.
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License Server CPU Time
For small numbers of clients, the license servers use very little CPU time. The servers might have consumed only a 
few seconds of CPU time after many days.


For a large number of clients (where each are exchanging heartbeat messages with the license server), or for high 
checkout and checkin activity levels (hundreds per second), the amount of CPU time consumed by the server may 
start to become significant; although, even here, CPU usage is normally not high. In this case, you may need to 
ensure that the system you select has enough CPU cycles to spare.


License Server Disk Space
The only output files created by the license servers are the debug and report log files. FlexNet Manager, Flexera 
Software’s Web-based software license management system, uses the report log files to generate accurate usage 
reports. If there is a lot of license activity, these log files grow very large. You need to consider where to put these 
files and how often to rotate and archive them. You have the option to suppress log file output if disk space is at a 
premium. 


It is recommended that the log files are local files on the server systems to avoid networking dependencies.


See Also
Report Log File
Debug Log File


License Server Memory
The license server uses little memory. The vendor daemons use approximately 2 MB each, although memory 
usage increases in the vendor daemon with the number of concurrent licenses, size of the options file, and the 
number of concurrent users. lmadmin, uses between 7 and 10 MB of memory during typical usage.Typically, the 
command-line license server manager, lmgrd, uses approximately 2 MB.


Network Bandwidth for License Server
FlexNet Publisher sends relatively small amounts of data across the network. Each transaction, such as a checkout 
or checkin of a license, generally transfers less than 1 KB of data. This means that FlexNet Publisher can be 
effectively run over slow networks (such as dial-up SLIP lines) for small numbers of clients.


For a large number of FlexEnabled applications (hundreds), each of which exchange heartbeat messages with the 
vendor daemon, the network bandwidth used may become significant. In this case, run the FlexEnabled 
application and server on the same local area network, and run multiple license servers if required. Users can use 
a license search path in the LM_LICENSE_FILE environment variable to have effective access to both servers. 
Enterprises can experience a performance issue when there is slow network communication or if FlexEnabled 
clients are using a dial-up link to connect to the network.
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When you are using lmadmin, which uses HTTP, you need to consider the clients that connect to the lmadmin user 
interface. Depending on the number of clients and the frequency of the page refresh, they can impose a significant 
burden on network traffic.


License Server Locally Mounted Disks
It is recommended that you do not use remote mounted disks when you run the license server. In other words, it is 
recommended that lmadmin or lmgrd, the vendor daemons, the license file, and the debug and report log files are 
all on locally mounted disks. If any of these files are on a remote mounted disk, this doubles the points of failure, 
which could lead to a temporary loss of all of your licenses. When all files are mounted locally, the licenses are 
available as long as the server is running. When the files are on a different system, licenses may become 
unavailable if the license server or file server fails.


License Server Port
It is recommended that a specific port is designated on the license server machine to be used only by license 
server components. The benefits of this are that it is:


• Easy to track processes by the port that they are run on.


• Easier to configure FlexEnabled clients to access the license server.


• Easier to manage license server components in an environment where a firewall and/ or antivirus software is in 
use.


• Useful in preventing port conflicts and the hijacking of the port by other processes.


To configure the license server port:


Using lmgrd - Specify it in the license file used to start the license server; see Configuring the Port Used by the 
License Server.


Using lmadmin - Configure the license server manager port either:


• Using the lmadmin user interface. See the online help for information.


• Using the lmadmin -licport command. For information about the -licport argument, see lmadmin Command-
line Arguments.
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Running the License Server on a Virtual 
Machine


If you plan to run the license server on a virtual machine, your software publisher may ask you to utilize a bare-
metal hostid. If so, you will be required to run the binding agent (lmbind) on the console of the virtual machine. For 
more information on lmbind, see Chapter 15, “Managing Virtualized License Servers for File-Based Licensing”. 


Running the License Server in a Cloud
Operating in a public or virtual private cloud in an Amazon EC2 environment, you can run the license server on an 
AMI instance and then deploy instances of the FlexEnabled application as one or more license clients in the cloud, 
in your enterprise network, or in both, with all clients pointing to the license server in the cloud. 


In a public cloud, you can run lmhostid directly on the AMI instance containing the license server to obtain the 
hostid needed to bind the license. However, in a virtual private cloud, your software publisher might require a bare-
metal-binding hostid. If so, you can easily run the binding agent (lmbind) on a physical machine in your enterprise 
data center and extract the hostid from this machine. For more information about these use cases and the required 
hostids, see Chapter 16, “Licensing in a Cloud-Computing Environment”.

72 FNP-11121-LAG00 License Administration Guide







9


lmadmin License Server Manager 

The license server manager is one of the components that makes up a license server (the other being the vendor 
daemon). It handles the initial contact with FlexEnabled applications, passing the connection on to the appropriate 
vendor daemon. The purpose of the license server manager is to:


• Start and maintain vendor daemons as required for serving license rights from different software publishers. 


• Refer application checkout (or other) requests to the correct vendor daemon.


There are two versions of the license server manager:


• lmadmin—The Web-based license server manager


• lmgrd—The original license server manager with a command-line interface


This section describes lmadmin. For information about lmgrd, see lmgrd - License Server Manager.


lmadmin provides improved methods of managing the license server and vendor daemons. A brief description of 
the improved capabilities follows. For a more detailed comparison of lmgrd and lmadmin, see Migrating from lmgrd 
to lmadmin.


lmadmin Capabilities


• Direct configuration of the vendor daemons and license server manager—License-server port 
number, vendor-daemon path and port, and three-server redundant port can be configured without any edits 
to the license files.


• Configurable alerts—You can set up lmadmin to issue alerts to warn you of potential problems (for example, 
license expiry, no available licenses, or vendor daemon status).


• License rights status display—The lmadmin user interface provides a display of all available and in-use 
license rights. This display can include all concurrent (floating) licenses both from license files and from 
trusted storage. It can also include activatable and hybrid licenses (held in trusted storage) when these are 
available on the license server.
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• Command-line functions accessed by option buttons—For example, the Stop Server and Reread 
License Files buttons perform the same actions as the lmdown and lmreread functions, respectively. For a list 
of license administration functions that are available directly from lmadmin, see lmadmin License 
Administration Functions.


• Minimal editing of license files—Option file specification requires editing.


This release of lmadmin is available for use on a limited number of platforms. For full details, contact your software 
publisher or see the Flexera Software download site. lmadmin is compatible with licensing components from 
version 9.2 or later. See Version Compatibility Between Components for detailed information on how to determine 
what versions of the licensing components are provided in your licensed applications.


Downloading and Installing lmadmin License 
Server


This section contains instructions for downloading and installing lmadmin.


System Requirements for lmadmin
You can run lmadmin on the following platforms:


Platform Architecture Processor Type Operating System


AIX 32-bit PowerPC AIX 6.1 and 7.1


AIX 64-bit PowerPC AIX 6.1 and 7.1


Linux 32-bit • x86 Certified with the following:


• RedHat Enterprise Linux 5 and 6


• SUSE Linux Enterprise 9, 10, 11


Linux 64-bit • x86-64 Certified with the following:


• RedHat Enterprise Linux 5 and 6


• SUSE Linux Enterprise 9, 10, 11


Microsoft Windows 
32-bit


x86 • Windows 8


• Windows Server 2012


• Windows Server 2008


• Windows 7 (Ultimate)


• Windows Vista (Ultimate)
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lmadmin is supported on the following Web browsers:


• On RedHat Linux, Mozilla Firefox 10


• On Windows, Microsoft Internet Explorer 8 and 9


• On Mac OS X, Apple Safari 5.0 and 5.2


Note • For 64-bit platforms, use the 32- bit lmadmin installers provided in the lmadmin folder of the toolkits


Additional Installation Requirements
Note the following additional requirements:


• On Linux platforms, do not install lmadmin under Root directories or run lmadmin as Root.


• To use lmadmin on Windows platforms, the Microsoft Visual C++ 2008 SP1 Redistributable Package (x86) 
must be installed. You have the option to install this package during the FlexNet Publisher License Server 
Installer process.


Using the License Server Installer
Download the FlexNet Publisher lmadmin installer from Flexera Software’s website; or, if the software publisher has 
provided their own lmadmin installation program, locate that program. If you have an existing installation of the 
lmadmin license server, see Upgrading lmadmin for instructions. This section describes how to install the license 
server for the first time. 


Microsoft Windows 
64-bit


x64 • Windows 8


• Windows Server 2012


• Windows Server 2008


• Windows 7 (Ultimate)


• Windows Vista (Ultimate)


Mac OS 32-bit x86 Mac OS X 10.5, 10.6, 10.7, and 10.8


Mac OS 64-bit x64 Mac OS X 10.5, 10.6, 10.7, and 10.8


Solaris 32-bit • x86


• SPARC 32-bit


Solaris 10 and 11


Solaris 64-bit • x64 


• SPARC 64-bit


• Solaris 10 and 11 (on SPARC 64)


• Solaris 10 (on x64)


Platform Architecture Processor Type Operating System
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Note • The FlexNet Publisher License Server Installer requires Java Runtime Environment 1.5 or later. Except 


for Mac OS, lmadmin installer does not require Java 1.5 or greater versions to be installed for all tier1 platforms 


as lmadmin installer is now bundled with Jre1.7. 


Whether running the FlexNet Publisher lmadmin installer or the software publisher’s version of the lmadmin installer, 
accept the default settings whenever possible. If you are given the option to modify installation settings, keep the 
following information in mind. (This information refers mainly to windows and options in the FlexNet Publisher 
lmadmin installer, but you can apply the information to the software publisher’s installation program as well.)


• Choose Install Folder window—Do not install the lmadmin license server in the same folder as an existing 
FlexNet Publisher installation.


• Service Configuration window—While it is possible to manually start and stop the lmadmin license server 
manager, it is recommended that you install it as an operating system service so that it will automatically start 
whenever the operating system restarts. The installer will set up the service for you on Windows. For UNIX or 
Mac, see Installing lmadmin License Server Manager as an Operating System Service for more details.


• Windows Active Directory domain user or group prompt—During installation on a Windows machine, 
the installer might prompt you to pre-designate an Active Directory domain user or group name to be used to 
sign into the lmadmin user interface. (Providing this information is optional.) If you specify a domain user name, 
administrators can sign in using this user name and its associated password as defined in Active Directory. If 
you specify a domain group name, administrators can sign in using the name and password of any domain 
user belonging to the specified group. (Designating a domain group is helpful in a large enterprise where you 
might have several license administrators who need access to the interface.) Once lmadmin is installed, you 
can use its interface to set up additional domain users or groups for sign-in. 


Note • The lmadmin installer of certain software publishers might provide this option to pre-designate an 


Active Directory user or group for sign-in. However, the FlexNet Publisher lmadmin installer that you download 


from the Flexera Software website does not offer this option.


• Start the Server window—It is recommended that you select Start server now. If the server is started 
successfully, the License Server Manager Interface is displayed. Typical output is shown in the following figure 
(although you might have to sign in initially, depending on whether this page is password-protected). If the 
server is not started successfully, see License Server Manager Not Starting for instructions.
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After installing lmadmin with the default configuration, you can configure the location where it stores the license files 
it uses. See Configuring the License File Upload Directory for details.


Running the Installer in Console Mode


On AIX, Linux, Solaris, or Windows platforms, you can run the FlexNet Publisher lmadmin installer in console mode. 
This mode enables you to install lmadmin from the command line, providing an alternative to the user-interface-
based method.


Use the following command to run the installer in console mode:


<lmadmin_installer> -i console


where <lmadmin_installer> is the name of the lmadmin installation program.


The console installation process prompts you for information needed to complete the installation.
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License Server Directory Structure
After installing the lmadmin license server, you will see the following files and directories. Do not edit the contents of 
any file or directory except where explicitly instructed to by this License Administration Guide, or by other supplied 
licensing documentation.  


Upgrading lmadmin
Before installing a new version of lmadmin:


• If you have configured lmadmin as a system service, shut down the service.


• Shut down any lmadmin processes running on the system.


The lmadmin installer provides the option Import files from Previous Installation. This option allows you to 
upgrade lmadmin while retaining a previous lmadmin configuration. The installer does not allow you to install 
lmadmin over an existing installation.


Table 9-1 • Directories Used by the License Server Manager


Directory Description of Contents


<lmadmin_install_dir> The installation folder that you specified when installing lmadmin, often referred to 
in this documentation as the installation root directory. Configuration paths are 
usually specified relative to this directory location. This directory contains lmadmin 
(lmadmin.exe on Windows), the license server executable.


/cache System directory that is created after you start any vendor daemon using the 
license server management interface.


/conf Contains the system files that define the license server configuration.


/demo Contains sample license files and the demo vendor daemon.


/eventlog Exists on Window systems only and includes the files needed to allow the license 
server to record messages to the Windows event log.


/examples Contains code samples that show how to build capabilities using the Web 
services.


/logs Contains the application log files. This directory is created after the license server 
is started for the first time.


/web Contains the license server management interface.


/wsdl Contains the WSDL file that you can use to generate a client proxy for the Web 
services.
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The following files and folders are imported from an existing lmadmin installation:


• lmadmin configuration data—Permanent lmadmin settings that were configured either via the license server 
management interface or via the command-line. For example, these setting include the license server port 
number; vendor daemon path and port; three-server redundant port; and the maximum size of a file import. 
These and other configuration data are held in the file server.xml which is imported to the conf directory.


• Vendor daemon files and license files—The vendor daemon executable, the license file used to start the 
vendor daemon, and additional license files imported via the license server management interface after the 
initial import of a vendor daemon. A copy of the directory structure is created and these files are imported.


• Log files—The log file (<vendor>.log) for each vendor daemon.


Note • Only files held in the lmadmin installation root directory or its sub-directories are imported. 


This section describes the upgrade procedure when you are installing the latest version of lmadmin and want to 
import files from a previous lmadmin installation. To determine which version of lmadmin you are using, see 


Release Version value displayed on the System Information page.


Task: To upgrade an existing lmadmin installation


1. Run the lmadmin installer.


2. In Choose Install Folder set the installation root directory. Ensure that this is not a sub-directory of the 
existing installation.


3. In Import files from Previous Installation enter the path to the installation root directory of the lmadmin 
installation that you want to import and check Yes Import.


4. If you have configured the license server manager port, in Launch Configuration enter the License Server 
Port Number. (See License Server Manager Not Starting.)


5. If you have configured the TCP/IP port that the Web server uses to listen for communication with clients 
connecting to the license server management interface, in Launch Configuration enter the HTTP Port 
Number. (See License Server Manager Not Starting.)


6. Complete the remaining installation dialogs.


Note • Note the following when upgrading lmadmin:


• The lmadmin installer imports an existing vendor daemon and its associated files only when the license file used 


to import the vendor daemon contains the license file path as a relative path on its VENDOR line.


• If a vendor daemon uses trusted storage, you must manually copy the activation library, <vendor>_libFNP.*, 


from the existing installation to the new installation.


• Any existing demo vendor daemon and associated license files and log files are not imported. The installer 


always installs an up-to-date version of the demo vendor daemon and the files required to run it.
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Using lmadmin


Manually Starting the License Server Manager
You can start the license server using one of the following methods: 


• On Windows platforms, open the installation directory in Windows Explorer and then double-click the 
lmadmin.exe file. This mechanism does not allow you to specify non-default command-line arguments.


• Execute the lmadmin command from the root installation directory. To see a list of available command-line 
arguments, execute the command:


lmadmin -help


The help display identifies the default arguments and which arguments are persistent, options that will remain 
in effect for later instances of lmadmin.


• Create a shell script file (UNIX) or a batch file (Windows) that will run the lmadmin command with your desired 
command-line arguments and then execute that file.


Note • If either the default license server port or the HTTP port for the user interface is in use, the license server 


manager will not start. For instructions see License Server Manager Not Starting.


License Server Manager Not Starting


The license server manager will not start if either of the following ports are in use:


• Default license server port (no ports in range 27000 to 27009 available)


• Default HTTP port for the license server manager user interface (port 8090)


Task: To check for this error and correct it:


1. Run lmadmin from the command line using the -foreground argument:


lmadmin -foreground


2. Examine the output at the command prompt. The following shows typical output when there is a clash on the 
HTTP port:


<OS 10048>Only one usage of each socket address <protocol/network address/port> is normally 
permitted. : make_sock: could not bind to address 0.0.0.0:8090 no listening sockets available, 
shutting down
Unable to open logs
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3. Reconfigure any port where there is a clash:


• Use the -licPort argument for the license server port.


• Use the -webPort argument for the HTTP port. 


For example, the following command reconfigures the HTTP port to 8091:


lmadmin -webPort 8091


When you have reconfigured the HTTP port, you access the license server management interface using the 
new port number. So for lmadmin -webPort 8091, connect to the URL, http://<server>:8090. 


Manually Stopping the License Server Manager
The allowStopServer command-line argument toggles the presence of the Stop Server button in the lmadmin 
user interface. The default is the Stop Server button is present. Click the Stop Server button in the Administration 
section of the license server management interface to shut down the license server manager (lmadmin) and all 
vendor daemons.


If lmadmin is started with the command-line argument -allowStopServer no, or if -allowStopServer no was the 
most recent use of the -allowStopServer argument, you cannot stop the license server using the license server 
management interface. In this situation, to stop the license server you must stop the lmadmin process.


On UNIX systems, you can use the ps utility to identify the process and the kill command to terminate it. 


Caution • Do not use kill -9, use only kill with its default signal; otherwise, the license server will not shut down 


cleanly.


 On Windows systems, you can use the Task Manager to identify the lmadmin.exe process and stop it.


You cannot restart the license server from the management interface. You must restart the license server as 
described in the previous section.


Accessing the License Server Management Interface
The license server management interface has two modes of operation—Standard mode and Section 508 mode. 
Either mode is accessible from a supported Web browser. See System Requirements for lmadmin for a list of 
supported Web browsers.


1. Make sure that you have started the license server.


2. Open the Web browser and browse to one of the following URLs:


• Standard mode—This is the standard license server management interface:


http://<server>:8090


where <server> is the system name where the license server is running.
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• Section 508 mode—Section 508 mode provides access to people with disabilities and has the same 
capabilities that are available in Standard mode: 


http://<server>:8090/login508


where <server> is the system name where the license server is running.  (The term “Section 508 mode” 
comes from Section 508, 36 CFR 1194.21, “Requirements for Software Applications and Operating 
Systems” of the 1998 amendment to the Federal Rehabilitation Act.)


Signing in to lmadmin as an Administrator


To use the following pages of the license server management interface, you must sign in as an administrator:


• System Information


• User Configuration


• Alert Configuration


• Server Configuration


• Vendor Daemon Configuration


When lmadmin is first installed, the administrator user name and password are both set to admin. Use this 
information when you first sign in to the interface as an administrator. 


Note • If lmadmin is running on a Windows machine, you can also sign in to the interface using the Active Directory 


user ID specified as an lmadmin Administrator (either directly or via the specified Active Directory group) during 


lmadmin installation. However, this type of sign-in is available only if your lmadmin installation prompted for an Active 


Directory domain user or group name and if this information was provided. 


Viewing the lmadmin Log Files
Application log files (except the report.log file) are written to the <lmadmin_install_dir>/logs directory. 


Table 9-2 • Log files


Log File Name Description


access.log Contains information recorded about access to the license server 
management interface.


lmadmin.log Contains information recorded by the license server.


web.log Contains information recorded by the license server management interface. 
This file does not contain information about login events. See the 
access.log file for that information.

82 FNP-11121-LAG00 License Administration Guide







Chapter 9: lmadmin License Server Manager
Managing lmadmin from the Command Line

Managing lmadmin from the Command Line
This section describes some of the common tasks that can be performed using the lmadmin command line and the 
command-line arguments.


Adding a Vendor Daemon to lmadmin
The lmadmin license server must be configured with data about vendor daemons and license files. To add a vendor 
daemon, you must import it using a license file. You can do this from the command line (or from the lmadmin user 
interface.) 


Note • FlexNet Publisher provides a sample vendor daemon (demo or demo.exe) that you can use with lmadmin. To 


use this vendor daemon, first copy it and its associated library from the <platform> directory to the <platform>/


lmadmin/demo directory. (The associated library is one of the following: demo_libFNP.so for UNIX, 


demo_libFNP.dll for Windows, demo_server_libFNP_notr.so for AIX, or demo_libFNP.dylib for Mac.) Then, issuing 


the command described in the following procedure, import the vendor daemon, using the sample license file 


lmadmin/demo/demo.lic.


<vendor>.log These files contain information recorded by the corresponding vendor 
daemons (where <vendor> is the vendor daemon name). Each vendor 
daemon has its own log file, called the debug log file. In the installation 
package, you should see the demo.log file as the debug log file for the 
default demo vendor daemon.


report.log A sample report log for the demo vendor daemon. Each vendor daemon can 
maintain a separate report log to record information about features that have 
been checked out by users. By default, a vendor daemon does not maintain 
report logs. This capability (in addition to the location of the report log file) 
must be enabled using the Options file.


FLEXnet_Publisher_License
_Server_Manager_Install_
MM_dd_yyyy_hh_mm_ss.log


A log recording events of the lmadmin installation. This file is usually created 
in the uninstall\Logs directory located under the installation root directory. 
However, the lmadmin installer might create it under a different name and 
location. If necessary, contact the publisher for the log file’s name and 
location.


Note • Prior to lmadmin 11.10.1, the installation log file was created directly under the 
installation root directory.


Table 9-2 • Log files


Log File Name Description
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Task: To add a vendor daemon from the command line


1. Create or locate a valid license file (for example, mylicense.lic) with the appropriate SERVER lines, VENDOR 
lines, and feature definition lines.


2. Make sure that the vendor daemon executable is in the correct location relative to lmadmin. This location is 
defined in the VENDOR line.


3. Import the license file by executing the following command: 


lmadmin -import <mylicense.lic>


where <mylicense.lic> is the path and name of the license file. This command imports the license file, but 
does not start the license server.


When you import a license file, the license server configuration file (<lmadmin_install_dir>/conf/
server.xml) is populated with the vendor daemon information (vendor name, vendor daemon path, port 
number, etc.).


4. Start the license server. See Manually Starting the License Server Manager.


Note • For information about how to import a license file using the license server management interface, see the 


online help available from within the license server management interface.


Configuring the License File Upload Directory
The license file upload directory is the location where copies of license files used by lmadmin are stored when 
license files are imported using the Import License button on the Vendor Daemon Configuration tab or the 
-import command-line argument. 


When this location is not configured, the default settings create the following directory structure into which license 
files are uploaded:


.../<lmadmin_install_dir>/licenses/<vendor daemon name>/


For example, on Windows when lmadmin is installed in the default location and two vendor daemons, demo and 
publisherA, are being managed by lmadmin, the following directories are created when license files for these 
vendor daemons are imported:


C:\Program Files\FlexNet Publisher License Server Manager\licenses\demo


C:\Program Files\FlexNet Publisher License Server Manager\licenses\publisherA


The license file that contains license rights for the vendor daemon demo is copied to the ..\demo directory. The 
license file that contains license rights for the vendor daemon publisherA is copied to the ..\publisherA 
directory. When additional license files are imported for either of these vendor daemons, they are uploaded to the 
appropriate vendor daemon-specific directory.
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You can replace this default configuration as described in the following instructions. Typically the license file upload 
directory is configured when lmadmin is installed for the first time and then not altered. This ensures that license 
files, once imported, are available to lmadmin and the vendor daemons it manages.


Task: To configure the license file upload directory


1. If lmadmin is running, shut it down (Manually Stopping the License Server Manager).


2. From the command line, execute an lmadmin command using the -uploadDir argument.


The upload directory can be specified either as a relative or absolute path. When a relative path is used, it is 
relative to the current directory. Additionally a special string, %v, can be used to include the vendor daemon 
name in the directory path. Thus the following example specifies that the upload directory will be located at 
C:\Program Files\ FlexNet Publisher License Server Manager\<vendor>\licenses:


lmadmin -uploadDir C:\Program Files\FlexNet Publisher License Server Manager\%v\licenses


Installing lmadmin License Server Manager as an 
Operating System Service


While it is possible to manually start and stop the lmadmin license server manager, it is recommended that you 
install it as a service on the operating system so that it will automatically start whenever the operating system 
restarts.


Important • For security reasons, Flexera Software recommends that the license server be run with non-elevated 


user privileges (which, in turn, the vendor daemon inherits). See the later section, Running FlexNet Publisher 


License Server as a System Service With Non-Elevated Privileges, for details on enabling the lmadmin operating-


system service to run under a non-Root or non-administrator user account.


Windows Systems


As part of the lmadmin installation process on Windows systems, the lmadmin installer might provide the option to 
configure the lmadmin license server manager as a system service. However, only users in the Windows 
Administrators group can successfully perform this action. The Startup Type is set to Automatic so that the 
service starts automatically when the system is restarted. 


As an alternative, use the following lmadmin command-line arguments to install and uninstall the service (see Table 
9-3). 


Important • After you execute the command to install the license server manager as a Windows service, the 


service is not started automatically. You must manually start the service for the first time using the Windows Services 


Console.
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Windows Vista and Later


To run lmadmin with any of the command-line arguments used to configure lmadmin as a Windows service requires 
that the user has administrator privilege. (Vista and later Windows versions enforce administrator privileges for 
installation or removal of a service.) Therefore, to use these arguments you must do the following:


• Sign in as an administrator before running lmadmin with these arguments.


• Start the command prompt using the option Run as Administrator.


Red Hat Linux Systems


On Red Hat Linux platforms, the <lmadmin_install_dir>/examples/service directory contains a shell-script file, 
lmadmin. (Do not confuse this lmadmin file with the executable for the license server manager.) This script file 
contains service installation instructions, including details on where this file should be installed on the Red Hat 
Linux.


Additionally, see Running FlexNet Publisher License Server as a System Service With Non-Elevated Privileges for 
instructions on modifying the script to run the lmadmin system service with non-elevated privileges.


Note • The instructions in the sample script might work on other lmadmin-supported UNIX platforms with minor 


changes.


Table 9-3 • lmadmin command-line arguments to configure lmadmin as a Windows service.


lmadmin Command-line 
Argument Description


–installService service name Creates a Windows service (with the name you provide) to run the license 
server manager. 


–removeService Uninstalls the Windows service with the name you specified. Make sure you 
stop the service before removing it.


–delay nn Sets the number of seconds (nn) to delay between the time you start the 
service and the time it actually begins running. This delay is helpful when a 
FlexNet ID dongle is used to lock the license server to a machine (that is, 
when the FLEXid is used on the SERVER line). The license server can 
sometimes fail to start when a system reboots because the license server 
loads before the dongle device driver has a chance to load properly.


Note • Use this option with the -installService argument.
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Mac OS Systems


On Mac OS Systems, administrators have to create their own startup script in a directory such as /Library/
StartupItems/LMadmin. The installed <lmadmin_install_dir>/examples/service script is the same script as 
installed for Linux and Solaris systems and is provided for reference only; it will not work properly on Mac OS 
systems. For more information on installing an executable file as a system service (and running it with non-elevated 
privileges) on Mac OS systems, see any of the many publicly available references such as http://
www.oreilly.com/pub/a/mac/2003/10/21/startup.html.


Note • Flexera Software is not responsible for the accuracy of information obtained from such reference sources or 


for the results of the startup script that you write.


Running FlexNet Publisher License Server as a System 
Service With Non-Elevated Privileges


Flexera Software recommends that the lmadmin license server manager be run with non-elevated user privileges. 
(The vendor daemon inherits these same privileges.) This practice ensures that any security vulnerabilities 
exploited by malicious users with access to the corporate network will have minimal impact beyond the licensing 
services. 


The instructions below are examples for enabling the lmadmin operating-system service to run under a non-root or 
non-administrator user account. The instructions assume that you have lmadmin already installed.


Procedure Overview


Managing the license server as a system service typically requires three main phases:


• Phase 1--Install the license server as a system service. This step typically requires elevated privileges. See the 
previous section, Installing lmadmin License Server Manager as an Operating System Service.


• Phase 2--Identify or create a user account with non-elevated privileges. You should create a user account 
(either a domain account or a local account) that is dedicated to running the license server system service. In 
the instructions that follow, this user account is referred to as the Service User account. Make sure that this 
Service User account has sufficient permissions to read the license files and write the log files in the 
designated folders.


• Phase 3--Configure the installed license server system service to use the Service User account. This step 
requires elevated privileges as well.


The following sections provide steps (based on the above procedure overview) for enabling the lmadmin license 
server to run with non-elevated user privileges on various operating-system platforms. Adjust these steps as 
needed for your specific platform or platform version.


Windows Systems


Use the following procedure to run the lmadmin system service with non-elevated privileges on Windows.
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Task: To configure the lmadmin system service to run with non-elevated user privileges


1. If the lmadmin was not set up as a Windows service during the lmadmin installation process, install the service 
from the command line: 


lmadmin –installService servicename


where servicename is the name of the lmadmin Windows service. 


This step requires elevated user privileges.


2. Create a Service User account either on the local system or on the domain. 


3. Grant this lesser-privileged account the permissions to start and stop the service. Use any appropriate 
method, such as Security Descriptor Definition Language or a publicly available third-party tool such as 
SetACL.


The following steps use SetACL to manage the permissions for the service: 


a. Download and install the command-line SetACL utility. 


b. From the command-line, change to the directory where the SetACL utility is installed, and execute this 
command:


SetACL.exe –on “servicename” –ot srv –actn ace –ace “n:\domain\serviceuser;p:start_stop”


where the the following elements are defined as follows:


• servicename is the name of the installed lmadmin service.


• domain is the domain to which the user belongs.


• serviceuser is the user under which the lmadmin service is intended to run.


4. To designate the Service User, navigate to the Windows Services console (for example, on some Windows 
platforms, you access this console from the Task Manager or from Administrative Services on the Control 
Panel).


5. From the Services console, do the following:


a. Right-click the lmadmin service, and select the Properties option.


b. Under the Log On tab, select This account, and specify the Service User and its password.


Linux Systems


The procedure described in this section requires the sample shell-script file called lmadmin, which is shipped with 
the FlexNet Publisher toolkit to help you set up lmadmin as a system service on Linux platforms. If you have already 
configured lmadmin to start up as a system service, skip steps 1 and 2 in the following procedure. However, you 
must must still access this script to make additional modifications, as described below.
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Task: To configure the lmadmin system service to run with non-elevated user privileges


1. In your lmadmin installation directory, copy the sample shell-script file lmadmin, located in the /examples/
service directory, to the /etc/rc.d/init.d directory. 


Important • Once the script is copied, make sure it has execution privilege. 


2. To update the run-level information for the service, execute the following command:


chkconfig lmadmin on 


3. Modify the following line in the script to identify the lmdamin path:


InstallDir="/opt/FNPlm/lmadmin"


where the installDir value is the directory location where the lmadmin binary is installed.


4. Modify the following line in the script to identify the user under which the lmadmin system service will run:


lmadminUser="lmadmin"


where the lmadminUser value is the name of the Service User account with the non-elevated privileges.


5. Remove --pidfile=${pidFile} from following line under the start() section:


daemon --user $lmadminUser --pidfile=${pidFile} "$lmadmin" -root "$installDir"


6. Save the changes in the script.


7. To start the lmadmin system service under the user you specified for lmadminUser, execute the following 
command:


service lmadmin start 


Other UNIX Systems


After configuring lmadmin to start up as a system service, as described in Installing lmadmin License Server 
Manager as an Operating System Service, modify the startup script (lmadmin or similar shell script) to run the 
lmadmin service with non-elevated privileges. Use the instructions in the previous section, Linux Systems, as a 
guide for editing the script. However, adjust the procedure as needed for your specific UNIX platform. 


Mac OS Systems


See the previous section, Mac OS Systems, under Installing lmadmin License Server Manager as an Operating 
System Service.


lmadmin Command-line Arguments
This section describes in outline each of the lmadmin command-line arguments. Arguments defined as persistent 
will remain set until they are reset.
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Usage


lmadmin [-version] [-config <configFile>] [-configDir <configFileDirectory>] 
[-root <lmadmin_install_dir>] [-force] [-import <licenseFileList>] 
[-importInstallation <oldInstallDirectory>[-config <configFileForImport>][-configDir 
<configDirForImport>]] [-licPort <licenseServerPort>][-webPort <httpPort>] 
[-allowStopServer <yes|no>] [-allowRemoteStopServer <yes|no>][-allowLicenseReclaim <yes|no>] 
[-installService <servicename>] [-delay <seconds>] [-removeService <serviceName>] 
[-defaultAdminUser <domain\username>] [-defaultAdminGroup <domain\groupname>] 
[-uploadDir <uploadDirectory>] [-useradd <userid> -Pass <password> -Role <roleType> [-FirstName 
<name>] [-LastName <name>]] [-usermod <userid> [-Pass <password>] [-Role <role_type>] [-FirstName 
<name>] [-LastName <name>]] [-userdel <userid>] [-foreground] [-adminOnly <yes|no>] [-logDir 
<logDirectory>]


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function


-adminOnly 
<yes|no>


Default—Yes


Persistent —Yes


Set from UI—No


Restricts usage of lmdown, lmreread, and 
lmremove—as well as lmswitch, lmswitchr, and 
lmnewlog. If you set -adminOnly no, command-
line access to these utilities is unrestricted. 
(Access to related features in the lmadmin UI is 
governed separately by lmadmin login 
credentials.) 


By default, lmadmin restricts command-line 
access to these utilities. The default argument, 
-adminOnly yes, overrides other lmadmin 
command-line options, such as 
-allowLicenseReclaim, -allowStopServer, and 
-allowRemoteStopServer. 


Restrictions vary depending on the operating 
system on which lmadmin is running. 


On Windows, command-line access to these 
utilities is completely restricted. If -adminOnly 
yes is used when starting lmadmin, no user on 
Windows can shut down the license server with 
lmdown, nor can they use the lmswitch, 
lmswitchr, and lmnewlog command-line utilities.


On UNIX, -adminOnly yes permits access by the 
root user only, by default. However, if you define 
a UNIX group called lmadmin, then access is 
permitted to members of that group only. (If root 
is not a member of this group, then root does 
not have permission to use any of the above 
utilities.) 
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-allowLicenseReclaim
<yes|no>


Default —No


Persistent—Yes


Set from UI—No


Controls the operation of lmremove (in License-
File-Based Licensing). If set to yes, licenses can 
be reclaimed from a user. If set to no, licenses 
cannot be reclaimed from a user. 


Note • Restrictions from the -adminOnly yes 
argument may prevent license reclamation even if you 
set -allowLicenseReclaim yes.


-allowStopServer
<yes|no>


Default—Yes value


Persistent —Yes


Set from UI —No


Configures how the license server can be 
stopped. 


If set to yes, local clients can stop the license 
server using either lmdown or the Stop Server 
button in the UI. 


Note • Restrictions from the -adminOnly yes 
argument may prohibit stopping the server from the 
command line even if you set 
-allowStopServer yes.


If set to no, then the license server must be 
stopped by stopping the process. See Manually 
Stopping the License Server Manager. 


Note • Setting -allowStopServer no also sets 
-allowRemoteStopServer to no.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-allowRemoteStopServer
<yes|no>


Default—No value


Persistent—Yes


Set from UI—No


Configures whether the license server can be 
stopped from a remote location. 


If set to yes, then you can stop the license server 
from a remote location and local clients can stop 
the license server using either lmdown or the 
Stop Server button in the UI. 


Note • Restrictions from the -adminOnly yes 
argument may prohibit remotely stopping the server 
from the command line even if you set 
-allowRemoteStopServer yes.


If set to no, then it must be stopped from a local 
client. See online help for further details. 


Note • Setting -allowRemoteStopServer yes when 
-allowStopServer is not defined, forces 
-allowStopServer to be set to yes.


-config
<configFile>


Default—server.xml


Persistent—Yes


Set from UI—No


Defines the name of the license server 
configuration file to use when starting the license 
server manager. If all defaults are set, the path 
and name is the following: 
<lmadmin_install_directory>/conf/


server.xml.


-configDir
<configDir>


Default—
<lmadmin_install_dir>/conf


Persistent—Yes


Set from UI—No


Defines the directory where the license server 
configuration files are located.


-delay
<seconds>


Default—0


Persistent—Yes


Set from UI—No


Used when configuring the license server as a 
service on Windows. See Installing lmadmin 
License Server Manager as an Operating System 
Service.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-defaultAdminUser 
<domain\username>


Default—N/A


Persistent—Yes


Set from UI—Yes


Adds the specified Windows Active Directory 
user as an lmadmin Administrator. The license 
administrator can then log in to the lmadmin user 
interface initially using this user ID (and its Active 
Directory password) and proceed to perform 
administrative tasks.


To identify this user, use the format 
domain\username, where domain is a valid 
Windows Active Directory domain to which the 
machine running lmadmin has a trusted 
relationship, and username identifies a valid 
account within that domain. This value is not 
case-sensitive and can include up to 32 
characters.


Note • Use this argument sparingly. Its main purpose 
is to provide initial access to the lmadmin interface.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-defaultAdminGroup 
<domain\groupname>


Default—N/A


Persistent—Yes


Set from UI—Yes


Adds the specified Windows Active Directory 
group as an lmadmin Administrator. The license 
administrator can then log in to the lmadmin user 
interface initially using any Active Directory user 
ID (and its associated password) belonging to 
this group and proceed to perform administrative 
tasks. 


To identify this group, use the format 
domain\groupname, where domain is a valid 
Windows Active Directory domain to which the 
machine running lmadmin has a trusted 
relationship, and groupname identifies a valid 
account within that domain. This value is not 
case-sensitive and can include up to 32 
characters.


Note • Consider the following:


• Setting a domain group as the lmadmin 
Administrator is helpful in a large enterprise where 
you might have several license administrators who 
need access to the interface. For more information, 
see the online help once you have opened the 
interface.


• Use this argument sparingly. Its main purpose is to 
provide initial access to the lmadmin interface.


-force Default—Do not overwrite 
settings


Persistent—No


Set from UI—No


Use with the -import argument to overwrite 
existing vendor daemon settings in the license 
server configuration file. The following settings 
are overwritten or reset to the default:


• License file location (overwritten).


• Vendor daemon location (overwritten).


• Vendor daemon port (reset to default).


• Restart retries (reset to default).


• Date-based versions (reset to default).


• Overwrite vendor daemon log (reset to 
default).


• Vendor daemon log location and name 
(reset to default).


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-foreground Default—Run in background


Persistent—No


Set from UI—N/A


Run lmadmin in the foreground (output status 
and errors are sent to the command window).


-import
<licenseFileList>


Default—N/A


Persistent—N/A


Set from UI —Import 
License button


Updates the license server configuration file with 
information extracted from the specified license 
files. See license_file_list for details of the format 
of <licenseFileList>. This option does not start 
lmadmin. The only arguments that can be 
combined with -import are: -config, -configDir, 
and -force.


-importInstallation
<oldInstallDirectory>
[-config 
<configFileForImport>]
[-configDir 
<configDirForImport>]


Default—N/A


Persistent—N/A


Set from Installer—Specify in 
Import files from Previous 
Installation in the lmadmin 
Installer.


Imports configuration information from the 
specified existing lmadmin installation directory 
or from a specified location for the license server 
configuration files (optional use of -config or -
confDir). This option does not start lmadmin. The 
only arguments that can be combined with -
importInstallation are: -config, -configDir, and 
-root. 


-installService
<serviceName>


Default—Do not install 
lmadmin as a Windows service


Persistent—N/A


Set from UI—No


Used when configuring the license server as a 
service on Windows. See Installing lmadmin 
License Server Manager as an Operating System 
Service.


-licPort
<licenseServerPort>


Default—First available in 
range 27000-27009


Persistent—Yes


Set from UI—Specify for 
License Server Manager 
Port (located under the 
License Server 
Configuration heading on 
the Server Configuration tab 
on the Administration page)


Configures the license server manager port. To 
set a specific port, enter a positive integer for 
<licenseServerPort>. To have the license server 
manager determine the default, enter 0 (zero).


Note • For security purposes, best practice is not to 
allow the license server manager determine a default 
port number. Instead, specify a port number outside of 
the range 27000 through 27009.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-logDir
<logDirectory>


Default—
<lmadmin_install_dir>/logs


Persistent—Yes


Set from UI—No


Writes the lmadmin logs to the location you 
specify for <logDirectory>. Enter an absolute 
path for <logDirectory>. 


Assuming no vendor daemon logs have been set 
(in the options file) to write to a custom location, 
lmadmin writes all lmadmin logs to the location 
you set for <logDirectory>. When a custom 
vendor daemon log location is set, that setting 
overrides the -logDir setting for that particular 
vendor-daemon log.


-removeService
<serviceName>


Default—N/A


Persistent—N/A


Set from UI—No


Used when configuring the license server as a 
service on Windows. See Installing lmadmin 
License Server Manager as an Operating System 
Service.


-root
<lmadmin_install_dir>


Default— root installation 
directory.


Persistent—No


Set from UI—No


Specifies the root directory for lmadmin. This 
enables you to issue an lmadmin command from 
somewhere other than the directory where 
lmadmin is installed.


Note • Any command-line arguments that specify 
relative paths define paths relative to the current 
directory and not the directory specified with -root.


-uploadDir
<uploadDirectory>


Default—
<lmadmin_install_dir>/


licenses/<vendor>


Persistent—Yes


Set from UI—No


Configures the directory where license files that 
are uploaded to the license server manager are 
stored. A directory with the name of the vendor 
daemon can be set by using the string “%v” as in 
the following example:


-uploadDir flexlicenses\%v


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-useradd <userid> -Pass 
<password> -Role 
<roleType> [-FirstName 
<name>] [-LastName 
<name>]


Persistent—Yes


Set from UI—Yes


Adds a new lmadmin user-interface user. Provide 
the following parameters:


• -useradd <userid>—Provide either value:


For a locally managed account (that is, 
defined and managed by lmadmin), a user-
defined sign-in ID, up to 32 characters. The 
value is case-sensitive and can include 
spaces but no backslashes (\).


or


For a Windows Active Directory domain 
account, the account ID in the following 
format: 


<domain>\<username> | <groupname>


where <domain> is the active Active Directory 
domain to which the machine running 
lmadmin has a trusted relationship and 
<username> or <groupname> identifies a valid 
user or group account existing within that 
domain. This value is not case-sensitive and 
can include up to 32 characters. Separate 
multiple domains with a backslash (\).


Note • When a Windows Active Directory group 
account is defined to lmadmin, only the group name is 
identified in the account. However, a user must sign in 
to lmadmin using a domain user name (not the group 
name) and its password. lmadmin then contacts the 
domain server to validate the user as a member of a 
group account defined to lmadmin.


• -Pass <password>—(Locally managed 
accounts only) Specify the password for the 
specified user ID, up to 32 characters.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-useradd <userid> -Pass 
<password> -Role 
<roleType> [-FirstName 
<name>] [-LastName 
<name>]


(continued)


• -Role <roleType>—Specify one of these 
roles to assign lmadmin user-interface 
privileges to the account:


user—The user is limited to lmadmin 
Dashboard functionality only.* Assign this 
role only when you are password-protecting 
the Dashboard.*** Otherwise, the user has 
automatic access to the Dashboard.


admin—The user (locally managed or in 
Windows Active Directory ) has 
administrator rights.**


userGroup—(Windows Active Directory 
group account only) The domain group is 
limited to lmadmin Dashboard functionality 
only.* Assign this role only when you are 
password-protecting the Dashboard.*** 
Otherwise, the group has automatic access 
to the Dashboard.


adminGroup—(Windows Active Directory 
group account only) The domain group has 
administrator rights.** 


• -FirstName <name>— (Locally managed 
accounts only; optional) The user’s first 
name.


• -LastName <name>—(Locally managed  
accounts only; optional) The user’s last 
name.


-usermod <userid> [-
Pass <password>] [-Role 
<role_type>] [-
FirstName <name>] [-
LastName <name>]


Persistent—Yes


Set from UI—Yes


Allows you to modify the lmadmin user-interface 
user account identified by the account ID 
(<userid>). You can modify the accounts’s role 
and, for locally managed accounts, the 
password and first and last names of the user. 
See the -useradd argument described previously 
in this table for descriptions of these parameters. 


-userdel <userid> Persistent—Yes


Set from UI—Yes


Removes the lmadmin user-interface user 
account identified by the account ID (<userid>).


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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-webPort
<httpPort>


Default—8090


Persistent—Yes


Set from UI—Specify for 
HTTP Port (located under 
the Web Server 
Configuration heading on 
the Server Configuration tab 
on the Administration page)


Configures the TCP/IP port that the Web server 
uses to listen for communication with clients 
connecting to the license server management 
interface. See License Server Manager Not 
Starting for an example of how to use this 
argument.


-webSecurePort 
<httpsPort>


Default—0


Persistent—Yes


Set from UI—Specify for 
HTTPS Port (located under 
the Secure Web Server 
Configuration heading on 
the Server Configuration tab 
on the Administration page)


Configures the TCP/IP port (five characters 
maximum) that the lmadmin web server uses to 
listen for HTTPS (HTTP-over-SSL) 
communication. If you change the port, you must 
stop and restart the license server.


Important • Specify the -webSecurePort option only 
if you are configuring HTTPS communication with the 
lmadmin web server interface. 


-version N/A Outputs details of the lmadmin version to the 
command prompt.


* Dashboard privileges provide access to all the lmadmin user-interface Dashboard functionality. This includes 
viewing license activity and alterts, changing the user password (locally managed accounts only), and selecting 
a locale when multiple locales are configured on the system. 


** Administrator privileges include all Dashboard privileges plus the ability to access the Administration page of 
the lmadmin user interface. From this page, the administrator can perform license-server configuration and 
management tasks, and set up, edit, or delete other lmadmin user accounts.


*** To password-protect the Dashboard, use Password Protect Dashboard option on the Server 
Configuration tab located on the Administration page in the lmadmin user interface. 


Note • Active Directory domain users or groups are supported on Windows platforms only.


Table 9-4 • lmadmin Command-line Arguments


Argument Syntax Description Function
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Obtaining lmadmin Command-Line Help


For a handy reference to lmadmin command-line arguments, use this procedure. 


Task: To obtain a handy reference of lmadmin command-line arguments


1. Open a command-prompt window.


2. Change to the directory where the lmadmin file is located.


3. Enter the following command to view a list of available arguments with a description of each:


lmadmin -help 


The help descriptions identify the default arguments and which arguments are persistent, arguments that will 
remain in effect for later instances of lmadmin.


Extending lmadmin License Server Capability
lmadmin can be customized. These customizations require some programming. The lmadmin installation package 
includes some example applications and files that demonstrate simple customizations. 


Using the lmadmin Web Service Interface
lmadmin provides a Web service interface that exposes certain APIs that can be called from a custom-built utility. 
These services enable you to extend the core license server capabilities. The WSDL file needed to generate the 
client proxy can be found in the <lmadmin_install_dir>\wsdl s directory.


The lmadmin installation package includes a set of examples in the <lmadmin_install_dir>\examples directory 
that demonstrate how to implement certain capabilities using the Web service interface. 


Creating an lmadmin Alerter Service
The lmadmin license server installation includes an example of how to implement an email alerter service. This 
service will poll for alerts and then send a user an email when an alert has been triggered. 


Using the Alerter Service Email Alerts


The sample Alerter service utility runs on the license server and enables a user to receive alert notifications by 
email. To use the Alerter service, you must install Java Runtime Environment (JRE) 1.5 or later on the license server.


To start the Alerter service, there are two files in the <lmadmin_install_dir>/examples/alerter directory:


• For Windows systems, the runalerter.bat file.


• For UNIX systems, the runalerter file.
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When starting this service, you must configure certain command-line arguments to define the mail server, sender, 
receiver, and so on. To see the list of available command-line arguments for the runalerter script, type the following 
command:


runalerter -help 


The source code for this utility is in the <lmadmin_install_dir>/examples/alerter/src directory. 
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lmgrd - License Server Manager 

The license server manager is one of the components that make up a license server (the other being the vendor 
daemon). It handles the initial contact with FlexEnabled applications, passing the connection on to the appropriate 
vendor daemon. The purposes of the license server manager are to:


• Start and maintain all the vendor daemons listed in the VENDOR lines of the license file used to start lmgrd. 


• Refer application checkout (or other) requests to the correct vendor daemon.


lmgrd is an application-based version of the license server manager. On most platforms it is controlled from a 
command-line. On Windows LMTOOLS can be used to manage lmgrd.


A newer lmgrd can be used with an older vendor daemon or FlexEnabled application, but a newer vendor daemon 
or FlexEnabled application might not work properly with an older lmgrd. Always use the latest version of lmgrd, 
which is available from the download site. See Version Compatibility Between Components for detailed 
information.


lmgrd Command-Line Syntax
When you invoke lmgrd, it looks for a license file that contains information about vendors and features and starts 
those vendor daemons.


Usage


lmgrd [-c license_file_list] [-l [+]debug_log_path] 
[-2 -p] [-local] [-x lmdown] [-x lmremove] [-z] [-v] [-help]
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The following table describes the syntax elements:


Table 10-1 • lmgrd Command-Line Syntax Usage


Term Description


-c license_file_list Use the specified license files.


-l [+]debug_log_path Write debugging information to file debug_log_path. This option uses the letter l, not 
the numeral 1. Prepending debug_log_path with the + character appends logging 
entries. Use -l option before other options to log all debugging information to 
debug_log_path. See Debug Log File for more information on this file.


-2 -p Restricts usage of lmdown, lmreread, and lmremove—as well as lmswitch, lmswitchr, 
and lmnewlog—to a license administrator who is by default root. If there a UNIX 
group called lmadmin, then use is restricted to only members of that group. If root is 
not a member of this group, then root does not have permission to use any of the 
above utilities. If -2 -p is used when starting lmgrd, no user on Windows can shut 
down the license server with lmdown, nor can they use the lmswitch, lmswitchr, and 
lmnewlog command-line utilities.


Note • For non windows -2 -p option is really effective when used with -local.


-local Restricts the lmdown and lmreread commands to be run only from the same system 
where lmgrd is running. 


-x lmdown Disable the lmdown command (no user can run lmdown). If lmdown is disabled, stop 
lmgrd via kill pid (UNIX), or stop the lmgrd and vendor daemon processes through 
the Windows Task Manager or Windows service. On UNIX, be sure the kill 
command does not have a -9 argument.


-x lmremove Disable the lmremove command (no user can run lmremove).


-z Run in foreground. The default behavior is to run in the background. If -l 
debug_log_path is present, then no windows are used, but if no -l argument 
specified, separate windows are used for lmgrd and each vendor daemon.


-v Displays lmgrd version number and copyright and exits.


-help Displays usage information and exits.


-reuseaddr [optional] Allows the server to explicitly bind to a same port, which remains in 
TIME_WAIT state after the server restart or crash


Note • It is recommended to use -reuseaddr option only on non-Windows to avoid undefined 
behavior.
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Starting the License Server Manager on UNIX 
Platforms


If any licenses in the license file are counted (license count > 0), the license server manager, and hence the license 
server, must be started before the FlexEnabled application can be used. 


The license server manager, lmgrd, is started either manually on the command line or automatically at system 
startup. Both methods are discussed in the following sections.


Note • Start lmgrd only on the system specified on the SERVER line in the license file. 


If you are running license servers configured for three-server redundancy, maintain an identical copy of the license 


file (as well as the lmgrd and the vendor daemons binaries) locally on each system rather than on a file server. If you 


do not do this, you lose all the advantages of having redundant servers, as the file server holding these files 


becomes a single point of failure.


Manual Start
Start lmgrd from the UNIX command line using the following syntax:


lmgrd -c license_file_list -L [+]debug_log_path


where 


license_file_list is one or more of the following:


• the full path to a single license file


• a directory, where all files named *.lic in that directory are used


If the license_file_list value contains more than one license file or directory, they must be separated by colons on 
UNIX or semicolons on Windows. 


debug_log_path is the full path to the debug log file


Prepending debug_log_path with the + character appends logging entries. 


Start lmgrd by a user other than root since processes started by root can introduce security risks. If lmgrd must be 
started by the root user, use the su command to run lmgrd as a non-privileged user:


su username -c "lmgrd -c license_file_list -l debug_log_path"


where username is a non-privileged user. You must ensure that the vendor daemons listed in the license file have 
execute permissions for username. The paths to all the vendor daemons in the license file are listed on each 
VENDOR line.
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Automatic Start
On UNIX, edit the appropriate boot script, which may be /etc/rc.boot, /etc/rc.local, /etc/rc2.d/Sxxx, /sbin/
rc2.d/Sxxxx. Include commands similar to the following. See the following notes for a full explanation.


/bin/su daniel -c 'echo starting lmgrd > \
/home/flexlm/v11/hp700_u9/boot.log'


/bin/nohup /bin/su daniel -c 'umask 022; \
/home/flexlm/v11/hp700_u9/lmgrd -c \
/home/flexlm/v11/hp700_u9/license.dat >> \
/home/flexlm/v11/hp700_u9/boot.log'


/bin/su daniel -c 'echo sleep 5 >> \
/home/flexlm/v11/hp700_u9/boot.log'


/bin/sleep 5


/bin/su daniel -c 'echo lmdiag >>\
/home/flexlm/v11/hp700_u9/boot.log'


/bin/su daniel -c '/home/flexlm/v11/hp700_u9/lmdiag -n -c\
/home/flexlm/v11/hp700_u9/license.dat >> \
/home/flexlm/v11/hp700_u9/boot.log'


/bin/su daniel -c 'echo exiting >>\
/home/flexlm/v11/hp700_u9/boot.log'


Please note the following about how this script was written:


• All paths are specified in full because no paths are assumed at boot time.


• Because no paths are assumed, the vendor daemon must be in the same directory as lmgrd, or the VENDOR 
lines in the license file must be edited to include the full path to the vendor daemon.


• The su command is used to run lmgrd as a non-root user, daniel. It is recommended that lmgrd not be run as 
root since it is a security risk to run any program as root that does not require root permissions. lmgrd does not 
require root permissions.


• daniel has a csh login, so all commands executed as daniel must be in csh syntax. All commands not 
executed as daniel must be in /bin/sh syntax since that is what is used by the boot scripts.


• The use of nohup and sleep are required on some operating systems, notably HP-UX. These are not needed 
on Solaris and some other operating systems, but are safe to use on all.


• lmdiag is used as a diagnostic tool to verify that the server is running and serving licenses.


Note • This does not start the vendor daemon until you reboot the system.
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Starting the License Server Manager on 
Windows


This section provides procedural information on manual starts from the command line and how to configure the 
License Server Manager (lmgrd) as a service.


Manual Start from the Command Line
To start lmgrd from the command line:


Start lmgrd as an application from a Windows command shell using the following syntax:


C:\fnp> lmgrd -c license_file_list -L [+]debug_log_path


where 


• license_file_list is one or more of the following:


• the full path to a single license file 


• a directory, where all files named *.lic in that directory are used


• debug_log_path is the full path to the debug log file


Prepending debug_log_path with the + character appends logging entries. 


Spaces in pathnames require double quotes around the path.


Configuring the License Server Manager as a Windows 
Service


To configure a license server manager (lmgrd) as a service, you must have Administrator privileges. The service will 
run under the LocalSystem account. This account is required to run this utility as a service.


Task: To configure a license server as a service:


1. Run the lmtools utility.


2. Click the Configuration using Services button, and then click the Config Services tab.


3. In the Service Name, type the name of the service that you want to define, for example, DEMO License 
Manager. If you leave this field blank, the service will be named FlexNet Publisher Service.


4. In the Path to the lmgrd.exe file field, enter or browse to lmgrd.exe for this license server.


5. In the Path to the license file field, enter or browse to the license file for this license server.
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6. In the Path to the debug log file, enter or browse to the debug log file that this license server writes. 
Prepending the debug log file name with the + character appends logging entries. The default location for 
the debug log file is the c:\winnt\System32 folder. To specify a different location, make sure you specify a fully 
qualified path.


7. To save the new DEMO License Manager service, click Save Service.


Figure 10-1: Completed Config Services Tab 


Configuring the License Server Manager Service for a 
Delayed Start


In situations where the license server needs to wait for other drivers or services to start before it starts, you can 
configure a delay before the license server service starts. A typical scenario where a delay is needed is when a 
FlexNet ID dongle is used to lock the license server to a machine (the FLEXid is used on the SERVER line). In this 
scenario the license server will sometimes fail to start upon reboot of the system because the license server is 
loaded before the dongle device driver has loaded properly.


Task: To Configure a delayed start for the license server manager service:


1. Configure the license server manager as a service (Configuring the License Server Manager as a Windows 
Service).


2. Locate the registry entry for your license server manager service at:


HKEY_LOCAL_MACHINE\SOFTWARE\FLEXlm License Manager\service_name


where service_name is the name of the license server manager service. 


3. Optionally, to configure a delay longer than 20 seconds, add a string value to the registry entry and set the 
fields in this entry as follows:


Name - unlimitedServiceDelay
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Type - REG_SZ (set automatically when a string value is created)


Data - no value set


4. Add a string value to the registry entry and set the fields in this entry as follows:


Name - serviceDelay


Type - REG_SZ (set automatically when a string value is created)


Data - the service delay in seconds. This value is limited to the range 1-20 seconds unless 
unlimitedServiceDelay has previously been defined (see Step 3).


Manually Start the License Server Using the lmtools 
Utility


A graphical user interface to the license server manager tools is provided called lmtools. Some of the functions 
lmtools performs include:


• Starting, stopping, and configuring license servers


• Retrieving system information, including hostids


• Retrieving server status


In order to control the operation of lmgrd from the lmtools user interface, you first must configure it as a license 
server manager service. Follow the procedure in Configuring the License Server Manager as a Windows Service 
before proceeding.


Once the license server manager service is configured, lmgrd is started by starting the service from the lmtools 
interface.


Task: To start the service from the lmtools interface:


1. Start lmtools and display the Service/License File tab.


2. Click Configuration using Services button.
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3. Select the service name from the list presented in the selection box. In this example, the service name is 
DEMO License Manager.


Figure 10-2: Service/License File Tab


4. Click the Start/Stop/Reread tab.


5. Start DEMO License Manager by clicking the Start Server button. DEMO License Manager license server 
starts and writes its debug log output to c:\prods\i86_n3\debuglog.


Figure 10-3: Start/Stop/Reread Tab 
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Automatically Start the License Server when System 
Starts


In order for lmgrd to start up automatically at system start-up time, you first must configure it as a service. Follow 
the procedure in Configuring the License Server Manager as a Windows Service before proceeding, and then 
continue with the steps below.


Task: To configure lmgrd as a service:


1. With lmtools started and the desired service name selected, click the Config Services tab.


Figure 10-4: Config Services Tab 


2. Make this license server manager a Windows service by selecting the Use Services check box.


3. Configure it to start at system startup time by selecting the Start Server at Power Up check box.


From now on, when the system is rebooted, this license server manager starts automatically as a Windows service.
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Migrating from lmgrd to lmadmin

A Fundamental Mode Change
The lmadmin license server manager combines all the functionality of the lmgrd license server manager with a Web-
based, administrative interface. However, the lmadmin license server manager operates in some fundamentally 
different ways than the lmgrd license server manager.


The obvious change is that previous versions of the license server manager (lmgrd) used a command-line interface 
and the new license server manger (lmadmin) supports a browser-based client connection over HTTP. A more 
fundamental change in operation is that configuration options are now persistent—if you change settings and 
relaunch the tool, the previously set options stay in effect.


With lmgrd, the primary mode of operation is to run one instance of lmgrd for each vendor daemon where lmgrd 
obtains its configuration information from the command-line options used when the program is started, including 
the required specifying of a license file.  To change settings you typically stop the license server, edit the license file 
and/or the script containing your command-line options, and relaunch the tool.


In contrast, the lmadmin license server manager is designed to: 


• Support multiple vendor daemons with one lmadmin process.


• Launch without requiring any configuration options.


• Perform all server configuration and administration functions from the browser. (For special circumstances, the 
lmutil package provides additional functions.)


• Import existing license files (the new lmadmin license server manager is compatible with license files and 
vendor daemons produced using FlexNet Publisher 9.2 and later).


• Keep configuration options persistent.
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Persistent configuration options is a significant change. Once set, settings remain in effect until changed. For 
example, if two vendor daemons are specified to use the same TCP port, only one will run. With lmgrd, this requires 
making changes to at least one of the license files as well as stopping and restarting the server. With lmadmin, you 
can change the TCP port for a vendor daemon while the license server is running. The manually specified port is 
then persistent and will remain as it was manually set the next time the license server is started, even if the license 
file is changed. The changes set in the license server manager override the license files.


Command Changes
Because of the changes in the fundamental operation of the system, many features have been redesigned. The 
following lmgrd command-line options are not supported by lmadmin. 


Table 11-1 • Command-line options to lmgrd that are not supported by lmadmin.


lmgrd option lmadmin notes


–2 –p The replacement option is -adminOnly yes, which is the default for 
lmadmin. 


–z The replacement option is -foreground.


–c license_file_list License files are now managed using either the license server 
management interface or the new -import option.


–v Version information is now displayed in the license server management 
interface. The equivalent is -version option.


–l [+]debug_log_path The -logDir option defines the path to the debug log file (lmadmin.log) 
written by the lmadmin license server manager. The default location is 
<lmadmin_install_dir>/logs.


The default location for the vendor daemon debug log files is 
<lmadmin_install_dir>/logs/<vendor>.log. The path to vendor 
daemon debug logs can be changed via either the lmadmin license 
management interface or the options file.


–local The replacement is to use the following argument settings:


-allowStopServer Yes -allowRemoteStopServer No


–x lmdown The replacement option is -allowStopServer. Note that the logical 
direction of this option has been reversed.


–x lmremove The replacement option is -allowLicenseReclaim. Note that the logical 
direction of this option has been reversed.
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lmadmin License Administration Functions
lmadmin provides some of the license administration functions previously provided by the command-line based 
license administration utilities or LMTOOLS on the Windows platform. The following table lists functions provided 
within lmadmin that replace those provided by the license administration utilities.


The following table details which command-line utilities may no longer be required and which utilities are required 
when using lmadmin. 


Table 11-2 • lmadmin License Administration Functions


lmadmin Function Description Replaces Utility


Dashboard -  Licenses Displays details of licenses rights available and in 
use.


lmstat


Vendor Daemon Configuration 
- Administer - Stop


Stops the vendor daemon. lmdown (in some usage cases)


Vendor Daemon Configuration 
- Administer - Reread License 
Files


Rereads license rights from license files included in 
the lmadmin configuration. Required only when the 
content of a license file is updated.


lmreread (see also Changes in 
lmreread Behavior when Using 
lmadmin)


Vendor Daemon Configuration 
- Administer - Rotate Report 
Logs


Switches the report log to a new file name. lmswitchr


Server Configuration - Stop 
Server


Stops the license server. Note that lmadmin’s 
default setting enables this button. To disable the 
button, start lmadmin with the -allowStopServer No 
argument.


lmdown (in some usage cases)


Table 11-3 • lmadmin Use of License Administration Utilities 


Utility Required when using lmadmin


lmborrow Yes, if using license rights in license files and borrow capability.


lmdiag Yes, to diagnose license checkout problems. 


lmdown Not normally required.


lmhostid Not normally required for lmadmin as it displays information about the system it is running 
on that includes the various identities normally used as hostids. Required for determining 
the hostids of client systems.


lminstall Yes, converts license files between different formats. 
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Changes in lmreread Behavior when Using lmadmin


Normally lmreread is not required when using lmadmin, however if you use lmreread with lmadmin the following use 
cases are not supported:


• Using lmreread to restart a vendor daemon - When using lmgrd you can shut down a vendor daemon 
using lmdown and then use the lmreread command to restart the vendor daemon. The following sequence of 
commands will result in an error when using lmadmin:


lmdown -vendor demo
lmreread -vendor demo


• Using lmreread to load and start a new vendor daemon - You can start lmgrd with a license file that 
specifies a vendor daemon and then replace this license file with one that includes information about a second 
vendor daemon. When lmreread is run, this second vendor daemon will be started. Using lmreread in this way 
with lmadmin will not load or start the vendor daemon. When using lmadmin, load and start a new vendor 
daemon as follows:


1. To import a license file for the vendor daemon, go to the Administration page, open the Vendor Daemon 
Configuration tab, and click Import License.


2. To start the vendor daemon, go to the Administration page, open the Vendor Daemon Configuration tab, 
and click Administer for the specific vendor daemon. Click Start.


lmnewlog Yes, if you use this function instead of lmswitchr to change to a new report log because 
you do not want to edit the report log file name in the options file. 


lmpath Yes, allows users direct control over license file path settings. 


lmremove (in 
License-File-
Based 
Licensing)


Yes, releases a hung license to the pool of free licenses. Note that lmadmin’s default setting 
disables the operation of lmremove. To enable lmremove, start lmadmin with the -
allowLicenseReclaim argument.


lmreread Not normally required. See also Changes in lmreread Behavior when Using lmadmin.


lmstat Only required to show additional information (such as borrow or reservations).


lmswitch Yes, controls debug log location and size.


lmswitchr Not required.


lmver Yes, reports the version of a library or binary file. Note that you can determine the version 
of lmadmin by starting it with the -version argument.


Table 11-3 • lmadmin Use of License Administration Utilities 


Utility Required when using lmadmin
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Using License Administration Tools

License administration tools are available from the Flexera Software download site to help license administrators 
manage licenses and license servers. Always use the latest version of the utilities. If you are using lmadmin as your 
license server manager, then it provides functionality that replace some of these utilities. The table, License 
Administration Utilities, lists these utilities and indicates when lmadmin provides an alternative. 


Command-Line Utilities
All license server utilities are packaged as a single executable called lmutil. The lmutil is either installed as 
individual commands (either by creating links to the individual command names, or making copies of lmutil as 
the individual command names), or as a wrapper that runs the individual command as lmutil command. For 
example, lmutil lmstat or lmutil lmdown. 


On Windows systems, the lmutil command form of the commands are available. There is also a graphical user 
interface available for these commands—see lmtools (Windows only).  


Table 12-1 • License Administration Utilities 


Utility Description lmadmin Function


lmborrow Supports license borrowing. None


lmdiag Diagnoses license checkout problems. None


lmdown Gracefully shuts down selected vendor daemons on the 
license server (or on all three systems in the case of 
three-server redundancy).


Vendor Daemon Configuration - 
Administer - Stop


lmhostid Reports the hostid of a system. System Information displays 
hostids for the license server.
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• The lmpath utility introduced in the version 7.0 utilities.


• The lmborrow utility introduced in the version 8.0 utilities.


• The lmswitch utility introduced in version 8.0 vendor daemon.


• The lmswitchr utility introduced in version 5.0 vendor daemon.


lminstall Converts license files between different formats. None


lmnewlog Moves existing report log information to a new file name 
and starts a new report log file with existing file name.


None


lmpath Allows users direct control over license file path settings. None


lmremove 
(in License-
File-Based 
Licensing)


Releases a hung license to the pool of free licenses. None. Note lmadmin default 
setting disables lmremove.


lmremove 
(in Trusted-
Storage-
Based 
Licensing)


Releases a hung license to the pool of free licenses in 
trusted storage.


None


lmreread Causes the license daemon to reread the license file and 
start any new vendor daemons.


Vendor Daemon Configuration - 
Administer - Reread License Files


lmstat Displays the status of a license server. Dashboard -  Licenses


lmswitch Controls debug log location and size. None


lmswitchr Switches the report log to a new file name. Vendor Daemon Configuration - 
Administer - Rotate Report Logs


lmver Reports the version of a library or binary file. None


Table 12-1 • License Administration Utilities 


Utility Description lmadmin Function
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Common Arguments for lmutil
The following are valid arguments for most lmutil utilities:


Note • The following information might be helpful:


• VENDOR_LICENSE_FILE environment variable is honored in utilities starting with version 7.0.


• The -verbose option was introduced in version 6.0 of the utilities.


lmborrow
The lmborrow utility supports the borrowing of those licenses that contain the BORROW attribute. This utility runs on 
the FlexEnabled client machine that borrows the licenses. The FlexEnabled application end users can use the 
utility to do the following:


• Initiate borrowing by setting the borrow period


• Clear the borrow period


• Purge expired licenses


• Determine borrow status


• Return a borrowed license early


Table 12-2 • lmutil Valid Arguments


Argument Description


-c license_file_path Most lmutil utilities need to know the path to the license file. This is specified with a -
c license_file_path argument, or by setting the LM_LICENSE_FILE environment 
variable. Otherwise, the default location is used. The utilities also honor all 
VENDOR_LICENSE_FILE environment variables. Some utilities take more than one 
license file path in a license search path separated by colons on UNIX and semicolons 
on Windows.


Pathnames that include spaces must be enclosed in double quotes.


-help Displays usage information and exits.


-v Displays the version of the utility and exits. 


-verbose Displays longer description for all errors found.
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Initiating Borrowing


To initiate borrowing, the end user of the FlexEnabled application sets the borrow period by running lmborrow 
from the command line or through lmtools on the FlexEnabled client machine.


Task: To initiate borrowing


From the FlexEnabled client machine, enter the following command:


lmborrow {vendor | all} enddate [time] 


where:


For example, you might enter the following:


lmborrow sampled 20-aug-2007 13:00


This has the effect of setting LM_BORROW with the borrow period in either the registry (Windows) or in $HOME/
.flexlmborrow (UNIX).


To borrow licenses for the desired vendor name, on the same day and the same system that the user runs lmborrow, 
run the applications to check out the licenses. If you run the applications more than once that day, no duplicate 
licenses are borrowed. No licenses are borrowed if the application is run on a day different than the date borrowing 
is initiated. 


Aside from the lmborrow utility, you can use these other methods to initiate borrowing:


• Use the borrowing interface included in the FlexEnabled application, if such an interface is provided.


• Set the LM_BORROW environment variable directly.


See Initiating License Borrowing for more information on these other ways.


Table 12-3 • lmborrow Arguments for Initiating Borrowing


Argument Description


vendor The vendor daemon name that serves the licenses to be borrowed, or all specifies all 
vendor daemons in that license server.


enddate [time] Date the license is to be returned in dd-mmm-yyyy format. time is optional and is 
specified in 24-hour format (hh:mm) in the FlexEnabled application’s local time. If time is 
unspecified, the checkout lasts until the end of the given end date.
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Clearing the Borrowed License Setting


End users of the FlexEnabled application can clear the LM_BORROW setting to stop licenses from being borrowed 
until borrowing is initiated again. For example, users might run lmborrow -clear after they have borrowed licenses 
for features that are used offline if—before disconnecting from the network—they want to run an application that 
checks out additional features, served by that vendor name, that are not meant to be borrowed. Clearing LM_BORROW 
does not change the status for already borrowed licenses.


Task: To clear the LM_BORROW setting in the Windows registry or in $HOME/.flexlmborrow 


From the FlexEnabled client machine, enter the following command:


lmborrow -clear


Purging Expired Licenses


End users can remove expired borrowed licenses from their FlexEnabled client machine.


Task: To remove expired borrowed licenses


From the FlexEnabled client machine, enter the following command:


lmborrow -purge


Tip • Combine this option with the -status option both to purge expired borrowed licenses from the client machine 


and to display information about the still valid borrowed licenses. See the next section Determining Borrowed-


License Status.


Determining Borrowed-License Status


End users can issue the following commands to display the status of licenses (vendor, feature name, and 
expiration date) currently borrowed by their FlexEnabled application. 


Note • The current status of borrowed licenses is read from information stored on the client machine itself. 


Therefore, the client machine does not need to be connected to the network to obtain this information.


Task: To display the status of all currently borrowed features, expired or not


From the FlexEnabled client machine, enter the following command:


lmborrow -status
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Task: To purge expired borrowed licenses and display the status of non-expired borrowed licenses


From the FlexEnabled client machine, enter the following command:


lmborrow -purge -status


Note • You can specify the -purge and -status options in any order. The result is always the same--expired 


borrowed licenses are removed and the status of the remaining borrowed licenses is displayed.


Returning a Borrowed License Early


Task: To return a borrowed license early


1. Reconnect the FlexEnabled client to the network.


2. From the FlexEnabled client machine, issue the following command:


lmborrow -return [-fqdn][-c license_file_list] [-d display] feature


where:


Table 12-4 • lmborrow Arguments for Returning a Borrowed License Early


Argument Description


-fqdn Directs lmborrow to access the borrowing system using its fully qualified host name. 
Use this option if the license was borrowed based on the fully qualified host name, 
rather than the relative distinguished name. Use lmstat to determine the format of the 
host name used when the license was borrowed.


-c 
license_file_list


Use the specified license files. In some configurations, the license file needs to be 
specified in order to return the license file early.


-d display Used to specify the display from which the borrow was initiated. Required if your 
current display is different than what was used to initiate the borrow.


On Windows, it is the system name or, in the case of a terminal server environment, the 
terminal server client name. On UNIX, it is in the form 
/dev/ttyxx or the X-Display name.


feature The name of the borrowed feature to be returned early. Use lmborrow -status to get a 
list of borrowed feature names.

122 FNP-11121-LAG00 License Administration Guide







Chapter 12: Using License Administration Tools
Command-Line Utilities

If the borrowing system is not placed back on the network before attempting the early return, the license is not 
returned and LM_BORROW is kept intact. Additionally, an error message is issued to the user with notification that the 
system needs to be connected to the network.


Note • Early borrowed license return was introduced in version 8.3 utilities.


lmdiag
lmdiag allows you to diagnose problems when you cannot check out a license.


Usage


lmdiag [-c license_file_list] [-n] [feature[:keyword=value]]


where:


If no feature is specified, lmdiag operates on all features in the license files in your list. lmdiag first prints 
information about the license, then attempts to check out each license. If the checkout succeeds, lmdiag indicates 
this. If the checkout fails, lmdiag gives you the reason for the failure. If the checkout fails because lmdiag cannot 
connect to the license server, then you have the option of running extended connection diagnostics. 


These extended diagnostics attempt to connect to each TCP/IP port on the license server, and detects if the port 
number in the license file is incorrect. lmdiag indicates each TCP/IP port number that is listening, and if it is an 
lmadmin or lmgrd process, lmdiag indicates this as well. If lmdiag finds the vendor daemon for the feature being 
tested, then it indicates the correct port number for the license file to correct the problem. 


See Also 
FLEXLM_DIAGNOSTICS


Table 12-5 • lmdiag Argument Usage


Argument Description


-c license_file_list Diagnose the specified files.


-n Run in non-interactive mode; lmdiag does not prompt for any input in this mode. In 
this mode, extended connection diagnostics are not available.


feature Diagnose this feature only.


keyword=value If a license file contains multiple lines for a particular feature, select a particular line 


for lmdiag to report on. For example:


lmdiag f1:HOSTID=12345678


attempts a checkout on the line with the hostid “12345678.” keyword is one of the 
following: VERSION, HOSTID, EXPDATE, KEY, VENDOR_STRING, ISSUER
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lmdown
The lmdown utility allows for the graceful shutdown of selected license daemons on all systems. 


Usage


lmdown -c license_file_list [-vendor vendor_daemon] [-q] [-all] [-force]


where:


If lmdown encounters more than one server (for example if -c specifies a directory with many *.lic files) and -all is 
not specified, a choice of license servers to shut down is presented.


Note • On UNIX, do not use kill -9 to shut down license servers. On Windows, if you must use the Task Manager 


to kill the FlexNet Publisher Licensing Service, be sure to end the lmadmin (or lmgrd) process first, then all the 


vendor daemon processes.


When using the lmdown utility to shut down license servers configured for three-server redundancy, there is a one-
minute delay. You can protect the unauthorized execution of lmdown when you start up the license server manager.


See Also
Downloading and Installing lmadmin License Server
lmgrd Command-Line Syntax for details about securing access to lmdown


Table 12-6 • lmdown Argument Usage


Argument Description


-c license_file_list Use the specified license files. Note that specifying -c license_file_list is 
always recommended with lmdown.


-vendor vendor_daemon Shut down only this vendor daemon. The license server continues running.


-q Don’t prompt. Otherwise, lmdown provides a confirmation prompt.”


-all If multiple servers are specified, automatically shuts down all of them. -q is 
implied with -all.


-force If licenses are borrowed, lmdown runs only from the system where the license 
server is running, and then only if the user adds -force.
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lmhostid
The lmhostid utility returns the hostid of the current platform. Invoked without any arguments, lmhostid displays 
the default hostid type for the current platform. Otherwise, the hostid corresponding to the requested type is 
displayed, if supported on the current platform.


Usage


lmhostid [-n] [-utf8] [-ptype argument] [hostid_type]


Where:


Table 12-7 • lmhostid Argument Usage


Argument Description


-n Only the hostid, itself, is returned as a string, which is appropriate to use with HOSTID= 
in the license file. Header text is suppressed.
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hostid_type One of the following hostid types. If not specified, the default hostid for the current 
platform is displayed. See Hostids for Supported Platforms for a list of the default types.


PLATFORM-DEPENDENT HOSTIDS


• -ether—Ethernet address.


Note • On Windows, Linux, and Mac OS X platforms, this command returns all available 
addresses (active and inactive). For Windows and Linux platforms, these addresses include 
both teamed and non-teamed Ethernet interfaces. In general for teamed interfaces, the unique 
address for the team-bonding virtual adaptor is returned. On Linux platforms, a separate (but 
same) virtual-adaptor address is returned for each interface in the team. On Windows platforms, 
a single instance of the virtual-adaptor address is returned for all teamed interfaces.


• -string—String id.


• -vsn—Volume serial number (Windows platforms only).


• -flexid— USB FLEXID identification. This is applicable only for those platforms that 
support FlexNet ID dongles. See Obtaining System Hostids for a complete list.


• -long—32-bit hostid.


• -uuid—UUID binding value. Used with the -ptype command line option, shown 
under -ptype below. Only permitted with platform types (ptype) VM, VMW, or HPV.


• -iid—AMI (Amazon Machine Image) Instance ID. Used with the -ptype AMZN 
command line option to capture this ID from an Amazon EC2 AMI instance 
containing the FlexEnabled application. The ID is used for node-locked licenses 
only.


• -eip—Elastic IP address. Used with the -ptype AMZN command line option to 
capture this address from an Amazon EC2 AMI instance containing the license 
server.


PLATFORM-INDEPENDENT HOSTIDS


• -user—Current user name. Note that user names that contain spaces, for example 
‘test user’ cannot be used in the Options file. Use the first word of the user name, for 
example ‘test’, in the Options file.


• -display—Current display name. On Windows, it is the system name or, in the case 
of a terminal server environment, the terminal server client name. On UNIX, it is in the 
form 
/dev/ttyxx or the X-Display name.


• -hostname—Current host name.


• -hostdomain—Current host domain.


• -internet—IP address of the machine in the format of the machine’s protocol (IPv4 
or IPv6). In a dual-stack environment, you can use the -v4 or -v6 switch to obtain the 
version-specific IP address (see the next bulleted items).


Table 12-7 • lmhostid Argument Usage


Argument Description
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hostid type


(continued)


• -v4—Use with -internet to obtain the IPv4 address for a FlexEnabled application 
built with the IPv6 toolkit and running in a dual-stack environment.


• -v6—Use with -internet to obtain the IPv6 address for a FlexEnabled application 
built with the IPv6 toolkit and running in a dual-stack environment.


Tip •  Both -v4 & -v6 are optional; using just -internet fetches the IP address based on the 
FlexNet Publisher toolkit type (IPv4 or IPv6) with which the FlexEnabled application is built.


Note • (Windows only) If a Windows machine is connected to a VPN, lmhostid -internet returns 
the virtual adapter IP address. To ensure that this command returns the physical adaptor IP address 
during checkouts, perform this workaround: Run regedit, navigate to 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\Tcpip\Linkage, locate the 
Bind parameter, and edit the adapter order so that the physical adapter is listed first. Run ipconfig/
registerdns to put the edit into effect.


-utf8 The hostid is output as a UTF-8 encoded string rather than an ASCII string. If your hostid 
contains characters other than ASCII A through Z, a through z, or 0 through 9, use this 
option with lmhostid. To view a correct representation of the resulting hostid, use a utility, 
such as Notepad, that can display UTF-8 encoded strings.


-ptype (License-server binding in virtual environments only) Indicates the platform type. This 
option must be used in conjunction with a valid hostid binding type (see hostid_type). 


-ptype requires one of the following arguments, which then prefixes the generated hostid 
appropriately (as described):


• PHY—Physical machine only (does not support lmbind). Prefixes hostid with PHY_.


• VM—Xen, VMware, or Hyper-V virtual platform. Prefixes hostid with VM_.


• VMW—VMware virtual platform. Prefixes hostid with VMW_.


• HPV—Hyper-V virtual platform. Prefixes hostid with HPV_. 


• AMZN—Amazon EC2 cloud environment. Prefixes hostid with AMZN_.


• LMB—Bare-metal binding for Amazon EC2, VMware, Hyper-V, or Xen platform. 
Prefixes hostid with LMB_. (lmbind is installed either directly on the hypervisor or on a 
remote physical machine that communicates with the virtual machine.) 


Table 12-7 • lmhostid Argument Usage


Argument Description
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The following are examples of output from lmhostid:


lmhostid


lmhostid - Copyright (c) 1989-2013 Flexera Software LLC. All Rights Reserved.


The FlexNet host ID of this machine is ""00ff5018c189 0019d244e9fc 0016cfdaf65d 001558809422 
005056c00001 005056c00008""


Only use ONE from the list of hostids.


lmhostid -ptype VMW -ether
lmhostid - Copyright (c) 1989-2013 Flexera Software LLC. All Rights Reserved.
The FlexNet host ID of this machine is "VMW_ETHER=0019d22f8672 VMW_ETHER=005056c00001 
VMW_ETHER=005056c0000
"
Only use ONE from the list of hostids.


lmhostid -ptype VM -uuid
lmhostid - Copyright (c) 1989-2013 Flexera Software LLC. All Rights Reserved.
The FlexNet host ID of this machine is "VM_UUID=0011223344556677889911bbccddeeff" 


lmhostid -ptype PHY -display
lmhostid - Copyright (c) 1989-2013 Flexera Software LLC. All Rights Reserved.
The FlexNet host ID of this machine is "PHY_DISPLAY=sc-EXAMPLE" 


Note • Some limitations exist with hostid reporting on virtual devices: 


• Ethernet hostids on Windows platforms - From lmutil version 11.6.1 onwards, only the hostids of 


physical ethernet adapters are reported. Devices identified as virtual ethernet adapters are not reported as 


these identities are not permanent. 


• Physical (bare metal) hostids on virtual machines - When run from a virtual machine, lmhostid cannot 


return hostids for the physical machine that hosts the virtual machine. To obtain hostids for the physical 


machine, lmhostid must be run from the Console OS.


See Also 
Hostids for Supported Platforms


lminstall
The lminstall utility is designed primarily for typing in decimal format licenses to generate a readable format 
license file.


Usage


lminstall [-i in_lic_file] [-maxlen n] [-e err_file] [-o out_lic_file] \
[-overfmt {2 | 3 | 4 | 5 | 5.1 | 6 | 7 | 7.1 | 8}] [-odecimal]

128 FNP-11121-LAG00 License Administration Guide







Chapter 12: Using License Administration Tools
Command-Line Utilities

Normally, to convert from decimal to readable format, lminstall is used with no arguments; you are prompted for 
the name of the output license file. The default file name is today’s date in yyyymmdd.lic format. Move this file to the 
application’s default license file directory, if specified by the software publisher. Otherwise, use the 
LM_LICENSE_FILE or VENDOR_LICENSE_FILE environment variables to specify the directory where the *.lic files are 
located.


To finish entering, type q on a line by itself or enter two blank lines.


When an input file is specified with no output file specified, output goes to stdout; if neither input nor output file is 
specified, lminstall assumes that input comes from stdin and prompts the user for an output file name. 


lminstall is also used to convert licenses from readable to decimal format and between different license versions.


To convert from readable to decimal:


lminstall -i in_lic_file -o out_lic_file -odecimal


To convert to v5.1 format:


lminstall -i in_lic_file -o out_lic_file -overfmt 5.1


To enforce a maximum line length of, for example, 50 characters:


lminstall -maxlen 50


Conversion errors are reported as necessary and can be written to a file by specifying -e err_file. lminstall has 
a limit of 1,000 lines of input.


lmnewlog
The lmnewlog utility switches the report log file by moving the existing report log information to a new file, then 
starting a new report log with the original report log file name. If you rotate report logs with lmnewlog instead of 
lmswitchr, you do not have to change the file name in the REPORTLOG line of the vendor daemon’s option file. 
Requires a version 7.1 or later vendor daemon.


Usage


lmnewlog [-c license_file_list] feature renamed_report_log


or:


lmnewlog [-c license_file_list] vendor renamed_report_log


where:


Table 12-8 • lmnewlog Argument Usage


Argument Description


-c license_file_list Use the specified license files.


feature Any feature in this license file.
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lmpath
The lmpath utility allows direct control over license path settings. It is used to add to, override, or get the current 
license path settings.


Usage


lmpath {-add | -override | -status} {vendor | all} license_file_list


where:


Note • lmpath works by setting the registry entry on Windows or $HOME/.flexlmrc on UNIX.


vendor name of the vendor daemon in this license file.


renamed_report_log New file path where existing report log information is to be moved.


Table 12-9 • lmpath Argument Usage


Argument Description


-add Prepends license_file_list to the current license search path or creates the 
license search path, if it doesn’t exist, initializing it to license_file_list. 
Duplicates are discarded.


-override Overrides the existing license search path with license_file_list. If 


license_file_list is the null string, "", the specified list is deleted. 


• lmpath -override all ""—Deletes the value of LM_LICENSE_FILE.


• lmpath -override vendor ""—Deletes the value of VENDOR_LICENSE_FILE.


-status Displays current license path settings.


vendor A vendor daemon name. Affects the value of VENDOR_LICENSE_FILE.


all Refers to all vendor daemons. Affects the value of LM_LICENSE_FILE.


license_file_list On UNIX, separate values with a colon. On Windows, separate values with a 


semicolon. If license_file_list is the null string, "", then the specified entry is 
deleted.


Table 12-8 • lmnewlog Argument Usage


Argument Description
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To display the current license path settings:


lmpath -status


The following is displayed:


lmpath - Copyright (c) 1989-2013 Flexera Software LLC.
Known Vendors:
_____________
demo:   ./counted.lic:./uncounted.lic
_____________
Other Vendors:
______________
/usr/local/flexlm/licenses/license.lic


Note that where the path is set to a directory, all the *.lic files are listed separately. 


lmremove (in License-File-Based Licensing)
The lmremove utility allows you to remove a single user’s license for a specified feature. If the application is active, it 
rechecks out the license shortly after it is freed by lmremove. Note that lmadmin’s default setting disables lmremove. 
To enable lmremove, start lmadmin with the -allowLicenseReclaim argument.


Usage


lmremove [-c license_file_list] feature user user_host display


or


lmremove [-c license_file_list] -h feature server_host port handle


where:


Table 12-10 • lmremove in License-file-based licensing Argument Usage


Argument Description


-c license_file_list Specify license files.


-h Specify the license by its handle. Include feature, server_host, port, and 
handle with this argument.


feature Name of the feature checked out by the user.


user Name of the user whose license you are removing, as reported by lmstat -a.


user_host Name of the host the user is logged into, as reported by lmstat -a.


display Name of the display where the user is working, as reported by lmstat -a.
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The user, user_host, display, server_host, port, and handle information must be obtained from the output of lmstat 
-a.


lmremove removes all instances of user on user_host and display from usage of feature. If the optional -c 
license_file_list is specified, the indicated files are used as the license file.


The -h variation uses the server_host, port, and license handle, as reported by lmstat -a. Consider this example 
lmstat -a output:


joe nirvana /dev/ttyp5 (v1.000) (cloud9/7654 102), start Fri 10/29 18:40


In this example, the user is joe, the user host is nirvana, the display is /dev/typp5, the server host is cloud9, the 
TCP/IP port is 7654, and the license handle is 102. 


To remove this license, issue one of the following commands:


lmremove f1 joe nirvana /dev/ttyp5


or


lmremove -h f1 cloud9 7654 102


When removing by handle, if licenses are grouped as duplicates, all duplicate licenses are also removed. If license 
lingering is set and lmremove is used to reclaim the license, lmremove starts, but does not override, the license’s 
linger time. 


You can protect the unauthorized execution of lmremove when you start up lmgrd. The default for lmadmin is to 
disable lmremove because removing a user’s license is disruptive.


See Also
Downloading and Installing lmadmin License Server
lmgrd Command-Line Syntax for details about securing access to lmremove


lmremove (in Trusted-Storage-Based Licensing)
License Administrator (LA) uses lmremove utility to perform trusted storage borrow reclaim action when enabled 
by publisher. Note that lmadmin’s default setting disables lmremove. To enable lmremove, start lmadmin with the -
allowLicenseReclaim argument. 


server_host Name of the host on which the license server is running.


port TCP/IP port number where the license server is running, as reported by lmstat 
-a.


handle License handle, as reported by lmstat -a.


Table 12-10 • lmremove in License-file-based licensing Argument Usage


Argument Description
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Usage


lmremove <-c licfile> [-tsborrow <client_hostname>] | [-tsborrowstat]


where:


lmremove utility allows the license administrator to perform borrow reclaim action by removing the deduction 
records from server trusted storage for the specified client host.


The publisher can enable this feature by setting appropriate values for the borrow reclaim percentage.By default, 
the reclaim percentage is set to 0 so the reclaim operation is not allowed.


The licenses activated or borrowed only from the activatable and hybrid license group can be reclaimed. Note that, 
the licenses obtained from concurrent license group cannot be reclaimed with this feature. 


To be able to use the borrow reclaim feature, lmremove utility should run on the same system as license server. 


For example,


• borrow reclaim percentage is 10% 


• total license count is 25


• client "nirvana" borrowed a license from server trusted storage 


• client “cloud9” activated 2 licenses from server trusted storage


 To view the borrow reclaim status on the license server, issue one of the following commands:


    lmremove -c port@host –tsborrowstat


or


Table 12-11 • lmremove in trusted storage argument usage


Argument Description


-c Specifies both license file and port@host. 


-tsborrow Specifies trusted storage borrow reclaim, using this option along with client host 
name is mandatory.


client host name The deduction record(s) associated with the hostname that could be reclaimed.


tsborrowstat Specifies trusted storage borrow reclaim status. When this option is used, no 
borrow reclaim operation would be performed and borrow reclaim status would 
be displayed with the following information:


• Number of licenses borrowed currently


• Percentage borrow reclaim level


• Count of reclaimed licenses


• Number of borrow reclaims currently available
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    lmremove -c counted.lic -tsborrowstat


Output similar to following is displayed:


=== ACTIVATION BORROW RECLAIM STATUS ===


Number of licenses borrowed currently: 24


Percentage borrow reclaim level: 10%


Count of reclaimed licenses:0


Number of borrow reclaims currently available: 2


Number of borrow reclaims currently available = ((total number of deduction records * borrow reclaim percentage) 
– (count of reclaimed licenses) = (24 * 10%) – (0) = 2.4 rounded to 2.


Assume, the client host “nirvana” is lost or damaged.


To reclaim the borrow licenses issued for client host “nirvana”, issue one of the following commands:


    lmremove –c port@host –tsborrow “nirvana”


or


    lmremove –c counted.lic –tsborrow “nirvana”


Output similar to the following is displayed: 


Lmremove: Sucessfully reclaimed (1) borrowed licenses(s) for the client “nirvana”.


Now, view the borrow reclaim status, issue one of the following the commands:


   lmremove -c port@host –tsborrowstat


or


   lmremove -c counted.lic -tsborrowstat 


Output similar to following is displayed: 


=== ACTIVATION BORROW RECLAIM STATUS ===


Number of licenses borrowed currently: 23


Percentage borrow reclaim level: 10%


Count of reclaimed licenses:1


Number of borrow reclaims currently available: 1


Notice that, the count of reclaimed licenses is incremented by the number of deduction records that are reclaimed.


Note • when a reclaimed deduction record expires the “Count of reclaimed licenses” is decremented by the one.


Assume, the client host “cloud9” is lost or damaged. To reclaim the borrow licenses issued for client host “cloud9”, 
issue one of the following commands,


     lmremove –c port@host –tsborrow “cloud9”


or


     lmremove –c counted.lic –tsborrow “cloud9”
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Output similar to following is displayed:


lmremove: Failed to perform activation borrow reclaim operation. (-205, 14100)


Failure reason: The requested activation borrow reclaim count (2) for client “cloud9” is greater than 
available reclaim count (1).


Assume, two more licenses are activated or borrowed. So, the number of deducted records is 25. Now, to reclaim 
the licenses issued for client host “cloud9” issue one of the following commands,


       lmremove –c port@host –tsborrowstat


or


    lmremove -c counted.lic -tsborrowstat


Output similar to following is displayed:


Lmremove: Successfully reclaimed (2) borrowed licenses for the client “cloud9”.


Now, to view the borrow reclaim status, issue one of the following commands, 


    lmremove –c port@host –tsborrowstat


or


    lmremove -c counted.lic -tsborrowstat


Output similar to following is displayed:


=== ACTIVATION BORROW RECLAIM STATUS ===


Number of licenses borrowed currently: 23


Percentage borrow reclaim level: 10%


Count of reclaimed licenses: 3


Number of borrow reclaims currently available: 0


Now the borrowed reclaim level of 10% is reached so no more reclaims are allowed. To reclaim any more licenses, 
the license administrator creates an offline request to reset the reclaimed license count. 


To reset the reclaimed license count, issue the following command and send the request.xml to publisher.


       servercomptranutil –new request.xml reference=BorrowClaimReclaim


To process the reset response from publisher, issue the following command, 


       servercomptranutil -process response.xml


Now, view the borrow reclaim status, issue one of the following commands, 


    lmremove –c port@host –tsborrowstat


or


    lmremove -c counted.lic -tsborrowstat
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Output similar to following is displayed:


=== ACTIVATION BORROW RECLAIM STATUS ===


Number of licenses borrowed currently: 23


Percentage borrow reclaim level: 10%


Count of reclaimed licenses: 0


Number of borrow reclaims currently available: 2


Notice that, the count of reclaimed licenses is reset to 0 and the number of borrow reclaims currently available are 
two.


See Also


Downloading and Installing lmadmin License Server
lmgrd Command-Line Syntax for details about securing access to lmreread


lmreread
 The following description refers to the operation of lmreread with lmgrd.


Note • lmadmin includes functionality to read license files and start vendor daemons instead of using lmreread.


The lmreread utility causes the license server manager to reread the license file and start any new vendor 
daemons that have been added. In addition, all currently running vendor daemons are signaled to reread the 
license file and their options files for changes. If report logging is enabled, any report log data still in the vendor 
daemon’s internal data buffer is flushed. lmreread recognizes changes to system host names, but cannot be used 
to change server TCP/IP port numbers. 


If the optional vendor daemon name is specified, only the named daemon rereads the license file and its options 
file (in this case, lmgrd does not reread the license file).


Usage


lmreread [-c license_file_list] [-vendor vendor] [-all]


where:


Table 12-12 • lmreread Argument Usage


Argument Description


-c license_file_list Use the specified license files.


-vendor vendor Only the vendor daemon, specified by the vendor option, rereads the license file 
and the options file. Additionally, lmgrd restarts vendor if necessary.


-all If more than one lmgrd is specified, instructs all instances of lmgrd to reread. 
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Note • If you use the -c license_file_list option, the license files specified are read by lmreread, not by lmgrd; 


lmgrd rereads the file it read originally.


You can protect the unauthorized execution of lmreread when you start up the license server manager, lmgrd.


Note • Ability for vendor daemon to participate in rereading of its option file introduced in version 8.0 vendor 


daemon


See Also
Downloading and Installing lmadmin License Server
Changes in lmreread Behavior when Using lmadmin
lmgrd Command-Line Syntax for details about securing access to lmreread


lmstat
The lmstat utility helps you monitor the status of all network licensing activities, including:


• Daemons that are running


• License files


• Users of individual features


• Users of features served by a specific vendor daemon


• BORROW licenses borrowed 


The lmstat utility prints information that it receives from the license server; therefore, it does not report on unserved 
licenses such as uncounted licenses. To report on an uncounted license, the license must be added to a served 
license file and the application must be directed to use the license server for that license file (via @host, port@host, 
or USE_SERVER). Queued users and licenses shared due to duplicate grouping are also not returned by lmstat. 


Usage


lmstat [-a] [-c license_file_list] [-f [feature]] [-i [feature]] [-s[server]]
[-S [vendor]] [-t timeout_value]


where:


Table 12-13 • lmstat Argument Usage


Argument Description


-a Displays all information. This option is a potentially expensive command. With 
many active users, this command option generates a lot of network activity.


-c license_file_list Uses the specified license files.
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-f [feature] Displays users of feature. If feature is not specified, usage information for all 
features is displayed.


-i [feature] Displays information from the feature definition line for the specified feature, or 
all features if feature is not specified.


-s [server] Displays status of all license files listed in $VENDOR_LICENSE_FILE or 


$LM_LICENSE_FILE on server, or on all servers if server is not specified.


-S [vendor] Lists all users of vendor’s features.


-t timeout_value Sets connection timeout to timeout_value. This limits the amount of time 


lmstat spends attempting to connect to server.


Table 12-13 • lmstat Argument Usage


Argument Description
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The output of lmstat -a looks similar to the following:


lmstat - Copyright (c) 1989-2013 Flexera Software LLC. All Rights Reserved.


Flexible License Manager status on Wed 02/28/2013 14:49


[Detecting lmgrd processes...]


License server status: 40000@prod


    License file(s) on prod: C:\prod\i86_n3\counted.lic:


prod: license server UP v11.5
Feature usage info:
Users of f1:  (Total of 4 licenses issued;  Total of 1 license in use)
"f1" v1.0, vendor: demo 
floating license 
daniel myhost2 19.36.18.26 (v1.0) (myhost1/40000 102), start Fri


2/28 14:29


where:


The user, user_host, display, server_host, port, and handle information is used when removing licenses with 
lmremove.


Table 12-14 • lmstat Output


Output Argument Description


daniel user User name.


myhost2 user_host Host where user is running.


19.36.18.26 display Display where user is running.


v1.0 version Version of feature.


myhost1 server_host Host where license server is running.


40000 port TCP/IP port on server_host where license server is running.


102 handle License handle.


start Fri 5/3 7:29 checkout_time Time that this license was checked out.
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lmswitch 
The lmswitch utility switches the debug log file written by a particular vendor daemon by closing the existing 
debug log for that vendor daemon and starting a new debug log for that vendor daemon with a new file name. It 
also starts a new debug log file written by that vendor daemon if one does not already exist.


Usage


lmswitch [-c license_file_list] vendor new_debug_log


where:


By default, debug log output from the license server and all vendor daemons started by the server get written into 
the same debug file. lmswitch allows companies to keep separate log files for different vendor daemons and 
control the size of their debug log file. 


If debug log output is not already directed to a separate file for this vendor daemon, lmswitch tells the vendor 
daemon to start writing its debug log output to a file, new_debug_log. If this vendor daemon is already writing to its 
own debug log, lmswitch tells the vendor daemon to close its current debug log file and start writing its debug 
log output to new_debug_log. 


Note • The effect of lmswitch continues only until the vendor daemon is shut down or its options file is reread via 


lmreread. When the vendor daemon is restarted or its options file is reread, it looks for a DEBUGLOG line in the 


options file to determine whether or not to write its debug log output into its own file and, if so, what file to write. 


See Also:
Downloading and Installing lmadmin License Server for information on lmadmin display
DEBUGLOG
Debug Log File


lmswitchr
The lmswitchr utility switches the report log file by closing the existing report log and starting a new report log with 
a new file name. It also starts a new report log file if one does not already exist. 


Table 12-15 • lmswitch Argument Usage


Argument Description


-c license_file_list Use the specified license files.


vendor Vendor daemon in this license file.


new_debug_log Path to new debug log file.
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Usage


lmswitchr [-c license_file_list] feature new_report_log


With version 5.0 or later vendor daemon, the command looks like this:


lmswitchr [-c license_file_list] vendor new_report_log


where:


If report logging is not enabled for the vendor daemon, lmswitchr tells it to start writing its report log output to 
new_report_log. If report logging is already enabled for the vendor daemon, lmswitchr tells the vendor daemon to 
close its report log file and start writing its new report log output to new_report_log. 


Note • The effect of lmswitchr continues only until the vendor daemon is shut down or its options file is reread via 


lmreread. When the vendor daemon is restarted or its options file is reread, it looks for a REPORTLOG line in the 


options file to determine whether or not to write report log output to a file and, if so, what file to write.


See Also:
REPORTLOG
lmnewlog
For security purpose, the TS borrow reclaim is performed only when lmremove utility runs in the same host as the 
license server and this would be enforced internally when “lmremove -tsborrow/-tsborrowstat" request is 
processed.
Report Log File


lmver
The lmver utility reports the version of a FlexNet Publisher library or binary file.


Usage


lmver filename


where filename is one of the following:


• The name of an executable file built with FlexNet Publisher


Table 12-16 • lmswitchr Argument Usage


Argument Description


-c license_file_list Use the specified license files.


feature Any feature in this license file.


vendor Vendor daemon in this license file.


new_report_log Path to new report log file.
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• The license server manager


• A license administration tool


• A vendor daemon


For example, if you have an application called spell, type lmver spell.


lmtools (Windows only)
The lmtools utility is a graphical user interface that allows you to administer the license server. This executable is 
available in the 32-bit and 64-bit Windows packages. Always use the newest version possible. You can get it from 
the software download site.


Some of the functions this utility performs include:


• Starting, stopping, and configuring license servers


• Getting system information, including hostids


• Getting server status


The lmtools utility has two modes in which to configure a license server:


• Configuration using a license file


• Configuration using services


On Windows Vista or later, you must run the lmtools utility as an administrator. If you do not run this executable as 
an administrator, the User Account Control (UAC) dialog will display as soon as it is started (as long as the UAC 
prompt is not disabled on the system).


Configuration Using License File


Operations are performed on a particular license file. The file can be either local or remote. In this mode, you 
cannot start the lmadmin or lmgrd process, but you can do everything else. 


Task: To configure this mode:


1. Run the lmtools utility.


2. Click the Configuration using License File button.


3. Enter one or more the license file names or port@host specifications.


Configuration Using Services


Operations are performed on a service, which allows starting lmadmin or lmgrd processes local to the system on 
which lmtools is running. For details on configuring services, see Configuring the License Server Manager as a 
Windows Service.
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Limitation on File Path Lengths


The following file paths, used when configuring lmtools, are limited to 255 characters:


• Path to the lmadmin.exe or lmgrd.exe file


• Path to the license file


• Path to the debug log file


Ethernet hostids on Windows platforms


From version 11.6.1 onwards lmtools reports only the hostids of physical ethernet adapters. Devices identified as 
virtual ethernet adapters are not reported as these identities are not permanent. 


Physical (Bare Metal) hostids on Virtual Machines


When run from a virtual machine, lmtools cannot return hostids for the physical machine that hosts the virtual 
machine. To obtain hostids for the physical machine lmhostid must be run from the Console OS.


Japanese User Identities


lmtools, when running on a system where native Microsoft shift-js user identities are used, does not correctly 
display the user identity using non-ASCII, multi-byte (such as Japanese) characters. To display user identities 
correctly in multi-byte characters, use lmstat instead.
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Managing the Options File

The options file allows the license administrator to control various operating parameters within the constraints of 
the license model. Users are identified by their user name, host name, display, IP address, or PROJECT (which is 
set with the LM_PROJECT environment variable).


For concurrent (floating) licenses, the license administrator can:


• Allow the use of features 


• Deny the use of features


• Reserve licenses


The concurrent licenses can be held either in license files or in fulfillment records within trusted storage. 


For activatable licenses, the license administrator can:


• Allow activation of licenses in a specific fulfillment record


• Deny activation of licenses in a specific fulfillment record


For all licenses, the license administrator can:


• Restrict the number of licenses available


• Control the amount of information logged about license usage


• Enable a report log file


• Control the automatic rereading of licenses


Options files allow you, as the license administrator, to be as secure or open with licenses as you like.


Lines in the options file are limited to 4000 characters. The \ character is the line-continuation character.
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Note • The following lists changes in the options file for FlexNet Publisher versions:


• PROJECT identification (set by LM_PROJECT) in options file was introduced in the version 7.0 vendor daemon.


• Option file control for licenses held in fulfillment records in trusted storage was introduced in the 11.3 vendor 


daemon.


• AUTOMATIC_REREAD keyword introduced in the version 11.7 vendor daemon.


Creating an Options File


Task: To create an options file:


1. Use the appropriate options listed in Options File Syntax to create the options file for a vendor daemon using 
any text editor. 


2. Locate the options file anywhere; however, it is recommended that the options file be placed in the same 
directory as the license file. 


3. Add the path to the options file in the license file as the fourth field on the VENDOR line for the application’s 
vendor daemon. For example:


VENDOR sampled /etc/sampled \
[OPTIONS=]/sample_app/sampled/licenses/sampled.opt


enables the sampled vendor daemon to look at the specified options file.


If the path is omitted, the vendor daemon automatically looks for a file according to the following criteria:


• The name of the file is vendor.opt, where vendor is the vendor daemon name.


• The directory that contains the license file used by the license server manager.


Note • The default options file name, vendor.opt, was introduced in the version 6 vendor daemon.
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Options File Syntax
The following is an overview of the available options. See Options File Examples for examples and additional 
information. Each line of the file controls one option. 


Table 13-1 • Option Keywords 


Option Keyword Description


AUTOMATIC_REREAD Turn off automatic reread of licenses at midnight.


ACTIVATION_LOWWATER Controls the number of licenses that cannot be borrowed or transferred.


ACTIVATION_ EXPIRY_DAYS Controls the activation request based on the expiration dates mentioned in 
options file during activation.


BORROW_LOWWATER Set the number of BORROW licenses that cannot be borrowed.


DAEMON_SELECT_TIMEOUT Defines the vendor daemon’s timeout limit.


DEBUGLOG Writes debug log information for this vendor daemon to the specified file 
(version 8.0 or later vendor daemon).


EXCLUDE Deny a user access to a feature.


EXCLUDE_BORROW Deny a user the ability to borrow BORROW licenses. 


EXCLUDE_ENTITLEMENT Deny a user the ability to activate licenses held in a fulfillment record in 
trusted storage.


EXCLUDEALL Deny a user access to all features served by this vendor daemon.


FQDN_MATCHING Sets the level of host name matching.


GROUP Define a group of users for use with any options.


GROUPCASEINSENSITIVE Sets case sensitivity for user and host lists specified in GROUP and 
HOST_GROUP keywords.


HOST_GROUP Define a group of hosts for use with any options (version 4.0 or later).


INCLUDE Allow a user to use a feature.


INCLUDE_BORROW Allow a user to borrow BORROW licenses. 


INCLUDE_ENTITLEMENT Allow a user to activate licenses held in a fulfillment record in trusted 
storage.
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Comments


Include comments in your options file by starting each comment line with the hash symbol, #. 


Specifying Features


When used within an options file entry, the feature name can be modified with an optional keyword-value pair to 
fully qualify it. This notation is used for distinguishing a particular group of licenses when there are multiple FEATURE 
lines for a single feature. The following syntax is used:


feature:keyword=value


For example:


f1:VERSION=2.0


specifies the version 2.0 pool of licenses for feature f1.


The following option keywords are used as feature name modifiers to denote a specific group of licenses: 


• VERSION= 


• HOSTID=


• EXPDATE=


• KEY=


• SIGN=


INCLUDEALL Allow a user to use all features served by this vendor daemon.


LINGER Allow a user to extend the linger time for a feature beyond its check in.


MAX Limit usage for a particular feature/group—prioritizes usage among users.


MAX_BORROW_HOURS Changes the maximum borrow period for the specified feature.


MAX_OVERDRAFT Limit overdraft usage to less than the amount specified in the license.


NOLOG Turn off logging of certain items in the debug log file.


REPORTLOG Specify that a report log file suitable for use by the FlexNet Manager 
license usage reporting tool be written.


RESERVE Reserve licenses for a user or group of users/hosts.


TIMEOUT Specify idle timeout for a feature, returning it to the free pool for use by 
another user.


TIMEOUTALL Set timeout on all features.


Table 13-1 • Option Keywords 


Option Keyword Description
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• ISSUER=


• NOTICE=


• VENDOR_STRING= (if configured by the publisher as a pooling component)


• dist_info=


• user_info=


• asset_info=


If the USER_BASED or HOST_BASED keywords appear in a feature line, this feature specification syntax must be used to 
qualify the feature.


Using a package name in place of a feature name applies the option to all of the components in the package.


Note • A colon (:) is a valid feature name character. If colons are in your feature names, specify a group of licenses 


with the following alternative syntax using quotation marks and spaces:


"feature keyword=value"


Specifying License Restrictions Using Type


Some option keywords restrict who may use licenses or where licenses may be used. These options take a type 
argument that specifies what the restriction is based on. 


When using the option keywords EXCLUDE, EXCLUDE_ENTITLEMENT, EXCLUDEALL, EXCLUDE_BORROW, INCLUDE, 
INCLUDE_ENTITLEMENT, INCLUDEALL, INCLUDE_BORROW, MAX, and RESERVE, the following values can be used for type:


• USER—User name of the user executing the FlexEnabled application. User names are case sensitive and 
cannot contain spaces. 


For the MAX option, you can also specify ALL_USERS as a value for the USER type. See MAX for details.


• GROUP—Name of the group of users executing the FlexEnabled application. (Before you can restrict an 
option by a specific group, the options file must also include a GROUP option that defines the group.) 


For the MAX option, you can also specify ALL_GROUPS as a value for the GROUP type. See MAX for details.


• HOST—System host name or IP address where the application is executing. Host names are not case 
sensitive. The IP address can contain wildcard characters.


When using the option keywords EXCLUDE, EXCLUDEALL, EXCLUDE_BORROW, INCLUDE, INCLUDEALL, INCLUDE_BORROW, 
MAX, and RESERVE, the following values can be used for type:


• DISPLAY—Display where the application is displayed. On UNIX, DISPLAY is /dev/ttyxx (which is always /
dev/tty when an application is run in the background) or the X-Display name. On Windows, it is the system 
name or, in the case of a terminal server environment, the terminal server client name. Display names are case 
sensitive.


• INTERNET—IP address of the system where the application is executing. 


• PROJECT—LM_PROJECT environment variable set by the user who is executing the FlexEnabled application. 
Project names are case sensitive. See Chapter 24, “Environment Variables,” for more information about this 
variable.
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On Windows (without terminal server), the HOST and DISPLAY names are both set to the system name. For licenses 
that allow checkouts from a terminal server (TS_OK keyword in the feature line), the USER, HOST, and DISPLAY names 
can be different from one another. 


The types listed above take a single member. For example:


EXCLUDE coolsoft USER joe


To specify a list of users or hosts, first define the list using the GROUP or HOST_GROUP option lines, then use the 
GROUP or HOST_GROUP type to specify the group name. For example:


GROUP stars joe barbara susan
EXCLUDE coolsoft GROUP stars


• IP address as a HOST specification introduced in version 8 vendor daemon.


• Colons in feature names introduced in version 8 vendor daemon.


AUTOMATIC_REREAD
This option applies to all concurrent licenses held in license files or trusted storage.


AUTOMATIC_REREAD OFF|ON


Controls the automatic rereading of license files and trusted storage when any features are found to have expired. 
The default when this option is not set is that at midnight each day a check of each license is made to determine if 
it has expired. When any license is found to have expired, all license files and trusted storage are reread.


To turn off this automatic reread at midnight, enter AUTOMATIC_REREAD OFF in the options file.


ACTIVATION_LOWWATER
This option allows license administrator to control the number of hybrid and activatable license that cannot be 
borrowed or transferred. It works with a hybrid and activatable license in server side trusted storage.


Syntax


ACTIVATION_LOWWATER entitlementID count
ACTIVATION_LOWWATER entitlementID:FID=fulfillmentID count


For example, the server has an entitlement AAAA with 10 hybrid counts.


The following line in the options file allow only 4 licenses from entitlement AAAA to be borrowed or transferred to 
another license server.


     ACTIVATION_LOWWATER AAAA 6


Table 13-2 • ACTIVATION_LOWWATER Terms


Term Description


entitlementID The entitlement Id originally used when requesting license activation.
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Note • If more than one ACTIVATION_LOWWATER option for the same EntitlementID and fulfillmentID is specified in 


the options file, only the first one will be considered and the rest of duplicate entries will be discarded. 


ACTIVATION_ EXPIRY_DAYS
This option is to control the activation request based on the expiration dates mentioned in the options file while 
activation. Publisher controls the activations based on the number of expiration days. If the expiration date is 
greater than the date set in the options file then the functionality is not successful. 


ACTIVATION_EXPIRY_DAYS entitlement ID days
ACTIVATION_EXPIRY_DAYS entitlementID:FID=fulfillmentID days


For example, if there are more than one entry in the options file, the functionality works fine with respect to first line 
given in the options file.


ACTIVATION_EXPIRY_DAYS ENTL-EZCALC 3


As per the example, if the current date is 11-December-2013 then the client can activate the license untill 13-dec-
2013. In case of normal activation without option file, client can borrow license beyond 13-dec-2013. 


Note • If more than one ACTIVATION_EXPIRY_DAYS option for the same EntitlementID and FulfillmentID with 


different count of days mentioned in the options file, then the functionality always considers first line and ignores 


subsequent lines. 


Hybrid or Activatable 
count


Number of licenses that cannot be borrowed/transferred.


 fulfillmentID 
(Optional)


A unique identity for this fulfillment record. Used to specify the fulfillment 
record to be returned.


Table 13-3 • ACTIVATION_EXPIRY_DAYS


Term Description


entitlementID The entitlement Id originally used when requesting license activation.


 fulfillmentID 
(Optional)


A unique identity for this fulfillment record. Used to specify the fulfillment record to 
be returned.


Table 13-2 • ACTIVATION_LOWWATER Terms


Term Description
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BORROW_LOWWATER
This option is used for licenses held in license files. When licenses are available in trusted storage, activation is 
normally provided instead of BORROW.


BORROW_LOWWATER feature[:keyword=value] n


Sets the number of licenses for a BORROW feature that cannot be borrowed. 


For example, a feature f1 has a count of 10 and borrowing is enabled in the application and on the FEATURE line:


FEATURE f1 ... 10 ... BORROW SIGN=...


The following line in the options file allows only 7 licenses for this feature to be borrowed:


BORROW_LOWWATER f1 3


DAEMON_SELECT_TIMEOUT
DAEMON_SELECT_TIMEOUT value_in_seconds


Specifies the threshold for the amount of time (in seconds) that can elapse before a vendor-daemon connection 
experiences a timeout. The maximum value is 60; the minimum is 1. 


Important • You can define the DAEMON_SELECT_TIMEOUT option only when the publisher has enabled it (that is, set 


the vendor variable ls_support_custom_daemon_select_timeout to 1). Best practice is for publishers to enable 


DAEMON_SELECT_TIMEOUT only for environments that have limited bandwidth. If this option is not enabled, the timeout 


value for the vendor-daemon connection is 1 second, by default.


The following rules apply to DAEMON_SELECT_TIMEOUT:


• A value over 60 is always considered 60.


• A value under 1 is always considered 1.


• The default value is 1.


Table 13-4 • BORROW_LOWWATER Terms


Term Description


feature Name of feature being affected.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features for 
details.


n Number of licenses that cannot be borrowed via license borrowing.
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DEBUGLOG
DEBUGLOG [+]debug_log_path


Specifies a location for the debug log output from the vendor daemon associated with this options file. Preceding 
the debug_log_path with a + character appends logging entries; otherwise, the file is overwritten each time the 
daemon is started. Note that this affects output from only the vendor daemon associated with this options file. The 
debug log output of the license server manager and any other vendor daemons in the same license file is not 
captured in this file.


On Windows, path names which include spaces have to be enclosed in double quotes. If lmgrd is started as a 
service, the default location for the report log file is the c:\winnt\System32 folder unless a fully qualified path is 
specified.


See Also:
Configuring the License Server Manager as a Windows Service
lmswitch
Debug Log File—Debug log output restricted to that of just the vendor daemon introduced in version 8 vendor 
daemon.


EXCLUDE
This option applies to concurrent licenses held in license files and trusted storage.


EXCLUDE feature[:keyword=value] type {name | group_name}


Excludes a user or predefined group of users from the list of who is allowed to use the feature. EXCLUDE supersedes 
INCLUDE; conflicts between the EXCLUDE list and the INCLUDE list are resolved by the EXCLUDE taking precedence.


For example, the following option syntax excludes the user hank from the list of users able to use feature f1:


Table 13-5 • EXCLUDE Terms


Term Description


feature Name of the feature or package being affected.


keyword=value Feature name modifier to denote a group of licenses. See “Specifying Features” for 
details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See “Specifying 
License Restrictions Using Type” for details.


name Name of an item of type type for which license usage is excluded.


group_name Name of the group to exclude. Group names are case sensitive. 
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EXCLUDE f1 USER hank


EXCLUDE_BORROW
This option is used for licenses held in license files. When licenses are available in trusted storage, activation is 
normally provided instead of BORROW.


EXCLUDE_BORROW feature[:keyword=value] type \
{name | group_name}


Excludes a user or predefined group of users from the list of who is allowed to borrow licenses for this BORROW 
feature. EXCLUDE_BORROW supersedes INCLUDE_BORROW; conflicts between the EXCLUDE_BORROW list and the 
INCLUDE_BORROW list are resolved by the EXCLUDE_BORROW taking precedence.


For example, the following option syntax excludes the user fred from the list of users able to borrow feature f1 
(assuming the feature has the BORROW attribute):


EXCLUDE_BORROW f1 USER fred


EXCLUDE_ENTITLEMENT
This option only applies to licenses held in trusted storage and supplied using activation.


Table 13-6 • EXCLUDE_BORROW Terms


Term Description


feature Name of the feature being affected.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features for 
details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See 
Specifying License Restrictions Using Type for details.


name Name of an item of type type for which license borrowing is excluded.


group_name Name of the group to exclude from borrowing. Group names are case sensitive. 
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EXCLUDE_ENTITLEMENT entitlementId type {name | group_name}


Excludes a user or pre-defined group of users, etc., from the list of who is allowed to activate the licenses 
contained in a fulfillment record held in trusted storage. EXCLUDE_ENTITLEMENT supersedes INCLUDE_ENTITLEMENT; 
conflicts between the EXCLUDE_ENTITLEMENT list and the INCLUDE_ENTITLEMENT list are resolved by the 
EXCLUDE_ENTITLEMENT taking precedence. 


For example, the following option syntax excludes the user pete from the list of users able to activate licenses 
provided in the fulfillment record specified by the entitlement ID AB456:


EXCLUDE_ENTITLEMENT AB456 USER pete


Table 13-7 • EXCLUDE_ENTITLEMENT Terms


Term Description


entitlementId The entitlement Id used when requesting a license activation.


type One of USER, HOST, GROUP, or HOST_GROUP. See Specifying License Restrictions Using 
Type for details.


name Name of an item of type type for which license usage is excluded.


group_name Name of the group to exclude. Group names are case sensitive. 

License Administration Guide FNP-11121-LAG00 155







Chapter 13: Managing the Options File
Options File Syntax

EXCLUDEALL
This option applies to concurrent licenses held in license files and trusted storage.


EXCLUDEALL type {name | group_name}


Excludes a user or predefined group of users from the list of who is allowed to use all features served by this 
vendor daemon.


For example, the following option syntax excludes any user on the system called chaos using all features served by 
this vendor daemon:


EXCLUDEALL HOST chaos


FQDN_MATCHING
This option applies to all licenses held in license files or trusted storage.


FQDN_MATCHING exact | lenient


Sets the level to which host names used in HOST type-specifiers must match the host name sent by the FlexEnabled 
application. The application is configured to send either its host name or its fully qualified domain name (FQDN) to 
the vendor daemon for validation with HOST type-specifiers. Check with your software publisher to determine fully 
qualified domain name support.


Only the last FQDN_MATCHING keyword in the options file has effect; all others are ignored.


Table 13-8 • EXCLUDEALL Terms


Term Description


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See Specifying 
License Restrictions Using Type for details.


name Name of an item of type type for which license usage is excluded.


group_name Name of the group to exclude. Group names are case sensitive. 


Table 13-9 • FQDN_MATCHING Terms


Term Description


exact The host name in the HOST type specifier must match in content and format to that 
sent by the application. This is the default setting.


lenient The host name sent by the application needs to match to the extent supplied in the 
HOST type specifier or by the application, which ever is less restrictive.
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Table 13-10 shows the outcome of matching attempts between HOST type-specifiers in the options file and host 
names sent by the application. 


Examples


Consider the following example that demonstrates restrictive host name matching:


INCLUDE f1 HOST myhost.abc.com


FQDN_MATCHING exact


This includes myhost.abc.com on the list of hosts able to use feature f1. Furthermore, the host name sent by the 
application must be a fully qualified domain name that matches myhost.abc.com exactly.


In contrast, consider this example, which is less restrictive:


INCLUDE f2 HOST myhost.abc.com


FQDN_MATCHING lenient


This includes myhost.abc.com on the list of hosts able to use feature f2. The license rights are authenticated and a 
checkout allowed if any of the following match:


• The FQDN - myhost.abc.com 


• The host name - myhost 


• The domain name - .abc.com 


The example below is even more lenient:


INCLUDE f2 HOST myhost


FQDN_MATCHING lenient


This includes the host name, myhost, on the list of hosts for feature f3. Since lenient matching is specified, host 
names such as myhost, myhost.abc.com, and myhost.xyz.com match, whereas yourhost or yourhost.abc.com do 
not match.


Table 13-10 • Host Name Matching Matrix


Options File Settings


Application configured 
for FQDN—sends 
myhost.abc.com


Application not 
configured for FQDN—
sends myhost


FQDN_MATCHING
exact


INCLUDE feature HOST
myhost


no yes


INCLUDE feature HOST
myhost.abc.com


yes no


FQDN_MATCHING
lenient


INCLUDE feature HOST
myhost


yes yes


INCLUDE feature HOST
myhost.abc.com


yes yes
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See Also
“Specifying License Restrictions Using Type”
FQDN_MATCHING introduced in version 9.3 client library and vendor daemon.


GROUP
GROUP group_name user_list


Defines a group of users for use in INCLUDE, INCLUDEALL, INCLUDE_ENTITLEMENT, EXCLUDE, EXCLUDEALL, 
EXCLUDE_ENTITLEMENT, and RESERVE option lines.


To create a large user group, define several GROUP lines each containing up to the maximum of 4,000 characters. All 
the users will be placed in a single group: Multiple GROUP lines for the same group name add all the specified users 
into the group.


For example, the following option syntax defines the group Hackers consisting of bob, howard, and james:


GROUP Hackers bob howard james


Note • USER_GROUP is an alias for GROUP.


GROUPCASEINSENSITIVE
GROUPCASEINSENSITIVE OFF|ON


If set to ON, user names and host names specified with the options file GROUP and HOST_GROUP keywords, 
respectively, are treated as case-insensitive. 


By default, GROUPCASEINSENSITIVE is OFF, and user and host names are treated as case-sensitive.


Table 13-11 • GROUP Terms


Term Description


group_name Name of the group being defined. Group names are case sensitive.


user_list List of user names in that group. Names are case sensitive and cannot contain 
spaces. Set the GROUPCASEINSENSITIVE options file keyword to turn on case 
insensitivity. See GROUPCASEINSENSITIVE.
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HOST_GROUP
HOST_GROUP group_name host_list


Defines a group of hosts for use in INCLUDE, INCLUDEALL, INCLUDE_ENTITLEMENT, EXCLUDE, EXCLUDEALL, 
EXCLUDE_ENTITLEMENT, and RESERVE option lines. Multiple HOST_GROUP lines add all the specified hosts into the 
group.


For example, the following option syntax defines the host group Pacific consisting of tokyo, seattle, and 
auckland:


HOST_GROUP Pacific tokyo seattle auckland


Anywhere a host name can be used in an options file, an IP address can be used instead. 


INCLUDE
This option applies to concurrent licenses held in license files and trusted storage.


INCLUDE feature[:keyword=value] type {name | group_name}


Includes a user or predefined group of users in the list of who is allowed to use licenses for this feature. Any user 
who is not in an INCLUDE or INCLUDEALL statement is not allowed to use that feature. EXCLUDE supersedes INCLUDE; 
conflicts between the EXCLUDE list and the INCLUDE list are resolved by the EXCLUDE taking precedence. 


Table 13-12 • HOST_GROUP Terms


Term Definition


group_name Name of the group being defined. Host group names are case sensitive.


host_list List of host names in that group. Names are case sensitive. Set the 
GROUPCASEINSENSITIVE options file keyword to turn on case insensitivity. See 
GROUPCASEINSENSITIVE.


Table 13-13 • INCLUDE Terms


Term Definition


feature Name of the feature or package being affected.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See 
Specifying License Restrictions Using Type for details.


name Name of an item of type type for which license usage is included.
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To include user bob in the list of users able to use feature f1:


INCLUDE f1 USER bob


The include list is created from all the INCLUDEALL and INCLUDE lines in the options file.


Note • INCLUDE is required for USER_BASED or HOST_BASED features. The license administrator specifies which users 


are allowed to use the product, via INCLUDE, and the license limits the number of users that are INCLUDEd. In a 


USER_BASED or HOST_BASED license model, users (or predefined groups of users) who are not listed with the INCLUDE 


keyword cannot check out a license.


INCLUDE_BORROW 
This option is used for licenses held in license files. When licenses are available in trusted storage, normally 
activation is provided instead of BORROW.


INCLUDE_BORROW feature[:keyword=value] type {name | group_name}


Includes a user or predefined group of users in the list of who is allowed to borrow the BORROW feature. Anyone not 
in an INCLUDE_BORROW statement is not allowed to borrow licenses. EXCLUDE_BORROW supersedes INCLUDE_BORROW; 
conflicts between the EXCLUDE_BORROW list and the INCLUDE_BORROW list are resolved by the EXCLUDE_BORROW taking 
precedence. 


group_name Name of the group for which license usage is included. Group names are case 
sensitive. 


Table 13-14 • INCLUDE_BORROW Terms


Term Definition


feature Name of the feature being affected.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features for 
details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See Specifying 
License Restrictions Using Type for details.


name Name of an item of type type for which license borrowing is included.


group_name Name of the group for which license borrowing is included. Group names are case 
sensitive. 


Table 13-13 • INCLUDE Terms


Term Definition
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For example, the following option syntax includes user tom in the list of users able to borrow feature f1:


INCLUDE_BORROW f1 USER tom


Note • For USER_BASED or HOST_BASED features a user or predefined group of users must be on both an INCLUDE list 


and an INCLUDE_BORROW list to borrow a feature.


INCLUDE_ENTITLEMENT
This option only applies to licenses held in trusted storage.


INCLUDE_ENTITLEMENT entitlementId type {name | group_name}


Includes a user or predefined group of users in the list of who is allowed to activate the licenses contained in a 
fulfillment record held in trusted storage. EXCLUDE_ENTITLEMENT supersedes INCLUDE_ENTITLEMENT; conflicts 
between the EXCLUDE_ENTITLEMENT list and the INCLUDE_ENTITLEMENT list are resolved by the EXCLUDE_ENTITLEMENT 
taking precedence. 


For example, the following option syntax includes the user claire in the list of users able to activate licenses 
provided in the fulfillment record specified by the entitlement Id AB456:


INCLUDE_ENTITLEMENT AB456 USER claire


INCLUDEALL 
This option applies to concurrent licenses held in license files and trusted storage.


INCLUDEALL type {name | group_name}


Includes a user or predefined group of users in the list of who is allowed to use all features served by this vendor 
daemon.


Table 13-15 • INCLUDE_ENTITLEMENT Terms


Term Definition


entitlementId The entitlement Id originally used when requesting a license activation.


type One of USER, HOST, GROUP, or HOST_GROUP. See Specifying License Restrictions Using 
Type for details.


name Name of an item of type type for which license usage is included.


group_name Name of the group to include. Group names are case sensitive. 
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For example, the following option syntax allows the user jane to use all features served by this vendor daemon:


INCLUDEALL USER jane


The include list is created from all the INCLUDEALL and INCLUDE lines in the options file.


LINGER
This option applies to concurrent licenses held in license files and trusted storage.


LINGER feature[:keyword=value] seconds


A lingering license stays checked out for a specified period of time beyond its checkin or FlexEnabled application 
exit, whichever comes first. The linger time may have been configured by the software publisher in the FlexEnabled 
application. When this is the case, then the longer linger time is applied. Thus you can set a longer linger time than 
configured by the software publisher but not shorten the linger time. 


For example, the following option syntax sets the linger value for feature f1 to one hour (3600 seconds):


LINGER f1 3600


The actual linger time varies somewhat since the vendor daemon checks all lingering licenses just once per 
minute. Also if a new license request is made that would otherwise be denied, a check of the lingering licenses is 
made immediately to attempt to satisfy the new request. 


Table 13-16 • INCLUDEALL Terms


Term Definition


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See Specifying 
License Restrictions Using Type for details.


name Name of an item of type type for which license usage is included.


group_name Name of the group to include. Group names are case sensitive. 


Table 13-17 • LINGER Terms


Term Definition


feature Name of the feature.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


seconds Number of seconds the license lingers. The software publisher sets a minimum 
value. If you specify a value for seconds that is smaller than the minimum, the 
minimum is used.
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MAX
This option applies to concurrent licenses held in license files and trusted storage.


MAX num_lic feature[:keyword=value] type {name | group_name}


Limits usage for a group or user.


USER and GROUP Examples


The following are examples of using the USER and GROUP types for the MAX option.


Note • Never position a MAX line that restricts USER user_name for a specific feature after a MAX line that restricts 


USER ALL_USERS for the same feature. Likewise, never position a MAX line that restricts GROUP group_name for a 


specific feature after a MAX line that restricts GROUP ALL_GROUPS for the same feature. The positioning invalidates the  


restriction in the later line.


• To limit the user jan to five licenses for feature f1, include the following line in the options file:


MAX 5 f1 USER jan


Table 13-18 • MAX Terms


Term Description


num_lic Usage limit for this user or group.


feature Feature or package this limit applies to.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See 
Specifying License Restrictions Using Type for details.


name Name of an item of type type for which usage is limited. 


To avoid having to repeat the MAX line multiple times to restrict all users, you can 
use one MAX line that specifies ALL_USERS as the value for the type USER (for 
example, USER ALL_USERS). See for USER and GROUP Examples more 
information.


group_name Name of the group to limit. Group names are case sensitive. (The options file 
must include a GROUP line that defines this group.)


To avoid having to repeat the MAX line multiple times to restrict all groups defined 
in the options file, you can use one MAX line that specifies ALL_GROUPS as the 
value for the type GROUP (for example, GROUP ALL_GROUPS). See for USER and 
GROUP Examples more information.
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• To limit all users to to five licenses for feature f1, include the following line:


MAX 5 f1 USER ALL_USERS


• To limit the user jan to five licenses  for feature f1 and all other users to four licenses for the same feature, 
include the following lines:


MAX 5 f1 USER jan
MAX 4 f1 USER ALL_USERS


• To limit group DEV to three license for feature f2 and all other groups to one license for the same feature, 
include these lines:


MAX 3 f2 GROUP DEV
MAX 1 f2 GROUP ALL_GROUPS


• If you attempt to position a MAX line that specifies ALL_USERS (or ALL_GROUPS) before a MAX line that specifies a 
single user (or single group), FlexNet Publisher cannot enforce the restriction in the second line because the 
user or group in the second line (in this case, the DEV group) is a part of ALL_USERS or ALL_GROUPS in the first 
line.


For example, the following line positioning is invalid:


MAX 1 f2 GROUP ALL_GROUPS
MAX 3 f2 GROUP DEV


Queueing Behavior When Requested Licenses Exceed MAX Limit


For current version vendor daemons, if queuing is allowed by the application, requests for licenses that exceed the 
limit set by the MAX keyword will be denied. From the above example, if the user jan requests six licenses for 
feature f1, the request will be denied. Requests from users or groups within the MAX limit that exceed the number of 
available licenses will be queued. For example, if the license file includes ten licenses for feature f1 and nine of 
those licenses are already checked out, a request from the user jan for two licenses will be queued. 


MAX_BORROW_HOURS
This option is used for licenses held in license files. When licenses are available in trusted storage, normally 
activation is provided instead of BORROW.


MAX_BORROW_HOURS feature[:keyword=value] num_hours


Changes the maximum period a license can be borrowed from that specified in the license file for feature. The 
new period must be less than that in the license file. If multiple MAX_BORROW_HOURS keywords appear in the options 
file, only the last one is applied to feature.


Table 13-19 • MAX_BORROW_HOURS Terms


Term Description


feature Feature this borrow period applies to. The feature must have BORROW enabled.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.
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MAX_OVERDRAFT
This option applies to concurrent licenses held in license files and trusted storage.


MAX_OVERDRAFT feature[:keyword=value] num_lic


Limits OVERDRAFT license usage below the OVERDRAFT allowed by the license file.


NOLOG
NOLOG {IN | OUT | DENIED | QUEUED | UNSUPPORTED}


Suppresses logging the selected type of event in the debug log file. 


num_hours Number of hours in the new borrow period. This value must be less than that 
specified in the license file for feature (the default, if not specified, is 168 hours).


Table 13-20 • MAX_OVERDRAFT Terms


Term Description


feature Feature this limit applies to.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


num_lic Usage limit for this user or group.


Table 13-21 • NOLOG Terms


Entry Description


NOLOG IN Turns off logging of checkins. Two separate NOLOG lines are required to 
turn off logging of checkouts and queued requests.


NOLOG OUT Turns off logging of checkouts. 


NOLOG DENIED


NOLOG QUEUED


Turns off logging of checkouts and queued requests. License 
administrators use this option to reduce the size of the debug log file. 
However, it can reduce the usefulness of the debug log when debugging 
license server problems.


Table 13-19 • MAX_BORROW_HOURS Terms


Term Description
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See Also
lmswitch


REPORTLOG
REPORTLOG [+]report_log_path


REPORTLOG specifies the report log file for this vendor daemon. It is recommended preceding the report_log_path 
with a + character to append logging entries; otherwise, the file is overwritten each time the daemon is started. 


On Windows, path names that include spaces have to be enclosed in double quotes. If lmgrd is started as a 
service, the default location for the report log file is the c:\winnt\System32 folder unless a fully qualified path is 
specified.


Note • FlexNet Manager is a separate product available from Flexera Software, it is used to process report log files. 


FlexNet Manager processes only report log files, not debug log files.


Reporting on Projects with LM_PROJECT


The FlexNet Manager report writer reports on projects. A project is set up by having all users working on the same 
project set their LM_PROJECT environment variable (or registry on Windows) to a string that describes the project. 
FlexNet Manager groups usage by project, as defined by what LM_PROJECT was set to when the application was 
run.


See Also 
Configuring the License Server Manager as a Windows Service
Environment Variables
Report Log File


RESERVE
This option applies to concurrent licenses held in license files and trusted storage.


NOLOG 
UNSUPPORTED


Suppresses UNSUPPORTED messages in the debug log. This suppresses 
error messages in the debug log that report a failure due to the feature 
being unsupported.


Table 13-21 • NOLOG Terms


Entry Description
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RESERVE num_lic feature[:keyword=value] type {name | group_name}


Reserves licenses for a specific user.


For example, the following option syntax reserves one license of feature f1 for user mel:


RESERVE 1 f1 USER mel


If you want to reserve a license for each of several users or groups, you must use a separate RESERVE line for each 
user or group. If a package name is specified, all components that comprise the package are reserved.


The RESERVE keyword should not be used on packages and package suites that also use the SUITE_RESERVED 
option. The RESERVE keyword in the options file includes static information about the reservation policy. The 
SUITE_RESERVED option reserves a set of package components. Once one package component is checked out, all 
the other components are reserved for that same user. When the license keys are checked out by a user, the 
SUITE_RESERVED option within the Package will dictate additional reservation policy which can dynamically change 
depending on the product usage pattern. Because these options present conflicting reserve parameters, they can 
not be used together. The total number of reservations supported per options file is 10000.


Note • Any licenses reserved for a user are dedicated to that user. Even when that user is not actively using the 


license, it is unavailable to other users. However, a RESERVEd license does not cause usage to be reported by 


FlexNet Manager if the license is not actually in use.


TIMEOUT
This option applies to concurrent licenses held in license files and trusted storage.


Table 13-22 • RESERVE Terms


Term Description


num_lic Number of licenses to reserve for this user or group.


feature Feature or package this reservation applies to.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


type One of USER, HOST, DISPLAY, INTERNET, PROJECT, GROUP, or HOST_GROUP. See 
Specifying License Restrictions Using Type for details.


name Name of an item of type type for which license usage is reserved.


group_name Name of group for which license usage is reserved. Group names are case 
sensitive. 
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TIMEOUT feature[:keyword=value] seconds


Sets the time after which an inactive license is freed and reclaimed by the vendor daemon.


Note • The software publisher must have enabled this feature in the FlexEnabled application for it to work. Contact 


your software publisher to find out if this feature is implemented. 


For example, the following option syntax sets the timeout for feature f1 to one hour (3600 seconds):


TIMEOUT f1 3600


TIMEOUT checks in the licenses if the FlexEnabled application has been inactive for a period longer than the 
specified time period. The daemon declares a process inactive when it has not received heartbeats from it whereas 
an active FlexEnabled application sends heartbeats. A TIMEOUT line must be present in the options file in order to 
take advantage of this feature. 


TIMEOUTALL
This option applies to concurrent licenses held in license files and trusted storage.


TIMEOUTALL seconds


Same as TIMEOUT, but applies to all features.


How the Vendor Daemon Uses the Options File
When the vendor daemon is started by lmadmin or lmgrd, the vendor daemon reads its options file. There is only 
one options file per vendor daemon and each vendor daemon needs its own options file. For any changes in an 
options file to take effect, the vendor daemon must read its options file. The lmreread utility causes the vendor 
daemon to reread its options file.


Table 13-23 • TIMEOUT Terms


Term Description


feature Name of the feature.


keyword=value Feature name modifier to denote a group of licenses. See Specifying Features 
for details.


seconds Number of seconds after which inactive license is reclaimed. The software 
publisher sets a minimum value.If you specify a value for seconds that is smaller 
than the minimum, the minimum is used.
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The lmreread utility enhanced in version 8.0 vendor daemon so that it causes the vendor daemon to reread the 
options file. If you are using earlier versions, the vendor daemon must be stopped and restarted in order for the 
options file to be reread.


Rules of Precedence in Options Files
Rules of precedence take effect when INCLUDE and EXCLUDE statements are combined in the same options file and 
control access to the same feature (in license files) or fulfillment record (in trusted storage). The following define 
the precedence when both types of statements appear together:


• If there is only an EXCLUDE list, everyone who is not on the list is allowed to use the feature. 


• If there is only an INCLUDE list, only those users on the list are allowed to use the feature. 


• If neither list exists, everyone is allowed to use the feature. 


• The EXCLUDE list is checked before the INCLUDE list; someone who is on both lists is not allowed to use the 
feature.


Once you create an INCLUDE or EXCLUDE list, everyone else is implicitly outside the group. This feature allows you, 
as a license administrator, the ability to control licenses without having to explicitly list each user that you wish to 
allow or deny access to. In other words, there are two approaches; you either:


• Give most users access and list only the exceptions, or


• Severely limit access and list only the those users that have access privileges


Options File Examples
The following information gives some examples of options files intended to illustrate ways to effectively control 
access to your licenses.


Simple Options File Example
RESERVE 1 compile USER robert
RESERVE 3 compile HOST mainline
EXCLUDE compile USER lori
NOLOG QUEUED


This options file restricts the use of concurrent licenses as follows:


• Reserves one license for the feature compile for the user robert.


• Reserves three licenses for the feature compile for anyone on the system with the host name mainline.


• Prevents the user lori from using the compile feature on any system on the network.


• Causes QUEUED messages to be omitted from the debug log file.
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The sum total of the licenses reserved must be less than or equal to the number of licenses specified in the 
FEATURE line. In the example above, there must be a minimum of four licenses on the compile FEATURE line. If fewer 
licenses are available, only the first set of reservations (up to the license limit) is used. 
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If this data were in file /a/b/sampled/licenses/sampled.opt, then modify the license file VENDOR line as follows:


VENDOR sampled /etc/sampled /sample_app/sampled/licenses/sampled.opt


Limiting Access for Multiple Users
Each INCLUDE, INCLUDEALL, INCLUDE_BORROW, INCLUDE_ENTITLEMENT, EXCLUDE, EXCLUDEALL, EXCLUDE_BORROW, 
EXCLUDE_ENTITLEMENT, MAX, and RESERVE line must have a single user name (or group) listed. To affect more than 
one user name create a GROUP. For example to exclude bob, howard, and james from using the feature called 
toothbrush, create the following options file:


EXCLUDE toothbrush USER bob
EXCLUDE toothbrush USER howard
EXCLUDE toothbrush USER james


However, there is an easier way. Create a GROUP and exclude the list of users from using the feature. Like the 
previous example, the following options file excludes bob, howard, and james from using the feature called 
toothbrush:


# First define the group "Hackers"
GROUP Hackers bob howard james
# Then exclude the group
EXCLUDE toothbrush GROUP Hackers


Now when you want to allow or deny access to any feature to that group, you have an alias list to make it simple.


Use HOST_GROUP to allow, deny, or reserve licenses for multiple hosts. For example, to exclude all users logged in 
on the hosts fred and barney from using a feature called f1, add these lines to your options file:


HOST_GROUP writers fred barney
EXCLUDE f1 HOST_GROUP writers


See Also
HOST_GROUP for more information about defining groups


EXCLUDE Example
#First Define the group "painters"
GROUP painters picasso mondrian klee
EXCLUDE spell GROUP painters
EXCLUDE spell USER bob
EXCLUDE spell INTERNET 123.123.123.*


This options file:


• Prevents the users picasso, mondrian, and klee from using the feature spell on any system on the network.


• Prevents the user bob from using the feature spell on any system on the network.


• Prevents any user logged into a host with an IP address in the range 123.123.123.0 through 123.123.123.255 
from using the feature spell.
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• Allows any other user, as long as they are not on the excluded IP addresses, and they are not a member of the 
painters GROUP, and they are not bob, to use feature spell (by implication).


Note that bob could have been added to the group painters. However, painters might be used for some other 
purpose in the future so the license administrator chose to handle bob as a special case here. In this case, the two 
EXCLUDE statements concatenate to create a list of four users. 


EXCLUDE_ENTITLEMENT Example
#First Define the group "admin"
GROUP admin johns adrianp maryt
EXCLUDE_ENTITLEMENT qf573k GROUP admin
EXCLUDE_ENTITLEMENT qf573k USER bob
EXCLUDE_ENTITLEMENT qf573k HOST cordelia


This options file:


• Prevents the users johns, adrianp, and maryt from activating any licenses contained in the fulfillment record 
obtained using the entitlement Id qf573k on any system on the network.


• Prevents the user bob from activating any licenses contained in the fulfillment record obtained using the 
entitlement Id qf573k on any system on the network.


• Prevents any user on the system called cordelia from activating any licenses contained in the fulfillment 
record obtained using the entitlement Id qf573k.


• By implication allows any other users on any system other than cordelia to activate the licenses contained in 
the fulfillment record obtained using the entitlement Id qf573k.


INCLUDE Example
INCLUDE paint USER picasso
INCLUDE paint USER mondrian
INCLUDE paint HOST bigbrush


This options file:


• Allows the user picasso to use the feature paint on any system on the network.


• Allows the user mondrian to use the feature paint on any system on the network.


• Allows any user, as long as they are on the host bigbrush, to use feature paint.


• Denies access to the feature paint to anyone except picasso, mondrian, or anyone from the host bigbrush (by 
implication).


INCLUDE_ENTITLEMENT Example
INCLUDE_ENTITLEMENT gy7210 USER tom
INCLUDE_ENTITLEMENT gy7210 USER anthony
INCLUDE_ENTITLEMENT gy7210 HOST jupiter

172 FNP-11121-LAG00 License Administration Guide







Chapter 13: Managing the Options File
Options File Examples

This options file does the following:


• Allows the user tom to activate any licenses contained in the fulfillment record obtained using the entitlement Id 
gy7210 on any system on the network.


• Allows the user anthony to activate any licenses contained in the fulfillment record obtained using the 
entitlement Id gy7210 on any system on the network.


• Allows any user, as long as they are on the host jupiter to activate any licenses contained in the fulfillment 
record obtained using the entitlement Id gy7210.


• By implication, denies the activation of any licenses contained in the fulfillment record obtained using the 
entitlement Id gy7210 to anyone except tom, anthony, or someone on the host jupiter.
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Ensuring License Availability

You can configure multiple license servers to allow FlexEnabled applications to continue to check our licenses if 
one of the license servers goes down. This failover protection for license servers can be provided using either of 
the following methods:


• Redundancy using the license search path: Configure and maintain multiple independent license servers, 
each with a subset of the total licenses available to the enterprise. Configure the FlexEnabled client with the 
license servers in the license search path. This provides load balancing capabilities and limited failover 
protection. You must manage different versions of the license rights on each license server. This configuration 
option is available when licenses are held in license files and in trusted storage.


• Three-server redundancy: Configure and maintain a set of three license server systems configured 
specifically for three-server redundancy. This provides failover protection only. You manage only one version of 
the license file and vendor daemon on all three license servers. This configuration option is only available 
when licenses are held in license files.


Do not store your license files on a single network file server (separate from the license servers) if you are using 
either of these methods of failover protection: The failure of the file server will cause all the license servers to fail.


Redundancy Using the License Search Path
In this configuration you install multiple license servers that each use a subset of the available licenses. Network 
machines are configured with a license search path that contains details of each license server. A FlexEnabled 
application tries each license server on the license search path in order until it succeeds or gets to the end of the 
list. 
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Example of Redundancy Using the License Search Path


This example demonstrates the use of two license servers, chicago and tokyo, that serve five licenses each for 
the features f1 and f2. The publisher supplies the following license files:


• For chicago


SERVER chicago 17007ea8 1700
VENDOR sampled /etc/mydaemon
FEATURE f1 sampled 1.000 01-jan-2013 5 SIGN=.....
FEATURE f2 sampled 1.000 01-jan-2013 5 SIGN=.....


• For tokyo


SERVER tokyo 17007ea8 1700
VENDOR sampled /etc/mydaemon
FEATURE f1 sampled 1.000 01-jan-2013 5 SIGN=.....
FEATURE f2 sampled 1.000 01-jan-2013 5 SIGN=.....


The license search path is set on the network machines using the LM_LICENSE_FILE environment variable so that 
machines in the US request licenses first from the license server chicago and machines in Japan request licenses 
first from the license server tokyo. 


• US machines set LM_LICENSE_FILE to - 1700@chicago:1700@tokyo


• Japanese machines set LM_LICENSE_FILE to - 1700@tokyo:1700@chicago 


This example uses UNIX syntax (:) for separating entries on the license search path. See Setting the License 
Search Path Using an Environment Variable for full details of the license search path syntax.


Limitations of Redundancy Using the License Search 
Path


The main limitation is that this method only provides limited protection: When a license server fails, the licenses it 
serves are no longer available. 


All licenses must be checked out from a single server


By default, once a FlexEnabled application has successfully checked out a license from a license server, all 
subsequent license requests from that application must be served by the same license server. When an application 
makes subsequent license requests and no more licenses are available from that license server, the license 
request is denied even though licenses may exist on another server. However, this behavior is configurable by 
software publishers. Contact your software publisher to determine whether or not each new license request scans 
all the license servers.


Licenses are queued from a single server


If the application supports license queuing, all licenses are queued from the first license server on the list rather 
than the request moving to another license server.
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Overview of Three-Server Redundancy
Using the three-server redundancy capability in FlexNet Publisher, all three license servers operate to form a triad. 
The license servers send periodic messages to each other to make sure that at least two servers are running and 
communicating. A quorum is formed when at least two of the three license servers are running and communicating 
with each other. 


The license servers are identified as either primary, secondary, or tertiary. One license server is also designated as 
the master [m] and is responsible for:


• Serving licenses to FlexEnabled applications


• Recording information into the debug log.


• Recording information into the report log.


If the master fails, then another license server becomes the master. 


In the following figure, the primary license server is the master [m]. When a FlexEnabled application sends a 
checkout request for a license, the master responds and then serves the license to the FlexEnabled application. 


Figure 14-1: Three-Server Redundancy Overview 
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If the master fails, then the secondary license server becomes the master (see the following figure) and will server 
licenses to FlexEnabled applications. The tertiary license server can never be the master. If both the primary and 
secondary license servers go down, licenses are no longer served to FlexEnabled applications. The master will not 
serve licenses unless there are at least two license servers in the triad running and communicating. 


Figure 14-2: Three-Server Redundancy Backup Failover 


Understanding How License Servers Communicate


When started, each license server reads the license file and checks that it can communicate with the other license 
servers. Until each license server establishes this first connection with the others, it will continue to send messages 
periodically.


Once the initial communication has been established, each license server periodically sends a heartbeat to the 
others. Heartbeats are messages sent over TCP/IP. Each license server sends a heartbeat and waits for a response 
from the other license servers. If a license server does not receive a response, it shuts down the vendor daemon so 
that it cannot serve licenses. A publisher or license administrator can configure the amount of time a license server 
waits to receive a heartbeat using the HEARTBEAT_INTERVAL property. 


Poor network communication causes system performance to slow.  Slow network communication can also cause a 
delay in the transmission of heartbeats between license servers.
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Configuring License Servers for Three-Server 
Redundancy


Perform the following steps to configure three-server redundancy:


1. Before obtaining the license server software package from the publisher, identify and set up the three systems. 
When selecting systems, make sure they are stable. Do not use systems that are frequently rebooted or shut 
down. 


2. Send the publisher the hostname and hostid values for these systems. Ask the publisher what system 
identifier they need for the hostid. This could be an Ethernet address, disk serial number, etc. The publisher 
will create license server components specifically for these systems.


Note • Best practice is to obtain a hostid of the same type for each of the three machines. Issues can arise if 


different hostid types are used in the configuration. If you plan to obtain the hostid using the default hostid type 


for a given machine, be aware that the default type can vary between operating-system platforms.


3. After receiving the license server package from the publisher, change the following SERVER line properties in 
the license file if necessary:


• port number the license servers uses to listen for communication 


• PRIMARY_IS_MASTER keyword 


• HEARTBEAT_INTERVAL property


Do not change the hostid values. If the hostid changes at any time, the license administrator must work with 
the software publisher to obtain a new license file.


4. Perform any additional configuration as required by the software publisher. 


5. Copy or install the license server software package to each of the three systems. 


6. Start the license servers in the following order: primary, secondary, and then tertiary.


An Example License File


The following is an example of a license file that is configured for three-server redundancy.


SERVER pat 17003456 2837 PRIMARY_IS_MASTER
SERVER lee 17004355 2837
SERVER terry 17007ea8 2837
VENDOR demo
FEATURE f1 demo 1.0 1-jan-2013 10 SIGN=”<...>”
FEATURE f2 demo 1.0 1-jan-2013 10 SIGN=”<...>”
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The following portions of the license file directly affect the three-server redundant configuration: 


• SERVER lines—Each line contains this information for the given server:


• The host name value: pat, lee, or terry.


• The hostid value: 17003456, 17004355, or 17007ea8. This example uses the value returned by the lmhostid 
utility default hostid type for each server. 


Note • Keep in mind that the default hostid type can vary between operating-system platforms. Best 


practice is to use the same hostid type for all three servers. 


• The TCP/IP port—In this example, 2837. All servers use the same port to listen for communication.


The following properties of the license file do not affect the three-server redundant configuration directly, but are 
used to define license rights or configure the license server.


• VENDOR line—This required element references the publisher’s vendor daemon.


• FEATURE lines—The two features, f1 and f2, define the license rights. The SIGN value for each FEATURE line 
encodes the license server hostid values.


Managing License Servers in a Three-Server 
Redundant Configuration


Using the lmstat Utility


The output message generated by the lmstat utility identifies which license server is the master. In the following 
example lmstat output, the secondary license server is the master.


[Detecting lmgrd processes...]
License server status: 30000@RMD-PRIMARY,30000@RMD-SECONDARY,
30000@RMD-TERTIARY
License file(s) on RMD-PRIMARY: C:\server\3.lic:
RMD-PRIMARY: license server UP v11.4
RMD-SECONDARY: license server UP (MASTER) v11.4
RMD-TERTIARY: license server UP v11.4


Starting and Stopping License Servers


To start the entire system, you must start each license server manager (lmadmin or lmgrd). Generally, it is good 
practice to start the primary license server before the secondary or tertiary license server. This allows the primary 
license server to become the master before the others start. If you start the secondary and tertiary before the 
primary, then the secondary will establish itself as master.


If you do not set the PRIMARY_IS_MASTER keyword for the primary license server, then the order in which you 
start the license servers is important. If you do not set this property, when you start the primary license server after 
the secondary license server control will not transfer to the primary license server. By setting the 
PRIMARY_IS_MASTER keyword, you ensure that when the primary license server is running, it is always the 
master.
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In three-server scenarios, a system administrator may wish to shut down one of the servers to perform 
maintenance on it, while the other two servers maintain a quorum and continue to serve licenses. Previously, 
shutting down a license server in a triad through lmdown (or lmtools) would shut down the entire triad. Now, a 
system admin can run lmdown -c 3server-license.lic from one of the machines in the triad. lmdown will read the 
3-server license file and provide a prompt asking which of the three listed servers to shut down.


Running the License Server Manager as a Service on Windows


There are no dependencies or known issues related to running the license server manager as a service in this 
configuration.


Logging and the Debug Log


When using three-server redundancy, the master records information to its local debug log and report log (and the 
Windows event log if this is configured). If this system fails, another license server becomes the master and records 
information to its local debug log and report log. Subsequently, there may be different versions of the debug log 
and report log on the primary and secondary license server which each contains different information.


Using Other Capabilities with Three-Server 
Redundancy


The following section describe other capabilities available in FlexNet Publisher Licensing Toolkit and how they 
interact with three-server redundancy.


Configuring the License Search Path


This configuration can be performed by either the software publisher or the license administrator. Before a 
FlexEnabled application can check out a license, it must know where to locate the license rights. The license 
search path identifies the location of license rights. 


When connecting to a license server configured for three-server redundancy, the FlexEnabled application must use 
the <port>@<host> convention (and not a license file location) in the license search path. 


The license search path should list the license servers in the same order that they appear in the license file. This 
helps shorten the amount of time it takes to identify the master server and respond to the checkout request. 
Although the configuration will work if you include only one of the license servers in the license search path, this 
may lengthen the amount of time it takes for the license server to respond to the checkout request. This is because 
the license server must identify all other license servers and designate a master.


Separate each <port>@<host> entry with a comma. Using the previous license file as an example, the license 
search path should be the following:


2837@pat,2837@lee,2837@terry


The FlexEnabled application will try to connect to each of the license servers in the list, in the order listed, until it 
either successfully connects to a license server or reaches the end of the list. This helps ensure that the 
FlexEnabled application can connect to the quorum.
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Specifying Three-Server Redundancy in the License Finder


When the license search path has not been configured, the FLEXlm License Finder dialog is displayed on Windows 
platforms when a FlexEnabled application is run. 


Task: To specify a triad of license servers in the License Finder dialog:


1. Select Specify the License File.


2. Click Next.


3. Type the path name or use the browse button to specify your three-server redundant license file. An Example 
License File shows a typical three-server redundant license file.


4. Click Next.


Note that the License Finder dialog option, Specify the License Server System, allows you to only specify a 
single license server and not a triad of license servers.


Using License File Keywords


The following keywords and properties for the SERVER line allow you to modify the configuration. 


• Host: this is the hostname of the system. The publisher should know this information when generating the 
license file. This value can be changed after the license file has been signed.


• Port: the port number that the license server uses to listen for communication. Unlike single license servers, 
each SERVER line must include a port number. This can be any number between 1024 and 64000 that is not 
used by another process running on the system. This value can be changed after the license file has been 
signed. If you are using lmadmin, you do not need to edit the license file: you can configure the port number 
using the interface. See on-line help for more details.


To make it easier to administer the license server, we strongly recommended that you define the same port 
number for each SERVER line. This value can be changed after the license file has been signed.


• PRIMARY_IS_MASTER: this keyword ensures that the primary server is the master whenever it is running and 
communicating with one of the other license servers. 


• If this is set and the primary server goes down, when the primary server comes back up again, it will 
always become the master.


• If this is not set and the primary server goes down, the secondary server becomes the master and 
remains the master even when the primary server comes back up. The primary can only become the 
master again when the secondary license server fails. 


This parameter is optional and should be placed on the first SERVER line. This value can be changed after the 
license file has been signed. The license server must be running a version 10.8 or later vendor daemon to use 
this keyword.


•  HEARTBEAT_INTERVAL=seconds: this indicates how long the license servers wait to receive a heartbeat 
from another license server before shutting down the vendor daemon. This value is used in the following 
equation to calculate the actual timeout value:
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timeout = (3 * seconds) + (seconds – 1)


The default value is 20, which equates to an actual timeout of 79 seconds. Valid values are 0 through 120. This 
parameter is optional and should be placed on the first SERVER line in the license file. This value can be 
changed after the license file has been signed. The license server must be running a version 10.8 or later 
vendor daemon to use this keyword. 


Using Options File Keywords


None of the keywords in the options file affect three-server redundancy.


Troubleshooting Tips and Limitations for 
Three-Server Redundancy


Important • Three-server redundancy configurations require all three servers use the same platform type. You can 


use any of the following platform types in the configuration, but each server must use the same platform type: 


HPV_*, VMW_*, or PHY_*. 


Separating the Contents of a License File


Because the hostid values in the SERVER lines are computed into the signature of each feature definition line, 
make sure you keep SERVER lines together with any feature definition lines as they were generated. This means 
that if you move a feature definition line to another file, you must also move the respective SERVER lines and 
VENDOR line.


Putting the License File on a Network File Server


Do not put the license file on a network file server. If you do this, you lose the advantages of having failover 
protection because the file server becomes a possible single point of failure. 


Using License Servers in Heavy Network Traffic


On a network with excessive traffic, the license servers may miss heartbeats which causes them to shut down the 
vendor daemon. The master may then stop serving licenses. If you find that heavy network traffic causes this to 
occur, you should set the HEARTBEAT_INTERVAL to a larger value. Enterprises can experience a performance 
issue when there is slow network communication or if FlexEnabled clients are using a dialup link to connect to the 
network.


Using Multiple Vendor Daemons


The license server manager (lmadmin or lmgrd) can not start vendor daemons from multiple software publishers 
when configured for three-server redundancy. The license server manager can only manage one vendor daemon. 
If one of the systems runs more that one vendor daemon, then the license administrator must run separate 
instances of the license server on that system to support the other vendor daemons. Make sure that the port 
numbers do not clash.
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Switching Between Three-Server Redundancy and Single-Server Configuration


While running, the license server manager (lmadmin or lmgrd) is not designed for switching from three-server 
redundancy to a single-server configuration (and vice-versa). To switch configurations, you need to do the 
following:


1. Shut down the license server manager in the single-server configuration or, in a three-server redundancy, all 
the license server managers currently running.


2. Do one of the following:


• For lmadmin:


a. From the lmadmin installation directory on a given machine, import the required license files for the 
new configuration to which you are switching (either the three-server-redundant or single-server 
configuration):


lmadmin -import <new_license_file_list> -force


b. Restart lmadmin.


• For lmgrd:


To restart lmgrd on a given machine in the configuration to which you are switching (either the three-
server-redundant or single-server configuration), enter the following from the directory in which lmgrd is 
located:


lmgrd -c <new_license_file_list>


Avoiding Undefined lmdown Behavior


If any two license servers in a three-server redundancy group are started with the -allowStopServer no option 
(lmadmin) or the -x lmdown option (lmgrd), then the behavior of lmdown is undefined for that system. 
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Managing Virtualized License 
Servers for File-Based Licensing

Virtualization software allows you to run multiple instances of a license server on a single machine. You can use 
virtualized license servers to take advantage of the high availability and fault tolerance that virtual machines offer. 


Note • This chapter deals with managing license servers configured for license-file-based licensing in a virtual 


environment. For information about trusted-storage-based licensing in a virtual environment, see Chapter 2, “Trusted 


Storage.”


Binding Solutions in a Virtual Environment
For license-file-based licensing, a license server can be bound to either the virtual machine itself or to a bare-metal 
element of a physical system--either the hypervisor hosting the virtual machine or a remote physical machine that 
communicates with the virtual machine--to prevent duplicate license servers and license overuse. A bare-metal 
binding element for a license server could be the MAC address, IP address, or other identifying element of this 
physical system.


FlexNet Publisher supports local bare-metal binding (to the hypervisor itself) and remote bare-metal binding (to a 
remote physical machine) for the following virtualization platforms: 


• VMware ESX and Hyper-V (local and remote bare-metal binding).


• VMware ESXi and Citrix XenServer (remote bare-metal binding only)


Binding Agent lmbind
To support bare-metal binding, FlexNet Publisher provides the binding agent, lmbind. This agent enforces a mutex 
lock on a host so that only a single instance of a vendor daemon can run at any given time across all virtual 
machines hosted on the hypervisor.
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The lmbind agent performs these services when the license server connects to it:


• Provides the requested physical binding information (for example, the Ethernet address of the physical 
system)


• Verifies that no other license server (of the same publisher) with the same binding information is currently 
connected


• Maintains a heartbeat contact with the license server


The lmbind agent runs on one of the following physical systems:


• The hypervisor hosting the virtual machine that runs the license server


• A remote physical Linux or Windows machine connected to the virtual machine via the lmbind 
communications protocol (defined using the LM_BINDING_AGENT environment variable)


Setting Up a Virtual License Server on VMware 
ESX


The process of setting up a license server on a virtual machine hosted by a VMware ESX hypervisor depends on 
the hostid chosen to bind the license file to the license server. This hostid can be either the virtual machine’s UUID 
(Universally Unique ID) or a hostid of a physical system--either the hypervisor or a remote physical machine that 
communicates with the virtual machine. The following sections demonstrate these two binding methods.


If your license-server virtual machine is being hosted by a VMware ESXi hypervisor, see Setting Up a Virtual 
License Server on VMware ESXi or XenServer for details.


Using the UUID Hostid
In general, the process for binding to the UUID of the virtual machine hosting the license server follows this outline.


Task: To bind to the UUID of the virtual machine hosting the license server


1. Identify the virtual machine on which the license server will be run, and download the platform-specific 
lmhostid utility from the Flexera Software website onto this virtual machine.


2. Run the following command from the command line of the virtual machine:


lmhostid -ptype VM -uuid


3. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the UUID value.


4. Modify the license certificate to configure server parameters (like TCP port number, options file, or other 
parameters).


5. Launch the license server on the virtual machine by pointing to the license certificate.
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Note • If the license server has to be moved to another physical machine, simply copy the virtual-machine 


image and move it to the new physical host machine. 


Using a Bare-Metal Hostid
In this scenario, you have made a request to the software publisher to run the license server on a virtual machine 
instance. In response, the publisher has mandated a bare-metal binding to the Ethernet address of either the 
VMware ESX hypervisor or to a remote physical system that communicates with the virtual machine.


Note About Binding in This Scenario


If the license-server virtual machine is being hosted on a VMware ESX hypervisor, lmbind can operate either on the 
hypervisor or on a remote physical machine that communicates with the virtual machine (through the 
LM_BINDING_AGENT environment variable). Best practice is to use an LMB_* hostid, which can identify the hypervisor 
itself or a remote physical machine. (See Chapter 6, “Hostids for Supported Platforms” for details.)


The scenario outlined in the next section uses the LMB_ETHER hostid.


Binding With the LMB_ETHER hostid


The bare-metal-binding process for a license server on a virtual machine follows this general outline.


Task: To bind the license server to the Ethernet address of the physical system


1. Identify the virtual machine on which the license server will be run.


2. Identify the physical machine--either the VMware ESX hypervisor hosting this virtual machine or a remote 
physical machine; and download the Linux lmhostid utility from the Flexera Software website to this physical 
system. 


Note • If you download lmbind to the VMware ESX hypervisor, see Installing lmbind for VMware ESX (with Linux 


Console OS) for additional details.


3. Do either:


• If lmbind is installed on the VMware ESX hypervisor, log in to the Console OS (COS), and run the following 
from the command line of the COS:


 lmhostid -ptype LMB -ether


• If lmbind is installed on a remote physical machine, log on to this physical machine, and enter the same 
command.
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4. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the Ethernet address of the physical system.


5. Modify the license certificate to configure server parameters (like TCP port number, options file, and other 
parameters).


6. If lmbind is installed on the VMware ESX hypervisor, log in to hypervisor as root, and then open the lmbind port 
on the COS firewall for both incoming and outgoing traffic, as follows:


#usr/sbin/esxcfg-firewall -o 27010,tcp,in,lmbind


#usr/sbin/esxcfg-firewall -o 27010,tcp,out,lmbind


7. From where lmbind is installed, enter the following command to launch the binding agent at port 27010:


lmbind -port 27010 -l lmbind.log


8. On the virtual machine that hosts the license server, configure the environment variable LM_BINDING_AGENT 
<port>@<host>, where 


• <port> is the TCP port number at which the binding agent is listening (27010 in the above example) 


• <host> is the fully qualified host name or IP address of the physical system on which lmbind is running


9. Launch the license server on the virtual machine by pointing to the license certificate.


Note • If the license server has to be moved to another physical machine, make a re-host request to the 


software publisher. However, if the license server has to be moved to another virtual machine on the same 


physical host, you do not need to contact the software publisher. The license server can simply be run on a 


different instance of the virtual machine hosted on the same physical host, after shutting down the license 


server running on the first virtual machine.


Setting Up a Virtual License Server on 
Microsoft Hyper-V


The process of setting up a license server on a virtual machine hosted by a Microsoft Hyper-V hypervisor depends 
on the hostid chosen to bind the license file to the license server. This hostid can be either the virtual machine’s 
UUID (Universally Unique ID) or the hostid of a physical machine--either the hypervisor or a remote physical 
machine that communicates with the virtual machine. The following sections demonstrate these two binding 
methods.


Using the UUID Hostid
In general, the process for binding to the UUID of the virtual machine hosting the license server follows this outline.
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Task: To bind to the UUID of the virtual machine hosting the license server


1. Identify the virtual machine on which the license server will be run.


2. Run the following command from the command line of the virtual machine:


lmhostid -ptype VM -uuid


3. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the UUID value.


4. Modify the license certificate to configure server parameters (like TCP port number, options file, or other 
parameters).


5. Launch the license server on the virtual machine by pointing to the license certificate.


Note • If the license server has to be moved to another physical machine, simply copy the virtual-machine 


image and move it to the new physical host machine. 


Using a Bare-Metal Hostid
In this scenario, you have made a request to the software publisher to run the license server on a virtual machine 
instance. In response, the publisher has mandated a bare-metal binding to the Ethernet address of either the 
VMware hypervisor or to a remote physical system that communicates with the virtual machine.


Note About Binding in This Scenario


If the license-server virtual machine is being hosted on a Microsoft Hyper-V hypervisor, lmbind can operate either 
on the physical hypervisor or on a remote physical machine that communicates with the virtual machine (through 
the LM_BINDING_AGENT environment variable). Best practice is to use an LMB_* hostid, which can identify either the 
hypervisor itself or a remote physical machine. (See Chapter 6, “Hostids for Supported Platforms” for details.)


The scenario outlined in the next section uses the LMB_ETHER hostid.


Binding With the LMB_ETHER hostid


The bare-metal-binding process for a license server on a virtual machine follows this general outline.
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Task: To bind the license server to the Ethernet address of the physical system


1. Identify the virtual machine on which the license server will be run.


2. Identify the physical machine--either the Microsoft Hyper-V hypervisor hosting this virtual machine or a remote 
physical machine; and download the platform-specific lmhostid utility from the Flexera Software website to 
this physical system. 


Note • If you download lmbind to the Hyper-V hypervisor, see Installing lmbind for Microsoft Hyper-V for 


additional details.


3. Do either:


• If lmbind is installed on the Microsoft Hyper-V hypervisor, log in to the Windows Console OS (COS), and 
run the following from the command line of the COS:


 lmhostid -ptype LMB -ether


• If lmbind is installed on a remote physical machine, log on to this physical machine, and enter the same 
command.


4. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the Ethernet address of the host machine.


5. Modify the license certificate to configure server parameters (like TCP port number, options file, and other 
parameters).


6. From where lmbind is installed, enter the following command to launch the binding agent at port 27010:


lmbind -port 27010 -l lmbind.log


7. On the virtual machine that hosts the license server, configure the environment variable LM_BINDING_AGENT 
<port>@<host>, where 


• <port> is the TCP port number at which the binding agent is listening (27010 in the above example) 


• <host> is the fully qualified host name or IP address of the physical system on which lmbind is running


8. Launch the license server on the virtual machine by pointing to the license certificate.


Note • If the license server has to be moved to another physical machine, make a re-host request to the 


software publisher. However, if the license server has to be moved to another virtual machine on the same 


physical host, you do not need to contact the software publisher. The license server can simply be run on a 


different instance of the virtual machine hosted on the same physical host, after shutting down the license 


server running on the first virtual machine.
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Setting Up a Virtual License Server on VMware 
ESXi or XenServer


The process of setting up a license server on a virtual machine hosted by a VMware ESXi or XenServer hypervisor 
depends on the hostid chosen to bind the license file to the license server. This hostid can be either the virtual 
machine’s UUID (Universally Unique ID) or the hostid of a remote physical machine that communicates with the 
virtual machine. The following sections demonstrate these two binding methods.


If your license-server virtual machine is being hosted by a VMware ESX hypervisor, see Setting Up a Virtual License 
Server on VMware ESX for details.


Using the UUID Hostid
In general, the process for binding to the UUID of the virtual machine hosting the license server follows this outline.


Task: To bind to the UUID of the virtual machine hosting the license server


1. Identify the virtual machine on which the license server will be run, and download the platform-specific 
lmhostid utility from the Flexera Software website onto this virtual machine.


2. Run the following command from the command line of the virtual machine:


lmhostid -ptype VM -uuid


3. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the UUID value.


4. Modify the license certificate to configure server parameters (like TCP port number, options file, or other 
parameters).


5. Launch the license server on the virtual machine by pointing to the license certificate.


Note • If the license server has to be moved to another physical machine, simply copy the virtual-machine 


image and move it to the new physical host machine. 


Using a Bare-Metal Hostid
In this scenario, you have made a request to the software publisher to run the license server on a virtual machine 
instance. In response, the publisher has mandated a bare-metal binding that uses an Ethernet address.
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Note About Binding in This Scenario


When the license-server virtual machine is being hosted on a VMware ESXi or XenServer hypervisor, lmbind can 
operate only on a remote physical machine that communicates with the virtual machine (through the 
LM_BINDING_AGENT environment variable). You must use an LMB_* hostid to identify this machine. (See Chapter 6, 
“Hostids for Supported Platforms” for details.)


Binding With the LMB_ETHER hostid


The bare-metal-binding process for a license server on a virtual machine follows this general outline.


Task: To bind the license server to the Ethernet address of the physical system


1. Identify the virtual machine on which the license server will be run.


2. Identify the remote physical machine on which to run lmbind; and download the Linux lmhostid utility from the 
Flexera Software website to this machine.


3. Log on to the physical machine, and enter this command:


 lmhostid -ptype LMB -ether


4. Send the output of this command to the software publisher. The software publisher sends back a license 
certificate in which the license server is bound to the Ethernet address of the physical system.


5. Modify the license certificate to configure server parameters (like TCP port number, options file, and other 
parameters).


6. From where lmbind is installed, enter the following command to launch the binding agent at port 27010:


lmbind -port 27010 -l lmbind.log


7. On the virtual machine that hosts the license server, configure the environment variable LM_BINDING_AGENT 
<port>@<host>, where 


• <port> is the TCP port number at which the binding agent is listening to (27010 in the above example) 


• <host> is the fully qualified host name or IP address of the physical system on which lmbind is running


8. Launch the license server on the virtual machine by pointing to the license certificate.


Note • If the license server has to be moved to another physical machine, make a re-host request to the 


software publisher. However, if the license server has to be moved to another virtual machine on the same 


physical host, you do not need to contact the software publisher. The license server can simply be run on a 


different instance of the virtual machine hosted on the same physical host, after shutting down the license 


server running on the first virtual machine.
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Installing lmbind on the Hypervisor
The specific procedure for installing the binding agent depends on your choice of platforms.


Installing lmbind for VMware ESX (with Linux Console 
OS)


As a 32-bit Linux application, lmbind runs on the console OS of VMware ESX. The binding agent only supports 
IPv4 connections.


Note • For VMware ESXi, lmbind can run only on a physical machine connected to the VMware ESXi hypervisor. 


Task: To install lmbind for Linux


1. Select a VMware ESX host, and download lmbind to this machine.


2. Select a port number for the Agent to listen to. The default port number range is from 27010 through 27019, if 
no port is specified while starting lmbind. (Any port is permitted as long as incoming and outgoing 
communication is enabled for that port.)


3. To start lmbind, enter lmbind --port <port>, where <port> is the TCP port number you selected in Step 2. 
(See lmbind Command Line Options for more information.). Only a single instance of lmbind can run on a 
given host.


Installing lmbind for Microsoft Hyper-V
As a 64-bit Windows application, lmbind runs on Windows Console OS of Microsoft Hyper-V and supports only 
IPv4 connections.


The Windows Management Instrumentation (WMI) service is required for virtualization support of Hyper-V. 


Task: To install lmbind using the Windows command line


1. Select a Hyper-V host, and download lmbind to this machine.


2. Start the Windows Management Instrumentation (WMI) service on the host.


3. Select a port number for the lmbind to listen to. The default port number range is from 27010 through 27019, if 
no port is specified while starting lmbind. (Any port is permitted as long as incoming and outgoing 
communication is enabled for that port.)
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4. To start lmbind, enter lmbind --port <port>, where <port> is the TCP port number you selected in Step 3. 
(See lmbind Command Line Options for more information.) Only a single instance of lmbind can run on a 
given host. In addition, the WMI service should be in running mode whenever lmbind is started.


lmbind Command Line Options
Table 15-1 lists the command line options supported by all versions of lmbind. 


Note • Command line options can optionally be specified by a single dash and the first letter of the option. For 


example, --port portNumber can be specified instead by -p portNumber. 


Table 15-1 • lmbind Command Line Options


lmbind option Description


--help Display the copyright and version information and command-line options.


--port <port> Specify the TCP port number at which the binding agent will be listening 
at. If the specified port number is not available, the program will exit with 
an error. If this option is not specified, the first available port in the range 
from 27010 through 27019 is chosen.


--log <logfile> Write the log information that includes the following information:


• Copyright information


• Version number


• Listening port


• (For each license server that is connected) Vendor daemon name, 
binding hostid, and port at which vendor daemon is communicating


--verbosity <level> Specify the verbosity level. This controls how much information gets 
written to the log file. Verbosity levels include:


• 0--All logging turned off


• 1--Default level


• 2--Default messaging, plus messages showing when the vendor 
daemon connects and disconnects


• 3--Messages from level 2, plus vendor-daemon heartbeat messages


• 4--Verbose information that helps in debugging connectivity 
problems
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Additional Considerations
Consider the following when configuring the binding agent:


• 3-server redundancy--When using the license server in a 3-server redundant configuration using hostid 
types that require connection to the binding agent, each license server that is part of the quorum must connect 
to a unique instance of the lmbind process. The hostids for all three servers must use the same platform type 
(VM_UUID or PHY_*). It is recommended that only PHY_* hostid types be used for a 3-server redundant 
configuration. 


• CVD support--If you desire a combined vendor daemon (CVD) to support the virtualization hostid types (such 
as VM_UUID or PHY_*), both the primary and all the secondary vendor daemons that constitute the CVD must 
have the appropriate vendor keys that support virtualization. If only some of the secondary vendor daemons 
have the requisite vendor keys that support virtualization, the behavior of the CVD is unpredictable with 
respect to the support for virtualization hostid types.


• Hypervisor COS use--Running a license server or a FlexEnabled client application on the COS of the 
hypervisor is not supported. The license server and FlexEnabled client application must run either on a 
physical machine or on a virtual machine.


Virtualization Support
The following picture illustrates how the FlexNet licensing server or a FlexEnabled application operates within a 
virtualization stack. The table below the picture lists the virtualization stacks that FlexNet Publisher supports.
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Use this table to determine the supported virtualization stacks:


FlexNet 
Publisher 
Architecture Guest OS Hypervisor Host ID (virtual) Host ID (native)


i86_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1 and SP2


• Windows 7 
(Professional, 
Enterprise, Ultimate)


• Windows Vista, 
including SP1 
(Ultimate) and SP2 
(Business, Enterprise, 
Ultimate)


VMware ESX 4.1/
ESXi 4.1 and 5.0


• VM_UUID


• VMW_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• VMW_HOSTNAME


• VMW_ETHER


• VMW_INTERNET


i86_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1 and SP2


• Windows 7 
(Professional, 
Enterprise, Ultimate)


• Windows Vista, 
including SP1 
(Ultimate) and SP2 
(Business, Enterprise, 
Ultimate)


Microsoft Hyper-V


• Windows 
Server 2008 
R2 (including 
SP1)


• Windows 
Server 2012


• VM_UUID


• HPV_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• HPV_HOSTNAME


• HPV_ETHER


• HPV_INTERNET


• HPV_VSN


i86_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1 and SP2


• Windows 7 
(Professional, 
Enterprise, Ultimate)


• Windows Vista, 
including SP1 
(Ultimate) and SP2 
(Business, Enterprise, 
Ultimate)


Citrix XenServer 
6.0


VM_UUID • LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID
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i86_n • Windows 8


• Windows 7 (Starter, 
Home Basic, Home 
Premium, 
Professional, 
Enterprise, Ultimate) 
and SP1


• Windows Vista, 
including SP1 
(Ultimate) and SP2 
(Starter, Home Basic, 
Home Premium, 
Business, Enterprise, 
Ultimate)


VMware 
Workstation 8


VM_UUID Not applicable


x64_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1, SP2, 
and R2


• Windows 7 (Ultimate 
and Enterprise)


• Windows Vista, 
including SP1 and SP2 
(Ultimate)


VMware ESX 4.1/
ESXi 4.1 and 5.0


• VM_UUID


• VMW_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• VMW_HOSTNAME


• VMW_ETHER


• VMW_INTERNET


x64_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1, SP2, 
and R2


• Windows 7 (Ultimate 
and Enterprise)


• Windows Vista, 
including SP1 and SP2 
(Ultimate)


Microsoft Hyper-V


• Windows 
Server 2008 
R2 (including 
SP1)


• Windows 
Server 2012


• VM_UUID


• HPV_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• HPV_HOSTNAME


• HPV_ETHER


• HPV_INTERNET


• HPV_VSN


FlexNet 
Publisher 
Architecture Guest OS Hypervisor Host ID (virtual) Host ID (native)
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x64_n • Windows 8


• Windows Server 2012


• Windows Server 2008, 
including SP1, SP2, 
and R2


• Windows 7 (Ultimate 
and Enterprise)


• Windows Vista, 
including SP1 and SP2 
(Ultimate)


Citrix XenServer 
6.0


VM_UUID • LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


x64_n • Windows 8


• Windows 7 (Starter, 
Home Premium, 
Professional, 
Enterprise, Ultimate)


• Windows Vista, 
including SP1 and SP2 
(Ultimate)


VMware 
Workstation 8


VM_UUID Not applicable


i86_lsb (on x86) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


VMware ESX 4.1/
ESXi 4.1 and 5.0


• VM_UUID


• VMW_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• VMW_HOSTNAME


• VMW_ETHER


• VMW_INTERNET


i86_lsb (on x86) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


Microsoft Hyper-V


• Windows 
Server 2008 
R2 (including 
SP1)


• Windows 
Server 2012


• VM_UUID


• HPV_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• HPV_HOSTNAME


• HPV_ETHER


• HPV_INTERNET


• HPV_VSN


i86_lsb (on x86) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


Citrix XenServer 
6.0


VM_UUID • LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


FlexNet 
Publisher 
Architecture Guest OS Hypervisor Host ID (virtual) Host ID (native)
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i86_lsb (on x86) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


VMware 
Workstation 8


VM_UUID Not applicable


x64_lsb (on x64) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


VMware ESX 4.1/
ESXi 4.1 and 5.0


• VM_UUID


• VMW_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• VMW_HOSTNAME


• VMW_ETHER


• VMW_INTERNET


x64_lsb (on x64) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


Microsoft Hyper-V


• Windows 
Server 2008 
R2 (including 
SP1)


• Windows 
Server 2012


• VM_UUID


• HPV_UUID*


• LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


• HPV_HOSTNAME


• HPV_ETHER


• HPV_INTERNET


• HPV_VSN


x64_lsb (on x64) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


Citrix XenServer 
6.0


VM_UUID • LMB_HOSTNAME


• LMB_ETHER


• LMB_INTERNET


• LMB_FLEXID


x64_lsb (on x64) • RedHat Enterprise 
Linux 5 and 6


• SUSE Linux Enterprise 
9, 10, 11


VMware 
Workstation 8


VM_UUID Not applicable


* FlexNet Publisher is in the process of deprecating VMW_UUID and HPV_UUID in favor of VM_UUID.


FlexNet 
Publisher 
Architecture Guest OS Hypervisor Host ID (virtual) Host ID (native)
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Licensing in a Cloud-Computing 
Environment

This chapter provides the following information to help the license administrator implement secure software 
licensing in a cloud-computing:


• Licensing Challenges in a Cloud Environment


• Scope of Support for Cloud Licensing


• Use Cases for Licensing Software in the Cloud


• Hostids for Binding


Note • For simplification, the remainder of this chapter refers to the cloud-computing environment as the cloud 


environment.


Licensing Challenges in a Cloud Environment
The fundamental concept of software licensing involves binding the license to characteristics of the physical 
machine on which the software resides and, for served licenses, on which the license server resides. These 
characteristics, called binding elements, include machine identities such as the Ethernet address or the host name. 
However, a cloud environment runs on virtual machines that are instantiated and brought down frequently. 
Consequently, the traditional hardware-based binding elements are not reliable in a cloud environment. 
Additionally, the FlexNet Publisher bare-metal-bindings (BMB) feature available in prior releases for on-premises 
virtual machines is unusable in a cloud environment; the license administrator does not have access to the 
physical hardware on which the virtual instances are running. This access is a prerequisite for the BMB feature.


A public cloud provider charges the customer based on the number of hours a machine instance is used. To 
optimize billing charges, a user typically stops or terminates an instance when it is not in use. This type of stop-
restart usage is contrary to the on-premises machine usage, which is typically continuous.Therefore, the ideal 
binding element in the cloud environment is one that has these attributes:


• Globally unique within the cloud infrastructure to prevent over-licensing by cloned images
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• Unchanging between normal start/stop, suspend/resume, live-process migration, and reboots of machine 
instances


• Not easily changed by the user


• Not usable when the license is outside the cloud


FlexNet Publisher provides licensing solutions that meet these binding-element requirements. These solutions are 
based on typical licensing use cases in a cloud environment and are within the scope of cloud-licensing support 
for this release. 


Scope of Support for Cloud Licensing
In this release, FlexNet Publisher limits its initial support for cloud licensing to the following:


• Licensing in the Amazon EC2 environment only


• Certificate-based licensing only


• 32-bit Windows, 64-bit Windows, 32-bit Linux, or 64-bit Linux machine instances (all in IPv4 format) for running 
FlexEnabled applications and license servers


Additionally, FlexNet Publisher does not support the following for cloud licensing:


• Cross-version signatures on served, node-locked license clients


• Composite hostids using Amazon machine bindings


• Three-server redundancy


Note • Cloud environments have other methods that compensate for three-server redundancy to ensure high 


availability of the license server.


Use Cases for Licensing Software in the Cloud
The following use cases describe typical licensing scenarios in a cloud environment. For each case, FlexNet 
Publisher provides a binding-element solution specific to the Amazon EC2 environment.


Note • The machine instance referenced in these use cases is known as the AMI (Amazon Machine Image) 


instance in the Amazon EC2 environment.
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Case 1: Traditional Served and Unserved Licensing in a 
Public Cloud


This use case involves software users (end-users or license administrators) deploying FlexEnabled applications in 
a public cloud much like deploying these applications on user premises. In the case of served licenses, the user 
can deploy and bind the FlexNet Publisher license server to a machine instance in the cloud. The user then 
deploys the FlexEnabled application as a license client to machines instances in the cloud, to machines in the 
enterprise network, or to both, with all clients pointing to the license server in the cloud. In the case of unserved 
licenses, the user simply deploys the node-locked FlexEnabled application to one or more machine instances in 
the cloud.


Binding Elements Required for Case 1


In the Amazon EC2 environment, this use case involves binding licenses to the AMI instance on which the license 
server resides or, for any node-locked licenses, to the AMI instance on which the specific license client resides. The 
required binding elements include the following:


• For served licenses, the elastic IP (EIP) address for the AMI instance on which the server resides 


• For node-locked licenses (served or unserved), the AMI instance ID for the AMI instance containing the 
license client


For a description of these binding elements and how to obtain them, see the Hostids for Binding section.


License Administrator Tasks for Case 1


Perform the following basic tasks for traditional served and unserved licensing in the cloud:


1. Open an Amazon Web Services account to use Amazon EC2.


2. Depending on the use case, set up a separate AMI instance for each license client and for the license server.


Note •  A large-sized AMI instance is recommended for the license server.


3. On the AMI instance for the license server, perform the following additional tasks:


• Ensure that the ports for the license server, vendor daemon, and the webport (for the license server 
manager user interface) allow incoming connections.


• Set the appropriate EC2 security group to control access to the license server port.


• Associate an Elastic IP (EIP) address with the AMI instance.


4. Download the platform-specific lmhostid utility from the Flexera Software website to these locations:


• For served licenses, the AMI instance hosting the license server


• For node-locked licenses, each license-client AMI instance to which you intend to bind licenses
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5. To obtain the required hostids listed in Binding Elements Required for Case 1, run the appropriate lmhostid 
command on the AMI instances. 


See Hostids for Binding for more information about the different lmhostid commands.


6. Send the hostids to the software publisher, who then uses this information to generate the license certificate.


7. When you receive the license file from the publisher, modify the license certificate to configure server 
parameters (like TCP port number, options file, or other parameters.)


8. Install the required FlexEnabled components on the AMI instances, using methods similar to on-premises 
deployment.


Case 2: Virtual Appliance Licensing in a Public Cloud
In this use case, the software publisher sets up a virtual appliance (VA)--that is, a machine instance on which the 
publisher pre-installs and pre-configures their FlexEnabled software product and supporting software stack. The 
publisher then makes the complete software setup available to customers in the public cloud. For example, if 
Flexera Software were to set up a VA for their product, FlexNet Operations, a machine image containing these 
software components is made available to customers:


• Red Hat Enterprise Linux 5.0


• FlexNet Operations


• Oracle database


Because the software is already installed and configured to use all these components, the time that the software 
user requires to get started is significantly reduced.


Basic VA Licensing Scenario


The software publisher advertises the availability of the VA on a pay-as-you-go basis, while the cloud provider 
handles the metering and billing of the VA (as it does for any machine instance in the cloud). 


1. The publisher advertises the availability and the cost of the VA to the customer base and provides a hostid that 
allows the customer access to the appliance.


2. The customer opens an Amazon account, instantiates the VA, and is billed by Amazon. Except for product 
support, no interaction needs to exist between the customer and the publisher.


3. Amazon tracks the usage of the VA and pays the publisher their share of the usage.


Binding Element Required for Case 2


In this use case, the software publisher handles retrieving the binding element and setting up the licensing on the 
VA. 
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License Administrator Tasks for Case 2


Generally, license administration for virtual appliances is handled by the software publisher. Contact the software 
publisher for any tasks you might have to perform. 


Case 3: Traditional Served and Unserved Licensing in a 
Virtual Private Cloud


A virtual private cloud (VPC) is a portion of the public cloud that forms the private cloud for a specific corporate 
enterprise. The enterprise deploys all of its network security policies on this VPC by establishing a secure tunneling 
mechanism (a virtual private network, or VPN) between the corporate network and the cloud components. This 
model is popular with enterprises who are concerned about security issues associated with the public cloud. Cloud 
providers, such as Amazon EC2, typically charge for both VPC machine-instance usage and for data crossing the 
VPN tunnel.


Basic VPC Licensing Scenario


A secure and cost-effective scenario for this use case is to run the license server in the cloud, deploy the 
FlexEnabled application as one or more license clients in the cloud, and run the license-server binding agent 
(lmbind) on a physical machine in the enterprise data center. Advantages to this setup include the following:


• License enforcement is based on the bare-metal binding (BMB) method, which FlexNet Publisher introduced 
for non-cloud virtual environments in a previous release. Binding the license file to a physical machine 
provides more license protection than binding the file to a virtual machine instance. 


• In a non-cloud virtual environment, the BMB method requires that you run lmbind on the physical machine 
hosting the virtual machine instance on which the license server runs. This requirement limits BMB support to 
Hyper-V and VMware virtual environments, which have the console operating systems necessary for running 
lmbind. However, in the VPC environment, this setup is virtual-machine-vendor independent. That is, you can 
run lmbind separately on any physical Windows or Linux machine in the enterprise; and the license server can 
run on any machine instance whose operating system is by the FlexNet Publisher license servers. 


• While you can always run the license server on a physical machine in the enterprise data center, the server has 
higher availability inside the cloud environment. By contrast, the lmbind agent requires less availability and is 
better suited for a physical machine in the data center; it is needed only at license-server startup and for 
heartbeat connections with the server, which are set at configurable intervals. 


• The data transferred between lmbind and the license server is a fraction of the data that is transferred between 
the license server and the application. Because VPC providers typically charge by the amount of data that 
crosses the VPN gateway, the more cost-effective option is to host lmbind, but not the server, inside the 
enterprise data center.
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Binding Elements Required for Case 3


In the Amazon EC2 environment, this use case involves binding licenses to the machine on which the lmbind 
component of the license server resides and, for any served node-locked licenses, to the AMI instance on which 
the specific license client resides. The required binding elements include the following:


• The lmbind binding identity for the physical enterprise machine where you intend lmbind to run. The 
software publisher specifies the type of lmbind hostid needed. 


• For any served node-locked licenses, the AMI instance ID for the AMI instance containing the license client.


For a description of these binding elements and how to obtain them, see the Hostids for Binding section.


License Administrator Tasks for Case 3


Perform the following basic tasks for traditional served and unserved licensing in a virtual private cloud:


1. Set up a separate AMI instance for each license client and for the license server.


Note • A large-sized AMI instance is recommended for the license server.


2. On the AMI instance for the license server, perform the following additional tasks:


• Ensure that the ports for the license server, vendor daemon, and the webport (for the license server 
manager user interface) allow incoming connections.


• Set the appropriate EC2 security group to control access to the license server port.


3. Download the platform-specific lmhostid utility from the Flexera Software website to these locations:


• The physical machine in your enterprise on which you intend to run lmbind 


• For any served node-locked licenses, each license-client AMI instance to which you intend to bind 
licenses


4. To obtain the hostids listed in Binding Elements Required for Case 3, run the appropriate lmhostid command 
on the AMI instances and on the physical machine running lmbind.


See Hostids for Binding for information about the different lmhostid commands.


5. Send the hostids to the software publisher, who then uses this information to generate the license certificate.


6. When you receive the license file from the publisher, modify the license certificate to configure server 
parameters (like TCP port number, options file, or other parameters.)


7. Install the required FlexEnabled components on the AMI instances, using methods similar to on-premises 
deployment.


For served licenses, continue with these steps:


8. Install lmbind on the physical enterprise machine, and launch it on port 27010. (Enter lmbind -port 27010 -l 
lmbind.log).
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Note • Download lmbind from the Flexera Software website.


9. On the virtual machine that hosts the license server, configure the environment variable LM_BINDING_AGENT 
port@host, where port is the TCP port number at which the binding agent is listening to (27010 in the above 
example), and host is the fully qualified host name or IP address of the physical machine hosting lmbind.


10. Launch the license server on the virtual machine by pointing to the license certificate.


Hostids for Binding
The binding element used to bind a license to the specific AMI instance on which the license client or the licence 
server resides is called the hostid of the AMI instance. This section discusses the types of hostids that FlexNet 
Publisher supports for licensing in the Amazon EC2 environment.


Supported Hostid Types
The following table describes the hostids that FlexNet Publisher supports in the Amazon EC2 environment. For 
instructions on how to retrieve each hostid, see the next section, Retrieving and Specifying Hostids. 


Table 16-1 • Hostid Types Supported in Amazon EC2 


Hostid Type Binding Applicability Characteristics


Elastic IP (EIP) 
address 


Licence server only • IPv4 format only.


• For use only on the SERVER line in the 
license file.


• Manually assigned to any running AMI 
instance.


• Static identity--that is, can be reassigned 
to another AMI instance if the current 
instance crashes. For example, if the 
instance containing the license server 
crashes, the license administrator can 
copy the server to another instance and 
reassign the EIP. 


• Cross-version signatures not required.


• Specific to Case 1: Traditional Served and 
Unserved Licensing in a Public Cloud.
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AMI instance ID License client only (node-
locked)


• Unique ID automatically assigned to an 
AMI instance.


• For use only on the INCREMENT or 
FEATURE line in the license file.


• Remains in tact when the instance is 
suspended, resumed, or rebooted, but 
disappears if the instance terminates 
accidentally or crashes.


• Cross-version signatures not supported. 
Therefore, legacy FlexEnabled 
applications cannot obtain licenses that 
are bound to this hostid.


• Specific to Case 1: Traditional Served and 
Unserved Licensing in a Public Cloud and 
Case 3: Traditional Served and Unserved 
Licensing in a Virtual Private Cloud.


lmbind binding 
identity


License server only • For use only on the SERVER line in the 
license file.


• Cross-version signatures not required.


• Specific to Case 3: Traditional Served and 
Unserved Licensing in a Virtual Private 
Cloud.


Table 16-1 • Hostid Types Supported in Amazon EC2 


Hostid Type Binding Applicability Characteristics
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Retrieving and Specifying Hostids
The following table lists the methods used by the software user or publisher (depending on the use case) to 
retrieve hostids in the Amazon EC2 environment. The table also shows how a given hostid is used in the license 
file.


Note • The System Info page in the lmadmin user interface does not show these hostids specific to the Amazon 


EC2 environment. To obtain these hostids, you must use the methods described the following table.


Table 16-2 • Retrieving and Specifying Hostids


Hostid Type Method to Obtain ID License File Syntax


Elastic IP (EIP) 
address 


Use either method:


• On the AMI instance containing the 
server, run the following command:


lmhostid -ptype AMZN -eip


• Obtain the EIP from the Amazon 
infrastructure.


Note • This lmhostid command actually 
returns the public IP address for the AMI 
instance, and this value might not always be 
the EIP address. Consider the following:


• If the AMI instance is associated with an 
EIP address, the EIP address is the public 
IP address. Consequently, lmhostid 
returns the EIP address.


• If the AMI instance has no EIP address 
associated with it, EC2 assigns a default 
public IP address, which is the value that 
lmhostid returns.


FlexNet Publisher strongly recommends 
obtaining the EIP address. To ensure 
lmhostid returns this value, associate the 
instance with an EIP address before running 
the command. If necessary, consult Amazon 
for help with this process.


Syntax:


AMZN_EIP=IPv4 address


Example:


SERVER this_host 
AMZN_EIP=184.72.45.35
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AMI instance ID Use either method:


• On the AMI instance containing the 
license client, run the following 
command:


lmhostid -ptype AMZN -iid


• Obtain the instance ID from the 
Amazon infrastructure.


Syntax:


AMZN_IID=AMI instance ID


Example:


INCREMENT F1 demo... 
HOSTID=AMZN_IID=i51e04315...SIGN=xxx


lmbind binding 
identity


On the physical machine hosting 
lmbind, run the appropriate command:


• lmhostid -ptype LMB -ether (to 
obtain ethernet address)


• lmhostid -ptype LMB -internet 
(to obtain IP address)


• lmhostid -ptype LMB -hostname 
(to obtain hostname)


• lmhostid -ptype LMB -flexid (to 
obtain dongle FLEXID)


Note • For dongles, only LMB_FLEXID=9 
and LMB_FLEXID=10 are currently 
supported. The dongle driver must be 
installed on the lmbind machine before you 
can obtain the hostid.


Syntax:


LMB_ETHER=ethernet address


LMB_FLEXID=9


Examples:


SERVER this_host 
LMB_ETHER=0019d22f8672


SERVER this_host LMB_FLEXID=9-
19dD22f86


Table 16-2 • Retrieving and Specifying Hostids


Hostid Type Method to Obtain ID License File Syntax
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IPv6 Support

Internet Protocol version 6 (IPv6) is the next generation IP protocol. This section contains information for license 
administrators who have networks that support IPv6 addresses. The information in this section assumes the reader 
has a familiarity with the IPv6 networking protocols. The following sections of this chapter describe the FlexNet 
Publisher support for IPv6.


• Capabilities that Support IPv6


• Deploying License Servers in Mixed Protocol Environments


Capabilities that Support IPv6
This section describes the capabilities in the FlexNet Publisher Licensing toolkit configurable by license 
administrators that support IPv6. This section describes components used with both license file-based licensing 
and trusted storage-based licensing.


When working with a software publisher to obtain a software package that supports IPv6, you should collect and 
provide the IP addresses of systems (FlexEnabled clients and license servers) that will be used in the license file.


License File


In a license file, the SERVER line can define an IPv6 address as the host value.


Options File


An options file can contain an IPv6 address to specify host restrictions when using the:


• INTERNET type in these keywords - EXCLUDE, EXCLUDEALL, EXCLUDE_BORROW, INCLUDE, INCLUDEALL, 
INCLUDE_BORROW, MAX, and RESERVE.


• HOST type in these keywords - EXCLUDE, EXCLUDE_ENTITLEMENT, EXCLUDEALL, EXCLUDE_BORROW, 
INCLUDE, INCLUDE_ENTITLEMENT, INCLUDEALL, INCLUDE_BORROW, MAX, and RESERVE 


• HOST_GROUP keyword (it takes IP addresses). 
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License Search Path


Entries in the license search path that use the ‘port@host’ convention to identify the license server, can specify an 
IPv6 address as the ‘host’ value.


Deploying License Servers in Mixed Protocol 
Environments


For FlexNet Publisher components to work properly using IPv6 addresses, all systems in an enterprise (including 
the network hardware and software) must be configure properly to support communication using IPv6 addresses. 
Before testing or deploying a FlexEnabled application that supports IPv6 or IPv4/IPv6 dual communication, make 
sure that all systems on the network can communicate successfully.


If the license server will run under any of the following operating systems, it can communicate with FlexEnabled 
clients using either IPv4 or IPv6 (as long as the network is configured properly).


• Any supported edition of Windows


• Any supported Linux platform


• Any supported UNIX platform


Because these operating systems support dual-layer communication, both IPv4 and IPv6 FlexEnabled clients can 
communicate with an IPv6 license server. In addition, IPv6 clients can communicate with an IPv4 license server 
using the IPv4 address. Figure 17-1 illustrates this behavior.


If you are using lmadmin as your license server, it supports both IPv4 and IPv6 clients. You must rename one of your 
vendor daemon executable files, because separate IPv4 and IPv6 vendor daemons are required.


 


Figure 17-1: License Server Running on Windows Vista or later, UNIX, or Linux 

212 FNP-11121-LAG00 License Administration Guide







Chapter 17: IPv6 Support
Deploying License Servers in Mixed Protocol Environments

If the license server runs on Windows XP or Windows Server 2003, there are certain limitations because of the 
limited dual-layer support on these operating systems. IPv4 FlexEnabled clients cannot communicate with a IPv6 
license server running on these operating systems. However, IPv6 FlexEnabled clients can communicate with an 
IPv4 license server running on these operating systems. Figure 17-2 illustrates this behavior.


Figure 17-2: License Server running on Windows 2003 or XP


If an enterprise runs license servers on Windows 2003 or Windows XP the license administrators should create and 
maintain two separate networks - one for IPv6 FlexEnabled clients (that will use the IPv6 license server) and the 
other for IPv4 FlexEnabled clients (that uses the IPv4 license server). The following figure illustrates this 
configuration. 


Figure 17-3: Separate IPv4 and IPv6 Environments
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Using Wildcards in an IPv6 Address
The wildcard character, “*,” may be used in place of an entire field or on a byte-by-byte basis to specify a range of 
addresses without having to list them all. For example, this example feature definition line is locked to four specific 
addresses:


FEATURE f1 myvendor 1.0 1-jan-2013 uncounted \
HOSTID="INTERNET=127.17.0.1,\


INTERNET=2001:0db8:0000:0000:ff8f:effa:13da:0001,\
INTERNET=127.17.0.4,\
INTERNET=2001:0db8:0000:0000:ff8f:effa:13da:0004" \


SIGN=”<...>”


The following example feature definition line specifies an entire range of addresses, including the four specific ones 
from the line above:


FEATURE f1 myvendor 1.0 1-jan-2013 uncounted \
HOSTID="INTERNET=127.17.0.*,\


INTERNET=2001:0db8:0000:0000:*:*:*:000*"\
SIGN=”<...>”
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Managing Licenses from Multiple 
Software Publishers

Overview of Multiple License Management 
Strategies


When you are running FlexEnabled applications from multiple software publishers, you might need to take steps to 
prevent conflicts during installation. There are several strategies to accomplish this, three of which are presented 
here:


• Multiple systems, each running one license server manager, one vendor daemon, and using one or more 
license files.


• One system running multiple license server managers, each managing one vendor daemon and one or more 
license files.


• One system running one license server manager, that manages multiple vendor daemons, each using its own 
license files. License files share a common directory.


Each of these three strategies is described in detail in the following sections. Variations are mentioned in Additional 
Considerations.
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Multiple Systems
In this scenario, each license server instance (lmadmin or lmgrd, vendor daemon, license file, and other files) is 
located on a separate system. Each system serves licenses just for its vendor daemon and runs its own local copy 
of the license server manager. Figure 18-1 shows this arrangement.


Figure 18-1: Multiple License Server Systems  


Advantages


• The license files for each software publisher are independent from one another.


• Systems are maintained separately. If one system goes down, the other systems continue to serve licenses for 
their software publishers.


• Each server has its own debug log. 


• The license requests are distributed.


Disadvantages


• Administrative overhead is the highest.
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Starting the License Servers
In this configuration, you start the license server on each machine separately. Each server runs a single vendor 
daemon. Use lmadmin or lmgrd as the license server manager.


Using lmadmin


When using lmadmin, you can start each license server using the lmadmin user interface or a command line. Repeat 
the procedure on each machine to start the license server on that machine.


Starting the License Servers Using the User Interface


Task: To use the lmadmin user interface to start the license servers


1. At a command prompt from the lmadmin installation directory on the machine, enter lmadmin. No specials 
command-line options are required.


2. Open the lmadmin user interface. For instructions, see Accessing the License Server Management Interface in 
Chapter 9, “lmadmin License Server Manager.”


3. From the lmadmin user interface’s main window, click Administration to open the Administration page, and 
sign in with your administrator credentials.


4. Go to the Vendor Daemon Configuration tab.


5. Click Import License File.


6. Select and import the license file.


Note •  A status message displayed on the lmadmin user interface lists any follow-up steps you need to 


perform after the import. If the message requests that you start (or restart) the vendor daemon, click 


Administer for the specific vendor daemon on the Vendor Daemon Configuration tab; and then click Stop or 


Start.


7. Repeat the import process for each license file you want to import for this server.


8. Close down the lmadmin user interface.


9. Repeat the previous steps to start the license server on the next machine.
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Starting the License Servers Using the Command Line


Task: To use the command line to start the license servers


1. Open a command window on the machine.


2. At a command prompt from the lmadmin installation directory, enter the following to import the license files:


lmadmin -import <server_system_n_license_list> 


where <server_system_n_license_list> is the list of license files for the specific vendor daemon on the 
license server, as described in Managing Multiple License Files.


Note • Use the -force option along with -import if you wish to reset configuration in server.conf to the 


current vendor daemon being imported.


3. Enter lmadmin (and any lmadmin options you might need) to start the license server. For a description of 
options, see lmadmin Command-line Arguments in Chapter 9, “lmadmin License Server Manager.”


4. Repeat the previous steps to start the license server on the next machine.


Using lmgrd


Task: To start the license server on each machine


On each machine, enter the following command:


lmgrd -c <server_system_n_license_list>


where <server_system_n_license_list> is the list of license files for the specific vendor daemon on the license 
server, as described in Managing Multiple License Files. In turn, the lmgrd instance on the machine starts the 
vendor daemon referred to in its license files.
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One System with Multiple License Server 
Instances


In this model, each vendor daemon and its associated license file or files is served by its own license server 
manager, and everything is contained in one system. Figure 18-2 depicts this scheme.


Figure 18-2: Multiple license server managers, Multiple License Files 


When maintaining separate license servers on the same system, keep in mind:


• If the TCP/IP port number is specified on the SERVER line, it must be different for each license server instance. 
Use a standard text editor to change the TCP/IP port number in each license file so that they are all different. If 
you are running 10 instances or less, you can omit all port numbers to let lmadmin (or lmgrd) assign unique 
ones for you within the default range of 27000–27009.


Note • For security purposes, best practice is not to let the license server manager assign a default port for 


each license server. Instead, for each server, specify a unique port number outside of the range 27000 through 


27009.


• You must make sure that you are using a compatible version of lmadmin (or lmgrd) for each particular license 
file. This is done by using an explicit path. See Version Component Compatibility.


• The number of license server instances is limited only by the CPU, available memory, and networking of the 
system.
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Advantages


• The license files for each software publisher are independent from one another.


• License servers are maintained separately. If one server goes down, the other servers continue to serve 
licenses.


• Each server has its own debug log. 


Disadvantages


• Administrative overhead is high.


• If the system goes down, all licenses are disabled.


• License request load is concentrated to one system.


Starting the License Servers
In this configuration, you start multiple license servers on one machine, each server running a single vendor 
daemon. Use lmadmin or lmgrd as the license server manager.


Using lmadmin


To start multiple lmadmin instances on the same machine, use the command line. 


Important • While you can run multiple lmadmin instances on a single machine, best practice is to run multiple 


vendor daemons with a single instance of lmadmin. See One System with One License Server and Multiple License 


Files.


Task: To start the license server instances on one machine


1. Open a command window on the machine.


2. At a command prompt from the directory where the first lmadmin is installed, enter the following to import the 
license files:


lmadmin -import <server_system_n_license_list> 


where <server_system_n_license_list> is the list of license files for the specific vendor daemon on the 
license server, as described in Managing Multiple License Files.


3. To start the lmadmin instance, enter the following:


 lmadmin -webPort <httpPort> -webSecurePort <httpsPort>
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where:


• <httpPort> is the TCP/IP port number that the web server uses to listen for communication with clients 
connecting to the lmadmin user interface. While 8090 is the default port number for the web server, you 
must provide a different port number for each lmadmin instance you are configuring.


• <httpsPort> is the TCP/IP port number for the Secure Web Server. You must provide a different port 
number for each lmadmin instance you are configuring.


Important • Specify the -webSecurePort option only if you are configuring an HTTP-over-SSL (HTTPS) 


communication with the lmadmin web server interface. To define additional certificate information for the 


Secure Web Server, access the lmadmin user interface using the correct URL based on <httpPort>. (On 


the Administration page, go to the Secure Web Server section of the Server Configuration tab.) For more 


instructions, see Accessing the License Server Management Interface in Chapter 9, “lmadmin License 


Server Manager.”


You can also specify any other lmadmin options you might need to start the license server. For a description of 
options, see lmadmin Command-line Arguments in Chapter 9, “lmadmin License Server Manager.”


4. Repeat the previous steps to start each lmadmin instance on the machine.


Using lmgrd


Task: To start the license servers


On the machine, invoke each license server:


• For Server 1: lmgrd -c vendor_ABC_license_dir_list


• For Server 2: lmgrd -c vendor_DEF_license_dir_list


• For Server 3: lmgrd -c vendor_XYZ_license_dir_list


where vendor_nnn_license_list is a list of license files as described in Managing Multiple License Files. Each 
lmgrd starts the vendor daemon referred to in its license files.
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One System with One License Server and 
Multiple License Files


In this scenario, one license server manager runs on the system and serves one or more vendor daemons, each 
with one or more license files. If you are using lmadmin, you can maintain license files from different publishers in 
separate directories. If you are using lmgrd, all the license files are usually held in the same directory. The standard 
filename extension for license files is .lic. The number of vendor daemons is not limited by FlexNet Publisher. 
Figure 18-3 illustrates this scenario.


Figure 18-3: One license server manager, Multiple License Files


Advantages


• The license files can be maintained separately.


• Reduced administrative overhead.


Disadvantages


• One license server manager serves all vendor daemons. If the license server manager goes down, all licenses 
are unavailable.


• If the system goes down, all licenses are unavailable.
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• Output from all vendor daemons goes into one common debug log unless separate debug logs are specified 
with DEBUGLOG in each vendor daemon’s options file. Having one common debug log makes it harder to 
debug a single vendor daemon’s problem.


• Maximizes licensing load to one system and one license server manager.


Starting the License Server
In this configuration, you start one license server on a single machine. The license server uses multiple license files 
(and hence possibly multiple vendor daemons). Use lmadmin or lmgrd as the license server manager.


Using lmadmin


When using lmadmin, you can start the license server using the lmadmin user interface or a command line. 


Starting the License Server Using the User Interface


Task: To use the lmadmin user interface to start the license server


1. At a command prompt from the lmadmin installation directory on the machine, enter lmadmin. No specials 
command-line options are required.


2. Open the lmadmin user interface. For instructions, see Accessing the License Server Management Interface in 
Chapter 9, “lmadmin License Server Manager.”


3. From the lmadmin user interface’s main window, click Administration to open the Administration page, and 
sign in with your administrator credentials.


4. Go to the Vendor Daemon Configuration tab.


5. Click Import License File. 


6. Select and import the license file.


Note • A status message displayed on the lmadmin user interface lists any follow-up steps you need to perform 


after the import. If the message requests that you start (or restart) the vendor daemon, click Administer for the 


specific vendor daemon on the Vendor Daemon Configuration tab; and then click Stop or Start.


7. Repeat the import process for each license file you want to import.


8. Close down the lmadmin user interface.
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Starting the License Server Using the Command Line


Task: To use the command line to start the license server


1. Open a command window on the machine.


2. At a command prompt from the lmadmin installation directory, enter the following to import the license files:


lmadmin -import <license_file_list> 


where <license_file_list> is the list of license files to import, as described in Managing Multiple License 
Files.


Note • Use the -force option with -import only if you want to overwrite server.xml settings previously defined 


for the vendor daemons specified in the license files.


3. Enter lmadmin (and any lmadmin options you might need) to start the license server. For a description of 
options, see lmadmin Command-line Arguments in Chapter 9, “lmadmin License Server Manager.”


Using lmgrd


Task: To start the license server


Enter the following command:


lmgrd -c <common_license_directory>


where <common_license_directory> is the directory containing the license files, as described in Managing Multiple 
License Files. (By specifying the directory, you do not need to enumerate each license file name on the lmgrd 
command line.)


lmgrd processes all files with the .lic extension in the directory and then starts all vendor daemons to which the 
files refer.


See Also
Managing Multiple License Files
Capturing Debug Log Output for a Particular Vendor Daemon


Managing Multiple License Files
As described in the previous sections, both lmadmin and lmgrd handle multiple license files. This section briefly 
describes how the license server managers handle multiple files and how you set up a multiple-license-file list. 
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Managing Multiple File in lmadmin
When using lmadmin as your license server manager, you can use the lmadmin user interface to import the license 
files one at a time or use the command-line -import option (and the license_file_list) to specify the files. See 
the previous sections for details.


Managing Multiple Files in lmgrd
When using lmgrd as the license server manager, you can manage multiple license files that are on the same 
system via a license search path. A license search path is specified two ways:


• By using the -c option to lmgrd:


lmgrd -c license_file_list [other lmgrd options]


• By defining the LM_LICENSE_FILE environment variable within the scope of the lmgrd process’s environment.


lmgrd builds up an internal license search path when it starts up by parsing each entry in the order listed.


Defining the License File List
Install the license files in convenient locations on the system, and then define the license_file_list. 


Wherever license_file_list is specified, it consists of a list of one or more of the following components. (Use a colon 
(:) to separate the license file names on UNIX; on Windows, use a semicolon (;).)


• The full path to the license file


• A directory containing one or more license files with a .lic extension


• The license server port. Use one of the following:


• A port@host setting, where port and host are the TCP/IP port number and host name from the SERVER 
line in the license file. 


• The shortcut specification, @host, if the license file SERVER line uses a default TCP/IP port or specifies a 
port in the default port range (27000–27009).


• A comma separated list of three port@host specifiers denoting a license servers configured for three-
server redundancy (for example, port1@host1,port2@host2,port3@host3).


Some scenarios where a license search path is used include those described in Multiple Systems, One System 
with Multiple License Server Instances, or One System with One License Server and Multiple License Files.


See Also
Setting the License Search Path Using an Environment Variable
Ensuring License Availability
Environment Variables
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Additional Considerations


Combining License Files
If you have two or more products whose licenses are intended for the same system, as specified by their SERVER 
lines, you may be able to combine the license files into a single license file. This has advantages if you are using 
lmgrd as your license server manager. 


Note • lmadmin supports the use of a combined license file. However, use of such a file is redundant when you can 


simply use the lmadmin user interface to add (import) any number of license files. Once a license file is imported, 


lmadmin manages it.


The license files for the models described in One System with Multiple License Server Instances and One System 
with One License Server and Multiple License Files could be combined if they met certain criteria. See Criteria for 
Combining License Files. Figure 18-4 shows one possible scenario using a combined license file.


Figure 18-4: One lmgrd, One License File 


Advantages


• A single license file to administer.


• Once the files are combined, there is low administrative overhead.


Disadvantage


• Careful planning must be given in combining license lines from multiple software publishers into one file, 
initially and over time.
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Starting the License Server


Task: To start the license server


Invoke the license server manager once on the system.


lmgrd -c combined_license_file


Criteria for Combining License Files
Your product’s license files define the license server systems by host name and hostid in the SERVER lines in the 
license file. License files are candidates for combining under the following conditions:


• The number of SERVER lines in each file is the same. 


• The hostid field of each SERVER line in one file exactly matches the hostid field of each SERVER line in the 
other file. 


 Some possible reasons license files may not be compatible are: 


• License files are set up to run on different server systems, so hostids are different. 


• One file is set up for a single license server (has only one SERVER line), the other is set up for a three-server 
redundancy (has three SERVER lines).


• Hostids for the same system use different hostid types. For example, the SERVER line in one license file uses 
INTERNET= for its hostid type and the other file uses the ethernet MAC address for its hostid type.


If your license files are compatible as described above, then you have the option of combining license files as 
summarized in Figure 18-4 and below in How to Combine License Files. Note that you are not required to combine 
compatible license files. There is no performance or system-load penalty for not combining the files.
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How to Combine License Files
If your license files are compatible, use any text editor to combine them. To combine license files, read all of the 
compatible license files into one file, then edit out the extra SERVER lines so that only one set of SERVER lines 
remains. Save the resulting data, and you have your combined license file. Figure 18-5 shows an example of 
combining license files.


Figure 18-5: Combining License Files  


Version Component Compatibility
When one license server manager manages multiple vendor daemons, it may be the case that those vendor 
daemons do not use the same version of FlexNet Publisher. By observing the FlexNet Publisher version 
compatibility rules described in Version Compatibility Between Components you are assured that all of your 
FlexNet Publisher components are compatible.


You can maintain multiple versions of FlexEnabled applications in the enterprise. The vendor daemon for an 
application must be at least the same version as the FlexNet Publisher version used in the FlexEnabled application.
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Troubleshooting

This section documents areas of the license server that have given customers difficulty in the past.


General Troubleshooting Hints
This list provides some general debugging information:


• When you start the license server be sure that you direct the output into a local log file where you can examine 
it. The log file often contains useful information. Examine it when you have a problem, and be prepared to 
answer questions about it when you talk to a support person.


• If the license server appears to have started correctly (which you can determine from the log file), try running 
lmstat -a and lmdiag to see if that program has the same problem as your application.


• If your application is version 4.1 or later (version 5 or later on Windows), you can use the FLEXLM_DIAGNOSTICS 
environment variable. Set FLEXLM_DIAGNOSTICS to 1, 2, or 3. A setting of 3 gives more information than 2, 2 
gives more information than 1 (in particular, the feature name that was denied). See FLEXLM_DIAGNOSTICS 
for more information.


• When you talk to a support person, be prepared with answers to the following questions:


• What kind of system is your license server running on? 


• What version of the operating system? 


• What system and operating system is the application running on?


• What version of FlexNet Publisher does the FlexEnabled application use? 


Use the lmver script, or, on UNIX, execute the following command on your license server manager, 
vendor daemon, and application:


strings binary_name | grep Copy


Alternatives are: for lmadmin, use the command lmadmin -version; for lmgrd and the vendor daemon use 
the -v argument, for example lmgrd -v.
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• What error or warning messages appear in the log file? 


• Did the server start correctly? Look for a message such as: 


server xyz started for: feature1 feature2.


• What is the output from running lmstat -a?


• Are you running other FlexEnabled products? 


• Are you using a combined license file or separate license files?


• Are you using three-server redundancy (i.e. there are multiple SERVER lines in your license file)?


FLEXLM_DIAGNOSTICS


Note • The ability for FlexNet Publisher to produce diagnostic output is controlled by your software publisher.


FLEXLM_DIAGNOSTICS is an environment variable that causes the application to produce diagnostic information 
when a checkout is denied. The format of the diagnostic information may change over time.


On UNIX, the diagnostic output goes to stderr.


On Windows, the output is a file called flexpid.log (where pid is the application’s process ID). The file is found in 
the FlexNet Publisher toolkit’s <install_dir>\<platform_dir> directory.


Level 1 Content
If FLEXLM_DIAGNOSTICS is set to 1, then the standard FlexNet Publisher error message is be presented, plus a 
complete list of license files that the application tried to use. For example:


setenv FLEXLM_DIAGNOSTICS 1
FlexNet checkout error: Cannot find license file (-1,73:2) No such file or directory
license file(s):  /usr/myproduct/licenses/testing.lic license.lic


Level 2 Content
If FLEXLM_DIAGNOSTICS is set to 2, then, in addition to level 1 output, the checkout arguments are presented. For 
example:


setenv FLEXLM_DIAGNOSTICS 2
FlexNet checkout error: No such feature exists (-5,116:2) No such file or directory
license file(s):  /usr/myproduct/licenses/testing.lic license.lic
lm_checkout("f1", 1.0, 1, 0x0, ..., 0x4000)


Note that the error message actually contains two separate problems, which both occurred during the checkout: 


• There is no such feature in the license it did find.


• It was unable to find the other license file, which is what produces the message No such file or directory.
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This is a description of the arguments to lm_checkout:


lm_checkout(feature, version, num_lic, queue_flag, ..., dupgroup_mask)


where:


Level 3 Content (Version 6.0 or Later Only)
If FLEXLM_DIAGNOSTICS is set to 3, then, in addition to level 1 and 2 output, if a checkout is successful, information is 
printed explaining how the license was granted:


setenv FLEXLM_DIAGNOSTICS 3
app
Checkout succeeded: f0/14263EAEA8E0
License file: ./servtest.lic
No server used
app2
Checkout succeeded: f1/BC64A7B120AE
License file: @localhost
License Server Machine: @localhost
app3
Checkout succeeded: f1/BC64A7B120AE
License file: servtest.lic
License Server Machine: @speedy


Note that the feature name and license key are printed, along with the license file location (or host name if @host 
were used) and host name of the server, where applicable.


Table 19-1 • lm_checkout Arguments


Argument Description


feature The requested feature.


version The requested version. The license file must contain a version >= the requested version.


num_lic Number of licenses requested. Usually 1.


queue_flag If 0, no queueing
If 1, queue for license (“blocking” queue)
If 2, queue for licenses, but return to application (“non-blocking” queue)


dupgroup_mask Indicates duplicate grouping, also called license sharing. User, host, and display are as 
shown by lmstat -a.
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Error Codes

This section documents FlexNet Publisher error messages, including general format and error message 
descriptions.


Error Message Format
FlexNet Publisher error messages presented by applications have the multiple components, which are described 
in the following table. An error message may also contain other optional supporting information.


Table 20-1 • FlexNet Publisher Error Message Components


Component Description Required


Error Number A positive or negative integer that identifies the error.


Error Text Sentence that summarizes the issue.


Error Explanation Paragraph that explains the problem and provides possible solutions 
or workarounds.


Minor Error Number A positive integer. These numbers are unique error identifiers and are 
used by software publishers for more advanced support assistance. 
Their meaning is not documented.


System Error Number Error code last set by the operating system.


System Error 
Explanation


Sentence that explains the system error.
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These error messages may occur in two formats available with FlexNet Publisher, or they may appear in a format 
customized by the application.


Format 1 (short)
FlexNet error text (lm_errno, minor_num[:sys_errno]) [sys_error_text]


The error information may be missing.


Example


Can’t connect to license server machine (-15,12:61) Connection refused


Format 2 (long)
FlexNet error text
FlexNet error explanation
[Optional Supporting information]
FlexNet error: lm_errno, minor_num. [System Error: sys_errno] [“system_error_text”]


Example


Cannot connect to license server system
The server (lmgrd) has not been started yet, or
the wrong port@host or license file is being used, or the
port or hostname in the license file has been changed.
Feature:       f1
Server name:   localhost
License path: @localhost:license.dat:./*.lic
FlexNet error:  -15,12.  System Error: 61 “Connection refused”


Error Code Descriptions
The following table lists the most common errors produced by FlexEnabled applications.


Table 20-2 • Error Codes


Error Code Description


21 lc_flexinit failed because there were insufficient rights to start the FlexNet Publisher Licensing 
Service. Resolve this by setting the service to start automatically.


20 FlexNet Publisher Licensing Service is not installed. 


13 Computed path to required file is too long for Mac OS X operating system.


12 Invalid bundle ID on Mac OS X operating system.
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11 Framework specified by bundle ID was not loaded.


10 Error creating path from URL.


9 Error creating URL.


8 Path string not specified in UTF-8 format.


7 A call to lc_flexinit is not allowed after a call to lc_flexinit_cleanup.


6 Activation utility has not been processed using the preptool, or the activation library for the 
activation utility cannot be found.


5 Unable to allocate resources.


4 Initialization failed.


3 Unsupported version of the operating system.


2 Unable to load activation library.


1 Unable to find activation library.


-1 Cannot find license file.


-2 Invalid license file syntax.


-3 No license server system for this feature.


-4 Licensed number of users already reached.


-5 No such feature exists.


-6 No TCP/IP port number in license file, and FlexNet Publisher Licensing Service does not exist. 
(pre-v6 only)


-7 No socket connection to license server manager service.


-8 Invalid (inconsistent) license key or signature.


The license key/signature and data for the feature do not match. This usually happens when a 
license file has been altered.


-9 Invalid host.


The hostid of this system does not match the hostid specified in the license file.


Table 20-2 • Error Codes


Error Code Description
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-10 Feature has expired.


-11 Invalid date format in license file.


-12 Invalid returned data from license server system.


-13 No SERVER lines in license file.


-14 Cannot find SERVER host name in network database.


The lookup for the host name on the SERVER line in the license file failed. This often happens 
when NIS or DNS or the hosts file is incorrect. Work around: Use IP address (for example, 
123.456.789.123) instead of host name.


-15 Cannot connect to license server system.


The server (lmadmin or lmgrd) has not been started yet, or the wrong port@host or license file is 
being used, or the TCP/IP port or host name in the license file has been changed.


Windows XP SP2 platforms have a limit on the number of TCP/IP connection attempts per 
second that can be made, which your application may have exceeded. Refer to the 
manufacturer’s documentation on how to change this limit.


-16 Cannot read data from license server system.


-17 Cannot write data to license server system.


-18 License server system does not support this feature.


-19 Error in select system call.


-20 License server system busy (no majority).


-21 License file does not support this version.


-22 Feature checkin failure detected at license server system.


-23 License server system temporarily busy (new server connecting).


-24 Users are queued for this feature.


-25 License server system does not support this version of this feature.


-26 Request for more licenses than this feature supports.


-29 Cannot find ethernet device.


Table 20-2 • Error Codes


Error Code Description
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-30 Cannot read license file.


-31 Feature start date is in the future.


-32 No such attribute.


-33 Bad encryption handshake with vendor daemon.


-34 Clock difference too large between client and license server system.


-35 In the queue for this feature.


-36 Feature database corrupted in vendor daemon.


-37 Duplicate selection mismatch for this feature. Obsolete with version 8.0 or later vendor daemon.


-38 User/host on EXCLUDE list for feature.


-39 User/host not on INCLUDE list for feature.


-40 Cannot allocate dynamic memory.


-41 Feature was never checked out.


-42 Invalid parameter.


-47 Clock setting check not available in vendor daemon.


-52 Vendor daemon did not respond within timeout interval.


-53 Checkout request rejected by vendor-defined checkout filter.


-54 No FEATURESET line in license file.


-55 Incorrect FEATURESET line in license file.


-56 Cannot compute FEATURESET data from license file.


-57 socket call failed.


-59 Message checksum failure.


-60 License server system message checksum failure.


-61 Cannot read license file data from license server system.


Table 20-2 • Error Codes


Error Code Description
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-62 Network software (TCP/IP) not available.


-63 You are not a license administrator.


-64 lmremove request before the minimum lmremove interval.


-67 No licenses available to borrow.


-68 License BORROW support not enabled.


-69 FLOAT_OK can’t run standalone on license server system.


-71 Invalid TZ environment variable.


-73 Local checkout filter rejected request.


-74 Attempt to read beyond end of license file path.


-75 SYS$SETIMR call failed (VMS). Indicates and error due to an operating system failure.


-76 Internal FlexNet Licensing error. Please report error to Flexera Software.


-77 Bad version number must be floating-point number with no letters.


-82 Invalid PACKAGE line in license file.


-83 FlexNet Licensing version of client newer than server.


-84 USER_BASED license has no specified users; see license server system log.


-85 License server system doesn’t support this request.


-87 Checkout exceeds MAX specified in options file.


-88 System clock has been set back.


-89 This platform not authorized by license.


-90 Future license file format or misspelling in license file.


The file was issued for a later version of FlexNet Licensing than this program understands.


-91 Encryption seeds are non-unique.


-92 Feature removed during lmreread, or wrong SERVER line hostid.


Table 20-2 • Error Codes


Error Code Description
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-93 This feature is available in a different license pool.


This is a warning condition. The server has pooled one or more INCREMENT lines into a single 
pool, and the request was made on an INCREMENT line that has been pooled.


-94 Attempt to generate license with incompatible attributes.


-95 Network connect to THIS_HOST failed.


Change this_host on the SERVER line in the license file to the actual host name.


-96 License server machine is down or not responding. 


See the system administrator about starting the server, or make sure that you’re referring to the 
right host (see LM_LICENSE_FILE environment variable).


-97 The desired vendor daemon is down. 


1) Check the lmadmin or lmgrd log file, or 2) Try lmreread.


-98 This FEATURE line can’t be converted to decimal format.


-99 The decimal format license is typed incorrectly.


-100 Cannot remove a linger license.


-101 All licenses are reserved for others.


The system administrator has reserved all the licenses for others. Reservations are made in the 
options file. The server must be restarted for options file changes to take effect.


-102 A FLEXid borrow error occurred.


-103 Terminal Server remote client not allowed.


-104 Cannot borrow that long.


-105 Feature already returned to license server.


-106 License server system out of network connections.


The vendor daemon can't handle any more users. See the debug log for further information.


-110 Cannot read dongle: check dongle or driver.


Either the dongle is unattached, or the necessary software driver for this dongle type is not 
installed.


Table 20-2 • Error Codes


Error Code Description
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-112 Missing dongle driver.


In order to read the FLEXID hostid, the correct driver must be installed. These drivers are 
available from your software publisher.


-114 SIGN= keyword required, but missing from license certificate.


You need to obtain a SIGN= version of this license from your publisher.


-115 Error in Public Key package.


-116 TRL not supported for this platform.


-117 BORROW failed.


-118 BORROW period expired.


-119 lmdown and lmreread must be run on license server.


-120 Cannot lmdown the server when licenses are borrowed.


-121 FLOAT_OK requires exactly one FLEXid hostid.


-122 Unable to delete local borrow info.


-123 Returning a borrowed license early is not supported. 


Contact the publisher for further details.


-124 Error returning borrowed license.


-125 A PACKAGE component must be specified.


-126 Composite hostid not initialized.


-127 A item needed for the composite hostid is missing or invalid.


-128 Error, borrowed license doesn't match any known server license.


-135 Error enabling the event log.


-136 Event logging is disabled.


-137 Error writing to the event log.


-139 Communications timeout.


Table 20-2 • Error Codes


Error Code Description
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-140 Bad message command.


-141 Error writing to socket. Peer has closed socket.


-142 Error, cannot generate version specific license tied to a single hostid, which is composite.


-143 Version-specific signatures are not supported for uncounted licenses.


-144 License template contains redundant signature specifiers.


-145 Bad V71_LK signature.


-146 Bad V71_SIGN signature.


-147 Bad V80_LK signature.


-148 Bad V80_SIGN signature.


-149 Bad V81_LK signature.


-150 Bad V81_SIGN signature.


-151 Bad V81_SIGN2 signature.


-152 Bad V84_LK signature.


-153 Bad V84_SIGN signature.


-154 Bad V84_SIGN2 signature.


-155 License key required but missing from the license certificate. The application requires a license 
key in the license certificate. You need to obtain a license key version of this certificate from your 
publisher.


-156 Invalid signature specified with the AUTH= keyword.


-157 Trusted storage has been compromised; repair needed. Contact your publisher for repair 
instructions.


-158 Trusted storage open failure. Contact your publisher for further information.


-159 Invalid fulfillment record. Contact your publisher for further information.


-160 Invalid activation request received. Contact your publisher for further information.


Table 20-2 • Error Codes


Error Code Description
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-161 No fulfillment exists in trusted storage which matches the request. Contact your publisher for 
further information.


-162 Invalid activation response received. Contact your publisher for further information.


-163 Cannot return the specified activation. Contact your publisher for further information.


-164 Return count(s) would exceed the maximum for the fulfillment. Contact your publisher for further 
information.


-165 No repair count left. Contact your publisher for further repair authorization.


-166 Specified operation not allowed. Contact your publisher for further information.


-167 The requested activation has been denied because the user or host is excluded from activating 
this entitlement by a specification in the options file.


-168 The options file contains include specifications for the entitlement, and this user or host is not 
included in these specifications.


-169 Activation error. Contact your publisher for further information.


-170 Invalid date format in trusted storage. Can be caused by setting your system clock to an earlier 
date. Check that your system clock is set to the current date and time.


-171 Message encryption failed. Internal error. Report issue to Flexera Software.


-172 Message decryption failed. Internal error. Report issue to Flexera Software.


-173 Bad filter context. Internal error. Report issue to Flexera Software.


-174 SUPERSEDE feature conflict. Contact your publisher for further information.


-175 Invalid SUPERSEDE_SIGN syntax. Contact your publisher for further information.


-176 SUPERSEDE_SIGN does not contain a feature name and license signature. Contact your 
publisher for further information.


-177 ONE_TS_OK is not supported in this Windows Platform.


-178 Internal error. Report issue to Flexera Software.


-179 Only one terminal server remote client checkout is allowed for this feature.


-180 Internal error. Report issue to Flexera Software.


Table 20-2 • Error Codes


Error Code Description
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-181 Internal error. Report issue to Flexera Software.


-182 Internal error. Report issue to Flexera Software.


-183 More than one ethernet hostid not supported in composite hostid definition. Contact your 
publisher for further information.


-184 The number of characters in the license file paths exceeds the permissible limit. 


There is a limit on the number of license files that can be used by a license server manager. This 
limit is on the number of characters in the combined license file paths to the license files:


• UNIX—40,960 characters


• Windows—20,400 characters


Reduce the number of license files, or relocate them so that the paths are shorter.


-187 The time zone information could not be obtained.


A license that is time zone limited could not be checked out because time zone information 
could not be obtained for the machine on which the license is required. Contact your publisher 
for further information.


-188 License client time zone not authorized for license rights.


A license that is time zone limited could not be checked out because the time zone of the 
machine on which the license is required does not match the time zone specified in the license.


-190 Feature can be checked out from Physical machine only.


The license specifies that it cannot be used on a virtual machine: The FlexEnabled application is 
installed on a virtual machine so checkout has been denied. Install the FlexEnabled application 
on a physical machine.


-191 FEATURE can be checked out from Virtual machine only.


The license specifies that it cannot be used on a physical machine. The FlexEnabled application 
is installed on a physical machine so checkout has been denied. Install the FlexEnabled 
application on a virtual machine.


-192 VM platform not authorized by license.


-193 FNP vendor keys do not support Virtualization feature.


-194 Checkout request denied as it exceeds the MAX limit specified in the options file.


-195 Binding agent API - Internal error.


Table 20-2 • Error Codes


Error Code Description
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-196 Binding agent communication error 


-197 Invalid Binding agent version.


-201 Invalid IP address used while overriding.


The IP address specified for the LM_A_INTERNET_OVERRIDE attribute, used to override the existing 
IP address, is invalid.


Table 20-2 • Error Codes


Error Code Description
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Report Log File

The license server produces both report log files and debug log files. The focus of this section is report log files. 
For information on debug log files see Debug Log File.


The report log file contains feature usage information and is generated by the vendor daemon. However, a vendor 
daemon does not write report logs by default; this action must be enabled. The data in report logs is compressed, 
authenticated, and organized into a repository.


Use Flexera Software’s software license administration solution, FlexNet Manager, to gain exceptional visibility into 
license usage data and to create insightful reports on critical information like license availability and usage. FlexNet 
Manager can be fully automated to run these reports on schedule and can be used to track license servers and 
usage across a heterogeneous network of server including Windows NT, Linux and UNIX. Contact Flexera Software 
at www.flexerasoftware.com for more details on how to obtain an evaluation copy of FlexNet Manager for your 
enterprise.


Managing Report Log Output
As a vendor daemon runs for a period of time, the volume of report log output increases. If you have a lot of license 
activity, these log files grow very large. You need to consider where to put these files and how often to rotate and 
archive them. Therefore, it may be necessary to rotate or switch report log output into different files over time, each 
file containing license activity over a particular period of time. 


Report log data is collected by the vendor daemon into an internal data buffer area before being flushed to the 
output file. The daemon’s internal buffer is flushed once a minute or whenever it gets full, whichever occurs first. To 
ensure the freshest data possible in the report log file, flush the buffer on demand with the lmreread command. 
Use standard file compression tools to reduce the size of a report log file when it is no longer being written. 


To avoid corruption and for performance, it is suggested that the vendor daemon write its report log to a file on a 
disk local to the system running the vendor daemon. Each vendor daemon must write to its own report log file.
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Enabling Report Log Output for a Vendor 
Daemon


There are two ways to enable report logging for a particular vendor daemon either before or after starting the 
license server.


• Add the REPORTLOG line to the options file for that vendor daemon. See REPORTLOG for more details.


• Invoke lmswitchr on the vendor daemon. See lmswitchr for more details.


Redirecting Report Log Output for a Vendor 
Daemon


The report log output for a particular vendor daemon can be moved into separate files, each file representing 
activity over a different period of time. There are three ways in which to do this whether the vendor daemon is 
running or not:


• Change the REPORTLOG line in the vendor daemon’s options file and reread its options file by invoking 
lmreread (version 8.0 or later vendor daemon) or restart.


• Invoke lmswitchr on the vendor daemon. See lmswitchr for more details.


• Invoke lmnewlog on the vendor daemon. Requires a version 7.1 or later vendor daemon. See lmnewlog for 
more details.
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Debug Log File

The license server produces both debug log files and report log files. For information on report log files, see Report 
Log File.


A debug log file contains status and error messages useful for debugging the license server. The lmgrd debug 
log displays the server's system date, time, and time zone at the beginning of a log. A license server always 
generates debug log output. Some of the debug log output describes events specific to lmadmin or lmgrd and 
some of the debug log output describes events specific to each vendor daemon. 


Managing Debug Log Output
As the license server manager and its vendor daemons run for a period of time, the volume of this output 
increases. As it gets older, the value of the debug log output decreases; therefore, it may be necessary for you to 
separate old debug log output from current output; either archive or delete the old output.


For performance, it is suggested that each debug log file be on a disk that is local to the system that is running the 
license server manager and its vendor daemons. However, if the debug log file must be on a remotely-mounted 
disk and you find that the license server is too slow, start lmgrd with the -nfs_log option to improve performance.


See Debug Log Messages for a description of the debug log output format.


Capturing Debug Log Output for a License Server
If you are using lmadmin as your license server manager, separate log files are created for lmadmin and each 
vendor daemon that it manages. The log files are written to the logs directory within the lmadmin install directory; 
however, you can use the -logDir option on the command line to change the location to which lmadmin writes 
lmadmin.log. See lmadmin Command-line Arguments for details.


By default, lmgrd and the vendor daemons it manages write debug log output to standard out. To put this debug 
log output in a file, either redirect the output of the license server to a file or start lmgrd with the -l debug_log_path 
option. See lmgrd Command-Line Syntax for more information.
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Capturing Debug Log Output for a Particular Vendor 
Daemon


The debug log output from different vendor daemons controlled by the same license server can be written to their 
own files (version 8.0 and later vendor daemon). There are three ways to do this:


• If you are using lmadmin as your license server manager, you configure the location and file name from the 
Vendor Daemon Configuration screen. See on-line help for information on Vendor Daemon Log.


• Add the DEBUGLOG line to the options file for each vendor daemon. See DEBUGLOG for more details.


• Invoke lmswitch on the vendor daemon. See lmswitch for more details.


Note that lmgrd writes its own debug log output to standard out.


Redirecting Debug Log Output for a Running Vendor 
Daemon


It is possible to redirect the debug log output for a particular vendor daemon to a different file. There are two ways 
to do this:


• Change the DEBUGLOG line to the options file for the vendor daemon and reread its options file by invoking 
lmreread. See DEBUGLOG for more details.


• Invoke lmswitch on the vendor daemon. See lmswitch for more details.


Limiting Debug Log Output for a Vendor Daemon
By default, debug log output contains all events. To limit the events that are logged for a particular vendor daemon, 
add a NOLOG line to the options file of that vendor daemon. One of the reasons you may want to limit the events 
that are logged is to reduce the size of the debug log output.


See Also
NOLOG


License Server Diagnostics in the Debug Log
Enhanced license server diagnostics will now be emitted in the license server debug log. Additional diagnostics 
are prefixed by “(@lmgrd-SLOG@)” for the lmgrd and “(@<vendor>-SLOG@)” for the Vendor Daemon, facilitating easy 
grep-like extraction from the debug-log. The Vendor Daemon would emit the additional diagnostics when run with 
lmgrd or lmadmin. These diagnostics are intended to assist publishers and Flexera diagnose license server issues. 
These diagnostics include:


• For lmgrd:


 Start timestamp, Version, ProcessID, Network Info (IPv4/IPv6 interface, listening port), command-line options, 
list of license files, whether the license server is running as a windows service.
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• For Vendor Daemon:


Start timestamp, Version, ProcessID, Network info (IPv4/IPv6 interface, listening port, select timeout of 
vendor daemon), Vendor daemon name, Options file used, Trusted storage accessed (yes/no), Host name, 
Virtual/physical environment, (limited) hypervisor info if virtual, Lmbind used (yes/no), #Restarts of 
vendor daemon since lmgrd startup, #Rereads since vendor daemon (re)start, Last reread time, 


Reread initiation type (automatic versus lmreread).


Every 4 hours (and at vendor daemon shutdown) the following performance data are logged: 


Details of the 10 peak client transactions (including client hostname, user, transaction time, concurrent 
clients at time of transaction, memory usage (Windows only)), Peak concurrent clients served, High 
watermark memory usage (Windows only), Transaction time for last 10 transactions.


Debug Log Messages
FlexNet Publisher processes generate debug log files in the following format:


hh:mm:ss (daemon) message


where:


The debug log files can be used to diagnose configuration problems and vendor-daemon software errors.


Note • A debug log file cannot be used for usage reporting with FlexNet Manager.


Informational Messages
Table 22-2 lists the various informational messages used within FlexNet Publisher.


Table 22-1 • Debug Log Messages


Message Description


hh:mm:ss Time that the message was logged.


daemon Either lmadmin, lmgrd or the vendor daemon name. In the case where a single copy 
of the daemon cannot handle all of the requested licenses, an optional “_” followed 
by a number indicates that this message comes from a forked daemon.


message The text of the message.


Table 22-2 • Information Messages


Message Description


Connected to host This daemon is connected to its peer on host.
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CONNECTED, master is host The license daemons log this message when a quorum is up and 
everyone has selected a master.


DENIED: num_lic feature to user user was denied access to num_lic licenses of feature.   


EXITING DUE TO SIGNAL nnn
EXITING with code nnn


All daemons list the reason that the daemon has exited. 


EXPIRED: feature feature has passed its expiration date.


IN: “feature” user (num_lic licenses) user has checked in num_lic licenses of feature.


Lost connection to host A daemon can no longer communicate with its peer on node host, 
which can cause the clients to have to reconnect, or cause the 
number of daemons to go below the minimum number, in which 
case clients may start exiting. If the license daemons lose the 
connection to the master, they kill all the vendor daemons; vendor 
daemons shut themselves down.


Lost quorum The daemon lost quorum, so it processes only connection requests 
from other daemons.


MULTIPLE vendor servers running. 
Kill and restart license daemon.


The license server manager has detected that multiple vendor 
daemons with the same vendor name are running. Shutdown 
lmadmin or lmgrd and all vendor daemons and then restart lmadmin 
or lmgrd.


OUT: feature user (num_lic licenses) user has checked out num_lic licenses of feature.


RESERVE feature for USER user
RESERVE feature for HOST host


A license of feature is reserved for either user or host.


REStarted vendor (internet port 
nnn)


Vendor daemon vendor was restarted at TCP/IP port nnn.


Retrying socket bind (address in 
use)


The license servers try to bind their sockets for approximately six 
minutes if they detect “address in use” errors.


Selected (EXISTING) master host. This license daemon has selected an existing master host as the 
master.


SERVER shutdown requested. A daemon was requested to shut down via a user-generated kill 
command.


Table 22-2 • Information Messages


Message Description
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Configuration Problem Messages
Table 22-3 lists configuration problem messages found in FlexNet Publisher.


Server started on host for: 
feature_list


A (possibly new) server was started for the features listed.


Shutting down vendor The license server manager is shutting down the vendor daemon 
vendor.


SIGCHLD received. Killing child 
servers.


A vendor daemon logs this message when a shutdown was 
requested by the license daemon.


Started vendor The license server manager logs this message whenever it starts a 
new vendor daemon.


TIMESTAMP A vendor daemon logs this message at regular intervals. The default 
interval between vendor daemon timestamps is 6 hours 5 minutes.


A license server manager (lmadmin or lmgrd) logs this message at 
regular intervals. The default interval between license server 
manager timestamps is 6 hours.


Trying to connect to host The daemon is attempting a connection to host.


UPGRADE: “<feature>” ....(x->y 
licenses)


Identical checkout requests (using the LM_A_CHECKOUT_DATA 
attribute) has incremented the number of licenses checked out for a 
given feature within the same license job. The previous request 
checked out x licenses, while latest request has checked out y 
licenses, for a total of x +y licenses checked out for the feature.


Table 22-3 • Configuration Problem Messages


Message Description


host: Not a valid server host, 
exiting


This daemon was run on an invalid host name.


host: Wrong hostid, exiting The hostid is wrong for host.


BAD CODE for feature The specified feature name has a bad license key or signature. It was 
probably typed in wrong, or modified by the end user.


CANNOT OPEN options file The options file specified in the license file could not be opened.


Table 22-2 • Information Messages


Message Description
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Daemon Software Error Messages
Table 22-4 lists various daemon software error messages:


Couldn’t find a master The daemons could not agree on a master.


License daemon: lost all 
connections


This message is logged when all the connections to a server are lost, 
which often indicates a network problem.


Lost lock, exiting
Error closing lock file
Unable to re-open lock file


The vendor daemon has a problem with its lock file, usually because of an 
attempt to run more than one copy of the daemon on a single node. 


Locate the other daemon that is running via a ps command, and kill it 
with kill -9.


No DAEMON line for vendor The license file does not contain a DAEMON or VENDOR line for vendor.


No DAEMON lines, exiting The license daemon logs this message if there are no DAEMON or 
VENDOR lines in the license file. Because there are no vendor daemons 
to start, there is nothing for the license daemon to do.


No features to serve! A vendor daemon found no features to serve. This could be caused by a 
corrupted or incorrectly entered license file.


UNSUPPORTED FEATURE 
request: feature by user


The user has requested a feature that this vendor daemon does not 
support. This can happen for a number of reasons: the license file is bad, 
the feature has expired, or the daemon is accessing the wrong license file.


Unknown host: host The host name specified on a SERVER line in the license file does not 
exist in the network database (probably /etc/hosts).


Table 22-4 • Daemon Software Error Messages


Message Description


accept: message An error was detected in the accept system call.


Can’t allocate server table 
space


A malloc error. Check swap space.


Connection to host TIMED OUT The daemon could not connect to host.


Illegal connection request to 
vendor


A connection request was made to vendor, but this vendor daemon is not 
vendor.


Table 22-3 • Configuration Problem Messages


Message Description
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read: error message An error in a “read” system call was detected.


select: message An error in a “select” system call was detected. This is usually a sign of a 
system networking failure.


Server exiting The server is exiting. This is normally due to an error.


Table 22-4 • Daemon Software Error Messages


Message Description
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Identifying FlexNet Publisher 
Versions

Version Compatibility Between Components
In general, always use the latest version of lmadmin, lmgrd, lmutil, and lmtools, all of which are available from 
www.flexerasoftware.com, to exploit the enhancements available in the most recent versions of FlexNet Licensing. 
However, some enhancements require a vendor daemon built with a newer version of FlexNet Publisher, and yet 
others require a FlexEnabled application built with a newer version of FlexNet Publisher. Contact your software 
publisher for the latest version of their vendor daemon. 


The rules about FlexNet Licensing component version compatibility are summarized as:


• Version of lmutil/lmtools must be >=


• Version of lmadmin (or lmgrd), which must be >=


Note • lmadmin can only be used with components with a version of 9.2 or later.


• Version of vendor daemon, which must be >=


• Version of the client library linked to the FlexEnabled application, which must be >=


• Activation utility, which must be >=


• Version of license file format


Except for the license file, use lmver to discover the version of all these components. For the vendor daemon, 
lmgrd, and lmutil, you can also use the -v argument to print the version. 
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Determining the License File Version
The following rules apply to individual FEATURE, INCREMENT or UPGRADE lines. It is possible to have a mix of 
versions in a single file. Only the features that a particular application checks out determine the version of the 
license for that feature.


Version Summary
Version 1.0—1988


First FLEXLM Release, containing all the basic FLEXLM features


Version 1.5—February 1990


First widely used version including DEMO


Version 2.1—March 1991


• Improved TIMEOUT support


• Improved ethernet hostid support


Table 23-1 • Determining the License File Version


Version Description


Version 2 Blank quotes or a quoted string at the end of the FEATURE line.


>= Version 3 INCREMENT or UPGRADE line.


>= Version 4 OVERDRAFT, DUP_GROUP, INTERNET, or PACKAGE appear.


>= Version 5 SUPERSEDE, ISSUED, USER_BASED, HOST_BASED, or SN appear.


>= Version 6 START appears.


>= Version 7.1 SIGN= keyword appears.


>= Version 8.0 BORROW, FLOAT_OK, and TS_OK appear.


>= Version 8.1 SUITE_RESERVED appears.


>= Version 8.4 COMPOSITE appears.


>= Version 11.5 ONE_TS_OK and SUPERSEDE_SIGN appear.


>=Version 11.7 VM_PLATFORMS and TZ appear.
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Version 2.21—November 1991


• Added support for many platforms and some platform-specific improvements, such as hostid


• Hostid ANY added


Version 2.26—March 1992 (Used only by Sun)


• Added license lingering


Version 2.4—December 1992


• Added use-all-feature-lines capability for incremental license distribution


• Enhanced vendor customization routines


• Enhanced options file


• Added new hostid types: USER, HOSTNAME, and DISPLAY


• Added port@host to locate license file —downloads license file from server


Version 2.61—March 1993 (Used only by Sun)


• Added INCREMENT and UPGRADE lines to license file


Version 3.0—May 1994 


• INCREMENT and UPGRADE behavior changed and improved


• Added UDP protocol support


• Added uname -i hostid for HP


• Added multiple jobs for enhanced support of LM_LICENSE_FILE environment variable as a license search path


• New, optional license file format with keyword=value syntax for optional new features, including: asset_info, 
ISSUER, and NOTICE, “ \ ” license file continuation character, 2,048 character limit per feature


Version 4.0—December 1994


• Removed use of floating point, for enhanced reliability


• FEATURE line additions: ck, OVERDRAFT, DUP_GROUP, INTERNET hostid


• PACKAGE line


• License Finder


• lmdiag and FLEXLM_DIAGNOSTICS for diagnostics


Version 4.1—May 1995


• Performance improvements and new platform support

License Administration Guide FNP-11121-LAG00 257







Chapter 23: Identifying FlexNet Publisher Versions
Version Summary

Version 4.1—Patch Release 6, October 1995


• Windows patch release for Windows 95 with various performance improvements


Version 5.0—March 1996


• Improved port@host behavior—FlexEnabled application doesn’t read license file


• Automatic port@host via USE_SERVER line in license file


• Hostid lists—lock a feature to several hostids


• New FEATURE attributes: SN (serial number), USER_BASED, HOST_BASED, MINIMUM, SUPERSEDE, 
ISSUED (issued date), CAPACITY (charging based on system capacity)


• Optional avoidance of NIS and DNS via IP address instead of host name


• Improved report log file format


• Server, upon startup, notifies of licenses that expire within two weeks


• Improved options file functionality


Version 5.11—February 1997


• SUPERSEDE lists, PLATFORMS= license attribute,


• new options: MAX, TIMEOUTALL


• Windows control panel added 


• Windows license generator GENLIC added


Version 5.12—April 1997


• Performance improvements and new platform support


Version 6.0—September 1997


• lmgrd can read multiple license files


• FLEXLM license directory support: *.lic automatically used


• License files require no editing for use at the site


• Optional path on DAEMON/VENDOR line; $PATH environment variable used


• Decimal license format, with lminstall utility for typing in licenses


• FEATURE lines are shorter, easier to understand and type in


• PACKAGE lines can be shipped in separate files that never require user editing


• Default TCP/IP port numbers make SERVER line port number optional


• Default options file path


• this_host host name supported on SERVER line

258 FNP-11121-LAG00 License Administration Guide







Chapter 23: Identifying FlexNet Publisher Versions
Version Summary

• VENDOR_LICENSE_FILE supported (for example, DEMO_LICENSE_FILE)


• @host supported where default port numbers are used


• Windows only: user prompted for license file or license server name


• License files are optionally case insensitive


• lmdown and lmreread accept -vendor vendor argument


• START=dd-mmm-yyyy optional license attribute


Version 6.1—June 1998


• Performance improvements


Version 7.0—August 1999


• License Certificate Manager support for automatic license fulfillment


• Support for try-before-you-buy licensing


• License file handles inserted new lines from emailers


• License lines automatically optimally sorted


• Improved lmtools interface for Windows


• lmgrd, when run at command line on Windows, runs in background by default


• Improved three-server redundancy reliability (version 7.0 vendor daemon and lmgrd)


• lmreread and lmdown take -all argument to shut down or reread all lmgrds


• Support registry (Windows) and $HOME/.flexlmrc (UNIX) for FLEXLM environment variables


• Automatically install license path in registry or $HOME/.flexlmrc after successful checkout


• Options support for LM_PROJECT with PROJECT


• Performance improvements, especially for Windows NT


• Intel Pentium III CPU-ID (version 7.0d or later, November 1999)


Version 7.1—August 2000


• Security enhancements 


• SIGN= keyword in license 


• lmnewlog utility (version 7.0d or later vendor daemon)


Version 7.2—December 2000


• Performance enhancements 
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Version 8.0—October 2001


• lmborrow (version 8.0 or later components), lmpath (version 8.0 or later vendor daemon), lmswitch (version 
8.0 or later vendor daemon) utilities


• lmreread rereads options file and SERVER host name 


• License borrowing with BORROW keyword 


Version 8.1—January 2002


• CRO Security enhancements


Version 8.2—August 2002


• Support added for Windows XP compliancy


Version 8.3—October 2002


• Support added for returning borrowed licenses early


Version 8.4—January 2003


• Support for reserved package suites


Version 9.0—March 2003


• Support for COMPOSITE= hostid type


Version 9.2—July 2003


• Options file keywords added: GROUPCASEINSENSITIVE and MAX_BORROW_HOURS


Version 9.5—November 2004


• New environment variable: LM_UTIL_CASE_SENSITIVE


Version 10.0—April 2004


• Released as FlexNet Publisher


• Support for fully qualified domain names


Version 10.1—November 2004


• Additional FLEXid driver support for USB dongles


Version 10.8—April 2005


• IPv6 address support for hostids


• Enhanced three-server redundant configuration support


• Support for common vendor daemons
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Version 11.1—November 2005


• Support for license rights in trusted storage


• IPv6 support for hostids reverted in this release


Version 11.5—February 2008


• Support new attribute for the NOLOG Option keyword


• IPv6 support


• New error codes


• New feature definition line keywords–ONE_TS_OK and SUPERSEDE_SIGN


Version 11.6—August 2008


• New license server manager, lmadmin, which requires components with a minimum version of 9.2


• Support for multiple ethernet hostids on Linux platforms


Version 11.6.1—April 2009


• Queuing of license requests when MAX as defined in the option file is exceeded. Note that queuing must be 
configured in the FlexEnabled application


Version 11.7—July 2009


• New feature definition line keywords–TZ and VM_PLATFORMS


• New error codes


• (License-file licensing only) Support for license servers and clients running in virtual environments on VMware 
platforms


• Policies that let you limit usage of FlexEnabled applications to physical machines only or to supported virtual 
machines only


• Support for more than 255 trial IDs by means of trial packs


Version 11.8—March 2010


• Support for composite transactions in trusted-storage licensing 


• (License-file licensing only) Bare-metal binding and binding to the Universally Unique Identifier (UUID) of the 
virtual container now available for virtualized license servers on the VMware ESX platform


• (License-file licensing only) New binding agent, lmbind, which enforces bare-metal binding on virtualized 
license servers and ensures that only one instance of a specific vendor daemon is running across all virtual 
machines on a given host machine
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Version 11.9—September 2010


• (License-file licensing only) Full support--including policies, bare-metal binding, lmbind--for virtualized license 
servers and clients on the Microsoft Hyper-V platform


• Improvements to the lmstrip utility to handle ELF object files properly


• Support for the WibuKey dongle on Windows, Linux, and Mac OS X systems


• Support for Visual Studio 2010 Compiler for building the FlexNet Publisher Licensing Toolkit and FlexEnabled 
applications on Windows x86 and x64 platforms


• Sample implementation of activation APIs encapsulated in C# now available in the FlexNet Publisher 
Licensing Toolkit


Version 11.9.1—February 2011


• Command-line options -ADMINONLY and -LOGDIR added to lmadmin to increase the parity between lmadmin 
and lmgrd


• Aladdin USB FlexNet ID dongle driver updated to support Windows 7 and Windows Server 2008


• Java toolkit support for Wibu dongles


Version 11.10—July 2011


• Support for virtualization in trusted-storage licensing


• (License-file-based licensing only) Support for license servers and clients running in an Amazon EC2 cloud 
environment


• New hostid keywords for license servers (AMZN_EIP) and for FlexEnabled clients (AMZN_IID) running in an 
Amazon EC2 cloud environment


• New hostid keywords (LMB_*) for lmbind support in the Amazon EC2 cloud environment


• Implementation of Secure Data Types (SDTs) available for license-file licensing


• lmadmin updated to support customized installations, silent installations, and Windows Active Directory users 
or groups


• Support for flash-based hardware dongles (SafeNet HL 2GB)


Version 11.10.1—February 2012


• Full support for Mac OS X 10.7.x


The following features were introduced for trusted-storage-based licensing:


• Support for prepped trusted storage


• Hybrid license information displayed on lmadmin dashboard


• New options keyword (DAEMON_SELECT_TIMEOUT) to support for activations against license servers in 
bandwidth-restricted environments


• New function flxActTransactionGetResponseXML used to retrieve response XML from online activations
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Version 11.11.0—August 2012


• Support for XenServer in virtualized environments


• New hostid keyword VM_UUID to support binding to a virtual machine on VMware, Microsoft Hyper-V, and 
XenServer platforms


Version 11.11.1—February 2013


• Support for server-side ASRs


• New lmadmin command line options to add, delete, or manage roles


• Support for lmadmin console installer on Windows


Version 11.12.0—September 2013


• Elimination of cross version signature


• Enhanced license server diagnostics in the debug log


• Activation error code enhancements


Version 11.12.1—March 2014


• Support reclaim of borrowed license (trusted storage)


• Improved Virtualization support 
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Environment Variables

Environment variables are not required in order to use FlexEnabled applications. Environment variables are 
normally used for debugging or for changing license default location.


How to Set Environment Variables
FlexNet Publisher environment variables are set in two different ways: 


• In the process’ environment


• In the registry (Windows version 6.0 or earlier) or in $HOME/.flexlmrc (UNIX version 7.0 or earlier), which 
functions like the registry on UNIX. 


Windows Registry
On Windows XP systems, the registry location is HKEY_LOCAL_MACHINE\Software\FLEXlm License Manager.


On Windows systems later than Windows XP, the location is HKEY_CURRENT_USER\Software\FLEXlm License 
Manager. 


On UNIX, the equivalent information is stored in $HOME/.flexlmrc. In this file, the syntax is variable=value.


Precedence
If the variable is LM_LICENSE_FILE or VENDOR_LICENSE_FILE, then both the environment and the registry are used, 
with the environment used first, and the registry appended to the path.


If it’s a different variable, then if the environment is set, only that is used, otherwise the registry is used. That is, the 
registry is only used if the environment is not set.
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Environment Variables
The table below provides various environment variables and their definitions:


Table 24-1 • Environment Variables


Variable Definition


EVENTTIMEOUT (Windows only) Sets the maximum amount of time (in microseconds) that 
the license-server service (lmadmin or lmgrd) waits for the vendor daemon 
to start before switching to a “Running” status:


• If this variable is not defined, the default value 300000 is used.


• If the vendor daemon starts before the time limit is reached, the server 
service switches to “Running” once the vendor daemon starts.


• When the time limit is reached and the vendor daemon has not yet 
started, the server service does not start.


• A zero (0) value means that the server service does not attempt to start 
at all.


This variable is especially useful in scenarios where the FlexEnabled client 
and license server are both running as services on the same machine. If the 
client service has a dependency on the license-server service, checkouts 
fail if vendor daemon is not running. Adjust this variable to allow enough 
time for the vendor daemon to start, thus increasing the likelihood of 
synchronization between service startups and initial checkouts.


FLEXLM_BATCH (Windows only) Prevents interactive pop-ups from appearing. Set to 1 if a 
batch application. (Version 7.0 and later clients)


FLEXLM_DIAGNOSTICS Used for debugging where applications do not print error message text. Set 
to 1, 2, or 3, depending on the amount of diagnostic information desired. 
See FLEXLM_DIAGNOSTICS (Version 5.0 and later clients)


FLEXLM_TIMEOUT (Windows only) Sets the timeout value a FlexEnabled application uses 
when attempting to connect to a license server port in the range of 27000 
through 27009. 


Values are in microseconds, within the range of 0 through 2,147,483,647. 
The default setting is 100,000 microseconds.


Note • For security purposes, best practice is not to use a default port for the license 
server. Instead, specify a port number outside of the range of 27000 through 27009.
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LM_BINDING_AGENT LM_BINDING_AGENT must be of the form port@host, where port is port 
number in the range of 27010 through 27019, and host is the hostname or 
IP address of the physical system on which lmbind is running. This physical 
system can be the hypervisor itself or a remote physical machine that 
communicates with the virtual machine through this protocol. (Depending 
on your network settings, the hostname might need to be a fully-qualified 
domain name.) For example, this variable might look like this: 
LM_BINDING_AGENT=27011@hostname.example.com


LM_BORROW Used for initiating license borrowing and setting the borrow period. See 
Initiating License Borrowing for more details. On UNIX platforms, $HOME/
.flexlmborrow is used for the registry instead of $HOME/.flexlmrc.


LM_LICENSE_FILE or


VENDOR_LICENSE_FILE


Reset path to license file. Can be a license search path, separated by “ : ” 
on UNIX and “ ; ” on Windows. If VENDOR_LICENSE_FILE used, VENDOR is the 
vendor daemon name used by this application. For example, Flexera 
Software products use MVSN_LICENSE_FILE. Can be a file name, or 


port@host. See also Setting the License Search Path Using an 
Environment Variable (VENDOR_LICENSE_FILE requires version 6.0 and later 
clients).


LM_PROJECT LM_PROJECT’s value (up to 30 characters) is logged in the report log file and 
later reported on by FlexNet Manager. It can also be used to RESERVE, 
INCLUDE, and so on licenses with PROJECT. For example:


RESERVE 1 f1 PROJECT airplane


The variable is read upon the license server’s initial connection with the 
FlexEnabled client and is reread for each job, enabling you to update the 
variable value as needed on a job-to-job basis. However, the value with 
which a job initiates remains in effect for the duration of that job. You cannot 
modify this value mid-job.


Note • This feature requires that the FlexEnabled client be built with FlexNet 
Publisher 5.0 or later and that the vendor daemon be built with FlexNet Publisher 7.0 
or later.


LM_SERVER_HIGHEST_FD Used to set the highest file descriptor value, above which the license server 
will not access.


Table 24-1 • Environment Variables


Variable Definition
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LM_UTIL_CASE_SENSITIVE Used by the FlexLM utilities. If set to 1, the utilities process license file lines 
as case sensitive. By default, this variable is set to 0; license files are treated 
as case insensitive. This environment variable is applicable only when the 
license server, itself, has been configured by your software publisher to 
treat license files in a case sensitive manner.


TCP_NODELAY Improves license server performance when processing license requests. 
Set to 1 to enable performance enhancements. Use with caution: when 
enabled it may cause an increase in network traffic. Set TCP_NODELAY as 
System variables when setting the service to start at power up using 
lmtools. 


Table 24-1 • Environment Variables


Variable Definition
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◆ Features from 9.2.x release products that apply to 9.3.x............................................  6
◆ Technical notes from 9.2.x release products that apply to 9.3.x .................................  6
◆ Fixed problems from 9.2.x that apply to 9.3.x ............................................................  8
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Features from 9.2.x release products that apply to 9.3.x
◆ “Features in 9.2.2 release products” on page 6


◆ “Technical notes from 9.2.x release products that apply to 9.3.x” on page 6


◆ “Fixed Problems in 9.2.x” on page 8


Features in 9.2.2 release products


◆ “New behavior for the sm_migrate utility” on page 6


New behavior for the sm_migrate utility
The sm_migrate utility prompts you to copy the security configuration files including the 
runcmd_env.sh file. You can either choose to copy the files into the local directory of the 
new installation or configure the files later, manually. If you choose to copy and have 
changed the site secret in your previous installation, run the sm_rebond command to 
encrypt the files:


./sm_rebond --basedir=C:\InCharge\IP\smarts


After copying the files, the data in the old runcmd_env.sh file is appended to the new 
runcmd_env.sh file and the new Smarts 9.2.2 version data is commented.


That is, if you select to reuse the runcmd_env.sh file from your old installation, the 
sm_migrate utility migrates the old values and will also append a commented out section 
to the bottom of the runcmd_env.sh file with the default environment values in the new 
version for your evaluation.


Technical notes from 9.2.x release products that apply to 9.3.x
◆ “Technical notes from 9.2.x release products that apply to 9.3.x” on page 6


◆ “Technical notes for 9.2.1 release products” on page 7


Technical notes for 9.2.2 release products


Instructions for changing default Cryptographic settings 


Changing Pseudo-random Number Generators (PRNG) algorithm


CQ 649798 


The Smarts Global Console SSL implementation uses ECDRBG128 (Dual EC DRBG) as the 
default PRNG algorithm. Following NIST's decision to recommend against the use of 
Dual_EC_DRBG, it is recommended that you discontinue the use of Dual EC DRBG, and 
move to a different PRNG (HMACDRBG256) at this time.


Changing the use of the default PRNG algorithm


Add the following line in the java.security file located at BASEDIR/_jvm/lib/security/ 
directory:


com.rsa.crypto.default.random = HMACDRBG256
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Apply this change to the following components:


◆ Smarts Global Console


◆ Any other custom programs written by you using the DMT Java remote API


The EMC Smarts Version 9.2 Security Configuration Guide is updated to provide 
instructions on how to change the default cryptographic settings in Smarts components as 
well as provide information on how to change the use of the default PRNG algorithm.


Replacing or importing  TLS certificates
By default, a Smarts Domain Manager generates a self-signed TLS certificate that it will 
present to the incoming TLS connections. However, you can configure a certificate to use 
by performing the following step:


Place the certificate and key files in $SM_SITEMOD/conf/tls/$DOMAIN.crt and 
$SM_SITEMOD/conf/tls/$DOMAIN.key where $DOMAIN is the name of the domain used 
to register with the broker. The files must be in PKCS#8, PEM encoded form with no 
password.


Self-signed certificates generated by Smarts are stored in the process memory. To 
regenerate default self-signed TLS certificates, stop and restart the Smarts processes.


Technical notes for 9.2.1 release products


There are no technical notes that apply to all 9.2.1 release products.
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Fixed problems from 9.2.x that apply to 9.3.x
“Fixed Problems in 9.2.x” on page 8


Fixed Problems in 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems common for all 9.2.x products


CQ 577981
CQ 577738


--env=SM_SITEMOD crashed the VoIP domain 
in Windows.
When Smarts was installed as a Windows 
service, with SM_SITEMOD specified using the 
--env option, the SM_SITEMOD search path did 
not get computed correctly when the service 
started.


Apply the environment variable settings (which are 
encoded in a special command line argument) early 
from the runcmd.exe wrapper program, so that the 
values are used in any search path computations 
performed by runcmd.
Changed Components:
Executables: runcmd.exe (and hence all shipped 
executables in smarts/bin)
Libraries: sm_sms


9.2.1


CQ 644152
CQ 604257
SR 55843484


The activation command did not set the 
Standby domain to the Active domain.


The failover server did not process the command to 
TakeOver a domain.
When the shell script actions that are part of the 
failover solution are modified using sm_edit, these 
actions fail when the failover server runs them.
The first one is due to a limitation on the failover 
server. Backups are currently run sequentially and 
there were too many domains attached to the 
failover manager which was resulting in too much 
time being spent on backups. The recommendation 
is to split the domains into multiple failover servers 
so that the time spent doing backups is optimized 
and the failover/takeover requests are handled 
quicker. For example, put SAM, OI, BIM, NPM into 
one failover server and IP, MPLS into another failover 
server.
The second issue was due to a bug in the shell 
scripts. Locating files under SM_SITEMOD/actions 
were not handled properly. They were looking at 
SM_HOME/actions. This is now fixed. The scripts 
can be modified using sm_edit and the failover 
server processes the actions from the modified 
script.


9.2.0.1
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CQ 644510
CQ 644456


When the failover server was restarted, it 
started running backups and operations could 
not be performed until the backups 
completed.


A parameter “AutoBackupsEnabled” is now 
provided in the failover.conf file. The 
“AutoBackupsEnabled” parameter controls backups 
that are run automatically by the Failover Domain 
Manager. You can change the value to FALSE in the 
user interface, only if you want to disable the backup 
tasks. 


Note: (1) Changing the value in the Failover.conf file 
will result in unsuccessful failovers. 
(2) When starting the failover server for the first 
time, you must start it with AutoBackupsEnabled = 
TRUE. On subsequent restart, it can be set to FALSE 
for no auto manual backup.


9.2


CQ 577477
SR 50887122


Server's memory usage increases when there 
is a rate function defined over a negative 
window.


A negative value converted to unsigned resulted in a 
big value for the window over which to calculate the 
rate. This resulted in a big amount of samples that 
were required to cover the window. 
So new samples kept being added to the history 
collection data structure, which was causing the 
increased memory usage. The fix was to limit the 
collection size. The limit was set to 1000 samples. 
The rate function in this situation will be suspended 
with error MR_NOT_ENOUGH_TIME. 


9.2.1


CQ 597446
SR 49540808


A problem gets suspended with 
"DX-PROBLEMUNKNOWN-Problem unknown to 
correlator because it has no symptoms", even 
though it has symptoms, and 
consistencyUpdate has been run after 
topology changes.


The problem was observed when server was started 
with --subscribe option that starts internal 
subscriber on start up. The correlator's 
consistencyUpdate has not been called by the time 
subscriptions started, so the problems initially gets 
rejected with DX-PROBLEMUNKNOWN error because 
they have not been added to the codebook yet. 
Normally, these problems will be resubscribed in the 
course of consistencyUpdateCompletion by 
resubscribeRejections call, and the error will be 
cleared.
However, it may happen that by the time 
resubscribeRejections runs some of the problems 
are still in pending state, since their subscritpion 
processing has not been finished. These problems 
will not get resubscribed, and the error will not clear 
until the next consistencyUpdate call.
The fix was to make resubscribeRejections being 
called after all pending subscriptions are processed.


9.2.1


CQ 577631
CQ 577591


Made the TLS cipher suite preferences 
configurable.


Allowed SM_TLS_SUITE_LIST to be set to a 
colon-separated list of cipher suite specifier strings. 
The list of allowable options, including FIPS 
compatibility, is listed in the RSA BSAFE MES 
documentation. The client and server will choose 
the first item in the client's suite list that also 
appears in the server's list. In other words, client 
and server must agree on acceptable options, but 
the client's preference wins. Also, removed 
undocumented support for FIPS TLS Suite B.
Changed Components:
Libraries: sm_clsapi


9.2.1
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CQ 577628
CQ 577588


Allow CI_FlowBufferHead_U default buffer size 
to be tuned through an environment variable.


The default buffer size for CI_FlowBUfferedHead_U 
affects performance, but is not configurable at 
runtime, so any investigation of performance 
changes or tuning requires custom-built libraries. 
Introduced an environment variable 
SM_FBH_BUFSIZE to allow adjusting the default. It 
currently defaults to 2048 (the old hardcoded 
default).


9.2.1


CQ 642779 sm_migrate.pl error message. sm_migrate.pl must be invoked using sm_perl. 9.2.1


CQ 567978 Enable run-time control over locking in 
SM_RepositoryServer get methods.


Introduced method EnableTransaction to 
MR_LockInterface model class to set the mask 
defining which methods of SM_RepositoryServer 
should start repository transaction. Also added
method GetTransactionMask, to get the current 
mask. By default, transaction is disabled in all 
methods.
Added an option to selectively unblock readers in 
SM_RepositoryServer transactions, depending on 
the method initiating the transaction, a 
single-property get or a get of multiple properties.
Set the default value of 
MR_UnblockReaders::allowed flag to disallow 
unblocking in all cases.


Note: Do not change these settings unless advised 
by EMC support.


Changed Components:
Libraries: sm_repos
Model file: MR_LockInterface.mdl


9.2.1
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CHAPTER 2
Service Assurance Manager 9.2.x Features and 
Technical Notes 


This chapter includes the following sections: 


◆ Service Assurance Manager features from 9.2.x that apply to 9.3.x..........................  12
◆ Service Assurance Manager technical notes from 9.2.x that apply to 9.3.x...............  16
◆ Service Assurance Manager fixed problems from 9.2.x that apply to 9.3.x ...............  19
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Service Assurance Manager features from 9.2.x that apply to 9.3.x
◆ “Features in SAM 9.2.2” on page 12


◆ “-Features in SAM 9.2.1” on page 12


Features in SAM 9.2.2


Support for Internet Explorer (IE) 10 and IE 11
The EMC Smarts Support Matrix provides a list of officially supported browsers for 
launching the EMC Smarts Global Console.


-Features in SAM 9.2.1


SAM release 9.2.1 includes important new features and changes to the existing features:


◆ “SAM heartbeat monitoring” on page 12


◆ “Improvements to SAM archival time” on page 15


◆ “Service Assurance Manager technical notes from 9.2.x that apply to 9.3.x” on 
page 16


◆ “Service Assurance Manager technical notes from 9.2.x that apply to 9.3.x” on 
page 16


SAM heartbeat monitoring
All Smarts servers maintain an uptime attribute through the SM_System::SM-System 
object, which is updated once every minute. This uptime attribute can be perceived as the 
heartbeat of a Smarts server. In this release, SAM server has been enhanced with the 
functionality to monitor the heartbeat of a Smarts server. SAM heartbeat monitoring is a 
feature available from SAM that provides the capability to monitor the health conditions of 
the heartbeats of its underlying domains. In addition to monitoring heartbeats of 
underlying domains, this new feature is also capable of detecting two abnormal 
conditions:


◆ burstyNotification - Extreme burst arrivals of events or notifications, which could 
overwhelm the system resulting  in slow response time or even freeze.


◆ hyperNotifThreadHung - This use case applies only  to  SAM -> SAM  communication in 
hierarchical SAM configuration and to  SAM -> OI communication. The feature can 
detect hanging of the hyper-notify thread associated with the underlying domain, 
which may indicate the notification processing at the local SAM server being 
suspended.
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The feature is facilitated by the introduction of the ICS_Heartbeat model. Once SAM 
heartbeat monitoring is enabled from top level SAM for underlying  servers, an instance of 
ICS_Heartbeat is created correspondingly for this domain in SAM. ICS_Hearbeat is 
responsible for generating the heartbeat events as well as events indicating the two 
abnormal conditions stated above. In a hierarchical SAM configuration, ICS_Heartbeat 
monitoring needs to be enabled for every SAM and OI server.


Issues addressed


SAM heartbeat monitoring, once deployed, provides a mechanism that can quickly 
identify the nature of some performance issues that are encountered in the field, thereby 
reducing troubleshooting time or providing guidance to hardware upgrade. 


For example, if SAM experiences slow response time or freeze, it can be quickly 
determined whether the problem is due to burst arrivals from a connected domain, or due 
to a slow network connection, or high CPU usage. If it is due to the burst of Notifications, 
burstyNotification alerts for the domains that have sent all the notifications are seen. If 
the issue is due to a slow network connection, heartbeatDelayed notifications are 
received.


Further, if the SAM domain stopped processing new notifications from one or more 
underlying domains, it can be quickly determined whether the problem is due to hanging 
threads (hyperNotifThreadHung) or due to a broken network connection 
(heartbeatDelayed).


Heartbeat monitoring events


ICS_Heartbeat model generates four types of events when the event conditions are met. 
All events are converted to SAM notifications, therefore are visible from a Console.


◆ heartbeatReceived - Indicates a heartbeat is received from the monitored domain. No 
action is needed, which indicates the system is operating normally.


◆ heartbeatDelayed - Indicates a heartbeat has missed its deadline (determined by a 
configurable threshold) of 180 seconds. No immediate action is needed. This event 
will be cleared when a new heartbeatReceived event has arrived. If heartbeatDelayed 
is not cleared within several minutes, it could indicate a connection problem with the 
domain server, or the domain server is overwhelmed by operations that may hold the 
repository for too long, such as reconfigure or repository save or a  hook script with a 
bug, therefore delaying reporting its heartbeat. If there is a consistent 
heartbeatDelayed event, it may indicate a hardware upgrade opportunity as well if the 
problem is not caused by a buggy hook script.  If heartbeatDelayed notification is 
persistent, run the sm_monitor tool in <BASEDIR>/smarts/bin directory against the 
domain for which the heartbeatDelayed notification was generated.


◆ burstyNotification - Indicates the condition that notification or event arrivals per 
minute exceeds a threshold of 3000 per minute. No immediate action is needed. This 
event indicates the reason/root cause behind the response time slowness. It can 
pin-point the source of the bursts.  To recover from the slowness, temporarily 
disconnect the source or reduce the bursts by enabling filtering (such as trap filters). If 
the bursts are legitimate and persistent, it might be an opportunity to upgrade the 
hardware or rethink on the system architecture, for example, if your system is capable 
of handling over 3000 notifications per minute, increase the threshold to avoid false 
alerts. “Setting up SAM heartbeat monitoring” on page 14 provides more details.
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◆ hyperNotifThreadHung - Indicates the condition that the hyper-notify thread stopped 
processing events for more than the time period determined by a threshold of 180 
seconds. Take action to resolve this issue. If the heartbeatDelayed alert is generated 
at the same time, it could indicate a network connection issue or a freezing peer 
server. If the heartbeatReceived event is generated normally, it could indicate that the 
hyper-notify thread within the local domain has stopped processing notifications 
which may be due to either a failed hook script or a remote function call that has 
never returned (such as a prolonged DNS request). By taking a sequence of the 
stacktrace using the sm_monitor tool in <BASEDIR>/smarts/bin, the exact cause can 
be determined. The sm_monitor tool needs to run against the domain running the 
hyper-notif thread, for example, top level SAM or SAM subscribing to OI.


Setting up SAM heartbeat monitoring


SAM heartbeat monitoring is currently not enabled by default. 


To enable heartbeat monitoring:


1. In a hierarchical SAM configuration, heartbeat monitoring needs to be enabled at 
every layer of the hierarchy. Enable heartbeat monitoring once the SAM servers are up 
and running and the underlying domains are configured.


Use dmctl to initialize and set up heartbeat monitoring by typing the following 
command:


dmctl> invoke ICS_HeartbeatMonitor::ICS-HeartbeatMonitor initialize


Once this command is executed, a conf file named as heartbeat.conf is automatically 
created in the local/conf folder, which contains all the appropriate entries for that  
SAM domain.


2. Use sm_edit to open smarts/local/conf/ics/heartbeat.conf (or the 
smarts/local/conf/icoi/heartbeat.conf) file. Check the following ICS_Heartbeat 
attributes for each instance based on the monitoring requirements and data from the 
past. The set of attributes include:


• heartbeatDelayThreshold - the maximum delay time (in seconds) of the monitored 
heartbeat before a heartbeatDelayed event is fired by the corresponding 
ICS_Heartbeat instance.


• notificationThresholdInOneHeartbeat - when notifications which had arrived from 
the connected domain exceeds the threshold, a burstyNotification event is fired by 
the corresponding ICS_Heartbeat instance.


• hyperNotifQuietTimeThreshold - when the time period has passed in which there is 
no notification received through hyperNotif, a hyperNotifThreadHung event is fired 
by the corresponding ICS_Heartbeat instance.


3. Close the heartbeat.conf file if the default settings meet the monitoring requirements. 
This completes the setup.


4. If there are changes to be made to heartbeat.conf, then again use dmctl to reconfigure 
heartbeat monitoring by typing the following command:


dmctl> invoke ICS_HeartbeatMonitor::ICS-HeartbeatMonitor reconfigure
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Once the above steps are executed correctly, heartbeat events will be displayed in the 
Console. Attach a Console directly to SAM and verify the arrival of heartbeat events to 
determine whether heartbeat monitoring has been set up correctly.


Controlling SAM heartbeat monitoring


ICS_HeartbeatMonitor is a manager object for controlling this feature. This object provides 
the following functions to enable and disable SAM heartbeat Monitoring. All the functions 
can be executed through dmctl.


◆ enableMonitorAll - Enables all heartbeat monitoring (which is default after initialize() 
is called)


◆ disableMonitorAll - Disables all heartbeat monitoring


◆ enableMonitorForDomain (in string domainName) - Enables monitoring for a specific 
domain


◆ disableMonitorForDomain (in string domainName) - Disables monitoring for a specific 
domain


◆ enableNotifyHeartbeatAll - Allows heartbeatReceived to be reported (which is default 
after initialize() is called). This does not turn off monitoring. 


◆ disableNotifyHeartbeatAll - Does not allow heartbeatReceived to be reported


◆ enableNotifyHeartbeatForDomain (in string domainName) - Allows heartbeatReceived 
to be reported only for a specific domain.


◆ disableNotifyHeartbeatForDomain (in string domainName) - Does not allow 
heartbeatReceived to be reported for a specific domain


◆ resetHeartbeatAll() - Resets heartbeat statistics maintained by all ICS_Heartbeat 
Instances.


◆ resetHeartbeatForDomain (in string domainName) - Resets heartbeat statistics for a 
specific domain.


Improvements to SAM archival time
This is a performance improvement of the existing SAM archive feature. In the earlier 
release, it used to take the SAM server a long time to archive notifications with many audit 
entries.  In this release, the code has been optimized so that SAM does not take a long 
time to archive notifications, even though it contains a large audit log.
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Service Assurance Manager technical notes from 9.2.x that apply 
to 9.3.x


◆ “Technical notes for SAM 9.2.2” on page 16


◆ “Technical notes for SAM 9.2.1” on page 18


Technical notes for SAM 9.2.2


◆ “Details on how KeepAlive works” on page 16


◆ “After a crash, the failover server does not restart the Failover System” on page 16


◆ “How to configure trapFlood traps and TrapdDiscardingTraps” on page 17


◆ “Timeout value is set by default for all underlying Domain Managers” on page 17


◆ “Resolving issues related to unusual growth in log file size” on page 18


◆ “Users with custom code that uses EMC Smarts API” on page 18


Details on how KeepAlive works
CQ 641853 / CQ 641846 / SR 52796808


The Perl script acts as a client that connects to the EMC Smarts Domain Manager. The Perl 
script and the Domain Manager communicate through a TCP connection.


The KeepAlive messages check the connection between the clients, including Perl clients, 
and the EMC Smarts Domain Managers. Under certain circumstances, the client's 
operating system might incorrectly insert the urgent data into the regular data stream, 
which corrupts the regular data stream and causes problems in the connection. This leads 
to an error on the client side.


For a detailed explanation on how KeepAlive messages work, and to disable the feature, 
refer to SM_DISABLE_KEEPALIVES in the “Environment variables for users” section of the 
EMC Smarts Foundation 9.2 System Administration Guide.


After a crash, the failover server does not restart the Failover System
CQ 649126


When a failover server crashes, the server restarts from the point before it shut down and 
does not restart the Failover System.


For example, INCHARGE-SA is started as primary server A and secondary server B on two 
different machines. When a failover occurs, server B becomes the primary server and 
server A becomes the secondary server. Now if the failover server crashes, then after a 
restart of the failover server, INCHARGE-SA server B will still start as the primary server, 
even though it is set up as the secondary server in the failover.conf file, that is, server B 
will not pick up the status from the failover.conf file.


The roles cannot be reversed through the console.
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How to configure trapFlood traps and TrapdDiscardingTraps
CQ 642856 / CQ 642389


“Starting and stopping the SNMP Trap Adapter” section in the EMC Smarts Service 
Assurance Manager Adapter Platform User Guide provides information on how to use the 
sm_service utility to manually start and stop the SNMP Trap Adapter.


This section describes how to configure trapFlood traps and TrapdDiscardingTraps.


.1.3.6.1.4.1.733.10 6 1 and .1.3.6.1.4.1.733.10 6 2 are TrapdDiscardingTraps. The 
following traps are sent by the sm_trapd queue when it reaches the QUEUE_LIMIT_MEGS 
or the QUEUE_LIMIT_SECS limits:


◆ .1.3.6.1.4.1.733.10 6 1 is sent when the Trap receiver queue has reached its limit.


◆ .1.3.6.1.4.1.733.10 6 2 is sent when the Trap receiver is not discarding traps any 
more.


◆ .1.3.6.1.4.1.733.10 6 3 and .1.3.6.1.4.1.733.10 6 4 are TrapFlood. The following traps 
are sent by the sm_trapd queue when it determines that certain sources are flooding 
it with traps:


• .1.3.6.1.4.1.733.10 6 3 is sent when the Device is flooding the trap receiver.


• .1.3.6.1.4.1.733.10 6 4 is sent when the Device is not flooding the trap receiver 
any more.


These traps are introduced in SAM 9.x and later releases. The trap_mgr.conf file provides 
more information on these traps.


You can create the flood trap using NOTIF by importing the trap_mgr.conf or by creating the 
Event Configuration Information (ECI) similar to the definition in the trap_mgr.conf file. The 
Notification Module User Guide provides more information on how to create the ECI.


Timeout value is set by default for all underlying Domain Managers


CQ 576857


In the 9.1 release, a timeout value is set by default for Event driver, Notification driver, 
and Topology driver. A default timeout value of 600 seconds is enabled for all underlying 
Domain Managers connected to SAM. Previously, SAM would wait indefinitely for a 
response from the underlying Domain Managers. Now with the default timeout value, 
SAM will wait for 600 seconds for the underlying Domain Managers to respond after 
which, it will end the connection with the Domain Manager and start a new connection. 


The timeout value is assigned to the variables, TimeOutBE and TimeOutTopo in the files – 
ics-event-driver.asl, ics-event-processing.asl, and ics-nl-processing.asl. TimeOutBE is a 
timeout set for events and notification driver timeouts, and TimeOutTopo is a timeout set 
for topology driver timeout.


If you would like to modify the timeout value, you need to edit the variables in the dxa 
conf file corresponding to the underlying Domain Manager. 
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Resolving issues related to unusual growth in log file size


CQ 636047


If a huge growth in the log file size is observed, for instance in the Broker log:


1. Re-install the Broker as service with environment setting SM_NO_LOG_CLIENTS=TRUE.


2. Restart the Broker service.


To disable the client logging feature subscription for all the servers or Domain Managers, 
set SM_NO_LOG_CLIENTS=TRUE in the runcmd_env.sh file, and then restart the Broker 
and Domain Managers.


Users with custom code that uses EMC Smarts API


If the code is based on Java, Perl, or C API, modify and retest the code according to the 
changes in this release. If a dynamic model is used, recompile the code.


The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


Technical notes for SAM 9.2.1


There are no technical notes for Service Assurance Manager 9.2.1.
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Service Assurance Manager fixed problems from 9.2.x that apply 
to 9.3.x


“Fixed problems in Service Assurance Manager 9.2.x” on page 19


Fixed problems in Service Assurance Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems in SAM 9.2.x


CQ 644260
CQ 577986
SR 56283120


Overloaded logs were added to the OI server.
The log messages help debug if traps are not 
converted into notifications because of the 
unknownagent setting. Notif has different log 
levels that you can specify when configuring it.


In earlier releases, the log level was set to ALWAYS. 
From this release, the log level is changed to DEBUG. 
These messages are logged only when the log level 
is set to DEBUG. Set the log level during the start of 
the SAM/OI server and restart the SAM/OI server if 
you need to enable this debugging.


8.1.4.4


CQ 644369
SR 56401364
CQ 644761
CQ 644210


When multiple domains with different domain 
names were started from the same SAM 
installation, the heartbeat.conf file was 
overwritten and the first domains entries were 
erased from the configuration file.


Running instances of the SAM server are 
distinguished from their server names. Thus the 
heartbeat configuration file name is now suffixed 
with the SAM server name. So when multiple SAM 
server instances are started from a single 
installation, as long as the corresponding server 
names are different, which should always be true in 
practice, the heartbeat monitor module should be 
able to automatically pick the correct configuration 
file to import or export heartbeat monitor related 
configurations. The location of the heartbeat 
monitor configuration file is not changed.


9.2.1


CQ 644394
CQ 604782
SR 55693508


Aggregate/Presentation SAM WAS_ACTIVE 
logic did not work.
The scenario was that the Presentation SAM 
was receiving the same notification from two 
Aggregate SAMs and then the first Aggregate 
SAM goes down. Because we are not notifying 
the notification received by the second 
Aggregate SAM, the notification in the 
Presentation SAM was marked as WAS_ACTIVE 
because the EventStateTable of the 
notification had only the first Aggregate SAM 
entry. Ideally the notification should have 
been ACTIVE since the second Aggregate SAM 
was still running.


The fix is to NOTIFY the notification even if we have 
received the same notification from the same 
source. By this we have the second Aggregate SAM 
entry in the EventStateTable and the above scenario 
will be handled with the notification still ACTIVE.


9.2.0.1


CQ 644813
CQ 605991
SR 56797280
CQ 606891
CQ 642703


Device information was not correctly 
propagated from the Domain Manager to SAM 
for the FibreChannelSwitch class.
Prior to the 9.2.1 release, because IP and ESM 
were following different naming conventions 
for the FC switch, SAM was creating duplicate 
instances (one for instance from IP and one 
instance from ESM).


From the 9.2.1 release, although the instance 
names are different in IP and  ESM, SAM uses IP 
address which is the only common attribute 
between IP and ESM to avoid creating duplicate 
instances. Instance in SAM is created with IP 
address irrespective of the naming convention 
followed in the underlying domain.


9.2.1

Service Assurance Manager fixed problems from 9.2.x that apply to 9.3.x 19







Service Assurance Manager 9.2.x Features and Technical Notes

CQ 642855
CQ 642742
SR 54337508
CQ 642855


In the Smarts 9.2 Installation Guide -> 
Overview -> Product and version compatibility 
-> Table 1 - Interoperability chart for EMC 
Smarts Service Assurance Manager, the EMC 
Smarts VoIP Availability Manager had only 4.0 
and 8.1.x listed.


EMC Smarts VoIP Availability Manager version 9.x 
should also be listed. The EMC Smarts Version 9.2.2 
Installation Guide for SAM, IP, ESM, MPLS, VoIP, and 
NPM Managers has been updated to reflect this 
change.


9.2.0.1


CQ 644791 
CQ 644725
CQ 649340
SR 57271350
CQ 609664
CQ 609489


Heartbeat events were not updated after SAM 
was restarted.


This issue is now fixed by starting the heartbeat 
monitoring whenever SAM/OI server is restarted. 
An editable flag AUTO_START_HEARTBEAT is 
provided in the ics-init.asl and icoi-init.asl files to 
enable/disable the heartbeat monitoring auto 
restart. By default this flag is set to TRUE.


9.2.1
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CQ 577496
SR 51566768
CQ 649082


SNMP v3 credentials need to be transferred to 
OI from IP and be used as part of SNMPv3 trap 
processing and handling. Keying in credentials 
twice (once in IP and then again in OI) is an 
overhead for users.


SNMP v3 Credentials present in IP Domain Manager 
will be automatically transferred to the OI server 
from IP during topology synchronization. The 
credentials will be saved in the InChargeDomain 
Object that will be read by the Trap Adapter Process.
The Trap Adapter Process imports credentials into 
the Local Credential database from the OI server at 
startup or on reload configuration. 
To reload configurations for Trap Adapter Process:
./sm_trapd -b <broker-name> -s <TrapAdapter-Name> 
--reloadConfig
Automatic Transfer of Credentials from IP to OI to 
Trap Adapter process :
Configuration steps:
1. imk.dat in the IP installation and the 


INCHARGE-OI install area (from where the Trap 
Adapter process is started), should contain the 
same pass-phrase. To ensure this, recreate or 
upgrade the imk.dat using the sm_rebond 
command, in both the IP and OI install locations.


2. Start the OI server. Automatic transfer of 
credentials from IP to OI is disabled by default.


    To enable, run the following dmctl command :
./dmctl -b <broker-name> -s <OI server-name> put 
ICF_TopologyManager::ICF-TopologyManager::im
portSNMPv3Credentials TRUE


3. Underly the IP server to OI server. Now any 
credentials configured in the IP Server will be 
transferred to the OI server.


4. Now start a Trap Adapter attaching to the OI 
server. Credentials will be read by the Trap 
Adapter Process from the OI server during startup 
and configuration reload.


5. SNMPv3 Credentials would be synced from IP to 
OI at the end of Topology Synchronization.


Note: After performing the reloadConfig operation 
for the Trap Adapter, configured as a Receiver to 
read the changed or new SNMPv3 Credentials from 
the OI server, wait till the first new trap is processed 
by the Trap Adapter for existing devices, so that the 
TrapAdapter successfully reads the changed or new 
SNMPv3 credentials from the OI Server.


9.2.1
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CQ 642445
CQ 639335
CQ 559952
CQ 639295 


SAM servers crashed due to out of memory. The previousEvent <string set> has been added only 
for the HyperNotification functionality (added from 
SAM 8.X onwards). In case of HyperNotificaton, all 
incoming notifications are verified against 
currentEvents and previousEvent list. If it does not 
exist in either of them, it treats this event as an 
invalid notification. We do not have any logic to 
cleanup this list (we move the notification from 
previousEvent list to currentEvents in case of 
renotify and reverse action is done in case of 
deleting an event). 
Now we clean the old cache data periodically. This 
value is defined by the new flag: 
SM_CACHE_CLEANUP_SECONDS.
Default 259200 seconds, that is, 3 days.


9.2.1


CQ 642135
CQ 642134
CQ 598052
CQ 640941


Migration of dynamic model files. The documentation related to the section “Migration 
of dynamic model files” in the Smarts Installation 
Guide should be updated with the following 
information:
1. Recompile the .mdl files using the SAM dynamic 


model compiler.


2. Copy all the .dat files generated, to the local/l10n 
directory.


3. Start the SAM server.


9.2.1
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IP Manager 9.2.x Features and Technical Notes


This chapter includes the following sections: 


◆ IP Manager features from 9.2.x that apply to 9.3.x...................................................  24
◆ IP Manager technical notes from 9.2.x that apply to 9.3.x ........................................  55
◆ IP Manager fixed problems from 9.2.x that apply to 9.3.x ........................................  61
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IP Manager features from 9.2.x that apply to 9.3.x
◆ “Features in IP Manager 9.2.2” on page 24


◆ “Features in IP Manager 9.2.1” on page 38


Features in IP Manager 9.2.2


◆ “Changes in discovery Rogue Access Points” on page 24


◆ “Changes in generating “CLI credentials not found” discovery error” on page 24


◆ “HP Blade System discovery” on page 24


◆ “Cisco UCS Enhancement” on page 33


◆ “Protect trap receiver against uncontrolled memory growth for IP” on page 35


◆ “Changes to oidInfo.conf file and its location after an upgrade” on page 36


◆ “Device type changes due to recertifications” on page 36


◆ “Support for Cisco IOS 15.0” on page 36


Changes in discovery Rogue Access Points
CQ 613263


There was no parameter in IP Domain Managers to control the discovery of Rogue Access 
Points. This resulted in discovery and alerts of unwanted Rogue Access Points on Cisco 
wireless controllers. The EnableRogueAPDiscovery parameter was introduced in the 
<BASEDIR>/IP/smarts/conf/discovery/tpmgr-param.conf file to control Rogue Access 
Points discovery. By default, the value is set to TRUE. Set it to FALSE if you would like to 
stop discovery of Rogue Access Points.


Changes in generating “CLI credentials not found” discovery error
CQ 614051 


By default, the IP Domain Manager generates the following discovery error message for 
devices that are discovered via CLI:


CLI credentials not found. Please provide the same in Device Access 
tab of Polling and Thresholds 


In some cases, users are satisfied with the discovery results based on SNMP only and do 
not wish to provide CLI credentials. The DisableCLIError parameter was introduced in the 
<BASEDIR>/IP/smarts/conf/discovery/tpmgr-param.conf file to prevent unnecessary 
discovery error alerts. The default value is TRUE. Set the parameter to FALSE if you would 
like to stop generating these discovery errors. 


HP Blade System discovery
IP has been enhanced to support discovery and monitoring of HP Blade System C7000. 
The Blade System is modeled as ComputeFabric, similar  to Cisco UCS.  New model classes 
like Blade and ComputeFabricManager are introduced.
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The Blade System C7000 provides the power, cooling, and I/O infrastructure needed to 
support modular server, interconnect, and storage components. The HP Blade system 
comprises of the following:


◆ HP Onboard Administrator — The OA or Onboard Administrator is the management 
entity of the HP Blade System.


The HP Onboard Administrator module provides the MIB details to manage the 
Compute Fabric and Blade Enclosure Manager. Both the Compute Fabric and the 
Blade Enclosure Manager are created using the ComputeFabricManager name.


The Onboard Administrator is located in the enclosure and performs the functions 
listed here. A second optional OA provides redundancy to these functions:


• Component insertion and removal detection


• Component identification and connectivity 


• Power and cooling management


• Components control


◆ HP Blade System C7000 Chassis 


◆ Blade Server


Both SNMP and CLI are used for discovery. 


CLI credentials of the Onboard Administrator (Active) is a prerequisite for complete 
discovery. You can configure the CLI credentials of the Onboard Administrator in Domain 
Manager Administrative Console > Polling and Threshold > Device Access tab. 


Components like ComputeFabric, BladeEnclosureManager, Blade, Fan, Power Supply, and 
ComputeFabricManager are discovered through SNMP polling of the Onboard 
Administrator.


CLI information is used to find enclosure components like VirtualConnect, Switches, and 
Hosts installed on Blades and build relationships with the ComputeFabric.


The Onboard Administrator’s redundancy is supported by creating a redundancy group 
and defining related events like SwitchOver, SwitchOverFailed, AtRisk, 
ReducedRedundancy, and so on.


The discovery of the HP Blade system involves the mapping of the HP Blade System 
NetConnectors to the HP Blade System. In the current implementation, the following 
switches are considered as HP Blade System NetConnector.


◆ HP VC-Ethernet Module — System ObjectID .1.3.6.1.4.1.11.5.7.5.1


◆  HP VC-FC Module — System ObjectID .1.3.6.1.4.1.3873.1.7


◆  HP VC-FlexFabric Module — System ObjectID .1.3.6.1.4.1.11.5.7.5.1


◆ Cisco Catalyst Blade Switches (Ethernet module), Model: 3120X, 3120G, 3200 — 
System ObjectID .1.3.6.1.4.1.9.1.748 or .1.3.6.1.4.1.9.1.948
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◆ Cisco MDS Switches — System ObjectID .1.3.6.1.4.1.9.12.3.1.3.606


◆ BrocadeSilkWormSwitch 


• System ObjectID — .1.3.6.1.4.1.1588.2.1.1.43 


• System ObjectID — .1.3.6.1.4.1.1588.2.1.1.72)


Discovery of Blade System c7000 Enclosure (ComputeFabric)


The Blade System c7000 Enclosure is represented by the class ComputeFabric in IP 
topology.


It is defined by the following relationships:


◆ ComposedOf relationship with Card


◆ ManagedBy relationship with ComputeFabricManager


◆ PackagedCooledBy relationship with Fan


◆ PackagesSystem relationship with BladeEnclosureManager, ComputeFabricManager, 
FibreChannelSwitch and Switch


◆ PackageTempMeasuredBy relationship with TemperatureSensor


To manage the HP Blade System C7000, add the active Onboard Administrator through 
the Add Agent option in Domain Manager Administrator Console. After adding the device 
name or IP address, IP Availability Manager discovers it.


IP Availability Manager discovers the Onboard Administrator as ComputeFabricManager.


Provide the active OA management IP address with the corresponding user credentials in 
the CLI Access Group, when discovering the HP Blade System C7000 equipment. IP 
requires a read only CLI access to OA and privileged access need not be provided.


Discovery of the HP Blade System C7000 Chassis 
(BladeEnclosureManager)


IP Availability Manager discovers and represents the HP Blade System C7000 Chassis as 
the BladeEnclosureManager in the topology.


A HP Blade System C7000 chassis can have up to 16 blades. These blades connect to 
Interconnects through the Midplane. 


When you discover the HP Blade System C7000 chassis, IP discovers the following 
components present in the HP Blade System C7000 entity: 


◆ Physical blades


◆ Power supply


◆ Fan


◆ Temperature Sensor


The class BladeEnclosureManager is defined by the following relationships:
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◆ ComposedOf relationship with Blades, Fan, and PowerSupply.


◆ SystemPackagedIn relationship with ComputeFabric.


IP uses the following CLI commands during HP Blade discovery: 
SHOW EBIPA 
SHOW SERVER PORT MAP ALL


The status of Blades, Power Supply, and Fans are fetched from the Onboard Administrator 
through SNMP requests. Other components are monitored through the respective device 
SNMPAgents.


Discovery of HP OnBoard Administrator (ComputeFabricManager)


IP Availability Manager discovers the HP OnBoard Administrator as 
ComputeFabricManager. The ComputeFabricManager is defined by the following 
relationships:


◆ ComposedOf relationship with Interface, Memory and Processor


◆ ConnectedVia relationship with Cable and IPNetwork


◆ HostsAccessPoints relationship with IP and MAC


◆ HostsServices relationship with SNMPAgent


◆ ListsOfHostsAccessPoints relationship with IP and MAC


◆ Manages relationship with ComputeFabric


◆ MemberOf relationship with Partition


◆ NeighboringSystems relationship with Router and Switches


◆ PartOf relationship with ComputeFabricManagerRedundancyGroup


◆ SystemPackagedIn relationship with ComputeFabric


Discovery of Blade


A Blade represents a compact, self-contained server that contains core processing 
components, hard-drives, memory, network cards that fit into an enclosure with other 
blade servers. These do not have their own power supplies or cooling solutions (including 
fans) as these are supplied by their enclosure.


Blade is defined by PartOf relationship with BladeEnclosureManager.


Discovery of ComputeFabricManagerRedundancyGroup


The ComputeFabricManagerRedundancyGroup is a specialized redundancy group 
comprising of more than one ComputeFabricManagers.


The ComputeFabricManagerRedundancyGroup is defined by the ComposedOf relationship 
with ComputeFabricManager.
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If credentials are not provided, the device is placed on the pending list with a discovery 
error.


Root-cause analysis for HP Blade System C7000


The root-cause problem diagnosed for Blade, BladeEnclosureManager, Switch and 
ComputeFabricManager are listed in Table 1 on page 28, Table 2 on page 28, Table 3 on 
page 28 and Table 4 on page 28 respectively. 


Table 1  Root-cause problem diagnosed for Blade


Root-cause problem Events on Blade Events on Host Impacted system


• Unresponsive
• MightBeDown
• Down


• Host::Unresponsive
• Host::MightBeDown


• Blade
• Host (on which the Blade is installed)


• Unresponsive
• MightBeDown


• Host::Unresponsive
• Host::MightBeDown


• BladeEnclosureManager 
• Blades
• Hosts installed on each blade


Table 2  Root-cause problem diagnosed for BladeEnclosureManager


Root-cause problem Description Events on Blade Impacted systems


• Unresponsive
• MightBeDown


• BladeEnclosureMan-
ager


• Blades present on it 
• Hosts installed on each 


blade.


Table 3  Root-cause problem diagnosed for Switch


Root-cause problem Description Events Impact


• Blade::Unresponsive
• Host::Unresponsive


• Blade
• Host


Table 4  Root-cause problem diagnosed for ComputeFabricManager


Root-cause problem Description Events Impact


Root Cause and impact scenarios for ComputeFabricManager


Let the two ComputeFabricManager in the RedundancyGroup be ComputeFabricManager1 
and ComputeFabricManager2.


Blade::Down


BladeEnclosureManager::Down


BladeEnclosureMan-
ager::Down


Indicates that all the blades included in 
the BEM are down.


Switch::Down Indicates that the switch is down.


ComputeFabricMan-
ager::Down


Indicates that the Onboard Administrator 
discovered as ComputeFabricManager is 
down. 


ComputeFabricMan-
ager::Unresponsive


ComputeFabricManager
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Scenario 1: ComputeFabricManager is NOT part of the RedundancyGroup


Table 5 on page 29 lists the root-cause and impact scenarios when the 
ComputeFabricManager is NOT part of the Redundancy Group.


Table 5  Root-cause and impact analysis for ComputeFabricManager  


Scenarios Root-cause and impact analysis


Compute 
Fabric 
Manager1


Compute 
Fabric 
Manager2 Blade


Blade Com-
posed
Of Host Host Problem Events


Impacted 
classes


Note: This 
occurs when all 
the blades are 
not unrespon-
sive.


Note: This 
occurs when all 
the blades are 
unresponsive.


Unresponsive NA Unresponsive No NA Compute 
FabricManager
1::Down


Unresponsive Blade


Unresponsive Compute 
FabricManager1


Unresponsive NA Unresponsive Yes Responsive Compute 
FabricManager
1::Down


Unresponsive Blade


Unresponsive Compute 
FabricManager1


Unresponsive NA Unresponsive Yes Unresponsive Compute 
FabricManager
1::Down
Blade::Down


Unresponsive Compute 
FabricManager1


Unresponsive Blade


Unresponsive Host


Unresponsive NA Unresponsive Yes Unresponsive Compute 
FabricManager
1::Down
BladeEnclo-
sureMan-
ager::Down


Unresponsive Blade


Unresponsive Compute 
FabricManager1


Unresponsive Host


Unresponsive Blade 
Enclosure 
Manager
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Scenario 2: ComputeFabricManager is a part of the RedundancyGroup


Table 6 on page 30 lists the root-cause and impact analysis of the 
ComputeFabricManager, when it is part of the RedundancyGroup.


Table 6  Root-cause and impact analysis for ComputeFabricManager  (page 1 of 2)


Scenarios Root-cause and impact analysis


Compute 
Fabric 
Manager1


Compute 
Fabric 
Manager2 Blade


Blade 
Com-
posed Of 
Host Host Problem Events


Impacted 
classes


Unresponsive Unresponsive Unresponsive NO NA ComputeFabric 
Manager1::Down
ComputeFabric 
Manager2::Down


Unresponsive Blade


ComputeFabric
Manager1


ComputeFabric
Manager2


Unresponsive Unresponsive Unresponsive Yes Responsive ComputeFabric 
Manager1::Down
ComputeFabric 
Manager2::Down


Unresponsive Blade


ComputeFabric
Manager1


ComputeFabric
Manager2


Unresponsive Unresponsive Unresponsive Yes Un 
responsive


ComputeFabric 
Manager1::Down
ComputeFabric 
Manager2::Down
Blade::Down


Note: This occurs 
when all the 
blades are not 
unresponsive.


Unresponsive Blade


ComputeFabric
Manager1


ComputeFabric
Manager2


Host


Unresponsive Unresponsive Unresponsive Yes Un
responsive


ComputeFabric 
Manager1::Down
ComputeFabric 
Manager2::Down
Blade::Down
BladeEnclosure 
Manager::Down


Note: This occurs 
when all the 
blades are unre-
sponsive.


Unresponsive Blade


ComputeFabric
Manager1


ComputeFabric
Manager2


Host


BladeEnclo-
sureManager


Unresponsive Responsive Unresponsive Yes Un
responsive


ComputeFabric 
Manager1::Down
Blade::Down


Unresponsive Blade


ComputeFabric
Manager1


Host
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Map representation


Figure 1 on page 31 depicts the HP Blade System C7000 support – Topology view. 


Figure 1  HP Blade System C7000 support–Topology view


Unresponsive Responsive Unresponsive No NA ComputeFabric 
Manager1::Down
Blade::Down


Unresponsive Blade


ComputeFabric
Manager1


Unresponsive Responsive Unresponsive No NA ComputeFabric 
Manager1::Down
BladeEnclosure 
Manager::Down


Note: This occurs 
when all the 
blades are unre-
sponsive.


Unresponsive Blade


ComputeFabric
Manager1


BladeEnclo-
sureManager


Table 6  Root-cause and impact analysis for ComputeFabricManager  (page 2 of 2)


Scenarios Root-cause and impact analysis


Compute 
Fabric 
Manager1


Compute 
Fabric 
Manager2 Blade


Blade 
Com-
posed Of 
Host Host Problem Events


Impacted 
classes
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Figure 2 on page 32 depicts the HP Blade System C7000 support – Map view.


Figure 2  HP Blade System C7000 support – Map view. 


Figure 3 on page 32 depicts the HP Blade System C7000 support – Map view (Expanded).


Figure 3  HP Blade System C7000 support – Map view (Expanded)
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Cisco UCS Enhancement


Blade Support


In this release, support is added to discover and monitor Blades in the Cisco UCS. The 
hosts installed on Blades can be accessed through the ComposedOf relationship of the 
Blade.


The Blade Down event will be generated based on the status provided by the Cisco UCS 
agent and the status of the Host which is installed on the Blade.


Discovery of Blades on a BladeEnclosureManager


The Blade servers present on the BladeEnclosureManager are represented as the class 
Blade in the IP topology. A Blade is a compact, self contained server containing core 
processing components, hard-drives, memory, and network cards that fit into an 
enclosure with other Blade servers. 


IP 9.2.2 supports the discovery and monitoring of the Blade present on a 
BladeEnclosureManager. 


The Blade is defined by the following relationship:


◆ PartOf relationship with BladeEnclosureManager. The BladeEnclosureManager has a 
ComposedOf relationship with the Blade. 


Table 7 on page 33 lists the MIB Object IDs used for discovery and monitoring of the Blade 
instance on a BladeEnclosureManager.


Table 7  MIB OIDS used for discovery and monitoring of Blade


Purpose Attribute in IP MIB attribute type MIB Object ID


Discovery Blade Instance Octet String cucsComputeBladeDn 
1.3.6.1.4.1.9.9.719.1.9.2.1.2


Display Name Octet String cucsComputeBladeName 
1.3.6.1.4.1.9.9.719.1.9.2.1.2


Model number Octet String cucsComputeBladeModel       
1.3.6.1.4.1.9.9.719.1.9.2.1.32


Serial number Octet String cucsComputeBladeSerial      
1.3.6.1.4.1.9.9.719.1.9.2.1.47


Vendor Octet String cucsComputeBladeVendor      
1.3.6.1.4.1.9.9.719.1.9.2.1.53


Monitoring Admin state Integer cucsComputeBladeAdminState  
1.3.6.1.4.1.9.9.719.1.9.2.1.5


Oper state Integer cucsComputeBladeOperState  
1.3.6.1.4.1.9.9.719.1.9.2.1.42
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Root-cause analysis for Blade on a BladeEnclosureManager


When a Blade fails, the host which resides on the Blade also goes down. The root-cause 
analysis for a Blade failure scenario is listed in Table 8 on page 34.


Table 8  Events generated for Blade


Problem
Events (symptom) of 
the problem Description Impacted system


• Blade


• Host


Map representation


Figure 4 on page 34 depicts the Cisco UCS enhancement – Topology view. 


Figure 4  Cisco UCS enhancement – Topology view


Blade::Down Host::Unresponsive Indicates that the system is not 
responding.


Blade::Unresponsive Indicates that the system is not 
responding.
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Figure 5 on page 35 depicts the Cisco UCS enhancement – Map view. 


Figure 5  Cisco UCS enhancement – Map view


Protect trap receiver against uncontrolled memory growth for IP


CQ 644557 /CQ 644587


When the trap receiver is flooded with traps, the trap receiver would crash, citing 
out-of-memory issue. This issue can be prevented by setting the values for the 
QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS parameters in the trapd.conf file to 200 
MB and 480 seconds, respectively.


By default, QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS are commented out in the 
trapd.conf file. If trap flooding occurs in your environment, it is recommended to have 
values set for the above attributes depending on your environment. Verify the Trap Queue 
size by running sm_monitor -queue and then fine tune the values based on your 
environment. By having values set for the above attributes, traps will be discarded in trap 
flooding situations.


Additionally, the following four forward statements have been added to the trapd.conf file:


FORWARD: * .1.3.6.1.4.1.733.10 6 1 host:port


FORWARD: * .1.3.6.1.4.1.733.10 6 2 host:port


FORWARD: * .1.3.6.1.4.1.733.10 6 3 host:port


FORWARD: * .1.3.6.1.4.1.733.10 6 4 host:port


Where:


◆ Host is the hostname of the machine or IP address where the trap adapter attached to 
the OI server is running.
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◆ Port is the port number where the trap adapter attached to the OI server is listening.


Traps .1.3.6.1.4.1.733.10 6 1  and .1.3.6.1.4.1.733.10 6 2 are sent by the OI trap receiver 
where they are converted into notifications in OI and then propagate to the SAM Console 
when it reaches  the thresholds set for the QUEUE_LIMIT_MEGS or the QUEUE_LIMIT_SECS 
parameters.


Traps .1.3.6.1.4.1.733.10 6 3 and .1.3.6.1.4.1.733.10 6 4 are sent by the sm_trapd queue 
when it determines that certain sources are flooding it with traps.


On reaching the limits set by these parameters, the sm_trapd queue starts discarding 
traps and a notification trapdDiscardingTraps is sent to the Service Assurance Manager. 
The alert is cleared once the incoming trap rate to sm_trapd reduces to a rate below which 
these traps can be processed by the queue.


Use the sm_edit utility to change the values for these parameters in the trapd.conf file, 
based on your requirement.


Changes to oidInfo.conf file and its location after an upgrade
CQ 641616 /CQ 644111


The OIdInfo tool is a troubleshooting tool that provides detailed information about MIBs 
used by the IP domain to discover and monitor devices in the topology. The Oidinfo.conf 
file is the configuration file for the OIDInfo tool. To get the SNMP details of the entity, 
specify the SYSTEMCLASS, SYSTEMINSTANCE, TYPE, ENTITY, and the INSTANCE of the 
entity.


In earlier releases, “Type” was set to Mandatory in the oidInfo.conf file. In this release, the 
“Type” is changed to Optional and the default value is changed to Monitoring.


CQ 649682


After an upgrade from IP 9.2.0.0 to IP 9.2.2, the oidInfo.conf file is available at 
conf/discovery/ and also at conf/oidInfo/. In earlier releases, the file available at 
conf/discovery/ was used but from the Smarts 9.2.2 release, the file at conf/oidInfo/ is 
used for running the OIdInfo tool.


Support for Cisco IOS 15.0
CQ 649503


IP 9.2.2 now supports IOS 15.0 and the IP topology shows instances of temperature 
sensor, power supply, and fan for devices running on IOS 15.0. IP Manager cannot create 
these instances if a device is running on IOS versions earlier than 15.0 because the 
required MIBs are not present in older IOS versions. For example, Temperature sensor, 
Power supply, and Fan instances may not be present for devices which ran on IOS 12.0.


Device type changes due to recertifications
CQ 649699 / CQ 607333 / SR 56713712


The following changes pertain to changes in device types because of recertifications:


For Cisco C2951 (.1.3.6.1.4.1.9.1.1043), the device type is changed from Switch to Router 
in IP 9.2.2. Due to this change, Ports are no longer discovered for the device.
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The device type for  Cisco ONS-15454 (.1.3.6.1.4.1.3607.1.20.10.70) is changed from 
Router to Switch in IP 9.2.2. Due to this change, MIB2 IfTable entries are discovered as 
Interfaces (if the underlying IP is present) and Ports (for those which do not have 
underlying IPs).


The device type for Alcatel 7700 (.1.3.6.1.4.1.6486.800.1.1.2.1.3.1.5) is changed from 
Bridge to Switch in IP 9.2.2. This change enables discovery and monitoring of cards, CPU, 
and memory.

IP Manager features from 9.2.x that apply to 9.3.x 37







IP Manager 9.2.x Features and Technical Notes

Features in IP Manager 9.2.1


IP Manager release 9.2.1 includes important new features and changes to the existing 
features:


◆ “Virtual Router Redundancy Protocol (VRRP) support for Aruba wireless controllers” on 
page 38


◆ “WirelessAccessPoint support enhancement” on page 44


• “WirelessRadioInterface discovery and monitoring”


• “Option to delay WirelessAccessPoint::Down problem”


• “MultipleWirelessAPDown event”


◆ “Authentication Server support enhancement” on page 47


◆ “Connectivity Polling for Wireless Devices” on page 49


◆ “Logic for processing RouteDistinguisher for Juniper devices changed” on page 50


◆ “Enhancement to FibreChannelSwitch discovery” on page 50


◆ “OID Info tool enhancements” on page 50


These features are available only for Aruba Wireless Controllers.


Virtual Router Redundancy Protocol (VRRP) support for Aruba wireless controllers


IP Availability Manager Version 9.2.1 supports discovery and monitoring of wireless 
controllers that are configured for redundancy. The IP topology class 
WirelessControllerRedundancyGroup has been introduced to support this functionality. 


WirelessControllerRedundancyGroup is a collection of two or more WirelessControllers 
that are configured for redundancy to manage the WirelessAccessPoints discovered by 
the WirelessControllers.


VRRP support for wireless devices is applicable only for Aruba Wireless Controllers.


Aruba OID certified for VRRP


All IP 9.1 certified WirelessController supports VRRP. One prerequisite is that the VRRP 
data should be available through SNMP.


Aruba OID .1.3.6.1.4.1.14823.1.1.13 is recertified as WirelessController in the Smarts 
9.2.1 release.


Enable VRRP trap processing for Aruba devices


CQ 577828 / CQ 643367 / CQ 568043


The wireless VRRP feature in IP uses a Trap sent by the Wireless controller to monitor the 
Switchover of the WirelessAccessPoints from one WirelessController to another. 

38 EMC Smarts Features from Version 9.2.x Applicable to Version 9.3.x SAM, IP, ESM, MPLS, VoIP, and NPM Managers







IP Manager 9.2.x Features and Technical Notes

A typical setup will have a Trap Exploder receiving the Traps from devices and then 
forwarding them to the IP Domain Manager. In order to forward the wireless VRRP traps 
received from devices to the IP Domain Manager:


Use the sm_edit utility to modify the trapd.conf file in the installation running the Trap 
Exploder:


#cd <BASEDIR>/smarts/bin
#./sm_edit conf/trapd/trapd.conf


Add the following line to trapd.conf:


# Traps required by InCharge IP Domain Manager for Wireless VRRP 
Monitoring


#
FORWARD: * .1.3.6.1.4.1.14823.2.2.1.1.100.1038 6 1  host:port


where host is the IP address of the IP Domain Manager and the Port is the port on which 
the IP Domain manager is listening for Traps. The default port is 9000.


The trap exploder has a predefined section in trapd.conf which contains a list of traps to 
be sent to IP domains.  This list is expanded in the Smarts 9.2.2 release to contain VRRP 
traps. 


Relationship of WirelessControllerRedundancyGroup


WirelessControllerRedundancyGroup is defined by:


◆ ComposedOf relationship with WirelessAccessPoints.


◆ LayeredOver relationship with WirelessControllers.


Attributes of WirelessControllerRedundancyGroup


Table 9 on page 39 lists the attributes of WirelessControllerRedundancyGroup. 


Table 9  WirelessControllerRedundancyGroup attributes  (page 1 of 2)


Attributes Description


ControllersList List of WirelessControllers which are configured in redun-
dancy mode and are part of a WirelessControllerRedundancy-
Group.


GroupID Unique identifier for the WirelessControllerRedundancyGroup 


SwitchOverTime Time duration (in seconds) that is allowed for the switch over 
to stabilize. The status is checked after this time interval. The 
time interval starts after the SwitchOver Trap is received from 
the WirelessController. 
Default: 1800 seconds.


Note: The SwitchoverTime can be configured in Polling and 
Threshold > Threshold > WirelessControllerRedundancyGroup.


LastChangedAt_seconds Time (in seconds) when the attribute IsSwitchover last 
changed.
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Events of WirelessControllerRedundancyGroup


Table 10 on page 40 lists the events that are generated for 
WirelessControllerRedundancyGroup.


Table 10  WirelessControllerRedundancyGroup events


Events Description


Note: The SwitchOver event is generated whenever a SwitchOver Trap is 
received from a WirelessController in IP Availability Manager. The event 
remains active for the time specified against the SwitchoverTime, and clears 
automatically after that. 


Note: The SwitchoverTime can be configured in Polling and Threshold.


Note: If the number of operational members is zero, an AllComponentsDown 
event occurs.


IsSwitchover Indicates that the switchover between WirelessControllers 
has taken place for the WirelessControllerRedundancyGroup.


NumOfWAPsUpBeforeSwitchover Indicates the total number of WirelessAccessPoint objects 
that were UP before the Switchover Trap is received.


NumOfWAPsDownAfterSwitchover Indicates the total number of WirelessAccessPoint objects 
that went down after the Switchover Trap is received.


TotalNumberOfWAPs Indicates total number of WirelessAccessPoint objects in this 
WirelessControllerRedundancyGroup.


Table 9  WirelessControllerRedundancyGroup attributes  (page 2 of 2)


Attributes Description


SwitchOver Indicates the occurence of switchover (VRRP).


SwitchOverFailed Indicates the failure of a switch over.
After receiving the VRRP SwitchOver trap from the Controller, the active wire-
less APs are identified. After the configured SwitchOverTime has elapsed, the 
status of Wireless APs will be reverified for the failures. If any one Wireless 
AP’s status was Down which was UP before, the SwitchOverFailed event will 
be generated.


AtRisk Indicates that the number of operational members in the redundancy group is 
less than or equal to the AtRiskThreshold value (set to 1 by default) but is not 
zero.


For example, assuming AtRiskThreshold = 1, the state of a three-member re-
dundancy group having one operational member (and two non-operational 
members) is AtRisk.


ReducedRedundancy Indicates that the number of operational members (WirelessControllers) in 
the redundancy group is greater than the AtRiskThreshold value, but is less 
than the total number of members in the redundancy group.
For example, and assuming AtRiskThreshold = 1, the state of a three-member 
redundancy group having two operational members (and one non operational 
member) is ReducedRedundancy.


AllComponentsDown Indicates that none of the member objects (WirelessControllers) in the redun-
dancy group are operational.
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Threshold settings


Table 11 on page 41 lists the threshold settings to configure the attribute 
SwitchOverTime. This attribute defines the length of time (in seconds) that the Switchover 
is allowed to stabilize, and status checked after this time interval. The Time Interval starts 
after the SwitchOver Trap is received from the WirelessController.


You can set the threshold settings for this attribute in Polling and Threshold > 
WirelessControllerRedundancyGroups > Settings. 


Table 11  WirelessControllerRedundancyGroup threshold settings


Threshold parameter Allowed values Description


VRRP SwitchOver trap information


Trap Syntax :<trap-oid generic specific> <Uptime> <Varbind - VRRPOperID> <type> <Value> 
<Varbind - VRRPMasterIP> <Type> <Value> <Varbind - VRRPOperstate> <type> <Value>


Example Trap varbind: .1.3.6.1.4.1.14823.2.2.1.1.100.1038 6 1 5000 .1.3.6.1.4.1.14823.2.2.1.1.100.100.19.0 
i 1 .1.3.6.1.4.1.14823.2.2.1.1.100.100.20.0 a 10.31.9.229 
.1.3.6.1.4.1.14823.2.2.1.1.100.100.21.0 i 3


Representation of WirelessControllerRedundancyGroup in Map Console


Figure 6 on page 42 depicts the map of a WirelessControllerRedundancyGroup.


SwitchOverTime 0 – 9999
Default: 1800  
(in seconds)


This is the time interval (in seconds) af-
ter receiving the trap, when the FailOver 
status will be verified.
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Figure 6  Map representation of WirelessControllerRedundancyGroup


Table 12 on page 42 explains the icons used in the map and their relationships. 


Table 12  Description of WirelessControllerRedundancyGroup map


Icon Representation


WirelessControllerRedundancyGroup


WirelessController


WirelessAccessPoints
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Representation of WirelessControllerRedundancyGroup in Topology 
Browser


Figure 7 on page 43 shows the WirelessControllerRedundancyGroup viewed in Topology 
Browser.


Figure 7  WirelessControllerRedundancyGroup in Topology Browser view


ComposedOf relationship with WirelessAccessPoints


LayeredOver relationship with WirelessController


Table 12  Description of WirelessControllerRedundancyGroup map


Icon Representation
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WirelessAccessPoint support enhancement
The WirelessAccessPoint support has been enhanced with the following:


◆ Discovery and monitoring support for wireless radio


◆ Delay APDown event


◆ Root cause and impact analysis for multiple Access Point down


WirelessRadioInterface discovery and monitoring


The support for WirelessAccessPoint has been enhanced to discover and monitor wireless 
radio, which is a component of the Wireless Access Point. The wireless radio on the 
WirelessAccessPoint is discovered as WirelessRadioInterface by IP Availability Manager. 
The user is alerted when the number of wireless clients per radio interface on the 
WirelessAccessPoint exceed the threshold.


Relationship of WirelessRadioInterface 


The WirelessRadioInterface is defined by PartOf relationship with the WirelessAccessPoint 
and the WirelessAccessPoint is defined by ComposedOf relationship with the 
WirelessRadioInterface.


Object IDs probed for discovery


Table 13  Object IDs probed


Object IDs Use


Table 13 on page 44 lists the Object IDs that are probed for discovery of wireless radio.


Attributes of WirelessRadioInterface


Table 14 on page 44 lists the attributes of the class WirelessRadioInterface.


Table 14  WirelessRadioInterface attributes  


Attributes Description


.1.3.6.1.4.1.14823.2.2.1.5.2.1.5.1.3 Used for the creation of WirelessRadioInterface.


.1.3.6.1.4.1.14823.2.2.1.5.2.1.5.1.2 Used for retrieving the type of radio interface.


.1.3.6.1.4.1.14823.2.2.1.5.2.1.5.1.7 Used for retrieving  the number of WirelessClients per ra-
dio.


.1.3.6.1.4.1.14823.2.2.1.5.2.1.5.1.6 Used for retrieving the current utilization of radio inter-
face.


AttachedWirelessClientThreshold Indicates the maximum number of WirelessClient that can be 
associated with this WirelessRadioInterface at a given time.


HighUtilizationThreshold Upper threshold for interface utilization expressed as a per-
centage of the total bandwidth.


NumberOfWirelessClientsOnRadio Indicates the number of WirelessClient  currently associated 
with the radio.


CurrentUtilization Indicates the current utilization of the WirelessRadioInterface 
as provided by its WirelessController.
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Events for WirelessRadioInterface


Table 15  WirelessRadioInterface events


Events Description


Table 15 on page 45 lists the events that are generated for classWirelessRadioInterface.


Threshold settings of WirelessRadioInterface


Table 16 on page 45 lists the threshold parameters of the threshold group 
WirelessRadioInterface. 


Table 16  WirelessRadioInterface threshold settings


Threshold parameters
Allowed val-
ues Description


You can set the threshold parameters in Polling and Threshold console > 
WirelessRadioInterface Group > WirelessRadioInterface > Settings > WirelessRadioInterface 
Threshold.


Option to delay WirelessAccessPoint::Down problem


The AccessPoint::Down problem has been customized with the option to delay the 
generation of the event for a specified time. The time can be specified in Polling and 
Threshold console > Threshold > System Resource Group > WirelessAccessPoint > 
MaxAPDownDelayTime. The default value is set to 0, which means that when the access 
points go down, then the event for AccessPoint::Down problem will be generated instantly.


For example, if the MaxAPDownDelayTime is set to 1800 seconds, the event for 
AccessPoint::Down problem will be generated only after half an hour. 


Table 17 on page 46 lists the new attributes of WirelessAccessPoints.


WirelessClientsThresholdReached Indicates that the maximum number of WirelessClients that 
can be connected to  the WirelessRadioInterface  has 
reached.


HighUtilization Indicates that the utilization of the WirelessRadioInterface is 
greater than the specified High Utilization Threshold.


MaxAttachedWirelessClientThreshold 0 – 99999
Default: 30


Maximum number of WirelessClients that can be at-
tached with the WirelessRadioInterface at a given point 
in time, which when exceeded will generate the Wire-
lessClientThresholdReached event.


UtilizationThreshold 0 – 100 Upper threshold for radio interface utilization expressed 
as a percentage of the total bandwidth, which when ex-
ceeded will generate the HighUtilization event.
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Table 17  New WirelessAccessPoints attributes


Attributes Allowed values Description


• The Down problem has occurred, and 
• The time set against MAXAPDownDelayTime has elapsed.


MultipleWirelessAPDown event
The event MultipleWirelessAPDown has been introduced to alert the user only when the 
configured number of WirelessAccessPoints go down for a specified time duration.


The configuration can be set in Polling and Threshold > Threshold > System Resource 
Group > WirelessController. The parameters are MaxAPsDownPerController and 
MaxMultipleAPDownDelayTimeThreshold. Table 20 on page 47 lists the details of these 
threshold parameters and settings.


Attributes of WirelessController


Table 18 on page 46 lists the new attributes of WirelessController.


Table 18  WirelessController attributes


Attributes Description


Events of WirelessController


Table 19 on page 46 lists the new event generated for WirelessController.


Table 19  WirelessController event


Event Description


MaxAPDownDelayTime Threshold 0 – 99999 
(in seconds)


Maximum threshold time for which Down problem will be supressed 
for the WirelessAccessPoint. 


ExceededAPDownDelayTimeThreshold TRUE, FALSE A value of TRUE indicates that:


LastChangedAt_seconds Unsigned inte-
ger


Time when the adapter last changed state. This typically represents the 
time at which this application monitored the change in state.  It does 
not necessarily represent the actual time that the state changed.


NumberOfAPDownThreshold Maximum number of AccessPoints that can be down simul-
taneously on a Controller at a given time.


NumberOfDownAPs Number of AccessPoints that are down on the Controller at 
a given time.


IsMultipleAPDown Indicates whether Multiple AP went down and crossed the 
threshold.


LastChangedAt_seconds The time at which the adapter last changed state. This typi-
cally represents the time at which this application moni-
tored the change in state. It does not necessarily represent 
the actual time that the state changed.


MultipleWirelessAPsDown Indicates that the Number of APs Down on this Controller has 
exceeded the Threshold.
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Threshold settings for WirelessController


Table 20 on page 47 lists the threshold settings for WirelessController. These threshold 
settings determine the generation of the MultipleWirelessAPDown event.


Table 20  WirelessController Thresholds settings


Threshold setting Default Value Description


Authentication Server support enhancement


The Authentication Server support has been enhanced to alert the user about 
authentication failures and authentication timeouts. Two new events 
FailureThresholdReached and TimeOutThresholdReached have been introduced to 
support the functionality. Table 22 on page 48 lists the details of these events. 


Attributes of AuthenticationServer


Table 21 on page 47 lists the new attributes of AuthenticationServer.


MaxAPsDownPerController 100 The maximum number of APs down in a con-
troller.


MaxMultipleAPDownDelayTime 720 Maximum length of time that the Max num-
ber of AccessPoints that can be down simul-
taneously on this controller


Table 21  Authentication Server attributes  (page 1 of 2)


Attributes Description


NumberOfAuthenticationFailures Indicates the number of times the connection from the Client to the 
Authentication Server failed.


Note: This attribute is available in instrumentation class of the 
AuthenticationServer.


NumberOfAuthenticationTimeouts Indicates the number of times the timeouts occurred when the Cli-
ent were trying to connect to the Authentication Server.


Note: This attribute is available in instrumentation class of the 
AuthenticationServer.


NumberOfAuthenticationRequests Indicates the number of times the authenticaiton requests were 
sent by the Clients to the Authentication Server.


Note: This attribute is available in instrumentation class of the 
AuthenticationServer.


DeltaOfAuthenticationTimeouts Indicates the delta of AutheticationTimeout value between two 
consecutive polling cycles.


Note: This attribute is available in instrumentation class of the 
AuthenticationServer.


AuthenticationFailureThreshold The upper threshold for authentication failures expressed as a per-
centage of the total number of authentication requests. This is the 
threshold for generating the event FailureThresholdReached event.
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Events of AuthenticationServer


Table 22  Authentication Server events


Events Description


• (NumberOfAuthenticationFailures > ((AuthenticationFailureThreshold*NumberOf-
AuthenticationRequests)/100)) and 


• NumberOfAuthenticationRequests > 50


Table 22 on page 48 lists the new events generated for AuthenticationServer.


Threshold settings of AuthenticationServer


You can set the threshold settings in Polling and Threshold > Threshold > System Resource 
Group > AuthenticationServer > AuthenticationServer Thresholds. 


Table 23 on page 48 lists the threshold settings for AuthenticationServer.


Table 23  AuthenticationServer threshold settings


Threshold parameter Default values Description


AuthenticationTimeOutThreshold This serves as the criteria for generating TimeOutEvent. 
Maximum number of authentication Timeouts between two polling 
cycle, beyond which the TimeOutThreshold event will be gener-
ated.


FailedAuthenticationsCount Lists the controllers that have crossed the failure threshold and 
their failed authentication count.


AuthenticationRequestsCount Lists the controllers that have crossed the failure threshold and 
their usage count.


AuthenticationTimeOutCount Lists the controllers that have crossed the timeout threshold and 
their Timeout values.


DeltaOfAuthenticationTimeOut Lists the controllers that has crossed the timeout threshold and 
their TimeoutDelta values.


FailureReached If TRUE, indicates that the criteria for generating FailureEvent has 
reached.


TimeOutReached If TRUE, indicates that the criteria for generating Timeout event has 
reached.


Table 21  Authentication Server attributes  (page 2 of 2)


Attributes Description


FailureThresholdReached This event is generated when:


TimeOutThresholdReached This event is generated when the difference between two consecutive polling cycle is 
greater than zero. 


AuthenticationFailureThresholds 0 – 100
Default: 50


Maximum percentage of the authentication failures, 
which when exceeded will generate the FailureThresh-
oldReached event.


AuthenticationTimeOutThreshold 0 – 99999
Default: 0


Maximum number of authentication timeouts between 
two consecutive polling cycles, which when exceeded 
will generate the TimeOutThresholdReached event.
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Connectivity Polling for Wireless Devices
The connectivity polling settings for polling groups have been segregated between 
wireless domain devices and other wired devices. Two new connectivity polling settings 
have been exclusively introduced for wireless devices: 


◆ Connectivity Polling for Wireless Devices


◆ Connectivity Polling for Wireless Devices — External Poller


For all wireless devices such as WirelessControllers, AuthenticationServers, 
WirelessAccessPoints, WirelessClient and so on, add these settings in Polling and 
Thresholds > Polling Groups > Connectivity Polling For Wireless Devices setting > Settings.


The “Connectivity Polling for Wireless Devices” and “Connectivity Polling settings” for 
other devices are mutually exclusive. The Connectivity Settings do not instrument the 
wireless devices. Use the Connectivity Polling settings for Wireless Devices to instrument 
the wireless devices only.


If you are upgrading and your existing topology contains Wireless Devices, replace the 
current Connectivity Polling setting with the Connectivity Polling for Wireless Devices 
setting in the respective polling groups in the Polling and Threshold Console. This has to 
be done manually as IP Availability Manager version 9.2.1 does not overwrite the existing 
settings in the old RPS file. “CQ 603145 / CQ 603416 / CQ 643403” on page 49 provides 
instructions on how to run the ic_correctSettings.asl script to correct the settings for the 
default polling and threshold groups.


Wireless topology is not monitored after an upgrade


CQ 603145 / CQ 603416 / CQ 643403


When you upgrade from an older version to IP 9.2.1, Polling settings for the Wireless 
Devices is not updated and hence monitoring does not happen for these devices. The 
settings need to be manually updated for the Wireless groups. This is applicable only for 
Wireless groups including WirelessController, WirelessAccessPoint, WirelessClient, and 
AuthenticationServer.


A new polling setting named as “Connectivity Polling for Wireless Devices” is added in IP 
9.2.1 which is applicable for Wireless Devices classes. This setting needs to be applied to 
all wireless devices in the polling groups to manage the wireless entities. 


Remove the old Connectivity Polling setting and add the new “Connectivity Polling for 
Wireless Devices” for Wireless Polling groups. This can be done by running the script 
ic_correctSettings.asl on the upgraded server. The script changes the “Connectivity 
Polling” setting to “Wireless Connectivity Polling” setting for the WirelessController, 
WirelessAccessPoint, and WirelessClient. For the Authentication Server group, the settings 
need to be applied manually. This script is applicable for post IP 9.0 upgrade scenarios. 
For IP 9.0 and lower version upgrade/migrate scenarios, the settings need to be updated 
manually.


Script usage


sm_adapter -s <IP server> -DCORRECTSETTINGS=TRUE ../rules/utils/ic_correctSettings.asl
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Post upgrade and migrate, the priority of the Wireless groups need to be moved above the 
“Other System” groups.


The ASL script which was used in the Smarts 9.2.1 release for enabling the Wireless 
Connectivity Polling setting for Wireless Devices in case of an upgrade, may no longer be 
required in the Smarts 9.2.2 release. It is recommended not to use ic_correctSettings.asl 
for the 9.2.2 release.


Logic for processing RouteDistinguisher for Juniper devices changed
CQ 567883/SR 53199934/CQ 642413


In the earlier release, RouteDistinguisher values were not calculated properly for devices 
with decimal and hexadecimal RouteDistinguisher values.


In this release, the logic in ic-juniper-ip-tag.asl is changed such that the 
RouteDistinguisher values are handled properly for devices having decimal values.


Enhancement to FibreChannelSwitch discovery
The FibreChannelSwitch is discovered by EMC Server Manager from ProSphere along with 
associated FC Ports, Port links, Fabrics, and SAN connectivity. 


FibreChannel switches has been recertified as FibreChanelSwitch in IP. These instances 
are now displayed under FibreChannelSwitch class instead of Switch class.


The details of the implementation, and the contrast with the earlier implementation are 
listed in Table 24 on page 50


Table 24  FibreChannelSwitch discovery


.


OID Info tool enhancements
◆ “Running multiple instances of the OID Info tool --input (or -i) option” on page 51


◆ “Using OID Info tool with Dynamic Model Classes” on page 51


◆ “Processing specific classes” on page 52


◆ “Changed output format” on page 53


◆ “OID Info tool dialog box changes” on page 55


Current implementation Previous implementation


Service Assurance Manager has only one in-
stance of the FibreChannel switch under the 
topology class FibreChannelSwitch.


Service Assurance Manager had two instances of 
the FibreChannel switch under two different 
classes, namely FibreChannelSwitch and Switch.


Additional attributes define the FibreChan-
nelSwitch, namely AgentAddressList and 
IPAddress


These attributes were absent in the earlier imple-
mentation. 
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Running multiple instances of the OID Info tool --input (or -i) option


In the 9.2.1 release, multiple instances of the OIDInfo tool can be run using the --input (or 
-i) option.  This option can be used to specify an alternate configuration file to be used for 
running the tool. If not specified, the tool looks at the default configuration file, that is, 
conf/oidinfo/oidInfo.conf. The alternate configuration file should adhere to the syntax of 
the default configuration file. This option is beneficial if multiple instances of the tool 
need to be run for debugging issues with instances on different devices.


An alternate configuration file can be specified as follows:


sm_perl sm_oidinfo.pl -server=INCHARGE-AM --compare  
--input=conf/oidinfo/oidInfo-1.conf


The alternate configuration file can be created using the sm_edit command as follows:


sm_edit --create conf/oidinfo/oidInfo-1.conf


Using OID Info tool with Dynamic Model Classes


The OIDInfo tool by default traverses select relationships for devices to collect 
instrumentation objects. If the dynamic model is used to introduce new relationships, 
entities or instrumentation classes, the tool configuration will need to be modified to 
traverse the new entities. This can be achieved by editing the configuration file 
conf/oidinfo/ClassRelations.conf. 


The entries under the section “Common Relationships” in the ClassRelations.conf are 
applied to all types of system objects. Few relationships specific to the IP domain are 
added under the section “Specific to IP”. Any custom entries that need to be made can be 
added after this section.


Any changes to this file will need a server restart. 
Changing this configuration will impact both the command line and console invocation. 
Entries in this file are validated when the server is started and invalid entries will be 
ignored.  
Class names and relationship names are case sensitive and they need to be defined using 
the same names as defined by the model.  
Relationships need to be defined one-way only, to avoid loops.


The configuration contains the following entries by default:


#
# Common Relationships
#
UnitaryComputerSystem    ComposedOf
UnitaryComputerSystem    HostsAccessPoints
UnitaryComputerSystem    HostsServices
UnitaryComputerSystem    SystemPackagedIn
#
# Specific to IP
#
WirelessController    Controls
WirelessController    AuthenticationServicedBy
WirelessController    Controls->WirelessAccessPoint->Hosts
WirelessAccessPoint   Hosts


Entries in this configuration file need to follow the following syntax: 
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Column 1 should be the class name and Column 2 should be the relationship name. It is 
mandatory to specify a relationship name when a class name is added. The entry is 
ignored if not specified. Relationships can be defined as single-level if entities are defined 
directly under it. If multiple relationships need to be traversed to get to the entity, then the 
relationship need to be defined as multi-level.


The syntax for single-level relationships is as follows:


<ClassName>        <RelationshipName>


For example, the configuration contains the entry “UnitaryComputerSystem    
ComposedOf”. This would collect all entities under the ComposedOf relationship for 
system objects. The class UnitaryComputerSystem is the base class for all other system 
classes such as Switch, Router, Host, and so on. So these entries need not be defined for 
each of these classes again.


The syntax for multi-level relationships is as follows:


<ClassName> <RelationshipName>-><ClassName>-><RelationshipName>


The relationship parameter specifies the sequence of traversal to get to the entity object. 
This needs to be defined as a sequence of <RelationshipName>-><ClassName>. The symbol 
“->” is used as a separator. This sequence can terminate at a relationship name or a class 
name. If the entry terminates at a relationship name then all objects under that 
relationship are picked up. If the entry terminates at a class name then only objects of that 
class are picked up from the preceding relationship name.


For example, to get to a WirelessClient object from a WirelessController, we will need to 
traverse the following path: Controls->WirelessAccessPoint->Hosts. As this entry 
terminates at the relationship “Hosts”, all objects under this relationship will be picked 
up. The relationship “InstrumentedBy” need not be added to single/multi-level 
definitions. This is automatically traversed by the tool.


Processing specific classes


The OIDInfo tool can be used to process specific entity instances under a device. This will 
be helpful if data for a specific instance only is needed and processing of all other 
instances can be skipped. An instance name pattern can be defined in oidInfo.conf to 
filter out specific instances. This needs to be defined as the last column.


For example, if we need data for only Interface1 on a Router, the entry needs to be made 
as follows:


Router       dev-7604.emc.com        Monitoring        Interface        *IF*/1


The last column defines a pattern to be used for filtering out instances. This pattern is 
applied to instrumentation objects of the entity. In the above example, the pattern *IF*/1 
is applied to instrumentation objects of Interface and the number 1 specifies the instance 
number of the object.  


The following patterns can be applied for entities in IP:


◆ Interface - *IF*/<number>


◆ Port - *PORT*/<number>


◆ Card - *CARD*/<number>
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◆ Memory - *MEM*/<number>


◆ Processor - *PSR*/<number>


◆ PowerSupply - *PWR*/<number>


◆ TemperatureSensor - *TEMP*/<number>


◆ VoltageSensor - *VOLT*/<number>


◆ Fan - *FAN*/<number>


◆ Disk - *DISK*/<number>


◆ FileSystem - *FS*/<number>


If an entity is instrumented by multiple instrumentation classes, then the pattern can also 
be set on the instrumentation class name.


For example, interface objects are typically instrumented by multiple instrumentation 
objects of different type for availability and performance. For instance, 
Interface_Performance_CiscoRouter, NetworkAdapter_PerformanceData_MIB2_ifMIB, 
Interface_Fault_MIB2. It is possible to filter out only the fault related data as follows:


Router  dev-7604.emc.com   Monitoring   Interface   *Interface_Fault_MIB2*/1


Changed output format


The output format of the OIDInfo tool is changed to use the csv format. The tool generates 
the following files for every entry defined in oidInfo.conf. 


◆ An XML file, which contains a snapshot of the configuration used to generate the 
output.


◆ A CSV file, which contains the actual output of the tool.


◆ A log file, which contains details of execution for debugging any tool related issues.


Each of these files is named by appending a timestamp to indicate the time of execution. 


For example, if the conf file has the following entry,


Router   dev-mplsp8.emc.com   Monitoring   Card|Processor|Memory


the tool will generate the following files under logs/oidInfoLogs:


Router_dev-mplsp8.lss.emc.com_05-15-2013-102832.csv


Router_dev-mplsp8.lss.emc.com_05-15-2013-102832.xml


sm_oidInfo-05-15-2013-102832.log


The csv file would have values as shown below: 


Type: Indicates the type of the entry. Possible values are Discovery/Monitoring.


Component: For Monitoring entry types, it indicates the class name of the device entity. 
For Discovery entry types, it indicates the discovery probe name.


Target: For Monitoring entry types, it indicates the instrumentation class name for the 
Component. For Discovery entry types, it indicates the discovery driver name.


OID: Indicates the SNMP OID associated with the Target.

IP Manager features from 9.2.x that apply to 9.3.x 53







IP Manager 9.2.x Features and Technical Notes

Index: Indicates the OID index used to run SNMP queries and would also indicate the 
instance number of the object in the server topology. Supported for entry type Monitoring 
only.


SNMPValue: Indicates the value retrieved via SNMP from the device. This column is 
displayed if the option --display (or -d) or --compare (or -c) or --poll (or -p) is used. 
Supported for entry type Monitoring only.


TopoValue: Indicates the value of the parameter in the server topology. This column will be 
displayed if the option --compare (or -c) is used. Supported for entry type Monitoring only.


TimeStamp: Indicates the time at which the data for the entry was collected. 


Description: Indicates the textual description for the parameter. For Monitoring entry 
types, this gives the parameter name in the instrumentation class for the OID. For 
Discovery entry types, this gives the ASL file name associated with the discovery driver 
and an optional description for the discovery probe.


The XML file will have entries as follows:


<Topology>
<Device SysOID=".1.3.6.1.4.1.2636.1.1.1.2.18" Name="dev-mplsp8.emc.com">
<Entity type="Monitoring" component="Card" target="Card_Fault_Juniper">
<oid name=".1.3.6.1.4.1.2636.3.1.15.1.8" desc="jnxFruState"/>
</Entity>
<Entity type="Monitoring" component="Card" target="Card_Fault_Juniper_Redundancy">
<oid name=".1.3.6.1.4.1.2636.3.1.14.1.7" desc="jnxRedundancyState"/>
<oid name=".1.3.6.1.4.1.2636.3.1.15.1.8" desc="jnxFruState"/>
<oid name=".1.3.6.1.4.1.2636.3.1.13.1.6" desc="jnxOperatingState"/>
</Entity>
<Entity type="Monitoring" component="Memory" 


target="Memory_Performance_JuniperRouter">
<oid name=".1.3.6.1.4.1.2636.3.1.13.1.11" desc="jnxOperatingBuffer"/>
<oid name=".1.3.6.1.4.1.2636.3.1.13.1.15" desc="jnxOperatingMemory"/>
<oid name=".1.3.6.1.4.1.2636.3.1.13.1.12" desc="jnxOperatingHeap"/>
</Entity>
<Entity type="Monitoring" component="Processor" 


target="CPU_Performance_JuniperRouter">
<oid name=".1.3.6.1.4.1.2636.3.1.13.1.8" desc="jnxOperatingCPU"/>
</Entity>
</Device>
</Topology>


The <Device> tag gives the SystemObjectID and the Name of the specified device in the 
server topology.


The <Entity> tag provides configuration of discovery and monitoring entries used to 
generate the output. The attribute type gives the type of the entry, that is, 
Discovery/Monitoring. The attribute component gives the discovery probe name or the 
entity class name. This can be directly mapped to the Component column in the csv file. 
The attribute target gives the instrumentation class name or the discovery driver name. 
This can be mapped to the Target column in the csv file. 


The number of entity tag entries can vary depending on the filtering defined in 
oidInfo.conf. Here the xml file contains entries for only monitoring of Card, Memory and 
Processor because the following pattern is used.


Router   dev-mplsp8.emc.com   Monitoring   Card|Processor|Memory

54 EMC Smarts Features from Version 9.2.x Applicable to Version 9.3.x SAM, IP, ESM, MPLS, VoIP, and NPM Managers







IP Manager 9.2.x Features and Technical Notes

Each entity tag can contain multiple <oid> tags. This gives the OIDs that are associated with 
a particular entity. If the entity has no OIDs, then there will be no <oid> tags under that 
entity. The attribute name gives the SNMP OID. This can be mapped to the OID column in 
the csv. The attribute description gives a textual description of the OID. This can be 
mapped to the Description column in the csv.


OID Info tool dialog box changes


The OIDInfo dialog in the SAM Admin Console is modified to address the following issues:


◆ Window resizing: The window can now be maximized or resized.


◆ Grid Scrolling: The grid view can now be scrolled horizontally and the columns can be 
resized.


An additional option of exporting the grid to a file (“Save Table”) is provided. The grid can 
now be saved by specifying a separator for the columns.


IP Manager technical notes from 9.2.x that apply to 9.3.x
◆ “Technical notes for IP Manager 9.2.2” on page 55


◆ “Technical notes for IP Manager 9.2.1” on page 60


Technical notes for IP Manager 9.2.2


QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS are commented out in trapd.conf in IP
CQ 609017


By default, QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS are commented out in the 
trapd.conf file. If trap flooding occurs in your environment, it is recommended to have 
values set for the above attributes depending on your environment.


Verify the Trap Queue size by running sm_monitor -queue and then fine tune the values 
based on your environment .


By having values set for the above attributes, traps will be discarded in trap flooding 
situations.


Exclude list functionality in the TCAT tool
CQ 567524


Certain objects or relationships can be excluded from comparison in the TCAT tool. This 
exclude functionality can be achieved by commenting out the unwanted elements in the 
TopoRulesDiff.txt file by adding “#” in front of that element.


#OBJ|Cable


#OBJ|TrunkCable


OBJ|Firewall


OBJ|IP


#OBJ|NetworkConnection


OBJ|LoadBalancer
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#OBJ|AccessPoint


The TCAT tool will not process those entities or elements that are commented during 
comparison.


DisableAutomaticSettingsUpgrade in the discovery.conf file
CQ 649104


During server start in 9.2.2 with old repos (7.x onwards), the priority and settings of any 
new “Polling Groups” and “System Resource Group” are taken care automatically. You 
need to only modify the priority of your defined groups. This automatic setting correction 
will be done only once on an old RPS during first time start.


If you do not want to use this feature, you can disable it by setting the value of 
“DisableAutomaticSettingsUpgrade” to TRUE in the discovery.conf file. If this feature is 
disabled, you may not see some polling and threshold settings in the server Polling and 
Thresholds window by default. To get these settings, load the respective settings.conf 
manually. These conf files are available in the installation directory path: 
$SM_SITEMOD/conf/<icf|devstat|health>/.


During server restart with the old repos, if “ComputeFabric” comes below “Switches” in 
“Polling Groups” and “System Resource Group”, then manually move the 
“ComputeFabric” up before “Switches” to apply the proper settings. Do not modify the 
default value of “DisableAutomaticSettingsUpgrade”, which is FALSE. It is recommended 
not to use “ic_correctSettings.asl”, as it is no more valid from the 9.2.2 release.


Different number of power supplies discovered on the same device in IP 9.2 and IP 9.2.1
CQ 577867


The device with sysOID 1.3.6.1.4.1.14823.1.1.13 is recertified as WirelessController in IP 
9.2.1. Hence while running the TCAT tool, explanation for this entity that is newly 
discovered in IP 9.2.1 appears as “In 9.2.1.0 (for the related Object): Originally Recertified 
in 9.2.1. Please refer to the Certification Matrix. Impacted Classes : Interface Port 
SNMPAgent IP Processor Memory Chassis”. For already existing entities, it appears as 
“Certified in an earlier release”. Extra power supplies will get created because of this 
recertification. No functionality is impacted due to this behavior.


Ports and interfaces may have 0.0 as the current utilization value
CQ 636366


In earlier releases, when ports and interfaces did not have instrumentation or were not 
managed, the current utilization was grayed out. In IP 9.1, when Ports and interfaces do 
not have instrumentation, the IP server displays the currentUtilization value as 0 for those 
ports and interfaces.


Issues related to unusual growth in log file size
CQ 636047


If you see a huge growth in the log file size, for instance in the Broker log:


1. Re-install the Broker as service with environment setting SM_NO_LOG_CLIENTS=TRUE.
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2. Restart the Broker service.


To disable the client logging feature subscription for all the servers or Domain Managers, 
put the entry in the runcmd_env.sh file, and then restart the Broker and Domain 
Managers.


Users with custom code that uses EMC Smarts API
If the code is based on Java, Perl, or C API, modify and retest the code according to the 
changes in this release. If a dynamic model is used, recompile the code.


The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


Fewer interfaces may be discovered on Hosts
CQ 574723 / CQ 574196 / CQ 542498


In IP 8.1.1, all interfaces defined in ifMIB were discovered if NIC Teaming was disabled on 
a Compaq device having Sys OID .1.3.6.1.4.1.311.1.1.3.1.*. 


In IP 9.0 and later versions, if NIC teaming is disabled, we discover only those interfaces 
that have IP addresses configured on them.


SHM monitors IP standby server using the old port number after a restart
CQ 572156 / CQ 564417


Issue


If you create a standby server without registering with the Broker and mention the standby 
server details in the /conf/serverhealth/stdby_servers.conf file, and then perform a 
Discover All in Server Health Monitor (SHM), the standby server gets monitored in SHM.


If the standby server is now shut down and restarted, and if the new Port Number and 
Process ID is mentioned in the /conf/serverhealth/stdby_servers.conf file, the old 
standby server appears in the Pending Devices list after a Discover All is performed in 
SHM.


Resolution


When you restart the standby server, ensure that you use the - -port option and provide 
the same port number used earlier before the restart. This will prevent the earlier or the 
old standby server to get listed in the Pending Devices list during discovery.


Less number of processors and more interfaces may be discovered
CQ 541555 / CQ 545618 / SR39030228


Issue


Less number of processors and more interfaces might be discovered.
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Resolution


In earlier releases, processors were created by polling the values from hrDeviceDescr and 
the processor utilization was taken from the UCD-Mib for all the processors created. Thus 
CPUs were created for Hosts in huge numbers. Now processors are created from the 
Host-resources-MIB, based only on the polled values of hrProcessorLoad. If 
hrProcessorLoad does not populate a value, then the processor(s) are created based on 
the values from ssCpuIdle(UCD-Mib). So if no data is populated for hrProcessorLoad 
(Host-Resources-Mib) but ssCpuIdle(UCD-Mib) has an entry, only a single CPU will be 
created for many hosts.


More interfaces seen may be because of the NIC teaming feature, which is enabled by 
default. However, if many Host SNMP agents are slow, on querying the NIC teaming OIDs, 
the agents may stop responding which may result in a partial discovery. If you are not 
using the NIC teaming feature, disable it by setting EnableTeamedNICDiscovery to FALSE in 
the tpmgr-param.conf file and then verify.


Further, ASNMP for specific devices may be timing out due to which the devices are getting 
added to the pending list. The devices will either go to the pending list or it will get 
discovered partially with a message saying "SNMP request timed out or had an error". To 
resolve this issue, reduce the "maxOIDsPerPacketForASNMP" value to less than 19 or 
disable ASNMP for the devices by setting the DoNotUseASNMPPattern flag in the 
tpmgr-param.conf file to TRUE. Then restart the server and rediscover the topology.

58 EMC Smarts Features from Version 9.2.x Applicable to Version 9.3.x SAM, IP, ESM, MPLS, VoIP, and NPM Managers







IP Manager 9.2.x Features and Technical Notes

Creation of VirtualBridges and Bridges relationships
CQ 573309 / CQ 573334


During discovery, if a switch port is associated with a MAC address that matches the 
VirtualMACPattern configured in the file tpmgr_param.conf, a VirtualBridges relationship 
is created for the switch port. The VirtualBridges relation is also formed for Systemless 
MAC irrespective of the VirtualMACPattern.


Systemless MAC cannot have bridges relationship. The default VirtualMACPattern has the 
VMware specific MACs, VRRP, and HSRP MACs.


Limitation


By removing the VirtualMACPattern from the tpmgr-param.conf file, the Bridges 
relationship gets established. On the contrary, when the VirtualMACPattern is added 
again in the configuration file, the VirtualBridges relationship does get established, but 
the existing Bridges relationship is not removed.


Resolution


To avoid having both Bridges and VirtualBridges relationships, delete the device from the 
topology and discover the device again. This will enable the creation of VirtualBridges 
relationship only.


Incorrect layering of ATM interfaces may result in erroneous notifications
CQ 545619 / CQ 502966 / SR37491304


Issue


User had the custom setting to explicitly manage the AAL5/ATM subinterfaces. Because of 
this, the RCA was not proper for a specific fault.


Resolution


As per design, IP unmanages certain AAL5|ATM subinterfaces interfaces in 
ic-post-port-manager.asl. This is done to produce proper RCA.


In this case, these unmanaged interfaces were managed explicitly by the user script. This 
resulted in a wrong RCA of Interface::Down for the AAL5 interface that is explicitly 
managed by the user when the actual problem was connected Router DOWN.


This is because, when the underlying AAL5/ATMSUBINTERFACE interfaces are managed, IP 
has an additional symptom set to deduce the AAL5/ATMSUBINTERFACE as DOWN instead 
of arriving to Router DOWN.


So in such cases, when the user expects a router DOWN event, the custom management 
policy for the AAL5/ATMSUBINTERFACE must be removed.
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Creation of NetworkConnection Redundancy Groups (NCRG)
CQ 580365 / SR40971838


NCRGs are simply reference classes and they are not created during discovery.  


There is only one relationshipset: ComposedOf/PartOf between members of the 
NetworkConnection class. If that is populated, the typical events (ReducedRedundancy, 
AtRisk, AllComponentsDown) work as expected.


Technical notes for IP Manager 9.2.1


There are no technical notes for IP Manager 9.2.1.
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IP Manager fixed problems from 9.2.x that apply to 9.3.x
“Fixed problems in IP Manager 9.2.x” on page 61


Fixed problems in IP Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems iin IP 9.2.x


CQ 605787 Smarts IP Domain Manager did not discover 
Adtran TA5000 devices 
(1.3.6.1.4.1.664.1.747).


If the device is not discovered with default 
configuration, then proceed as follows:
Adtran TA5000 devices are re-certified in Smarts 
9.2.1 Patch 2 and can be discovered with the below 
settings in place because of lack of compatibility of 
Adtran TA5000 devices with advance SNMP settings 
of Smarts IP:
Set following parameters in tpmgr-param.conf:
#cd <BASEDIR>/IP/smarts/bin
#./sm_edit ../conf/discovery/tpmgr-param.conf
GetBulkPattern-.1.3.6.1.4.1.664.1.747 FALSE
DoNotUseASNMPPattern .1.3.6.1.4.1.664.1.747
SingleOIDPerPacketForASNMPPattern 
.1.3.6.1.4.1.664.1.747
Load the changes into the running domain:
#./sm_tpmgr –s <DM_Name> 
--load-conf=tpmgr-param.conf
This device will be discovered with PsuedoWire 
Interfaces, Advanced PsuedoWire Interfaces, and 
IPHost interfaces. For Advanced PsuedoWire 
Interfaces and IPHost interfaces, AdminStatus will 
always be “UP”. For PsuedoWire Interfaces, 
OperStatus is mapped to “DOWN” when the OID 
adGenAdvancedPseudowireCEMDestinationMac 
{1.3.6.1.4.1.664.5.70.30.2.1.1.6} returns zero 
MAC(00 00 00 00 00 00).
Windows:
\lib\sm_devstat_adtran.dll
\lib\sm_health_adtran.dll
Unix:
/lib/libsm_devstat_adtran.so
/lib/libsm_health_adtran.so
/conf/discovery/tpmgr-param.conf
/conf/discovery/DISCOVERY_ADTRAN.import
/rules/discovery/ic-adtran-card.asl
/rules/discovery ic-adtran-interface.asl
/rules/discovery ic-adtran-ta5000-health.asl
/rules/discovery ic-adtran-ta5000-vlan.asl
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CQ 643103
CQ 602815
SR 54481736


ic-serviced daemon error.
On Solaris 10, whenever ./ic-serviced start and 
./ic-serviced stop commands were run, the 
following message appeared:
root@infruz402 # ./ic-serviced start
Starting sm_serviced ...
./ic-serviced: test: unknown operator ==


The error message is because of the following line in 
the ic-serviced shell script:
109: [ "$OS" == "Linux" ] && touch $LOCKFILE
129: [ "$OS" == "Linux" ] && rm -f $LOCKFILE
The shell was not accepting the == operator. Hence 
the above lines are now changed by using a single = 
operator:
109: [ "$OS" = "Linux" ] && touch $LOCKFILE
129: [ "$OS" = "Linux" ] && rm -f $LOCKFILE


9.2.0.1


CQ 643963
CQ 604621
SR 56130730


When the IPV6LinkLocalAddressEnabled 
attribute in the discovery.conf file is set to 
TRUE, a network connection in the topology is 
removed.


When link local IPv6 addresses are discovered, the 
interface will have more than one IP and this results 
in the NetworkConnection not getting created. Now 
the link local IPv6 addresses are ignored, Aggregate 
link gets created and the NetworkConnection is 
present under the ComposedOf relation.


9.2


CQ 605086
SR 56335942
CQ 644841


SNMP V3 traps were processed when the 
credentials did not match the seedfile.


Security is now available for processing SNMP V3 
traps both in the Trap Adapter or in the Trap Exploder 
only if SM_SNMP_V3_STRICT_TRAP_CHECK =TRUE is 
set in the runcmd_env.sh file. By default, this flag is 
not available in the runcmd_env.sh file. Hence 
security check is not in place and this is the default 
legacy behavior.
For the SNMP V3 trap processing, fixed the following 
(to display warnings): 
• Seedfile has auth and the SNMP trap has no auth 


for this user
• Seedfile has auth/priv and the SNMP trap has 


auth/noPriv for this user
• Seedfile has auth/priv and the SNMP trap has 


wrong auth password
The env-var SM_SNMP_V3_STRICT_TRAP_CHECK 
should be set to TRUE to enable the above.


9.1
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CQ 644698
CQ 606473
CQ 644621
CQ 644655
CQ 644408
SR 56784012


If an SNMP agent has a community string with 
commas, call to 
SNMP_AccessorInterface::reset_ability_to_pol
l for this agent failed. Error 
ADSP-INVALID_ADDRESS-Invalid agent 
address appears in the log.


The problem was that commas were used as 
delimiters in the agent ID string, so having commas 
in the parameter values confused the parser. When 
constructing an agent ID string, a caller will need to 
escape commas in parameter values. The escaping 
is done by doubling the comma. Fixed the agent ID 
parsing routine to handle escaped (doubled) 
commas.


9.2.1


CQ 644666 When using IP and ESM topology in Watch4n, 
two instances of a single Nexus 1000 vSwitch 
get created. The preference is for only one 
consolidated vSwitch object. 


The issue has been resolved by introducing new 
parameter DisableNexus1KVConsolidation in 
tpmgr-param.conf file for IP and in ESM.import file 
for ESM. 
The consolidation can be enabled through this 
parameter. By default, the consolidation is disabled.
• If in IP, DisableNexus1KVConsolidation = FALSE in 


tpmgr-param.conf file, and in ESM 
ESM_Manager:: ESM-Manager 
DisableNexus1KVConsolidation = FALSE, then 
consolidation of Nexus 1000 vSwitch will take 
place in ESM. This means that the vSwitch name 
will be same in both in ESM and IP server.


• If in IP, DisableNexus1KVConsolidation = TRUE in 
tpmgr-param.conf file, and in ESM 
ESM_Manager:: ESM-Manager 
DisableNexus1KVConsolidation = TRUE, then 
consolidation of Nexus 1000 vSwitch will not take 
place in ESM. This means that the vSwitch name 
will be different in ESM and in IP.


Note: If you are not using EMC M&R (Watch4net), 
then there is no need to use this parameter, because 
in Service Assurance Manager, Nexus1KV 
consolidation is present by default.


9.2.2
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CQ 577960
CQ 577931
SR 55817374


VLAN Interfaces were not showing traffic 
statistics. Performance instrumentation on 
VLAN interfaces was not created.


A new parameter ExcludePerfInstDescPattern is 
added in the tpmgr-param.conf file.
This is used to enable performance instrumentation 
for all VLAN interfaces and for all SYSOIDs. 
By default, performance instrumenting for interfaces 
having VLAN as its description is excluded. 
ExcludePerfInstDescPattern is used to disable 
creating performance instrumentation for those 
interfaces which have VLAN in the description.
Current utilization will be populated only if the 
Performance instrumentation is created. The 
description added below is not case sensitive. If in 
case you want to instrument these interfaces for 
performance, prefix a "~" (tilde symbol) to the below 
description pattern.
For example, 
ExcludePerfInstDescPattern-.1.3.6.1.4.1.9.1.1327 
~*VLAN*|~*TUNNEL*
The below attribute is SysOID specific. If you want to 
apply this for the entire topology, then comment the 
SysOID specific flag and then uncomment the 
global, that is, the ExcludePerfInstDescPattern flag. 
This will apply the settings for all the 
Interfaces/Ports whose description contains VLAN. 
The following example will enable performance 
instrumentation for all devices with interfaces/ports 
having VLAN in its Description:
ExcludePerfInstDescPattern ~*VLAN*
Note that a system restart is a must for this to take 
effect. If both the parameters are used, that is, 
SysOID specific and global, then the priority is given 
to SysOID specific, and the settings will be applied 
accordingly. 
ExcludePerfInstDescPattern-.1.3.6.1.4.1.9.1.1327 
*VLAN*
ExcludePerfInstDescPattern *VLAN*


9.2
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Server Manager features from 9.2.x that apply to 9.3.x
◆ “Features in Server Manager 9.2.2” on page 66


◆ “Features in Server Manager 9.2.1” on page 66l


Features in Server Manager 9.2.2


The following Server Manager 9.2.2 features are incorporated in the 9.3 EMC Smarts 
Server Manager User and Configuration Guide:


◆ Disk rebuild


◆ Polling and Threshold enhancement for F5 Load Balancer


◆ Inter-Switch Link (ISL) monitoring


The following Server Manager 9.2.2 features are not supported for 9.3.x:


◆ SMI-S Provider discovery


◆ The SpareStoragePool class


Features in Server Manager 9.2.1


There are no enhancements in Server Manager 9.2.1.
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Server Manager technical notes from 9.2.x that apply to 9.3.x
◆ “Technical notes for Server Manager 9.2.2” on page 67


◆ “Technical notes for Server Manager 9.2.1” on page 71


Technical notes for Server Manager 9.2.2


This section contains special instructions for post-installation. Follow the procedures 
provided below:


◆ “Disabling tcp_fusion” on page 67


◆ “Users with custom code that uses EMC Smarts API” on page 67


◆ “Enabling Cisco Discovery Protocol (CDP)” on page 67


◆ “Configuring the runcmd_env.sh file to avoid ASL error messages” on page 70 should 
be performed as a best practice.


◆ “Configuring the IP Availability and Performance Manager to discover Microsoft cluster 
hosts using the cluster node name” on page 70


◆ “Creating field certification for vSphere (ESX 9.0) discovery” on page 70 should be 
performed if you need to discover VMware vSphere topology. 


Disabling tcp_fusion


To disable tcp_fusion, add the following lines at the bottom of the /etc/system file. 
Restart the system for the new setting to take effect.


Disable tcp fusion
set ip:do_tcp_fusion = 0×0


Users with custom code that uses EMC Smarts API


If the code is based on Java, Perl, or C API, modify and retest the code according to the 
changes in this release. If a dynamic model is used, recompile the code.


The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


Enabling Cisco Discovery Protocol (CDP) 


To create connections between a physical switch and an ESX server, Cisco Discovery 
Protocol (CDP) should be enabled on both the physical switch and the vSwitch (Standard 
vSwitch, Distributed vSwitch and Nexus 1000 vSwitch) installed on the ESX server. CDP 
should be running in both Listen and Advertize mode. If CDP is not enabled in both Listen 
and Advertize mode, then the connections between the physical switch and the ESX 
server will not be created. 


The ESX hostname should have an entry in DNS server mapping to ESX IP address.
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The procedures to enable CDP are:


◆ “Steps to enable CDP on Standard Virtual Switch installed on an ESX server” on 
page 68


◆ “Steps to enable CDP on Distributed Virtual Switch installed on an ESX server” on 
page 68


◆ “Steps to configure CDP on Nexus 1000v Switch installed on an ESX server” on 
page 69


Steps to enable CDP on Standard Virtual Switch installed on an ESX server


To enable CDP on a standard virtual switch installed on an ESX Server:


1. Log in to the Service Console using SSH, remote console, or physical console as root. 
Verify the current CDP setting for the desired virtual switch. In this example, vSwitch1:


[root@server root]# esxcfg-vswitch -b vSwitch1
down


The output down indicates that CDP is currently not implemented.


2. Set the CDP status for a given virtual switch. The possible values are: 


• down


• listen


• advertise


• both


[root@server root]#  esxcfg-vswitch -B both vSwitch1


3. Verify the new setting:


[root@server root]# esxcfg-vswitch -b vSwitch1
both


Steps to enable CDP on Distributed Virtual Switch installed on an ESX server


To enable CDP on a vNetwork Distributed Switches (vDS) installed on an ESX Server:


1. Connect to vCenter Server using the vSphere Client.


2. In the vCenter Server home page, click Networking.


3. Right-click vDS and click Edit Settings.


4. Go to Properties and select Advanced. Select the options to set the CDP settings. 


Example
An example of configuring CDP for a Cisco 6500 physical switch:


switch#
switch# config terminal
switch(config)# cdp run
switch(config)# interface g1/1
switch(config-if)# cdp enable
switch# show cdp neighbors
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Capability Codes: R - Router, T - Trans Bridge, B - Source Route 
Bridge
                S - Switch, H - Host, I - IGMP, r - Repeater, P - Phone
Device ID                        Local Intrfce   Holdtme   Capability 
Platform         Port ID
pa-tse-h24.pasl.vmware.com Gig   1/1             121       S           
VMware ESXvmnic2
pa-tse-h24.pasl.vmware.com Gig   1/2             121       S           
VMware ESXvmnic3


Steps to configure CDP on Nexus 1000v Switch installed on an ESX server


To configure CDP on a Nexus 1000v switch installed on an ESX server:


1. Log in to Nexus 1000v VSM using SSH.


2. Execute the following commands:


Nexus1000v(config)# cdp enable
Nexus1000v(config)#
Nexus1000v# show cdp neighbors
Capability Codes: R - Router, T - Trans-Bridge, B - 
Source-Route-Bridge
                  S - Switch, H - Host, I - IGMP, r - Repeater,
                  V - VoIP-Phone, D - Remotely-Managed-Device,
                  s - Supports-STP-Dispute


Device-ID             Local Intrfce Hldtme Capability  Platform      
Port ID


bdsc-cs7.lss.emc.com  Eth3/2        124    S I       WS-C2960-24TT 
Fas0/23
bdsc-cs7.lss.emc.com  Eth4/1        120    S I       WS-C2960-24TT 
Fas0/20
bdsc-cs7.lss.emc.com  Eth4/2        120    S I       WS-C2960-24TT 
Fas0/22
bdsc-cs7.lss.emc.com  Eth6/1        179    S I       WS-C2960-24TT 
Fas0/7
bdsc-cs7.lss.emc.com  Eth6/2        169    S I       WS-C2960-24TT 
Fas0/8
Nexus1000v#


Enabling SNMP probe for VMware discovery


To enable SNMP probe for VMware discovery:


1. Use the sm_edit utility to edit the DISCOVERY_VMWARE.import file:


sm_edit local\conf\esm\DISCOVERY_VMWARE.import


2. Uncomment the ICF_SNMPDiscoveryDriver:


#
#ICF_SNMPDiscoveryDriver::VMWARE-Probe {
#   ElementTypeGlob = "ESM"
#   Priority = 2000
#   waitForCompletion = TRUE
#   ExecutesDriver = GA_SelectiveDriver::VMWARE-SELECTIVE-Driver
#   #trace = TRUE
#}


3. Restart the Domain Manager.
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Configuring the runcmd_env.sh file to avoid ASL error messages


After discovering Server Manager and F5 devices through an IP 7.0.3 server, ASL error 
messages similar to the following may appear in the Server Manager log file:


[30-Mar-2010 15:06:54+272ms EDT] t@58 Discovery #10
ASL-W-ERROR_RULE_SOURCE-While executing rule set 
'/opt/xxx/EISMHF2/ESM/smarts/rules/dxa/dxa-topology-sync.asl'
 ASL-ERROR_ACTION-While executing action at:
 ASL-CALL_STACK_RULE-   RuleName: GET_DISPLAY_VALUE, Line: 3190
 ASL-CALL_STACK_RULE-   RuleName: IMPORT_ATTRS_AND_RELS, Line: 2875
 ASL-CALL_STACK_RULE-   RuleName: EOF, Line: 1270
 ASL-ERROR_UNDEFINED_VARIABLE_ACCESS-Variable 'remoteValue' has not 
been
    assigned a value


[30-Mar-2010 15:06:54+315ms EDT] t@58 Discovery #10
ASL-E-ERROR_LOSTSERVER-Lost contact with remote server -- 
terminating parser
 ASL-ERROR_GET-While attempting to get property 'PartOf' of object
    'MR_Object::frame.lss.emc.com'
 SM-EIO-Fatal I/O error


These ASL error messages are generated as a result of connectivity issues between Server 
Manager and IP Availability Manager. The best practice is to ensure that the firewall 
running between IP Availability Manager and Server Manager allows the flow of data that 
is used by keep alive mechanism. The keep alive mechanism is used between Server 
Manager and IP Availability Manager. Disabling keepalives should be used as the last 
resort. 


Configuring the IP Availability and Performance Manager to discover Microsoft cluster hosts using 
the cluster node name


To ensure that Microsoft cluster hosts are properly discovered by the IP Availability and 
Performance Manager, you must force the IP Availability and Performance Manager to 
name each cluster host by the cluster node name instead of the DNS name. To do this, 
you must add the cluster node name to the hosts file on the IP Availability Manager 
server.


Creating field certification for vSphere (ESX 9.0) discovery 


To discover VMware vSphere topology, create a field certification of the vSphere OID in 
the EMC Smarts IP Availability Manager, as follows:


If you are at IP 7.0.2 Patch 2 and IP 8.1.1 Patch 1, then there is no need of adding the 
certification manually.


1. At IP BASEDIR/smarts/bin, enter the following command:


sm_edit conf/discovery/oid2type_Field.conf


After saving the oid2type_Field.conf file, the certification needs to be loaded in  
<BASEDIR>/IP/smarts/bin/sm_tpmgr –s <IP_Domain> --reloadoid
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2. Type the following lines:


# VMware 4 ESX server (vSphere )
.1.3.6.1.4.1.6876.4.1 {
    TYPE = Host
    VENDOR = VMWare
    MODEL = ESX4.0
    CERTIFICATION = CERTIFIED
    CONT = Generic-MIB2
    HOSTRESRCS = MIB2


INSTRUMENTATION:
    Disk-Fault = HostResources:DeviceID
    FileSystem-Performance = HostResources:DeviceID
    CPU/Memory = HostResources:DeviceID
    Interface-Fault = MIB2
    Interface-Performance = MIB2
}


The System ObjectID .1.3.6.1.4.1.6876.4.1 is for VMware ESX 9.0 and above. If the 
System ObjectID is .1.3.6.1.4.1.6876.4.1, then certification is required. Else 
certification is not required.


3. Save and close the file.


Start the agents on the VMware ESX server. In VMware ESX 3.5, two agents — VMware 
agent and NetSNMP agent should be started. In VMware ESX 9.0, only one agent, that is, 
the VMware agent should be started. 


Technical notes for Server Manager 9.2.1


There are no technical notes for Server Manager 9.2.1.
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Server Manager fixed problems from 9.2.x that apply to 9.3.x
“Fixed problems in Server Manager 9.2.x” on page 72


Fixed problems in Server Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems in ESM 9.2.x


• conf/init/settings.conf
• esm/rules/f5/f5_esm-setting.asl
• esm/rules/f5/f5_pool-setting.asl
• esm/rules/f5/f5_pool_member-setting.asl
• esm/rules/f5/f5_virtual_server-setting.asl
• esm/rules/init/init-settings.asl


CQ 642604
SR 53835358
CQ 601020


F5 - Missing Threshold for Pool or 
PoolMembers.


Created a threshold group for LoadBalancerPool to 
set threshold values of AtRiskThreshold.
Also created Polling groups for LoadBalancerPool, 
LoadBPoolMembers, VirtualServer and also a new 
setting for each which helps in unmanaging analysis 
of a particular object.
Modified files:


9.1


CQ 609104
SR 57718300


When the wildcard (*) is used in the Process 
Monitoring table argument to monitor 
processes, ESM generates Missing Process 
events for the process even though the 
process is running (false positive).


When the process argument in the Process 
Monitoring table is changed to a wildcard (*), all 
processes with the same name are grouped and 
monitored under one application process. The count 
of process instances in the table is set to the 
number of processes with the same name. The 
Missing Process event is generated only when the 
count of process instances reaches 0.


9.2.1


CQ 608922
CQ 605648
SR 56306992


Processor, FileSystem, and Memory objects 
were also discovered in ESM. These objects 
should not be discovered in ESM because 
these were already discovered and monitored 
by the IP Manager.


Added a configurable flag 
EnableCPUFilesystemMemoryDiscovery in 
<Smarts>/conf/esm/ESM.import file to enable or 
disable the discovery of Processor, FileSystem, and 
Memory objects. By default this flag is set to TRUE. 
Set it to FALSE if you want to disable the discovery of 
Processor, FileSystem, and Memory objects.


9.2.1
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MPLS Manager 9.2.x Features and Technical Notes


This chapter includes the following sections: 
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MPLS Manager features from 9.2.x that apply to 9.3.x
◆ “Features in MPLS Manager 9.2.2” on page 74


◆ “Features in MPLS Manager 9.2.1” on page 74


Features in MPLS Manager 9.2.2


There are no new features implemented in MPLS Manager 9.2.2.


Features in MPLS Manager 9.2.1


There are no enhancements in MPLS Manager 9.2.1.


MPLS Manager technical notes from 9.2.x that apply to 9.3.x
◆ “Technical notes for MPLS Manager 9.2.2” on page 74


◆ “Technical notes for MPLS Manager 9.2.1” on page 74


Technical notes for MPLS Manager 9.2.2


Users with custom code that uses EMC Smarts API


If the code is based on Java, Perl, or C API, modify and retest the code according to the 
changes in this release. If a dynamic model is used, recompile the code.


The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


Technical notes for MPLS Manager 9.2.1


There are no technical notes for MPLS Manager 9.2.1.
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MPLS Manager fixed problems from 9.2.x that apply to 9.3.x
“Fixed problems in MPLS Manager 9.2.x” on page 75


Fixed problems in MPLS Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems in MPLS 9.2.x


CQ 601008
SR 53723510


SMARTS is not reporting a notification when 
LdpAdjacency between two devices is 
disconnected. 


LDP adjacency down event is now getting generated 
when the OperStatus is set to NOTPRESENT.
For both Cisco and Juniper instrumentation classes, 
the LDPSessionStatusEnum::NOTPRESENT is 
mapped to IsDownStatus being TRUE. 


9.2.1
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CHAPTER 6
Network Protocol Manager 9.2.x Features and 
Technical Notes


This chapter includes the following sections: 


◆ Network Protocol Manager features from 9.2.x that apply to 9.3.x ...........................  78
◆ Network Protocol Manager technical notes from 9.2.x that apply to 9.3.x.................  79
◆ Network Protocol Manager fixed problems from 9.2.x that apply to 9.3.x .................  81
◆ Fixed problems in Network Protocol Manager 9.2.x patch documentation................  81

Network Protocol Manager 9.2.x Features and Technical Notes 77







Network Protocol Manager 9.2.x Features and Technical Notes

Network Protocol Manager features from 9.2.x that apply to 9.3.x
◆ “Features in Network Protocol Manager 9.2.2” on page 78


◆ “Features in Network Protocol Manager 9.2.1” on page 78


Features in Network Protocol Manager 9.2.2


There are no new features implemented in Network Protocol Manager 9.2.2.


Features in Network Protocol Manager 9.2.1


RFC 4444 device support for IPv6 IS-IS
CQ 643327


The RFC - 4444 support is only for IPv6 ISIS.


ISIS RFC 4444 MIB support is verified and validated for devices only with IPv6 configured 
in them. For pure IPv4 devices with RFC 4444 ISIS-MIB support, the devices get discovered 
by the IP Manager but will not be listed as part of ISIS_TopologyCollection and hence the 
NPM ISIS server will not discover the devices.


In the NPM 9.2 release, issues were observed on RFC - 4444 ISIS IPv6 discovery and 
monitoring. Now RFC 4444 followed devices ( ISIS IPv6 MIB) are fully supported regardless 
of device vendors ( Cisco and Juniper ). Discovery and monitoring support is complete and 
the ISIS NPM Domain Manager is able to stitch topologies discovered using RFC -4444 
MIBs.


Following is the complete OID information for  RFC-4444:


            ###################################
            #      ISIS-MIB - RFC 4444
            ###################################


            #isisAreaAddr
                                {40, ".1.3.6.1.2.1.138.1.1.3.1.1"},
            #isisSysLevelType
                                {45, ".1.3.6.1.2.1.138.1.1.1.2"},
            #isisISAdjIPAddrAddress
                                {50, ".1.3.6.1.2.1.138.1.6.3.1.3"},
            #isisCircIfIndex
                                {51, ".1.3.6.1.2.1.138.1.3.2.1.2"},
            #isisRouterSysID
                {55, ".1.3.6.1.2.1.138.1.1.1.3"},
            #isisISAdjNeighPriority
                                {60, ".1.3.6.1.2.1.138.1.6.1.1.10"},
            #isisISAdjState
                                {65, ".1.3.6.1.2.1.138.1.6.1.1.2"}
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Network Protocol Manager technical notes from 9.2.x that apply 
to 9.3.x


◆ “Technical notes for Network Protocol Manager 9.2.2” on page 79


◆ “Technical notes for Network Protocol Manager 9.2.1” on page 80


Technical notes for Network Protocol Manager 9.2.2


◆ “Users with custom code that uses EMC Smarts API” on page 79


◆ “NPM dump instrumentation utility” on page 79


Users with custom code that uses EMC Smarts API


If the code is based on Java, Perl, or C API, modify and retest the code according to the 
changes in this release. If a dynamic model is used, recompile the code.


The EMC Smarts Dynamic Modeling Tutorial explains the concepts and methods of 
dynamic modeling.


NPM dump instrumentation utility


The NPM dump instrumentation utility is a tool that can provide useful event information 
for troubleshooting by EMC Support. Here are sample commands for running the utility:


Note: You must send both the output file plus the repository file (for example, bgp.rps) in 
order for EMC Support to troubleshoot the problem.


Table 25  Scripts to write the instrumented values to an output file


BGP instrumentation utility command


The command to write the instrumented values is:


sm_adapter --output=<LOG_FILE> --server=<BGP-DOMAIN-MANAGER> 
utils/ic_dumpinst_bgp.asl


Where
 * <BGP-DOMAIN-MANAGER> - Name of the BGP Domain Manager to connect to.
 * <LOG_FILE> - Name of log file to write instrumentation objects to.
 * Log file will be located under the <BASEDIR>/smarts/local/log


Commands Description


ic_dumpinst_bgp.asl Write the instrumented attribute values for BGP objects to an out-
put file.


ic_dumpinst_eigrp.asl Write the instrumented attribute values for EIGRP objects to an out-
put file.


ic_dumpinst_isis.asl Write the instrumented attribute values for IS-IS objects to an out-
put file.


ic_dumpinst_ospf.asl Write the instrumented attribute values for OSPF objects to an out-
put file.
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EIGRP instrumentation utility command


The command to write the instrumented values is:


sm_adapter --output=<LOG_FILE> --server=<EIGRP-DOMAIN-MANAGER> 
utils/ic_dumpinst_eigrp.asl


Where
 * <EIGRP-DOMAIN-MANAGER> - Name of the EIGRP Domain Manager to connect 


to.
 * <LOG_FILE> - Name of log file to write instrumentation objects to.
 * Log file will be located under the <BASEDIR>/smarts/local/log


IS-IS instrumentation utility command


The command to write the instrumented values is:


sm_adapter --output=<LOG_FILE> --server=<IS-IS-DOMAIN-MANAGER> 
utils/ic_dumpinst_isis.asl


Where
 * <IS-IS-DOMAIN-MANAGER> - Name of the IS-IS Domain Manager to connect 


to.
 * <LOG_FILE> - Name of log file to write instrumentation objects to.
 * Log file will be located under the <BASEDIR>/smarts/local/log


OSPF instrumentation utility command


The command to write the instrumented values is:


sm_adapter --output=<LOG_FILE> --server=<OSPF-DOMAIN-MANAGER> 
utils/ic_dumpinst_ospf.asl


Where
 * <OSPF-DOMAIN-MANAGER> - Name of the OSPF Domain Manager to connect 


to.
 * <LOG_FILE> - Name of log file to write instrumentation objects to.
 * Log file will be located under the <BASEDIR>/smarts/local/log


Technical notes for Network Protocol Manager 9.2.1


There are no technical notes for Network Protocol Manager 9.2.1.
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Network Protocol Manager fixed problems from 9.2.x that apply to 
9.3.x


“Fixed problems in Network Protocol Manager 9.2.x” on page 81


Fixed problems in Network Protocol Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems in NPM 9.2.2


Fixed problems in Network Protocol Manager 9.2.x patch documentation


Features introduced in the Enhancements section of the 9.2.x NPM patch documentation 
are included here.


Regular full discovery in BGP is long when new devices are added at fixed intervals in AM Domain
CQ 615584


Issue


Regular full discovery in BGP Domain Manager takes long time when user adds few 
devices at fixed intervals in AM Domain.


Resolution


Implemented a Smarts driver-based mechanism to detect newly added devices 
automatically. This mechanism imports only the newly added devices into NPM BGP.


There are three attributes introduced with this fix in conf/bgp/bgp.conf which enable or 
disable the ability to detect new devices.


◆ LiteSynchronizationInterval = 3600


◆ EnableReconfigureLaunchedLiteSynchronization = FALSE


◆ EnablePeriodicLiteSynchronization = FALSE


CQ 605924
CQ 604957
SR 56310962
CQ 604789
SR 55949384
CQ 604333


OSPFNeighborRelationship was not built for 
IPv6 and Neighbor down alerts was not 
notified for both IPv4 and IPv6.


A configurable flag 
EnableAlertsOnDynamicOSPFLinks is now added to 
<BASEDIR>/NPM/smarts/conf/ospf/ospf.conf. Use 
sm_edit to modify the value.
If this flag is set to TRUE and an SNMP error occurs, 
Neighbor state will be set as DOWN, otherwise 
UNKNOWN.
Default value is TRUE.
libsm_msi.so
libsm_rpsm_ospf.so
rules/settings.asl


9.2
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By default, lite-synchronization between BGP Domain Manager and underlying AM domain 
is disabled. Set the above attributes to TRUE and restart the BGP Domain to turn on the 
lite- synchronization.
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CHAPTER 7
VoIP Availability Manager 9.2.x Features and 
Technical Notes


This chapter includes the following sections: 


◆ VoIP Availability Manager features from 9.2.x that apply to 9.3.x .............................  84
◆ VoIP Availability Manager technical notes from 9.2.x that apply to 9.3.x ..................  88
◆ VoIP Availability Manager fixed problems from 9.2.x that apply to 9.3.x...................  89
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VoIP Availability Manager features from 9.2.x that apply to 9.3.x
◆ “Features in VoIP Availability Manager 9.2.2” on page 84


◆ “Features in VoIP Availability Manager 9.2.1” on page 86


Features in VoIP Availability Manager 9.2.2


◆ “Discovery and monitoring of VoIP components for AudioCodes MediaGateway 
devices - Mediant 1000 and Mediant 2000” on page 84


◆ “Discovery and Monitoring of VoIP Components for ACME SBC 3800 and 4000” on 
page 85


◆ “Realms” on page 86


Discovery and monitoring of VoIP components for AudioCodes MediaGateway devices - Mediant 
1000 and Mediant 2000


CQ 644770


Discovery and monitoring of VoIP components for AudioCodes MediaGateway devices 
have been added in VoIP 9.2.2. The devices that are supported are Mediant 1000 and 
Mediant 2000 AudioCode devices.


Mediant 1000 and Mediant 2000 AudioCodes devices are discovered as 
“MediaGateways” in the IP Manager. Mediant 1000 and Mediant 2000 MediaGateways 
devices are a part of VOIP_TopologyCollection.


The IP containment discovery for the MediaGateways devices is based on MIB2.


All the VoIP components for the AudioCodes device are discovered from the AcGateway 
MIB (1.3.6.1.4.1.5003.9.10.3).


The following components and attributes are discovered as part of VoIP AudioCodes 
discovery:


◆ Channels — Attribute discovered is StartingPhoneNumber


◆ TrunkGroupSettings — Attribute discovered is TrunkGroupID


◆ IPProfile — Attribute discovered is ProfileName


◆ TelProfile — Attribute discovered is ProfileName


◆ ProxyIP — Attribute discovered is ProxyIPAddress


◆ Tel2IPRouting — Attribute discovered is ProfileID


◆ IP2TelRouting — Attribute discovered is ProfileID


The above components are discovered as part of “VoipNetworkService” for the 
AudioCodes devices.
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Table 26 on page 85 lists the events generated for AudioCodes MediaGateway 
VoipNetworkService.


Table 26  Events generated for AudioCodes MediaGateway VoipNetworkService


Managed Object Event Condition Instrumentation source


The above VoIP components are monitored for their status. All components that are added 
as part of VoIP discovery are imported into SAM. The map console for the device reflects 
these components for the VoipNetworkService “ComposedOf” relationship.


Discovery and Monitoring of VoIP Components for ACME SBC 3800 and 4000
ACME SBC 3800 and 4000 are the SBCs from ACME Packet. SBCs are the devices in the 
VoIP domain which are used to exert control over signaling and media streams involved in 
setting up, conducting, and tearing down telephone calls or other interactive media 
communications.


ACME SBCs  are certified in IP as Switches and are discovered for components like 
Interface, Cards, and so on based on MIB2. With the new IP implementation, these 
devices are now part of VOIP_TopologyCollection in IP. VoIP domain further picks up these 
devices for discovery and monitoring of VoIP components.


Prerequisites:


◆ ACME packet SBC SNMP agent need to be configured and open 161 port SNMP 
queries. It needs to respond to .1.3.6.1.4.1.9148 tree OIDs.


◆ Trap destination needs to be set or configured in SBC to send to the VoIP trap receiver.


◆ VoIP-AM license with VOIP_ACME feature.


VoIP AM uses SNMP queries and creates/discovers the following components in the VoIP 
AM topology:


SBC application -> VoIPNetworkService


New traps from APSYSMGMT-MIB are modeled in VoIP 9.2.2 and available in the 
acme-trapd.conf file.


Channels Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


TrunkGroupSettings Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


IPProfile Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


TelProfile Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


ProxyIP Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


Tel2IPRouting Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB


IP2TelRouting Unresponsive A channel for AudioCodes MediaGateway is unresponsive. AcGateway MIB
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Because information is not available in SBC MIB regarding associated Audio Codecs with 
which SBC is associated, relationship with codec devices is not discovered or displayed in 
the topology. So Audio Codecs association discovery is not supported. 
Though SBC is available in HA mode, information is not available in the MIB which 
describes the redundancy configuration. So redundancy groups will not be shown. Only 
the VoipCluster class with associated SBCs are displayed.


Realms
Realm is a specific domain in VoIP for Session Initiation Protocol (SIP) authentication, 
which has its own usernames and password configured. Realms are discovered based on 
APSYSMGMT-MIB (1.3.6.1.4.1.9148.3.2.1.1). These components are classified as part of 
VoipNetworkService for the SBCs.


Realms are discovered and monitored as part of VoIP. In this release, SBC certification is 
based only on SNMP and based on APSYSMGMT-MIB. 


The following attributes are instrumented and monitored for the Realms:


◆ ActiveSessionInbound


◆ ActiveSessionOutbound


◆ TotalSessionInbound


◆ TotalSessionOutbound


“Realms” is the new class that is added in the VoIP domain. SAM has been modified to 
import the Realms class as part of topology import. The map console for the device 
reflects these components for the VoipNetworkService -> ComposedOf -> Realms 
relationship.


apSigRealmStatsTable (1.3.6.1.4.1.9148.3.2.1.2.4)  is probed to discover Realms 
instances. VoIP instruments Realms elements and monitors them for availability.


Table 27 on page 86 lists the events generated related to SBC VoipNetworkService.


Table 27  Events generated related to SBC VoipNetworkService


Managed Object Event Condition Instrumentation source


Features in VoIP Availability Manager 9.2.1


VoIP release 9.2.1 includes important new features and changes to the existing features:


◆ “Support Avaya Communication Manager 6.3” on page 87


◆ “VoIP 9.2.1 now handles Avaya stale phones issue by enabling the 
“EnableAvayaStalePhonesCleanup” flag in voip.conf . When enabled, in the next 
discovery, Avaya stale phones get deleted.” on page 87


Realms Unresponsive A Realm for ACME SBC is unresponsive. APSYSMGMT-MIB
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Support Avaya Communication Manager 6.3
In the VoIP 9.2 release, Avaya Communication Manager 6.2 was certified with CLI/SNMP 
discovery. In this release, Avaya Communication Manager 6.3 is certified with CLI/SNMP 
discovery.


Support clean up of Cisco and Avaya stale phones


CQ 602317 / SR 54403618 / CQ 643208


VoIP-AM did not clean up Cisco IP Phones from its topology as they are either removed and 
no longer registered to any Cisco Unified Call Manager clusters. A once instantiated Phone 
instance stays within VoIP AM repository and this gave inaccurate information to the end 
user managing Cisco Phones.


To clean Cisco stale phones:


1. sm_edit conf/voip/voip.conf


2. Set the EnableCiscoStalePhonesCleanup = TRUE. 


3. Restart the server to have this flag setting take effect. Subsequent CUCM rediscovery 
should cleanup Cisco stale phones.


# If TRUE, stale Cisco phones will be removed from the topology
# Default value is FALSE(By default stale phones are not cleaned).
# EnableCiscoStalePhonesCleanup = TRUE


CQ 576438


VoIP-AM did not clean up Avaya IP Phones from its topology because they were removed 
and no longer registered to any Avaya Communication Manager. An instantiated Phone 
instance stays within VoIP AM repository and this gave inaccurate information to the end 
user managing Avaya phones.


VoIP 9.2.1 now handles Avaya stale phones issue by enabling the 
“EnableAvayaStalePhonesCleanup” flag in voip.conf . When enabled, in the next 
discovery, Avaya stale phones get deleted.


To clean Avaya stale phones:


1. sm_edit conf/voip/voip.conf 


2. Set the EnableAvayaStalePhonesCleanup = TRUE. 


3. Restart the server to have the flag setting to take effect. Subsequent Avaya CMs 
(re)discovery should cleanup Avaya stale phones.


# If TRUE, Avaya Stale phones will be removed from the topology
# Default value is FALSE (By default stale phones are not removed).
# EnableAvayaStalePhonesCleanup = TRUE
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VoIP Availability Manager technical notes from 9.2.x that apply to 
9.3.x


◆ “Technical notes for VoIP Availability Manager 9.2.2” on page 88


◆ “Technical notes for VoIP Availability Manager 9.2.1” on page 88


Technical notes for VoIP Availability Manager 9.2.2


VoIP ACME SBC Polling Group was not found under the VoIP Network Services Group
CQ 576242


IThe ACME SBC Polling Groups were not found under the VoIP Network Services Group.


If the ACME feature is enabled and if the VoIP server is started, the ACME SBC polling 
group is created under the VoIP Network Services Group.


If the ACME feature is not enabled, the ACME SBC polling group will not be created. If the 
feature is enabled later and if an old RPS is used, the ACME SBC polling group will not 
appear. In this case, run the following commands to load the settings and to create the 
ACME SBC polling group:


dmctl -s VoIP-AM invoke ICF_PolicyManager::ICF-PolicyManager loadSettings 
<VOIP-INSTALL>/smarts/[local]/conf/voip/acme-settings.conf


dmctl -s VoIP-AM invoke ICF_PolicyManager::ICF-PolicyManager reconfigure TRUE


How to get cluster information on Cisco and Avaya devices
This is regarding the VoIP topology split feature. To configure topology split, you can get 
information on the cluster name using the commands provided and update the same in 
the voip.conf file. Then add the cluster information for Cisco and Avaya devices by 
uncommenting the lines in voip.conf. 


To get information on cluster name, run the following command from the VoIP install 
InCharge/VoIP/smarts/bin:


Avaya


./sm_snmp -d <Avaya Call Server IP address> get 


.1.3.6.1.4.1.6889.2.8.2.2.9.0.1.3.6.1.4.1.6889.2.8.2.2.9.0 = <Cluster Name>


Cisco


./sm_snmp -d  <Cisco Call Manager IP address> get 


.1.3.6.1.4.1.9.9.156.1.1.2.1.8.1.1.3.6.1.4.1.9.9.156.1.1.2.1.8.1 = <Cluster Name>


The output you get is the cluster name that can be used to configure TSM in voip.conf.


Technical notes for VoIP Availability Manager 9.2.1


There are no technical notes for VoIP Availability Manager 9.2.1.
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VoIP Availability Manager fixed problems from 9.2.x that apply to 
9.3.x


“Fixed problems in VoIP Availability Manager 9.2.x” on page 89


Fixed problems in VoIP Availability Manager 9.2.x


Features introduced in the Fixed Problems tables from 9.2.x.release notes are included 
here.


CQ/SR/Issue 
number Problem summary Description of fix


Found in 
version


Fixed problems in VoIP 9.2.x


CQ 567402 In voip.conf, in ManagedClusters  
configuration, ClusterID values should be 
case-insensitive.
#ManagedClusters  = { 
#                                    
{<ClusterID>, <Vendor>}, 
#                                    
{<ClusterID>, <Vendor>}
#                                  }


Prior 9.2.1 release values were case sensitive, so 
can miss some clusters if case is sensitive.
In 9.2.1, ClusterID values can be any case.


9.2.1

VoIP Availability Manager fixed problems from 9.2.x that apply to 9.3.x 89







VoIP Availability Manager 9.2.x Features and Technical Notes

90 EMC Smarts Features from Version 9.2.x Applicable to Version 9.3.x SAM, IP, ESM, MPLS, VoIP, and NPM Managers





		9.2.x Release Product Features and Technical Notes

		Features from 9.2.x release products that apply to 9.3.x

		Features in 9.2.2 release products



		Technical notes from 9.2.x release products that apply to 9.3.x

		Technical notes for 9.2.2 release products

		Technical notes for 9.2.1 release products



		Fixed problems from 9.2.x that apply to 9.3.x

		Fixed Problems in 9.2.x





		Service Assurance Manager 9.2.x Features and Technical Notes

		Service Assurance Manager features from 9.2.x that apply to 9.3.x

		Features in SAM 9.2.2

		-Features in SAM 9.2.1



		Service Assurance Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for SAM 9.2.2

		Technical notes for SAM 9.2.1



		Service Assurance Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in Service Assurance Manager 9.2.x





		IP Manager 9.2.x Features and Technical Notes

		IP Manager features from 9.2.x that apply to 9.3.x

		Features in IP Manager 9.2.2

		Features in IP Manager 9.2.1



		IP Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for IP Manager 9.2.2

		Technical notes for IP Manager 9.2.1



		IP Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in IP Manager 9.2.x





		Server Manager 9.2.x Features and Technical Notes

		Server Manager features from 9.2.x that apply to 9.3.x

		Features in Server Manager 9.2.2

		Features in Server Manager 9.2.1



		Server Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for Server Manager 9.2.2

		Technical notes for Server Manager 9.2.1



		Server Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in Server Manager 9.2.x





		MPLS Manager 9.2.x Features and Technical Notes

		MPLS Manager features from 9.2.x that apply to 9.3.x

		Features in MPLS Manager 9.2.2

		Features in MPLS Manager 9.2.1



		MPLS Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for MPLS Manager 9.2.2

		Technical notes for MPLS Manager 9.2.1



		MPLS Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in MPLS Manager 9.2.x





		Network Protocol Manager 9.2.x Features and Technical Notes

		Network Protocol Manager features from 9.2.x that apply to 9.3.x

		Features in Network Protocol Manager 9.2.2

		Features in Network Protocol Manager 9.2.1



		Network Protocol Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for Network Protocol Manager 9.2.2

		Technical notes for Network Protocol Manager 9.2.1



		Network Protocol Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in Network Protocol Manager 9.2.x

		Fixed problems in Network Protocol Manager 9.2.x patch documentation





		VoIP Availability Manager 9.2.x Features and Technical Notes

		VoIP Availability Manager features from 9.2.x that apply to 9.3.x

		Features in VoIP Availability Manager 9.2.2

		Features in VoIP Availability Manager 9.2.1



		VoIP Availability Manager technical notes from 9.2.x that apply to 9.3.x

		Technical notes for VoIP Availability Manager 9.2.2

		Technical notes for VoIP Availability Manager 9.2.1



		VoIP Availability Manager fixed problems from 9.2.x that apply to 9.3.x

		Fixed problems in VoIP Availability Manager 9.2.x










EMC® Service Assurance Suite
Version 9.4.2


Installation and Configuration Guide for
EMC M&R
302-003-142


REV 01







Copyright © 2015-2016 EMC Corporation. All rights reserved. Published in the USA.


Published September 2016


EMC believes the information in this publication is accurate as of its publication date. The information is subject to change
without notice.


The information in this publication is provided as is. EMC Corporation makes no representations or warranties of any kind with
respect to the information in this publication, and specifically disclaims implied warranties of merchantability or fitness for a
particular purpose. Use, copying, and distribution of any EMC software described in this publication requires an applicable
software license.


EMC², EMC, and the EMC logo are registered trademarks or trademarks of EMC Corporation in the United States and other
countries. All other trademarks used herein are the property of their respective owners.


For the most up-to-date regulatory document for your product line, go to EMC Online Support (https://support.emc.com).


EMC Corporation
Hopkinton, Massachusetts 01748-9103
1-508-435-1000 In North America 1-866-464-7381
www.EMC.com


2 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







7


9


Installing Using the Binary Installer 11


Options for standard installation...................................................................12
General requirements....................................................................................12
Linux requirements....................................................................................... 13
Installing EMC M&R platform on UNIX............................................................13


Configuring the user process limits for a Linux installation............... 14
Installing EMC M&R platform on Windows Server...........................................15


Configuring virus-scanning software.................................................15
Configuring the hosts.................................................................................... 16
Configuring the Primary Backend hosts......................................................... 16
Installing and configuring the Additional Backend hosts............................... 17
Installing and configuring the Frontend host..................................................20
Starting the collector..................................................................................... 23
Configuring the load balancer arbiter............................................................ 23
Configuring Load Balancer Connectors, generic-snmp, and generic-rsc..........25
Installing the health collectors...................................................................... 26
Editing new actions scripts............................................................................27
Verifying that the services are running...........................................................27


Troubleshooting service start-up problems on UNIX......................... 28
Troubleshooting service start-up problems on Windows...................28


Logging in to the user interface..................................................................... 28
Connecting to Centralized Management........................................................ 29
Confirming settings for the first time..............................................................29


Using the Binary Installer to Scaleout the Environment 31


Options for standard installation...................................................................32
General requirements....................................................................................32
Linux requirements....................................................................................... 33
Server requirements......................................................................................33
Installing the basic binary deployment with four hosts.................................. 33
Configuring the hosts.................................................................................... 34
Configuring the Primary Backend hosts......................................................... 34
Installing and configuring the Additional Backend hosts............................... 35
Installing and configuring the Frontend host..................................................38
Starting the collector..................................................................................... 41
Configuring the load balancer arbiter............................................................ 41
Configuring Load Balancer Connectors, generic-snmp, and generic-rsc..........43
Installing the health collectors...................................................................... 44


Licensing 47


Licensing Operations.....................................................................................48
Trial licenses....................................................................................48


Figures


Tables


Chapter 1


Chapter 2


Chapter 3


CONTENTS


EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R 3







License duration.............................................................................. 48
License purchase............................................................................. 48


Log in with administrator credentials.............................................................49
View license information............................................................................... 49
Upload a new license file...............................................................................49
Delete licenses..............................................................................................50
Synchronize licenses on multiple hosts.........................................................50
Troubleshooting licensing problems..............................................................51


Permanent license stops working after host reconfiguration.............51
Users are locked out ........................................................................52
Module does not start or has no license .......................................... 54


Upgrading from 6.5u4 onwards to 6.7u1 55


Overview....................................................................................................... 56
Required tools...............................................................................................56
Required credentials..................................................................................... 56
Verifying and documenting the current status of the environment................. 57
Saving the Java certificates file...................................................................... 57
Importing Java certificates............................................................................. 58
Checks for the SolutionPack for Physical Hosts............................................. 58
Updating WinRM URL prefixes....................................................................... 59
Deleting backup schedules and scheduled reports from the DPA server........ 59
Updating the Centralized Management module............................................. 60
Upgrading the system................................................................................... 62
Restoring the Java certificates file..................................................................65


Upgrading from 6.5 through 6.5u3 to 6.7u1 67


Overview....................................................................................................... 68
Required tools...............................................................................................68
Required credentials..................................................................................... 68
Verifying and documenting the current status of the environment................. 69
Saving the Java certificates file...................................................................... 69
EMC M&R upgrade workflow..........................................................................70


Mixed operating system deployments.............................................. 71
Preparing for the upgrade of binary installations in Linux deployments .........71


Updating core modules in a Linux environment................................ 72
Preparing for the upgrade of binary installations in Windows deployments ...73


Updating core modules in a Windows environment.......................... 74
Restoring the Java certificates file..................................................................75
Synchronizing packages................................................................................76
Updating all components.............................................................................. 76
Checking the status of remote host services..................................................77


Reconfiguring a SolutionPack .......................................................... 78
Increasing the heap size for the Tomcat service.............................................78
Editing new Actions scripts to support alerting changes................................ 78
Updating the SNMP collections..................................................................... 79
Configuring virus-scanning software (Windows)............................................ 79
Restoring timeout values...............................................................................80
Reviewing report customizations...................................................................80


Removing an obsolete Default ReportPack....................................... 80
Validating the environment........................................................................... 81


Updating SolutionPacks and Other Components 83


Chapter 4


Chapter 5


Chapter 6


CONTENTS


4 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







Overview....................................................................................................... 84
Upgrading all SolutionPacks and other components......................................84
Updating SolutionPacks and other components............................................ 86
Adding new components...............................................................................88
Updating components distributed in package (.pkg) files.............................. 88


Automating the Download of Updates 89


Online Update overview................................................................................ 90
Configuring server settings for online updates..................................90
Enabling the online update task.......................................................90
Running the online update task manually.........................................91
Online Update Status....................................................................... 91
Online Update History...................................................................... 92
Disabling the online update task......................................................93


Uninstallation 95


Overview....................................................................................................... 96
Stopping EMC M&R platform services on a UNIX server..................................96
Uninstalling EMC M&R platform from a UNIX server....................................... 96
Stopping EMC M&R platform services on a Windows server........................... 96
Uninstalling EMC M&R platform from a Windows server.................................97
Uninstalling a SolutionPack...........................................................................97


Telnet and Socket Interface Ports 99


Telnet and socket interface ports for each backend..................................... 100


SolutionPack Reconfiguration Fields 101


SolutionPack Reconfiguration Fields........................................................... 102


Restoring Modules to their Previous Version 103


Restoring modules workflow....................................................................... 104
Listing restorable modules.......................................................................... 104
Restoring modules...................................................................................... 105


manage-modules.sh restore command.......................................... 106
Starting the EMC M&R platform services from the command line................. 107
Starting the EMC M&R platform services on Windows.................................. 108


Chapter 7


Chapter 8


Appendix A


Appendix B


Appendix C


CONTENTS


EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R 5







CONTENTS


6 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







Online Update Status.................................................................................................... 91
Online Update Status with a major version update detected.......................................... 92


1
2


FIGURES


EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R 7







FIGURES


8 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







Installation Options....................................................................................................... 12
Installation Options....................................................................................................... 32
Required Server Resources............................................................................................ 33
Host-id commands........................................................................................................ 51
Install license commands.............................................................................................. 52
Restart tomcat commands............................................................................................. 53
SolutionPack Reconfiguration Fields............................................................................102


1
2
3
4
5
6
7


TABLES


EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R 9







TABLES


10 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







CHAPTER 1


Installing Using the Binary Installer


This chapter includes the following topics:


l Options for standard installation...........................................................................12
l General requirements............................................................................................12
l Linux requirements............................................................................................... 13
l Installing EMC M&R platform on UNIX....................................................................13
l Installing EMC M&R platform on Windows Server...................................................15
l Configuring the hosts............................................................................................ 16
l Configuring the Primary Backend hosts................................................................. 16
l Installing and configuring the Additional Backend hosts....................................... 17
l Installing and configuring the Frontend host..........................................................20
l Starting the collector............................................................................................. 23
l Configuring the load balancer arbiter.................................................................... 23
l Configuring Load Balancer Connectors, generic-snmp, and generic-rsc..................25
l Installing the health collectors.............................................................................. 26
l Editing new actions scripts....................................................................................27
l Verifying that the services are running...................................................................27
l Logging in to the user interface..............................................................................28
l Connecting to Centralized Management................................................................ 29
l Confirming settings for the first time......................................................................29
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Options for standard installation
Learn how to install the platform using a binary installation package.


The platform infrastructure consists of four types of hosts:


l Frontend host


l Backend hosts (Primary and Additional)


l Collector host


l All-In-One (recommended for testing only)


You can only have one Primary Backend host. You can add Additional Backend hosts with
up to four Time-Series databases on each.


For deployments to support 5 million metrics or more, EMC recommends deploying the
Frontend, Primary Backend and Additional Backend hosts on the Linux operating system.


The MySQL version included with the product is 5.5.48 MySQL Community Server (GPL).


Table 1 Installation Options


Frontend Primary
Backend


Additional Backend Collector


Linux Installation
Options


[f]rontend [b]ackend [m]inimal [c]ollector


Windows
Installation
Options


Frontend
Modules


Backend
Modules


Base Installation (with
none of the modules
selected)


Collector
Modules


General requirements
These requirements are for a minimal deployment. In a production environment, the
requirements will vary depending on the provisioned load, and you must include careful
planning and sizing before beginning the deployment.


The environment must meet the following requirements:


l 64 bit operating system (Linux or Windows)


l 16 to 24 GB RAM for each host


l Frontend – 16 GB RAM, 320 GB disk storage


l Backends – 24 GB RAM, disk storage is determined by the sizing


l Collectors – 16 GB RAM, 130+ GB disk storage


l 4 CPUs per host


l Forward and Reverse IP and DNS lookups must work on each server


Note


The following sections use Linux commands and directories as examples. For Windows,
use .cmd instead of .sh, and / instead of \ for directories.
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Linux requirements
The environment must meet the following requirements:


l /tmp folder larger than 2.5 GB


l SWAP file should be at least equal to the RAM size


l On CentOs or RedHat-like Linux, the SELinux should be disabled or reconfigured


l The graphical desktop environment is not required


l On some Linux distributions:


n MySQL server requires libaio1, libaio-dev, or libaio to start


n The installation process requires unzip


n On system restart the apg services may not start


Installing EMC M&R platform on UNIX
You can install the EMC M&R platform on supported UNIX hosts. This procedure
specifically uses the Linux installation procedure as an example.


Before you begin


l When you install EMC M&R platform on a UNIX server, assign executable permissions
to the installation script.


l Ensure that you have a login with root privileges to run the installer.


l Download the installation file from support.emc.com, and place it in a temporary
location on the server.


Procedure


1. Log in to the server as root.


2. Change the permissions of the installer.


For example:


chmod +x <file_name>.sh
3. Run the installer from the directory.


For example:


./<file_name>.sh
4. Read and accept the End User License Agreement.


5. Accept the default installation directory of /opt/APG or type another location.


6. Accept the default user account name of apg or type another name.


7. Accept the default location of service scripts of /etc/init.d or type another
location.


8. Accept the default base directory of/etc for runlevel scripts or type another base
directory.


9. Depending on the host purpose, select one of the following options:
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Option Description


Default Installs recommended modules available in the binary installation
package. You can use this option on a single host, which enables it to
serve as a Frontend, Backend and Collector host. To customize this host
further, manually add or remove specific modules.


Frontend Installs web services and front end applications.


Backend Installs the database and backend services.


Collector Installs base modules to perform data collection and enrichment.


Minimal Installs the minimal modules required for any host type. To customize this
host further, manually add specific modules. You may also use this
option to install and configure additional Backend Hosts.


Configuring the user process limits for a Linux installation
Increase the user process limits for the apg user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.
This step is required for proper functioning of the core software.


Before you begin


l Make sure you have a login with root privileges.


l The core software installed on a server running Red Hat Enterprise Linux 6, CentOS
Linux 6, SUSE Linux Enterprise Server (SLES) 11, or any other supported Linux
operating systems.


Procedure


1. Open the /etc/security/limits.conf file.


2. Add the following lines for the user.


In this example, the user is apg.


apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534


3. Save the file.


4. To verify the changes, type the following command:


su apg -c 'ulimit -n -u'
5. In the apg.properties file, edit the hostname to a FQDN host name.


6. To restart the services, type the following commands from the bin directory of the
installation:


./manage-modules.sh service stop all


./manage-modules.sh service start all
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Installing EMC M&R platform on Windows Server
You can install the EMC M&R platform on supported Windows Server hosts.


Before you begin


l Ensure that you have a login with system administrator privileges to run the installer.


l Download the installation file from support.emc.com, and place it in a temporary
location on the server.


Procedure


1. Double-click the .exe file.


2. Click Next on the Welcome screen.


3. Read and accept the End User License Agreement. Click I Agree.


4. Select the Destination Folder:


a. Change the drive to a Windows non-root drive.


b. Maintain the default folder structure (Program Files\APG).


c. Click Next.


5. Depending on the host purpose, select one of the following options:


Option Description


Recommended
Modules


Installs all recommended modules available in the binary
installation package. You can use this option on a single
host, which enables it to serve as a Frontend, Backend and
Collector host. To customize this host further, manually add
or remove specific modules.


Frontend Modules Installs web services and front end applications.


Backend Modules Installs the database and backend services.


Collector Modules Installs base modules to perform data collection and
enrichment.


Base Installation Installs the minimal modules required for any host type. To
customize this host further, manually add specific modules.
You may also use this option to install and configure
Additional Backend Hosts.


6. Click Install.


7. When the installation is complete, click Next.


8. To close the installer, click Finish.


Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.


After installing MySQL Server, it is recommended that you disable virus scanning on the
directory used to store your MySQL table data (such as C:\Program Files\APG
\Databases\MySQL\Default\data). In addition, by default, MySQL creates
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temporary files in the standard Windows temporary directory. To prevent scanning the
temporary files, configure a separate temporary directory for MySQL temporary files and
add this directory to the virus scanning exclusion list. To do this, add a configuration
option for the tmpdir parameter to your my.ini configuration file.


Configuring the hosts
You must configure the hosts in a particular order.


Configure the four hosts in the following order:


Procedure


1. Select one of the backend hosts to be the primary backend.


2. Select the other backend host to be the additional backend.


3. Select a host to be the frontend.


4. Select a host to be the collector.


Configuring the Primary Backend hosts
Learn how to install and configure the Primary Backend hosts.


Before you begin


l Identify the host you want to configure as the Primary Backend host.


l Identify the hosts you want to configure as the Frontend, Collectors, and Additional
Backends.


l Minimum System Requirements:


n CPU: 4


n Memory: 24 GB


n Disk Space: 150 GB HDD


Procedure


1. Set the Maximum Java Heap Size in the /opt/APG/Backends/Topology-
Service/Default/conf/unix-service.properties file to 6144 MB.


2. Reconfigure the topology service to commit the change.


/opt/APG/bin/manage-modules.sh service update topology-service


/opt/APG/bin/manage-modules.sh service start topology-service


3. Allow remote access to the databases.


On the primary backend, replace <FQDN-New-Server> with localhost, Collectors,
Backends and Frontend hosts Fully Qualified Domain names:


<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`compliance\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`apg\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`events\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
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'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`master\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`topology\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"


4. Start the backend services:


Option Description


Linux manage-module.sh service start all


Windows manage-module.cmd service start all


5. Verify that all of the services are running:


Option Description


Linux manage-module.sh service status all


Windows manage-module.cmd service status all


Installing and configuring the Additional Backend hosts
Learn how to install and configure the additional backend host. This step is optional. To
configure an additional backend host, choose the Minimal option when installing the
software.


Before you begin


l Identify the host you want to configure as the Additional Backend host.


l Identify the hosts you want to configure as the Frontend, Collectors, and Additional
Backends.


l Minimum System Requirements:


n 64-bit Operating System


n CPU: 4


n Memory: 24 GB


n Disk Space: 150 GB HDD


Procedure


1. Start the installation as described in Installing EMC M&R platform on UNIX on page
13.


2. When you are prompted to select the installation type, choose the "minimal" option
and complete the installation.


3. Configure the user process limits as described in Configuring the user process limits
for a Linux installation on page 14.


At this stage, you will have a host with minimal components installed. Customize this
host further by manually adding the modules required for additional backend.


Installing Using the Binary Installer


Installing and configuring the Additional Backend hosts     17







4. Install the MySQL module:


/opt/APG/bin/manage-modules.sh install mysql <Instance-Name>


Answer “no” when asked to install the databases packaged with the application.


5. Start the MySQL process:


/opt/APG/bin/manage-modules.sh service start mysql


6. Install the maintenance tool for each new backend by running the following command
for each apg database. Answer yes to each question.


/opt/APG/bin/manage-modules.sh install mysql-maintenance-
tool apg[1..n]


7. Create four new databases with the names apg1, apg2, apg3, and apg4 by running
the following command four times (replacing the [1..n] with a number):


/opt/APG/bin/mysql-command-runner-apg[1..n].sh -c /opt/APG/
Tools/MySQLMaintenance-Tool/apg[1..n]/conf/mysql-root-
mysql.xml -Q "create database apg[1..n]";


Note


EMC recommends keeping the default APG timeseries database.


8. Register the apg databases to the APG Backend server by running the following
command for each apg database. Answer Yes to each question.


/opt/APG/bin/manage-modules.sh install backend apg[1..n]


Note


The MySQL Storage Adapter uses in-memory temporary tables. You should set the
max_heap_table_size in …/APG/Databases/MySQL/Default/my.cnf (Unix) or


my.ini (Windows) to at least 128M (depending on your installation size) to avoid


errors.


9. Allow remote access to the new databases. Each database must be configured to be
accessible from other hosts. Repeat the following command replacing <HostName>
with each collector, frontend, primary backend and localhost:


/opt/APG/bin/mysql-command-runner.sh -c /opt/APG/Tools/MySQL-
Maintenance-
Tool/<apg[1..n]>/conf/mysql-root-mysql.xml -Q "GRANT ALL
PRIVILEGES ON *.* TO 'apg'@'<HostName>' IDENTIFIED BY
PASSWORD'*FA71926E39A02D4DA4843003DF34BEADE3920AF3'"


The <HOST NAME> must be the DNS name resolved from the nslookup <CLIENT IP>
command executed from the Additional Backend host.


10. Find all of the XML files in the /opt/APG/Backends/APG-Backend/apg[1..n]
folders that contains JDBS connection URLs.


For example: …localhost:53306/apg
11. Update the URLs to include the correct APG database numbers.


For example: …localhost:53306/apg[1..n]
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To complete this step with a script (for Linux), run this command:


find /opt/APG/Backends/APG-Backend/apg[1..n] -name '*.xml' | xargs
sed -i "s|jdbc:mysql://localhost:53306/apg|\\0[1..n]|"


12. Set the Telnet interface port for each new apg database.


The Telnet interface port for each new apg database must be different. The default
port is 2001. To change the port numbers, edit the following file and set the port
numbers to 2[1..n]01: /opt/APG/Backends/APG-Backend/apg[1..n]/conf/
telnetinterface.xml
Refer to Telnet and Socket Interface Ports on page 99 for guidelines.


13. Set the socket interface port for each new apg database.


The socket interface port for each new apg database must be different. The default
port is 2000. To change the port numbers, edit the following files and set the port
numbers to 2[1..n]00:/opt/APG/Backends/APG-Backend/apg[1..n]/conf/
Negotiating-socket-interface.xml


14. Point the MySQL maintenance tools to the new local databases.


Edit the following files and replace "apg" with the correct name, for example,
"apg1."/opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n]/conf/
mysql.xml
/opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n]/conf/mysql-
root-apg.xml


For example:


<url>jdbc:mysql://localhost:53306/apg1?autoReconnect=true</url>
<!-- The username for database access. -->
<username>apg</username>
<!-- The password for database access. -->
<password>watch4net</password>


To complete this step with a script (for Linux), run the following command:
find /opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n] -name
'*.xml' | xargs sed -i "s|jdbc:mysql://localhost:53306/apg|\
\0[1..n]|"


15. Start the backend services:


Option Description


Linux manage-modules.sh service start all


Windows manage-modules.cmd service start all


16. Verify that all the services are running:


Option Description


Linux manage-modules.sh service status all


Windows manage-modules.cmd service status all


17. To complete the configuration of additional backends, reconfigure the Load Balancer
Arbiter (LBA) as described in Configuring the load balancer arbiter on page 23 and
add an entry for each of the apg backends.
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After the installation, you can reconfigure the backends and ports from Centralized
Management > SolutionPacks > Other Components.


Installing and configuring the Frontend host
Learn how to install and configure the frontend host.


Before you begin


l Ensure that you have the details of the Backend host, Additional Backend hosts, and
Collector hosts.


l Minimum System Requirements:


n 64-bit Operating System


n CPU: 4


n Memory: 16 GB


n Disk Space: 150 GB HDD


Procedure


1. Start the installation as described in Installing EMC M&R platform on UNIX.


2. When you are prompted to select the installation type, choose the "frontend" option
and complete the installation.


3. Configure the user process limits as described in Configuring the user process limits
for a Linux installation on page 14 .


4. Set the connections that point to a local MySQL server to point to the primary
backend. In the following files, locate all of the strings like localhost:53306, and
replace the string localhost with the primary backend DNS name (it must be
resolvable):


l /opt/APG/Web-Servers/Tomcat/Default/conf/server.xml
l /opt/APG/Tools/Frontend-Report-Generator/Default/conf/


report-generation-config.xml
l /opt/APG/Tools/Administration-Tool/Default/conf/master-


accessor-service-conf.xml
l /opt/APG/Tools/WhatIf-Scenario-CLI/Default/conf/whatif-


scenario-cli-conf.xml


5. Set non-MySQL localhost connections to point to the new primary backend:


a. Locate and replace the hostname in the strings localhost:48443 in the
following file:


/opt/APG/Web-Servers/Tomcat/Default/conf/Catalina/
localhost/APG.xml


b. Locate and replace the hostname in the strings localhost:52569 in the
following file:


/opt/APG/Web-Servers/Tomcat/Default/conf/Catalina/
localhost/alerting-frontend.xml


c. Locate and replace the hostname in the strings localhost:52569 in the
following file:


/opt/APG/Tools/Frontend-Report-Generator/Default/conf/
report-generation-config.xml
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6. Increase the maximum memory that the Tomcat server can use by locating
memory.max= in the /opt/APG/Web-Servers/Tomcat/Default/conf/
unix-service.properties file and setting it to memory.max=8192.


7. Update the Tomcat service to apply the new memory settings:


#/opt/APG/bin/manage-modules.sh service update tomcat Default


8. Restart the Tomcat service and the webservice-gateway:


#/opt/APG/bin/manage-modules.sh service start tomcat Default
#/opt/APG/bin/manage-modules service.sh restart webservice-gateway 
Default


9. Using a web browser, log in to Centralized Management on the frontend at http://
<frontend-host>:58080/centralized-management.


l User Name = admin


l Password = changeme


At the first login, the Servers Configuration page opens. Register the frontend host by
updating the WS Gateway URL. Replace localhost with the FQDN of the frontend host
and click Save.


10. Go to Configuration > Servers, and then click Register a Server. Register all of the APG
servers that are up and running.


Use the following settings:


l Server HostName – the DNS name of the server


l Gateway URL – https://<server DNS name>:48443/
l User Name – admin


l Password – changeme


11. Click Save.


12. Once you have registered all of the servers, verify that they display in Centralized
Management > Physical Overview without any error messages.


13. ResourceLinks for the timeseries database are now stored in the master database. To
give access to the timeseries database on the primary backend and the additional
backend, update the resources using the manage-resources.sh command:


#/opt/APG/bin/manage-modules.sh service restart all
#/opt/APG/bin/manage-resources.sh list (this will list all the 
resources)
#/opt/APG/bin/manage-resources.sh get "dba/APG-DB" 


a. Check the details of dba/APG-DB and update the connection URL to point to the
primary backend host:


/opt/APG/bin/manage-resources.sh update dba/APG-DB '{
  "type": "jdbc",
  "datasource":   {
    "maxActive": "10",
    "maxIdle": "10",
    "validationQuery": "SELECT 1",
    "testOnBorrow": "false",
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    "testWhileIdle": "true",
    "validationQueryTimeout": "5",
    "timeBetweenEvictionRunsMillis": "10000",
    "minEvictableIdleTimeMillis": "60000",
    "maxWait": "10000",
    "removeAbandoned": "true",
    "removeAbandonedTimeout": "60",
    "logAbandoned": "true",
    "driverClassName": "com.mysql.jdbc.Driver",
    "username": "apg",
    "password": 
"{6230FED930DD59BEB1095D6801AA74E2FC23B2C8B76AFF6447D5C49B84C400
1FDF5B6441DF7CD5CB2B19D4A927C63934}",
    "url": "jdbc:mysql://<FQDN-Primary-Backend>:53306/apg?
autoReconnect=true&connectTimeout=20000&maxReconnects=2"
  },
  "settings": {"cachegrp": "DB"}
}'


b. Update the management resource for the data management tool to communicate
with the backend:


/opt/APG/bin/manage-resources.sh update mgmt/APG-DB '{
  "type": "webservice",
  "connection":   {
    "disableSSLValidation": true,
    "url": "https://<FQDN-Primary-Backend>:48443/Backends/APG-
Backend/apg",
    "user": "admin",
    "password": 
"{68951D237EABAFD17BD2F90B2029E51B9078C3968D27791E745EB38C2F8E4B
7B6351D632200618220667E25792D7E8894330B34886D638E3C3B93856C94998
B9}"
  }
}'


c. Update all of the remaining resources in the same way.


14. Create resources for each of the newly added APG databases on the Additional
Backend with resources names such as dba/APG-DB[1..n] and mgmt./APG-DB[1..n].
Perform this operation every time a new additional backend host is added to the
environment to scale-out backends.


For example, to create a Database resource:


manage-resources.sh create dba/APG-DB[1..n] '{
    "type": "jdbc",
     "datasource":   {
     "maxActive": "10",
     "maxIdle": "10",
     "validationQuery": "SELECT 1",
     "testOnBorrow": "false",
     "testWhileIdle": "true",
     "validationQueryTimeout": "5",
     "timeBetweenEvictionRunsMillis": "10000",
     "minEvictableIdleTimeMillis": "60000",
     "maxWait": "10000",
     "removeAbandoned": "true",
     "removeAbandonedTimeout": "60",
     "logAbandoned": "true",
     "driverClassName": "com.mysql.jdbc.Driver",
     "username": "apg",
     "password": 
"{6230FED930DD59BEB1095D6801AA74E2FC23B2C8B76AFF6447D5C49B84C4001FD
F5B6441DF7CD5CB2B19D4A927C63934}",
     "url": "jdbc:mysql://<FQDN-Additional-Backend>:53306/
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apg[1..n]?autoReconnect=true&connectTimeout=20000&maxReconnects=2"
   },
   "settings": {"cachegrp": "DB"}
 }'


To create a Management Resource:


manage-resources.sh update mgmt/APG-DB[1..n] '{
  "type": "webservice",
  "connection":   {
    "disableSSLValidation": true,
    "url": "https://<FQDN-Additional-Backend>:48443/Backends/APG-
Backend/apg[1..n]",
    "user": "admin",
    "password": 
"{68951D237EABAFD17BD2F90B2029E51B9078C3968D27791E745EB38C2F8E4B7B6
351D632200618220667E25792D7E8894330B34886D638E3C3B93856C94998B9}"
  }
}'


Starting the collector
Learn how to start the collector.


Procedure


1. Install the collector as described in Installing Using the Binary Installer on page 11.


2. Start the collector service:


manage-modules service start all


Configuring the load balancer arbiter
Learn how to configure the load balancer arbiter from Centralized Management. Complete
these steps every time a new backend host is added to the environment to scaleout
backends.


Before you begin


l The connection must point to the FQDN of the primary backend or additional backend
host.


l The listening port must be 2020.


Procedure


1. Log in to Centralized Management at http://<frontend-host>:58080/
centralized-management.


2. Navigate to SolutionPacks > Other Components.


3. Locate the load-balancer-arbiter component and click the Reconfigure button.


4. Click on the drop down against Arbiter configuration and select Add a new arbiter
configuration


a. Update the backend hostname with the DNS name of primary backend host.


b. Change the Web-Service Gateway to the primary backend host.


c. Update the backend database hostname with the DNS name of primary backend
host.
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5. Add a configuration for all the apg backends installed on the additional backend host.
Complete this step whenever a new additional backend host is added to the
environment to scale out backends.


For example:


SolutionPack Reconfiguration Fields on page 101 describes the values that you
should enter for each field on the SolutionPack Reconfiguration page.


6. Click the + button and add an entry for each of the backend instances (apg1, apg2,
apg3 and apg4) created on the additional backend host.


7. Provide the appropriate backend data port, web-service gateway, backend instance
name, and DB connection details for each of the instances.


8. Modify the Alerting data collection section and provide the primary backend DNS
name for Alerting Backend hostname.


9. Modify the Frontend Web service section and provide the frontend DNS name for
Tomcat hostname.


10. Once everything is updated, click Reconfigure.


11. After you have setup the arbiter, check the logs under /opt/APG/Collecting/
Collector-Manager/Load-Balancer/logs to see if all of the APG backend
instances were correctly installed.


For example:


# cat /opt/APG/Collecting/Collector-Manager/Load-Balancer/
logscollecting-0-0.log | grep "LoadFactorDecision::isReady"
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Starting decision with current load 
factor of:
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend1 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend2 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend3 0.0/750000.0 (0.0)
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INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend4 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend0 595.0/750000.0 
(7.933333333333333E-4)


Configuring Load Balancer Connectors, generic-snmp, and
generic-rsc


Learn how to configure Load Balancer Connectors (LBCs). Complete these steps every
time a new collector host is added to the environment to scale-out collectors.


Before you begin


l The Load Balancer Arbiter is installed on the primary backend with the listener port of
2020.


l The LBCs are installed on all of the collector hosts.


l The LBC listens on port 2020 local on that collector server and communicates with
the Load Balancer Arbiter on the primary backend also using port 2020.


Procedure


1. During the installation of the LBC, when the script asks for the Web-Service
gateway hostname or IP address [localhost], enter the DNS of the
primary backend server where the arbiter is installed.


2. The collector server has the LBC installed by default, but you must reconfigured it to
point it to the primary backend and its arbiter:


a. In Centralized Management > SolutionPacks > Other Components, filter on the
collector name, and click the Reconfigure button for the load-balancer-connector.


b. Update all of the host names and gateway URLs so they point to the primary
backend.


c. Update the Alerting Backend hostname to Primary Backend host and 2010 port.


d. Update the Frontend Web Service to point to the Frontend host.


For example:


e. generic-rsc is installed by default on the collector host. Click the Reconfigure
button and update the Frontend Web Service to point to frontend host. Update the
Topology service question by changing the host name and gateway to point to the
primary backend host.
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f. Click the Reconfigure button for generic-snmp. Update the Frontend Web service to
point to frontend host. Update the Topology service question by changing the host
name and gateway to point to primary backend host


Installing the health collectors
Learn how to install the health collectors. Each server should have a health collector to
monitor and report its state.


Before you begin


The Health Collector on the primary backend must point to the local LBA and its port. In
this installation, the port is 2020.


The first installation of the SolutionPack will install the Health Reports on the frontend
server.


Procedure


1. Log in to the Centralized Management UI.


2. Open SolutionPack Center and select EMC M&R Health.


3. Click Install.


4. On the Select the Components to Install window:


a. Install Pre-configured alerts and the Events block where the primary backend is
located.


b. Install the Data collection block on every host by repeating the installation
procedure for each host.


c. Install Reports on the frontend.


5. On the Data Collection window:


a. Data collection is the local LBC on port 2020.


b. Alerting is on the primary backend.


c. Topology host and gateway is on the primary backend
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Editing new actions scripts
Edit actions on the frontend host to send events to the machine on which the event-
processing-manager of the alerting-consolidation module is configured.


Procedure


1. In the following file, replace 127.0.0.1 with the primary backend IP address:


Option Description


Linux /opt/APG/Custom/WebApps-Resources/Default/actions/
event-mgmt/linux/conf


Windows Program Files\APG\Custom\WebApps-Resources\Default
\actions\event-mgmt\windows\conf.cmd


Verifying that the services are running
Verify that the services are running on each host by obtaining the status.


Before you begin


Ensure that you have a login with root, APG, or system administrator privileges. The user
apg is the account that the application uses instead of root.
Procedure


1. Type the command for your operating system from the bin directory of the
installation:


Operating system Command


UNIX manage-modules.sh service status all
Windows manage-modules.cmd service status all


2. Verify that each service has a status of running in the output.
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Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with root to check the log files.


Procedure


l The default ViPR SRM path is /opt/APG/.


The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).


Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log


Troubleshooting service start-up problems on Windows
Check the log files when services do not start.


Before you begin


Ensure that you have logged in with system administrator credentials to check the log
files.


Procedure


l Look for log files in these C:\Program Files\APG directory paths.


The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).


Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log


Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet your needs


Procedure


1. Open a browser and type the following URL:


http://<Frontend-hostname>:58080/APG
2. Type the login credentials.


The default username is admin. The default password is changeme.


3. Click Sign In.
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Note


You are automatically logged off after four hours.


Connecting to Centralized Management
Connect to the server so that you can access Centralized Management to install and
administer SolutionPacks.


Centralized Management is one of the multiple web applications available in EMC M&R
platform.


Procedure


1. Open a browser.


2. Type http://<serverIP:port>/centralized-management.


The serverIP is the fully qualified hostname or IP address of the server where EMC M&R
platform runs.


The port is the port number of the server.


Example:


http://myHost.emc.com:58080/centralized-management
3. Log in.


a. Default username is admin.


b. Default password is changeme.


c. Click Sign In.


After you finish


You are automatically logged off after four hours.


Confirming settings for the first time
After you first log in with administrator credentials for EMC M&R platform, you must
confirm the configuration settings for the server.


Procedure


l Upon first login, the Server Configuration page opens automatically. Modify the
references to localhost in the WS Gateway URL to the DNS name of the server.


l To accept the predefined values for the server, click Save.


Blank fields must remain blank.


Installing Using the Binary Installer


Connecting to Centralized Management     29







Installing Using the Binary Installer


30 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







CHAPTER 2
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Options for standard installation
Learn how to install the platform using a binary installation package.


The platform infrastructure consists of four types of hosts:


l Frontend host


l Backend hosts (Primary and Additional)


l Collector host


l All-In-One (recommended for testing only)


You can only have one Primary Backend host. You can add Additional Backend hosts with
up to four Time-Series databases on each.


For deployments to support 5 million metrics or more, EMC recommends deploying the
Frontend, Primary Backend and Additional Backend hosts on the Linux operating system.


The MySQL version included with the product is 5.5.48 MySQL Community Server (GPL).


Table 2 Installation Options


Frontend Primary
Backend


Additional Backend Collector


Linux Installation
Options


[f]rontend [b]ackend [m]inimal [c]ollector


Windows
Installation
Options


Frontend
Modules


Backend
Modules


Base Installation (with
none of the modules
selected)


Collector
Modules


General requirements
These requirements are for a minimal deployment. In a production environment, the
requirements will vary depending on the provisioned load, and you must include careful
planning and sizing before beginning the deployment.


The environment must meet the following requirements:


l 64 bit operating system (Linux or Windows)


l 16 to 24 GB RAM for each host


l Frontend – 16 GB RAM, 320 GB disk storage


l Backends – 24 GB RAM, disk storage is determined by the sizing


l Collectors – 16 GB RAM, 130+ GB disk storage


l 4 CPUs per host


l Forward and Reverse IP and DNS lookups must work on each server


Note


The following sections use Linux commands and directories as examples. For Windows,
use .cmd instead of .sh, and / instead of \ for directories.
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Linux requirements
The environment must meet certain requirements for Linux distributions.


The environment must meet the following requirements:


l /tmp folder larger than 2.5 GB


l SWAP file should be at least equal to the RAM size


l On CentOs or RedHat-like Linux, the SELinux should be disabled or reconfigured


l The graphical desktop environment is not required


l On some Linux distributions:


n MySQL server requires libaio1 libaio-dev or libaio to start


n The installation process requires unzip


n On system restart the apg services will not start


Server requirements
The environment must meet certain server requirements.


The environment must meet the following requirements:


l Each server should have a health collector to monitor and report its state


l The Load Balancer Arbiter should be installed on the primary backend


l The Load Balancer Connector should be installed on each of the collector hosts


Table 3 Required Server Resources


Type of Server RAM (GB) HDD (GB)


Backend default
installation with Load
Balancer Arbiter


24 150


Additional backend with 4
backend instances


24 150


Frontend 16 150


Collector 8 to 16 150


Installing the basic binary deployment with four hosts
Install the system components on four hosts to establish the basic four host solution.


Install the product using the binary installation package as described in Install Using the
Binary Installer on page 11.


Procedure


l Install the software for the following types of hosts:


n 1 frontend host
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n 2 backend hosts


n 1 collector host


Configuring the hosts
You must configure the hosts in a particular order.


Configure the four hosts in the following order:


Procedure


1. Select one of the backend hosts to be the primary backend.


2. Select the other backend host to be the additional backend.


3. Select a host to be the frontend.


4. Select a host to be the collector.


Configuring the Primary Backend hosts
Learn how to install and configure the Primary Backend hosts.


Before you begin


l Identify the host you want to configure as the Primary Backend host.


l Identify the hosts you want to configure as the Frontend, Collectors, and Additional
Backends.


l Minimum System Requirements:


n CPU: 4


n Memory: 24 GB


n Disk Space: 150 GB HDD


Procedure


1. Set the Maximum Java Heap Size in the /opt/APG/Backends/Topology-
Service/Default/conf/unix-service.properties file to 6144 MB.


2. Reconfigure the topology service to commit the change.


/opt/APG/bin/manage-modules.sh service update topology-service


/opt/APG/bin/manage-modules.sh service start topology-service


3. Allow remote access to the databases.


On the primary backend, replace <FQDN-New-Server> with localhost, Collectors,
Backends and Frontend hosts Fully Qualified Domain names:


<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`compliance\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`apg\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`events\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"
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<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`master\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"
<APG>/bin/mysql-command-runner.sh -c <APG>/Tools/MySQL-Maintenance-
Tool/Default/conf/mysql-root-mysql.xml -Q "GRANT ALL PRIVILEGES ON 
\`topology\`.* TO 'apg'@'<FQDN-New-Server>' IDENTIFIED BY 
'watch4net';"


4. Start the backend services:


Option Description


Linux manage-module.sh service start all


Windows manage-module.cmd service start all


5. Verify that all of the services are running:


Option Description


Linux manage-module.sh service status all


Windows manage-module.cmd service status all


Installing and configuring the Additional Backend hosts
Learn how to install and configure the additional backend host. This step is optional. To
configure an additional backend host, choose the Minimal option when installing the
software.


Before you begin


l Identify the host you want to configure as the Additional Backend host.


l Identify the hosts you want to configure as the Frontend, Collectors, and Additional
Backends.


l Minimum System Requirements:


n 64-bit Operating System


n CPU: 4


n Memory: 24 GB


n Disk Space: 150 GB HDD


Procedure


1. Start the installation as described in Installing EMC M&R platform on UNIX on page
13.


2. When you are prompted to select the installation type, choose the "minimal" option
and complete the installation.


3. Configure the user process limits as described in Configuring the user process limits
for a Linux installation on page 14.


At this stage, you will have a host with minimal components installed. Customize this
host further by manually adding the modules required for additional backend.


4. Install the MySQL module:


/opt/APG/bin/manage-modules.sh install mysql <Instance-Name>
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Answer “no” when asked to install the databases packaged with the application.


5. Start the MySQL process:


/opt/APG/bin/manage-modules.sh service start mysql


6. Install the maintenance tool for each new backend by running the following command
for each apg database. Answer yes to each question.


/opt/APG/bin/manage-modules.sh install mysql-maintenance-
tool apg[1..n]


7. Create four new databases with the names apg1, apg2, apg3, and apg4 by running
the following command four times (replacing the [1..n] with a number):


/opt/APG/bin/mysql-command-runner-apg[1..n].sh -c /opt/APG/
Tools/MySQLMaintenance-Tool/apg[1..n]/conf/mysql-root-
mysql.xml -Q "create database apg[1..n]";


Note


EMC recommends keeping the default APG timeseries database.


8. Register the apg databases to the APG Backend server by running the following
command for each apg database. Answer Yes to each question.


/opt/APG/bin/manage-modules.sh install backend apg[1..n]


Note


The MySQL Storage Adapter uses in-memory temporary tables. You should set the
max_heap_table_size in …/APG/Databases/MySQL/Default/my.cnf (Unix) or


my.ini (Windows) to at least 128M (depending on your installation size) to avoid


errors.


9. Allow remote access to the new databases. Each database must be configured to be
accessible from other hosts. Repeat the following command replacing <HostName>
with each collector, frontend, primary backend and localhost:


/opt/APG/bin/mysql-command-runner.sh -c /opt/APG/Tools/MySQL-
Maintenance-
Tool/<apg[1..n]>/conf/mysql-root-mysql.xml -Q "GRANT ALL
PRIVILEGES ON *.* TO 'apg'@'<HostName>' IDENTIFIED BY
PASSWORD'*FA71926E39A02D4DA4843003DF34BEADE3920AF3'"


The <HOST NAME> must be the DNS name resolved from the nslookup <CLIENT IP>
command executed from the Additional Backend host.


10. Find all of the XML files in the /opt/APG/Backends/APG-Backend/apg[1..n]
folders that contains JDBS connection URLs.


For example: …localhost:53306/apg
11. Update the URLs to include the correct APG database numbers.


For example: …localhost:53306/apg[1..n]
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To complete this step with a script (for Linux), run this command:


find /opt/APG/Backends/APG-Backend/apg[1..n] -name '*.xml' | xargs
sed -i "s|jdbc:mysql://localhost:53306/apg|\\0[1..n]|"


12. Set the Telnet interface port for each new apg database.


The Telnet interface port for each new apg database must be different. The default
port is 2001. To change the port numbers, edit the following file and set the port
numbers to 2[1..n]01: /opt/APG/Backends/APG-Backend/apg[1..n]/conf/
telnetinterface.xml
Refer to Telnet and Socket Interface Ports on page 99 for guidelines.


13. Set the socket interface port for each new apg database.


The socket interface port for each new apg database must be different. The default
port is 2000. To change the port numbers, edit the following files and set the port
numbers to 2[1..n]00:/opt/APG/Backends/APG-Backend/apg[1..n]/conf/
Negotiating-socket-interface.xml


14. Point the MySQL maintenance tools to the new local databases.


Edit the following files and replace "apg" with the correct name, for example,
"apg1."/opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n]/conf/
mysql.xml
/opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n]/conf/mysql-
root-apg.xml


For example:


<url>jdbc:mysql://localhost:53306/apg1?autoReconnect=true</url>
<!-- The username for database access. -->
<username>apg</username>
<!-- The password for database access. -->
<password>watch4net</password>


To complete this step with a script (for Linux), run the following command:
find /opt/APG/Tools/MySQL-Maintenance-Tool/apg[1..n] -name
'*.xml' | xargs sed -i "s|jdbc:mysql://localhost:53306/apg|\
\0[1..n]|"


15. Start the backend services:


Option Description


Linux manage-modules.sh service start all


Windows manage-modules.cmd service start all


16. Verify that all the services are running:


Option Description


Linux manage-modules.sh service status all


Windows manage-modules.cmd service status all


17. To complete the configuration of additional backends, reconfigure the Load Balancer
Arbiter (LBA) as described in Configuring the load balancer arbiter on page 23 and add
an entry for each of the apg backends.
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After the installation, you can reconfigure the backends and ports from Centralized
Management > SolutionPacks > Other Components.


Installing and configuring the Frontend host
Learn how to install and configure the frontend host.


Before you begin


l Ensure that you have the details of the Backend host, Additional Backend hosts, and
Collector hosts.


l Minimum System Requirements:


n 64-bit Operating System


n CPU: 4


n Memory: 16 GB


n Disk Space: 150 GB HDD


Procedure


1. Start the installation as described in Installing EMC M&R platform on UNIX.


2. When you are prompted to select the installation type, choose the "frontend" option
and complete the installation.


3. Configure the user process limits as described in Configuring the user process limits
for a Linux installation on page 14 .


4. Set the connections that point to a local MySQL server to point to the primary
backend. In the following files, locate all of the strings like localhost:53306, and
replace the string localhost with the primary backend DNS name (it must be
resolvable):


l /opt/APG/Web-Servers/Tomcat/Default/conf/server.xml
l /opt/APG/Tools/Frontend-Report-Generator/Default/conf/


report-generation-config.xml
l /opt/APG/Tools/Administration-Tool/Default/conf/master-


accessor-service-conf.xml
l /opt/APG/Tools/WhatIf-Scenario-CLI/Default/conf/whatif-


scenario-cli-conf.xml


5. Set non-MySQL localhost connections to point to the new primary backend:


a. Locate and replace the hostname in the strings localhost:48443 in the
following file:


/opt/APG/Web-Servers/Tomcat/Default/conf/Catalina/
localhost/APG.xml


b. Locate and replace the hostname in the strings localhost:52569 in the
following file:


/opt/APG/Web-Servers/Tomcat/Default/conf/Catalina/
localhost/alerting-frontend.xml


c. Locate and replace the hostname in the strings localhost:52569 in the
following file:


/opt/APG/Tools/Frontend-Report-Generator/Default/conf/
report-generation-config.xml
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6. Increase the maximum memory that the Tomcat server can use by locating
memory.max= in the /opt/APG/Web-Servers/Tomcat/Default/conf/
unix-service.properties file and setting it to memory.max=8192.


7. Update the Tomcat service to apply the new memory settings:


#/opt/APG/bin/manage-modules.sh service update tomcat Default


8. Restart the Tomcat service and the webservice-gateway:


#/opt/APG/bin/manage-modules.sh service start tomcat Default
#/opt/APG/bin/manage-modules service.sh restart webservice-gateway 
Default


9. Using a web browser, log in to Centralized Management on the frontend at http://
<frontend-host>:58080/centralized-management.


l User Name = admin


l Password = changeme


At the first login, the Servers Configuration page opens. Register the frontend host by
updating the WS Gateway URL. Replace localhost with the FQDN of the frontend host
and click Save.


10. Go to Configuration > Servers, and then click Register a Server. Register all of the APG
servers that are up and running.


Use the following settings:


l Server HostName – the DNS name of the server


l Gateway URL – https://<server DNS name>:48443/
l User Name – admin


l Password – changeme


11. Click Save.


12. Once you have registered all of the servers, verify that they display in Centralized
Management > Physical Overview without any error messages.


13. ResourceLinks for the timeseries database are now stored in the master database. To
give access to the timeseries database on the primary backend and the additional
backend, update the resources using the manage-resources.sh command:


#/opt/APG/bin/manage-modules.sh service restart all
#/opt/APG/bin/manage-resources.sh list (this will list all the 
resources)
#/opt/APG/bin/manage-resources.sh get "dba/APG-DB" 


a. Check the details of dba/APG-DB and update the connection URL to point to the
primary backend host:


/opt/APG/bin/manage-resources.sh update dba/APG-DB '{
  "type": "jdbc",
  "datasource":   {
    "maxActive": "10",
    "maxIdle": "10",
    "validationQuery": "SELECT 1",
    "testOnBorrow": "false",
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    "testWhileIdle": "true",
    "validationQueryTimeout": "5",
    "timeBetweenEvictionRunsMillis": "10000",
    "minEvictableIdleTimeMillis": "60000",
    "maxWait": "10000",
    "removeAbandoned": "true",
    "removeAbandonedTimeout": "60",
    "logAbandoned": "true",
    "driverClassName": "com.mysql.jdbc.Driver",
    "username": "apg",
    "password": 
"{6230FED930DD59BEB1095D6801AA74E2FC23B2C8B76AFF6447D5C49B84C400
1FDF5B6441DF7CD5CB2B19D4A927C63934}",
    "url": "jdbc:mysql://<FQDN-Primary-Backend>:53306/apg?
autoReconnect=true&connectTimeout=20000&maxReconnects=2"
  },
  "settings": {"cachegrp": "DB"}
}'


b. Update the management resource for the data management tool to communicate
with the backend:


/opt/APG/bin/manage-resources.sh update mgmt/APG-DB '{
  "type": "webservice",
  "connection":   {
    "disableSSLValidation": true,
    "url": "https://<FQDN-Primary-Backend>:48443/Backends/APG-
Backend/apg",
    "user": "admin",
    "password": 
"{68951D237EABAFD17BD2F90B2029E51B9078C3968D27791E745EB38C2F8E4B
7B6351D632200618220667E25792D7E8894330B34886D638E3C3B93856C94998
B9}"
  }
}'


c. Update all of the remaining resources in the same way.


14. Create resources for each of the newly added APG databases on the Additional
Backend with resources names such as dba/APG-DB[1..n] and mgmt./APG-DB[1..n].
Perform this operation every time a new additional backend host is added to the
environment to scale-out backends.


For example, to create a Database resource:


manage-resources.sh create dba/APG-DB[1..n] '{
    "type": "jdbc",
     "datasource":   {
     "maxActive": "10",
     "maxIdle": "10",
     "validationQuery": "SELECT 1",
     "testOnBorrow": "false",
     "testWhileIdle": "true",
     "validationQueryTimeout": "5",
     "timeBetweenEvictionRunsMillis": "10000",
     "minEvictableIdleTimeMillis": "60000",
     "maxWait": "10000",
     "removeAbandoned": "true",
     "removeAbandonedTimeout": "60",
     "logAbandoned": "true",
     "driverClassName": "com.mysql.jdbc.Driver",
     "username": "apg",
     "password": 
"{6230FED930DD59BEB1095D6801AA74E2FC23B2C8B76AFF6447D5C49B84C4001FD
F5B6441DF7CD5CB2B19D4A927C63934}",
     "url": "jdbc:mysql://<FQDN-Additional-Backend>:53306/
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apg[1..n]?autoReconnect=true&connectTimeout=20000&maxReconnects=2"
   },
   "settings": {"cachegrp": "DB"}
 }'


To create a Management Resource:


manage-resources.sh update mgmt/APG-DB[1..n] '{
  "type": "webservice",
  "connection":   {
    "disableSSLValidation": true,
    "url": "https://<FQDN-Additional-Backend>:48443/Backends/APG-
Backend/apg[1..n]",
    "user": "admin",
    "password": 
"{68951D237EABAFD17BD2F90B2029E51B9078C3968D27791E745EB38C2F8E4B7B6
351D632200618220667E25792D7E8894330B34886D638E3C3B93856C94998B9}"
  }
}'


Starting the collector
Learn how to start the collector.


Procedure


1. Install the collector as described in Installing Using the Binary Installer on page 11.


2. Start the collector service:


manage-modules service start all


Configuring the load balancer arbiter
Learn how to configure the load balancer arbiter from Centralized Management. Complete
these steps every time a new backend host is added to the environment to scaleout
backends.


Before you begin


l The connection must point to the FQDN of the primary backend or additional backend
host.


l The listening port must be 2020.


Procedure


1. Log in to Centralized Management at http://<frontend-host>:58080/
centralized-management.


2. Navigate to SolutionPacks > Other Components.


3. Locate the load-balancer-arbiter component and click the Reconfigure button.


4. Click on the drop down against Arbiter configuration and select Add a new arbiter
configuration


a. Update the backend hostname with the DNS name of primary backend host.


b. Change the Web-Service Gateway to the primary backend host.


c. Update the backend database hostname with the DNS name of primary backend
host.
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5. Add a configuration for all the apg backends installed on the additional backend host.
Complete this step whenever a new additional backend host is added to the
environment to scale out backends.


For example:


SolutionPack Reconfiguration Fields on page 101 describes the values that you
should enter for each field on the SolutionPack Reconfiguration page.


6. Click the + button and add an entry for each of the backend instances (apg1, apg2,
apg3 and apg4) created on the additional backend host.


7. Provide the appropriate backend data port, web-service gateway, backend instance
name, and DB connection details for each of the instances.


8. Modify the Alerting data collection section and provide the primary backend DNS
name for Alerting Backend hostname.


9. Modify the Frontend Web service section and provide the frontend DNS name for
Tomcat hostname.


10. Once everything is updated, click Reconfigure.


11. After you have setup the arbiter, check the logs under /opt/APG/Collecting/
Collector-Manager/Load-Balancer/logs to see if all of the APG backend
instances were correctly installed.


For example:


# cat /opt/APG/Collecting/Collector-Manager/Load-Balancer/
logscollecting-0-0.log | grep "LoadFactorDecision::isReady"
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Starting decision with current load 
factor of:
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend1 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend2 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend3 0.0/750000.0 (0.0)
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INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend4 0.0/750000.0 (0.0)
INFO -- [2014-06-05 12:28:44 EDT] -- 
LoadFactorDecision::isReady(): Backend0 595.0/750000.0 
(7.933333333333333E-4)


Configuring Load Balancer Connectors, generic-snmp, and
generic-rsc


Learn how to configure Load Balancer Connectors (LBCs). Complete these steps every
time a new collector host is added to the environment to scale-out collectors.


Before you begin


l The Load Balancer Arbiter is installed on the primary backend with the listener port of
2020.


l The LBCs are installed on all of the collector hosts.


l The LBC listens on port 2020 local on that collector server and communicates with
the Load Balancer Arbiter on the primary backend also using port 2020.


Procedure


1. During the installation of the LBC, when the script asks for the Web-Service
gateway hostname or IP address [localhost], enter the DNS of the
primary backend server where the arbiter is installed.


2. The collector server has the LBC installed by default, but you must reconfigured it to
point it to the primary backend and its arbiter:


a. In Centralized Management > SolutionPacks > Other Components, filter on the
collector name, and click the Reconfigure button for the load-balancer-connector.


b. Update all of the host names and gateway URLs so they point to the primary
backend.


c. Update the Alerting Backend hostname to Primary Backend host and 2010 port.


d. Update the Frontend Web Service to point to the Frontend host.


For example:


e. generic-rsc is installed by default on the collector host. Click the Reconfigure
button and update the Frontend Web Service to point to frontend host. Update the
Topology service question by changing the host name and gateway to point to the
primary backend host.
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f. Click the Reconfigure button for generic-snmp. Update the Frontend Web service to
point to frontend host. Update the Topology service question by changing the host
name and gateway to point to primary backend host


Installing the health collectors
Learn how to install the health collectors. Each server should have a health collector to
monitor and report its state.


Before you begin


The Health Collector on the primary backend must point to the local LBA and its port. In
this installation, the port is 2020.


The first installation of the SolutionPack will install the Health Reports on the frontend
server.


Procedure


1. Log in to the Centralized Management UI.


2. Open SolutionPack Center and select EMC M&R Health.


3. Click Install.


4. On the Select the Components to Install window:


a. Install Pre-configured alerts and the Events block where the primary backend is
located.


b. Install the Data collection block on every host by repeating the installation
procedure for each host.


c. Install Reports on the frontend.


5. On the Data Collection window:


a. Data collection is the local LBC on port 2020.


b. Alerting is on the primary backend.


c. Topology host and gateway is on the primary backend
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CHAPTER 3


Licensing


This chapter includes the following topics:
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l Synchronize licenses on multiple hosts.................................................................50
l Troubleshooting licensing problems......................................................................51
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Licensing Operations
Use Centralized Management user interface to perform licensing management
operations.


These operations include uploading, verifying, deleting, and synchronizing licenses.


Trial licenses
Your software can include all trial licenses or a combination of permanent and trial
licenses.


Licenses that you purchase are permanent. Other software comes with trial licenses.


Trial licenses let you test features in the UI and perform some initial configurations before
full purchase. Trial licenses typically last for 30 days after the installation time. You
cannot copy or regenerate a trial license in the product.


If all of your licenses are trial licenses, including the core software license that includes
the Web Portal feature, the software can lock out all users from accessing the UI when the
trial expires.


License duration
Permanent licenses do not expire. Trial licenses have expiration dates, typically 30 days
after the installation date.


When trial licenses expire, module license checks fail and the modules stop working. If
the Web Portal module fails, you cannot access the product.


Because the License Management UI operates behind the Web Portal module, you must
upload your permanent license file or extended trials before the 30-day license for the
core features expires. Otherwise, the UI locks and you cannot upload the license file.


License purchase
To convert a feature from a trial license into a permanently licensed feature, you need to
purchase a license.


To initiate the purchase of a license for a SolutionPack, visit EMC Online Support using
the following URL:


https://support.emc.com/servicecenter/createSR/


On the page that appears, submit a service request to EMC. Include the SolutionPack
name that you want to purchase.


When all purchasing transactions are complete, EMC sends you instructions for
downloading a regenerated license file for your site that includes the newly purchased
software license. Download the file to a local server, and then follow instructions in 
Upload a new license file on page 49 to upload the new license file.


Note


Until the license is purchased and the new license file is obtained and uploaded, the
SolutionPack is inoperable, unless the 30-day trial license is still in effect.
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Log in with administrator credentials
You must have administrator credentials to perform license management operations.


Procedure


1. Access EMC M&R platform software by typing the following URL in a web browser:


http://frontend-hostname:58080/centralized-management


where frontend-hostname is the server where the frontend module is installed.


The login page opens.


2. Log in with a user account that has administrator credentials.


The Centralized Management UI opens to the Physical Overview page.


3. In the navigation tree in the left pane, click Licenses Management.


The Licenses Listing page opens. Notice the Upload and Synchronize operational
commands at the top of the page.


View license information
You can view license information in two ways. One method displays licenses by host. The
other one shows a centralized view of all licenses.


Procedure


1. Log in with administrator credentials.


2. To view active licenses on a physical host, navigate to Administration > Centralized
Management > Physical Overview > host-name.


3. Click the Licenses tab.


The Licenses tab displays active licenses on that host. It also indicates whether
licenses are permanent or trial, the expiration date for trials, and additional license
properties, if applicable.


4. To view a consolidated list of licenses for all hosts, and to perform license
management operations, in the navigation tree in the left pane, click Licenses
Management.


The Licenses Listing page opens showing all licenses on all servers.
Notice the ELMS permanent license, showing all features included in the license and
the license serial number. Also notice the Upload and Synchronize commands at the
top of the page.


This table displays Information for ELMS licenses related to product name for the
license, SWID (software ID), and serial numbers.


Upload a new license file
To add a new license to your system, such as a newly purchased SolutionPack license,
upload a new license file.


Before you begin


1. Purchase the required licenses.
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2. Download the new license file to a local server, as directed by EMC during the
purchase process.


When you upload a license file, the new file affects all servers capable of using the
licenses.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management


2. In the navigation pane, select Licenses Management.


3. Click Upload at the top of the page.


The License Upload dialog appears.


4. Click Browse and locate the new license file that you downloaded.


5. Click OK.


The system extracts the licenses and displays them in the table on the Licenses
Listing pane.


6. When the License Upload Complete dialog appears, click OK, and then click Continue.


The new license automatically affects all servers capable of using the license.


7. Delete the trial licenses that correspond to newly licensed features, if any.


To delete a trial license, see Delete licenses on page 50.


Delete licenses
You can select and delete specific licenses or delete all licenses. A delete action affects
all servers that use the license.


After you install a permanent license, delete the trial licenses that are covered by the
permanent license.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management


2. In the navigation pane, select Licenses Management.


3. In the Licenses Listing table, select one or more license check boxes.


4. Click Delete.


The Delete command appears below the table. It is dimmed until you select at least
one license.


The system deletes the selected license from all available servers.


Synchronize licenses on multiple hosts
The Synchronize action ensures that all remote hosts have licenses based on those
available on the Centralized Management host.


Certain situations might cause licenses to become out of sync. For example, if a remote
host is unavailable when you perform an upload or a delete operation, those operations
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would not be propagated to the offline server. Another example is if you add a new server
to your configuration, the new server would need licensing information.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management


2. In the navigation pane, select Licenses Management.


3. Click Synchronize at the top of the page.


The system synchronizes the licenses on all remote hosts.


Troubleshooting licensing problems
You can resolve common licensing problems.


Permanent license stops working after host reconfiguration
If you change the configuration of a host, for example, by adding interfaces, removing
interfaces, or changing the operating system, your permanent license might stop working.
If your license does not work, obtain a new host ID and request a new permanent license.


Before you begin


Ensure that you have a login with root, APG, or system administrator privileges to perform
this task. The user apg is the account that the application uses instead of root.


Procedure


1. Log in to the operating system command line on the host server.


2. To obtain the new host ID, run one of the following operating system commands:


Table 4 Host-id commands


Operating system Command


UNIX /opt/APG/bin/manage-licenses.sh host-id


Windows C:\Program Files\APG\bin\manage-licenses.cmd host-
id


The command output is the new host ID.


3. Copy the host ID information to the clipboard or to a text file.


4. To obtain the new license, go to the EMC support site using the following URL:


https://support.emc.com/servicecenter/createSR/


The Create a Service Request page opens.


5. Submit a service request to EMC, asking for a new permanent license file for a new
host. Paste the new host ID into the request.


6. When EMC sends you the new license file, follow the procedure in Upload a new
license file on page 49.
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Users are locked out
If the license for the core software features expires, the system locks users out of the UI.


To recover from this scenario:


1. Obtain a license file with permanent licenses.


2. Install the new license file from the command line. Install license file from the
command line on page 52


3. Restart the Tomcat service. See Restart Tomcat service on page 53.


4. Log in and perform the following tasks:


a. Reinstall the new license file from the Centralized Management UI.


b. Delete the expired trial licenses.


See Reinstall license file and delete trial licenses after lockout on page 53.


Install license file from the command line
You can install a license file from the command line if you are locked out of the UI. Always
use the UI unless you are locked out.


Before you begin


l Ensure that you have an OS account with root, APG, or system administrator
privileges. The application uses the apg account, rather than root.


l Acquire a new license file from EMC and download it to a local server. To request a
new license file, create a Service Request on EMC Online Support.


Procedure


1. Log in to the server where the core software is installed.


2. Copy the new, valid license file to this same server. The file is a .zip file.


3. At the OS command line, navigate to the bin directory.


4. Install the license file using one of the following commands appropriate to your OS:


Table 5 Install license commands


Operating
System


Command


UNIX ./manage-licenses.sh install download_path/license.zip


Windows manage-licenses.cmd install download_path\license.zip


Note


The command installs the license file on this server only.
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Restart Tomcat service
If the Web Portal license expires, you might need to restart the Tomcat service.


Before you begin


1. Install the new license file using operating system commands.


2. Ensure that the library search path is correct on the server that is the host for the core
software. This requirement applies to the libstdc package on a Solaris server and
the libaio package on a LINUX server.


It is only necessary to restart the Tomcat service when the license for a web application,
such as the Web Portal, expires.


Procedure


1. Log in to the server where the core software is installed.


2. At the OS command line, navigate to the bin directory.


3. Run one of the following commands appropriate to the OS:


Table 6 Restart tomcat commands


Operating System Command


UNIX ./manage-modules.sh service restart tomcat


Windows manage-modules.cmd service restart tomcat


The command output starts like this:


* Starting 'tomcat Default'... [ OK ]


Reinstall license file and delete trial licenses after lockout
After you install a permanent license file on the command line, you need to reinstall that
file using the Centralized Management UI to make the license visible in the UI and
available for distribution to other remote servers. You also need to delete the expired trial
licenses.


Procedure


1. Open a browser and log in to Centralized Management using the following URL:


http://frontend-hostname:58080/centralized-management


2. In the navigation pane, select Licenses Management.


3. Click Upload at the top of the page.


The License Upload dialog appears.


4. Click Browse and locate the new license file.


5. Click OK.


The system extracts the licenses and displays them in the table on the Licenses
Listing pane.


6. When the License Upload Complete dialog appears, click OK, and then click Continue.


The new license automatically affects all servers capable of using the license.
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7. In the License Listing table, select all expired trial licenses by clicking the appropriate
check boxes.


8. Click Delete.


The Delete command appears at the bottom of the page, below the table of licenses.


The delete action automatically affects all available servers.


Module does not start or has no license
If a component reports that it has no license or does not start, verify the licenses on the
physical host.


Procedure


1. Log in to the Centralized Management UI using the following URL:


http://frontend-hostname:58080/centralized-management


2. Navigate to Physical hosts > host-name > Licenses.


The page shows all licenses active on this local host.


3. Inspect the Expiration column for the termination date of each license.
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CHAPTER 4


Upgrading from 6.5u4 onwards to 6.7u1
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Overview
This chapter applies to binary-only installations of 6.5u4 onwards upgrading to 6.7u1.


If you want to update a single SolutionPack to receive the benefit of a required fix or
feature, refer to Updating SolutionPacks and Other Components on page 83.


Ensure your environment meets the operating system support requirements described in
the EMC M&R 6.7u1 Release Notes.


l If you want to update a single SolutionPack to receive the benefit of a required fix or
feature, refer to the Updating SolutionPacks and Other Components chapter.


l From EMC M&R 6.6.x onwards, if you use ViPR SRM SolutionPacks in addition to
Service Assurance Suite SolutionPacks, you must upgrade using binary installation
files from both products. Follow this order when upgrading:


1. Upgrade the Presentation Service Assurance Manager first. The EMC Smarts
Installation Guide for SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers and the
article, How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts provide
more information.


2. Upgrade the EMC M&R system to 6.7u1 or higher.


3. Upgrade the Service Assurance Suite SolutionPacks.


4. Upgrade the ViPR SRM system to 4.0.x.


5. Upgrade the ViPR SRM SolutionPacks.


Note


Upgrading to ViPR SRM 4.0 using the System Upgrade UI, EMC VIPR SRM: Upgrading
version 3.5.x to 3.7.2 or EMC ViPR SRM: Upgrading version 3.6.1, 3.6.2, or 3.6.3 to 3.7.2
provide more information for ViPR SRM customers.


Required tools
Ensure that you have the necessary tools.


l WinSCP or equivalent


l Putty/SSH


l Remote Desktop


Required credentials
Gather the necessary credentials.


l root/administrator credentials for all of the servers


l ESX server credentials (if appropriate)


l SMI array hosts (if also using ViPR SRM SolutionPacks)


l Brocade SMI hosts (if also using ViPR SRM SolutionPacks)
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Verifying and documenting the current status of the environment
Verify and document the current status of the environment before starting the upgrade
process. This will help you assess the success of the upgrade.


Before you begin


Refer to the EMC Service Assurance Suite SolutionPack Performance and Scalability
Guidelines for details about determining configuration size.


Note


The Topology-Mapping-Service module, by default, is configured with 2GB max heap. For
those installed on the Frontend and Backend hosts, actual maximum consumption is
under 128MB. The additional memory need not be considered for sizing calculations. The
Topology-Mapping-Service installed on the Collector host should have its full 2GB max
heap considered.


Procedure


1. Look for blank reports and graphs. Determine if there are any blank reports caused by
collection errors. Resolve any issues or document them for later follow up.


2. Look for broken links and resolve any issues or document them for later follow up.


3. Validate that end-to-end topology is working. Resolve any issues.


4. Review the existing backend and databases. Check Report Library > EMC M&R Health >
Stress > Components > Backends and Report Library > EMC M&R Health > Stress >
Components > Databases.


l Check backend thresholds to verify that you have room to accommodate new
sizing


l Add additional backends and databases as required.


l Refer to the Watch4net Database Split v1.2 document for help if you need to
manually move data to redistribute the metrics.


5. Review and document any customizations.


For example:


l Polling intervals


l Timeout values


After you finish


Engage EMC Support to resolve any observed issues prior to proceeding with the
upgrade.


Saving the Java certificates file
If you are upgrading from EMC M&R 6.5u4, the certificates file provided with the Java
installation is overwritten during the upgrade. If you have custom certificates stored in
this file (such as for an LDAP server configuration), those certificates will also be
overwritten. Starting in version 6.6u1, the EMC M&R platform software provides a new
means for importing those certificates so they are not lost during the upgrade.


If you have previously imported your LDAP SSL certificates, EMC recommends that you
allow the upgrade to overwrite the certificates. Once this is done, you can import the
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certificates again using the new method (described in the "Importing custom certificates
into the JRE" section of the EMC M&R Security Configuration Guide. The new method not
only survives upgrades, but also improves overall security as any changes to the default
trust store that ships with Java will be reflected in your environment.


If you are unable to import the certificates using this new method, you may manually
migrate the certificates, but you will not gain the benefits of the new procedure. To
manually migrate the certificates, you must save the certificates file before the upgrade,
and restore the file after the upgrade.


Procedure


1. To save the certificates file before the upgrade, go to this directory: ${APG INSTALL
DIRECTORY}/Java/Sun-JRE/<Java version>/lib/security.


For example, cd /opt/APG/Java/Sun-JRE/<Java version>/lib/
security.


2. Copy the cacerts file to a safe place. (Do not use the Java installation directory
because it will be deleted and replaced by the new installation.)


For example, cp cacerts /var/tmp/cacerts.


Importing Java certificates
If you are upgrading from EMC M&R 6.6.x, you may make use of a new method for
importing certificates into the trust store for use in LDAP, device discovery, or other
secure communication. If you are leveraging SSL communications and have previously
imported certificates into the product to enable this, you may need to perform a one-time
operation to re-import them using this new method. Once you have done this, the import
will persist across future upgrades.


Note


If you have already imported the certificates using this method, you do not need to import
them again. This procedure will validate that you have done so.


Procedure


1. Check to see if there are any certificate files located at <APG_HOME>/Java/Sun-
JRE/<version>/customcerts. If so, your certificates will be automatically
migrated during the update, and you can skip the next step.


2. If there are not any certificate files in this location, then any certificates you previously
added manually will not persist across the upgrade to EMC M&R 6.7u1. You should
perform a one-time re-import of the certificates file as described in the "Importing
custom certificates into the JRE" section of the EMC M&R Security Configuration Guide.


Checks for the SolutionPack for Physical Hosts
Hosts discovered with a private/public key pair will fail if the Generic-RSC instance
(directory) created under "Remote-Shell-Collector" directory is cleaned up manually from
the collector appliance. A sample path to the Generic-RSC instance on a Unix Collector
is /opt/APG/Collecting/Remote-Shell-Collector/Generic-RSC.


Upgrading from 6.5u4 onwards to 6.7u1


58 EMC Service Assurance Suite 9.4.2  Installation and Configuration Guide for EMC M&R







Updating WinRM URL prefixes
Prior to release of EMC M&R 6.6u1, if you discovered Windows hosts using Custom
WinRM URL prefixes, you had to add the custom URL prefix to module.properties of
Generic-RSC Collector Manager. These changes are no longer applicable after the
upgrade.


Procedure


1. To resolve this issue, enter the custom WinRM URL prefix along with the host
credentials.


Deleting backup schedules and scheduled reports from the DPA
server


You should remove backup schedules and scheduled reports from the DPA server before
the upgrade.


Procedure


1. If Avamar is discovered:


a. Navigate to Reports > Report Jobs > Schedule Report, and delete the following
reports:


l W4N-Avamar All Jobs Report


l W4N-Avamar Client Configuration Report


l W4N-Avamar Restore Details Configuration Report


l W4N-Avamar Server Configuration Report


b. Navigate to Admin > System > Manage Schedules, and delete the following
schedule:


l Avamar-1HourInterval


2. If NetBackup is discovered:


a. Navigate to Reports > Report Jobs > Schedule Report, and delete the following
reports:


l W4N-NetBackup All Jobs Report


l W4N-NetBackup Client Configuration Report


l W4N-NetBackup Disk Volume Configuration Report


l W4N-NetBackup Disk Volume Status Report


l W4N-NetBackup Restore Details


l W4N-NetBackup Server Configuration Report


l W4N-NetBackup Storage Unit Configuration Report


b. Navigate to Admin > System > Manage Schedules, and delete the following
schedule:


l NBU-1HourInterval
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Updating the Centralized Management module
To get the new System Upgrade interface in Centralized Management to upgrade all of the
servers from a single UI, you must update the Centralized Management module to the
latest version.


Note


This section is only required if you are upgrading a binary-only installation of EMC M&R
6.5.x..


Procedure


1. Download the Centralized Management package from support.emc.com.


Option Description


Linux centralized-management-<version number>-linux-
x64.pkg


Windows centralized-management-<version number>-windows-
x64.pkg


2. From Centralized Management, click Packages Management on the left-hand pane.


3. On the Packages Listing page, click the Upload button.


4. Click Browse, and select the Centralized Management package file.


5. Click OK.


6. Click Continue.


The package is uploaded to the server.


7. On the left-hand pane, navigate to Physical Overview > Front End > Modules > Web-
Applications > Centralized Management.


8. Click Manually Update to Latest Version.
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9. Click Update. Answer yes to both of the questions about online-update-check.task.


10. Restart the tomcat service.


a. From Centralized Management, navigate to Physical Overview > Front End.


b. On the Services tab, click the Tomcat module.


c. Click Restart.
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Upgrading the system
Learn how to upgrade the system with the System Upgrade wizard.


Before you begin


If you have enabled Online Update, the files have automatically been staged, and you
can skip steps 1, 3, and 4. For information about enabling and configuring Online
Update, refer to Automating the Download of Updates on page 89.


Procedure


1. Download the core update file for each of your deployed architectures from 
support.emc.com.


Option Description


Linux (binary only) EMC_MnR_6.7.1_Linux_64-bit_Update_File.zip
Windows EMC_MnR_6.7.1_Windows_64-bit_Update_File.zip


2. From Centralized Management, click Configuration > System Upgrade.


If an upgrade package is currently being downloaded via Online Update, wait until the
download is complete before proceeding to the next step.


3. For your Linux and/or Windows deployments, click Browse and select the core update
file.
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4. Click Upload Content.


5. The system displays a message about ensuring that there is minimum of 5 GB disk
space on the servers. Click OK.


The system upgrade files are uploaded to Centralized Management and non-
disruptively distributed to all of the servers in the deployment. This process may take
several minutes.


6. When you are ready to proceed with the upgrade, click Go to maintenance mode.


Maintenance mode begins, the front end becomes unavailable, and you are
redirected to the Platform Upgrade page. Any users who try to access the front end will
receive a message that it is in maintenance mode and has been temporarily disabled.


7. When the system has completed the validation checks, click Launch upgrade.
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The upgrade begins. After several minutes, the Upgrade status displays.


Note


You may need to manually refresh your browser to see the Upgrade status page.


When the upgrade is complete, the system displays a green check mark next to each
node and a success message at the top of the window.
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8. Click Exit.


9. Click OK.


The system restarts the front end, and it is now available to users.


10. Verify that all of the services are running on each host by checking Centralized
Management > Phyical Overview > <host> > Services.


Note


It is normal for the Topology-Mapping Service on the primary backend, the frontend,
or the additional backend to remain stopped at this point. The service will start
automatically when the SolutionPack for EMC M&R Health is upgraded on these
systems.


11. In Windows deployments, the Java module is updated during the upgrade, but the old
version of Java is not removed. EMC recommends that you remove the older version of
Java. Only the latest Java version folder should be kept. Remove the Java files as
described in this message:


Some files were left behind after the update of Java... 
Please manually remove directory <version number> from the path 'C:
\Program Files\APG\Java\Sun-JRE\<version number>’


Restoring the Java certificates file
If you are upgrading from EMC M&R 6.5.x, and you saved the certificates file, you now
have two choices.


You may either restore the file manually, or follow the directions in the "Importing custom
certificates into the JRE" section of theEMC M&R Security Configuration Guide. This allows
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importing these certificates using the new mechanism. EMC recommends this, but if you
are unable to follow that procedure, you may restore the certificates file using the
following steps.


Procedure


1. Go to the directory where the upgraded version of Java was installed: ${APG
INSTALL DIRECTORY}/Java/Sun-JRE/<new Java version>/lib/
security
For example, cd /opt/APG/Java/Sun-JRE/<new Java version>/lib/
security


2. Save the current certificates file.


For example, cp cacerts cacerts.bak
3. Restore the original cacerts file containing your certificates.


For example, cp /var/tmp/cacerts cacerts
4. Restart the tomcat service.


For example, ${APG INSTALL DIRECTORY}/bin/manage-modules.sh
service restart tomcat Default
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CHAPTER 5


Upgrading from 6.5 through 6.5u3 to 6.7u1


This chapter includes the following topics:
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Overview
This chapter applies to binary-only installations of 6.5 through 6.5u3 upgrading to 6.7u1.


Although the upgrade procedures in this chapter work for 6.5.x versions of EMC M&R,
there is an alternative system upgrade feature that allows you to upgrade all servers from
a single UI. This "one-click" system upgrade feature is available only for version 6.5u4
onwards.


Ensure your environment meets the operating system support requirements described in
the EMC M&R 6.7u1 Release Notes.


l If you are upgrading a binary-only installation of EMC M&R 6.5u4 onwards, refer to 
Upgrading from 6.5.x onwards to 6.7u1 on page 55


l If you want to update a single SolutionPack to receive the benefit of a required fix or
feature, refer Updating SolutionPacks and Other Components on page 83.


l From EMC M&R 6.6 onwards, if you use ViPR SRM SolutionPacks in addition to
Service Assurance Suite SolutionPacks, you must upgrade using binary installation
files from both products. Follow this order when upgrading:


1. Upgrade the Presentation Service Assurance Manager first. The EMC Smarts
Installation Guide for SAM, IP, ESM, MPLS, NPM, OTM, and VoIP Managers and the
article, How to Set Up SAM, EMC M&R, and the SolutionPack for EMC Smarts provide
more information.


2. Upgrade the EMC M&R system to 6.7u1 or higher.


3. Upgrade the Service Assurance Suite SolutionPacks.


4. Upgrade the ViPR SRM system to 4.0.x.


5. Upgrade the ViPR SRM SolutionPacks.


Note


Upgrading to ViPR SRM 4.0 using the System Upgrade UI, EMC VIPR SRM: Upgrading
version 3.5.x to 3.7.2 or EMC ViPR SRM: Upgrading version 3.6.1, 3.6.2, or 3.6.3 to 3.7.2
provide more information for ViPR SRM customers.


Required tools
Ensure that you have the necessary tools.


l WinSCP or equivalent


l Putty/SSH


l Remote Desktop


Required credentials
Gather the necessary credentials.


l root/administrator credentials for all of the servers


l ESX server credentials (if appropriate)


l SMI array hosts (if also using ViPR SRM SolutionPacks)


l Brocade SMI hosts (if also using ViPR SRM SolutionPacks)
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Verifying and documenting the current status of the environment
Verify and document the current status of the environment before starting the upgrade
process. This will help you assess the success of the upgrade.


Before you begin


Refer to the EMC Service Assurance Suite SolutionPack Performance and Scalability
Guidelines for details about determining configuration size.


Note


The Topology-Mapping-Service module, by default, is configured with 2GB max heap. For
those installed on the Frontend and Backend hosts, actual maximum consumption is
under 128MB. The additional memory need not be considered for sizing calculations. The
Topology-Mapping-Service installed on the Collector host should have its full 2GB max
heap considered.


Procedure


1. Look for blank reports and graphs. Determine if there are any blank reports caused by
collection errors. Resolve any issues or document them for later follow up.


2. Look for broken links and resolve any issues or document them for later follow up.


3. Validate that end-to-end topology is working. Resolve any issues.


4. Review the existing backend and databases. Check Report Library > EMC M&R Health >
Stress > Components > Backends and Report Library > EMC M&R Health > Stress >
Components > Databases.


l Check backend thresholds to verify that you have room to accommodate new
sizing


l Add additional backends and databases as required.


l Refer to the Watch4net Database Split v1.2 document for help if you need to
manually move data to redistribute the metrics.


5. Review and document any customizations.


For example:


l Polling intervals


l Timeout values


After you finish


Engage EMC Support to resolve any observed issues prior to proceeding with the
upgrade.


Saving the Java certificates file
If you are upgrading from EMC M&R 6.5u4, the certificates file provided with the Java
installation is overwritten during the upgrade. If you have custom certificates stored in
this file (such as for an LDAP server configuration), those certificates will also be
overwritten. Starting in version 6.6u1, the EMC M&R platform software provides a new
means for importing those certificates so they are not lost during the upgrade.


If you have previously imported your LDAP SSL certificates, EMC recommends that you
allow the upgrade to overwrite the certificates. Once this is done, you can import the
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certificates again using the new method (described in the "Importing custom certificates
into the JRE" section of the EMC M&R Security Configuration Guide. The new method not
only survives upgrades, but also improves overall security as any changes to the default
trust store that ships with Java will be reflected in your environment.


If you are unable to import the certificates using this new method, you may manually
migrate the certificates, but you will not gain the benefits of the new procedure. To
manually migrate the certificates, you must save the certificates file before the upgrade,
and restore the file after the upgrade.


Procedure


1. To save the certificates file before the upgrade, go to this directory: ${APG INSTALL
DIRECTORY}/Java/Sun-JRE/<Java version>/lib/security.


For example, cd /opt/APG/Java/Sun-JRE/<Java version>/lib/
security.


2. Copy the cacerts file to a safe place. (Do not use the Java installation directory
because it will be deleted and replaced by the new installation.)


For example, cp cacerts /var/tmp/cacerts.


EMC M&R upgrade workflow
You can upgrade the EMC M&R platform in a Linux, Windows, or mixed operating system
environment. Ensure you back up all servers before starting the update process.


Ensure new software is downloaded to all EMC M&R servers
If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed new EMC M&R modules to each server. You do still
have to run the launch-update script to upgrade the modules. Automating the Download
of Updates on page 89 provides information about configuring your deployment to use
the online update feature.


Upgrade workflow


1. Update module-manager and core modules by running the update script on each
server. Preparing for the upgrade of binary installations in Linux deployments  on
page 71 or Preparing for the upgrade of binary installations in Windows
deployments  on page 73


2. Restoring the Java certificates file on page 75


3. Synchronizing packages on page 76


4. Updating all components on page 76


5. Checking the status of remote host services on page 77


l Reconfiguring a SolutionPack  on page 78


6. Increasing the heap size for the Tomcat service on page 78


7. Editing new Actions scripts to support alerting changes on page 78


8. Updating the SNMP collections on page 79


9. Configuring virus-scanning software (Windows) on page 79


10. Restoring timeout values on page 80


11. Reviewing report customizations on page 80


l Removing an obsolete Default ReportPack on page 80
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12. Validating the environment on page 81


Mixed operating system deployments
To update a mixed-operating system deployment (non-vApp Linux and Windows), you
must perform the steps for single operating system deployments separately on each
platform.


For example, a Linux deployment with one Windows collector would require updating the
Linux machine hosting Centralized Management and the Windows machine where the
collector is running.


Preparing for the upgrade of binary installations in Linux
deployments


Before you can upgrade the EMC M&R platform in your Linux environment, you must run
the setup script on each server.


Before you begin


Note


If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed the modules to each server, and you can skip this
section. For information about enabling and configuring Online Update, refer to Automate
the Download of Updates.


l Identify the servers that you plan to upgrade and back up all necessary files.


l Ensure that a login with root credentials is available.


l If you have not enabled Online Update, download the Linux setup script (<product
name>_<version number>_Linux_x86_64.sh) from your product page on the
EMC support website.


Procedure


1. Use a tool such as SCP to upload the setup script to a temporary directory on every
server that you plan to upgrade.


2. Log in to the server as root.


3. Navigate to the temporary directory and make the setup script executable. For
example:


chmod +x EMC_MnR_6.7.1_Linux_64-bit_Setup_File.sh
4. Run the setup script for your product. For example:


./EMC_MnR_6.7.1_Linux_64-bit_Setup_File.sh
5. Answer the questions as directed. For example, accept the EULA and use the defaults


for the installation directory and the package installation. A warning message may
display when modules are updated. For example,


 " WARNING message will be provided for those module which has an 
update"


For example
Identifier                          Instance               : 
Category         Module Name                         Version 
Revision OS-Arch   Status
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   ----------------------------------- ---------------------- - 
---------------- ----------------------------------- ------- 
-------- --------- ---------------------------
 * active-cache                        Alert-Consolidation    : 
Event-Processing Active-Cache                        v1.1    
r31744   linux-x64
 * active-cache                        emc-smarts             : 
Event-Processing Active-Cache                        v1.1    
r31744   linux-x64
 ! administration-tool                 Default                : 
Tools            Administration-Tool                 v1.3u1  
r53752   linux-x64 can be updated to v1.4u1
 ! alert-consolidation                 Alert-Consolidation    : 
Block            alert-consolidation                 v3.6.1  
r11870             can be updated to v4.0
 ! alerting-backend                    Default                : 
Backends         Alerting-Backend                    v3.8u1  
r54289   linux-x
 
 Warning: if a newer version of the module-manager is available, 
please make sure it gets updated before any other module.


Results


Your system is now prepared for update.


After you finish


Repeat these steps for each Linux server you want to upgrade.


If you are upgrading from 6.5.1, delete these SolutionPack packages from Centralized
Management > Packages Management before continuing the update process:


l SolutionPack for Nokia Siemens Network (NSN GGSN)


l SolutionPack for Cisco CUCM version 1.1 (cisco-voip-cucm version 1.1).


Updating core modules in a Linux environment
Update core modules using the launch-update script.


During this step, you will update the core modules on all of the servers. Core modules
must be updated prior to any others, and they must be updated from the command line
using the launch-update script.


Procedure


1. The launch-update script is delivered through the module-manager, so update the
module-manager module by typing the following command from the /opt/APG/bin
directory:


./manage-modules.sh update module-manager
2. Navigate to the <install directory>/Tools/Module-Manager/
1.8u1/bin directory.


3. Change the permissions for the launch-update.sh script:


chmod u+x launch-update.sh
4. Run ./launch-update.sh


You can run this script on multiple servers at the same time.


On the frontend server, you may see a message about frontend search being
deprecated. EMC recommends that you select, "yes."


5. Review the modules that will be updated and the SolutionPacks that will be
reconfigured. At the Proceed? prompt, press Enter to launch the update.
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The script starts updating modules. Let the script run uninterrupted. Once completed,
the script lists which modules and SolutionPacks were updated and reconfigured
successfully.


All modules except block-type modules are updated by the script. Block-type modules
are updated later through the UI.


Note


It is normal for the Topology-Mapping Service on the primary backend, the frontend,
or the additional backend to remain stopped at this point. The service will start
automatically when the SolutionPack for EMC M&R Health is upgraded on these
systems.


Preparing for the upgrade of binary installations in Windows
deployments


Before you can upgrade the EMC M&R platform in your Windows environment, you must
run the setup executable on each server.


Before you begin


Note


If you have enabled Online Update for your system, the automatic update process has
already downloaded and distributed the modules to each server, and you can skip this
section. For information about enabling and configuring Online Update, refer to Automate
the Download of Updates.


l Identify the servers that you plan to upgrade and back up all necessary files.


l Ensure that login credentials with System Administrator permissions are available.


l If you have not enabled Online Update, download the Windows executable, for
example, EMC_MnR_6.7.1_Windows_64-bit_Setup_File.exe, from your
product page on the EMC support website. http://support.emc.com.


l Place the Windows installation binary setup script in a temporary folder on every
server that you plan to upgrade.


Procedure


1. Double-click the executable file.


2. Click Next.


3. Read and accept the End User License Agreement. Click I Agree.


4. Press Enter to accept the default installation folder of C:\Program Files\APG, or
specify a different directory.


5. Press OK to install the new packages in the C:\Program Files\APG\Tools
\Module-Repository directory. A warning message may display when modules
are updated. For example,


 " WARNING message will be provided for those module which has an 
update"


For example
Identifier                          Instance               : 
Category         Module Name                         Version 


Upgrading from 6.5 through 6.5u3 to 6.7u1


Preparing for the upgrade of binary installations in Windows deployments      73



http://support.emc.com





Revision OS-Arch   Status
   ----------------------------------- ---------------------- - 
---------------- ----------------------------------- ------- 
-------- --------- ---------------------------
 * active-cache                        Alert-Consolidation    : 
Event-Processing Active-Cache                        v1.1    
r31744   linux-x64
 * active-cache                        emc-smarts             : 
Event-Processing Active-Cache                        v1.1    
r31744   linux-x64
 ! administration-tool                 Default                : 
Tools            Administration-Tool                 v1.3u1  
r53752   linux-x64 can be updated to v1.4u1
 ! alert-consolidation                 Alert-Consolidation    : 
Block            alert-consolidation                 v3.6.1  
r11870             can be updated to v4.0
 ! alerting-backend                    Default                : 
Backends         Alerting-Backend                    v3.8u1  
r54289   linux-x
 
 Warning: if a newer version of the module-manager is available, 
please make sure it gets updated before any other module.


Your system is now prepared for update.


After you finish


Repeat these steps for each Windows server you want to upgrade.


If you are upgrading from 6.5.1, delete these SolutionPack packages from Centralized
Management > Packages Management before continuing the update process:


l SolutionPack for Nokia Siemens Network (NSN GGSN)


l SolutionPack for Cisco CUCM version 1.1 (cisco-voip-cucm version 1.1).


Updating core modules in a Windows environment
Update core modules using the launch-update script.


During this step, you will update the core modules on all of the servers. Core modules
must be updated prior to any others, and they must be updated from the command line
using the launch-update script.


Procedure


1. Stop all of the services by typing the following command from the C:\Program
Files\APG\bin directory:


manage-modules.cmd service stop all
2. Use Windows Task Manager to verify that all of the APG services have stopped.


Manually stop any services that are stuck in the “Stopping” state for more than a few
minutes.


3. The launch-update script is delivered through the module-manager, so update the
module-manager module by typing the following command from the C:\Program
Files\APG\bin directory:


manage-modules.cmd update module-manager
4. Launch the script from <install directory>\Tools\Module-Manager
\1.8u1\bin by running launch-update.cmd.


5. Review the modules that will be updated and the SolutionPacks that will be
reconfigured.
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6. At the Proceed? prompt, press Enter to launch the update.


The script starts updating modules. Let the script run uninterrupted. Once completed,
the script lists which modules and SolutionPacks were updated and reconfigured
successfully.


7. To review the list of installed modules and their update status, type this command
from the C:\Program Files\APG\bin directory:


manage-modules.cmd list installed


At this stage of the upgrade, only a few block-type modules should need to be
updated. These will be updated later through the UI.


After you finish


After the launch-update script runs, the Windows collector indicates successful update of
the Java module. If you are upgrading from EMC M&R 6.5u1, the older version of Java is
not removed. You must manually remove the older version of Java after a Windows
upgrade.


Note


It is normal for the Topology-Mapping Service on the primary backend, the frontend, or
the additional backend to remain stopped at this point. The service will start
automatically when the SolutionPack for EMC M&R Health is upgraded on these systems.


Deleting old Java files after Windows update
You must remove old Java files after running the launch-update script.


Before you begin


After the launch-update script runs, the Windows collector indicates successful
update of the Java module, but the older version of Java may not have been removed. If
the old version remains, you must manually remove the Java directory as described in
this message:


Some files were left behind after the update of Java...
Please manually remove directory 8.0u25 from the path 'C:\Program 
Files\APG\Java\Sun-JRE\8.0u25’


Restoring the Java certificates file
If you are upgrading from 3.6.x, and you saved the certificates file, you now have two
choices.


You may either restore the file manually, or follow the directions in the "Importing custom
certificates into the JRE" section of theEMC M&R Security Configuration Guide. This allows
importing these certificates using the new mechanism. EMC recommends this, but if you
are unable to follow that procedure, you may restore the certificates file using the
following steps.


Procedure


1. Go to the directory where the upgraded version of Java was installed: ${APG
INSTALL DIRECTORY}/Java/Sun-JRE/<new Java version>/lib/
security
For example, cd /opt/APG/Java/Sun-JRE/<new Java version>/lib/
security
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2. Save the current certificates file.


For example, cp cacerts cacerts.bak
3. Restore the original cacerts file containing your certificates.


For example, cp /var/tmp/cacerts cacerts
4. Restart the tomcat service.


For example, ${APG INSTALL DIRECTORY}/bin/manage-modules.sh
service restart tomcat Default


Synchronizing packages
Retrieve all software packges from the remote servers before updating SolutionPacks and
other components.


Procedure


1. Navigate to the packages management page: http://<Frontend IP
address>:58080/centralized-management/#/packages


2. Click the Synchronization button.


3. Select Retrieve all the packages from the remote servers and click OK.


4. Wait for synchronization to complete before proceeding to the next step.


Updating all components
Update SolutionPacks and all other components to the latest software version.


Before you begin


Before updating all components, ensure you synchronized the packages and selected
Retrieve all the packages from the remote servers.


Procedure


1. Navigate to the Installed SolutionPacks page: http://<Frontend IP
address>:58080/centralized-management/#/sp


2. Click the Update All Components button in the top-right corner of the page.


When upgrading from 6.5.x, the Initialization window opens and lists the number of
components from SolutionPacks that will be updated to the latest version.


3. Click Next.


A Configuration window opens. Carefully review the selections to make sure the
configuration details for the components and SolutionPacks are correct. Modify any
configurations that are not set correctly. When you have finished configuring a
component, click Next to move on to the next component.


a. If necessary, edit the entry for the Load Balancer Connector on Collector hosts.
Ensure the Web-Service Gateway points to the host where the Load-Balancer
Arbiter is installed. This is normally the primary backend host. Set the Arbiter Web-
Service Instance to the Load Balancer.


b. After you have configured every component on the list, click Next to open the
Confirmation window.


4. A Confirmation window opens and lists all of the components that will be updated.
Confirm that all of the components are correctly listed.
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5. Click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update.


Note


Do not close the browser window during this step.


Note


The update process detects if any manual edits were made to the SolutionPack files. If
a manually edited file is compatible with the new version of the SolutionPack, it will
be reused and the system will display a message to let you know. If a manually edited
file is not compatible with the new version of the SolutionPack, the system will back
up the file and display a warning message that indicates the name and location of the
incompatible file. The backed up files are saved in their current directory with the
following format: <file-name>-old-<version>_<date>.<ext>
Messages about an incompatible tmsconfig file can safely be ignored. Similar
warnings while updating generic-snmp about incompatible files for module ‘snmp-
collector’ can also safely be ignored.


6. After the Results window opens, use the drop-down menu to check the status of each
component. Any manually edited files that were backed up by the system will be
displayed under “Updated with warnings."


After you finish


If you forgot to retrieve all packages in the Synchronize Packages prerequisite, you can do
it now. But then you must repeat the Update All Components procedure before continuing
with the upgrade.


Checking the status of remote host services
The remote host services should start automatically after an upgrade. Check the status of
the services and restart them manually if they are not running.


Before you begin


Check that all services have started on each of the hosts:


1. Navigate to Centralized Management > Physical Overview.


2. For each host, click the host name.


3. Verify that the status for each service is Started.


If a service did not start automatically, restart the service manually.


Procedure


1. Click the name of the service.


2. Click Start.


If successful, the Service Status changes to Started. If the service does not start,
review the log to determine the cause. The issue may be a misconfigured option that
can be resolved by reconfiguring the SolutionPack settings and manually starting the
service again.
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Reconfiguring a SolutionPack
Reconfigure a SolutionPack when you want to refresh existing settings or make changes
to settings.


Procedure


1. Navigate to Centralized Management.


2. Click the SolutionPacks node on the left panel to display the existing installed
SolutionPacks.


3. Click the SolutionPack to access its SolutionPackBlocks.


4. Locate the instance that you want to reconfigure. For SolutionPackBlocks that are a
component of a SolutionPack, select the SolutionPack, and then locate the instance
on the Properties page.


5. Edit the settings by clicking the Pencil icon next to the SolutionPackBlock.


6. Refresh the settings by clicking Reconfigure.


Increasing the heap size for the Tomcat service
Increase the heap size for the Tomcat service on the frontend to 8 GB.


Procedure


1. Navigate to Centralized Management > Physical Overview > Front End.


2. On the Services tab, click the Tomcat module.


3. Click Configure service.


4. From the Available memory for the service drop-down menu, select Custom.


5. In the max field, type 8, and select GB from the drop down menu.


6. Click Save.


Editing new Actions scripts to support alerting changes
Edit Actions on the Frontend host to send events to the machine on which the event-
processing-manager of the alerting-consolidation module is configured.


Perform this task after a manual installation or upgrade of multiple servers.


Procedure


1. For Linux, edit this file: /opt/APG/Custom/WebApps-Resources/Default/
actions/event-mgmt/linux/conf


2. For Windows, edit this file: Program Files\APG\Custom\WebApps-
Resources\Default\actions\event-mgmt\windows\conf.cmd


3. Replace 127.0.0.1 with the primary Backend IP address.


### For vApp distribution, this should get replaced automatically. 
For Software based installed, please change the value of 127.0.0.1 
to the server where your alert consolidation is running 
PRIMARYBACKEND=127.0.0.1
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Updating the SNMP collections
Learn how to update the SNMP collections and synchronize the configuration.


Procedure


1. Log into the device discovery web interface at http://<Frontend IP
address>:58080/device-discovery.


(On the Administration Dashboard, Device Discovery has been renamed SNMP Device
Discovery.)


2. Click Collectors in the left-hand pane.


3. On the Collectors page, click the checkbox for each collector.


4. Click the Delete icon.


5. Cick New Collector.


6. Retain the values for Network interface and Collector Port unless you have changed
the port configuration.


7. The Collector IP Address must be the address of the Generic-SNMP collector’s IP
address where the collection for the SNMP-based discovery is located.


8. On the collectors, click Send configurations to the 1 selected collector(s).


9. Verify that all of the new capabilities are shown correctly against the collector.


10. On the Dashboard, click Discover capabilities from all the approved devices to ensure
that the SNMP masks have gone into effect after the update.


11. On the Dashboard, examine the Device Distribution section. If any collectors are not
synchronized, this section will contain a warning such as “1 collector(s) configuration
not synchronized.”


12. If any of the collectors are not synchronized, click the Distribute all approved
devices… button.


13. Click Send the generated configurations on all available collectors.


After you confirm that the collector configurations are synchronized, navigate through
the UI and review your Reports, SolutionPacks, and other features. One way to check
the health of the system is to look at the reports in the EMC Watch4net Health
SolutionPack.


In order for new data to display in the UI, three polling cycles must pass and the
import-properties-Default task must have run.


Configuring virus-scanning software (Windows)
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.


Disable virus scanning on the main APG directory after installing the MySQL Server. To
prevent scanning of the temporary files, configure a separate temporary directory for
MySQL temporary files. Add this directory to the virus scanning exclusion list.
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Procedure


1. Add a configuration option for the tmpdir parameter to your my.ini configuration
file.


Restoring timeout values
Customized timeout values are overwritten with a default value during the upgrade, and
the system backs up the xml files that contained customized values.


Procedure


1. On Linux, run the following command on each server to find the files with values that
changed: find / -name *old*2016* -print


2. On Windows, use Windows Explorer on each server to locate the files.


After the upgrade, you must manually compare the old files to the new files and
restore the desired values accordingly.


Reviewing report customizations
After an upgrade, you must decide whether to use a saved reportpack or the new one.


Report customizations are maintained during the upgrade (under “My Reports”), but you
will need to decide whether to use the saved reportpack or the new one. New metrics to a
report are not merged with the old report, so you must manually add any new metrics to
the old reports.


Removing an obsolete Default ReportPack
After an upgrade, you may see duplicate nodes in the navigation tree. Delete the obsolete
Default ReportPack to remove the duplicate nodes.


When you install or update the Report block of any SolutionPack, a generic-report module
installs a default ReportPack template. This process does not remove or update an
existing default ReportPack, and you may see duplicate node entries in the navigation
tree as a result.


Procedure


1. Check the new reports after installing or updating a SolutionPack. Ensure any
scheduled reports or pre-generated reports are set up to use the new Default
ReportPack template before deleting the old one.


You can find the list of scheduled reports and pre-generated reports by accessing
Scheduled Reports in the User Interface or by viewing Physical Overview > Tasks >
report-scheduling or Centralized Management > Scheduled Tasks > report-scheduling.


2. In the User Interface, select Administration.


3. Expand ReportPacks.


4. Expand the Default ReportPack and click the date to access the current default
ReportPack.


5. If you see two Default ReportPacks in the pane, select the older one for deletion.


Newer default ReportPacks show a version number associated with the release, for
example, 3.5.0.0.


6. Click Delete.
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7. Click Save.


Validating the environment
After upgrading your system, verify the operational status.


Procedure


1. Look for blank reports and graphs.


Determine whether blank reports are caused by collection errors. Resolve issues or
document them for later follow up.


2. Verify that all tasks are completing successfully (with the possible exception of
automatic updates and ESRS).


3. Validate that topology is working. Resolve any issues.


4. Verify or edit polling periods.
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CHAPTER 6


Updating SolutionPacks and Other Components


This chapter includes the following topics:


l Overview............................................................................................................... 84
l Upgrading all SolutionPacks and other components..............................................84
l Updating SolutionPacks and other components.................................................... 86
l Adding new components.......................................................................................88
l Updating components distributed in package (.pkg) files...................................... 88
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Overview
Use these procedures to update SolutionPacks and other components that Online Update
has downloaded from the EMC Update server to the Module Repository on the Centralized
Management (CM) server. You can update SolutionPacks separately from the process of
upgrading the system to the latest version.


The update process detects if any manual edits were made to the SolutionPack files. If a
manually edited file is compatible with the new version of the SolutionPack, it will be
reused and the system will display a message to let you know. If a manually edited file is
not compatible with the new version of the SolutionPack, the system will back up the file
and display a warning message that indicates the name and location of the incompatible
file. The system does not check files that were not were not included with the
SolutionPack.


Upgrading all SolutionPacks and other components
You can upgrade all of your installed SolutionPacks and other components with a single
click.


Before you begin


If you want to update a single SolutionPack to receive the benefit of a required fix or
feature, refer to Updating SolutionPacks and Other Components on page 86.


Synchronize the packages across the servers:


1. From Centralized Management, click Packages Management on the left-hand pane.


2. Click the Synchronization button.


3. Select retrieve the latest packages from the remote servers.


4. Wait for the synchronization to complete before proceeding.


Procedure


1. From Centralized Management, click SolutionPacks on the left-hand pane.


2. Click the Update All Components button in the top-right corner of the page.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next. The Configuration window opens. The left-hand pane lists each of the
components that include new features that you need to configure. The right-hand
pane displays the configuration details for the component with the new features
highlighted in yellow. Carefully review the selections to make sure the configuration
details for the components and SolutionPacks are correct, and modify any
configuration that are not set correctly. When you have finished configuring a
component, click Next to move onto the next component. You must edit some
SolutionPack entries while reviewing the configuration:


l For the SolutionPack for EMC M&R Health, select the Front End hostname for the
Web-Service Gateway.
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4. After you have configured every component on the list, click Next.


5. The Confirmation window opens and lists all of the components that will be updated.
Confirm that all of the components are correctly listed, and then click Update.


6. The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step.


The update process detects if any manual edits were made to the SolutionPack files. If
a manually edited file is compatible with the new version of the SolutionPack, it will
be reused and the system will display a message to let you know. If a manually edited
file is not compatible with the new version of the SolutionPack, the system will back
up the file and display a warning message that indicates the name and location of the
incompatible file. The backed up files are saved in their current directory with the
following format: <file-name>-old-<version>_<date>.<ext>
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Messages about the following incompatible files can safely be ignored:


l tmsconfig.xml


l snmp-masks.xml


l slave-snmp-poller.xml


l emc-vmax-mapping.xml


7. The Results window opens. Use the drop-down menu to check the status of each
component. Any manually edited files that were backed up by the system will be
displayed under “Updated with warnings.”


Updating SolutionPacks and other components
Learn how to update installed SolutionPacks and other components.


Procedure


1. Navigate to the installed SolutionPacks page: http://<Frontend IP
address>:58080/centralized-management/#/sp


2. Depending on which SolutionPacks or components you want to update, click the
appropriate button:
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Option Description


Update all of the installed
SolutionPacks and other
components


Click the Update All Components button in the top-
right corner of the page.


Update all of the installed
SolutionPacks


Click the Select All button located below the
SolutionPacks table, and then click the Update
button.


Update all of the installed
other components


Click the Select All button located below the Other
Components table, and then click the Update button.


Update individual
SolutionPacks or other
components


In the SolutionPacks table or the Other Components


table, click the update icon  for the SolutionPacks
or other components that you want to update.


The Initialization window opens and lists the following details:


l Number of components from SolutionPacks that will be updated to the latest
version.


l Number of components that contain new features that require configuration.


3. Click Next.


The Configuration window opens. The left-hand pane lists each of the components
that include new features that you need to configure. The right-hand pane displays the
configuration details for the component with the new features highlighted in yellow.
Carefully review the selections to make sure the configuration details for the
components and SolutionPacks are correct, and modify any configuration that are not
set correctly. When you have finished configuring a component, click Next to move
onto the next component. After you have configured every component on the list, click
Next.


4. The Confirmation window opens and lists all of the components that will be updated.
Confirm that all of the components are correctly listed, and then click Update.


The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step. When the installation is complete, the Results page opens.


5. The Update window opens and displays the progress of each update and the
percentage complete of the overall update. Do not close the browser window during
this step.


The update process detects if any manual edits were made to the SolutionPack files. If
a manually edited file is compatible with the new version of the SolutionPack, it will
be reused and the system will display a message to let you know. If a manually edited
file is not compatible with the new version of the SolutionPack, the system will back
up the file and display a warning message that indicates the name and location of the
incompatible file. The backed up files are saved in their current directory with the
following format: <file-name>-old-<version>_<date>.<ext>
Messages about an incompatible tmsconfig file can safely be ignored. Similar
warnings while updating generic-snmp about incompatible files for module 'snmp-
collector' can also safely be ignored.
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6. The Results window opens. Use the drop-down menu to check the status of each
component. Any manually edited files that were backed up by the system will be
displayed under “Updated with warnings.”


Adding new components
Procedure


1. Navigate to the installed SolutionPacks page: http://<Frontend IP
address>:58080/centralized-management/#/sp


2. In the Other Components section of the page, click Add Component.


The Browse and Install Other Components page opens.


3. Click the component that you want to install.


4. Specify the server where you want to install the new component, and click Next.


5. If necessary, specify additional configuration settings.


6. Click Install.


Updating components distributed in package (.pkg) files
Use this procedure to update EMC M&R software when a component is distributed as
a .pkg or .zip file containing multiple package files.


Before you begin


l A login with administrative privileges.


l The <EMC MnR component>.pkg file you downloaded from EMC Online Support
to a directory, such as /temp.


Procedure


1. From Centralized Management, click Packages Management.


2. On the Packages Listing page, click the Upload button.


3. Click Browse, and select the package file to be uploaded.


4. Click OK and then Continue.


The package is uploaded to the server where you can install it.
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CHAPTER 7


Automating the Download of Updates


This chapter includes the following topics:


l Online Update overview........................................................................................ 90
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server.


In a multi-server environment, the downloaded modules are distributed to all of the
remote servers managed by the CM server.


Configuring server settings for online updates
Procedure


1. Click Administration .


2. Click Centralized Management.


3. Click Configuration > Online Update .


4. Ensure that you are on the Settings tab.


5. Check the Enabled checkbox.


6. Type your EMC Online Support username and password.


7. Click the  icon to test connectivity to the update server.


The  icon indicates that connectivity to the server has been established.


The  icon indicates that connectivity to the server failed.


8. Click Save.


Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.


Procedure


1. Click Administration .


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Enable.


Note


By default, this task is set to run once everyday at 12AM. You can customize the task
schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.


Procedure


1. Click Administration .


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Run Now.


Online Update Status
The Online Update Status tab indicates whether or not the last online update check was
successful, provides the date and time of the last successful check, and lists any updates
that are available for download.


Figure 1  Online Update Status


If a major update of the EMC M&R platform is detected, the Status tab includes a Major
Update Status section that describes the version that is available, provides a link to the
upgrade documentation, and includes a Start Download button.
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Figure 2  Online Update Status with a major version update detected


Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform. You
should only download a major version if you intend to immediately complete the full
upgrade process.


Procedure


1. Click Administration .


2. Click Centralized Management.


3. Click Configuration > Online Update.


4. Click the Status tab.


5. Click Start Download. When the download is finished, the Download State will change
from "Not Downloaded" to "Complete."


6. Complete the upgrade process as described in the upgrade documentation.


Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.


The History tab also allows you to search the download history for a particular component
name or version number.
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Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.


Procedure


1. Click Administration .


2. Click Centralized Management.


3. On the Physical Overview page, click the <host_name> - Front End where the Online
Update task needs to run.


4. Click Tasks.


5. Type OnlineUpdate in the Search bar.


6. Click the OnlineUpdate scheduled task.


7. Click Disable.
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CHAPTER 8


Uninstallation


This chapter includes the following topics:


l Overview............................................................................................................... 96
l Stopping EMC M&R platform services on a UNIX server..........................................96
l Uninstalling EMC M&R platform from a UNIX server............................................... 96
l Stopping EMC M&R platform services on a Windows server................................... 96
l Uninstalling EMC M&R platform from a Windows server.........................................97
l Uninstalling a SolutionPack...................................................................................97
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Overview
You can uninstall a SolutionPack and uninstall EMC M&R platform from a UNIX or
Windows server.


Stop the EMC M&R platform services before uninstalling EMC M&R platform.


Stopping EMC M&R platform services on a UNIX server
Use the manage-modules.sh service stop command to stop a specific EMC M&R
platform service or to stop all EMC M&R platform services on a UNIX server.


Before you begin


Make sure you have logged in with root or APG privileges.


Note


The list of services varies depending upon which type of installation was performed, for
example, vApp, collector, backend, frontend, and so forth.


Procedure


l Type manage-modules.sh service stop <service_name> from the bin directory
of the installation to stop a specific EMC M&R platform service.


This example shows how to stop all EMC M&R platform services:


./manage-modules.sh service stop all 


Uninstalling EMC M&R platform from a UNIX server
Use the manage-modules.sh service remove all command to uninstall all EMC
M&R platform services.


Before you begin


Make sure you have a login with root privileges.


Procedure


1. Type manage-modules.sh service remove all from the /opt/APG/bin
directory to uninstall all EMC M&R platform services.


2. Type rm -rf /opt/APG to remove the installation directory.


Stopping EMC M&R platform services on a Windows server
Use this procedure to stop EMC M&R platform services from the Windows desktop.


Before you begin


Make sure you have logged in with system administrator credentials to manage services.
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Note


The list of services varies depending upon which type of installation was performed, for
example, vApp, collector, backend, frontend, and so forth.


Procedure


1. Type manage-modules.cmd service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.


This example shows how to stop all EMC M&R platform services:


./manage-modules.cmd service stop all 


Uninstalling EMC M&R platform from a Windows server
Use the manage-modules.cmd service remove all command to remove all EMC
M&R platform services from a Windows server.


Before you begin


Make sure you have logged in with system administrator credentials.


Procedure


1. Type manage-modules.cmd service remove all from the C:\Program Files
\APG\bin folder to uninstall all EMC M&R platform services.


2. Use the Windows Control Panel to uninstall EMC M&R platform.


a. Click Start > Control Panel > Programs.


b. Click Uninstall a program.


c. Select the Watch4net Solutions APG and click Uninstall.


Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall that
SolutionPack from the server.


Procedure


1. Log in with administrator credentials for EMC M&R platform and select Administration.


2. Select Centralized Management in the Administration tree.


3. Select SolutionPacks in the tree.


4. Select the SolutionPack that you want to uninstall in the Installed SolutionPacks
screen.


5. In the Properties area, click Trashcan icon for each instance of the SolutionPackBlock
and click Remove.
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APPENDIX A


Telnet and Socket Interface Ports


This appendix includes the following topics:


l Telnet and socket interface ports for each backend............................................. 100


Telnet and Socket Interface Ports     99







Telnet and socket interface ports for each backend
The telnet and socket interface for each backend must be different on that backend host.
These ports are open in the Linux firewall setting by default.


Backend Host Backend socket interface telnet interface


Primary Backend (PBE) DB 2000 2001


Additional Backend #1 (ABE) DB1 2100 2101


DB2 2200 2201


DB3 2300 2301


DB4 2400 2401


Additional Backend #2 (ABE) DB-hostname-1 2100 2101


DB-hostname-2 2200 2201


DB-hostname-3 2300 2301


DB-hostname-4 2400 2401


Additional Backend #3 (ABE) DB-hostname-1 2100 2101


DB-hostname-2 2200 2201


DB-hostname-3 2300 2301


DB-hostname-4 2400 2401


Additional Backend #4 (ABE) DB-hostname-1 2100 2101


DB-hostname-2 2200 2201


DB-hostname-3 2300 2301


DB-hostname-4 2400 2401


Additional Backend #5 (ABE) DB-hostname-1 2100 2101


DB-hostname-2 2200 2201


DB-hostname-3 2300 2301


DB-hostname-4 2400 2401


Additional Backend #6 (ABE) DB-hostname-1 2100 2101


DB-hostname-2 2200 2201


DB-hostname-3 2300 2301


DB-hostname-4 2400 2401
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APPENDIX B


SolutionPack Reconfiguration Fields


This appendix includes the following topics:


l SolutionPack Reconfiguration Fields....................................................................102
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SolutionPack Reconfiguration Fields
You can change the settings for the SolutionPack from the SolutionPack Reconfiguration
page.


Table 7 SolutionPack Reconfiguration Fields


Field Description


Socket Collector port On this TCP port on the Primary Backend, the Arbiter is accepting the
remote connections from all LBCs.


APG Backend
hostname or IP
address


The hostname of the server where the apg database and its backend
service are running. In this deployment, the possible options are
backend and backend2. Do not use "localhost" for the default apg on
the primary backend.


APG Backend data port Each apg has a backend and each backend has its own TCP port to
receive raw data. The port must be unique only inside the server. Refer
to Configuring the Additional Backend.


In this installation, the ports are 2000, 2100, 2200, 2300 and 2400.


Web-Service Gateway Each APG server has a Web-Service Gateway. This hostname must point
to the APG server with the backend service.


Backend Web-Service
Instance


The backend instance name. In this deployment, the possible values
are:


l Default (the default backend instance name from primary backend)


l apg1


l apg2


l apg3


l apg4


Backend database
type


MySQL by default.


Backend database
hostname or IP
address


The hostname where the MySQL database is running. By default, it is
same as the APG Backend hostname.


Backend database port
number


The port on which MySQL is accepting remote TCP connections. By
default, it is 53306 .


Backend Database
name


The database name used in MySQL. For example, apg, apg1, apg2.


Backend database
username


The user configured in MySQL. The default is "apg"


Backend database
password


The default password for the MySQL user is "watch4net"
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APPENDIX C


Restoring Modules to their Previous Version


This appendix includes the following topics:


l Restoring modules workflow............................................................................... 104
l Listing restorable modules.................................................................................. 104
l Restoring modules.............................................................................................. 105
l Starting the EMC M&R platform services from the command line......................... 107
l Starting the EMC M&R platform services on Windows.......................................... 108


Restoring Modules to their Previous Version     103







Restoring modules workflow
If you need to, you can revert to the previous version of EMC M&R platform after an
update. If the software is installed on multiple servers, you need to perform the restore
process on each server.


Restoring the modules does not restore them to their exact state prior to an upgrade. The
reason is that during the update process, some modules may modify their data files to
work for newer version. Once the data files are modified, they cannot revert to their
previous state.


The Module-Manager cannot be restored to its previous version. The 6.5.x or higher
version of Module Manager is fully compatible with version 6.4.x and can be used in its
place.


Make sure you have a login with root or system administrator privileges to restore
modules.


For single host or multiple host deployments:


1. Listing restorable modules on page 104


2. Restoring modules on page 105


3. Start the EMC M&R platform services: Starting the EMC M&R platform services from
the command line on page 107 or Starting the EMC M&R platform services on
Windows on page 108


Listing restorable modules
Use the manage-modules.sh list restorable command to list all modules that
can be restored.


Before you begin


Make sure you have a login with root or system administrator privileges to restore
modules.


Procedure


l Type the command for your operating system from the EMC M&R platform installation
directory:


Operating system Command


UNIX
<INSTALL_DIR>/bin/manage-modules.sh list restorable [--
match="<module>"]


Windows
<INSTALL_DIR>\bin\manage-modules.cmd list restorable [--
match="<module>"]


To determine if the module has more than one version to restore, specify the --
match option. For example:


/opt/APG/bin/manage-modules.sh list restorable --match="frontend"


When you view the output, record the order in which the modules display. You will
need to use the order later when you restore the modules.
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This partial Linux sample output indicates modules that can be restored.


Available Restore Points:


   Identifier                Instance               Version Date
   ------------------------- ---------------------- ------- 
--------------------
 * variable-handling-filter  Generic-SNMP           v1.8u3  
11/26/13 9:00:30 AM
 * property-tagging-filter   Generic-SNMP           v2.5u1  
11/26/13 8:57:46 AM
 * frontend-report-generator Default                v6.2u3  
11/26/13 8:38:01 AM
 * collector-manager         emc-smarts             v5.3u2  
11/26/13 8:31:29 AM
 * event-processing-manager  emc-smarts             v1.2u3  
11/26/13 8:32:29 AM


Restoring modules
Restore modules to their previous version.


Before you begin


l Identify all modules that can be restored by using the manage-modules.sh list
restorable command.


l Make sure you have a login with root or system administrator privileges to restore
modules.


Restore the modules in the order in which they displayed, starting from first to last. To
avoid dependency issues, restore the main components or managers before their sub-
components. For example, restore the Event Processing Manager before its sub-
component, Event Property Tagger. Refer to the Module Manager documentation for more
complete information about module rollback. This document is in the documentation
directory of the installation path (for example, /opt/APG/Doc).


Procedure


1. Type the command for your operating system from the EMC M&R platform installation
directory:


Operating system Command


UNIX
<INSTALL_DIR>/bin/manage-modules.sh restore 
<module_identifier> [<module_instance>]


Windows
<INSTALL_DIR>\bin\manage-modules.cmd restore 
<module_identifier> [<module_instance>]


2. Answer any questions.


This Linux sample output shows that the administration-tool module has been
restored to its previous version.


opt/APG/manage-modules.sh restore administration-tool
Starting restoration of administration-tool Default v1.0u2...
 * Gathering information...
 * Issuing a rollback will overwrite all existing files - except 
the data ones - and replace them with their previous versions, 
including configuration files.
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 * The module 'Administration-Tool' will now be restored in 
'/opt/APG/Tools/Administration-Tool/Default'.
 ! WARNING: The targeted directory already exists. This will 
overwrite existing files in this directory.
 ? Continue? [y]es, [n]o > y
 * Restoring files...
Restoration complete.


manage-modules.sh restore command
Use the manage-modules.sh restore command to revert modules to their previous
version after an update. Type the command for your operating system from the bin
directory of your EMC M&R platform installation directory.


Description
The manage-modules.sh restore command enables you to revert to the
previous version of EMC M&R platform after an update. For UNIX, specify manage-
modules.sh restore. For Window, specify manage-modules.cmd restore.


To look up the identifier and module instance name, use the manage-modules.sh
list restorable command.


Syntax
manage-modules.sh restore <module_identifier>
[ <module_instance> ] [ <version> ]


Options


module_identifier


The identifier value of the installed module.


module_instance


The unique name of the module. Omit this value if only one instance is installed since
the command will use it as the default. If multiple instances exist, specify the
instance you want to restore.
The identifier and instance values form a unique key to refer to the module.


version


The version number to which the module should be restored. Omit this value if only
one previous version exists.


In this Linux example, the following command restores the Collector-Manager from 6.5.x
to 6.4.x. Since only one previous version exists, the version option is omitted.


<INSTALL_DIR>/bin/manage-modules.sh update collector-manager
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In this Windows example, the following command restores the variable-handling-filter
from 6.5.x to 6.4.x. Since only one previous version exists, the version option is
omitted.


<INSTALL_DIR>\bin\manage-modules.cmd restore variable-handling-filter 
generic-snmp


In this Linux example, the following command restores the frontend-ws to version 6.4.


./manage-modules.sh restore frontend-ws apg-ws 6.4


./manage-modules.sh update mib-browser mymib_browser2


Starting the EMC M&R platform services from the command line
After you install EMC M&R platform, start required services.


Before you begin


l Before you start EMC M&R platform services, ensure the library search path is correct
on the server that hosts EMC M&R platform. This requirement applies to the libaio
package on Linux.


l Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the EMC M&R platform application uses instead of root.


Procedure


l Type the command for your operating system from the bin directory of the
installation:


Operating system Command


UNIX ./manage-modules.sh service start all


Windows manage-modules.cmd service start all


Results


The platform displays a list of services.


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Example:


* Starting 'topology-mapping-service Default'... [ OK ]
* Starting 'webservice-gateway Default'... [ OK ]
* Starting 'mysql Default'... [ OK ]
* Starting 'alerting-backend Default'... [ OK ]
* Starting 'backend Default'... [ OK ]
* Starting 'collector-manager Default'... [ OK ]
* Starting 'collector-manager Generic-SNMP'... [ OK ]
* Starting 'collector-manager Load-Balancer'... [ OK ]
* Starting 'collector-manager emc smarts'... [ OK ]
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* Starting 'event-processing-manager emc smarts'... [ OK ]
* Starting 'tomcat Default'... [ OK ]
* Starting 'task-scheduler Default'... [ OK ]


Starting the EMC M&R platform services on Windows
After installing EMC M&R platform on Windows, you can start all required services from a
Windows desktop.


Before you begin


Make sure you have logged in with system administrator credentials to manage services.


Note


The list of available services will vary depending upon choices (Collector, Backend,
Frontend, Default, or Minimal) made during installation.


Procedure


1. From the application server's desktop, select Start > Administrative Tools > Services.


2. Right-click each service and click Start, in this order:


l APG Topology Mapping Service


l APG Topology Service


l APG Webservice Gateway


l APG MySQL


l APG Alerting Backend


l APG Backend


l APG Collector Manager (Generic RSC)


l APG Collector Manager (Generic-SNMP)


l APG Collector Manager (Load-Balancer)


l APG Event Processing Manager (Alert-Consolidation)


l APG Tomcat


l APG Task Scheduler
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